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Para P-40B z 47 Pursuit Squadron USAAC, której udało się wystartować 7 grudnia 1941r do walki z japońskim nalotem na Pearl Harbor. Pilotują je porucznicy: Kenneth Taylor i George Welch.
47 PS był w tym czasie oddelegowany na ćwiczenia strzeleckie w ustronny, północny zakątek wyspy Oahu, na polowe lądowisko Haleiwa. To obszar nie był blokowany przez japońskie samoloty. (Pearl Harbor leżało na przeciwnym brzegu wyspy). Pas startowy biegł wzdłuż brzegu morza. Tak ta para samolotów mogła wyglądać zaraz po starcie. Fotografia tła przypomina autentyczny fragment brzegu w pobliżu lotniska Haleiwa
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Bo zawsze chciałem stworzyć model samolotu w komputerze. A gdy już to zrobiłem — stwierdziłem, że to dobra zabawa, i że warto tym doświadczeniem podzielić się z innymi.
Dawno temu byłem zwykłym modelarzem i robiłem redukcyjne modele samolotów. To hobby dość specyficzne. Ślęczymy miesiącami nad naszym dziełem, starając się nanieść na kawałek materiału maleńkie nity, złącza blach, czy drobne detale tablic przyrządów. Sądzę, że postronnym obserwatorom zajęcia wędkarzy wydadzą w porównaniu z modelarzami mniej męczące, choć podobnie monotonne. W dodatku, zamiast tworzyć ładne, błyszczące miniaturki, nanosimy na ich powierzchnię (o zgrozo!) zabrudzenia i przetarcia, jakie powstawały podczas intensywnego używania. Szpecimy je, aby wyglądały jak rzeczywiste, zużyte i gdzieniegdzie pordzewiałe maszyny. Całą naszą nagrodą jest pokazanie naszych dzieł komuś, kto potrafi docenić ich finezję. Zdarza się to raz na jakiś czas. Mówiąc szczerze, dziwnym trafem są to zazwyczaj inni modelarze. A może ukrytą nagrodą jest możliwość nawiązania dyskusji na tak ezoteryczne tematy, jak wyższość Spitfire’a IX nad FW 190 A4? Albo paląca kwestia, jak był pomalowany P-40, na którym Witold Urbanowicz latał nad Chinami w 1943r?
Otóż chciałbym teraz zaoferować kolegom modelarzom (i nielicznych koleżankom – jakoś tak się te proporcje układają) zupełnie nowy materiał i narzędzia. Zamiast własnego, czasami nieco pobrudzonego aerografem biurka — okno na inny świat, w głębi ekranu.
Jest tu niezwykle plastyczny materiał, który można „wytłaczać” w dowolne powłoki, bez obawy że go zabraknie. Są tu farby, dla których można dokładnie ustalić odcień i zasady nakładania. Jest tu możliwa do osiągnięcia dokładność, której nie uzyskasz nigdzie indziej, ani w skali 1:24, ani w 1:18. Tu, gdy stwierdzisz, że okapotowanie silnika samolotu, który zrobiłeś rok temu, powinno mieć inny kształt, zawsze możesz ten błąd poprawić. I to nie raz! Tu nigdy Twój model nie obrośnie kurzem. Nie będziesz wysłuchiwał narzekań domowników na to, że nie ma już gdzie zmieścić Twojej kolekcji. Możesz tu powielić swoje dzieło – choćby po to, by odwzorować je w kilku różnych wersjach malowania. I możesz przesłać swój model innym hobbystom, takim jak Ty, bez obawy że coś się z nim stanie podczas transportu. Z obiektów, które w ten sposób stworzysz, można szybko budować całe sceny.
Jedyne, do czego trzeba się przyzwyczaić, to to, że niczego w tym świecie nie można dotknąć. Możesz tylko patrzeć, i łapać wszystko myszką. Przynajmniej na obecnym etapie rozwoju technologii, urządzenia dotykowe (ang. haptic devices) są nadal drogie i prymitywne. Za to możemy obserwować szybki rozwój drukarek 3D. Przypuszczam że za dwa — trzy lata będziemy mogli na nich „drukować” np. dokładne części modeli.
Ten świat wirtualnego modelarstwa stał niepostrzeżenie dostępny. W istocie każdy komputer, kupiony po 2005r, to silna stacja graficzna, o której w latach 90-tych można było tylko pomarzyć. Około 15 lat temu „ruszył z miejsca” nowy model matematyczny, służący do odwzorowania powierzchni. Mam na myśli powierzchnie podziałowe (ang. subdivision surfaces). Pozwoliły stworzyć Shreka i dziesiątki innych postaci z filmów animowanych za pomocą komputera. Ten nowy model matematyczny skierował do lamusa powierzchnie NURBS, wykorzystywane od lat 70-tych. Powierzchnie podziałowe pozwalają łatwo uzyskiwać naprawdę złożone kształty. W miarę dobrze radzą sobie ze zmorą NURBS – otworami i wycięciami.
Co więcej – odpowiednie programy, które potrafią to wszystko wykorzystać, stały się dostępne za darmo! Stworzyły je dziesiątki programistów Open Source. Ludzie ci chcą pokazać, że stać ich co najmniej na to samo, co twórców najlepszych programów komercyjnych. I to zaczęło im się udawać! Być może, trochę w tym zdrowej ambicji („ja to zrobię lepiej!”), oraz innego rytmu powstawania takich produktów. Podczas pracy nad nimi nie ma, typowego dla komercyjnych projektów pośpiechu, związanego z napiętymi terminami. (A pośpiech rodzi błędy). W efekcie pracy odpowiednio dużej grupy entuzjastów powstaje dobry, stabilny program.
Podsumowując – kupując do domu komputer do gier, kupiłeś wszystko, co potrzeba do wejścia w świat wirtualnego modelarstwa. Nie będę oszukiwał, że nie ma tu tego, co jest nieodłączną cechą pracy każdego modelarza: wielotygodniowego wysiłku. Mam jednak nadzieję, że ta książka ułatwi Ci, drogi Czytelniku, jak najszybsze osiągnięcie pożądanych rezultatów. Potem możesz pójść dalej i zrobić to samo jeszcze lepiej, niż tu proponuję. Przeczytanie dalszych stron, oszczędzi Ci dużo czasu i – niekiedy – frustracji. Ta ostatnia bywa nieodłącznym składnikiem pracy z „tą głupią maszyną” – komputerem. Postaram się nie zanudzać i pokazywać dużo obrazków, więc mam nadzieję, że „Wirtualne modelarstwo” Cię zainteresuje.
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„Wirtualne Modelarstwo” uczy „od zera”, jak tworzyć takie modele samolotów, jak pokazany na okładce. Aby szybciej udostępniać Czytelnikom uaktualnione fragmenty tej książki, zdecydowałem się stworzyć i opublikować wyciągi z jej tekstu, związane z określoną dziedziną. Są to: „Tom I: Przygotowania”, „Tom II: Modelowanie”, „Tom III: Materiały i tekstury”, oraz „Tom IV: Detale i renderowanie”. Przebieg pracy prezentuję na przykładzie modelu myśliwca Curtiss P-40B. Maszyna ta zawiera klasyczne rozwiązania, stosowane w większości samolotów tego okresu. Z całym rozmysłem nie wybrałem Spitfire, Mustanga, Thunerbolta, Focke-Wulfa czy Messerschmita. Nie chciałem zabierać Ci przyjemności samodzielnego odwzorowania tych słynnych samolotów.
Możesz tworzyć model każdego myśliwca z okresu II wojny światowej1, czytając jednocześnie kolejne rozdziały z tej książki. To wcale nie musi być P-40. Wszystkie te samoloty wykonuje się podobnie. W trakcie pracy na pewno zetkniesz się ze wszystkimi zagadnieniami, które są tu opisane.
Ta książka ma służyć zarówno tym, którzy dopiero zaczynają swoją przygodę „w 3D”, jak i tym, którzy mają już w tej dziedzinie pewne doświadczenie. W związku z tym zdecydowałem się ją podzielić na dwie części:
część pierwsza ("Budowa modelu") to tekst podstawowy, który koncentruje się na tym, co trzeba zrobić;
część druga ("Szczegóły obsługi programów") to szczegółowe opisy, jak posłużyć się odpowiednim programem, by osiągnąć efekt, pokazany w części pierwszej.
Cały tekst ma dużo stron, z czego "Szczegóły obsługi programów" zajmują ok. 40%. Układ tej części przypomina tekst systemu pomocy (Help) do programu. To krótkie (na jedną lub dwie strony), nie zawierające więcej niż kilka ilustracji, opisy pojedynczych poleceń.
Dzieląc materiał na część podstawową i „szczegółową”, starałem się uniknąć niepotrzebnych, wydłużających niezmiernie tekst, wskazówek w rodzaju „kliknij tu, a potem naciśnij tamto”. W odpowiednich miejscach części pierwszej umieściłem odnośniki do części drugiej. Jeżeli nie znasz programu, o którym akurat piszę, korzystaj z tych odnośników i czytaj umieszczone w nich informacje szczegółowe2. Przygotowałem je tak, abyś nauczył się posługiwać wszystkimi narzędziami "od zera", w trakcie czytania głównego tekstu. Gdy już będziesz wiedział, jak zrobić to, co opisuję — po prostu przestaniesz do nich zaglądać.
Książka zawiera jeszcze jedną część: „Dodatki”. To materiały, które mogą być ciekawe dla co dociekliwszych Czytelników. Tematyka „Dodatków” przypomina trochę "groch z kapustą": od pewnych zagadnień optyki (deformacja obrazu na fotografii), do odwzorowania profili lotniczych. A oprócz tego: metody zaawansowanej weryfikacja rysunków samolotu (na poziomie tworzenia planów modelarskich), oraz szczegółowy opis właściwości powierzchni podziałowych. Nie musisz do „Dodatków” zaglądać, choć sądzę, że niektórzy mogą w tych materiałach znaleźć dla siebie coś interesującego.
Wskazówki dotyczące klawiatury i myszki oparłem na założeniu, że masz standardowe:
klawiaturę — w normalnym układzie amerykańskim, 102 klawisze (dodam także parę uwag o klawiaturze notebooka, bo sam na takiej pracuję);
myszkę — wyposażoną w dwa przyciski i kółko przewijania (które daje się także naciskać: wtedy działa jak trzeci, środkowy przycisk).
Wywołanie polecenia programu będę zaznaczał następująco:
| Menu→Polecenie | taki zapis oznacza wywołanie z menu „Menu” polecenia „Polecenie”. W przypadku bardziej zagnieżdżonych menu może wystąpić więcej strzałek! |
| Panel:Przycisk | taki zapis oznacza naciśnięcie w oknie dialogowym lub panelu "Panel" przycisku „Przycisk”. Czasami mogę także w ten sposób napisać o przełączniku lub liście rozwijalnej. ("Panel" to pojęcie związane z ekranem Blendera, wyjaśnienia — patrz „Tom II: Modelowanie”) |
Naciśnięcie klawisza na klawiaturze:
| Alt-K | myślnik pomiędzy znakami klawiszy oznacza jednoczesne naciśnięcie obydwu klawiszy na klawiaturze. W tym przykładzie trzymając wciśnięty Alt, naciskasz K; |
| G, X | przecinek pomiędzy znakami klawiszy oznacza, że je naciskasz (i zwalniasz!) po kolei. W tym przykładzie najpierw G, a potem X (tak, jak gdybyś chciał napisać wyraz „gx”). |
Naciśnięcie klawisza myszki:
| LPM | lewy przycisk myszy |
| PPM | prawy przycisk myszy |
| SPM | środkowy przycisk myszy (naciśnięte kółko przewijania) |
| KM | kółko przewijania (pełni tę rolę, gdy jest obracane) |
Na koniec — „w kwestii formalnej”: jak mam się do Ciebie zwracać? Zazwyczaj w poradnikach używa się formy bezosobowej („teraz należy zrobić”). To jednak, mówiąc szczerze, czyni czytany tekst mniej zrozumiałym. Aby ta książka była jak najbardziej czytelna, zwracam się do Czytelnika w krótkiej, drugiej osobie („teraz zrób”). Czasami używam także osoby pierwszej („teraz zrobiłem”, „teraz zrobimy”). Tak jest mi łatwiej1.
„Wirtualne modelarstwo” najlepiej jest czytać na możliwie dużym, kolorowym tablecie, takim jak Kindle Fire 8.9”, lub na komputerze stacjonarnym, w aplikacji Kindle for PC. Ze względu na kolorowe ilustracje o dużej rozdzielczości, zdecydowanie odradzam próby użycia mniejszych czytników wykorzystujących technologię e-ink, takich jak Kindle Touch czy Kindle Paperwhite1.
Ta książka jest dostępna w kilku popularnych formatch. Użyj tej matrycy format/platforma aby lepiej zorientować się we właściwościach każdego z nich dla każdego z najpopularniejszych czytników/komputerów. To pozwoli zdecydować, który z tych formatów będzie najlepiej pasować do Twoich potrzeb. Każdą wersję tej książki możesz pobrać ze strony tego projektu.
Na stosunkowo dużym ekranie Kindle Fire 8.9” książkę można czytać w układzie pionowym (Rysunek i.3.1). Ilustracje „Wirtualnego modelarstwa” dostosowują się dynamicznie do szerokości ekranu:
Rysunek 0.3.1 Strony książki na Kindle Fire 8.9”
W tym poradniku chciałem, aby tekst i powiązane z nim ilustracje pojawiały się jak najbliżej siebie. W tym celu musiałem połączyć je w jedną, ciągłą zawartość i pozwolić czytnikowi dzielić ją na strony. Dlatego czasami może się zdarzyć, że ilustracja znajdzie się na jednej stronie, a jej podpis — już na następnej. Wynika to z niedoskonałości obecnie używanych formatów książek elektronicznych. (Nie mogłem zastosować żadnego rozwiązania które wymusiłoby na czytniku pozostawianie ilustracji i jej podpisu razem).
W ustawieniach czytnika dla tej książki proponuję wybrać niezbyt duży rozmiar czcionki (Settings: Font Size: 3 lub 4). W ten sposób podstawowy tekst będzie miał wysokość dopasowaną do odsyłaczy na ilustracjach (tekst podstawowy powinien być o około 50% wyższy od tekstu na ilustracjach). Ustaw także wąskie marginesy (Margins:Narrow), aby ilustracje były jak największe (Rysunek i.3.2):
Tło wszystkich ilustracji jest białe, stąd książka najlepiej wygląda z białym tłem (Color Mode). Odstęp pomiędzy liniami tekstu (Line Spacing) można ustawić na szeroki, a domyślną czcionkę (Font) — na szeryfową Georgia.
Gdy ustawisz tablet poziomo, czytnik podzieli treść książki na dwie „rozłożone” strony (Rysunek i.3.3):
Rysunek i.3.3 Domyślny sposób wyświetlania przy poziomym układzie tabletu
Uważam, że w takim układzie jest mniej czytelna, przede wszystkim ze względu na zmniejszone ilustracje.
Na szczęście możemy taki tryb wyłączyć. W opcjach programu (Settings) naciśnij More Options, aby przejść na drugi ekran. Przełącz tam tryb Two Column na Off (Rysunek i.3.4):
Rysunek i.3.4 Wyłączenie trybu „rozłożonych stron”
Rysunek i.3.5 Powiększanie ilustracji poprzez obrót tabletu
Rozmiar wszystkich ilustracji w tej książce zależy od rozmiaru ekranu: ich szerokość jest ustawiona jako % aktualnej szerokości ekranu. Stąd w ustawieniu poziomym wszystkie ilustracje są proporcjonalnie większe gdyż ekran tabletu jest szerszy.
Gdy wyłączysz tryb Two Column, możesz szybko powiększać ilustracje z bieżącej strony poprzez obrót tabletu, jak na Rysunku i.3.5:
Rozmiar czcionki każdego tekstu spoza ilustracji pozostaje taki sam w obydwu położeniach: pionowym i poziomym. Położenie poziome wydłuża linie tekstu do więcej niż 72 znaków na linię. (Optymalną długość linii tekstu to 66-72 znaki. Linie dłuższe lub krótsze czyta nieco trudniej). Co więcej, ekran Kindle Fire w położeniu poziomym nie jest zbyt wysoki, i potrafi wyświetlic tylko jedną ilustrację i kilka linii tekstu. Stąd proponuję używać ustawienia poziomego do szybkich powiększeń, a pionowego — do normalnego czytania.
Kindle Fire wyświetla przełącznik Two Column tylko wtedy, gdy tablet jest ustawiony poziomo!
Ta książka zawiera mnóstwo hipertekstowych odsyłaczy. Są wyróżnione cienkim podkreśleniem. W głównym tekście te hipertekstowe skróty sa przypisane do symboli nagłówków, sekcji, czy numerów stron (Rysunek i.3.6):
Rysunek i.3.6 Użycie skrótów hipertekstowych
Używaj przycisku Back (Rysunek i.3.6) do powrotu z takiego „hipertekstowego skoku” w poprzednie położenie w książce. (Gdy tablet jest ustawiony poziomo, znajdziesz ten przycisk z prawej strony ekranu).
Wyjątkiem w użyciu przycisku Back jest powrót z przypisu na Kindle Fire: użyj w tym celu numeru fizycznej strony, umieszczonego za numerem przypisu (Rysunek i.3.6). (Rób tak, dopóki Amazon nie usunie błędu z oprogramowania dla tego tabletu. W przeciwnym razie po jakimś kolejnym naciśnięciu Back zamknie się książka i trzeba ją ponownie otworzyć).
W tej książce referencją jest każdy numer fizycznej strony. Numery te pochodzą z książki formacie PDF, i choć nie odpowiadają stosowanym przez Kindle „lokalizacjom” (loc)to pozostawiłem je aby tekst tej publikacji był we wszystkich formatach taki sam. (No, może poza tą sekcją wproadzenia, która jest specyficzna dla każdego z zastosowanych formatów).
Starając się by ta publikacja elektroniczna była bardziej czytelna niż typowe papierowe poradniki, przesunąłem większość szczegółowych opisów z tekstu głównego do podrozdziałów. W ich miejscu pozostawiłem hipertekstowe odsyłacze. Skorzystaj z tych skrótów aby poznać wszystkie niuanse opisywanych operacji. W ten sposób główny wątek książki pozostaje wolny od rozpraszających uwagę detali.
* * *
Przypuszczam że często będziesz czytał ten poradnik pracując jednocześnie na komputerze. I choć sądzę, że najlepiej się taką książkę czyta na tablecie, to możesz czasami możesz nie mieć żadnego „pod ręką”. Wtedy użyj darmowego programu Kindle for PC, dostarczanego przez Amazon na komputery z systemami Windows (Rysunek i.3.7). (Istnieją jeszcze Kindle for Mac i Kindle for Android. Wszystkie wyglądają bardzo podobnie):
Rysunek i.3.7 Przeglądanie tej książki w programie Kindle for PC
Zauważ że ta aplikacja ma pod menu rozwijalnym pasek narzędzi (Rysunek i.3.7). Aby przełączyć się w tryb jednej kolumny, kliknij przedostatnią ikonę.
Zalecam czytanie tej ksiażki w trybie jednej kolumny (por. Rysunek i.3.7). W tym trybie ilustracje są więkze i bardziej czytelne, i możesz używać fontów o większym rozmiarze. W trybie dwukolumnowym ("otwartej książki") trudniej jest czytać mniejszy tekst, szczególnie na szarym tle "ramek". (Z tego powodu specjalnie pozostawiłem tę ramkę bez wypełnienia, abyś mógł przeczytać tę wskazówkę w trybie dwukolumnowym).
Kliknij w jedną z jego ikon (Rysunek i.3.7) aby otworzyć panel ustawień (Settings — Rysunek i.3.8):
Rysunek i.3.8 Ustawienia Kindle for PC
Podobnie jak na Kindle Fire możesz ustawić tu rozmiar podstawowego tekstu, szerokość marginesów czy barwę tła (białą).
W Kindle for PC nie ma możliwości zmiany kroju czcionki podstawowego tekstu — wszystko jest wyświetlane w jednolitej czcionce szeryfowej (sądzę że jest to Georgia).
Kursor myszki zmienia się ponad każdym hipertekstowym linkiem we „wskazującą dłoń” (Rysunek i.3.8). Gdy w takim miejscu klikniesz myszką — przejdziesz do odpowiedniej strony (Rysunek i.3.9):
Rysunek i.3.9 Powrót do poprzedniego położenia w książce
Aby powrócić z takiego „skoku” do poprzedniego miejsca w książce, naciśnij przycisk Back, umieszczony w pasku ponad tekstem (Rysunek i.3.9).
Wersja tej aplikacji Amazon na tablety firmy Apple — Kindle for iOS — nie otwiera poprawnie tej książki. Dopóki Amazon nie usunie tego błędu2, najlepszym rozwiązaniem dla tabletów IPad jest pobrać tę książkę w formacie EPUB i czytać ją w darmowej aplikacji iBooks.
W tej części stworzymy model P-40B. Zakładam, że dla wielu Czytelników będzie to wprowadzenie w świat grafiki komputerowej. Nie znaczy to jednak, że nasz samolot będzie jakiś uproszczony! (Choć, przyznam, gdy zaczynałem pisanie tej książki, chciałem parę zagadnień pominąć). Wykonamy go „w pełnej wersji”: z chowanym podwoziem i większością detali kabiny pilota. W trakcie pracy postaram się przekazać Wam całą wiedzę, jaką do tej pory na ten temat zgromadziłem.
W tym rozdziale omówimy pokrótce instalację oprogramowania, z którego będziemy korzystać. Są to:
Blender: program podstawowy;
GIMP: pomocniczy, do edycji obrazów rastrowych;
Inkscape: pomocniczy, do edycji obrazów wektorowych;
To oprogramowanie jest udostępniane w zasadach licencji GPL. Oznacza to m.in., że nie można pobierać za nie żadnych opłat. (Oczywiście, jeżeli masz gest, a program Ci się bardzo spodoba, możesz wspomóc twórców dotacją — ale na zasadzie zupełnej dobrowolności. Szczegółowy opis, jak to zrobić, znajdziesz na stronie internetowej każdego z tych projektów.)
Przypuszczam, że większość czytelników tej książki używa komputera z Windows. Podczas opisu instalacji koncentruję się wyłącznie na tym środowisku. Sam go używam. Nie mam żadnych doświadczeń z Linuksem, ani z Mac OS, więc nie będę pisał o instalacjach, których nie wykonałem. Jeżeli używasz systemów innych niż Windows — poszukaj wskazówek na stronach tych programów (ich adresy są w kolejnych sekcjach rozdziału).
Przygotowałem także trochę materiałów dodatkowych, i udostępniłem je jako spakowane pliki zip:
Pliki towarzyszące tej książce możesz pobrać ze strony: http://samoloty3d.pl/wm3_p.xml . Utrzymuję tam ich aktualne wersje1.
Następujące pliki są ważną częścią tej książki:
source.zip: zawiera skrypty Pythona, plany P-40B, udostępnione przez producenta fragmenty rysunków technicznych (P-40E), i inne pomocnicze materiały;
la5.zip: Zawiera model, który wykorzystuje Rozdział 3;
p40.zip, p40w.zip: Zawierają historię zmian (pliki *.blend) modelu P-40, oraz kilka obrazów tła, wykorzystanych w tej książce. Każdej sekcji tej książki odpowiada plik ze spakowanego folderu history\;
textures1.zip, textures2.zip: folder, zawierające kolejne wersje tekstur odpowiadające poszczególnym modelom z pliku p40.zip, i robocze pliki, wykorzystywane do ich stworzenia. (Podzieliłem te dane na dwie części ze względu na znaczny rozmiar zawartych w nich plików rastrowych);
Rozpakuj wszystkie pobrane pliki *.zip do tego samego folderu. W trakcie ich rozpakowania stworzą odpowiednie podkatalogii:
Ta książka opisuje Blendera w wersji 2.7. Jednak wszystkie poprzednie wersje tego programu także można instalować w sposób opisany poniżej.
Najpierw pobierz pliki programu ze strony Fundacji Blendera: — http://www.blender.org . Pliki do pobrania są obecnie dostępne pod adresem: http://www.blender.org/download/ (Rysunek 1.1.1). Za jakiś czas (trzy, cztery lata) może to się trochę zmienić przy okazji kolejnej przebudowy tego portalu, więc w razie czego zacznij od strony głównej1.
Rysunek 1.1.1 Strona, z której możesz pobrać pliki Blendera
Pod wskazanym adresem znajdziesz skróty do wersji programu skompilowanych dla różnych systemów operacyjnych (Windows, Linux, Max OSX, …). Na ilustracji widać, że wybrałem wersję dla Windows, 64 bity. Zdecydowanie doradzam użycie 64-bitową wersję Blendera2. Wersja 32-bitowa jest przeznaczona dla tych, którzy ze względu na 32-bitowy system operacyjny (XP, Vista) nie mogą użyć innej.
Jak pokazuje Rysunek 1.1.1, każda z wersji dla Windows jest udostępniona w dwóch postaciach: programu instalacyjnego i spakowanego pliku *.zip.
Jeżeli jesteś bardzo przyzwyczajony do programów instalacyjnych Windows, pobierz go i uruchom. Po wskazaniu folderu, w którym należy umieścić Blendera, będziesz miał po chwili zainstalowany program.
Ja jednak należę do ludzi, którzy wolą dokładnie wiedzieć, co się dzieje z ich komputerem3. Rzecz w tym, że Blender prawie „nie dotyka” reszty systemu. Dlatego najlepszym (jak uważam) sposobem instalacji Blendera jest rozpakowanie pliku *.zip. W ten sposób po prostu wiesz dokładnie, co robisz. Wystarczy:
pobrać ze strony BF plik *.zip (Rysunek 1.1.1), zawierający spakowany folder z jego plikami;
rozpakować zawartość tego pliku na lokalny dysk, np. jako folder C:\Program Files\Blender;
dodać skrót do C:\Program Files\Blender\blender.exe na pulpit i/lub do menu Start;
opcjonalnie: skojarzyć rozszerzenie *.blend z tym programem (np. przy okazji otwierania przykładowego pliku);
Jeżeli masz jakiekolwiek wątpliwości co do przebiegu tej nieskomplikowanej procedury, na str. 756 znajdziesz szczegółowy opis, jak to robię.
Gdy już używasz Blendera, i chcesz wgrać nową wersję — nie musisz wcale po raz kolejny uruchamiać programu instalacyjnego. (Choć, oczywiście, możesz to zrobić). Moja metoda na uaktualnienie do nowej wersji polega na:
zmianie nazwy aktualnego folderu Blender na „Blender-XX.X”, gdzie XX.X to numer starej wersji. Na przykład: przed wgraniem wersji 2.70a zmieniłem nazwę dotychczasowego folderu z Blender na Blender-2.69;
pobraniu ze strony BF pliku *.zip z nową wersją Blendera;
rozpakowaniu plików Blendera do folderu o takiej samej nazwie, jaką zmieniliśmy w pkt 1 (Blender).
(W ten sposób wszystkie skróty do Blendera w menu Start i skojarzenie rozszerzenia plików *.blend samoczynnie przechodzą na nową wersję — nie musisz niczego więcej zmieniać).
Przy pierwszym uruchomieniu Blender sam zaproponuje mi przeniesienie konfiguracji ze starej wersji (Rysunek 1.1.2) — wystarczy nie przeoczyć tego momentu i kliknąć przycisk Copy Previous Settings:
Rysunek 1.1.2 Okno powitalne (splash screen) przy pierwszym uruchomieniu nowej wersji Blendera
Dzięki zachowywaniu poprzednich wersji Blendera w folderze o zmienionej nazwie, możesz zawsze z niej skorzystać. Wystarczy uruchomić plik blender.exe z jej katalogu.
Możesz mieć na swoim komputerze równocześnie używać wielu różnych wersji Blendera. Wystarczy, że każda z nich znajduje się w innym katalogu.
Do poprawnego działania Blender nie potrzebuje żadnej instalacji Pythona. (Możesz o niej napotkać w wzmianki w Internecie. Interpreter Pythona był opcjonalnym dodatkiem do jego wcześniejszych wersji — np. 2.4). Blender od wersji 2.5 korzysta z własnego, wbudowanego interpretera tego języka. Jest on używany np. w obsłudze interfejsu użytkownika (okienek, przycisków, i menu programu).
Aby zainstalować GIMP, zajrzyj na stronę tego projektu — http://www.gimp.org . Od kilku lat plik do pobrania jest dostępny pod adresem: http://www.gimp.org/downloads (Rysunek 1.2.1):
Rysunek 1.2.1 Strona, z której można pobrać program instalacyjny GIMP
Ten uniwersalny program instalacyjny zawiera obydwie wersje GIMPA: 32-bitową i 64-bitową. Po uruchomieniu rozpoznaje typ systemu operacyjnego, i, gdy jest to możliwe, instaluje wersję 64-bitową1.
W procesie instalacji Gimpa nie ma żadnych “haczyków”. Po jej zakończeniu warto zmienić język interfejsu na angielski i przełączyć program w tryb pojedynczego okna (Windows→Single-Window Mode). Szczegółowy opis, jak to zrobić, znajdziesz na str. 607.
Podczas pracy nad tą edycją książki używałem GIMP v. 2.8.10.
Zajrzyj na stronę projektu Inkscape — http://www.inkscape.org (Rysunek 1.3.1):
Rysunek 1.3.1 Strona projektu Inkscape
Obecnie pliki instalacyjne są udostępnione na http://www.inkscape.org/downloads/ (Rysunek 1.3.2):
Rysunek 1.3.2 Strona z plikami instalacyjnymi Inkscape
„Oficjalny” pakiet instalacyjny zawiera Inkscape w wersji 32-bitowej. Ja jednak sugeruję zainstalować odmianę 64-bitową, która nam obsłuży o wiele bardziej złożone rysunki (np. obraz detali poszycia samolotu).
W chwili gdy piszę ten rozdział, wygląda na to, że 64-bitowy Inkscape jest kompilowany nie przez samych twórców, a przez kogoś innego (to i tak dobrze — dawniej była dostępna wyłącznie odmiana 32-bitowa). Gdy klikniesz w odpowiedni link na stronie Inkscape (na stronie pokazywanej przez Rysunek 1.3.2 jest to www.pratha.com ), możesz się znaleźć na takim portalu jak ten pokazywany przez Rysunek 1.3.3:
Rysunek 1.3.3 Pobieranie 64-bitowej odmiany Inkscape
Na pierwszy rzut oka wydaj się być to portal poświęcony GIMP, a nie Inkscape! Jeżeli jednak przyjrzysz się uważniej jego zawartości, znajdziesz odpowiedni skrót (w lewym dolnym rogu — por. Rysunek 1.3.3).
Możesz pobrać stąd program instalacyjny, a następnie uruchomić go na swoim komputerze. Proces instalacji Inkscape jest prosty, wystarczy abyś naciskał wszystkie przyciski domyślne. Gdybyś miał jakieś wątpliwości — szczegółowy opis instalacji znajdziesz na str. 673.
64-bitowa wersja Inkscape pobrana ze strony www.pratha.com ma pewną wadę: niestandardowy, zbyt ciemny kolor okien (por. str. 676). Można sobie z tym problemem poradzić tak, jak to opisuję w szczegółowym opisie instalacji.
Proponuję jednak prostsze rozwiązanie: przygotowałem gotowy do rozpakowania plik *.zip, zawierający odpowiednio skonfigurowaną 64-bitową wersję 0.48.10 Inkscape dla Windows 7 i 8. Aby jej użyć wystarczy:
pobrać plik http://airplanes3d.net/downloads/wm3/inkscape-048-64.zip ;
rozpakować jego zawartość (czyli przenieść folder Inkscape) do katalogu C:\Program Files\;
Potem dodaj skrót do C:\Program Files\Inkscape\inkscape.exe na pulpit lub do menu Start, i już możesz zacząć używać ten program.
W tej edycji książki używałem właśnie tego Inkscape (0.48.10, 64bit).
W tym rozdziale przedstawię metodę przygotowania rysunków samolotu, które wykorzystamy jako wzorzec w Blenderze. Zrobię to tu na przykładzie myśliwca P-40, ale tok postępowania jest taki sam dla każdego innego samolotu. W tym rozdziale będę się posługiwał wyłącznie GIMP. Przy okazji możesz się tu nauczyć podstaw jego obsługi.
Model cyfrowy powstaje na podstawie rysunków wzorcowych — rzutu z boku, góry, dołu, przodu, ewentualnie także z tyłu. Rysunki takie muszą być dokładne. Inaczej tylko utrudnią nam pracę1.
Na szczęście mamy w Polsce co najmniej dwa dobre plany modelarskie P-40, opracowane przez dwóch różnych autorów:
Jacka Jackiewicza — rysunki opublikowane w monografii “Curtiss P-40”, wydanej w latach 2000-2001 przez AJ Press, w ramach serii “Monografie lotnicze” (zeszyty nr 64, 65, 66);
Mariusza Łukasika — rysunki opublikowane w monografii “Curtiss P-40”, wydanej w latach 2008-2009 przez Kagero, w ramach serii “Monografie” (zeszyty nr 36, 40)
Jeżeli chcesz samodzielnie wykonać model P-40, gorąco polecam zakup co najmniej jednej z podanych powyżej publikacji. W materiałach załączonych do tej książki nie ma rysunków (byłoby to naruszenie praw ich autorów). Rysunki to zresztą nie wszystko - podczas pracy nieodzowne są także bliskie zdjęcia różnych części samolotu. Takie fotografie znajdziesz w Internecie, są także publikowane w specjalnych wydawnictwach dla modelarzy, nazywanych po angielsku “walk around”. Na przykład, na potrzeby tej pracy kupiłem zeszyt “Kittyhawk I/IA”, wydawnictwa Model Detail Photo Monograph (zeszyt nr 14). Zawiera ponad 100 fotografii i szkiców fragmentów P-40E. Właściwie im bardziej szczegółowy zamierzasz zbudować model, tym więcej takich materiałów powinieneś zgromadzić. Na pewno się przydadzą!
Wróćmy jednak do naszych rysunków: należy je zamienić na obrazy komputerowe, więc muszą być zeskanowane. W sumie jest to jedyny moment, gdy potrzebujesz skorzystać ze skanera. Nie stosuj jakichś wysokich rozdzielczości - obraz zeskanowany w trybie 300x300 dpi jest zupełnie dobry.
Przy okazji przygotowywania rysunków, będę się starał dokładnie zweryfikować poprawność kształtu samolotu. Może i czasami będziemy coś upraszczać, ale to uproszczenie ma polegać na rezygnacji z jakiegoś szczegółu. Stąd nie ma tu miejsca na jakąś “taryfę ulgową”. Sam się przekonasz, ile i jakiego rodzaju błędów potrafią zawierać nawet szczegółowe plany.
W tym rozdziale pokażę podstawowy proces przygotowania rysunków. Trzeba je wyprostować, sprawdzić poprawność proporcji i zapisać w plikach o ujednoliconych wymiarach. Użyjemy do tego Gimpa. Po zapoznaniu się z tymi sekcjami będziesz w stanie sam przygotować zestaw rysunków, których użyjesz w Blenderze.
Jeżeli chciałbyś dowiedzieć się, jak można dokładniej zweryfikować plany2 — polecam Rozdział 18 (“Szczegółowa weryfikacja planów samolotu”, str. 1189). Porównuję tam rysunek, jaki przygotowaliśmy, z fragmentami rysunków fabrycznych P-40, a także ze zdjęciami. Korekty kształtu nanoszę w Inkscape. Tam ostatecznie możesz sprawdzić, na ile nasze rysunki nie kłamią! Metody, które stosuję, mogą być wykorzystane nawet do opracowywania nowych planów modelarskich.
Rysunki po zeskanowaniu nie nadają się do natychmiastowego użycia. Zazwyczaj są mniej lub bardziej zniekształcone — na przykład osie samolotu nie są idealnie poziome lub pionowe. Mogą im się także przytrafić problemy z wzajemną prostopadłością. Takie rzeczy trzeba sprawdzić i skorygować. Stworzymy w ten sposób ich poprawione wersje: każdy rzut w oddzielnym pliku. Najłatwiej jest to zrobić w Gimpie. (Jeżeli zupełnie nie znasz tego programu — patrz “Wprowadzenie”, str. 611).
Wczytaj do Gimpa jeden z zeskanowanych arkuszy, zawierający rzut z boku (szczegóły — str. 616). Zazwyczaj najlepiej jest użyć w tym celu jednego z głównych arkuszy planów. Raczej nie korzystaj z zestawienia różnych wersji samolotu. (Na rysunkach robionych metodą tradycyjną — w tuszu — zestawienie sylwetek wersji jest zawsze narysowane mniej starannie.) W tym konkretnym przypadku (publikacji AJ-Press) był z tym problem. Rzut z lewej znajduje się w niej pobliżu szwu zeszytu. W takim miejscu podczas skanowania kartka jest nieco wygięta, i rzut z boku wychodził zdeformowany. Nie chciałem rozcinać stron, i w ten sposób niszczyć mojego egzemplarza monografii. Przyjrzałem się więc dokładnie innym arkuszom planów. Na rysunkach Jacka Jackiewicza zestawienie wersji samolotu wydawało się tak samo dokładne, jak główny rzut. Zdecydowałem się więc z nich skorzystać, bo były najmniej zniekształcone przez wygięcie strony.
Rysunek 2.1.1 pokazuje, jak w Gimpie może wyglądać materiał “wejściowy” — zeskanowany arkusz planów modelarskich.
Rysunek 2.1.1 Wycięcie z planów modelarskich pojedynczego rzutu z lewej (w GIMP)
Wytnij z tego obrazu fragment, zawierający pojedynczy rzut z boku (szczegóły — patrz str. 619).
Teraz sprawdzimy, czy rysunek nie jest obrócony ani przekoszony. Umieść linie pomocnicze (guides: szczegóły — patrz str. 620) na kluczowych liniach konstrukcyjnych, o których wiesz, że powinny być pionowe lub poziome (Rysunek 2.1.2):
Rysunek 2.1.2 Przykładowe rozmieszczenie linii pomocniczych
Zapewne zapytacie, skąd wiem, które łączenia blach na kadłubie P-40 były pionowe lub poziome. No cóż, nie ma na to precyzyjnej odpowiedzi. Zacznijmy od poziomych. Na każdym rysunku i wielu zdjęciach widać na kadłubie długi “szew”, ciągnący się od ogona do okapotowania silnika (Rysunek 2.1.2). Jego linia przebiega odrobinę poniżej osi śmigła. W opisie technicznym samolotu można wyczytać, że kadłub P-40 był składany z dwóch połówek: górnej i dolnej. Co więcej, na zachowanych zdjęciach z odbudowy pewnego nowozelandzkiego P-40N widać, że granica podziału biegnie właśnie wzdłuż tego szwu. Wydaje się to tym bardziej prawdopodobne, że blachy w P-40 były łączone “na zakładkę”. Krawędź dolnej połówki kadłuba — ta niewidoczna, schowana “pod zakładką” — znajduje się jakieś 2 cm powyżej szwu. Wygląda na to, że leży na osi śmigła. To prawdopodobnie ślad po oryginalnej osi samolotu, jaka występowała na jego rysunkach konstrukcyjnych. Linie pionowe, które sprawdzam — są to po prostu linie głównych wręg. Krawędź steru kierunku — zakładam, że jest prostopadła do osi, bo na taką wygląda. (Zazwyczaj technolodzy, gdy robią już coś ukośnego, to jest to pochylone o jakiś znaczący kąt, a nie o ułamek stopnia).
W dużym pomniejszeniu szwy na rysunku zdają się doskonale przylegać do linii pomocniczych. Czy tak jest jednak na pewno? Trzeba to sprawdzić w większym zbliżeniu. (Zmiana widoku w GIMP — patrz str. 621.) Przejrzyj rysunek fragment po fragmencie, w powiększeniu. W strefie silnika i wokół kabiny wszystkie linie wydają się być w porządku. (Nie widać odchyleń narysowanych linii szwów od linii pomocniczych). Kłopot zaczyna się na ogonie (Rysunek 2.1.3). Linia głównego szwu, biegnąca poziomo przez cały kadłub, w tym obszarze wyraźnie jest zagięta w dół. Nie jest to duże odchylenie, ale wykracza poza tolerancję “zamiany linii na piksele”, dokonywanej przez skaner. Co więcej, linia szwu biegnącego powyżej jest odchylona w podobny sposób.
Rysunek 2.1.3 Szczegółowe sprawdzanie równoległości linii rysunku - odchylenia na ogonie
To mogłoby wskazywać na deformację rysunku w tylnej części, wywołaną np. nieznacznym wygięciem strony podczas skanowania. W takim jednak przypadku wszystkie linie w tym obszarze byłyby zdeformowane w ten sam sposób. A tak nie jest. Nałożyłem dodatkową linię pomocniczą na rząd nitów, biegnących tuż powyżej jednej ze zdeformowanych linii. Nie ma odchyleń! Zmierzyłem kąt zaklinowania statecznika poziomego — zgodnie z opisem technicznym samolotu powinien wynosić +2º — i tak jest! Więc co o tym sądzić?
Przyjrzyjmy się dokładniej. Rysunek Jacka Jackiewicza, który tu analizujemy, wygląda na wykonywany metodą tradycyjną. (Kreślony najpierw ołówkiem, potem — poprzez kalkę — tuszem.) Sądzę tak, gdyż poszczególne linie wydają się być odrobinę nierówne. Takie odstępy pomiędzy kropkami nitów są różne w różnych miejscach1. Wygląda na to, że odchylenia, znalezione na tym rysunku to drobna pomyłka, wynikająca z ręcznego wykonania. Widać linijka podczas kreślenia została przyłożona odrobinę nierówno do kalki. Pozostaje tylko pamiętać, podczas korzystania z rysunku, że na ogonie dwie linie są narysowane z drobnym błędem.
No dobrze, rzut z boku jest już przycięty i sprawdzony. Korekty w postaci drobnego obrotu nie potrzebuje, bo odpowiednie linie są poziome i pionowe. Teraz pozostaje usunąć z niego niepotrzebne resztki innych sylwetek, a potem zapisać na dysk jako oddzielny plik.
Do usunięcia z rysunku pozostałości innych sylwetek użyj “gumki” (Rysunek 2.1.4, szczegóły — str. 633):
Rysunek 2.1.4 Wymazywanie z rysunku niepotrzebnych elementów
Gdy oczyścimy obraz z „naleciałości”, czas go zapisać do oddzielnego pliku (szczegóły — patrz str. 617). Proponuję nadać obrazowi nazwę składającą się z:
krótkiego oznaczenia typu,
inicjałów autora (bo będziemy korzystać z obydwu),
nazwy rzutu (“Left”, “Top”, “Bottom”, “Right”, “Front”, “Back”).
Proponuję także nadać mu rozszerzenie .tif. (GIMP wybiera format zapisu na podstawie rozszerzenia nazwy pliku — „.tif” oznacza zapis w popularnym formacie TIFF).
Ostatecznie przygotowany plik będzie nosił nazwę: P40B-JJ-Left.tif. Będzie tak nazywany w całej książce. Przyznam, że uprościłem nieco oznaczenie tego samolotu. Ściśle rzecz biorąc, to sylwetka Curtiss Tomahawk IIA dostosowanego do celów rozpoznania. (Posiada kamerę w luku kadłuba i dodatkową antenę.) W istocie jednak ten typ (oznaczenie fabryczne Hawk 81-A2) był eksportową wersją P-40B, produkowanych równolegle dla USAAC. Antenę i kamerę podczas tworzenia modelu P-40B zignoruję, i wszystko będzie w porządku.
Przygotowanie zestawu rysunków, potrzebnych do stworzenia modelu, zawsze zaczynaj od rzutu z lewej. Ten rzut jest najczęściej najdokładniejszy2. Staraj się unikać pobierania rzutu z lewej z mniej ważnych fragmentów planów, np. zestawienia różnych wersji samolotu (str. 30).
Każdy rzut kadrujemy z zeskanowanego arkusza planów modelarskich do oddzielnego pliku (str. 30). (Zazwyczaj każdy arkusz planów zawiera więcej niż jeden rzut).
Sprawdzamy, czy uzyskany obraz nie ma deformacji (str. 31). (Gdyby były, należałoby je skorygować - patrz następna sekcja tego rozdziału).
Usuwamy niepotrzebne fragmenty obrazu (zazwyczaj resztki innych rysunków — str. 32).
Gotowy rysunek zapisujemy na dysk pod nową nazwą. Warto tu przyjąć jakąś zasadę nazewnictwa — ułatwi nam to później pracę (str. 32).
Przygotujmy teraz — w podobny sposób jak rzut z lewej — rysunek prawej strony. Zazwyczaj wybieram na ten rzut jakąś wersję z otwartym podwoziem. Podobnie jak rzut z lewej, odpowiednio ją kadrujemy (Rysunek 2.2.1):
Rysunek 2.2.1 Wykadrowanie rzutu z prawej
Teraz powinniśmy rysunek obrócić, aby ustawić sylwetkę poziomo. Wcześniej dodaj poziomą linię pomocniczą. Ustaw ją tak, by przechodziła przez czubek kołpaka śmigła (Rysunek 2.2.2). (W tym punkcie umieścimy oś obrotu):
Rysunek 2.2.2 Umieszczenie poziomej linii odniesienia
Trzeba jeszcze zwiększyć rozmiar obrazu w kierunku pionowym o jakieś 70%, aby zmieścił się w nim “wyprostowany” (obrotem) rzut z boku (szczegóły — str. 643). Inaczej statecznik pionowy znajdzie się poza rysunkiem.
Przygotowania do obrotu zakończone — linia pomocnicza jest na miejscu, rozmiar obrazu odpowiednio powiększony. Rozpocznij obrót. Zacznij od przesunięcia środka tam, gdzie linia pomocnicza przecina kołpak śmigła (Rysunek 2.2.3 — szczegóły str. 643):
Rysunek 2.2.3 Sylwetka samolotu przed obrotem
Podczas obracania staraj się doprowadzić do sytuacji, gdy lina pomocnicza będzie równoległa do głównego szwu kadłuba (Rysunek 2.2.4). Wartość, przy której to osiągnęliśmy — 13.43º — jest niemal idealnie zgodna z rysunkami gabarytowymi Curtiss (13.30º).
Rysunek 2.2.4 Sylwetka samolotu po obrocie
Po zatwierdzeniu obrotu przyjrzyjmy się kluczowym liniom rzut z prawej i podobnym liniom na opracowanym poprzednio rzucie z lewej (Rysunek 2.1.2).Sprawdź uważnie oś kadłuba. W widoku z lewej strony oś biegnie od czubka kołpaka śmigła, ale niemal dotyka głównego szwu kadłuba. A na naszym rzucie (Rysunek 2.2.4), jest od niego zdecydowanie odsunięta. Wygląda na to, że widok z prawej ma wyżej podniesiony nos samolotu!
Popatrzmy uważniej na ten obszar (Rysunek 2.2.5):
Rysunek 2.2.5 Zniekształcenie nosa samolotu (rzut z prawej)
Tym razem to nie jest błąd autora — wygląda na to, że przód samolotu jest wygięty do góry. Przyczyną było najprawdopodobniej wygięcie w tym miejscu strony podczas skanowania. (Ten fragment był niedaleko od szwu zeszytu monografii, takie wygięcia mogą się zdarzyć).
W sumie — nie wiadomo, czy rysunek nie zawiera innych, mniej rzucających się w oczy różnic. Najlepiej byłoby nałożyć na siebie obydwa rzuty — z prawej i lewej, i sprawdzić, gdzie ich linie się “rozjeżdżają”. (Takie nałożenie to bardzo wymagający test dla rysunków kreślonych ręcznie. Człowiek praktycznie nie jest w stanie narysować w sposób identyczny dwóch tak złożonych kształtów).
GIMP umożliwia taką operację. Dodamy rzut z lewej jako oddzielną warstwę rysunku. Następnie zwiększymy przejrzystość tej warstwy, by widać było jednocześnie linie obydwu sylwetek.
Na razie zapisz tę sylwetkę z boku do nowego pliku: P40B-JJ-Right.tif. Aby porównać ten rysunek z rzutem z lewej, wykonaj lustrzane odbicie aktualnego obrazu (Layer→Transform→Filp Horizontally). (Nie martw się, na koniec wykonamy je znowu, aby powrócić “na właściwą stronę”).
Teraz wczytaj plik P40B-JJ-Left.tif jako nową warstwę (File→Open as Layers), i zwiększ jej przejrzystość (szczegóły — str. 624). Rysunek 2.2.6 pokazuje, jak takie złożenie może początkowo wyglądać:
Rysunek 2.2.6 Efekt włączenia przejrzystości na górnej warstwie obrazu
Warstwa z wczytanym rzutem z lewej nazywa się tak jak plik — P40B-JJ-Left.tif. Nasuń ją na rysunek prześwitujący “spod spodu” (szczegóły — str. 644). Podczas dopasowywania położenia rzutów największą uwagę zwracaj na takie linie charakterystyczne, jak główne szwy oraz krawędzie sterów. (Wszystko to, co jest narysowane prostymi liniami i wyznacza ważne miejsca konstrukcyjne.) Pamiętaj, że na rysunkach kreślonych ręcznie różnice mogą wystąpić na wszelkich krzywiznach. (Na przykład — obrysy kadłuba lub steru kierunku mogą się różnić.) Nałóż na siebie sylwetki tak, aby główny szew kadłuba oraz ostatnia wręga były w tym samym miejscu.
Przyjrzyjmy się rezultatom. Wygląda na to, że środek kadłuba jest narysowany na obydwu sylwetkach dokładnie tak samo. Różnice pojawiły się z przodu (Rysunek 2.2.7) i na ogonie (Rysunek 2.2.8).
Rysunek 2.2.7 Porównanie dwóch sylwetek z tych samych planów - część przednia
Rysunek 2.2.8 Porównanie dwóch sylwetek z tych samych planów - część tylna
Widoczne są wyraźne odchylenia kształtu statecznika i steru kierunku. Sądzę, że jest to przekoszenie. (Linie żeber i inne linie, które powinny być poziome, są poziome. Linie pionowe za to są pochylone. A to świadczy o tym, że nie jest to obrót).
Nim zaczniemy korygować znalezione różnice, musimy zmienić kolejność warstw. W zakładce sterującej warstwami (okno przybornika — Rysunek 2.2.9):
Włącz pełną nieprzejrzystość warstwy P40B-JJ-Left.tif (Opacity na 100%);
Przesuń na liście warstwę P40B-JJ-Right.tif tak, by znalazła się u samej góry;
Zmień nieprzejrzystość warstwy P40B-JJ-Right.tif (Opacity na 50%);
Zaczniemy od skorygowania przekoszania ogona. Ustaw linię pomocniczą tak, by wyznaczała prawidłowe położenie końcowej krawędzi kadłuba (Rysunek 2.2.10). (Jest to jednocześnie miejsce, gdzie zaczyna się ster kierunku). To nasz wzór, na którym będziemy sprawdzać, czy krawędź steru stała się już pionowa.
Zaznacz na rysunku prostokątny obszar (szczegóły — str. 634). Tę deformację poprawimy także przekoszeniem (Tools→Transform Tools→Shear — szczegóły na str. 646), tylko w drugą stronę.
Rysunek 2.2.10 Prostowanie (przez przekoszenie) obszaru usterzenia
Zwróć uwagę na wybór deformowanego obszaru (Rysunek 2.2.10). Linie pionowe są w tej transformacji poddane niewielkiemu obrotowi. Pionowe granice zaznaczonego obszaru poprowadziłem więc przez kadłub tam, gdzie przecinają same poziome łączenia blach kadłuba. Z kolei linie poziome ulegną tylko przesunięciu. Poprowadziłem je więc wzdłuż linii szwu na kadłubie. W ten sposób przesunięcie tych pikseli nie zepsuje zbytnio rysunku.
Rysunek 2.2.11 przedstawia uzyskany efekt — uzgodniony obrys usterzenia pionowego.
Rysunek 2.2.11 Obrys statecznika po korekcie
Przy takich transformacjach, dokonywanych na obrazach rastrowych, zawsze wystąpią efekty uboczne. W oknie głównym zmień nieprzejrzystość aktualnej warstwy z powrotem na 100. Teraz zobaczymy, co nam na rysunku się popsuło (Rysunek 2.2.12):
Rysunek 2.2.12 Niedokładności, o których trzeba pamiętać (aby ich nie przenieść na model)
Przyglądając się efektom, z ulgą można stwierdzić, że defekty są stosunkowo niewielkie (Rysunek 2.2.12):
przesunęły się trzy linie nitów (ale, dzięki pozostałościom u dołu, widać gdzie być powinny),
fragment głównego szwu kadłuba jest odrobinę przesunięty do dołu (ale widać, gdzie powinna przebiegać);
tylna krawędź kadłuba jest lekko wykrzywiona;
zanika najniższe żebro steru kierunku.
Moglibyśmy jeszcze raz użyć narzędzi Gimpa, aby poprawić te błędy. Naszym ostatecznym celem nie jest jednak naprawa planów P-40. Korygujemy rysunki tylko w takim zakresie, by wystarczyły do stworzenia jak najdokładniejszego modelu. Najważniejszą rzeczą jest zgodność kształtu. W przypadku drobnych nieprawidłowości w liniach nitów lub szwów wystarczy pamiętać, że ten obraz był w tym miejscu poprawiany. Podczas modelowania zignorujemy te różnice, traktując rzut z lewej jako wzór.
Otwartą sprawą pozostaje kwestia, skąd wzięła się ta poprawiona deformacja. Przypuszczam, że może być efektem odkształcenia podczas druku. Inną możliwością jest pomyłka autora planów. W każdym razie takie różnice pozwalają nam ocenić granice możliwego błędu przygotowywanych rysunków.
Do prostowania przodu samolotu użyjemy obrotu (Rysunek 2.2.13):
Rysunek 2.2.13 Prostowanie przodu samolotu
Zwróć uwagę, że linie łączeń blach pod skrzydłem są zgodne, a kabiny, położonej ponad nimi - nie. Tego obszaru nie można “wybrać prostokątem”. Zastosuj inną metodę selekcji: dowolnym obrysem (szczegóły — str. 635). Ważne jest także takie dobranie punktu obrotu, aby wiatrochron kabiny nie uniósł się do góry. Jednocześnie linie łączenia blach przed wiatrochronem powinny przesunąć się do przodu. Rysunek 2.2.13 pokazuje położenie osi obrotu, dla której efekt końcowy wydaje się całkiem zadowalający (por. Rysunek 2.2.14 - z Rysunek 2.2.7, str. 37):
Rysunek 2.2.14 Wyprostowany nos samolotu (obydwie sylwetki są na siebie nałożone)
W wyniku obrotu nosa obydwie sylwetki niemal idealnie się pokryły (Rysunek 2.2.15). Jedynie celownik przed kabiną jest odrobinę wyżej. Właściwie tylko po różnicy w pozycji odsuniętej owiewki można poznać, że są tu nałożone na siebie dwa rysunki. Niemal udało się uniknąć “ubocznych” deformacji:
Rysunek 2.2.15 Niedokładności, pozostałe po wyprostowaniu nosa samolotu
Końcówki śmigła leżą (w zakresie akceptowalnej tolerancji) na tej samej linii pionowej. Większość łączeń blach przyjęła poprawne położenia, za wyjątkiem dwóch (Rysunek 2.2.15). (Będzie trzeba o nich pamiętać).
Gotowy obraz przerzuć z powrotem w poziomie w przeciwną stronę (Image→Transform→Filp Horizontally).
Na koniec usuń warstwę z rzutem z lewej (szczegóły — str. 630) — nie będziemy jej więcej używać. Oczyść rysunek z niepotrzebnych linii (str. 633) i zapisz (jako P40B-JJ-Right.ti).
Podsumowanie
Sprawdzanie rysunku rozpocznij od porównania z liniami pomocniczymi (str. 36);
Następnie porównaj go z rzutem z przeciwnej strony (str. 37);
Wykryte deformacje można skorygować za pomocą różnych transformacji: obrotu (pamiętaj, ważne jest położenie środka tej transformacji! — str. 36), przekoszenia (Shear — str. 38), przesunięcia, i zmiany skali w jednym kierunku (ta ostatnia jest opisana w następnej sekcji);
Podczas korygowania używaj linii pomocniczych, które pozwolą Ci w trakcie transformacji na bieżąco sprawdzać, czy osiągnąłeś już cel (str. 38).
W sylwetkach bocznych samolotu, które do tej pory opracowaliśmy, koncentrowaliśmy przede wszystkim na odchyleniach od osi poziomej. To dlatego, że wysokość rzutu z boku jest o wiele mniejsza od jego długości. Pewne deformacje wzdłuż osi Y, nawet jeżeli istnieją, powodują odchylenia mieszczące się w granicach tolerancji.
Zupełnie inaczej jest z rzutem z góry lub z dołu. Tutaj ważne są obydwa kierunki, i każdy z nich musi być starannie sprawdzony. Pokażę to na przykładzie przygotowywania rzutu z góry z rysunków Jacka Jackiewicza.
Rysunek 2.3.1 “Wyprostowanie” rzutu z góry, poprzez obrót całego arkusza
Rysunek 2.3.1 ilustruje przekształcenia, jakim należy poddać obraz po załadowaniu:
obróć obraz o 90º (Image→Transform→Rotate 90º counter-clockwise) ;
dodaj pionową linii pomocniczej. Umieść ją tak, by przechodziła przez czubek kołpaka śmigła. (To dlatego, że punkt ten leży mniej więcej w środku rysunku, w pobliżu górnej krawędzi);
obróć cały obraz (Tools→Transform Tools→Rotate), tak, by oś kadłuba znalazła się dokładnie pod linią pomocniczą.
Po tym wstępnym “wyprostowaniu” należy sprawdzić, czy skrzydła nie są przekoszone. (Od tej pory wszelkie błędy obrazu będziemy poprawiali transformacją Shear w kierunku równoległym do osi samolotu. Przyczyna jest prosta — wszystkie linie równoległe do osi wzdłużnej są już wyprostowane. Dalsze obroty mogłyby tylko coś popsuć).
Zgodnie z przyjętą konwencją, zapisz ten obraz pod nazwa P40B-JJ-Top.tif.
Zweryfikujmy, czy końce krawędzi płata leżą w tym samym miejscu (Rysunek 2.3.2):
Rysunek 2.3.2 Sprawdzanie deformacji płata
Nałóż na rysunek kilka poziomych linii pomocniczych, umieszczając je w punktach charakterystycznych lewej końcówki płata. Gdyby skrzydła nie były zdeformowane, linie powinny przejść przez analogiczne punkty na prawej końcówce. Tak się jednak nie dzieje — widać wyraźną różnicę (Rysunek 2.3.2).
Skoryguj przekoszenie w kierunku osi Y (Tool→Transform Tools→Shear). Nie zaznaczaj żadnego obszaru, by deformowany był cały obraz. (Taka deformacja dotyczy zazwyczaj całego zeskanowanego arkusza.) GIMP sam ustala środek (punkt neutralny) transformacji — jest to środek obrazu, a więc punkt w pobliżu osi podłużnej kadłuba. W przypadku, jaki pokazuje Rysunek 2.3.2, konieczne się stało skorygowanie przekoszenia w kierunku osi Y o -19 pikseli (przy rozmiarach obrazu rzędu 2400 x 2900 px).
Teraz płat jest już poprawny. Przy przeglądaniu rysunku znajdujemy kolejną deformację — statecznika poziomego (Rysunek 2.3.3):
Rysunek 2.3.3 Kolejny problem - wykrzywiony statecznik poziomy
Wygląda na to, że po wyprostowaniu skrzydła powiększyła się deformacja usterzenia poziomego. (Stało się jeszcze bardziej przekoszone). Przynajmniej kadłub i skrzydło mamy już wyprostowane.
Tym razem musimy to poprawić, ograniczając transformację do obszaru usterzenia. Jak pokazuje Rysunek 2.3.4, zrobiłem to obszarem prostokątnym (szczegóły — str. 634):
Rysunek 2.3.4 Prostowanie statecznika poziomego
Przy właściwym doborze obszaru deformacji, możliwe jest, w tym przypadku, uniknięcie “popsucia” innych linii na planach (Rysunek 2.3.5):
Rysunek 2.3.5 Wyprostowane usterzenie poziome
Pomijam w tej sekcji następny sprawdzian — porównanie sylwetek rzutu z góry z rzutem z dołu. Należy je porównać w ten sam sposób (poprzez nałożenie), w jaki porównywaliśmy rzuty z lewej i z prawej (str. 36). W tym przypadku trudniej jest mi poradzić, który rzut jest ważniejszy. Gdy znajdziesz różnice — pozostaje porównanie ze zdjęciami, aby określić która wersja jest bliższa rzeczywistości. Ja traktuję rzut z góry jako “ważniejszy”.
Na koniec pozostaje sprawdzić, czy rysunek ma właściwe proporcje. Chodzi o prostą sprawę: stosunek długości i rozpiętości powinien być taki sam, jak w rzeczywistym samolocie.
Znalazłem w Internecie (http://www.p40warhawk.com) oryginalne rysunki gabarytowe P-40B/C, zaakceptowane przez USAAC w kwietniu 1939 (Rysunek 2.3.6). Zostały opublikowane (odtajnione) przez firmę Curtiss w 1941, ponad dwa lata po oblocie prototypu. Nie oszałamiają dokładnością linii, ale zawierają rzecz cenną: kilka dodatkowych wymiarów poza rozpiętością i długością. Zwymiarowano na nich np. trapez skrzydła (poprzez podanie cięciwy u nasady, na końcu, i kąta pochylenia krawędzi natarcia). Podano także rozpiętość usterzenia poziomego. Wymiary, naniesione w sposób tak jednoznaczny przez producenta — to dobre narzędzie weryfikacji.
Rysunek 2.3.6 Gabaryty P-40B/C — w stopach i calach (Curtiss, 1941)
Zmierzmy długość i rozpiętość rysunku, używając pikseli jako jednostki. GIMP wyświetla aktualne współrzędne kursora w lewym dolnym narożniku ekranu (Rysunek 2.3.7):
Rysunek 2.3.7 Odczytywanie współrzędnych początku kadłuba
Wystarczy ustawić kursor myszki na początku kadłuba, i odczytać współrzędną Y aktualnej pozycji. Podobnie — ustawiając kursor — można odczytać pozostałe trzy wymiary, potrzebne do określenia długości i rozpiętości rysunku. Tabela 2.3.1 pokazuje wyniki pomiaru:
| Wymiar | Początek (px) | Koniec (px) | Różnica (px) |
| Kadłub | Y: 124 | Y: 2476 | 2352 |
| Płat | X: 328 | X: 3126 | 2798 |
Tabela 2.3.1 Zmierzone wymiary rysunku (piksele — px)
Zgodnie z fabrycznymi rysunkami P-40B miał długość 967 cm (31 stóp i 8 9 / 16 cala). Rozpiętość wynosiła - 1137 cm (37 stóp i 3 1 / 2 cala). Daje to stosunek długości do rozpiętości = 967 / 1137 = 0.85048. Jeżeli zmierzona rozpiętość rysunku to 2798 px (Tabela 2.3.1), to długość powinna wynosić 2798 px * 0.85048 = 2379 px.
Różni się to od wartości zmierzonej (2352 px). Wynikałoby z tego, że kadłub w rzucie z góry jest za krótki o 27 pikseli. Czy na pewno? Równie dobrze można przyjąć, że długość rysunku Jacka Jackiewicza jest poprawna, a rozpiętość wymaga małego “ściśnięcia” (o 2798 - (2352 / 0.85048) = 32 piksele).
Załóżmy, że długość kadłuba jest poprawna. Daje to skalę 2.43 pikseli / cal. Stosując tę wartość, można określić inne wymiary, które warto sprawdzić:
cięciwa największego żebra skrzydła (leży w osi kadłuba) powinna mierzyć na rysunku 667 pikseli (wg planów Curtissa miała dokładnie 9 stóp, czyli 108 cali);
rozpiętość usterzenia poziomego powinna wynosić na rysunku 949 pikseli (wg planów Curtissa wynosiła 12 stóp i 9 5 / 8 cala).
Przedłużmy na planach Jacka Jackiewicza linie krawędzi natarcia i krawędź spływu skrzydła (Rysunek 2.3.8). Ich przecięcie z osią kadłuba wyznacza początek i koniec “żebra kadłubowego”. Ten odcinek powinien mieć długość 667 pikseli, a ma 676 — o 9 za dużo. Wygląda więc na to, że płat jest za duży w stosunku do kadłuba. (Ma większe obydwa podstawowe wymiary: cięciwę i rozpiętość).
Podobnie za duża jest rozpiętość statecznika poziomego. Powinna wynosić 949 pikseli, a wynosi 960 — o 11 pikseli za dużo (Rysunek 2.3.8):
Rysunek 2.3.8 Różnice pomiędzy planami a rzeczywistymi wymiarami samolotu.
W którym kierunku skorygować rysunek? Aby to ostatecznie rozstrzygnąć, sprawdźmy, jak pasuje rzut z lewej do widoku kadłuba z góry. Czy długości poszczególnych elementów się zgadzają? Przygotujmy rysunek do porównania:
dokonaj konwersji obrazu na odcienie szarości (o ile nie zrobiłeś tego wcześniej): Image→Mode→Grayscale;
obróć rysunek o 90º w lewo: Image→Transform→Rotate 90º counter-clockwise;
Załaduj jako nową warstwę plik P40B-JJ-Left.tif (File→Open as Layers) . W przyborniku, w zakładce Layers, zmniejsz nieprzejrzystość (Opacity) warstwy P40B-JJ-Left.tif ze 100 na 50;
Na koniec spróbuj nasunąć rzut z lewej na kadłub rzutu z góry. Zrób to tak, aby linie kołpaka śmigła jak najlepiej się pokryły (Rysunek 2.3.9):
Rysunek 2.3.9 Złożenie — kadłub, rzutu z lewej i rzutu z góry
Na pierwszy rzut oka wygląda to jak plątanina linii. Jednak w zbliżeniu na obydwu rzutach dostrzeżesz wspólne punkty charakterystyczne. Długość kadłuba na obu rysunkach jest idealnie zgodna. Obrys kołpaka - również. Nie można znaleźć większej różnicy w pozycjach poszczególnych linii w okolicach usterzenia. (Krawędzie sterów są w tym samym miejscu).
Za to środek kadłuba — tu mamy różnice! (Rysunek 2.3.10) Krawędź natarcia skrzydła w rzucie z góry jest przesunięta do przodu o 12 pikseli. (W stosunku do krawędzi natarcia w rzucie z boku.) Z kolei cały obszar kabiny, zaczynając od przedniej krawędzi skrzydła, wydaje się być przesunięty do tyłu o 4-5 pikseli.
Rysunek 2.3.10 Różnice w położeniu szczegółów kadłuba i skrzydła
Załóżmy (coś trzeba założyć), że rzut z lewej jest poprawny1. Będziemy go traktować jako wzór. W tej sytuacji wygląda na to, że należy dokonać jeszcze następujących poprawek:
przeskalować cały rysunek wzdłuż osi Y, aby zmniejszyć rozpiętość płata o 32 piksele (i — proporcjonalnie — usterzenia poziomego);
“ścisnąć” skrzydło, wraz z fragmentem kadłuba, o 9 pikseli wzdłuż osi X. (Krawędź spływu pozostaje, mniej więcej, w dotychczasowym miejscu). W ten sposób płat ulegnie proporcjonalnemu (przynajmniej w przybliżeniu) zmniejszeniu.2
rozciągnąć sam kadłub w kierunku osi X, od statecznika pionowego do okapotowaniu silnika. Przy okapotowaniu silnika powinna nastąpić największa deformacja — o 5 pikseli do przodu;
Nim wykonamy krok 1, przytnij obraz tak, by zawierał wyłącznie rzut z góry (szczegóły — str. 619). Zrób to tak, by jego krawędzie — górna i dolna — były jak najbliżej końcówek skrzydeł.
Przygotowując rysunek do poprawek, zmień kolejność warstw: Layer→Stack→Reverse Layer Order.
zmień nieprzejrzystość (Opacity) warstwy z rzutem z lewej (P40B-JJ-Left.tif) na 100 (kompletnie nieprzejrzysta).
zmień nieprzejrzystość (Opacity) warstwy z rzutem z góry (P40B-JJ-Top.tif) ze 100 na 75;
(Szczegóły zarządzania warstwami znajdziesz na str. 624). Rysunek 2.3.11 pokazuje, jak powinno wyglądać ułożenie warstw przed dalszymi transformacjami. Zwróć uwagę, aby podświetlona (aktywna) była warstwa z rzutem z góry.
Teraz wykonaj pierwszy z zaplanowanych kroków: zmniejsz rozmiaru całości wzdłuż osi Y (rozpiętość) o 32 piksele (szczegóły — str. 648). Przekształć w ten sposób całą aktywną warstwę (tzn. nie zaznaczaj wcześniej żadnego obszaru).
Następnie wykonamy krok drugi: “ściśnięcie” obszaru skrzydła, wraz z kadłubem, o 9 pikseli. Obramuj skrzydło prostokątnym obszarem selekcji (Rysunek 2.3.12), a następnie wybierz znów polecenie zmiany skali.
Rysunek 2.3.12 “Ściśnięcie” skrzydła w kierunku X
Po zakończeniu zmiany skali znów należy - podobnie jak poprzednim razem - odrobinę przesunąć przeskalowany obszar. Tym razem trzeba dosunąć go do tyłu. (Gdy wpisujesz nowy rozmiar w pola Width lub Height, środkiem skalowania jest w GIMP zawsze lewy górny narożnik obszaru selekcji. W związku z tym, w wyniku zmiany skali, przesunęła się w lewo krawędź spływu płata, a nie jego krawędź natarcia — por. Rysunek 2.3.13.) Lukę po skalowaniu poprawimy przesunięciem o 9 pikseli w prawo. Wywoła to efekt “krótkiej kołderki” z przodu selekcji. Luka pojawi się teraz w obszarze okapotowania silnika, pomiędzy rurami wydechowymi a początkiem skrzydła. (Spokojnie, skorygujemy ją wykonując trzeci, ostatni krok zaplanowanej transformacji.)
Rysunek 2.3.13 Po skalowaniu: przerwę z tyłu zamieniamy na przerwę z przodu
Ostatni krok transformacji ma polegać na wyciągnięciu w kierunku silnika samego kadłuba, bez skrzydła. Żadna z metody selekcji, które dotychczas poznaliśmy, nie jest do tego odpowiednia. Zaznaczenie prostokątem objęłoby i przesunęło nie tylko kadłub, ale także fragment skrzydła. Z kolei Free Select zbyt zależy od losowych drgnięć ręki. Jak możesz się przekonać, nie mam jej zbyt pewnej (Rysunek 2.2.14, str. 40).
Pozostaje mi skorzystać z innej możliwości Gimpa: narysowania obszaru selekcji. Opisując rzecz w skrócie, robi się to w następujący sposób:
tworzysz na chwilę nową, (przejrzystą) warstwę (patrz str. 629);
rysujesz na niej kształt selekcji (patrz str. 631);
wywołujesz polecenie Layer→Transparency→Alpha to Selection (por. 638) ;
“sprzątasz” po operacji: usuwasz niepotrzebną już warstwę z kształtem selekcji (patrz str. 630);
Nim zamienisz narysowany kształt w selekcję, wprowadź pewną poprawkę. Wykonaj za pomocą „gumki” (Eraser — patrz str. 633) niewielkie wgłębienia wszędzie tam, gdzie z kadłubem styka się jakaś linia skrzydła (Rysunek 2.3.14):
Rysunek 2.3.14 Przygotowanie obszaru selekcji — wymazanie “naddatków”, wykonanie wgłębień
Takie wgłębienia pozwolą uniknąć pozostałości po transformacji w postaci brzydkich, krótkich, poprzecznych linii. Teraz możesz przekształcić narysowany kształt na selekcję: Layer→Transparency→Alpha to Selection.
Następnie przeskaluj zaznaczony obszar. Tym razem, po wywołaniu polecenia Scale, nie wpisuj wartości w oknie dialogowym. Zamiast tego użyj jednego z uchwytów obszaru selekcji, by dopasować położenie kabiny do zaznaczonych na rysunku linii pomocniczych (Rysunek 2.3.15). (Linie te nanieś na podstawie rzutu z lewej — patrz Rysunek 2.3.10, str.48)
Rysunek 2.3.15 Zmiana skali za pomocą uchwytów obszaru selekcji
Po przeskalowaniu nie zapomnij o wywołaniu Layer→Anchor Layer, by zatwierdzić transformację! Rysunek 2.3.16 pokazuje efekt rozciągnięcia kadłuba. Udało się dopasować do rzutu z lewej linie kabiny i dalsze szwy, w kierunku ogona.
To, co pozostało po tej transformacji, to nieco wysunięte do przodu (w stosunku do wzoru) łączenia blach przed kabiną. Różnice są jednak niezbyt duże. W dodatku położenie tych szwów w rzucie z góry nie wydaje się godne zaufania — nawet nie są pionowe! Wygląda to na niedokładność podczas kreślenia. Po oryginalnych “wgłębieniach” w okolicach łączenia linii skrzydła i kadłuba pozostały teraz przesunięte przerwy (Rysunek 2.3.16). W wykorzystaniu rysunku do naszych celów nie będzie to przeszkadzać. Zapewniam, że to wygląda o wiele lepiej, niż gdybyśmy takich wgłębień w kształcie selekcji nie zrobili.
Rysunek 2.3.16 Efekt trzeciego kroku - kadłub w rzucie z góry jest “dociągnięty” do rzutu z lewej
Mamy więc ostatecznie “wyprostowany” rzut z góry, uzgodniony z rzutem z boku. Na koniec:
usuń wszystkie warstwy pomocnicze, pozostawiając tylko rzut z góry (P40B-JJ-Top.tif);
obróć rysunek o kolejne 90º (Image→Transform→Rotate 90º counter-clockwise);
wymaż “gumką” wszystkie niepotrzebne fragmenty które pozostały ze skanowanego arkusza (Tools→Paint Tools→Eraser);
przełącz tryb barw z powrotem na odcienie szarości (Image→Mode→Grayscale);
Dodatkowo możesz “spłaszczyć” rysunek (poleceniem Image→Flatten Image)3.
Rysunek 2.3.17 pokazuje ostateczną postać rzutu z góry z planów Jacka Jackiewicza. Zapisz go (pod nazwą P40B-JJ-Top.tif).
Rysunek 2.3.17 Ostateczna postać rzutu z góry
W rzutach z góry i z dołu wyszukaj i popraw ewentualne przekoszenia skrzydła i statecznika poziomego (str. 43 - 44).
Duże korekty kształtu (np. całego skrzydła) powodują pojawienie się mniejszych, lokalnych deformacji (str. 50 - 51). Od razu staraj się je przewidzieć, by potem skutecznie wykonać odpowiednie lokalne poprawki.
Porównaj z rzutem z lewej rzuty z góry i z dołu. Sprawdź, czy pozycje elementów kadłuba są na nich takie same (str. 47).
Sprawdź proporcje rysunku, przede wszystkim rozpiętości do długości (por. str. 45 - 47). W miarę możliwości, należy sprawdzić także inne wymiary (jeżeli są znane).4 Wnioski z tej weryfikacji mogą prowadzić do dalszych korekt.
Niektóre z korekt — jak wydłużenie w tej sekcji samego kadłuba, bez skrzydła — wymagają użycia selekcji “przez narysowanie” (str. 50).
Do pracy nad modelem w Blenderze potrzebne są następujące rzuty samolotu (w nawiasach podaję nazwy, jakie nadałem odpowiednim plikom):
widok z lewej (P40B-JJ-Left.tif);
widok z prawej (P40B-JJ-Right.tif);
widok z góry (P40B-JJ-Top.tif);
widok z dołu (P40B-JJ-Bottom.tif);
widok z przodu (P40B-JJ-Front.tif).
Oprócz tego, możesz także przygotować dodatkowo:
widok z tyłu (czasami się przydaje) (P40B-JJ-Rear.tif);
W poprzednich sekcjach pokazałem, jak przygotowywać rzuty w GIMP, uzyskując obrazy 1, 2, 3 (Rysunek 2.4.1). Teraz przygotuj w ten sam sposób pozostałe elementy (4, 5, 6) z powyższego zestawienia. Powinieneś uzyskać ostatecznie sześć rysunków:
Rysunek 2.4.1 Unifikacja rozmiarów i położenia sylwetek “podkładów” dla Blendera
Zwróć uwagę, że odpowiednie wysokości i szerokości (wymiary A i B) poszczególnych rysunków zostały ujednolicone (Rysunek 2.4.1), podobnie jak położenie sylwetki wewnątrz obrazu (wymiary f,g,h). Rysunek 2.4.1 pokazuje rzut z dołu (4) obrócony o 90º w lewo. Ustawiłem go w ten sposób wyłącznie na tej ilustracji. Chciałem w ten sposób pokazać, że długość boku A i odstęp f są takie same, jak na rzucie z boku.
Odpowiednie odległości A, B, f, g, h powinny mieć taką samą długość (mierzoną w pikselach) na każdym z rysunków
Aby takie ujednolicenie uzyskać, ostatnimi krokami, które wykonywałem w GIMP, były:
zmiana rozmiaru obrazu na “standardowy” (czyli taki z wymiarem A, B);
załadowanie, w charakterze wzorca, poprzednio przygotowanego rysunku (do nowej warstwy);
dopasowanie sylwetki na obrazie do rozmiarów i położenia sylwetki — wzorca;
usunięcie warstwy ze wzorcem;
zapisanie sprawdzonego w ten sposób obrazu do pliku.
Ujednolicone wymiary rysunków, które pokazałem na przykładowym zestawieniu (Rysunek 2.4.1), wynoszą: A = 2390px, B = 2827px. Nie są to żadne “magiczne” liczby. Po prostu szerokość pierwszego rysunku — rzutu z lewej — zdeterminowała mi wymiar A. Podobnie szerokość rzutu z góry określiła wymiar B. Położenie osi samolotu względem krawędzi tych rysunków podyktowało mi wymiary f,g,h, do których dopasowałem pozostałe sylwetki.
Ujednolicenie położenia sylwetek względem granic obrazu nie jest konieczne. Jednak narzucenie sobie tej reguły bardzo ułatwi późniejsze pozycjonowanie rysunków jako “podkładów” w Blenderze
Do tej pory pokazywałem wszystkie operacje na przykładzie rysunków Jacka Jackiewicza. Na początku tego rozdziału wspomniałem, że mamy do dyspozycji także drugie plany - opracowane przez Mariusza Łukasika1. W istocie obydwa opracowania nie różnią się specjalnie. Wydaje mi się, że Mariusz Łukasik korzystał w szerokim zakresie z rysunków Jacka Jackiewicza. (Nie ma w tym nic złego, plany są także po to publikowane). Porównując te rysunki, dostrzegłem następujące różnice:
Kadłub na rysunkach M.Ł. jest o ok. 2% dłuższy od rysunków J.J. Wygląda na to, że został proporcjonalnie rozciągnięty wzdłuż osi X.
Rzut z przodu na planach J.J. ma zbyt nisko narysowany kołpak i śmigło, oraz zbyt wąski rozstaw kół. M.Ł. skorygował te błędy. Co prawda z rozstawem kół podwozia nie do końca się udało2. Dodatkowo linie płata w rzucie z tyłu i z przodu na rysunkach M.Ł. nie pokrywają się.
M.Ł zastosował bardziej poprawny obrys steru wysokości. (Na rysunkach J.J. krawędź spływu steru jest zbyt “wypukła”).
Sądzę, że gdy Mariusz Łukasik znalazł na rysunkach Jacka Jackiewicza niewłaściwe proporcje rozpiętości i długości, zdecydował się je poprawić przez wydłużenie kadłuba. (My zmniejszyliśmy skrzydła i stateczniki — por. str. 46). Aby te sylwetki uzgodnić, na planach M.Ł. wydłużyłem rzut z boku i kadłub w rzucie z góry o 2%. Nałożyłem tak przygotowane sylwetki na rysunki J.J. Okazało się, że doskonale do siebie pasują. Można je stosować zupełnie wymiennie! Na przykład - zamierzam wykorzystać rzut z prawej z rysunków M.Ł, gdyż ma “odjęte” skrzydło (Rysunek 2.4.2). (Takiego ujęcia nie ma na rysunkach Jacka Jackiewicza).
Rysunek 2.4.2 Rzut z prawej — z planów Mariusza Łukasika
Rysunki Mariusza Łukasika zostały wykonane za pomocą komputera. Tu już się nie zdarzają “poślizgi linijki”, jak na rysunkach robionych ręcznie. Mają także bardziej jednorodne, wyraźne linie. Przygotowałem drugi zestaw sześciu rzutów na podstawie tych planów. Nadałem tym plikom nazwy zaczynające się od “P40C-ML-”. (Na przykład Rysunek 2.4.2 to P40C-ML-Right.tif).
Z rysunkami, które opracowaliśmy w tym rozdziale, można wykonać model P-40. Czy jednak będzie naprawdę taki, jak oryginał? Jeżeli jesteś modelarzem, a nie tylko grafikiem komputerowym, zapewne będziesz chciał to sprawdzić. Zapraszam do zajrzenia do dodatkowych materiałów, na końcu tej książki (Rozdział 18, “Szczegółowa weryfikacja planów samolotu”, str. 1189). Dla “pobudzenia apetytu” pokazuję rezultat weryfikacji rzutu z boku (Rysunek 2.4.3):
Rysunek 2.4.3 Korekty rzutu z boku, naniesione po dokładnej weryfikacji
Czerwonymi liniami oznaczyłem różnice. Jest ich sporo, nieprawdaż?
Podsumowanie
Warto jest ujednolicić szerokość i wysokość poszczególnych rysunków samolotu (str. 54). Także położenie sylwetki samolotu względem lewego górnego narożnika rysunku powinno być takie samo.
Rysunki można poddać dalszej weryfikacji, polegającej na dokładnym porównaniu kształtu ze zdjęciami (str. 1189). Nie jest to jednak niezbędne.
W tym rozdziale zapoznasz się z Blenderem. Złamałem tu zasadę, przyjętą w tej książce1, i opisuję, jak się nim posługiwać. Zrobiłem tak, gdyż pojęcia i polecenia przedstawione w tym rozdziale są niezbędne do płynnej pracy w Blenderze. Są to podstawy, które będziesz później wykorzystywał na każdym kroku. Nawet nie zauważysz, jak szybko je zapamiętasz.
Aby gdzieś dojść, trzeba wykonać pierwszy krok. Niektórzy mówią, że ten pierwszy jest najtrudniejszy. Na forach internetowych często czytuję głosy „chciałbym się pobawić Blenderem, ale przy pierwszej próbie dałem sobie spokój”. Ja też chciałem się nim pobawić. I szybko się wciągnąłem.
Myślę, że mit o tym, że jest to program trudny, wyolbrzymiają ci, którzy chcieliby się nauczyć wszystkiego od razu. Moi drodzy, tak się nie da. Czasami trzeba ciężko westchnąć i siąść, i przeczytać.2 Na razie nie wymyślono takich pigułek, jak w Matrix-ie – aby połknąć całą książkę i od razu wiedzieć wszystko. Dokonywałem kiedyś studiów porównawczych interfejsu użytkownika różnych systemów 3D. Mogę uczciwie powiedzieć, że Blender ma naprawdę fajny, spójny interfejs. Tyle, że trochę niekonwencjonalny. Zresztą w wersji 2.5 został przepisany od nowa, przez co stał się łatwiejszy. W dalszych sekcjach powolutku wyjaśnię, jakie są te konwencje ekranów Blendera. Gdy je poznasz, przekonasz się, że jest to nie tak trudna do opanowania całość. Wyrabia dobre nawyki – pracy z komputerem „na dwie ręce” (lewa na klawiaturze, prawa na myszce).
Większość tej nauki przeprowadzimy na modelu myśliwca Ła-5. Otworzysz ten plik, obejrzysz jego zawartość, nauczysz się podstawowych metod edycji (transformacji) obiektów. Zrobimy to, przestawiając i obracając kamerę tej sceny. (Tak! Podobnie jak w prawdziwym studio fotograficznym, mamy tu kamery!). W sumie – po przeczytaniu tego rozdziału będziesz już umiał „pozować” model. Na koniec rozdziału wygenerujesz finalną scenę z tym samolotem. (O takim obrazie będę często mówił, że jest wyrenderowany 3.)
W tym rozdziale będziemy wykorzystywać materiały z plików source.zip i la5.zip, towarzyszących tej książce (adres, z którego można je pobrać, znajdziesz na. str. 22)
Rysunek 3.1.1 pokazuje, jak wygląda Twój ekran, gdy po raz pierwszy uruchomisz Blender:
Rysunek 3.1.1 Blender – domyślny wygląd programu
Nie wygląda jak typowa aplikacja Windows, prawda? Przyznam się: gdy miałem zacząć pracować z tą przepisaną od nowa wersją 2.5, to po pierwszym uruchomieniu przez 15 minut siedziałem i po prostu gapiłem się w ekran. Tak wszystko na nim „przemeblowano”, że był dla mnie zupełnie nowy! Nie ruszałem nawet myszką — nie byłem pewien, jak zacząć. Stało się tak, choć przez cztery lata pracowałem w kolejnych wersjach Blendera 2.4, i wcześniej nawet trochę zaglądałem do wersji testowych 2.5. Jednak po tych pierwszych 15 minutach kontemplacji zacząłem od powtórki najprostszych czynności, zajrzenia do kilku samouczków — i jakoś poszło. Mam nadzieję, że pamięć o tym „drugim początku” pomoże mi lepiej napisać to wprowadzenie.
Rozmieszczenie elementów na ekranie Blendera 2.5 lepiej pasuje do nowszych monitorów o proporcji 8x5. (Poprzednie wersje dobrze pasowały do monitorów o starych proporcjach — 4x3). Blender jest napisany dla kilku systemów operacyjnych: Linux, Mac OS, Windows. W każdym z nich wygląda i działa w identyczny sposób1. Siłą rzeczy ten program ma specyficzny styl, który go wyróżnia. Jest to przemyślany interfejs użytkownika. Zacznijmy od omówienia jego podstawowych założeń.
Ekran Blendera jest podzielony na prostokątne obszary. Nazywane są oknami (ang. window, a czasami także ”obszarem”: area)2. W odróżnieniu od typowych systemów „okienkowych”, okna Blendera nigdy się na siebie nie „nakładają". Osobiście uważam to za zaletę, a nie wadę. W edytorach nakładające się okienka dobrze wyglądają jedynie na materiałach reklamowych. Gdy przychodzi do realnej pracy nad projektem, każdy ustawia je sobie tak, aby widzieć wszystkie naraz. Na domyślnym ekranie Blendera widzisz pięć okien3 (Rysunek 3.1.2):
Rysunek 3.1.2 Blender – obszary okien
Okno widoku (View 3D): pokazuje trójwymiarową „scenę”, a na niej model (tutaj: sześcian);
Okno struktury (Outliner): struktura sceny, przedstawiona w postaci symbolicznej;
Okno właściwości (Properties): obszar na wszelkie przyciski, pola numeryczne, przełączniki, za pomocą których zmieniamy właściwości elementów sceny;
Okno informacyjne (Info): menu główne programu oraz miejsce na komunikaty (np. o błędach).
Okno osi czasu (Timeline) (Timeline): potrzebne do animacji;
Granicę każdego z okien Blendera można „złapać” myszką i przesunąć (Rysunek 3.1.3):
Rysunek 3.1.3 Przesuwanie granic okien Blendera
Usuńmy z ekranu niepotrzebne nam obecnie okno Timeline. Można je wyeliminować, łącząc z jednym z sąsiednich obszarów. Umieść kursor na krawędzi okna, która ma zniknąć, i naciśnij PPM. Spowoduje to otwarcie menu Area Options, z którego wybieramy polecenie Join Areas (Rysunek 3.1.4a) :
Rysunek 3.1.4 Scalanie okien na ekranie Blendera
Po wybraniu tego polecenia Blender na bieżąco pokazuje za pomocą strzałki okno, które zostanie wyeliminowane (Rysunek 3.1.4b). Jest to zawsze okno w którym znajduje się kursor myszki.
Okno Blendera, znajdujące się pod kursorem myszy, nazywamy oknem aktywnym. (Spośród innych okien jest sygnalizowane odrobinę jaśniejszym nagłówkiem, ale nie widać tego na ilustracjach).
Kliknięcie LPM kończy operację — powinieneś uzyskać taki ekran, jaki pokazuje Rysunek 3.1.5:
Rysunek 3.1.5 Ekran po scaleniu okna Timeline z oknem 3D View
Dopóki nie wykonasz końcowego kliknięcia, zawsze możesz przerwać łączenie okien naciskając Esc. (W Blenderze naciśnięcie tego klawisza zawsze oznacza rezygnację z aktualnie wykonywanego polecenia).
Analogicznie, do podziału okna możesz użyć polecenia Area Options→Split Area. Można to także zrobić w inny sposób — wykorzystując uchwyt, umieszczony w lewym górnym i prawym dolnym narożniku każdego okna. Wygląda jak „karbowany” trójkąt (Rysunek 3.1.6):
Rysunek 3.1.6 Podział okna Blendera za pomocą uchwytu
„Złap” myszką (LPM) za uchwyt okna i przesuń go do wnętrza obszaru. Gdy przesuniesz go bardziej pionowo — przeciągniesz w dół poziomą granicę nowego okna (Rysunek 3.1.6). Gdy zrobisz to bardziej poziomo — podzielisz okno w pionie.
Nowe okno, uzyskane w wyniku podziału, jest zawsze dokładną kopią okna dzielonego
Uchwyt może także służyć do łączenia okien. Wystarczy go przeciągnąć na obszar, który ma zostać wyeliminowany (Rysunek 3.1.7):
Rysunek 3.1.7 Łączenie okien za pomocą uchwytu
Blender zaznacza takie okno odpowiednią strzałką (Rysunek 3.1.7). Wystarczy zwolnić LPM, by wskazane okno uległo scaleniu.
W ramach ćwiczenia spróbuj za pomocą podziałów uzyskać taki układ ekranu, jaki pokazuje Rysunek 3.1.8:
Rysunek 3.1.8 Zmieniony układ okien Blendera
Zajmijmy się teraz podstawowymi elementami wnętrza pojedynczego okna (Rysunek 3.1.9):
Rysunek 3.1.9 Elementy okna Blendera
Każde okno Blendera ma nagłówek. Na ilustracji umieszczony jest akurat nie u góry, jak sugerowałby jego nazwa, a u dołu. Nagłówek zawiera menu rozwijalne i inne pomocnicze kontrolki.
Z lewej strony nagłówka okna znajduje się lista rozwijalna, z której można wybrać typu edytora. Wybierasz z niej to, co ma być aktualnie wyświetlane. Na przykład — struktura sceny w oknie Outliner (Rysunek 3.1.10):
Rysunek 3.1.10 Zmiana typu (zawartości) okna
Kilka typów edytorów Blendera (3D View, UV/Image Editor, Text Editor) ma także „wysuwany przybornik”, z narzędziami, umieszczony z lewej strony okna. Można go przywołać poleceniem menu (View→Tool Shelf), ale o wiele łatwiej jest po prostu nacisnąć na klawiaturze przycisk T (Rysunek 3.1.11):
Rysunek 3.1.11 Ukrywanie i wysuwanie przybornika z narzędziami (Tool Shelf) za pomocą klawiatury
W podobny sposób możesz wyświetlać/chować umieszczony z prawej strony przybornik właściwości (Properties, np. obiektu lub widoku): za pomocą klawisza N, lub polecenia z menu (Rysunek 3.1.12):
Rysunek 3.1.12 Przybornik z właściwościami — różne metody „wysunięcia” i ukrycia.
Gdy kursor myszki znajduje się ponad nagłówkiem okna, kliknij PPM, by otworzyć menu kontekstowe. W zależności od tego w co kliknąłeś, Blender otworzy mniejsze lub większe menu (Rysunek 3.1.13):
Rysunek 3.1.13 Różne menu kontekstowe kontrolek Blendera
Najwięcej poleceń znajduje się na menu kontekstowym kontrolki (Rysunek 3.1.13c). Polecenie Reset to Default Value może być czasami przydatne, gdy nie wiesz jaka jest ta wartość domyślna. Polecenie Online Manual otwiera odpowiedni fragment instrukcji Blendera (artykuł z wiki.blender.org ), o ile oczywiście masz w tym momencie dostęp do Internetu. Polecenia Edit Source i Edit Translation są przydatne tylko dla programistów lub tłumaczy programu. Krótsza wersja tego menu (Rysunek 3.1.13a) pojawi się, gdy klikniesz PPM w jedno z menu rozwijalnych. W każdym z tych menu znajdziesz przejście do menu Header, sterującego nagłówkiem okna (Rysunek 3.1.13b). Choć w menu a) i c) występuje jako submenu, Blender otwiera je od razu gdy klikniesz PPM gdzieś na „tle” nagłówka okna, omijając wszystkie kontrolki.
Polecenia z menu Header są przydatne przy modyfikowaniu układu ekranu. Jeżeli wywołasz polecenie Header→Flip to Top, nagłówek okna zostanie wyświetlony u góry (Rysunek 3.1.14):
Rysunek 3.1.14 Przesunięcie nagłówka na górę okna
Po przeniesieniu nagłówka do góry okna Blender zmienia jego menu Header. Zastępuje w nim polecenie Flip to Top poleceniem Flip to Bottom. Gdy je wywołasz, nagłówek znajdzie się z powrotem na dole.
Od wersji 2.70 w menu Header znalazł się także przełącznik Collapse Menus. Gdy go włączysz, menu rozwijalne zostanie „ściśnięte” (Rysunek 3.1.15). Może to być przydatne dla węższych okien:
Rysunek 3.1.15 „Zwijanie” menu okna
Kolejne polecenie z menu Header — Maximize Area — służy do rozciągnięcia aktywnego okna na cały ekran Blendera. Wygodniej jest jednak to zrobić za pomocą skrótu klawiatury: Ctrl-↑ (Rysunek 3.1.16):
Rysunek 3.1.16 Przełączanie rozmiaru okna: na cały ekran i z powrotem
Operację odwrotną — zmniejszenie okna do oryginalnego miejsca na ekranie — uzyskasz naciskając Ctrl-↓ (albo wywołując polecenie Header→Tile Area — ale po co tyle klikać?).
Zwróć uwagę, że do tej pory poznaliśmy trzy skróty klawiaturowe Blendera: T, N, i Ctrl-↓ / ↑. Każdemu z nich podałem także odpowiednie polecenie z menu. Która droga wywołania jest lepsza: wybór z menu czy skrót z klawiatury ? Skróty są oczywiście szybsze. Jednak nie warto uczyć się każdego z nich, bo każda ludzka głowa ma skończoną pojemność. (Wiele poradników Blendera koncentruje się właśnie na skrótach. Sądzę, że przez to właśnie program ma opinię trudnego do opanowania). Rzadziej używane polecenia łatwiej jest wybierać z menu. (Bo wystarczy wtedy pamiętać “mniej więcej”, gdzie to polecenie się znajduje). Gdy zauważysz, że niektórych komend używasz bardzo często — zwróć uwagę na prawą stronę ich menu. Jeżeli polecenie ma swój skrót klawiaturowy — jest tam wyświetlany. Opisując ten program, zawsze będę się starał określić, gdzie i w jakim menu jest dostępne omawiane polecenie. W przypadku częściej używanych operacji podam także ich skróty4.
W Blenderze masz dostępnych wiele różnych układów ekranu, abyś nie musiał za każdym razem mozolnie przestawiać granic okien. Służy do tego lista Screen lay-out, umieszczona w nagłówku okna Info (Rysunek 3.1.17):
Rysunek 3.1.17 Wybór jednego z zapamiętanych układów ekranu
To, co zmienialiśmy do tej pory, to układ zapamiętywany pod nazwą Default. Będziesz go używał przez większość czasu pracy nad modelem. Układy UV Editing i Animation przydadzą się później. Przyjrzyj się oknom każdego z tych zestawów (Rysunek 3.1.18):
Rysunek 3.1.18 Inne, predefiniowane układy ekranów: UV Editing i Animation
Oczywiście, to tylko propozycja autorów programu. Możesz je kompletnie pozmieniać. Kontrolka Screen lay-out pozwala użytkownikowi tworzyć kolejne układy ekranu — służy do tego przycisk , umieszczony z prawej strony listy. Tuż obok znajduje się przycisk
, którym możesz usunąć (wymazać z rysunku) aktualny układ ekranów. Więcej na temat tej kontrolki i zarządzania układami ekranów znajdziesz na str. 788.
Edytor konfiguracji programu — User Preferences — możesz otworzyć w każdym z jego okien, bo jest dostępny na liście, tuż powyżej edytora Outliner (por. str. 63, Rysunek 3.1.10). Ja jednak wolę je wywoływać z poleceniem z głównego menu Blendera (File→User Preferences… — Rysunek 3.1.19):
Rysunek 3.1.19 Wywołanie okna konfiguracji programu
U góry okna konfiguracji Blendera można się przełączyć na odpowiednią sekcję (Interface, Editing, Input…) (Rysunek 3.1.20):
Rysunek 3.1.20 Okno konfiguracji (User Preferences)
Szczegółowe omówienie, co warto przestawić w tej konfiguracji znajdziesz na str. 764. Tutaj chciałbym tylko zasygnalizować opcję, która będzie potrzebna już w następnej sekcji. Jeżeli używasz laptopa, który nie ma klawiatury numerycznej — koniecznie w sekcji Input zaznacz opcję Emulate Numpad, jak to pokazuje Rysunek 3.1.20. Następnie zapisz tę zmianę przyciskiem Save User Settings, umieszczonym u dołu, w nagłówku okna.
Począwszy od wersji 2.665 Blender przechowuje konfigurację w specjalnym pliku o nazwie userpref.blend. Ten plik znajduje się w specjalnym folderze z konfiguracją Blendera, w katalogu użytkownika.
Więcej na temat tego, jakie ustawienia co Blender przechowuje w każdym rysunku, a co tylko w pliku konfiguracji, i gdzie dokładnie ten plik jest przechowywany, znajdziesz na str. 764.
Inną ciekawą właściwością Blendera są krótkie podpowiedzi, pojawiające się przy każdym elemencie ekranu. (Aby się tak się działo, w sekcji Interface musi być włączona opcja Tooltips — Rysunek 3.1.21a). Wystarczy wtedy zatrzymać kursor nieco dłużej ponad czymś, czego nie znamy — i zobaczymy podpowiedź (Rysunek 3.1.21b):
Rysunek 3.1.21 Podpowiedzi do każdej kontrolki, widocznej na ekranie
Dolna linia podpowiedzi jest zapisana czymś, co nie jest zrozumiałe dla zwykłego użytkownika: to nazwy tzw. właściwości klas — rzecz tylko dla programistów! Jeżeli ta informacja nie jest Ci potrzebna, możesz wyłączyć opcję Show Python Tooltips (Rysunek 3.1.21a), a znikną.
A swoją drogą — zwróciłeś uwagę, że teraz na monitorze masz dwa ekrany Blendera (Rysunek 3.1.22)?:
Rysunek 3.1.22 Dwa ekrany Blendera
Ten drugi ekran ma takie same właściwości jak pierwszy — możesz zmienić w nim typ edytora (np. na 3D View), możesz go także podzielić na kilka okien. Jeżeli Twój komputer ma dwa monitory, pracujące w trybie tzw. „rozszerzonego pulpitu”6 — możesz na nich rozmieścić ekrany Blendera. Każdy z tych ekranów będzie na bieżąco pokazywał ten sam model (Rysunek 3.1.23):
Rysunek 3.1.23 Jeden z możliwych układów ekranów przy pracy na dwóch monitorach
W praktyce zwiększa to co najmniej dwukrotnie dostępną przestrzeń ekranu, znacznie poprawiając komfort pracy.
Inna metoda otworzenia drugiego ekranu Blendera: W oknie 3D View, menu View, jest polecenie kopiujące je w nowe okno: Duplicate Area into New Window.
Dla porządku, na końcu tego wprowadzenia podaję jak zamknąć program.
Tak, dobrze się domyślasz: jak każdą aplikację Windows, Blender można zakończyć klikając przycisk w prawym górnym narożniku jego okna. Można to także zrobić inaczej: wybierając z menu polecenie File→Quit (Rysunek 3.1.24), lub naciskając na klawiaturze skrót Ctrl-Q.
Po wybraniu polecenia Quit Blender nie ostrzega użytkownika, że aktualny plik zawiera nie zapisane zmiany!
Być może takie zachowanie polecenia Quit wynika z faktu, że w istocie zapisuje ono aktualny stan do specjalnego pliku, który możesz odtworzyć poleceniem File→Recover Last Session. Za to gdy włączysz odpowiednią opcję konfiguracji (por. str. 765), Blender będzie wyświetlał odpowiednie ostrzeżenie podczas zamykania jego okna przyciskiem .
Zwróć także uwagę, że w menu File masz polecenie zapisujące aktualny plik jako „startowy” (Save Startup File). A gdybyś już sam nie wiedział, co pozmieniałeś w konfiguracji, zawsze możesz skorzystać z polecenia Load Factory Settings.
Podsumowanie
Interfejs użytkownika Blendera różni się od innych aplikacji Windows. Jednak „inny” nie znaczy wcale „gorszy” — sam się o tym przekonasz;
Ekran Blendera jest podzielony na obszary (ang. area, używane jest także określenie „okna”). Każdy z nich może zawierać jeden z kilkunastu typów dostępnych edytorów. W Blenderze możesz przesuwać granice tych okien (por. str. 59), ale nie można ich na siebie nałożyć;
Okna Blendera można dzielić i łączyć (wtedy eliminujesz jedno z nich). Możesz użyć do tych operacji poleceń z menu kontekstowego Area Options (str. 60). Ten sam efekt możesz uzyskać przesuwając uchwyty, umieszczone w lewym dolnym i prawym górnym narożniku każdego obszaru (str. 61);
Każde okno Blendera ma nagłówek i obszar roboczy, a niektóre z nich — umieszczone po bokach przyborniki (str. 62);
Pomocnicze okna przyborników można „wsuwać” i „wysuwać” z boków ekranu klawiszami T (narzędzia) i N (właściwości). Jeżeli nie pamiętasz tych skrótów, możesz posłużyć się poleceniami z menu View (str. 63);
Aby zmienić typ edytora (zawartość okna), należy użyć menu rozwijalnego, umieszczonego zawsze z lewej strony nagłówka (str. 63);
Blender posiada wiele gotowych układów ekranu, odpowiednich do różnych etapów prac nad modelem czy animacją (str. 66). Każdy z tych układów możesz zmodyfikować. Możesz także stworzyć własny układ;
Oknem aktywnym nazywamy w Blenderze okno, w którym obecnie znajduje się kursor myszki (por. str. 60).
Aktywne okno można powiększyć na cały ekran skrótem klawiatury Ctrl-↑; Powtórne naciśnięcie tych klawiszy powoduje powrót do oryginalnego układu ekranu (str. 65);
Okna Blendera mogą być wyświetlane na wielu ekranach. Gdy masz do dyspozycji dwa monitory, możesz wykorzystać ich całą powierzchnię (str. 69). Większa przestrzeń ekranu bardzo ułatwia pracę!
Okno konfiguracji programu najwygodniej jest otworzyć poleceniem File→User Preferences (str. 67).
Aby zachować zmiany w konfiguracji na stałe (tzn. tak, by obowiązywały przy następnym uruchomieniu programu), należy użyć przycisku User Preferences:Save User Settings (str. 68). Blender przechowuje swoją konfigurację w specjalnym pliku o nazwie userpref.blend. (Więcej na ten temat — patrz str. 764);
Podczas zamykania programu poleceniem File→Quit Blender nie ostrzega użytkownika, że aktualny plik posiada nie zapisane zmiany. Zamiast tego zapisuje jego aktualny stan do tymczasowego pliku, którego zawartość można otworzyć poleceniem File→Recover Last Session (str. 69). Zwróć jednak uwagę, że możesz w ten sposób odtworzyć tylko stan z końca ostatniej (Last) sesji, którą zamknąłeś poleceniem Quit!
Jak długo można podziwiać na ekranie domyślne „pudełko” Blendera, przewijające się przez ilustracje w poprzedniej sekcji? Wczytajmy jakiś bardziej interesujący model!
Najpierw otwórz (File→Open — szczegóły znajdziesz na. str. 759) spakowany w source.zip (por. str. 22) plik source\config\startup.blend z konfiguracją Blendera, którą przygotowałem dla tej książki. Aby ją zapisać, w oknie User Preferences naciśnij przycisk Save User Settings, a potem wywołaj File→Save Startup File (szczegóły — str. 764). Zmienisz w ten sposób m.in. kolorystykę ekranu na taką, jaką wykorzystuję w dalszym tekście. Następnie otwórz rysunek model\la5\la5.blend. (Znajdziesz go w pliku la5.zip, towarzyszącym tej książce). Rysunek 3.2.1 pokazuje, jak powinien wyglądać rezultat. Tym Ła-5F posłużymy w dalszej części tego rozdziału, byś mógł pracować na jakimś prawdziwym modelu.
Rysunek 3.2.1 Załadowany plik z modelem myśliwca Ła-5F (nowa kolorystyka ekranu pochodzi z pliku startup.blend)
Mamy wczytany model, czas pomówić o tym, jak obejrzeć go dokładniej. Zaczniemy od szybkiego powiększenia jednego z okien (Rysunek 3.2.2):
Rysunek 3.2.2 Wywołanie powiększenia aktywnego okna
Pamiętasz z poprzedniej sekcji? Ustaw kursor myszy wewnątrz jednego z okien 3D View (Rysunek 3.2.2). Naciśnij kombinację klawiszy Ctrl - ↑. Spowoduje to rozciągnięcie aktywnego okna na cały ekran. (Wolę to polecenie przypomnieć, bo będziesz je często wykorzystywał — podczas modelownia ekranu zawsze brakuje!).
Teraz zobaczysz model o wiele dokładniej (Rysunek 3.2.3):
Rysunek 3.2.3 Powiększone okno aktywne
Naciśnięcie Ctrl - ↓ (albo przycisku Back to Previous w nagłówku okna Info) powoduje pomniejszenie okna do poprzedniego rozmiaru. Pozostańmy jednak na razie z tym powiększonym widokiem z boku.
Załadowany model składa się z wielu niewielkich ścian. Można to odczytać na informacji o stanie, w prawej części nagłówka okna Info (Rysunek 3.2.3). Te informacje widać teraz lepiej, gdyż w trybie powiększenia pojedynczego okna znikają listy układów ekranu i scen (porównaj: Rysunek 3.2.3 i Rysunek 3.2.1). Co oznaczają dokładnie skróty i liczby, wyświetlone na ekranie? Już wyjaśniam:
v2.70.5 : to numer wersji Blendera (w tym przypadku: Blender 2.70, edycja 5);
Verts: liczba wierzchołków (vertices), użytych w modelu widocznym w aktywnym oknie widoku. Ten samolot składa się z 446 319 wierzchołków. Jest to stosunkowo duży model;
Faces: liczba elementarnych ścian, użytych w modelu widocznym w aktywnym oknie widoku. Załadowany samolot składa się z 436 176 ścian;
Tris: liczba elementarnych trójkątów, użytych w ścianach modelu. Zazwyczaj każda elementarna czworokątna ściana (face) składa się z dwóch elementarnych trójkątów. Jeżeli elementarna ściana ma więcej niż 4 boki (zdarzają się takie) wówczas jest zbudowana z więcej niż 2 trójkatów;
Objects: liczba wybranych obiektów, oraz (po kresce) wszystkich widocznych obiektów. W przypadku tego samolotu jest ich aktualnie 357, przy czym żaden nie jest wybrany („0”);
Lamps: liczba „lamp” (źródeł światła) — wybranych/aktualnie widocznych na scenie;
Mem: ilość użytej przez program ciągłej pamięci RAM1. W tym przypadku – nieco ponad 347 MB. Na pewno ta wartość powinna być mniejsza od rozmiaru pamięci RAM fizycznie dostępnej na Twoim komputerze. Jeżeli używasz 32-bitowej wersji Blendera, musisz pamiętać o innym ograniczeniu: w systemie Windows 32-bitowa aplikacja może co najwyżej uzyskać dostęp do 1.3 GB RAM, niezależnie od tego jaka ilość jest zainstalowana. W innych systemach (Linux, OSX) wygląda to podobnie. Właśnie aby takie ograniczenia przezwyciężyć powstały systemy i aplikacje 64-bitowe;
012.Body: nazwa tzw. aktywnego obiektu (por. str. 83, Rysunek 3.3.3);
Obawiam się, że Blender z tym modelem Ła-5 może wolno odświeżać okna widoku na komputerach wielu z Czytelników. Aby temu zaradzić, proponuję ukryć niektóre warstwy, jak pokazuje to Rysunek 3.2.4:
Rysunek 3.2.4 “Odchudzony” widok La-5 - część obiektów jest na niewidocznych warstwach
Klikając LPM w „komórki” kontrolki obsługi warstw (p. Rysunek 3.2.4), włączamy lub wyłączamy ich widoczność (jasne = niewidoczne). Koniecznie rób to trzymając wciśnięty klawisz Shift. Jeżeli o tym zapomnisz, kliknięcie w jakąś warstwę wyłączy widoczność wszystkich pozostałych2.
Co to właściwie są warstwy (layers) w takim programie jak Blender? Ich nazwa pochodzi z systemów 2D. Spotkałeś je już w Gimpie (np. w sekcji 2.3). W programach 3D warstwy straciły swoją analogię do powierzchni, które można nakładać jedna na drugą3. Pozostały w roli grup obiektów, które można szybko ukryć lub pokazać. Stosuję je bardzo często, umieszczając na różnych warstwach różne elementy samolotu. Zazwyczaj podczas formowania nowego fragmentu pracuję na jednej – dwóch warstwach, na których mam wszystko, co potrzebne. Na przykład – modelując owiewkę pomiędzy skrzydłem i kadłubem, mam włączone tylko 3 warstwy: skrzydła, kadłuba, i samej owiewki. (Czyli to, co zmieniam, i to, do czego mam się dopasować).
Blender oferuje nam do wykorzystania 20 warstw. Traktuj je jak „segregatory”, w które możesz wkładać obiekty tak, jak Ci wygodnie (a jak – opiszę dalej na str. 277)4.
Czas pooglądać nasz model z różnych stron. Naciśnij klawisz numeryczny 1 (lub wybierz z menu polecenie: View→Front). Zobaczysz samolot z przodu (Rysunek 3.2.5):
Rysunek 3.2.5 Widok z przodu (ZX) - efekt naciśnięcia klawisza 1
Gdy naciśniesz na klawiaturze numerycznej klawisz 3 (z menu: View→Left) — zobaczysz widok z lewej (ZY — Rysunek 3.2.4). Gdy naciśniesz klawisz numeryczny 7 (z menu: View→Top) — zobaczysz widok z góry (XY — Rysunek 3.2.6):
Rysunek 3.2.6 Widok z góry (XY) - efekt naciśnięcia klawisza 7
Aby zobaczyć model ze strony przeciwnej (prawej, spodu, tyłu) użyj tych samych klawiszy skrótów, ale dodatkowo trzymaj wciśnięty Ctrl:
Rysunek 3.2.6 nie obejmuje całego samolotu. Aby zmienić powiększenie, naciśnij dwa – trzy razy na klawiaturze numerycznej przycisk - (View→Navigation→Zoom In) :
Rysunek 3.2.7 Zmiana powiększenia
Analogicznie, naciśnięcie klawisza +(View→View Navigation→Zoom Out) powiększa obraz. Naciśnięcie Home – przełącza na takie powiększenie, że na ekranie widoczne są wszystkie obiekty.
Powiększenie można także zmieniać za pomocą myszki. Zgrubnie (skokowo) — obracając kółko KM. (Odpowiada to dokładnie naciśnięciom klawiszy +/-). Dokładnie (płynnie) — trzymając wciśnięte: klawisz Ctrl i SPM przesuwaj myszkę do góry lub do dołu.
A jak przesunąć widok w bok? Zgrubnie – klawisze Ctrl-8 lub Ctrl-2 (góra lub dół), Ctrl-4 lubCtrl-6 (lewo lub prawo). To można zapamiętać – zwróć uwagę, że na klawiaturze numerycznej klawisze 8, 6, 2 i 4 mają nawet narysowane odpowiednie strzałki! Mówiąc jednak szczerze — zawsze używam tego celu myszki. Trzymając wciśnięty klawisz Shift i SPM przesuwam myszką, a ekran podąża za tym ruchem5 (Rysunek 3.2.8):
Rysunek 3.2.8 Przesuwanie obrazu
Wreszcie – obracanie. Naciskamy SPM i przesuwamy myszkę w oknie 3D View. Model zaczyna się obracać. Popatrz na Rysunek 3.2.9 – narysowałem tam zasady, obowiązujące przy obrotach:
Rysunek 3.2.9 Obracanie widoku — różne osie obrotu w zależności od położenia kursora myszy
W Blenderze rodzaj obrotu widoku zależy od miejsca, w którym znajduje się kursor myszy. Gdy przesuwasz go po obszarach bliskich krawędzi okna — wywołuje to obrót wokół osi prostopadłej do płaszczyzny ekranu. Gdy przesuwasz kursor w centrum okna — następuje obrót po wyimaginowanej kuli, w środku której znajduje się aktywny obiekt. Przesunięcie poziome powoduje wzdłuż jej „równoleżnika”, a przesuniecie pionowe — wzdłuż „południka”.
Brzmi to trochę skomplikowanie, ale proponuję potrenować obroty przez chwilę lub dwie, aby „wyczuć” jak to działa. W praktyce obrót co chwilę przeplata się przesunięciem obrazu (Shift–SPM, patrz Rysunek 3.2.8), gdyż zdarza się, że obracany model „ucieka” z pola widzenia.
Popatrzmy krytycznie na Rysunek 3.2.10. Czy ten samolot jest proporcjonalny? Bliższe skrzydło wydaje się być mniejsze od dalszego... Nic dziwnego, oglądamy widok w projekcji aksonometrycznej! (To taka projekcja, gdzie dwie równoległe linie w przestrzeni są także równoległe).
Fotografie przyzwyczaiły nas do projekcji perspektywicznej — więc włączmy ją. Naciśnij klawisz 5 (View→Persp/Ortho — Rysunek 3.2.11):
Rysunek 3.2.11 Włączona perspektywa - silny efekt “rybiego oka”
Uff, wygląda na to, że zniekształcenie perspektywiczne jest zbyt silne (Rysunek 3.2.11) – tak wygląda samolot przez obiektyw baaardzo szerokokątny! Czy można coś z tym zrobić?
Oczywiście! Naciśnij N lub wybierz polecenie View→Properties, by otworzyć przybornik po prawej stronie okna (Rysunek 3.2.12a). Jeżeli kontrolki w tym oknie wydają się Ci jakieś dziwne – zerknij na str. 99, tam są opisane.
Rysunek 3.2.12 Przybornik Properties i jego panel View
U góry przybornika znajduje się obecnie sekcja (panel) Transform, z właściwościami tzw. aktywnego obiektu (o tym, co to jest „obiekt aktywny” dowiesz się w następnej sekcji). To nie jest to, czego w tej chwili potrzebujemy. Poniżej są jednak inne, niewidoczne w tej chwili kontrolki. Przesuń suwak przybornika tak, by zobaczyć niewidoczną przy otwarciu panel View (Rysunek 3.2.12b). (W razie potrzeby możesz zmienić kolejność paneli w przyborniku, na przykład tak, by View wyświetlała się jako pierwsza — por. str. 96).
W panelu View widzisz właściwości projekcji widoku. Zmień jego wartość Lens (ogniskowa) z 35 jednostek do 70. (Pole Lens to pole numeryczne – w razie wątpliwości, jak się nim posługiwać zerknij na str. 101). Widać zmianę, tylko że teraz samolot stał się zbyt bliski, i ekran obejmuje tylko jego fragment. Oddalmy się trochę – klawiszem - lub obrotem KM. Ostateczny efekt pokazuje Rysunek 3.2.13:
Rysunek 3.2.13 Widok perspektywiczny — skorygowana ogniskowa
Na powierzchni modelu pojawiły się „przebicia” powierzchni wewnętrznych, które w realnym świecie leżałyby 1-2mm poniżej. (To grubość blachy lub sklejki poszycia). Nie było ich widać w projekcji aksonometrycznej, a także znikają przy zbliżaniu się kamery do obiektu. Są jednak bardzo brzydkie. Jak się ich pozbyć?
Okazuje się, że wystarczy w zmienić inną właściwość na panelu View: zwiększ Clip:Start np. na 0.1, aby te wszystkie przebicia zniknęły (Rysunek 3.2.14):
Rysunek 3.2.14 Widok perspektywiczny — zwiększona wartość Clip:Start
(Poprzednio była wpisana wartość Clip:Start była dziesięć razy mniejsza — por. Rysunek 3.2.13).
Jeżeli chciałbyś z powrotem przełączyć się na projekcję aksonometryczną – naciśnij jeszcze raz 5 (ten przycisk działa jak przełącznik). Możesz także wybrać z menu: View→Persp/Ortho.
W widoku perspektywicznym możesz się spotkać ze zjawiskiem, które nazywam „niewidzialną ścianą”. Aby przekonać się o czym mówię, spróbuj np. powiększyć fragment zawierający kabinę pilota (Rysunek 3.2.15):
Rysunek 3.2.15 Efekt „niewidzialnej ściany” podczas powiększania w widoku perspektywicznym
Ustaw ten fragment w środku okna 3D View i zacznij obracać do przodu KM (Rysunek 3.2.15a). Początkowo będziesz miał wrażenie jakbyś zbliżał się szybko do modelu. Stopniowo jednak ruch staje się coraz bardziej powolny. Ostatecznie osiągniesz takie zbliżenie, w którym mimo dalszego obracania KM nic już się nie będzie zmieniać (Rysunek 3.2.15c). W dodatku w tym powiększeniu przestało także działać przesuwanie obrazu na boki (Shift-SPM)!
Co to za dziwny efekt? No cóż, widok w projekcji perspektywicznej koncentruje się na swoim „fouksie” — punkcie umieszczonym w pewnej odległości od płaszczyzny ekranu. Powiększenie w widoku perspektywicznym oznacza zmniejszenie odległości od tego punktu (Rysunek 3.2.16):
Rysunek 3.2.16 Przyczyny blokady powiększania w widoku prespektywicznym
Gdy obrócisz KM do przodu (lub naciśniesz + na klawiaturze numerycznej) Blender zmniejsza odległość obserwatora od fokusa o 1 / 6 aktualnego dystansu. Oznacza to, że im bliżej jesteś tego punktu, tym wolniej będziesz się poruszał, aż wreszcie utkniesz w odległości bliskiej zera. I to właśnie pokazuje Rysunek 3.2.15. Niestety, w Blenderze nie masz bezpośredniej możliwości przesunięcia fokusa w nowe miejsce!
Na szczęście możemy przesunąć fokus w sposób pośredni. Gdy napotkasz podczas powiększania „niewidzialną ścianę”, cofnij się trochę (tzn. zmniejsz powiększenie) tak, by zwiększyć z powrotem bieżącą odległość od fokusa. Gdy stwierdzisz, że znów możesz wygodnie przesuwać ekranem do góry i na boki, naciśnij Shift-F (View→Navigation→Walk Navigation — Rysunek 3.2.17a):
Rysunek 3.2.17 Wykorzystanie polecenia Walk Navigation do przesunięcia kamery wraz z fokusem
W tym trybie możesz poruszać się po scenie Blendera jak w grach: klawiszem W do przodu, S do tyłu, A w lewo, D w prawo, a myszką zmieniasz kierunek w którym patrzysz. W centrum ekranu pojawią niewielki „celownik”. Aby zbliżyć się do obiektu w kierunku prostopadłym do ekranu, trzymaj wciśnięty klawisz W. (Aby przyśpieszyć ruch, możesz kilka razy obrócić KM do przodu). Gdy zbliżysz się już na tyle, ile potrzeba — kliknij LPM, by zakończyć tę operację (potwierdzić zmianę projekcji). Jeżeli coś pójdzie nie tak — zawsze możesz nacisnąć Esc, by z niej zrezygnować. Polecenie Walk Navigation przesuwa widok wraz z fokusem, dzięki czemu jest najszybszą metodą pokonania efektu „niewidzialnej ściany”. (Dlatego przed jego wywołaniem musisz się trochę cofnąć — by dysponować odpowiednim dystansem po zakończeniu operacji).
Wszystkie omówione w tej sekcji polecenia znajdziesz w submenu View→Navigationokna widoku. Jeżeli początkowo nie będziesz pamiętał jakiegoś klawisza skrótu — użyj go jak podpowiedzi (Rysunek 3.2.18):
Rysunek 3.2.18 Menu View okna widoku
Duży model jest podzielony pomiędzy różne warstwy. Zmieniając widoczność warstw, możesz wybierać te elementy, z którymi chcesz w tym momencie pracować (str. 73);
Do szybkiego przywołanie podstawowych widoków ortogonalnych służą klawisze: 1 (przód), 3 (bok), 7 (góra). Aby zobaczyć obiekt z kierunku przeciwnego – należy dodatkowo nacisnąć Ctrl. Czyli: Ctrl-1 (tył), Ctrl-3 (prawy bok), Ctrl-7 (dół) (str. 74)
Obrót wokół modelu: przesunięcie myszki z wciśniętym przyciskiem środkowym SPM (str. 76)
Przesuwanie ekranu: przesunięcie myszki z wciśniętym SPM i Shift (str. 75);
Powiększenie lub pomniejszenie: przesunięcie myszki do góry lub dołu z wciśniętym SPM i Ctrl (str. 75);
Przełączenie pomiędzy widokiem perspektywicznym i aksonometrycznym: 5 (str. 77);
Parametry widoku (np. ogniskową) możesz zmieniać w przyborniku Properties (N), panel View (str. 78);
Podczas powiększania fragmentu modelu w trybie perspektywicznym możesz natknąć się na efekt „niewidzialnej ściany” (str. 79). Aby go przezwyciężyć, użyj do powiększenia obrazu polecenia Fly Navigation (Shift-F, str. 80).
W poprzednim paragrafie nie powiedzieliśmy jeszcze wszystkiego o możliwych sposobach oglądania modelu. Aby się o tym przekonać, naciśnij klawisz 0 (View→Camera):
Rysunek 3.3.1 Widok z kamery
To, co widzimy powyżej (Rysunek 3.3.1), to widok z kamery. Jest to projekcja, jaką Blender użyje do stworzenia ostatecznego obrazka lub animacji.
A co to są same kamery? To pewien rodzaj obiektu, który możesz wstawić w scenę. W tej umieściłem dwie kamery. Naciśnij 1 i zmień nieco powiększenie, aby je zobaczyć (Rysunek 3.3.2):
Rysunek 3.3.2 Dwie kamery w scenie z Ła-5
Kamery można przesuwać — zupełnie tak, jak w rzeczywistym studio. Nim do tego przejdziemy (str. 86), nauczymy się zaznaczać obiekty. Od tego zaczyna się w Blenderze każda operacja. Kliknij w prawą kamerę PPM. Powinna się podświetlić (Rysunek 3.3.3):
Rysunek 3.3.3 Zaznaczony obiekt – kamera
Zaznaczony obiekt zmienił kolor na bladoróżowy. Tak właśnie w Blenderze zaznacza się pojedynczy element. Jednocześnie w lewym dolnym narożniku okna została wyświetlona jego nazwa. Ta nazwa jest nazwą aktualnego obiektu aktywnego. Obiekt aktywny to obiekt, który ostatnio został zaznaczony przez kliknięcie myszką.
Naciśnij teraz A (Select→Select/Deselect All), aby wyłączyć selekcję. (To polecenie „czyści” listę wybranych obiektów, gdy coś jest wybrane, lub zaznacza wszystko, gdy nic nie było zaznaczone). Zwróć uwagę, że nazwa obiektu aktywnego pozostanie na ekranie (Rysunek 3.3.4):
Rysunek 3.3.4 Ten sam obiekt wciąż aktywny - mimo, że wyłączyliśmy zaznaczenie
Zawsze warto zwracać uwagę, jaki jest aktualny obiekt aktywny. Zobaczysz później, że Blender zawsze traktuje taki obiekt w sposób szczególny.
Aby po kolei dołączać obiekty do grupy wybranych, wystarczy podczas klikania PPM trzymać wciśnięty klawisz Shift. Aby lepiej „wyczuć”, jak to działa, proponuję, abyś wykonał kilka szybkich doświadczeń.
Zacznij od sytuacji, gdy nic nie jest zaznaczone. Trzymaj wciśnięty klawisz Shift i wykonuj po kolei operacje, które wylicza Tabela 3.3.1. (Przypisania nazw do kamer znajdziesz na str. 82, Rysunek 3.3.2). :
| Trzymając wciśnięty Shift: | Rezultat | |
| Obiekty wybrane i ich kolory | Obiekt aktywny | |
| Kliknij PPM w obiekt Camera.Static | Camera.Static (bladoróżowy) | Camera.Static |
| Kliknij PPM w obiekt Camera.Tracked | Camera.Static (różowy) Camera.Tracked (bladoróżowy) | Camera.Tracked |
| Kliknij PPM w obiekt Camera.Static | Camera.Static (bladoróżowy) Camera.Tracked (różowy) | Camera.Static |
| Kliknij PPM w obiekt Camera.Static | Camera.Tracked (różowy) | Camera.Static |
Tabela 3.3.1 Obiekty wybrane a obiekt aktywny - kilka doświadczeń z operacjami grupowymi
Nie będę pokazywał rezultatów operacji, jakie podaje Tabela 3.3.1, na oddzielnych ilustracjach. To ułomność poligrafii, że nie pokazuje delikatnej różnicy pomiędzy dwoma barwami zaznaczeń: bladoróżową (obiekt aktywny) i różową (pozostałe obiekty wybrane). Wnioski z wykonanego doświadczenia:
Modyfikator w postaci klawisza Shift służy nie tylko do włączania, ale i wyłączania obiektu spośród wyboru. (Gdy klikniesz w obiekt powtórnie, stanie się obiektem aktywnym, a gdy klikniesz jeszcze raz – przestanie być wybranym);
Obiekt aktywny nie musi być w ogóle obiektem wybranym (patrz Tabela 3.3.1, ostatni wiersz);
Możliwe jest także zaznaczanie grupy obiektów obszarem prostokątnym. Naciśnij na klawiaturze klawisz B (Select→Border Select). Przy kursorze myszy pojawią się dwie kreskowane linie. Przesuń kursor w miejsce, gdzie chciałbyś umieścić jeden z narożników obszaru. Naciśnij lewy klawisz myszki LPM, i nie zwalniaj. Na ekranie pojawi się prostokątny obszar (por. Rysunek 3.3.5). Nieruchomy narożnik tego obszaru jest w miejscu, w którym wcisnąłeś LPM. Ruchomy narożnik podąża za ruchem myszki. Gdy ustawisz właściwy obszar, zwolnij LPM. Zaznaczeniu ulegają wszystkie obiekty, które znalazły się wewnątrz obszaru, lub przecięły jego krawędź. Zaznaczenie obszarem nie zmienia aktualnego obiektu aktywnego.
Rysunek 3.3.5 Zaznaczenie obszarem (Border Select)
Aby wykluczyć z zaznaczenia objęte obszarem przedmioty, po naciśnięciu B użyj SPM (zamiast LPM).
Menu selekcji zawiera jeszcze kilka innych możliwości wyboru, m. in. wybór wg warstw, lub typu obiektu (Rysunek 3.3.6):
Rysunek 3.3.6 Przykład innych możliwości wyboru, dostępnych z menu Select.
Na str. 884 znajdziesz opis kilku innych przydatnych metod selekcji obiektów.
Podsumowanie
Aby zobaczyć podgląd widoku z kamery – naciśnij klawisz 0 (View→Camera) (str. 82);
Zaznaczanie obiektu – kliknięcie PPM. Z wciśniętym dodatkowo Shift – dołącza obiekt do wybranych poprzednio (str. 83);
Zaznaczanie grupy obiektów prostokątnym obszarem – naciśnij B (lub Select→Border Select). Potem wciśnij LPM w jednym narożniku i przeciągnij kursor z wciśniętym LPM do przeciwległego narożnika obszaru. Wykluczenie z zaznaczenia prostokątnym obszarem — zaczynasz tak samo (B), tylko zamiast LPM używasz SPM (str. 84);
Blender wyróżnia, oprócz zaznaczenia, obiekt ostatnio „kliknięty” PPM. Taki obiekt jest nazywany aktywnym, a jego nazwa pojawia się w lewym dolnym narożniku okna (str. 83);
Zaczniemy od przesunięcia kamery (to też obiekt). Wcześniej jednak:
upewnij się, że po zaznaczaniu kamery, w lewym dolnym narożniku okna pojawiła się nazwa Camera.Tracked. Jest to kamera, którą przesuniemy;
naciśnij Ctrl – ↓ (Area Options→Tile Window), by powrócić do układu wielu okien. W jednym z nich ustaw widok kamery, a w drugim – widok z przodu (por. Rysunek 3.4.1). W ten sposób będziemy w stanie obserwować obraz z kamery:
Rysunek 3.4.1 Proponowany układ ekranu
Naciśnij klawisz G (Object→Transform→Grab/Move). Od tej chwili każdy ruch myszką powoduje przemieszczenie kamery. Zwróć uwagę, że zmienia się także projekcja w oknie kamery (Rysunek 3.4.2):
Rysunek 3.4.2 Przemieszczanie obiektu
Podczas przesuwania Blender pokazuje w nagłówku aktywnego okna zmianę współrzędnych X,Y,Z, oraz zmianę odległości (w nawiasie) od oryginalnego położenia obiektu. Kliknięciem LPM kończysz tę operację, zatwierdzając nowe położenie. (W razie czego: naciśnięcie Esc także ją kończy, anulując przesunięcie).
Jak to się stało, że podczas przesuwania kamera nie straciła samolotu z centrum widzenia? Otóż ten obiekt ma włączony tryb „śledzenia” (ang. track). W dalszej części tej książki opiszę, jak tworzyć takie powiązanie. Teraz chciałbym zademonstrować, co właściwe śledzi kamera.
Abym mógł pokazać ten obiekt, musimy wyłączyć pewne warstwy, i włączyć inne. Ale gdzie się podziała kontrolka z warstwami? Każde z okienek widoków jest na tyle wąskie, że ukryła się gdzieś za krawędzią ekranu (por. Rysunek 3.4.1)!
Mały sekret: w Blenderze możesz przesuwać zawartość nagłówków okien, jak gdyby były płaskim rysunkiem. Ustaw kursor ponad tym, który chcesz przesunąć, i wciśnij SPM. Trzymając wciśnięty klawisz, przesuwaj kursor. Widzisz, że cały nagłówek się porusza? Przesuń go w lewo, abyśmy zobaczyli kontrolkę z warstwami (Rysunek 3.4.3).
Teraz wyłącz warstwę 11 i włącz 10. Ach, prawda, muszę wprowadzić pojęcie numeracji warstw! Aby w dalszym tekście nie tłumaczyć długo i zawile, o jaką warstwę chodzi, na potrzeby tej książki przypisałem warstwom numery:
Rysunek 3.4.4 Numeracja warstw – konwencja przyjęta na potrzeby tej książki
Tak więc wyłączenie warstwy 11 i włączenie 10 oznacza uzyskanie dla tego modelu następującego układu: . Wraz z warstwą 11 została ukryta środkowa i tylna część kadłuba, oraz skrzydła. Warstwa 10 jest jedną z dwóch warstw zawierających obiekty „sterujące”, nie przeznaczone do pokazywania na ostatecznym obrazie. (Drugą taką warstwą w tym modelu jest warstwa 9). Teraz miejsce niewidocznych skrzydeł na naszym modelu wyznaczają sloty, klapy i lotki, a usterzenia – stery kierunku i wysokości (Rysunek 3.4.5):
Rysunek 3.4.5 Obiekt Camera.Target- cel naszej kamery
Gdzieś w okolicy kabiny pilota znajduje się stosunkowo duży, czerwony walec. Nazywa się Camera.Target. Zaznacz go (por. Rysunek 3.4.5).
Powiedzmy, że chcielibyśmy, aby punkt, na który „patrzy” kamera znajdował się w okolicy silnika, a nie kabiny pilota. W tym celu należy przesunąć obiekt Camera.Target wzdłuż osi Y. Jest to możliwe w każdym widoku, nawet perspektywicznym (jak widok z kamery).
Naciśnij znów klawisz G, aby rozpocząć przesuwanie. Zaraz potem naciśnij Y – oznacza to, że ograniczamy przesunięcie tylko do tej osi. Oś Y stała się biała, i zmienił się tekst u dołu okna – pokazuje wyłącznie zmianę odległości wzdłuż tej osi. Teraz, wraz z każdym przesunięciem myszki, obiekt „jeździ” po osi Y jak po drucie (Rysunek 3.4.6).
Rysunek 3.4.6 Przesuwanie obiektu wzdłuż osi Y
Jak widać, kamera przez cały czas „trzyma” Camera.Targetw centrum obrazu. Nie kończ jeszcze przesunięcia. Pokażę teraz inny efekt: w czasie ruchu myszki naciśnij, i trzymaj wciśnięty, klawisz Ctrl. Wykonaj stosunkowo daleki ruch. Zobaczysz, że przesunięcie następuje teraz skokowo, co 10 jednostek (Rysunek 3.4.7):
Rysunek 3.4.7 Przesunięcie skokowe (wciśnięty klawisz Ctrl)
Warto zapamiętać: klawisz Ctrl podczas każdej transformacji (przesunięcia, obrotu, zmiany skali) wymusza skokowe zmiany, o jakieś „zaokrąglone” wartości.
(To, że pokazuję działanie klawisza Ctrl akurat na przesuwaniu wzdłuż osi Y to przypadek. Możesz go używać w każdej transformacji).
Dlaczego rozmiar „skoku” dla przesunięcia w oknie kamery wynosił akurat 10 jednostek? To zależy od dwóch czynników: aktualnego powiększenia, oraz projekcji. Przerwij aktualne przesunięcie (Esc) i zacznij je jeszcze raz, ale w oknie z widokiem z boku (lewe dolne - por. Rysunek 3.4.7). Gdy będziesz trzymał wciśnięty klawisz Ctrl, obiekt będzie się przemieszczał co 5 jednostek — dwa razy mniej, niż w przypadku widoku perspektywicznego. To jakaś ogólna zasada — w oknach z projekcją „prostopadłą” (z góry, z boku, z przodu..), te odległości są najmniejsze. Wynoszą mniej więcej tyle, ile odległości pomiędzy węzłami pomocniczej siatki, którą widać na ekranie. Gdy powiększymy obraz, siatka robi się coraz gęstsza. Odpowiednio maleje skok, jaki uzyskujemy w czasie przesunięć z klawiszem Ctrl — z 5 jednostek do 1.
A teraz inny efekt: podczas przesuwania obiektu trzymaj wciśnięty klawisz Shift. Co się dzieje? Ten sam ruch myszki wywołuje mniejsze przesunięcia!
Warto zapamiętać: klawisz Shift podczas każdej transformacji (przesunięcia, obrotu, zmiany skali) zwiększa „przełożenie” ruchu myszki. (Większe ruchy myszką odpowiadają mniejszym przesunięciom na ekranie). Ułatwia to dokładniejsze ustalanie końcowej pozycji
A gdy wciśniesz jednocześnie Ctrl i Shift? Uzyskujemy nadal skokowe przesunięcia, ale o jednostki o rząd mniejsze. W widoku perspektywicznym kamery przesunięcie z samym Ctrl zmieniało położenie obiektu co 10 jednostek, a z wciśniętym Shift-Ctrl – co 1 jednostkę.
Obrót obiektu chciałbym pokazać w oknie z widokiem z boku. Tylko jest mały problem – obracany obiekt jest zasłonięty przez klapę. Powiedzmy, że nie chcę wyłączać widoczności warstwy, która zawiera ten element, bo przestałbym widzieć zarys skrzydła. Zamiast tego zmienię sposób rysowania zawartości tego okna na liniowy (ang. wireframe). Służy do tego lista rozwijalna Viewport Shading w nagłówku każdego okna 3D View (Rysunek 3.4.8):
Rysunek 3.4.8 Wybór sposobu rysowania (Viewport shading) zawartości okna
Rysunek 3.4.9 pokazuje, jak wygląda rezultat przełączenia. Jak widać, sposób rysowania można ustalać niezależnie dla każdego okna. (Pozostałe są nadal w trybie Solid).
W praktyce tryby Solid i Wireframe wykorzystuje się najczęściej. O trzecim sposobie cieniowania (Textured) opowiem przy okazji pracy z teksturami.
Jak się obraca obiekt? Bardzo podobnie do przesuwania: naciskasz klawisz R (Object→Transform→Rotate), i zaczynasz obrót (Rysunek 3.4.9):
Rysunek 3.4.9 Obrót (dookoła środka aktywnego obiektu)
Domyślną płaszczyzną obrotu jest aktualna płaszczyzna ekranu. Możesz także dokonywać obrotu wokół wybranych osi X,Y, Z, naciskając jedną z tych klawiszy klawiatury. Podobnie jak w przypadku przesunięcia, nagłówek okna pokazuje aktualny kąt obrotu.
Wraz z obrotem Camera.Target, obraca się kamera (patrz okno po prawej). Wynika to z faktu, że kamera ma włączone “śledzenie” tego obiektu, więc orientacja osi Z kamery także podąża za orientacją Camera.Target.
Podczas obrotu można także stosować klawisze Shift (dokładny obrót, o ułamki stopnia), Ctrl (obrót co 5 stopni), Shift-Ctrl (obrót co 1 stopień).
Jeżeli chcesz użyć innego środka transformacji niż środek obiektu, musisz się posłużyć tzw. „kursorem 3D” (3D cursor).
Wiesz zapewne, jak działa w każdym edytorze tekstów mrugający znak „karetki” (caret). Pokazuje, w którym miejscu będzie teraz wstawiony tekst, gdybyś zaczął go pisać. Tę koncepcję przeniesiono w trzy wymiary. W Blenderze istnieje taki specjalny punkt, który możesz umieścić w dowolnym miejscu w przestrzeni. Nazywa się także kursorem (ale, dla odróżnienia, „3D”). Pokazuje, gdzie zostałby umieszczony nowy obiekt, gdybyś go chciał w tym momencie stworzyć. Może także służyć jako punkt odniesienia w takich operacjach jak obrót czy skalowanie.
Kursor 3D jest rysowany jako niewielki krzyż, otoczony czerwono-białym okręgiem (Rysunek 3.4.10). Możesz go umieścić w dowolnym miejscu, klikając w tym punkcieLMB. Można zmusić go, aby przesunął się do najbliższego punktu siatki – w tym celu naciśnij Shift-S (Object to Snap) i z menu kontekstowego, które się pojawi, wybierz opcję Cursor to Grid (Rysunek 3.4.10). (Ten drugi krok – wybór pozycji z menu – możesz to zrobić lewą ręką, naciskając na klawiaturze klawisz 6. Jest to numer pozycji Cursor to Grid w menu Snap)
Aby wykonać obrót Camera.Target wokół dowolnego punktu przestrzeni, umieść w tym miejscu (kliknięcie LPM) kursor 3D. (Często musisz wskazać jego położenie na dwóch rzutach. Przydaje się tu także możliwość “skoku do węzła siatki”).
Następnie przełącz Blender w tryb, który wykorzystuje kursor jako punkt odniesienia dla wywoływanych transformacji. Służy do tego lista rozwijalna Pivot, umieszczona w nagłówku okna 3D View (Rysunek 3.4.11). Wybierz z niej pozycję 3D Cursor (lub . z klawiatury):
Rysunek 3.4.11 Zmiana trybu odniesienia transformacji — na kursor sceny
Upewnij się także, że obiekt Camera.Target jest nadal zaznaczony.
Reszta przebiega tak samo, jak poprzednio – naciśnij R i zacznij obracać obiekt (Rysunek 3.4.12):
Rysunek 3.4.12 Obrót obiektu dookoła kursora 3D
Po zakończeniu operacji przestaw menu Pivot Point z powrotem na opcję Bounding Box Center (,). Alternatywnie możesz się przełączyć na tryb Individual Centers (Ctrl-.).
Ostatniej z trzech podstawowych operacji — skalowania — nie będę tu szczegółowo opisywał. Starałem się do tej pory omawiać każdy temat w ten sposób, abyś mógł, Czytelniku, zdobytą wiedzę zaraz wykorzystać. Na przykład za pomocą obrotu obiektu Camera.Target i zmiany położenia Camera.Tracked możesz zaaranżować do renderowania zupełnie nowy widok modelu Ła-5. (Renderowania pokażę w następnej sekcji). Jak na złość, nie znalazłem, w tym momencie i w tym rysunku, żadnego „użytecznego” zastosowania dla zmiany skali. W skrócie wspomnę tylko, że zmiana rozmiaru obiektu przebiega bardzo podobnie do obrotu. Tak samo ważny jest wybór punktu odniesienia: środka obiektu lub kursora 3D. Skalowanie wywołujemy poprzez naciśnięcie klawisza S (Object→Transform→Scale). Więcej na temat tego polecenia znajdziesz w opisie szczegółów, na str. 821.
Do tej pory określaliśmy wektor przesunięcia czy kąt obrotu „interaktywnie” — za pomocą myszki. Jeżeli chcesz po prostu wpisać dokładną wartość numeryczną transformacji obiektu, naciśnij klawisz N, by otworzyć prawy przybornik okna (View→Properties). W panelu Transform(Rysunek 3.4.12) znajdziesz numeryczne wartości położenia (Location), obrotu (Rotation) i skali (Scale) aktywnego obiektu. Gdybyś w tej chwili zaczął go obracać za pomocą myszki, wartości, Blender „na bieżąco” uaktualniałby wartości w przyborniku. To działa także na odwrót: gdy wpiszesz w jedno z pól panelu Transform nową wartość, to efekt od razu zobaczysz na scenie.
Zwróć uwagę, że przy każdym z pól transformacji znajduje się ikona „kłódki” (). Jeżeli zostanie wciśnięta — współrzędna z tego pola jest wyłączona ze zmian podczas jakichkolwiek przekształceń. To się może przydać, aby np. przeskalować obiekt wyłącznie w płaszczyźnie XZ – wystarczy zablokować Scale:Y. Gdy potem wywołasz operację zmianę skali we wszystkich kierunkach jednocześnie (S) – kierunek Y pozostanie niezmienny.
W trakcie transformacji (obrotu, przesunięcia, zmiany skali…) można także wprowadzić dokładne wartości przesunięć za pomocą klawiatury. Wystarczy po wywołaniu transformacji nacisnąć klawisz = (Rysunek 3.4.14):
Rysunek 3.4.14 Przełączenie w tryb ręcznego wpisywanie wartości transformacji
Przełącza to Blendera w tryb, w którym w miejscu pierwszej współrzędnej pojawia się linia karetki — i możesz wpisać nową wartość z klawiatury). Aby przejść do następnego pola, naciśnij Tab (Rysunek 3.4.15b). Aby zaakceptować wprowadzone zmiany naciśnij Enter, a aby z nich zrezygnować — Esc.
Rysunek 3.4.15 Wpisywanie dokładnych wartości przesunięć
W przyborniku Properties możesz także sprawdzić lub wpisać dokładne współrzędne kursora 3D. Wystarczy że przesuniesz jego zawartość nieco w górę, by odsłonić panel 3D Cursor. Nowe wartości położenia kursora możesz wpisać w sekcję Location (Rysunek 3.4.16):
Po tylu operacjach edycji warto powiedzieć, co zrobić gdy się pomyliliśmy i chcemy wycofać dokonane zmiany. Jak większość edytorów, Blender umożliwia wielokrotne wycofanie (Undo) i powtórzenia (Redo) ostatnio wykonanych poleceń. Są to operacje na tyle ważne, że ich skróty od razu umieszczę w ramkach, aby w krytycznej chwili zaraz wpadły Ci w oko:
Operacja Undo – wycofanie ostatniego polecenia: naciśnij Ctrl-Z (albo wybierz z menu polecenie Object→Undo).
Operacja Redo – wycofanie wycofania ostatniego polecenia: naciśnij Ctrl-Shift-Z (albo wybierz z menu polecenie Object→Redo)
Trochę wyprzedzając kolejność wprowadzania zagadnień przyjętą w tej książce, wspomnę że menu Object jest dostępne w 3D View tylko w tzw. trybie obiektu (Object Mode). W innych trybach, (np. edycji siatki pojedynczego obiektu — Edit Mode), jego miejsce zajmują inne menu (np. Mesh). W każdym z nich są dostępne polecenia Undo i Redo. Wydaje mi się jednak, że te dwa skróty lepiej jest zapamiętać. W innych oknach, np. UV/Edit Image takich poleceń nie ma ani w menu Image, ani żadnym innym. Tam polecenia Undo i Redo są jednak nadal dostępne — poprzez podane powyżej kombinacje klawiszy klawiatury.
Na skalowaniu zakończymy omawianie podstawowych transformacji w Blenderze. Jest ich oczywiście o wiele więcej – jak sam się możesz przekonać, otwierając menu Object. (Rysunek 3.4.17):
Rysunek 3.4.17 Menu transformacji obiektu
Nie przerażaj się rozmiarem tego menu. Wielu z tych poleceń nie będziesz używał, a te, które są potrzebne, omówię powoli w dalszych rozdziałach tej książki.
Przesuwanie obiektu – klawisz G (Grab/Move — str. 86);
Skalowanie obiektu – klawisz S (Scale — str. 92);
Wciśnięcie Ctrl podczas transformacji włącza zmiany skokowe, o zaokrąglone wartości (str. 88);
Wciśnięcie Shift podczas transformacji włącza zmiany dokładne, ułatwiając końcowe ustalanie pozycji (str. 89);
Wszystkie transformacje można ograniczać do pojedynczej osi, naciskając w ich trakcie X, Y, lub Z (str. 88);
Przełączanie punktu odniesienia (wykorzystywany podczas obrotu i skalowania): . = 3D Cursor, , = Bounding Box (str. 91)
Rezygnacja z aktualnie wykonywanego polecenia – klawisz Esc (str. 86, 89)
Wycofanie ostatniego polecenia – Ctrl-Z (Undo — str. 93).
Odtworzenie wycofanego polecenia – Shift-Ctrl-Z (Redo — str. 93);
Na koniec tego rozdziału chciałbym pokazać, jak otrzymać produkt końcowy – wyrenderowany obraz modelu Ła-5. W tym celu trzeba będzie coś kliknąć i coś przestawić w oknie właściwości (Properties). To okno jest domyślnie umieszczone z prawej strony ekranu Blendera (Rysunek 3.5.1):
Rysunek 3.5.1 Elementy okna właściwości (Properties)
W tym oknie są wyeksponowane wewnętrzne właściwości sceny, modelu, pojedynczej części, materiału, tekstury... Na pierwszy rzut oka roi się w niej od kontrolek. Zacznę więc od wyjaśnienia jego wewnętrznej struktury i sposobu obsługi. W nagłówku okna znajduje się pole wyboru sekcji (zestawu paneli). Poniżej widać tzw. kontekst — czyli rzecz, której dotyczą wyświetlane właściwości. (W przykładzie, który pokazuje Rysunek 3.5.1, jest to aktualna scena, o nazwie Airborne). Poniżej są umieszczone panele, grupujące kontrolki związane z jakimś zagadnieniem (Render, Layers, Dimensions, … — Rysunek 3.5.1).
Każda panel ma nagłówek. Jest w nim wyświetlana nazwa panelu. Z lewej strony nazwy umieszczono przycisk umożliwiający zwijanie i rozwijanie (Rysunek 3.5.2):
Rysunek 3.5.2 Obsługa panelu — zwijanie i rozwijanie
Po prawej stronie nagłówka panelu znajduje się „uchwyt” . Możesz go „złapać” LPM i przesunąć panel w nowe miejsce (Rysunek 3.5.5):
Rysunek 3.5.3 Obsługa panelu — przesuwanie
Pozycje wszystkich paneli (i w ogóle — cały stan interfejsu użytkownika) jest zachowywany w pliku Blendera. (Gdy otworzysz plik, wszystko na ekranie Blendera będzie wyglądać dokładnie tak, jak w momencie wywołania polecenia File→Save. To bardzo wygodne)
Często panele wybranej sekcji nie mieszczą się na ekranie. Wtedy musisz przesuwać zawartość okna Properties. Możesz to zrobić używając suwaka (Rysunek 3.5.4a), umieszczonego przy krawędzi okna, lub po prostu przesuwając myszkę z wciśniętym SPM (Rysunek 3.5.4b):
Rysunek 3.5.4 Okno Properties — dwie metody przesuwanie zawartości
Blender posiada tak dużo różnorodnych paneli, że korzystanie z nich wszystkich jednocześnie jest właściwie niemożliwe. (Za dużo byłoby przewijania w górę i w dół okna). Na szczęście nawet nie ma takiej potrzeby. Innych kontrolek potrzebujesz przy modelowania geometrii, innych do pracy nad materiałami i oświetleniem, a jeszcze innych – do renderowania ostatecznego rezultatu: pojedynczego obrazu lub animacji. Dlatego panele w oknie Properties są podzielone na kilkanaście zestawów (sekcji), odpowiadających typowym operacjom. Przełączanie się pomiędzy zestawami odbywa się za pomocą przycisków z ikonami umieszczonych w nagłówku okna (Rysunek 3.5.5):
Rysunek 3.5.5 Typowe zestawy paneli okna Properties
Rysunek 3.5.5 przedstawia najczęściej występujący układ sekcji. Tak wygląda nagłówek okna Properties dla typowego obiektu „geometrycznego”, z których buduje się modele. Rysunek 3.5.5a) podaje krótki opis zestawów, które zawsze są w nagłówku okna Properties, niezależnie od rodzaju aktywnego obiektu. To pięć pierwszych sekcji z lewej: Render, Scene, Word, Object, Object Constraints, i jedna z prawej: Phisics. Rysunek 3.5.5b) wylicza sekcje wyświetlane dla obiektu zawierającego tzw. „siatkę” (mesh) — czyli jakieś ściany, krawędzie, wierzchołki.
Przy okazji — zwróć uwagę, że Rysunek 3.5.5a) pokazuje inny kontekst (scenę o nazwie Airborne) niż Rysunek 3.5.5b). Dzieje się tak, mimo że na scenie aktywnym obiektem był przez cały czas kadłub samolotu (obiekt 012.Body). Spróbuj wybrać jeszcze inne sekcje, a zauważysz dalsze różnice (Rysunek 3.5.6):
Rysunek 3.5.6 Wyświetlany kontekst zależy od wybranej sekcji
Gdy przełączysz się na zestaw Object, Blender wyświetli jako kontekst aktywny obiekt (Rysunek 3.5.6a) — tym razem już bez siatki (por. Rysunek 3.5.5b). Gdy wybierzesz sekcję World, w polu kontekstu pojawi się definicja otoczenia w którym znajduje sięobiekt aktywny. Z tego samego powodu po wybraniu sekcji Render w kontekście pojawia się już tylko scena, w której znajduje się wybrany obiekt (por. z Rysunek 3.5.5a).
Wyświetlany tuż pod nagłówkiem okna Properties kontekst zawsze wskazuje przedmiot, którego właściwości są udostępnione w panelach poniżej.
Jeżeli nie chcesz, by kontekst zmieniał się wraz ze zmianą aktualnego obiektu aktywnego, można go “przypiąć” do nagłówka umieszczoną z boku “szpilką” (Rysunek 3.5.7). W nagłówku okna pozostaną wówczas wyłącznie te sekcje, które dotyczą tego “przypiętego” kontekstu.
W Blenderze istnieją także inne rodzaje obiektów, które nie przechowują siatek: np. źródła światła (Lamp), albo kamery. Rysunek 3.5.8a) przedstawia sekcje, które są wyświetlane dla obiektów typu Lamp, a Rysunek 3.5.8b) — dla obiektów typu Camera:
Rysunek 3.5.8 Warianty zestawów dla różnych typów Object Data
Jak widać, w sekcji Object Data, która dla siatek miała ikonę „trójkąta” (por. Rysunek 3.5.5b), dla źródła światła jest „słoneczko” (Rysunek 3.5.8a). Ikona kamery mówi sama za siebie Rysunek 3.5.8b). Zauważ, że ani kamery, ani lampy, nie mogą mieć przypisanych sekcji cząsteczek (Particles) ani materiałów (Material), a kamery nie mają także sekcji tekstur (bo nie jest to im do niczego potrzebne).
Tabela 3.5.1 podaje zestawienie zestawów jakich przyjdzie nam używać w dalszych rozdziałach tej książki:
| Zestaw | Opis |
| | Obsługa tworzenia ostatecznego obrazu lub animacji (renderowania). Na koniec tej sekcji pokażę, o co chodzi. |
| | Właściwości sceny, np. wybór aktywnej kamery, ustawienie jakiejś drugiej sceny w charakterze tła. Jeden z dodatków do „pozowania” samolotu (wysuwanie u chowanie podwozia, ruchy sterów, itp.), który będziemy używać (Handle Panel) umieszcza swoje panele w tej sekcji. |
| | Sterowanie parametrami otoczenia sceny (np. kolor i/lub obraz tła, światło rozproszone, itp.) |
| | Właściwości obiektu: aktualne położenie, orientacja, nazwa, i inne (np. warstwy, na których się znajduje). |
| | Zarządzanie ewentualnymi ograniczeniami obiektu. (Na przykład — kamera Camera.Tracked jest zawsze jest skierowana na model Ła-5, bo ma przypisane ograniczenie Track To. To ograniczenie zawsze kieruje wybraną oś kamery na obiekt Camera.Target). |
| | Sekcja wyświetlana tylko dla obiektów „geometrycznych” — czyli zawierających siatki (mesh). Pozwala w sposób „odwracalny” wzbogacić siatkę o dodatkowe efekty, np. wygładzania powierzchni (powierzchniami podziałowymi Catmull-Clarka), albo wygiąć ją wzdłuż wskazanej krzywej. |
| Object Data | Właściwości „zawartości” obiektu: siatki (obiekt typu Mesh), albo źródła światła (Lamp), albo kamery (Camera), albo jeszcze innych typów obiektów (np. linii krzywej — Curve). |
| | Ustalanie ogólnych właściwości materiału obiektu (kolor i połyskliwość powierzchni, przejrzystość, rzucanie cieni, i wiele innych aspektów) |
| | Zarządzanie teksturami. Są to obrazy rastrowe, za pomocą których odwzorowane są drobne nierówności powierzchni (łączenia blach poszycia, nity). Służą także do lokalnych zmiany właściwości materiału — np. koloru (kamuflaż samolotu, zabrudzenia), czy nawet przejrzystości (odwzorowują drobne otwory). |
| | Z tej sekcji skorzystamy pod koniec książki do zamodelowania trawy lotniska, na którym postawimy nasz model. |
Tabela 3.5.1 Zestawienie wybranych zestawów i podzestawów paneli
Jeżeli takie pojęcia jak „materiał” czy „tekstura” są dla Ciebie dalej abstrakcyjne — nie przejmuj się, wyjaśnię to w dalszych rozdziałach. Tabela 3.5.1 została tutaj umieszczona, abyś wiedział, co należy wybrać, gdy napiszę: „w oknie właściwości przełącz się na zestaw Material”.
Wybacz, jeżeli dotychczasowe wprowadzenie było trochę przydługie. Chciałem przybliżyć szczegóły posługiwania się systemem paneli i ich zestawów. W istocie wygenerowanie ostatecznego obrazu lub animacji w Blender możne się sprowadzić do naciśnięcia pojedynczego przycisku. (Za chwilę podam, który to jest). Nim to jednak zrobię, omówię kilka opcji, określających postać obrazu, jaki uzyskamy. Przy tej okazji wyjaśnię pokrótce nietypowe szczegóły kontrolek Blendera.
Przełącz się na zestaw Render. Rysunek 3.5.9 przedstawia podstawowe rodzaje kontrolek, wykorzystywanych przez GUI Blendera na przykładzie paneli z tej sekcji:
Rysunek 3.5.9 Podstawowe rodzaje kontrolek Blendera
Przyciski (operation buttons), umieszczone w panelach, służą do wywołania jakiegoś polecenia (jak np. Render:Image lub Render:Animation). Tak w ogóle to w oryginalnej terminologii Blendera każda kontrolka jest określana jako jakiegoś rodzaju „przycisk” (button). To tradycja, której początki giną w mrokach historii programu. Pewnie dlatego indywidualne etykiety są tu umieszczane wewnątrz list, pól numerycznych, czy przełączników (por. Rysunek 3.5.9a). Trzeba się do tej konwencji przyzwyczaić. Wyłamują się z niej tylko pola opcji (wszędzie indziej określane jako checkbox, ale tutaj — jako toggle button). To jest jednak stosunkowo świeża modyfikacja, które pojawiła się w wersji 2.5 (we wcześniejszych wersjach tę rolę pełniły przyciski o dwóch stanach: „wciśnięty” i „zwolniony”). Obecne pola opcji są dla nowego użytkownika bardziej czytelne, bo nawiązują do konwencji używanej w popularnych systemach okienkowych.
Tuż pod nagłówkiem panelu Dimensions jest umieszczona lista rozwijalna (menu button) o nazwie Render Presets. Możesz w nią kliknąć (oczywiście LPM) i wybrać jeden z typowych wymiarów obrazu lub animacji (Rysunek 3.5.9b)1. Na innych panelach widzisz jeszcze kilka innych list rozwijalnych, służących np. do wyboru jednej z możliwych opcji (np. lista Render:Display). Gdy nazwy alternatywnych opcji są krótkie, zamiast listy może być użyty przełącznik (radio button) — taki, jak w panelu Anti-Aliasing (Rysunek 3.5.9).
Czasami lista rozwijalna może mieć kilka kolumn. Pokażę to na przykładzie innej listy. Przesuń panele sekcji Render nieco do góry, abyś mógł zobaczyć umieszczony na jej końcu panel Output. Znajduje się na nim lista rozwijalna, w której możesz ustalić domyślny format zapisu wyrenderowanego obrazu (Rysunek 3.5.10):
Rysunek 3.5.10 Wybór domyślnego formatu pliku obrazu/animacji — inna postać listy rozwijanej
Format, ustalony w tym miejscu, dotyczy nie tylko obrazu renderowanego. Nawet zwykły „zrzut” aktualnego ekranu Blendera (Ctrl-F3) jest zapisywany w postaci ustalonej właśnie w tym polu!
Gdy wybierzemy jako format zapisu Jpeg, warto sprawdzić wartość w polu numerycznym Quality (Rysunek 3.5.10). Format Jpeg jest jednym z tzw. formatów degradujących (jakość obrazu) za cenę mniejszego rozmiaru. Za pomocą wartości Quality (wyrażonej w procentach) można sterować kompromisem pomiędzy rozmiarem a jakością. Jeżeli Quality = 100%, to żadna degradacja nie zachodzi (każdy piksel obrazu jest pamiętany oddzielnie). Takie pliki będą miały oczywiście największy rozmiar. Osobiście radzę ustalić wartość Quality do 85% – daje to jeszcze nie za duży plik, i w miarę dobrą jakość rezultatu.
A jak to wpisać? Zapewne dla większości Czytelników jest to oczywiste, ale opiszę tu to w paru słowach. Być może przy okazji dowiesz się jakiegoś przydatnego szczegółu.
Pole Output:Quality jest tzw. „suwakiem” (slider) , czyli polem o ustalonym zakresie dopuszczalnych wartości (w tym przypadku to 0% i 100%). Blender wypełnia suwak dwoma barwami, przy czym granica tych kolorów odpowiada aktualnej wartości kontrolki. Wartość suwaka możesz zmienić, przesuwając ponad nim myszką z wciśniętym LPM (Rysunek 3.5.11):
Rysunek 3.5.11 Zmiana wartości pola numerycznego za pomocą myszki
Jeżeli tylko raz klikniesz w pole numeryczne LPM (lub naciśniesz na nim Enter), przełączysz je w stan edycji, w którym możesz po prostu wpisać dokładną wartość (Rysunek 3.5.12):
Rysunek 3.5.12 Zmiana wartości pola numerycznego poprzez wpisanie
Co ciekawe – można tu także wpisać wyrażenie arytmetyczne: np. „100/3”, a nawet coś z nawiasami! To działa jak kalkulator, podstawiając wynik operacji jako nową wartość pola numerycznego.
Częściej spotykaną postacią pola numerycznego jest wersja „ze strzałkami” . Takie pole może nie mieć ograniczeń na wpisywane wartości. W sekcji Dimensions:Resolution możesz znaleźć zespół trzech pól numerycznych, sterujących rozmiarem renderowanego obrazu. Dwa górne — X i Y — są polami „ze strzałkami”, określającymi szerokość i wysokość rezultatu (w pikselach)2 (Rysunek 3.5.13):
Rysunek 3.5.13 Dwie metody zmiany wartości zwykłego pola numerycznego
Klikając LPM w „strzałki”, umieszczone po lewej i prawej stronie pola, możesz zmniejszać i zwiększać wyświetlaną wartość (Rysunek 3.5.13a). Każde kliknięcie oznacza zmianę o ustaloną „krok” (w tym przypadku — o 1 piksel). To dobre dla jakiś małych poprawek, ale jeżeli to pole ma zawierać zupełnie inną wartość — najlepiej ją bezpośrednio wpisać (jak to pokazuje Rysunek 3.5.13b i Rysunek 3.5.12).
Naciśnięcie Esc podczas edycji wartości (w sytuacji, jaką pokazuje Rysunek 3.5.13b) oznacza rezygnację ze zmiany.
Każdym polem numerycznym możesz się posługiwać jak suwakiem — przeciągając ponad jego obszarem myszką z wciśniętym LPM (por. Rysunek 3.5.11). Jeżeli będziesz dodatkowo trzymał wciśnięty klawisz Ctrl, wyświetlana wartość będzie się zmieniać o zaokrąglone wartości. To podobna konwencja jak podczas przesuwania obiektów — por. str. 88, Rysunek 3.4.7. Za pomocą myszki możesz take zaznaczyć i zmieniać wartości powiązanych pól (takich, które są umieszczone jedno nad drugim: Rysunek 3.5.15):
Rysunek 3.5.14 Jednoczesna zmiana dwóch powiązanych pól numerycznych
Wróćmy jeszcze na chwilę do panelu Render:Output, gdyż zawiera jeszcze jeden rodzaj kontrolki: pole tekstowe (Rysunek 3.5.15).
W pole tekstowe wpisujesz nową wartość tak samo jak to robisz w polu numerycznym — klikasz LPM, wpisujesz, a na koniec naciskasz Enter. Podczas wpisywania są dostępne typowe operacje na tekście: możesz zaznaczyć i usunąć fragment, możesz także go skopiować (Ctrl-C) lub wkleić (Ctrl-V) ze schowka.
Zauważ, że pole w tym przykładzie, jest przykładem kontrolki „wyspecjalizowanej” do wybierania ścieżek do plików. Z prawej strony ma niewielką ikonę otwartego folderu. Gdy klikniesz w nią, na ekranie pojawi się okno wyboru plików (podobne do opisanego na str. 759). Możesz w nim wskazać odpowiednią ścieżkę. Oczywiście, możesz także wprost wpisać całą ścieżkę w to pole. Zwróć uwagę, że domyślnie zaczyna się ono od podwójnego ukośnika: „//”. To tak zwany „znacznik ścieżki względnej” (Relative path). Czytając ten wpis, Blender zastępuje „//” odpowiednią ścieżką początkową – zazwyczaj miejscem, gdzie znajduje się aktualny plik z rysunkiem. Dzięki temu można przesuwać folder z rysunkiem i wszystkimi plikami towarzyszącymi z jednego miejsca na dysku na drugie. Przy konsekwentnym stosowaniu znacznika „//” na początku ścieżek nie ma niebezpieczeństwa, że Blender nie będzie mógł czegoś znaleźć po takim przeniesieniu.
Myślę, że na tym zakończymy nasze wprowadzenie do okna Properties i kontrolek Blendera. (Niektóre panele z okna Properties zawierają jeszcze jeden rodzaj formantu: listy. Jednak obsługę takiej złożonej kontrolki GUI zdecydowałem się opisać w oddzielnej sekcji, na stronie 806). Przy okazji zmieniliśmy w panelu Output domyślny format zapisu obrazu na Jpeg (por. str. 100, Rysunek 3.5.10). Zwiększyliśmy także w panelu Dimensions wysokość renderowanego obrazu, na 1024 px (por. str. 101, Rysunek 3.5.13). Czy zwróciłeś uwagę, że od razu zmieniło to proporcje okna kamery, wyświetlanej w jednym z widoków 3D?
W Blenderze nie ma prawie wcale przycisków „OK.”, czy „Akceptuj”. Wszystko, co ustawisz za pomocą jakiejkolwiek kontrolki w oknie przycisków lub przybornikach, natychmiast jest odwzorowane na scenie.
Ta „natychmiastowość” efektu jest w zasadzie bardzo wygodna. Bazuje na założeniu, że czas odświeżenia ekranu (wszystkich okien Blendera!) jest bardzo krótki. Gorzej, gdy Twój komputer nie ma żadnego specjalnego akceleratora grafiki. Gdy w trzech różnych oknach 3D masz wyświetlone kilkaset tysięcy ścian takiego modelu jak ten Ła-5, i zaczynasz przesuwać myszką jakiś suwak, możesz zauważyć jego „opór” — wyświetlane w kontrolce wartości nie będą się zmieniać natychmiast. Dzieje się tak dlatego, że każda zmiana tej kontrolki wymaga ponownego narysowania modelu w każdym z okien programu! To nie jest jakaś wielka niedogodność, ale można zmniejszyć takie opóźnienia pracując tylko na warstwach, które są w danym momencie potrzebne (por. str. 73, Rysunek 3.2.4).
Ustawienia w sekcji Render poprawiliśmy, by wygenerować obraz tego modelu Ła-5. Nim jednak naciśniesz ostateczny przycisk, upewnij się, że w oknie widoku są włączone co najmniej następujące warstwy: . (Jeżeli zapomnisz włączyć warstwy nr 11, nie zobaczysz ani skrzydeł, ani kadłuba.)
Blender renderuje się zawsze tylko to, co jest na widocznych warstwach
Wreszcie – zróbmy to! Naciśnij ten duży przycisk Render:Image (Rysunek 3.5.16). Możesz także nacisnąć skrót tego polecenia: klawisz F12. Blender wyświetli wówczas na całym ekranie nowe okno, typu UV/Image Editor. (Tak działa, gdy masz ustawione Render:Display na Full Screen — por. Rysunek 3.5.16. W razie czego sprawdź, jak działają pozostałe możliwości z tej listy!). Na początku pole obrazu jest zupełnie czarne, potem coś zaczyna się na nim pojawiać (Rysunek 3.5.17):
Rysunek 3.5.17 Okno UV/Image Editor w trakcie renderowania
Blender generuje obraz w tle (a dokładniej rzecz biorąc: jest obliczany w oddzielnych wątkach programu). Dzięki temu ekran nadal reaguje na polecenia użytkownika. Na przykład — możesz w dowolnym momencie przerwać ten proces, korzystając z przycisku umieszczonego u góry ekranu, w nagłówku okna Info (Rysunek 3.5.17).
Ostatecznie powinieneś uzyskać taki rezultat, jaki przedstawia Rysunek 3.5.18:
Rysunek 3.5.18 Okno obrazu po zakończeniu renderowania
Aby zapisać uzyskany obraz na dysku – naciśnij F3 (lub wybierz z menu polecenie Image→Save a Copy). Spowoduje to otwarcie okna wyboru pliku. Możesz tam ustalić, pod jaką nazwą i gdzie obraz będzie zachowany. (W tym oknie możesz także zmienić domyślny format zapisu na inny — na przykład z Jpeg na PNG).
Gdybyś chciał uzyskać efekt rozmycia ruchu wirujących łopat śmigła — włącz w sekcji Render panel Motion Blur (Rysunek 3.5.19a), po czym ponownie uruchom renderowanie i uzbrój się w cierpliwość:
Rysunek 3.5.19 Ten sam obraz, ale z rozmytymi łopatami wirującego śmigła
Dlaczego piszę o cierpliwości? Bo w przypadku tego modelu efekt rozmycia ruchu został uzyskany najprostszą, lecz najbardziej kosztowną obliczeniowo metodą: Sampled Motion Blur. W tym trybie Blender tworzy tyle oddzielnych obrazów modelu, ile jest wpisane polu Sampled Motion Blur:Motion Samples (w tym przypadku to 16 — por. Rysunek 3.5.19a). Każdy z nich odpowiada kolejnej klatce (frame) animacji. Potem rezultat jest łączony, i powstaje efekt rozmycia.
Jeżeli pojedynczy obraz, taki jaki pokazuje Rysunek 3.5.18, generował się na moim komputerze przez 34s, to po włączeniu Sampled Motion Blur będzie generowany 16 x 34s, czyli 9 minut. Ten czas wydłuży się proporcjonalnie do liczby pikseli (tzn. powierzchni) obrazu, gdy ustawię jego większe rozmiary. Bardziej optymalne czasowo metody uzyskania rozmycia ruchu dla wirującego śmigła opisałem w rozdziale o kompozycji, pod koniec książki (str. 578).
Podsumowanie
Kontrolki w oknie właściwości są pogrupowane w tematyczne „zasobniki” – panele (str. 95);
Panele są pogrupowane w zestawy (sekcje), odpowiednie dla różnych etapów pracy nad sceną lub animacją (str. 95, 98);
Przełącznik, umieszczony w nagłówku okna Properties, pozwala na szybki wybór odpowiedniego zestawu. (str. 95, 97);
Okno Properties dobiera wyświetlany w nagłówku zestaw paneli do aktualnego kontekstu (obiektu aktywnego) (str. 97)
Zawartość okna Properties można swobodnie przesuwać w górę i w dół (str. 96). Dzięki temu każda sekcja może zawierać więcej paneli, niż te które są widoczne na ekranie;
Panele okna przycisków można przesuwać (tzn. zmieniać kolejność w zestawie — str. 96) i zwijać „w pasek” (str. 95). Te ustawienia są zapamiętywane przy zapisaniu pliku rysunku;
Poznałeś podstawowe kontrolki Blendera, takie jak przycisk (operation button – str. 99), lista rozwijalna (menu button — str. 99, 100), pole opcji (checkbox albo toggle button — str. 99), przełącznik (radio button — str. 99) oraz pole numeryczne (numeric button — str. 100, 101) i tekstowe (text button — str. 101);
Wszystko co zmienisz w oknie Properties jest natychmiast widoczne na modelu lub scenie. Stąd w Blenderze prawie w ogóle nie spotyka się przycisków OK. lub Accept, znanych Ci z okien dialogowych innych programów;
Aby wygenerować ostateczny obraz sceny, należy nacisnąć przycisk Render:Image (str. 102);
Rezultat renderowania można zapisać do pliku na dysku poleceniem Image→Save (skrót: F3 — str. 103);
Efekty specjalne, jak rozmycie ruchu, wydłużają czas renderowania (str. 103);
W tym rozdziale zaczynamy “regularną” pracę z Blenderem. Z własnego doświadczenia radziłbym zapisywać stan pracy, osiągnięty na koniec każdego dnia, do oddzielnego pliku. (Więcej na ten temat znajdziesz na str. 762).
Na wszelki wypadek zapoznaj się także ze sposobem odzyskiwania danych — na str. 775. (Choć na tym etapie nie spodziewam się żadnych kłopotów z Blenderem — to naprawdę stabilny program)
Pierwsze sekcje tego rozdziału będą bardzo szczegółowo opisywać poszczególne kroki w formowaniu coraz bardziej złożonych elementów. Chcę w ten sposób zaznajomić Czytelników, którzy to robią po raz pierwszy, z typowymi sposobami pracy z siatkami Blendera. Zaczniemy więc od nieskomplikowanej bryły obrotowej — kołpaka śmigła. Potem do tego dodamy coś bardziej skomplikowanego — łopatę (śmigła, oczywiście). Następnie zajmiemy się formowaniem płata. Skrzydło ma w zasadzie obrys (w rzucie z góry) trapezu, któremu zaokrąglono końcówkę. Końcówka płata w P-40 jest dość trudna do prawidłowego uformowania1, więc omówiłem ją w oddzielnej sekcji. Stosuję tam m.in. odcinanie powierzchni inną powierzchnią (stworzyłem specjalny dodatek Blendera, który do tego służy). Sądzę, że po ukończeniu skrzydła będziesz już dobrze znał większość “tricków” pozwalających uzyskać w Blenderze taki kształt, jaki jest potrzebny. Stateczniki to właściwie powtórzenie w uproszczonej wersji formowania płata, więc nie poświęcam im wiele miejsca. Potem uformujemy najbardziej złożony element — kadłub.
W tym rozdziale będziemy wykorzystywać materiały z towarzyszącego tej książce pliku source.zip. Rysunki *.blend, odpowiadające rezultatom poszczególnych sekcji rozdziału znajdziesz w pliku p40.zip. (Po rozpakowaniu tego pliku — w jego folderze model\p40\history. Adres internetowy, z którego można je pobrać, znajdziesz na. str. 22).
Nazwa każdego z towarzyszących temu rozdziałowi plików *.blend składa się z przedrostka „P40B-„ i numeru sekcji, której dotyczy. (Np. plik z rezultatem sekcji 4.1 nosi nazwę P40B-4.01.blend, a z rezultatem sekcji 4.2 — P40B-4.02.blend). Aby podstawić jakieś rysunki referencyjne i nie naruszyć praw innych autorów, w plikach P40B-*.blend używam własnych planów P-40, które opracowałem w 2011r. Te rysunki powstały na podstawie ukończonego w Blenderze P-40, więc w pewnych miejscach mogą nie być zgodne z prezentowanym kształtem siatki samolotu. To dlatego, że model tworzyłem w oparciu o zmodyfikowane (por. str. 1197, 1207) plany Jacka Jackiewicza i Mariusza Łukasika, które przedstawiam na ilustracjach. Czasami te rysunki także zawierały błędy, co opisuję w poszczególnych sekcjach tego rozdziału. Plany, podstawione pod modelem w opublikowanych plikach przedstawiają zawsze ostateczny kształt, po wszystkich poprawkach — i stąd różnice.
Skonfiguruj środowisko Blendera tak, jak jest to podane na str. 764. Do odtworzenia geometrii samolotu, wykorzystamy rysunki przygotowane we wcześniejszych rozdziałach. Na początek scal wszystkie okna 3D View w jedno. Wykorzystując panel Background Images z przybornika Properties umieść w tle widoku plany samolotu1 (Rysunek 4.1.1):
Rysunek 4.1.1 Ustawianie planów samolotu w tle okna 3D View
Podczas wstawiania rysunków tła, musisz zdecydować, jaką długość “w świecie rzeczywistym” ma reprezentować 1 jednostka długości w Blenderze.
Przyjąłem, że 1 jednostka Blendera odpowiada 10 cm na prawdziwym samolocie.
Dlaczego akurat taka skala? Obraz tła w Blenderze można maksymalnie powiększyć do prostokąta, w którym dłuższy bok ma rozmiar 500 jednostek. To za mało, by dla 10-metrowego samolotu zastosować np. skalę 1 jednostka = 1cm. (Obraz tła musiałby mieć wtedy rozmiar dwa razy większy, niż dopuszcza Blender: 1000 jednostek)2. Szczegółowy opis ustawiania rysunków z planami w oknach 3DView znajdziesz na str. 780.
Rysunek 4.1.2 przedstawia szczegóły ustawień trzech podstawowych rzutów naszego P-40:
Rysunek 4.1.2 Przykład ustawienia podstawowych rzutów samolotu w panelu Background Images
Zwróć uwagę że każdy z obrazów jest przypisany do odpowiedniej osi (Axis— Rysunek 4.1.2). Dzięki temu ustawieniu rzut z boku będzie się podstawiał tylko wtedy, gdy naciśniesz 3, rzut z góry — 7, a rzut z przodu — 1. Uważam, że tak jest wygodniej, bo w ten sposób plany nie przeszkadzają w oglądaniu modelu w rzucie perspektywicznym.
Obrazy, podstawione na wszystkich rzutach, muszą być umieszczone w przestrzeni w sposób spójny. Jaki punkt przyjąć jako środek sceny (punkt o współrzędnych 0,0,0)?. Z osią Y nie ma problemu — leży w osi śmigła (kadłuba). W jakim jednak punkcie kadłuba umieścić “bazową” płaszczyznę XZ ? To zależy od konstrukcji modelowanego samolotu. W przypadku innych samolotów często jako powierzchnię bazową przyjmowałem płaszczyznę podstawy kołpaka śmigła. Dla tej konstrukcji wolę jednak ustalić “bazę” w takim miejscu kadłuba, które nie ulegało zmianie pomiędzy kolejnymi wersjami. (Nosy P-40 uległy zmianie trzy razy, a licząc to z P-36 — aż pięć). Proponuję ustawić rysunki tak, by punkt (0,0,0) sceny leżał na pierwszej wrędze kadłuba (Rysunek 4.1.1). Na rysunkach fabrycznych widać, że ta płaszczyzna była także wykorzystana jako baza do wymiarowania płata (i leżał na niej przedni dźwigar skrzydła). W obszarze za wręgą, w której umieściłem środek układu współrzędnych, zmiana kształtu kadłuba zaszła tylko dwa razy. (Mam na myśli przebudowę górnej części kadłuba w P-40D i wydłużenie ogona w P-40L). Kształt skrzydeł P-36/P-40, i kształt usterzenia poziomego, oraz ich wzajemne położenie, nie uległo zmianie przez całą historię konstrukcji3.
Gdy uzgodniłeś położenie planów we wzorcowym oknie 3D View, możesz je podzielić na trzy lub cztery okna (Rysunek 4.1.3):
Rysunek 4.1.3 Przykład ustawienia podstawowych rzutów samolotu
To układ ekranu w którym będziemy formować nasz model. Każde ze „sklonowanych” w ten sposób okien dziedziczy po pierwowzorze przypisane obrazy tła. Dzięki temu w po wybraniu odpowiedniej projekcji — z boku, z przodu lub z góry — w każdym widoku 3D podstawi Ci się odpowiedni rysunek referencyjny.
Niestety, nie mogłem do tej publikacji dołączyć oryginalnych rysunków, których użyłem do budowy modelu (bo byłoby to naruszenie praw ich Autorów). Zamiast tego opracowałem własne plany, które zobaczysz w przykładowych plikach *.blend, towarzyszących każdej z sekcji tego rozdziału (Rysunek 4.1.4):
Rysunek 4.1.4 Zawartość pliku P40B-4.01.blend, towarzyszącego tej książce
Te obrazy to rendery ukończonego modelu P-40B, wykonane z wykorzystaniem specjalnej „kamery ortogonalnej” i cieniowania „z konturem”, jak dla kreskówek. W chwili obecnej to chyba jedyne rysunki P-40 stworzone na podstawie trójwymiarowego modelu. Dzięki tej technice uzyskałem na nich wysoką zgodność pomiędzy poszczególnymi rzutami samolotu, która jest praktycznie niemożliwa do osiągnięcia na planach kreślonych metodami tradycyjnymi.
Przykładowe pliki *.blend dla tego i następnych rozdziałów znajdziesz w folderze model\p40\history\ (por. str. 22). Nazwa każdego z nich składa się z przedrostka „P40B-„ i numer sekcji, której dotyczy. (Np. plik dla tej sekcji nosi nazwę P40B-4.01.blend, a dla następnej — P40B-4.02.blend).
Choć w przykładowych danych wykorzystuję moje rysunki, to na ilustracjach w tej książce pokazuję oryginalne plany (których przygotowanie opisuje Rozdział 2). Sądzę, że w ten sposób lepiej zaprezentuję typowe niezgodności, z jakimi możesz się zetknąć podczas pracy ze zwykłymi (tzn. zeskanowanymi) rysunkami referencyjnymi!
Podsumowanie
Na poczatku określić „skalę” modelu — tzn przelicznik rzeczywistych wymiarów samolotu na Jednostkę Blendera. Dla samolotów jednosilnikowych proponuję przyjąć że 1 Jednostka = 10 cm (str. 106);
W Blenderze możesz podstawić rysunki referencyjne samolotu jako tło okna 3D View. Służy do tego panel Background Image, umieszczona w panelu właściwości takiego okna (str. 106). Takie rysunki znacznie ułatwiają modelowanie;
Najlepiej przypisać wszystkie rysunki referencyjne do poszczególnych osi pojedynczego okna 3D View. Każdy obraz z rzutem samolotu trzeba dopasować do pozostałych obrazów i do założonego rozmiaru sceny. Po uzgodnieniu można powielić takie okno w 3 lub 4 obszary (str. 107);
Każdej sekcji tego rozdziału towarzyszy przykładowy plik Blendera (o nazwie P40B-<nr sekcji>.blend);
Modelowanie zaczniemy od kołpaka śmigła. Specjalnie wybrałem na początek tak nieskomplikowany kształt. Opiszę jego formowanie trochę dokładniej, abyś, jeżeli jest to Twoja pierwsza praca w Blenderze, miał okazję poznać podstawowe techniki kształtowania powierzchni. Obowiązkowo korzystaj w takim przypadku z odsyłaczy do szczegółowych opisów czynności!
Kołpak śmigła zacznij od umieszczenia kursora 3D tam, gdzie ma się znaleźć środek jego podstawy (jak — str. 777). (Pamiętaj, że to miejsce stanie się środkiem nowo utworzonego obiektu). Następnie, w rzucie z przodu, utwórz okrąg o promieniu nieco większym od podstawy kołpaka (można użyć polecenia Add→Mesh→Circle, ale lepiej to zrobić tak, jak opisałem na str. 810). Liczba wierzchołków nie musi być zbyt duża — uważam że po wygładzeniu modyfikatorem Subdivision Surface 8 krawędzi zupełnie dobrze odwzoruje okrąg. Rysunek 4.2.1 pokazuje, jak powinien wyglądać efekt tych dwóch czynności:
Rysunek 4.2.1 Początkowy okrąg, z którego powstanie kołpak śmigła
Przełącz się w Edit Mode (Tab) i wytłocz utworzony okrąg na całą długość kołpaka wzdłuż osi Y (E,Y lub Mesh→Extrude — str. 901). Zatrzymaj się przed jego czubkiem. Rysunek 4.2.2 pokazuje przebieg operacji:
Rysunek 4.2.2 Wytłoczenie (Extrude) okręgu w powierzchnię
Po wytłoczeniu warto poprawić metodę cieniowania, aby powierzchnia wydawała się doskonale gładka (Mesh→Faces→Shade Smooth, patrz str. 904) .
Ustaw tryb środka transformacji na Bounding Box Center (,, Rysunek 4.2.3) . Następnie zaznacz przednią krawędź powierzchni. i zdecydowanie zmniejsz ją poprzez zmianę skali (S, albo Mesh→Transform→Scale — str. 896) . Rysunek 4.2.3 pokazuje przebieg operacji:
Rysunek 4.2.3 Uformowanie zarysów kształtu kołpaka
Rozmiar końca stożka dobierz tak, by był zbliżony do zaokrąglenia końcówki kołpaka (skorzystaj z rysunków widocznych na rzucie z boku).
Zaokrąglenie noska formujemy poprzez “wytłoczenie” (str. 901) z końcówki powierzchni jej kolejnego segmentu (Rysunek 4.2.4). Przesuń nową krawędź do przodu o promień nosa kołpaka. Zmniejsz ją (poprzez zmianę skali) do mniejszej średnicy. Aby zamknąć siatkę, wygeneruj jeszcze jedną krawędź, poprzez kolejne wytłoczenie. Potem jej nie przesuwaj, tylko “zsuń” wszystkie wierzchołki (poprzez zmianę skali do 0) w jeden punkt. Zamień je w pojedynczy wierzchołek poprzez scalenie (Mesh→Vertices→Remove Doubles, str. 906) . Rysunek 4.2.4 pokazuje rezultat tej operacji:
Rysunek 4.2.4 Formowanie zaokrąglonego noska
Zaokrąglenie, jakie uzyskaliśmy, warto jeszcze zestawić z rzutem z boku (sylwetką narysowaną czerwoną linią — poprawialiśmy plany w tym miejscu). W przypadku naszej siatki konieczne okazało się dodatkowe zmniejszenie ostatniej (nie licząc końcowego wierzchołka) sekcji (Rysunek 4.2.5):
Rysunek 4.2.5 Dopasowywanie zaokrąglenia do zadanego obrysu
Zwróć uwagę, że ostatnia sekcja i wierzchołek zamykający cały stożek leżą na tej samej płaszczyźnie. Taką “tarczkę” najlepiej jest umieszczać jako zakończenie wszelkich kulistych zaokrągleń.
Gdy uporządkowaliśmy końcówkę stożka, warto poprawić także ściany boczne. Wstaw mniej więcej pośrodku nową sekcję (tzn. nowy rząd wierzchołków — poleceniem Loop Cut, por. str. 913) . Po wstawieniu zwiększ odrobinę jej średnicę poprzez zmianę skali, by dopasować wygięcie ścian stożka do obrysu widocznego na planach (Rysunek 4.2.6):
Rysunek 4.2.6 Lekkie wygięcie ścian kołpaka — poprzez dodatkową linię siatki
Czas przejść do ostatniej fazy formowania kształtu — dokładnego uzgodnienia z planami. Najłatwiej jest to robić po przełączeniu sposobu reprezentacji (Draw Type) siatek z Solid na Wireframe (por. str. 89). Dodatkowo można także włączyć w modyfikatorze Subsurf opcję Apply during Edit (por. Rysunek 4.2.7).
Rysunek 4.2.7 przedstawia siatkę kołpaka w trybie Wireframe, nałożoną na rzut z boku.
Rysunek 4.2.7 Wstępne porównanie z obrysem na planach (czerwona linia)
Jak widać, zarys siatki wymaga drobnych korekt, w celu uzgodnienia z kształtem na rysunku. Pierwsza modyfikacja jest jednak związana z przystosowaniem do późniejszej pracy. Dopóki nie jest to zbyt kłopotliwe, warto by linie siatki znajdowały się w miejscu, gdy przebiegało łączenie blach na prawdziwym samolocie. W związku z tym przesunąłem (poleceniem Edge Slide — por. str. 911) centralną sekcję w takie miejsce, narysowane na planach.
Następnie próbowałem skorygować obrys nosa kołpaka poprzez zmianę średnicy (poleceniem Scale) i przesuwanie (Edge Slide) jego przednich sekcji. Ostatecznie jednak do uzyskania założonego kształtu trzeba było dodać do tej siatki (Loop Cut) jeszcze jeden rząd wierzchołków (Rysunek 4.2.8):
Rysunek 4.2.8 Ostateczne dopasowanie siatki do zadanego obrysu
Gdy kształt obiektu jest już zgodny z planami, pozostał do utworzenia ostatni szczegół: zamknięcie podstawy tego kołpaka. W prawdziwej konstrukcji było umieszczone w tym miejscu okrągłe żebro. Nie będziemy go teraz dokładnie modelować (zresztą — brak jest jakichkolwiek zdjęć tego elementu, więc nie wiadomo, jak wyglądał). Zadowolimy się prostym “wytłoczeniem” kolejnej sekcji z dotychczasowej podstawy stożka (Rysunek 4.2.9). Krawędź, dodaną w wyniku wytłoczenia, nie przesuwaj, tylko zmniejsz (poprzez zmianę skali).
Rysunek 4.2.9 Wstawienie dodatkowej powierzchni u podstawy stożka
W rezultacie wydłużenia siatki podstawowej o dodatkową sekcję, krawędź podstawy stożka uległa zaokrągleniu (Rysunek 4.2.9). Pamiętaj, powierzchnia podziałowa stara się wygładzić każdą nierówność1!
W P-40 krawędź podstawy kołpaka była ostra, więc musisz ją “przywołać do porządku”. Zmień ostrość krawędzi, którą pokazuje Rysunek 4.2.10, z 0.0 do 1.0 (Mesh→Edges→Edge Crease — patrz str. 915). Wraz ze zmianą sposobu cieniowania ścian podstawy na „płaski” (Mesh→Faces→Shade Flat) bryła uzyska właściwy kształt (Rysunek 4.2.10):
Rysunek 4.2.10 Usunięcie niepożądanego zaokrąglenia krawędzi kołpaka
Rysunek 4.2.11 pokazuje efekt — uformowany kołpak śmigła. Nie będziemy wycinać w tej siatce otworów na łopaty. Zrobimy to w o wiele łatwiejszy sposób później, za pomocą tekstury (por. str. 450).
Rysunek 4.2.11 Uformowany kołpak
Zwróć uwagę na dziwne cienie, które pojawiły się wzdłuż ostrej krawędzi. Aby je zlikwidować, włącz we właściwościach tej siatki opcję Auto Smooth (na panelu Normals) lub dodaj kolejny modyfikator o nazwie Edge Split. Więcej na ten temat znajdziesz na str. 974.
Na koniec pozostało nadać nowej części nazwę. W oknie Properties wpisz identyczną nazwę w kontekście obiektu (Rysunek 4.2.12a) i jego siatki (Rysunek 4.2.12b):
Rysunek 4.2.12 Nadanie nazwy obiektowi i jego siatce
Zgodnie z przyjętymi dla tego modelu regułami (patrz str. 825), nadałem kołpakowi nazwę B.005.Hub.
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.02.blend (por. str. 22).
Podsumowanie
Model samolotu formujemy z siatek wygładzonych za pomocą powierzchni podziałowych Catmulla-Clarka (Subdivison Surfaces);
Metoda formowania, którą przedstawiam w tej książce, polega na osiągnięciu zamierzonego kształtu poprzez koleje deformacje prostej siatki początkowej. Uważam, że ta droga jest wygodniejsza i bardziej elastyczna, od formowania “wszystkiego od razu” opartą na krzywych NURBS. (Ten tradycyjny sposób, oparty o powierzchnie NURBS, jest często preferowany przez użytkowników którzy wcześniej mieli co czynienia z systemami CAD). Siatki uzyskane poprzez stopniową deformację zawierają mniej błędów — gdyż znasz ich wszelkie “ukryte zakamarki”;
Ostateczny kształt obiektu uzyskujemy poprzez dodawanie i formowanie kolejnych linii wierzchołków siatki. Dodawanie odbywa się poprzez wytłoczenie nowych krawędzi (Extrude — str. 109) lub wstawienianie w środek siatki nowych sekcji (Loop Cut — str. 111). Dalsze zmiany kształtu powierzchni realizuje się przekształcając poszczególne linie wierzchołków — zazwyczaj za pomocą przesunięcia lub zmiany skali. (W następnej sekcji pokażę jeszcze: obrót i przesunięcie);
Mimo wygładzenia powierzchniami podziałowymi, wybrane krawędzie mogą pozostać ostre, jeżeli zwiększymy wartość ich współczynnika Crease (str. 113). Będzie to potrzebne, bo nawet opływowe kształty samolotów mają mnóstwo ostrych krawędzi;
Każdy obiekt i jego siatka musi mieć unikalny identyfikator — nazwę. Proponuję stosować tu regułę:
<przedrostek>.<numer kolejny>.<nazwa opisowa>[.strona (P lub L) albo numer kolejny],
np. B.005.Hub (szczegóły — str. 825);
Zacznijmy od ukształtowania pojedynczej łopaty śmigła. Będzie skierowana w dół, wzdłuż osi Z. Następnie powielimy ten obiekt dwa razy, tworząc zespół trzech łopat. Podobnie jak w przypadku kołpaka, na podstawie zdjęć naniosłem na plany zmodyfikowane kształt i położenie śmigła. Wśród fotografii wyszukałem ujęcie, w którym łopata była ustawiona (przynajmniej w przybliżeniu) prostopadle do obiektywu. Jej obrys naniosłem na rzut z przodu. Obrys łopaty w rzucie z boku, oraz określenie położenia jej osi względem kołpaka pochodzi ze zdjęcia z boku (Rysunek 18.2.12, str. 1203)1.
Zmień widoczną warstwę z 1 na 2 (p. str. 87). Ustaw kursor 3D w miejscu, które odpowiada końcówce łopaty. Następnie w przyborniku Properties wyzeruj współrzędne kursora: X i Z (w ten sposób najłatwiej jest rzutować kursor na odpowiednie miejsce na osi Y — Rysunek 4.3.1) :
Rysunek 4.3.1 Ustalenie środka łopaty śmigła — poprzez wyzerowanie wybranych wspł.
Po ustaleniu pozycji kursora 3D wstaw w scenę początek łopaty — okrąg o promieniu 0.5 jednostki. Wystarczy, jeżeli będzie miał 8 wierzchołków. Okrąg wstaw w rzucie z góry (Rysunek 4.3.2), a potem wygładź modyfikatorem Subdivision Surface (por. str. 811):
Rysunek 4.3.2 Wstawienie początkowego okręgu
Przejdź do Edit Mode i wytłocz (E — Extrude) okrąg w dół osi Z, na odległość 2 jedn. Potem wytłocz kolejną krawędź wzdłuż osi Z, na odległość ok. 4 jednostek, tworząc następny segment łopaty (Rysunek 4.3.3a). Następnie:
rozciągnij ostatnią sekcję (poprzez zmianę skali) w kierunku X tak, by jej prawa krawędź pokryła się z prawą krawędzią łopaty w tym miejscu rysunku (Rysunek 4.3.3a);
spłaszcz tę sekcję w kierunku Y, tak by osiągnęła 30% szerokości (Rysunek 4.3.3b);
przesuń trzy wierzchołki (G — por. str. 894) z lewej, by dopasować rozmiar tej sekcji do lewej krawędzi obrysu łopaty śmigła (Rysunek 4.3.3).
Powinieneś uzyskać niesymetryczny kształt, przypominający końcówkę odkurzacza (Rysunek 4.3.3):
Rysunek 4.3.3 Początek formowania łopaty — pierwszy przekrój poprzeczny (nie licząc osi).
Teraz przekształcimy kształt sekcji w coś, co będzie przypominać gruby profil lotniczy. W tym celu:
zaznacz krawędzie wychodzące z punktu, który na profilu jest ostrym wierzchołkiem (Rysunek 4.3.4a), i zwiększ ich ostrość (Shift-E) do 1.0;
zaznacz trzy dolne wierzchołki sekcji i spłaszcz je za pomocą zmiany skali (Rysunek 4.3.4b);
Rysunek 4.3.4 Przekształcanie elipsy w profil lotniczy
Nie wiem, jaki profil miało śmigło P-40. Zakładam, że był to, najczęściej spotykany w śmigłach, profil płasko - wypukły. (Tylna powierzchnia łopaty z takim profilem jest płaska)2.
Rysunek 4.3.5 pokazuje ostateczny kształt przekroju łopaty śmigła. To profil, jaki występuje w okolicach 30% promienia (mierząc od osi obrotu). Możesz ten zarys traktować jako wzór dla innych śmigieł, których dokładna geometria nie jest Ci znana. Spód profilu tworzy linię prostą. Punkt, w którym przekrój jest najgrubszy, znajduje się w odległości ok. 30% od krawędzi natarcia.
Ostateczny kształt uzyskałem za pomocą kilku przesunięć wierzchołków siatki. Przesunięcia w kierunku X wykonałem parami — razem wierzchołki: górny i dolny3. Przedni, górny wierzchołek przesunąłem do góry (wzdłuż osi Y), aby przemieścić największe wybrzuszenie przekroju z 50% do 30% szerokości łopaty.
Rysunek 4.3.5 Uformowany profil przekroju łopaty
Wytłocz tak przygotowany profil do końca łopaty. Jej grubość wzdłuż osi Z powinna się szybko zmniejszać. Spłaszcz więc profil końcówki (poprzez zmianę skali w kierunku Y) do 5-8% jej szerokości (Rysunek 4.3.6):
Rysunek 4.3.6 Wytłoczenie łopaty śmigła
Po rozciągnięciu profili łopaty na pełną długość, skoryguj oznaczenia ostrych krawędzi (Rysunek 4.3.7a) Należy zwiększyć wartość Crease dla krawędzi spływu do 1.0 i zmniejszyć ją dla końcowych krawędzi profili (por. Rysunek 4.3.4a, str. 117 — nie jest w tym miejscu już potrzebna). Następnie wstaw w tę siatkę dwie dodatkowe sekcje (Rysunek 4.3.7b). Potem zacznij dopasowywać kształt łopaty do obrysu na planach. Najłatwiej to robić zmieniając skalę w kierunku X połówek poszczególnych sekcji łopaty (Rysunek 4.3.7c). Punktem odniesienia skalowania musi być koniecznie kursor 3D, umieszczony na osi Z! (Przełącz Pivot na 3D Cursor — Rysunek 4.3.7c) . Dodatkowo niektóre sekcje można także nieco przesuwać wzdłuż osi Z.
Rysunek 4.3.7 Kształtowanie obrysu łopaty z przodu
Dalsze formowanie najwygodniej jest przeprowadzić w trybie wyświetlania Wireframe. Dodatkowo można także włączyć opcję Apply during Edit w panelu modyfikatora Subdivison Surface (por. str. 112). W tym trybie dobrze widać kontur, do którego mamy dopasować krawędzie siatki (Rysunek 4.3.8a):
Rysunek 4.3.8 Szczegóły kształtowania obrysu łopaty
Obiekt zaczyna już przypominać swój pierwowzór. Gdy obejrzysz go ze wszystkich stron, znajdziesz miejsca, gdzie są potrzebne drobne korekty. Popatrz, na przykład, na początek krawędzi spływu (Rysunek 4.3.9). W naszym modelu krawędź spływu zachowuje ostrość niemal do końca — do osi obrotu. W oryginalnym samolocie przy kołpaku śmigła rozchodziła się bardziej płynnie, przechodząc w coraz większy promień krzywizny. Należy to poprawić, poprzez zmianę ostrości (crease) jednej z krawędzi siatki:
Rysunek 4.3.9 Zaokrąglanie początku krawędzi spływu łopaty śmigła
Pora na uformowanie zaokrąglonej końcówki. Metod uzyskania takiego kształtu jest wiele, tu zaproponuję jedną z nich. Uważam, że jest dobra, gdyż nie wymaga dodania zbyt dużej liczby nowych wierzchołków.
Zaczynamy od umieszczenia punktu odniesienia — kursora 3D — w nosku profilu końcówki (Rysunek 4.3.10). Następnie wytłocz końcówkę w nową sekcję. Tym razem jednak nie przesuwaj nowego rzędu wierzchołków w jakieś inne położenie: zaraz po wytłoczeniu naciśnij Esc (Rysunek 4.3.11):
Rysunek 4.3.10 Ustawienie kursora 3D w nosku profilu końcówki łopaty | Rysunek 4.3.11 Dodanie nowej sekcji — wytłoczenie i pozostawienie jej w tym samym miejscu |
Zaraz potem (nowa sekcja jest nadal zaznaczona) włącz zmianę skali w kierunku Y (S,Y) względem kursora 3D, i zmniejsz grubość końcowej sekcji do zera (Rysunek 4.3.12a):
Rysunek 4.3.12 Przekształcenie ostatniej sekcji z pętli w pojedynczą linię
W tej chwili w każdym miejscu “ściśniętej” linii znajdują się dwa wierzchołki. Scalmy je ze sobą (W, Remove Doubles — Rysunek 4.3.12b) .
Rysunek 4.3.13 Kształtowanie sekcji końcówki łopaty — c.d.
W ten sposób przekształciliśmy ostatnią sekcję z “pętli” w pojedynczą “linię” wierzchołków. Następnie:
Przesuń końce krańcowej linii tak, by znalazły się w tym samym miejscu, co końce poprzedniej sekcji (Rysunek 4.3.13a);
Scal te wierzchołki (Remove Doubles), aby krańcowa linia stała się przedłużeniem krawędzi natarcia i krawędzi spływu;
Zwiększ ostrość (crease) tej linii do 1.0 (Rysunek 4.3.13a);
Zmniejsz grubość poprzedniej sekcji, aby zmniejszyć promień zaokrąglenia końcówki (Rysunek 4.3.13b).
Zamknęliśmy w ten sposób siatkę łopaty śmigła, uzyskując na końcu odpowiednią grubość.
Pozostaje tylko poprzesuwać odpowiednie grupy wierzchołków w rzucie z przodu, by dopasować się do obrysu z planów (Rysunek 4.3.14):
Rysunek 4.3.14 Zaokrąglanie końcówki łopaty. | Rysunek 4.3.15 Uformowana łopata śmigła. |
Na tym etapie uzyskaliśmy już właściwie uformowaną łopatę śmigła (Rysunek 4.3.15).
Teraz skręcimy ją wzdłuż osi Z . Końcówkę łopaty pozostawimy nie skręconą — to będzie nasza “baza”. Całkowity kąt skręcenia łopaty śmigła — od końca do nasady — to zazwyczaj 30-40º. Rośnie w miarę równomiernie wzdłuż osi Z, choć nieco szybciej w pobliżu osi obrotu śmigła. Zwróć uwagę na położenie kolejnych sekcji na naszej łopacie: taże są bliżej siebie przy osi obrotu. (Zazwyczaj uzyskasz takie taki układ krawędzi dla łopaty o typowym kształcie). Dzięki temu można łatwo uzyskać efekt narastającego skręcenia metodą kolejnych obrotów o stały kąt. Na początek zaznacz prawie wszystkie sekcje poza końcówką (Rysunek 4.3.16a):
Rysunek 4.3.16 Skręcanie łopaty śmigła — początek
Ustaw jako środek tej transformacji (Pivot) kursor 3D, umieszczony w środku łopaty4. Następnie obróć (R, szczegóły — str. 899) zaznaczone sekcje o 10º (Rysunek 4.3.16b).
Teraz wyklucz z zaznaczenia krańcową sekcję (Rysunek 4.3.17a), i powtórnie wykonaj obrót zaznaczenia o kolejne 10º (Rysunek 4.3.17b):
Rysunek 4.3.17 Skręcanie łopaty śmigła — następny krok
Powtarzaj tę operację, za każdym razem zmniejszając obszar selekcji o kolejną sekcję. Rysunek 4.3.18 pokazuje ostateczny efekt skręcenia (osiągnięty po obróceniu ostatniej sekcji)
Rysunek 4.3.18 Ostateczny efekt skręcenia łopaty śmigła
Skręcenie łopaty nie spowodowało zaburzeń w większej części obrysu łopaty z przodu. Problemy tego typu wystąpią w pobliżu nasady śmigła, gdzie kat obrotu sekcji jest już duży (waha się pomiędzy 30 i 45º). To spowodowało pewne zmiany w obrysie łopaty, która przestała pasować do planów (Rysunek 4.3.19a).
Najprościej jest to poprawić, zmieniając wzdłuż osi X skalę sekcji, które znajdują się w tym obszarze (Rysunek 4.3.19b). Podczas skalowania punktem odniesienia musi być oczywiście kursor 3D (Pivot: 3DCursor). Aby nie naruszyć osi łopaty, upewnij się wcześniej, że nadal znajduje się osi Z. Takie skalowanie wzdłuż jednej osi zmienia kształt i kąt pochylenia modyfikowanych profili łopaty, ale są to bardzo nieznaczne różnice. W praktyce trudno nawet je zauważyć.
Rysunek 4.3.19 Poprawianie obrysu w miejscu, gdzie łopata wyraźnie zmieniła kształt (w wyniku skręcenia)
Pierwsza łopata śmigła jest gotowa! Przełącz się z trybu edycji w tryb obiektu (Object Mode, Tab). Włącz dodatkowo widoczność warstwy 1, na której umieściliśmy kołpak śmigła, aby zobaczyć rezultat.
P-40 miał śmigło o zmiennym skoku. Oznacza to, że podczas lotu łopata mogła się obracać wokół osi Z 5. W jakim zakresie kątów? Na pewno była bardziej skręcona — na razie kąt natarcia końcówki wynosi 0º. W niektórych źródłach można się doczytać, że w użytym w P-40 śmigle Curtiss Electric kąt zaklinowania łopaty można było zmieniać od 24 do 49º. Obróćmy więc nasz obiekt o 24º wokół osi Z (R, Z) — w “położenie startowe” (Rysunek 4.3.20):
Rysunek 4.3.20 Ustawianie kąta natarcia łopaty
Jak zwykle po wykonaniu jakiegoś detalu warto go obejrzeć z różnych stron. W wyniku porównań ze zdjęciami, stwierdziłem że łopata śmigła w P-40B/C miała, w okolicy kołpaka śmigła, przekrój niemal okrągły.
Musiałem więc dodać (Loop Cut) dodatkową sekcję tuż za dotychczasową. W ten sposób przyśpieszyłem w tym miejscu przejście kształtu z “profilu lotniczego” w okrąg (Rysunek 4.3.21).
Czas nazwać nasz obiekt — niech to będzie B.010.A.Blade. Litera “A” w nazwie wynika stąd, że śmigło miało trzy łopaty: rozróżnimy je literami A, B, C. Siatka będzie się nazywać B.010.Blade (bez „A”,”B”,”C”) bo drugą i trzecią łopatę stworzymy kopie powiązane (Alt-D: Duplicate Linked — str. 823) obiektu A (Rysunek 4.3.22):
Rysunek 4.3.22 Powielanie łopaty śmigła
Nowo stworzony obiekt obracamy (względem kursora 3D, umieszczonego w osi śmigła) o 120º. Nadaj mu nazwę B.010.B.Blade. Podobnie utwórz trzecią łopatę — B.010.C.Blade.
Każda z łopat jest połączoną kopią pierwowzoru (tzn. wykorzystuje tę samą siatkę). Dzięki temu zmiana kształtu jednej z nich zmieni natychmiast kształt pozostałych. Jeżeli jesteś ciekaw, dlaczego — patrz “Struktura danych modelu i sceny w Blenderze”, str. 1215. Pewnym mankamentem takiego “klonowania” jest brak możliwości przypisania każdej z łopat indywidualnych tekstur czy współrzędnych UV. Na ostatecznym renderingu będą musiały wyglądać identycznie6.
Od razu po stworzeniu nowego elementu, należy wskazać mu jego miejsce w hierarchii części. Przypisz wszystkie trzy łopaty do kołpaka (Ctrl-P: Make Parent — str. 827) .
Na zakończenie warto wspomnieć o zaskakującym (przynajmniej dla mnie) efekcie geometrycznym. Na wszystkich rzutach z boku samolotów, jakie widziałem, jedna z łopat śmigła zawsze zasłaniała drugą. Gdy po raz pierwszy stworzyłem trójłopatowe śmigło w Blenderze, i obejrzałem je w widoku z boku (jak Rysunek 4.3.23), byłem zaskoczony, że łopaty nie do końca się zasłaniają. Czy to miałoby znaczyć, że się gdzieś pomyliłem?
Rysunek 4.3.23 Zaskakujący efekt geometryczny — odsunięcie końcówek łopat!
Sprawdziłem wówczas wszystkie kąty skręcenia, położenia, środki — i nic! Potem zacząłem dokładnie analizować sprawę. Rysunek 4.3.23 pokazuje rezultat tej analizy — jest to zupełnie poprawny efekt skręcenia łopat śmigła. Nie występuje tylko wtedy, gdy skok śmigła jest równy zeru. Wygląda na to, że nikt z autorów planów modelarskich nie uświadomił sobie wcześniej, że trójłopatowe śmigło w rzucie z boku właśnie tak wygląda!
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.03.blend (por. str. 22).
Podsumowanie
Nawet najbardziej skomplikowane kształty — jak łopata śmigła — można uzyskać drogą stopniowego przekształcania bardzo prostego kształtu “wyjściowego”.
Na razie poznałeś dwie metody dodawania nowych wierzchołków: na krawędzi siatki — wytłaczanie (Extrude — str. 118). W środku siatki — wstawianie (Loop Cut. — str. 119).
Podstawowymi metodami edycji wierzchołków są: przesunięcie (Grab — str. 117), zmiana skali (Scale — str. 121), obrót (Rotate — str. 122). Dodatkowo często stosuję zmianę ostrości krawędzi (crease), oraz scalanie (Remove Doubles).
Elementy, których kształt się powtarza (jak łopata śmigła) opłaca się tworzyć jako kopie powiązane (Duplicate Linked — str. 125). W ten sposób łatwiej będzie w przyszłości modyfikować ich kształt, gdyż zmiana jednej powoduje zmianę pozostałych.
Ważnym elementem formowania modelu jest tworzenie hierarchii obiektów, poprzez przypisanie nowo utworzonego obiektu do obiektu nadrzędnego (Parent) (str. 125).
Końcówki łopat śmigła w rzucie z boku mogą się nie pokrywać — i to nie jest błąd (str. 126).
Nim rozpoczniesz formować skrzydło, warto sprawdzić jaki jest jego wznios w rzucie z przodu. Kąt wzniosu skrzydeł naszego P-40 był stosunkowo duży i wynosił 6º (Rysunek 4.4.1):
Rysunek 4.4.1 Wpływ kąta wzniosu na deformację skrzydła w rzucie z góry
Tak duży wznios powoduje widoczne deformacje skrzydła w rzucie z góry. Dlatego do formowania siatki przygotowałem dodatkowy rysunek skrzydła bez wzniosu („położonego płasko” na płaszczyźnie XY). Opracowałem go w oparciu o dostępną dokumentację fabryczną (Rysunek 4.4.2):
Rysunek 4.4.2 Przygotowanie roboczego rysunku skrzydła
Oczywiście, jeżeli nie dysponujesz oryginalnymi rysunkami, można uzyskać taki rzut np. rozciągając w poziomie oryginalny rzut płata o 1/cos(kąta wzniosu). Zazwyczaj autorzy planów nie odwzorowują w rzucie z góry delikatnego wygięcia linii żeber, co tym przypadku zdecydowanie ułatwia w sprawę.
W każdym razie takie „położone” skrzydło i skrzydło na rzucie z góry powinny mieć taką samą cięciwę (por. Rysunek 4.4.2 — pomijam tu wpływ ewentualnego kąta natarcia).
W przypadku P-40 wykorzystanie pomocniczego rysunku skrzydła jest niezbędne do poprawnego wykonania modelu, gdyż deformacja w rzucie z góry jest dość znaczna (Rysunek 4.4.3).
Taki pomocniczy rysunek jest dołączony do tej książki, jako plik source\plans\p40b-highres\wing.png (por. str. 22). W przykładach pokazanych na ilustracjach w dalszych sekcjach książki wykorzystuję jednak jako referencję inny obraz, który uzyskałem w wyniku nieznacznego rozciągnięcia płatów z planów Jacka Jackiewicza.
Skrzydło można by w zasadzie uformować w sposób podobny do tego, który zastosowaliśmy do stworzenia łopaty śmigła. Zaczniemy od stworzenia profilu początkowego, który później wytłoczymy (Extrude) w podstawowy kształt płata — trapez. Zazwyczaj w opisach konstrukcji samolotu można znaleźć szczegółowe informacje, jaki profil lotniczy został w niej zastosowany. W przypadku P-40 był to: NACA-2215 u nasady i NACA-2209 na końcówkach. Obrys NACA-2215 centropłata naniosłem na plany (por. Rysunek 18.2.14, str. 1205). NACA-2209 to w istocie “spłaszczony” o 40% NACA-2215 (więcej na ten temat znajdziesz na str. 1240, w dodatku “Kształt profili lotniczych (metody odwzorowania)”, a o rodzinie profili NACA — na str. 1242).
Kształt profilu płata można odwzorować za pomocą linii podziałowej, opartej na siatce złożonej z niewielu (nawet kilkunastu) punktów. Czy należy się koncentrować na uzyskaniu siatki o jak najmniejszej liczbie wierzchołków? Można do tego dążyć. Tylko, mimo pozorów, taki efekt nie będzie najwygodniejszy na dalszych etapach pracy. Najlepiej jest, gdy jak najwięcej linii siatki skrzydła pokrywa się z głównymi liniami konstrukcyjnymi, widocznymi na planach. To ułatwi w przyszłości rysowanie tekstury nierówności (z paneli i nitów), a także wykonywanie otworów — lotek, klap, czy podwozia. Formowanie płata zaczniemy więc od narysowania płaskiego, “testowego” trapezu, który pozwoli nam “przymierzyć” położenie wierzchołków wzdłuż profilu płata.
Sądzę, że najlepszym miejscem na środek (punkt odniesienia) płata będzie punkt o współrzędnych X=0, Y=01. Umieść tam kursor 3D. Następnie wstaw w tym punkcie, w rzucie z góry, kwadrat (Add→Mesh→Plane — str. 813). Przełącz się w tryb edycji (Rysunek 4.4.4a) i powiększ go do szerokości skrzydła (Rysunek 4.4.4b):
Rysunek 4.4.4 Początek formowania płata — kwadrat
Najpierw przesuń kwadrat ponad płat, aby jego lewy górny narożnik znalazł się na krawędzi spływu. Zrób to w Edit Mode (aby środek obiektu ma pozostać w tym samym miejscu). Umieść tam kursor 3D (zaznacz tylko ten wierzchołek, a następnie wywołaj Shift-S, Cursor to Selected). Potem powiększ (Scale) cały kwadrat tak, by jeden z jego boków stał się cięciwą płata w pobliżu kadłuba (Rysunek 4.4.4b).
przesuń prawy boku kwadratu do końca rozpiętości płata (tzn. w kierunku X, w prawo);
przesuń jego wierzchołki w pionie (wzdłuż osi Y) tak, by przekształcić ten kwadrat w trapez, którego górna i dolna krawędź pokrywają się się z krawędziami płata (Rysunek 4.4.5a);
Rysunek 4.4.5 Nanoszenie linii, odpowiadających podłużnicom płata
Wstaw (za pomocą polecenia Loop Cut) dodatkowe krwędzie wewnątrz trapezu. Umieść je wszędzie tam, gdzie na planach są narysowane istotne linie konstrukcyjne. Rysunek 4.4.5b) pokazuje pierwsze z nich.
Potem:
dosuń lewy bok trapezu do osi kadłuba (ustw kursor 3D w punkcie 0,0,0, przełącz Pivot Point na 3D Cursor, zaznacz wierzchołki lewej krawędzi i zmniejsz ich skalę do 0 w kierunku osi X);
zwiększ jego rozmiar w kierunku Y tak, by po tej zmianie uzgodnić górną i dolną krawędź trapezu z krawędziami płata;
Rysunek 4.4.6 pokazuje efekt tych operacji:
Rysunek 4.4.6 Trapez “testowy” — w celu dopasowania się do układu podłużnic płata
Wierzchołki, połączone liniami siatki, są umieszczone w tej samej proporcji (% cięciwy płata) na obydwu krańcach trapezu. Rysunek 4.4.6 pokazuje, że te “południki” niemal idealnie pasują do odpowiednich linii konstrukcyjnych. Ten efekt nie jest przypadkowy. Każdy inny kierunek na wypukłej powierzchni płata nie jest linią prostą. Podłużnica, która nie biegnie w kierunku “południkowym” jest w prawdziwym samolocie o wiele trudniejsza do wykonania. Co prawda tam, gdzie wypukłość płata jest niewielka — w pobliżu krawędzi spływu — mogą się zdarzyć podłużnice biegnące w innym kierunku. Rysunek 4.4.6 pokazuje, że w P-40 były to krawędzie klap.
Jedynym elementem stworzonego trapezu, którego potrzebujemy do dalszej pracy, jest linia biegnąca wzdłuż postawy płata (Rysunek 4.4.6). Przekształcimy ją w profil poczatkowy. Usuń wszystkie pozostałe wierzchołki siatki, by pozostały z niej tylko krawędzie leżące na osi samolotu. Jako rysunek referencyjny rzutu z boku załaduj source\plans\p40b-highres\Left (gear).png. Następnie:
przesuń tę linię wierzchołków o jedną jednostkę do góry;
skopiuj wierzchołki pozostawionej linii w nową linię (Shift-D, Mesh→Duplicate, str. 909) , i przesuń o 2 jednostki do dołu (by każda z linii leżała po przeciwnych stronach środka obiektu — Rysunek 4.4.7);
połącz obydwa krańce tych linii krawędziami (F, Mesh→Edges→Make Edge/Face, str. 923) ;
podziel te nowo utworzone krawędzie za pomocą dodatkowych wierzchołków (W, Mesh→Edges→Subdivide, str. 910): jednego na przedniej i dwóch na tylnej krawędzi;
Rysunek 4.4.7 Obrys, przygotowany do przekształcenia w profil
Rysunek 4.4.7 przedstawia obrys, który powinieneś przygotować . Przednia krawędź ma wierzchołek dokładnie w połowie długości, czyli dla Z = 0. Powstanie z niego linia krawędzi natarcia. Tylne połączenie obrysów: górnego i dolnego, składa się aż z 4 wierzchołków. Powstanie z nich krawędź spływu. Te cztery wierzchołki ustaw tak, jak na ilustracji — ich wysokość nie powinna przekroczyć 0.05 jednostki Blendera (czyli 5 mm na “prawdziwym” samolocie). Po włączeniu wygładzenia powierzchni, utworzą zaokrąglenie o promieniu ok. 0.03 jednostek Blendera (czyli 3 mm na “prawdziwym” samolocie)2.
Rysunek 4.4.8 Ustawienie obrysu w pozycji właściwej dla płata
Teraz przekształcimy obrys w poprawny profil płata. Przełącz się w tryb obiektu (Object Mode). Obróć obrys wokół osi X o -1º. Następnie przesuń go do dołu, aby znalazł się w osi płata (Rysunek 4.4.8).
Najłatwiej jest to zrobić, ustawiając krawędź spływu w punkcie, gdzie na planach jest krawędź spływu profilu centropłata (Rysunek 4.4.8).
Przełącz się z powrotem w tryb edycji (Edit Mode). Włącz wygładzenie linii (dodając modyfikator Subdivision Surface) i ustaw jego poziom (Subdivisions) na 2. Włącz tryb wyświetlania Wireframe (Z), by oprócz linii siatki, zobaczyć na ekranie także cienką, wygładzony kontur efektywnego kształtu. Spróbuj najpierw odwzorować profil płata, przesuwając tylko istniejące wierzchołki. Nie zmieniaj ich pozycji względem cięciwy profilu (lokalnej osi Y), gdyż pod tym względem zostały już “ustawione”. Możesz je jedynie przesuwać wzdłuż lokalnej osi Z (kombinacja G,Z,Z — Rysunek 4.4.9):
Rysunek 4.4.9 Formowanie profilu — przesuwanie wierzchołka wzdłuż lokalnej osi Z
Czasami do uzyskania ostatecznego kształtu okaże się konieczne dodanie do obrysu dodatkowego wierzchołka. Najłatwiej to zrobić poprzez podział odpowiedniej krawędzi (Subdivide). Te dodatkowe wierzchołki nie mają odwzorować żadnej konkretnej linii konstrukcyjnej. Możesz więc je swobodnie przesuwać, zarówno wzdłuż lokalnej osi Z, jak i osi Y.
Oryginalne wierzchołki, które możesz tylko przesuwać w kierunku Z, poznasz po tym, że występują “parami”. Każdemu takiemu wierzchołkowi na dolnym obrysie profilu odpowiada wierzchołek na górnym obrysie profilu. Obydwa leżą w tym samym miejscu lokalnej osi Y (Rysunek 4.4.9).
Rysunek 4.4.10 przedstawia fragment obrysu profilu płata, w trakcie dopasowywania do zadanego konturu. Jako pomoc w uzyskaniu odpowiedniego kształtu, umieściłem w nosie profilu pomocniczy okrąg (usunę go, gdy skończę). Podczas formowania okazało się, że niezbędne jest dodanie dodatkowego wierzchołka, pokazanego na ilustracji.
Rysunek 4.4.10 Formowanie nosa profilu — przykład wstawienia dodatkowego wierzchołka
Ustawiając kolejne wierzchołki od krawędzi natarcia do krawędzi spływu profilu, szybko dopasujesz obrys do założonego konturu (Rysunek 4.4.11) :
Rysunek 4.4.11 Uformowany profil płata
W tym przykładzie udało nam się odwzorować dokładnie profil płata za pomocą 32 wierzchołków. To dość typowy rezultat.
Większość dalszych prac będzie nam łatwiej wykonywać, gdy płat nie będzie pochylony o -1º. W związku z tym przełącz się w Object Mode i zmień kąt pochylenia na 0º. Przesuń ten obiekt z powrotem do środka układu współrzędnych. To ułatwi odczyt współrzędnych góry i dołu płata (jedne będą dodatnie, a drugie — ujemne). Dalsze przekształcenia siatki będą wykonywane w oparciu o rzut z góry i z przodu. Dopiero po ostatecznym uformowaniu umieścimy płat w docelowym miejscu konstrukcji i tam go “zaklinujemy” pod katem -1º.
Zgodnie z dokumentacją, profilem końcówki płata był NACA-2209. Ten symbol oznacza taki sam kształt, jak NACA-2215, tylko “spłaszczony” o 40%. Podczas ustalania grubości płata przyda nam się jakiś dokładny wzór, aby sprawdzić, czy osiągnęliśmy właściwą grubość. Na plany nie ma w tym przypadku co liczyć — rzuty z przodu zazwyczaj pokazują grubość płata niepoprawnie. Zresztą, nawet gdyby autor starał się być dokładny, to powinien narysować kształt skrzydła pochylonego o 1º. Zróbmy więc nasz własny wzorzec grubości skrzydła. Będzie to kopia obrysu, który właśnie ukończyliśmy:
skopiuj (Shift-D) profil podstawy w nowy obiekt;
otwórz przybornik Properties (N) i w panelu Transform zmień jego rozmiar (Dimensions): w kierunku Y do 10.0, a Z — do 0.9 (w ten sposób uzyskujemy profil końcówki o grubości 9%: NACA-2209).
Rysunek 4.4.12 pokazuje, jak na tym etapie powinien wyglądać nowy profil:
Rysunek 4.4.12 Pomocniczy wzorzec profilu końcówki płata
O jakim konkretnie miejscu myślał autor opisu technicznego P-40, pisząc że grubość profilu na końcu płata wynosiła 9%? Proponuję założyć, że chodzi tu o ostatnie żebro przed obszarem zaokrąglonej końcówki. Przesuń wzorzec końcówki w to miejsce (współrzędne Y i Z środka mają pozostać = 0,0). Następnie powiększ cały obiekt — we wszystkich kierunkach, względem środka obiektu — aby dopasować krańce profilu do obrysu płata. Najprościej to zrobić poprzez zmianę skali (S — Rysunek 4.4.13, por także str. 821):
Rysunek 4.4.13 Ustalenie położenia i rozmiaru wzorca końcówki
Dzięki proporcjonalnemu powiększeniu profilu we wszystkich kierunkach, masz pewność, że jego grubość względna nadal wynosi 9%.
Stwórz podstawowy obrys skrzydła, wytłaczając profil centropłata wzdłuż osi X (E,X). Sekcję końcową pozostaw nieco poza konturem skrzydła, przedstawionym na planach (Rysunek 4.4.14). (Ten nadmiar zostanie usunięty przy okazji odcinania końcówek płata).
Następnie upewnij się, że kursor 3D jest w środku układu współrzędnych (Rysunek 4.4.14). Zmniejsz skalę końcówki w kierunku Y tak, by pasowała do konturu płata w rzucie z góry. Potem zacznij zmieniać skalę końcówki w kierunku osi Z. W rzucie z przodu obserwuj położenie końców szablonu i linii siatki:
Rysunek 4.4.14 Wytłoczenie (Extrude) podstawowego kształtu płata
Dochodzenie do właściwej grubości końcówki można wykonać stopniowo, w kilku krokach. Podczas ostatniej fazy śledź jedną z końcówek wzorca w możliwie dużym powiększeniu (Rysunek 4.4.15). Aby lepiej widzieć kontur siatki i profilu końcówki, włącz w modyfikatorze Subsurf skrzydła opcję Apply during Edit (por. str. 112). W połączeniu z trybem wyświetlania Wireframe (Z) pozwoli to precyzyjnie dopasować skalę w rzucie z przodu.
Rysunek 4.4.15 Dopasowanie grubości końcówki płata do zadanego wzorca
Ten etap formowania skrzydła jest zakończony, gdy powierzchnia płata pokryje się z tymczasowym 9% profilem, który umieściliśmy przy końcówce. Gdy to osiągniesz, usuń ten pomocniczy obiekt. Wykonał już swoje zadanie, i nie jest nam dłużej potrzebny.
Pozostało uporządkować jeszcze sprawę kształtu krawędzi spływu. Obróć aktualną projekcję i ustaw ją tak, by krawędź spływu stała się niemal prostopadła do płaszczyzny widoku. Zobaczysz wówczas to, co pokazuje Rysunek 4.4.16a: promień zaokrąglenia na końcówce jest kilka razy mniejszy od analogicznego zaokrąglenia u nasady płata. Technologicznie jest to niemożliwe — krawędź spływu jest zazwyczaj uformowana przez wygięcie blachy pokrycia, z jakimś stałym promieniem. Powiększ wszystkie cztery punkty końcówki względem ich naturalnego środka (Pivot: Bounding Box Center) w kierunku osi Z. Dodatkowo przesuń odrobinę dwa zewnętrzne wierzchołki do przodu wzdłuż osi Y. Utworzą w ten sposób identyczny obrys, jak na początkowym profilu skrzydła (Rysunek 4.4.16b):
Rysunek 4.4.16 Ujednolicenie promienia na krawędzi spływu
W efekcie uzyskałeś wzdłuż krawędzi spływu stały promień zaokrąglenia — w realnym samolocie miałby średnicę ok. 3mm. To bardzo mały promień - nie jestem pewien, czy można aż tak zagiąć blachę pokrycia (zazwyczaj ok. 1mm grubości) bez ryzyka pęknięcia duralu. Mimo ogromnej liczby zdjęć konstrukcji nie byłem w stanie określić, czy krawędź spływu była uzyskana poprzez zagięcie, czy też znitowanie górnej i dolnej powłoki płata. Zresztą nawet taką “kanciastą”, znitowaną krawędź często poddaje się oszlifowaniu, uzyskując koniec końców zaokrąglenie.
Czy powiększenie promienia krawędzi spływu bardzo zaburzyło profil tylnej części końcówki? Gdy zmniejszysz nieco powiększenie, zobaczysz że na szczęście nic takiego się nie stało (Rysunek 4.4.17). Tylna, dolna krawędź przekroju płata z lekko wypukłej linii stała się linią prostą — ot, i wszystko:
Rysunek 4.4.17 Rozmiar zaokrąglenia końcówki — ujęcie, pozwalające ocenić skalę.
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.04.blend (por. str. 22).
Podsumowanie
Jeżeli skrzydła modelowanego samolotu mają wznios większy niż 2-3º, przygotuj dla nich odrębny rysunek referencyjny. Możesz go stworzyć z rysunków fabrycznych (o ile je masz), lub rozciągając wzdłuż rozpiętości o odpowiedni współczynnik (1/cos(kąt wzniosu)) oryginalne plany (str. 127);
Warto się postarać, by jak najwięcej linii siatki skrzydła — “żeber” i “podłużnic” — pokrywało się krawędziami paneli i liniami nitów, widocznymi na planach. To ułatwi w przyszłości przygotowanie tekstur, odwzorowujących te detale.
Zaczęliśmy się od “testowego”, płaskiego obrysu skrzydła. Posłużył nam do podjęcia decyzji o rozłożeniu wierzchołków wzdłuż profilu płata (str. 129). Efektem tej “przymiarki” było przygotowanie odpowiedniego rozkładu podłużnic dla siatki skrzydła.
Właściwe formowanie skrzydła zaczynamy od uformowania profilu jego podstawy (zazwyczaj podstawa płata leży w osi samolotu). Profil to linia zamknięta, wygładzona modyfikatorem Subsurf. Podczas kształtowania tej linii dodajemy do jej obrysu dodatkowe wierzchołki, aby uzyskać odpowiedni kształt krzywej (por. str. 132).
Po stworzeniu profilu podstawy płata należy przygotować profil końcówki (str. 132)
Podstawowy kształt płata — trapez — uzyskujemy poprzez wytłoczenie (Extrude) profilu podstawy, rozciągając go na całą rozpiętość skrzydła. Potem dopasowujemy koniec (poprzez zmianę skali) do zadanych rozmiarów profilu końcówki (str. 133).
Na krawędzi spływu skrzydła lepiej pozostawić małe, “technologiczne” zaokrąglenie. Powinno mieć promień rzędu milimetrów (wyrażając to w jednostkach rzeczywistego samolotu).
Do powielenia wierzchołków służy polecenia Duplicate (Shift-D, str. 130). Powielane są także zaznaczone krawędzie i ściany.
Podczas pracy z linią wierzchołków przydatne są operacje: stworzenia nowej krawędzi (F, Make Edge, str. 130), wstawienia nowego wierzchołka (W, Subdivide odpowiedniej krawędzi — str. 131).
Końcówki płata P-40 nie da się uformować tak łatwo, jak końcówki łopaty śmigła. Po pierwsze, jest o wiele większa. Drobne nieścisłości kształtu, które “uchodzą” w przypadku małej końcówki łopaty, tu stałyby się zbyt widoczne. Po drugie, końcówka płata P-40 jest lekko wygięta do góry. Zrobiono to jednak w taki sposób, że linia górnej powierzchni płata pozostaje prosta (Rysunek 4.5.1):
Rysunek 4.5.1 Specyficzny, wygięty do góry kształt końcówki płata P-40
Przyjrzałem się temu fragmentowi na wielu zdjęciach. Doszedłem do wniosku, że najbezpieczniej będzie uzyskać ten obrys poprzez odcięcie nadmiaru siatki, tak, by górna krawędź płata pozostała nie zdeformowana. Potem wygnę dolną krawędź końcówki do góry, tworząc w rzucie z przodu charakterystyczne, lekkie wybrzuszenie.
Nim odetniemy końcówkę, nanieśmy na ten obszar siatki kilka dodatkowych sekcji (“żeber”) — za pomocą polecenia Loop Cut (Rysunek 4.5.2):
Rysunek 4.5.2 Dodatkowe sekcje, dodane do siatki płata
Sekcję A naniosłem z myślą o przyszłości — przyda się przy formowaniu lotki, a B — tam, gdzie się zaczynają zaokrąglenia. Sekcję C wstawiłem u podstawy końcówki płata, a D — tam, gdzie się później przyda do kształtowania obrysu.
Patrząc na ten rzut z góry nie dziw się, że widzisz dwie linie obrysu końcówki. Czarna linia pochodzi z oryginalnych planów, które okazały się niedokładne (por. str. 1208). Ten drugi obrys w kolorze czerwonym — to moja poprawka, do której będziemy dopasowywać końcówkę.
W ramach dalszych przygotowań krawędź spływu zmodyfikujemy końcówki tych żeber, by stworzyć na niej jeszcze jeden punkt, i rozłożyć pozostałe punkty bardziej równomiernie. (Inaczej trudno byłoby uzyskać odpowiedni kształt konturu płata). Utwórz przy sekcjach C i D trzy dodatkowe, lokalne linie wierzchołków — poprzez nacięcie (Shift-K, Knife — str. 907). Wszystkie powinny być równoległe do widocznej na planie krawędzi lotki (Rysunek 4.5.3a):
Rysunek 4.5.3 Pochylenie żeber w tylnej części skrzydła
Potem zaznacz i usuń (X, Delete→Limited Dissolve, str. 917) końcówki oryginalnych sekcji D i C, aby włączyć w nie nowe krawędzie (Rysunek 4.5.3b). Zwróć uwagę, że żadna z tych modyfikacji nie zmieniła kształtu górnej powierzchni płata!
Teraz przygotuj pomocniczy “nóż” do odcięcia końcówki. Siatkę tego obiektu utwórz poprzez złożenie fragmentów kilku okręgów (o środkach jak na planach) (Rysunek 4.5.4a):
Rysunek 4.5.4 Przygotowanie obiektu odcinającego końcówkę płata
Uzyskaną linię wytłocz (Extrude). Obiekt umieść w odpowiednim położeniu (Rysunek 4.5.4b).
Krawędź przecięcia powierzchni płata z tą pomocniczą powłoką uzyskamy za pomocą dodatku do Blendera o nazwie Intersection. Jest dostarczony wraz z tą książką (source\scripts\addons\object_intersection.py — por. str. 22). Powinieneś go znaleźć w sekcji Addons: Object (por. str. 767) i aktywować.
Krawędź przenikania pomocniczego obiektu z powierzchnią płata wyznaczymy używając polecenia Intersection (z menu Specials — por. str. 829). Opcje skryptu ustaw tak, by uzyskać wyłącznie punkty przecięcia z krawędzi skrzydła (Rysunek 4.5.5):
Rysunek 4.5.5 Rezultat przecięcia - nowa krawędź
Po wyznaczeniu krawędzi przecięcia, możesz już usunąć obiekt, którego użyliśmy jako “noża”. Uzyskana krawędź nie należy na razie do żadnej ściany siatki skrzydła. Aby ją do niej włączyć:
Zaznacz i usuń ostatnią sekcję płata (Rysunek 4.5.5);
Usuń także niepotrzebne, krańcowe wierzchołki z linii przecięcia (Rysunek 4.5.5);
Złącz linię przecięcia z odpowiednimi podłużnicami skrzydła za pomocą czterech nowych krawędzi (Rysunek 4.5.6a)
Utwórz z poszczególnych wierzchołków nowe ściany (zaznaczając po trzy lub cztery i naciskając F — str. 921). Wkomponuj w ten sposób krawędź w płat (Rysunek 4.5.6b);
Rysunek 4.5.6 Scalenie nowej krawędzi z resztą siatki
Rysunek 4.5.6b) przedstawia efekt operacji. Mówiąc szczerze, wtyczkę Intersection napisałem, ponieważ nigdy nie lubiłem efektów operacji Boolean w Blenderze. Zawsze lepiej mieć pełną kontrolę nad siatką, i nadać jej dokładnie taki układ wierzchołków, jaki sobie życzymy.
Teraz dopasujemy krawędź spływu końcówki do obrysu w rzucie z góry. Zaczniemy od dwóch nie naruszonych sekcji z oryginalnej siatki. Należy przemieścić ostatnie wierzchołki tych żeber tak, by znalazły się tylko odrobinę poza obrysem (Rysunek 4.5.7a).
Pamiętaj, że każdy z węzłów siatki, widoczny w rzucie z góry, to dwa wierzchołki — na górnej i dolnej powierzchni płata. Zaznaczaj je więc jako grupę, np. używając C (Circle select — por. str. 891). Należy przesunąć je tak, by wygięcie siatki było płynne. Wierzchołki po przesunięciu powinny leżeć na tej samej linii żebra, tylko bliżej środka. Można to zrobić poprzez przesunięcie (G) — zaznaczając oddzielnie każdy z węzłów. To najbardziej oczywista, ale trudniejsza droga (trudno zachować dokładną współliniowość z linią żebra). Znam szybszą metodę:
umieść w pierwszym z wierzchołków linii żebra, który nie jest przesuwany, kursor 3D (zaznacz go, a następnie wywołaj Shift-S, Cursor to Selected);
zaznacz wierzchołki końcówki żebra, które mają być przesunięte (por. Rysunek 4.5.7a);
przełącz aktualny środek transformacji (Pivot Point) na 3D Cursor;
zmień skalę zaznaczonych wierzchołków by znalazły się w nowym miejscu. (Po wywołaniu polecena Resize klawiszem S, naciśnij Shift-Z aby zablokować zmiany wzdłuż osi Z). Rezultat powinien wyglądać tak jak to pokazuje Rysunek 4.5.7a);
Szczegóły tej metody „przesuwania poprzez skalowanie” i ograniczenia zmiany skali do płaszczyzny znajdziesz na str. 897.
Tą metodą dopasuj po kolei każde z żeber (zacznij od zewnętrznego). Rysunek 4.5.7b) pokazuje rezultat, który powinieneś osiągnąć:
Rysunek 4.5.7 Dopasowanie tylnej krawędzi końcówki do obrysu w rzucie z góry
Potem pozostają doszlifowanie szczegółów (Rysunek 4.5.7b):
stwórz dwie brakujące, trójkątne ściany (na górnej i dolnej powierzchni płata);
poprzesuwaj wierzchołki krawędzi spływu tak, by dokładnie dopasować obrys wygładzonej siatki do rysunku;
Pamiętaj, że krawędź spływu każdego żebra to cztery leżące blisko siebie wierzchołki! Zaznaczaj je jako grupę i razem poddawaj każdej transformacji.
Czas dodać ściany, z których (w rzucie z przodu) za chwilę powstanie zaokrąglenie końcówki płata. Zaokrąglenie to było niewielkie — miało promień rzędu centymetra. Stwórz dwie nowe krawędzie wytłaczając (Extrude) krawędź końca płata do dołu, wzdłuż osi Z. Zachowaj niewielką odległość pomiędzy tymi liniami — około 0.1 jednostki Blendera (Rysunek 4.5.8a):
Rysunek 4.5.8 Łączenie krawędzi — natarcia i spływu
Z przodu i z tyłu pozostały w siatce luki, które aż się proszą o uzupełnienie. Utwórz w tych miejscach nowe ściany (Rysunek 4.5.8b, c).
Dodaj teraz do górnej powierzchni płata nową sekcję (Rysunek 4.5.9). Użyj w tym celu polecenia Loop Cut, by nie zmienić kształtu górnej powierzchni skrzydła. Nową sekcję umieść w pobliżu końcówki — będzie wyznaczała granicę zaokrąglenia. Aby wyrównać jej odległość od końcówki, przesuń trochę jej krańcówe wierzchołki (Shift-V — Vertex Slide, p. str. 912):
Rysunek 4.5.9 Dodatkowa sekcja na powierzchni górnej
Rysunek 4.5.9 pokazuje linię po scaleniu trójkątnych ścian w okolicach jej końcówek (Alt-J — Tris to Quads, p. str. 924). Dzięki tej operacji ta sekcja jest połączona z “podłużnicami”.
Podobną operację wykonamy także na dolnej powierzchni: wstaw nową sekcję za pomocą polecenia Loop Cut. Uzyskaną linię umieść jednak w połowie odległości pomiędzy sąsiednimi sekcjami — posłuży nam do sterowania wygięciem tej powłoki (Rysunek 4.5.10):
Rysunek 4.5.10 Dodatkowa sekcja na powierzchni dolnej
Tak, jak w przypadku sekcji z powierzchni górnej, scal trójkątne ściany na jej końcach w czworokąty (Alt-J, p. str. 924) . Usuniemy w ten sposób z siatki wierzchołki, z których wychodzą więcej niż 4 krawędzie. (Takie punkty zazwyczaj odrobinę zaburzają kształt wygiętej powłoki podziałowej).
Powoli zbliżamy się do uzyskania ostatecznego kształtu. Teraz wygniemy dolną powierzchnię końcówki, zbliżając ją do górnej. Przełącz się na rzut z przodu (ZX). Umieść kursor 3D na krawędzi natarcia (Rysunek 4.5.11). Obróć wokół tego punktu taki “pas” ścian dolnej powierzchni, jak ten podświetlony na ilustracji poniżej (Rysunek 4.5.11):
Rysunek 4.5.11 Wyginanie powierzchni dolnej (poprzez obrót wybranych sekcji)
(W tym rzucie wygląda to trochę jak zamykanie szczęk krokodyla). Najpierw obróć obydwie zaznaczone krawędzi o kilka stopni (2º - 3º), potem samą końcówkę o kolejnych 10-12º. Nie “domykaj” jej jednak do końca — pozostaw pomiędzy górną i dolną krawędzią odstęp rzędu 0.1 jednostki Blendera.
Szczelinę, która pozostała, wypełnij rzędem nowych ścian, zamykając w ten sposób siatkę (Rysunek 4.5.12).
Teraz możemy przesunąć wzdłuż osi X górną i dolną krawędź obrysu (nie więcej niż o 0.1 - 0.2 jedn.) (Rysunek 4.5.12). Uzyskamy w ten sposób zaokrąglenie krawędzi płata.
Rysunek 4.5.12 Ostateczne domknięcie końcówki rzędem ścian wzdłuż obwodu
Przy okazji zdecydowałem się usunąć trójkątną ścianę z krawędzi natarcia. Po przemyśleniu udało mi się dobrać w tym miejscu układ ścian czworokątnych (Rysunek 4.5.12).
Pozostało dokonać ostatnich dopasowań do obrysu z góry (Rysunek 4.5.13). W ich trakcie:
oznaczyłem całą sekcję C, biegnącą jako podstawa końcówki, jako “ostrą” (crease = 1.0). W ten sposób wszelkie zmiany końcówki nie zmienią kształtu reszty skrzydła;
wygiąłem końce sekcji D, aby uzyskać lepsze dopasowanie do konturu płata, przedstawionego na planach (uzyskać punkt sterujący w odpowiednim miejscu);
dodałem małą krawędź na krawędzi spływu lotki. (W wyniku wyostrzenia krawędzi C potrzebny był dodatkowy punkt sterujący wzdłuż otworu lotki, aby dopasować znów powierzchnię do obrysu płata);
Rysunek 4.5.13 Ostateczne dopasowanie krawędzi końcówki do obrysu z góry
Wybrzuszeniem dolnej powierzchni końcówki można sterować za pomocą skalowania (wzdłuż osi Z) krawędzi, pokazanych na ilustracji (Rysunek 4.5.14):
Rysunek 4.5.14 Możliwe kształtu wybrzuszenia powierzchni dolnej
Na koniec obejrzyj ze wszystkich stron uzyskany kształt. Nie sugeruj się tu planami samolotu, bo akurat w tym miejscu są błędne. Porównuj raczej ten fragment ze zdjęciami.
Rysunek 4.5.15 przedstawia ostateczny efekt — końcówkę w widoku przodu:
Rysunek 4.5.15 Rezultat — uformowana końcówka (widok z przodu)
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.05.blend (por. str. 22).
Końcówka płata P-40 jest dość trudna do uformowania, ponieważ jej górna powierzchnia jest prostą kontynuacją górnej powierzchni. Większość zakończeń skrzydeł w innych samolotach ma mniej skomplikowany kształt.
Zawsze należy umieścić nowe sekcje siatki (“żebra”) tam, gdzie znajdują się ważne miejsca konstrukcji. (Ważne zarówno pod względem budowy płatowca — np. krawędź lotki, jak i geometrycznym — np. początek zaokrąglenia). Czasami także dodajemy żebro dla uzyskania równomiernego rozkładu wierzchołków wzdłuż krzywizny (str. 136).
Niektóre krawędzie (sekcje) siatki mogą być lokalne (tzn. istnieć tylko na obszarze kilku sąsiednich ścian). Niezastąpionym narzędziem do ich tworzenia jest Knife (Shift-K, str. 137). Często “przy okazji” usuwamy fragmenty innych sekcji (Erase→Edgeloop).
Zasadniczy kształt końcówki uzyskaliśmy przez odcięcie części siatki pomocniczym obiektem o kształcie założonego obrysu (str. 137). Wykonane to zostało w trzech krokach. Najpierw wyznaczyliśmy krawędź przecięcia za pomocą skryptu Intersection (str. 138). Potem usunęliśmy niepotrzebne wierzchołki (Delete→Vertices). Na koniec połączyliśmy krawędź przecięcia z resztą siatki, tworząc nowe ściany (F, Make Face — str. 138)
Ostateczne “zamknięcie” siatki końcówki nastąpiło w wyniku dosunięciu kilku dolnych sekcji do górnych (str. 141) i uzupełnieniu brakujących ścian.
Podczas pracy z siatką w dużym zakresie używaliśmy ograniczenia transformacji (przesunięcia, skalowania) do pojedynczej osi X, Y, Z. Taka technika pozwala “pracować w przestrzeni” bez konieczności ciągłego korzystania z rzutów z góry, przodu czy boku.
Zwróć uwagę, że można bezpiecznie podzielić kształtowanie powierzchni podziałowych na oddzielne płaszczyzny. Najpierw uformowaliśmy obrys z góry końcówki (płaszczyzna XY). Potem ukształtowaliśmy ten sam element w rzucie z przodu (ZX). Kształt w rzucie z góry, nie ulegał żadnej zmianie, dopóki przesuwaliśmy wierzchołki obrysu wyłącznie wzdłuż osi Z. To żaden przypadek, tylko reguła, której znajomość może Ci bardzo ułatwić modelowanie (szczegóły — str. 1236).
Lotkę warto wydzielić z płata jako oddzielny obiekt. Dlaczego? Po pierwsze — zazwyczaj jest w ruchu. Model będzie wyglądać bardziej realistycznie z nieco poruszonymi lotkami. Po drugie — w samolotach opracowanych w po roku 1930 (a do nich zalicza się P-40) stosowane były tzw. lotki szczelinowe. Ich nazwa wzięła się od dużej szczeliny pomiędzy krawędzią lotki i płatem1. Szczelina lotki ma dość znaczne rozmiary na dolnej powierzchni płata, i pominięcie jej w modelowaniu byłoby poważną niedokładnością. Na pewno to zbyt duża “dziura”, aby ją zbyć w uproszczony sposób, np. linią na teksturze.
Już prędzej można byłoby w ten sposób uprościć inny element mechanizacji płata — klapy2. Aby można było je dodać w ramach uszczegóławiania modelu umieszczę na siatce dodatkową krawędź, biegnącą wzdłuż ich osi.
Przygotowując lotkę, dodamy do siatki płata dwie następne sekcje, pełniące rolę żeber, i jedną podłużnicę (Rysunek 4.6.1):
Rysunek 4.6.1 Dodatkowe sekcje, związane z przygotowaniem lotki
Żebro A już istnieje (utworzone w poprzedniej sekcji — p. str. 136, Rysunek 4.5.2). Wstaw teraz (Loop Cut) żebro C — tylko po to, aby następne żebra wstawiane od strony osi samolotu były proste. Przy końcówce żebra A natnij (Knife) dodatkową, pochyloną krawędź lotki. Na koniec usuń prostą końcówkę żebra A (por. Rysunek 4.6.1) — tak jak to zrobiliśmy poprzednio, na str. 137. Istnieją już także podłużnice 1, 2, biegnące wzdłuż dolnej i górnej krawędzi lotki. Krawędź klap (krawędź b)to przekątna pomiędzy tymi podłużnicami (por. Rysunek 4.6.1). Zaznacz dwa przeciwległe wierzchołki pomiędzy podłużnicą 1 i żebrem A oraz podłużnicą 2 i żebrem początkowym na dolnej powierzchni skrzydła. Połącz je poleceniem Vertex Connect (J). Powstawnie w ten sposób nowa krawędź b. (Przy okazji Blender wstawi nowy wierzchołek we wręgę C — por. str. 923).
Teraz zaznacz obszar siatki, zajmowany przez lotkę (Rysunek 4.6.2). (Zwróć uwagę, że na dolnej powierzchni jest to “o podłużnicę” więcej, niż na górnej):
Rysunek 4.6.2 Obszar lotki — do wydzielenia w nowy obiekt
Zaznaczony obszar wydziel w nowy obiekt (P, Separate — szczegóły na str. 925). W efekcie w płacie powstanie “otwór po lotce”. Wyostrz (crease = 1.0) krawędzie na jego narożnikach, aby nabrały właściwego wyglądu (Rysunek 4.6.3):
Rysunek 4.6.3 Skrzydło po wydzieleniu lotki — “wyostrzenie” (crease) narożników
Fragment, który znikł z siatki skrzydła, stał się nowym obiektem (Rysunek 4.6.4), o nazwie B.100.L.Wing.001. Znajduje się nadal w tym samym miejscu. Zaznacz go i czym prędzej zmień jego nazwę na odpowiednią dla lewej lotki: B.105.L.Aileron (jak i dlaczego— str. 825).
Rysunek 4.6.4 Lotka, po oddzieleniu od skrzydła
Na razie siatka lotki wygląda jak „uchylony zeszyt” (por. Rysunek 4.6.6a). Dodajmy do niej krawędź natarcia. Szczegóły tego fragmentu znajdziesz na obrazie source\plans\highres\wing.png(plik source.zip — por. str. 22). Wykorzystaliśmy w nim fragment oryginalnych rysunków konstrukcyjnych skrzydła (source\blueprints\P-40E-Wing-Details.png). W rzucie z dołu (Bottom) ponad krawędzią spływu modelu znajdziesz szczegółowy rysunek przekroju poprzecznego lotki i współpracującego z nią fragmentu płata. Traktując go jako wzór, stwórz linię profilu przedniej krawędzi lotki (Rysunek 4.6.5):
Rysunek 4.6.5 Przygotowanie profilu krawędzi natarcia lotki (rysunek w orientacji naturalnej)
Blender nie ma specjalnego polecenia do rysowania dowolnych linii. Możesz jednak łatwo “obejść” to ograniczenie, wstawiając w tym miejscu nowy okrąg (Circle) , złożony z dziesięciu wierzchołków. Potem go “rozerwij”, usuwając jedną krawędź, poprzesuwaj w odpowiednie miejsce wierzchołki — i profil gotowy (Rysunek 4.6.5).
Z siatki lotki usuń najbardziej wysuniętą do przodu dolną krawędź (Rysunek 4.6.6b) (to miejsce m. in. zajmie szczelina). Następnie dosuń do jej wewnętrznego krańca przygotowany profil, i odpowiednio przeskaluj, dopasowując rozmiarem do reszty siatki (Rysunek 4.6.6a). Zorientuj go tak, by leżał w płaszczyźnie ostatniego żebra lotki, i aby dotykał jej przedniej krawędzi (Rysunek 4.6.6b):
Rysunek 4.6.6 Ustawienie obrysu przodu lotki na wewnętrznej krawędzi
Podczas operacji przedstawianej przez Rysunek 4.6.6 wykorzystałem jako obraz referencyjny kolejny fragment oryginalnej dokumentacji fabrycznej. Znajdziesz go w pliku source\plans\highres\aileron.png (z source.zip — por. str. 22). Jest przygotowany do wstawienia na miejsce obrazu dla rzutu Bottom.
Zwróć także uwagę, że poprawiłem nieco układ ścian na końcówce lotki (Rysunek 4.6.6b). Usunąłem jeden wierzchołek i utworzyłem w tym miejscu nowe, trójkątne ściany. W ten sposób z krawędzią natarcia styka się czworokąt, a nie trójkąt (por. Rysunek 4.6.4).
Takie czworokątne ściany są w tym miejscu potrzebne, gdyż teraz odetniemy (Knife) ich przednie części (Rysunek 4.6.7, krok 1). W ten sposób przygotowaliśmy tylną powierzchnię lotki do połączenia.
Teraz wytłocz (Extrude) profil wzdłuż lotki. Po wytłoczeniu zmniejsz (Scale) jego końcówkę, aby dopasować ją do rozmiaru lotki (Rysunek 4.6.7, kroki 2,3) .
Rysunek 4.6.7 “Wytłoczenie” (Extrude) przedniej powierzchni lotki
Na koniec wstaw (Loop Cut) w nowo powstałe ściany dwie dodatkowe sekcje. Umieść je tak, by były przedłużeniem dwóch linii wierzchołków biegnących przez tylną część siatki (Rysunek 4.6.7, krok 4).
Po takim przygotowaniu przedniej i tylnej krawędzi lotki nie pozostaje nic innego, jak je połączyć. Wystarczy utworzyć sześć brakujących ścian (trzy z góry i trzy z dołu) (Rysunek 4.6.8):
Rysunek 4.6.8 Scalenie przedniej powierzchni lotki z resztą siatki
Musimy jeszcze zamknąć powłokę lotki za pomocą dwóch żeber — zewnętrznego i wewnętrznego. Nim je stworzymy, zwiększ ostrość (crease) odpowiednich krawędzi do 1.0. Dzięki temu nie wystąpią na nich żadne przypadkowe zaokrąglenia.
Formowanie żebra końcowego zaczynamy od stworzenia pojedynczych krawędzi (F, Make Edge/Face), łączących odpowiednie wierzchołki górnej i dolnej powierzchni (Rysunek 4.6.9). Następnie podziel każdą z nich na dwie równe połówki (poleceniem Subdivide). Uzyskałeś w ten sposób wierzchołki, na których możesz “rozpiąć” kolejne ściany (Rysunek 4.6.9):
Rysunek 4.6.9 Przygotowanie płaszczyzny żebra, zamykającego lotkę
Rysunek 4.6.10 pokazuje ukończoną ścianę lotki:
Rysunek 4.6.10 Domknięcie żebra lotki
Lotka jest gotowa, teraz warto dodać jej oś obrotu. Taki obiekt będzie “rodzicem” lotki. Obracając oś, będziemy obracać lotkę3. Na początek stwórz gdzieś w pobliżu, w rzucie z boku (ZY), niewielki walec (Cylinder — str. 814) (Rysunek 4.6.11):
Rysunek 4.6.11 Stworzenie osi lotki
Po stworzeniu przesuń środek walca (jak — str. 835) na ścianę wewnętrzną. Potem rozciągnij ten obiekt wzdłuż osi X. Oś nabrała kształtu pręta (Rysunek 4.6.11). Nadaj temu obiektowi nazwę B.106.L.Aileron Axis.
W rzucie z góry, przesuń ten “pręt” i obróć tak, by biegł wzdłuż osi lotki (widocznej na rysunkach fabrycznych) (Rysunek 4.6.12):
Rysunek 4.6.12 Ustawienie osi lotki (widok z góry)
Z rysunków fabrycznych wynika, że oś obrotu biegła równolegle do dolnej powierzchni lotki. Aby osiągnąć ten efekt, w rzucie z przodu (ZX) przesuń ją nieco do dołu i odpowiednio pochyl (Rysunek 4.6.13):
Rysunek 4.6.13 Ustawienie osi lotki (widok z przodu i wzdłuż osi obrotu)
Jak wysoko umieścić oś obrotu ponad dolną powierzchnią lotki? Ustaw ją tak, jak pokazują z rysunki fabryczne (por. Rysunek 4.6.5, str. 147). Wynika z nich, że w rzeczywistej konstrukcji oś obrotu lotki była rurką o średnicy ok. 1cm. Jej końce widać było w szczelinach na krańcach lotki. Dopasuj średnicę naszego obiektu do tego rozmiaru. Co prawda to maleńki detal, który prawie nigdy nie będzie widoczny, ale w końcu nie jest to specjalnie trudne. Z odwzorowania nawet takich właśnie szczegółów składa się końcowy efekt modelu.
Pora teraz ustalić, co do czego należy:
przypisz lotce (B.105.L.Aileron) jako “rodzica” (Parent — str. 827) przygotowaną przed chwilą oś (B.106.L.Aileron Axis);
przypisz osi (B.106.L.Aileron Axis) jako “rodzica” skrzydło (B.100.L.Wing);
Rysunek 4.6.14a) pokazuje, jaką hierarchię części powinieneś uzyskać:
Rysunek 4.6.14 Hierarchia — lotka, oś, skrzydło, i jej efekty
Czy wiesz, jak to działa? Zaznacz w oknie hierarchii (Outliner, Rysunek 4.6.14a) oś lotki. (W oknie widoku jest zasłonięta, więc nie ma co klikać na oślep). Teraz w oknie 3D View włącz jej obrót dookoła lokalnej osi Z (R,Z,Z — Rysunek 4.6.14b) — i możesz ruszać lotką! Przyznasz, że obraca się całkiem realistycznie. Muszę przyznać, że zawsze lubiłem zabawki, a później modele, z dużą liczbą ruchomych części ☺. W dalszych rozdziałach pokażę, jak wygodniej sterować o wiele bardziej złożonymi efektami: różnicowym wychylaniem lotek, składaniem i rozkładaniem podwozia.
Lotka jest gotowa i zamontowana. Wróćmy teraz do siatki płata: trzeba oprofilować wewnętrzne ściany wycięcia na lotkę. Zrobimy to w ten sam sposób, co krawędź natarcia lotki. Zaczynamy od przygotowania profilu ściany, wykorzystując rysunki fabryczne (Rysunek 4.6.15):
Rysunek 4.6.15 Przygotowanie obrysu szczeliny lotki
Następnie ustaw ją w płaszczyźnie wewnętrznego żebra, i dopasuj rozmiar do reszty siatki (Rysunek 4.6.16):
Rysunek 4.6.16 Dopasowanie obrysu szczeliny lotki
Kolejnym krokiem jest wytłoczenie tego obrysu wzdłuż krawędzi otworu lotki, oraz dopasowanie (zmniejszenie) rozmiaru końcówki (Rysunek 4.6.17):
Rysunek 4.6.17 Wytłoczenie powierzchni w szczelinie lotki
Przy okazji usuń (Delete→Edge Loop) dwa żebra, wskazane na ilustracji (Rysunek 4.6.17). Pozostały z czasów sprzed oddzielenia lotki, i teraz już tylko przeszkadzają.
Po usunięciu niepotrzebnych żeber scal (Remove Doubles) wytłoczoną powierzchnię z resztą siatki. Wypełnij także boczne ściany (Rysunek 4.6.17) — w ten sam sposób, jak boczne ściany lotki.
Rysunek 4.6.18 Zamknięcie wycięcia na lotkę
W konstrukcji tego fragmentu jest pewien szczegół, na który chciałbym zwrócić uwagę. Aby uzyskać ładną, ostrą krawędź ściany, o kształcie spłaszczonego “S”, ułożyłem w tym miejscu krawędzie w dość specyficzny sposób. Gdy popatrzysz na ilustrację poniżej (Rysunek 4.6.19a), możesz odnieść wrażenie, że wierzchołki 1, 2, 3 leżą na wspólnej krawędzi.
Rysunek 4.6.19 Szczegóły ściany żebra
Tak jednak wcale nie jest. To są dwie oddzielne krawędzie: |1-3| i |2-3|. Zbliżenie pokazuje, że w istocie wierzchołki 1, 2, 3 tworzą bardzo płaski trójkąt, leżący w płaszczyźnie żebra (Rysunek 4.6.19b). Taki układ siatki pozwala uzyskać na powierzchni podziałowej dwie ostre krzywe, zbiegające się ładnym łukiem w jednym punkcie.
(Nie zdecydowałem się umieścić punktów 1, 2, 3 w jednej linii. Żaden program renderujący “nie lubi” takich “zdegradowanych” ścian. Nie chciałem ryzykować jakichś lokalnych problemów z barwą czy teksturą).
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.06.blend (por. str. 22).
Podsumowanie
Lotki w konstrukcjach z okresu II WŚ miały konstrukcję szczelinową. Z tego powodu warto je modelować jako oddzielny element skrzydła.
Siatkę lotki najprościej jest uzyskać poprzez wydzielenie z siatki płata. Służy do tego polecenie Separate (str. 146).
Przednią krawędź lotki i tylną krawędź skrzydła modelujemy poprzez wytłoczenie profilu wzdłuż osi lotki.
Oś obrotu lotki warto jest stworzyć jako oddzielny obiekt. Zorientowanie samej lotki wzdłuż takiej osi stwarza dużo problemów.
Skrzydło, oś lotki i samą lotkę łączymy więzami Parent (str. 151) w hierarchię. Dzięki temu będziesz mógł przesuwać i obracać cały płat bez martwienia się o położenie jego komponentów. Lotkę można obracać poprzez obrót jej osi (brzmi to jak oczywistość, ale ten efekt jest możliwy dzięki hierarchii).
Rysunek 4.7.1 pokazuje układ siatki skrzydła, jaki do tej pory uzyskaliśmy (por. str. 145):
Rysunek 4.7.1 Obecny układ siatki skrzydła
Pozostało jeszcze do dodania kilka drobiazgów, z których największym jest otwór na koła podwozia głównego. Przygotowałem obrys jego krawędzi jako oddzielny obiekt (Rysunek 4.7.2) :
Rysunek 4.7.2 Narzędzie do wycięcia otworu podwozia głównego: ośmioboczna “rura”
W ramach przygotowania siatki płata wstawiłem trzy nowe żebra. Jedno z nich dokładnie w środku otworu, a pozostałe dwa — na zewnątrz (Rysunek 4.7.3):
Rysunek 4.7.3 Dodatkowe sekcje siatki płata — przygotowanie do wykonania otworu
Dlaczego do odwzorowania okręgu posługuję się ośmiobokiem? Dlatego, że więcej krawędzi tu nie trzeba. Dwukrotna powierzchnia podziałowa (Subdivisions = 2), wytworzy na takim obrysie w miarę gładki 32-kąt. Największe odchylenie wierzchołków tej linii od “idealnego” okręgu wynosi zaledwie 0.71% (więcej na ten temat — str. 1226). Na pewno blacha na prawdziwym samolocie była wycinana z podobną, a być może nawet większą tolerancją.
Po tych przygotowaniach czas na cięcie. Podobnie jak w przypadku końcówki płata, użyj do tego polecenia Intersection. Tym razem skorzystaj wyłącznie z ośmiu punktów krawędzi przecięcia tego pomocniczego cylindra z powierzchnią płata (Rysunek 4.7.4):
Rysunek 4.7.4 Wyznaczenie krawędzi otworu koła podwozia
Siatka ośmiobocznego graniastosłupa zyskała dodatkową linię wierzchołków — krawędź przecięcia. Następnie zaznacz najpierw ten cylinder, potem skrzydło, o scal te dwie siatki (Ctrl-J — Join, str. 833). Po scaleniu usuń wszystkie niepotrzebne wierzchołki. Z pomocniczego graniastosłupa pozostaw z tylko samą krawędź przecięcia (Rysunek 4.7.5a):
Rysunek 4.7.5 Wyznaczenie krawędzi otworu na koło podwozia
Teraz ze środkowego żebra płata usuń cztery wierzchołki, leżące wewnątrz i na granicy krawędzi przecięcia (Rysunek 4.7.5b).
W rezultacie zrobiło się pusto wokół krawędzi otworu w skrzydle (Rysunek 4.7.6a):
Rysunek 4.7.6 Wkomponowanie nowej krawędzi w siatkę płata
Wystarczy zabudować tę przestrzeń, tworząc nowe ściany łączące krawędź przecięcia z resztą siatki. I w ten sposób uzyskasz ładny, okrągły otwór (Rysunek 4.7.6b)!
Aby nie “straszyć” pokryciem o zerowej grubości, wytłocz krawędź tego otworu wzdłuż lokalnej osi Z do wnętrza skrzydła o ok. 0.1 jednostki (Rysunek 4.7.7). (W rzeczywistym samolocie był to kołnierz o szerokości ok. 1 cm):
Rysunek 4.7.7 Wygięcie krawędzi otworu do wnętrza skrzydła
Możesz sprawdzić, że kształt otworu w rzucie z góry nadal jest okręgiem. Skąd wiedziałem, że tak się zachowa powierzchnia skrzydła? W końcu jest wygładzoną powłoką podziałową (Subsurf)... Otóż wynika to właśnie z właściwości powierzchni podziałowych. Jedna z nich brzmi ona: “kształt rzutu powierzchni podziałowej na dowolną płaszczyznę zależy tylko od rzutu na tę płaszczyznę jej siatki”. Jeżeli rzut z góry wygładzonego modyfikatorem Subsurf ośmioboku był okręgiem, to okręgiem w rzucie z góry jest także jego krawędź przecięcia ze skrzydłem. (Dlatego podczas operacji przecinania użyliśmy wyłącznie punktów leżących na krawędziach pomocniczego cylindra). Gdy połączymy uzyskaną krawędź przecięcia z siatką skrzydła nowymi ścianami — rzut z góry tego otworu także pozostanie okręgiem. (Nie zmieniliśmy przecież w żaden sposób położenia jego wierzchołków). Więcej na temat właściwości specyficznego “materiału”, jakim są linie i krzywe podziałowe, znajdziesz w sekcji 19.2, na str. 1221.
Zbliżamy się już do końca prac nad kształtem płata. Pozostaje jeszcze tylko pochylić początkowe żebro o 6º. (Płat P-40 miał wznios 6º i składał się z dwóch połówek, złączonych śrubami. Aby do siebie pasowały, pierwsze żebro musi być o ten kąt pochylone).
Obróć cały obiekt w rzucie z przodu (ZX) o 6º do góry (Rysunek 4.7.8):
Rysunek 4.7.8 Pochylenie płata (6º)
Potem przełącz się w tryb edycji. Wstaw (Loop Cut) dodatkowe żebro w obszarze, który będzie w całości zasłonięty przez kadłub (Rysunek 4.7.9). Potem obróć żebro początkowe tak, by było pionowe. Na koniec “rozciągnij” (Scale) je trochę w kierunku Z, aby obrys dolnej i górnej krawędzi płata nie był załamany (Rysunek 4.7.9):
Rysunek 4.7.9 Pochylenie pierwszego żebra
I to wszystko! Pozostaje teraz jeszcze pochylić płat w rzucie z boku (ZY) o kąt zaklinowania (1º), i umieścić w docelowym położeniu (Rysunek 4.7.10):
Rysunek 4.7.10 Ustawienie płata w położeniu docelowym
Gdy siatka jest już gotowa, sprawdź jeszcze czy nie zawiera jakichś utworzonych przypadkiem ścian o liczbie boków większej niż 4 (tzw. n-gonów — por. str. 933). Jeżeli znalazłeś taki n-gon — podziel go zaraz na czworokąty i/lub trójkąty!
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.07.blend (por. str. 22).
Podsumowanie
Otwór na podwozie można wyciąć w powierzchni płata. Zazwyczaj otwory takie mają kształt będący pochodną okręgu.
Do zamodelowania całkiem dokładnego okręgu za pomocą linii/powierzchni podziałowych wystarczy ośmiokąt.
Obiekty (a dokładniej - ich siatki) można scalać. Służy do tego polecenie Join (str. 155).
Usterzenie poziome naszego modelu będzie się składać ze statecznika, steru wysokości i jego osi obrotu. Podobnie jak w przypadku płata, na plany samolotu naniosłem skorygowany (na podstawie zdjęć i rysunków fabrycznych) obrys kształtu tego zespołu. Miejscami różni się w dość dużym stopniu od oryginalnych rysunków — zarówno J. Jackowskiego jak i M. Łukasika (por. str. 1211).
Usterzenie poziome wygląda jak małe skrzydło, i tworzymy je w ten sam sposób. Będzie łatwiejsze do uformowania niż płat, gdyż profil statecznika jest symetryczny, a końcówka ma konwencjonalny kształt. (Bez takich udziwnień, jakie wystąpiły w skrzydle).
Zaczynamy tak samo jak poprzednio — od przymiarki płaskiego trapezu do położenia podłużnic (Rysunek 4.8.1) :
Rysunek 4.8.1 Przymiarka położenia podłużnic na stateczniku
Środkiem nowego obiektu jest punkt przecięcia osi obrotu steru wysokości z osią symetrii kadłuba. Z trapezu pozostawiamy tylko profil początkowy (Rysunek 4.8.2a), dla którego włączamy odbicie lustrzane (modyfikator Mirror — p. Rysunek 4.8.2b, szczegóły: str. 927) :
Rysunek 4.8.2 Początkowa postać profilu (modyfikator Mirror włączony)
Nim przełączysz się do trybu edycji, ustaw cały obiekt wzdłuż osi usterzenia pod kątem -2º. Następnie, w trybie edycji, przekształć początkowy prostokąt w kształt obrysu górnej powierzchni usterzenia, zgodnie z rysunkiem. (Na plany naniosłem profil z rodziny NACA 00xxT, o zmniejszonym promieniu noska — taką “ostrą” krawędź natarcia widać na zdjęciach). Dolna połówka obrysu jest zawsze odbiciem górnej, dzięki modyfikatorowi Mirror (Rysunek 4.8.3). Aby uniknąć szczelin na krawędzi natarcia i spływu, te linie powinny leżeć na płaszczyźne XY lokalnego układu współrzędnych (współrzędne Z ich wierzchołków powinny być = 0):
Rysunek 4.8.3 Przygotowany profil statecznika
Pamiętaj, aby podczas formowania profilu przesuwać wierzchołki odpowiadające podłużnicom tylko wzdłuż lokalnej osi Z. W ten sposób zachowasz położenie podłużnic tam, gdzie je zaplanowałeś. Nowe wierzchołki, które dodałeś później, możesz przesuwać w sposób dowolny. Podobnie jak na płacie, zastosuj niewielkie zaokrąglenie na krawędzi spływu (Rysunek 4.8.3).
Po uformowaniu profilu wyprostuj z powrotem cały obiekt (zmień obrót dookoła osi X z -2º na 0º). Następnie wróć do trybu edycji i wytłocz (Extrude) jego profil wzdłuż osi X (Rysunek 4.8.4a). Upewnij się, czy kursor znajduje się w środku obiektu. (Mam na myśli punkt odniesienia — por. Rysunek 4.8.4b — a nie geometryczny środek siatki!) Ustaw tryb środka obrotu — Pivot — na 3D Cursor. Potem “ściśnij” końcówkę, zmieniając jej skalę wzdłuż osi Y (Rysunek 4.8.4b) :
Rysunek 4.8.4 Wytłoczenie profilu (a) i zmiana rozmiaru końcówki (b)
Przy formowaniu usterzenia nie jestem już tak dokładny, jak w przypadku skrzydła: nie przygotowałem pomocniczego profilu końcówki. Zamiast tego naniosłem na obrys z góry zarys przedniej krawędzi steru wysokości, uzyskany z rysunków fabrycznych tego elementu. Ster wysokości P-40 nie miał wyważenia krawędziowego, więc zakładam, że jego przednia krawędź miała okrągły przekrój (por. Rysunek 4.8.18, str. 166). Przy takim założeniu odległość przedniej krawędzi steru od osi obrotu określa także grubość usterzenia w tym miejscu.
Potraktowałem więc obrys przedniej krawędzi steru w rzucie z góry jak ekwiwalent obrysu w rzucie z przodu. Dopasowałem do niego grubość końcówki usterzenia poziomego, zmieniając skalę jej wierzchołków wzdłuż osi Z (Rysunek 4.8.5):
Rysunek 4.8.5 “Spłaszczenie” końcówki usterzenia (obiekt w rzucie z przodu, rysunek w tle to rzut z góry)
Czy nie popełniliśmy jakiejś poważnej pomyłki? Ustawiłem elementy, samolotu, które stworzyliśmy do tej pory, w odpowiednich miejscach na rzucie z boku (YZ). Potem porównałem je z planami Jacka Jackiewicza, których używałem przy tworzeniu tego modelu (Rysunek 4.8.6):
Rysunek 4.8.6 Mała weryfikacja rzutu z przodu — różnice w porównaniu z planami (narysowanymi ręcznie)
Wygląda na to, że grubości statecznika i skrzydła są podobne do tych, na planach modelarskich. Widać jest za to, że obydwa te elementy są w stosunku do rzutu z przodu przesunięte do dołu. (Kołpak śmigła jest we właściwym miejscu). Czy ta różnica wynikała z przyjęcia przez autora planów innego przebiegu osi samolotu? W takim przypadku statecznik byłby dwa razy bardziej odległy od swojego pierwowzoru na rysunku, niż skrzydło. Tak jednak nie jest. To raczej błąd rysunków — niewłaściwe położenie śmigła, wraz z kołpakiem, w płaszczyźnie ZX.
Rzuty z przodu mogą zawierać więcej błędów niż pozostałe, i należy traktować je z dużą rezerwą. Często będziesz się spotykał z podobnymi niespójnościami na planach. Należy wówczas przyjąć, że w pierwszej kolejności “rację ma” rzut z boku, później — rzut z dołu lub góry. Rysunki w pozostałych projekcjach i przekroje poprzeczne są mniej ważne. Traktuj je raczej jako poglądowe szkice, a nie dokładne odwzorowanie kształtu.
Plany które towarzyszą tej książce (z folderu source/plans/p40b-highres) są wolne od takich błędów (Rysunek 4.8.7) — ponieważ nie zostały narysowane „ludzką ręką”:
Rysunek 4.8.7 Weryfikacja rzutu z przodu (plany wygwnerowane z modelu 3D)
Czas stworzyć zaokrągloną końcówkę usterzenia. Na początek dodaj przy końcu siatki dodatkowe “żebro” (Rysunek 4.8.8). Według rysunków, obrys końcówki był fragmentem łuku. Dołącz więc do siatki, na lokalnej płaszczyźnie XY statecznika, pojedynczy łuk (uzyskany z 12 - wierzchołkowego Circle). Połącz jego końce z siatką, dokonując drobnych przemieszczeń wierzchołków, aby zneutralizować odchylenia linii od wzorcowego okręgu (Rysunek 4.8.8):
Rysunek 4.8.8 Końcówka usterzenia — naniesienie obrysu z góry
Następnie wytłocz wierzchołki łuku w pierścień (zmieniając skalę względem środka okręgu) (Rysunek 4.8.8). Wytłoczoną krawędź unieś nieco do góry (tzn. przesuń wzdłuż osi Z) (Rysunek 4.8.9):
Rysunek 4.8.9 Końcówka usterzenia — szczegóły zaokrąglenia
Potem dodaj do pierścienia kolejne linie wierzchołków (poleceniem Loop Cut). Ustawiam je tak, by każda z nich odpowiadała jednej z podłużnic z trapezowej cześci siatki (Rysunek 4.8.9).
W prawdziwym P-40 na końcu statecznika był zamocowany wygięty pierścień z blachy, o takim samym kształcie i rozmiarze jak nasz. Przyznam się, że zdjęcia z dwóch rekonstrukcji P-40 różnią się promieniem zaokrąglenia przekroju końcówki. Rekonstrukcja z Nowej Zelandii ma stosunkowo ostre końce, a inna, z USA — bardziej zaokrąglone. Wybrałem wersję z Nowej Zelandii, bo uważam ją za bardziej prawdopodobną (bardziej mi pasowała do promienia nosa profilu statecznika).
Od razu warto się przygotować do podziału usterzenia na statecznik i ster. Jeżeli zaznaczysz wcześniej krawędź podziału jako “ostrą” (crease = 1.0), to późniejszy podział siatki nie wpłynie na kształt żadnej z tych części. Oznaczyłem ją jako “ostrą”, w tym także odcinek na pierścieniu końcówki usterzenia. Oczywiście, zmieniło to obrys powierzchni podziałowej w tym obszarze. Przywracając w tym miejscu z powrotem kształt łuku, dodaj w pobliżu granicy steru i statecznika dwie dodatkowe krawędzie (Rysunek 4.8.10a). (Łatwiej je dodać na tym etapie — poleceniem Loop Cut — niż po wypełnieniu końcówki ścianami).
Rysunek 4.8.10 Końcówka usterzenia — dodatkowe krawędzie
Aby zapełnić pustą przestrzeń wewnątrz końcówki, wytłocz trzy wierzchołki siatki w “wypustkę”, lekko zaginiętą do dołu (Rysunek 4.8.10b,a). Już widzisz o co chodzi? Teraz wystarczy “rozpiąć” ściany na sąsiednich wierzchołkach, i końcówka jest zbudowana (Rysunek 4.8.11):
Rysunek 4.8.11 Siatka usterzenia — gotowa do wydzielenia steru
Zaznacz obszar siatki, z którego powstanie ster (Rysunek 4.8.11), i wydziel z niej nowy obiekt — B.205.R.Elevator. Jednocześnie nadaj nazwę statecznikowi: B.200.R.Stabilizer.
Podział siatek otwiera nowe możliwości uporządkowania każdej z nich. Chodzi tu przede wszystkim o wyeliminowanie wszystkich, lub prawie wszystkich ścian trójkątnych. (Powierzchnie podziałowe Catmull-Clarka generują się najlepiej w oparciu o ściany czworokątne).
Po oddzieleniu steru użyłem Knife i scalania ścian trójkątnych, aby zmienić wszystkie ściany statecznika w czworokątne (Rysunek 4.8.12) :
Rysunek 4.8.12 Uzupełniona i poprawiona siatka statecznika
Pozostało jeszcze dobudować tylną ścianę statecznika. Zacznij od wytłoczenia tylnej krawędzi wzdłuż lokalnej osi Z “na grubość blachy” — powiedzmy że będzie to 0.01 jedn. Blendera. Potem tę nową krawędź wytłocz jeszcze raz — tym razem aż do płaszczyzny symetrii (poprzez zmianę skali wzdłuż osi Z — Rysunek 4.8.13):
Rysunek 4.8.13 Przygotowanie tylnej ścianki statecznika
Ściany, zaznaczone jak na ilustracji (Rysunek 4.8.13), wytłocz jako region (E — Extrude), ale nie przesuwaj. Odsuń je “w głąb statecznika” poleceniem Alt-S (Toolshelf:Mesh Tools:Shrink/Fatten, str. 929) , na odległość ok. 0.2 jedn. Blendera. Bezpośredni rezultat operacji nie wygląda jeszcze olśniewająco (Rysunek 4.8.14):
Rysunek 4.8.14 “Surowy” efekt wytłoczenie wewnętrznych ścianek
Przed wywołaniem polecenia Shrink/Fatten uporządkuj kierunki normalnych siatki (por. str. 972) — np. skieruj je wszystkie na zewnątrz poleceniem Recalculate Outside (Ctrl-N).
Wystarczy jednak tylko usunąć niepotrzebne wierzchołki oraz wyprostować nieco “pokrzywione” ścianki, by rezultat wyglądał tak, jak powinien (Rysunek 4.8.15):
Rysunek 4.8.15 Efekt po poprawkach
Aby szybko wyprostować ścianki:
przełącz tryb Pivot na Bounding Box Center;
zaznacz wierzchołki ściany;
zmień ich skalę względem osi prostopadłej (X lub Y) do 0.
Na koniec przesuń lewą ścianę do samej krawędzi wycięcia (Rysunek 4.8.16). Z fotografii wynika, że do tego żebra było przymocowany jeden z zawiasów steru wysokości. Stąd ta powierzchnia nie była “schowana” we wnętrzu statecznika, tak jak pozostałe ściany:
Rysunek 4.8.16 Uwzględnienie wewnętrznego żebra
Rysunek 4.8.17 pokazuje, jak powinien wyglądać gotowy statecznik:
Rysunek 4.8.17 Gotowy statecznik poziomy
Pora się zabrać za formowanie steru. Praca nad nim bardzo przypomina tworzenie lotki. Zacznij od przygotowania profilu przedniej krawędzi (Rysunek 4.8.18) :
Rysunek 4.8.18 Ster wysokości — przygotowanie profilu przedniej krawędzi
Potem wytłocz ten profil wzdłuż osi X steru, zmniejsz na końcu, i połącz z resztą siatki (Rysunek 4.8.19):
Rysunek 4.8.19 Dodana przednia krawędź
Przy okazji, podobnie jak w przypadku statecznika, zmień układ krawędzi, by wyeliminować jak najwięcej ścian trójkątnych. Jest to wstęp do ukształtowania wyważenia masowego i aerodynamicznego, zlokalizowanego na końcówce steru (Rysunek 4.8.20a,b) :
Rysunek 4.8.20 Wyważenie steru — szczegóły siatki
W okolicy wyważenia odsuń od siebie krawędzie, tworząc otwór na zawias steru (Rysunek 4.8.20a). (Same okucia zawiasów dodamy później, przy okazji uzupełniania szczegółów). Ten “rozstęp” pozwoli zastosować inny układ “podłużnic” na końcówce steru (Rysunek 4.8.20b). Wykorzystaj tę możliwość, formując wystające wyważenie, i dodając dodatkowe podłużnice na końcówce. Nie zapomnij także o wytłoczeniu wzdłuż krawędzi otworu okucia małej fazki “na grubość blachy” (0.01 jedn).
Takie małe otwory jak te które pokazuje Rysunek 4.8.20 o wiele wygodniej wykonuje się za pomocą specjalnej tekstury (por. str. 449). W tej sekcji uległem pokusie modelowania wszystkiego „w siatce”!
Pozostało jeszcze tylko uformować krawędź spływu steru. Jest to krzywa, więc dodaj do siatki kolejne żebra, oraz odetnij (Knife) niepotrzebny narożnik (Rysunek 4.8.21) :
Rysunek 4.8.21 Przygotowanie do ukształtowania krawędzi spływu
Wykorzystując nowe żebra, wygnij krawędź spływu tak, by pasowała do obrysu na rysunku (Rysunek 4.8.22a):
Rysunek 4.8.22 Formowanie “wcięcia” steru wysokości
Musimy jeszcze zamknąć siatkę steru od strony kadłuba. Zdjęcia pokazują, że przekrój poprzeczny tego fragmentu był zaokrąglony. Dodaj (Knife) do tego obszaru kolejną krawędź (Rysunek 4.8.22a). Umożliwi nam uzyskanie zaokrąglenia. Wytłocz także końcową krawędź tak, by zamknąć siatkę (Rysunek 4.8.22b). (Nową krawędź najłatwiej dosunąć do płaszczyzny symetrii, zmieniając skalę wierzchołków względem osi Z do zera). Skopiuj także wierzchołki łuku z przedniej krawędzi siatki, aby uzyskać u nasady steru okrąg (Rysunek 4.8.22c). Stwórz wzdłuż tych nowo powstałych krawędzi ściany, które połączą je z resztą siatki. Dodaj (Loop Cut) jeszcze jedną krawędź wewnętrzną (Rysunek 4.8.23a) — aby wszystkie krawędzie zaokrąglenia były kontynuacją odpowiednich podłużnic siatki.
Rysunek 4.8.23 “Zamknięcie” powłoki steru
Na koniec wytłocz i zmień skalę ścianek wokół otworu na oś obrotu (ustawiając wcześniej kursor 3D w środku tego okręgu). Nasz ster jest już niemal skończony (Rysunek 4.8.23b).
Pozostał jeszcze drobiazg — szczelina na drugi zawias1. Utwórz ją, nacinając (Knife) przód steru— najpierw pośrodku szczeliny, później, o jedną podłużnicę “płyciej”, wzdłuż krawędzi (Rysunek 4.8.24a). Potem pozostało uporządkować ściany (wewnętrzne usunąć, inne zamienić na trójkąty) :
Rysunek 4.8.24 Wycięcie szczeliny na drugi zawias
Wytłoczyłem także wokół tego otworu zawiasu dodatkową krawędź “na grubość blachy” (Rysunek 4.8.24b).
Statecznik i ster są już uformowane. Teraz trzeba je ze sobą połączyć. Podobnie jak w przypadku lotki i skrzydła, posłuży nam do tego obiekt pomocniczy — oś steru. Utwórz odpowiednią “rurkę”, i nadaj jej nazwę B.210.R.Elevator Axis (Rysunek 4.8.25a). W odróżnieniu od osi lotki, część osi steru będzie widoczna, więc powinna mieć średnicę jak na planach. Warto ją także wygładzić modyfikatorem Subsurf.
Rysunek 4.8.25 Dodanie osi obrotu i połączenie w jeden zespół
Uczyń oś “rodzicem” steru głębokości (Ctrl-P, Make Parent, str. 827). “Rodzicem” osi ma być z kolei statecznik. Rysunek 4.8.25b) pokazuje hierarchię części, jaką powinieneś uzyskać. Potem pozostaje już tylko umieścić statecznik (B.200.R.Stabilizer) w docelowym miejscu modelu. Nadaj mu kąt zaklinowania (X) -2º, jak w oryginalnej konstrukcji (Rysunek 4.8.26):
Rysunek 4.8.26 Umieszczenie usterzenia w docelowym miejscu modelu
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.08.blend (por. str. 22).
Podsumowanie
Usterzenie wykonujemy według tego samego wzorca postępowania, co skrzydło.
Tak jak skrzydło ma wydzieloną, ruchomą lotkę, tak usterzenie dzieli się na statecznik, ster, i łączącą je oś (str. 168).
Usterzenia mają zazwyczaj profil symetryczny, stąd wystarcza uformować tylko jedną z dwóch powierzchni obrysu — górną lub dolną. Drugą “załatwia” modyfikator Mirror (str. 159)
Do formowania wewnętrznych ścianek przydatne jest polecenie “odsunięcia” od powierzchni o zadaną odległość. W Blenderze jest to komenda Alt-S (Toolshelf:Mesh Tools:Shrink/Fatten, str. 164).
Rzut z przodu na planach modelarskich może zawierać więcej błędów niż inne rzuty (por. str. 161). Należy więc traktować go z rezerwą. Najlepiej przyjąć zasadę, że w przypadku stwierdzenia różnic najważniejszy jest rzut z boku, a potem rzut z góry.
Warto zorientować się (na podstawie opisów konstrukcji, planów), jaki rodzaj kompensacji aerodynamicznej miało usterzenie samolotu. W przypadku P-40 wychylenie steru wysokości było kompensowane tylko przez prostokątny występ na jego końcu. W takiej sytuacji można założyć, że przekrój przedniej krawędzi steru jest okrągły. To z kolei pozwoliło użyć obrysu z góry tej linii także w charakterze obrysu z przodu (por. str. 161). To zawsze lepsza alternatywa niż ślepe zawierzenie pod tym względem rzutowi z przodu z planów.
Usterzenie pionowe, składające się ze statecznika, steru kierunku i jego osi, wykonujemy tak samo jak usterzenie poziome. Dlatego w tej sekcji opiszę ten proces z pewnymi skrótami.
Miałem pewne problemy z ustaleniem poprawnego profilu usterzenia. Profil na planach modelarskich Mariusza Łukasika nie wyglądał zbyt poprawnie. Od razu zwróciłem uwagę na zbyt duży (w porównaniu ze zdjęciami) promień noska. Wśród rysunków fabrycznych, jakimi dysponowałem, znalazłem rysunek oprofilowania połączenia usterzenia i kadłuba. Pozwoliło mi to nanieść na plany poprawiony profil podstawy, wyznaczony na podstawie narysowanej na nim krawędzi blachy oprofilowania podstawy statecznika. Jest w tym oczywiście także trochę moich domysłów. Zdecydowałem się użyć profil NACA-0008T , gdyż pasował do fragmentu obrysu z rysunków fabrycznych. (Nieco grubszy profil tego samego typu zastosowałem w usterzeniu poziomym).
Także grubość końcówki statecznika pionowego na planach Mariusza Łukasika jest zdecydowanie przesadzona (por. str. 175). Na rysunkach Jacka Jackowskiego statecznik pionowy jest o wiele cieńszy, ale autor przerysował z kolei efekt jego zaklinowania pod kątem 1.5º od osi samolotu. W tej sytuacji pozostało mi już tylko wzorować się na zdjęciach i tym, co wynikało z fragmentów oryginalnej dokumentacji, jakie zgromadziłem.
Rysunek 4.9.1a) pokazuje pierwsze “przymiarki” do ułożenia podłużnic siatki wzdłuż podłużnic rzeczywistej konstrukcji. Pionowa “linia neutralna” (krawędź, która nie zmienia się w żaden sposób gdy skalujesz „żebra”) biegnie wzdłuż przedniej krawędzi steru.
Rysunek 4.9.1 Początkowe fazy budowy usterzenia pionowego
Krawędź spływu steru kierunku okazała się zbyt “fantazyjna”, by dać się przybliżyć jakimkolwiek regularnym trapezem. Proponuję się na tym etapie nie zawracać nią głowy, koncentrując się na fragmencie odwzorowującym przednią część usterzenia — stateczniku pionowym.
Po ustaleniu położenia początków podłużnic wzdłuż cięciwy profilu, pozostaw z trapezu tylko dolną linię wierzchołków. W trybie obiektu (Object Mode) obróć obiekt o 1.5º wokół osi Z (usterzenie pionowe było tak zaklinowane, by równoważyć efekt wirowania śmigła). Włącz do obiektu modyfikatory Mirror i Subsurf, i wygnij linię wierzchołków w profil usterzenia (Rysunek 4.9.1b) . Potem usuń skręcenie tego obiektu o 1.5º (utrudniałoby dalszą pracę).
Uzyskany profil wytłocz wzdłuż osi Z. Zmniejsz także rozmiar żeber końcowych (Rysunek 4.9.2a). Zacznij formować końcówkę usterzenia pionowego. Najpierw stwórz cienki pierścień ścian, tak samo jak to robiliśmy w usterzeniu poziomym (Rysunek 4.9.2b):
Rysunek 4.9.2 Wytłoczenie profilu i przygotowanie obrysu końcówki
Wytłocz teraz “w górę”, wzdłuż osi Z, kilka środkowych wierzchołków żebra. Przesuń je nieco względem osi X, aby nie odstawały na boki od reszty powierzchni statecznika (Rysunek 4.9.3):
Rysunek 4.9.3 Zbudowanie ścian końcówki
W oparciu o wierzchołki wytłoczonej krawędzi zbuduj nowe ściany (Rysunek 4.9.3). Dla uzyskania odpowiedniego kształtu okazuje się konieczne dodanie pomiędzy paskiem ścian końcówki a resztą siatki jeszcze jednej linii wierzchołków (Loop Cut). Rysunek 4.9.4 pokazuje układ ścian uformowanej końcówki. Taką powierzchnię podziel (P, Separate) na ster i statecznik.
Rysunek 4.9.4 Podział na ster i statecznik
Statecznikowi pionowemu nadaj nazwę B.250.Fin, a sterowi kierunku — B.255.Rudder. Sam statecznik jest prawie gotowy. Do wykończenia pozostało tylko dodanie tylnej ścianki (Rysunek 4.9.5a). Uzyskasz ją w ten sam sposób, co w stateczniku poziomym (por. str. 164).
Rysunek 4.9.5 Szczegóły tylnej ścianki statecznika (a) i gotowy element (b)
W P-40 statecznik poziomy był wykonany jako jedna całość. Trzy dźwigary statecznika pionowego były do niego przymocowane śrubami, ukrytymi pod oprofilowaniem. Ostatni z dźwigarów był jednocześnie tylną ścianą statecznika. Stąd odpowiednio wydłużyłem dół tylnej ściany na naszej siatce, by po złożeniu z resztą modelu dotykała powierzchni statecznika poziomego (Rysunek 4.9.5b).
Statecznik jest gotowy, przejdźmy więc do formowania steru kierunku. Zacznijmy od górnej części jego przedniej krawędzi. Jest tu zastosowana kompensacja masowa (bardzo wysunięta do przodu końcówka), jaki i aerodynamiczna (pozostała część przedniej krawędzi jest także nieco wysunięta).
Dodaj dodatkowe żebro, separujące uskok krawędzi. Następnie usuń w miejscu uskoku rząd ścian, by dodać (poleceniem Loop Cut) nowe podłużnice (odrębnie do każdego z tych dwóch obszarów). Dodaj nowe ściany z przodu, zaokrąglając oddzielnie górną i dolną część krawędzi natarcia. Potem z powrotem “zabuduj” tę przerwę, tworząc za pomocą dwóch “ostrych” krawędzi (crease = 1) uskok (Rysunek 4.9.6):
Rysunek 4.9.6 Szczegóły przedniej krawędzi steru kierunku (część górna)
Ze względu na zastosowanie kompensacji aerodynamicznej, zawias steru kierunku był zamocowany inaczej niż zawias steru wysokości. Zastosowano tu rodzaj “wysięgnika”, po lewej stronie steru (dodamy go później). Na razie przygotuj tylko otwór w miejscu, gdzie to ramię przenikało przez powierzchnię1 (Rysunek 4.9.7) :
Rysunek 4.9.7 Szczegóły przedniej krawędzi steru kierunku
Oczywiście, wokół tego otworu także nanieś fazkę “na grubość blachy” (0.01 jedn.).
Czas przejść do formowania dolnej części steru kierunku. Po dodaniu kilku dodatkowych żeber uformuj krawędź spływu (Rysunek 4.9.8a). Zrób to tak, by krawędzie siatki były ułożone ponad obrysem klapki trymera. (To nam pomoże nanieść ją na teksturę, przyda się także, gdybyś w przyszłości chciał ją wydzielić) . Przód steru kierunku w tym obszarze był schowany w kadłubie i miał przekrój okrągły. Przenieś na plany modelarskie obrys tej krawędzi, skopiowany z rysunków fabrycznych (Rysunek 4.9.8a). Teraz możesz z niego skorzystać: podstaw na chwilę ten obrazu tła także pod rzut z przodu. Następnie pochyl boczne powierzchnie steru, by pokryły się z obrysem (Rysunek 4.9.8b):
Rysunek 4.9.8 Szczegóły przedniej krawędzi steru kierunku (część dolna)
Dodatkowo u dołu dodaj “ćwiartkę” nieco spłaszczonego ośmioboku. To pierwsza z krawędzi, z których w tym miejscu uformujemy coś w rodzaju fragmentu elipsoidy (Rysunek 4.9.8b).
Przednia, dolna część steru ma kształt przypominający końcówkę kija używanego w baseballu: stożek zakończony kulą. Fragment kuli uformuj powielając i obracając wokół osi Z dodaną przed chwilą ćwiartkę ośmiokąta (Rysunek 4.9.9a):
Rysunek 4.9.9 Formowanie przedniej krawędzi steru kierunku (część dolna)
Część stożkową uzyskasz poprzez wytłoczenie i zmniejszenie skali krawędzi stworzonej przed chwilą kuli (Rysunek 4.9.9b). Nie będziemy jej “dociągać” do reszty siatki — P-40 miał w tym miejscu duży otwór. (Obsługa techniczna miała w ten sposób łatwy dostęp do popychaczy sterów).
Scalenie tak przygotowanej przedniej krawędzi z resztą siatki wymaga uprzedniego dodania do niej dwóch dodatkowych “żeber” (Rysunek 4.9.10a). (Są potrzebne, aby można było ją połączyć z odpowiednimi krawędziami na powierzchni steru za pomocą ścian czworokątnych):
Rysunek 4.9.10 Szczegóły przedniej krawędzi steru kierunku (część dolna)
Usuń tylną (schowaną w sterze) część stożka, i scal resztę z powierzchnią steru tworząc nowy rząd ścian (Rysunek 4.9.10b). Zwróć uwagę na układ ścian na powłoce kuli, u dołu siatki. Usuń jedną z jej krawędzi (a), aby wszystkie ściany tej siatki były prostokątne. Uzyskasz dzięki temu ładny, regularny kształt bez wypiętrzenia w okolicach “bieguna” tej sfery. Usuń jeden z rzędów ścian, by dodać w tym miejscu drugi otwór na zawias steru. Obydwa otwory zabuduj “na płasko” dodatkowymi ścianami (Rysunek 4.9.10b).
Ster jest już uformowany, pozostaje tylko dodać mu oś. Wstaw w odpowiednie miejsce “rurkę” o nazwie B.260.Rudder Axis (Rysunek 4.9.11a):
Rysunek 4.9.11 Wykończenie podzespołu — dodanie osi steru, wygląd ostateczny
Połącz cały podzespół w hierarchiczną całość, analogicznie jak usterzenie poziome: oś jest “rodzicem” steru, a “rodzicem” osi jest statecznik. Następnie “zaklinuj” (obrót wokół osi Z) statecznik pionowy pod kątem 1.5º. Rysunek 4.9.11b) przedstawia gotowy zespół usterzenia.
Rysunek 4.9.12 Porównanie szerokości statecznika z planami modelarskimi
Porównamy rezultat naszej pracy z rzutem z przodu z planów Mariusza Łukasika. (Poprawiłem już ich położenie względem modelu, uwzględniając niepoprawną pozycję kołpaka śmigła — por. str. 168). Rysunek 4.9.12 pokazuje, że usterzenie pionowe na planach jest zdecydowanie za grube.
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.09.blend (por. str. 22).
Wobec bardziej “fantazyjnych” kształtów steru kierunku, metoda wstępnego przybliżenia trapezem całego usterzenia może zawieść (str. 170). Warto jednak spróbować użyć jej do przybliżenia kształtu statecznika.
Ster kierunku P-40 jest przykładem powierzchni sterowej, w której zastosowano kompensację aerodynamiczną. (W takim rozwiązaniu przednia krawędź steru jest przesunięta do przodu względem osi obrotu. Przekrój takiej krawędzi nie jest okrągły, a np. eliptyczny).
Czasami warto usunąć na chwilę kilka ścian, gdy otwiera to nowe możliwości wstawiania krawędzi poleceniem Loop Cut (np. przy uskoku przedniej krawędzi — p. str. 172).
Powłokę kuli można dobrze przybliżyć za pomocą czterech ośmiokątów (p. str. 174). Kwadratowe ściany w okolicach “biegunów” takiej powłoki uzyskasz, rezygnując w nich po jednej z przekątnych w każdej. (Scalając po dwie trójkątne ściany w jedną czworokątną).
W tej sekcji wykonamy środkową i tylną część kadłuba (Rysunek 4.10.1):
Rysunek 4.10.1 Fragment kadłuba, który odwzorujemy w tej sekcji
Dlaczego nie cały kadłub? Po pierwsze dlatego, że okapotowanie silnika ma dość złożony kształt. Po drugie — zawsze warto dzielić model na takie zespoły, na jakie była podzielona prawdziwa konstrukcja. W prawdziwych P-40 i P-36 środek i tył kadłuba tworzyły technologiczną całość. Po trzecie — nos P-40 zmieniał się często, od wersji do wersji. Środek i ogon, mimo tych zmian, pozostawał taki sam — i w P-36, i w P-40 (B, C). Będziesz mógł później wykorzystać tę część w innych modelach.
Modelowany fragment zawiera dwa duże otwory — na kabinę pilota i chowane kółko ogonowe. Aby te wycięcia nie zaburzyły kształtu kadłuba, zawczasu poprowadźmy wzdłuż ich krawędzi “ostre” (crease = 1) podłużnice (Rysunek 4.10.1). Gdy połączone taką podłużnicą ściany będą leżały w jednej płaszczyźnie — uzyskamy gładkie i wolne od deformacji krawędzie otworów (por. Rysunek 4.10.4a, a więcej wyjaśnień — str. 1234).
Formowanie kadłuba zaczynamy od wstawienia w płaszczyźnie ZX pierwszej wręgi (Rysunek 4.10.2b). To połówka okręgu (Circle), złożna z kilkunastu wierzchołków. W nowym obiekcie od razu włączyłem modyfikatory Mirror (względem osi X) i Subsurf. Dzięki nim druga, symetryczna połowa kadłuba rysuje się “sama” (Rysunek 4.10.2a):
Rysunek 4.10.2 Pierwsza wręga
Po przekształceniu okręgu w pierwszą wręgę, wytłocz ją wzdłuż osi kadłuba, aż za kabinę pilota (Rysunek 4.10.3a) . “Ściśnij” (poprzez zmianę skali w kierunku osi Z) jej dolną połowę tak, by zetknęła się z dolną powierzchnią płata (Rysunek 4.10.3a, Rysunek 4.10.4b). Zmniejsz także jej szerokość wzdłuż osi X — zgodnie z rzutem z góry (Rysunek 4.10.3b):
Rysunek 4.10.3 Wytłoczenie fragmentu kadłuba i zmiana rozmiaru ostatniej wręgi
Na razie nie zmieniaj rozmiaru górnej części powłoki. Dlaczego? Ponieważ zawiera krawędź, po której przesuwa się do tyłu owiewka kabiny pilota. W samolotach z tego okresu owiewka kabiny pilota była zazwyczaj odsuwana na parze małych szyn. Tak też było w P-40. Te szyny muszą mieć taki sam rozstaw na całej długości. Inaczej owiewka nie mogłaby po nich “jeździć”. A to z kolei znaczy, że szerokość kadłuba wzdłuż tych szyn nie może ulegać zmianie. To drobiazg, o którym często zapominają autorzy planów modelarskich. (Nieraz zetknąłem się z sytuacją, gdy nakreślone przekroje w tym obszarze się zawężały). Rysunek 4.10.4a pokazuje, że na kadłubie naszego P-40 krawędź 2 musi zachować wzdłuż toru owiewki kabiny stałą szerokość.
Rysunek 4.10.4 Szczegóły wytłoczenia pierwszej części kadłuba
Aby otwór na kabinę nie miał wzdłuż krawędzi żadnych deformacji krawędź 2 musi być oznaczona jako “ostra” (crease = 1). Jednocześnie ściany |1 2| i |2 3| muszą leżeć na tej samej płaszczyźnie (Rysunek 4.10.4a), aby wzdłuż “ostrej” krawędzi 2 kadłub pozostał gładki.
Ściana |2 4| może być pochylona pod innym kątem, gdyż znajduje się już za kabiną pilota. (Będzie dopasowywana do obrysu za kabiną, który był bardziej pionowy.)
W tak przygotowaną siatkę wstaw dwie kolejne wręgi (najpierw wstaw wręgę 1, dopasuj do szerokości kadłuba, potem wstaw wręgę 2). Następnie usuń wierzchołki z obszaru kabiny (Rysunek 4.10.5):
Rysunek 4.10.5 Przygotowania do formowania górnej części kadłuba
Rysując kształt kadłuba P-40 B, C przed kabiną pilota, obydwaj autorzy planów, z których korzystamy — Jacek Jackiewicz i Mariusz Łukasik — popełnili błąd. Przekroje na ich planach pokazują w tym obszarze regularny, eliptyczny przekrój. W rzeczywistości na zdjęciach widać przed kabiną dwa wyraźnie narożniki (Rysunek 4.10.6a, b) . Te “wypukłości” były spowodowane położeniem zamków nkm Browing (Rysunek 4.10.5, Rysunek 4.10.6b). Końce zamków karabinów znajdowały się po obydwu stronach tablicy przyrządów. Tak było także w P-361. Wydaje się, że P-36 i P-40 B, C miały identyczny kształt tego fragmentu kadłuba.
Rysunek 4.10.6 Uformowanie odcinka kadłuba przed kabiną pilota
Do siatki dodaj także linię konturu kadłuba za kabiną pilota. Na rzucie z przodu Mariusza Łukasika jej szczyt ma przekrój spłaszczonej elipsy. Udało mi się znaleźć kilka zdjęć, dzięki którym zweryfikowałem jej kształt. Grzbiet kadłub za kabiną pilota miał przekrój okrągły, o promieniu nieco mniejszym od owiewki (Rysunek 4.10.6b).
Formując dalej kształt tej części kadłuba, wytłocz wzdłuż osi Y kontur za kabiną pilota (Rysunek 4.10.7). Po wytłoczeniu spłaszczy nową krawędź (poprzez zmianę skali do 0 wzdłuż osi Y). Umieść ją tak, by znalazła się dokładnie ponad końcową wręgą dolnej części kadłuba i scal z resztą obrysu za pomocą dodanej ściany (szczegóły — patrz str. 934):
Rysunek 4.10.7 Dalsze uzupełnianie środkowej sekcji kadłuba
Wytnij w powłoce (używając Knife) wręgi 3 i 4. Zagęść w ten sposób siatkę spodu kadłuba, przygotowując ją do przecięcia powierzchnią płata. Natnij także, tuż przy przedniej krawędzi, wręgę 5. Potem wystarczyło usunąć część dotychczasowej przedniej krawędzi, by uzyskać uskok, jak występował w prawdziwym samolocie. (P-36 miał w tym miejscu rząd szczelin odprowadzających powietrze z silnika chłodzonego powietrzem. W P-40 B, C “tak zostało”, zapewne by nie trzeba było zmieniać oprzyrządowania linii produkcyjnej).
Kolejnym krokiem jest wyznaczenie krawędzi przecięcia kadłuba ze skrzydłem (Rysunek 4.10.8) . Użyj do tego dodatku Intersection (str. 829):
Rysunek 4.10.8 Wyznaczenie krawędzi przecięcia z płatem
Przecięcie wykonaj tak, by jego krawędź została dodana do siatki kadłuba. Następnie usuń dotychczasowe wierzchołki spodu kadłuba i stwórz nowe ściany w oparciu o wierzchołki krawędzi przecięcia:
Rysunek 4.10.9 Wyznaczenie krawędzi przecięcia z płatem
Uzyskałeś w ten sposób kolejny otwór w kadłubie. Prawdziwy samolot także miał taki — w P-40 kadłub “leżał” na skrzydle (był przykręcony do niego śrubami).
Wytłocz teraz dolną i środkową część ostatniej wręgi w kolejny segment ogona (Rysunek 4.10.10):
Rysunek 4.10.10 Wytłoczenie pierwszej części ogona
Po wytłoczeniu, “ściśnij” wszystkie wierzchołki ostatniej wręgi, znajdujące się poniżej osi kadłuba (Rysunek 4.10.10) do rozmiaru obrysu z dołu. Pozostałe wierzchołki możesz “ścisnąć” zupełnie nieznacznie, tak tylko, by górna krawędź pokryła się z narysowaną na planach podłużnicą.
Dolna krawędź kadłuba była w rzucie z boku linią prostą2, więc nie będzie trzeba dodawać z tego powodu kolejnej wręgi pośrodku ogona. (I tak będzie trzeba ją dodać, by “uwypuklić” kształt grzbietu kadłuba).
“Ściśnij” ostatnią wręgę także wzdłuż osi X (Rysunek 4.10.11a). Dopasujesz się w ten sposób do obrysu z góry. (Tu także widać, że trzeba dodać kolejną wręgę pośrodku ogona, by uwypuklić nieco kadłub w tym rzucie).
Przygotowując się do wycięcia w kadłubie otworu na kółko ogonowe, skopiuj fragment ostatniej wręgi. Przysuń tę linię do steru kierunku. To będzie końcowa krawędź kadłuba (por. Rysunek 4.10.11b). Dlaczego nie utworzymy jej przez wytłoczenie dotychczasowej krawędzi? Bo czeka nas na tym odcinku dodatkowa praca, związana z precyzyjnym ukształtowaniem każdej z jego krańcowych wręg. Gdybyśmy wytłoczyli ten fragment, nie widzielibyśmy ich wygładzonych linii odpowiednio dokładnie.
Zacznij od dopasowania wręgi końca kadłuba. Powinna dobrze przylegać do obrysu steru kierunku, więc ustaw jej wierzchołki w odpowiedni sposób. Nie zapomnij o zachowaniu odpowiedniego dystansu od steru (ok. 1 cm w rzeczywistym samolocie — Rysunek 4.10.12b). Na razie połącz obydwie wręgi pojedynczą podłużnicą (|Bb| — Rysunek 4.10.11b). To krawędź otworu kółka ogonowego. Od razu oznacz ją jako ostrą (crease = 1).
Rysunek 4.10.11 Szczegóły formowania pierwszej części ogona
Musisz jeszcze ustawić każdą z trójek wierzchołków: |abc|, |ABC| w ten sposób, by w rzucie z przodu leżały na jednej linii. (To pozwoli uniknąć wybrzuszeń krawędzi otworu). Taka modyfikacja “popsuje” jednak gładki, eliptyczny obrys obydwu wręg. Będzie trzeba nieco poprzesuwać wierzchołki sąsiadujące ze “spłaszczonymi” odcinkami, by kształt tych sekcji kadłuba jak najmniej odbiegał od początkowego. W przypadku tylnej krawędzi, naturalnym wzorcem właściwego obrysu jest kształt steru kierunku. W przypadku wręgi położonej bliżej — przed spłaszczeniem odcinka |ABC| skopiuj wierzchołki tej linii (Shift-D), i odrobinę zmniejsz ich skalę (względem osi kadłuba) (Rysunek 4.10.11b). Uzyskasz w ten sposób “wzorzec”, z którym będziesz mógł porównywać obrys modyfikowanej wręgi. Gdy tylko osiągniesz zamierzony kształt — usuń ten wzorzec, bo już nie będzie do niczego potrzebny.
Podczas dopasowywania do eliptycznego obrysu, musisz manipulować każdą z trójek wierzchołków (|abc| i |ABC|): skracać, obracać, przesuwać. Należy to robić tak, by wszystkie trzy wierzchołki zawsze leżały na jednej linii. Najprościej to osiągnąć, zaznaczając takie trzy punkty i przełączając się na orientację normalną (Alt-Spacja, Orientation→Normal). W tym trybie lokalna oś Y trzech zaznaczonych wierzchołków przebiega wzdłuż wypadkowej odcinków które tworzą (Rysunek 4.10.11b — |AB| i |BC|). Zaczynasz od “spłaszczenia” tej trójki: wystarczy zmienić ich skalę wzdłuż lokalnej osi X do zera. Potem możesz odrobinę ten zespół obrócić, dopasowując z powrotem do wzorcowego obrysu. W trakcie dalszych manipulacji konieczne będzie zmniejszenie długości krawędzi |ABC|. Można je uzyskać przez zmianę skali wzdłuż lokalnej osi Y.
Gdy kształt konturów siatki wokół wierzchołków |abc|, |ABC| wygląda poprawnie, możesz usunąć pomocnicze, „wzorocowe” krawędzie.
Gdy ostatnia i poprzednia wręga kadłuba są już uformowane — połącz ich odpowiednie wierzchołki ścianami (F, str. 921) (Rysunek 4.10.12a). Następnie wytłocz cztery górne wierzchołki, i dopasuj je do krawędzi steru (Trzeba je m.in. „spłaszczyć” wzdłuż osi X — por. Rysunek 4.10.12b) :
Rysunek 4.10.12 Szczegóły formowania tylnej krawędzi kadłuba
Kolejnym krokiem jest wytłoczenie górnej części ogona, aż do przedostatniej wręgi (Rysunek 4.10.13):
Rysunek 4.10.13 Szczegóły formowania grzbietu kadłuba za kabiną
Oczywiście, po wytłoczeniu zmień rozmiar tego fragmentu, aby pasował w tym miejscu do reszty przekroju kadłuba. Następnie połącz go z nim pojedynczą ścianą.
Grzbiet i boki ogona P-40 były nieco wypukłe, więc wstaw pośrodku ogona kolejną wręgę (Rysunek 4.10.14). Poszerz ją nieco (poprzez zmianę skali wzdłuż osi X), aby dopasować krawędź kadłuba do konturu w rzucie z góry (XY). Górny fragment wręgi dopasuj do obrysu z boku (str. 934).
Pozostało jeszcze wstawić (Loop Cut) kolejną wręgę pod statecznikiem pionowym, i “dociągnąć” do niej (poprzez wytłoczenie) kontur grzbietu (Rysunek 4.10.14). Ten fragment ułatwi formowanie owiewki, zakrywającej połączenie stateczników z kadłubem. Wreszcie, na koniec, uprość układ ścian kadłuba ponad tylną częścią skrzydła. To przygotowanie do zmiany kształtu tego fragmentu. (Zdjęcia wykazują, że miał w tym miejscu nieco inny przekrój, niż wynika to z planów JJ czy ML):
Rysunek 4.10.14 Wstawienie dodatkowych wręg kadłuba
W wyniku analizy zdjęć okazało się, że wzdłuż kabiny pilota, poniżej osi samolotu, ściany kadłuba były niemal pionowe (Rysunek 4.10.15). Wydaje się to uzasadnione, gdyż ta część konstrukcji zawierała kadłubowy zbiornik paliwa. Na pewno w oczach konstruktorów okropnym marnotrawstwem byłaby rezygnacja z kilku galonów paliwa w imię zaokrąglenia przekroju.
Rysunek 4.10.15 Poprawka tylnej części krawędzi łączącej kadłub z płatem
Usuń dolną część wręgi 2 i przedostatni wierzchołek wręgi 1. Potem ukształtuj ten fragment kadłuba na nowo, wytłaczając dolną część wręgi 3. Każdy kolejny z tych segmentów coraz bardziej pochylaj, by ostatni “położyć” na górnej powierzchni płata (Rysunek 4.10.15). Następnie odtwórz brakujące fragmenty wręgi 1 i 2 (Rysunek 4.10.16):
Rysunek 4.10.16 Poprawiony kształt kadłuba
Teraz można wyciąć otwór kółka ogonowego. Przygotuj się do tego, nacinając (Knife) dwie dodatkowe płaskie wręgi wzdłuż linii nitów kadłuba (Rysunek 4.10.17). (To dla zagęszczenia siatki i z myślą o przyszłych teksturach nierówności). Kolejne trzy “częściowe” wręgi umieść tak, by znalazły się w istotnych miejscach zarysu luku na kółko ogonowe. (Jedna z nich wyznacza tylną krawędź otworu, dwie pozostałe — końce zaokrąglonych narożników):
Rysunek 4.10.17 Przygotowania do wycięcia otworu na kółko ogonowe
Po przygotowaniu podłużnic możesz naciąć (za pomocą Knife) przednią i tylną krawędź luku podwozia. Na razie nie będą miały zaokrągleń na narożnikach. Przednią krawędź wytnij w rzucie z boku (w tym rzucie jest ukośną linią prostą). Tylna krawędź w rzucie z dołu ma kształt fragmentu okręgu. Można by było oczywiście wyznaczyć ją za pomocą pomocniczego walca i skryptu Intersection. (Analogicznie, jak wyznaczyliśmy luk podwozia głównego w skrzydle — str. 155). Jeżeli jednak masz w miarę pewną rękę, takie mniej istotne otwory możesz także wykonać za pomocą Knife.
Rysunek 4.10.18 Szczegóły krawędzi otworu kółka ogonowego
Pozostały jeszcze do wykonania zaokrąglenia na krawędziach luku (Rysunek 4.10.18). Aby nadać im właściwy kształt, należy poprzesuwać po powierzchni ściany kilka wierzchołków, by uformowały odpowiednią krzywą. Najprościej to zrobić ustawiając widok w płaszczyźnie wybranej ściany (Shift-7, View→Align View→Align View To Selected→Top — str. 932). Jeżeli masz wątpliwości, na str. 936 znajdziesz szczegółowy opis uformowania takiego narożnika. Narożnik tylnej krawędzi jest prostszy od przedniej. To w istocie jeden dodatkowy wierzchołek, “dopasowujący” przejście łuku w prostą.
Oznacz przednie i tylne krawędzie otworu jako “ostre” (crease = 1). Następnie zaznacz całe jego wnętrze i wydziel je (P, Separate) w oddzielny obiekt — pokrywę luk podwozia. Nadaj mu nazwę B.305.L.Door. (To jest lewa strona luku. Potem skopiujemy ją także w prawą).
Rysunek 4.10.19 pokazuje kształt otworu po wydzieleniu luku. Dzięki dobremu przygotowaniu (por. Rysunek 4.10.11, str. 182) udało się uzyskać bardzo regularną krawędź, bez żadnych wybrzuszeń i innych deformacji:
Rysunek 4.10.19 Otwór kółka ogonowego po wydzieleniu pokryw
Nie zapomnij o dodaniu “fazki” wzdłuż krawędzi luku podwozia (“na grubość blachy”). Wydzielonej pokrywie nadaj podobną grubość, na przykład używając polecenia Solidify (por. str. 939). (Później będzie jeszcze trzeba dodać jej wewnętrzne usztywnienia).
Pierwszy etap formowania kadłuba jest ukończony. Rysunek 4.10.20 pokazuje uzyskany kształt:
Rysunek 4.10.20 Rezultat — uformowany środek i tył kadłuba
Nadaj temu obiektowi nazwę B.300.Fuselage.
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.10.blend (por. str. 22).
Kadłub rozpoczynamy od narysowania połówki pojedynczej wręgi. Najlepiej wybrać jedną z wręg istotnych pod względem konstrukcyjnym — np. w okolicy kabiny pilota (por. str. 177).
Kształt kadłuba tworzymy poprzez wytłoczenia kolejnych fragmentów. Na każdym kroku należy weryfikować ich kontury z planami i zdjęciami (por. str. 178, 179)
Przygotowując otwór w kadłubie, umieść na jego przeciwległych krawędziach “ostre” podłużnice. Ściany połączone za pomocą tych podłużnic, powinny leżeć na tej samej płaszczyźnie (str. 182, 186).
W tej sekcji ukształtujemy górne i boczne osłony silnika (Rysunek 4.11.1). Ze względu na bardzo skomplikowaną geometrię, osłonie chłodnicy cieczy poświęcę całą następna sekcję (4.12, str. 198).
Rysunek 4.11.1 Fragment kadłuba, który odwzorujemy w tej sekcji
Proponuję podzielić przód kadłuba na części, odpowiadające oryginalnym panelom pokrywy silnika. To oznacza na początku trochę więcej pracy. Potem jednak łatwiej będzie odwzorować otwory na rury kolektora spalin, i wypukłości osłony karabinów oraz chwytu powietrza. Uformowanie każdego z tych szczegółów wymaga lokalnego zagęszczenia siatki. Co więcej, dla każdego z tych detali trzeba będzie to zrobić w nieco inny sposób. Próba odwzorowania wszystkiego na jednej powłoce prowadziłaby do nadmiernej komplikacji jej topologii. Dzieląc powłokę na pojedyncze panele, możemy lokalnie dobrać dla każdego z nich odpowiedni układ siatki. Co więcej, może Ci się zamarzyć w przyszłości wykonanie w środku makiety silnika Allison, i stworzenie obraz pokazującego “rozbebeszony” samolot na lotnisku. W ten sposób powłokę silnika będziesz miał już do tego przygotowaną.
Aby podział na panele odbył się bez komplikacji, już na wstępnych etapach formowania należy poprowadzić wzdłuż ich przyszłych granic „ostre” (crease = 1) krawędzie. Rysunek 4.11.1 pokazuje ich układ.
Pracę zacznij od wydzielenia (P, Separate) wierzchołków przedniej wręgi z uformowanej poprzednio części kadłuba (Rysunek 4.11.2). To zalążek osłony silnika:
Rysunek 4.11.2 Wydzielenie przedniej wręgi z uformowanej części kadłuba
Wydziel także z kołpaka śmigła (B.005.Hub) obrys podstawy, i scal go (Ctrl-J, Join Objects) z tworzoną siatką (Rysunek 4.11.3):
Rysunek 4.11.3 Wręga początkowa — skopiowana podstawa kołpaka śmigła
Usuń wierzchołki z z prawej strony wręgi początkowej. Upewnij się że ten obiekt ma włączony modyfikator Mirror (względem osi X) i Subsurf (Subdivisions = 2). Przednia wręga ma teraz pięć wierzchołków, a tylna — około 20. Potraktuj tylną („gęstą”) wręgę jako wzorzec docelowego kształtu. Utwórz w tym samym miejscu nową wręgę końcową, złożoną z tylu wierzchołków, co wręga początkowa (Rysunek 4.11.4a):
Rysunek 4.11.4 Dopasowanie nowej (ośmiokątnej) tylnej wręgi do wzorca obrysu (wręgi “gęstej”)
Najłatwiej nową wręgę końcową utworzyć poprzez skopiowanie wręgi początkowej, i poprzesuwanie jej wierzchołków. Rysunek 4.11.4a pokazuje, że nawet za pomocą pięciu punktów (lub symetrycznie licząc — ośmiu) można całkiem nieźle odwzorować krzywiznę “gęstej” wręgi wzorcowej.
Tak przygotowane wręgi połącz ścianami (Rysunek 4.11.4b) (możesz stworzyć je poleceniem Bridge Edge Loops — por. str. 922). Zwróć uwagę, że gęstość takiej siatki przy dwukrotnym podziale jest zbliżona do gęstości wierzchołków na linii wzorcowej (“gęstej” wrędze). Kształt, który utworzymy za pomocą tej rzadkiej (“ośmiobocznej”) siatki będzie pierwszym przybliżeniem kształtu kadłuba. Potem tę siatkę zagęścimy, “utrwalając” (Apply) modyfikator Subsurf. Dokładne dopasowanie do kształtu wręgi wzorcowej uzyskamy za pomocą ok. 16 wierzchołków.
Wstaw (Loop Cut) w nowo utworzoną powłokę kolejne dwie wręgi. Rozciągnij je wzdłuż osi Z i X tak, by uzyskać właściwy kształt w rzucie z góry i z boku (Rysunek 4.11.5):
Rysunek 4.11.5 Formowanie podstawowego kształtu nosa P-40B
W rzucie z boku skoncentruj się przede wszystkim na właściwym uformowaniu górnej części nosa samolotu. Dolną część ukształtuj tylko pobieżnie, tyle tylko, aby poprawnie uformować boki osłony silnika. Osłona chłodnicy, znajdująca się u dołu, zostanie poddana intensywnej adaptacji w następnej sekcji (str. 198).
Zdjęcia zdają się wykazywać, że górna część osłony silnika nie miała idealnie eliptycznego przekroju. (Taki kształt mają przekroje na planach Jacka Jackiewicza i Mariusza Łukasika). Z przodu, przed kolektorem spalin, grzbiet pokrywy silnika był nieco spłaszczony. Jest to konieczne, by ukryć pod nią cylindry silnika1. Dalej przekrój przechodził płynnie w obrys, jaki nadaliśmy wrędze końcowej. To także nie jest elipsa — jest nieco wypiętrzona tam, gdzie znajdowały się zamki karabinów (por. str. 179).
Aby uzyskać odpowiedni kształt grzbietu osłony silnika, przesuń do góry cztery wierzchołki środkowych wręg (Rysunek 4.11.5, Rysunek 4.11.6a):
Rysunek 4.11.6 Formowanie podstawowego kształtu nosa P-40B
Dodatkowo, poszerz w kierunku X ścianę, którą tworzą te wierzchołki. Rysunek 4.11.6b pokazuje kształt powłoki, który powinieneś przy tym osiągnąć.
Uzyskaliśmy “zgrubny” kształt nosa samolotu. Teraz należy zwiększyć liczbę podłużnic, aby można było dokonać dalszych, drobnych modyfikacji. Nie będziemy na razie zwiększać liczby wręg (to by niepotrzebnie skomplikowało siatkę i utrudniło jej dalsze zmiany).
Aby zwiększyć liczbę podłużnic, zacznij od usunięcia dotychczasowych. Pozostaw tylko cztery krawędzie, po pięć wierzchołków każda (Rysunek 4.11.7):
Rysunek 4.11.7 Przygotowanie do zwielokrotnienia wierzchołków: usunięcie “podłużnic”
Następnie przełącz się w tryb obiektu (Object Mode) i “utrwal” modyfikatory siatki, naciskając przyciski Apply: najpierw dla modyfikatora Mirror, potem dla Subsurf 2. (Naciśnięcie Apply powoduje jednocześnie usunięcie modyfikatora. Wierzchołki, które generował, stały się “realne”, i nie jest już więcej potrzebny). Potem przełącz się z powrotem w tryb edycji (Edit Mode). Rysunek 4.11.8 przedstawia rezultat tej operacji:
Rysunek 4.11.8 “Zagęszczenie” wierzchołków poprzez “utrwalenie” modyfikatorów Subsurf i Mirror
Pozostaje jeszcze “posprzątać”: usuń prawe strony wręg, włącz powtórnie modyfikatory Mirror i Subsurf. Następnie połącz te wręgi ścianami poleceniem Mesh→Edges→Bridge Edge Loops. Rysunek 4.11.9 pokazuje rezultat tej operacji:
Rysunek 4.11.9 Siatka z czterokrotnie zwiększoną liczbą podłużnic
Dodaj także (Loop Cut) jedną dodatkową podłużnicę, umieszczając ją bardzo blisko osi kadłuba. Stworzysz w ten sposób wąski “pasek” ścian, ustawionych zupełnie poziomo (Rysunek 4.11.9). Powinien zapewnić poprawny kształt powłok dodanych poleceniem Solidify. Skopiuj także jeszcze raz z drugiej części kadłuba przednią wręgę, i włącz ją powtórnie do siatki osłony silnika. Teraz już nie wypada nazywać jej “gęstą”, gdy liczba wierzchołków wszystkich pozostałych wręg stała się bardzo zbliżona. Nadal jednak przyda się nam w charakterze wzorca do dopasowywania. (Tym razem do dokładnego uzgodnienia miejsca styku przedniej i tylnej sekcji kadłuba).
Przygotowując się do “pocięcia” przodu samolotu wzdłuż oryginalnych łączeń blach, trzeba nieco poprzesuwać podłużnice (Rysunek 4.11.10):
Rysunek 4.11.10 Dopasowywanie (poleceniem Edge Slide) podłużnic siatki do linii podziału paneli na osłonie silnika
Zacznij od przesunięcia (Ctrl-E, Edge Slide) całej krawędzi |1234| tak, aby jej początek (wierzchołek 1) przy kołpaku śmigła znalazł się we właściwym miejscu. Potem skoryguj położenie kolejnych wierzchołków — 2,3, 4— przesuwając je wzdłuż poprzecznych krawędzi (Shift-V — Vertex Slide) tak jak to pokazuje Rysunek 4.11.11. Oczywiście, aby uzyskać docelowe położenie wierzchołków, trzeba przesunąć w ten sposób nie jedną, a kilka podłużnic, jedną za drugą.
Rysunek 4.11.11 Przesuwanie wierzchołków podłużnicy (dopasowanie krawędzi siatki do linii podziału paneli)
Na koniec należy włączyć ostrość (crease = 1) linii przyszłych podziałów (Rysunek 4.11.12b). W ten sposób nabiorą takiego kształtu, jak krawędzie powłok, na które zamierzamy podzielić nos samolotu. Warto na czas tej operacji włączyć w modyfikatorze Subsurf przełącznik Apply during edit (Rysunek 4.11.12a). W tym trybie zamiast krawędzi oryginalnej siatki Blender rysuje segmenty wygładzonej powłoki. W tej postaci łatwiej można sprawdzić, czy ostra krawędź dokładnie pokrywa się z podziałami oryginalnych paneli. Czasami pojawia się konieczność dodania kolejnych podłużnic, aby zapełnić “puste przestrzenie”, pozostałe po wcześniejszych przesunięciach (Rysunek 4.11.12a):
Rysunek 4.11.12 Przygotowywanie siatki do podziału na panele
Po ustawieniu kluczowych krawędzi, można dopasować dokładnie miejsce połączenia przedniej i tylnej części kadłuba.
Dodaj poprzez wytłoczenie występ, pasujący do uskoku wręgi wzdłuż ściany ogniowej (Rysunek 4.11.13a). Potem powiększ obraz (zoom), i dopasuj poszczególne wierzchołki tej tylnej krawędzi siatki osłony silnika do reszty części kadłuba (Rysunek 4.11.13b) . Najwygodniej jest to zrobić, metodycznie poprawiając kolejne punkty ustawione wzdłuż linii łączącej dwie siatki. Podczas dopasowywania przesuwaj poszczególne wierzchołki wzdłuż osi globalnych: Z i X. Dzięki temu nie jesteś ograniczony do pracy wyłącznie w określonym rzucie (z lewej, góry czy przodu) i możesz je przesuwać w dowolnym widoku.
Rysunek 4.11.13 Dopasowanie połączenia przedniej i tylnej części kadłuba
Dodaj jeszcze jedno żebro tam, gdzie znajduje się tylna ściana osłony chłodnicy i koniec otworu na kolektor rur wydechowych. Aby nie zaburzyć tak pracowicie przygotowanego układu podłużnic, zrób to w takiej kolejności jak przedstawia Rysunek 4.11.14:
Rysunek 4.11.14 Dodanie do nosa samolotu dodatkowej, piątej wręgi
Rysunek 4.11.15 pokazuje kształt osłony silnika, jak osiągnęliśmy na tym etapie:
Rysunek 4.11.15 Osłona silnika — kształt po uformowaniu
Teraz możesz wydzielić (P, Separate) z powłoki poszczególne panele (Rysunek 4.11.16):
Rysunek 4.11.16 Wydzielenie z powłoki poszczególnych paneli osłony silnika
Po rozdzieleniu powłoki można odciąć fragment jej dolnej części, którego nie było w prawdziwym samolocie (Rysunek 4.11.17). (Możemy to zrobić dopiero teraz, gdy nie zaburzy to w żaden sposób układu krawędzi na pozostałej części siatki). Linię cięcia (Knife) poprowadź wzdłuż krawędzi widocznej na planach modelarskich (P-40 miał w tym miejscu ostre zakończenie kadłuba):
Rysunek 4.11.17 Odcięcie niepotrzebnego, dolnego fragmentu powłoki modelu
Nie zapomnij o pogrubieniu każdej z paneli, imitującego grubość blachy (o 0.02 jedn.). Okazuje się, że do takich podłużnych kształtów najlepiej nadaje się polecenie Solidify (str. 939). Po jego wywołaniu musisz tylko usunąć wszystkie wierzchołki drugiej ściany, stworzonej przez tę operację, pozostawiając tylko ściany boczne (Rysunek 4.11.18):
Rysunek 4.11.18 Pogubienie panelu osłony za pomocą polecenia Solidify
Zamiast polecenia Solidify możesz użyć modyfikatora Solidify (szczególnie gdy nie zamierzasz eksportować tego modelu do innych programów
Wzdłuż ostrego załamania gładkich ścian o różnej długości powstają brzydkie “cienie”. Taki efekt przeszkadza w pracy nad modelem. Możesz je wyeliminować, wstawiając (Loop Cut) dodatkowe wręgi bardzo blisko przedniej i tylnej krawędzi każdego panelu (Rysunek 4.11.19):
Rysunek 4.11.19 Pogrubienie blach (0.01 jednostki Blendera)
Zamiast dodawać taką krawędź, możesz także włączyć opcję Normals:Auto Smooth (por. str 974). Ja wolę jednak poprawić najpierw co większe cienie „w siatce”, aby nie pojawiły się przy eksporcie do innych programów (np. do postaci odpowiedniej dla różnych silników gier).
Rysunek 4.11.20 podaje nazwy, jakie nadałem poszczególnym częścią osłony silnika. Panele boczne otrzymały dodatkowy wyróżnik “L” (jak Left) po numerze. To na przyszłość — przed rozpoczęciem teksturowania trzeba będzie zastąpić po prawej stronie samolotu lustrzane odbicia tych części prawdziwymi siatkami. Wyróżnimy je literą “R” (jak Right):
Rysunek 4.11.20 Nazwy, nadane poszczególnym panelom osłony silnika
Fragment, z którego powstanie osłona chłodnicy cieczy zredukuj do niewielkiego odcinka od kołpaka śmigła do chwytu powietrza (B.350.Cowling.005). Resztę tej osłony stworzymy od podstaw w następnej sekcji.
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.11.blend (por. str. 22).
Przekroje, umieszczone na planach modelarskich traktuj z dużą rezerwą. Mogą zawierać wiele błędów. Podczas formowania kształtu zwracaj przede wszystkim uwagę na zdjęcia, oraz na rzuty z boku i góry/dołu;
Formowanie może przebiegać w dwóch etapach. Pierwszy etap to “zgrubne” nadanie kształtu, za pomocą siatki o niewielkiej liczbie krawędzi (str. 190). Drugi etap to drobne poprawki, wykonane na siatce o zwiększonej liczbie krawędzi (str. 192);
Aby zwiększyć siatkę dla jednego typu krawędzi (np. podłużnic), musisz je wszystkie usunąć z pierwotnej siatki pozostawiając np. tylko wręgi (por. str. 191). Potem “utrwal” (przyciskiem Apply) modyfikator Subsurf, zwiększając liczbę wierzchołków na każdej z tych linii (str. 191). Na koniec — odtwórz brakujące ściany i krawędzie.
Dopasowanie krawędzi siatki do zadanej linii najlepiej jest wykonywać za pomocą poleceń Edge Slide i Vertex Slide, metodą “od lewej do prawej” (str. 192);
Do nadania “grubości blachy” poszczególnym panelom można wykorzystać polecenie Solidify (str. 195);
Wszystkie chłodnice cieczy — glikolu i oleju — były w P-40 umieszczone bezpośrednio pod silnikiem (Rysunek 4.12.1a). Ich wlot powietrza był podzielony dwoma ściankami na trzy kanały: środkowy, do chłodnicy oleju i boczne, do chłodnic glikolu. Przed kanałami bocznymi były wytłoczone w kadłubie wgłębienia, zwiększające napływ powietrza (Rysunek 4.12.1b). Zespół wlotów powietrza wraz z tymi wgłębieniami tworzy dość złożony kształt, który odwzorujemy w tej sekcji.
Rysunek 4.12.1 Osłona chłodnicy cieczy
Pracę nad zacznij od zagęszczenia przedniego odcinka siatki (od kołpaka śmigła do wlotu powietrza — element B.350.Cowling.005). Zrób to “utrwalając” (przycisk Modifiers:Apply) modyfikator Subsurf z Subdivisions = 2 (Rysunek 4.12.2a). Gęsta siatka jest w tym miejscu potrzebna do odwzorowania wgłębienia przed wlotem powietrza oraz zaokrąglonych narożników wlotu .
Dodaj, jako niezależne obiekty, dwa pomocnicze okręgi. (Ze zdjęć wynika, że spód osłony chłodnicy miał przekrój okrągły lub bardzo zbliżony). Ich środki przydadzą się nieraz jako “punkt zaczepienia” dla kursora 3D (Cursor to Selected). Jeden z okręgów umieść tam, gdzie będzie się znajdować wlot powietrza do chłodnicy, a drugi — tam, gdzie wylot (Rysunek 4.12.2a). Przy okazji dopasowywania wręg do reszty kadłuba, koniecznym okazało się poszerzenie krawędzi za wylotem powietrza1 (Rysunek 4.12.2b):
Rysunek 4.12.2 Przygotowanie dwóch okrągłych żeber
Dodaj do siatki dwie wręgi w kształcie łuków tam, gdzie umieściłeś okręgi wzorcowe (Rysunek 4.12.2a). Powinny mieć tą samą, umiarkowaną liczbę wierzchołków — ja pozostawiłem po 7 wierzchołków w każdym łuku.
Połącz te dwie dodane wręgi ścianami2 (Mesh→Edges→Bridge Edge Loops — Rysunek 4.12.3a):
Rysunek 4.12.3 Uformowanie podstawowego kształtu osłony chłodnicy
Wstaw w środek osłony dalsze wręgi (Loop Cut), i dopasuj uzyskany kształt do obrysu z boku i z góry (Rysunek 4.12.3b). Dodaj kilka podłużnic przy bocznej krawędzi, i dopasuj dokładnie siatkę do jej obrysu.
Umieść kursor 3D w środku przedniego wzorcowego okręgu. (w Object Mode: zaznacz okrąg, potem naciśnij Shift-S, i wybierz Cursor to Selected). Następnie wytłocz (Extrude, Scale) krawędź wlotu powietrza w płaską ścianę przedniej wręgi. Wstaw do wnętrza tak utworzonej ściany trzy nowe wręgi (Rysunek 4.12.4a):
Rysunek 4.12.4 Utworzenie zaokrąglenia na wlocie
Potem przesuń je do przodu. To wystarczy, by powstała krawędź wlotu, zaokrąglona niewielkim promieniem (Rysunek 4.12.4b, Rysunek 4.12.4c).
Przygotowując się do uformowania obszaru przed wlotem powietrza, umieść wewnątrz osłony dwa pomocnicze elementy. Pierwszym z nich jest kontur chodnicy. Wstaw go jako odrębny obiekt. Jest to okrąg, gdyż wszystkie chłodnice w P-40 miały kształt walca (Rysunek 4.12.5). Drugim pomocniczym elementem jest wzorcowa wręga, dodana do siatki na poziomie wlotu powietrza. Będzie wyznaczać docelowe położenie dla wierzchołków formowanej powłoki. Stwórz ją poprzez skopiowanie aktualnej wręgi wlotu. Potem wstaw w tę linię dodatkowe wierzchołki, i uformuj z niej właściwy kontur wlotu (w rzucie z przodu — Rysunek 4.12.5a). Nie zapomnij także o zarysie ścianek, oddzielających kanał chłodnicy glikolu i oleju:
Rysunek 4.12.5 Nacięcie konturu zagłębienia przed wlotem powietrza
Zarysy obydwu obiektów pomocniczych pozwolą Ci zorientować się co do kierunku zagłębienia przed wlotem powietrza3. (Biegł lekko pochylony do dołu i ukośnie w bok). Teraz w rzucie z przodu natnij (Knife) granice zagłębienia przed wlotem (Rysunek 4.12.5a).
Przesuń teraz do wnętrza kadłuba wierzchołki, znajdujące się wewnątrz tego konturu zagłębienia (Rysunek 4.12.6a) — aż do wręgi wzorcowej. Zrób to tak, by powierzchnia wewnątrz wgłębienia wyglądała jak fragment stożka (Rysunek 4.12.6b).
Rysunek 4.12.6 Ukształtowanie wklęsłych powierzchni przed wlotami — przesuwanie wierzchołków
Aby uzyskać stałe pochylenie ścian wewnątrz tego zagłębienia, zamiast przesuwać pojedyncze wręgi lepiej obróć cały ich zespół. Wcześniej tylko ustaw płaszczyznę aktualnego widoku (obrotu) prostopadle do krawędzi wgłębienia (Rysunek 4.12.6a,b).
Rysunek 4.12.7 pokazuje wierzchołki przed wlotem powietrza po dosunięciu do wręgi wzorcowej. W trakcie pracy uprościłem (poprzez scalanie) układ ścian wzdłuż krawędzi zagłębienia. W okolicy narożnika konieczne okazało się dodanie jeszcze jednej podłużnicy (Rysunek 4.12.7a):
Rysunek 4.12.7 Ukształtowanie wklęsłych powierzchni przed wlotami — końcowe dopasowania
W trakcie pracy nad wlotem często porównywałem model ze zdjęciami. W takich sytuacjach może się zdarzyć, że dostrzeżesz jakieś nie zauważone wcześniej różnice. Tak było i w tym przypadku — ścianki kanału chłodnicy oleju okazały się zbyt szeroko rozstawione. Trzeba było zsunąć nieco kilka centralnych podłużnic i poprawić zarys wzorcowej wręgi wlotu (Rysunek 4.12.7b).
Teraz można połączyć przednią i tylną część osłony, formując zaokrąglony narożnik. To często powtarzający się detal w konstrukcjach lotniczych. Najpierw przygotuj ściany z jednej i drugiej części powłoki tak, by każdy z wierzchołków miał swój odpowiednik “po przeciwnej stronie” (Rysunek 4.12.8a). (W tym przypadku okazało się konieczne dodanie jeszcze jednej podłużnicy, by temu sprostać). Przy okazji możesz już połączyć obydwie powierzchnie tam, gdzie stykają się “na płasko”: z boku, w pobliżu zewnętrznej krawędzi (Rysunek 4.12.8a):
Rysunek 4.12.8 Ukształtowanie narożnika wlotu powietrza
Potem usuń niepotrzebne ściany, przygotowując w ten sposób pole do stworzenia nowych. Muszę przyznać, że najwięcej czasu zajmuje mi przemyślenie, co z czym zostanie połączone, aby uzyskać jak najlepszy układ krawędzi. Potem — pozostaje tylko połączyć przygotowane wierzchołki (Rysunek 4.12.8b). Staraj się unikać ścian trójkątnych, gdyż takie miejsca o dużej krzywiźnie mogą tworzyć nierówności na powierzchni wygładzonej modyfikatorem Subdivision Surface.
Teraz można usunąć pomocniczą wręgę z wlotu powietrza — spełniła już swoje zadanie. Pozostaw z niej tylko kontur ściany dzielącej kanały chłodnic. Wytłocz go w zaokrąglony “słupek” (Rysunek 4.12.9a). Przygotuj także odpowiednie wierzchołki u podstawy “słupka”. Dodaj nową wręgę, biegnącą tuż przed nim. Natnij (Knife) w pobliżu dodatkowe krawędzie, by ograniczyć promień tworzonego zaokrąglenia połączenia (Rysunek 4.12.9a). Na koniec usuń dotychczasowe ściany z tego obszaru i utwórz nowe (Rysunek 4.12.9b):
Rysunek 4.12.9 Wlot powietrza — formowanie początku ściany wewnętrznej
W ten sam sposób ukształtuj połączenie “słupka” z przeciwległą ścianą chłodnicy. Gdy to zrobisz, osłona będzie gotowa (Rysunek 4.12.10):
Rysunek 4.12.10 Gotowa osłona chłodnicy cieczy
Jeżeli obejrzysz model z pliku P40B-4.12.blend, na pewno zauważysz że wlot powietrza do chłodnicy jest cofnięty w stosunku do podstawionych tam planów. Tak był położony na oryginalnym rysunku, według którego budowałem ten model. Skoryguję tę różnicę w ostatnich sekcjach tego rozdziału.
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.12.blend (por. str. 22).
Zaokrąglenie wokół krawędzi wlotu powietrza najłatwiej uzyskać, wstawiając (Loop Cut) w jednej płaszczyźnie trzy wręgi blisko siebie. Potem tylko przesuń je do przodu na odpowiednią odległość (str. 199);
Przy formowaniu wklęsłych fragmentów kadłuba (jak przed wlotem powietrza do chłodnicy w P-40B/C), warto dodać krawędź wzdłuż granicy takiego zagłębienia (str. 200);
Narożniki ścian wlotów należy najpierw starannie przygotować, aby poszczególne wierzchołki miały swoje odpowiedniki “po przeciwnej stronie” (str. 201). Staraj się tak uformować te fragment siatki, by składały się wyłącznie z czworokątów;
Maska silnika P-40 ma wiele dodatkowych szczegółów: chwyt powietrza do sprężarki i osłony luf nkm u góry, otwory na rury wydechowe kolektora spalin po bokach (Rysunek 4.13.1). W tej sekcji pokażę, jak można wkomponować te elementy w siatki poszczególnych paneli, by tworzyły z nimi jedną całość. (Czyli tak, jak w prawdziwym samolocie).
Rysunek 4.13.1 Szczegóły osłony silnika
Najtrudniejszym chyba do wykonania elementem w tej sekcji jest osłona lufy karabinu maszynowego. Wygląda dość niepozornie w porównaniu z chwytem powietrza do silnika, ale to tylko pierwsze wrażenie. Chwyt płynnie “zlewa” się ze swoim panelem. Obudowa karabinu — przeciwnie, do końca zachowuje wyraźną krawędź o drobnym, ale istotnym zaokrągleniu. Jak tu takie zaokrąglenie połączyć z resztą panelu, by nie zaburzyć jego dotychczasowego kształtu? W osłonach silników myśliwców z okresu II Wojny Światowej (Messerschmit, Jak, ŁaGG, Dewoitine) często występuje negatyw tego elementu — zagłębienie na lufę karabinu maszynowego. Obydwie — i wypukłą osłonę, i wklęsłe zagłębienie — wykonuje się w ten sam sposób.
Najpierw zagęść siatkę B.350.Cowling.002 (przycisk Apply na modyfikatorze Subsurf) zwiększając dwukrotnie liczbę wręg i podłużnic (Subsurf:Subdivisions = 1, Rysunek 4.13.2). (Trzeba to zrobić, aby dodanie do siatki krawędzi otworu pod osłonę karabinu spowodowało jak najmniejsze zmiany kształtu. W ten sposób zwiększysz jej liczbę ścian i zbliżysz kształt do wygładzonej powłoki).
Rysunek 4.13.2 Przygotowanie do “wycięcia” otworu — dwukrotne zagęszczenie siatki panelu osłony silnika
Uważaj na krawędzie zewnętrzne panelu. W wyniku utrwalenia modyfikatora Subsurf gubią informację o ostrości (crease), i trzeba ją ponownie przypisywać.
Po dwukrotnym zagęszczeniu siatki możesz do niej ponownie dodać modyfikator Subsurf, ale tym razem z mniejszym poziomem podziału — Subsurf:Subdivisions = 1. Wcześniej, dla rzadkiej siatki, stosowaliśmy dwukrotnie większą liczbę podziałów — Subdivisions = 2. W ten sposób ostateczna liczba ścian wygładzonej powierzchni nie uległa zmianie.
Wykonaj teraz podstawowy kształt osłony karabinu maszynowego poprzez wytłoczenie prostego przekroju o kształcie odwróconego “U”, (Rysunek 4.13.3). Umieść ten obiekt we właściwym miejscu. Nie będziemy mu nadawać specjalnej nazwy, bo za chwilę i tak zostanie scalony z panelem. Na razie jest nam potrzeby jako odrębna siatka, by można było wyznaczyć jego krawędź przecięcia z osłoną silnika:
Rysunek 4.13.3 Wytłoczony kształt osłony (przed odcięciem niepotrzebnych części ścian)
Przejdź z powrotem do edycji panelu pokrywy silnika. Przyjrzyj się, jak układają się linie siatki w względem osłony karabinu. Podłużnice w siatce wydają się być odpowiednio “gęste”, ale wręgi wymagają uzupełnienia. Dodaj (Loop Cut) do panelu dwie nowe krawędzie (Rysunek 4.13.4). Ich wstawienie zmieni nieco kształt najbliższego otoczenia na siatce (w każdą stronę do drugiej wręgi). Dopasuj granice tego panelu do krawędzi sąsiednich osłon za pomocą drobnych zmiany skali wręg w kierunku Y i Z. Środek zmiany skali powinien leżeć na osi samolotu (np. w punkcie 0,0,0):
Rysunek 4.13.4 Wstawienie dwóch nowych wręg do panelu osłony silnika
Dzięki temu, że wcześniej podzieliliśmy maskę silnika na kilka fragmentów, łatwiej jest teraz wykonywać takie lokalne zagęszczenia siatki. Wstawiasz nowe wręgi w jeden panel, i nie musisz się zupełnie przejmować pozostałymi. Mogą mieć inny układ ścian — w zależności od tego, co zawierają.
Do dalszej pracy będziemy potrzebować lepszego sprawdzianu, pokazującego gdzie kształt modyfikowanej powłoki uległ zmianie. Dotychczas stosowaliśmy metodę “na oko”, teraz po każdej operacji będziemy porównywać wynik z oryginalnym kształtem.
Wzorzec, z którym będziesz się porównywać, mogłeś stworzyć jeszcze przed dodaniem nowych wręg. Jeżeli tego nie zrobiłeś wcześniej — zrób to teraz. Skopiuj panel w nowy obiekt (Shift-D, Duplicate — str. 823). Umieść go na innej warstwie (M, szczegóły — str. 838), aby ułatwić wyświetlanie i ukrywanie. Nadaj temu wzorcowi kontrastowy, czerwony kolor. (Utwórz na potrzeby tego i następnych wzorców specjalny materiał i nazwij go Artifical — szczegóły na str. 1145). Rysunek 4.13.5 pokazuje przykład wykorzystania “czerwonego wzorca”. Podczas dopasowywania do oryginalnego kształtu, obserwuj uważnie, kiedy szara, modyfikowana powłoka, zniknie pod czerwoną. Staraj się ją ukształtować tak, by była tuż powyżej lub tuż poniżej tego punktu:
Rysunek 4.13.5 Dopasowywanie zmodyfikowanej powłoki panelu do powłoki wzorcowej (wzorzec jest w kolorze czerwonym)
Osłona karabinu była wytłoczona z tego samego kawałka blachy, co okapotowanie silnika. Krawędź łącząca te dwie powłoki musi być zaokrąglona. Przybliżymy ten efekt przekrojem o kształcie 90º łuku za pomocą krzywej podziałowej opartej o przekrój złożony z trzech punktów. Dlatego wyznaczymy (za pomocą skryptu Intersection, str. 829) nie jedną, a trzy krawędzie przenikania:
Rysunek 4.13.6 Zaokrąglona krawędź połączenia wymaga wyznaczenia trzech krawędzi przecięcia
Pierwszą krawędź (1) na osłonie karabinu utwórz jako zwykłą krawędź przecięcia z pokrywą silnika. Aby wyznaczyć kolejną (krawędź 2, Rysunek 4.13.6a) — przesuń na chwilę osłonę karabinu o 0.05 jedn. Blendera do dołu. Wyznacz krawędź (2) tak samo, jak wyznaczyłeś krawędź (1). Potem przesuń osłonę karabinu z powrotem na stare miejsce.
Trzecią krawędź (3) wyznacz jako linię przenikania pokrywy z “pogrubioną” o 0.05 jednostki Blendera osłoną karabinu (Rysunek 4.13.6b,c). Aby ją uzyskać, skopiuj na chwilę osłonę karabinu w nowy obiekt (Shift-D). Pogrub tę kopię we wszystkie strony — np. poprzez zmianą skali względem wskazanego na ilustracji punktu (Rysunek 4.13.6b) o 10%. Wyznacz przecięcie tego obiektu z maską silnika. Przed wywołaniem Intersection wskaż najpierw pogrubioną osłonę, a potem pokrywę silnika. W ten sposób rezultat — krawędź przecięcia — zostanie dodana do siatki okapotowania (Rysunek 4.13.7a). Po wyznaczeniu tej linii usuń pogrubiony duplikat osłony karabinu z rysunku, bo nie będziemy już go więcej potrzebować.
Z krawędzi (3) wyeliminuj kilka wierzchołków, które nie wnoszą nic nowego do jej kształtu, a tylko niepotrzebnie komplikowałyby siatkę. Następnie usuń z siatki wierzchołki położone w środku konturu (3) i zbuduj wokół niego nowe ściany (Rysunek 4.13.7b):
Rysunek 4.13.7 Wycinanie otworu na osłonę karabinu w panelu osłony silnika
Krawędź takiego otworu leży nieco ponad oryginalną powłoką (Rysunek 4.13.7c). Musisz teraz dosunąć jej wierzchołki tak, by różnica kształtu była jak najmniejsza. Sądzę, że najwygodniej jest to zrobić przesuwając je wzdłuż globalnej osi Z (G,Z). Rysunek 4.13.8 pokazuje poprawioną krawędź:
Rysunek 4.13.8 Krawędź otworu po dosunięciu w pobliże powierzchni wzorcowej
Pora teraz włączyć siatkę osłony karabinu w siatkę pokrywy silnika (Ctrl-J, Object→Join). Zaraz po dodaniu są to nadal dwie oddzielne powłoki. Wykorzystaj to, by wstawić (Loop Cut) w osłonę karabinu kolejne wręgi. Umieść je tak, by każda z nich biegła w tym samym miejscu, co odpowiednia wręga pokrywy silnika (Rysunek 4.13.9):
Rysunek 4.13.9 Wstawienie w powłokę osłony karabinu nowych wręg
Następnie usuń wszystkie niepotrzebne ściany z osłony karabinu. Włącz krawędzie 1, 2, 3 w siatkę aby zbudować nowy układ ścian łączący obydwie powłoki (Rysunek 4.13.10a):
Rysunek 4.13.10 Połączenie powłoki osłony karabinu z powłoką pokrywy silnika
Rysunek 4.13.10b) pokazuje osiągnięty rezultat: gładka, zaokrąglona krawędź wokół osłony karabinu, przy zachowaniu oryginalnego kształtu pokrywy silnika wokół tego elementu. I o to chodziło! Gdy będziesz miał wykonać w jakimś innym modelu wgłębienie na lufę karabinu — zrób to w ten sam sposób. Po prostu zamiast wypukłej osłony włączysz w siatkę jej negatyw — wklęsłe “korytko”.
Czas na kolejny element do scalenia z osłoną silnika: chwyt powietrza do sprężarki. Podobnie jak osłony karabinów, element ten stopniowo “zanurza” się w kadłubie. Choć zaczyna się przekrojem kołowym, to szerokość jego krawędzi przenikania z osłoną silnika jest stała (Rysunek 4.13.12b). Aby uzyskać taki efekt, końcowy przekrój chwytu musiał być zbliżony do prostokąta (Rysunek 4.13.12a). Wytłocz więc właśnie taki podstawowy kształt (Rysunek 4.13.11). Na początku będzie to oddzielny obiekt, aby można było wyznaczyć jego krawędź przecięcia z pokrywą silnika.
Rysunek 4.13.11 Podstawowy kształt chwytu powietrza do sprężarki
Gdy dosunąłem wytłoczony chwyt powietrza do kadłuba, zauważyłem błąd, popełniony wcześniej. Krawędź podziału pokryw silnika powinna być o jakieś 2 cm węższa (z obydwu stron — Rysunek 4.13.12b). Takie sytuacje zdarzają się podczas modelowania, więc przerwę na chwilę i opowiem, jak sobie z tym poradzić.
Rysunek 4.13.12 Chwyt powietrza do sprężarki — “przymiarka” do pokrywy silnika
Poprawienie tego błędu wymaga niewielkiego przesunięcia wszystkich podłużnic siatki do wnętrza, połączonego z ich wyprostowaniem (Rysunek 4.13.13a). Następnie zaznacz ściany “do odstąpienia” i wydziel (P, Separate) je na chwilę w odrębny obiekt. Scal go zaraz z sąsiednim panelem (B.350.Cowling.002). Trochę przy tej okazji jest pracy z usuwaniem i powtórnym tworzeniem krawędzi na “grubość blachy”. (Pamiętasz? Umieszczaliśmy je wzdłuż wszystkich krawędzi podziału pokrywy silnika.) Rysunek 4.13.13b przedstawia rezultat operacji:
Rysunek 4.13.13 Poprawianie krawędzi panelu pokrywy silnika
Bardzo pomocna przy tego typu drobnych poprawkach kształtu osłony silnika jest powłoka wzorcowa. Proponuję zachować ją także na przyszłość, bo nigdy nie wiadomo, kiedy jeszcze będziemy jej potrzebować.
Wróćmy do przerwanego na czas poprawki formowania chwytu powietrza. Początkowy kształt wytłoczyliśmy z dwunastoboku (por. Rysunek 4.13.12a). Dzięki niewielkiej liczbie wierzchołków nie mieliśmy zbyt dużo pracy z przekształcaniem okręgu w prostokąt. Aby teraz uzyskać “gładsze” zaokrąglenie wlotu, zagęść tę siatkę dwukrotnie (Subsurf:Apply, dla Subsurf:Subdivisions = 1). Zwiększenie liczby podłużnic ułatwi także jej przyszłe złączenie z pokrywą silnika.
W P-40 chwyt powietrza płynnie “wtapiał” się w górną część pokrywy silnika. Formowanie takiego przypadku jest prostsze, niż wykonanej wcześniej osłony karabinu. Zamiast trzech krawędzi przecięcia wystarczy tu tylko jedna, zamieniona na otwór w oryginalnej powłoce. Przygotuj kopię górnego panelu pokrywy silnika. Nadaj jej nazwę B.350.T.Cowling.001. Posłuży nam jako wzorzec pokrywy przed deformacją. Następnie wyznacz (Intersection) linię przenikania chwytu powietrza i osłony silnika. Zrób to tak, by rezultat stał się częścią siatki panelu, a nie chwytu (Rysunek 4.13.14a):
Rysunek 4.13.14 Wykonanie otworu na chwyt powietrza w górnej części pokrywy silnika
Korzystając z wyznaczonej krawędzi przecięcia, zmień układ ścian panelu, tworząc otwór na chwyt powietrza (Rysunek 4.13.14b). Następnie wstaw siatkę chwytu w pokrywę silnika (Rysunek 4.13.15a):
Rysunek 4.13.15 Wstawienie siatki chwytu powietrza do siatki pokrywy silnika
Zaraz po wstawieniu, dodaj (Loop Cut) do powłoki chwytu powietrza dodatkowe wręgi. Tak samo jak w przypadku osłony karabinu, rozmieść je tak, by “spotkały” się z poszczególnymi wręgami osłony silnika (Rysunek 4.13.15a). Potem usuń niepotrzebne ściany (Rysunek 4.13.15b).
Gdy to zrobiłeś, nie pozostaje nic innego jak tylko zapełnić nowymi ścianami powstałe luki. Zrób to, tylko postaraj się nie umieszczać trójkątnych ścian bezpośrednio przy krawędzi połączenia dwóch siatek. Jeżeli już muszą istnieć, lepiej umieścić je przynajmniej “o jedną ścianę dalej” (Rysunek 4.13.16a):
Rysunek 4.13.16 Połączenie siatki chwytu powietrza z siatką pokrywy silnika
Podstawa wlotu powietrza P-40 miała najniższy punkt na poziomie pokrywy silnika, i charakterystyczne wyoblenia po bokach1. Uzyskasz je za pomocą krótkiej, przekątnej krawędzi w ścianie narożnej (Rysunek 4.13.16b). Środkowy wierzchołek tej krawędzi decyduje w dużej mierze o kształcie zaokrąglenia w tym miejscu. Rysunek 4.13.16b) pokazuje także, że w tym narożniku można użyć dwóch ścian trójkątnych.
Chwyt powietrza jest już ukończony (Rysunek 4.13.17). Zwróć uwagę na płynne przejście w kształt pokrywy silnika, szczególnie na końcu osłony chwytu. Z przodu, przed wlotem, widoczne są charakterystyczne wyoblenia, utrwalone na wielu zdjęciach.
Rysunek 4.13.17 Gotowy chwyt powietrza do sprężarki po scaleniu z górnym panelem osłony silnika
Spośród elementów, które mamy wykonać w tej sekcji, pozostał już ostatni — otwór na kolektor spalin. W porównaniu z osłoną luf karabinów czy chwytem powietrza to naprawdę drobiazg. Wykonuje się go w ten sam sposób, tylko jeszcze prościej.
Zacznij od przygotowania “rury” o kształcie otworu (Rysunek 4.13.18a). To nasz “nóż” do wycięcia “dziury” w panelu B.350.L.Cowling.003. Ustaw go w odpowiednim miejscu i pochyl pod odpowiednim katem. (Patrząc na zdjęcia wydaje się, że rury wydechowe kolektora spalin były w rzucie z przodu zadarte lekko do góry. Najprawdopodobniej także ich otwór leżał na podobnie pochylonej płaszczyźnie, mniej więcej prostopadle do ściany pokrywy silnika). Wyznacz krawędź przecięcia tego obiektu z okapotowaniem silnika (Rysunek 4.13.18b). Potem możesz go usunąć, bo nie będzie już potrzebny.
Rysunek 4.13.18 Wyznaczenie krawędzi otworu kolektora spalin
Przygotuj kopię siatki B.350.L.Cowling.003 jako wzorzec. (Nazwij go B.350.T.Cowling.003 i nadaj mu “tradycyjny, czerwony kolor” materiału Artifical). Wykorzystując ten wzór, zwiększ liczbę wręg na panelu, umieszczając je tam, gdzie znajdą się kluczowe punkty konturu otworu (Rysunek 4.13.18b).
Usuń wierzchołki siatki z wnętrza otworu, i wykorzystując krawędź przecięcia utwórz wokół niego nowy układ ścian (Rysunek 4.13.19a). Powierzchnia tego panelu jest na tyle płaska, że krawędź otworu całkiem dobrze “leży” na wzorcu, i nie wymaga poprawek.
Rysunek 4.13.19 Wykonanie otworu na kolektor spalin, i dodanie pogrubienia (“fazki”) na jego krawędzi
Na koniec zwiększ ostrość (crease) krawędzi otworu do 1.0, i wytłocz ją w głąb kadłuba na głębokość ok. 0.1 jedn. Blendera (1 cm w rzeczywistym samolocie) (Rysunek 4.13.19b). (P-40 miał wokół rur wydechowych coś w rodzaju ekranu, aby te elementy, rozgrzewające się podczas pracy do bardzo wysokich temperatur, nie uszkodziły okapotowania silnika).
I to już wszystko, co mieliśmy wykonać w tej sekcji. Rysunek 4.13.20 przedstawia osłonę silnika wraz ze wszystkimi szczegółami.
Rysunek 4.13.20 Panele osłony silnika wraz ze szczegółami
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.13.blend (por. str. 22).
Podsumowanie
W tej sekcji wkomponowaliśmy w okapotowanie silnika trzy dość trudne elementy: osłony luf nkm, chwyt powietrza do sprężarki oraz otwór na kolektor spalin;
Wszystkie takie elementy zaczyna się od uformowania ich podstawowego kształtu. Zagęszczasz (Subsurf:Apply) także siatkę powłoki, do której chcesz je dodać. Potem wyznaczasz kontur przecięcia (Intersection) ich siatek z powłoką kadłuba. Usuwasz stare ściany z wnętrza uzyskanego konturu i tworzysz ich nowy układ wzdłuż krawędzi przecięcia. W przypadku, gdy chodziło tylko o otwór (np. otwór kolektora spalin), to kończy operację (str. 212);
Przed taką modyfikacją siatki jak wycięcie otworu, warto stworzyć jej kopię. Będziesz mógł później wykorzystać ten obiekt jako referencję, aby „płożyć” ściany siatki wokół brzegów nowo utworzonego otworu na oryginalnej powierzchni (str. 206);
Po wykonaniu otworu należy włączyć w siatkę panelu powłokę wykonywanego szczegółu (osłony lufy karabinu, chwytu powietrza). Bezpośrednio po tym połączeniu zwiększ liczbę wręg w jego powłoce, aby dostosować ją do liczby wręg na panelu (str. 210). Potem usuń niepotrzebne ściany z okolic połączenia, i utwórz nowe, wzdłuż krawędzi przecięcia (str. 211)
Najwięcej kłopotów stwarzają elementy, które w oryginalnej konstrukcji były wytłoczone wraz z panelem z jednego kawałka blachy, z niewielkim promieniem zaokrąglenia wzdłuż krawędzi połączenia. Przykładem takiego detalu jest osłona karabinu maszynowego (str. 206). Zamiast jednej krawędzi przecięcia wymaga wyznaczenia aż trzech. W oparciu o nie utworzysz dwa cienkie paski ścian kontrolnych, połączone wzdłuż właściwej krawędzi przecięcia. Wygładzona powłoka wzdłuż takich ścian utworzy odpowiednie zaokrąglenie (str. 208).
Formowanie oszklenia kabiny pilota proponuję zacząć od tylnych “okien”, umieszczonych za zagłówkiem pilota (Rysunek 4.14.1):
Rysunek 4.14.1 Oszklenie P-40 B/C za głową pilota
Jest to chyba najtrudniejszy fragment z całej osłony kabiny. Po pierwsze, wymaga wkomponowania w kadłub zagłębienia, którego krawędź musi odpowiadać krawędziom oszklenia. Po drugie — oszklenie ponad zagłębieniem ma zachować dotychczasowy kształt kadłuba. Po trzecie, należy na to wszystko nałożyć fragment blachy (ramkę oszklenia), którego kształt także ma być gładką kontynuacją grzbietu kadłuba. Pewną możliwość na ewentualne drobne korekty (poniżej 1mm) pozostawia właśnie ta blacha, a właściwie jej grubość. W końcu na prawdziwym samolocie pokrycie także miewa niewielkie wgłębienia i wypukłości.
Zacznij od stworzenia pomocniczej kopii kadłuba bez wgłębienia. Chodzi tu o referencyjny wzorzec kształtu — podobny do tych, jakie wykorzystywaliśmy do sprawdzania otworów na masce silnika (por. str. 206). Nadaj mu nazwę B.300.T.Fuselage.
Jaki kształt mogło mieć zagłębienie za nagłówkiem pilota ? Spróbowałem zastosować fragment okręgu, którego promień i środek pokazuje Rysunek 4.14.2a). Wytłoczyłem go w fragment walca, i wyznaczyłem krawędź przenikania z grzbietem kadłuba Rysunek 4.14.2b):
Rysunek 4.14.2 Fragment walca — powierzchnia zagłębienia za kabiną pilota
Promień walca (Rysunek 4.14.2) dobrałem “na oko”, na podstawie zdjęć. O dziwo, krawędź przenikania z grzbietem kadłuba już przy pierwszej próbie okazała się całkiem dobra. Leży w odległości mniej więcej 3-4 cm (na oryginalnym samolocie) od zewnętrznego konturu ramki oszklenia (Rysunek 4.14.3):
Rysunek 4.14.3 Krawędź zagłębienia dla walca jest zgodna z rzutem z boku
(Blacha, którą przymocowano oszklenie, była przynitowana wzdłuż krawędzi wgłębienia. Musiała być szersza od konturu zagłębienia o “zakładkę” dla szwu nitów).
Muszę przyznać, że liczyłem się z koniecznością wykonania kilku przybliżeń tego wgłębienia. Odchylenia od krawędzi przenikania dwóch powierzchni zależą od błędów kształtu każdej z nich. Zazwyczaj błędy się sumują, a nie znoszą. Zarys konturu blachy, w rzucie z boku, został zweryfikowany ze zdjęciami (por. str. 1204), więc jest całkiem niezłym testem. Poprawna krawędź przecięcia może świadczyć o prawidłowym doborze przekroju poprzecznego grzbietu kadłuba1. Dlaczego zaproponowałem na kształt wgłębienia fragmentu prostego cylindra? To czysta intuicja, wsparta przypuszczeniami2.
Skoro ten potencjalnie trudny fragment pracy udało się nam uzyskać tak łatwo, przejdźmy do następnego etapu. Wkomponuj krawędź przecięcia w siatkę kadłuba, usuwając ściany wewnętrzne (Rysunek 4.14.4):
Rysunek 4.14.4 Włączona w siatkę kadłuba uproszczona krawędź przenikania,
Przy okazji usuń z krawędzi przecięcia nadmiarowe (tzn. umieszczone blisko siebie) wierzchołki.
Następnie włącz (Join Objects) powłokę cylindra w siatkę kadłuba (Rysunek 4.14.5):
Rysunek 4.14.5 Dodanie powierzchni walca do siatki kadłuba
Po włączeniu cylindra wstaw (Loop Cut) w jego siatkę dwie dodatkowe wręgi. Umieść je tam, gdzie się znajdują odpowiednie wręgi powłoki kadłuba (Rysunek 4.14.5). Potem usuń niepotrzebne ściany z powierzchni cylindra (Rysunek 4.14.6):
Rysunek 4.14.6 Usunięcie niepotrzebnych ścian powłoki walca
Teraz pozostaje utworzyć nowe ściany. Przy okazji “optymalizacji siatki” usuń jeszcze kilka mniej potrzebnych wierzchołków na krawędzi wgłębienia (Rysunek 4.14.7a). Samą krawędź pozostaw lekko zaokrągloną (crease = 0.5) — tak, jak było w prawdziwej konstrukcji (Rysunek 4.14.7b):
Rysunek 4.14.7 Powłoka walca po scaleniu z resztą kadłuba
Wgłębienie w kadłubie jest gotowe, teraz uformujemy powierzchnię, z której powstanie oszklenie i jego ramka. Z utworzonego wcześniej (por. str. 214) wzorca B.300.T.Fuselage wydziel (Separate) odpowiedni fragment powłoki (Rysunek 4.14.8):
Rysunek 4.14.8 Początek formowania oszklenia za kabiną pilota: skopiowanie fragmentu oryginalnej powłoki kadłuba
Aby lepiej odwzorować krawędź tego elementu, wstaw (Loop Cut) w odpowiednie miejsca siatki dodatkowe wręgi. Ramka miała na zewnątrz dwie kanciaste “wypustki”, ułatwiające przynitowanie do podłużnic. Dodanie wręg w okolicy tych załamań jest konieczne (Rysunek 4.14.9):
Rysunek 4.14.9 Nacięcie (Knife) zewnętrznej krawędzi oszklenia
Po przygotowaniu siatki wytnij w niej (Knife) krawędź ramki oszklenia (Rysunek 4.14.9). (Nacinamy, a nie np. wyznaczamy przecięcia z nową powłoką walca, gdyż kształt jest tu ściśle określony). Podczas nacinania kieruj się przede wszystkim rzutem z boku. Potem usuń niepotrzebne ściany (Rysunek 4.14.10):
Rysunek 4.14.10 Siatka po usunięcie zbędnych ścian
Uzyskany kształt wymaga jeszcze dalszych poprawek. Po pierwsze — ściany wzdłuż krawędzi odstają nieco od powłoki kadłuba (tak się dzieje zawsze przy wycięciu fragmentu wygładzonej siatki).
Aby temu zaradzić, natnij (Knife) dodatkową podłużnicę wzdłuż górnej krawędzi powłoki (Rysunek 4.14.11a). To pozwoli dopasować poprzeczne wygięcie wygładzonych ścian oszklenia do powierzchni kadłuba (Rysunek 4.14.11b):
Rysunek 4.14.11 Dalsze dopasowywanie siatki — do oryginalnego wzorca (a) i do aktualnej powłoki kadłuba (b)
Dolna krawędź oszklenia nie ma “problemów z odstawaniem”, gdyż w tym obszarze ściany nie mają żadnego wygięcia. Poprzez nacięcie przemodelowałem ten fragment, przesuwając przedostatnią podłużnicę tak, by biegła wzdłuż ramki okna (Rysunek 4.14.11a). To wstęp do odwzorowania za pomocą oddzielnej krawędzi obrysu wewnętrznych otworów ramki (Rysunek 4.14.12):
Rysunek 4.14.12 Nowe krawędzie, wzdłuż wewnętrznych granic ramki oszklenia
Tylna krawędź szyby w P-40 B/C była łukiem. Możesz ją uzyskać wyznaczając przenikanie powłoki szyby z pomocniczym walcem, utworzonym z ośmioboku. Oprócz tego, za pomocą przesuwania krawędzi (Edge Slide) i wierzchołków (Vertex Slide) ułóż drugą od góry podłużnicę wzdłuż górnej granicy oszklenia. Po tych modyfikacjach układ krawędzi uległ pewnym zmianom (Rysunek 4.14.12). Na koniec wstaw dwie dodatkowe wręgi tak, by przechodziły przez środki okrągłych wlewów paliwa. Samych otworów na razie nie wykonamy, gdyż znajdowały się wyłącznie z lewej strony. Poczekaj z tym do momentu, gdy będzie trzeba tworzyć “prawe” kopie wszystkich “lewych” siatek — tak późno, jak tylko to możliwe. (Zawsze może wcześniej pojawić się konieczność poprawienia jakiegoś kształtu. Dopóki pracujemy na powierzchniach z włączonym modyfikatorem Mirror, dopóty taką poprawkę jest łatwiej wprowadzić)
Po co umieszczać w powłoce szyby zarys wycięć, które powinny się znaleźć nie na szybie, a na jej ramce? Dlatego, że ramkę zaraz utworzymy poprzez skopiowanie szyby. Im bardziej podobne ściany na obydwu powłokach, tym mniej będziemy mieli problemów z ich późniejszym dopasowaniem.
Powłoka szyby jest gotowa. Nadaj jej nazwę B.310.L.RearGlass. Powiel (Duplicate) ten obiekt w powłokę, z której utworzymy ramkę: B.315.L.RearFrame (Rysunek 4.14.13a):
Rysunek 4.14.13 Pogrubienie szkła i powielenie w drugi obiekt — ramkę
Nowo utworzoną powłokę ramki odsuń “o grubość blachy” (X: +0.007, Z: +0.007, czyli 1 mm po przekątnej) od powłoki “szkła”. Nie zaszkodzi umieścić jej na osobnej warstwie (M, szczegóły — str. 838), przynajmniej na czas formowania oszklenia kabiny. Samą szybę na koniec pogrub (Solidify) o 0.03 jednostki Blendera (to jest 3 mm — przypuszczam że miała taką grubość). Rysunek 4.14.13b) pokazuje szybę B.310.L.RearGlass po pogrubieniu. (Powłoka ramki jest tu ukryta na niewidocznej warstwie). Zwróć uwagę, że zewnętrzna powierzchnia szyby leży na powłoce kadłuba, o czym świadczą niewielkie “przebicia” powłoki wzdłuż krawędzi wgłębienia. Te “przebicia” zasłoni ramka, którą zaraz uformujemy.
Formowanie ramki zacznij od uzupełnienia o dodatkową wręgę — tak, by powstał “pasek” ścian, biegnący przez środek oszklenia. Potem usuń ściany z wnętrza przygotowanych wcześniej konturów otworu (Rysunek 4.14.14):
Rysunek 4.14.14 Usunięcie z “ramki” niepotrzebnych ścian
Po usunięciu ścian obiekt jest już bardzo zbliżony do ostatecznego kształtu. Pozostało jeszcze tylko trochę popracować nad “fazkami” blachy w narożnikach. Na razie są tu naturalne zaokrąglenia powierzchni podziałowych.
“Fazki” blachy w narożnikach ramek kabin występują w większości samolotów lat 30 i 40-tych (kwestia technologii). Rysunek 4.14.15a, b) pokazuje, jak je odwzorować za pomocą tylko jednej dodatkowej ściany:
Rysunek 4.14.15 Wykonanie fazki w narożniku ramki
Wreszcie — pogrub (Solidify) powłokę ramki “o grubość blachy”, czyli 0.01 jednostki Blendera (1 mm) (Rysunek 4.14.16):
Rysunek 4.14.16 Ramka po pogrubieniu (o “grubość blachy”) i wyostrzeniu krawędzi
Przednia krawędź oszklenia miała w P-40 dodatkowe wzmocnienie (była grubsza). Przy próbie lokalnego pogrubienia przedniej ramki polecenie Solidify pochyla obydwie ściany. W takiej sytuacji lepiej jest pogrubić lokalnie “szkło” (B.310.L.RearGlass), bo tu przynajmniej tylna krawędź wychodziła poprawnie (Rysunek 4.14.17):
Rysunek 4.14.17 Pogrubienie fragmentu “szkła” w początkową wręgę
Modelując początkowe wzmocnienie, pogrubiliśmy obiekt reprezentujący szkło, zamiast ramki. Nie jest to jednak jakaś szczególna komplikacja — potem temu fragmentowi siatki “szkła” przypisze się materiał reprezentujący dural, a nie pleksiglas. (W Blenderze różnym fragmentom tej samej siatki można przypisać różne materiały — por. str. 941).
Wzmocnienie przedniej krawędzi było ostatnim szczegółem, jaki należało wykonać. Rysunek 4.14.18 przedstawia ukończone oszklenie grzbietu kadłuba, wraz z ramką:
Rysunek 4.14.18 Gotowy, tylny fragment oszklenia kabiny
Otwory wlewu paliwa wytniemy po utworzeniu odrębnego obiektu reprezentującego prawą stronę owiewki (B.310.R.RearGlass). Oszklenie na razie pozostaje nieprzejrzyste. Zmienimy ją w prawdziwe szkło organiczne dopiero w sekcjach poświęconych materiałom.
Wydawało mi się, że to już koniec pracy nad tym fragmentem. Zabrałem się więc za przeglądanie zdjęć następnych elementów — owiewki i wiatrochronu. Zdecydowałem się skorzystać także z posiadanych zdjęć P-36, gdyż ten fragment kadłuba był w obydwu konstrukcjach niemal identyczny. (P-36 miał tylko jeden, ale nieco większy otwór w oszkleniu na wlew paliwa, oraz inną szynę po której przesuwała się owiewka). W trakcie tej pracy natknąłem się na następujące zdjęcie (Rysunek 4.14.19):
Rysunek 4.14.19 Fragment jednego ze zdjęć P-36 (USAAF)
Widać na nim wyraźnie, że “wycięcia” w grzbiecie kadłuba miały o wiele mniejszy promień, niż założyłem! Szybkie przejrzenie posiadanych zdjęć P-40 potwierdziło to spostrzeżenie. Skórzany zagłówek pilota, zdemontowana na tym zdjęciu, utrudniał na innych fotografiach dostrzeżenie właściwego kształtu tych wgłębień.
Bądź przygotowany na podobne “odkrycia”. Nikt nie jest nieomylny, więc zdecydowałem się w tej książce także pokazać, gdzie zdarzyło mi się popełnić błąd. Są one w końcu nieodłącznym elementem pracy nad modelem.
Rysunek 4.14.20a) przedstawia zarys poprawionego kształtu (w rzucie z przodu). Jak wykonać niezbędną korektę? Zacznij od krótkiej analizy, co trzeba zmienić. Zewnętrzna krawędź wgłębienia powinna pozostać bez zmian, bo jest zgodna ze zdjęciami. (Gdyby wytłoczyć nowy okrąg wzdłuż osi Y, tak jak to zrobiliśmy poprzednio — por. str. 214 — to wgłębienie byłoby dwa razy dłuższe).
Rysunek 4.14.20 Analiza poprawionej powierzchni wgłębienia
Wytłocz okrąg w walec, i dokonaj kilku “przymiarek”, przesuwając jego tylny przekrój. Okazuje się, że można uzyskać niemal identyczną krawędź przenikania z grzbietem kadłuba, jak dotychczasowa. Wystarczy, by walec był nieco odchylony na zewnątrz (wzdłuż osi X) i do góry (wzdłuż osi Z) (Rysunek 4.14.20b). To bardzo dobra wiadomość — zachowanie tej krawędzi oznacza, że nie trzeba będzie zmieniać ani oszklenia grzbietu kadłuba, a ni jego ramki.
Teraz pozostaje wymienić dotychczasowe ściany wgłębienia na nowe, pochodzące z przygotowanego przed chwilą walca. Zacznij od usunięcia wszystkich starych ścian (Rysunek 4.14.21a). Wstaw także (Loop Cut) w powłokę walca kilka wręg. Umieść je w takich miejscach, by dokładnie odpowiadały wręgom kadłuba.
Rysunek 4.14.21 Poprawka — usunięcie starych ścian i przygotowanie nowych
Potem pozostaje usunąć niepotrzebne ściany walca, pozostawiając tylko te wewnątrz wgłębienia (Rysunek 4.14.21b). Aby uzyskać wzdłuż krawędzi regularny ciąg wąskich ścian czworokątnych, wykonaj w pozostawionych ścianach pomocnicze nacięcia (Knife). Można także przesunąć te wierzchołki poleceniem Vertex Slide.
Rysunek 4.14.22a) pokazuje układ ścian po włączeniu nowej powierzchni do kadłuba. Obyło się bez żadnych “efektów ubocznych” — wgłębienie jest regularne, nie widać żadnych skaz kształtu (Rysunek 4.14.22b):
Rysunek 4.14.22 Rezultat poprawki — głębsze wycięcie za kabiną pilota
W ten sposób zakończyliśmy korektę tego fragmentu. Efekt finalny widziałeś już na str. 214 — jako pierwszą ilustrację umieściłem tam wstępny render ukończonego oszklenia grzbietu kadłuba.
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.14.blend (por. str. 22).
Podsumowanie
W tej sekcji wykonaliśmy wgłębienie inną (nieco dokładniejszą) metodą, niż wgłębienie przed wlotem powietrza do chłodnicy (por. str. 200). Metodą tu zastosowaną posłużyliśmy się wcześniej do wykonania szczegółów (osłony luf km, chwyt powietrza do sprężarki) osłony silnika (por. str. 204);
Poznałeś szybką i prostą metodę uzyskiwania “fazek” na ostrych krawędziach ramek oszklenia (str. 220)
W tej sekcji uformujemy przednią część kabiny. W P-40 zastosowano typowe dla tego okresu rozwiązanie, złożone z wiatrochronu i odsuwanej do tyłu owiewki (Rysunek 4.15.1):
Rysunek 4.15.1 Elementy osłony kabiny pilota
P-40B/C odziedziczył kabinę po P-36. Był więc to dość stary projekt — gdzieś z 1935r. Owiewka kabiny ma typową konstrukcję — to warstwa szkła, wzmocniona od spodu i z wierzchu ramkami z blachy. Wiatrochron P-40 był uformowany z wygiętego kawałka szkła organicznego. U góry przymocowano je do ramy kabiny, z dołu — bezpośrednio do poszycia kadłuba. Wzmocnieniem ramy wiatrochronu były dwa wewnętrzne “pręty” (tak je będę dalej nazywał). Miały dość mały przekrój, więc ich rola mogła być podobna do szprych w kole rowerowym: przenosiły tylko obciążenia rozciągające. (Takie obciążenie powodował np. napór powietrza podczas lotu). Do tych prętów od 1940r. przyłączano szyby pancerne, których konstruktorzy oryginalnie nie przewidzieli. Wydaje mi się, że nie było to dość pewne mocowanie. Najlepiej świadczy o tym fakt, że w kolejnej wersji samolotu (P-40D) cały wiatrochron uległ kompletnej przebudowie.
W naszym modelu wiatrochron i owiewkę utworzymy podobnie jak oszklenie grzbietu kadłuba, z dwóch obiektów: warstwy szkła oraz ramki. Dla uproszczenia nie dzielimy ramki na wewnętrzną i zewnętrzną — jej ściany będą przenikać przez szkło. Oczywiście, wykonamy także pozostałe szczegóły: pręty, szyny, oprofilowanie.
Formowanie zacznij od przygotowania okręgu, który będzie miał taki promień, jak grzbiet owiewki (Rysunek 4.15.2a) . Następnie “rozegnij” jego dolne wierzchołki w proste boki, i wytłocz wzdłuż osi Y (Rysunek 4.15.2b):
Rysunek 4.15.2 Uformowanie podstawowego kształtu owiewki
Kształt wiatrochronu zacznij formować od góry. Skopiuj wierzchołki grzbietu owiewki i powiel je (poprzez obrót) w trzy kolejne wręgi w kluczowych miejscach zaokrąglenia (Rysunek 4.15.3a). Połącz je następnie ścianami:
Rysunek 4.15.3 Uformowanie wiatrochronu
Dolną krawędź wiatrochronu uzyskasz poprzez wytłoczenie (wzdłuż obrysu szyby w rzucie z boku) ostatniej z wręg zaokrąglenia (Rysunek 4.15.3a). Powiększ nieco tę dolną wręgę (równo, względem wszystkich osi) względem środka leżącego na krawędzi wiatrochronu (Rysunek 4.15.3b). (Możesz łatwo tam umieścić kursor, zaznaczając na chwilę położony tam wierzchołek i wywołując polecenie Shift-S, Cursor to Selected). Wręgę powiększ tak, by krawędź przecięcia wiatrochronu z kadłubem nabrała kształtu widocznego na rysunkach i na zdjęciach samolotu. W końcowej fazie dopasowywania zacznij zmieniać skalę tylko wzdłuż osi X (przekształcając wręgę z łuku we fragment elipsy).
Przed ostatecznym dopasowaniem trzeba jednak uzupełnić ściany kadłuba o fragment, którego do tej pory nie uformowaliśmy. Wstaw (poprzez nacięcie - Knife) w siatkę kadłuba dodatkową wręgę, mniej więcej na wysokości ramki wiatrochronu (Rysunek 4.15.4a). (Przed nacięciem uprość układ ścian kadłuba przy skrzydle, łącząc na chwilę ścianę trójkątną z czworokątną). Wytłocz jednocześnie wzdłuż osi Y fragment narożnika kadłuba, tak by znalazł się dokładnie ponad naciętą wręgą (Rysunek 4.15.4a):
Rysunek 4.15.4 Uzupełnienie brakującego fragmentu kadłuba
Połącz przygotowane w ten sposób dwa odcinki wierzchołków w jedną wręgę, tworząc brakującą ścianę (Rysunek 4.15.4b). To obszar, na którym nastąpi przecięcie kadłuba z wiatrochronem.
Teraz możesz już dokładnie dopasować przednią krawędź wiatrochronu. Okazuje się, że największy wpływ na kształt linii przenikania z kadłubem ma pojedynczy wierzchołek (Rysunek 4.15.5a). To bardzo ułatwia dopasowanie — przesuń go wzdłuż osi X, aż uzyskasz odpowiedni efekt.
Rysunek 4.15.5 Dopasowywanie kształtu wiatrochronu i kadłuba
W ramach “końcowej kosmetyki” proponuję odrobinę rozsunąć (Edge Slide) dwie linie wierzchołków po obu stronach narożnika kadłuba (Rysunek 4.15.5b). W ten sposób zwiększysz w tym miejscu promień zaokrąglenia przekroju.
Ogólny kształt kabiny został uformowany, teraz czas na podział i szczegóły. Przygotowując się do tego etapu, odetnij (Knife) część wiatrochronu zasłoniętą przez kadłub (Rysunek 4.15.6a). Zrób to tak, by nie powstała żadna szczelina pomiędzy tymi dwoma powłokami. Po przecięciu uzyskasz dodatkowy wierzchołek, który warto przesunąć trochę do przodu (Rysunek 4.15.6a):
Rysunek 4.15.6 Przygotowywanie ramki wiatrochronu
Utwórz przednią krawędź przyszłej ramki kolejnym nacięciem (Knife) wzdłuż krawędzi łączącej wiatrochron i owiewkę (Rysunek 4.15.6b). Przy okazji zmień układ ścian u dołu powłoki, aby usunąć z niej przecięty trójkąt (ten odcinek nie był zakrzywiony, a dodatkowe wierzchołki niepotrzebnie komplikowałyby siatkę).
Odetnij (Knife) pod odpowiednim kątem tylną krawędź owiewki (była bardziej pochylona niż przednia). Kolejnym nacięciem nanieś w jej pobliżu krawędź pomocniczą, nieco węższą od przyszłej ramki (Rysunek 4.15.7a):
Rysunek 4.15.7 Nadawanie ostatecznego kształtu owiewce
Po nacięciu odsuń (Shrink/Fatten) do wnętrza tylną krawędź o przybliżoną grubość ramki (ok. 0.08 jedn. — 8mm). (Ramka owiewki P-40 miała z tyłu miała takie zagięcie). Potem dopasuj tylną krawędź do grzbietu kadłuba. Pozostaw pomiędzy owiewką i kadłubem szczelinę o grubości ok. 0.1 jednostki Blendera (1 cm). Wydaje mi się, że taki właśnie dystans jest widoczny na zdjęciach tego fragmentu samolotu.
Tylny przekrój owiewki był nieznacznie węższy i niższy od przedniego (dosłownie o kilka milimetrów). Na mniejszą wysokość wskazuje lekkie pochylenie górnej krawędzi szkła w rzucie z boku. (Wydaje się być także widoczne na zdjęciach). Na mniejszą szerokość — mała “falbanka” blachy wokół szyny, po której poruszała się owiewka (por. str. 224, Rysunek 4.15.1 oraz str. 231, Rysunek 4.15.15b)
Po dopasowaniu tylnej krawędzi owiewki do kadłuba nadszedł czas na podział uformowanej powłoki kabiny na dwie podstawowe części. Zaznacz i oddziel (Separate) owiewkę od wiatrochronu (Rysunek 4.15.8):
Rysunek 4.15.8 Podział oszklenia na wiatrochron i owiewkę
Rysunek 4.15.8 podaje, jakie nazwy nadałem obydwu obiektom. Po pogrubieniu będą pełnić rolę powierzchni ze szkła organicznego.
Czas przystąpić do formowania ramki wiatrochronu. Skopiuj (Duplicate) B.320.WindshGlass w nowy obiekt — B.330.WindshFrame. Potem usuń z tej nowej powłoki niepotrzebne ściany (Rysunek 4.15.9a). Ramkę wiatrochronu pogrub “na grubszą blachę” (0.02 jedn. Blendera — 2mm). Tylną krawędź potraktuj inaczej: wytłocz górny łuk tak, by wyglądał jak grubsze żebro, a boczne słupki — jak lite pręty, o przekroju klina i szerokości ok. 1 cm (Rysunek 4.15.9a). Dodaj też u góry spłaszczoną na obydwu końcach rurkę (Rysunek 4.15.9c). Sądzę, że lepiej zrobić z niej oddzielny obiekt (B.331.WindshTube). (Ze zdjęć wynika, że w odróżnieniu od reszty owiewki była w naturalnym kolorze metalu.)
Rysunek 4.15.9 Wydzielenie i uformowanie ramki wiatrochronu
Ramka wiatrochronu miała także dolną, niewidoczną część (Rysunek 4.15.10a). Ten fragment pełnił jednocześnie rolę wzmocnienia krawędzi poszycia kadłuba1. Aby ją uzyskać, wytłocz prostokątny przekrój wzdłuż krawędzi przenikania wiatrochronu i kadłuba. Każda wręga uzyskanej w ten sposób powłoki jest inaczej zorientowana w przestrzeni (Rysunek 4.15.10b):
Rysunek 4.15.10 Dodanie dalszych elementów ramki wiatrochronu
Jest z tym trochę roboty — przed każdym kolejnym wytłoczeniem trzeba zmieniać projekcję, ustawiając ją prostopadle do kolejnej ściany wiatrochronu. Potem trzeba jeszcze poprawić zewnętrzny obrys tak, by leżał dokładnie na płaszczyźnie szkła wiatrochronu. (Nie powinien ani wystawać, ani być szczególnie zagłębiony.) Uformowanie tego fragmentu, wraz z dopasowaniem do powierzchni wiatrochronu, zajęło mi jakąś godzinę. Być może istnieje łatwiejszy sposób, by uzyskać taką “pogiętą rurę”. Sądzę jednak, że straciłbym więcej czasu na eksperymenty, niż zużyłem na jej wykonanie opisaną metodą.
Po uformowaniu dolnej części ramy wiatrochronu wstaw w nią dwa wewnętrzne pręty (Rysunek 4.15.10a) . Wykonaj je jako oddzielne obiekty. Nadałem im nazwy B.333.R.WindshWire i B.333.L.WindshWire. Środkiem (tzn. punktem odniesienia — ang. origin) każdego pręta uczyń jego górny koniec. To ułatwi późniejsze dopasowywania do spodu ramki — wystarczy je obrócić wokół globalnej osi X.
Dla łatwiejszego odróżnienia od kadłuba nadałem ramce (na czas pracy) kontrastowy, sztuczny kolor przypisując jej czerwony materiał Artifical. Teraz zmodyfikuj kadłub: wkomponuj w jego siatkę krawędź przecięcia z wiatrochronem (Knife, a później reorganizacja ścian). Będzie to przednia krawędź otworu kabiny. Wytłocz także boczne zakończenia ścian kadłuba (wzdłuż boków owiewki — Rysunek 4.15.11):
Rysunek 4.15.11 Modyfikacja siatki kadłuba wokół kabiny
Przy okazji można zamknąć ścianą otwór, ziejący do tej pory z tyłu, za kabiną. Umieść tam (poprzez wytłoczenie, a potem zmianę skali nowej krawędzi wzdłuż osi X do zera) górną część pancernej płyty, osłaniającej pilota (Rysunek 4.15.11).
Wróćmy jeszcze na chwilę do wiatrochronu. Z analizy zdjęć wynika, że jego wewnętrzne pręty biegły równolegle do powierzchni szkła. Sprawdź to, przykładając w ich płaszczyźnie utworzoną na chwilę płaską powierzchnię (Rysunek 4.15.12a). W moim przypadku okazało się konieczne poprawienie kąta pochylenia słupka. W efekcie jego “gniazdo” stało się o wiele bardziej odległe od ramki. Trzeba było “wyciągnąć” tylną powierzchnię dolnej ramki wiatrochronu w masywne zgrubienie (Rysunek 4.15.12b) . Takie właśnie zgrubienie widać także na zdjęciach z wnętrza kabiny P-40 B/C. Na szczęście nie miało to wpływu na przednią krawędź ramy, dopasowaną do kadłuba. (Dopóki dodajesz nowe wierzchołki wyłącznie na tylnej krawędzi ramki, kształt ściany przedniej pozostaje niezmienny).
Rysunek 4.15.12 Szczegóły ramki wiatrochronu
Pozostaw pomiędzy ramką a powierzchnią kadłuba niewielką szczelinę — na grubość szkła wiatrochronu (Rysunek 4.15.12b). Zwróć także uwagę, że dolny koniec słupka wiatrochronu wystaje poza obrys kadłuba (tak właśnie było w P-36 i P-40B/C).
Aby ten wystający koniec zasłonić, konstruktorzy nałożyli na ten fragment niewielką “łatkę” z wygiętej blachy. Najprościej jest ją wykonać, zaczynając od uformowania płaskiej płytki o obrysie „łatki” z boku (Rysunek 4.15.13a). Potem wystarczy poprzesuwać wierzchołki tej powłoki wzdłuż osi X, “układając” je na powierzchni kadłuba (Rysunek 4.15.13b):
Rysunek 4.15.13 Dodanie “łatki”, zasłaniającej wystającą ramkę wiatrochronu
Kolejnym elementem jest szyna, po której przesuwała się owiewka kabiny pilota (B.337.CanopyRail) . Aby ją wyróżnić, przypisałem temu obiektowi, podobnie jak ramce wiatrochronu, czerwony materiał (Artifical —Rysunek 4.15.14a). Szyna owiewki miała przekrój w kształcie litery “T”2. Mimo naszych starań zachowania na poziomie dolnej krawędzi owiewki stałej szerokości kadłuba, w połowie oszklenia za kabiną pilota kadłub staje się nieco węższy. Koniec zupełnie prostej szyny odstaje jego powierzchni na jakiś centymetr. Na szczęście, na zdjęciach z rekonstrukcji P-36 widać, że szyna była lekko wygięta do dołu. (P-36 miał taki sam tył, jak P-40B/C). Geometrycznie to bardzo ważne, bo nawet 1-2 cm niżej kadłub był szerszy, i można w ten sposób zachować stałą odległość pomiędzy szynami (Rysunek 4.15.14b):
Rysunek 4.15.14 Szyna owiewki kabiny
Szynę owiewki już stworzyliśmy, teraz czas na jej ramkę. Utwórz nowy obiekt — B.335.CanopyFrame — poprzez powielenie (Duplicate) powierzchni “szkła”, czyli przygotowanego wcześniej (str. 227) obiektu B.225.CanopyGlass. Aby łatwiej było trafić liniami wierzchołków w układ ramek, zagęść siatkę nowo utworzonego obiektu (Subsurf:Apply, z Subdivisions ustawionym na 1). Rysunek 4.15.15a pokazuje rezultat. Uformowany jest tu już także dolny fragment ramki owiewki. (Wygląda mi to na coś w rodzaju osłony poruszającego się po szynach “wózka”, do którego była przyczepiona reszta konstrukcji3).
Rysunek 4.15.15 Ramka owiewki kabiny — początkowe etapy formowania
Zwróć uwagę na narastającą wzdłuż dolnej krawędzi ramki “falbankę”, kryjącą krawędź szyny (Rysunek 4.15.15b). Jest widoczna na wszystkich zdjęciach. (Świadczy o nieznacznym zawężeniu tyłu owiewki).
Po przygotowaniu siatki można na niej naciąć (Knife) wewnętrzne krawędzie ramek (Rysunek 4.15.16):
Rysunek 4.15.16 Przygotowanie zarysu wewnętrznych krawędzi ramki
Ukośne “fazki” w narożnikach ramek dodaj na samym końcu, zastępując znajdującą się w tych miejscach ścianę prostokątną dwoma trójkątnymi (J).
Teraz usuń wierzchołki ze środka otworów i pogrub (Solidify) całą ramkę do wewnątrz o jakieś 0.08 jednostki Blendera (8 mm) (Rysunek 4.15.17). Założyłem, że grubość całego “sandwicza”: ramka zewnętrzna, szkło organiczne, ramka wewnętrzna, miała grubość 8mm. Równie dobrze mogło to być 9, 10 czy 11mm — trudno to dokładnie ustalić na podstawie zdjęć.
Rysunek 4.15.17 Ramka po usunięciu wnętrza otworów i pogrubieniu
Owiewki P-36 i P-40 miały ciekawe rozwiązanie awaryjne — lewy segment oszklenia mógł być uchylony do góry4. Wyglądało to tak, że w lewą ścianę owiewki była wkomponowana druga, cieńsza ramka, do której przymocowano szybę boczną (Rysunek 4.15.18a) . Po przejrzeniu zdjęć doszedłem do wniosku, że ogólna szerokość “pasków” ramki z lewej i z prawej strony jest identyczna. Dzięki temu możemy pozostawić zastosowany do tej siatki modyfikator Mirror, i dalej kształtować tylko symetryczną połowę siatki. Zdecydowałem się nanieść (Loop Cut) dodatkowe linie wierzchołków tam, gdzie występowały krawędzie uchylanej ramki. Przydadzą się, gdybyś chciał uszczegółowić model.
Rysunek 4.15.18 Dalsze szczegóły ramki owiewki kabiny
Na przedniej krawędzi owiewki znajdowała się wręga, usztywniająca jej konstrukcję5. Nanieś (Loop Cut) na dolną powierzchnię dwa położone blisko siebie rzędy wierzchołków. Następnie wytłocz je (jako region) i odsuń do wnętrza owiewki (Shrink/Fatten) (Rysunek 4.15.18b).
Ramka owiewki jest już gotowa. Pozostało już tylko jest pogrubienie powłok oszklenia (B.320.WindshGlass i B.325.CanopyGlass). Zrób to za pomocą polecenia Solidify(Rysunek 4.15.19):
Rysunek 4.15.19 Ostatnia czynność — pogrubienie powierzchni szkła kabiny
Przyjąłem, że grubość szkła wynosiła 4mm (0.04 jednostki Blendera). Oczywiście, to tylko moje przypuszczenie — równie dobrze mogło to być 3 lub 6mm.
Rysunek 4.15.20 Gotowa osłona kabiny — wyliczenie elementów
Rysunek 4.15.20 pokazuje gotową osłonę kabiny. Na koniec każdego etapu warto uporządkować wzajemne przypisanie obiektów (relacje Parent) oraz przypisania do warstw. Powierzchnie szklane (B.320.WindscrGlass, B.325.CanopyGlass, B.310.L/R.RearGlass) umieść na odrębnej warstwie (M, str. 838) — aby, w razie potrzeby, szybko je ukryć. Proponuję, aby to była warstwa 16. Pozostałe elementy ramek kabiny (Rysunek 4.15.20) umieść na drugiej warstwie: 17.
Całość składa się z dziesięciu elementów, więc warto ją zawczasu połączyć w hierarchię, aby nic się nie “zgubiło”. Proponuję przypisać “szkła” do odpowiednich ramek (B.320.WindshGlass do B.330.WindshFrame, B.325.CanopyGlass do B.335.CanopyFrame, a B.310.L/R.RearGlass do B.315.L/R.RearFrame). Potem każdą z ramek przypisz do kadłuba (B.300.Fuselage). Do ramki wiatrochronu (B.330.WindshFrame) przypisz także jego wzmocnienia (B.333.L/R.WindshWire, B.332.WindscrTube). Bezpośrednio do kadłuba (B.300.Fuselage) przypisz “łatki” (B.331.L/R.Patch) oraz szyny owiewki (B.337.L/R.CanopyRail).
Przygotowując się do tematu następnej sekcji, powtórnie przeglądałem zdjęcia kabiny P-40. Im dłużej się w nie wpatrywałem, tym więcej dostrzegałem niedokładności w modelu, który wykonaliśmy. Nie są duże, a tego typu niewielkie poprawki są normą na każdym etapie pracy. Omawiam je dopiero teraz, abyście nie sądzili, że jestem nieomylny ☺. Zacznijmy od bocznej krawędzi kabiny: powinna być nieco wyżej (Rysunek 4.15.21a):
Rysunek 4.15.21 Podniesienie krawędzi kabiny i poprawki w ramce owiewki
(Ze zdjęć wynika, że szyna owiewki była niemal na takiej samej wysokości, co górna krawędź “łatki”, a w naszym modelu była niżej). Trzeba było więc podnieść do góry i szyny, i krawędź kadłuba o jakieś 0.08 jednostki Blendera. To z kolei spowodowało konieczność podniesienia do góry “stopki” ramki wiatrochronu — aby nadal opierała się o krawędź kadłuba, a nie “tonęła” w jego wnętrzu.
Poprawek wymagała także ramka owiewki kabiny (Rysunek 4.15.21b) . Zdjęcia pokazują, że “falbanka” ponad krawędzią szyny miała mniejszą grubość, niż jej początkowo nadaliśmy. Jej krawędzie były także raczej ostre, a nie zaokrąglone. Nie “rozmywała” się zupełnie z przodu owiewki, jak zamodelowaliśmy poprzednio. Poza tym dolna ramka oszklenia była położona nieco niżej (o ok. 0.1 jednostki Blendera). (Wyszło mi to z porównania proporcji wysokości ramki pod i ponad “falbanką”).
Zdjęcia pokazały także, że kształt dolnej ramki wiatrochronu, wykonany na wcześniejszych stronach tej sekcji, był prawidłowy — ale dla wersji poprzedzającej P-40B! Oznaczano ją jako P-40 (bez żadnej litery) lub Tomahawk I, i produkowano w 1940r. Podobnie jak P-36, nie miała opancerzenia. Wraz z dodaniem przedniej szyby pancernej w P-40B, ramka wiatrochronu uległa zmianie. Pojawiło się na niej wybrzuszenie, pokryte z zewnątrz wygiętym poszyciem kadłuba (Rysunek 4.15.22a) :
Rysunek 4.15.22 Poprawki w zespole wiatrochronu
Pojęcia nie mam, co mogło być przyczyną takiej modyfikacji: zwiększone obciążenie ramy przez szybę pancerną? Doświadczenia z eksploatacji? Trzeba jednak ten szczegół odwzorować. Zacząłem od wzmacniających wiatrochron prętów. Obserwując ich mocowanie w ramce, doszedłem do wniosku, że miały wygięte końce. Pozwoliło to przesunąć je nieco do przodu (Rysunek 4.15.22b), i zmniejszyć pochylenie ich “gniazd” w ramce. Dzięki temu zaczęły wyglądać jak na zdjęciu (Rysunek 4.15.23a).
Rysunek 4.15.23 Poprawki w wiatrochronu — zmiana kształtu ramki i kadłuba
Ze zmianą kształtu samej ramki było trochę roboty. Po przesunięciu odpowiednich sekcji do góry, należało je powtórnie dopasować do powierzchni wiatrochronu. Potem trzeba było bardziej wygiąć powłokę kadłuba, aby pokryć zmieniony kształt ramki (Rysunek 4.15.23a). W rezultacie zagięte poszycie kadłuba tworzy w rzucie z przodu linię prostą (Rysunek 4.15.23b).
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.15.blend (por. str. 22).
Podsumowanie
Osłona kabiny jest pierwszym przykładem zespołu, który jest złożony z większej liczby elementów. Pamiętaj, aby od razu zadbać o nadanie całości właściwej hierarchii (relacjami Parent — por. str. 233);
Oszklenie kabiny zawsze warto trzymać na osobnej warstwie. W trybie wyświetlania Solid, w którym zazwyczaj pracujesz, powłoka oszklenia jest nieprzejrzysta. Zasłania wiele szczegółów ramki, które często będziesz chciał widzieć, chociażby podczas prac nad wnętrzem kabiny. Co chwila będziesz potrzebował zmienić widoczność powłok oszklenia. Włączenie/wyłączenie widoczności warstwy jest tu najprostszym rozwiązaniem (por. str. 233);
W trakcie prac, opisanych w tej sekcji, wykorzystywaliśmy poznane wcześniej techniki formowania. Nie pojawiło się już nic nowego. To wskazuje, że zdobyłeś już dużo doświadczenia!
Wnętrze kabiny — fotel pilota, tablicę przyrządów, szybę pancerną, zagłówek — wykonamy później, na etapie uzupełniania drobnych części. Teraz przygotujmy ściany kabiny pilota. Wręgi i podłużnice, biegnące wewnątrz kabiny, spełnią rolę “kratki”, która pozwoli nam lepiej porównać ze zdjęciami wzajemne proporcje poszczególnych elementów jej wyposażenia. Gdy szkielet burt będzie wyglądać jak na fotografiach, umieszczone na nich detale także powinny mieć poprawne rozmiary.
Przebieg podłużnic i wręg najlepiej rozpoznać, śledząc linie nitów na kadłubie. Układ tych linii, narysowany na planach koniecznie skonfrontuj ze zdjęciami — czasami znajdziesz różnice! Rysunek 4.16.1 pokazuje linie podłużnic i wręg, jakie posiadał P-40B/C (i P-36):
Rysunek 4.16.1 Określanie przebiegu wręg i podłużnic na podstawie linii nitów na kadłubie
Wśród wręg, które narysowałem, są dwie oznaczone kolorem żółtym (Rysunek 4.16.1). Wręgi te są widoczne na zdjęciach wnętrza kabiny, ale nie mają “swojego” szwu nitów na zewnątrz. Przypuszczam, że był to rodzaj “ścianek wewnętrznych”, przymocowanych nie do poszycia, tylko do podłużnic kadłuba. Wewnątrz kabiny nie odróżniają się od innych wręg, więc zamodelujemy je w ten sam sposób, co pozostałe.
Skopiuj tył kadłuba (B.300.Fuselage) w nowy obiekt. Nadaj mu nazwę B.301.Cockpit.001 i umieść na warstwie nr 17 (na innej niż kadłub). Usuń z jego siatki niepotrzebne ściany, pozostawiając tylko otoczenie kabiny (Rysunek 4.16.2a):
Rysunek 4.16.2 Uproszczenie siatki wewnętrznej ściany kabiny
Uprość tę siatkę (usuwając niektóre wierzchołki i tworząc nowe ściany). Przygotuj ją tak, by zawierała wyłącznie ściany czworokątne (Rysunek 4.16.2b). Między innymi — odłącz na chwilę od siatki dolną krawędź i połącz ją na nowo, tym razem bez trójkątnych ścian.
W tak przygotowanej siatce natnij (Knife) kolejne wręgi tam, gdzie biegły linie nitów. Większość podłużnic jest niemal w poprawnym miejscu — skoryguj tylko niektóre z nich drobnymi przesunięciami (Edge Slide) (Rysunek 4.16.3):
Rysunek 4.16.3 Gotowy układ wręg i podłużnic wewnętrznych ścian kabiny
Sprawdź, czy kształt powłoki nie uległ deformacjom w wyniku wprowadzonych zmian. Włącz widoczność warstwy z powłoką kadłuba (B.300.Fuselage). Aby łatwiej dostrzec różnicę, zmień barwę obiektu B.301.Cockpit.001 na czerwoną (materiał Artifical) (Rysunek 4.16.4a):
Rysunek 4.16.4 Ściany wewnętrzne: uzgodnienie kształtu i odsunięcie od zewnętrznej powierzchni kadłuba
Gdy wszystko się zgadza, odsuń (Shrink/Fatten) powłokę wnętrza kabiny od powierzchni kadłuba o “grubość blachy” — 0.02 jednostki Blendera. Przyjrzyj się, patrząc wzdłuż krawędzi, czy odsunięcie nastąpiło rzeczywiście wszędzie, na taką samą odległość (Rysunek 4.16.4b). Potem można z powrotem ukryć warstwę z powłoką kadłuba. (Możesz to także zrobić poleceniem Solidify, ale wtedy trzeba usunąć zewnętrzną powłokę)
Ostatnia wręga kabiny była litą płytą pancerną. Górny fragment tej ściany uformowaliśmy wcześniej, podczas prac nad osłoną kabiny (por. str. 229). Oddziel go teraz (Separate) z siatki kadłuba i włącz do tej siatki. Dolną część płyty proponuję wytłoczyć z ostatniej krawędzi siatki kabiny. Potem wystarczy przekształcić wytłoczoną krawędź w linię prostą, zmieniając jej skalę wzdłuż osi X do zera (Rysunek 4.16.5a). Teraz można uzupełnić brakującą ścianę pomiędzy górną i dolną częścią tej wręgi (Rysunek 4.16.5b). Zwróć uwagę na wąską “zakładkę”, jaką pozostawiłem wzdłuż górnej krawędzi płyty pancernej. To zabezpieczenie przed powstaniem przypadkowej szczeliny pomiędzy wewnętrzną ścianą kabiny i poszyciem kadłuba.
Rysunek 4.16.5 Utworzenie tylnej ściany kabiny
Wzdłuż wewnętrznych ścian kadłuba biegły wręgi i podłużnice. Zacznijmy od wykonania podłużnic: skopiuj siatkę ścian kabiny w nowy obiekt (B.301.Cockpit.002). Powiel (poleceniem Loop Cut) linie podłużnic. Zrób to tak, by odpowiednie linie były od siebie odległe o grubość podłużnicy (Rysunek 4.16.6):
Rysunek 4.16.6 Kopia ścian kabiny, przygotowana do przekształcenia w podłużnice
Po zdublowaniu linii podłużnic należy sprawdzić, czy żadna jej część nie wystaje ponad powłokę kadłuba. Dwa rzędy wierzchołków, umieszczone blisko siebie, dają efekt podobny do ostrej krawędzi (Rysunek 4.16.7a). W związku z tym zazwyczaj trzeba trochę zsunąć boki siatki wzdłuż osi X (Rysunek 4.16.7b). (Nowe linie zmieniły jej kształt, stała się bardziej wypukła i widać je ponad powierzchnią zewnętrznego poszycia kadłuba):
Rysunek 4.16.7 Kopia ścian kabiny, przygotowana do przekształcenia w podłużnice
Siatka jest przygotowana, czas na wytłoczenie z niej podłużnic. Zaznacz odpowiednie ściany (Rysunek 4.16.8a). Następnie wytłocz je do wnętrza (Extrude) — i powstała w ten sposób podłużnica (Rysunek 4.16.8b):
Rysunek 4.16.8 Wytłaczanie podłużnicy
Można także wytłaczać kilka elementów jednocześnie. Przydatne jest wówczas wstawienie (Loop Cut) pomiędzy wytłaczanymi obszarami dodatkowych rzędów wierzchołków (bez jakiegokolwiek kształtowania — to tylko separatory) (Rysunek 4.16.9a):
Rysunek 4.16.9 Formowanie podłużnic
Te pomocnicze rzędy wierzchołków pozwalają poprawnie zaznaczyć naraz kilka rzędów ścian do wytłoczenia. Rysunek 4.16.9b) pokazuje jednoczesne wytłoczenie czterech podłużnic. Można tak to robić, jeżeli wszystkie są zorientowane w ten sam sposób, i miały taką samą szerokość. Potem wystarczy usunąć niepotrzebne krawędzie i wierzchołki (bardzo to ułatwiają dodane przed chwilą pomocnicze linie siatki) (Rysunek 4.16.9c).
W podobny sposób formujemy zespół wręg. Umieść ten obiekt na oddzielnej warstwie. Tu po wytłoczeniu wierzchołków lepiej jest je odsunąć od ścian poleceniem Shrink/Fatten (Rysunek 4.16.10):
Rysunek 4.16.10 Formowanie wręg
Rysunek 4.16.11a) pokazuje wytłoczone wręgi, po “uwolnieniu” od niepotrzebnych wierzchołków. Nie wygląda to specjalnie realistycznie, prawda? Ale chwileczkę: teraz włącz warstwę z podłużnicami (Rysunek 4.16.11b). Prawda, że to złożenie przypomina już szkielet prawdziwego samolotu?
Rysunek 4.16.11 Złożenie wręg i podłużnic
Włącz jeszcze warstwę z wewnętrzną i zewnętrzną ścianą kadłuba (Rysunek 4.16.12a) . (Zmieniłem kolor wewnętrznych ścian na neutralny, by szkielet był bardziej wyraźny. Prawda, że całość wygląda dość realistycznie?
Rysunek 4.16.12 Połączenie z wewnętrznymi ścianami kabiny
Proponuję tak ją już pozostawić. Gdybyś chciał dokładniej cyzelować ten fragment, należałoby dodać wzdłuż każdej podłużnicy i wręgi płaskie pasy blachy, za pomocą których były przynitowane do kadłuba. (Podłużnice miały przekrój poprzeczny w kształcie litery “L”, i były dość wąskie. Wręgi — miały przekrój w kształcie litery “U”, z dwoma dodatkowymi, poziomymi paskami u końców). Nim zabierzesz się za tę pracę, warto abyś wiedział, że wnętrze kabiny jest zawsze mało widoczne na ostatecznym renderze. Wynika to z stosunkowo niewielkich rozmiarów elementów wnętrza, obecności szyb, oraz typowych kątów ustawienia kamery. Jeżeli więc nie przewidujesz jakichś szczegółowych zbliżeń kabiny — nie ma sensu odtwarzać jej zbyt szczegółowo.
Rysunek 4.16.12b) pokazuje drobny szczegół, który pozostawiłem na sam koniec: w wyniku upraszczania układu ścian pozostała szczelina pomiędzy wewnętrzną ścianą kabiny, a ramą wiatrochronu. Teraz, po wydzieleniu (w obiekt B.301.Cockpit.001) i utworzeniu wręg i podłużnic, z powrotem można odrobinę skomplikować siatkę ścian wewnętrznych, by tę szczelinę “załatać”. Wystarczy dodać dwie ściany, oparte o dwa dodatkowe wierzchołki.
Skoro już o mowa o ramce wiatrochronu (B.320.WindscrFrame), to pozostała na niej do wykonania charakterystyczna “wypustka” (Rysunek 4.16.13). Ten element pojawił się wraz ze zmianą kształtu ramki w P-40B/C. Wyraźnie stanowi dodatkowe mocowanie ramki do wręgi kadłuba. Nie chciałem go dodawać “na ślepo” w poprzedniej sekcji, nie wiedząc do końca , gdzie się pojawi wręga i jaką będzie miała szerokość. Teraz już można było to zrobić:
Rysunek 4.16.13 Połączenie ramki wiatrochronu z wręgami kabiny
Rysunek 4.16.13 pokazuje uformowaną “wypustkę” ramy wiatrochronu. Jej kształt i rozmiar starałem się ustalić na podstawie nielicznych zdjęć z Internetu, na których widać ten fragment wnętrza kabiny P-40B/C. W ten sposób uzupełniliśmy o ostatni element część, rozpoczętą w poprzedniej sekcji. Swoją drogą — ta rama miała bardzo złożony kształt. Jej dolna część mogła być jakimś aluminiowym odlewem lub odkuwką.
Po zakończeniu formowania warto zadbać o zbudowanie odpowiedniej hierarchii części. Przypisz wręgi (B.301.Cockpit.003) i podłużnice (B.301.Cockpit.002) do wewnętrznych ścian kabiny (B.301.Cockpit.001). Same wewnętrzne ściany przypisz do kadłuba (B.300.Fuselage). Każdy ze składników — ściany, wręgi i podłużnice — podczas tworzenia był umieszczany na innej warstwie. Teraz umieść je na jednej — powiedzmy warstwie nr 17. (Zewnętrzna powierzchnia kadłuba jest na warstwie nr 7, wydaje mi się, że w ten sposób będziesz mógł wzrokowo zapamiętać, że wewnętrzne szczegóły są na warstwie “o rząd niższej”).
Na tym zakończyliśmy (na razie) prace nad kabiną. Powrócimy do niej, gdy będziemy uzupełniać nasz model o drobne detale1. Jak się domyślasz, kabina pilota może zawierać ich całe mnóstwo!
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.16.blend (por. str. 22).
Podsumowanie
Wewnętrzne ściany kabiny, wraz z wręgami i podłużnicami, warto uformować jednocześnie z kadłubem. Podczas pracy nad nimi często możesz dostrzec jakieś błędy w kształcie dotychczas uformowanych powłok. Lepiej poprawić je teraz, nim kadłub “obrośnie” w dalsze szczegóły i będzie jeszcze trudniejszy do zmiany!
W tej sekcji poznałeś szybki sposób formowania całych zespołów wręgi i podłużnic — poprzez wytłaczanie regionem. Elementy uformowane w ten sposób od razu są dokładnie dopasowane do zewnętrznych ścian konstrukcji. W przyszłości ta metoda może Ci pozwolić nie tylko tworzyć wnętrze kabiny, ale całą strukturę płatowca. (W Internecie można znaleźć kilka takich bardzo interesujących modeli z „przeźroczystym” poszyciem — np. Mitsubishi A6M2 “Zero” na http://www2.cc22.ne.jp/~harada, albo Fokker Dr.I z http://www.airart3d.com).
Rysunek 4.17.1 przedstawia osłony podwozia głównego P-40. Jest to element specyficzny dla linii rozwojowej P-36/P-40, i nie występuje chyba w żadnym innym myśliwcu z okresu II wojny światowej1.
Rysunek 4.17.1 Osłony goleni podwozia głównego
Pracę należy zacząć od ustalenia, jak dokładnie wygląda ta osłona. Korzystając z fotografii, doszedłem do wniosku, że przekrój poprzeczny “gondoli” podwozia był nieco inny, niż na planach, których używam. Wyglądał na dość regularną elipsę (Rysunek 4.17.2):
Rysunek 4.17.2 Poprawiony obrys osłony podwozia
Nowy obiekt zacznij od wstawienia okręgu (Circle), złożonego początkowo z 16 wierzchołków. Przekształć go w odpowiednią elipsę. Umieść także po trzy dodatkowe wierzchołki tam, gdzie będą biec krawędzie otworu w gondoli, zamykanego przez boczną pokrywę. Te dodane wierzchołki powinny leżeć blisko siebie, i na jednej linii prostej (Rysunek 4.17.3a):
Rysunek 4.17.3 Uformowanie i wytłoczenie podstawowego profilu
Po dodaniu nowych wierzchołków koniecznie popraw położenie pozostałych, by ogólny kształt konturu nadal był jak najbardziej zbliżony do elipsy. Następnie wytłocz ten profil w obydwu kierunkach wzdłuż osi Y. Z przodu wstaw kilka coraz mniejszych profili, formując w ten sposób podstawowy kształt osłony (Rysunek 4.17.3b). Nadaj nowemu obiektowi nazwę B.150.R.Cover. Nazwa zawiera przyrostek .R, gdyż rysunek referencyjny przodu gondoli umieściłem pod prawym skrzydłem, i tam też jest nasz obiekt. Czasami jednak zachodzi potrzeba przymierzenia tej siatki do płata. W tym celu utwórz drugą instancję obiektu (Alt-D — Duplicate Linked) i nazwij ją B.150.L.Cover. Obydwa obiekty używają tej samej siatki (B.150.Cover). Aby ją zmienić, wystarczy przejść w tryb edycji jednego z nich.
Po wytłoczeniu kształtu podstawowej bryły (“wrzeciona”) należy dodać “przybudówkę”. (Ukrywała we wnętrzu boczne zamocowania goleni podwozia). Zacznij od narysowania jej profilu (Rysunek 4.17.4a):
Rysunek 4.17.4 Uformowanie i wytłoczenie wybrzuszenia z boku owiewki
Po narysowaniu wytłocz profil wzdłuż osi Y (Rysunek 4.17.4b). Na razie siatka tego bocznego “dodatku” nie jest w żaden sposób połączona z główną bryłą (“wrzecionem”). To nie przypadek — na czas formowania warto wstawić ją do tego istniejącego obiektu, który zawiera podstawową siatkę gondoli. Pozwala to na umieszczenie profili w tych samych, lub niemal tych samych miejscach “przybudówki”, co profile głównej powłoki (por. Rysunek 4.17.5b). Do poprawnego połączenia obydwu powłok potrzebne jest wyznaczenie ich krawędzi przecięcia. Możesz ją wyznaczyć dodatkiem Interesection, który jest dostępny także w trybie edycji (por. str. 831). Wystarczy zaznaczyć ściany „przybudówki”, i wywołać to polecenie z menu Specials.
Rysunek 4.17.5a) przedstawia siatkę „przybudówki” wydzieloną na czas przecięcia w nowy obiekt. (Tę część tworzyłem zanim zmodyfikowałem skrypt Intersection). Przygotowując zaokrąglenie biegnące wzdłuż krawędzi obydwu powłok, natnij (Knife) na “wrzecionie” dodatkową linię. Podobną linię na “przybudówce” można dodać poleceniem Loop Cut (Rysunek 4.17.5b):
Rysunek 4.17.5 Przygotowanie krawędzi przecięcia i jej otoczenia
Połączenie obydwu powłok wykonaj w ten sam sposób, jak kształtowaliśmy szczegóły maski silnika: usuwając stare ściany i budując nowe wzdłuż krawędzi przenikania (Rysunek 4.17.6a):
Rysunek 4.17.6 Połączenie siatek wybrzuszenia i owiewki
Ta technika pozwala uzyskać całkiem poprawny kształt połączenia (Rysunek 4.17.6b). Nie należy także zapominać o przygotowaniu krawędzi otworów w gondoli. Jak pamiętasz, radziłem aby zawczasu w profil początkowy “wmontować” po dwa współliniowe odcinki, o środku w miejscu krawędzi przyszłego otworu (str. 243). Z tych odcinków powstały rzędy ścian. Oznacz teraz krawędzie biegnące przez ich środki jako “ostre” (Rysunek 4.17.7a). Przy okazji wyprostuj linię krawędzi obrotu pokrywy bocznej (Rysunek 4.17.7b):
Rysunek 4.17.7 Przygotowanie krawędzi otworów
Uformowanie zewnętrznych krawędzi owiewki podwozia zaczniemy od wyznaczenia linii przecięcia z płatem (Rysunek 4.17.8a):
Rysunek 4.17.8 Ograniczenie krawędzi owiewki do obrysu płata
Potem włącz tę krawędź w siatkę. Najprościej jest to zrobić usuwając wszystkie ściany wzdłuż starej krawędzi siatki, i budując w to miejsce nowe, łączące krawędź przenikania z płatem z resztą siatki (Rysunek 4.17.8b). Starą krawędź usuń, za wyjątkiem obszaru z przodu owiewki. Tam wykorzystaj ją do zbudowania kolejnego rzędu ścian, tworząc coś w rodzaju „kołnierza” (Rysunek 4.17.9a):
Rysunek 4.17.9 Formowania przedniej krawędzi blachy owiewki
Wierzchołki tego "kołnierza" przesuń do przodu, wzdłuż osi Y. Każdy z nich przemieść inną odległość. by "położyć” przednią krawędź owiewki na krawędzi natarcia płata (Rysunek 4.17.9b, c). Przy okazji zmień barwę owiewki na kontrastową czerwień (materiał Artifical), by łatwiej dopasować jej powierzchnię do powierzchni skrzydła. Boczne krawędzie owiewki także płynnie przylegały do powierzchni samolotu. Aby ten efekt uzyskać, zacznij od wytłoczenia wzdłuż osi X każdej z bocznych krawędzi (Rysunek 4.17.10a):
Rysunek 4.17.10 Formowanie krawędzi bocznej
Aby promień zaokrąglenia pomiędzy owiewką i płatem był w miarę stały, natnij (Knife) z boku owiewki dodatkową krawędź (Rysunek 4.17.10b). Zrób to tak, by była mniej więcej równo odległa od powierzchni skrzydła Potem usuń poprzednią podłużnicę, która biegła w pobliżu nowej linii (na ilustracji już została usunięta).
Wytłoczone, zewnętrzne krańce siatki dosuń do powierzchni płata (Rysunek 4.17.11a). Popraw także ich położenie poprzeczne, by biegły prosto wzdłuż wręg skrzydła (Rysunek 4.17.11b):
Rysunek 4.17.11 Nadanie powłoce ostatecznego kształtu
Po nadaniu owiewce ostatecznego kształtu, zaznacz na niej obszar, który mają zajmować odchylane osłony goleni podwozia (Rysunek 4.17.12):
Rysunek 4.17.12 Przygotowanie do wydzielenia z owiewki otwieranych pokryw goleni podwozia
Skopiuj (Shift-D, Duplicate) ten fragment, a następnie wydziel go (P, Separate) w nowy obiekt (Rysunek 4.17.13a) :
Rysunek 4.17.13 Podział pokrywy podwozia na dwie części (jak w prawdziwym P-40)
Z uzyskanej siatki wydziel w kolejny obiekt boczną pokrywę goleni podwozia (Rysunek 4.17.13b).
Powróćmy jeszcze na chwilę do owiewki. Wzdłuż wszystkich „wolnych” krawędzi (tzn. tych, do których nie są zamocowane zawiasy pokryw podwozia) miała “zakładki”, o szerokości ok. 1 cm. Aby je wykonać, zaznacz obszar przyszłego otworu, i wytłocz tę powierzchnię (Extrude, Shrink/Fatten) do wnętrza owiewki na jakieś 0.02 jednostki Blendera (2mm) (Rysunek 4.17.14a,b):
Rysunek 4.17.14 Wytłoczenie obszaru otworów owiewki
Na wytłoczonej powierzchni natnij (Knife) kontury “zakładek” — tak, jak wyglądały na zdjęciach (Rysunek 4.17.15a). Potem wystarczy usunąć wewnętrzne wierzchołki, i mamy krawędź “jak prawdziwą” (Rysunek 4.17.15b) :
Rysunek 4.17.15 Wycięcie “zakładek” wzdłuż krawędzi otworów w owiewce podwozia.
Kierując się zdjęciami, wstaw teraz do owiewki ściany wewnętrzne (Rysunek 4.17.16):
Rysunek 4.17.16 Dodanie wewnętrznych ścian owiewki
Na zdjęciach te “ściany” to typowe usztywnienia wewnętrzne: kawałki perforowanej blachy. Perforacji na razie nie wykonamy, aby nie mnożyć niepotrzebnie wierzchołków modelu na tak drobny i mało widoczny szczegół2. Ściany najprościej jest uzyskać przez skopiowanie odpowiednich linii wierzchołków zewnętrznej powłoki, i wytłoczenie ich wzdłuż osi Z. Po uformowaniu, łączymy je z krawędziami otworów. (Wcześniej wytłocz krawędzie “zakładek” na grubość blachy — 1 mm). W ten sposób powstaje wewnętrzna powłoka owiewki (Rysunek 4.17.17) :
Rysunek 4.17.17 Rezultat — owiewka po połączeniu ścian wewnętrznych i zewnętrznych
Nie sądzę, aby w prawdziwym samolocie blacha owiewki miała większą grubość niż 1 mm. Nasza wewnętrzna powłoka jest odsunięta od zewnętrznej o sumę grubości i wytłoczenia “zakładek” krawędzi: 1 mm + 2 mm. Razem daje to 3 mm (0.03 jedn. Blendera — Rysunek 4.17.17). To dlatego, że nie będziemy modelować wewnętrznych szczegółów konstrukcyjnych: zakończeń zakładek (były tylko paskami grubej blachy) i innych drobiazgów. Oczywiście, jeżeli chcesz, możesz to zrobić, ale od razu ostrzegam, że na ostatecznym modelu chyba nikt ich nie zauważy. Podobnie jak pogrubienia powłoki owiewki z 1 do 3 mm w naszym modelu.
Po każdej takiej operacji warto uważnie obejrzeć nowo utworzone krawędzie. Z tyłu owiewki (por. Rysunek 4.17.17) możesz się natknąć na brzydką “nadlewkę” powierzchni podziałowej (Rysunek 4.17.18a) :
Rysunek 4.17.18 Częściowe rozwiązanie problemu “nadlewki” na ostrej krawędzi
Coś takiego powstaje, gdy jedna krawędź płaskiej ściany jest łagodnym łukiem, a druga — ma ostry narożnik. Gdy “gładki” i “ostry” narożnik znajdą się bardzo blisko siebie — następuje nałożenie ścian “łagodnego łuku” na “ostry kant”. Jeżeli chcemy zachować krzywiznę łuku nie możemy użyć żadnych kombinacji z nadaniem ostrości dodatkowym krawędziom. Jedynym rozwiązaniem, jakie znalazłem, jest zagęszczenie siatki — wstawienie w pobliżu “nadlewki” dwóch nowych krawędzi (Rysunek 4.17.18b). To minimalizuje niepożądany efekt poniżej granicy tolerancji. Warto zdawać sobie sprawę z tej przypadłości powierzchni podziałowych.
Ostatni szczegół, który pozostał do wykonania na owiewce, to zakończenie zewnętrznych krawędzi “na grubość blachy”. Wytłocz je prostopadle do powierzchni płata (ze względu na bardzo wygięty kształt — oddzielnie przód i oddzielnie boki) na jakieś 2 mm (Rysunek 4.17.19):
Rysunek 4.17.19 Zakończenie zewnętrznych krawędzi owiewki
Pozostały jeszcze do uformowania ruchome pokrywy podwozia, których powłoki wydzieliliśmy wcześniej (str. 246). Zacznijmy od mniejszej: nadaj jej nazwę B.160.L.SideDoor. Pogrub ją (oczywiście — do wewnątrz) używając polecenia Solidify na “grubszą blachę” — 2 mm (Rysunek 4.17.20a) :
Rysunek 4.17.20 Formowanie bocznej pokrywy podwozia — cz. 1
W pewnej odległości od krawędzi pokrywy były do niej przynitowane prostopadłe wzmocnienia. Aby poprawnie wyznaczyć ich położenie (nie mogą przecież nachodzić na “zakładki” krawędzi otworu w owiewce), przyłóż pokrywę do owiewki (Rysunek 4.17.20b). Natnij (Knife) na wewnętrznej powierzchni pokrywy po dwie równoległe linie, biegnące wzdłuż zewnętrznych krawędzi. Zachowaj pomiędzy nimi niewielką odległość — rzędu grubości blachy (Rysunek 4.17.20b).
Następnie wytłocz (Extrude) ściany wewnątrz naciętych krawędzi w kierunku “do wnętrza” pokrywy, na jakieś 1.5 cm (0.15 jednostki Blendera) (Rysunek 4.17.21a). (Najłatwiej jest odsunąć nowe ściany poleceniem Shrink/Fatten).
Na koniec wygładź “wolne” krawędzie wytłoczeń, aby nie miały “kanciastego” zakończenia (wystarczy przesunąć kilka wierzchołków w płaszczyźnie XZ) (Rysunek 4.17.21b). Ze zdjęć wynika, że boczna pokrywa podwozia wzdłuż jednej z krawędzi także miała “zakładkę”, podobną do tych umieszczonych wzdłuż krawędzi otworu owiewki. Wytłocz ją z pionowej ściany wzmocnienia (Rysunek 4.17.21b). (Wcześniej natnij na jego ściance dodatkową, poziomą krawędź, abyś miał obszar o grubości blachy, który można wytłoczyć).
Rysunek 4.17.21 Formowanie bocznej pokrywy podwozia — cz. 2
Boczna pokrywa podwozia jest uformowana, czas zająć się pokrywą główną. Nadaj jej nazwę B.155.L.MainDoor. Formowanie zacznij od drobnej poprawki kształtu: zdjęcia wykazują, że tylna krawędź tej pokrywy miała w P-40 fantazyjne wygięcie. Przesuń więc odpowiednio wierzchołki (Rysunek 4.17.22):
Rysunek 4.17.22 Główna pokrywa podwozia — korekta kształtu tylnej krawędzi
Następnie pogrub tę pokrywę “na grubość blachy” (czyli 2 mm — Rysunek 4.17.23a):
Rysunek 4.17.23 Główna pokrywa podwozia — formowanie wnętrza
Wewnętrzne ścianki pokrywy utworzymy jako oddzielny obiekt (B.157.L.MainDoor), z uproszczonego, prostokątnego obrysu (Rysunek 4.17.23b). To usztywnienie pokrywy miało liczne otwory, tak jak inne żebra. Nie będziemy ich teraz modelować “w siatce” — łatwiej je uzyskać później, za pomocą tekstury. Na ostatecznym obrazie przez te otwory będzie widoczna wewnętrzna powłoka pokrywy.
Po przygotowaniu “zgrubnych” kształtów wewnętrznych usztywnień, nasuń je na pokrywę i wyznacz (Intersection) krawędzie przecięcia z jej powierzchnią (Rysunek 4.17.24a):
Rysunek 4.17.24 Główna pokrywa podwozia — dopasowanie zewnętrznych krawędzi usztywnień
Po wyznaczeniu tych linii wystarczy usunąć z siatki usztywnienia dotychczasowe krawędzie zewnętrzne, podstawiając na ich miejsce krawędzie przecięcia. Rysunek 4.17.24b) pokazuje rezultat operacji. Oczywiście, na koniec przypisz (relacją Parent) usztywnienie (B.157.L.MainDoor) do pokrywy (B.155.L.MainDoor), aby już zawsze były traktowane jako całość.
Pozostaje jeszcze dołączyć pokrywy podwozia do owiewki. Proponuję to zrobić za pomocą pomocniczych obiektów — osi. Tak się szczęśliwie składa, że nie musimy ich ukrywać. W prawdziwej konstrukcji zawiasy pokryw były przymocowane do poszycia i miały kształt cylindra. Ich średnicę można szacować na podstawie zdjęć na 8 do 10 mm. Wstaw więc podłużne “pręty” o tej średnicy tam, gdzie mają się znajdować zawiasy. Osi głównej pokrywy nadaj nazwę B.165.L.Axis, a bocznej — B.170.L.Axis (Rysunek 4.17.25a) :
Rysunek 4.17.25 Zamocowanie pokryw do owiewki za pomocą osi
Teraz przypisz (relacją Parent) pokrywy do osi, a osie — do owiewki. (Owiewki z kolei przypisz do płata, o ile nie zrobiłeś tego wcześniej). W efekcie, obrót każdej osi wokół lokalnej osi Z powoduje realistyczne odchylanie pokryw (Rysunek 4.17.25b). Nie stworzyliśmy jeszcze zespołu goleni podwozia, ale nie zaszkodzi przyłożyć ukończoną owiewkę do rzutu z przodu z rysunków fabrycznych, aby się upewnić, czy wszystko pasuje (Rysunek 4.17.25b). Wygląda na to, że tak. Dolna krawędź owiewki jest nieco ponad obrysem, narysowanym na podstawie zdjęć. To zapewne efekt pochylenia owiewki, wraz z całym płatem, o -1º względem osi X (skrzydło było zamocowane pod tym kątem)
Rysunek 4.17.26 pokazuje ukończoną owiewkę “w pełnej krasie” — z otwartymi pokrywami luku podwozia.
Rysunek 4.17.26 Gotowa owiewka podwozia
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.17.blend (por. str. 22).
Podsumowanie
Owiewka podwozia P-40 jest dobrym przykładem elementu, który na pierwszy rzut oka wydaje się prosty, a potem okazuje się bardzo pracochłonny. Pamiętaj, że podobną ilość pracy może pochłonąć wykonanie wnęki podwozia, wraz z pokrywami, w innych samolotach. Wszystko zależy od tego, czy zaczniesz odwzorowywać szczegóły wewnętrzne, czy nie!
Jeżeli wewnętrzna struktura (wręgi, podłużnice) ma prosty kształt, który nie zależy od kształtu powłoki — można ją wykonać “zgrubnie”, jako oddzielny obiekt złożony z prostych płaszczyzn. Potem wystarczy te płaszczyzny “przyciąć” poleceniem Intersection, by pasował do poszycia (str. 250-251). Z kadłubem nie mogliśmy tak postąpić, bo jego podłużnice biegną równolegle do powierzchni poszycia.
W tej sekcji wykonamy oprofilowanie połączenia kadłuba z usterzeniem pionowym i poziomym. Ten fragment ma skomplikowany kształt (Rysunek 4.18.1a). Nie dość, że jest gładkim połączeniem dwóch prostopadłych stateczników, to jego przód musi być płynną kontynuacją grzbietu kadłuba:
Rysunek 4.18.1 Oprofilowanie krawędzi stateczników i kadłuba
W dodatku całość nie jest symetryczna wzdłuż osi poprzecznej (X — Rysunek 4.18.1b). Tak być musi, gdyż statecznik pionowy był odchylony od osi samolotu o 1,5º (Rysunek 4.18.2):
Rysunek 4.18.2 Przyczyna asymetrii oprofilowania — skręcenie statecznika pionowego
Początkową powłoką, którą zaczniemy przekształcać w owiewkę, jest górny tylny fragment kadłuba (Rysunek 4.18.3a) . Skopiuj go (Shift-D, Duplicate) z oryginalnej siatki i wydziel (Separate) w oddzielny obiekt. Nadaj mu nazwę B.360.TailFillet. Stwórz także kopie (Duplicate) stateczników (to obiekty pomocnicze — po zakończeniu pracy zostaną usunięte). Umieść je wszystkie na nowej warstwie (np.18).
Rysunek 4.18.3 Symetryczne powielenie wierzchołków fragmentu kadłuba i wyznaczenie krawędzi przecięcia z usterzeniem
Aby wyznaczyć krawędzi przenikania stateczników i kadłuba, w siatce B.360.TailFillet i obydwu kopii stateczników “utrwal” modyfikatory Mirror (Mirror:Apply — Rysunek 4.18.3a pokazuje efekt). Teraz wyznacz (dodatkiem Intersection) ich linie przenikania (Rysunek 4.18.3b).
Z uzyskanych krawędzi usuń niepotrzebne wierzchołki (np. te leżące blisko siebie). Następnie porównaj układ pozostawionych punktów z liniami siatki B.360.TailFillet. Wstaw (Loop Cut) w tę siatkę dodatkowe wręgi tam, gdzie wierzchołkowi na krawędzi przecięcia nie odpowiadała żadna linia (Rysunek 4.18.4).
Zaczniemy od formowania tego, co jest w owiewce symetryczne: oprofilowania krawędzi statecznika poziomego. W związku z tym ukryj (H, albo Specials→Hide) na razie krawędź przenikania ze statecznikiem pionowym. Usuń pozostałe wierzchołki z prawej strony siatki i włącz ponownie modyfikator Mirror (względem osi X — Rysunek 4.18.5b).
Natnij (Knife) na siatce nową krawędź, odpowiadającą dolnej krawędzi owiewki (Rysunek 4.18.5a) . Możesz zaraz potem usunąć wierzchołki leżące na zewnątrz tej linii (Rysunek 4.18.5b):
Rysunek 4.18.5 Nacięcie zewnętrznej krawędzi zaokrąglenia wokół statecznika poziomego
Natnij także w siatce wewnętrzną granicę owiewki (Rysunek 4.18.5b). Z kolei zewnętrzna krawędź oprofilowania leży na powierzchni statecznika. Aby ją wyznaczyć, przygotuj dwie pionowe powierzchnie pomocnicze, wygięte tak jak obrys krawędzi owiewki dla górnej i dolnej powierzchni usterzenia (Rysunek 4.18.6a):
Rysunek 4.18.6 Wyznaczenie krawędzi owiewki na stateczniku poziomym
Wyznacz (dodatkiem Intersection) krawędzie przecięcia tych dwóch powierzchni ze statecznikiem (Rysunek 4.18.6b). Potem te powierzchnie pomocnicze są już niepotrzebne i możesz je usunąć.
Połącz górną i dolną krawędź przecięcia w jedną linię. Usuń z niej niepotrzebne wierzchołki (np. jednym z każdej pary położonych blisko siebie punktów) (Rysunek 4.18.7a):
Rysunek 4.18.7 Budowanie zaokrąglenia wokół statecznika poziomego
Usuń ściany z wnętrza obszaru ograniczonego naciętą krawędzią zaokrąglenia statecznika poziomego. Na ich miejsce stwórz nowe, w oparciu o trzy wyznaczone wcześniej krawędzie (Rysunek 4.18.7b). W ten sposób włączysz je w siatkę. Na koniec dodaj (Loop Cut) dodatkową linię wzdłuż krawędzi na stateczniku (Rysunek 4.18.8a):
Rysunek 4.18.8 Profilowanie zaokrąglenia wokół statecznika poziomego
Widzisz już, co uzyskaliśmy? Poprzeczne zaokrąglenie wokół statecznika jest oparte w zasadzie na trzech liniach (dwie dodatkowe w pobliżu krańców to tylko “wyrównanie na śruby”, którymi była przykręcona owiewka). Profil zaokrąglenia zależy przede wszystkim od linii wewnętrznej (oryginalnej linii przecięcia statecznika z kadłubem). Przesuń odrobinę tę linię na zewnątrz, wzdłuż osi X, by uzyskać łagodniejszy profil (Rysunek 4.18.8b).
Podobną techniką wykonamy zaokrąglenie wokół statecznika pionowego. Odsłoń z powrotem (Alt-H) ukryte krawędzie (por. str. 254) i „utrwal” modyfikator Mirror tej siatki (Mirror:Apply) (Rysunek 4.18.9a) :
Rysunek 4.18.9 Pierwsze etapy modelowania zaokrąglenia wokół statecznika poziomego
Powielenie symetrycznych wierzchołków jest już konieczne, bo statecznik pionowy jest umieszczony niesymetrycznie (str. 253). Pamiętaj, aby przed powieleniem wierzchołków owiewki do ostatniego szczegółu ukształtować zaokrąglenie wokół statecznika poziomego. (Jeżeli o czymś zapomnisz, to po tej operacji będziesz miał dwa razy więcej roboty z ewentualnymi poprawkami!).
Podobnie jak w przypadku usterzenia poziomego, do wyznaczenia krawędzi owiewki na stateczniku pionowym używam powierzchni wygiętej tak jak obrys z boku jej górnej krawędzi (Rysunek 4.18.9b). Tym razem obrys był z obydwu stron taki sam, więc można użyć jednej, a nie dwóch powierzchni pomocniczych. Po wyznaczeniu przecięcia tej powierzchni ze statecznikiem uprość tę krawędź, usuwając powielone lub umieszczone blisko siebie wierzchołki (Rysunek 4.18.10a). Usuń także samą powierzchnię pomocniczą.
Rysunek 4.18.10 Budowanie krawędzi wokół statecznika pionowego
Natnij (Knife) na górnej powierzchni owiewki granicę zaokrąglenia wokół statecznika pionowego (Rysunek 4.18.10a). Usuń wierzchołki z jej wnętrza, pozostawiając tylko dwie wyznaczone wcześniej krawędzie (Rysunek 4.18.11):
Rysunek 4.18.11 Budowanie nowych ścian wokół statecznika pionowego
W oparciu o te trzy krawędzie zacznij budować nowe ściany (Rysunek 4.18.11). Potem wstaw (Loop Cut) linię wierzchołków w pobliżu górnej granicy owiewki (to taki “pasek na śruby”) (Rysunek 4.18.12):
Rysunek 4.18.12 Wstawienie dodatkowej linii wierzchołków
Podnieś trochę do góry, wzdłuż osi Z, środkową linię wierzchołków (Rysunek 4.18.13a). W ten sposób sterujesz poprzecznym zaokrągleniem owiewki. Nadaj mu kształt łuku o dość dużym promieniu. (W prawdziwym P-36/40 owiewka zakrywała rząd śrub, którym statecznik pionowy był przymocowany do statecznika poziomego).
Rysunek 4.18.13 Wykończenie kształtu wokół statecznika pionowego
Rysunek 4.18.13b) pokazuje gotową owiewkę. Po zakończeniu pracy usuń kopie statecznika pionowego i poziomego, których używaliśmy do wyznaczenia krawędzi przenikania i dopasowaniu kształtu owiewki. (Stworzyliśmy je na początku tej sekcji — str. 253). Przenieś gotową owiewkę na tę samą warstwę, co tył kadłuba i nadaj jej zewnętrznym brzegom „grubość blachy” — tak jak to robiliśmy z osłoną goleni podwozia w poprzedniej sekcji (por. str. 249).
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.18.blend (por. str. 22).
Podsumowanie
Oprofilowanie połączenia usterzenia z kadłubem było w P-40 bardzo “pogiętym” kawałkiem blachy. Na szczęście w większości konstrukcji z okresu II Wojny Światowej ten fragment ma bardzo podobny kształt. Możesz je wykonać dokładnie w ten sam sposób.
Oprofilowanie połączenia kadłuba i płata było w P-40 całkiem sporym elementem: zajmowało prawie połowę długości samolotu! Inna sprawa, że takie wielkie owiewki były “modne” w pierwszej generacji dolnopłatów, opracowanych w połowie lat 30-tych1. (Rekomendowała je NACA, a P-40 odziedziczył je wraz z całym kadłubem po P-36, którego kształt wyłonił się na deskach kreślarskich jesienią 1934r).
Ze zdjęć wynika, że owiewka płata w P-40 miała w zasadzie okrągły przekrój poprzeczny (Rysunek 4.19.1a). Zmieniał się w nieco mniej regularny tylko w przedniej części, wzdłuż osłony silnika. Dolna powierzchnia owiewki była płaską kontynuacją dolnej powierzchni płata (Rysunek 4.19.1b):
Rysunek 4.19.1 Owiewka połączenia skrzydła z kadłubem
Owiewkę płata moglibyśmy wykonać taką samą techniką jak owiewkę usterzenia: zbudować ściany w oparciu o trzy krawędzie, potem zaokrąglić. Sądzę jednak, że ta metoda nie nadaje się do tak dużych elementów. Trudno za jej pomocą uzyskać regularny, okrągły, przekrój poprzeczny wzdłuż całej długości oprofilowania. Tę owiewkę wykonamy więc metodą dokładniejszą, choć nieco bardziej pracochłonną.
Zaczniemy od wyznaczenia zarysów granic tego elementu: krawędzi na kadłubie i na skrzydle. Linie te będą pełniły rolę pomocniczą, o czym przekonasz się za chwilę.
Zewnętrzną krawędź owiewki wyznaczamy tak, jak krawędzie w poprzedniej sekcji: tworząc pomocniczą powierzchnię, wygiętą tak, jak krawędź oprofilowania w rzucie z góry (Rysunek 4.19.2a).
Rysunek 4.19.2 Powierzchnia pomocnicza, do wyznaczenia krawędzi owiewki na płacie
Zwróć uwagę, że krawędź owiewki “zachodziła” na krawędź osłony goleni podwozia (Rysunek 4.19.2b).
Siatka płata jest na tyle gęsta, że przecięcia jej krawędzi z powierzchnią pomocniczą w zupełności wystarczą do wyznaczenia konturu owiewki. Oznacza to, że podczas użycia dodatku Intersection możesz wyłączyć opcję Use bothmeshes (por. str. 830). Rezultatem będzie linia wierzchołków, należąca do siatki skrzydła (Rysunek 4.19.3a):
Rysunek 4.19.3 Wyznaczenie krawędzi owiewki
Przenieś tę linię do siatki owiewki (B.170.L.WingFillet): wydziel ją (Separate) z siatki płata w tymczasowy obiekt i włącz (Join) do owiewki (Rysunek 4.19.3b).
Wyznaczenie przeciwległej, kadłubowej krawędź owiewki, zacznij od rzutu z boku. Skopiuj wyznaczoną przed chwilą krawędź na płacie, powiększ ją, i „spłaszcz” wzdłuż osi X. Następnie dopasuj położenie wierzchołków tej linii tak, by jak najlepiej odwzorowały krawędź owiewki na kadłubie w rzucie z boku (Rysunek 4.19.4).
Rysunek 4.19.4 Uformowanie obrysu (rzutu z boku) drugiego krańca owiewki
Wyznaczoną krawędź wytłocz wzdłuż osi X, i wyznacz jej linię przecięcia z kadłubem (Rysunek 4.19.5):
Rysunek 4.19.5 Wyznaczenie drugiej krawędzi owiewki
Krawędzie, wyznaczone przed chwilą, będą pełniły rolę linii pomocniczych podczas kształtowania powłoki owiewki. Pozostawimy je na razie jako odrębny obiekt. Powierzchnię oprofilownia zacznij ją od narysowania i umieszczenia we właściwym miejscu jego przekroju poprzecznego — okręgu (Rysunek 4.19.6a) :
Rysunek 4.19.6 Początek formowania właściwej powłoki owiewki
Następnie przekształć ten okrąg w stożek (poprzez wytłoczenie i powiększenie nowej wręgi). Podstawę tego stożka umieść na krawędzi spływu skrzydła (Rysunek 4.19.6b). Jej rozmiar i położenie w płaszczyźnie ZX dobierz tak, by pasowała do założonych krawędzi owiewki (Rysunek 4.19.7a):
Rysunek 4.19.7 Zasada formowania stożka powłoki owiewki
Granica przenikania kadłuba i płata z powierzchnią prostego stożka daleka jest jeszcze od założonego obrysu (Rysunek 4.19.7a). Aby tę sytuację poprawić, wstaw (Loop Cut) w środek powłoki kolejną wręgę, i powtórnie dopasuj do płata i kadłuba jej rozmiar (poprzez zmianę skali i położenia w płaszczyźnie ZX — Rysunek 4.19.7b). Rysunek 4.19.8a) pokazuje powierzchnię, jaką uzyskasz metodą takich kolejnych przybliżeń. Rysunek 4.19.8b) pokazuje wnętrze tej powłoki — widać regularny przebieg linii styku z kadłubem i płatem:
Rysunek 4.19.8 Gotowa powłoka stożkowa, dopasowana do kadłuba i płata
Powierzchnia owiewki mieści się w 1 / 4 powierzchni stożka, który stworzyliśmy. Formowaliśmy go, używając pełnych okręgów aby łatwiej było zmieniać rozmiar pojedynczym sekcjom. (Dla okręgu środek skalowania w trybie Bounding Box leży w jego geometrycznym środku). Teraz jednak należy się pozbyć tego nadmiaru ścian. Usuń niepotrzebne wierzchołki — czyli 3 / 4 powierzchni stożka (Rysunek 4.19.9a):
Rysunek 4.19.9 Przekształcanie stożka w powłokę owiewki
Kolejnym krokiem jest usunięcie ścian leżących poza krawędzią oprofilowania na kadłubie (Rysunek 4.19.9b). Natnij (Knife) linię wzdłuż docelowego przebiegu krawędzi (Rysunek 4.19.9b), a następnie usuń wszystkie leżące ponad nią wierzchołki.
Rysunek 4.19.10 przedstawia rezultat — powłokę, która zaczyna przypominać docelowy kształt owiewki. Na ilustracji są zaznaczone zarysy konturów, stworzone na początku tej sekcji. Pomocniczy kontur na kadłubie dokładnie pokrywa się z krawędzią powłoki. Kontur na skrzydle znajduje się jednak wewnątrz uzyskanej powierzchni (łączy się z nią dopiero na krawędzi spływu — Rysunek 4.19.10). Taki przebieg krawędzi musi wystąpić, jeżeli przekrój poprzeczny ma być okrągły, a krawędź na kadłubie ma kształt jak na planach. Prawa geometrii wykazały różnicę. I co teraz można z tym począć? Pozostaje ocenić, który wariant jest bardziej prawdopodobny. Kontur owiewki jest pewny, bo dobrze udokumentowany na zdjęciach. Okrągły przekrój poprzeczny? — no cóż, wydaje mi się że właśnie taki kształt ma na zdjęciach. Natomiast nie ma żadnego “drugiego świadka”, który potwierdziłby wiarygodność kształtu zewnętrznego konturu owiewki z planów. Stąd zdecydowałem, że kształt przedstawiony na planach jest błędny.
Następną czynnością jest odcięcie niepotrzebnej już na tym etapie dolnej części owiewki. Natnij (Knife) na siatce linię tam, gdzie oprofilowanie miało krawędź spływu (Rysunek 4.19.11a):
Rysunek 4.19.11 Usunięcie niepotrzebnej, dolnej części owiewki
Usuń wierzchołki umieszczone poniżej naciętej linii (Rysunek 4.19.11b).
Przyjrzyjmy się na chwilę wynikowi, zestawiając go z planami (z rzutem z boku — Rysunek 4.19.12). Linią przerywaną podkreśliłem na nim zarys krawędzi owiewki na oryginalnym rysunku. Jak widzisz, jest zdecydowanie poniżej tej, którą uzyskaliśmy w wyniku cięcia powłoki. Nie przejmuj się, to błąd często występujący na planach modelarskich: autor rysując rzut z boku zapomina, że rysowane skrzydło ma wznios!
Rysunek 4.19.12 Porównanie położenia krawędzi owiewki z planami (M. Łukasika)
Uzyskana krawędź wymaga niewielkich poprawek, aby pasowała do rzutu z góry. (Ten obrys mamy zweryfikowany ze zdjęciami, więc możemy mu zaufać). Zrób to, przesuwając poszczególne wierzchołki krawędzi wzdłuż osi X (Rysunek 4.19.13):
Rysunek 4.19.13 Drobne poprawki kształtu krawędzi
Czas zaokrąglić tę krawędź: wytłocz z niej kolejną (Rysunek 4.19.14a). Odsuń ją na niewielką odległość wzdłuż osi Z (dokładniej: na grubość, jaką nadałeś krawędzi spływu skrzydła). Potem obróć te wierzchołki o kilka stopni do dołu, wokół krawędzi spływu płata (Rysunek 4.19.14b) aby uzyskać na końcu owiewki odpowiednie zaokrąglenie:
Rysunek 4.19.14 Wytłoczenie nowych ścian wzdłuż krawędzi
Teraz wytłocz utworzoną przed chwila krawędź wzdłuż osi X (Rysunek 4.19.15a). “Spłaszcz” ją (poprzez zmianę skali do zera wzdłuż osi X — Rysunek 4.19.15b). Przesuń tę nową krawędź do dołu, tak by dotykała dolnej powierzchni płata (Rysunek 4.19.15c) :
Rysunek 4.19.15 Formowanie spodu tylnej części owiewki (1)
Stworzyliśmy w ten sposób dolne ściany owiewki. “Ściśnij” utworzoną linię wierzchołków (poprzez zmianę skali wzdłuż osi Y, względem ostatniego punktu), by krawędź oprofilowania biegła wzdłuż krawędzi spływu płata (Rysunek 4.19.16a). Teraz, aby ściany owiewki przylegały do dolnej powierzchni kadłuba, wyprostuj ostatnią krawędź w linię prostą (zmiana skali do zera wzdłuż osi Z i obrót) i odsuń ją od osi kadłuba (Rysunek 4.19.16b):
Rysunek 4.19.16 Formowanie spodu tylnej części owiewki (2)
Aby zmniejszyć promień zaokrąglenia krawędzi spływu oprofilownia, wstaw (Loop Cut) pomiędzy jej górną i dolną krawędź jeszcze jedną linię wierzchołków (Rysunek 4.19.16c). (Potem przesuń nieco do kadłuba wzdłuż osi X sąsiednie linie). Popraw także wierzchołki przy końcu linii, wyginając krawędź na zewnątrz (Rysunek 4.19.16c). “Nasuń” owiewkę na krawędź spływu płata poprzez wytłoczenie dodatkowej, wąskiej ściany na jego granicy (Rysunek 4.19.17a):
Rysunek 4.19.17 Formowanie spodu tylnej części owiewki (3)
Uformowaliśmy w ten sposób gotową tylną część oprofilowania. Zwróć uwagę, że jej dolna krawędź biegnie wzdłuż kadłuba inaczej niż założona (Rysunek 4.19.17b). Tym niemniej tak to miejsce wyglądało na zdjęciach (fragment rzutu z boku, według którego stworzyliśmy wzorcowy zarys, nie był dokładny).
Pora połączyć uzyskaną powłokę ze stworzonymi wcześniej krawędziami pomocniczymi (Rysunek 4.19.18a). Scalę te dwie siatki i usuń wszystkie wierzchołki krawędzi pomocniczych za wyjątkiem tych biegnących wzdłuż okapotowania silnika. Połącz je ścianami — uformujemy z nich przednią część oprofilowania, która nie miała okrągłego przekroju poprzecznego (Rysunek 4.19.18b):
Rysunek 4.19.18 Formowanie przedniej części owiewki (1)
Zacznij “zaokrąglać” ten odcinek powłoki. Wstaw (Loop Cut) w pobliżu zewnętrznej krawędzi nową linię wierzchołków (Rysunek 4.19.19a). Przysuń ją do kadłuba i spłaszcz (nie do końca — Rysunek 4.19.19b). Potem dopasuj do obrysu z góry, poprzez zmianę skali wzdłuż osi Y (Rysunek 4.19.19c):
Rysunek 4.19.19 Wstawianie nowej linii wierzchołków w owiewkę
Wstaw w ten sposób trzy kolejne linie (Rysunek 4.19.20a). Potem złącz ten fragment z resztą owiewki (Rysunek 4.19.20b):
Rysunek 4.19.20 Połączenie przedniej i tylnej części owiewki
Pozostaje jeszcze wstawić dodatkowy wierzchołek w okolicy połączenia z owiewką goleni podwozia. Należy uformować w tym miejscu narożnik, aby krzywizna oprofilowania ułożyła się wokół wybrzuszenia owiewki (Rysunek 4.19.21a):
Rysunek 4.19.21 Ostatnie szczegóły wykończenia owiewki
Na zakończenie pogrub wszystkie zewnętrzne krawędzie elementu “o grubość blachy” (2mm — czyli 0.02 jedn. Blendera) (Rysunek 4.19.21b). To nada bardziej realistyczny wygląd połączeniu z powierzchniami płata i kadłuba.
Rysunek 4.19.22 pokazuje rezultat — ukończoną owiewkę:
Rysunek 4.19.22 Gotowa owiewka płata
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.19.blend (por. str. 22).
Podsumowanie
Oprofilowanie połączenia płata i kadłuba P-40 to typowa konstrukcja z połowy lat 30-tych XXw, zgodna z rekomendacją NACA: duża owiewka o okrągłym przekroju, którego promień wzrasta w kierunku krawędzi spływu;
Ze względu na rozmiar, taką owiewkę płata dobrze jest uformować w bardziej dokładny (i, niestety, pracochłonny) sposób, niż owiewkę usterzenia. Różnica polega na wstawieniu w narożnik płata i kadłuba wygiętego stożka. Z tej powłoki wycinasz potem fragment, tworząc powierzchnię owiewki;
Zbliżamy się do końca formowania “blach”, z których był zbudowany nasz samolot. Umieściłem tu opis tworzenia kilku mniejszych elementów, którym nie warto było poświęcać odrębnej sekcji, a które jednak powinny być opisane w tym rozdziale. Jakoś tak się składa, że wszystkie znajdują się na spodzie samolotu.
Zaczniemy od chłodnic cieczy. W głębi kanałów wlotowych P-40 widać było ich powierzchnie czołowe. Warto więc je wykonać, aby model oglądany z przodu nie straszył nierealistyczną dziurą. Z rysunków fabrycznych i zdjęć wynika, że chłodnice wszystkich wersji z silnikiem Allison miały prosty, cylindryczny kształt. Dwie większe, umieszczone po bokach, chłodziły glikol, a mniejsza, centralna — olej. Okręgi, odpowiadające czołowym ścianom chłodnic, przygotowaliśmy już przy okazji formowania osłony spodu silnika (str. 200). Wyciągnijmy je z warstwy części pomocniczych (Rysunek 4.20.1a):
Rysunek 4.20.1 Utworzenie zespołu chłodnic cieczy
Utwórz nowy, zamknięty cylinder o średnicy odpowiadającej jednemu z okręgów. Powinien składać się z 8 wierzchołków. Włącz jego wygładzenie (Subsurf), aby przypominał walec. Chłodnice cieczy i glikolu różniły się tylko rozmiarem. Utwórz pozostałe chłodnice, stosując tę samą siatkę (Duplicate Linked) — (Rysunek 4.20.1b). Możesz ją uprościć, włączając symetrie (modyfikator Mirror) wzdłuż osi X i Z (Rysunek 4.20.1c). Na ścianie czołowej wstaw (Loop Cut) dodatkową linię wierzchołków i zmień ją w ostrą krawędź. To zarys granicy czynnego (“przelotowego”) obszaru chłodnicy. Sądzę, że przyda się przy nakładaniu tekstur.
Rysunek 4.20.2 pokazuje formowanie kanału wlotowego powietrza do chłodnicy. Zacznij od wydzielenia krawędzi wlotu i stworzenia okręgu wokół czoła chłodnicy (Rysunek 4.20.2a). Okrąg powinien mieć taką samą liczbę wierzchołków co wlot. Następnie połącz te krawędzie ścianami. Potem w środek wstaw (Loop Cut) dodatkowe wręgi, i przesuń je, nadając kanałom wygięcie (Rysunek 4.20.2b):
Rysunek 4.20.2 Kanał doprowadzający powietrze do chłodnic
Po uformowaniu kanałów wlotowych wykonaj także wewnętrzne ściany wokół wylotu powietrza z chłodnic. Tu już konstruktorzy nie musieli robić oddzielnych kanałów (powietrze i tak wylatywało kompletnie zaburzone). Zacznij od wydzielenia z siatki okapotowania ścian bocznych (Rysunek 4.20.3a). Potem dodaj do tej siatki okręgi wokół chodnic. Połącz je ścianami tworząc wręgę (Rysunek 4.20.3b):
Rysunek 4.20.3 Wewnętrzna powierzchnia wylotu powietrza z chłodnic cieczy
W środku wylotu powietrza była umieszczona dodatkowa, centralna powierzchnia. Miała dość złożony kształt, który teraz uformujemy. Zaczniemy od krawędzi, którą pozostawiliśmy podczas formowania kadłuba (str. 181). Wydziel ją w nowy obiekt (Rysunek 4.20.4a):
Rysunek 4.20.4 Centralna powierzchnia wylotu powietrza — formowanie
Następnie wytłocz z tej krawędzi powierzchnię i zmień ją w coś w rodzaju stożka (Rysunek 4.20.4b). Dodaj także nową linię wierzchołków: fragment okręgu, otaczającego chłodnicę glikolu. Połącz ją z resztą siatki ścianami, tworząc coś w rodzaju drugiego stożka (Rysunek 4.20.5a):
Rysunek 4.20.5 Centralna powierzchnia wylotu powietrza — formowanie
Na koniec wstaw (Loop Cut) w tę siatkę kolejna wręgę, nadając jej odpowiednią krzywiznę (Rysunek 4.20.5b).
W P-36 i P40 powierzchnia, która zaczyna się w wylocie powietrza z chłodnicy, ma swoje przedłużenie aż do krawędzi spływu płata. Co kryło się pod spodem? Niedużo — przewody paliwowe oraz instalacja awaryjnego zrzutu paliwa1. Formowanie dalszej części tej osłony zacznij od krawędzi, wydzielonej (Separate) z jej przedniej części (Rysunek 4.20.6a). Wytłocz potem tę linię w powłokę (Rysunek 4.20.6b):
Rysunek 4.20.6 Osłona awaryjnego zrzutu paliwa
Każda wręga tej osłony jest fragmentem łuku. Początkowy kat rozwarcia tych łuków wynosił ok. 120º. Zdjęcia i zarys w rzucie z dołu wskazują, że przekrój tej powłoki zmieniał się wzdłuż cięciwy profilu skrzydła i ostatnie wręgi miały już przekrój złożony z połówek okręgów (kąt rozwarcia ok. 180º). Płynne przejście pomiędzy tymi przekrojami najłatwiej jest osiągnąć, tworząc najpierw “stożek”, łączący wręgę początkową i końcową. Potem wystarczy wstawiać (Loop Cut) kolejne wręgi w środek takiej powłoki. Po wstawieniu przesuwaj je od razu wzdłuż osi Z, aby uzyskać właściwy kontur osłony w rzucie z boku (Rysunek 4.20.6b, Rysunek 4.20.7).
Rysunek 4.20.7 Dopasowanie osłony do zadanego konturu
Nie zapomnij dodaniu zaokrąglenia na czołowej części osłony, która zaczynała się od szczeliny (Rysunek 4.20.6b, Rysunek 4.20.7)2.
Ze zdjęć wynika, że końcówka osłony była oddzielną częścią. Odseparuj ją więc od reszty powłoki w nowy obiekt (Rysunek 4.20.8a). Potem pozostaje wytłoczyć z krawędzi bocznych “zakładki”, za pomocą których osłona była przymocowana do dolnej powierzchni płata (Rysunek 4.20.8a,b):
Rysunek 4.20.8 Podział osłony i wytłoczenie bocznej “zakładki”
Ostatnim elementem zespołu chłodnicy są ruchome klapy, sterujące natężeniem przepływu powietrza. Zaczniemy od wytłoczenia wręgi, do której były przymocowane wewnętrzne ściany wylotu (Rysunek 4.20.9a):
Rysunek 4.20.9 Przygotowanie do montażu klap — wzmocnienie krawędzi wylotu powietrza
Może to nie będzie specjalnie widoczne, ale nie mogłem się powstrzymać, by nie spłaszczyć wewnętrznych krawędzi tej wręgi wzdłuż osi obrotu klap (Rysunek 4.20.9b). (Takie spłaszczenie jest widoczne na zdjęciach).
Same klapy zacznij od wstępnej przymiarki — ich kształt wyznaczy „łuk” złożony z czterech odcinków, wytłoczony na odpowiednią długość (Rysunek 4.20.10a) :
Rysunek 4.20.10 Wstępna “przymiarka” do rozłożenia klap wokół wylotu powietrza
Aby nadać tym klapom grubość, dodaj do siatki drugą, wewnętrzną powłokę, oraz włącz jej wygładzanie (modyfikatorem Subsurf — Rysunek 4.20.10b).
Utrwal wygładzenie (Subsurf:Apply) powłoki klap, i pozostaw z niej tylko fragment odpowiadający pojedynczej klapie — 4 segmenty (Rysunek 4.20.11a). Na razie usuń wewnętrzną powłokę i użyj polecenia Solidify, upraszczając kształt obiektu do wygiętego kawałka blachy, o stałej grubości. Umieść go centralnie, obracając o połowę kąta rozwarcia (Rysunek 4.20.11a). (Na chwilę będzie wyrównana do globalnego układu współrzędnych). Przypisz jej nowy środek (Object→Transform→Origin to 3D Cursor— por. str. 835) tam, gdzie wystąpi oś obrotu (Rysunek 4.20.11b):
Rysunek 4.20.11 Wydzielenie i uformowanie pojedynczej klapy
Po zmianie środka obróć klapę wokół środka pierścienia wylotu z chłodnicy tak, by znalazła się w prawidłowym położeniu3. Zdjęcia pokazują pomiędzy rozchylonymi klapami dodatkowe “uszczelnienia”. Zamodeluj je jako dodatkową, lekko wygiętą płytkę, ustawioną równolegle do bocznej krawędzi klapy. “Przymocuj” ją do niej relacją Parent. Umieść także (Duplicate Linked) z boku drugą klapę (Rysunek 4.20.12a). Obróć płytkę uszczelniającą wokół lokalnej osi Y, aby przylegała płasko do jej powierzchni (Rysunek 4.20.12a).
Do tej pory modelowaliśmy klapę w pozycji zamkniętej (także w tej pozycji pozostawiały trochę przestrzeni na wylot powietrza). Czas sprawdzić, jak taki zespół się porusza.
Rysunek 4.20.12 Sprawdzanie działania klap jako zespołu (zamykanie i otwieranie)
Gdy obrócisz obydwie klapy wokół ich lokalnych osi X o 35º, ustawisz cały zespół w pozycji otwartej (Rysunek 4.20.12b). W tej pozycji sprawdź, czy przednie krawędzie klap nie przenikają powłoki osłony chłodnicy. Jeżeli tak jest — odsuń obydwie klapy odrobinę do tyłu. (Pomiędzy przednimi krawędziami klap i osłoną występuje szczelina szerokości 3-4 mm).
Gdy klapy są w pozycji otwartej, przyjrzyj się płytce uszczelniającej: w tym położeniu powstaje pomiędzy nią i powierzchnią klapy widoczna szczelina (Rysunek 4.20.13a):
Rysunek 4.20.13 Sprawdzanie zespołu klap w położeniu otwartym
Rysunek 4.20.13b) pokazuje, widok wzdłuż krawędzi klapy. Widać na nim, że płytka jest nieco zadarta do góry. Wystarczy ją obrócić wokół jej lokalnej osi Y o 6º, by to skorygować (Rysunek 4.20.13c). Na razie pozostaw jednak tę szczelinę. W dalszych rozdziałach opiszę, jak “zmechanizować” model. Wtedy zmusimy te płytki (za pomocą tzw. ograniczeń — Constrains) by same się dopasowywały w ten sposób (por. str. 561).
Rysunek 4.20.14 Klapy — wykończenie
Praca nad zespołem klap zbliża się do zakończenia. Dodaj jeszcze krawędź wewnątrz płytki uszczelniającej, i wydłuż ją wzdłuż lokalnej osi Y. To nada płytce lekkie wygięcie (wg zdjęć miała taki właśnie kształt) (Rysunek 4.20.14a).
Wytłocz (Extrude) z wewnętrznych powierzchni klap “kieszeń”, w którą chowały się płytki uszczelniające (Rysunek 4.20.14b). Zwróć uwagę, że górne powierzchnie tej “kieszeni” były płaskie. (Spłaszcz je po wytłoczeniu, zmieniając skalę wzdłuż lokalnej osi Z do zera). Ustaw je na koniec tak, by przednia krawędź “kieszeni” biegła wzdłuż osi obrotu klapy.
Dodaj (Duplicate Linked) kolejne dwie klapy z płytkami. Umieść je na właściwych miejscach (obracając wokół środka pierścienia klap). Rysunek 4.20.15 pokazuje gotowy zespół regulujący przepływ powietrza w chłodnicach
Wnęka podwozia głównego nie miała w P-40 żadnej pokrywy, poza samym kołem. Być może producent umieszczał w niej tekstylną (skórzaną?) wykładzinę, zabezpieczającą przed przenikaniem zanieczyszczeń do wnętrza płata. (Widać ją w niektórych odrestaurowanych egzemplarzach tego samolotu.) Sądzę jednak, że jeżeli nawet takie wykładziny były stosowane, to w warunkach polowych szybko szły w strzępy. Stąd należy zamodelować fragment wewnętrznej struktury płata, tworzący komorę koła głównego. Najszybciej można go uzyskać wytłaczając wzdłuż osi Z kontur komory w rzucie z góry. Potem wyznacz krawędź przecięcia takiej powłoki ze skrzydłem (Rysunek 4.20.16a):
Rysunek 4.20.16 Wnęka koła podwozia
Przyznam się, że nie wytrzymałem, i wstawiłem wzdłuż ścian wnęki podwozia podłużnice, widoczne na rysunkach fabrycznych i zdjęciach (Rysunek 4.20.16b). Wiem dobrze, że tych dziesięć ceówek pod górnym poszyciem płata ma nikłe szanse pojawić się na renderze. (W rzucie na ziemi będą niewidoczne, a w powietrzu są zasłonięte schowanym kołem.) To po prostu moja natura modelarza redukcyjnego kazała mi je wykonać.
Skoro już odtwarzamy takie szczegóły, to chyba jednak warto zabrać się za wnętrze klap skrzydła. Początkowo (por. str. 145) sądziłem, że to dużo roboty, a klapy były zamykane wkrótce po wylądowaniu samolotu, więc i tak nigdy nie było widać ich wnętrza. Jednak przy okazji tego samego “uszczegóławiania”, które kazało mi wypełnić podłużnicami wnękę podwozia, zdecydowałem się wydzielić i zamodelować ten zespół. Pocieszam się tym, że nie muszę jednak stosować do ich żeber wygładzenia powierzchniami podziałowymi. Elementy klap były w P-40 “kanciaste”, i można je uformować za pomocą stosunkowo niewielkiej liczby ścian. Otwory, występujące w żebrach, naniesiemy później za pomocą tekstur.
Pracę nad klapą zacznij od wydzielenia (Separate) jej powierzchni z reszty płata (Rysunek 4.20.17a). Wnękę w skrzydle uformuj jako oddzielny obiekt, umieszczony na innej warstwie. (Aby można było szybko wyłączyć ja z renderu, gdy nie jest potrzebna). Rysunek 4.20.17b pokazuje początkowy etap formowania wnęki klapy: to klin z załamaną powierzchnią wewnętrzną. Natnij na tej powłoce (Loop Cut) linie żeber, które za chwilę utworzymy:
Rysunek 4.20.17 Początek formowania klap skrzydła
Dalszym krokiem w formowaniu wnęki klapy jest usunięcie spomiędzy linii żeber dotychczasowych, poziomych ścian wewnętrznych. Na ich miejsce utwórz, w oparciu o te same wierzchołki, pionowe ściany (Rysunek 4.20.18a):
Rysunek 4.20.18 Formowanie wnęki klap skrzydła
Stwórz tylko prawe ściany żeber, aby wyglądały jak blacha z wygiętymi zakładkami (Rysunek 4.20.18b). W tym przypadku te elementy są za mało widoczne, by opłacało się nadać im “grubość blachy”. Dodaj także (kierując się liniami nitów, przedstawionymi na planach) trzy podłużnice, biegnące wzdłuż górnego poszycia płata (Rysunek 4.20.18a). To oddzielne ściany, nie powiązane z resztą siatki.
Uformuj na powierzchni klapy uskok, “omijający” wzmocnienie górnej powierzchni płata (chodzi o wzmocnienie pokazywane przez Rysunek 4.20.18). Następnie skopiuj tę obiekt (Duplicate, aby miał własną kopię siatki), i odsuń go od powierzchni zewnętrznej “na grubość blachy” (jakieś 2 mm). Rysunek 4.20.19a pokazuje obydwie powierzchnie (wewnętrzna jest szara, a zewnętrzna — czerwona). Przypisz powierzchnię wewnętrzną do oddzielnej warstwy — tej samej, do której należy ukończona przed chwilą wnęka klapy skrzydła4.
Ze zdjęć wynika, że blacha na krawędziach klapy była zawinięta (zapewne wokół jakiegoś płaskiego wzmocnienia). Z tego powodu warto pozostawić w siatce powierzchni zewnętrznej wygładzanie (modyfikator Subsurf). Zamodeluj odpowiednie zgrubienia wzdłuż przedniej i tylnej krawędzi zewnętrznej powierzchni klapy (Rysunek 4.20.19b):
Rysunek 4.20.19 Formowanie poszycia klapy
Boczne krawędzie klapy pozostaw bez “zawinięcia”, gdyż były zamknięte pełnymi żebrami.
Podłużnice, biegnące wzdłuż klapy, wytłocz z powierzchni wewnętrznej (Rysunek 4.20.20). Zdjęcia pokazują, że klapa miała przynitowany jeden większy ceownik, i jeden mniejszy kątownik:
Rysunek 4.20.20 Podłużnice klapy | Rysunek 4.20.21 Pojedyncze żebro klapy |
Żebra klapy można by wykonać w podobny sposób, co żebra jej wnęki — poprzez wytłoczenie nacięć wykonanych w powłoce wewnętrznej. Proponuję jednak wykonać je alternatywną metodą: z jednego, wzorcowego obiektu. (Będziesz miał okazję ocenić, który sposób jest lepszy). Utwórz wzorcowe żebro w typowym położeniu — gdzieś w środku klapy. Zorientuj jego siatkę tak w przestrzeni, by środek znajdował się na przedniej krawędzi klapy, i lokalna oś X biegła wzdłuż tej krawędzi (Rysunek 4.20.21).
Następnie powiel wzorcowe żebro (Duplicate Linked) we wszystkie pozostałe miejsca. Korzystaj przy tym z możliwości przesunięcia kopii wzdłuż lokalnej osi X. Różnice rozmiarów, występujące np. tam, gdzie żebro jest ustawione ukośnie, skompensuj zmianą skali obiektu wzdłuż lokalnej osi Y.
Rysunek 4.20.22 Szkielet klapy
Rysunek 4.20.22 pokazuje powielone żebra, tworzące szkielet klapy. Trudno jednoznacznie ocenić, która metoda była bardziej pracochłonna. Podczas tworzenia żeber we wnęce (str. 273) najwięcej czasu zajęło nacinanie (Loop Cut) ich zarysów na powierzchni (każde z nich to dwie linie, umieszczone w stałej odległości). Potem było także trochę klikania przy reorganizacji ścian. Najwięcej czasu podczas tworzenia żeber jako oddzielnych obiektów zajęła ich dokładna orientacja w przestrzeni. Powierzchnia klapy jest nieco skręcona (w wyniku różnic w grubości profilu u nasady i w środku płata). Spowodowało to konieczność indywidualnego obrócenia każdego żebra o pewien niewielki kąt. Ogólny czas wykonania w każdym przypadku był podobny i wynosił kilkadziesiąt minut.
Rysunek 4.20.23 pokazuje ukończony zespół. Klapy zostały “przymocowane” do płata poprzez oś (B.115.L.Axis), która tu “udaje” zgrubienie oryginalnych zawiasów:
Rysunek 4.20.23 Uformowana klapa
Ostatnim szczegółem, który pozostał do uformowania, to zespół komory kółka ogonowego. Sam otwór i ruchomą pokrywę ukształtowaliśmy podczas formowania kadłuba (str. 186). Teraz nadaj tej pokrywie “grubość blachy” (2 mm) . Wewnętrzne usztywnienie wykonaj tak samo, jak osłony podwozia głównego (str. 250) — uformuj je jako niezależny obiekt, a potem przetnij powierzchnią pokrywy (Rysunek 4.20.24a).
Rysunek 4.20.24 Pokrywa i wnęka kółka ogonowego
Wnęka kółka ogonowego nie miała żadnych dodatkowych ścian. Na niektórych zdjęciach widać osłaniający ją tekstylny (skórzany?) pokrowiec. Podtrzymując jednak założenie o szybkim zniszczeniu tego rodzaju osłon, musimy zamodelować całe wnętrze tylnej części kadłuba. Jeżeli zrobisz to taką samą metodą, jak wnętrze kabiny (str. 236), to umiarkowanym wysiłkiem uzyskasz całkiem realistyczny szkielet (Rysunek 4.20.24b).
Utwórz symetryczną kopię (Duplicate Linked) pokrywy kółka ogonowego, i przymocuj je kadłuba dwoma osiami (Rysunek 4.20.25). Podobnie jak pozostałe osie, są to dwa cienkie walce, „udające” zgrubienie zawiasów, użytych w prawdziwej konstrukcji.
Wykonanie wnętrza całego obszaru ogona ma jeszcze dodatkową zaletę — przez wycięcia w sterze kierunku widać realistyczną konstrukcję (Rysunek 4.20.26). Te otwory były w P-40 na tyle duże, że w pewnych ujęciach “czarna dziura” w tym miejscu mogłaby razić!
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.20.blend (por. str. 22).
Podsumowanie
Do modelu warto wstawiać chłodnice (str. 266) — ich powierzchnie czołowe mogą być widoczne w głębi kanałów wlotowych.
Klapy wylotu chłodnicy w P-40 (str. 269) wykonane zostały tak samo, jak typowe klapy osłon silników gwiazdowych (np. w P-47 Thunderbolt, A6M2 Zero, i innych). Klapy takie mają zazwyczaj prostszą konstrukcję — bez płytek “uszczelniających”.
Jeżeli w swojej scenie zamierzasz przedstawić model na ziemi — zazwyczaj trzeba wykonać wnętrze wnęk podwozia, przynajmniej głównego (str. 272). Rzadko kiedy znajdziesz jego szczegóły na planach — pamiętaj o wcześniejszym zebraniu odpowiednich zdjęć!
Uformowanie klapy skrzydłowych typu “krokodylowego” (jak w P-40) wymaga odtworzenia wewnętrznych szkieletów samej klapy i jej wnęki w płacie (str. 273). Warto je wykonać, jeżeli planujemy scenę z wychylonymi klapami (lub gdy cierpimy na typowo modelarską obsesję szczegółów).
Porównaliśmy (przy okazji formowania klap skrzydłowych) dwie metody odwzorowania żeber szkieletu:
- poprzez wytłoczenie z powierzchni (str. 272);
- poprzez powielenie pojedynczego żebra (str. 274);
Czas wykonania w każdej z metod był podobny, ale metoda wytłoczenia sprawdzi się nawet dla zmiennych kształtów (np. wytłoczenia wręg w ogonie samolotu). W takim przypadku każde żebro ma inny kształt i po prostu nie można zastosować metody powielenia takiej samej siatki.
Pokrywę kółka ogonowego wykonujemy takimi samymi metodami, jak pokrywy goleni podwozia głównego (str. 250);
Wewnętrzną strukturę ogona samolotu — widoczną przez otwór kółka ogonowego — wykonujemy w taki sam sposób, jak wewnętrzna strukturę ścian kabiny (str. 236);
Po gwałtownym rozwoju modelu, który miał miejsce w tym rozdziale, pora trochę uporządkować rezultat. Na przykład — coś trzeba zrobić z różnymi pomocniczymi powłokami, np. wzorcem kształtu kadłuba czy okapotowania silnika (por. str. 206) (Rysunek 4.21.1):
Rysunek 4.21.1 Elementy wzorcowe, pozostałe po formowaniu modelu
Wątpię, aby były nadal potrzebne, ale zdrowa zapobiegawczość nakazuje je “upchnąć w jakiś zapomniany kąt”. Chodzi o miejsce, w którym te wzorce nie przeszkadzałyby w niczym, a w razie czego byłyby “pod ręką”. Coś takiego można w Blenderze zrobić. Dla ich przechowania proponuję utworzyć w naszym pliku oddzielną scenę, pełniącą rolę składziku na “różne różności” — Tools (jak to zrobić — patrz str. 792) . Przypisz do niej (poleceniem Objects→Make Links→To Scene...) wszystkie pomocnicze elementy, a potem je usuń z aktualnej sceny. (Scenę Tools wykorzystywałem już w plikach *.blend związanych z wcześniejszymi sekcjami tego rozdziału).
W czasie prac często umieszczaliśmy różne obiekty na różnych warstwach. Teraz przyszedł czas, aby ustalić ich docelowe miejsce. Pamiętaj, że włączenie/wyłączenie warstwy nie jest jedynym sposobem sterowania widocznością obiektów. Możesz także używać do tego celu polecenia Hide Selected (H, patrz str. 836). Rysunek 4.21.2 przedstawia propozycję przypisania elementów modelu do poszczególnych warstw:
Rysunek 4.21.2 Propozycja rozłożenia części modelu na poszczególne warstwy
Aby zmieścić wszystkie opisy na ilustracji, obróciłem symbole warstw o 90º. Zwróć uwagę, że nie wszystkie miejsca są zajęte. To rezerwa na przyszłość: podczas bieżącej pracy zawsze warto mieć do dyspozycji jedną lub dwie puste warstwy. Wymieniam tu także trochę elementów, których jeszcze w modelu nie ma (np. podwozie). Takie zestawienie zbiorcze to dobra okazja, by wyliczyć wszystkie planowane zespoły modelu. Elementy, które jeszcze nie są wykonane, oznaczyłem pochyłą czcionką.
Przejrzyjmy zawartość kolejnych warstw, abyś mógł się upewnić co dokładnie zawierają. Przy okazji uzupełnimy brakujące przypisania hierarchiczne. Gdybyś zauważył, że Twojej wersji tego modelu jakiś obiekt jest na innej warstwie — przypisz go teraz do tej, którą podaje Rysunek 4.21.2.
Na warstwie 1 znajduje się podstawowy zespół skrzydeł: płaty, lotki, klapy, oraz osłony goleni podwozia (Rysunek 4.21.3):
Rysunek 4.21.3 Warstwa 1: Skrzydło, lotki, klapy i owiewki podwozia
Do siatki skrzydła dodaj ostatni szczegół: kołnierz, biegnący wzdłuż pierwszego żebra (Rysunek 4.21.3a). Choć jest mało widoczny, będziemy go potrzebować we wnętrzu kabiny. (W P-40 górna powierzchnia płata była jednocześnie jej podłogą). Na zdjęciach widać na niej także fragment kołnierza, łączącego płaty. Konstruktorzy przymocowali do niego różne części wyposażenia, jak np. drążek sterowy.
Stwórz teraz prawe skrzydło — poprzez skopiowanie (Duplicate Linked) lewego. Gdy wykonasz to jedną operacją, kopiując płat wraz ze wszystkimi podzespołami, zachowasz wewnętrzną hierarchię tych obiektów. Podczas kopiowania wystarczy zmienić skalę wzdłuż lokalnej osi X na -1, aby płat znalazł się po prawej stronie. Nowemu obiektowi nadaj nazwę B.100.R.Wing. Zmień jeszcze jego obrót wokół osi Y z -6º na +6º, by skrzydło uzyskało prawidłowy wznios. Potem pozostaje poprawić nazwy jego elementów, zmieniając w nich człon “.L” na “.R”.
Na warstwie 11 umieść szczegóły, które mogą być przydatne w jakiejś scenie “na lotnisku”, z wysuniętym podwoziem i otwartymi klapami (Rysunek 4.21.4):
Rysunek 4.21.4 Warstwa 11: wnętrze klap oraz komór podwozia głównego
Początkowo na warstwie 11 chciałem także umieścić wnętrza komór klap (B.101.x.FlapBay). Gdy okazało się, że fragmenty tych obiektów wystają spod uskoku klap, przeniosłem je na warstwę 1.
Na warstwie 2 umieść podstawowe elementy kadłuba, oraz różne owiewki i osłony (Rysunek 4.21.5):
Rysunek 4.21.5 Warstwa 2: środkowa i tylna część kadłuba, wraz z owiewkami
Warstwa 12 zawiera wnętrza wybranych fragmentów kadłuba (kabiny pilota i kółka ogonowego). Powłoki wewnętrzne mają zawsze końcówkę .001, podłużnice — .002, a wręgi — .003 (Rysunek 4.21.6):
Rysunek 4.21.6 Warstwa 12: Wewnętrze kadłuba
Warstwa 3 zawiera elementy okapotowania silnika (Rysunek 4.21.7), a warstwa 16 — zespół śmigła (Rysunek 4.21.8). Zwróć uwagę, że kołpak jest przypisany do obydwu warstw (by nie wystawały “gołe” początki łopat).
Rysunek 4.21.7 Warstwa 3: okapotowanie silnika | Rysunek 4.21.8 Warstwa 16: śmigło |
Warstwa 13 zawiera elementy wewnętrzne: nkm Browing, chłodnice cieczy, ich tunele wlotowe i wylotowe (Rysunek 4.21.9):
Rysunek 4.21.9 Warstwa 13: wnętrze zespołu chłodnic, karabiny zamontowane w kadłubie
Warstwa 4 to ramki kabiny pilota (Rysunek 4.21.10), a warstwa 14 to jej oszklenie (Rysunek 4.21.11):
Rysunek 4.21.10 Warstwa 4: ramki osłony kabiny | Rysunek 4.21.11 Warstwa 14: oszklenie |
Oszklenie kabiny jest najwygodniej umieścić na oddzielnej warstwie, gdyż bardzo często potrzeba przełączać jego widoczność. Ramki kabiny są wydzielone po trosze także ze względu na stopień ich komplikacji. Na warstwie 4 umieścimy również elementy wyposażenia kabiny widoczne podczas lotu, jak zagłówek na płycie pancernej czy szkło odblaskowe celownika.
Usterzenie umieść na warstwie 6 (Rysunek 4.21.12). Na razie składa się tylko z podstawowych elementów. Statecznik pionowy jest “przymocowany” (relacją Parent) do statecznika poziomego. (W prawdziwym samolocie był do niego przykręcony dwoma rzędami śrub, ciągnącymi się pod owiewką.) W dalszych rozdziałach na tej warstwie przybędą kolejne szczegóły, jak popychacze trymerów, światła pozycyjne, czy okucia mocujące osie sterów do dźwigarów.
Jeżeli chodzi o najbardziej ogólną hierarchię, to statecznik poziomy (B.200.L.Stabilizer — podstawa całego usterzenia) przypisz do kadłuba (B.300.Fuselage). Do tego samego obiektu przypisz także obydwa płaty (w końcu skrzydła są dwa, a kadłub — tylko jeden). W ten sposób “początkiem” hierarchii zespołów samolotu zostanie obiekt B.300.Fuselage (Rysunek 4.21.13).
Rysunek 4.21.14 przedstawia postać, jaką osiągnął nasz model na tym etapie prac. Zaczyna już przypominać pierwowzór!
Rysunek 4.21.14 Wygląd ogólny modelu
I moglibyśmy na tym ten rozdział zakończyć, gdyby nie moja mania ciągłego poszukiwania materiałów w Internecie. Właśnie (tzn. w 2009r, gdy budowałem ten model) znalazłem nowość o P-40. To artykuł "Long Nose Hawks" (z www.hyperscale.com). Jego autor — Hume Bates — podaje wiele wymiarów P-40B, zmierzonych "z natury" na egzemplarzu P-40C z Naval Air Museum (w Pensacola, o ile się nie mylę). Okazuje się, że rozstaw luf karabinów kadłubowych wynosił 19 1 / 2 ", czyli 49.5 cm. To po 4 cm z każdej strony więcej, niż przyjąłem (i tak rozstawiając je szerzej niż na planach!) (Rysunek 4.21.15):
Różnica w położeniu jest zbyt duża, by dało się jakoś “przesunąć” osłonę karabinu po powierzchni pokrywy. W dodatku górny panel okapotowania silnika powinien być szerszy, aby zmieścić nieco większy chwyt powietrza do sprężarki.
To już oznacza nie kosmetyczną przeróbkę, a konieczność zbudowanie jeszcze raz górnej części okapotowania silnika (por. str. 204)! Całe szczęście, że “wymęczony” na podstawie zdjęć szkielet wiatrochronu przeszedł tę próbę zwycięsko — jest zgodny. Podobnie grzbiet kadłuba pod wiatrochronem. (Jego kształt jest efektem uzgadnianie ze zdjęciami linii przenikania wiatrochronu z kadłubem).
Nie miej złudzeń — jeżeli chcesz wykonać coś możliwie dokładnie, takie sytuacje będą się powtarzać. Postęp prac nad dobrym modelem czy planami można porównać do ruchu po spirali. Co jakiś czas musisz się cofnąć, by poprawić coś, co już zrobiłeś. Potem wykonasz nowy etap pracy, do którego najprawdopodobniej powrócisz po jakimś czasie, by znów coś poprawić. I tak dalej, dopóki nie uznasz modelu za skończony.
Prędzej czy później zawsze znajdziesz lepsze rysunki lub zdjęcia, z których wynikną jakieś rewelacje na temat samolotu, który robisz. Możesz je uwzględnić albo zignorować. Jak sądzisz, którą z tych dwóch możliwości teraz wybiorę? Tak, nie myliłeś się: przerabiamy model!
Artykuł Hume Batesa przytacza trochę nowych zdjęć z odbudowy egzemplarza P-40C. Wśród nich jest wyraźne ujęcie ściany ogniowej kadłuba. Jej kształt różni się od kształtu w naszym modelu. Zdecydowałem się to także poprawić. W efekcie zmianie uległ kształt poszycia od wiatrochronu kabiny do kołpaka śmigła. W rzutach z boku i z góry kontury samolotu są bez zmian. Zmianie uległ tylko przekrój poprzeczny kadłuba. Załamanie pokryw wzdłuż pierwszej wręgi stało się wyraźniejsze (Rysunek 4.21.16)1:
Rysunek 4.21.16 Poprawione górne panele osłony silnika
Rysunek 4.21.16 przedstawia także poprawiony chwyt powietrza do sprężarki i rozsunięte osłony km. Średnica chwytu została powiększona o 10%. Porównaj z tą ilustracją Rysunek 4.21.14. Prawda, że na pierwszy rzut oka nic się nie zmieniło? A jednak ja wiem, że teraz jest tak, jak w oryginale — a wcześniej męczyła mnie świadomość, że jest inaczej. To takie “modelarskie dobre samopoczucie” ☺.
Rysunek 4.21.17 Skracanie czoła osłony chłodnicy
Ta sama mania dokładności zmusiła mnie do kolejnej poprawki. Z opublikowanych przez Batesa pomiarów wynika, że osłona chłodnicy w naszym modelu ma poprawne wymiary, ale była położona o 5 cm bliżej nosa samolotu2. To także poprawimy. Ta zmiana na szczęście wymaga tylko drobnej “operacji plastycznej”, a nie ponownego tworzenia od podstaw.
Pierwszym krokiem poprawki jest “ściśnięcie” wzdłuż osi Y fragmentu, który w oryginalnym samolocie był o 5 cm krótszy (Rysunek 4.21.20). Zwróć uwagę, że wierzchołki wzdłuż zewnętrznych krawędzi osłony nie są poddane tej transformacji. Oszczędzimy sobie w ten sposób konieczności ponownego dopasowywania do sąsiednich paneli.
Po skróceniu czoła osłony chłodnicy, przesuń resztę jej siatki o 5 cm do przodu (Rysunek 4.21.18):
Rysunek 4.21.18 Przesunięcie osłony chłodnicy
Jeżeli nie podobają Ci się pochylone linie wręg w okolicach krawędzi siatki — możesz je wyprostować. Wystarczy je przesunąć (Edge Slide) po ścianach zagięcia “na grubość blachy”, umieszczonych wzdłuż krawędzi osłony chłodnicy (krawędź |32| — p. Rysunek 4.21.19):
Rysunek 4.21.19 Prostowanie końcówki wręgi
Z pozostałych poprawek — zmianie uległy szczegóły kształtu wylotu powietrza z chłodnicy (Rysunek 4.21.20). Trochę w nim nadal moich domysłów, bo brak jest dobrej jakości zdjęć tego fragmentu P-40 B/C.
Rysunek 4.21.20 Przerobiony wylot powietrza | Rysunek 4.21.21 Zmienione zakończenia osłon podwozia |
Zgodnie z sugestią Batesa, zmieniłem także końcówki osłon goleni podwozia (Rysunek 4.21.21) . Zakładałem, że wyglądały jak w P-40E, a tu okazuje się, że miały “pozostałości” po P-36.
Zwróć jeszcze uwagę na sztuczne przyciemnienia i przejaśnienia, które mogły się gdzieniegdzie pojawić na powierzchniach modelu (Rysunek 4.21.22a,b,c):
Rysunek 4.21.22 Artefakty na granicach ostrych krawędzi
W ferworze formowania poszczególnych części mogłeś nie zwrócić na nie uwagi. Takie artefakty powstają przy ostrej (Crease=1) krawędzi łączącej jakąś dłuższą, “gładką” (Shade Smooth) ścianę z drugą, o wiele mniejszą (por. str. 974). Aby eliminować taki kłopot, masz do dyspozycji kilka rozwiązań:
najprostsze: zmienić tryb cieniowania ściany z “gładkiego” (Shade Smooth) na “płaski” (Shade Flat). W przypadku powierzchni, które pokazuje Rysunek 4.21.22, lepiej jednak tego uniknąć. (Na powłokach, które teraz wyglądają jak gładkie, pojawiłyby się drobne krawędzie);
standardowe: włączyć dla siatki opcję Normals:Auto Smooth (por. str. 975). Ta opcja usuwa „cienie” z każdej krawędzi, w której ściany są połączone pod kątem większy niż graniczny kąt Normals:Angle (ustaw na jakąś wartość od 30º do 90º);
redukcyjne: dodać wzdłuż ostrych krawędzi dodatkowy rząd niewielkich ścian. To zmniejsza efekt do niedostrzegalnych rozmiarów. Z tym może się wiązać jednak trochę dodatkowej pracy.
W przyszłości może się zdarzyć, że będziesz chciał skorzystać z jakiegoś zewnętrznego programu renderującego albo zaadaptować ten model do jakiejś gry. Nie każdy format plików eksportu przenosi takie niuanse, jak odchylenia kierunków wektorów normalnych tworzone przez opcję Auto Smooth. Wtedy ten problem może się znowu pojawić. Dlatego proponuję usunąć z modelu co większe przebarwienia za pomocą dodatkowego rzędu ścian. W przypadku lotki sprawa jest bardzo prosta: wystarczy wstawić (Loop Cut) nową wręgę (Rysunek 4.21.23):
Rysunek 4.21.23 Usunięcie przyciemnienia krawędzi lotki poprzez dodanie rzędu nowych ścian
Wstawienie dodatkowych ścian wokół krawędzi sterów wymaga więcej pracy. Bardzo przydaje się tu technika nacinania (Knife). (Nie będę tutaj dokładnie pokazywał, jak je po kolei robić, myślę że sobie poradzisz). Mniejsze przebarwienia usuwaj opcją Normals:Auto Smooth lub modyfikatorem Edge Split (str. 975).
Model jest już uformowany (Rysunek 4.21.24). Mam nadzieję, że nie będą go czekały w przyszłości tak duże poprawki, jak te, które wprowadziłem po artykule Hume Batesa. Jedynym obszarem, co do kształtu którego nadal mam pewne wątpliwości, jest wylot powietrza z chłodnicy cieczy. Wylot jest bardzo dobrze “obfotografowany” dla wersji P-40E, istnieją także jego rysunki konstrukcyjne. Jak na złość, na temat wcześniejszych wersji (B,C) brak jest dobrych danych. Mam nadzieję, że w przyszłości dotrę do jakichś dokładniejszych zdjęć tego fragmentu3.
Rysunek 4.21.24 Kształt modelu, jaki osiągnęliśmy w trakcie tego rozdziału
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-4.21.blend (por. str. 22).
Podsumowanie
Po zakończeniu fazy “formowania blach” samolotu warto jest przejrzeć wszystkie warstwy i zaprowadzić w nich porządek (str. 277). Koniecznie zaplanuj zawczasu, gdzie umieścisz takie zespoły, jak podwozie, czy wnętrze kabiny. Zarezerwuj także co najmniej dwie warstwy do nieprzewidzianych, przyszłych zastosowań;
Na tym etapie warto także zadbać o uzupełnienie brakujących relacji hierarchii (Parent). Struktura samolotu powinna się “zaczynać” od jakiejś pojedynczej części, np. kadłuba (str. 281);
Zapisz w odrębnej scenie (str. 277) wszystkie pomocnicze obiekty, np. wzorce kształtu. Nie wiadomo, kiedy się przydadzą;
Przejrzyj krytycznie i popraw wszelkie “przebarwione” fragmenty siatki (str. 284). Występują na wygładzonych powłokach, w okolicach ostrych krawędzi;
Sprawdź na tyle dokładnie, na ile jesteś w stanie, wymiary modelu. Bądź jednak przygotowany na konieczność poprawek. (Postęp prac nad każdym dokładnym modelem odbywa się często wg zasady “dwa kroki naprzód, jeden krok w tył ”);
Do dalszej pracy będziemy potrzebować: kamery, tła, oświetlenia. Ustawimy je wstępnie w tym rozdziale. Opowiem tu także trochę więcej o materiałach w Blenderze. (Do tej pory wspomniałem o nich zaledwie, gdy potrzebowaliśmy zabarwienia powłoki na kontrastowy kolor — por. str. 206). W tym rozdziale pokażę, jak uzyskać typowe powierzchnie samolotu: wypolerowanego duralu, połyskliwego lakieru, i matowego kamuflażu. Będzie to nam potrzebne podczas tworzenia szczegółów samolotu — podwozia, wnętrza kabiny. Uważam, że najlepszą metodą na wykonanie takich drobnych elementów jest od razu stworzyć je w ostatecznej postaci, pokryte odpowiednimi materiałami. W ten sposób nie będziesz musiał do nich nie wracać. Stąd po uformowaniu podstawowej bryły samolotu wprowadzam w świat materiałów i tekstur. Gdy już go poznasz, powrócimy do tworzenia detali modelowanej maszyny (por str.473).
Zdecydowałem się podać w tym rozdziale “prosty przepis kuchenny” na kompozycję sceny. Nie będę się tu rozpisywał o możliwościach oświetlenia, tylko pokażę jak je ustawiać dla uzyskania efektu otwartej przestrzeni. Nie będę mówił o sztuce kompozycji, tylko powiem, gdzie należy ustawić kamerę. Takie minimalistyczne podejście wynika z ogromu możliwości, jakie się kryją w tych zagadnieniach. A ja chcę tu pokazać coś, co można stosunkowo łatwo uzyskać, i co będzie w miarę dobrze wyglądać. Gdy zrobisz już pierwszy model, gorąco zachęcam do dalszej, samodzielnej nauki. Wokół jest kilkadziesiąt książek o Blenderze (licząc razem te w języku angielskim i polskim). W Internecie znajdziesz tysiące różnego rodzaju samouczków (tutoriali), więc ze źródłem wiedzy nie powinno być problemu. Sądzę, że wkrótce bez większego trudu będziesz w stanie tworzyć dużo lepsze sceny od przedstawionych w tej publikacji.
W tym rozdziale będziemy wykorzystywać materiały z towarzyszącego tej książce pliku source.zip. Pliki *.blend odpowiadające rezultatom poszczególnych sekcji rozdziału znajdziesz w pliku p40.zip. (Adres miejsca, z którego można pobrać te pliki, znajdziesz na. str. 22).
W tej sekcji skorzystasz z umiejętności, które nabyłeś w Blender – pierwsze kroki"”(Rozdział 3). Dokładniej chodzi o sekcje 3.3 i 3.4 (str. 82-95). Zacznij od odszukania domyślnej kamery i źródła światła w pliku naszego modelu (Rysunek 5.1.1):
Rysunek 5.1.1 Wstępne poprawienie położenia kamery i światła
Domyślna kamera (o nazwie Camera) i źródło światła (o nazwie Lamp) powinny się znajdować na warstwie 20. (Umieściliśmy je tam na samym początku pracy — p. str. 770). Włącz widoczność tej warstwy i przesuń je z domyślnego położenia w nowe, bardziej odległe (Rysunek 5.1.1). Jeżeli ich tam nie ma (bo np. usunąłeś je wcześniej) — wstaw nowe (Add→Camera — str. 818, Add→Lamp — str. 817), w miejsca, które pokazuje Rysunek 5.1.1b). Przenieś je także (M, szczegóły — str. 838) na warstwę 20 1.
Przełącz się teraz na widok z kamery (0, lub View→Cameras→Active Camera). Przy okazji możesz wyłączyć wyświetlanie obrazu tła (Background image), bo widok z kamery także je wyświetla. Projekcja, którą uzyskasz w oknie 3D View, ma silną deformację perspektywiczną (“rybie oko” — Rysunek 5.1.2a):
Rysunek 5.1.2 Widok z kamery: przed i po skorygowaniu parametrów kamery
Przejdź do właściwości kamery (zestaw Object Data, panel Lens — str. 819). Zwiększ jej ogniskową (Focal Length) do 70mm, a zasięg (Clipping Start/End) wydłuż dziesięciokrotnie (Start = 1, do End = 1000 jednostek). Następnie odsuń kamerę od modelu wzdłuż jej lokalnej osi Z (G,Z,Z), by ująć cały model (Rysunek 5.1.2b).
Na ekranie masz trzy okna 3D View. Pozostaw w jednym z nich widok z kamery, a w pozostałych dwóch ustaw rzuty: z przodu i z góry. Obserwując na bieżąco obraz z kamery, spróbuj w pozostałych oknach przesunąć ją tak, by ująć cały samolot. W trakcie tych manipulacji zapewne zauważysz, że kamera nie zachowuje się tu tak “mądrze”, jak to pokazywał Rozdział 3. Tutaj możesz bez problemu “zgubić” cały samolot z kadru. Kamera ciągle “patrzy” w tę samą stronę. Dlaczego tak się dzieje? Bo nie jest jeszcze przypisana do odpowiedniego celu!
Stwórzmy więc cel dla kamery. Włącz widoczność warstwy 10 i wstaw na nią nowy obiekt o nazwie Target (żadnych przedrostków numerycznych, bo to obiekt specyficzny dla tej sceny). Może wyglądać jakkolwiek, byleby nie był ani za mały, ani za duży, tylko “w sam raz” do złapania i przesunięcia. Osobiście zawsze rysuję go jako nieskomplikowany graniastosłup (walec, bez wygładzenia, z niewielką liczbą ścian), o promieniu 3 jedn. (Rysunek 5.1.3). Aby wyróżniał się na tle innych części modelu przypisz mu czerwony materiał Artifical.
Teraz przypisz do kamery i światła ograniczenie (constraint) typu Track To, podając jako cel obiekt Target (Ctrl-T, Track To. szczegóły — patrz str. 847). Aby kamera objęła cały samolot, odsuń ją na większą odległość. Można to zrobić także w samym widoku z kamery. Zaznacz jej obiekt, a następnie naciśnij G,Z,Z. To włączy przesuwanie kamery wzdłuż lokalnej osi Z, która zawsze jest skierowana prostopadle do płaszczyzny ekranu.
Obiekt Target pozostaw w pobliżu centrum modelu — to “focus” kamery. Podobnie jak kamerę, oddal od modelu także źródło światła (Rysunek 5.1.4):
Na koniec wyłącz warstwę 10, aby obiekt Target przestał być widoczny.
Kamerę już ustawiliśmy, teraz czas na oświetlenie. Zaznacz światło Lamp i zmień jego nazwę na Sun. Następnie we właściwościach jego danych (zestaw przycisków Object Data):
nadaj temu blokowi danych nową nazwę: Sun (bądźmy konsekwentni!);
ustaw barwę tego światła na białą;
upewnij się, że intensywność światła wynosi 1.0 (pole Energy, w panelu Lamp);
upewnij się, że włączone jest rzucanie cieni (opcja Ray Shadow z panelu Shadow);
To źródło światła powinno być tak ustawione, jak to pokazuje Rysunek 5.1.5.
Jednocześnie wyłącz widoczność warstwy 16, zawierającej śmigło. Dopóki nie zostanie “rozkręcone” w kolejnych klatkach animacji i nie włączymy efektu “rozmycia w ruchu”, lepiej żeby go na tej scenie nie było widać.
Pamiętaj: Blender renderuje tylko zawartość warstw, które są aktualnie widoczne. Daje to Ci możliwość określenia, co ma się pojawić na ostatecznym obrazie.
Po tych ustawieniach przyszedł czas na “pierwszy strzał”. Naciśnij F12 (Render→Render Image) , by wygenerować pierwszy rendering naszego modelu (Rysunek 5.1.6):
Rysunek 5.1.6 Pierwszy rendering
Efekt jest daleki od pożądanego, nieprawdaż? Cały samolot wygląda jak wykonany z szarego plastiku. To dlatego, że nie przypisaliśmy powierzchniom żadnego konkretnego materiału. Celowo zacząłem od takiego “zera”. Przez ten i dalsze rozdziały będziemy tę scenę stopniowo poprawiać, aż stanie się warta pokazania.
Jeżeli na Twoim renderze prawy płat jest zupełnie czarny — rozwiązanie problemu znajdziesz na str. 978.
Spróbujmy rozjaśnić całość włączając tzw. korekcję gamma barw tej sceny (sRGB — str. 794). Ten przełącznik znajdziesz w panelu Color Management z zestawu Scene. Nazywa się Display Device (Rysunek 5.1.7):
Rysunek 5.1.7 Rozjaśnienie tła... | Rysunek 5.1.8 …nie rozjaśnia wcale modelu! |
Być może miałeś już go włączony — wtedy od razu otrzymałeś taki rezultat, jaki pokazuje Rysunek 5.1.8. Tło i model pojaśniały, ale cienie nadal pozostały „kosmicznie czarne”.
Teraz należałoby rozpocząć „pracę z oświetleniem” sceny, dodając dodatkowe źródła światła i stosując inne sztuczki, aby rezultat zaczął przypominać rzeczywisty obiekt. Taki proces opisałem w pierwszym wydaniu tej książki, w której wykorzystywałem domyślny silnik renderujący Blendera (Blender Internal, albo BI). Choć jego kod był rozwijany do 2010r, to niektóre jego fragmenty pamiętają jeszcze połowę lat 90. XX w.
W kwietniu 2011 jeden z kluczowych programistów Blendera — Brecht van Lommel — zaprezentował pomysł drugiego silnika renderującego, o nazwie Cycles. Po kilku miesiącach przygotowań Cycles zostało włączone do wersji 2.61 Blendera jako alternatywny renderer. Aby z niego skorzystać, wystarczy wybrać pozycję Cycles Renderer z listy rozwijalnej w nagłówku okna Info (Rysunek 5.1.9).
Przełączenie na Cycles zmienia nieco panele w zestawie Render i kilka innych szczegółów interfejsu użytkownika (przekonasz się o tym za chwilę). Blender Internal należy do tzw. biased renderers, wykorzystujących uproszczony (czyli szybszy do obliczenia) model oświetlenia. Takie silniki generuje ostateczny obraz „kawałek po kawałku”. Cycles jest jednym z unbiased renderers, wykorzystujących model oświetlenia zbliżony do rzeczywistego. Unbiased renderers tworzą ostateczny render na zasadzie kolejnych przybliżeń. W każdym przybliżeniu (tzw. próbce — sample) generują cały obraz. Pierwsze przybliżenie jest bardzo niedoskonałe, pełne kolorowego szumu. Jednak w kolejnych próbkach te zaburzenia zazwyczaj szybko znikają. Cycles mógłby tak poprawiać obraz w nieskończoność. W panelu Sampling zestawu Render należy określić, po jakiej liczbie próbek ma zakończyć pracę (Rysunek 5.1.10). Domyślne wartości pól Sampling: Samples (Render:10, Preview:10) są trochę za małe dla takiego modelu jak nasz samolot. Pierwszą proponuję zwiększyć — do 100 albo nawet do 500, a drugą zmniejszyć do zera.
Potem już możesz nacisnąć F12. Rysunek 5.1.11 przedstawia uzyskany rezultat (por. Rysunek 5.1.8):
Rysunek 5.1.11 Ta sama scena, renderowana za pomocą Cycles
Teraz model wygląda jak niedoświetlony obiekt z gliny. Cienie jednak są łagodne, i widać więcej szczegółów.
W Blenderze możesz także uruchomić podgląd renderu w dowolnym oknie 3D View. Służy do tego nowy tryb Viewport Shading, o nazwie Rendered (Rysunek 5.1.12):
Rysunek 5.1.12 Cycles umożliwia przełączenie trybu wyświetlania okna 3D View na podgląd renderu
W przypadku Cycyles ten obraz jest cyzelowany w nieskończoność, gdy liczba próbek podglądu = 0 (por. Rysunek 5.1.10). Umożliwia Ci to oszacowanie, ile próbek trzeba ustawić w polu Samples:Render, by ostateczny rezultat był pozbawiony początkowych szumów. Cycles zmienia zawartość podglądu dynamicznie. Na przykład — przejdź do zestawu World i spróbuj rozjaśnić kolor tła sceny (Rysunek 5.1.13a):
Rysunek 5.1.13 Podgląd renderu reaguje na bieżąco na zmianę każdego parametru
Przekonasz się, że każdy ruch myszką powoduje rozpoczęcie próbkowania od nowa. Próbki liczą się szybko, co pozwala na interaktywną pracę z efektami widocznymi w podglądzie. Co więcej, w trybie Renderer nadal możesz zmieniać projekcję, oglądając renderowany model z różnych stron. Zawsze warto to zrobić — chociażby po to, by znaleźć takie wady modelu, jak brzydkie cienie na owiewce kabiny (Rysunek 5.1.14a):
Rysunek 5.1.14 Efekt sprawdzania modelu na podglądzie renderu — dziwne cienie na owiewce kabiny
Rysunek 5.1.14b) pokazuje, że te cienie widać także w trybie Solid, który wykorzystywaliśmy podczas modelowania (por. także str. 224 i następne). Nie rzucały się tak bardzo w oczy, więc umknęły mi podczas poprzedniej weryfikacji modelu (str. 284). Takie artefakty pojawiają się w pobliżu ostrych załamań siatki, która jest cieniowana jako „gładka” (ma włączony tryb Smooth Shade). Teraz trzeba poprawić ten błąd, bo te czarne przebarwienia zepsują nam efekt oszklenia kabiny (por. str. 975). Znikną, gdy skorygujesz ustawienia siatki w panelu Object Data:Normals (Rysunek 5.1.15):
Rysunek 5.1.15 Skorygowanie błędnego cieniowania za pomocą ustawień z panelu Normals
Wystarczy zmniejszyć kąt graniczny Angle z domyślnych 180º do 30-90º i włączyć opcję Auto Smooth. W podobny sposób poprawiłem siatkę wiatrochronu. Auto Smooth skutecznie eliminuje ciemne przebarwienia z owiewki — zarówno w trybie Solid, jak i na podglądzie renderu (Rysunek 5.1.15b).
Zawsze zwracaj uwagę na ciemne przebarwienia siatki podczas modelowania — i od razu je eliminuj. Zaoszczędzisz sobie w ten sposób późniejszych zaskoczeń.
Jeżeli jakaś projekcja uzyskana w podglądzie renderu podoba Ci się szczególnie, możesz ją bardzo łatwo zamienić w ostateczny obraz. Najpierw tylko odłącz aktywną kamerę od śledzenia obiektu Target (Alt-T, albo Object→Track→Clear→Clear Track). Potem wystarczy w oknie podglądu użyć skrótu Ctrl-Alt-0 (View→Align View→Align Active Camera to View).
Możesz także dodawać do sceny kolejne kamery, czyniąc każdą kamerą aktywną (Ctrl-0 albo View→Cameras→Set Active Object as Camera). W ten sposób możesz utrwalić wiele alternatywnych ujęć swojej sceny.
Póki co, aby wydobyć z Cycles ich pełną siłę, należy zacząć korzystać z ich ustawień w trybie tzw. węzłów (Nodes). O tym, co to jest, dowiesz się w następnej sekcji. Na razie po prostu zaznacz nasze „słońce” (obiekt Sun) i naciśnij przycisk Use Nodes w panelu Nodes zestawu Object Data (Rysunek 5.1.16):
Rysunek 5.1.16 Przełączenie źródła światła w tryb węzłów (Nodes)
Podobny przycisk znajdziesz także w ustawieniach otoczenia (zestaw World). Przełącz je także na Nodes.
Przełączenie w tryb węzłów spowodowało pojawianie się w panelach World:Surface i Object Data:Nodes obiektu Sun czegoś, co jest niezbędne: kontrolek Strength (por. Rysunek 5.1.16). To sterowanie intensywnością każdego z tych dwóch komplementarnych źródeł światła. Parametry World:Surface sterują rozproszonym, bezkierunkowym światłem otoczenia. Z kolei właściwości Object Data:Nodes obiektu Sun opisują kierunkowe, równoległe światło słoneczne. Dotychczasowy („podwodny”) efekt uzyskaliśmy gdy intensywności obydwu źródeł wynosiły 1.0. Spróbujmy teraz to zmienić w coś bardziej „atmosferycznego”.
Zmniejsz natężenie otoczenia (World:Surface:Strength) do 0.6, i jednocześnie zwiększ intensywność oświetlenia słonecznego (Object Data:Nodes:Strength) do 2.5. Rezultat przedstawia Rysunek 5.1.17:
Rysunek 5.1.17 Model po zróżnicowaniu natężenia światła rozproszonego i słońca
Teraz nasz model wygląda nieco lepiej — jak w jakiś pochmurny dzień. Uwzględniając niebieskawy odcień światła otaczającego, można zacząć przypuszczać, że jest to model w kolorze białym. (Tak jest w istocie — obiekty którym nie przypisano jeszcze żadnego materiału są w Cycles białe i zupełnie matowe. Wyglądają tak, jak gdyby były uformowane z białej gliny). Co prawda tło jest teraz ciemniejsze, ale w dalszych sekcjach pokażę, jak można je zasłonić jakimś bardziej wiarygodnym obrazkiem.
Oczywiście, skorzystaj z trybu podglądu tego renderu, by obejrzeć ten model ze wszystkich stron. Zwróć uwagę na wymodelowane krawędzie okapotowania silnika. W zasadzie te linie wyglądają poprawnie, poza dwoma (Rysunek 5.1.18a). Cienie i rozjaśnienia są na nich większe niż na sąsiednich panelach!
Rysunek 5.1.18 Korygowanie zbyt mocnego cienia na krawędzi okapotowania silnika
Ten efekt wynika z dwukrotnie mniejszej liczby ścian tego fragmentu (jego siatka — B.350.Cowling.004 —pozostała jak na str. 195, podczas gdy sąsiednie segmenty później zagęściliśmy). Aby nadrobić tę różnicę, wystarczy zwiększyć liczbę podziałów z 2 do 3 (Rysunek 5.1.18b). To wyrównuje krawędzie (Rysunek 5.1.18c).
Jak napisałem poprzednio, na razie nasz model wygląda jak przy oświetleniu w jakiś pochmurny dzień. W takich warunkach światło słoneczne jest rozproszone, wywołując łagodne i rozmyte cienie (Rysunek 5.1.19):
Rysunek 5.1.19 Efekt dla rozproszenia cieni = 1.0
Spróbuj zmniejszyć tę wartość, na przykład o połowę. Spowoduje to wyostrzenie cienia i pewne rozjaśnienie powierzchni oświetlonych światłem słońca (Rysunek 5.1.20a). Takie cienie są jednak nadal zbyt rozmyte. (Przyjrzyj się cieniom rzucanym przez przedmioty w słoneczny dzień — są bardzo ostre). Dlatego, aby dobrze odwzorować silne światło słoneczne, trzeba użyć odpowiednio mocnej „lampy” typu Sun o bardzo małych rozmiarach — rzędu 0.05 – 0.01 (Rysunek 5.1.20b). Można, oczywiście, zredukować rozmiar słońca do zera (Rysunek 5.1.20c), ale wtedy nawet bardzo odległe cienie pozostaną ostre, przez co będą mniej realistyczne.
Inną metodą rozjaśnienia całości obrazu jest wydłużenie „czasu ekspozycji” — wartość Exposure w panelu Film zestawu Render (Rysunek 5.1.21) . Mogłoby się wydawać, że przesadziłem tu już z tym światłem — niektóre miejsca na kadłubie stały się oślepiająco białe. Należy jednak pamiętać, że zazwyczaj samolot jest pokryty jakimś ciemnym kamuflażem, a słońce na wysokości kilku kilometrów potrafi być naprawdę ostre. Przy okazji spróbowałem w panelu Film zwiększyć nieco intensywność wygładzania linii (Width — por. str. 1147) — by nie było widać granic pikseli na prowadnicach owiewki kabiny.
Rysunek 5.1.21 Rozjaśnienie renderu poprzez wydłużenie „czasu ekspozycji” (Film:Exposure)
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-5.01.blend (por. str. 22).
Podsumowanie
Domyślne parametry kamery Blendera zazwyczaj wymagają zmiany (str. 287). Uważaj na zbyt małą wartość Clipping Start, gdyż może wywołać sztuczne “przebicia” wewnętrznych powłok modelu (por. str. 820).
Aby łatwo manipulować kamerą i oświetleniem, skieruj je na jakiś pomocniczy obiekt (“cel”, za pomocą ograniczeń Track To — str. 288). Alternatywnie możesz przesuwać kamerę wzdłuż lokalnych osi jej obiektu (wykorzystując skróty G,X,X, albo G,Y,Y, albo G,Z,Z). Jeszcze inną metodą jest przypisanie aktywnej kamerze aktualnego widoku w oknie 3D View (Ctrl-Alt-0 — por. str. 292);
Blender umieszcza na renderingu tylko obiekty z warstw, które są aktualnie widoczne;
Obecnie Blender udostępnia dwa alternatywne silniki renderujące: Blender Renderer (znany także jako Blender Internal — BI) oraz Cycles (str. 290). W tej książce do renderowania będziemy używać Cycles;
Cycles umożliwia wykorzystanie wygodnego, interaktywnego podglądu renderu (str. 291);
Podgląd renderu ułatwia znalezienie na modelu skaz, które należy poprawić (str. 291, 293);
Podstawowe oświetlenie sceny w locie uzyskujemy za pomocą: światła typu Sun (kierunkowe, wywołujące cienie), i rozproszonego światła otaczającego ustawianego w zestawie World (str. 293). Intensywność (Strength) każdego z tych źródeł należy dobrać odpowiednio do założonych warunków oświetlenia. Ustaw więcej światła otaczającego a mniej słonecznego gdy niebo ma być zachmurzone, i na odwrót gdy ma być słonecznie;
Ostrość cienia światła słonecznego (Lamp:Size) pozwala sterować poziomem rozmycia cieni. Należy stosować duże wartość dla uzyskania rozmytych cieni (jak w pochmurny dzień), a bardzo małe — dla uzyskania cieni ostrych (odpowiednich dla jasnej, słonecznej pogody) (str. 294);
Wygładzanie renderowanych linii domyślnie wykorzystuje metodę (filtr) Gauss. Intensywnością wygładzania można sterować za pomocą parametru Film:Width z zestawu Render (str. 294);
Materiałem (material) nazywa się w Blenderze zespół parametrów opisujących sposób odbijania światła. Materiał, oprócz tak intuicyjnych własności jak barwa, posiada wiele innych atrybutów (np. “chropowatość” — roughness). Może także zawierać tekstury, których piksele “lokalnie” zmieniają wartości niektórych parametrów (np. zarysowanie szyby — to lokalna zmiana jej przejrzystości). O teksturach dowiesz się więcej w następnym rozdziale.
W tej sekcji utworzymy i przypiszemy do siatek dwa podstawowe materiały: B.Skin.Camouflage dla powierzchni zewnętrznych, i B.Skin.Inner dla powierzchni wewnętrznych1. W przyszłości B.Skin.Camouflage stanie się kamuflażem samolotu. Przy okazji przygotujemy także przejrzysty materiał osłony kabiny pilota.
Zacznij od stworzenia materiału B.Skin.Camouflage i przypisania go do powierzchni prawego płata (w zestawie Material — patrz str. 987). Do wyświetlania w trybie Solid przypisz mu na razie kolor pomarańczowy (ustawiając Settings:Viewport Color na R = 1.0, G = 0.27, B = 0.0 — por. str. 988). Taki kontrastowy kolor zdecydowanie odróżnia się od szarości powłok bez przypisanego materiału. Dzięki temu łatwiej dostrzeżesz obiekty, którym jeszcze trzeba go przypisać (Rysunek 5.2.1). Potem zmienimy barwę tego materiału na inną.
Rysunek 5.2.1 Dwa podstawowe materiały, naniesione na powierzchnię skrzydła.
Zwróć uwagę, że do lewego skrzydła B.Skin.Camouflage „przypisał się sam”. To dlatego, że materiał jest powiązany z siatką, a nie z obiektem. Obydwa płaty: prawy i lewy, korzystają z tej samej siatki: B.100.L.Wing 2.
Stwórz także materiał dla powierzchni wewnętrznych: B.Skin.Inner. Nadaj mu kolor zielonkawy (R = 0.10, G = 0.12, B = 0.0)3 i przypisz np. do siatki wnęki podwozia (B.120.WheelBay — Rysunek 5.2.1). Teraz przed nami trochę pracy: trzeba przypisać odpowiedni materiał do każdej siatki modelu (por. str. 940). Pewną pomocą będzie możliwość kopiowania materiału na całą grupę obiektów (Ctrl-L, Material — por. str. 940).
Mówiąc szczerze, rozdział o materiałach wstawiłem w tym miejscu książki wyłącznie po to, by oszczędzić Ci jak najwięcej takiej roboty. Czeka nas jeszcze wytworzenie wielu małych części. Tym “drobiazgom” będziemy już przypisywali materiały na bieżąco, zaraz po uformowaniu. Gdybyśmy najpierw przygotowali cały model, aż do ostatniego detalu, a potem zabrali się za przypisywanie materiałów — pracy byłoby jeszcze więcej. Wzrosłaby także szansa, że jakiś fragment pozostanie omyłkowo pominięty.
Koniec gadania, bierzmy się do roboty. Sądzę, że najwygodniej będzie przypisywać obiekty “warstwa po warstwie”. Za każdym razem włącz widoczność tylko jednej warstwy, gdyż znajduje się tam kilka — kilkanaście obiektów. To odpowiednia “porcja” na jeden raz, bo łatwiej jest dostrzec i zaznaczyć każdy przedmiot. Dodatkowo, dużą pomocą jest możliwość chwilowego ukrywania pojedynczych obiektów (H, Hide Selected — patrz str. 836 4). Rysunek 5.2.2 pokazuje przypisywanie materiałów na warstwie 1 (zespół skrzydła):
Rysunek 5.2.2 Przypisywanie materiałów — wykorzystanie polecenia Hide Selected (chwilowe ukrywanie obiektów).
Czasami może pojawić się taka sytuacja, jak w gondoli podwozia głównego: zewnętrzna część siatki powinna być przypisana do materiału B.Skin.Camouflage, a część wewnętrzna — do B.Skin.Inner. Na szczęście w każdej siatce w Blenderze można wyznaczyć wiele obszarów, i każdemu z nich przypisać inny materiał (a dokładniej — tzw. material slot, czyli „łącze materiału”). Robi się to w trybie edycji, w zestawie Material (szczegóły — str. 941). Najpierw przypisz do całej siatki jeden materiał. Najlepiej wybierz ten, który zajmuje na niej najwięcej ścian (w tym przypadku — jest to zewnętrzny B.Skin.Camouflage). Takie przypisanie automatycznie tworzy pierwsze łącze materiału, do którego są na razie przypisane wszystkie ściany. Potem stwórz drugie łącze i przypisz do niego ściany. Do tego nowego łącza przypisz mu materiał B.Skin.Inner (Rysunek 5.2.3):
Rysunek 5.2.3 Przypisanie fragmentowi siatki materiału “wnętrza” (B.Skin.Inner).
Alternatywną techniką do tej, którą pokazuje Rysunek 5.2.3, będzie pomalowanie fragmentu tekstury B.Skin.Camouflage na kolor wnętrza samolotu, lub fragmentu tekstury B.Skin.Inner na kolor zewnętrzny. Zastosujemy je wszędzie tam, gdzie granica kolorów przebiega poprzez ściany (Nie ma sensu, w imię podziału barw, wstawiać dodatkowych krawędzi).
Rysunek 5.2.4 pokazuje przykłady obszarów, które najlepiej będzie „zamalować” na inny kolor:
Rysunek 5.2.4 Obszary, w których układ ścian uniemożliwia zastosowanie w siatce dwóch materiałów
Sukcesywnie przypisuj zawartość kolejnych warstw do materiałów. W przypadku ramek kabiny zacznij od przypisania ich do barwy “wewnętrznej” (B.Skin.Inner). Barwa zewnętrzna (B.Skin.Camouflage) jest zaledwie dodatkiem do tego podstawowego zabarwienia (Rysunek 5.2.5):
Rysunek 5.2.5 Ramki kabiny — tu “dominującym” materiałem jest wewnętrzny B.Skin.Inner.
Efekt przypisania materiałów B.Skin.* do samolotu demonstruje Rysunek 5.2.6:
Rysunek 5.2.6 Model po przypisaniu materiału do wszystkich elementów.
Jeżeli cały samolot stał się pomarańczowy, oznacza to, że przypisaliśmy do materiałów B.Skin.Camouflage i B.Skin.Inner wszystkie powłoki, które należało przypisać. Teraz można zmienić z powrotem barwę B.Skin.Camouflage na jakąś bardziej umiarkowaną (nadal to będzie barwa tymczasowa).
Proponuję ustawić ten kolor (Settings:Viewport Color) na jasnoszary (V = 0.85) (Rysunek 5.2.7):
Rysunek 5.2.7 Model po zmianie barwy materiału B.Skin.Camouflage wyświetlanej w 3D View na jasnoszary.
Pamiętaj, że takie materiały jak B.Skin.Camouflage, czy B.Skin.Inner, są przypisane do wielu siatek. Gdy zaznaczasz pojedynczy obiekt i zmieniasz jakąkolwiek jego właściwość, zmienisz ją dla wszystkich pozostałych fragmentów modelu które używają tego materiału6.
Ten sam materiał może na renderze w Cycles mieć zupełnie inny kolor. Na razie jednak nasz samolot będzie na nim także szary (ustaw wartość V = 0.5 w trybie HSV kontrolki Surface:Color) (Rysunek 5.2.8):
Rysunek 5.2.8 Robocza barwa B.Skin.Camouflage na renderze: szary (V = 0.5)
Do tej pory ten materiał był zupełnie matowy. Teraz warto mu nadać odpowiedni połysk (Rysunek 5.2.9):
Rysunek 5.2.9 Dodanie połysku
Oglądane od strony słońca (por. str. 288) powierzchnie samolotu powinny mieć tylko niewielkie odbłyski (Rysunek 5.2.9a). Pełen blask skrzydeł uzyskasz, ustawiając je „pod światło” (Rysunek 5.2.9b).
Jak uzyskać efekt, który przedstawia Rysunek 5.2.9? To rezultat połączenia dwóch podstawowych rodzajów powierzchni: matowej i lustrzanej. Rodzaje powierzchni określa się w Cycles jako shaders. (W dalszym tekście będę używał nazwy „shadery” — z góry przepraszam wszystkich polonistów!). Do tej pory używaliśmy powierzchni zupełnie matowej — shadera Diffuse (por. chociażby panel Material:Surface, Rysunek 5.2.8 — jest tam wybrany w polu Surface). Połączenie dwóch shaderów najwygodniej jest zdefiniować je w edytorze węzłów (oknie Node Editor). Jeżeli jeszcze nigdy go nie używałeś, i w ogóle niezbyt wiesz co mam na myśli — przeczytaj szczegółowe wprowadzenie na str. 796. Przedstawiam tam, jak używać węzłów do definiowania materiału. W Cycles, jak się przekonasz, prawie wszystko ustawia się w Node Editor — nie tylko materiały, ale także źródła światła. (Tu świecić może każda siatka — wystarczy w schemat jej materiału wstawić shader Emission).
We wprowadzeniu do Cycles (str. 989) pokazuję krok po kroku, jak zbudować schemat typowego materiału „z połyskiem” (Rysunek 5.2.10a). To połączenie za pomocą węzła Mix Shader powierzchni matowej (Diffuse BSDF) i połyskliwej (Glossy BSDF). Zwróć uwagę na trzeci węzeł wejściowy: Layer Weight. Jest podłączony do „wagi” łączonych powierzchni (Mix Shader:Fac). W ten sposób udział „lustrzanej” powierzchni Glossy BSDF został uzależniony od kąta nachylenia ścianek modelu do obserwatora (por. str. 1001). To typowe rozwiązanie dla uzyskania zwykłych odblasków światła na powierzchni:
Rysunek 5.2.10 Zdefiniowanie nowego shadera — Gloss Paint
Skoro to typowe rozwiązanie, warto te węzły połączyć w taką grupę, jaką pokazuje Rysunek 5.2.10b). (Szczegółowy opis tworzenia grupy znajdziesz na str. 994). W ten sposób zdefiniowaliśmy nasz własny, wyspecjalizowany shader (Rysunek 5.2.10c). Zwróć uwagę, że z węzłów wchodzących w skład grupy możesz wybrać parametry, którymi będzie sterować jej użytkownik. W odróżnieniu od przykładu ze strony 994, zdecydowałem się tu rozdzielić barwy matowego (Diffuse) i połyskliwego (Specular) składnika powierzchni. Uzyskanemu w ten sposób shaderowi nadałem nazwę Gloss Paint (ang. „lakier”).
Aby się przekonać, że shader Gloss Paint zasługuje na swoją nazwę, zmień na chwilę jego kolor Diffuse na czerwony i zmniejsz szorstkość Roughness do 0.05 (Rysunek 5.2.11):
Rysunek 5.2.11 Zastosowanie shadera Gloss Paint do stworzenia efektu bardzo gładkiej powierzchni
Na powierzchni pojawiły się „twarde” odbicia światła słońca, jak na pomalowanej „na wysoki połysk” sportowej awionetce. Zauważ także, że odcień powłoki zależy od stopnia szarości koloru Specular (Rysunek 5.2.12):
Rysunek 5.2.12 Wpływ koloru Specular na powierzchnię Gloss Paint
Kamuflaż samolotów bojowych jest zazwyczaj bardziej matowy. Aby uzyskać taki efekt, zwiększ szorstkość (Roughness) powierzchni do 0.15 — 0.20 (Rysunek 5.2.13):
Rysunek 5.2.13 Zastosowanie shadera Gloss Paint do stworzenia półmatowej powierzchni
Zwróć uwagę, że odblaski słońca stały się na niej większe, ale jednocześnie bardziej rozmyte („miękkie”).
Na podglądzie renderu obejrzyjmy znów nasz model ze wszystkich stron. Czasami możesz znaleźć na jego powierzchni dziwne „srebrne” elementy (Rysunek 5.2.14):
Rysunek 5.2.14 Efekt „odwróconych ścian”
Gdy używaliśmy prostego materiału opartego wyłącznie na Diffuse BSDF, ten fragment kadłuba nie odróżniał się od innych. Co mu się teraz stało?
To sprawa orientacji ścianek siatki! Siatki pozostałych elementów kadłuba mają ściany skierowane na zewnątrz, a ta — nie. Orientację ścian określają tzw. wektory normalne (czyli prostopadłe do płaszczyzny ściany — ang. normal). Aby je zobaczyć, włącz wyświetlanie tych wektorów na siatce (w przyborniku właściwości, paneli Mesh Display — por. str. 972, Rysunek 14.45.1). Potem wymuś przeliczenie zwrotu normalnych (Ctrl-N, albo Mesh→Normals→Recalculate Outside — por. str. 972) (Rysunek 5.1.15):
Rysunek 5.2.15 Przełączenie zwrotu wektorów normalnych do ścian siatki
Następnie przełącz się z trybu Edit Mode w Object Mode, a niepożądany efekt zniknie (Rysunek 5.2.16):
Rysunek 5.2.16 Ten sam element po poprawieniu kierunku normalnych
W ten sam sposób popraw kierunki normalnych na drugim „srebrnym” elemencie — klapkach wylotu chłodnicy cieczy (Rysunek 5.2.16).
Gdy już zrobisz porządek z powierzchniami zewnętrznymi, czas ulepszyć materiał powierzchni wewnętrznych (B.Skin.Inner). Wymień używany tam dotychczas shader Diffuse BSDF na nasz Glossy Paint (Rysunek 5.2.17, szczegóły — str. 999). Tylko nie zapomnij zmienić podstawowego koloru tego materiału na Curtiss Green!
Po tej zmianie przejrzyj starannie na podglądzie renderu wszystkie elementy wykorzystujące ten materiał. Powierzchnie wewnętrzne mają zazwyczaj dużo źle zorientowanych ścian. Czasami część pojedynczej siatki może być poprawna, a druga część — błędna, tak ja w przypadku wnętrza kabiny (Rysunek 5.2.18):
Rysunek 5.2.18 Korygowanie kierunku normalnych na wewnętrznych powierzchniach kadłuba
Zazwyczaj w takim przypadku proste przeliczenie (Ctrl - N) nie pomoże. Trzeba zaznaczać w Edit Mode błędnie zorientowane ściany i przełączyć ich kierunek poleceniem Filp Normals (por. str. 973).
Najwięcej kłopotów sprawiła mi na tym etapie siatka wnęki klapy skrzydła (B.101.Flap Bay — (Rysunek 5.2.19a). Zemściło się próba uzyskania „blachy z zakładką” przy zastosowaniu pojedynczych ścian (Rysunek 5.2.19b, por. str. 273). Dla renderów tworzonych za pomocą BI to było dobre rozwiązanie, ale na potrzeby Cycles należałoby zrezygnować blachy o profilu „C” i zamknąć ten przekrój drugą ścianą (Rysunek 5.2.19c):
Rysunek 5.2.19 Eliminacja „dwustronnych” ścian we wnęce klapy
Alternatywnie można wykorzystać w materiale B.Inner.Skin flagę Geometry:Backfacing (por. str. 1010).
Na koniec tej sekcji przypiszemy owiewce kabiny odpowiedni materiał, imitujący szkło organiczne (plexiglas). Nadajmy mu nazwę B.Glass.Canopy. Poniżej przedstawiam kluczowe etapy kompozycji tego materiału. Szczegółowy opis, wraz z omówieniem występujących problemów, znajdziesz na str. 1046.
Upewnij się, że wszystkie przejrzyste elementy modelu mają nadaną grubość (czy to na etapie modelowania, czy też modyfikatorem Solidify). Jeżeli jej nie mają, Cycles potraktuje przestrzeń, którą zamykają, jak lite szkło!
W Cycles mamy do dyspozycji „gotowy” shader szkła: Glass BSDF. Jednak w scenie oświetlonej światłem kierunkowym (Sun) materiał bazujący wyłącznie na tym węźle pozostawia wiele do życzenia (Rysunek 5.2.20):
Rysunek 5.2.20 Efekt zastosowania shadera Glass BSDF
Łącząc shadery Glass i Transparent za pomocą flag Light Path można temu zaradzić (Rysunek 5.2.21):
Rysunek 5.2.21 Shader Glass BSDF + efekt cienia
Brakuje tu jeszcze połysku. Uzyskasz go podobnie jak dla powierzchni nieprzejrzystych: łącząc shader podstawowy (Glass BSDF) z shaderem Glossy BSDF. Do wagi tego połączenia podłącz współczynnik Fresnel (por. str. 1048). Rysunek 5.2.22 przedstawia użycie zbudowanego w ten sposób shadera Plexiglas:
Rysunek 5.2.22 Ostateczny materiał owiewki — shader (grupa) Plexiglas (Glass BSDF + Glossy BSDF + efekt cienia)
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-5.02.blend (por. str. 22).
Podsumowanie
Podstawowymi materiałami, które odwzorują pokrycie samolotu, są: B.Skin.Camouflage — na powierzchnie zewnętrzne, B.Skin.Inner — na powierzchnie wewnętrzne. Dodatkowo owiewka jest wykonana ze szkła — B.Glass.Canopy.
Ten sam materiał — np. B.Skin.Camouflage — może być przypisany do wielu siatek. By łatwo odszukać siatki, do których nie został przypisany, zmień na chwilę jego barwę na jakąś kontrastową, np. pomarańcz (str. 296).
Materiał najlepiej jest przypisać do siatki zaraz po jej stworzeniu (by na pewno o niej nie zapomnieć). W tej książce nie chciałem jednak wcześniej zawracać początkującemu Czytelnikowi głowy materiałami. Stąd trzeba je było przypisać dopiero teraz, do wszystkich siatek naraz (str. 297);
Siatkę można w Blenderze podzielić na obszary, z których każdy będzie przypisany do innego materiału (tzw. indeksu materiału) — str. 297. W ten sposób można przygotować element, którego część ma mieć kolor wnętrza samolotu, a część — kamuflaż zewnętrzny;
Nie zawsze na siatce można wyróżnić ściany, biegnące wzdłuż granicy podziału kolorów. W takim przypadku nie ma sensu ją zagęszczać wyłącznie z tego powodu. Lepiej będzie “namalować” ten fragment na teksturze (str. 298);
W Cycles masz do dyspozycji proste „elementy podstawowe”: shadery Diffuse, Glossy, Glass, Transparent. Łącząc je ze sobą w edytorze węzłów (Node Editor) możesz tworzyć efekty, odpowiednie dla realistycznych materiałów (str. 300);
Możesz także tworzyć swoje własne węzły — łącząc wybrany zespół elementów w grupę (str. 300). Grupowanie węzłów pozwala wyróżnić istotne parametry zespołu i ukryć wszystkie pozostałe. To zwiększa czytelność schematów. Ułatwia także wykorzystanie tego samego efektu w kilku różnych materiałach. W tym rozdziale zdefiniowaliśmy uniwersalny shader „powierzchni z połyskiem” — Gloss Paint, który został użyty w materiałach powierzchni zewnętrznych (B.Skin.Camouflage — str. 301) i wewnętrznych (B.Skin.Inner — str. 303);
Każdy „połyskliwy” materiał wymaga w Cycles właściwej orientacji ścian siatki (wektory normalne muszą być zwrócone „na zewnątrz”). Ściany o niewłaściwej orientacji mają na renderze charakterystyczną „lustrzaną” powierzchnię. Łatwo je znaleźć na podglądzie, nadając materiałowi jakiś ciemny kolor (str. 302). Ten efekt znika po skorygowaniu zwrotu normalnych (str. 302);
Nie należy tworzyć w modelu ścian, w których widoczne są obydwie strony (str. 303). Jedna z tych stron na pewno wyjdzie na renderze nieprawidłowo, ze względu na przeciwny zwrot wektora normalnego!
Mimo obiecującej nazwy, sam standardowy shader Glass BSDF nie wystarcza do uzyskania efektu odpowiedniego dla powierzchni szkła organicznego. Ma to związek z typem oświetlenia, wybranego dla naszej sceny. Wymaga dodania połyskliwości (poprzez połączenie z shaderem Glossy BSDF). Można także zastosować tu uproszczony efekt przejrzystych cieni (za pomocą shadera Transparent BSDF i flagi Input Path:Is Shadow Ray — str. 304). Taki efekt pozwala wyłączyć obliczenia tzw. kaustyki, co skraca czas renderowania obrazu;
Do odwzorowania szkła organicznego (a także zwykłego szkła) stworzyliśmy wyspecjalizowany shader Plexiglas (str. 304). Wykorzystamy go nie tylko w materiale osłony kabiny (B.Canopy.Glass), ale także w tarczach przyrządów pokładowych i osłonach świateł pozycyjnych;
Otoczeniem sceny zajmowaliśmy się do tej pory tylko przez chwilę, w pierwszej sekcji tego rozdziału (por. str. 291, 294). Wszystko, co wtedy zrobiliśmy, to rozjaśnienie domyślnej, jednolitej brawy tła za modelem.
W rzeczywistości nigdzie chyba nie zetkniesz się z taką „jednobarwną otchłanią. Do oceny komponownanych materiałów lepiej użyć czegoś, co bardziej przypomina docelowe otoczenie, w którym chcemy zobaczyć nasz model. Najlepiej się chyba o tym przekonać po ustawieniu materiału samolotu na coś w rodzaju wypolerowanego duralu. Taką powierzchnię otrzymasz, zmieniając ustawienia B.Skin.Camouflage w sposób pokazany przez Rysunek 5.3.1 (szczegóły — str. 1055).
W jednolitym otoczeniu (Rysunek 5.3.2a) model wcale nie wygląda jak „srebrna maszyna” (Rysunek 5.3.2b):
Rysunek 5.3.2 Metaliczna powierzchnia w sztucznym, jednolitym otoczeniu
Gdy zastosujesz nawet najprostszy (generowany przez program) obraz nieba: Sky Texture (Rysunek 5.3.3a, szczegóły — str. 1013), model wygląda zdecydowanie lepiej (Rysunek 5.3.3b):
Rysunek 5.3.3 Metaliczna powierzchnia w otoczeniu wygenerowanego obrazu nieba (Sky Texture)
Jeszcze lepsze efekty można uzyskać, podstawiając jako tło prawdziwe, panoramiczne zdjęcie (Rysunek 5.3.4):
Rysunek 5.3.4 Metaliczna powierzchnia w otoczeniu uzyskanym ze zdjęcia panoramicznego (Environment Texture)
(Szczegółowy opis, jak podstawiać takie zdjęcie jako Environment Texture znajdziesz na str. 1022).
Ale czy można w Blenderze „podstawić” za modelem jakieś zwykłe zdjęcie, powiedzmy takie jak te, które pokazuje Rysunek 5.3.5?
Rysunek 5.3.5 Zdjęcie z powietrza — tło dla obrazu naszego modelu (© Tomo.Yun — www.yunphoto.net).
To całkiem proste: należy podłączyć do wejścia Color shadera Background węzeł Texture Image z tą fotografią, nałożoną w trybie Texture Coordinate:Window (szczegóły — na str. 1033). Plik ze zdjęciem pokazywanym przez Rysunek 5.3.5 znajdziesz wśród materiałów towarzyszących tej książce (por. str. 22). Umieściłem go w folderze p40\background\ pod nazwąnebraska.png 1.
Aby dobrze dopasować model do fotografii, warto poprawić położenie słońca na scenie. Na zdjęciu, które wybraliśmy, widać tzw. „widmo Brockenu”: cień samolotu na chmurze, otoczony tęczową aureolą. To bardzo ułatwia nam zadanie: możemy być pewni, że słońce powinno znajdować się za kamerą. Proponuję ustawić źródło Sun tak, jak pokazuje to Rysunek 5.3.6:
Rysunek 5.3.6 Dopasowanie położenia słońca do fotografii
Przyznam się, że odsunąłem trochę słońce w prawo, by uzyskać odblask na owiewce kabiny!
Rysunek 5.3.7 przedstawia podgląd renderu tak przygotowanej sceny:
Rysunek 5.3.7 Model, ustawiony „przed zdjęciem” (wykorzystanie obrazu tła w mapowaniu Window)
Zwróć uwagę (por. Rysunek 5.3.7 i Rysunek 5.3.5), że obraz tła uległ rozciągnięciu, dopasowując się do proporcji okna renderu.
Mapowanie w trybie Window deformuje tło tak, by wypełniło okno renderu. Jeżeli nie chcesz takich zniekształceń, dopasuj proporcje ostatecznego obrazu (Render:Dimensions) do proporcji zdjęcia.
Takie proste „podstawienie” zdjęcia za modelem ma pewną wadę: nie możesz w znaczący sposób zmieniać jasności otoczenia (Background:Strength = 1.0). Jeżeli spróbujesz to zrobić, obraz tła stanie się za jasny lub zbyt ciemny.
Istnieje jeszcze jedyna wada tego rozwiązania. Obrazu w mapowaniu Window nie można podstawiać jako tła dla modelu o „srebrnych” i/lub połyskliwych powierzchniach. Tworzy się wówczas nieprawidłowy obraz odbić otoczenia (Rysunek 5.3.8):
Rysunek 5.3.8 Nieprawidłowe odbicia otoczenia, występujące w mapowaniu obrazu tła w trybie Window
W takiej sytuacji pozostaje zbudować otoczenie „hybrydowe” , w którym odbicia na powierzchni modelu będą pochodzić z panoramy otoczenia, a tło, widoczne za modelem — ze zdjęcia. Szczegółowy opis budowy takiego środowiska znajdziesz na str. 1036. W tej sekcji przedstawię tylko jego ogólną koncepcję.
Zacznijmy od stworzenia panoramy. Rysunek 5.3.9 przedstawia dwa obrazy, które w tym celu przygotowałem:
Rysunek 5.3.9 Przygotowanie obrazów panoramy
Każdy z nich zostanie przypisany do węzła Environment Texture, więc musi mieć proporcje 1:2 (por. str. 1022). Pierwszy z obrazów (Rysunek 5.3.9a) posłuży nam do odwzorowania górnej półsfery (nieba). (To darmowa próbka z portalu www.cgskies.com ) . Dolna część tej panoramy jest jednolicie czarna. Aby podstawić w to miejsce obraz ziemi o odcieniu zgodnym z obrazem tła, przygotowałem drugą panoramę (Rysunek 5.3.9b). Powstała ze złożenia obrazu tła z jego własnym „lustrzanym” odbiciem. Wolna przestrzeń powyżej nie ma znaczenia, więc wypełniłem ją kolorem białym — byleby tylko całość miała proporcje 1:2.
Panoramy najłatwiej jest sprawdzać za pomocą tzw. sondy — testowej kuli, w której powierzchni odbija się całe otoczenie (szczegóły — str. 1016). Rysunek 5.3.10 przedstawia złożenie obrazów górnej i dolnej półsfery za pomocą gradientu (Gradient Texture):
Rysunek 5.3.10 Kompozycja panoram górnej i dolnej półsfery za pomocą gradientu
Taką kompozycję (Rysunek 5.3.10d) buduje się z dwóch węzłów Environment Texture (Rysunek 5.3.10a,b), połączonych w węźle Color→Mix za pomocą gradientu (Rysunek 5.3.10c). (Szczegóły — str. 1039).
Rysunek 5.3.11 przedstawia odbicie tak zestawionego otoczenia na powierzchni modelu:
Rysunek 5.3.11 Odbicie panoramy na powierzchni modelu
Gdy panorama jest gotowa, można ją połączyć z obrazem tła używając węzła Light Path (Rysunek 5.3.12):
Rysunek 5.3.12 Dodanie obrazu tła (szczegóły — por. str. 1042)
Obraz tła (Image Texture) podłączyłem do odrębnego shadera Background. Pozwala to na niezależną regulację jasności odbić otoczenia na powierzchni modelu. Shadery panoramy i tła są łączone za pomocą flag Light Path: Is Camera Ray (tło) oraz LightPath: Is Transmission Ray (tło za szybą kabiny) (Rysunek 5.3.13):
Rysunek 5.3.13 Test połyskliwego modelu w otoczeniu hybrydowym
Uważam, że takie „hybrydowe” otoczenie może się przydać w wielu scenach. O wiele łatwiej jest znaleźć jakieś „płaskie” zdjęcie z ujęciem pasującym na tło, niż panoramę o odpowiednio wysokiej rozdzielczości. Poza tym obrazy, wykorzystywane w takim „składanym” otoczeniu, zajmują o wiele mniej miejsca w pamięci komputera niż panorama o profesjonalnej rozdzielczości (rzędu 10000x4000px lub większej).
Czasami możesz nie być w stanie określić skąd na takim zdjęciu ziemi z chmurami dokładnie pada światło słońca. Gdyby nie efekt „widma Brockenu” na obrazie tła, który wybraliśmy (por. Rysunek 5.3.5), także mielibyśmy z tym kłopot! Zresztą przekonaj się sam: powiększ obraz tła (zmniejszając Scale:X i Scale:Y w odpowiednim węźle Mapping — Rysunek 5.3.14a). Powiększony obraz przesuń do dołu i w lewo (Location:X, Y), aby z ekranu zniknął cień samolotu na chmurze i jego otoczka (Rysunek 5.3.14b):
Rysunek 5.3.14 Przesunięcie i powiększenie obrazu tła
Załóżmy, że tym razem będziemy widzieli model z prawej strony (Rysunek 5.3.15). Słońce nadal będzie oświetlać go z lewej, więc w tym ujęciu będzie świecić „z wnętrza” sceny. Aby podkreślić ten efekt, przesunąłem obiekt Sun tak, że znajduje się o jakieś 20º wyżej, a jego promienie padają pod kątem prostym do osi kadłuba samolotu.
Rysunek 5.3.16 przedstawia testowy render. Tym razem widzimy kadłub od zacienionej strony. Inna sprawa, że dla tak połyskliwej powierzchni ten cień nie jest specjalnie ciemny…
Rysunek 5.3.16 Rezultat dla zmienionych ustawień tła i oświetlenia
Uważam, że w tym ujęciu model wygląda równie dobrze, o ile nie lepiej, niż w poprzednim (Rysunek 5.3.13).
Dlaczego sądzę, że render pokazywany przez Rysunek 5.3.16 jest lepszy od tego pokazywanego przez Rysunek 5.3.13? Chodzi tu o dopasowanie renderowanego modelu do zdjęcia pokazywanego w tle. W idealnym przypadku powinien wyglądać tak, jak gdyby był naturalną częścią zdjęcia — do tego stopnia, by widz nie wiedział, co zostało dodane za pomocą komputera. Zazwyczaj musimy się zmagać z mniejszym lub większym wrażeniem sztuczności renderowanych komputerowo elementów sceny. Ta sztuczność przypomina wykonywane w XX-wiecznych studiach fotograficznych ujęcia modelu na tle planszy z fototapetą. W zasadzie w naszej scenie stosujemy podobną aranżację. Wydaje mi się, że samolot pokazywany przez Rysunek 5.3.13 wygląda na tle swojego zdjęcia bardziej „studyjnie” niż ten drugi (Rysunek 5.3.16). I tak będziemy ten efekt poprawiać na etapie tzw. postprocessingu (por. str. 583). Jednak im więcej wykona teraz za nas silnik renderujący, tym mniej się później napracujemy. Zazwyczaj lepszy efekt można osiągnąć z lepszych materiałów „wejściowych”.
Ujęcie modelu „pod słońce” jest trudniejsze, gdy mamy do czynienia z materiałem o mniejszym współczynniku odbicia otoczenia (Gloss Paint:Reflectivity) niż lustrzana powierzchnia wypolerowanej blachy aluminiowej (Reflectivity = 0.98). Popatrz chociażby na ten testowy render modelu pokrytego czerwonym, połyskliwym lakierem (Reflectivity = 0.6) (Rysunek 5.3.17):
Rysunek 5.3.17 Rezultat dla tego samego otoczenia i mniej „lustrzanej” powierzchni modelu
Ten głęboki cień na powierzchni kadłuba można rozjaśnić, zwiększając intensywność panoramy otoczenia (jej shadera Background — por. Rysunek 5.3.12):
Rysunek 5.3.18 Rozjaśnienie powierzchni modelu poprzez zwiększenie intensywności panoramy otoczenia
Szczegóły ustawień materiału powierzchni samolotu, wykorzystywanych w tej sekcji, znajdziesz na str. 1054 i następnych.
Zazwyczaj kamuflaż samolotu to jeszcze ciemniejsza, półmatowa (Roughness = 0.2) powierzchnia. Pokryjmy nasz model czymś, co w przybliżeniu odpowiada przepisowej barwie Olive Drab (Rysunek 5.3.19):
Rysunek 5.3.19 Ciemniejszy materiał (kamuflaż) w tym samym otoczeniu co poprzednio
Choć nie zmieniliśmy intensywności panoramy otoczenia (Background:Strength nadal jest równe 2.0), to cień na kadłubie samolotu znów stał się ciemniejszy. W zasadzie to efekt prawidłowy. Na wielu zdjęciach samolotów, wykonanych w słoneczny dzień, można dostrzec cienie o podobnym odcieniu.
Z drugiej strony — obiektyw kamery ma inną czułość niż oko ludzkie, i dlatego pogłębia intensywność cieni. Jeżeli chciałbyś uzyskać mniej „fotorealistyczny”, a bardziej intuicyjny obraz — możesz spróbować jeszcze bardziej zwiększyć jasność otoczenia (Background:Strength = 3.0 — Rysunek 5.3.20):
Rysunek 5.3.20 Kolejne zwiększenie intensywności panoramy otoczenia
Zwróć uwagę, że rozjaśniło to cienie, ale jednocześnie kolor kamuflażu stał się mniej nasycony — a dokładniej: bardziej błękitny (od koloru nieba). Wyraźniejsze stały się także odbicia otoczenia na owiewce kabiny.
Nie zawsze takie „wyblaknięcie” modelu jest efektem pożądanym. Zresztą czasami wcale nie trzeba aż tak bardzo „podkręcać” intensywności światła otoczenia. Na przykład Rysunek 5.3.21 przedstawia ujęcie, w którym umiarkowana intensywność (Background:Strength = 2.0) jest zupełnie wystarczająca:
Rysunek 5.3.21 Ujęcie, pozwalające zmniejszyć intensywność panoramy
W tym przypadku pomaga nam ustawienie zacienionych powierzchni pod dużym kątem do obserwatora. W wyniku efektu Fresnela odbija się w nich „więcej nieba”, niż w powierzchniach prostopadłych (porównaj barwę ogona i krawędzi natarcia prawego płata przy kadłubie).
Model nigdy nie ma jednolitej barwy. Jest to zawsze wypadkowa intensywności i barwy światła słońca, panoramy otoczenia, oraz kolorów samego materiału przypisanego do powierzchni.
Oznacza to, że modelarskie dywagacje na temat „prawdziwego” odcienia farb użytych do kamuflażu oryginalnych maszyn (por. str. 1251) można traktować tylko jako pierwsze przybliżenie. Reszta, zupełnie tak, jak w malarstwie, zależy od Twojej intuicji i wyczucia sceny.
Na przykład — czasami opłaca się, oprócz rozjaśnienia otoczenia, przesunąć nieco kamerę „do tyłu”. Chodzi o to, by nasz samolot nie zajmował całej szerokości obrazu (Rysunek 5.3.22):
Rysunek 5.3.22 Rozjaśniony i zmniejszony model — próba lepszej integracji z tłem
W ten sposób model „tonie” w tle, przez co staje się trochę lepiej zintegrowany ze zdjęciem.
Na zakończenie chciałbym dodać, że materiały, które wykorzystywaliśmy w tej sekcji, były niezwykle proste. W rzeczywistości na powierzchni samolotu gromadzą się różne zabrudzenia, zmatowienia, i inne lokalne zmiany. Aby je odtworzyć, musimy podłączyć wejścia naszych shaderów do tekstur. I o tym piszę w następnym rozdziale tej książki.
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-5.03.blend (por. str. 22).
Podsumowanie
Słońce i obraz panoramy otoczenia to dwa uzupełniające się źródła światła. Ich intensywność należy dobierać odpowiednio do jasności materiału modelu (str. 312-314);
Najprostszym otoczeniem, które daje efekt zbliżony do naturalnego jest Sky Texture (str. 306);
Obraz panoramiczny, wykorzystany jako Environment Texture, pozwala uzyskać realistyczne odbicia otoczenia na powierzchni modelu (str. 306). Niestety, takie panoramy zazwyczaj nie maja odpowiedniej rozdzielczości, aby można je było jednocześnie użyć w charakterze tła;
Dla modeli pokrytych matowym kamuflażem można stosować technikę „podstawiania” zdjęcia za model (z wykorzystaniem wyjścia Window węzła Texture Coordiante — str. 307, 308). Takie otoczenie nie sprawdza się jednak dla powierzchni połyskliwych (str. 308);
Uniwersalnym otoczeniem dla każdego modelu jest połączenie panoramy (str. 309), z płaskim obrazem (tzn. zwykłym zdjęciem) podstawionym jako tło (w mapowaniu Texture Coordinate:Window) za modelem. Panorama służy do uzyskania realistycznych odbić otoczenia na powierzchni modelu, a płaski obraz zapewnia tło, które widać za modelem i poprzez przejrzystą owiewkę kabiny. Do takiego połączenia należy wykorzystać flagi Is Camera Ray i Is Transmission Ray z węzła Light Path (str. 310);
Oświetlenie modelu należy dostosować do kierunku i intensywności światła widocznego na zdjęciu (str. 307). Czasami jednak na zdjęciach „z powietrza” trudno ocenić, skąd świeci słońce (str. 311);
W zasadzie, im ciemniejsza i bardziej matowa powierzchnia modelu, tym większą intensywność należy przypisać światłu (panoramie) otoczenia (str. 312, 313). Dla różnych kątów ujęcia tego samego modelu w tym samym otoczeniu ta intensywność może być różna (str. 314). Trzeba ją dobierać tak, aby cienie nie były zbyt jasne;
Barwa powierzchni modelu zależy nie tylko od koloru przypisanego materiału, ale także od barwy i jasności panoramy otoczenia i światła słońca (str. 311, 312, 314). Zależy także od kąta nachylenia powierzchni do obserwatora!
Jeżeli pozostawisz z brzegu obrazu trochę wolnej przestrzeni, wówczas model może lepiej „wtopić się w tło”. Poprawia to nieco realizm rezultatu;
Formowanie modelu jest etapem prac oczywistym nawet dla laika. Efekty, jakie można uzyskać za pomocą tekstury są już sekretem grafików, z której istnienia ludzie „spoza branży” nie zdają sobie sprawy. Dobrze przygotowane i odpowiednio nałożone obrazy mogą zmienić najprostszy model w zachwycające „cacko”. A źle wykonane tekstury popsują wygląd nawet najstaranniej ukształtowanej siatki.
Ten rozdział to wprowadzenie do tekstur w Cycles. Wyjaśniam tu podstawowe pojęcia i pokazuję typowe metody przygotowania obrazów powierzchni. Robię to na przykładzie niewielkiego „kawałka” modelu — statecznika pionowego i jego owiewki. Jeżeli masz już doświadczenie w tym zakresie — możesz od razu przejść do następnego rozdziału (na str. 359).
W tym rozdziale będziemy wykorzystywać materiały z towarzyszącego tej książce pliku source.zip. Pliki *.blend odpowiadające rezultatom poszczególnych sekcji rozdziału znajdziesz w pliku p40.zip, a foldery z obrazami ich tekstur — w pliku textures1.zip. (Adres miejsca, z którego można pobrać te pliki, znajdziesz na. str. 22).
Na powierzchni metalowego samolotu widać zawsze wiele linii połączeń fragmentów blach, którymi został pokryty. Jest ich tak dużo, że nie ma sensu odwzorowywać ich jako oddzielnych fragmentów siatki.
Rysunek 6.1.1 Rysunek łączenia blach — na podstawie planów | Rysunek 6.1.2 Nałożenie rysunku na powierzchnię modelu |
Na szczęście istnieje metoda alternatywna. Wystarczy, że przygotujesz obraz z liniami łączeń blach (Rysunek 6.1.1). Następnie nałożysz go na powierzchnię modelu (Rysunek 6.1.2). Obraz, który wykorzystujemy w ten sposób, nazywa się teksturą. Sama operacja nakładania na model — mapowaniem tekstury. Tekstury możesz w Cycles podłączyć wszędzie tam, gdzie węzeł ma pole wejściowe typu Color lub Value. Umożliwiają w ten sposób lokalną zmianę różnych właściwości materiału — barwy, szorstkość, połyskliwość, itp. Sam się o tym przekonasz w ciągu tego rozdziału.
Aby wprowadzać Cię stopniowo w niuanse teksturowania, zdecydowałem się w tej sekcji nałożyć przykładową teksturę na statecznik pionowy. Przy okazji przeprowadzimy trochę eksperymentów z przypisaniem tekstur do materiału. Proponuję, abyś nie wykonywał ich na „ogólnym” materiale B.Skin.Camouflage, który przygotowaliśmy w poprzednim rozdziale. Zróbmy z niego lokalną kopię, przypisaną do statecznika pionowego (B.250.Fin), o nazwie B.Skin.Test (Rysunek 6.1.3) :
Rysunek 6.1.3 Utworzenie kopii materiału B.Skin.Camouflage — o nazwie B.Skin.Test — do „eksperymentów” w tej sekcji.
(To typowe kopiowanie tzw. „bloku danych” w Blenderze. Jeżeli chcesz się dowiedzieć więcej, co to jest „blok danych”, „licznik użycia”, itp. — zajrzyj na str. 1215).
Najpierw zrobimy rysunek łączenia blach. Najlepiej jest go przygotować jako obraz wektorowy, a nie rastrowy. Użyjemy więc do tego Inkscape, a nie, jak do tej pory, Gimpa. Otwórz w Inkscape nowy rysunek (jeżeli robisz to po raz pierwszy — zerknij do wprowadzenia, na str. 679). Ustal jego rozmiary (File→Document Properties, str. 681) na 2048 x 2048 px (pikseli). (W razie czego — nie traktuj tych jednostek jako ostatecznych. Gdy będzie to potrzebne, bez problemu uzyskasz z tego rysunku obraz o większej rozdzielczości, np. 4096 x 4096). Wstaw (File→Import... , str. 682) w ten rysunek obraz rzutu z boku naszego P-40:
Rysunek 6.1.4 Rysunek w Inkscape z wstawionym fragmentem planów samolotu
Od razu zmniejsz wstawiony obraz (jak — str. 709) i przesuń (jak — str. 707) w prawy górny narożnik. Aby zapobiec bałaganowi w rysunku, każdy rzut umieścimy na osobnej warstwie. Rzut z boku nie znajduje się na razie na żadnej, więc:
zmień nazwę aktualnej warstwy (Layer→Rename Layer…, por. str. 686) na nazwę BP-Left (wszystkie nazwy warstw planów będą miały przedrostek BP od angielskiego blueprint);
dodaj nową warstwę (Layer→Add Layer…, p. str. 687) o nazwie Drawing, ponad aktualną (Above current);
uczyń warstwę Drawing warstwą aktualną (por. str. 686);
Narysuj na warstwie Drawing (por. str. 694) linie łączenia blach na stateczniku pionowym (Rysunek 6.1.5):
Rysunek 6.1.5 Narysowanie krawędzi blach poszycia na stateczniku pionowym
W razie czego pamiętaj, że na planach poprawny obrys narysowaliśmy linią czerwoną (por. str. 56). Nie dziw się więc, że nie trzymam się oryginalnych, „czarnych” planów. Są w tym miejscu błędne. Narysuj krawędzie blach ciągłą, czarną linią o grubości 0.5 px (por. str. 695). Jej końcówki mogą wystawać za obrys (Rysunek 6.1.5).
Dodaj jeszcze jedną warstwę, pomiędzy warstwą Drawing i warstwą BP-Left. Nadaj jej nazwę Bkg-White. Umieścimy na niej pomocniczy kwadrat, który będzie służył jako tło dla linii. Aby był widoczny, pozostaw mu cienką ramkę (0.25 px). Na razie kwadrat tła nie obejmuje całego rysunku, a tylko ten fragment, który przeniesiemy jako teksturę do Blendera (Rysunek 6.1.6):
Rysunek 6.1.6 Obszar obrazu do przeniesienia do Blendera
Obwódce kwadratu tła tekstury nadałem kolor niebieski (by łatwo odróżnić jego kontur od linii samej tekstury).
Zapisz (File→Save) rysunek Inkscape do pliku o nazwie, powiedzmy, p40\textures\6.01\texture.svg (robimy to po to, by nie stracić przypadkiem dotychczasowej pracy). Następnie zaznacz kwadrat z warstwy Bkg-White i wywołaj polecenie File→Export Bitmap (z ustawieniami: Export area: Selection, 180 dpi — por. str. 684). Zapisz plik jako p40\textures\6.01\blueprint.png. Powinieneś uzyskać taki sam rozmiar tego obrazu (w pikselach), jak zaznaczony na rysunku kwadrat — 512 x 512px.
Teraz wróćmy do Blendera. Zaznacz statecznik pionowy, przejdź do ustawień materiału (Node Editor), i dodaj do niego pierwszą teksturę (poleceniem Add→Texture→Image Texture — por. str. 1020). Przypisz do tego węzła plik blueprint.png, a sam węzeł przyłącz do barwy Specular shadera Gloss Paint (Rysunek 6.1.7a):
Rysunek 6.1.7 Tekstura (barwy Specular), przypisana do materiału B.Skin.Test
Efekt jest na razie zaskakujący: cały statecznik wypełnił się kolorem niebieskim (Rysunek 6.1.7b)! Co się tutaj właściwie stało? No cóż, nie wskazaliśmy Blenderowi metody, jakiej ma użyć do nałożenia dwuwymiarowego obrazu na trójwymiarową siatkę. (Nie podłączyliśmy niczego do wejścia Vector węzła Image Texture). W tej sytuacji Blender użył tzw. współrzędnych UV siatki (więcej o nich opowiem później — na str. 335). A że domyślnie wszystkie te współrzędne są równe 0, stąd na całym stateczniku rozpostarty został pojedynczy piksel obrazu blueprint.png, znajdujący się w punkcie X=0, Y=0: fragment niebieskiej ramki (por. Rysunek 6.1.6)!
Dobrze, więc dodajmy do naszego schematu źródło różnych współrzędnych tekstur: węzeł Texture Coordinate. W poprzednim rozdziale używaliśmy do mapowania panoram współrzędnych jego wyjścia Generated (por. str. 311), ale tutaj proponuję wykorzystać wyjście Object (Rysunek 6.1.8a, patrz także str. 1072):
Rysunek 6.1.8 Efekt bezpośredniego nałożenia obrazu we współrzędnych Texture Coordinate:Object
Coś się zmieniło: cały statecznik został pokryty miniaturowymi obrazkami tekstury! (Rysunek 6.1.8b,c). Na pewno nie jest to jeszcze to, o co nam chodziło. Jednak przynajmniej widać, że tekstura jest nakładana na boki siatki, tak jak pokazywał to jak pokazuje to na str. 317, Rysunek 6.1.2. Gdy podstawowy kierunek jest poprawny, wystarczy wstawić pomiędzy Texture Coordinate i Image Texture dodatkowy węzeł Mapping. Posłuży nam do proporcjonalnego rozciągnięcia pojedynczego obrazu na całą powierzchnię statecznika (Rysunek 6.1.9):
Rysunek 6.1.9 Dopasowanie obrazu tekstury do statecznika za pomocą węzła Mapping
Parametry Location:X,Y oraz Scale:X,Y tego mapowania można ustalić metodą kolejnych przybliżeń (Rysunek 6.1.9a). Każda tych iteracji polega na zmianie skali (pamiętaj: im mniejsza skala, tym większy obraz!), po której następuje zmiana położenia (Location), kompensująca zmianę rozmiaru obrazu.
Muszę przyznać, że dopasowanie tej tekstury do modelu zajęło mi chwilę czasu. Pomocne okazały się linie charakterystyczne, umieszczone na planach. Najpierw dopasowałem odległość pomiędzy górną krawędzią owiewki statecznika i krawędzią wycięcia na wyważenie steru. To pozwoliło dobrać skalę (Scale:X i Scale:Y — jest w obydwu kierunkach identyczna) i ustalić położenie w pionie (Location:Y). Położenie w poziomie (Location:X) dobrałem na podstawie położenia krawędzi natarcia statecznika. Rezultat — odpowiednie przesunięcie i skalę mapowania — pokazuje Rysunek 6.1.9a). Rysunek 6.1.9b) przedstawia teksturę po dopasowaniu.
To tylko eksperyment z mapowaniem współrzędnych tekstury w trybie Object. W tym wprowadzeniu do tekstur nie chciałem od razu wprowadzać do rozwinięć siatki w przestrzeni UV. Później w większości przypadków będziemy wykorzystywali właśnie współrzędne UV, które omówimy później (na str. 335).
Fragmenty planów (czerwone linie) na obrazie blueprint.png ułatwiły nam poprawne dopasowanie tekstury do obiektu. Teraz czas je zakryć. Wróć na chwilę do Inkscape i zwiększ nieprzejrzystość (Opacity) warstwy Bkg-White do 100 (Rysunek 6.1.10a):
Rysunek 6.1.10 Przygotowanie i użycie tekstury z zakrytymi liniami planów.
Zapisz (File→Export Bitmap...) zaznaczony w Inkscape obszar do pliku, tym razem o nazwie texture.png. W Blenderze przypisz go, w miejsce blueprint.png, do węzła Image Texture. W rezultacie na powierzchni statecznika powinny pozostać tylko narysowane linie połączenia blach poszycia (Rysunek 6.1.10b).
Na razie same linie połączeń blach nie prezentują się zbyt okazale. Dodajmy do nich coś więcej — nity. Nit na rysunku powierzchni to małe kółko. Proponuję uzyskać ten efekt za pomocą linii kropkowej (Rysunek 6.1.11a):
Rysunek 6.1.11 Naniesienie linii nitów za pomocą linii kropkowych
Linie nitów rysuję na oddzielnej warstwie, którą nazwałem Rivets. Dla takich rozmiarów rysunku jak w tym przykładzie nadaję im szerokość 1 px. Wśród standardowych wzorów kropkowania, dostępnych w Inkscape, nie ma takiego, który pozwala uzyskać odpowiedni wzór „samych kółek”. Dlatego trzeba w oknie XML Editor zmienić w jednym miejscu styl linii (Rysunek 6.1.11b). Należy tam ręcznie zmodyfikować wartości atrybutu stroke-dasharray na „0.05, 3.05”. Od tej chwili nie możesz zmieniać właściwości tej linii w standardowym oknie Fill and Stroke, bo Inkscape zmieni styl linii na ciągłą. W tej sytuacji najprościej jest dodawać kolejne rzędy nitów poprzez skopiowanie jednej z poprzednio stworzonych linii. Szczegółowy opis rysowania nitów, wraz z uwagami na temat ich krzyżowania, znajdziesz na str. 716.
Alternatywną metodą uzyskania nitów jest napisanie ich jako tekstu, złożonego z samych spacji i znaków „●” (unicode - hex. 25CF). (O tym, jak tworzyć napisy w Inkscape — str. 712). Wzorcowe znaki „●” możesz skopiować do schowka z pliku source\textures\dots.txt (por. str. 22), a potem wkleić do Inkscape. Nadaj czcionce jakiś niewielki rozmiar — np. 3px (Rysunek 6.1.11a). W takim tekście możesz przesuwać nity dodatkowymi spacjami, gdy któryś z nich wypada nie tam, gdzie trzeba. To przydaje się w np. miejscach, gdzie linie nitów się krzyżują. (Ten sam efekt w liniach kropkowych uzyskasz lokalnie przerywając linię). W odróżnieniu od nitów uzyskanych z linii kropkowych, linie pisane jako tekst mogą mieć ciemną obwódkę. Wynika to z faktu, że możesz oddzielnie w nich sterować wypełnieniem (Fill), a oddzielnie — barwą i szerokością konturu (Stroke) (Rysunek 6.1.12):
Rysunek 6.1.12 Alternatywna metoda rysowania nitów: jako tekstu
Pochyłe linie nitów uzyskasz obracając tekst. Długość rzędu nitów regulujesz wklejając nowe fragmenty napisu, lub je usuwając. Gdy nity biegną wzdłuż linii krzywej — tak jak na krawędzi natarcia końcówki (Rysunek 6.1.12b) — wykorzystaj funkcję Text→Put on Path (str. 714). Wzorcowe krzywe, wzdłuż których wyginany jest tekst najlepiej umieść na oddzielnej warstwie (nazwij ją np. Helpers).
Nity uzyskane za pomocą tekstu mogą być przydatne, gdy będziesz tworzył jakieś dokładne tekstury o bardzo dużej rozdzielczości. Ich rysowanie jest nieco bardziej pracochłonne od linii kropkowych — szczególnie szwów nitów biegnących po krzywej. O wiele większą wadą rozwiązania opartego o ciągi tekstu jest problem z wydajnością Inkscape. Początkowo w pracy nad modelem używałem właśnie tej metody. Gdy kończyłem kompletny rysunek powierzchni P-40, ze wszystkimi warstwami i filtrami, zauważyłem wyraźne spowolnienie działania Inkscape. Każda zmiana warstwy lub powiększenia zajmowała mu sporo czasu. Po dłuższym przełączaniu warstw Inkscape kończył się z błędem krytycznym (na komputerze z 1 GB RAM, gdy program zaalokował nieco ponad 700MB RAM). Dlaczego? Okazało się, że przyczyną są nity, odwzorowane jako tekst. Testowo usunąłem z pliku Inkscape wszystkie klony warstwy Rivets, a później także samą warstwę. Spowodowało to zmniejszenie rozmiaru pliku rysunku o 40%, a zapotrzebowanie programu na RAM spadło o 50%. Inkscape bez tej warstwy zaczął działać całkiem normalnie (można powiedzieć, że „odzyskał dawny wigor”).
Do odwzorowania nitów radzę używać zmodyfikowanych linii kropkowych (tzn. rozwiązania przedstawianego przez Rysunek 6.1.11, a szczegółowo na str. 716). Inkscape wtedy nie spowalnia, a efekt na teksturach o zwykłej rozdzielczości jest taki sam jak dla nitów „tekstowych”.
Wygląda na to, że Inkscape nie jest zoptymalizowany do wyświetlania dużej liczby liter. Na pełnej teksturze przeciętnego myśliwca, jakim jest P-40, naliczyłem ok. 60 tysięcy nitów. Jeżeli przymierzasz się do modelu większego samolotu — np. bombowca — tych nitów będzie trzy lub cztery razy więcej. Odwzorowanie ich jako tekstu zupełnie zablokuje Inkscape, tym bardziej że obecnie ten program potrafi wykorzystać tylko jeden wątek procesora. Z drugiej strony — na teksturach o rozdzielczości 2048x2048, a nawet 4096x4096 px każdy nit zajmuje dosłownie kilka pikseli. Przy tak niewielkim rozmiarze rastra giną wszystkie szczegóły, jak cienkie obwódki wokół każdego „tekstowego” nitu.
Aktualny schemat i rezultat mapowania tekstury (512x512 px) przedstawia Rysunek 6.1.13a:
Rysunek 6.1.13 Obraz nitów — naniesiony na statecznik jako tekstura barwy
Na razie linie połączeń blach i nity wyglądają jak namalowane flamastrem na powierzchni statecznika. To dlatego, że są nałożone jako tekstura barwy. O tym, jak poprawnie nanosi się takie szczegóły, opowiem w następnej sekcji.
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-6.01.blend, a pliki tekstur — w folderze model\p40\textures\6.01\* (por. str. 22).
Podsumowanie
Tekstur używamy, by zwiększyć realizm renderowanych obiektów. Idea jest prosta: zamiast modelować drobne szczegóły (np. nit po nicie) lepiej jest je narysować i nałożyć taki rysunek na model;
Obrazy tekstur podłącza się w materiałach Cycles za pomocą węzła Image Texture. Można je podłączyć do dowolnego wejścia typu Color lub Value. Oznacza to że służą nie tylko do nanoszenia barw na powierzchnię modelu. Mogą np. także lokalnie zmieniać („modulować”) rozproszenie światła (parametr Gloss Paint:Roughness) czy intensywność odbłysków (Gloss Paint:Reflectivity);
Sposób nałożenia obrazu tekstury na model określa się poprzez wybór jednej z metod dostarczanych przez węzeł Texture Coordinate. Czasami może być konieczne zmodyfikowanie tego wejścia za pomocą transformacji (węzła Mapping — por. str. 320).
Obrazy do tekstur można przygotować w Inkscape (w szczególności drobne detale techniczne — str. 318). Inne elementy, jak np. plamy i zabrudzenia, łatwiej będzie „malować” w Gimpie. Czasami będziemy po kolei wykorzystywać obydwa programy.
Do szybkiego nałożenia linii nitów na rysunek w Inkscape najlepiej użyć specjalnych linii kropkowych (str. 321). Jeżeli chcesz je odtworzyć bardzo dokładnie, można użyć w tym celu odcinków tekstu, w których każdy nit to pojedynczy znak „●” (unicode — hex. 25CF) (str. 322). Odstępy pomiędzy nitami to spacje. Jednak użycie tekstu bardzo obciąża procesor — do tego stopnia, że zmieszczenie kompletnego obrazu powierzchni na jednym rysunku może okazać się niemożliwe.
Tekstury można użyć nie tylko do „rysowania” po powierzchni modelu! Spróbuj obraz przygotowany w poprzedniej sekcji podłączyć do wejścia Displacement węzła Material Output (Rysunek 6.2.1a):
Rysunek 6.2.1 Ten sam obraz, ale użyty jako „mapa nierówności” (Displacement) .
Coś się zmieniło, prawda? W miejscu każdej linii pojawiła się szczelina, a nitu — wgłębienie (Rysunek 6.2.1b). Aby sterować intensywnością tego efektu, wstaw za węzłem tekstury węzeł Math:Multiply (Rysunek 6.2.2):
Rysunek 6.2.2 Zmniejszenie intensywności tekstury nierówności
Jeżeli odwrócić barwy obrazu tekstury za pomocą pomocniczego węzła Invert (Rysunek 6.2.3a), wówczas ciemne obszary staną się wypukłe. W ten sposób możesz uzyskać efekt zwykłych nitów (Rysunek 6.2.3b):
Rysunek 6.2.3 Uzyskanie wypukłych nierówności
Węzeł Invert, użyty w schemacie który przedstawia Rysunek 6.2.3, używaj wszędzie tam gdzie potrzebujesz matematycznej operacji (1-x), a wartości x są z przedziału od 0.0 do 1.0.
Poszycie, jakie pokazuje Rysunek 6.2.2b) Rysunek 6.2.3b), wygląda jak na plastikowym modelu samolotu. Prawdziwy P-40 miał nity z tzw. „wpuszczanym łbem” , nie wystające ani nie zagłębione w powierzchnię blachy1. Były przez to o wiele mniej widoczne, niż szczeliny łączenia fragmentów poszycia2. (Widoczność takich nitów wynika bardziej z gromadzenia się kurzu i innych zabrudzeń wokół ich krawędzi. Stają się także bardziej widoczne na różnych obtarciach lub na wypolerowanych, metalowych powierzchniach. Na tych ostatnich często z powodu innego odcienia materiału).
Musimy poprawić nasz rysunek, aby odwzorować te niuanse. Przy okazji przygotujemy go pod jednoczesne odwzorowanie i wypukłości, i wklęsłości. Będzie to możliwe, jeżeli użyjemy tła o naturalnym odcieniu 50% szarości, zamiast bieli. Barwę tła traktuj jako „poziom odniesienia”. Wszystko to, co jest jaśniejsze — pojawi się jako wypukłość, a co ciemniejsze — jako zagłębienie (Rysunek 6.2.4).
Rozbudujmy nasz plik Inkscape o kolejne warstwy:
Rivets: umieść ją pod warstwą Drawing. Przenieś na nią (Shift-PgDn — p. str. 721) wszystkie narysowane nity. Zmniejsz nieprzejrzystość tej nowej warstwy na 45%;
Bkg-Grey: umieść ją pod warstwą Drawing. Skopiuj (Ctrl-D — p. str. 715) na nią biały prostokąt tła (z warstwy Bkg-White) i zmień jego intensywność na 50% (w zakładce barw Fill:HSL ustaw L na 128 — por. str. 695);
Dodatkowo: zmień nazwę dotychczasowej warstwy Drawing na Lines, bo pozostały na niej same linie. Rysunek 6.2.5 pokazuje rezultat, jaki powinieneś osiągnąć:
Rysunek 6.2.5 Bardziej poprawna mapa nierówności .
Nity na rysunku są tylko o 7% ciemniejsze od tła. (Lepiej wyglądają jako odrobinę zagłębione, niż odrobinę wypukłe). Powróćmy więc do mapowania nierówności jako wklęsłych (czyli bez węzła Invert — Rysunek 6.2.6a):
Rysunek 6.2.6 Mapa nierówności ze zróżnicowaną głębokością szczelin i nitów
Szczeliny pomiędzy panelami poszycia są tak samo głębokie jak poprzednio (por. Rysunek 6.2.6b i Rysunek 6.2.2b ze str. 324). Jednocześnie zmniejszyła się głębokość nitów (bo teraz ich odcień nie różni się specjalnie od poziomu szarości tła). W efekcie widać je tylko na odpowiednio podświetlonych fragmentach statecznika (Rysunek 6.2.6c). Na innych zanikają.
Nie staraj się odtworzyć rzędów wpuszczanych nitów tak wyraźnie jak na plastikowych modelach samolotów. Lepiej przyjrzyj się, jak wyglądają (a czasami właśnie ich w ogóle nie widać!) na zdjęciach.
Do tej pory na naszej mapie nierówności krawędzie paneli były modelowane za pomocą wklęsłego „rowka”. Jest to całkiem dobre przybliżenie rzeczywistego poszycia. W dodatku łatwe do wykonania: wystarczy narysować ciemne linie wzdłuż każdego połączenia. Stosuj ją, jeżeli nie chcesz za głęboko wchodzić w detale.
Jeżeli jednak chcesz dopracować ten szczegół, to powinieneś uwzględnić sposób łączenia paneli poszycia stosowany we wszystkich samolotach z tego okresu: „na zakładkę” .
Popatrz zresztą sam na zbliżenie fragmentu ogona muzealnego P-40B (Rysunek 6.2.7). Z bliska widać wyraźnie grubość każdego fragmentu poszycia. Jeżeli nawet w silnym świetle lampy błyskowej jakiś fragment połączenia rzeczywiście wygląda na „rowek”, to to wrażenie szybko znika po przyjrzeniu się dalszej części tego samego szwu.
Aby odwzorować łączenie blach „na zakładkę”, linie połączenia zastąpiłem złożeniem paneli wypełnionych odpowiednim gradientem. To właśnie kontrast pomiędzy lewym i prawym brzegiem tych obszarów tworzy na modelu efekt „zakładki”. Panele umieściłem na warstwach Panel H i Panel V. Dodatkowe elementy, które są nałożone „na wierzch wszystkiego” (jak blacha na końcówce statecznika) są na warstwie Overlay. Do ich wypełnienia użyłem odcienia 90% bieli (L=232) (Rysunek 6.2.8):
Rysunek 6.2.8 Odwzorowanie łączenia „na zakładkę” za pomocą gradientów
Warstwę Lines z dotychczas wykorzystywanymi czarnymi liniami podziału blach także zachowałem, ale wyłącznie na potrzeby innych tekstur.
Rysunek 6.2.9 przedstawia uzyskany rezultat: dla połyskliwej, „srebrnej” powierzchni (a) i dla matowej (b):
Rysunek 6.2.9 Rezultat na powierzchni modelu
Zwróć uwagę, że to łączenie blach „na zakładkę” wydaje się lepiej wyróżniać poszczególne fragmenty poszycia na matowej powierzchni (Rysunek 6.2.9b). To ważne, bo kamuflaż samolotu był nanoszony farbami matowymi. Na powierzchni połyskliwej, takiej jak ta pokazywana przez Rysunek 6.2.9a, krawędzie paneli czasami giną w odbiciach otoczenia.
To jeszcze nie koniec „kosmetyki” naszej testowej powierzchni. Blacha poszycia jest zawsze trochę wygięta wzdłuż linii nitów, tworząc pomiędzy nimi charakterystyczne wybrzuszenia. Ten efekt pokazuje Rysunek 6.2.10.
Należy podkreślić, że egzemplarz pokazany na ilustracji to maszyna odrestaurowana. Seryjne P-40, gdy opuszczały zakłady Curtiss, miały o wiele gładsze poszycie. Takie nierówności pojawiały się później, w trakcie eksploatacji.
Aby je odtworzyć, przygotujemy teraz drugi obraz tekstury. W źródłowym rysunku Inkscape dodałem pod warstwą Rivets warstwę Shadows. To jasnoszare (18% — L = 208) linie o szerokości 3px (Rysunek 6.2.11):
Rysunek 6.2.11 Przygotowanie drugiej tekstury nierówności
Połączyłem linie z warstwy Shadows w jedną grupę i nadałem im rozmycie (Blur) = 2 (Rysunek 6.2.12):
Rysunek 6.2.12 Rozmycie wgłębień pod nitami
Warstwy Rivets i Shadows, wraz z białym tłem (Bkg-White) zapisałem do pliku rastrowego o nazwie blur.png.
Aby uzyskać efekt stopniowego rozmycia, wczytałem plik blur.png do Gimpa (Rysunek 6.2.13). GIMP umieści zawartość tego pliku na domyślnej warstwie o nazwie blur.png. Zmieńmy jej nazwę na Background. Następnie Skopiuj warstwę Background w nową (Layer→Duplicate Layer) (Rysunek 6.2.14):
Rysunek 6.2.13 Obraz blur.png w GIMP. | Rysunek 6.2.14 Obraz, powielony na nowej warstwie. |
Zawartość nowej warstwy poddałem operacji Filters→Blur→Gaussian Blur. Zastosowałem rozmycie o promieniu (Gaussian Blur:Blur Radius) = 5. (Więcej na temat rozmycia metodą Gaussa w GIMP znajdziesz na str. 658). Zmieniłem nazwę rozmytej warstwy na Blur05.
W wyniku rozmycia uzyskałem taki rezultat, jaki pokazuje Rysunek 6.2.15a):
Rysunek 6.2.15 Złożenie obrazu oryginalnego (ostrego) i rozmytego za pomocą operatora Multiply.
Warstwa Blur05 była nieprzejrzysta. Wystarczyło jednak tylko zmienić sposób jej połączenia z warstwami leżącymi pod spodem (Layers:Mode) z Normal na Multiply (Rysunek 6.2.15b). Mode= Multiply sprawiło, że na obrazie pojawią się także nity i linie z leżącego pod spodem oryginalnego obrazu (Rysunek 6.2.15c).
Szczegóły z warstwy Background były jednak zbyt wyraźne na tle rozmytej warstwy Blur05 (Rysunek 6.2.15c). Aby temu zaradzić, wstawiłem do rysunku nową warstwę (Layer→New Layer, por. str. 629), wypełnioną białym kolorem tła (Fill Type:Background color). Nadałem jej nazwę Filter i umieściłem zaraz ponad Background (Rysunek 6.2.16):
Rysunek 6.2.16 Użycie jednolitej, białej warstwy Filter, o częściowej przejrzystości, do rozjaśnienia obrazu z Background.
Gdy zmniejszyłem nieprzejrzystość warstwy Filter (Opacity — p. Rysunek 6.2.16) do 80-85% — uzyskałem właściwy odcień elementów z warstwy Background.
Następnie wstawiłem do rysunku i poddałem rozmyciu kolejne kopie warstwy Background. Powstały w ten sposób warstwy Blur10 i Blur25 (Rysunek 6.2.17):
Rysunek 6.2.17 Kolejne rozmycia, dodane do obrazu Blur.
Do rozmycia każdej z nich używałem Gaussian Blur z coraz większy promieniem: 10px (Blur10) i 25px (Blur25). Wszystkie „rozmyte” warstwy łączyłem resztą obrazu tak samo jak warstwę Blur05 — trybem Multiply. Rezultat — obraz ze stopniowo rozmywającymi się liniami — przedstawia Rysunek 6.2.17.
Na wszelki wypadek (to, co robimy w tej sekcji to przecież tylko test!) zapisz (File→Save As) obraz Blur do pliku Gimpa: blur.xcf. Dzięki temu nie stracimy informacji o warstwach i innych szczegółów, które w nim umieściliśmy. Dodatkowo, zapisz kopię tego obrazu (File→Export As) jako blur.png. (Nadpisz oryginalny plik). Ten właśnie obraz rastrowy wykorzystamy teraz w Blenderze.
Podstawmy blur.png do naszego schematu jako drugą teksturę nierówności (Rysunek 6.2.18):
Rysunek 6.2.18 Podłączenie drugiej tekstury z „rozmytym” obrazem nierówności (blur.png)
Nowa tekstura to kolejny węzeł Image Texture. Jest podłączony do tych samych współrzędnych mapowania (wejścia Vector), co pierwszy. Barwy z obydwu tekstur traktuję jako współczynniki (bo są odcieniami szarości) i połączyłem za pomocą Math:Multiply. Za tym nowo dodanym węzłem pozostawiłem poprzednią operację mnożenia (Multiply) przez stałą. W ten sposób jej wartość (Multiply:Value) nadal służy do regulowania intensywności (głębokości) wszystkich nierówności (Rysunek 6.2.19):
Rysunek 6.2.19 Rezultaty pomocniczej tekstury nierówności (blur.png) w zależności od intensywności (Multiply:Value)
Rysunek 6.2.19a) przedstawia rezultat na próbnym renderze uzyskany dla typowych, umiarkowanych nierówności. Gdy jednak jest to potrzebne, możesz zwiększyć intensywność tekstury, wyginając niemiłosiernie całą powierzchnię Rysunek 6.2.19b). Jeżeli chciałbyś, mógłbyś dodać także w GIMP do tekstury blur.png parę nieregularnych wgnieceń. Może nie na stateczniku pionowym (bo to najmniej prawdopodobne miejsce), ale np. na pokrywach komór amunicyjnych lub okapotowaniu silnika.
Dlaczego takie zagłębienia wzdłuż nitów zamodelowałem oddzielną teksturą, a nie umieściłem ich jako elementu obrazu pierwszej? Przecież mógłbym obydwa obrazy — texture.png i blur.png — połączyć jako dwie oddzielne warstwy trybem Multiply w GIMP, i zapisać uzyskany rezultat.
Przyczyn jest kilka:
użycie dwóch tekstury pozwala na oddzielne sterowanie intensywnością każdego z obrazów. (Co prawda — nie w takim schemacie jak ten przedstawiony przez Rysunek 6.2.18, ale o tym za chwilę);
pomocnicza tekstura z rozmytym obrazem nierówności może mieć mniejszą rozdzielczość od podstawowej tekstury nierówności;
Na schemacie, który przedstawia Rysunek 6.2.18, zastosowaliśmy do sterowania intensywnością tekstur węzeł Math:Multiply. Mnożenie przez stałą z zakresu 0..1 przy okazji „spłaszczenia” obrazu zawsze go przyciemnia (por. str. 1249). To nie ma specjalnego znaczenia, dopóki wykorzystujemy pojedynczą teksturę nierówności. Jednak efekt przyciemnienia uniemożliwia stosowanie takich węzłów do niezależnego sterowania intensywnością tekstur łączonych przez węzeł Multiply. Aby sterować niezależnie głębokością podstawowych nierówności (z pliku texture.png) i wygięć blachy (z pliku blur.png) trzeba zamiast mnożenia przez stałą zastosować inne rozwiązanie: np. węzeł Color:Mix (Rysunek 6.2.20):
Rysunek 6.2.20 Materiał z niezależnym sterowaniem intensywnością każdej z tekstur nierówności
Zwróć uwagę, że obraz tekstury jest w nich użyty w charakterze współczynnika Fac (Rysunek 6.2.20). Zasadę działania węzła w tej roli przedstawia Rysunek 6.2.21a), a rezultat — Rysunek 6.2.21b):
Rysunek 6.2.21 Oddzielne sterowanie intensywnością tekstury blur.png
Dla zwiększenia przejrzystości schematów proponuję stworzyć na bazie węzła Color:Mix grupę Moderate (Rysunek 6.2.22, por. także str. 1062):
Rysunek 6.2.22 Wewnętrzna konstrukcja pomocniczej grupy Moderate
Rysunek 6.2.23 przedstawia zmodyfikowany schemat materiału, wykorzystujący do sterowania teksturami nierówności węzły Moderate:
Rysunek 6.2.23 Zmodyfikowany schemat, wykorzystujący grupy Moderate
Uważam, że sterowanie nierównościami za pomocą parametru Moderate:Range jest o wiele prostsze i bardziej intuicyjne niż modyfikacja intensywności barwy Color1 w węzłach Color:Mix (porównaj Rysunek 6.2.20 i Rysunek 6.2.23)3! Zmodyfikowany schemat pozwala wygodnie sterować stopniem „eksploatacyjnego pogięcia blachy” na naszym modelu (Rysunek 6.2.24):
Rysunek 6.2.24 Sterowanie wygięciami powierzchni
Nowe P-40 po opuszczeniu fabryki mogły mieć taką powierzchnię, jak ta którą przedstawia Rysunek 6.2.24a). Po wielu latach intensywnej eksploatacji blacha na bardziej obciążonych miejscach samolotu (np. skrzydłach) mogła wyglądać tak, jak przedstawia to Rysunek 6.2.24b). (Właściwie wtedy należy taką maszynę złomować).
Nasz test będziemy jeszcze kontynuować w następnej sekcji (6.3), gdzie zajmiemy się zagadnieniem rozwijania teksturowanych powierzchni. W istocie rzadko kiedy zdarza się, że teksturę można dobrze nałożyć takim płaskim mapowaniem, jakie stosowaliśmy do tej pory (por. str. 317, Rysunek 6.1.2). Dalszą poprawę odwzorowania drobnych szczegółów powierzchni uzyskamy wykorzystując teksturę rozpraszania światła (Ref). Taka tekstura pomaga odwzorować efekt zmiany połyskliwości wywołanych przez drobne zanieczyszczenia, gromadzących się w każdej nierówności poszycia samolotu. Omówimy ją w kolejnej sekcji tego rozdziału.
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-6.02.blend, a pliki tekstur — w folderze model\p40\textures\6.02\* (por. str. 22).
Podsumowanie
Celem tej sekcji było wprowadzenie do zagadnień związanych z teksturami nierówności. Wykorzystujemy je do odtworzenia szczegółów powierzchni samolotu. Rozwiązanie, które uzyskaliśmy, składa się na razie z dwóch tekstur:
1. podstawowej tekstury nierówności, zawierającej ostry i dokładny rysunek „technicznych” nierówności na poszyciu: połączeń blach, nitów. W tym teście był to obraz texture.png (w modelu użyjemy obrazu o innej nazwie);
2. dodatkowej tekstury nierówności, bazującej na rozmytym obrazie tekstury 1. Ta tekstura odpowiada za „kosmetyczne” efekty dodatkowe, np. nieznaczne pofałdowania blachy W naszym teście to obraz blur.png;
Bazową barwą dla tekstur nierówności powinien być neutralny szary (50%). Elementy wypukłe są rysowane jako jaśniejsze, a wklęsłe — ciemniejsze (trochę tak, jak poziomice na mapie — str. 325);
Podstawową teksturę nierówności najprościej jest narysować w Inkscape. Do odwzorowania łączenia blach „na zakładkę” można użyć obszarów wypełnionych gradientem (str. 327);
W konstrukcjach lotniczych z lat czterdziestych XX w. były szeroko stosowane nity z łbem wpuszczanym. Takie nity są mało widoczne na poszyciu kadłuba (por. str. 326);
Aby stworzyć typowe wgłębienia na nitowanym poszyciu (str. 328), można użyć obrazu nitów i linii szwów „rozmytych” metodą Gaussa w Inkscape. W celu uzyskania bardziej płynnego przejścia można ten obraz poddać dodatkowym rozmyciem w Gimpie (str. 329 — 330);
Do niezależnej regulacji wpływu dwóch tekstur nierówności zamiast węzła Math:Multiply lepiej jest użyć węzła Color:Mix (str. 331). Dla większej przejrzystości schematu warto „obudować” go pomocniczą grupą. Proponuję nazwać ją Moderate (str. 332 - 333). To wyspecjalizowany węzeł do zmiany intensywności tekstur monochromatycznych — takich jak tekstury nierówności czy rozpraszania światła (Ref);
Każdą teksturę nierówności warto narysować z dużym kontrastem pomiędzy obszarami jasnymi (wypukłości) i ciemnymi (wgłębienia). Potem zawsze można ją dowolnie „spłaszczać” węzłem grupy Moderate. (Osłabienie zbyt silnego efektu zazwyczaj nie jest problemem. Kłopot zaczyna się wówczas, gdy włączyłeś już wszystko co mogłeś, a rezultat wciąż jeszcze jest zbyt słaby. Takich sytuacji można uniknąć, z góry zakładając w komponowanym w Inkscape lub GIMP obrazie odpowiednią nadmiarowość).
Podczas rysowania należy za to zwracać uwagę na odpowiednie proporcje głębokości poszczególnych elementów obrazu (np. jasność nitów i krawędzi paneli poszycia samolotu);
Jak nałożyć teksturę nierówności na powierzchnię o tak skomplikowanym kształcie, jak ta, którą pokazuje Rysunek 6.3.1? Jak uzyskać rezultat, który pokazuje Rysunek 6.3.2?
Rysunek 6.3.1 Owiewka stateczników — powierzchnia do nałożenia tekstury. | Rysunek 6.3.2 Owiewka po nałożeniu tekstury. |
Gdybyś próbował ten efekt osiągnąć prostym rzutowaniem, które stosowaliśmy w poprzedniej sekcji, obrazy śrub wokół statecznika pionowego lub poziomego zamieniłyby się w rozmyte linie. (Wystąpiłoby to na powierzchniach równoległych do kierunku nałożenia tekstury). Tak złożony kształt kwalifikuje siatkę do „mapowania” poprzez rozwinięcie powierzchni na płaszczyźnie UV. (Na str. 1109 znajdziesz wyjaśnienie, co to jest przestrzeń UV i rozwinięcie siatki w tej przestrzeni).
Przełącz się w tryb edycji siatki, zaznacz wszystkie wierzchołki, i rozwiń siatkę (skrótem U lub poleceniem Mesh→UV Unwrap→Unwrap: szczegóły — patrz str. 943). Rysunek 6.3.3 pokazuje, w oknie UV/Image Editor, rezultat operacji:
Rysunek 6.3.3 Rozwinięcie siatki w przestrzeni tekstury (UV)
(Krótkie wprowadzenie do posługiwania się oknem UV/Image Editor znajdziesz na str. 1111). Rozwinięcie, jakie uzyskaliśmy, mogłoby w zasadzie wystarczyć, aby poprawnie „zmapować” teksturę z tak drobnymi detalami, jak śruby. Ale tylko „w zasadzie”. Siatka UV, którą przedstawia Rysunek 6.3.3, ma kilka wad:
zajmuje za dużą powierzchnię. Docelowo będziemy się starać „upchać” jak najwięcej obiektów na jak najmniejszej teksturze. Nie możemy sobie pozwolić na taką rozrzutność, jak stosunkowo niewielki detal, rozwinięty w coś, co przypomina gwiazdę.
pod taki kształt trudno jest „podstawić” odpowiedni rysunek z planów samolotu. To utrudnia naniesienie na rozwiniecie linii śrub, bo trzeba coś na chwilę obrócić — albo plan, albo rozwinięcie siatki.
Spróbujmy jakoś zwinąć naszą siatkę z czegoś, co przypomina literę „K” , w kształt zbliżony do litery „E”. Wykorzystamy w tym celu typowe narzędzia do edycji siatki w Blenderze: „szpilki” (czyli przypinanie — Pin) oraz rozwijanie (E, Unwrap). Opis obydwu poleceń znajdziesz na str. 1122.
Upewnij się, że w oknie 3D View masz zaznaczoną całą siatkę, i wyłącz w nagłówku okna UV/Image Editor tryb synchronizacji selekcji ( — por. str. 1113). Włącz tryb Live Unwrap (UVs→Live Unwrap). Zaznacz i przypnij (P, Pin — p. str. 1122) rząd wierzchołków biegnący wzdłuż statecznika pionowego (Rysunek 6.3.4a). Ustaw kursor 2D w okolicy krawędzi natarcia statecznika i przestaw oś transformacji (Pivot) edytora UV w tryb 2D Cursor (.). Teraz zaznacz tylko górną połowę przypiętych wierzchołków, i zacznij ją obracać (R, szczegóły — str. 1119) (Rysunek 6.3.4b):
Rysunek 6.3.4 Poprawianie rozwinięcia za pomocą „przypiętych” wierzchołków i dynamicznego rozwijania
Widzisz? Reszta siatki podąża za „przyszpilonymi” wierzchołkami, jak gdyby była skrawkiem elastycznego materiału. To bardzo wygodne, prawda? W ten sam sposób obróć dolną część przypiętej krawędzi. Owiewka nie jest zupełnie symetryczna, więc na pewno zauważysz, że po ustawieniu obok siebie, dolna krawędź jest nieco krótsza. Dopasuj ją do górnej, zmieniając skalę (S, więcej — str. 1120) względem kursora, wzdłuż osi X (Rysunek 6.3.4c).
W podobny sposób, najpierw przypinając kluczowe krawędzie, a potem je obracając, przesuwając (G — szczegóły str. 1118) i skalując, zmień okolice statecznika poziomego (Rysunek 6.3.5):
Rysunek 6.3.5 Poprawianie rozwinięcia krawędzi statecznika poziomego (w kształt zbliżony do litery „E”).
Rysunek 6.3.5c pokazuje rezultat. Mówiąc szczerze, to rozwinięcie wymaga jeszcze dalszych poprawek: trzeba wyprostować pofalowane krawędzie, poprawić wzajemne proporcje wycięcia na statecznik poziomy i statecznik pionowy. Dodatkowym utrudnieniem brak symetrii tej siatki — musisz każdą poprawkę wykonać dwa razy — u góry i u dołu.
A może istnieje jakiś szybszy sposób uzyskania w miarę regularnego rozwinięcia o założonym kształcie litery „E”? Jak najbardziej! Tylko trzeba inaczej zacząć. Na trop tego rozwiązania skierowała mnie właśnie dywagacja, jak by tu uzyskać od razu ładne obramowanie krawędzi statecznika. (Tych krawędzi, które tak pofałdowane pokazuje Rysunek 6.3.5c).
Usuń dotychczasowe „przyszpilenia” wierzchołków (Alt-P — por. str. 1123). Upewnij się, że tryb synchronizacji selekcji z oknem 3D View jest wyłączony. Ustaw owiewkę w oknie 3D View w rzucie z góry. Zaznacz rząd wąskich ścian wokół krawędzi statecznika pionowego (tych, które udają „grubość blachy” — Rysunek 6.3.6a):
Rysunek 6.3.6 Rzutowanie krawędzi statecznika pionowego na płaszczyznę UV.
Wykonaj proste rzutowanie (Mesh→UV Unwrap→Project From View — p. str. 944) zaznaczonych ścian na powierzchnię UV. Rezultat obróć o -90º, aby obraz krawędzi leżał poziomo, a nie pionowo (Rysunek 6.3.6b). Na koniec „przypnij” wierzchołki tej krawędzi. (Blender będzie pamiętał, że są przypięte, nawet wtedy, gdy nie będą wybrane).
Teraz przestaw okno 3D View na rzut z boku. Zaznacz na nim lewą i prawą krawędź statecznika poziomego (Rysunek 6.3.7a). Wykonaj rzutowanie tego paska ścian na płaszczyznę UV (Project From View). Rezultat przesuń do dołu (wzdłuż osi Y),aby znalazł się poniżejj kursora 2D (Rysunek 6.3.7b):
Rysunek 6.3.7 Rzutowanie krawędzi statecznika poziomego na płaszczyznę UV.
„Przypnij” (P) obydwie krawędzie do obrazu. Teraz musimy przerzucić symetrycznie tylko prawą krawędź statecznika na przeciwną stronę kursora (Rysunek 6.3.7b). Wyłącz więc z zaznaczenia w 3D View krawędź lewą, aby w oknie UV/Image Editor pozostała tylko prawa. Ściany lewej krawędzi przeskaluj wzdłuż osi Y (S,Y) o współczynnik -1.0 (najszybciej i najdokładniej — z wciśniętym Ctrl) względem kursora 2D, aby uzyskać rezultat jak na ilustracji. Pomiędzy krawędziami statecznika poziomego zostawiliśmy przestrzeń, w której wcześniej umieściłeś rzut statecznika pionowego (por. Rysunek 6.3.6b). Właściwie to można je jeszcze trochę rozsunąć (G, ściany prawej krawędzi do góry a lewej — do dołu).
Następnie zaznacz w 3D View całą siatkę. Rysunek 6.3.8a) pokazuje, co powinieneś zobaczyć w edytorze UV1. „Przyszpilone” wierzchołki siatki są tam, gdzie je zostawiłeś przed chwilą. Cała reszta ścian pozostała na swoich domyślnych miejscach (w rozwinięciu w literę „K”). Czy aby na pewno? Wystarczy tylko nacisnąć klawisz E (UVs→Unwrap), by ściany dopasowały się do przypiętych krawędzi (Rysunek 6.3.8b):
Rysunek 6.3.8 Dopasowanie reszty siatki do „przyszpilonych” krawędzi stateczników.
Osiągnęliśmy to stosunkowo niewielkim wysiłkiem — zamieniliśmy rozpostarte, zajmujące dużą powierzchnię rozwinięcie w „K” na małe, kompaktowe rozwinięcie w literę „E”. Jeżeli masz włączoną opcję UVs→Live Unwrap, to nawet nie musisz naciskać klawisza E. Siatka połączy się z „przyszpilonymi” krawędziami przy pierwszej próbie poruszenia jednej z nich.
Aby zmniejszyć deformację obrazu, który nałożymy na siatkę, warto ustalić długość krawędzi stateczników we właściwej proporcji (jak na planach). Nic nie stoi na przeszkodzie, by pod rozwinięcie UV podstawić rzut z boku (Rysunek 6.3.9a — szczegóły patrz str. 1124):
Rysunek 6.3.9 Dopasowanie proporcji długości siatki do stateczników
Bazując na rysunku, załadowanym do UV/Image Editor, uzgodnij długości i wzajemne położenia krawędzi statecznika pionowego i poziomego. W związku z nieproporcjonalnym wydłużeniem rozwinięcia (spowodowanym nierównymi bokami rysunku rzutu z boku), do uzgodnienia stosuj tylko proporcjonalną zmianę skali i przesunięcie wzdłuż osi X (U). Rezultat uzgadniania przedstawia Rysunek 6.3.9b. Usunąłem już z niego podstawiony rzut z boku, więc siatka wróciła do właściwych proporcji (kwadratu).
Jeżeli chodzi o siatkę, to pozostały nam jeszcze tylko drobne operacje. Na przykład — zsunięcie i „przyszpilenie” zewnętrznych rzędów ścian, które odpowiadają grubości blachy owiewki — po lewej i prawej (Rysunek 6.3.10):
Rysunek 6.3.10 Wyrównanie i zmniejszenie dolnej krawędzi owiewki | Rysunek 6.3.11 Podstawienie obrazu do testowania deformacji rozwinięcia siatki |
Najszybszą metodą takiego „wyprostowania” krawędzi do poziomu i pionu jest użycie poleceń z grupy Weld/Align (pod klawiszem W, więcej informacji — str. 1127). Wyprostuj także — do linii pionowej — przednią krawędź (por. Rysunek 6.3.10, Rysunek 6.3.11).
Gdy wydaje Ci się, że rozwinięcie wygląda na ukończone — warto „rozłożyć” na siatce specjalny obraz testowej „szachownicy” (Image→New Image, New Image:UV Grid — patrz str. 1125) . W oknie UV/Image obraz wygląda tak, jak to pokazuje Rysunek 6.3.11. Aby sprawdzić, czy rozwinięcie nie powoduje jakichś poważnych deformacji obrazu tekstury, zmień tryb wyświetlania w oknie 3D View z Solid na Textured. (Szczegóły znajdziesz na str. 1125). Rezultat przedstawia Rysunek 6.3.12:
Rysunek 6.3.12 Obraz załadowany do okna UV/Image Editor, widoczny w widoku 3D (tryb wyświetlania Textured).
Po przełączeniu okna 3D View w tryb wyświetlania Textured, zobaczysz siatkę pokrytą obrazem aktualnie załadowanym w oknie UV/Image Editor. Musisz tylko na chwilę przełączyć renderer na Blendere Renderer.
Praca z siatką testową odbywa się na dwóch oknach (p. Rysunek 6.3.13). W 3D View oglądasz obiekt ze wszystkich stron i szukasz na nim jakichś poważnych zaburzeń obrazu „szachownicy”. Może to być np. większa dysproporcja rozmiaru poszczególnych kwadratów, albo wygięcie całego ich rzędu. Poprawiasz wtedy odpowiednio rozwinięcie siatki w UV/Image Editor, a potem znów patrzysz w okno 3D View, by się przekonać, czy wykonana poprawka była dostateczna. Pamiętaj, że na pewno nie uda Ci się uzyskać „idealnego” rozłożenia obrazu testowego, bez żadnych zakłóceń. To, co powinieneś osiągnąć, to rozsądny kompromis pomiędzy Twoim czasem a rezultatem rozwinięcia. Kompromis powinien zapewnić, że w istotnych miejscach (linii nitów, łączenia blach) obraz tekstury nie będzie w sposób widoczny zdeformowany (Rysunek 6.3.13):
Rysunek 6.3.13 Wykorzystanie obrazu UV Test Grid do poprawek rozwinięcia siatki w UV.
W czasie pracy z obrazem testowym możesz włączyć tryb synchronizacji selekcji (por. Rysunek 6.3.13). Pamiętaj jednak (abyś nie był zaskoczony): dopóki w oknie 3D View nie masz zaznaczonej choć jednej, pełnej ściany, żaden obraz nie pojawi się w oknie UV/Image Editor. (Dzieje się tak dlatego, że przypisania obrazu w Blenderze jest związane ze ścianami, a nie wierzchołkami czy krawędziami siatki).
Osobiście wolę poprawiać siatkę z wyłączonym trybem synchronizacji selekcji. Mam wtedy włączoną aktualizację siatki „na bieżąco” (Images→Live Unwrap Transform), i pewność, że nic mi jej potem przypadkowo nie przekształci.
Na szczęście nasze rozwinięcie okazało się wolne od większych błędów, i nie wymagało jakichś dużych poprawek. Rysunek 6.3.14 pokazuje ostateczny układ ścian w edytorze UV:
Rysunek 6.3.14 Rozwinięcie po kosmetycznych poprawkach, wprowadzonych w wyniku zastosowania obrazu UV Test Grid.
To rozwinięcie zapisz do pliku rastrowego (Image→Scripts→Save UV Layout, szczegóły — patrz str. 1128). Nadaj mu nazwę uv.png. Umieść go w tym samym folderze, co plik texture.svg.
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-6.03.blend, a pliki z wyeksportowanymi rozwinięciami UV — w folderze model\p40\textures\6.03\* (por. str. 22).
Podsumowanie
Poszczególnym ścianom siatki można przypisać dokładne położenie na powierzchni obrazu. Jest to tak zwane „rozwinięcie w wymiarach UV”, nazywane także krócej „rozwinięciem UV” (UV to względne wymiary obrazu — p. str. 1109). Do edycji tego rozwinięcia służy okno UV/Image Editor (p. str. 1111);
Blender udostępnia wiele różnych metod rozwinięcia siatek. Znajdziesz je w trybie edycji, w menu Mesh→UV Unwrap (str. 335, 337). Spośród nich w tej książce będziemy najczęściej używać dwóch: Project From View i Unwrap;
Siatki w UV powinny mieć możliwie małe wymiary i jak największe wypełnienie powierzchni. Dlatego należy starać się je rozwijać w coś, co układem przypomina okrąg, lub prostokąt. (W ten sposób będzie można lepiej wykorzystać powierzchnię wspólnych tekstur — zobacz przykład w następnej sekcji, na str. 344);
Typową metodą dopasowywania siatki w edytorze UV jest przesuwanie (a także obracanie, skalowanie) kluczowych, „przypiętych” (Pin) wierzchołków. Reszta siatki dopasowuje się samoczynnie do ich nowego układu — „na żądanie” (UVs→Unwrap), lub na bieżąco (UVs→Live Unwrap) (str. 336);
Unikaj poważnych przekształceń siatki w edytorze UV — zajmują dużo czasu. Najszybszą metodą uzyskania docelowego kształtu rozwinięcia jest stworzenie za pomocą „ogólnych” metod z menu Mesh→UV Unwrap (3D View, Edit Mode) jak najlepszego przybliżenia. Możesz nawet to zrobić, rozwijając siatkę fragmentami (por. str. 337). Potem, w edytorze UV dokonasz kilku kosmetycznych poprawek, i rozwinięcie gotowe!
W oknie UV/Image Editor możesz „podstawiać” pod rozwinięcie obrazy, by dopasować jakieś istotne proporcje siatki do planów samolotu. Najlepiej, aby podstawiane obrazy były kwadratowe, bo inaczej siatka może zostać „rozciągnięta”, tak jak to jest pokazane na str. 338.
Poprawność (brak deformacji) rozwinięcia siatki możesz sprawdzić za pomocą specjalnego obrazu „szachownicy” — UV Test Grid. Podglądając w oknie 3D View aktualne rozłożenie wzoru na siatce, możesz jednocześnie poprawiać kształt rozwinięcia w oknie edytora UV (str. 340);
Rozwinięcie siatki możesz zapisać — zarówno w postaci rastrowej, jak i wektorowej (skryptem Save UV Layout). Takie rozwinięcie można wczytać do GIMP lub Inkscape, aby przygotować obraz tekstury dla tej siatki (str. 342);
Czas przygotować obraz nierówności dla rozwinięcia siatki wykonanego w poprzedniej sekcji. Otwórz plik texture.svg w Inkscape. Na razie wyłącz widoczność wszystkich warstw poza rzutem z boku (BP-Left). Dodaj jeszcze jedną warstwę, w której będziemy przechowywać referencje do rozwinięć UV. Nadaj jej nazwę — non omen — UV, i umieść poniżej warstwy Bkg-White (Rysunek 6.4.1):
Rysunek 6.4.1 Wstawienie obrazu rozwinięcia do pliku texture.svg
Wczytaj na warstwę UV wyeksportowany z Blendera obraz uv_B.360.TailFilet.png (File→Import, jako link). Dzięki temu Inkscape odnotowuje tylko, z jakiego pliku ma skorzystać, aby wyświetlić jego zawartość. Możesz się o tym przekonać, zaglądając do okna Image Properties (Rysunek 6.4.1). Dzięki takiemu podłączeniu wystarczy, że wyeksportujemy z Blendera zmienione rozwinięcie UV do pliku rastrowego — a jego obraz w rysunku Inkscape sam się uaktualni!
Obraz rozwinięcia zmniejsz (proporcjonalnie, z wciśniętym klawiszem Ctrl) i przesuń, aby ustawił się w odpowiednim miejscu planów (Rysunek 6.4.2). Potrzebujemy tak ustawić, by w odpowiednich miejscach narysować śruby, którymi była przymocowana owiewka do kadłuba i statecznika:
Rysunek 6.4.2 Obraz rozwinięcia siatki, po dopasowaniu do planów.
W rysunku Inkscape mamy już oddzielne warstwy na linie (Lines) i nity (Rivets). Teraz dodaj kolejną, na śruby: (Screws) . Sama owiewka zawierała ich kilkadziesiąt. (Demontaż statecznika na pewno nie był łatwą operacją!).
Gdzieś w ustronnym miejscu rysunku stwórz wzór śruby. Osobiście wybrałem na miejsce z takimi wzorcami prawy górny narożnik obrazu texture.svg (Rysunek 6.4.3a):
Rysunek 6.4.3 Rysunek śruby (a), sklonowany w odpowiednie miejsca mapy nierówności (b).
Na warstwie Screws narysowałem pierwowzór śruby (Rysunek 6.4.3a). Do rysunku wstawiłem także kolejną warstwę, o nazwie Bumps. Umieściłem na niej wzór wgłębienia blachy pod dokręconą śrubą (koło wypełnione gradientem). (Szczegółowy opis uzyskania takich detali mapy nierówności znajdziesz na str. 731 i 732). Po narysowaniu, złącz elementy wzorcowej śruby w grupę (Ctrl-G, Object→Group — patrz str. 722). Nadaj jej nazwę Screw01. (Potem dodamy tu kolejne wzory śrub, np. z łbem krzyżowym. Otrzymają nazwy Screw02, Screw03, …). Wzór śruby i wgłębienia zaznacz i sklonuj (Alt-D, Object→Clone→Create Clone — patrz. str. 715). Umieść klon w miejscu jednej ze śrub w rozwinięciu UV i dopasuj skalę (Rysunek 6.4.3b). Polecenie klonowania wywołaj tylko raz. Potem wstawiaj śruby, powielając rezultat klonowania zwykłym poleceniem Object→Duplicate (Ctrl-D) — aby nie klonować klonów. (To by stworzyło niepotrzebnie dodatkowe poziomy zagnieżdżenia w pliku SVG).
Na wszystkie siatki, do których jest przypisany materiał B.Skin.Test, Blender nakłada teksturę tą samą metodą. Dlatego, skoro już zamierzamy zacząć używać mapowania UV, musimy odpowiednio przygotować także siatkę statecznika pionowego. (Do tej pory używaliśmy w niej mapowania Object — por. str. 320). Na potrzeby naszego testu można ją rozwinąć najprostszą metodą: Project From View (Rysunek 6.4.4):
Rysunek 6.4.4 Mapowanie UV siatki statecznika pionowego.
(Szczegóły tej metody rozwinięcia znajdziesz na str. 944). W ostatecznym rozwinięciu całego modelu zrobimy to nieco inaczej, by prawidłowo „odwinąć” ścianki dźwigara i krawędzi natarcia.
Po rozwinięciu statecznika musimy uzgodnić rozwinięcia obydwu siatek, które będą używać tekstury. Chodzi tu o to, by się na siebie nie nakładały (Rysunek 6.4.5):
Rysunek 6.4.5 Uzgadnianie położenia siatek na wspólnej mapie UV
Do takiego uzgadniania bardzo przydatna jest w oknie UV/Image Editor opcja View→Draw Other Objects. Służy do wyświetlania w przestrzeni UV ścian innych obiektów, które są przypisane do tego samego obrazu (Rysunek 6.4.5, por także str. 1125). Dlatego warto przypisać wszystkie ściany w edytorze UV do jednego obrazu — np. do obrazu Test 1. Wówczas po zaznaczeniu kilku obiektów i przełączeniu jednego z nich w tryb edycji, zobaczysz w edytorze UV rozwinięcia wszystkich wskazanych w ten sposób siatek. Co prawda, zmieniać można tylko jedną z nich — tę należącą do obiektu aktywnego — ale to już mniejsza niedogodność.
Uzgodnione rozwinięcia siatek wyeksportuj z Blendera do postaci SVG. Aby ułatwić tę operację, przygotowałem wyspecjalizowany dodatek o nazwie Export to SVG (pełen opis znajdziesz na str. 1128). Pozwala m.in. zapisać do pliku SVG wszystkie siatki aktualnie zaznaczonych obiektów (Rysunek 6.4.6):
Rysunek 6.4.6 Rezultat eksportu rozwinięcia UV do pliku SVG
Uzyskane z Blendera pliki SVG można bezpośrednio importować do warstwy UV pliku texture.svg. Jednak gdy zaczesz wczytywać tam kolejne rozwinięcia siatek o dużej liczbie ścian (takich jak skrzydła czy kadłub) spowoduje to coraz wolniejsze działanie Inkscape. Dlatego lepiej je gromadzić w pomocniczym pliku uv.svg.
Rysunek 6.4.7 przedstawia, o co chodzi w tym pomyśle z pomocniczym plikiem uv.svg:
Rysunek 6.4.7 Wykorzystanie pomocniczego pliku (uv.svg) do podstawienia obrazu rozwinięć UV
W Blenderze rozwijamy i uzgadniamy kolejne siatki modelu. Wiele z nich może mieć kilka alternatywnych mapowań UV (UV Maps — przekonasz się o tym w następnym rozdziale). Po uzgodnieniu położenia na obrazie rozwinięcia UV eksportujemy (za pomocą polecenia UVs→Export to SVG do tymczasowych plików *.svg. Zawartość tych plików wczytujemy (poleceniem File→Import lub po prostu „przeciągnij i upuść”) do zbiorczego rysunku uv.svg. Tam można poszczególne rozwinięcia podzielić na warstwy, odpowiadające istniejącym w naszym modelu nazwom map (rozwinięć) UV. Zalety zastosowania do eksportu rozwinięć wektorowego formatu SVG zamiast rastrowego PNG to:
Łatwiejsze wprowadzanie późniejszy poprawek do rozwinięcia jednej lub kilku siatek: usuwasz ich stare rozwinięcia z uv.svg, po czym ponownie eksportujesz z Blendera i wczytujesz do uv.svg uaktualnione wersje;
Pliki z rozwinięciami zapisane w formacie SVG zajmują o wiele mniej miejsca na dysku niż rastrowe obrazy PNG;
Zestawienie rozwinięć z pliku uv.svg wyeksportuj do obrazu rastrowego uv.png. Referencja (link) do tego obrazu powinien być umieszczony na warstwie UV pliku texture.svg. Zmiany w takim obrazie Inkscape odświeża automatycznie, gdy tylko na dysku pojawi się nowa wersja pliku. Pamiętaj tylko, aby eksportować do uv.png obraz rastrowy o wystarczającej rozdzielczości!
Po podstawieniu obrazu rozwinięć pod rysunek tekstury, można było nanieść w pliku texture.svg niezbędne poprawki (Rysunek 6.4.8):
Rysunek 6.4.8 Wprowadzenia poprawek w obrazie mapy nierówności (texture.svg)
Przesunąłem obraz śrub i ich wgłębień, aby trafiły na zmienione rozwinięcie siatki owiewki statecznika.
Przechowując wyeksportowane z Blendera obrazy rozwinięć UV w pomocniczym pliku uv.svg, i podstawiając do rysunku tekstury jego rastrowy obraz uv.png unikniesz spowolnienia pracy w Inkscape.
Wprowadźmy w tej sekcji parę zmian „organizacyjnych”, które przydadzą nam się przy dalszej pracy z teksturami. Nadajmy każdemu plikowi z obrazem tekstury przedrostek odpowiedni do jej typu. I tak teksturom nierówności nadajmy nazwy zaczynające się od nor_, a teksturom barwy — od col_. Obraz podstawowych nierówności, wykorzystywany przez materiał B.Skin.Test, nosił do tej pory nazwę texture.png. Od tej chwili ten plik będzie się nazywał nor_details.png. Uzyskujemy go bezpośrednio poprzez eksport z Inkscape (nie wymaga żadnej dodatkowej „obróbki” w Gimpie):
Rysunek 6.4.9 Podstawowa mapa nierówności (nor_details.png)
Rysunek 6.4.9a) pokazuje, które warstwy z pliku Inkscape biorą udział w tworzeniu obrazu. Rysunek 6.4.9b) pokazuje zawartość wyeksportowanego z Inkscape obrazu — nor_details.png. Rezultat jest bardzo szary, ze względu na barwę tła (kwadratu z warstwy Bkg-Grey). W takim pomniejszeniu, w jakim pokazuje go Rysunek 6.4.9b), giną drobne szczegóły, poza granicami łączenia blach. Rysunek 6.4.9c) pokazuje więc także powiększony fragment nor_details.png, na którym lepiej widać nity.
Obraz nor_details.png został złożony z następujących warstw źródłowego pliku Inkscape:
Screws: zawiera śruby (występujące na owiewce usterzenia) — wzorzec i jego klony;
Rivets: zawiera nity, odwzorowane jako czarne linie kropkowe; Ta warstwa ma bardzo małą nieprzejrzystość (Opacity — por. Rysunek 6.4.9a), ustaloną na 5%. W rezultacie nity są tylko o 5% ciemniejsze od tła, ponad którym się znajdują;
Overlay: zawiera panele, które w prawdziwej konstrukcji były nałożone na pozostałe;
Plane V: zawiera panele, które odpowiadają za pionowe (mniej więcej) krawędzie podziału;
Plane H: będzie zawierał panele, które odpowiadają za poziome krawędzie podziału (na razie nie ma jeszcze ani jednej) ;
Bkg-Grey: zawiera szary (50%) kwadrat tła. Rozmiary tego kwadratu określają jednocześnie obszar, który jest eksportowany do pliku. (Zaznaczasz go przed wywołaniem polecenia File→Export Bitmap, a potem w oknie Export Bitmap wybierasz Export area:Selection);
Dla testów w tej sekcji, ustal rozmiar nor_details.png i wszystkich następnych obrazów na 768x768 pikseli.
Kolejnym obrazem, którym wyeksportujemy z Inkscape (ze texture.svg) jest zarys wszelkich wgnieceń blachy (Rysunek 6.4.10):
Rysunek 6.4.10 Kompozycja w Inkscape źródłowego obrazu do rozmycia w GIMP (blur.png)
Rezultat zapisz do chwilowego pliku o nazwie, powiedzmy, blur.png (Rysunek 6.4.10b). Zapisany obraz (768x768 px) został złożony z następujących warstw pliku texture.svg:
Bumps: wgłębienia pod śrubami — nadaj jej nieprzejrzystość 40%;
Shadows: wgłębienia pod liniami nitów. Nadaj jej nieprzejrzystość na 80%;
Plik blur.png poddajemy w GIMP „kaskadowemu” rozmyciu, opisanemu na str. 329 - 330. Rezultat zapisz jako obraz drugorzędnej tekstury nierówności, do pliku o nazwie nor_blur.png (Rysunek 6.4.11):
Rysunek 6.4.11 Kaskadowe rozmycie obrazu blur.png w drugą teksturę nierówności (nor_blur.png)
Podczas eksportowania obrazu tekstur z pliku texture.svg do plików rastrowych zwróć uwagę, by kwadraty tła (z Bkg-Grey, Bkg-White) miały dokładnie taki sam rozmiar i położenie jak podstawiony na warstwie UV obraz uv.png. Tylko w ten sposób tekstura trafi we właściwe miejsce siatki modelu!
Najlepiej, aby obraz uv.png z Blendera i obraz tekstury w Inkscape miały takie same rozmiary, a prostokąty tła zasłaniały ich całą powierzchnię. Wtedy wszystko do siebie będzie od razu pasować. W ten sposób przygotujemy w następnym rozdziale plik dla rozwinięcia całego modelu. W teście, jaki teraz wykonujemy, nie chciałem od początku zawracać tym Czytelnikowi głowy. Dlatego w tej sekcji trzeba było przesunąć i dopasować tła do zmienionego położenia i rozmiaru eksportowanego fragmentu rysunku.
Gdy nowe obrazy są gotowe, czas zmienić schemat materiału B.Skin.Test w Blenderze. Przypisz każdej z tekstur plik z odpowiednim obrazem (nor_details.png dla podstawowej, nor_blur.png dla pomocniczej). Obydwa węzły Texture Image podłącz teraz bezpośrednio z wyjściem Texture Coordinate: UV (Rysunek 6.4.12):
Rysunek 6.4.12 Zmodyfikowany schemat materiału B.Skin.Test
Rysunek 6.4.13 przedstawia rezultat zastosowania tekstur nierówności dla powierzchni “aluminiowej” (a) i matowej (b):
Rysunek 6.4.13 Rezultat dla różnych rodzajów powierzchni
Zwróć uwagę na śruby (efekt nowej warstwy Screws) i wygięcia blachy wokół dokręconych śrub (efekt cieni z warstwy Bumps).
Na pewno poszycie, które przedstawia Rysunek 6.4.13, wyglądałoby lepiej, gdybyśmy zastosowali w teksturach obrazy o większej rozdzielczości. Chodzi tu głównie o dokładne odwzorowanie kształtu nitów, śrub, i połączeń blach. Spróbuj przyjrzeć się z bliska, jak „wyszły” te elementy po eksporcie z Inkscape do obrazu 768x768 px. Zobaczysz, że regularne koła śrub i nitów zostały zredukowane do kilkunastu pikseli, o niezbyt regularnym kształcie. Każdy obraz rastrowy przestaje pełnić dobrze swoją rolę, gdy jest oglądany w zbyt dużym powiększeniu. Sprawa jest „pod kontrolą”, gdy jesteś klasycznym grafikiem komputerowym i wykonujesz model samolotu do jednej — dwóch scen. Możesz wtedy dobrać do każdej z nich odpowiednią rozdzielczość tekstur. Ale w przypadku takiego „ogólnego” modelu, jak nasz, choćbyś chciał, nie możesz poświęcić zbyt dużo powierzchni na pojedynczą owiewkę. Aby ułatwić nanoszenie różnych kamuflaży, i zachować sensowny czas renderingu, musimy umieścić na jednej teksturze rozwinięcie całego modelu. Jej rozmiar zależy od mocy obliczeniowej i RAM twojego komputera. Obecnie (2012r.) może to oznaczać rozmiar obrazu rzędu 8000x8000 px (system 64-bitowy) lub 4000x4000px (starsze systemy 32-bitowe).
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-6.04.blend, a pliki tekstur — w folderze model\p40\textures\6.04\* (por. str. 22).
Podsumowanie
Obrazy tekstur najłatwiej jest rysować na obrazie jej rozwinięcia w UV (str. 343). W przypadku tekstury nierówności dobrze jest jednocześnie podstawić „pod spód” plany samolotu, w takiej samej skali jak rozwinięcie (str. 342);
Gdy wykorzystujesz do mapowania tekstur współrzędne UV, musisz rozmieścić rozwinięcia wszystkich siatek na jednym, wspólnym obszarze. Trzeba to zrobić tak, by nie nakładały się na siebie. Takie uzgodnienie można zrobić w Blenderze. Bardzo się przy tym przydaje opcja View→Draw Other Objects (str. 344);
Postaraj się, aby wszystkie rozwinięcia siatek miały taką samą skalę. (Aby narysowane na nich nity lub śruby nie różniły się na modelu rozmiarem). Możesz to łatwo sprawdzić za pomocą obrazu testowego (por. str. 339): rozmiar kwadratów tej szachownicy powinien być jednakowy (lub prawie jednakowy);
W przypadku modeli złożonych z wielu siatek (takich jak nasz samolot) wygodnie jest wyeksportować rozwinięcia do wektorowych plików SVG. Proponuję użyć do tego wyspecjalizowanego polecenia Export To SVG — dodatku, który towarzyszy tej książce (str. 344); Ze względu na ograniczoną wydajność Inkscape, stworzone w ten sposób obrazy warto złożyć w pomocniczym pliku uv.svg (str. 345). Plik uv.svg posłuży nam do generowania zbiorczego (rastrowego) obrazu rozwinięcia wszystkich siatek (uv.png), który wykorzystam przy rysowaniu tekstur;
W tej sekcji dodaliśmy do źródłowego obrazu nierówności texture.svg warstwy z obrazami śrub (Screws) i wgłębień pod śrubami (Bumps) (str. 343)
Śruby i towarzyszące im wgłębienia najlepiej jest wstawić jako „klony” (referencje) pojedynczego szablonu (str. 343). W przyszłości dzięki temu będzie Ci bardzo łatwo jest wprowadzić ewentualne poprawki — wystarczy zmienić wzorzec;
Na str. 346 znajdziesz wyliczenie warstw pliku texture.svg, z których komponowany jest obraz podstawowej tekstury nierówności (plik nor_details.png);
Na str. 347 znajdziesz wyliczenie warstw pliku texture.svg, z których komponowany jest obraz pomocniczej tekstury nierówności (plik nor_blur.png). Jest tam także opis jej „rozmycia” z wykorzystaniem GIMP;
Wprowadzenie poprawki w pliku texture.svg do jakiejkolwiek warstwy z której powstaje pomocnicza mapa nierówności, wymaga powtórnego rozmycia jej obrazu w GIMP. To dość nużące. W następnym rozdziale postaram się zaproponować lepsze rozwiązanie, oparte o tzw. filtry SVG. Pozwoli ono automatycznie uzyskiwać efekt „kaskadowego” rozmycia obrazu bezpośrednio w Inkscape;
Aby zastosować mapowanie UV dla tekstur w Cycles, wystarczy połączyć wyjście UV węzła Texture Coordinate z wejściem Vector odpowiednich węzłów Texture Image (str. 348). Takich węzłów z obrazami może być wiele;
W tym rozdziale używaliśmy do tej pory prostej tekstury barw (por. str. 319) i złożonej tekstury nierówności (str. 346-348). Do tekstur barwy jeszcze wrócimy w następnym rozdziale — pokażę, jak nanieść kamuflaż na powierzchnię samolotu (por. str. 425, 440 i 458). Tekstury nierówności omówiliśmy już dość dokładnie. Czas na trzecią (i ostatnią) z tekstur „obowiązkowych”: obraz sterujący intensywnością odbicia światła. Zastanawiałeś się, co odróżnia czarną plamę sadzy od czarnej plamy świeżej smoły albo atramentu? Na pewno nie kolor! Różnią sposobem odbijania światła. Obydwa materiały możesz uzyskać za pomocą shadera Gloss Paint. Każdy z nich będzie miał inną szorstkość (Roughness) i odblask (Reflectivity). Właśnie te parametry moduluje tekstura odbić, którą dalej będę także określał jako Ref (od Ref lectivity). Pozwala uzyskać efekt gromadzących się w nierównościach poszycia samolotu zanieczyszczeń, które zmieniają właściwości podstawowego materiału (np. pył, połyskliwe plamy po paliwie czy oleju, matowe ślady sadzy po spalinach czy gazach prochowych).
Kompozycja w Inkscape obrazu, z którego zrobimy w GIMP obraz odbicia światła (Ref) bardzo przypomina kompozycję obrazu pomocniczej mapy nierówności (pliku blur.png, por. str. 347). Nie można jednak po prostu wykorzystać tego pliku, gdyż różnią się kilkoma szczegółami (Rysunek 6.5.1):
Rysunek 6.5.1 Kompozycja w Inkscape źródłowego obrazu do rozmycia w GIMP (shadows.png)
Po pierwsze, wyłączona została warstwa Screws, a włączona — Lines. Zwiększyłem nieprzejrzystość warstwy Lines (do 50%) i dodałem nową warstwę Contours (Rysunek 6.5.1a). Uzyskany obraz (Rysunek 6.5.1b) wyeksportuj do pomocniczego pliku rastrowego shadows.png. Podobnie jak blur.png, shadows.png jest tymczasowym plikiem, który poddamy dalszej „obróbce” w Gimpie.
Obraz shadows.png został złożony z następujących warstw pliku texture.svg:
Lines: linie podziału paneli poszycia (czarny, 0.5 px szerokości);
Rivets: nity (czarne, nieprzejrzystość —50%). W rezultacie nity mają barwę na poziomie 45% szarości (znajdują się ponad liniami z warstwy Shadows —szary 90%);
Contours: obrys konturów (tam, gdzie w konstrukcji występowała krawędź). Linie konturów są dwa razy szersze i od linii podziału blach. Są także od nich dwa razy jaśniejsze (szary 50%);
Shadows: „cienie” pod liniami nitów. Barwa — szary 90% (L = 232). Nieprzejrzystość: 80%;
Bkg-White: biały kwadrat tła. Rozmiary tego prostokąta określają jednocześnie obszar, który jest eksportowany do pliku;
Oprócz obrazu shadows.png (Rysunek 6.5.1b), do kompozycji mapy odbić w GIMP będziemy jeszcze potrzebować dwóch oddzielnych plików z zawartością warstw: Rivets (rivets.png — Rysunek 6.5.2a) i Screws (screws.png — Rysunek 6.5.2b):
Rysunek 6.5.2 Dodatkowe obrazy, potrzebne do kompozycji mapy odbić w GIMP
Podczas eksportu każdego z tych plików, wyłącz w texture.svg wszystkie pozostałe warstwy, w szczególności Bkg-White (obydwa obrazy muszą mieć przejrzyste tło).
Dla testów w tej sekcji, ustal rozmiar wszystkich obrazów eksportowanych z texture.svg na 768x768 pikseli (w parametrach okna Export Bitmap).
Zaraz po eksporcie z Inkscape otwórz shadows.png w Gimpie, i zapisz jako ref.xcf. Utwórz w GIMP złożenie rozmyć obrazu promieniami 5, 10 i 25, tak jak to zrobiliśmy przedtem w pliku nor_blur.xcf (Rysunek 6.5.3a).
Rysunek 6.5.3 Kompozycja w GIMP tekstury odbić (ref.png)
To rozmycie różni się jednak od poprzedniego obrazu przejrzystością poszczególnych warstw: Blur10 jest tu w 50% nieprzejrzysta, Blur05 — w 15%, a Filter — w 95% (Rysunek 6.5.3a). Oprócz tego wczytaj jako oddzielne warstwy przygotowane wcześniej dwa pliki — rivets.png i screws.png. Posłużą nam do wybielenia miejsc na nity i śruby. Obydwie warstwy mają przejrzyste tło, więc „wybielenie” śrub uzyskamy od razu. Gorzej z nitami z warstwy rivets.png — są czarne. A jednak, gdy zmienisz tryb mapowania tej warstwy z Normal na Grain extract, z czarnych staną się białe (Rysunek 6.5.3c).
Rezultat kompozycji w GIMP (Rysunek 6.5.3b) zapisz (File→Save a Copy) pod nazwą ref.png. To obraz naszej tekstury odbicia światła.
Obraz jest gotowy, teraz należy dodać go w Blenderze do schematu materiału B.Skin.Test (Rysunek 6.5.4):
Rysunek 6.5.4 Dołączenie tekstury ref.png do schematu materiału B.Skin.Test
W Node Editor dodaj nowy węzeł Image Texture i przypisz go do obrazu ref.png. Wejście Image Texture:Vector podłącz do współrzędnych Texture Coordinates:UV. Wyjście, poprzez pomocniczy węzeł Moderate, przyłącz do parametru Reflectivity shadera Gloss Paint. W sumie, to takie samo rozwiązanie, jak te zastosowane w teksturach nierówności (podłączonych do wejścia Displacement — por. Rysunek 6.5.4). Parametru Moderate:Range użyjemy do sterowania intensywnością tego efektu.
Rysunek 6.5.5 pokazuje na testowej powierzchni (statecznik pionowy wraz z owiewką) efekt uzyskany w wyniku zastosowania tekstury ref.png:
Rysunek 6.5.5 Sterowanie wartością Gloss Paint:Reflectivity za pomocą tekstury
Rysunek 6.5.5a) to obraz „porównawczy”. W materiale zastosowanym na tej powierzchni nie jest jeszcze użyta tekstura ref.png, a wartości wszystkich parametrów shadera Gloss Paint są stałe (i podane na ilustracji). Rysunek 6.5.5b) przedstawia ten sam obiekt, ale pokryty materiałem używającym tekstury ref.png (podłączonej tak, jak pokazuje to Rysunek 6.5.4, z tym że wartość Moderate:Range jest tu większa: 0.6). Widać że zastosowany obraz tekstury podkreśla wszystkie nierówności i zagłębienia. (Są to przebarwienia, przez które bardziej prześwituje kolor Gloss Paint:Diffuse).
Uzyskany efekt jest ciekawy, ale w wyniku zastosowania węzła Moderate białym pikselom tła ref.png odpowiada na powierzchni modelu wartość Reflectivity = 1.0 (por. str. 1062). A my chcielibyśmy uzyskać w takich miejscach nieco mniej: 0.98. Dlatego zamiast węzła Moderate zastosujmy w tym miejscu węzeł podobny, ale pozwalający dodatkowo ustawić max. jasność obrazu (Rysunek 6.5.6):
Zdefiniowałem taką pomocniczą grupę i nadałem jej nazwę Range To Max (szczegóły — str. 1063). Ustawiłem ją tak, by w tym przypadku obraz ref.png miał „spłaszczony” zakres intensywności: od 0.38 do 0.98 (Range = 0.6, Max = 0.98: por Rysunek 6.5.6).
Rysunek 6.5.7 dla porządku przedstawia rezultat zastosowania węzła Range To Max. Zmianę wartości Reflectivity z 1.0 na 0.98 właściwie trudno dostrzec, ale chodziło mi tu o wprowadzenie możliwości pełnego sterowania zakresem intensywności tekstury.
Rysunek 6.5.7 Efekt zastosowanie węzła Range To Max
Tekstury ref.png możemy także użyć do sterowania lokalną szorstkością (Gloss Paint:Roughness) materiału. Zabrudzona powierzchnia wzdłuż szwów i śrub powinna mieć nieco większą szorstkość, więc w tym przypadku potrzebujemy użyć negatywu obrazu ref.png. Możesz go uzyskać używając węzła Negate (Rysunek 6.5.8):
Rysunek 6.5.8 „Przymiarka” negatywu obrazu ref.png
Czasami dobrze jest przed użyciem tak przekształcanego obrazu sprawdzić, jak właściwie wygląda, podłączając go jako teksturę koloru (Rysunek 6.5.8a). Tak właśnie zrobiłem w tym przypadku (Rysunek 6.5.8b).
Po sprawdzeniu przekształconego obrazu (czy wygląda tak, jak się tego spodziewasz) podłącz go do wejścia Gloss Paint:Roughness (Rysunek 6.5.9):
Rysunek 6.5.9 Ustawienia tekstury do sterowania szorstkością powierzchni
Okazuje się, że nawet niewielkie lokalne zmiany Roughness silnie rozjaśniają nierówności (Rysunek 6.5.10):
Rysunek 6.5.10 Rezultat lokalnego zwiększenia szorstkości powierzchni
Taki efekt „przetarć” może się przydać, ale teraz potrzebujemy czegoś łagodniejszego (Rysunek 6.5.11):
Rysunek 6.5.11 Ten sam materiał dla mniejszych intensywności tekstury chropowatości
Materiały matowe nie są tak efektowne, jak metaliczne. Spróbujmy użyć tekstury ref.png do dyskretnego podkreślenia nierówności na typowej powierzchni matowego kamuflażu (Rysunek 6.5.12):
Rysunek 6.5.12 Wstępne ustawienia dla materiału matowego
Podobnie jak w poprzednim przypadku, podłączenie do Reflectivity zaciemnia wgłębienia (Rysunek 6.5.13):
Rysunek 6.5.13 Zmiany powierzchni matowej po zastosowaniu tekstury odbić (Reflectivity)
Powierzchnie matowe są mniej czułe na zmiany szorstkości od powierzchni połyskliwych (Rysunek 6.5.14):
Rysunek 6.5.14 Efekt zastosowania tekstury szorstkości (Roughness) o różnej intensywności
Jak chyba zauważyłeś, w tej sekcji używaliśmy tekstury odbić do dyskretnego podkreślenia „technicznych” nierówności na powierzchni modelu. Aby ją uzyskać, użyliśmy obrazu ref.png, utworzonego z rysunku konstrukcyjnych detali naszego samolotu — pliku texture.svg. Bardziej intensywne zabrudzenia — plamy, smugi sadzy — można otrzymać stosując bardziej intensywną, drugą teksturę. Najlepiej ją namalować w GIMP. Pokażę to rozwiązanie przy okazji tworzenia szczegółowych tekstur barwy, w następnym rozdziale.
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-6.05.blend, a pliki tekstur — w folderze model\p40\textures\6.05\* (por. str. 22).
Podsumowanie
W tej sekcji dodaliśmy do źródłowego rysunku texture.svg warstwę Contours. Zawiera kontury niektórych siatek (str. 350), które chcemy nieco podkreślić;
Obraz tekstury odbić (ref.png) tworzy się w sposób podobny do pomocniczej („rozmytej”) tekstury nierówności (str. 350, 351). Największą różnicą są białe nity i śruby, które nie podlegają rozmyciu (str. 351);
Tekstura odbić zmienia lokalne wartości parametrów Reflectivity i Roughness shadera materiału (str. 352);
Tam, gdzie obraz ref.png jest ciemniejszy, na powierzchni pojawiają się przebarwienia w kolorze Gloss Paint:Diffuse (str. 352). W zależności od tego, jak jasny jest to kolor, te przebarwienia mogą wyglądać jak rozjaśnienia lub zaciemnienia;
Obraz, który należy wykorzystać do sterowania szorstkością powierzchni (Roughness) to negatyw obrazu tekstury odbić (Reflectivity);
Do lepszej kontroli nad intensywnością tekstury Reflectivity lepiej jest użyć węzeł Range To Max (str. 353) zamiast węzła Moderate. (To przypadek „obrazu o białym tle”). Dla „obrazów o czarnym tle” (por. str. 353) — jak tekstury Roughness — lepiej się nadaje węzeł Range From Min (str. 354);
Nawet niewielka zmiana szorstkości powierzchni w znaczący sposób rozjaśnia oświetloną powierzchnię materiału (str. 354 i 355);
W tym miejscu kończymy nasze eksperymenty z materiałem B.Skin.Test. Zastosowaliśmy go do małego, lecz reprezentatywnego fragmentu modelu (statecznika i owiewki — Rysunek 6.6.1). Statecznik zawiera panele i nity jak skrzydła i większa część kadłuba, a owiewka — śruby, takie same jak na okapotowaniu silnika1. To była nasza „próbka”, pozwalająca znaleźć najlepsze metody przygotowania tekstur.
Zawsze jest łatwiej poprawiać błędy jakiejś niewielkiej części odtwarzanego samolotu, niż od razu na jego całej powierzchni. Pamiętaj, że rozpoczęcie przygotowywania tekstur od takiej małej „próbki” pozwoli Ci najszybciej dobrać najlepsze rozwiązanie2. Potem tylko je powielisz na resztę modelu.
W materiale B.Skin.Test opracowaliśmy schemat użycia dwóch podstawowych rodzajów tekstur: nierówności i odbić (Rysunek 6.6.2):
Rysunek 6.6.2 Schemat testowego materiału B.Skin.Test
W tym schemacie nie używamy jeszcze tekstury koloru, choć już wiesz jak taki obraz podłączać (por. str. 319 i 353). Zajmiemy się nią szczegółowo w jednej z sekcji następnego rozdziału (str. 425). Do tego czasu będziemy eksperymentować z powierzchniami utrzymanymi w naturalnym kolorze duralu.
W tym rozdziale poznałeś podstawowy sposób opracowania tekstur dla modelu. Robi się to tak:
Przygotuj w Blenderze indywidualne rozwinięcia (UV) dla każdej siatki, która ma być pokryta teksturą (str. 335). Uzgodnij ich położenie na wspólnym obrazie tak, by każda zajmowała inny fragment (str. 344);
Przygotuj zbiorczy obraz rozwiniętych siatek. W tym celu można gromadzić ich obrazy, wyeksportowane z Blendera do formatu SVG, w pomocniczym pliku uv.svg. (str. 345);
Stwórz w Inkscape wektorowy rysunek texture.svg. Nanieś w nim obraz nierówności modelu (linie podziału blach, nity, śruby, krawędzi konturów) dopasowany do obrazu rozwinięcia siatek (str. 345). Rezultat wyeksportuj jako pliki rastrowe nor_details.png (str. 346), blur.png (str. 347), shadows.png, rivets.png, screws.png (str. 350);
Na podstawie obrazów z Inkscape, stwórz w Gimpie pliki nor_blur.xcf i ref.xcf. Skomponuj z ich warstw odpowiednie obrazy rastrowe: nor_blur.png (str. 347), ref.png (str. 351);
Użyj obrazów nor_details.png, nor_blur.png do stworzenia w Blenderze odpowiednich tekstur nierówności (str. 348), a ref.png — jako tekstury odbić i szorstkości (str. 353 i 354);
W poprzednim rozdziale poznałeś podstawowe techniki pracy z teksturami i ich możliwości. Eksperymentowaliśmy tam na siatkach dwóch wybranych obiektów. Teraz czas pokazać, jak zastosować tę wiedzę na całym modelu:
Trzy pierwsze sekcje (7.1 - 7.3) tego rozdziału poświęcimy na szczegółowe omówienie rozwijania powierzchni samolotu w płaszczyźnie UV. Pokażę tu typowe problemy, jakie występują przy tej pracy, omówię metody ich rozwiązania.
W sekcji 7.4 pokażę, jak przygotować w Inkscape rysunek szczegółów powierzchni całego samolotu. Efektem będzie przygotowanie pierwszej, kompletnej tekstury: podstawowych nierówności (czyli nitów, śrub, krawędzi paneli).
W sekcji 7.5 zajmiemy się komponowaniem obrazów tekstur. W poprzednim rozdziale robiłem to w sposób „tradycyjny”, oparty w dużej mierze na plikach rastrowych i Gimpie. Teraz przedstawię lepszą (jak sądzę) alternatywę, w postaci filtrów Inkscape. Rezultatem będą: pomocnicza tekstura nierówności, oraz tekstura odbić światła.
W sekcjach 7.7, 7.8 i 7.9 zakończymy nakładanie podstawowych tekstur. W sekcji 7.7 opiszę jak nałożyć na model kamuflaż i „wyczarować” z powierzchni przetarcia i zabrudzenia eksploatacyjne. W rezultacie stworzymy podstawową teksturę koloru. W sekcji 7.8 pokażę jak nanieść na model „naklejki” — znaki przynależności państwowej, numery taktyczne, napisy. To pomocnicza tekstura barwy. Na koniec, w sekcji 7.9 przedstawię, jak za pomocą obrazu „wycinać” dziury w powierzchni samolotu. (Chodzi o pomocniczą teksturę, odwzorowującą tzw. otwory ulżeniowe w wewnętrznej strukturze płatowca).
Na koniec tego rozdziału znajdziesz schemat (w sekcji 7.11), podsumowujący jakie pliki tekstur, skąd, i do czego są używane. Te informacje przydadzą Ci się, gdy będzie trzeba coś na tych teksturach poprawiać.
W tym rozdziale będziemy wykorzystywać materiały z towarzyszącego tej książce pliku source.zip. Pliki *.blend odpowiadające rezultatom poszczególnych sekcji rozdziału znajdziesz w pliku p40.zip, a foldery z obrazami ich tekstur — w pliku textures1.zip. (Adres miejsca, z którego można pobrać te pliki, znajdziesz na. str. 22).
Stwórz kopię opracowanego w poprzednim rozdziale rysunku texture.svg, i nazwij ją skin.svg 1. Wypełnimy ją w tym rozdziale obrazem szczegółów powierzchni zewnętrznych całego modelu. Na początek, nauczeni wcześniejszymi doświadczeniami (por. str. 338, Rysunek 6.3.9), podstawmy „na spód” skin.svg wkomponowane w kwadrat plany istotnych fragmentów samolotu (Rysunek 7.1.1):
Rysunek 7.1.1 Złożenie planów samolotu, na potrzeby rozwinięcia UV (skin.svg).
Skin.svg zawiera już rzut z boku — na warstwie BP-Left. Nie ruszaj go, tylko dodaj poniżej, na dwóch kolejnych warstwach rzuty z góry i z dołu. Dopasuj je starannie do rzutu z boku, aby wszystkie trzy były w takiej samej skali. Potem ustaw te rzuty na rysunku mniej więcej w tym miejscu, gdzie będą rozwinięte odpowiednie siatki płata i kadłuba. Wstępnie możesz założyć, że rozwinięcie płata będzie miało kształt bardzo zbliżony do rzutu z góry, a kadłuba — zbliżony (ale nie tak bardzo) do rzutów z boku. Nie zapomnij pozostawić gdzieś miejsca na rozwinięcie prawej strony kadłuba (na razie zakładam, że umieszczę je poniżej rozwinięcia skrzydeł).
Rysunek 7.1.1b) zawiera lewe skrzydło i prawy statecznik stateczniku z rzutu z góry, a prawy płat i lewy statecznik — z dołu. Jak taki efekt szybko uzyskać w Inkscape? Na każdej z warstw BP-Top i BP-Bottom narysuj białe prostokąty. Użyj ich, aby zasłonić prawe skrzydło i lewy statecznik. Przestaw Blend mode warstwy BP-Top z Normal na Multiply (Rysunek 7.1.1a). Efektem będą wyraźne, czarne linie z każdej strony samolotu (wyjaśnienie, dlaczego — patrz str. 1246). Stwórz kopię rastrową tego obrazu o wymiarach 2048x2048 i zapisz ją pod nazwą reference.png. Użyjemy jej później do dopasowania rozwinięć siatek modelu.
W Blenderze czas skończyć już z materiałem B.Skin.Test, który przewijał się przez cały Rozdział 6. Przypisz zewnętrzne powierzchnie statecznika pionowego i owiewki usterzenia z powrotem do materiału B.Skin.Camouflage. Materiał ten wzbogacimy w następnych sekcjach o odpowiednie tekstury..
Do pracy z rozwinięciem siatki wygodniejszy jest nieco inny układ ekranu: dwa okna 3D View i jedno UV/Image Editor (Rysunek 7.1.2) . W Blenderze możesz stworzyć wiele alternatywnych zestawów okien, i szybko się pomiędzy nimi przełączać. Jeżeli chcesz teraz przygotować sobie taki odrębny układ ekranu do rozwinięć UV — zobacz na str. 788, jak go stworzyć. Ja tak zrobiłem. Nowemu układowi ekranu nadałem nazwę 6-UV Mapping.
Płat rozwiniemy na dwie powierzchnie — górną i dolną. Przed rozwinięciem każdą z nich trzeba zaznaczyć. To klikanie w grupy wierzchołków wymaga dłuższej chwili. Aby tę pracę wykonać tylko raz, proponuję zapamiętać zaznaczone wierzchołki jako grupy o nazwach: Top (górna powierzchnia płata) i Bottom (reszta). (Więcej na temat — patrz str. 945) . Od tej chwili możesz je szybko wybierać, odwołując się do odpowiedniej grupy. Rysunek 7.1.3 pokazuje, gdzie należy wyznaczyć granice podziału tych zbiorów wierzchołków:
Rysunek 7.1.3 Zaznaczenie górnej części płata (grupa wierzchołków o nazwie Top).
Przed rozwinięciem trzeba ustawić widok prostopadle do płaszczyzny XY płata. Tu nie można po prostu się przełączyć na widok z góry — płat jest przecież zaklinowany pod kątem 1º, i ma wznios 6º. Gdy przełączysz się na „zwykłą” projekcję XY, linie żeber będą przez to lekko wygięte, a cały płat jest nieco krótszy. Przełącz się więc na chwilę do Object Mode, i użyj polecenia View→Align View→Align View to Selected→Top (str. 837).
Teraz wróć z powrotem do Edit Mode i zaznacz wszystkie wierzchołki siatki skrzydła (A). Rozwinięcie UV warto rozpocząć od wywołania polecenia Mesh→UV Unwrap→Reset (za chwilę zobaczysz, dlaczego). Potem zaznacz tylko górną powierzchnię siatki (grupa Top) i wywołaj polecenie Mesh→UV Unwrap→Project From View (Rysunek 7.1.4):
Rysunek 7.1.4 Rozwinięcie UV grzbietu płata (metodą Project From View).
Tak jak powierzchnie górne, zaznacz teraz i rozwiń dolne powierzchnie skrzydła (grupa wierzchołków Bottom) . Ten fragment przesuń nieco w edytorze UV do dołu, i wykonaj na nim lustrzane odbicie (UVs→Mirror) wzdłuż osi Y. Na razie „przyszpil” (Pin) wszystkie rozwinięte wierzchołki.
Po takim rozwinięciu warto obejrzeć, jak „leży” cała siatka. Zaznacz w 3D View wszystkie wierzchołki i popatrz w edytor UV. Co u licha!? Skąd się na nim wzięły te trójkątne ściany, zajmujące cały obszar!? (Rysunek 7.1.5):
Rysunek 7.1.5 Weryfikacja poprawności rozwinięcia (sprawdzenie, czy jakieś ściany nie zostały pominięte).
Ten wielki kwadrat z przekątną, obejmujący cały rysunek, to efekt działania polecenia UV Unwrap→Reset, które wywołaliśmy na początku rozwijania. Przygotuj się na takie „odkrycia” wszędzie tam, gdzie rozwijasz siatkę „kawałek po kawałku” . Ściany, które Ci umknęły, pozostają przy swoich współrzędnych UV nadanych przez operator Reset — i są rozciągnięte na cały obszar tekstury. Mówiąc szczerze, zapomniałem o nich celowo, aby pokazać Ci, jak sobie radzić z takim problemem.
Przełącz edytor UV na synchronizację zaznaczenia z oknem 3D View (przycisk w nagłówku edytora UV). Wyłącz zaznaczenie wszystkich wierzchołków (A), a następnie zaznacz te cztery, widoczne w narożnikach obrazu UV (Rysunek 7.1.6a):
Rysunek 7.1.6 Wyszukiwanie ścian, pominiętych przy rozwinięciu.
Podczas zaznaczania w edytorze UV od razu załóż, że chodzi tu o wiele ścian. Aby je wszystkie od razu podświetlić w oknie 3D View, użyj jednej z masowych metod selekcji — np. Border Select (B, str. 891). Po zaznaczeniu przyjrzyj się ścianom, które zostały wyróżnione w oknie widoku (Rysunek 7.1.6b,c). (Gdybyś nie mógł ich od razu znaleźć wzrokiem, kursor wskaże Ci ich położenie — wystarczy użyć polecenia Mesh→Snap→Cursor to Selection.). Rysunek 7.1.6b pokazuje, że w tym przykładzie ewidentnie pominąłem rząd ścian wzdłuż granicy obszaru Top (por. str. 361, Rysunek 7.1.3)2. Ten rząd nie należy do obszaru Bottom. Przypisz więc zaraz (Vertex Groups:Assign) zaznaczone wierzchołki do tej grupy. Następnie wyłącz tryb synchronizacji selekcji pomiędzy edytorem UV i 3D View. Usuń „przyszpilenia” (UVs→Unpin) z górnej powierzchni skrzydła, i powtórz powtórnie jego rozwinięcie (Project From View). Tym razem powinno się obyć bez niespodzianek (Rysunek 7.1.7):
Rysunek 7.1.7 Poprawione rozwinięcie dolnej powierzchni płata.
Ogólny układ płatów jest gotowy. Tak się składa, że była to najmniej pracochłonna część pracy nad rozwinięciem. Teraz czas zagłębić się w poprawki drobiazgów.
Zacznijmy od obramowania otworu na koła podwozia. W wyniku „rozwinięcia przez rzutowanie”, wierzchołki ścian tego „paska” dokładnie się zasłaniają w płaszczyźnie UV (Rysunek 7.1.8a,b):
Rysunek 7.1.8 „Odwinięcie” obramowania otworu podwozia.
Gdybyśmy nic z tym nie zrobili, nie można by było nanieść na ten fragment poszycia tekstury drobnych otworów, rozmieszczonych wzdłuż krawędzi3.
Aby odwzorować ten szczegóły na teksturze, musimy „odwinąć” obramowanie — najlepiej do środka otworu. W widoku 3D View zaznacz górną krawędź tego rzędu ścian (Rysunek 7.1.8a). Następnie przełącz selekcję w edytorze UV na „synchroniczną” (Rysunek 7.1.8b). Ustaw także punkt odniesienia transformacji — Pivot — na Bounding Box Center (środek obszaru, zajmowanego przez zaznaczone wierzchołki). Teraz w edytorze UV wywołaj zmianę skali (S), i zmniejsz zaznaczony kontur o około 5% (Rysunek 7.1.8c). W efekcie uzyskamy ładne i równe obramowanie otworu.
Kolejnym elementem do „odwinięcia” są boczne ściany wnęki lotki. Należą do rozwinięcia spodu płata. „Zagniemy” je do środka wnęki, deformując nieznacznie łączące je ściany (Rysunek 7.1.10).
Zwróć uwagę, że wierzchołki górnej krawędzi ścian, które chcemy przesunąć w przestrzeni UV, występują także na rozwinięciu z góry (por. Rysunek 7.1.9a, krawędź 4). To bardzo utrudnia zaznaczanie, bo nie możemy wykorzystać, jak poprzednio, trybu synchronicznego. (Gdybyś go użył, przesuwałbyś w UV wierzchołki na obydwu powierzchniach równocześnie, i zepsuł rozwinięcie grzbietu płata.) Musimy więc zaznaczać inaczej. Upewnij się, że synchronizacja selekcji pomiędzy edytorem UV i oknem 3D View jest wyłączona (jeżeli nie jest — wyłącz ją). Zacznij od zaznaczenia w 3D View grupy wierzchołków Bottom. Wyklucz z niej dolne krawędzie żebra, których nie będziemy ruszać (Rysunek 7.1.9a — krawędzie A i B):
Rysunek 7.1.9 Rozwinięcie bocznej ściany wnęki lotki.
Zauważ, że w ten sposób dolne krawędzie wnęki (A, B) i ich wierzchołki znikły z edytora UV. Dokładnie o to nam chodziło — teraz można w edytorze zaznaczyć wierzchołki UV krawędzi 1,2, 3, które chcemy przesunąć do środka wnęki (Rysunek 7.1.9a).
Najpierw obróć je wszystkie wokół narożnika na krawędzi spływu, tak by znalazły się pośrodku obszaru, który ma zajmować ściana wnęki (Rysunek 7.1.9b). To jest ostateczne położenie środkowej krawędzi 1. Potem „rozwiń” pary wierzchołków z krawędzi 2, 3 jak wachlarz — obracając każdą z par o trochę inny kąt wokół tego samego środka obrotu (w narożniku). Gdy rozłożyłeś już w UV wszystkie punkty siatki tak, że nie zasłaniają się wzajemnie, włącz z powrotem widoczność krawędzi A i B(Rysunek 7.1.9b). Potem wystarczy wywołać polecenie UVs→Unwrap (E) by we wnęce lotki zaroiło się od ścian. Pozostaje jeszcze parę ostatnich poprawek kształtu, które ułożą wierzchołki 2 i 3 bardziej równomiernie, i narożnik jest gotowy (Rysunek 7.1.9c).
Rysunek 7.1.10 przedstawia układ wnęki lotki po „odwinięciu” obydwu ścian bocznych:
Rysunek 7.1.10 Wnęka lotki po poprawieniu rozwinięcia (spód płata).
Dlaczego tak podkreślałem, abyś przy formowaniu wnęki lotki zaznaczył w oknie 3D View tylko dolną powierzchnię płata (wierzchołki z grupy Bottom)? Sam się przekonaj: zaznacz w 3D View cały płat, a potem wywołaj w edytorze UV polecenie Unwrap (E) (Rysunek 7.1.11):
Rysunek 7.1.11 Problemy z modyfikacją UV, gdy w oknie 3D View jest zaznaczona cała siatka.
Widzisz, co się nam z rozwinięciem porobiło? Zaraz się z tego wycofaj (Ctrl-Z — Undo)!. Program połączył ze sobą ściany, które podczas rzutowania rozdzieliliśmy wzdłuż krawędzi natarcia i spływu. W tym zachowaniu nie ma nic nietypowego (no, może to, że przesunięciu uległy niektóre „przyszpilone” wierzchołki). Wystarczy przypomnieć, że Blender zadziałał tak samo, łącząc ścianami „przyszpilone” krawędzie z przykładu na str. 338 (Rysunek 6.3.8). Tyle, że tam był to efekt pożądany, a tu — nie. Potrzebujemy czegoś, co powie Blenderowi że płat ma pozostać przecięty wzdłuż krawędzi natarcia i spływu. Służą do tego tzw. oznaczenia szwów (Seam). Nanosi się je na krawędzie siatki poleceniem Mark Seam, z menu Edges (Ctrl-E). (Więcej na ten temat — str. 947). Zaznacz na płacie szwy tam, gdzie to pokazuje Rysunek 7.1.12:
Rysunek 7.1.12 Naniesienie na siatkę płata szwów rozwinięcia UV.
Szwy na razie umieść dokładnie wzdłuż granicy obszaru Top (porównaj Rysunek 7.1.12a, b i Rysunek 7.1.3 ze str. 361). Zwróć szczególną uwagę na drobne ściany — na przykład w narożnikach wnęki lotki (Rysunek 7.1.12b). Często można zapomnieć o takich szczegółach.
Gdy wydaje Ci się, że wszystko jest jak należy, ponownie zaznacz cały płat i wywołaj w edytorze UV polecenie Unwrap. Niewykluczone, że ujawni się wówczas jakaś zapomniana grupka wierzchołków, np. przypisanych nie do tej części płata, co trzeba. Popraw je i próbuj jeszcze raz, dopóki nic nie będzie się „samo rozwijało”.
Po zapanowaniu nad samoczynnym rozwijaniem się siatki, możesz zająć się ostatnim detalem płata, wymagającym poprawki. Chodzi o kołnierz u nasady. W tej chwili jego boczne ściany są w rozwinięciu UV zredukowane do kreski, a przecież znajdowały się na nich śruby, łączące obydwa skrzydła. Nie byłoby się czym specjalnie przejmować, gdyby nie to, że górna część poszycia płata jest podłogą kabiny. W jej środku widać dłuższy odcinek tego kołnierza. Co więcej, przymocowywano do niego elementy wyposażenia, np. drążek sterowy. Na pewno prędzej czy później pojawi się potrzeba umieszczenia na bocznych ścianach kołnierza śrub, i towarzyszących im zabrudzeń. Rysunek 7.1.13 przedstawia szczegóły rozwinięcia tego fragmentu:
Rysunek 7.1.13 Szczegóły rozwinięcia UV kołnierza u nasady płata.
Rozwinięcie tego detalu jest bardzo proste — polega na rozsunięciu krawędzi 1, 2, 3, 4 (Rysunek 7.1.13d) wzdłuż osi U (X). Przy czym należy to zrobić tak, by zwiększyć szerokość ścian ograniczonych krawędziami 1 i 2 oraz 3 i 4 (Rysunek 7.1.13b,c). Szerokość ścian pomiędzy krawędziami 2 i 3, odpowiadających grubości kołnierza, pozostaw bez zmian (Rysunek 7.1.13b). Tak się szczęśliwie złożyło, że na obydwu rozwinięciach należy odsunąć wierzchołki UV dokładnie w ten sam sposób. Możesz więc użyć w tym przypadku synchronizacji selekcji z widokiem 3D View. To bardzo ułatwia zaznaczanie.
Na tym zakończyliśmy rozwijanie siatki płata. Czas teraz podstawić pod UV/Image Editor obraz testowy, np. o wymiarach 2048x2048 px (szczegóły — str. 1125). Nadajmy mu nazwę Test. (W przyszłości będziemy podstawiać pod ten obraz inne pliki. Dlatego warto tę testowy wzór zapisać na dysku, pod nazwą uv_test.png. Ułatwi to jego powtórne załadowanie). Przełącz tryb wyświetlania okna 3D View na Textured i uważnie obejrzyj „szachownicę”, która pojawi się na powierzchni skrzydła (Rysunek 7.1.14):
Rysunek 7.1.14 Szukanie deformacji rozwinięcia UV za pomocą obrazu testowego.
Szukaj jakichś zaburzeń wzoru testowego — wygiętych krawędzi, lub kwadratów nierównej wielkości. W zasadzie wygląda na to, że rozwinięcie nie wymaga specjalnych poprawek.
Aby uzyskać równomierny rozkład obrazu tekstury na powierzchni, koniecznie włącz w modyfikatorze Subsurf (okno Properties, zestaw Modifiers) opcję Subdivide UVs (Rysunek 7.1.15).
W Blenderze 2.49, gdy żebra skrzydła były rozłożone w nierównych odstępach, po włączeniu tej opcji występował pewne efekt uboczne wzdłuż szwów siatki4. Dlatego obejrzyj te fragmenty siatki szczególnie starannie. W każdym razie wydaje mi się, że gdzieś w kolejnej wersji (2.5?) Blendera ten błąd usunięto, w bo w obecnym wydaniu (2.62) siatka nie ma w tych miejscach żadnych zaburzeń.
Warto jeszcze chwilę pomyśleć, czy w ogóle podział siatki wzdłuż krawędzi natarcia jest najlepszym pomysłem. Nie mam wątpliwości co do krawędzi spływu — takie ostre „kanty” doskonale maskują drobne nieciągłości barwy łączonych tekstur. Ale krawędź natarcia ma stosunkowo duży promień zaokrąglenia, i wszystko będzie na niej widać „jak na dłoni”. Różne egzemplarze P-40 były eksploatowane często „w trudzie i brudzie” lotnisk polowych. Liczne fotografie pokazują charakterystyczne zabrudzenie przedniej krawędzi skrzydeł, ciągnące się od gondoli podwozia do połowy płata (za lufy karabinów maszynowych). Spójne namalowanie czegoś takiego na dwóch oddzielnych kawałkach tekstury jest bardzo trudne. Lepiej dociągnąć linię podziału do najbliższego łączenia paneli poszycia. W przypadku P-40 będzie to dolna krawędź przedniego dźwigara (Rysunek 7.1.16a):
Rysunek 7.1.16 Przesunięcie linii podziału siatki do najbliższego połączenia blach.
Usuń starą linie podziału na krawędzi natarcia (Clear Seam) i zaznacz nową. Następnie w edytorze UV zaznacz odpowiedni zespół ścian (najłatwiej to zrobić w trybie synchronizacji selekcji, ale z włączonym zaznaczaniem ścian, nie wierzchołków). Pozostaw „przyszpilenia” tylko wzdłuż tylnej, górnej i dolnej krawędzi tego segmentu. Pozostałe usuń (UVs→Unpin). Potem naciśnij E (Unwrap), by dać się siatkom połączyć (Rysunek 7.1.16b).
Przed rozwinięciem krawędzi natarcia ustaw tryb UV Calculation na Conformal (w tym przypadku lepiej się sprawdza od Angle Based — por. str. 943).
Krawędź panelu poszycia jest najlepszym miejscem na granicę rozwinięcia siatki5. Pewne nieciągłości barwy, które mogą na niej mogą wystąpić, nie będą razić na gotowym modelu — coś takiego może się zdarzyć i „w naturze”. Zadbaj tylko o to, by linie żeber na rozwinięciu pozostały pionowe (Rysunek 7.1.17):
Rysunek 7.1.17 Prostowanie drobnych odchyleń od pionu linii żeber.
Przy rozwijaniu uwolnione (tzn. nie „przypięte”) wierzchołki krawędzi żeber wygięły się nieco. Zaznaczaj je po kolei, prostuj (W, Align X — str. 1127), a potem ponownie „przypinaj” (Pin) — tak, jak to pokazuje Rysunek 7.1.17 . To tylko niezauważanie deformuje rozwinięcie, a proste linie żeber pozwolą Ci potem szybko nanieść na obraz łączenia paneli i nity.
Kształt rozwinięcia skrzydła można uznać za zakończony. Pozostaje „przymierzyć” je do planów, by upewnić się, co do proporcji, a także dobrać odpowiedni rozmiar rozwinięcia na obrazie tekstury.
Umówmy się, że wszystkie siatki będziemy przypisywać do pojedynczego obrazu o nazwie Test. (Wykorzystywaliśmy go w tej sekcji do wyszukiwania deformacji w rozwinięciu płata). Początkowa zawartość Test nie jest tak istotna, bo będziemy ją co chwila zmieniać poleceniem Image→Replace. Wywołując to polecenie dla jednej siatki, podstawisz nowy obraz także dla wszystkich pozostałych. Rysunek 7.1.18 przestawia obraz Test, w którym testowa „szachownica” UV została zastąpiona przez rysunek reference.png:
Rysunek 7.1.18 Dopasowanie rozwinięcia do planów (i rozwinięć innych siatek).
Użycie wspólnego obrazu Test pozwala wyświetlać w UV/Image Editor rozwinięcia siatek wielu zaznaczonych obiektów naraz (po włączeniu opcji View→Draw Other Objects — por. str. 344).
W czasie przymiarek do rysunku referencyjnego wyszło mi, że siatka płata za dużo „zachodzi” na umieszczony powyżej obrys kadłuba. Od razu po dopasowaniu do planów widać, że przy tej skali nie upakujemy całego samolotu w założony obszar. Trzeba będzie coś zmniejszyć.
Do prawidłowego ustalenia rozmiaru sylwetek na rysunku referencyjnym, wykorzystałem wyeksportowane z Blendera (str. 1128) rozwinięcie UV naszego płata. Wczytałem ten plik do Inkscape (na warstwę UV). Posługując się nim, proporcjonalnie zmniejszyłem wszystkie sylwetki na rysunku skin.svg (por. str. 360, Rysunek 7.1.1). Założyłem, że rozwinięcie kadłuba będzie o 50% wyższe od rzutu z boku. Okazuje się, że wystarczyło zmniejszyć całość o 15%, i nieco inaczej rozłożyć na powierzchni rysunku. Poprawiony rezultat zapisałem ponownie do pliku reference.png (Rysunek 7.1.19).
Potem w Blenderze dopasowałem rozwinięcie skrzydła do zmienionych rysunków referencyjnych.
Na tym zakończymy pracę nad przygotowaniem siatki płata w przestrzeniu UV. Była to jedna z trudniejszych do rozwinięcia powierzchni. Doświadczenia, które zdobyliśmy przy jej przygotowaniu, są wyliczone w podsumowaniu tej sekcji.
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-7.01.blend, a pliki z obrazami — w folderze model\p40\textures\7.01\* (por. str. 22).
Do pracy z teksturą potrzebne są rysunki referencyjne wpisane w kwadrat. Rzut z boku umieść na nich z grubsza tam, gdzie ma być rozwinięcie kadłuba, a rzut z góry — tam, gdzie rozwinięcie powierzchni skrzydeł (str. 360);
Zdefiniuj nowy, oddzielny układ ekranu, przeznaczony do pracy z rozwinięciami UV. Do tej pracy potrzebne są dwa podstawowe okna: widoku 3D i edytora UV (str. 361);
Podstawowe rozwinięcie płata uzyskasz poprzez złożenie płaskich rzutów (Project From View) z góry i z dołu (str. 361);
Rozwijanie siatki zaczynaj od wywołania polecenia UV Unwrap→Reset (str. 361). Po rozwinięciu zawsze zaznaczaj całą siatkę, aby znaleźć w edytorze UV ewentualne „zapomniane ściany”. Eliminuj je na bieżąco (str. 362);
Krawędzie, wzdłuż których dzielimy siatkę, warto oznaczyć jako „szwy” (Mark Seam — str. 365). Oszczędzi Ci to późniejszych zaskoczeń przy pracy z fragmentami siatki;
Większą część czasu, potrzebnego na rozwinięcie siatki, zajmuje praca nad detalami. W przypadku skrzydła są to „odwinięcia” takich szczegółów jak obramowanie otworu podwozia, wnęka lotki, kołnierz u nasady płata (str. 363);
Wszystkie rozwijane siatki przypisuj do tego samego obrazu — nazwijmy go Test (str. 366, 368). Pod tą nazwę możesz podstawić (poleceniem Image→Replace) każdy rysunek referencyjny, który jest w danym momencie potrzebny. Może to być testowa „szachownica” UV (UV Test Grid), może być plik reference.png z fragmentami planów samolotu. To rozwiązanie pozwala na natychmiastowa wymianę obrazu we wszystkich siatkach, a także ustawianie w UV/Image Editor rozwinięć różnych siatek obok siebie;
Aby uzyskać właściwe proporcje obrazu na ścianach powierzchni wygładzonej modyfikatorem Subdivison Surface, włącz jego opcję Subdivide UVs (str. 367);
Szwy na łagodnie zaokrąglonych obszarach, jak krawędź natarcia płata, najlepiej jest poprowadzić wzdłuż linii jakiegoś łączenia poszycia, występującego na rzeczywistym samolocie (str. 367). To zamaskuje drobne różnice barwy, zabrudzeń itp., którymi będą się różnić podzielone szwem obrazy;
Linie żeber skrzydła ustawiaj zawsze na rozwinięciu tak, by były liniami prostymi, najlepiej — pionowymi lub poziomymi (str. 368). Deformacja obrazu, spowodowana taką formą rozwinięcia UV jest minimalna. Za to proste linie znacznie ułatwiają późniejsze rysowanie mapy nierówności;
Rozwinięcie kadłuba zaczynamy od rzutu z boku, przeniesionego do przestrzeni UV. (Project From View —Rysunek 7.2.1):
Rysunek 7.2.1 „Płaski” rzut kadłuba na płaszczyznę UV (Project From View).
W edytorze UV „przypnij” (Pin) wierzchołki środka kadłuba. Następnie naciśnij E (Unwrap). Jeżeli Blender rozwinął Twoją siatkę inaczej niż pokazuje to Rysunek 7.2.2a), naciśnij F6 aby wyświetlić parametry ostatniego polecenia. Przełącz tam Unwrap:Method z Angle Based na Conformal (Rysunek 7.2.2b):
Rysunek 7.2.2 Wstępne rozwinięcie połowy kadłuba (Unwrap).
Unwrap rozwinął się całkiem poprawnie ściany grzbietu i spodu kadłuba, których wierzchołki nie były „przypięte” do obrazu. Zgodnie z prawami geometrii, linie wręg uległy nieznacznemu zakrzywieniu. Pozostaje teraz kolejno je wyprostować (W — Straighten X), przy okazji „przypinając” (Pin) na stałe do obrazu (Rysunek 7.2.3):
Rysunek 7.2.3 Rozwinięcie połowy kadłuba — po poprawkach.
Przy okazji wyprostuj krawędź przed kabiną do linii poziomej, oraz skoryguj nieco kształt zakładek w obramowaniu otworu kółka ogonowego. (Nic wielkiego, trzeba przesunąć parę ścian w narożnikach)
Nie zaszkodzi w tym momencie „przypiąć” do obrazu wszystkich wierzchołków. Nadszedł teraz także czas na wygenerowanie na stałe prawej strony kadłuba. Do tej pory jej obecność „załatwiał” modyfikator Mirror. Starałem się ten moment jak najbardziej odwlec, gdyż wszystkie modyfikacje kształtu są łatwiejsze do wykonania na jednej połówce. Rozwinięcie UV także nie poszłoby tak łatwo, gdybyśmy wykonywali je na pełnej siatce kadłuba. Dalej jednak nie można tego w ten sposób ciągnąć. Musimy mieć wyróżnioną strony prawą i lewą.
Utworzenie symetrycznej połówki jest błyskawiczne — wystarczy „utrwalić” modyfikator Mirror(przyciskiem Apply — por. str. 927) (Rysunek 7.2.4a):
Rysunek 7.2.4 Nowa, symetryczna połowa kadłuba.
Zaraz po tej operacji warto jest stworzyć w tej siatce po grupie wierzchołków dla każdej ze stron: Left i Right. Przydadzą się za chwilę. Dodanie drugiej połowy zamknęło obwód kadłuba, więc czas zaznaczyć na nim krawędzie szwów. Na początek poprowadź je wzdłuż osi symetrii (Rysunek 7.2.4b).
Upewnij się, że synchronizacja selekcji pomiędzy oknami 3D View i UV/Image Editor jest wyłączona i zaznacz w oknie 3D View lewą połowę kadłuba. (Najłatwiej to zrobić zaznaczając w panelu Vertex Groups grupę Left i naciskając przycisk Select, umieszczony poniżej). Spowoduje to pojawienie się w UV/Image Editor ścian tej części siatki. Przesuń je do dołu, aby zrobić miejsce na prawą połowę kadłuba. Następnie zaznacz grupę Right. Przekonasz się, że początkowo ma takie samo rozwinięcie jak strona prawa. Stwórz jej symetryczne odbicie — np. poleceniem UVs→Mirror (Rysunek 7.2.5):
Rysunek 7.2.5 Wstępne rozwinięcie całego kadłuba
Teraz warto się zastanowić, jak zmienić układ szwów, aby ukryć na modelu zarys podziału tekstur. Grzbiet kadłuba przed kabiną proponuję wydzielić w osobny fragment siatki. Krawędzie podziału poprowadź wzdłuż linii połączeń blach po bokach kadłuba (Rysunek 7.2.6):
Rysunek 7.2.6 Wydzielenie przedniego panelu.
Potem w oknie UV/Image Editor wystarczy zbliżyć do siebie wydzielone w ten sposób kawałki powłoki, i pozwolić się im połączyć (Rysunek 7.2.7):
Rysunek 7.2.7 Scalenie rozwinięcia UV przedniego panelu
Linię podziału grzbietu kadłuba za kabiną poprowadź niesymetrycznie, wzdłuż prawej krawędzi jednego z paneli grzbietu kadłuba (Rysunek 7.2.8a):
Rysunek 7.2.8 Niesymetryczny szew grzbietu kadłuba — cały przebieg (a), oraz część widoczna (b).
Zwróć uwagę, że część tego szwu udało się ukryć pod elementami ramek oszklenia kabiny (Rysunek 7.2.8b).
Oddziel odcięty szwem grzbiet za kabiną pilota od prawej strony kadłuba, i „doklej” go do strony lewej. (Tak samo, jak to zrobiliśmy w poprzedniej sekcji z krawędzią natarcia płata — por. str. 367).
W dolnej części ogona zapomnieliśmy o poprowadzeniu linii siatki wzdłuż krawędzi podłużnic — nasz błąd! Teraz za dużo roboty byłoby z jego korektą. Na szczęście to fragment dość rzadko pojawiający się na scenie — zazwyczaj ani w ujęciu samolotu na lotnisku, ani w locie, nie widać tej części kadłuba. Dlatego proponuję pozostawić tu szew, biegnący środkiem kadłuba.
Rysunek 7.2.9 przedstawia rozwinięcie kadłuba po wprowadzeniu opisanych powyżej poprawek:
Rysunek 7.2.9 Niesymetryczne rozwinięcie obydwu stron kadłuba.
Teraz można podstawić pod to rozwiniecie testową „szachownicę”. (Nie zmieniaj obrazu Test, tylko zmień poleceniem Image→Replace jego zawartość na plik uv_test.grid.png. To obraz, który zapisaliśmy w poprzedniej sekcji — por. str. 366). Rysunek 7.2.10 przedstawia uzyskany rezultat:
Rysunek 7.2.10 Sprawdzanie poprawności rozwinięcia (obraz UV Test).
W zasadzie całość wygląda poprawnie. Wszystkie kwadraty szachownicy mają takie same rozmiary, a ich krawędzie nie są zakrzywione.
Przyjrzyjmy się teraz dokładniej miejscom, w których zazwyczaj coś się nie zgadza: ścianom wzdłuż linii szwów. Zacznijmy od ogona (Rysunek 7.2.11):
Rysunek 7.2.11 Poprawianie deformacji wzdłuż szwu na grzbiecie kadłuba.
Przyjrzyj się szczególnie fragmentowi kadłuba za oszkleniem kabiny. Obraz na ścianach przylegających do linii szwu ma na pewnym odcinku nieznacznie wygięte krawędzie testowej „szachownicy” (Rysunek 7.2.11a). Wydaje mi się, że przyczyną tej deformacji jest leżąca wzdłuż szwu czworokątna ściana o nieregularnym kształcie. (Może nią także być pochyła krawędź, łącząca tę i następną ścianę). W każdym razie ta deformacja nie wystąpiłaby, gdybyś poprowadził szew o jedną krawędź dalej (Rysunek 7.2.11b). Niestety, wzdłuż tej krawędzi nie biegnie żadna wręga ani podłużnica! Nie chcę prowadzić linii podziału siatki jeszcze niżej, wzdłuż następnego panelu poszycia kadłuba. (Szew biegłby wtedy przez znaki rozpoznawcze). Proponuję na razie tak zostawić go w stanie który pokazuje Rysunek 7.2.11a). Zobaczymy, jak wyjdą krawędzie blach i nity — być może deformacja będzie na tyle niewielka, że już nie trzeba będzie niczego zmieniać. W razie czego wprowadzimy powyżej tego szwu dodatkową krawędź — na przykład poleceniem Loop Cut.
Kolejne zniekształcenie można dostrzec na odcinku przed kabiną pilota (Rysunek 7.2.12) :
Rysunek 7.2.12 Poprawianie deformacji wzdłuż szwu na boku kadłuba.
Ta deformacja to odsunięcie linii podziału paneli, widocznej na obrazie, od tego, co widać na siatce (Rysunek 7.2.12a). To inny rodzaj zniekształcenia. Tak się szczęśliwie składa, że akurat ten fragment zewnętrznej powłoki jest niemal płaski, więc możesz przeciwdziałać poprzez wyostrzenie wybranych krawędzi. Zwiększenie ostrości (Crearse) linii szwu i dwóch sąsiednich krawędzi do 1.0 skutecznie wyeliminowało to zniekształcenie (Rysunek 7.2.12b). (Zwróć uwagę szczególnie na wyostrzone krawędzie, nie należące do linii szwu — z tyłu większa, z przodu bardzo mała).
Główna część kadłuba już jest rozwinięta. Choć jeszcze w zeszłej sekcji planowałem to inaczej, proponuję pozostawić rozwinięcia tych dwóch połówek kadłuba obok siebie. Z przodu dodamy za chwilę rozwinięcie maski silnika. Takie położenie ułatwi np. malowanie plam kamuflażu. W związku z tym trzeba rozmieścić trochę inaczej pozostałe siatki na naszym rozwinięciu1.
Podstaw pod obraz Test plik z rysunkami referencyjnymi (reference.png). Upewnij się także, że w edytorze UV masz włączone View→Draw Other Objects (por. str. 368, Rysunek 7.1.18). Zaznacz w oknie 3D View obiekty, których siatki mamy już rozwinięte. Na razie to lewe skrzydło, kadłub, statecznik pionowy i owiewka usterzenia. Następnie przejdź do edycji ostatniego spośród wskazanych obiektów (jest to obiekt aktywny). Gdy to zrobisz, w oknie UV/Image Editor zobaczysz obok siebie wszystkie siatki (Rysunek 7.2.13):
Rysunek 7.2.13 Nowe rozłożenie siatek na wspólnej powierzchni UV.
Wybierz do edycji w UV siatkę płata i przesuń ją do dołu — nie musimy tam już rezerwować miejsca na drugą część kadłuba. Rozwinięcie drugiego płata wstawimy później, po lewej stronie. Pomiędzy połówkami kadłuba wstaw owiewkę usterzenia. (Nie wiem, czy to ma jakieś praktyczne uzasadnienie, ale staram się umieścić na rozwinięciu UV blisko siebie siatki elementów, które w 3D są połączone). Na rysunku pozostał „cień” po innym, naniesionym w Inkscape położeniu tego elementu. To nic nie szkodzi, wszystkie takie fragmenty przeniesiemy potem w nowe miejsce. W pobliżu umieść także rozwinięcie statecznika pionowego (drugą połówkę dodamy później).
Przestrzeni jest jeszcze dużo, starczy miejsca i na drugie skrzydło, i na rozwinięcia stateczników i sterów („upchnięte” gdzieś po bokach). Gdy do końca zapełnimy ten obszar siatkami, przeniesiemy obrazy ich rozwinięć do Inkscape (uv.svg). Użyjemy ich do dopasowania położenia planów i naniesiemy na nie elementy mapy nierówności.
Czas zająć się maską silnika. Rozwinięcie dwóch bocznych paneli jest proste — Project From View z rzutu z boku (Rysunek 7.2.14a). Rezultat zmniejsz do odpowiedniej skali i wpasuj w sylwetkę samolotu (Rysunek 7.2.14b):
Rysunek 7.2.14 Rozwinięcie bocznych segmentów okapotowania silnika.
Rozwinięcie osłony chłodnic jest trudniejsze. Proponuję podzielić ją na trzy obszary, wzdłuż połączenia blach w dolnej części powłoki (Rysunek 7.2.15a). Obszar 1 rozwiń (Project From View) w oparciu o projekcję z boku, a obszary 2, 3 — w oparciu o projekcję z dołu. Wyprostuj centralną krawędź (dokleimy do niej potem rozwinięcie drugiej, symetrycznej połówki). Na koniec przesuń do przodu obszar 3, aby bardziej wyróżnić słupki podziału wlotu chłodnicy (Rysunek 7.2.15b):
Rysunek 7.2.15 Rozwinięcie osłony chłodnic cieczy.
Rozwinięcie panelu z chwytem powietrza rozpocznij od kanału i jego krawędzi (Rysunek 7.2.16):
Rysunek 7.2.16 Rozwinięcie wewnętrznej powierzchni chwytu powietrza.
Zaznacz w rzucie z przodu kanał chwytu powietrza do gaźnika, i wywołaj polecenie Project From View (Rysunek 7.2.16a). „Przypnij” do rysunku wierzchołki okrągłej krawędzi chwytu powietrza (Rysunek 7.2.16b). Potem kolejno przypinaj i zmniejszaj kolejne wręgi kanału, by wypełniły przestrzeń wewnątrz krawędzi chwytu (Rysunek 7.2.16c). Wystąpi tam ogromna deformacja obrazu tekstury, ale nie ma się co przejmować — to miejsce bardzo mało widoczne.
Nanieś na siatkę szwy. Poprowadź je wzdłuż krawędzi chwytu powietrza, możliwie najkrótszą droga do krawędzi (Rysunek 7.2.17a, Rysunek 7.2.17a,c). Następnie zaznacz i rozwiń powłokę zewnętrzną (UV Unwrap→Unwrap) (Rysunek 7.2.17) :
Rysunek 7.2.17 Rozwinięcie zewnętrznej powierzchni chwytu powietrza.
Rozwinięcie zewnętrznej powłoki chwytu uległo podziałowi wzdłuż szwu, na dwie części: przednią i tylną. Zmień rozmiar tych fragmentów, dopasowując je do planów i do siebie nawzajem (Rysunek 7.2.17b,d). Następnie wyprostuj i przypnij do obrazu ważniejsze linie rozwinięcia.
Na koniec pozostaje złożyć razem rozwinięcia obydwu powłok: wewnętrznej i zewnętrznej (Rysunek 7.2.18):
Rysunek 7.2.18 Złożenie obydwu powierzchni chwytu powietrza.
W podobny sposób należy rozwinąć panele z wytłoczeniami na lufy karabinów maszynowych (Rysunek 7.2.19) :
Rysunek 7.2.19 Rozwinięcie panelu z wytłoczeniem na lufy km.
Wszystkie siatki osłon silnika są już rozwinięte. Zaznacz je wszystkie i ustaw obok siebie (Rysunek 7.2.20a) :
Rysunek 7.2.20 Złożenie siatek pokrywy silnika | Rysunek 7.2.21 Wyszukiwanie deformacji obrazu tekstury |
Do okapotowania silnika można zaliczyć także wylot z tuneli chłodnic cieczy. Dodaj do rozwinięcia i tę powierzchnię (Rysunek 7.2.20b), choć trudno właściwie ją jednoznacznie zakwalifikować jako powłokę zewnętrzną. Potem przypisz wszystkim siatkom obraz Test i sprawdź, czy gdzieś nie ma jakichś poważnych deformacji (Rysunek 7.2.21). Najlepiej, aby wzór „szachownicy” nie był zaburzony na całej powierzchni nosa samolotu, nawet na krawędziach paneli. Wystarczy poświęcić na to chwilę, aby potem łatwiej nakładać na model rysunek ze wszystkimi szczegółami. Oczywiście, nie przejmuj się zbytnio wnętrzem tunelu chwytu powietrza do sprężarki — tam deformacja być musi.
Po uważnym przejrzeniu rozkładu obraz testowego i naniesieniu na rozwinięcie UV drobnych poprawek, można skopiować je w drugą, symetryczną część osłony (Rysunek 7.2.22):
Rysunek 7.2.22 Pełne rozwinięcie osłon silnika | Rysunek 7.2.23 Wszystkie rozwinięte dotychczas siatki |
Generalnie oznacza to usunięcie ze wszystkich siatek B.350.* modyfikatora Mirror. W przypadku panelu z chwytem powietrza do sprężarki (B.350.Cowling.001), osłon chłodnic cieczy (B.350.Cowling.005) i ich wylotu (B.352.CoolerDuct.004) modyfikator zniknie w wyniku utrwalenia (Apply). Pozostałe fragmenty skopiuj i przenieś (transformacją Mirror — Ctrl-M) na prawą stronę samolotu. W nazwach kopii zastąp litery L literami R — np. lustrzanym odbiciem B.350.L.Cowling.002 po prawej stronie będzie B.350.R.Cowling.002.
Po rozwinięciu kadłuba warto jest także po raz kolejny skorygować układ rysunków referencyjnych, aby plany znalazły się pod rozwiniętymi obszarami. (To ułatwi dalsze prace). Aby dopasować je do położenia rozwinięć UV, wczytaj do skin.svg przynajmniej wyeksportowane z Blendera rozwinięcia głównej części kadłuba i skrzydła (Rysunek 7.2.24):
Rysunek 7.2.24 Zmieniony układ rysunków referencyjnych.
Sylwetkę rzutu z prawej strony (pierwsza od góry) powinienem właściwie wczytać jako oddzielny plik. W sumie różniła się od rzutu z lewej tylko brakiem luku bagażnika. Poszedłem trochę „na skróty” i zdecydowałem się użyć w tym charakterze lustrzanego odbicia rzutu z lewej. Będziemy tylko musieli pamiętać, że z prawej strony luku nie było.
W tej i poprzedniej sekcji udało się nam rozwinąć znaczną część powierzchni samolotu (Rysunek 7.2.25):
Rysunek 7.2.25 Złożenie dotychczas rozwiniętych siatek.
Pozostało jednak jeszcze wiele większych i mniejszych drobiazgów (na ilustracji mają jednolity kolor biały lub czarny). Ich rozwinięcia nie są specjalnie skomplikowane. Omówimy je pobieżnie w następnej sekcji.
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-7.02.blend, a pliki z obrazami — w folderze model\p40\textures\7.02\* (por. str. 22).
Podsumowanie
Prawie całe rozwinięcie kadłuba powstaje w oparciu o projekcję z boku (str. 371);
Rozwijanie powierzchni zmusza do tworzenia kopii symetrycznych części — np. prawej i lewej strony kadłuba. Zazwyczaj odbywa się to poprzez „utrwalanie” (Apply) modyfikatorów Mirror. (str. 372, 374). Czasami wiąże się z kopiowaniem siatek i obiektów (str. 379);
Szwy rozwinięcia kadłuba staraj się umieścić wzdłuż krawędzi oryginalnych paneli poszycia (str. 373);
Siatki głębokich tuneli, jak np. chwytu powietrza, można „ścisnąć” wewnątrz obramowania wlotu (str. 377). Wystąpi tam ogromna deformacja obrazu na siatce, ale zazwyczaj w takich miejscach to nie przeszkadza.
Panele z wystającymi chwytami powietrza dziel jak najkrótszym szwem na dwie części: tunel otworu wraz z obramowaniem i całą resztę (str. 377, 378). Obramowanie wraz z tunelem zazwyczaj najlepiej jest rozwinąć projekcją z przodu, a resztę — projekcją ogólną (Unwrap);
Podczas po rozwijania kadłuba i płatów następują kolejne „iteracje”, dopasowującą plany samolotu na rysunku referencyjnym do rozwinięcia głównych siatek (str. 380);
W tej sekcji pobieżnie omówię różne szczegóły związane z rozwijaniem powierzchni w UV. Zaczniemy od kołpaka śmigła. Szwy w tym miejscu mogą czasami popsuć realizm modelu. Lepiej rozwiń jego wierzchołki w UV jako koncentryczne okręgi (projekcją z przodu — Rysunek 7.3.1a,b) .
Rysunek 7.3.1 Rozwinięcie kołpaka śmigła.
Aby nie stracić na dokładności rysunku nitów i śrub — powiększ znacznie jego rozwinięcie o jakąś równą skalę, np. 3 lub 4 razy (Rysunek 7.3.1c). Zapamiętaj ten współczynnik, abyś potem wiedział, o ile przeskalować odpowiednie obiekty w Inkscape. (Później okazało się, że to rozwinięcie wymaga małej poprawki — p. str. 397)
Podczas rozwijania łopaty śmigła pozostaw połączenie siatek wzdłuż krawędzi natarcia (por. Rysunek 7.3.2a,d) — bo była często obtarta z farby. Dopilnuj, aby dolna część łopaty nie miała specjalnej deformacji — w tym miejscu było na śmigle umieszczone logo producenta (Rysunek 7.3.2d) :
Rysunek 7.3.2 Rozwinięcie łopaty śmigła.
Owiewkę podwozia zacznij rozwijać od projekcji obramowania na płaszczyznę (Rysunek 7.3.3a) :
Rysunek 7.3.3 Rozwijanie owiewki podwozia.
Pozwól się potem rozwinąć (E) przedniej części obramowania — po czym je przypnij (Rysunek 7.3.3b). Potem zaznacz resztę zewnętrznej siatki i pozwól jej wypełnić wnętrze obramowania (kolejne E). Rysunek 7.3.3c pokazuje, jakie rozwinięcie powinieneś uzyskać (po kilku drobnych poprawkach).
Rozwinięcie gondoli goleni podwozia starałem się wykonać tak, by żaden szew nie pojawił się na powierzchni. Doprowadziło to do powiększenia obrazu w części czołowej („jak na wygiętym kolanie” — Rysunek 7.3.4b). Taka jest cena kompromisów — w tym miejscu trzeba będzie zmniejszyć rozmiar nitów (poprzez zmianę skali). Na szczęście nie było ich tam za dużo. Możesz tylko dopilnować, aby powiększony fragment obrazu był równy (by linie podziału siatki się nie wyginały) i możliwe jednorodny (Rysunek 7.3.4a). (W następnej sekcji okaże się, że na tym rozwinięciu są kłopoty z odwzorowaniem połączenia trzech paneli — p. str. 398):
Rysunek 7.3.4 Szczegóły rozwinięcia owiewki podwozia.
Rozwiń także ruchome części owiewki, ich osie, oraz powierzchnie wewnętrzne (Rysunek 7.3.4c). Powierzchnie wewnętrzne można by było przygotować nieco później, ale zawsze lepiej jest rozwinąć od razu całą siatkę. (Inaczej może Cię zaskoczyć jakąś zapomnianą krawędzią bez szwu, psującą całe rozwinięcie).
Rozwinięcie oprofilowania pomiędzy skrzydłem i kadłubem rozpocznij od projekcji (Project From View) i przypięcia do rzutu z boku jego górnej krawędzi (Rysunek 7.3.5a) :
Rysunek 7.3.5 Szczegóły rozwinięcia owiewki płata.
Potem wywołaj polecenie Unwrap (E), aby cała reszta siatki wypełniła przygotowane w ten sposób obramowanie (Rysunek 7.3.5b).
P-40 miał, podobnie jak Spitfire, bardzo dużą owiewkę pomiędzy skrzydłem i kadłubem. Gdyby umieścić ją na rozwinięciu gdzieś z boku — czekałaby Cię podwójna robota uzgadniania różnych ciągłych elementów obrazu tekstury, np. granic plam kamuflażu. Taką owiewkę lepiej ustawić przy jednym z elementów, które łączy, aby do uzgadniania pozostała tylko jedna, „wolna”, krawędź. Do czego ją „przyłożyć”: skrzydła czy kadłuba? Proponuję dopasować to oprofilowanie do rozwinięcia kadłuba (Rysunek 7.3.6b), by mogły o nie swobodnie „zahaczyć” brzegi znaków rozpoznawczych lub numerów taktycznych. (W większości scen lepiej jest widoczny kadłub). Obraz na górnej powierzchni płata, wypadnie nam uzgadniać z obrazem na krawędzi owiewki.
Rysunek 7.3.6 Owiewka płata — część górna i przednia.
Przód owiewki pozostaw przyłączony do reszty powłoki (Rysunek 7.3.6a). W imię zachowania ciągłości tego elementu odsuniemy od kadłuba całe okapotowanie silnika, aby zrobić dla tego fragmentu miejsce. (Barwy na krawędziach okapotowania mogą być nieciągłe — każdy panel jest zamodelowany oddzielnie. Co innego na połączeniu oprofilowania płata i kadłuba!).
Jedynym elementem owiewki, który możemy oddzielić, jest spód jej tylnej części. Oznacz na niej szwem przedłużenie krawędzi spływu płata (Rysunek 7.3.7b):
Rysunek 7.3.7 Owiewka płata — część dolna.
Oddzielony w ten sposób fragment rozwiń przez proste rzutowanie (Project From View, z dołu) i ustaw przy krawędzi spływu dolnej powierzchni skrzydła.
Lotkę podziel szwem na powierzchnię górną i dolną. Po rozwinięciu umieść, nieco odsuniętą, w pobliżu miejsca gdzie jest zamocowana (Rysunek 7.3.8) :
Rysunek 7.3.8 Lotka — rozwinięcie górnej powierzchni.
Dolną powierzchnię lotki (wraz z krańcowymi żebrami) umieść w pobliżu wnęki na dolnej powierzchni płata (Rysunek 7.3.9) :
Rysunek 7.3.9 Lotka i klapa — ułożenie wzdłuż dolnej powierzchni płata.
Klapę także rozwiń poprzez projekcję z dołu, i po prostu umieść w otworze, jaki istniał w rozwinięciu (Rysunek 7.3.9). Nie ma sensu nawet „odwijać” jej brzegów — te same nity tekstury będą widoczne z obydwu stron, tak jak w oryginale.
Choć elementy kabiny pilota w P-40 nie są specjalnie skomplikowane, ich rozwinięcie w przestrzeni UV zajmie trochę czasu. Zacznij od rozwinięcia samych powierzchni szkła organicznego (Rysunek 7.3.10) :
Rysunek 7.3.10 Rozwinięcie przejrzystych powierzchni kabiny — przygotowanie do rozwinięcia ramek.
Co prawda do tych powierzchni jest przypisany inny materiał — B.Glass.Canopy (por. str. 1046). Jeżeli w tym materiale będziemy wykorzystywać tekstury, to będą to inne obrazy niż te z podstawowego materiału poszycia (B.Skin.Camouflage). Szklane powłoki kabiny mają zazwyczaj nieskomplikowane siatki. Stosunkowo łatwo je rozwinąć w UV. Ich kontury posłużą jako wzorzec podczas rozwijania bardziej złożonych siatek ramek. Umieść je na płaszczyźnie UV tam, gdzie chcesz później ulokować rozwinięcie ramki.
Od razu podczas rozwijania „szkła” napotkasz na problem: ich powłoki składają się w istocie z dwóch powierzchni: wewnętrznej i zewnętrznej — bo nadaliśmy mu grubość (por. np. str. 219, Rysunek 4.14.13b). Oznacz krawędzie powierzchni zewnętrznej jako szew. W związku z tym, że potrzebujemy tych rozwinięć tylko do celów „referencyjnych”, możesz „rozpłaszczyć” wyłącznie powierzchnie zewnętrzne. (Choć oczywiście, dobrze jest poprawnie rozwinąć także powierzchnie wewnętrzne — będą już gotowe na przyszłość).
Siatki ramek kabiny nie wydają się specjalnie trudne do rozwinięcia. Nic jednak bardziej mylnego! Duża liczba ścian schodzących się często po kątem ostrym, oraz grubość, nadana powłoce, bardzo utrudniają zastosowanie wszelkich „automatów” Blendera. Dlatego właśnie tak przydatny jest wzorzec, w postaci rozwiniętej powierzchni „szkła”. Pozwala podczas rozwijania ramek zorientować się w proporcjach poszczególnych ścian siatki.
Rysunek 7.3.11 przedstawia rozwinięcia ramek kabiny, po dopasowaniu do wzorcowych rozwinięć oszklenia:
Rysunek 7.3.11 Rozwinięcie ramek kabiny pilota.
Rozwinięcia należy zacząć od zaznaczenia szwu wzdłuż krawędzi powierzchni zewnętrznych i wewnętrznych. Potem rozwijasz kolejne fragment siatki, „przypinając” stopniowo kluczowe punkty do powierzchni obrazu i pozwalając dopasować się reszcie. Do rozwiniętych wycinków dołączasz następne — poleceniami Unwrap. W ten sposób stopniowo uzyskujesz właściwy kształt. Z czasem nabierzesz wprawy w tworzeniu założonego rozwinięcia za pomocą jak najmniejszej liczby „przypiętych” wierzchołków. W przypadku ramek wiatrochronu i owiewki zdecydowałem się pozostawić włączone modyfikatory symetrii (Mirror). Na takie „skróty” można pójść, gdy wiesz, że nawet na samolotach pomalowanych w plamy kamuflażu ta część miała jednolity kolor1. Rozwijanie połowy siatki jest prostsze niż uzgadnianie rozwinięcia całości — gdyż kierunek rozwinięcia ścian poleceniem Unwrap zależy od położenia w przestrzeni.
Na przykład — bardzo skomplikowany kształt przedniej ramy wiatrochronu zdecydowanie łatwiej było rozwijać po tej samej stronie samolotu, po której jest umieszczony „oryginał” (Rysunek 7.3.11, dolna połowa). Gdyby umieścić lustrzane odbicie tego rozwinięcia po stronie prawej (czyli w górnej połowie rozwinięcia, które pokazuje ilustracja), wszystkie ściany, które nie są „przypięte”, zawinęłyby się do wnętrza siatki. Fragment zamieniłby się w coś przypominającego spiralę DNA!
Gdy uzyskasz w wyniku polecenia Unwrap jakieś bezładne „kłębowisko” ścian, nie przejmuj się: to się zdarza. Należy wtedy nanieść na siatkę — tam, gdzie można — dodatkowe szwy. Potem zacznij rozwijać ją etapami, zaczynając od fragmentu, którego rozwinięcie nie przysparza Blenderowi problemów. Następnie starannie „przypnij” do obrazu wszystkie wierzchołki tego fragmentu, i pozwól się dopasować do nich następnym ścianom.
Ramkę oszklenia za nagłówkiem pilota umieściłem ponad powierzchnią, którą zasłania (Rysunek 7.3.11). Jest to projekcja (Project From View) z rzutu z boku, trochę „rozciągnięta”, by była dopasowana do rozwinięcia kadłuba. W odróżnieniu od wiatrochronu i owiewki, powierzchnie wewnętrzne i zewnętrzne są tu nałożone na siebie. (I tak wewnętrzne są praktycznie niewidoczne). Choć ilustracja tego (dla uproszczenia) nie pokazuje, to prawa ramka ma oddzielną siatkę, o identycznym kształcie rozwinięcia UV, po prawej strony kadłuba. Tu nie można było pozostawić symetrii — podział barw kamuflażu biegł poprzez ten element (a także poprzez powierzchnię kadłuba pod oszkleniem).
Czas zająć się kolejną częścią: sterem kierunku. To łatwe rozwinięcie. Najpierw nanieś szew na krawędź, leżącą na płaszczyźnie symetrii steru, oraz na granice materiałów (Rysunek 7.3.12a) :
Rysunek 7.3.12 Rozwinięcie steru kierunku.
Na razie zaznacz wyłącznie ściany należące do powierzchni zewnętrznych (materiału B.Skin.Camouflage). Pierwsze przybliżenie rozwinięcia uzyskasz poprzez projekcję (Project From View) steru z rzutu z boku (Rysunek 7.3.12b). Przypnij do obrazu jej kluczowe wierzchołki, by na pewno nie uległy deformacji podczas dalszej edycji. Potem pozwól się rozwinąć (Unwrap) ścianom na krawędzi natarcia i spodzie steru (Rysunek 7.3.12c).
Statecznik pionowy rozwinęliśmy (poprzez projekcję) już w poprzednim rozdziale. Teraz pozostaje nanieść na niego szwy (Rysunek 7.3.13a), oraz „odpiąć” od obrazu krawędź natarcia i pozwolić się jej rozwinąć (Rysunek 7.3.13b,c) :
Rysunek 7.3.13 Drobne poprawki rozwinięcia statecznika pionowego.
Na koniec utrwal modyfikator Mirror (Apply) dla statecznika i steru. Potem wykonaj w przestrzeni UV lustrzane odbicie ich rozwinięć (Rysunek 7.3.14a)
Rysunek 7.3.14 Pełne rozwinięcie statecznika pionowego (i steru kierunku).
Powierzchnie wewnętrzne, jak tylna ściana statecznika czy wycięcia w sterze warto jest rozwinąć już po „utrwaleniu” prawych stron. Rozwiną się wówczas od razu prosto i symetrycznie (Rysunek 7.3.14b).
Identyczną metodą rozwiń siatki statecznika poziomego i steru wysokości (Rysunek 7.3.15) :
Rysunek 7.3.15 Pełne rozwinięcie statecznika poziomego (i steru wysokości).
Powierzchnie wewnętrzne są na modelu o wiele mniej widoczne, i można je potraktować w sposób uproszczony. Dlatego rozwijamy tylko symetryczną połowę wnętrza kadłuba (Rysunek 7.3.16) :
Rysunek 7.3.16 Rozwinięcie wewnętrznych powierzchni kadłuba.
Wręg i podłużnic nie rozsuwaj — pozostaw je „w wiązkach”, tak jak wyszły z rzutowania z przodu i z góry.
Rozwiń także tylko jedną wnękę klapy skrzydłowej (druga pozostanie jej lustrzanym odbiciem) (Rysunek 7.3.17):
Rysunek 7.3.17 Rozwinięcie wnętrza komory klapy.
Zwróć uwagę na rozwinięcie żeber — mimo różnic rozmiarów ułożyłem dokładnie jedno na drugim (Rysunek 7.3.17b). To ułatwi zamalowywanie (choć wszystkie żebra będą miały jednakowe plamy) oraz nanoszenie tekstury otworu. W bardzo podobny sposób rozwiń górną powierzchnię klapy (Rysunek 7.3.18) :
Rysunek 7.3.18 Rozwinięcie wewnętrznej strony klapy skrzydłowej.
Wnękę komory podwozia także pozostaw symetryczną — rozwiń jedną siatkę, wspólną dla obydwu instancji (Rysunek 7.3.19) :
Rysunek 7.3.19 Rozwinięcie komory podwozia.
Zwróć uwagę, że wszystkie podłużnice powierzchni płata także używają tej samej, pojedynczej siatki.
Ostatnim zespołem, który pozostał do rozwinięcia, jest wnętrze chłodnicy cieczy (Rysunek 7.3.20) :
Rysunek 7.3.20 Rozwinięcie wnętrza zespołu chłodnic.
Wszystkie trzy chłodnice są zamodelowane przez tę samą siatkę (różnią się tylko skalami). W istocie, nie jest to nawet cały walec, a tylko jego „ćwiartka” (Rysunek 7.3.20b). Reszta elementów zespołu jest także reprezentowana symetrycznie. Na rozwinięciu jest tylko jeden boczny (lewy) tunel chłodnicy glikolu. Jego lustrzane odbicie jest po prawej stronie samolotu. Z centralnego tunelu — do chłodnicy oleju — na rozwinięciu umieściłem tylko połowę.
Rysunek 7.3.21 przedstawia rozwinięcie wszystkich powierzchni:
Rysunek 7.3.21 Zestawienie wszystkich siatek, zgromadzonych na wspólnej powierzchni UV.
Jak widać, na jednym obszarze „upchaliśmy” zarówno powierzchnie zewnętrzne (przypisane do materiału B.Skin.Camouflage), jak i wewnętrzne (B.Skin.Inner). Ten sam obraz będzie wykorzystywany przez obydwa materiały. To ułatwi jego rysowanie — mamy wszystko w jednym miejscu. Prawe skrzydło ma od tej pory swoją oddzielną siatkę (to kopia siatki lewego skrzydła). Jej rozwinięcie w UV to „lustrzane odbicie” rozwinięcia oryginalnej siatki. Przy okazji w 3D View zmieniłem skalę prawego płata (wzdłuż lokalnej osi X) na dodatnią, bo inaczej sprawiłoby nam kłopoty w następnym rozdziale.
Unikaj ujemnej skali obiektów, przynajmniej takich głównych zespołów jak skrzydła czy statecznik. W przypadku prawego skrzydła po zmianie skali obiektu na dodatnią musisz ją skompensować przeskalowując jego siatkę (B.100.R.Wing) o współczynnik -1 wzdłuż lokalnej osi X i środka obiektu skrzydła.
Zwróć uwagę, że na obrazie UV pozostało jest jeszcze trochę wolnej przestrzeni. Zawsze warto pozostawić jej zapas na wszelkie nieprzewidziane potrzeby. Na pewno, przy okazji formowania podwozia, dodamy tu kołpaki kół. Jednak w zasadzie, na wszystkich drobnych elementach (golenie podwozia, popychacze, pomalowane rurki i kable) wykorzystamy inne, uproszczone materiały. Jeżeli pojawią się na nich tekstury, to co najwyżej jakieś proceduralne „chmury” zabrudzeń — byle tylko nie rozwijać tych drobiazgów w UV i uniknąć ręcznego malowania.
Wreszcie mamy już rozwinięte w UV wszystkie zewnętrzne powierzchnie samolotu (Rysunek 7.3.22):
Rysunek 7.3.22 Wszystkie powierzchnie zewnętrzne modelu zmapowane w UV.
Przez ten obraz testowy model na tym etapie prac zawsze kojarzy mi się z arlekinem, nieprawdaż?
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-7.03.blend (por. str. 22).
Stożek kołpaka śmigła jest powierzchnią trudną do rozwinięcia. Aby nie pozostawić na nim szwu, zdecydowałem się „spłaszczyć” go w koło. Obraz na tej siatce jest co prawda zdeformowany, ale przynajmniej zdeformowany jednolicie. Umożliwia to narysowanie odpowiednio przeskalowanych nitów (str. 382);
W rozwinięciu owiewki gondoli podwozia wystąpiła deformacja na nosie powłoki. Chciałem to skompensować podobnie jak w przypadku kołpaka śmigła, przez odpowiednią zmianą skali nitów (str. 383). W następnej sekcji okaże się jednak, że w takich miejscach nie można ich umieszczać (str. 398);
Rozwinięcie oprofilowania krawędzi skrzydła i kadłuba najlepiej jest zacząć od projekcji z boku, na kadłub samolotu. Potem należy „przypiąć” do obrazu wierzchołki zewnętrznego obramowania, i pozwolić się rozwinąć (Unwrap) reszcie siatki (str. 384);
Rozwinięcie ramek owiewki kabiny pilota jest dość pracochłonne. Aby ułatwić sobie tę pracę, możesz rozwinąć wcześniej powierzchnie „szklane” (str. 385). Innym uproszczeniem jest możliwość rozwinięcia tylko jednej, symetryczną części (str. 386);
Stery i stateczniki formujemy na bazie projekcji z góry (usterzenie poziome) lub z boku (pionowe);
W rozwinięciu wewnętrznych powierzchni samolotu można dokonać wielu uproszczeń, np. rozwinięcia tylko połowy siatki. Te fragmenty modelu są tak nieznacznie wyeksponowane, że nikt nie zauważy symetrii (str. 388... 390;
Po rozwinięciu w UV wszystkich siatek czas przygotować obraz, który będzie podstawą dla wszystkich tekstur: rysunek powierzchni samolotu. Zrobimy to na odpowiednich warstwach pliku skin.svg (por. str. 346 i następne). Początek zresztą już mamy — to linie statecznika pionowego i owiewki usterzenia, przygotowane przy okazji „prac doświadczalnych” w poprzednich sekcjach (por. str. 318, 321, 343). Zaczniemy od powierzchni kadłuba. Wyeksportuj z Blendera do plików *.svg: rozwinięcia siatek kadłuba, statecznika pionowego, owiewek skrzydła i usterzenia, oraz tylnych ramek kabiny. Wczytaj te pliki do pomocniczego pliku uv.svg, z którego stwórz pomocniczy obraz rozwinięć uv.png (por. str. 345 i str. 1130). Korzystając z tego „podkładu”, oraz z sylwetki samolotu, narysuj na rozwinięciu lewej strony podstawowe linie paneli kadłuba (na warstwie Lines — Rysunek 7.4.1):
Rysunek 7.4.1 Początek obrazu — naniesienie podstawowych linii paneli kadłuba.
Przy okazji rysowania okazało się, że przydałaby się nowa warstwa na wszelkiego rodzaju pokrywy — klap i otwory inspekcyjne. Najszybciej je narysować na poziomie powyżej nitów (por. str. 346), bo wtedy nie trzeba dzielić ich linii. Warstwa, którą wykorzystywaliśmy do tej pory na takie rzeczy — Overlay — leży poniżej. Dodałem więc pomiędzy poziomem nitów (Rivets) i śrub (Screws) nową warstwę Cover, na której umieściłem pierwszą z pokryw — luk bagażnika (Rysunek 7.4.1) .
Narysowany fragment warto zaraz wyeksportować do pliku nor_details.png, i podstawić w Blenderze pod obraz Test (Image→Replace), by w trybie Textured „przymierzyć” go do modelu (Rysunek 7.4.2):
Rysunek 7.4.2 Sprawdzanie poprawności narysowanych linii (Blender, 3DView, tryb textured).
Nadaj plikowi nor_details.png rozdzielczość 4096x4096 pikseli, by odwzorował nawet drobne szczegóły.
Podczas „przymiarki” należy sprawdzić, czy wszystkie linie, które powinny być poziome i pionowe, są takimi na modelu. Potem warto się przyjrzeć konturom, narysowanym wzdłuż krawędzi powłok „nałożonych” na kadłub: ramki kabiny, oprofilowania skrzydła, oprofilowania usterzenia (por. Rysunek 7.4.1). Czasami niesforna linia może „zanurkować” pod siatkę (np. tak, jak to pokazuje Rysunek 7.4.2b). Trzeba wtedy poprawić jej kształt w Inkscape i powtórnie sprawdzić w Blenderze. Zazwyczaj wymaga to kilku takich „iteracji”. Aby jak najszybciej „trafić” z obrysem we właściwe miejsce, warto możliwie dokładnie zidentyfikować na rysunku Inkscape obszar, który należy zmienić. Pomocą w tym może być przestudiowanie położenia granic błędnej krawędzi względem poszczególnych „oczek” siatki. (Zobaczysz je, gdy przełączysz się w Blenderze w tryb edycji — Rysunek 7.4.2c).
Jeżeli spieszy Ci się, możesz poprzestać na narysowaniu prostej tekstury nierówności, złożonej z samych linii podziału blach. Reszta tej sekcji jest poświęcona nanoszeniu nitów, śrub, i innych szczegółów, które służą tylko pogłębieniu realizmu modelu.
Teraz zacznij nanosić na obraz w Inkscape pozostałe „konstrukcyjne” nierówności: śruby, nity. Nie zapomnij także o „podłożeniu” jasnych obszarów pod oprofilowanie połączenia skrzydła z kadłubem (na warstwie Overlay). W trakcie tej pracy stwierdzisz, że pomysł z nałożeniem ramek oszklenia na kadłub nie jest najlepszy (Rysunek 7.4.3) :
Rysunek 7.4.3 Nanoszenie śrub i nitów na rozwinięcie kadłuba.
Problemem stało się tu dokładnie to, co w przypadku tekstury kolorów ma być zaletą: gdy coś rysujesz na ramce, rysujesz jednocześnie po kadłubie. Właśnie o taki efekt chodziło w przypadku nanoszenia kamuflażu — aby nie trzeba było uzgadniać pomiędzy siatkami granic plam, namalowanych na powierzchni samolotu. Tyle, że teraz linie nitów, które biegły pod oszkleniem kadłuba, wychodzą także na ramce kabiny, a nierówności ramki — np. pionowy pasek — „odciśnie” się również na kadłubie!
Ramka oszklenia nie jest zresztą jedynym kłopotliwym obszarem. Jeszcze tego nie widać, ale będzie problem także z oprofilowaniem płata. Jest to na tyle duży element, że został złożony z kilku fragmentów blachy. Panele te łączą się na nim tak jak na innych powierzchniach samolotu — „na zakładkę”. Tyle, że są inaczej podzielone niż krawędzie paneli kadłuba, do którego przylegają. Czy trzeba będzie w tym miejscu męczyć się z dokładnym dopasowywaniem granic wypełnionych gradientem obszarów?
Najlepiej byłoby, gdyby można było użyć do nałożenia obrazu barwy układu UV z nałożonymi na siebie rozwinięciami, a na dla obrazu nierówności i odbić — innego, z rozwinięciami odseparowanymi. Czy jest to w Blenderze możliwe?
Na szczęście w Blenderze siatka może mieć kilka alternatywnych rozwinięć UV. Każde z nich jest nazywane „mapą UV” (UV Map). Do zarządzania nimi służą kontrolki w panelu UV Maps, zestawu Object Data. Zajrzyj na str. 949, aby dowiedzieć się, jak stworzyć alternatywne rozwinięcie UV, oraz poznać kluczowe pojęcia („mapa domyślna”, „mapa aktywna”). Do powiązania tekstury materiału z wybranym mapowaniem UV służy w Cycles węzeł Attribute (więcej na ten temat — str. 1066). Jest tam identyfikowane po nazwie. Stąd bardzo ważne, by odpowiadające sobie alternatywne rozwinięcia UV były w każdej siatce tak samo nazwane.
Proponuję, aby w naszym modelu domyślna (podstawowa) mapa UV miała w każdej siatce nazwę UVTex. (Cycles będzie jej używał wtedy, gdy materiał nie odwołuje się do żadnej konkretnej nazwy mapy UV, lub gdy siatka nie posiada żądanego przez materiał rozwinięcia). W siatkach ramki oszklenia i oprofilowania skrzydła utwórz kopię (str. str. 949) obecnego rozwinięcia UV, i nazwij je Color. To będzie rozwinięcie dla obrazów barwnych, zawierające nałożone na siebie rozwinięcia kadłuba i owiewki płata (takie, jakie pokazuje Rysunek 7.4.3). Potem zmień mapę UVTex, umieszczając rozwinięcia oprofilowania skrzydła i ramek oszklenia gdzieś poza kadłubem (Rysunek 7.4.4):
Rysunek 7.4.4 Alternatywne rozwinięcie UV oprofilowania skrzydła i ramek oszklenia na warstwie UVTex.
Oczywiście, trzeba było trochę poprzesuwać kilka innych siatek, by „zrobić” miejsce dla rozwinięć zdjętych z kadłuba (porównaj Rysunek 7.4.4 i Rysunek 7.3.21 ze str. 390). Przygotuj się także na to, że za jakiś czas dodamy do niektórych obiektów trzecie mapowanie UV: Decals. Będzie przeznaczona dla nałożenia oddzielnej tekstury ze znakami rozpoznawczymi, numerami seryjnymi i — rzecz jasna — szczęką rekina, namalowaną na masce silnika. Przy obecnym „rozparcelowaniu” okapotowania, malowanie obrazu tego szczegółu wymagałoby wielu uzgodnień wzdłuż krawędzi paneli. Aby oszczędzać nerwy i czas, lepiej jest skopiować rozwinięcie Color w Decals, a potem podzielić na niej rozwinięcie osłony chłodnicy wzdłuż osi symetrii kadłuba. Pozostałe fragmenty okapotowania poprzysuwać do siebie, i namalować na nich szczęki tak, jak były malowane w naturze — „w jednym kawałku” (por. str. 441).
Nanieś w Inkscape na rozwinięcie kadłuba (Rysunek 7.4.4) linie podziału (warstwa Lines), śruby (Screws), ich zagłębienia (Bumps), pierwszoplanowe „pokrywy” (Cover), nity (Rivets), drugoplanowe „pokrywy” (Overlay). Narysuj najpierw te szczegóły na lewej połówce kadłuba, sprawdź „jak leżą” w Blenderze (tryb textured), i w razie czego popraw, by leżały lepiej (Rysunek 7.4.5) :
Rysunek 7.4.5 Sprawdzanie poprawności nałożenia rysunku na kadłub — strona lewa.
Przy okazji prac nad lewą stroną, okazało się że kolejność warstw zaproponowana w poprzednich sekcjach (str. 346) wymaga poprawki. Trzeba było przenieść warstwę Bumps, oryginalnie umieszczoną dość „głęboko”, tuż po warstwę Screws. Inaczej nie widać by było zagłębienia pod śrubami na różnych zasłonach wzierników.
Potem skopiuj obraz tych wszystkich szczegółów na drugą połowę kadłuba i także ją sprawdź (Rysunek 7.4.6):
Rysunek 7.4.6 Sprawdzanie poprawności nałożenia rysunku — strona prawa.
Szczególnie uważnie przyjrzyj się tym wszystkim miejscom, gdzie biegną szwy podziału rozwinięcia UV. Tam najczęściej gromadzą się problemy! Niektóre z występujących tam deformacji obrazu na można skorygować poprzez wyostrzenie krawędzi poprzecznej (Rysunek 7.4.7) :
Rysunek 7.4.7 Korekta deformacji obrazu w okolicach szwu (spód kadłuba, przy kółku ogonowym).
(W podobny sposób radziliśmy sobie z nim wcześniej — por str. 375, Rysunek 7.2.12).
Tak jak tył kadłuba, przygotuj obraz maski silnika: z lewej (Rysunek 7.4.8a) i z prawej (Rysunek 7.4.8b) :
Rysunek 7.4.8 Nałożenie rysunku na okapotowanie silnika.
Czasami dopiero na tym etapie można się przekonać o niedoskonałości siatki. Rysunek 7.4.9a) pokazuje przykład deformacji obrazu, jaka wystąpiła na ścianach sąsiadujących z krawędzią szwu:
Rysunek 7.4.9 Skaza rozwinięcia w pobliżu szwu.
Ten błąd poprawiłem tak jak poprzednio — zwiększając ostrość (Crearse) dwóch krawędzi poprzecznych (Rysunek 7.4.9b). W tym miejscu trzeba było wstawić w siatkę dodatkową krawędź, by zachować zaokrąglony nosek chwytu powietrza.
Rozwinięcie kołpaka, mimo 2.5-krotnego powiększenia, nie wyglądało jednak najlepiej na modelu (por. str. 382, Rysunek 7.3.1). Pomogło dopiero zmniejszenie („zsunięcie”) ścian czubka tego elementu (Rysunek 7.4.10) :
Rysunek 7.4.10 Szczegóły rozwinięcia kołpaka śmigła.
Wszystkie wręgi kołpaka, poza ostatnią, „ścisnąłem” o 40-50%. Zwiększyłem w ten sposób niemal dwukrotnie obszar, na którym znajdują się ważne fragmenty obrazu — nity, otwory na łopaty śmigieł, i krawędzie blach za nimi (Rysunek 7.4.10b). Zminimalizowało to także poprzeczną deformację kształtów — okrąg na modelu to w tym obszarze w Inkscape nieznacznie spłaszczona elipsa (Rysunek 7.4.10c). W efekcie jakość obrazu na kołpaku bardzo się poprawiła, i stała się porównywalna z resztą rozwinięcia (Rysunek 7.4.10a). Obsłużenie „efektów ubocznych” takiej poprawki wymagało jednak pewnej pracy. Najpierw — trudno było trafić rysunkiem otworu (Rysunek 7.4.10c) w podstawę łopaty śmigła. Potem trzeba było w Inkscape trochę rozchylić linie krawędzi blachy za łopatą, aby na modelu stały się równoległe. Wreszcie — trzeba było zróżnicować średnice nitów w zależności od odległości od środka kołpaka (Rysunek 7.4.10b). Rezultat — ładne rozwinięcie, bez żadnego szwu — był jednak wart tego wysiłku.
Szczegóły powierzchni płata rysuje się tak samo, jak szczegóły kadłuba, a nawet prościej — skrzydło ma powierzchnię rozwijalną (Rysunek 7.4.11) :
Rysunek 7.4.11 Rysunek szczegółów górnej powierzchni płata.
Przy okazji pracy nad płatem zdecydowałem się narysować także szczegóły osłony podwozia. Tu czekało mnie niemiłe zaskoczenie: linie podziału blach na „nosie” tego elementu wyszły bardzo źle (Rysunek 7.4.12) :
Rysunek 7.4.12 Problem z deformacją obrazu podziału poszycia (osłona podwozia).
Na gondoli podwozia P-40 widać, w rzucie z przodu, dwie linie podziału: wygiętą od strony zewnętrznej i pionową od strony kadłuba. Najgorzej wyszła linia zewnętrzna (Rysunek 7.4.12a). Linia wewnętrzna wyglądała nieco lepiej, ale była za szeroka (Rysunek 7.4.12b). W dodatku gdyby przesunąć ją nieco bardziej w bok, na właściwe miejsce, dostałaby się w obszar silnych deformacji obrazu (Rysunek 7.4.12c).
Wygląda na to, że oryginalny pomysł (por. str. 383, Rysunek 7.3.4) na rozwinięcie tej powierzchni nie zdał egzaminu. (Wszystko byłoby w porządku, gdyby nie istnienie tych dwóch linii podziału, biegnących przez bardzo zdeformowane obszary tekstury).
Aby poprawnie nanieść obraz na nos owiewki podwozia, najlepiej byłoby ją inaczej rozwinąć w UV. Linia szwu powinna przebiegać wzdłuż linii podziałów. Na razie na siatce nie ma żadnej krawędzi, która by biegła choć w zbliżony w sposób. Trzeba powrócić do modelowania: ponacinać niektóre ściany, pousuwać niektóre krawędzie, aby ostatecznie dwie z nich biegły prawie tak, jak oryginalne linie paneli poszycia (Rysunek 7.4.13) :
Rysunek 7.4.13 Krawędzie podziału, nacięte na siatce owiewki | Rysunek 7.4.14 Powiększona pokrywa wspornika goleni |
Nieuniknionym efektem takiego nacinania jest pojawienie się ścian trójkątnych i wielokątnych (w każdym razie o liczbie boków innej niż 4). Wewnątrz takich ścian wygładzenie modyfikatorem Subsurf tworzy drobne, ale denerwujące wypukłości. Staraj się je eliminować, dopóki jest to możliwe. Na koniec pozostaniesz z kilkoma „niedobitkami” — te postaraj się zmniejszyć i ulokować w jakimś „gęstszym” fragmencie siatki, lub tam, gdzie powierzchnia jest wklęsła — przy skrzydle. Nie będę udawał, że jest to proste — zeszło mi na tym parę ładnych godzin. Ostatecznie jednak udało się uzyskać powłokę z odpowiednimi krawędziami i minimalnymi defektami kształtu (Rysunek 7.4.14). Swoją drogą - to nauczka na przyszłość:
Zawsze warto modelować siatkę tak, by niektóre z jej krawędzi odpowiadały liniom podziału poszycia na prawdziwym samolocie.
Pewną pociechą w tej pracy było odkrycie, że ostatnio jakaś dobra dusza umieściła na http://p40warhawk.com kolejne rysunki konstrukcyjne, w tym — dwa arkusze dotyczące owiewki podwozia. Gdy je przymierzyłem do planów, okazało się, że boczna pokrywa (pokazuje ją Rysunek 7.4.14) była niemal o 50% większa niż ta rysowana przez Jacka Jackiewicza i Mariusza Łukasika! Mówiąc szczerze, ja już zrobiłem ją nieco większą — bo inaczej podwozie nie mogłoby się złożyć. Starałem się jednak nie odbiegać zanadto od planów, więc ta pokrywa nadal była mniejsza od oryginału. Teraz trzeba powiększyć otwór w owiewce o jakieś 30%. To też była poważna przeróbka.
Po tym wszystkim, mogłem ostatecznie rozwinąć owiewkę w UV, dzieląc ją na trzy części, wzdłuż krawędzi podziału blach (Rysunek 7.4.15):
Rysunek 7.4.15 Rozwinięcie siatki owiewki podwozia
Rysunek 7.4.16 pokazuje uzyskany rezultat:
Rysunek 7.4.16 Poprawiony obraz linii podziału blach na owiewce podwozia
Zewnętrzna linia podziału uzyskała znośną grubość i już nie straszy kształtem (Rysunek 7.4.14a). Linia wewnętrzna także stała się cieńsza (Rysunek 7.4.14b). Można ją było umieścić we właściwym miejscu — na przedłużeniu krawędzi pokrywy goleni podwozia.
Po tych poprawkach można było już swobodniej zająć ostatnim fragmentem samolotu: usterzeniem. Tak, jak to opisałem poprzednio, odwzorowałem poszycie metalowych stateczników (Rysunek 7.4.17). W nieco inny sposób narysowałem szczegóły sterów, które były pokryte płótnem (Rysunek 7.4.18) :
Rysunek 7.4.17 Obraz szczegółów usterzenia | Rysunek 7.4.18 Odwzorowanie pokrycia płótnem |
Aby w ogóle widać było wypukłości na płóciennym poszyciu, zmieniłem kolor tła obrazu na 50% szarości. Wypukłości na żebrach steru i lotki uzyskałem za pomocą specjalnego gradientu, naniesionego na nową warstwę Fabric. (Szczegółowy opis, jak uzyskać obraz nierówności dla powierzchni krytych płótnem — zob. str. 738).
Zaszewki na żebrach, które pokazuje Rysunek 7.4.18, dobrze imitują napięte płótno na samolocie stojącym na ziemi. Ten rodzaj poszycia podczas lotu ulega różnym deformacjom. Różnica ciśnień strumienia powietrza potrafi „wtłoczyć” płótno do środka szkieletu, albo (rzadziej) — uwypuklić. Załóżmy typową sytuację, gdy poszycie pomiędzy żebrami będzie podczas lotu zagłębione. Aby to odwzorować, przygotowałem w skin.svg jeszcze jedną warstwę: Fabric Bumps. Narysowałem na niej odpowiednie czarne „cienie” pomiędzy żebrami sterów i lotek (Rysunek 7.4.19).
Zbliżamy się już do końca tworzenia obrazu podstawowych nierówności. Pozostało jeszcze tylko nanieść gradienty wzdłuż krawędzi paneli (por. str. 729). Najlepiej przy okazji zacząć sprawdzać, jak wychodzą te nierówności na renderze. Wyeksportuj więc do pliku nor_details.png odpowiednią kompozycję (por. str. 346). W stosunku do tej, opisanej wcześniej, metody, przybyło nam kilka dodatkowych warstw. Wyliczę więc wszystkie jeszcze raz (Rysunek 7.4.20):
Rysunek 7.4.20 Warstwy, użyte do skomponowania podstawowej mapy nierówności (nor_details.png)
W stosunku do schematu ze na str. 350, w skin.svg pojawiły się cztery nowe warstwy:
Fabric: „statyczne” szczegóły powierzchni krytych płótnem (stery, lotki) ;
Fabric Bumps: „dynamiczne” wgłębienia na powierzchniach krytych płótnem;
Holes: otwory (będą także wykorzystane w oddzielnej teksturze przejrzystości);
Z innych zmian — warstwa Bumps została przesunięta do góry (aby wgniecenia pod śrubami były także widoczne na pokrywach z warstwy Cover).
Dodaj teksturę nor_details.png do schematu materiału B.Skin.Camouflage (por. str. 348 — z tym że radzę stosować wyższe wartości Moderate:Range: rzędu 0.8 lub nawet 1.0). Potem włącz w Blenderze podgląd renderu, i obejrzyj ze wszystkich stron rezultaty dotychczasowej pracy (Rysunek 7.4.21) :
Rysunek 7.4.21 Weryfikacja gradientów, naniesionych wzdłuż krawędzi paneli (na podglądzie renderingu)
Rysunek 7.4.21a) przedstawia obraz nierówności, nałożony (w trybie Textured) na powierzchnię samolotu. Tak go sprawdzaliśmy do tej pory. Rysunek 7.4.21b) przedstawia ten sam fragment w trybie Rendered. Używając tych dwóch trybów szybko dostrzeżesz wszystkie błędy!
Prace nad obrazem nierówności zbliżają się szczęśliwie do końca. Pozostało jeszcze dorysować elementy przeznaczone dla pozostałych tekstur: zawartość warstw Contours i Shadows (Rysunek 7.4.22) :
Rysunek 7.4.22 Dodatkowe akcenty, używane w pozostałych teksturach: cienie pod nitami i wzdłuż konturów
W odróżnieniu od przepisuj ze str. 347, na warstwie Shadows narysowałem linie nie w kolorze szarym, ale czarnym. Tyle, że mają nieprzejrzystość na poziomie 10%. W ten sposób efektywny kolor na białym tle wyjdzie taki sam. Krawędzie każdej siatki, które na modelu są zakończone „na grubość blachy” (np. panele okapotowania silnika) są obrysowane na warstwie Contours grubą, ciemną linią. Zawartość obydwu warstw będzie wykorzystana podczas tworzenia drugorzędnej tekstury nierówności (nor_blur.png) i tekstury odbić (ref.png).
Rysunek 7.4.23 pokazuje zawartość pliku skin.svg, która została wykonana w tej sekcji:
Rysunek 7.4.23 Zawartość pliku skin.svg
Trzeba przyznać, że wysiłek, włożony w te wszystkie cienie i nity jest porównywalny z wykonaniem kilku arkuszy planów modelarskich! Gdybyś chciał coś z tego pominąć , by przyspieszyć pracę — zrezygnuj z nitów (warstwa Rivets) i ich cieni (Shadows). To najbardziej pracochłonne fragmenty rysunku, a ich efekty są widoczne na renderingu tylko z niewielkich odległości. Zobacz chociażby taki dość surowy przykład (Rysunek 7.4.24):
Rysunek 7.4.24 Rezultat zastosowania podstawowej tekstury nierówności (nor_details.png)
O ile linie podziałów paneli i punkty śrub w znaczący sposób dodają realizmu modelowi przedstawionemu na tej ilustracji, o tyle wszelkie nity są na nim niemal niewidoczne!
Rysunek 7.4.25 przedstawia schemat podłączenia podstawowej tekstury nierówności (taki sam, jak na str. 348):
Rysunek 7.4.25 B.Skin.Camouflage: podłączenie podstawowej tekstury nierówności (nor_details.png)
Warto sprawdzić, jak szczegóły rysunku „leżą” na powierzchni matowej. Może coś trzeba podkreślić lub osłabić? Przetestowałem to na typowej, półmatowej farbie w kolorze oliwkowozielonym (Rysunek 7.4.26):
Rysunek 7.4.26 Sprawdzanie tekstury nierówności na półmatowej powierzchni kamuflażu
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-7.04.blend, a pliki z teksturami — w folderze model\p40\textures\7.04\* (por. str. 22).
Podsumowanie
Rysowanie szczegółów powierzchni samolotu zaczyna się od przeniesienia z Blendera do Inkscape rozwinięć w UV siatek wszystkich elementów (str. 393);
Typowa taktyka pracy nad obrazem powierzchni polega na wykonywaniu kolejnych „przymiarek” do modelu. Masz jednocześnie otwarte: Blender i Inkscape. Po narysowaniu kolejnego fragmentu rysunku w Inkscape, eksportujesz całość do pliku rastrowego. W Blenderze obraz, związany z tym plikiem, jest nałożony (w trybie Textured) na model. Wystarczy go odświeżyć (Image→Reload) i sprawdzić, czy nowy fragment jest dobrze dopasowany. Potem pozostaje nanieść w Inkscape poprawki (str. 393);
Jeżeli chcesz uprościć obraz szczegółów technicznych powierzchni modelu — zrezygnuj w pierwszej kolejności z nitów (warstwa Rivets) i ich cieni (warstwa Shadows) (por. str. 403);
W Blenderze ta sama siatka może mieć kilka alternatywnych rozwinięć w przestrzeni UV (UV Maps). Ta właściwość przydaje się czasami, gdy inne wymagania rozwinięciu UV stawia tekstura barwy, a inne — tekstura nierówności czy odbić (str. 395);
Deformacje rozwinięcia w UV siatek wzdłuż szwów można poprawiać poprzez wyostrzenie krawędzi poprzecznej (str. 396, 397);
„Bezszwowe” rozwinięcie stożka kołpaka śmigła w koło okazało się całkiem dobrym rozwiązaniem, wymagającym drobnej korekty. Rozwinięcia UV ścian czubka stożka musiały być pomniejszone, by poprawić poprzeczne proporcje obrazu w okolicach łopat śmigła (por. str. 382 i str. 398);
„Bezszwowe” rozwinięcie gondoli podwozia (por. str. 383) okazało się niewypałem — linie podziału blach w najbardziej zdeformowanej części — nosie gondoli — nie wyglądały dobrze. Należało przemodelować całą siatkę, by nanieść na nią krawędzie, biegnące wzdłuż linii podziału blach. Następnie trzeba było poprowadzić szwy wzdłuż tych krawędzi, i poprawić rozwinięcia UV (str. 398 — 400);
Do sprawdzania poprawności układu podziału blach warto jest utworzyć odpowiednią teksturę nierówności, i przeglądać ją szczegółowo w trakcie rysowania (podglądem renderu — str. 401);
Rezultatem poprzedniej sekcji jest plik skin.svg, wypełniony do końca detalami powierzchni samolotu. Niejako przy okazji testowania wygenerowaliśmy podstawową teksturę nierówności — plik nor_details.png(str. 346, 402). W tej sekcji:
wprowadzimy usprawnienia, ułatwiające późniejsze modyfikacje źródłowych rysunków (skin.svg);
stworzymy obraz pomocniczej tekstury nierówności (nor_blur.png);
Zajrzyj do sekcji 6.4 (str. 346 - 351), aby przypomnieć sobie, jak składaliśmy te obrazy z poszczególnych warstw rysunku Inkscape. Nadal można byłoby to robić w ten sposób — włączając widoczność odpowiednich warstw i zmieniając dodatkowo w niektórych ustawienia przejrzystości. Ale ile wtedy trzeba pamiętać, co i jak ustawić! Na przykład — w każdym eksportowanym z Inkscape obrazów nity z warstwy Rivets muszą mieć inną przejrzystość. Warto zdać sobie sprawę, że jest to uciążliwe, szczególnie gdy będziesz często nanosił w pliku skin.svg jakieś poprawki. Na szczęście w Inkscape można tak przygotować ten rysunek, aby nie trzeba było wykonywać co chwila takich pracochłonnych kroków. W tej sekcji pokażę, jak to się robi.
Zacznijmy od uporządkowania zawartości pliku z obrazem tekstur. Zaznacz i połącz (Ctrl-G) wszystkie obiekty, należące do tej samej warstwy, w jedną grupę (Rysunek 7.5.1):
Rysunek 7.5.1 Łączenie zawartości warstwy w jedną grupę (na przykładzie warstwy Shadows)
Tę operację wykonaj dla wszystkich „górnych” grup, które zawierają jakieś elementy rysunku (od Lines do Shadows). Od razu zmień także nic nie mówiącą, domyślną nazwę tych grup na taką samą, jak nazwa warstwy (Rysunek 7.5.2). O ile to możliwe (np. nie uda się dla niektórych elementów warstwy Cover), zmień ustawienia wypełniania i rysowania obiektów na „dziedziczenie” z ustawień grupy (Rysunek 7.5.3):
Rysunek 7.5.2 Ustalenie identyfikatora (Id) i nazwy (Label) grupy | Rysunek 7.5.3 Włączenie dziedziczenia ustawień wypełnienia i linii (we wszystkich elementach grupy) |
Teraz dodaj do skin.svg kilka nowych warstw, z których każda będzie zawierać gotowy obraz tekstury. Takie zbiorcze warstwy będę nazywał Result:<Nazwa obrazu>. Dodaj pierwszą z nich: Result:Nor-Details. Stwórz klon (Ctrl-D) grupy zajmującej każdą z warstw wyliczonych w poprzedniej sekcji (Panel H, Panel V, Fabric, Overlay, Rivets, Cover, Bumps, Screws, Holes — por. str. 401). Przenieś każdy z tych klonów na warstwę Result:Nor-Details (np. naciskając kilka razy Shift-PgDn — por. str. 721). Przypisz poszczególnym klonom taką nieprzejrzystość, jaką podaje Rysunek 7.5.5. (Użyj do tego kontrolki O pacity obiektu, nie warstwy — zob. str. 696):
Rysunek 7.5.4 Obraz podstawowej mapy nierówności, gotowy do eksportu do pliku nor_details.png
Result:Nor-Details zawiera kompletny, gotowy do eksportu do pliku rastrowego obraz szczegółowej mapy nierówności (nor_details.png — 4096x4096px). Zwróć uwagę, że nie użyłem w nim zawartości warstwy Fabric Bump. Wykorzystamy ją za to w pomocniczej mapie nierówności. Dzięki temu, że do kompozycji obrazu używaliśmy wyłącznie klonów poszczególnych warstw — zachowujemy nadal możliwość łatwej modyfikacji szczegółów rysunku. Scalenie zawartości warstw w grupy nie jest w tym żadną przeszkodą. W Inkscape możesz „wejść” do wnętrza każdej grupy (wystarczy dwukrotnie w nią kliknąć) i poddać edycji jej zawartość. (W istocie grupy są tu traktowane jak „podwarstwy” — por. str. 722). A gdy zmieni się grupa wzorcowa (na warstwie, powiedzmy, Rivets) zmienią się także wszystkie jej klony, także te wchodzące w skład innych warstw rezultatu. (Stworzymy ich za chwilę jeszcze kilka, np. Result:Nor-Blur). Ta zasada przechowywania i modyfikacji jednego wzorca bardzo ułatwia wszelkie modyfikacje. Przy większych zmianach — np. gdy chcesz włączyć do grupy (np. #Rivets) nowy element — wystarczy go tam narysować lub przenieść operacjami Cut/Paste.
Obrazu nor_details.png jest przygotowany, zajmijmy się teraz kolejnym: nor_blur.png. To rozmyty obraz nierówności. Przypomnij sobie, jak na stronie 347-348 eksportowaliśmy pomocniczy plik blur.png z Inkscape do GIMP. Dalsze przygotowanie polegało na złożeniu w warstwach Gimpa kilku kopii tego obrazu. Każda z tych warstw była poddawana rozmyciu Gaussa o innym promieniu.
Tę metodę możesz zastosować także teraz. Jeżeli jednak chcesz to zrobić szybciej i dokładniej — skorzystaj filtrów Inkscape. Nie chciałem ich wprowadzać wcześniej, bo nie chciałem komplikować wprowadzenia do teksturowania. Teraz jednak czas już o nich opowiedzieć.
Dodaj do rysunku nową warstwę Result:Nor-Blur. Będziemy z niej eksportować rozmyty obraz nor_blur.png, gotowy do wykorzystania w Blenderze (Rysunek 7.5.5):
Rysunek 7.5.5 Przygotowanie pomocniczej mapy nierówności (nor_blur.png)
„Sklonuj” (Alt-D, por. str. 715) zawartość warstw: Contours, Bumps, Rivets, Shadows. Każdy z tych klonów przenieś na warstwę Result:Nor-Blur (np. naciskając kilka razy Shift-PgDn — por. str. 721). Przypisz poszczególnym klonom taką nieprzejrzystość, jaką podaje Rysunek 7.5.5. (Użyj do tego kontrolki O pacity — zob. str. 696). Połącz potem wszystkie klony w jedną grupę i nadaj jej nazwę #Nor-Blur.
W Inkscape różnorodne „efekty specjalne” można osiągnąć za pomocą tzw. filtrów (menu Filters). Przejdź do ich edytora (Filters→FIlter Editor... ) , i przypisz grupie #NorBlur filtr, złożony z trzech gaussowskich rozmyć. (Szczegółowy opis, jak zbudować filtr znajdziesz na str. 733). Rysunek 7.5.6 przedstawia rezultat:
Rysunek 7.5.6 Filtr, tworzący efekt kaskadowego rozmycia obrazu
Do poprawienia pozostał jeszcze tylko jeden szczegół: elementy z grupy #Nor-Blur nie powinny być widoczne na obszarach zasłoniętych różnego rodzaju pokrywami. Przykładem takich obszarów może być pokrywa luku bagażowego (z lewej strony kadłuba), czy osłony zbiorników paliwa na dolnej powierzchni centropłata1. Sklonuj zawartość warstwy Cover, zawierającej te wszystkie elementy. Przenieś ten klon na warstwę Result:Nor-Blur (Rysunek 7.5.7):
Rysunek 7.5.7 Klon obrazu pokryw (#Cover), przeniesiony na warstwę z rozmytym obrazem nierówności
Klon obrazu pokryw (#Cover) zasłania teraz linie, których nie powinno być na obrazie mapy nierówności. Jest jednak drugi problem: wszystkie pokrywy powinny być w kolorze tła (białym), a nie szarym (Rysunek 7.5.7)! Elementy grupy #Cover muszą mieć na tyle zróżnicowany styl linii i wypełnienia, że nie można było ustawić im wszystkim „dziedziczenia” ustawień po obiekcie nadrzędnym (Rysunek 7.5.3). W tej sytuacji można wykorzystać prosty filtr, by skutecznie nadać klonowi #Cover barwę tła (Rysunek 7.5.8):
Rysunek 7.5.8 Prosty filtr, nadający obiektowi barwę białą (zarówno liniom, jak i wypełnieniom)
Nazwałem taki filtr White. Wykorzystałem w nim element Color Matrix, wpisując w pierwsze trzy pola prawej kolumny wartości 1.0. (Przez tę macierz jest mnożony wektor wartości R,G,B,A każdego piksela grupy #Cover).
Jeżeli nie wiesz, co to są „macierze” i na czym polega ich mnożenie — poszukaj w Internecie wyjaśnienia. (Na pewno znajdziesz, jeżeli wpiszesz w wyszukiwarkę te słowa po polsku). Możesz także stosować przedstawione tu filtry na zasadzie „przepisów kuchennych”, nie wnikając w ich szczegóły.
Poza klonem #Cover dodałem do warstwy Result:Nor-Blur klony grup odwzorowujące powierzchnie kryte płótnem — #Fabric Bumps i #Fabric. Tę drugą wstawiłem tylko „na wszelki wypadek” bo praktycznie nie będzie widoczna na białym tle tego obrazu (Bkg-White). Nieprzejrzystość #Fabric Bumps odpowiada „dynamicznym” zagłębieniom płótna pomiędzy żebrami sterów i lotek. Dla scen statycznych (np. samolot stojący na ziemi) może być zupełnie przejrzysta — bo wtedy wystarczą wypukłości wzdłuż żeber uzyskane za pomocą obrazu nor_details.png (por. Rysunek 7.5.5). W scenach w locie wykorzystuję zazwyczaj obraz w którym #Fabric Bumps ma nieprzejrzystość na poziomie 50% — 80%. Rysunek 7.5.9 przedstawia ostateczną kompozycję, gotową do wyeksportowania wprost do pliku nor_blur.png i użycia w Blenderze:
Rysunek 7.5.9 Obraz drugorzędnej mapy nierówności gotowy do eksportu do pliku nor_blur.png
Obraz nor_blur.png, który wykorzystuję w tej książce, ma rozmiar 2048x2048 px2. Zwróć uwagę, że elementy z warstwy Cover są jasnoszare, ale nie białe. To dlatego, że zastosowałem na tym klonie filtr Gray zamiast White. Dlaczego? Tak mi wyszło z „przymiarki” obydwu tekstur nierówności do modelu. Na podstawowym obrazie (nor_details.png — Rysunek 7.5.5) te elementy są jaśniejsze od tła, przez co Cycles renderuje je jako wypukłości. Nie podobało mi się to, szczególnie na pokrywach karabinów w skrzydle (por. str. 401, Rysunek 7.4.21). Wygląda to jak na jakimś pojeździe opancerzonym, a nie samolocie. Dlatego „spłaszczam” je teraz za pomocą drugiej tekstury, na której te same jasnoszare obszary są „poniżej” białego tła.
Obydwa obrazy nierówności dodałem do materiału B.Skin.Camouflage w taki sam sposób, jak w poprzedniej sekcji (por. str. 348, Rysunek 6.4.12). Po pierwszych próbach okazało się, że muszę nieco zwiększyć ich intensywność (Rysunek 7.5.10):
Rysunek 7.5.10 Zastosowanie map nierówności w materiale B.Skin.Camouflage
Rysunek 7.5.11 przedstawia podgląd renderu dla tak zmodyfikowanego materiału:
Rysunek 7.5.11 Rezultat użycia map nierówności
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-7.05.blend, a pliki z teksturami — w folderze model\p40\textures\7.05\* (por. str. 22).
Ta sekcja przedstawia metody, umożliwiające szybkie uzyskanie z rysunku wektorowego obrazów tekstur nierówności i odbić. Jest to uszczegółowienie metod, opisanych w sekcji 6.4 (str. 347);
Obrazy w Inkscape komponujemy na wydzielonych „warstwach rezultatu” (warstwach o nazwach wyróżnionych np. przedrostkiem Result:). Kompozycja powstaje z tzw. klonów (czyli referencji) zawartości oryginalnych warstw roboczych. Takie klony które modyfikujemy za pomocą filtrów. W niektórych kompozycjach można użyć, z różnymi filtrami, nawet kilku klonów tej samej warstwy (np. #Rivets na str. 413 i 415);
Aby używać klonów warstw, należy najpierw połączyć ich zawartość w grupy (str. 405). W Inkscape po takim połączeniu możesz nadal zmieniać ich „wnętrze”. Taka zmiana, wprowadzona w we wnętrzu oryginalnej grupy, jest natychmiast widoczna na wszystkich jej kopiach (także tych na warstwach Result:). To bardzo ułatwia nanoszenie w obrazie tekstury ewentualnych poprawek (prędzej czy później — na pewno będzie taka potrzeba);
Stosując w Inkscape do kompozycji filtry, można uzyskać nie tylko szczegółowy obraz nierówności (nor_details.png — str. 406), ale także gotowy do użycia w Blenderze, rozmyty obraz nierówności (nor_blur.png — str. 409).
Korzystając z podglądu renderu obejrzyj ze wszystkich stron efekt uzyskany w poprzedniej sekcji: model pokryty teksturami nierówności. Zauważ, że szczegóły powierzchni są widoczne wyłącznie na odpowiednio podświetlonych powierzchniach. W dodatku cały samolot wydaje się nienaturalnie czysty (Rysunek 7.6.1):
Rysunek 7.6.1 Efekt zastosowania samych tekstur nierówności
Wokół śrub, paneli i innych nierówności powinien się zbierać kurz i przetarcia (drobne zmatowania). Można je podkreślić za pomocą tekstury modulującej współczynnik rozpraszania światła odbitego przez materiał (Ref lectivity — omawialiśmy już to w sekcji 6.5). W ramach uproszczenia ten sam obraz można także użyć do modulacji szorstkości (Roughness). W tej sekcji użyjemy złożenia dwóch takich obrazów:
drobnych zabrudzeń i przetarć związanych z „technicznymi” nierównościami powierzchni. Ten plik nazwiemy: ref_details.png;
innych zabrudzeń eksploatacyjnych (np. śladów spalin). Ten plik nazwiemy ref_dirt.png. Tę teksturę wykorzystamy także w obrazie barwy — aby sterować połyskliwością brązowych zacieków od oleju, czy czarnych śladów sadzy.
Przejrzałem setki historycznych zdjęć P-40 z wielu obszarów II wojny światowej. Jakoś tak się składało, że samoloty te operowały zazwyczaj z lotnisk polowych. Warto sobie uświadomić, że warunki eksploatacji na takich lądowiskach są zbliżone do warunków pracy współczesnych samolotów rolniczych — wszędzie pył, a czasami także błoto. Z tego powodu maszyny należało okresowo czyścić. Stan pokrycia samolotów zależał w dużym stopniu od liczebności i zaangażowania ludzi z obsługi naziemnej. Jeżeli było ich wystarczająco wielu — można było sobie pozwolić na mycie myśliwców po każdym locie. Niezależnie jednak od „ogólnego zabrudzenia” maszyn, wygląda na to, że farby nanoszone w zakładach Curtiss dobrze się trzymały powierzchni. Jedyne przetarcia „do gołej blachy” można zaobserwować u nasady skrzydeł (tam, gdzie pilot i obsługa naziemna najczęściej wchodzili w butach). Takie przetarcia odtworzymy w następnej sekcji, teksturą barwy. Reszta powierzchni — to zabrudzenia uzyskane za pomocą tekstur odbić.
Obraz szczegółowej mapy odbicia jest skomplikowany, więc zdecydowałem się go podzielić na trzy warstwy:
nitów i ich cieni (umieść je na warstwie Result:Ref-Blur), których obraz ulegnie rozmyciu;
linii połączeń poszycia (umieść je na Result:Ref-Grunge), które zostaną poddane „porysowaniu”;
elementów dodatkowych (nitów, śrub) (umieść je na warstwie Result:Ref-Other);
Na pierwszej z warstw (Result:Ref-Blur) umieściłem klony zawartości warstw Rivets i Shadows (Rysunek 7.6.2):
Rysunek 7.6.2 Początek kompozycji mapy odbić — złożenie nitów i ich „cieni” na warstwie Result:Ref-Blur.
Połączyłem te klony w jedną grupę #Ref-Blur, i „rozmyłem” jej obraz za pomocą jednokrotnego rozmycia Gaussa (Rysunek 7.6.3):
Rysunek 7.6.3 Proste, jednokrotne rozmycie zawartości warstwy Result:Ref-Blur (filtrem Simple Blur)
Współczynnik Std Deviation tego filtru ustawiłem na umiarkowaną wartość — 3.0. Dla porządku nadałem zastosowanemu filtrowi nazwę Simple Blur (może do czegoś jeszcze się w przyszłości przyda).
Warstwa Result:Ref-Blur to zaledwie podkład. Pod czym? Pod następną warstwą, która będzie zawierać właściwy efekt „zużycia”. Nazwiemy ją Result:Ref-Grunge.
Result:Ref-Grunge ma zawierać obraz drobnych zabrudzeń, rozrzuconych wzdłuż linii połączeń poszycia samolotu. Umieść na niej klony następujących warstw: Lines, Bumps, Cover, Contours (Rysunek 7.6.4):
Rysunek 7.6.4 Elementy, które zostaną przekształcone w „zabrudzenia” (warstwa Result:Ref-Grunge)
Klony, umieszczone na warstwie Result:Ref-Grunge, połącz w jedną grupę: #Ref-Grunge. Przypisz do niej specjalnie przygotowany w tym celu filtr Rough and Erode (Rysunek 7.6.5):
Rysunek 7.6.5 „Zabrudzenia” — rezultat zastosowania filtru Rough and Erode (warstwa Result:Ref-Grunge)
Trzeba przyznać, że filtr Rough and Erode tworzy naprawdę ciekawy efekt. Dawniej, gdy Inkscape nie miał takich możliwość, trzeba było w Gimpie ręcznie „pacykować” podobny wzór wzdłuż każdej linii. To była masa roboty! Teraz wyręczył nas w tym Inkscape. Być może wzór, który wytworzył, jest nieco jednostajny, i można go wzbogacić później w GIMP kilkoma dodatkowymi zabrudzeniami. To jednak pestka w porównaniu z mozolnym „brudzeniem” każdego szwu!
Filtr Rough and Erode powstał na podstawie standardowego filtra Inkscape o nazwie Rough and Dilate. Szczegółowy opis jego budowy i parametrów znajdziesz na str. 742.
Pozostało jeszcze dodać do mapy odbić takie szczegóły, jak rozjaśnienia w miejscu śrub i nitów, oraz przetarć na płótnie sterów. Dodatkowo, podobnie jak w przypadku warstwy Result:Nor-Blur, trzeba także zasłonić obszary luków (por. str. 408) — za pomocą kolejnego klonu warstwy Cover. Klony wszystkich tych dodatków (#Screws, #Rivets, #Fabric, #Cover) zgromadziłem na warstwie Result:Ref-Other (Rysunek 7.6.6):
Rysunek 7.6.6 Dodatkowe elementy obrazu ref_details.png (warstwa Result:Ref-Other)
Śruby (klon #Screws) mają białe wypełnienie i dzięki temu nie wymagają żadnej korekty. Wybielenia płótna na krawędziach żeber (klon #Fabric) zrób prawie przejrzyste (O pacity = 20%), aby się za bardzo nie wyróżniały. Nity (klon #Rivets) są czarne, a w tym przypadku powinny być białe. Aby to osiągnąć, wystarczy zastosować dla ich klonu filtr White (Rysunek 7.6.7):
Rysunek 7.6.7 „Wybielenie” nitów za pomocą filtra White (warstwa Result:Ref-Other)
Nieprzejrzystość (O pacity) #Rivets ustaw na poziomie jakichś 80%, aby na rysunku nie były zupełnie białe.
Grupę #Cover dodałem do tej warstwy przede wszystkim po to, by odrobinę odróżnić wszelkie klapy i zaślepki na od reszty poszycia za pomocą różnicy w odcieniu barwy. W „surowej postaci” występuje na nich duży kontrast pomiędzy czarnym konturem i stosunkowo jasnym wypełnieniem (czarny i szary z 70% bieli — por. Rysunek 7.6.6). Ten kontrast można „spłaszczyć” za pomocą kolejnego filtra, któremu nadałem nazwę Gray (Rysunek 7.6.8):
Rysunek 7.6.8 „Wyszarzenie” rysunku osłon za pomocą filtra Grey (warstwa Result:Ref-Other)
Jaki właściwie efekt osiągniemy za pomocą trzech tak przygotowanych warstw? Rysunek 7.6.9 przedstawia odpowiednio powiększony fragment, na którym widać wszystkie szczegóły:
Rysunek 7.6.9 Fragment mapy odbić/odbłysków (złożenie warstw Result:Ref-Other, *-Grunge, *-Blur)
Uważam, że jest to całkiem przyzwoite „ogólne zabrudzenie” powierzchni. Wymaga od komputera trochę obliczeń, więc możesz zauważyć spowolnienie pracy Inkscape. Dlatego włączaj widoczność tych trzech warstw tylko na czas eksportu do pliku rastrowego. Gdy będą niewidoczne, Inkscape będzie działał szybciej.
Rysunek 7.6.10 przedstawia obraz ref_details.png (2048x2048px), złożony z trzech warstw Result:Ref-*:
Rysunek 7.6.10 Obraz mapy odbić/odbłysków, gotowy do eksportu do pliku ref_details.png
Dla bardzo połyskliwych („srebrnych”) powierzchni, jak te ze str. 412 czy 418, obraz mapy odbić musi mieć białe tło. (Dla materiałów mniej połyskliwych – matowych i półmatowych — może być szare). Zwróć uwagę, że warstwa Result:Ref-Grunge nieco przyciemnia tło (o ok. 5%). Aby dostosować do tego odcienia pokrywy wszystkich otworów, stworzyłem pomocniczy filtr Light Gray. Działa na tej samej zasadzie co filtr Gray, zastosowany na warstwy Result:Nor-Blur — por. str. 409.
Teksturę odbić podłączamy do materiału B.Skin.Camouflage tak, jak to robiliśmy podczas testu (por. str. 354). Zwróć uwagę, że ze względu na jasnoszare tło tekstury, ustawiłem max. intensywność Reflectivity na 1.0, a nie na 0.98, jak to robiliśmy dla białego obrazu podczas testów. Gdy Range To Max:Range jest ograniczony do zakresu 0.3, nadaje to powierzchni modelu podstawową odbijalność światła na poziomie 0.98 (Rysunek 7.6.17):
Rysunek 7.6.11 Użycie tekstury ref_details.png w materiale B.Skin.Camouflage (wersji „srebrnej”)
Co właściwie uzyskujemy w wyniku zastosowania tak podłączonej tekstury ref_details.png ? Oceń sam (Rysunek 7.6.12):
Rysunek 7.6.12 Rezultat zastosowanie tekstury odbić (modulacja Gloss Paint:Reflectivity)
Jeżeli sądzisz, że taki efekt ciemnych zabrudzeń mógłbyś uzyskać stosując teksturę barwy, to popatrz teraz na górne powierzchnie tego modelu (Rysunek 7.6.13):
Rysunek 7.6.13 Lokalne rozjaśnienia w wyniku modulacji Gloss Paint:Roughness
Porównaj ten efekt z ilustracją na str. 412. Wszędzie, gdzie padające światło odbija się w kierunku kamery, na powierzchni samolotu pojawiają się lokalne rozjaśnienia. Są to ciemniejsze obszary obrazu ref_details.png: krawędzie paneli, szwów nitów. Ta tekstura szczególnie dobrze imituje lokalne przetarcia wokół pokryw wszelkich otworów (elementów pochodzących z warstwy Cover).
Plik ref_details.png na razie nie zawiera jeszcze różnych zabrudzeń eksploatacyjnych: śladów po spalinach i prochu strzelniczym, oraz wszelkich innych pomniejszych zaciemnień. Proponuję dla tego rodzaju elementów stworzyć oddzielny obraz, o nazwie ref_dirt.png. Pozwoli nam to oddzielnie sterować intensywnością wszystkich bardziej ulotnych i zmiennych zanieczyszczeń.
Plik ref_drit.png stworzyłem w UV/Image Editor Blendera jako nowy, biały obraz (Image→New Image, por. str. 1132). Dodaj do schematu materiału B.Skin.Camouflage kolejny węzeł Image Texture, i przypisz mu obraz ref_dirt.png (Rysunek 7.6.14):
Rysunek 7.6.14 Włączenie do schematu materiału pomocniczej tekstury odbić
Na ilustracji kolorem żółtym obrysowałem wszystkie nowe elementy, dodane do schematu. Na razie do wejścia Vector węzła nowej tekstury podłączam takie same współrzędne UV, co do pozostałych tekstur. Dzięki temu, że tło obrazu ref_dirt.png jest białe, można go połączyć z podstawową teksturą odbić (ref_details.png) za pomocą węzła Multiply. (W ten sam sposób są scalane pomocnicza i podstawowa tekstura nierówności). Z tego samego powodu do sterowania intensywnością efektu wykorzystuję prostszy węzeł Moderate, którego używamy w teksturach nierówności. Na razie włączam ten obraz na „pełną moc”, i zobaczymy co z tego wyniknie.
Ślady dymu ciągną się zazwyczaj poprzez kilka różnych siatek, stąd najłatwiej nanosić je w Blenderze, w trybie Texture Paint (Rysunek 7.6.15, por. także str. 1134):
Rysunek 7.6.15 Malowanie śladów dymu na pomocniczej mapie odbić (ref_dirt.png)
Nim zaczniesz malować spaliny, przyjrzyj się uważnie historycznym zdjęciom odtwarzanej maszyny. Każdy typ samolotu z silnikiem spalinowym ma swój specyficzny układ zabrudzeń pochodzących od rur wydechowych. Zazwyczaj zauważysz, że spaliny wcale nie opływają kadłuba wzdłuż linii prostych. Smugi, które pozostawiają na jego powierzchni, na dolnopłatach często są unoszone do góry przez opływ powietrza wokół skrzydła. Strumień zaśmigłowy także sprawia, że ślady spalin z lewej strony kadłuba mogą mieć inny kształt niż z prawej.
Do precyzyjnego namalowania smug wokół luf karabinów maszynowych bardzo przydają się linie pomocnicze (Grease Pencil — por. str. 1149). Użyj ich, aby odrysować z obrazu nierówności (nor_details.png) kluczowe osie i położenia źródeł zabrudzeń. Potem podmień wyświetlany na powierzchni modelu obraz na ref_dirt.png, i namaluj odpowiednie ślady dymu (Rysunek 7.6.16):
Rysunek 7.6.16 Wykorzystanie linii pomocniczych do malowania zabrudzeń wokół luf karabinów
Obraz ref_dirt.png wzbogacimy jeszcze o drobne zacieki i plamy. Łatwiej jest je nanieść w Gimpie, na podstawie obrazu ref_details.png. Wczytaj do GIMP pliki ref_details.png jako odrębną warstwę. Następnie załaduj do tego pliku obraz ref_dirt.png, jako nową warstwę (Rysunek 7.6.17a). Namaluj na niej obraz kolejnych zabrudzeń (Rysunek 7.6.17b):
Rysunek 7.6.17 Wzbogacanie pomocniczego obrazu odbić o kolejne zabrudzenia w GIMP (skin.xcf)
Szczegółowy opis, jak rysować zabrudzenia w GIMP znajdziesz na str. 659. Zachowaj ten rysunek pod nazwą skin.xcf, bo wykorzystamy go jeszcze w następnym rozdziale do stworzenia obrazu barwy. Zawartość warstwy ref_dirt.png zapisz (File→Save a Copy) z powrotem do osobnego pliku. Wykorzystamy go teraz w Blenderze.
Nie mogę powiedzieć, aby tak pracowicie namalowane na poprzednich stronach, czarne ślady spalin były na testowym renderze specjalnie widoczne (Rysunek 7.6.18):
Rysunek 7.6.18 Wstępny efekt zastosowania pomocniczej tekstury odbić.
Przyczyną jest ogólne „spłaszczenie” zakresu połączonego obrazu tekstur odbicia w węźle Range To Max do 30% (por. Rysunek 7.6.14). Jak w takim razie uzyskać na modelu czarną warstwę sadzy? Używając jej obrazu w charakterze tekstury barwy (Rysunek 7.6.19):
Rysunek 7.6.19 Użycie ref_dirt.png w roli tekstury barwy.
Połącz wyjście z węzła Moderate drugą linią z wejściem dla barwy Specular shadera Gloss Paint 1. Warto zdawać sobie sprawę, że tak prosta zmiana schematu jest możliwa, gdyż dotychczas Gloss Paint:Specular był biały — dokładnie tak, jak tło ref_dirt.png. Teraz także na większości powierzchni modelu jest biały, i w tych obszarach nic nie ulegnie zmianie. Jedynie w miejscach, gdzie tekstura zawiera czarne plamy uzyskamy bardziej zdecydowaną zmianę barwy.
Teraz nasze ślady spalin stały się zdecydowanie bardziej wyraźne (Rysunek 7.6.20):
Rysunek 7.6.20 Rezultat modulacji barwy Gloss Paint:Specular za pomocą obrazu ref_dirt.png.
Tak silny efekt można teraz tonować (w końcu obsługa naziemna często myła samoloty!). Zmniejsz wartość Range w węźle Moderate, podłączonym do obrazu tekstury (Rysunek 7.6.21 — por. także Rysunek 7.6.19):
Rysunek 7.6.21 Bardziej stonowany efekt zabrudzeń
Zanieczyszczenia w pliku ref_dirt.png umieściłem w miejscach, w których występowały na większości zdjęć. Wygląda na to, że w P-40 najbardziej brudziła się centralna część kadłuba. Mam teraz wątpliwości, czy nie powinienem dodatkowo pobrudzić krawędzi natarcia skrzydła. Na ilustracji wygląda zbyt czysto w stosunku do reszty maszyny (Rysunek 7.6.21). Proponuję jednak wstrzymać się z tym do zakończenia następnej sekcji. Być może po nałożeniu kamuflażu te plamy będą wyglądać inaczej.
W materiale matowym zastosowanie tekstury ref_dirt.png w roli pomocniczej tekstury barwy wygląda nieco inaczej (Rysunek 7.6.22):
Rysunek 7.6.22 Zastosowanie tekstury ref_dirt.png na powierzchni matowej
Po pierwsze — na ostateczną barwę takiego materiału największy wpływ ma kolor Diffuse, dlatego użyjemy tekstury do sterowania tym wejściem shadera Gloss Paint. Po drugie — teksturę ref_dirt.png trzeba połączyć z oryginalnym kolorem materiału za pomocą operacji Multiply. „Wyciągnąłem” więc używaną do tego testu barwę Olive Drab jako oddzielny węzeł RGB (Rysunek 7.6.22). Jeżeli wyjście z tego węzła podłączysz do używanego dotychczas węzła Math:Multiply, zamienisz kolor w odcienie szarości. Dlatego do łączenia barw użyłem węzła Color→Mix, z włączonym trybem Multiply.
Rysunek 7.6.23 przedstawia uzyskany rezultat (dodatkowo wzmocniłem tutaj światło słoneczne Sun):
Rysunek 7.6.23 Podgląd renderu — matowa wersja B.Skin.Camouflage z teksturą ref_dirt.png
Zwróć uwagę, że ślady spalin są lepiej widoczne z daleka, niż z bliska (Rysunek 7.6.23).
Na koniec chciałbym wspomnieć o możliwości szybszego wyeliminowania z renderu Cycles „białego szumu”, który występuje szczególnie intensywnie na połyskliwych powierzchniach (por. Rysunek 7.6.20, Rysunek 7.6.21). Gdy ustawisz w zestawie render, panelu Sampling wartości Clamp (Clamp Direct, Clamp Indirect) na gdzieś pomiędzy 2.0 i 3.0, skutecznie wyeliminujesz z renderu wszystkie niepożądane białe punkty! Więcej na temat — patrz str. 1051.
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-7.06.blend, a pliki ze zmienionymi teksturami — w folderze model\p40\textures\7.06\* (por. str. 22).
Podsumowanie
Podstawowa tekstura odbić (ref_details.png) pozwala odtwarzać zabrudzenia i przetarcia wokół „technicznych” nierówności na powierzchni samolotu (por. str. 412 i str. 418);
Obraz podstawowej tekstury odbić (ref_details.png) można uzyskać wprost w Inkscape, używając odpowiednich filtrów (str. 413 — 417);
Tekstura odbicia podkreśla szczegóły powierzchni, szczególnie te widziane pod dużym kątem (str. 418);
Ślady spalin, prochu i inne zabrudzenia nanosimy używając pomocniczej tekstury odbić (ref_dirt.png — str. 419);
Obraz pomocniczej tekstury odbić można rozpocząć w Blenderze, malując ślady spalin bezpośrednio na powierzchni modelu (str. 419); W tej pracy przydają się także czasami linie pomocnicze (Grease Pencil — por. str. 420);
Obrazy tekstur odbić łączymy ze sobą tak samo, jak tekstury nierówności — za pomocą węzła Multiply (str. 419). Dlatego konieczne jest, by obraz z ref_dirt.png miał białe tło;
Aby ślady zabrudzeń „eksploatacyjnych” były bardziej widoczne, należy użyć pomocniczej tekstury odbić jako tekstury barwy (str. 421 - 422);
Powierzchnie matowe wymagają przypisania obrazu ref_dirt.png do barwy Diffuse (str. 423), a połyskliwe (metaliczne, „srebrne”) — do barwy Specular (str. 421);
Czas nałożyć na nasz samolot kamuflaż. W tej sekcji wykonamy najprostszy, dwukolorowy schemat — taki jak ten, stosowany w USAAC w 1941r (Rysunek 7.7.1):
Rysunek 7.7.1 Kamuflaż stosowany w USAAC w 1941r (pominąłem znaki rozpoznawcze i wszelkie inne dodatki).
Górne i boczne powierzchnie samolotu były pokryte barwą Olive Drab, a dolne — Neutral Gray. Wewnętrzne powierzchnie (kabina, wnęki podwozia, wnętrza klap, itp.) — farbą podkładową Zinc Chromate. (Najprawdopodobniej była to odmiana tego podkładu z dodatkiem czerni, określana często jako Curtiss Green). Na rysunku pominąłem wszelkie oznaczenia, napisy i inne „ornamenty”, bo w tej sekcji nie będziemy się nimi jeszcze zajmować.
Pracę nad kamuflażem zaczniemy od przygotowania obrazu referencyjnego siatek rozwiniętych w UV. Pamiętasz, że dla obrazów kamuflażu przygotowaliśmy w Blenderze alternatywne mapowanie UV (UV Map) o nazwie Color? (Aby sobie przypomnieć sprawę, zerknij na str. 395) . Obrazy referencyjne wyeksportowane z Blendera zgromadziliśmy w pliku uv.svg. Wczytaj teraz do tego rysunku alternatywne rozwinięcia siatek oprofilowania płata i ramek tylnych szyb — takie, jakie są Blenderze przypisane do rozwinięcia UV o nazwie Color.
Aby się w tych rozwinięciach nie pogubić, stwórzmy w pliku uv.svg warstwy odpowiadające poszczególnym mapowaniom UV zdefiniowanym w Blenderze (Rysunek 7.7.2):
Rysunek 7.7.2 System warstw w pliku uv.svg
Na ilustracji sztucznie zabarwiłem zawartość warstwy UV-Color na czerwono, a UV-UVTex — na niebiesko, abyś mógł je łatwo odróżnić. Rysunek 7.7.2a) pokazuje układ, który proponuję. Warstwa UV-Base zawiera wszystkie siatki z Blendera, które mają tylko jedno rozwinięcie (w Blenderze są przypisane do domyślnego mapowania UVTex). Warstwa UV-UVTex z uv.svg zawiera pozostałe rozwinięcia mapowania UVTex Blendera. (Są to te elementy, które występują jeszcze na innych mapowaniach UV). Warstwa UV-Color zawiera rozwinięcia siatek z mapowania UV Color.
Teraz, aby z uv.svg uzyskać kompletny układ UV dla tekstury używającej w Blenderze warstwy Color, należy wyeksportować z Inkscape kompozycję warstw UVColor + UV-Base (Rysunek 7.7.2b). Takiego właśnie obrazu potrzebujemy w tej sekcji. Podobnie, by uzyskać podstawowy układ UV (dla tych tekstur, które używają współrzędnych UV z węzła Texture Coordinate) — należy wyeksportować złożenie UV-UVTex + UV-Base (Rysunek 7.7.2c). Taki obraz wykorzystywaliśmy dla wszystkich dotychczas omawianych tekstur.
Zwróć uwagę (Rysunek 7.7.2b,c), że rozwinięcia płatów są umieszczone warstwach UV-Color i UV-UVTex, choć niczym się nie różnią. To już przygotowanie do wstawienia trzeciej warstwy — UV-Decals. Mapowanie o tej nazwie stworzymy w Blenderze w sekcji 7.8, przy okazji nanoszenia znaków rozpoznawczych. Będzie zawierać inne rozwinięcie skrzydła, ze szwem biegnącym wzdłuż krawędzi natarcia.
Kamuflaż stworzymy w Gimpie, w pliku skin.xcf (to ten, stworzony w poprzedniej sekcji). Na początek zmień nazwy istniejących w nim warstw: ref-details.png na Ref-Shadows, a ref-dirt.png na Ref-Smoke. Potem wyeksportuj z Inkscape rysunek rozwinięć siatek w UV (UV-Base + UV-Color) do pliku uv-color.png. Wstaw ten plik jako nową warstwę referencyjną o nazwie UV-Color.png (Rysunek 7.7.3):
Rysunek 7.7.3 Wykorzystanie obrazu rozwinięć UV do zaznaczenia obszaru (GIMP, plik skin.xcf).
Zaznacz cały obszar rozwinięcia UV poleceniem Select→By Color (Shift-O, szczegóły — str. 636), wskazując seledynowe wypełnienie którejś z siatek. Aby „rozlać” selekcję także na krawędzie — powiększ ją o 2 piksele (Select→Grow... , szczegóły — str. 637). Następnie ogranicz zaznaczenie tylko do granic barwy Neutral Gray. Najłatwiej to zrobić, zamalowując odpowiednie obszary w trybie Quick Mask (szczegóły — str. 640) (Rysunek 7.7.4):
Rysunek 7.7.4 Ograniczenie zaznaczonego obszaru za pomocą Quick Mask.
Dodaj teraz do rysunku kolejną warstwę, o nazwie Color-UCamouflage. (Proponuję użyć przedrostka „Color-” do wszystkich warstw, składających się na obraz kamuflażu). Na nowej warstwie „zalejemy” () zaznaczony obszar barwą Olive Drab (Rysunek 7.7.5) :
Rysunek 7.7.5 „Zalewanie” barwą zaznaczonych powierzchni górnych.
Zmień najpierw barwę pierwszoplanową na kolor, którym wypełnimy obszar selekcji (Rysunek 7.7.5a). Skąd wiem, jaki jest symbol tej barwy w katalogu Federal Standard (FS) i znam konkretne wartości R,G,B? Poszperałem po opisach malowań dla modelarzy, umieszczonych w Internecie. Ówczesne farby zmieniały swój odcień wraz z upływem czasu, więc nie traktuj podanej tu wartości jako wyroczni, tylko jako przybliżenie. Więcej na temat identyfikacji kolorów kamuflaży znajdziesz na str. 1251.
Teraz wywołaj polecenie Tools→Paint Tools→Bucket Fill (, albo Shift-B). Spowoduje to zalanie obszaru selekcji kolorem pierwszoplanowym. Na koniec zapamiętaj obszar zaznaczenia górnych powierzchni poleceniem Select→Save to Channels (szczegóły — str. 642). Za chwilę się przyda do „wykrojenia” innego obszaru.
Aby uzyskać maskę dla powierzchni dolnych, zaznacz powtórnie całą powierzchnię rozwinięcia UV (Select→ByColor, Select→Grow...). Następnie odejmij od niej (Channels→Substract from Selection — zob. str. 642, Rysunek 10.21.2) zapamiętany przed chwilą w zakładce Channels obszar górnych powierzchni. Potem pozostaje już tylko wymazać powierzchnie wewnętrzne (w trybie Quick Mask — Rysunek 7.7.6a):
Rysunek 7.7.6 Przygotowanie maski i zalewanie barwą powierzchni dolnych.
Utwórz nową warstwę na powierzchnie dolne: Color-LCamouflage (Rysunek 7.7.6b). Zmień kolor pierwszoplanowy na ekwiwalent Neutral Gray (FS 36173 — podane na ilustracji wartości R,G,B to tylko przybliżenie). Powiększ obszar zaznaczenia o 2px (Select→Grow...) przed zalaniem barwą, aby na pewno na granicy kolorów nie pozostały żadne szczeliny.
Rysunek 7.7.6c) przedstawia złożenie warstw Color-UCamouflage i Color-LCamouflage. W miejscach, gdzie są rozwinięte powierzchnie wewnętrzne, prześwituje jeszcze pomocnicza UV-Color, bo na razie nie będziemy do materiału B.Skin.Inner dodawać tekstury.
Wyeksportuj (File→Save Copy) kopię złożenia obydwu warstw Color-* do pliku color.png. Włącz go, jako kolejny węzeł Image Texture do materiału B.Skin.Camouflage. Rysunek 7.7.7 przedstawia zmodyfikowany schemat (porównaj go ze schematem ze str. 423 — na miejsce węzła RGB wstawiliśmy nowe elementy):
Rysunek 7.7.7 Wstawienie tekstury color.png do materiału B.Skin.Camouflage (w wersji matowej)
Zwróć uwagę na przypisanie tekstury do alternatywnego rozwinięcia UV (Color — por. str. 395) za pomocą węzła Attribute i grupy UV Fallback (więcej na temat tych węzłów — patrz str. 1066)
Rysunek 7.7.8 przedstawia testowe rendery modelu z teksturą koloru (dla Background:Strength = 2.0):
Rysunek 7.7.8 Zależność barwy tekstury od intensywności światła słonecznego.
Uważam, że w scenie pokazywanej przez Rysunek 7.7.8b) (z silnym światłem słońca: Sun:Strength = 18) model wygląda lepiej niż w „oświetleniu studyjnym” (Sun:Strength = 3), które prezentuje Rysunek 7.7.8a) . Trzeba tylko przyciemnić kolory tekstury. Zrobimy to za pomocą węzła Hue Saturation Value (Rysunek 7.7.9):
Rysunek 7.7.9 Korekta intensywności barwy tekstury.
Nowy węzeł podłączyłem do wyjścia tekstury color.png, a następnie zmniejszyłem w nim intensywność (Value) barwy z 1.0 do 0.2. Rysunek 7.7.10 przedstawia rezultat, uzyskany na podglądzie renderu:
Rysunek 7.7.10 Ocena rezultat na podglądzie renderu.
Przyjrzyjmy się teraz temu modelowi bliżej. Namalowane w poprzedniej sekcji ślady spalin wyglądają na naszym kamuflażu zupełnie naturalnie. Wydaje mi się że barwa powierzchni wewnętrznych w tym ostrym świetle, także wymaga przyciemnienia. Skoro na razie nie zamierzamy „zamalować” ich teksturą, pozostaje tylko zmniejszyć intensywność barwy Gloss Paint:Diffuse (do V = 0.05) i Specular (do V = 0.30) materiału B.Skin.Inner (Rysunek 7.7.11):
Rysunek 7.7.11 Przyciemnienie barwy powierzchni wewnętrznych (B.Skin.Inner)
W rzeczywistym świecie, farba naniesiona na poszycia samolotów nie miała zupełnie jednorodnej barwy. Trudno mi nawet teraz rozstrzygać, czy to były jakieś ogólne zabrudzenia od kurzu i pyłu, czy też różne obszary farby wietrzały w różnym tempie. Dość, że nałożenie na jednolitą barwę kamuflażu delikatnego „szumu” zaciemnień i rozjaśnień czyni powierzchnię modelu bardziej wiarygodną. Taki „szum” można uzyskać używając jednego z filtrów Gimpa — Plasma 1. Ja jednak wolę oprzeć mój szum na mocnych fundamentach — i użyję w tym charakterze zdjęcia fragmentu powierzchni z betonu (Rysunek 7.7.12) :
Rysunek 7.7.12 Naniesienie na podstawową barwę obrazu „szumu”.
Oczywiście, wcześniej spośród kilku zdjęć wybrałem takie, które przedstawiało odpowiednio nieregularny wzór. W związku z tym, że miało rozmiary mniejsze od obrazu tekstury, poddałem je w Gimpie „wstępnej obróbce”, aby uzyskać obraz 2048x2048. Wyciąłem (Image→Canvas Size) ze zdjęcia betonu kwadratowy obszar 1024x1024 (to dokładnie ćwiartka docelowego obrazu). Następnie przekształciłem jego krawędzie tak, by można było je łączyć ze sobą (Filters→Map→Make Seamless). Wreszcie złożyłem 4 kopie tego obrazu w jedną całość, o docelowym rozmiarze 2048x2048 (Filters→Map→Tile..). Rezultat tych operacji masz udostępniony w materiałach związanych z tą sekcją (por. str. 22) jako plik concrete.jpg (Rysunek 7.7.12a)
Wczytaj zawartość tego pliku do skin.xcf jako nową warstwę (Color-concrete.jpg). Umieść ją na samej górze, ponad wszystkimi innymi warstwami Color-*. Zmień jej tryb mapowania z Normal na Multiple, a nieprzejrzystość (Opacity) zmniejsz do 10% (Rysunek 7.7.12b). (Za pomocą nieprzejrzystości tej warstwy sterujesz intensywnością „szumu”). Rysunek 7.7.12c) pokazuje efekt, uzyskany na obrazie. Jest bardziej widoczny na jaśniejszych powierzchniach dolnych, niż górnych.
Rezultat zastosowania tak zmienionej tekstury na modelu przedstawia Rysunek 7.7.13.
Do kolejnego etapu pracy potrzebujemy wzorca, w postaci linii połączeń na powierzchni samolotu. Powinny być na przeźroczystym tle, aby można je było łatwo „nałożyć” na pozostałe obrazy w Gimpie. Wyeksportuj taki obraz z Inkscape (skin.svg) do chwilowego pliku, o nazwie lines.png (Rysunek 7.7.14):
Rysunek 7.7.14 Warstwy ze skin.svg, których zawartość należy wyeksportować do pliku lines.png.
Przed zapisaniem rastrowej kopii do pliku lines.png, przyciemnij na chwilę w Inkscape linie na warstwie Shadows — do poziomu 50-80% czerni (Rysunek 7.7.14).
Lines.png wczytaj jako nową, pomocniczą warstwę do GIMP (do pliku skin.xcf). Nadaj jej nazwę UV-Lines.png i umieść ponad pozostałymi warstwami koloru (Rysunek 7.7.15a):
Rysunek 7.7.15 Malowanie rys na powierzchni kadłuba — w GIMP.
Wstaw także nową, pustą i przejrzystą warstwę o nazwie Color-Chips (Rysunek 7.7.15a). Namaluj na niej rysy i przetarcia (szczegółowy opis, jak to zrobić, znajdziesz na str. 663). Podczas tworzenia tych elementów trzeba uwzględniać „techniczne” nierówności poszycia, stąd tak potrzebna jest pomocnicza warstwa z ich obrazem. Aby przetarcia na modelu nie były zbyt ostre, przed wygenerowaniem pliku color.png zmniejszaj nieprzejrzystość warstwy Color-Chips — np. do 50% - 70% (por. str. 667, Rysunek 10.31.10 i Rysunek 10.31.11).
Pokrycie farbą, nanoszone w zakładach Curtiss, było dobrej jakości, stąd na P-40 prawie w ogóle nie występują odpryski farby. Na zdjęciach widać tylko przetarcia. Największe z nich to pas wzdłuż krawędzi skrzydła i kadłuba. Zostało wydeptane butami pilotów i obsługi (używanie ochronnych „dywaników” tylko zmniejszało jego rozmiar). Przetarcie na prawym skrzydle było mniejsze, bo uchwyt, ułatwiający wchodzenie, znajdował się z lewej strony kadłuba.
Rysunek 7.7.16 Podgląd renderu z teksturą barwy wzbogaconą o rysy i zadrapania.
Inne, drobniejsze zadrapania, umieściłem wokół zdejmowanych elementów poszycia, które mogły być często w użyciu: panelach okapotowania silnika, pokrywach sekcji uzbrojenia (Rysunek 7.7.16). Dodałem jeszcze „losowo” kilka małych rys na krawędziach natarcia płatów. Poza tymi obszarami przetarcia nie występowały.
Przetarcia możesz „chować”, zmniejszając intensywność tekstury (Rysunek 7.7.17):
Rysunek 7.7.17 Podgląd renderu z teksturą barwy wzbogaconą o rysy i zadrapania.
Cała powierzchnia samolotu staje się wówczas ciemniejsza, co jest całkiem dobrym przybliżeniem efektu „młodszej” (mniej zwietrzałej) farby. W razie czego możesz ją nieco rozjaśnić zwiększając nasycenie (Saturation). W węźle Hue Satruration Value ten parametr można ustawić na wartości > 1.0 (Rysunek 7.7.17).
Przetarciom towarzyszy otoczka zdartej farby podkładowej. Widać ją dobrze na amerykańskich maszynach, w których podkładem był czysty, nie „złamany” czernią Zinc Chromate. Zakładam jednak, że Curtiss stosował podkład z Curtiss Green. Ta farba jest tylko niewiele jaśniejsza od zużytego Olive Drab, więc efekt kontrastowej „otoczki” na P-40 nie występuje. Byłby widoczna na powierzchniach dolnych, ale tam z kolei nie ma przetarć (poza pokrywami komór uzbrojenia).
O ile na górnych powierzchniach gromadzą się rysy i zadrapania, o tyle na dolnych znajdziesz zawsze sporo kurzu i brudu — szczególnie, gdy samolot operuje z lotniska gruntowego. Moglibyśmy to odwzorować, rozbudowując teksturę odbić (ref_dirt.png). Jednak w tym przypadku różnice w połyskliwości zabrudzonej i czystej powierzchni nie są specjalnie duże. Zdecydowałem się nanieść je wyłącznie jako barwę. W pliku skin.xcf przeznaczyłem na te kolorowe plamy kolejną warstwę: Color-Dirt (Rysunek 7.7.18):
Rysunek 7.7.18 Warstwa Color-Dirt: ślady brunatnego kurzu, tłustych smug oleju, itp.
Nanieś plamy zabrudzeń na warstwę Color-Dirt podobną techniką, jaką wykonywaliśmy przetarcia (narzędziami Paint, Airbrush, Smudge, Blur, Erase). Warstwę, (o przejrzystości 60%), przedstawia Rysunek 7.7.19:
Rysunek 7.7.19 Naniesione zabrudzenia na dolnej powierzchni modelu (warstwa Color-Dirt).
Aby rozświetlić spód modelu, pokazywanego przez Rysunek 7.7.19, na chwilę przeniosłem obiekt Sun z góry na spód modelu. Kamerę ustawiłem tak, by pokazywała oświetlone dolne powierzchnie naszego samolotu.
Na jednym z forów modelarskich, w wątku o barwach, doczytałem się następującej uwagi: Klimat Hawajów wykańcza barwę każdej powłoki. Zostaw na parkingu na Oahu jaskrawoczerwonego Porsche, i wróć tam za pół roku. Przez ten czas samochód z czerwonego stanie się różowy.
Nasz model P-40 z Pearl Harbor powinien więc także mieć odpowiednio wyblakłe poszycie. Może nie aż tak bardzo jak ten Porsche, bo przypuszczam, że obsługa miała do dyspozycji hangary, a także jakieś pokrowce.
Poszycie samolotu zazwyczaj nie blaknie równomiernie — obszary wzdłuż linii łączeń różnią się o ton od reszty. Zacznijmy od przygotowania tych linii: wczytaj na nową warstwę (Color-Weathering) obraz lines.png (Rysunek 7.7.20a):
Rysunek 7.7.20 Warstwa Color-Weathering: rozmyte linie poszycia.
To ten sam plik, który wstawiliśmy na warstwę UV-Lines.png (Rysunek 7.7.20b, por. także str. 431, Rysunek 7.7.14). Tyle, że przed eksportem z Inkscape włączyłem pod liniami białe tło. W Gimpie poddaj warstwę Color-Weathering rozmyciu filtrem Gaussian Blur, o promieniu 30 px (Rysunek 7.7.20c, por. także str. 658).
Zamaluj fragmenty warstwy na biało, by były bardziej „losowe” (Rysunek 7.7.21a):
Rysunek 7.7.21 Wykończenie warstwy Color-Weathering.
Gdy nałożysz taki obraz na resztę rysunku w trybie Multiple, uzyskasz zaciemnienia (Rysunek 7.7.21b).
Barwa tych „zaciemnień” powinna w przybliżeniu odpowiadać Olive Drab (FS 34088), a na pozostałych obszarach powinna być jaśniejsza (bardziej „zwietrzała”). Aby taki efekt osiągnąć, wstaw do skin.xcf nowe warstwy: Color-Whiter i Color-Saturate, obydwie w trybie Screen (Rysunek 7.7.22a):
Rysunek 7.7.22 Warstwa Color-Saturate: rozjaśnienie poszycia.
Warstwę Color-Whiter wypełnij kolorem białym (np. podczas tworzenia). Zmieniając jej nieprzejrzystość będziesz mógł sterować stopniem „wyblaknięcia” poszycia.
Warstwę Color-Saturate dodałem, aby sterować nasyceniem koloru (wybielony wygląda nieciekawie). Zaznacz na niej obszar górnych powierzchni. (Najszybciej — poleceniem Layer→Transparency→Alpha to Selection na warstwie Color-UCamouflage. Potem przełącz się na warstwę Color-Saturate). Zalej ten obszar kolorem pomarańczowym (Rysunek 7.7.22b) — by Olive Drab, „przefiltrowany” przez tę warstwę, zachował trochę ciepłego odcienia. Potem analogicznie zaznacz dolne powierzchnie (wykorzystując zawartość warstwy Color-LCamouflage). Neutral Gray nie ma prawie wcale „ciepłych” tonów, więc ten obszar na Color-Saturate może być wypełniony barwą białą (Rysunek 7.7.22b).
Gdy zmniejszysz nieprzejrzystość Color-Whiter do 5% a Color-Saturate do 12% (Color Weathering jest na 60%), uzyskasz efekt delikatnych zaciemnień wzdłuż linii szwów (Rysunek 7.7.23a):
Rysunek 7.7.23 Kompozycja zaciemnień, wywołanych wietrzeniem farby.
Aby pogłębić wrażenie „zużycia”, zwiększyłem nieprzejrzystość Color-Concrete.jpg z 10 do 15%. Jednocześnie zmniejszyłem nieprzejrzystość warstwy Color-Chips do 50%. Po włączeniu warstw z brudem i przetarciami zaciemnienia stały się ledwo widoczne, (Rysunek 7.7.23b).
Zobacz jednak na próbny rendering (Rysunek 7.7.24a). Samolot wyblakł trochę, a wzdłuż połączeń paneli poszycia widać wpływ rozmytych cieni z warstwy Color-Weathering:
Rysunek 7.7.24 Model w wersji „wyblakłej”.
Tak zużyty samolot powinien być mniej połyskliwy. Ten efekt można łatwo osiągnąć, zwiększają w węźle Range From Min (por. str. 417, 423) bazową „szorstkość” powierzchni (Rysunek 7.7.24b). Przy okazji zmniejszyłem nieco jasność tekstury color.png (HSV:Value) do 0.15 i zwiększyłem jej nasycenie (HSV:Saturation) do 1.2.
Z innych ulepszeń — możesz jeszcze wkomponować w całość przeniesione z Inkscape śruby. Biały (a właściwie srebrnoszary) kolor ich łbów powinien wyglądać jak efekt częstych „spotkań ze śrubokrętem”!
Wyeksportuj z pliku skin.svg zawartość warstwy Screws do pliku o nazwie screws.png. Ten obraz ma mieć przejrzyste tło, aby można było go nałożyć na podstawową teksturę color.png (Rysunek 7.7.25). Zwróć uwagę, że na schemacie w Blenderze tekstura screws.png jest mapowana tak jak mapa nierówności — w domyślnych współrzędnych UV (UVTex, z Texture Coordinate:UV) a nie w mapowaniu Color. Węzeł Multiply pozwala sterować przejrzystością śrub.
Rysunek 7.7.26 przedstawia podgląd renderu z dodatkową teksturą screws.png:
Rysunek 7.7.26 Łby śrub, podkreślone za pomocą tekstury screws.png
W wyniku nałożenia tego obrazu wg domyślnych współrzędnych UV (z mapy UVTex), rozjaśnione zostały m.in. śruby na oprofilowaniu połączenia skrzydła i kadłuba. (Rozwinięcie oprofilowania znajduje się w innym miejscu na mapie UVTex, a w innym miejscu na mapie Color — por. str. 390 i 395).
Alternatywnie, zamiast komplikować schemat materiału za pomocą kolejnej tekstury, obraz śrub można wstawić do pliku skin.xcf jako kolejny składnik podstawowej tekstury barwy (Rysunek 7.7.27):
Rysunek 7.7.27 Wkomponowanie screws.png w podstawowy obraz tekstury (color.png)
Plik screws.png dodałem do skin.xcf jako nową warstwę o nazwie Color-screws.png, powyżej warstwy z przetarciami (Rysunek 7.7.27a). W odróżnieniu od przetarć, ta warstwa ma ustawioną pełną nieprzejrzystość. Mimo to dobrze się z nimi komponuje, bo śruby są wypełnione kolorem szarym, a nie białym (Rysunek 7.7.27b). Rysunek 7.7.28 przedstawia rezultat uzyskany za wyłącznie za pomocą zmodyfikowanej tekstury color.png:
Rysunek 7.7.28 Efekt wkomponowania śrub w podstawową teksturę barwy (color.png)
Wadą włączenia obrazu screws.png do podstawowego pliku tekstury barwy (skin.xcf i jego rezultat — obraz color.png) jest brak rozjaśnienia łbów śrub na oprofilowaniu kadłuba i skrzydła (por. Rysunek 7.7.28 i Rysunek 7.7.26 na poprzedniej stronie). Zaletą jest prostszy schemat materiału B.Skin.Camouflage, bez węzłów opisanych na str. 436 (Rysunek 7.7.25).
Aby nie komplikować nadmiernie materiału prezentowanego w tej książce, zdecydowałem się na włączenie obrazu śrub do tekstury color.png (tak, jaki pokazuje Rysunek 7.7.28). To zachowuje schemat materiału B.Skin.Camouflage pokazany na str. 428. Ostatecznie te śruby na oprofilowaniu płata mogły ani razu nie odkręcane być przez cały czas używania samolotu (w odróżnieniu od śrub na okapotowaniu silnika). Z tego samego powodu — zachowania prostoty — włączyłem w źródłowy plik skin.xcf efekt tworzony przez warstwy Color-Weathering, Color-Saturate i Color-Whiter (por. str. 435). Zawartość Color-Weathering i Color-Saturate można by przecież zapisać do oddzielnych plików i użyć w Blenderze jako oddzielnych tekstur. Zamiast Color-Whiter można by było wtedy zastosować zwykły węzeł RGB z kolorem białym. Wtedy tym efektem mógłbyś sterować interaktywnie. Możesz tak zrobić w swoim modelu. Ja jednak w tym przykładzie wolę ograniczać liczbę użytych tekstur, aby schemat materiału był jak najbardziej czytelny.
Rysunek 7.7.29 przedstawia ostateczny efekt, uzyskany za pomocą skomponowanego w tej sekcji obrazu color.png:
Rysunek 7.7.29 Ogólny efekt zastosowania podstawowej tekstury barwy (color.png)
Samolot wygląda teraz na dość zużyty, nieprawdaż? Aby nie wydawał się zbyt ciemny, zwiększyłem ostatecznie intensywność tekstury barwy do wartości 0.2 (w węźle Hue Saturation Value, parametr Value — por. str. 429, 432, 436).
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-7.07.blend, a pliki ze zmienionymi teksturami — w folderze model\p40\textures\7.07\* (por. str. 22).
Zwróć uwagę że w pliku skin.xcf znajdują się teraz warstwy dwóch tekstur: odbić (opracowanej w poprzedniej sekcji) i barwy. Umieściłem je razem, gdyż powinny być dobrze „zsynchronizowane” (np. plamy brudu powinny być bardziej matowe). Aby ułatwić eksportowanie obrazu każdej z tych tekstur, połączyłem odpowiednie warstwy GIMP w grupy o nazwach Reflectivity i Color (szczegóły — patrz str. 625)
Plik z wyeksportowanymi z Blendera rozwinięciami UV (uv.svg) warto podzielić na warstwy, odpowiadające alternatywnym mapom UV w Blenderze (str. 425). Nadaj im takie same nazwy, jakie nadałeś UV Maps. Oprócz nich utwórz warstwę „wspólną” — dla wszystkich siatek, które nie mają alternatywnych rozwinięć;
Wyeksportowany obraz rozwinięć siatek (uv.png) można w Gimpie wykorzystać do szybkiego „zalania” (Bucket Fill) powierzchni samolotu podstawowymi barwami (str. 426 - 427);
Aby tekstura wykorzystała jakąś konkretną mapę UV w Blenderze, jako źródła współrzędnych UV należy użyć węzła Attribute (str. 428). Aby Blender użył domyślnych współrzędnych UV dla siatek, które nie maja rozwinięcia o nazwie wpisanej w tej węzeł, użyj węzła UV Fallback;
Silne światło słońca potrafi bardzo rozjaśnić teksturę (str. 428). Możesz ten efekt skompensować, zmniejszając intensywność jej barw (na przykład za pomocą węzła Hue Saturation Value — str. 429);
Ciekawy wzór drobnych, losowych zabrudzeń powierzchni modelu można uzyskać podstawiając fotografię betonowej powierzchni (str. 430);
Do malowania przetarć i złuszczeń farby przyda się pomocniczy obraz ze wzorem linii połączeń poszycia — lines.png (str. 431). Potem wystarczy do tego pliku dodać w Inkscape białe tło, i użyć powtórnie do efektu „wyblakłej powierzchni” (str. 434);
Kolorowe plamy od oleju i kurzu lądowiska umieściłem na odrębnej warstwie Color-Dirt (str. 433);
Dodatkowy efekt „zużycia” powierzchni modelu możesz uzyskać za pomocą dwóch warstw „rozjaśniających” (Color-Saturate, Color-Whiter). Dodatkowe zaciemnienia (czy właściwie — resztki oryginalnej barwy) wzdłuż szwów poszycia uzyskasz stosując bardzo rozmytą wersję lines.png (Color-Weathering), nałożoną w trybie Multiply (str. 435). Sterujesz efektem, zmieniając nieprzejrzystości tych trzech warstw w GIMP, oraz szorstkość powierzchni (Roughness) w Blenderze (str. 436);
Na koniec warto podkreślić (rozjaśnić) na teksturze barwy częściej używane śruby (np. na okapotowaniu silnika). Użyj w tym celu kopii warstwy Screws z pliku skin.svg (str. 436 - 437);
Odcieniem kamuflażu możesz sterować za pomocą parametrów Value i Saturation węzła Hue Saturation Value (str. 436, 438). Ma to duże znaczenie, bo np. kolor Olive Drab ulegał znacznym zmianom w trakcie eksploatacji samolotu (wietrzenie);
Ustaw w zestawie Render parametry Integrator:Clamp na wartość 2.0, by Cycles szybko i skutecznie eliminowało z renderu niepożądane „świetliki” (por. str. 1051). (Tak nazywam białe punkty, pojawiające się podczas próbkowania na połyskliwych powierzchniach, takich jak szklana osłona kabiny, oraz jej odbiciach na innych elementach modelu);
Pozostało jeszcze nałożyć na model „naklejki”: znaki rozpoznawcze, napisy eksploatacyjne. Te elementy mogły by być kolejnym komponentem obrazu color.png, używanego przez teksturę barwy (B.Skin.Camouflage). Niestety, tekstura barwy jest namalowana na domyślnym rozwinięciu płata — z linią podziału biegnącą poniżej krawędzi natarcia. Gdy nałożysz na tę siatkę zarys amerykańskiej (lub brytyjskiej) kokardy, okaże się że jej przednia część wystaje poza krawędź podziału (Rysunek 7.8.1a):
Rysunek 7.8.1 Przyczyna stworzenia mapowania UV Decals: wygodne naniesienie znaków rozpoznawczych
Jak pamiętasz, specjalnie tak podzieliliśmy płat, by linia szwu rozwinięcia UV nie wyróżniała się na renderze (por. str. 395). Tyle, że takie rozwinięcie nie jest najwygodniejsze do nanoszenia oznaczeń. Dlatego, zamiast umieszczać znaki rozpoznawcze i napisy w charakterze dodatku do kamuflażu, umieścimy je na oddzielnej teksturze. Przygotujemy dla niej odpowiednie rozwinięcie, podzielone wzdłuż krawędzi natarcia. (Rysunek 7.8.1b). Nadamy tej mapie UV nazwę Decals.
Właściwie to mapę Decals powinniśmy już stworzyć o wiele wcześniej — przed skopiowaniem siatki lewego skrzydła w skrzydło prawe (por. str. 395). Mielibyśmy wtedy jeden płat do rozwinięcia, a tak — tę samą pracę trzeba wykonać dla każdego skrzydła oddzielnie. Nie chciałem jednak wprowadzać tej mapy na wcześniejszym etapie prac, aby tekst książki był bardziej zrozumiały.
Zacznij standardowo — utwórz w siatce płata nowe rozwinięcie o nazwie Decals poprzez skopiowanie (por. str. 949) domyślnej mapy UVTex. Aby pozwolić krawędzi natarcia rozwinąć się w nowy kształt (Rysunek 7.8.1b), musisz na chwilę usunąć z niej dotychczasowe szwy (Rysunek 7.8.2a), i nanieść nowe (Rysunek 7.8.2b):
Rysunek 7.8.2 Zmiany szwów przy tworzeniu mapy Decals.
Gdy skończysz formować rozwinięcie z warstwy Decals, „przypnij” (Pin) jej wszystkie wierzchołki UV. Potem zaznacz powtórnie na siatce szwy, wykorzystywane przez UVTex. Gdyby ich nie było, przypadkowe naciśnięcie E (Unwrap) na rozwinięciu UVTex połączyłoby ze sobą to, co powinno pozostać rozdzielone. Tak więc brak szwów może szkodzić, a ich nadmiar — nie, o ile już masz wszystko uformowane i przypięte. Rysunek 7.8.2c) pokazuje ostateczny układ szwów wokół krawędzi natarcia płata. Jest to złożenie tego, czego potrzebują wszystkie mapy UV tej siatki.
Cała różnica pomiędzy rozwinięciem UVTex i Decals polega na „odklejeniu” części ścian krawędzi natarcia od górnej powierzchni płata, i „przyklejeniu” ich do dolnej (Rysunek 7.8.3a):
Rysunek 7.8.3 Problemy z rozwinięciem krawędzi prawego płata
Jeżeli siatka prawego płata ma tendencje do samoistnego „rozwijania” w złym kierunku (Rysunek 7.8.3b) , to prawdopodobnie jest umieszczona w obiekcie poddanemu transformacji o ujemną skalę. (Tak się realizuje w Blenderze symetryczne odbicie). Popraw zaraz skalę tego płata z ujemnej na dodatnią, wykonaj lustrzane odbicie jej siatki względem środka obiektu i przerzuć kierunki normalnych (Flip Normals). Dopóki można, nie stosuj nigdy ujemnej skali obiektów, bo to rodzi później różne kłopoty!
Drugą siatką, która powinna mieć także rozwinięcie o nazwie Decals, jest osłona chłodnicy cieczy. To po to, by w innych schematach malowania łatwo na nią nanieść słynne szczęki rekina (Rysunek 7.8.4):
Rysunek 7.8.4 Alternatywne rozwinięcia osłony chłodnicy (UVTex i Decals)
Chłodnica na mapie UV Decals jest „rozcięta” wzdłuż płaszczyzny symetrii, i ściśle dopasowana do sąsiednich elementów osłony silnika (Rysunek 7.8.4c).
Na koniec w prawym i lewym oprofilowaniu płata (siatki B.180.*.Wing Fillet) skopiuj rozwinięcie Color w nowe rozwinięcie Decals 1. Zawartość mapy UV Decals wyeksportuj z Blendera do pomocniczego pliku *.svg, i wczytaj do uv.svg jako nową warstwę o nazwie UV-Decals (Rysunek 7.8.5a):
Rysunek 7.8.5 Nowa warstwa w pliku uv.png, z rozwinięciami z mapy Decals
Następnie zapisz złożenie warstw UV-Decals i UV-Base (Rysunek 7.8.5b) do pomocniczego pliku uv-decals.png, który wykorzystamy jako referencję do rysowania nowej tekstury barwy.
Znaki rozpoznawcze i napisy przygotujemy w Inkscape, w nowym pliku o nazwie decals.svg. Dotychczasowy plik skin.svg był przeznaczony na elementy wspólne dla wszystkich tekstur, a oznaczenia do takich nie należą.
Rozpocznijmy od umieszczenia na odrębnej warstwie pliku decals.svg stworzonego przed chwilą obrazu z rozwinięciem warstwy Decals. Potem możesz zacząć rysować znaki rozpoznawcze. Jak pamiętasz, odwzorowujemy samolot z Pearl Harbor, więc rozpocznij od narysowania kokardy USAAC, używanej do wiosny 1942r (Rysunek 7.8.6a):
Rysunek 7.8.6 Przygotowanie w Inkscape znaków rozpoznawczych (decals.svg)
Narysuj białą pięcioramienną gwiazdę (na szczęście w Inkscape ma oddzielny tryb rysowania wieloboków i gwiazd — ). Ten element był w kolorze Insignia White (FS 37875), czyli miał niewielką domieszkę błękitu. Następnie umieść pod gwiazdą błękitne koło w kolorze Insignia Blue (FS 15044), a ponad gwiazdą — czerwony okrąg (Insignia Red — FS 11136). Całość złącz w grupę. Klony tej grupy rozmieść, dopasowując rozmiar, we właściwych miejscach siatek (Rysunek 7.8.6b). Rezultat, bez żadnego tła, wyeksportuj do pliku decals.png. Ten plik wykorzystamy w Blenderze do stworzenia nowej tekstury barwy.
Rysunek 7.8.7 przedstawia fragment schematu materiału B.Skin.Camouflage, w którym należy wprowadzić odpowiednie modyfikacje:
Rysunek 7.8.7 Włączenie tekstury decals.png do schematu materiału B.Skin.Camouflage
Nową teksturę należy nałożyć wykorzystując alternatywną mapę UV Decals. Stąd wstawiłem kolejne trzy węzły tego samego typu, które wykorzystaliśmy do mapowania podstawowej tekstury barwy. Są to:
Attribute: w tym przypadku węzeł odwołuje się do mapy UV o nazwie Decals;
UV Fallback: taki sam węzeł jak ten użyty w mapowaniu tekstury color.png (por. str. 428). Dla siatek, które nie zawierają rozwinięcia Decals podstawia ich domyślne współrzędne UV;
Image Texture: właściwy węzeł z pomocniczą teksturą barwy decals.png;
Obraz decals.png ma przejrzyste tło, dzięki czemu można go „nałożyć” na podstawową teksturę barwy wykorzystując wyjście Image Texture:Alpha 2. W poprzedniej sekcji nakładaliśmy tak obraz śrub (por. str. 436, Rysunek 7.7.25), używając węzłów Multiply i Color→Mix. Tutaj „obudowałem” te dwa węzły pomocniczą grupą, którą nazwałem Stack Image (bo służy do „nakładania” obrazów). (Więcej o Stack Image — por. str. 1065).
Rysunek 7.8.8 przedstawia pierwszy rendering z użyciem tekstury decals.png:
Rysunek 7.8.8 Kokardy USAAC, naniesione za pomocą tekstury decals.png
Na dolnej powierzchni płata, oprócz gwiazdy na prawym skrzydle, malowano także napis U.S. ARMY (Rysunek 7.8.9b):
Rysunek 7.8.9 Nanoszenie napisów — za pomocą odpowiedniej czcionki.
Z narysowaniem takich litery byłoby trochę roboty. Na szczęście znalazłem w Internecie (simmerpaintshop.com) czcionki o kroju szablonów używanych w USAAF (Rysunek 7.8.9a) . O tym, jak ich użyć — patrz str. 749.
Kolejny napis to duży, biały numer taktyczny (takie oznaczenia były stosowane wyłącznie na Hawajach w 1941r). Aby go widzieć podczas rysowania podstawiłem pod spodem rysunku szary prostokąt (Rysunek 7.8.10):
Rysunek 7.8.10 Napisy na kadłubie.
Takie numery taktyczne były malowane za pomocą szablonów, i miały charakterystyczne przerwy. W dodatku były w innych miejscach niż na USAAF_Stencil. Zdecydowałem się przekształcić numer „160” na ścieżkę (Path→Object to Path) i narysować na niej prostokąty, rozłożone tak, jak paski szablonu (Rysunek 7.8.11a):
Rysunek 7.8.11 Wykonanie mniejszych „prześwitów” na numerze taktycznym
Potem wystarczyło „odjąć” (Path→Difference) od obrysu „160” te prostokąty, by uzyskać podział cyfr o odpowiednim położeniu i rozmiarze (Rysunek 7.8.11b).
Rysunek 7.8.12a) pokazuje, jak się prezentują tak przygotowane napisy na renderingu:
Rysunek 7.8.12 Napisy z pomocniczej tekstury barwy decals.png
Gdy napisy i kokardy na obrazie decals.png były zupełnie nieprzejrzyste, raziła mnie na renderze zbyt czysta biel gwiazd i numerów taktycznych. Dlatego zwiększyłem o 10% przejrzystość tej tekstury (zmniejszając w węźle Stack Image parametr Opacity do wartości 0.9 — por. Rysunek 7.8.12b).
Z drugiej strony — na oświetlonych pod dużym kątem powierzchniach zanikają ciemne elementy oznaczeń, takie jak czarne napisu czy granatowe kokardy (Rysunek 7.8.13):
Rysunek 7.8.13 Wpływ położenia słońca na postać oznaczeń
Tekstura barwy zanikają na podświetlonej powierzchni (Rysunek 7.8.13b), gdyż w takich miejscach decydujący wpływ ma kolor Specular shadera Gloss Paint. Do tej pory w matowym materiale była to kolor szary. Teraz, aby podkreślić barwy tekstury na podświetlonych powierzchniach, nałóżmy ją na to szare tło (Rysunek 7.8.14):
Rysunek 7.8.14 Modulacja barwy Gloss Paint:Specular
Oryginalny kolor Specular umieściłem w nowym węźle RGB. Z węzła Multiply wyciągnąłem drugi “przewód” z teksturą barwy (przed zaciemnieniem). Połączyłem te dwie barwy węzłem Stack Image (Rysunek 7.8.14).
Rysunek 7.8.15 przedstawia uzyskany rezultat tej “modulacji” barwy połysku:
Rysunek 7.8.15 Wpływ modulacji barwy Gloss Paint:Specular
Łącząc dotychczasowy kolor Specular z teksturą barwy udało się poprawić kontrast barw na podświetlonych powierzchniach (Rysunek 7.8.15a). Jednak wydaje mi się, że w zwykłych warunkach oświetlenia nasz model stał się przez to bardziej „płaski” (Rysunek 7.8.15b). Dlatego zamiast nakładać całą teksturę barwy, proponuję ograniczyć zasięg tego efektu tylko do namalowanych na samolocie oznaczeń (Rysunek 7.8.16):
Rysunek 7.8.16 Selektywna modulacja barwy Gloss Paint:Specular
Podłączyłem nieprzejrzystość tekstury decals.png (Image Texture:Alpha) jako nieprzejrzystość obrazu nakładanego w węźle Stack Image (wejście Alpha). Rysunek 7.8.17 przedstawia uzyskany rezultat:
Rysunek 7.8.17 Efekt selektywnej modulacja barwy Gloss Paint:Specular
Wygląda na to, że ograniczenie obszaru modulacji barwy Gloss Paint:Specular do samych oznaczeń jest całkiem dobrym kompromisem. Kokardy i napisy na podświetlonych powierzchniach skrzydeł pozostają kontrastowe (Rysunek 7.8.17a), a jednocześnie nie psujemy wyglądu modelu w innych oświetleniach (Rysunek 7.8.17b). Intensywnością kontrastu tekstury decals.png możesz sterować za pomocą parametru Opacity węzła Stack Image, który łączy barwy Specular (por. str. 446, Rysunek 7.8.14).
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-7.08.blend, a pliki ze zmienionymi teksturami — w folderze model\p40\textures\7.08\* (por. str. 22).
Podsumowanie
Teksturę z oznaczeniami i napisami należy wydzielić z tekstury barwy, gdy wykorzystuje inne rozwinięcie UV siatek modelu (o nazwie Decals — str. 440);
Wszystkie alternatywne rozwinięcia UV najlepiej jest przygotować jak najwcześniej — jeszcze przed skopiowaniem siatek Blendera, „utrwalającym” drugą, symetryczną połowę samolotu. Unikniesz w ten sposób połowy pracy — bo np. wystarczy wykonać wszystkie alternatywne rozwinięcia dla jednego płata, a nie dla dwóch! (str. 440);
Znaki rozpoznawcze i napisy, składające się na obraz tekstury, najlepiej jest narysować w Inkscape (str. 442). Do odwzorowania napisów bardzo wygodne jest wykorzystanie odpowiedniej czcionki True Type — o ile uda Ci się ją gdzieś znaleźć (str. 444);
Przerwy na dużych literach i cyfrach, nanoszonych na samolot za pomocą szablonu, można uzyskać w Inkscape poprzez różnicę dwóch kształtów (str. 444);
Obraz oznaczeń — plik decals.png — włączamy w schemat materiału jako pomocniczą teksturę barwy (str. 443). Decals.png powinien mieć przejrzyste tło, aby można go było „nałożyć” na podstawowy obraz tekstury za pomocą węzła Stack Image.
Jeżeli rysunek oznaczeń zawiera jakieś drobne napisy, eksportuj go z Inkscape (File→Export Bitmap) z odpowiednio dużą rozdzielczością (np. 4096x4096px);
Na podświetlonych matowych powierzchniach shader Gloss Paint używa więcej koloru Specular, dlatego tekstura barwy gwałtownie zanika (por. str. 445). Dzieje się tak, gdy jest podłączona (moduluje) tylko kolorem Gloss Paint:Diffuse;
Kontrast oznaczeń, szczególnie na podświetlonych powierzchniach, można poprawić modulując selektywnie za pomocą tekstury barwy kolor Gloss Paint:Specular (str. 447);
Ostatnią „obowiązkową” teksturą jest tekstura otworów. W każdym samolocie jest ich mnóstwo. Obraz „dziur” w powłoce był już wcześniej narysowany w Inkscape (w pliku skin.svg — por. 401). Specjalnie stworzyliśmy dla nich oddzielną warstwę Holes (Rysunek 7.9.1):
Rysunek 7.9.1 Rysunek otworów (plik skin.svg, warstwa Holes) - eksportowany do pliku holes.png.
Dla przypomnienia, Rysunek 7.9.1a) pokazuje, gdzie w skin.svg znajduje się warstwa Holes, a Rysunek 7.9.1b) — co zawiera. Dla większej czytelności ilustracji dodałem do obrazu, jaki pokazuje Rysunek 7.9.1b), zarys rozwinięcia UV. Bez tego podkładu trudno byłoby się zorientować, jaki otwór odwzorowuje każdy z czarnych konturów. Do eksportu do pliku holes.png wykorzystaj jednak wyłącznie warstwę Holes i Bkg-White: mają to być ostre, czarne plamy na białym tle (Rysunek 7.9.1c). Nadaj temu obrazowi rozmiar 4096x4096px.
Dodaj obraz holes.png do schematu materiału B.Skin.Camouflage jako kolejny węzeł typu Image Texture. Ustaw go w tryb Non-Color Data i podłącz do współczynnika Fac węzła Mix Shader. W tym węźle łączymy dwa shadery (Rysunek 7.9.2):
Rysunek 7.9.2 Fragment schematu materiału B.Skin.Camouflage z dodaną teksturą holes.png
Jako pierwszy (górny) shader węzła Mix podłączam Transparent BSDF, w kolorze białym. To powierzchnia idealnie przejrzysta — bardziej niż szkło, bo nie ma ani odblasków, ani cienia. Ten shader jest wykorzystywany gdy współczynnik Mix Shader:Fac jest = 0, czyli tam, gdzie na teksturze holes.png znajdują się czarne (V = 0.0) obszary otworów. Jako drugi (dolny) shader węzła Mix podłączam dotychczas używany shader Gloss Paint. Jest używany w tych obszarach, dla których tekstura holes.png jest biała (V = 1.0).
Wejścia nowego węzła Image Texture nie podłączyłem do wyjścia żadnego z istniejących węzłów (Rysunek 7.9.2). Blender podstawia wtedy na wejściu Vector:Image Teksture domyślne współrzędne UV.
Zobacz sam, jaki efekty pozwala uzyskać taka prosta tekstura. Czy wiesz, jak trudno jest zamodelować bez dodatkowych deformacji1 taki okrągły otwór w kołpaku śmigła, jak ten, który pokazuje Rysunek 7.9.3a)? A używając tekstury uzyskujesz go niemal bez wysiłku2!
Rysunek 7.9.3 Efekty zastosowania tekstury otworów na powierzchniach zewnętrznych (w materiale B.Skin.Camouflage)
Musisz się bardzo zbliżyć do tego otworu, by na renderze zauważyć że nie jest zamodelowany w siatce! Zwróć także uwagę na jego krawędzie: pojawia się na nich odbłysk, jakby otwór był wycięty w powierzchni o jakiejś niewielkiej, ale widocznej grubości (Rysunek 7.9.3a). To rezultat zastosowania warstwy Holes w podstawowej teksturze nierówności (por. str. 406). Za pomocą tekstury holes.png można także wyciąć z powierzchni sterowych klapki trymerów (Rysunek 7.9.3b). Szczeliny pomiędzy taką klapką a resztą steru miały na P-40 szerokość rzędu centymetra, przez co były wyraźnie widoczna nawet z dużej odległości.
Otwór wycięty teksturą można dodatkowo „urealnić”, dodając do siatki wewnętrzne ściany (o ile takie istniały). W ten sposób stworzyłem wewnętrzne powierzchnie trymera i jego wnęki (Rysunek 7.9.4):
Rysunek 7.9.4 Dodanie wewnętrznych ścian szczelin wokół klapek trymera
Może to się wydać dziwne, ale w P-40 krawędzie natarcia trymerów nie były nawet zaokrąglone! Sprawdzałem to na zdjęciach — w rzeczywistości, tak jak w naszym modelu (por. Rysunek 7.9.4b), była to płaska ściana. Oczywiście, klapki trymera wycięte za pomocą tekstury mają jedną wadę: nie mogą się obracać. Ale wyglądają zupełnie tak samo, jak zamodelowane elementy. Trzeba się bardzo zbliżyć (por. Rysunek 7.9.4a i c) by dostrzec różnicę!
Zwróć uwagę, że nasza tekstura otworów jest nałożona na model według domyślnego mapowania UV. To bardzo rozrzutna metoda, bo przez nią otwory zajmują tylko ułamek procenta tekstury!
O wiele większą dokładność można uzyskać, przygotowując dla otworów alternatywną mapę UV, która pozwoliłaby im efektywnie wypełnić obraz. Możesz w ten sposób uzyskać o wiele większą dokładność odwzorowania krawędzi!
Aby uprościć schemat materiału B.Skin.Camouflage, proponuję stworzyć z węzłów Transparent BSDF, Mix Shader i Material Output nową grupę (Rysunek 7.9.5):
Rysunek 7.9.5 Stworzenie węzła wyjściowego Surface Output
Nazwijmy ją Surface Output, bo będzie mogła występować w miejsce dotychczas używanego węzła Material Output. To węzeł końcowy materiału, więc nie ma żadnego wyjścia. Proponuję, aby udostępniał trzy wejścia, których używamy w tym modelu:
Surface: to dotychczasowe Material Output:Surface. Do tego wejścia podłączamy shader;
Displacement: to także “wyciągnięte” wejście z Material Output. Do tego wejścia podłączamy teksturę nierówności;
Opacity: to nowy rodzaj wejścia, typu Value. Możesz pozostawić je na domyślnej wartości (1.0) lub podłączyć teksturę otworów;
Zwróć uwagę, że węzeł Surface Output nie udostępnia wejścia na shader typu Volume. Przyczyna jest prosta: w tym modelu nigdy z niego nie skorzystamy.
Zmodyfikujmy także materiał powierzchni wewnętrznych (B.Skin.Inner — Rysunek 7.9.6):
W porównaniu z materiałem B.Skin.Camouflage, ten materiał ma na razie bardzo prosty schemat. Zastąpiłem używany w nim do tej pory węzeł Material Output węzłem Surface Output. Podłączyłem do niego dotychczas używany shader Gloss Paint oraz nowo dodaną teksturę holes.png.
W materiale B.Skin.Inner nie wykorzystujemy żadnych tekstur nierówności — dlatego do wejścia Surface Output:Displacement nie jest podłączona żadna tekstura.
Rysunek 7.9.7 przedstawia rezultat zastosowania tekstury otworów w materiale powierzchni wewnętrznych:
Rysunek 7.9.7 Rezultat zastosowania tekstury otworów w materiale B.Skin.Inner
Zazwyczaj te fragmenty samolotu kryją się w cieniu. Abyś mógł je lepiej ocenić, przesunąłem słońce (obiekt Sun) na spód samolotu, oraz odchyliłem klapę o 90º (konstrukcja P-40 pozwalała je wychylić tylko pod kątem 45º). Uważam, że tekstura holes.png przekonująco odwzorowała wszystkie konstrukcyjne otwory ulżeniowe, umieszczone w dźwigarach, żebrach, i innych elementach struktury płatowca. Te miejsca nie są nigdy wyeksponowane, więc nie stosuję tu tekstury nierówności.
Wydaje mi się natomiast, że faktura B.Skin.Inner jest trochę zbyt jednolita. Zwróć uwagę chociażby na odblask na dźwigarze klapy (Rysunek 7.9.7). Proponuję dodać do schematu materiału proceduralną teksturę „szumu” (Noise Texture — por. str. 1029). Podłączmy ją tak, jak teksturę odbić (Rysunek 7.9.8):
Rysunek 7.9.8 Dodanie losowych zabrudzeń i innych nieregularności do materiału B.Skin.Inner.
Zaroiło się na schemacie od węzłów, prawda? Ale to po prostu kopia schematu połączenia tekstury odbić dla materiału matowego, jaką wypracowaliśmy w sekcji 7.6 (por. str. 423). Tyle, że zamiast dwóch różnych węzłów Image Texture używamy tu jednej tekstury proceduralnej (Noise Texture). Z innych uproszczeń — obraz odbić jest tu jednocześnie podłączony do wejścia Gloss Paint:Specular. Odpowiednie wartości barwy w węźle RGB oraz Min lub Max w węzłach sterujących zostały skopiowane z ustawień shadera Gloss Paint (por. Rysunek 7.9.8 i Rysunek 7.9.6) Zwróć także uwagę, że tekstura „szumu” jest nałożona na model według współrzędnych Texture Coordinate:Generated, a nie UV. (Taka tekstura nie wymaga precyzyjnego mapowania).
Rysunek 7.9.9 przedstawia próbny render materiału B.Skin.Inner z „proceduralnymi zabrudzeniami”:
Rysunek 7.9.9 Materiał B.Skin.Inner w wersji „pobrudzonej”
Teraz barwa powierzchni wewnętrznych nie jest już zupełnie jednolita. Wydaje mi się, że tak jak odblask światła słońca na dźwigarze klapy (por. z Rysunek 7.9.7), wygląda przez to trochę realniej.
Przyglądając się na podglądzie renderu innym szczegółom modelu, z zaskoczeniem zauważyłem zniknięcie osi sterów (Rysunek 7.9.10b):
Rysunek 7.9.10 Tajemnicze zniknięcie(?) osi sterów
Nim dołączyliśmy do materiału B.Skin.Inner teksturę otworów, fragmenty osi były widoczne w otworze wziernikowym (Rysunek 7.9.10a). Teraz ich tam nie ma, choć w modelu są. Czary, czy co?
Nie to tylko efekt uboczny zastosowania tekstury otworów. Te osie nie mają żadnej mapy UV (Rysunek 7.9.11). Po prostu nie rozwijaliśmy ich powierzchni, bo nie było to potrzebne. Dla takich powierzchni węzeł Image Texture podstawia kolor czarny — niezależnie od przypisanego obrazu. A kolor czarny w przypadku tekstury otworów oznacza zupełną przejrzystość — więc te osie tam są, ale ich nie widać!
Jak rozwiązać ten problem? Materiał B.Skin.Inner będziemy przypisywać do wielu drobnych detali samolotu. Nie zamierzam wszystkich tych części rozwijać w UV, bo nie będą miały żadnych otworów nanoszonych teksturą. Pozostaje stworzyć dwie wersje materiału B.Skin.Inner. Wersja podstawowa nie będzie miała tekstury otworów. Będziemy ją przypisywać wszystkim drobnym częściom. Wersja dodatkowa — nazwijmy ją B.Skin.Inner+Holes — będzie miała dołączoną teksturę otworów. Przypiszemy ją tylko tym siatkom, na których takie otwory namalowaliśmy. Na szczęście tekstura zabrudzeń — Noise Image — nie wykorzystuje współrzędnych UV, tylko Texture Coordinate:Generated (por. str. 452). Oznacza to, że ten efekt można wykorzystać w obydwu materiałach.
Obydwa materiały powinny różnić się wyłącznie teksturą otworów. Jeżeli obydwa materiały będą miały własne kopie tego samego zestawu węzłów — możesz czasami coś przestawić w jednym, i zapomnieć zrobić to samo w drugim. Lepszym rozwiązaniem jest stworzyć specyficzną grupę, którą wykorzystamy w obydwu materiałach. Nazwijmy ją od barwy, którą zwraca X.Curtiss Green (Rysunek 7.9.12):
Rysunek 7.9.12 Stworzenie pomocniczej grupy X.Curtiss Green
(Przedrostek „X” dodałem po to, by odróżnić ją od pozostałych, „ogólnych” grup węzłów). Od tej pory barwą powierzchni zewnętrznych będziemy sterować zmieniając ustawienia we wnętrzu grupy X.Curtiss Green. Rysunek 7.9.13 przedstawia zmienione schematy obydwu materiałów powierzchni wewnętrznych:
Rysunek 7.9.13 Dwie wersje materiału powierzchni wewnętrznych, oparte o grupę X.Curtiss Green
Jak już się chyba zorientowałeś, w Cycles możesz podłączyć teksturę do każdego wejścia (parametru) dowolnego węzła. Wykorzystamy ją teraz do skorygowania pewnego szczegółu, który drażni mnie w naszym renderze: zbyt głębokich cieni we wlotach powietrza na masce silnika (Rysunek 7.9.14a):
Rysunek 7.9.14 Wpływ jasności tekstury barwy na cienie
Uważam, że cienie, jakie uzyskujemy na renderze w tych miejscach są zbyt intensywne. Przyczyną jest poważne zmniejszenie jasności całej tekstury w węźle HSV — do 20% (por. str. 429) . Gdyby nie ta korekta, wloty wyglądałyby poprawnie (Rysunek 7.9.14b), czego jednak nie można powiedzieć o reszcie samolotu. Używając pomocniczej tekstury podłączonej do HSV:Value, możemy rozjaśnić wnętrza wlotów i jednocześnie zachować intensywność 20% na pozostałych powierzchniach. Narysowałem odpowiedni rysunek w Inkscape, wyeksportowałem go do pliku col_intensity.png, który potem trochę poprawiłem w Gimpie (Rysunek 7.9.15):
Rysunek 7.9.15 Obraz, modulujący przyciemnienie tekstury barwy (col_intensity.png)
Tę niewielką teksturę (1024x1024) podłączyłem w schemacie materiału do HSV:Value (Rysunek 7.9.16):
Rysunek 7.9.16 Sterowanie intensywnością barw B.Skin.Camouflage za pomocą tekstury
Po modyfikacji schematu materiału B.Skin.Camouflage, którą przedstawia Rysunek 7.9.16, intensywnością całej powierzchni samolotu steruje powiązany z col_intensity.png węzeł Range From Min. Jego parametr Min determinuje ogólną jasność barw (nadal 20% oryginalnej), a Range pozwala sterować jasnością wlotów powietrza (Rysunek 7.9.17):
Rysunek 7.9.17 Sterowanie cieniem we wlotach powietrza
Zwróć uwagę, że rozjaśnienia na teksturze col_intensity.png mają rozmyte krawędzie a krawędź chłodnicy cieczy jest ciemniejsza od jej wnętrza (Rysunek 7.9.15b). Wszystko to ma na celu płynne przejście pomiędzy obszarami o większej i mniejszej intensywności, by nie raziły na renderze. Z tego samego powodu naniosłem w jednym miejscu tego obrazu dodatkowe rozmycia w GIMP (Rysunek 7.9.15c).
Ostatecznie rozjaśnienie cieni uzyskane dla Range = 1.0 (Rysunek 7.9.17c) wydaje mi się zbyt mocne, a dla Range = 0.2 — zbyt słabe. Właściwy kompromis leży chyba gdzieś w okolicach Range = 0.7 (Rysunek 7.9.17b). Taką wartość pozostawię w schemacie B.Skin.Camouflage (Rysunek 7.9.18):
Rysunek 7.9.18 Model po poprawkach
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-7.09.blend, a pliki ze zmienionymi teksturami — w folderze model\p40\textures\7.09\* (por. str. 22).
W tej sekcji poznałeś dodatkowe narzędzie modelarskie: teksturę przejrzystości (str. 450). Pozwala tworzyć w powierzchni modelu różne otwory w prosty sposób, bez deformacji i komplikacji siatki. Dla tej tekstury można nawet przygotować dedykowane rozwinięcie UV (nie zrobiliśmy tego w tym modelu). Uzyskasz wówczas szybko i łatwo tak samo dokładne rezultaty jak w wyniku pracochłonnego modelowania (por. np. str. 212);
Aby uzyskać efekt „grubości blachy” na krawędzi otworów wyciętych za pomocą tekstury przejrzystości, umieść ich obraz także na teksturze nierówności (str. 450);
Kiedy modelować otwory w siatce a kiedy tworzyć je za pomocą tekstury otworów? To w dużej mierze zależy od przeznaczenia modelu, który wykonujesz. Jeżeli zamierzasz użyć go tylko do stworzenia serii ilustracji (np. dla jakiejś monografii samolotu) — wykonaj jak najwięcej otworów za pomocą tekstur. Oszczędzisz w ten sposób czas, a siatki Twojego modelu będą łatwiejsze do modyfikacji i rozwinięcia UV. Jeżeli jednak tworzysz model dla różnych zastosowań, to przyjmij inne założenie. Na przykład silniki gier nie będą miały specjalnego problemu z większą liczbą ścian, ale mogą nie obsługiwać tekstur przejrzystości. Dlatego wszystkie ważniejsze szczegóły, jak wycięcia na rury wydechowe, należy wtedy zamodelować „w siatce”. W tym przypadku tekstura służy do odwzorowania tych niewielkich otworów, które w grze mogą się stać czarnymi plamami. Nasz model P-40 jest takim modelem „ogólnego zastosowania”;
Aby uprościć schematy, stworzyliśmy i wykorzystaliśmy w materiałach nowy węzeł wyjściowy: Surface Output (str. 451). Ta grupa węzłów posiada, oprócz wejść dla shadera i tekstury nierówności, nowe wejście o nazwie Opacity. Można do niego podłączać teksturę otworów;
Jeżeli siatka obiektu nie ma rozwinięcia UV, to po zastosowaniu tekstury przejrzystości staje się zupełnie niewidoczna (str. 453). Aby uniknąć takich zaskoczeń, stworzyliśmy drugą wersję materiału powierzchni wewnętrznych (B.Skin.Inner), z teksturą przejrzystości. Nadaliśmy mu nazwę B.Skin.Inner+Holes (str. 454);
Aby łatwo zachować spójność pomiędzy obydwoma wersjami materiału B.Skin.Inner, połączyliśmy prawie wszystkie jego węzły w jedną grupę (X.Curtiss Green — str. 454). Potem ta grupa jest wykorzystana w każdym z materiałów. Od tej chwili, aby zmienić barwę powierzchni wewnętrznych, wystarczy wejść na jednym ze schematów do wnętrza grupy X.Curtiss Green i dokonać odpowiednich modyfikacji. Dokonane zmiany będą dotyczyć także drugiego materiału, bo używa tej samej grupy;
W Cycles możesz podłączyć teksturę niemal do każdego parametru węzła (a dokładniej: do każdego wejścia typu Value, Color, a nawet — jeżeli wiesz, co robisz — typu Vector). Wykorzystaliśmy tę właściwość rozjaśniając za pomocą niewielkiej tekstury zbyt głębokie cienie w pewnych miejscach modelu (str. 455 - 456);
W tej sekcji pokażę, jak przekształcić proste malowanie samolotów USAAC z Hawajów (por. sekcje 7.7, 7.8 — str. 425 i następne) w zupełnie inny, bardziej złożony kamuflaż. Przygotujemy tu tekstury dla samolotu, na którym latał w AVG flight leader William Reed, z dywizjonu „Hell’s Angels” . Posłużę się tu doskonałym opracowaniem barw tej maszyny, autorstwa Janusza Światłonia (z publikacji [6] ).
Pracę rozpoczynam od zeskanowania schematu malowania. Następnie „tnę go na kawałki”, które dopasowuję do rozwinięcia UV modelu (Rysunek 7.10.1):
Rysunek 7.10.1 Przeniesienie schematu malowania na rozwinięcie siatek samolotu
Dopasowanie wyciętych fragmentów wykonuję w Inkscape, gdyż najłatwiej w nim obracać i skalować obrazy. Rezultat posłuży nam jako pomoc przy malowaniu plam kamuflażu i nanoszeniu oznaczeń. Nie trzeba przenosić tu wszystkich szczegółów schematu. Pominąłem np. ster kierunku, bo byłoby z nim dużo roboty, podobnie jak z prawą stroną statecznika pionowego. Ten obraz ma z grubsza sygnalizować układ plam maskowania. Przeniosłem więc tylko górne powierzchni skrzydeł. Nie „naciągam” też na siłę rzutów z boku kadłuba na jego rozwinięcie. Wystarczy, by pasowały do środkowej części siatek (Rysunek 7.10.1b). Rezultat wczytuję do Gimpa (pliku skin.xcf) jako osobną warstwę o nazwie reference.png (Rysunek 7.10.2a). Przyda się za chwilę.
Teraz zmienimy w GIMP barwy ogólne. Zaznacz (Select→By Color) obszary zamalowane na warstwie Color-LCamouflage barwą Neutral Grey. Zamaluj to zaznaczenie kolorem Sky RAF-u (Rysunek 7.10.2b,c):
Rysunek 7.10.2 Zmiana barwy dolnych powierzchni z Neutral Grey na Sky (warstwa Color-LCamouflage)
W istocie to był substytut brytyjskiej farby Sky, używany w latach czterdziestych przez producentów z USA: lakier DuPont 71-021. Symbol ten jest „ogólnie znany” i powtarzany przez wiele źródeł, ale mimo to trudno jest zdeterminować, jaką miał właściwie barwę. W doborze skorzystałem z sugestii Rato Marczaka, opublikowanych w artykule na ten temat (na www.ratomodeling.com ).
Rysunek 7.10.3 Zmiana barwy górnych powierzchni z Olive Drab na Dark Earth (warstwa Color-UCamouflage)
W analogiczny sposób zamieniłem na górnych powierzchniach samolotu (warstwie Color-UCamouflage) barwę Olive Drab USAAC na Dark Earth RAF (DuPont 71-009 — Rysunek 7.10.3).
Następnie zmieniłem nazwę tej warstwy na Color-BrownCamouflage. Dodałem ponad nią przejrzystą warstwę Color-GreenCamouflage (Rysunek 7.10.5a). Namalujemy na niej, w oparciu o schemat, plamy kamuflażu w kolorze Dark Green (DuPont 71-013) .
Popatrz na Rysunek 7.10.4. To zdjęcie z hali produkcyjnej P-40. Robotnicy nanosili kamuflaż, posługując się gumowymi wzorcami. W rezultacie na pomalowanych przez zakłady Curtiss samolotach granice kolorów były ostre i wyraźne. Aby uzyskać zbliżony efekt w GIMP, nie maluj ich aerografem, tylko pędzlem (Brush) — o kształcie koła (Rysunek 7.10.5b):
Rysunek 7.10.5 Nanoszenie plam kamuflażu (Dark Green) na warstwę Color-GreenCamouflage
Plamy kamuflażu namalowane w GIMP będą zawsze zawierały jakieś błędy. Są najczęściej niedopasowane wzdłuż któregoś ze szwów siatek, lub na granicy obiektów. Koniecznie musisz nałożyć ich obraz na model, aby to sprawdzić. Zapisz zawartość warstwy z plamami do pomocniczego pliku (np. camouflage.png). Potem wskaż ten plik Blenderowi (w UV/Image Editor) jako nową zawartość obrazu Test. Włącz jeszcze w oknie 3D View tryb wyświetlania tekstur (Textured Solid), i już możesz korygować kamuflaż bezpośrednio na powierzchni modelu (Rysunek 7.10.6):
Rysunek 7.10.6 Poprawianie plam kamuflażu — poprzez bezpośrednie malowanie na modelu
W Gimpie warstwa z plamami kamuflażu (Color-GreenCamouflage) miała przejrzyste tło. Gdy za pierwszym razem wyświetlisz ten obraz w Blenderze, przejrzyste obszary będą czarne. Musisz choć raz zaznaczyć każdą część modelu, by tło obrazu stało się białe. Więcej o malowaniu w 3D oraz imporcie zmian wprowadzonych w Blenderze do GIMP znajdziesz na str. 1134 i następnych (opis tego przypadku zaczyna się od strony 1140).
Samoloty AVG wyglądają na bardziej „chropowate” i zużyte od swoich odpowiedników z Pearl Harbor. Rysunek 7.10.7 przedstawia inną maszynę z tego samego dywizjonu („Hell’s Angels”):
Rysunek 7.10.7 Inny egzemplarz P-40 z tego samego dywizjonu — maszyna Charlesa Oldera ( www.ratomodeling.com )
Zwróć uwagę chociażby na zacieki za kabiną pilota. Podobne występowały także na naszej „białej 75”. (To chyba ślady po tankowaniach). Z kolei maszyna na schemacie Janusza Światłonia nie ma naklejonego żółtego, disneyowskiego tygrysa. Być może tak ten samolot wyglądał przed wizytą dziennikarzy, którzy je przywieźli.
Aby odwzorować zabrudzenia i wytarcia widoczne na zdjęciu, musimy zintensyfikować efekty na warstwach *Chips i *Dirt w pliku skin.xcf (Rysunek 7.10.8):
Rysunek 7.10.8 Odpowiednio „zabrudzone” tekstury barwy (warstwy Color*) i odbicia (warstwy Ref*)
Te warstwy wchodzą w skład obrazów tekstury barwy (color.png) i odbicia (ref_dirt.png). Dodaj przetarcia i odpryski farby wzdłuż krawędzi natarcia skrzydeł i stateczników, oraz „wydeptaj” wyraźniejszą ścieżkę u nasady skrzydła. W bezpośrednim sąsiedztwie rur wydechowych nanieś białe „przepalenia”. Dalej powinny przechodzić w czarny nalot (sadzy?), noszący ślady wielokrotnych prób zmywania i czyszczenia.
Ciekawym elementem tego obrazu zanieczyszczeń są zacieki, widoczne na wszystkich maszynach „Hells Angels” za kabiną pilota1. Wydzieliłem dla tego efektu odrębne warstwy *Leaks (po jednej dla tekstury koloru i odbić). Rysunek 7.10.9) przedstawia szczegóły warstwy Ref-Leaks, jednego z komponentów pliku ref.png:
Rysunek 7.10.9 Szczegóły zacieków za kabiną pilota (ref.png)
Do namalowania zacieków nie używałem żadnego specjalnego narzędzia. Wystarczyło poprowadzić kilka linii różnymi średnicami standardowego pędzla GIMP („kółka”). Malowałem je „z natury”, na podstawie jedynego zdjęcia fragmentu „białej 75”, jakie posiadam. Zaobserwowałem, że zacieki mają tendencję do rozlewania się i łączenia na krawędziach paneli poszycia. To nadaje im realistyczny wygląd (Rysunek 7.10.9b).
Pora na próbny rendering, aby sprawdzić skuteczność naszych wysiłków nad kamuflażem (Rysunek 7.10.10a):
Rysunek 7.10.10 Próbny render modelu
Zastosowałem tu ten sam schemat materiału B.Skin.Camouflage, co w poprzedniej sekcji, odłączając tylko teksturę decals.png, którą przygotujemy za chwilę. Zmniejszyłem intensywność tekstury col_intensity.png do 0.3, bo ten samolot miał jaśniejszy spód. Jednocześnie zwiększyłem za to intensywność słońca (Sun) do 25.
Na górnej powierzchni płatów „białej 75” znajdował się zaskakujący element — zapomniane kokardy RAF, których chyba nikomu nie chciało się zamalować (Rysunek 7.10.11):
Rysunek 7.10.11 „Zapomniane” znaki rozpoznawcze
Narysowałem je w Inkscape, ale dodałem jako oddzielną warstwę do skin.xcf, by były porządnie pokryte brudem i zadrapaniami. (W odróżnieniu od pozostałych oznaczeń, na pewno nikt ich nie konserwował). Inne znaki rozpoznawcze i godła przygotowałem w pliku decals.svg (Rysunek 7.10.12), z którego eksportuję plik decals.png:
Rysunek 7.10.12 Oznaczenia w pliku decals.svg (na tej ilustracji dodałem szare tło, by widać było białe elementy)
Zwróć uwagę, że użyłem teraz innego rozwinięcie UV powierzchni kadłuba przed kabiną (por. str. 462, Rysunek 7.10.12 i str. 390, Rysunek 7.3.21). To alternatywna mapa UV Decals, którą dodałem do siatki kadłuba aby sylwetki „aniołków” poprawnie ułożyły się na modelu.
Rysunek 7.10.13 przedstawia próbny render ze zmienioną teksturą color.png i uzupełnioną teksturą decals.png:
Rysunek 7.10.13 Model po dodaniu tekstury z oznaczeniami
Wydaje mi się, że barwy oznaczeń — „aniołków”, numerów taktycznych czy paszczy rekina — są zbyt żywe i przez to nie pasują do reszty powierzchni samolotu. Oznacza to, że musimy nieco stonować teksturę decals.png. Zrobimy to za pomocą dodatkowego węzła HSV (Hue Saturation Value), wstawionego bezpośrednio za jej węzłem Texture Image (Rysunek 7.10.14):
Rysunek 7.10.14 Zmniejszenie intensywności tekstury decals.png
Rysunek 7.10.15 przedstawia próbny render po zmniejszeniu kontrastu tekstury z oznaczeniami (decals.png):
Rysunek 7.10.15 Model po zmniejszeniu kontrastu tekstury z oznaczeniami
Jeżeli przyjrzysz się fragmentowi schematu materiału, pokazywanego przez Rysunek 7.10.14, zapewne zauważysz że nie ma na nim tekstury sterującej jasnością powierzchni (col_intensity.png — por. str. 455). Chciałem w ten sposób sprawdzić, czy dla jaśniejszego odcienia dolnych powierzchni, użytego w tym „brytyjskim” kamuflażu, ten element w ogóle jest potrzebny. Konkluzja? Tekstura col_intenisty.png jest nadal potrzebna, choć należy ją stosować z mniejszą intensywnością: Range = 0.3 (Rysunek 7.10.16):
Rysunek 7.10.16 Efekt sterowania jasnością powierzchni za pomocą tekstury col_intensity.png
(W poprzedniej sekcji, dla ciemniejszego kamuflażu USAAC, stosowaliśmy w tym miejscu Range = 0.7 — por. str. 456, Rysunek 7.9.17)
Na zakończenie myślę że warto wspomnieć o wpływie intensywności barwy Gloss Paint:Specular na wygląd modelu. Jak pamiętasz, “wyciągnęliśmy” ten stały kolor do oddzielnego węzła RGB, aby “zmieszać” go z insygniami z tekstury decals.png (por. str. 446, 447). Ta lokalna modulacja jest niemal bez znaczenia dla wpływu wartości ustalanej w węźle RGB na barwę odblasku słońca na powierzchni samolotu (Rysunek 7.10.17).
Rysunek 7.10.18a) przedstawia testowy render modelu w którym zmniejszono intensywność podstawowej barwy Specular do 0.15:
Rysunek 7.10.18 Wpływ intensywności barwy Gloss Paint:Specular na wygląd modelu
Rysunek 7.10.18b) przedstawia ten sam model z bardziej intensywną barwą odblasków (Specular = 0.25).
Uważam że powierzchnia modelu przedstawianego przez Rysunek 7.10.18a) wydaje się zbyt “płaska”. Co prawda grzbiet skrzydeł i usterzenia jest chyba bardziej przekonujący w tym przypadku niż w przedstawionym przez Rysunek 7.10.18b). Sądzę, że ogólne wrażenie wypada jednak na korzyść przypadku b): jaśniejsze odblaski słońca podkreślają bryłę samolotu. Sprawiają także, że model lepiej komponuje się z tłem. Oczywiście, nie należy z tym efektem przesadzać: dla powierzchni matowych intensywność odbitego światła może się wahać od 0.15 do 0.352.
Ostatecznie zdecydowałem się zastosować w tej scenie kolor odblasków o intensywności = 0.25, gdyż przy tym ustawieniu powierzchnia samolotu wygląda podobnie jak na historycznych zdjęciach. Rysunek 7.10.19 przedstawia model w gotowym malowaniu, podstawiony na jedno ze znanych zdjęć R. T. Smitha z maja 1942r:
Rysunek 7.10.19 Rezultat: P-40 w kamuflażu AVG (zdjęcie: en.wikipedia.org)
Cienie i intensywności barw są właściwie zgodne. Doszedłem do wniosku, że zielone plamy kamuflażu miały inny odcień (czysta ciemna zieleń). Zmodyfikowałem je we wzorcu skin.xcf (por. str. 458, Rysunek 7.10.2) i powtórnie wygenerowałem teksturę color.png. Nie udało mi się jednak dopasować barw modelu do tego historycznego zdjęcia. Kadłuby tych samolotów są ciemniejsze, bo na kliszy utrwaliły się głębokie cienie. Może to jakaś niedoskonałość aparatu lub kliszy? Amatorska fotografia kolorowa wtedy dopiero raczkowała…
Rysunek 7.10.20 przedstawia ten sam model, ale widziany z prawej strony. Na tej scenie umieściłem słońce z tyłu ponad samolotem — w ten sposób podświetla nierówności na skrzydłach i stateczniku poziomym:
Rysunek 7.10.20 Ten sam model, widziany z prawej strony (inne tło i położenie słońca)
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-7.10.blend, a pliki ze zmienionymi teksturami — w folderze model\p40\textures\7.10\* (por. str. 22).
Podsumowanie
Zmiana kamuflażu samolotu sprowadza się do modyfikacji tylko trzech obrazów jego tekstur. Są to, przede wszystkim: color.png i decals.png. Jeżeli nowy kamuflaż wymaga poważnych zmian w „zabrudzeniu” modelu, trzeba także nieco zmienić obraz ref_dirt.png;
Zmiany dotyczące pliku color.png wprowadzasz w GIMP, w pliku skin.xcf, na warstwach Color-UCamouflage i Color-LCamouflage. Zmiana polega na zaznaczeniu dotychczasowego koloru (By Color) i zamalowaniu zaznaczenia nowym (str. 458);
Plamy kamuflażu nanosisz w skin.xcf na oddzielnej warstwie (str. 459). Gdy je namalujesz, koniecznie sprawdź czy dobrze się „układają” wzdłuż szwów modelu!
Aby sprawdzić poprawność plam kamuflażu, należy wkopiować na chwilę ich warstwę z GIMP i podstawić jako obraz tekstury w Blenderze. Tryb Texture Paint Blendera umożliwia wygodne malowanie poprawek bezpośrednio na powierzchni modelu (str. 460). Poprawiony obraz przenosimy z powrotem do Gimpa.
Barwy tekstury decals.png mogą wymagać indywidualnej korekty (za pomocą dodatkowego węzła HSV — por. str. 463);
Intensywność pomocniczej tekstury col_intensity.png należy dobrać indywidualnie do każdego ustawienia modelu i oświetlenia (por. 464);
Barwa Specular ma duży wpływ na intensywność odblasków słońca na powierzchni modelu. Warto zawsze sprawdzić, czy drobna zmiana tego koloru nie poprawi integracji modelu z tłem (str. 465). W razie czego możesz także spróbować „zmieszać” podstawową barwę Specular (z węzła RGB) z teksturą barwy. (W tej chwili steruje tym „mieszaniem” oryginalny kanał Alpha tekstury decals.png. Można tę „nitkę” przeprowadzić przez dodatkowy węzeł Moderate, o wartości Range < 1.0);
Uff! W tym rozdziale żonglowaliśmy plikami obrazów, wstawiając je na różne warstwy w Inkscape lub Gimpie. Abyś się w tym nie pogubił, na koniec przedstawiam ogólny obraz tego procesu. Możesz na nim sprawdzić, skąd pochodzi konkretna tekstura i jak ją otrzymać (Rysunek 7.11.1):
Rysunek 7.11.1 Schemat generowania obrazów podstawowych tekstur dla zewnętrznych powierzchni modelu P- 40
Materiał, który stworzyliśmy (B.Skin.Camouflage) wymaga przygotowania co najmniej siedmiu plików: holes.png, color.png, ref_details.png, ref_dirt.png, nor_details.png, nor_blur.png, decals.png. Umieściłem je na schemacie po prawej. Po lewej podałem warstwy w plikach Inkscape i GIMP, z których pochodzą.
Większa część obrazów używanych przez Blender pochodzi bezpośrednio z dwóch plików Inkscape:
holes.png: to wyeksportowane z pliku skin.svg warstwy Holes + BkgWhite;
nor_details.png: to wyeksportowane z pliku skin.svg warstwy Result:Nor-Details + BkgGrey;
nor_blur.png: to wyeksportowane z pliku skin.svg warstwy Result:Nor-Blur + BkgWhite;
ref_details.png: to wyeksportowane z pliku skin.svg warstwy Result:Ref* + BkgWhite;
decals.png: to wyeksportowane z pliku decals.svg warstwy Color-Insingnia + Color-Technical (bez żadnego tła);
Dotyczy to także wszelkich tekstur pomocniczych (nie narysowałem ich na poprzedniej stronie, by nie komplikować schematu). W tym rozdziale używaliśmy jednej takiej tekstury:
col_intensity.png: to wyeksportowane z pliku decals.svg warstwy Intensity + Bkg-Black (służy do lokalnego rozjaśnienia powierzchni — por. str. 455);
Jej użycie zależy od oświetlenia konkretnej sceny i zastosowanego zmniejszenia intensywności tekstur barw. Czasami nie jest w ogóle potrzebna.
Oprócz tego z pliku Inkscape skin.svg eksportowane są dwa obrazy „do dalszej obróbki” w GIMP:
screws.png: to wyeksportowana z pliku skin.svg warstwa Screws, bez żadnego tła. Ten obraz można opcjonalnie wstawić do skin.xcf jako warstwę Color-screws.png. Służy do rozjaśnienia łbów śrub na teksturze barwy;
lines.png: to wyeksportowane z pliku skin.svg warstwy Lines, Contours, Holes, Bumps, Cover, Shadows, BkgWhite. Wstawiony do skin.xcf jako referencyjna warstwa UV-Lines.png, oraz, po “rozmyciu”, jako warstwa Color-Weathering służąca do uzyskania teksturze barwy efektu “zużycia” (str. 431, 434)
Ostatecznie, z pliku Gimpa uzyskujemy obrazy dwóch istotnych tekstur:
ref_dirt.png: to wyeksportowane ze skin.xcf złożenie wszystkich warstw o przedrostku Ref*;
color.png: to wyeksportowane ze skin.xcf złożenie wszystkich warstw o przedrostku Color*;
Podczas prac nad detalami samolotu na pewno będzie trzeba uzupełnić teksturę poszycia o jakieś śruby, nity, czy łączenia blach. Oznacza to, że jeszcze co najmniej kilka razy będziesz musiał wygenerować nowe wersje obrazów, które wylicza Rysunek 7.11.1.
Ewentualne zmiany obrazów tekstur należy najpierw wykonać w Inkscape. Wprowadź je w odpowiednich warstwach „szczegółowych” pliku skin.svg (Screws, Rivets, PanelV, PanelH, ...), wewnątrz umieszczonych na nich grup (#Screws, #Rivets, #PanelV, #PanelH, ....). Warstwy przygotowane w skin.svg do eksportu (Result:*) zawierają referencje do tych grup, więc natychmiast wyświetlą to, co zmienisz w warstwach szczegółowych.
Po wprowadzeniu zmian w Inkscape należy ponownie wykonać czynności przedstawione przez Rysunek 7.11.1:
wygenerować pięć plików z Inkscape (holes.png, screws.png, ref_details.png, nor_details.png, nor_blur.png);
włączyć do GIMP plik screws.png (na odpowiednią warstwę). To tymczasowy plik, który po wczytaniu można usunąć;
wygenerować ze skin.xcf nowe wersje color.png i ref_dirt.png;
Oczywiście, jeżeli niczego nie zmieniałeś w układzie „dziur” na warstwie Holes, możesz nie generować pliku holes.png. To samo dotyczy screws.png. Pozostałe trzy pliki, wyliczone w pkt. 1, są złożeniem wielu grup, i na wszelki wypadek generuj je po każdej zmianie!
Zwróć uwagę, że nie wymieniam tu pliku lines.png. To dość specyficzny plik pomocniczy: jego „rozmyta” wersja, ze względu na swoją „niedokładność” jest odporna na większość zmian. Wersja oryginalna (nie rozmyta) pełni rolę pomocniczą — jest potrzebna tylko do malownia warstw przetarć i odprysków farby. Właśnie dlatego, że można go często pominąc, nie stworzyłem dla tego obrazu odpowiedniej warstwy Result:* w pliku skin.svg.
Jeżeli chodzi o schemat materiału B.Skin.Camouflage — to rósł stopniowo w wyniku zmian, które wprowadzaliśmy w kolejnych sekcjach tego rozdziału. Obecnie stał się już bardzo duży (Rysunek 7.11.2):
Rysunek 7.11.2 Schemat materiału B.Skin.Camouflage
Dla uproszczenia usunąłem z pokazywanego na ilustracji schematu węzeł Texture Coordinate. Używaliśmy go jako źródło współrzędnych tekstur, pobieranych z domyślnego rozwinięcia UV każdej siatki. Ten rodzaj współrzędnych jest domyślnym dla stosowanych w tym schemacie węzłów Texture Image, więc gdy go odłączysz, wszystko dalej będzie działać1.
Schemat, przedstawiony przez Rysunek 7.11.2, można podzielić na strefy. Na ilustracji ten podział zaznaczyłem za pomocą białych, przerywanych linii. Poziomo można wyróżnić (wyliczając od lewej do prawej):
węzły dostarczające współrzędne teksturom;
obrazy tekstur2 (ich oryginalne pola z nazwami są przy takiej skali ilustracji bardzo małe, więc naniosłem na schemat ich nazwy w dodatkowych białych prostokątach);
węzły sterujące różnymi parametrami tekstur;
Pionowo rozbudowywaliśmy schemat „z dołu do góry”, stąd zaczynając od spodu można w nim wyróżnić obszary związane z:
odwzorowaniem nierówności na powierzchni samolotu (tekstury nor_details.png, nor_blur.png);
modulacją odbić światła (tekstury ref_details.png, ref_dirt.png);
teksturami barwy (color.png, decals.png);
innymi efektami (tekstura otworów — holes.png, intensywności barw — col_intensity.png);
Obszarem, który wygląda jakoś chaotycznie są węzły sterujące barwy i odbicia światła (Rysunek 7.11.2) — być może dlatego, że łączą się ze sobą. Zwróć także uwagę, ile różnych parametrów materiału B.Skin.Camouflage jest ukrytych w tej plątaninie! Nie miej złudzeń — jeżeli wrócisz do tego schematu za rok, nie będziesz pamiętał o istnieniu ani znaczeniu co najmniej połowy z nich. A co dopiero ktoś, kto będzie chciał wykorzystać ten model — dla niego to będzie zupełne „spaghetti”. Dlatego proponuję „obudować” obszar sterowania teksturami barwy i odbić za pomocą pomocniczej grupy (Rysunek 7.11.3):
Rysunek 7.11.3 Stworzenie grupy X.Textured Skin
Nadałem tej grupie nazwę X.Textured Skin. Poniżej wejścia dla każdej tekstury umieściłem się na niej podstawowe parametry, związane z tym obrazem. (Posługując się umieszczonymi na ilustracji numerami możesz szybko zidentyfikować, z jakiego węzła pochodzi każdy z nich). Dzięki grupowaniu mogłem nadać licznym parametrom odbić i barwy jakieś nazwy, co także poprawiło czytelność całego schematu (Rysunek 7.11.4):
Rysunek 7.11.4 Zastosowanie grupy X.Textured Skin w materiale B.Skin.Camouflage
Grupę X.Textured Skin wykorzystamy jeszcze w materiale wnętrza kabiny. Być może użyjesz jej potem w kolejnych modelach. Dlatego nie włączyłem do niej pewnych bardzo specyficznych szczegółów, takich jak sterowanie teksturą intensywności (col_intensity.png) czy przyciemnienie tekstury decals.png (Rysunek 7.11.4). Nawet bez tych dodatków, i bez miejsc na podłączenie dla obrazów, grupa X.Textured Skin eksponuje aż osiem różnych parametrów. (Nie liczę Decals Alpha, bo to po prostu miejsce do podłączenia wyjścia Alpha tekstury decals.png — por. Rysunek 7.11.4). Mogło by być ich jeszcze więcej, ale specjalnie pomijałem te parametry węzłów, które rzadko zmieniałem (por. Tabela 7.11.1). W razie potrzeby można przestawić ich wartości w definicji grupy.
Na pokazanych na poprzednich stronach schematach nadałem każdemu węzłowi sterującemu indywidualny numer (por. Rysunek 7.11.2, Rysunek 7.11.3). Zrobiłem to, aby zestawić w poniższej tabeli wszystkie parametry, którymi można sterować w materiale B.Skin.Camouflage:
| Nr węzła | Typ węzła | Przeznaczenie | Parametr węzła | Nazwa parametru w X.Textured Skin |
| 1 | Moderate | Głębokość podstawowej tekstury nierówności (por. str. 403) | Range | N/D |
| 2 | Moderate | Głębokość pomocniczej tekstury nierówności (por. str. 410) | Range | N/D |
| 3 | Range To Max | Poziom i zmienność odbijalności materiału (por. str. 417) | Max | Reflectivity |
| Range | pominięty | |||
| 4 | Range From Min | Poziom i zmienność szorstkości materiału (por. str. 417) | Min | Roughness |
| Range | pominięty | |||
| 5 | Moderate | Intensywność zabrudzeń (odwzorowanych przez pomocniczą teksturę Ref — por. str. 419) | Range | Dirt Intensity |
| 6 | RGB | Barwa odblasków światła (por. str. 465) | Value | Specular Image |
| 7 | Stack Image | Połyskliwość znaków rozpoznawczych i innych oznaczeń (por. str. 447) | Opacity | Decals Specularity |
| 8 | Moderate | Nieprzejrzystość barwy odblasków (łączenie barwy Specular z teksturą Diffuse — por. Podsumowanie na str. 467) | Range | Specular Intensity |
| 9 | Stack Image | Nieprzejrzystość znaków rozpoznawczych i innych oznaczeń (por. str. 443) | Opacity | Decals Intensity |
| 10 | Hue Saturation Value | Intensywność i nasycenie podstawowej barwy powierzchni (Diffuse — por. str. 429) | Value | Diffuse Intensity |
| Saturation | Diffuse Saturation | |||
| 11 | Hue Saturation Value | Przyciemnienie i nasycenie znaków rozpoznawczych i innych oznaczeń (por. str. 463) | Value | N/D |
| Saturation | N/D | |||
| 12 | Range From Min | Rozjaśnienie wybranych fragmentów powierzchni (za pomocą tekstury col_intensity.png — por. str. 455) | Min | N/D |
| Range | N/D |
Tabela 7.11.1 Wyliczenie węzłów sterujących materiałem B.Skin.Camouflage
Model z grupami z tej sekcji znajdziesz w pliku model\p40\history\P40B-7.11.blend (por. str. 22).
W tym rozdziale zakończymy formowanie naszego samolotu. Zaczniemy od typowej sytuacji — skorygowania tego, co zrobiliśmy wcześniej na podstawie nowych materiałów referencyjnych. Jeżeli robisz dokładny model, praca zawsze posuwa się po takiej „spirali”: od czasu do czasu trzeba wrócić do rzeczy, które już wykonałeś poprzednio, i je poprawić. Pokażę to w sekcji 8.1 na przykładzie poważnej modyfikacji kształtu kadłuba.
Następnie dodamy do modelu mnóstwo drobnych części — na przykład elementy podwozia. Nie będziemy ich rozwijać i teksturować, jak to robiliśmy z podstawowymi powierzchniami samolotu w poprzednim rozdziale. Zamiast tego do ich pokrycia użyjemy prostszych, jednorodnych materiałów, opartych o tekstury proceduralne.
W tym rozdziale nie będę opisywał wykonania każdego detalu. Skupię się raczej na tych, które wymagają zastosowania jakiejś nowej, nie omawianej do tej pory metody. Aby nabrać wprawy, pracę nad szczegółami zaczniemy od stworzenia kółka ogonowego. To dość prosty mechanizm, więc łatwo pokazać na jego przykładzie wszelkie niuanse nowych technik. Potem przejdziemy do bardziej złożonych całości: najpierw podwozia głównego, a później — wnętrza kabiny pilota.
Gdy skończysz kabinę pilota, cała reszta pracy wyda Ci się już łatwa i bardzo prosta!
W tym rozdziale będziemy wykorzystywać materiały z towarzyszącego tej książce pliku source.zip. Pliki *.blend odpowiadające rezultatom poszczególnych sekcji rozdziału znajdziesz w pliku p40.zip, a foldery z obrazami ich tekstur — w pliku textures2.zip. (Adres miejsca, z którego można pobrać te pliki, znajdziesz na. str. 22).
Podczas pracy nad modelem, prędzej czy później natrafisz na nowe materiały o samolocie, który tworzysz. (Czasami możesz natrafić na nie wtedy, gdy cała praca jest już skończona). Analizując takie nowe zdjęcia czy rysunki można znaleźć błędy w kształcie modelu. Poprawa takich niezgodności wiąże się często z dużym nakładem pracy. Jest to jednak konieczne, jeżeli chcesz jak najdokładniej odtworzyć pierwowzór. W tej sekcji pokażę jak możliwie prosto wprowadzić taką poważną zmianę kształtu.
Podczas pracy nad drugą edycją książki otrzymałem dzięki uprzejmości Hume Bates’a dwa nowe rysunki P-40B/C. Dotyczą wnętrza kabiny, ale widać na nich także kontur tylnej części kadłuba. Czym prędzej więc zestawiłem je z naszym modelem (Rysunek 8.1.1):
Rysunek 8.1.1 Porównanie otrzymanych rysunków fabrycznych z modelem
Użyłem tu rzutów z boku i z góry moich planów, które odpowiadają modelowi stworzonemu w pierwszej edycji „Wirtualnego modelarstwa”. (Kształt tego modelu jest taki sam jak ten, którego używaliśmy do tej pory).
Rysunek 8.1.1 pokazuje, że w rzucie z boku kadłub ma w zasadzie poprawny kształt. Zgadza się także położenie skrzydła. Do poprawki jest dolna część wiatrochronu kabiny pilota. (Widać źle zinterpretowałem zniekształcenie perspektywiczne na zdjęciach). Długo zastanawiałem się nad położeniem luku bagażowego, który na rysunkach fabrycznych jest odrobinę przesunięty w stosunku do tego na modelu (Rysunek 8.1.1a). Problem polegał na tym, że jednocześnie jego obramowanie (wręgi i podłużnice) są zgodne z dokumentacją. Po analizie dostępnych zdjęć doszedłem do wniosku, że to może być efekt jakiegoś przesunięcia kalki na desce kreślarskiej. (Na zdjęciach górna krawędź luku leży bliżej podłużnicy, niż widać to na tych rysunkach).
Za to w rzucie z góry widać poważne różnice pomiędzy kształtem modelu i konturem z dokumentacji technicznej. W zasadzie nie powinno mnie to dziwić: do tej pory nie było z czym go zweryfikować. (Jak to opisuje sekcja 18.3 na str. 1207, odpowiednie zdjęcia z góry praktycznie nie istnieją). Błędny kształt kadłuba w tym rzucie występuje na najwcześniejszych planach modelarskich, jakie odnalazłem1.
Szczególnie zainteresował mnie długi, prosty fragment konturu kadłuba ponad skrzydłem (Rysunek 8.1.2a):
Rysunek 8.1.2 Przyczyna płaskich boków kadłuba: kołnierze mocujące skrzydła (zdjęcie: Life)
Okazało się, że taki kształt nie był przypadkowy, i wynikał ze względów technologicznych: kadłub był mocowany do płata za pomocą kołnierza, ciągnącego się wzdłuż burt kabiny (Rysunek 8.1.2b). Z załączonego zdjęcia wynika, że ten kołnierz był to łagodnie wygięty fragment przekroju o kształcie litery „T”. Przypuszczam, że dodatkowe wygięcie w kierunku poprzecznym, które odwzorowałoby jakąś krzywiznę kadłuba byłoby bardzo kłopotliwe (to znaczy: drogie). Stąd łatwiej było dopasować na tym odcinku kadłub do kołnierza, pozostawiając proste krawędzie burt kabiny w płaszczyźnie poziomej. I choć na wszystkich innych planach P-40 ten fragment jest lekko wygięty, to ostatecznie przekonało mnie do poprawności konturu z rysunków fabrycznych.
Naniosłem odpowiednie poprawki czerwonymi liniami na plany samolotu (Rysunek 8.1.3):
Rysunek 8.1.3 Korekty, naniesione na plany samolotu
Ten skorygowany rzut z lewej (plik Left-upd.png) i z góry (plik Top-upd.png) znajdziesz w materiałach pomocniczych (w folderze source\plans\p40b-highres — por. str. 22).
Jak teraz dopasować kadłub samolotu do tych zmodyfikowanych planów? Zmiany dotyczą wielu siatek naraz. Ręczna modyfikacja każdej z nich byłaby pracochłonna. W dodatku wiąże się z ryzykiem powstania jakichś szczelin pomiędzy poszczególnymi częściami. Co gorsza, modyfikowane siatki są stosunkow gęste. Trudno będzie uniknąć na ich powierzchni drobnych pofałdowań. Jedynym ułatwieniem jest to, że te zmiany dotyczą tylko kształtu siatek — nie musimy (na szczęście) modyfikować tekstur. Dopóki nie usuniemy z poprawianych siatek żadnej ściany, dopóty współrzędne mapowania tekstur także pozostaną nienaruszone.
W takiej sytuacji dobrym rozwiązaniem wydaje się zmiana wszystkich tych części równocześnie, za pomocą modyfikatora Mesh Deform (por. str. 979) . Zacznijmy od obudowania kadłuba odpowiednim „pudełkiem” (Rysunek 8.1.4):
Rysunek 8.1.4 Pomocnicza siatka, której użyjemy do zmiany kształtu kadłuba
Nazwijmy tę tymczasową siatkę DeformBox. Wstaw do niej (Loop Cut) na poziome i pionowe krawędzie ponad kluczowymi miejscami kadłuba. Gdzie dokładnie trzeba je umieścić? W zasadzie tam, gdzie w rzucie z boku biegną odpowiednie wręgi i podłużnice. Musisz jednak z tym trochę sam poeksperymentować (Rysunek 8.1.5):
Rysunek 8.1.5 Rozmieszczenie krawędzi siatki pomocniczej
I właśnie przy okazji tych „eksperymentów” natkniesz się na mankamenty użycia modyfikatorów Mesh Deform. Choć na czas prób wystarczy je przypisać do głównych elementów kadłuba, to i tak ich „przypinanie” (przycisk Bind — por. str. 979) i późniejsze „odpinanie” (Unbind — por. str. 980) od deformatora jest pracochłonne. W dodatku po każdej próbie siatka deformująca pozostaje zmieniona, i trzeba ją ręcznie przywracać do poprzedniego kształtu… Tu potrzeba jakiegoś skryptu Pythona, który zautomatyzuje te kroki!
Stworzyłem więc taki dodatek do zarządzania zespołem modyfikatorów Mesh Deform. (Chodzi o zespół wielu deformowanych obiektów i jednej siatki deformującej). Nazywa się MDeform i znajdziesz go w oknie User Preferences, zakładce Addons, dziale Object. Jego plik jest dołączony do innych skryptów, towarzyszących tej książce. Szczegółowy opis jego użycia umieściłem na str. 982. Tutaj skoncentruję się bardziej na tym, jak przygotować kadłub do tej deformacji.
Zacznijmy od „przymiarki”: przypisz pleceniem Set Deformer do siatki DeformBox główne powierzchnie kadłuba: część centralną i tylną (B.300.Fuselage) oraz okapotowanie silnika (obiekty B.350.*.Cowling.*) . Następnie uaktywnij deformator (Deformer:Bind objects — por. str. 983) i zacznij stopniowo zmieniać szerokość kadłuba, zaczynając od przodu (Rysunek 8.1.6):
Rysunek 8.1.6 Zmniejszenie szerokości przedniej części kadłuba
Gdy fragment wokół ściany ogniowej osiągnie już założoną szerokość, ogranicz deformowany obszar siatki do dwóch krawędzi i ponownie zmniejsz jego szerokość (Rysunek 8.1.7a):
Rysunek 8.1.7 Zmniejszenie szerokości burt kabiny
Dopasowujesz w ten sposób do nowego konturu burty kabiny. Na koniec wyeliminuj ostatnie ślady po wygięciu tego fragmentu poszerzając nieco pojedynczą krawędź za kabiną pilota (Rysunek 8.1.7b).
W ten sam sposób zmień szerokość ogona samolotu (Rysunek 8.1.8):
Rysunek 8.1.8 Poszerzanie ogona
W ten sposób upewniliśmy się, że siatka DeformBox ma wystarczającą liczbę krawędzi do właściwego przekształcenia kadłuba. Obejrzyj teraz uważnie rezultat z każdej strony (Rysunek 8.1.9):
Rysunek 8.1.9 Weryfikacja rezultatu
Pierwsze wrażenia są pozytywne: cienie na kadłubie nie wykazują żadnych lokalnych zaburzeń kształtu. Połączenia deformowanych powłok zachowały ciągłość. Koniecznie jednak włącz inne warstwy i sprawdź wszystkie zakamarki — bo na pewno znajdziesz takie szczeliny, jak te które pokazuje Rysunek 8.1.10:
Rysunek 8.1.10 Szczeliny i przesunięcia pomiędzy odkształconymi i nieodkształconymi obiektami
Zapamiętaj albo zanotuj, gdzie znajdują się szczeliny lub przesunięcia. Większość z nich wyeliminujemy, przypisując do deformatora obiekty, wzdłuż których się pojawiły. Zacznijmy od przypisania do DeformBox wewnętrznych powierzchni kadłuba, wraz z podłużnicami i wręgami (Rysunek 8.1.11):
Rysunek 8.1.11 Przypisanie do deformatora wnętrza kadłuba
(Nie będę już pokazywać, jak bardzo te obiekty wystają spod zdeformowanej powierzchni kadłuba).
Aby podczas finalnej deformacji kadłuba nie powstały szczeliny wzdłuż ramek kabiny (por. Rysunek 8.1.10), przypisz je do deformatora (Rysunek 8.1.12a):
Rysunek 8.1.12 Przypisanie do deformatora dalszych elementów odstających od zmodyfikowanego kadłuba
Przypisz do deformatora jedną z klap kółka ogonowego (Rysunek 8.1.12b). Pamiętaj tylko, aby na czas tej deformacji odłączyć ją od jej osi obrotu (Clear Parent: Clear and Keep Transformation). (Te osie dosuniemy do nowych krawędzi otworu po zakończeniu całej operacji). Każda z pokryw kółka ogonowego używa tej samej siatki, więc przed przypisaniem usuń jedną z nich lub skopiuj jej siatkę (inaczej polecenie Apply nie zadziała).
Aby zmienić tylko część owiewki związaną z kadłubem, zdefiniuj na niej deformowany obszar jako grupę wierzchołków (Vertex Group — str. 945) o nazwie Deform. Po przypisaniu obiektu do deformatora wpisz ręcznie tę grupę we właściwościach modyfikatora MDformer (Rysunek 8.1.13):
Rysunek 8.1.13 Szczegóły przypisania owiewki skrzydła do deformatora
W podobny sposób ogranicz deformowany obszar na owiewce usterzenia (Rysunek 8.1.14a) i niższej części osłony silnika (Rysunek 8.1.14b):
Rysunek 8.1.14 Inne siatki, częściowo przypisane do deformatora
Gdy wszystkie drobne obiekty są już przypisane, wyłącz (Deformer:Unbind objects) wprowadzone zmiany w siatce deformatora. W ten sposób wracasz z deformacją do sytuacji początkowej, gdy ani żaden z obiektów, ani siatka deformatora nie były odkształcone (Rysunek 8.1.15):
Rysunek 8.1.15 Wyłączenie deformacji siatki
Potem uaktywnij z powrotem deformację, naciskając Deformer:Bind objects (tym razem jest więcej obiektów, więc potrwa to jeszcze dłużej). Gdy siatka stanie się aktywna, powtórz przekształcenia opisane na str. 477. Zacznij tak jak poprzednio, od przodu (Rysunek 8.1.16):
Rysunek 8.1.16 Deformacja kompletnej siatki kadłuba — część przednia
Potem poszerz ogon (Rysunek 8.1.17). (Traktuj te ilustracje tylko jako przypomnienie głównych kroków):
Rysunek 8.1.17 Deformacja kompletnej siatki kadłuba — ogon
Pamiętaj, że część warstw możesz ukryć, a to, co przeszkadza na warstwie aktualnej — także schować (H), by nic nie zasłaniało rysunku referencyjnego. Na przykład — owiewkę usterzenia (na ostatnim etapie deformacji).
Teraz znów przyjrzyj się uważnie wynikowi deformacji. Rysunek 8.1.18a) pokazuje ogon — wygląda na to że tu, poza drobnym przebiciem krawędzi powierzchni wewnętrznej wszystko jest poprawnie. Za to owiewka skrzydła zagłębiła się nam w niezdeformowaną część kadłuba! (Na chwilę nadałem jej kolor czerwony, aby Rysunek 8.1.18b lepiej pokazał, co się stało):
Rysunek 8.1.18 Weryfikacja rezultatu
W dodatku nie podoba mi się cień, wskazujący na drobną nieregularność kształtu w okolicy narożnika osłony chłodnicy cieczy (Rysunek 8.1.18b).
Na szczęście do modyfikatora przypisaliśmy tylko część owiewki skrzydła (por. str. 479, Rysunek 8.1.13). Pozwala to na wprowadzenie korekty „na bieżąco”, bez wyłączania całej deformacji. Wystarczy w trybie edycji tej siatki wykluczyć z deformowanej grupy odpowiednie wierzchołki (Rysunek 8.1.19):
Rysunek 8.1.19 Korygowanie obszaru deformacji na owiewce skrzydła
Po zmianie przypisania wystarczy przełączyć się na Object Mode, by zmiana odniosła skutek. Gdy do modyfikatora masz przypisaną grupę wierzchołków, możesz także sterować intensywnością efektu (za pomocą kontrolki Vertex Groups: Weight). Można nawet przypisywać indywidualne wagi poszczególnym wierzchołkom, „malując” je na siatce (por. str. 958). Pozwala to na płynne sterowanie kształtem. W ten sposób można wyeliminować np. jakieś drobne szczeliny, która pojawiła się po wykluczeniu z deformacji zaznaczonego fragmentu siatki. Tak się jednak złożyło, że tu jeszcze nie musimy ich stosować. Malowanie wag wykorzystamy następnym rozdziale, używając go do sterowania gęstością trawy na powierzchni lotniska.
O wiele gorzej przedstawia się sprawa „cienia” na narożniku chłodnicy cieczy (Rysunek 8.1.18b). Aby go wyeliminować, musimy jednak włączyć do deformacji także ten fragment osłony silnika. A to oznacza, że trzeba wycofać cały obecny efekt (znów wywołując Deformer:Unbind objects)!
Zawsze warto dodać do deformatora więcej siatek niż mniej — przy czym od razu przypisz tym, co do których masz wątpliwości, odpowiednie grupy wierzchołków.
Po wyłączeniu deformatora zmodyfikowałem obszar siatki B.350.Cowling.004 (Rysunek 8.1.20a), oraz przypisałem narożnik osłony chłodnicy cieczy (B.350.Cowling.005 — Rysunek 8.1.20b):
Rysunek 8.1.20 Zmodyfikowane obszary deformacji okapotowania silnika
Potem jeszcze raz wywołaj Deformer:Bind objects i poczekaj chwilę (na moim laptopie ta operacja zajmuje Blenderowi około 4 minut). Potem jeszcze raz zdeformuj siatkę — tak jak to robiliśmy poprzednio (por. str. 477 i str. 480).
Za trzecim razem zdeformowane elementy kadłuba pasują do siebie całkiem dobrze. Pozostały do poprawienia:
„przebicie” wewnętrznej powłoki kadłuba na ogonie (Rysunek 8.1.18b)
nieznaczne zagłębienie owiewki skrzydła w burtę kabiny (Rysunek 8.1.21):
Rysunek 8.1.21 Ostatni defekt — niewielkie zagłębienie owiewki skrzydła
Obydwu przypadków nie można już skorygować żadną sztuczką z deformatorem2.
W takim razie zatwierdźmy deformację naciskając Deformer:Apply 3. A gdy kadłub jest przekształcony „na stałe”, zajmijmy drobnymi poprawkami, które trzeba nanieść po tej operacji.
Krawędź obydwu owiewek możemy szybko skorygować. Przypisz je jeszcze raz do deformatora (tą samą grupę wierzchołków — por. str. 479) i lekko rozsuń odpowiednie ściany jego siatki (Rysunek 8.1.22):
Rysunek 8.1.22 Wysunięcie krawędzi owiewki skrzydła spod kadłuba
W podobny sposób dokonaj niewielkiej korekty szerokości elementów wewnątrz ogona (por. str. 481).
Wewnętrzne ściany owiewki skrzydła musimy poddać jeszcze korekcie, bo w wyniku tych wszystkich deformacji ich przekrój poprzeczny nie jest już okrągły. To wymagało trochę pracy, bo trzeba było przygotować nowy wzorcowy „stożek”, dostosowany do zmienionego kształtu narożnika kadłuba i skrzydła (por. str. 260). Potem przeniosłem zaznaczone ściany siatki owiewki na tę nową powłokę (Rysunek 8.1.23a). Aby to zrobić szybko, użyłem modyfikatora Shrinkwrap (Rysunek 8.1.23b):
Rysunek 8.1.23 Poprawienie kształtu wewnętrznych ścian owiewki (za pomocą modyfikatora Shrinkwrap)
(Szczegółowy opis modyfikatora Shrinkwrap znajdziesz na str. 970).
„Utrwal” modyfikator Shrinkwrap pokazywany przez Rysunek 8.1.23b) przyciskiem Apply. Po tej operacji trzeba jeszcze przesunąć (ręcznie) trzy wierzchołki z przodu siatki, przy krawędzi natarcia skrzydła (Rysunek 8.1.24). (W tym obszarze przekrój owiewki już nie był okrągły, i dlatego wzorcowa powłoka nie sięga do tego miejsca).
Uzyskaliśmy w ten sposób poprawny kształt lewej owiewki. Teraz jednak przed nami pewien problem: jak te wszystkie zmiany szybko i dokładnie przenieść na prawą owiewkę? Proponuję także do tego użyć modyfikator Shrinkwrap. Zrób to w następujący sposób:
wyłącz (na czas tej operacji) w lewej „wzorcowej” owiewce (B.180.L.WingFillet) modyfikator Subdivision Surface;
zmień skalę prawej owiewki (B.180.R.WingFillet) wzdłuż jej lokalnej osi Z na ujemną. To spowoduje „nałożenie” tej powłoki na lewą owiewkę (Rysunek 8.1.25a);
zdefiniuj na prawej owiewce grupę wierzchołków, których współrzędne chcesz uzgodnić (nazwałem ją Cone — por. Rysunek 8.1.25b)
dodaj do obiektu B.180.R.Wing.FIllet modyfikator Shrinkwrap (na początek stosu modyfikatorów!) i przypisz go tak jak pokazuje to Rysunek 8.1.25c). Koniecznie ustaw tryb na Nearest Vertex!;
Rysunek 8.1.25 Kopiowanie zmian w kształcie siatki za pomocą modyfikatora Shrinkwrap
Abyś mógł odróżnić każdą z tych powłok, na ilustracjach lewa owiewka ma kolor czerwony. Gdybym pozostawił w niej modyfikator Subsurf,to wierzchołki prawej owiewki dopasowałyby się do wygładzonych wierzchołków lewej.
Gdy wszystko wygląda poprawnie, zatwierdź zmianę prawej owiewki, naciskając przycisk Apply w panelu jej modyfikatora Shrinkwrap. Potem przywróć oryginalną skalę tego obiektu, by wrócił na swoje miejsce (Rysunek 8.1.26).
Na koniec dodaj z powrotem do lewej owiewki modyfikator Subsurf, by była wygładzona tak jak prawa.
Korektę owiewki kabiny zaczynam od obniżenia jej grzbietu (do linii poziomej) . To także można szybko wykonać za pomocą odpowiedniego „pudełka” i dodatku MDeform (Rysunek 8.1.27a):
Rysunek 8.1.27 Obniżenie grzbietu owiewki za pomocą dodatku MDeform
Korektę wprowadzamy przesuwając górną przednią krawędź siatki do dołu (Rysunek 8.1.27b). (Poziome linie na „pudełku” deformatora zapobiegają deformacji niższych partii osłony kabiny).
Więcej pracy będziemy mieli ze zmianą wiatrochronu. Zmieńmy najpierw kształt tej siatki, dopasowując ją do zadanej krawędzi przenikania (Rysunek 8.1.28a):
Rysunek 8.1.28 Dalsze korekty wiatrochronu i owiewki
Przednia krawędź wiatrochronu jest niemal zgodna, więc pozostaje poszerzyć podstawę tej powłoki (zmiana skali wzdłuż osi X). Na czas tej operacji usunąłem tylne ściany tej siatki, bo ich rozwinięcie UV nie było wykorzystywane w materiale B.Canopy.Glass. Dodamy je później, chociażby modyfikatorem Solidify.
Potem trzeba przesunąć krawędź kadłuba, otaczającą wiatrochron. Aby nie zdeformować przypadkiem tej części modelu, skopiowałem ją najpierw jako wzorzec. Potem przesunąłem odpowiednie wierzchołki (zmianą skali wzdłuż osi Y — Rysunek 8.1.29a), i „położyłem” je na wzorcu (Shrinkwrap — Rysunek 8.1.29b):
Rysunek 8.1.29 Przesunięcie krawędzi poszycia kadłuba
Formowanie krawędzi kadłuba wokół wiatrochronu zawsze zajmuje trochę czasu, bo to dość złożony fragment, który musi być dobrze przylegać do oszklenia. Posługując się przedstawionymi metodami udało mi się zachować oryginalny kształt kadłuba, bez żadnych nieregularności (Rysunek 8.1.30):
Rysunek 8.1.30 Przesunięta krawędź kadłuba | Rysunek 8.1.31 Skorygowane rozwinięcie UV tego fragmentu |
Po tak poważnej zmianie kształtu trzeba także uaktualnić rozwinięcie tej siatki w UV/Image Editor (Rysunek 8.1.31). To na szczęście dość proste: wystarczy „odpiąć” (Alt-P, Unpin) odpowiednie wierzchołki, i wywołać UVs→Unwrap (E). Blender ułoży ten fragment sam, odpowiednio do nowych proporcji. Pozostanie potem przenieść to rozwiniecie do pliku uv.svg i uaktualnić poszczególne rysunki tekstur (skin.svg, color.xcf, i pochodne). W przeciwnym razie nie będą pasować do siebie plamy kamuflażu!
Jeżeli chodzi o modelowanie, to na koniec można uzupełnić usuniętą (por. str. 479) symetryczną prawą osłonę kółka ogonowego. Potem przesuń ich osie obrotu ponad nowe krawędzie otworu w kadłubie, i powiąż z powrotem odpowiednimi relacjami Parent (Rysunek 8.1.32):
Model z tej sekcji znajdziesz w pliku model\p40\history\P40B-8.01.blend (por. str. 22). W jego pomocniczej scenie Tools znajdziesz siatkę deformującą (DeformBox). Aby powtórzyć kroki opisane w tej sekcji, wykorzystaj rezultat poprzedniego rozdziału: plik P40B-7.11a.blend.
Podsumowanie
Postęp prac nad modelem redukcyjnym przypomina bardziej „spiralę”, w której co jakiś czas powracasz do tego, co zrobiłeś, aby to poprawić. Tylko w wyniku takiego ciągłego doskonalenia można uzyskać naprawdę dokładny model. Ta sekcja opisuje jeden z takich „nawrotów” — wprowadzenia poważnej zmiany kształtu kadłuba (str. 474);
Do zmiany kształtu jednego lub wielu złożonych obiektów można wykorzystać deformację za pomocą pomocniczej siatki. Umożliwia to dodatek MDeform (str. 476);
Aby dopasować jedną powłokę do drugiej (str. 483, 485), lub skopiować zmiany wykonane w jednej siatce do jej symetrycznej kopii (str. 484) możesz wykorzystać modyfikator Shrinkwrap;
Aby nie naruszyć mapowań UV tekstur, żadna z opisanych w tej sekcji modyfikacji nie spowodowała usunięcia (ani stworzenia) jakiejkolwiek ściany w siatkach modelu.
Szczegóły samolotu zaczniemy od kółka ogonowego. Wybrałem je na początek tego rozdziału, gdyż nie jest zbyt skomplikowane. Jednocześnie wykonanie tego elementu pozwala pokazać kilka technik, które zastosujemy także w innych miejscach modelu.
Nim zabierzesz się za modelowanie podwozia, postaraj się zgromadzić jak najwięcej zdjęć tego elementu. Czasami są to dość skomplikowane mechanizmy! Na szczęście kółko ogonowe P-40 do takich nie należy1. Wśród dokumentacji, opublikowanej w Internecie, można znaleźć całkiem przejrzysty rysunek tego zespołu (Rysunek 8.2.1 — w istocie to schemat okresowego smarowania). Dodatkowo znalazłem tam także rysunek fabryczny goleni. Przygotowałem na tej podstawie „szkic wykonawczy” kółka ogonowego, wkomponowany w plany samolotu (Rysunek 8.2.2, patrz także source\plans\p40b-highres\Left (gear).png):
Rysunek 8.2.1 Oryginalny schemat zespołu kółka ogonowego | Rysunek 8.2.2 Rysunki wykonawcze dla modelu |
Cały zespół zaczniemy od goleni. W oparciu o rysunek fabryczny, zmniejszony do odpowiedniej skali, uformowałem najpierw dwa elementy cylindryczne: oś koła i górną część goleni (Rysunek 8.2.3a):
Rysunek 8.2.3 Formowanie goleni kółka ogonowego
Połączyłem te dwie „rury” wytłoczeniem, wygiętym jak na rysunku fabrycznym (Rysunek 8.2.3b). Następnie odwróciłem całą goleń o 90º, w położenie docelowe, i przesunąłem (przekoszeniem — Shear) oś koła w położenie zgodne z rzutem z boku (Rysunek 8.2.3c).
Rysunek 8.2.4 przedstawia uformowaną goleń. Nadałem jej nazwę B.510.Leg i umieściłem na warstwie 5 (przeznaczyliśmy ją na elementy podwozia — por. str. 277). Zwróć uwagę na karb, umieszczony z boku goleni. Takie wgłębienie jest widoczne na zdjęciach samolotu, i znajduje się na rysunkach konstrukcyjnych.
Nie wypadało go pominąć. Jednocześnie uzyskanie na powierzchni wygładzonej za pomocą modyfikatora Subsurf tak regularnej i ostrej krawędzi nie jest łatwe. Aby nie tracić na ten drobiazg zbyt dużo czasu, zdecydowałem się go stworzyć za pomocą modyfikatora Boolean (szczegóły — patrz str. 951). Umieść ten modyfikator poniżej modyfikatora Subsurf, by przecinał wygładzoną powierzchnię. Pozwala to szybko uzyskać poprawne efekty. Nie polecam jednak używać go do jakichś ważniejszych elementów — czasami ten modyfikator potrafi „z własnej inicjatywy” dorzucić do rezultatu dodatkowe ściany. Trzeba mu wtedy takie „twórcze podejście” wyperswadować, dodając do siatki dodatkowe krawędzie. (Chodzi o to, by zmienić jej topologię, uzyskując inny przebieg linii wzajemnego przenikania powłok).
Od razu przypiszmy wykonany element do odpowiedniego materiału. Na zachowanych kolorowych zdjęciach z lat 40-tych XX w. podwozie P-40 ma wyraźny, metaliczny połysk. Nie wygląda to na farbę, tylko na inny rodzaj powłoki (np. ocynk2). Takie pokrycie miałaby w tym miejscu sens. W końcu podwozie jest bardziej narażone na korozję, niż reszta samolotu.
Stworzyłem odpowiedni materiał, który będzie wyglądał jak lekko chropowata stal, pokryta jakąś warstwą zabezpieczającą w kolorze metalu. Szczegóły, jak to zrobić, znajdziesz na str. 1084. Materiałowi stali nadałem nazwę B.Steel.Rough, i przypisałem do siatki B.510.Leg. Rysunek 8.2.5 pokazuje, jak wygląda goleń podwozia na próbnym renderze.
Dla wszystkich drobnych części samolotu, za wyjątkiem paru elementów kabiny pilota, nie stosuj pracochłonnych rozwinięć w UV i „ręcznie malowanych” tekstur. Na typowych ujęciach i tak będą za małe, by takie detale można było dostrzec.
Zamiast tego, wykorzystaj do pokrycia drobnych części takie materiały jak B.Steel.Rough. Użyto w nich co najwyżej tekstur proceduralnych, nałożonych inną metodą (innymi współrzędnymi tekstury) niż pracochłonne UV (np. Generated lub Object).
Oczywiście, jeżeli planujesz robić jakieś ujęcie podwozia z bliska, to wtedy możesz się postarać. Trzeba na każdą siatkę nanieść szwy, rozwinąć, sprawdzić „jak leży” testowy obraz na poszczególnych detalach. Potem na obrazie tekstury namalować wszystkie zabrudzenia, plamy oleju, zacieki... Licz się jednak z tym, że zajmie Ci to dzień lub dwa. To poniekąd powtórzenie, tylko w trochę mniejszej skali, tego, co opisywał Rozdział 7. Mówiąc krótko: masa dodatkowej roboty!
Piastę koła najszybciej jest uformować, zaczynając od jej przekroju poprzecznego (Rysunek 8.2.6a):
Rysunek 8.2.6 Formowanie piasty kółka ogonowego
Potem wystarczy wytłoczyć ten kontur poprzez kolejne obroty o 30º wokół lokalnej osi X obiektu (Rysunek 8.2.6b). Na koniec dodałem do siatki modyfikator Mirror, wzdłuż osi Y i Z. Piastę nazwałem B.515.Gear.Tail i przypisałem jej ten sam materiał, co goleni (B.Steel.Rough).
Tak samo uformowałem oponę (B.520.Tire.Tail). Zacząłem od linii konturu (Rysunek 8.2.7a), a potem wytłoczyłem ją w „ćwiartkę” koła (Rysunek 8.2.7b):
Rysunek 8.2.7 Formowanie opony kółka ogonowego
Oponie kółka ogonowego przypisałem właściwości „zakurzonej gumy” — materiał B.Rubber.Tire. Gdybyś miał wątpliwości, jak powinna wyglądać, po prostu przyjrzyj się uważnie kołom jakiegoś niezbyt czystego samochodu (lub takiego, który przejechał jakąś długą trasę).
Rysunek 8.2.8 przedstawia próbny rendering tego zespołu. Muszę przyznać, że uzyskanie właściwego efektu zużycia koła nie było łatwe. Wymagało wykorzystania wielu tekstur proceduralnych. Zacząłem od maski, która osłabia wszelkie tekstury poza obszarem bieżnika. (Bieżnik jest zawsze bardziej wytarty, dlatego efekty chropowatości i zabrudzeń występują na nim w pełnej skali). Następnie naniosłem wokół opony wzór bieżnika (podłużne paski). Potem ustaliłem bazowe własności materiału opony, takie jak barwa (tylko zupełnie nowa guma jest czarna!), szorstkość, i połyskliwość. Na koniec za pomocą tekstur proceduralnych naniosłem efekty chropowatości i nieznacznego zakurzenia. Dokładny opis, jak przygotować taki materiał dla opony, znajdziesz na str. 1090.
Mówiąc szczerze, zawsze zaczynam modelowanie takich mechanizmów, jak podwozie, od odręcznego szkicu. To taka moja metoda na dogłębne poznanie rzeczy, którą mam odtworzyć. Konieczność narysowania poszczególnych detali (nawet niestarannie!) zmusza mnie do zastanowienia się nad ich kształtem i rolą. W czasie szkicowania decyduję, na jakie części podzielę cały zespół, oraz jakie szczegóły pominę. Po zakończeniu pracy taki szkic jest już niepotrzebny i ląduje w koszu. Przypuszczam, że możesz wypracować na własny użytek inne metody „zrozumienia” modelowanego zespołu. Najważniejsze w każdym razie, by najpierw ułożyć sobie w głowie plan pracy, a potem go zrealizować. Nie zaczynaj takich rzeczy impulsywnie, nie kieruj się naszym tradycyjnym (narodowym?) podejściem „jakoś to będzie” — bo zmarnujesz niepotrzebnie swój czas.
Po bliższej analizie stwierdzisz zapewne, że nawet najprostsze podwozie samolotu składa się z kilkunastu części, o różnym kształcie. Oznacza to, że trzeba tworzyć je co najmniej w tempie kilku dziennie, aby całość prac nie rozciągnęła się w tygodnie. Nie zawsze jest to takie łatwe. Muszę przyznać, że wymyślenie w miarę prostej siatki dla każdego niebanalnego detalu zajmuje mi trochę czasu. Na tej i następnych stronach pokażę formowanie szczegółów dwóch części: wahacza i amortyzatora. W ten sposób będziesz mógł skorzystać z moich doświadczeń, i podpatrzeć typowe metody tworzenia takich detali. Resztę elementów zespołu kółka ogonowego omówię bardzo pobieżnie — po jednej ilustracji na każdy obiekt.
Zacznijmy od końcówki wahacza, w której ma być osadzona goleń podwozia (Rysunek 8.2.9):
Rysunek 8.2.9 Początek formowania wahacza — miejsce na goleń podwozia
Podstawowy kształt końcówki to dwie rury, połączone w poziome „T” (Rysunek 8.2.9a). Następnie wyznaczam ich krawędź przecięcia (za pomocą dodatku Intersection — por. str. 829). Po wyznaczeniu tej krawędzi usunąłem ściany otaczające linię przenikania powłok (Rysunek 8.2.9b). Utworzyłem w ich miejsce nowy układ ścian, włączając w siatkę krawędź przecięcia (Rysunek 8.2.9c). Przy okazji usunąłem jedną z połówek siatki i włączyłem modyfikator Mirror.
Kolejnym detalem tej siatki są wypusty, umieszczone u góry i dołu końcówki. Zacząłem ich formowanie od zarysu w rzucie z boku. Do odwzorowania okręgów użyłem ośmioboków (Rysunek 8.2.10a):
Rysunek 8.2.10 Wahacz — początek formowania wypustu
Potem wytłoczyłem kontury wypustów na boki i do dołu, by uformować ich zasadniczy kształt (Rysunek 8.2.10b). Zrobiłem to tak, by wytłoczone ściany zagłębiły się wszędzie w powierzchnie „rur” końcówki.
Kolejnym krokiem jest scalenie siatki „rur” i wypustu. Zrobiłem to, tworząc nacięcia Knife, a potem zmieniając układ niektórych krawędzi i ścian (Rysunek 8.2.11a):
Rysunek 8.2.11 Wahacz — formowanie wypustu
Następnie przesunąłem w odpowiednie miejsce zarys gniazda osi amortyzatora, i wytłoczyłem je wzdłuż osi X (Rysunek 8.2.11b). Tymi samymi metodami, których użyłem poprzednio do scalenia wypustu z resztą siatki, scaliłem teraz z nią cylindry gniazd osi (Rysunek 8.2.12):
Rysunek 8.2.12 Gotowy wypust górny | Rysunek 8.2.13 Wahacz — gotowa końcówka |
I to wszystko — górny wypust jest gotowy. W ten sam sposób uformuj drugi, u dołu wahacza (Rysunek 8.2.13).
Do wykonania pozostała jeszcze reszta wahacza: ramię, które wytłoczę z końcówki, oraz okucie osi obrotu (Rysunek 8.2.14a):
Rysunek 8.2.14 Wahacz — okucie osi obrotu
Okucie osi obrotu wahacza wytłoczyłem z dwóch współosiowych ośmiokątów (Rysunek 8.2.14b). Potem połączyłem je z prostopadłościanem, który z kolei płynnie łączy się z okrągłym ramieniem wahacza (Rysunek 8.2.14d). Takie końcówki napotkasz w wielu elementach tego modelu. Temu wahaczowi nadałem nazwę B.530.SwingArm.
Amortyzator wydaje się na pierwszy rzut oka walcem, zupełnie łatwym do uformowania (Rysunek 8.2.15a). Ot, wystarczy stworzyć cylinder, rozciągnąć, dodać kilka wytłoczeń w odpowiednich miejscach, a na koniec pochylić, i gotowe. A jednak, gdy przyjrzysz się bliżej jego dolnej (tej lepiej widocznej z zewnątrz!) części (Rysunek 8.2.15b), napotkasz tam niby proste okucie, którego wykonanie może przysporzyć niespodziewanych kłopotów (Rysunek 8.2.15c):
Rysunek 8.2.15 Amortyzator i jego okucie
Problem z kształtem tego okucia polega na tym, że jego ścianki „wyrastają” wprost z okrągłej podstawy (Rysunek 8.2.15c). Takie ostre załamania psują zawsze kształt wygładzonych powierzchni podziałowych. Jak więc uzyskać w tym miejscu taki „kant”, a jednocześnie zachować wygładzony, okrągły kształt krawędzi?
Można to zrobić całkiem łatwo, pod warunkiem że zaczniemy formowanie całego amortyzatora właśnie od tego okucia. Wstaw do rysunku jakiś okrąg, który będzie nam służył za wzorzec kształtu. Potem wstaw drugi okrąg (np. ośmiokąt) — to początek amortyzatora. Możesz od razu dodać do siatki odpowiednie modyfikatory Mirror w kierunkach X, Y, i usunąć niepotrzebne wierzchołki, abyśmy dalej pracowali na „ćwiartce” okręgu. (Im mniej punktów do zmiany, tym lepiej!). Wytłocz (Extrude→Edges) krawędź ośmiokąta, zmieniając jej skalę wzdłuż osi Y do zera, by wypełnić „ćwiartkę” koła (Rysunek 8.2.16a).
Następnie wstaw w naszą „ćwiartkę” dodatkowe krawędzie przyszłych ścianek okucia: 1 i 2. Obok nich dodaj kolejne, pomocnicze krawędzie: a i c (b już istniała — to był wierzchołek oryginalnego ośmiokąta) :
Rysunek 8.2.16 Końcówka amortyzatora — początki formowania
Jest taka własność powierzchni podziałowych: jeżeli końcówki „ostrej” krawędzi (np. 1) i jej „sąsiadów” (a, b) leżą na linii prostej — to powłoka pozostanie w tym miejscu gładka (pokazuje to Rysunek 8.2.16a). Wystarczy teraz poprzesuwać trochę wierzchołki, by dopasować kształt obrysu do wzorcowego okręgu. Aby jak najlepiej odwzorować łuk, dodaj do siatki ostatnią, pomocniczą krawędź d. Całe dopasowanie zajmuje tylko chwilę. Potem możesz zaznaczyć krawędzie 1 i 2 jako „ostre (Crease = 1). Sam zobaczysz, że nie zaburzy to w żaden sposób kształtu okręgu obwodu.
Teraz spokojnie możesz już wytoczyć (Extrude) powierzchnię ograniczoną krawędziami 1 i 2 w ścianki okucia (Rysunek 8.2.16b).
Końcówki wytłoczonych ścianek „zsuń” wzdłuż osi Y do środka, by nadać im kształt trójkąta. Następnie ustaw kursor 3D w wierzchołku leżącym w na płaszczyźnie symetrii — tu będzie biegła oś otworu. Wytłocz krawędź końcówek w dwóch obrotach w półokrągłe zakończenie (Rysunek 8.2.17a):
Rysunek 8.2.17 Końcówka amortyzatora — formowanie wypustu
Potem obróć nieco te krawędzie końcówki jeszcze raz, aby dopasować je lepiej do pochylenia ścianek okucia (Rysunek 8.2.17b).
Następnie usuń dwa wierzchołki z centrum ścianki, by znikły dotychczasowe ściany boczne, i wstaw w ich miejsce kolejny, ośmioboczny cylinder (Rysunek 8.2.18a):
Rysunek 8.2.18 Końcówka amortyzatora — formowanie wypustu
Połącz krawędzie ścian otworu ze zewnętrznymi ścianami siatki, uzyskując w ten sposób nowe powierzchnie boczne (Rysunek 8.2.18b). Potem pozostaje tylko zaznaczyć je jako ostre, oraz zmienić tryb cieniowania na Solid, by okucie było gotowe.
Resztę siatki amortyzatora uzyskasz przez wytłoczenie okrągłej krawędzi podstawy okucia (Rysunek 8.2.19a):
Rysunek 8.2.19 Gotowy cylinder amortyzatora (B.540.Damper)
Na drugim końcu tego cylindra pozostaw otwór na tłok (Rysunek 8.2.19b). Nadaj tej części nazwę „z serii 500”, np. B.540.Damper.
Rysunek 8.2.20 przedstawia elementy podzespołu amortyzatora (por. str. 487, Rysunek 8.2.1):
Rysunek 8.2.20 Podzespół amortyzatora
Cylinder amortyzatora był połączony z wahaczem poprzez dodatkowy łącznik (B.535.Connector — Rysunek 8.2.20d). Taki element umożliwiał dodatkowo zginanie się cylindra na boki. (Przypuszczam, że czasami wahaczem mogło całkiem porządnie „machnąć” w poprzek kadłuba, szczególnie na jakimś nierównym lądowisku). Siatka B.335.Connector powstała z połączenia dwóch wytłoczonych w cylindry ośmiokątów. Element jest niewielki, więc jest tylko wygładzona „zgrubnym” modyfikatorem Subsurf (Level = 1). Aby oszczędzić sobie pracy, zamodelowałem tylko „ćwiartkę” tej części, a resztę załatwiły za mnie modyfikatory Mirror wzdłuż lokalnych osi X i Z (Rysunek 8.2.20d). Wydaje mi się, że takie elementy były pozostawione w kolorze „surowej” stali — więc zastosowałem tu gładszy materiał B.Steel.Smooth (to B.Steel.Rough bez tekstur — p. str. 1084).
Tłok amortyzatora (B.550.Piston) to prosty cylinder, zakończony „widelcem” z otworem na oś (Rysunek 8.2.20e). Siatkę widelca skopiowałem (P — Separate) z wykonanej wcześniej końcówki wahacza. Potem wystarczyło ją odpowiednio ustawić, zmniejszyć, i złączyć (Ctrl-J — Join) z siatką cylindra. Zwróć uwagę, że obszar roboczy cylindra ma bardzo gładką powierzchnię. Odwzorowałem to, stosując w tym miejscu inny materiał: B.Steel.Mirror (to taka trochę ciemniejsza odmiana B.Steel.Smooth, bez tekstury zabrudzeń).
Siłownik (B.560.Cylinder) to walec, z którego w miejscu mocowań wytłoczyłem poprzeczne „skrzydełka” (Rysunek 8.2.20c). Grubość tych wypustów jest dopasowana do szerokości siatek żeber — tak, aby razem wyglądały jak zupełnie cienkie, blaszane wzmocnienia. Popychacz siłownika (B.565.Rail) to także cylinder, z którego w odpowiednim miejscu wytłoczyłem wypust z osią (Rysunek 8.2.20f). Przyłączyłem do niej cylinder amortyzatora. Ostatnim, najmniej widocznym z zewnątrz elementem całego zespołu, są wysięgniki (B.570.Nest). Mocują koniec popychacza do szkieletu kadłuba. W odróżnieniu od pozostałych części nie zastosowałem tu żadnego wygładzenia — bo i tak ten element będzie tylko majaczył w głębi kadłuba.
B.535.Connector jest „rodzicem” (Parent) cylindra amortyzatora (B.540.Damper). Siłownik (B.560.Cylinder) jest „rodzicem” popychacza (B.565.Rail), a ten z kolei — „rodzicem” tłoka amortyzatora (B.550.Piston).
Rysunek 8.2.21a) przedstawia zespół wahacza, wraz z cięgnami służącymi do skręcania kółka ogonowego (były sprzężone ze sterem kierunku):
Rysunek 8.2.21 Podzespół wahacza
Siatki wahacza (B.530.SwingArm), opony (B.520.TyreTail), piasty (B.515.GearTail) i goleni (B.510.Leg) prezentowałem już w tej sekcji, więc nie ma co ich tu drugi raz pokazywać. Chociaż co do goleni, to muszę odnotować, że zdecydowałem się już ostatecznie „utrwalić” jej karb, uzyskany za pomocą modyfikatora Boolean (por. str. 488 i 951). Dlaczego teraz? Bo wydaje mi się, że nie będzie już trzeba poprawiać jej kształtu3. Aby utrwalić modyfikator Boolean, trzeba utrwalić także poprzedzający go modyfikator Subsurf. To dodaje goleni tyle wierzchołków, że można się pożegnać z myślą o jakichkolwiek dalszych poprawkach tej siatki (Rysunek 8.2.22):
Rysunek 8.2.22 Siatka goleni (B.510.Leg) po „utrwaleniu” modyfikatorów Subsurf i Boolean
Elementem zespołu pokazywanego przez Rysunek 8.2.21a), którego do tej pory jeszcze nie omawialiśmy, jest orczyk (B.516.Arm), przymocowany do końca goleni. Wytłoczyłem go z dwóch ośmiokątów, które następnie połączyłem (Rysunek 8.2.21b). Zastosowałem tu symetrię wzdłuż osi X i Z (można było i wzdłuż Y, ale nim o tym pomyślałem, miałem już element gotowy). Podobnie jak łącznik wahacza z amortyzatorem (B.535.Connector), orczyk jest wykonany z „surowej” stali (materiał B.Steel.Smooth). Cięgna — lewe i prawe (B.517.Wire.L i B.517.Wire.R) używają tej samej siatki B.517.Wire. Sama siatka to odpowiednio wytłoczone cylindry (Rysunek 8.2.21c). „Rurki”, modelujące cięgna, mają przypisany specjalny materiał B.Steel.Wire. Na renderze wyglądają dzięki niemu jak plecione stalowe linki (szczegóły — str. 1085) Zwróć uwagę na zgrubienia przy orczyku — za pomocą odpowiedniego materiału (B.Steel.Spring) zmienię je na renderingu w dość realistyczne sprężyny (szczegóły — p. str. 1086).
Jeżeli chodzi o hierarchię: wahacz (B.530.SwingArm) jest „rodzicem” goleni (B.510.Leg). Goleń jest z kolei „rodzicem” piasty koła (B.515.GearTail) i orczyka (B.516.Arm). Piasta jest „rodzicem” opony (B.520.TyreTail), a orczyk — cięgien (B.517.Wire.R i L).
Jako kolejny zespół można wyróżnić elementy, przymocowane „na sztywno” do wzmocnionej wręgi kadłuba (Rysunek 8.2.23a) :
Rysunek 8.2.23 Elementy przymocowane do wręgi ogonowej
Najważniejszą częścią jest tu okucie B.545.ArmBase, mocujące wahacz do wręgi. Oś obrotu wahacza wytłoczyłem z ośmiokąta, a resztę — za pomocą kolejnych wytłoczeń sekcji prostokątnej (Rysunek 8.2.23d). Formowałem tylko symetryczną “ćwiartkę” okucia, a potem ją powieliłem za pomocą modyfikatora Mirror wzdłuż lokalnych osi X i Z. W tym miejscu były bardzo widoczne łby czterech śrub, więc nie pozostało mi nic innego, jak je zamodelować (B.545.Screw.001 - .004) . Śruby przydadzą się w dziesiątkach innych miejsc, więc utworzyłem je jako cztery klony tej samej siatki — B.Screw. Sama siatka jest bardzo prosta (Rysunek 8.2.23e). Zwróć uwagę na położenie punktu centralnego obiektu — jest w płaszczyźnie podstawy łba śruby, aby najwygodniej ustawić ich podstawy. “Rodzicem” wszystkich czterech śrub jest oczywiście okucie B.545.ArmBase.
Kolejnymi składnikami zespołu pokazywane przez Rysunek 8.2.23a są prowadnice cięgien (B.517.Nest.L i .R). Takie trójkąty z otworem na końcu przydadzą się jeszcze w innych miejscach, więc, podobnie jak śruby, są to klony jednego wzorca (Rysunek 8.2.23b). Łączy je bolec (B.519.Bolt.L, .R). Siatka tego cylindra także będzie zawsze powieleniem jednego pierwowzoru: B.Bolt. Jeżeli chodzi o hierarchię, to bolec (B.519.Bolt.L lub .R) i prawa ścianka (B.519.Nest.002.L lub .R) są przypisane do lewych ścianek (B.519.Nest.001.L i .R), a te — do wręgi kadłuba.
Nim zabierzemy się za formowanie popychaczy luków podwozia, sklonujmy (Alt-D) do testów jeden luk wraz z osią (B.307.DoorAxis.R) (Rysunek 8.2.24a):
Rysunek 8.2.24 Robocza kopia luku podwozia i jego osi
Luk po skopiowaniu otwórz, obracając oś B.307.DoorAxis o jakiś „równy” kąt — np. 145º (Rysunek 8.2.24b).
Jeżeli obrócisz zespół luku podwozia o jakiś przypadkowy kąt, będziesz musiał potem go z powrotem pracowicie dopasowywać do pozycji „zamkniętej”. Dlatego — na wszelki wypadek — lepiej jest stworzyć robocze klony pokryw i do nich przymierzać otwarte podwozie. Ustaw taki klon luku w pozycji „otwarte” i dopasuj go do kółka ogonowego. Przekonasz się, że to bardzo wygodne. Możesz np. zmieniać kształt jego siatki, a zmiany są od razu widoczne na pierwowzorach pokryw. Konieczność takiej zmiany przytrafiła się i mi: podczas formowania zapomniałem wykonać w wewnętrznej powierzchni pokrywy podwozia otworu na okucie popychacza (Rysunek 8.2.25b). Musiałem ją uzupełnić teraz, oczywiście przymierzając od razu okucie do właściwych rozmiarów.
Rysunek 8.2.25a) pokazuje szczegóły popychacza pokryw kółka ogonowego:
Rysunek 8.2.25 Zespół popychaczy luku podwozia
Popychacze lewy i prawy (B.575.Stick.L i .R) są połączone ze sobą poprzez otwór w wahaczu łącznikiem B.570.Connector (Rysunek 8.2.25e). Ten łącznik może się obracać — bo inaczej popychacze by się zablokowały podczas chowania podwozia. Każda z końcówek popychacza B.575.Stick ma inny kształt i jest pochylona pod innym kątem, by dopasować się do “swojej” osi. Uzyskałem to poprzez obrót części siatki wokół lokalnej osi Z obiektu. Śladem p tych zabiegach jest skręcona siatka pośrodku popychacza (Rysunek 8.2.25f).
Okucie pokrywy podwozia zbudowałem z klonów tej samej trójkątnej siatki „blaszki” (B.519.Nest), co prowadnice cięgien (por. str. 496, Rysunek 8.2.23b). Skoro wszystkie te obiekty używają tej samej siatki, to jak udało mi się przypisać im inny kolor? To nic trudnego: na okuciach pokryw przełączyłem tryb przypisania materiału z Data na Object (szczegóły — str. 839). W trybie Object renderer używa materiału przypisanego do obiektu, a nie siatki. Dzięki temu każdy z klonów może mieć inny kolor, bo jest odrębnym obiektem. Do każdego z okuć B.303.Nest.L i .R dodałem u dołu dwa dodatkowe bolce (B.303.Bolt.L.nnn lub .R.nnn) — bo są widoczne na zdjęciach. W osi okucia umieściłem „beczułkę” (B.550.Dolly). Ten element umożliwia obrót końcówki popychacza w dwóch płaszczyznach. Mówiąc szczerze, nie jestem pewien kształtu tego elementu — na wszystkich fotografiach, które posiadam, jest zasłonięty przez blaszki okucia.
Hierarchia tego zespołu wygląda następująco: centralny łącznik (B.570.Connector) jest „rodzicem” popychacza (B.575.Stick). („Rodzicem” centralnego łącznika jest wahacz — B.530.SwingArm). Wewnętrzna część pokrywy luku podwozia (B.306.Door) jest „rodzicem” okucia (B.303.Nest). Okucie jest „rodzicem” beczułki (B.550.Dolly) oraz bolców wzmacniających.
Rysunek 8.2.26a) przedstawia uformowany mechanizm kółka ogonowego, wkomponowany w szkielet kadłuba, a Rysunek 8.2.26b) — bez szkieletu (widać wtedy więcej szczegółów):
Rysunek 8.2.26 Mechanizm kółka ogonowego — „w szkielecie” i osobno
Teraz konstrukcja ogona kadłuba stała się bardziej zrozumiała. Wręga przed lukiem podwozia musiała być taka szeroka (wzmocniona), bo przenosiła większość obciążeń pochodzących od kółka ogonowego. Skrzynkowe, wzmocnione podłużnice pod statecznikiem poziomym tworzyły wraz z tą wręgą „ramę”, w której zamocowany był siłownik.
Rysunek 8.2.27 przedstawia, jak teraz wygląda wnętrze luku podwozia. Przyznasz, że prezentuje się już bardziej realistycznie, prawda?
Rysunek 8.2.27 Widok do wnętrza komory kółka ogonowego
Myślę, że nie będziemy już dodawać tutaj dalszych detali. Oczywiście, w następnej sekcji uzupełnimy jeszcze tylko brakujący, prawy popychacz pokrywy, wraz z okuciem.
W tej sekcji starałem się pokazać ze wszystkimi szczegółami, jak modeluje się podwozie samolotu. Zrobiłem to na przykładzie stosunkowo prostego zespołu kółka ogonowego. Gdy w dalszych sekcjach będę omawiał podwozie główne, pominę już szczegóły formowania każdej śrubki czy popychacza. Po zapoznaniu się z tą sekcją, powinieneś być w stanie tworzyć je szybko, bez żadnych podpowiedzi;
Podwozie na zwykłych planach samolotu jest zazwyczaj narysowane w zbyt małej skali, a przez to — niewystarczająco dokładnie. Aby jak najlepiej odwzorować je w modelu, zgromadź możliwie dużo zdjęć tego zespołu. Nie zaszkodzi także przygotować jakiegoś schematycznego rysunku (str. 487);
Przed rozpoczęciem modelowania podwozia dobrze przemyśl, co i jak odwzorujesz. Musisz zdecydować, co należy pominąć, a co — uprościć (str. 490). Mnie pomaga w tym wykonanie odręcznych szkiców modelowanego mechanizmu. Na pewno istnieją także inne metody ☺;
Najtrudniejszymi do modelowania fragmentami są elementy z wieloma wypustami i otworami. Przykładem tak skomplikowanej części jest np. wahacz kółka ogonowego. Jego formowanie składa się z wielu etapów (str. 490 i dalsze);
Kształty prawie wszystkich części mechanizmów można „wyprowadzić” z początkowej kombinacji cylindrów i prostopadłościanów. Dobre przybliżenie cylindra uzyskuje się z ośmiokąta, „wygładzonego” modyfikatorem Subsurf (z Level = 2 dla większych obiektów, lub Level = 1 dla mniejszych). Tylko w wyjątkowych wypadkach należy stosować operacje typu Boolean (str. 488, 495);
Inne problemy mogą się kryć w prostych z pozoru przypadkach, jak wyprowadzenie prostopadłej ścianki z okrągłej podstawy (str. 492). Aby coś takiego uzyskać z powierzchni podziałowej (Subsurf), musisz przygotować odpowiedni układ wierzchołków. Jeżeli rozpoczniesz siatkę, od razu uwzględniając powstanie takich ostrych krawędzi, nie jest to nawet specjalnie trudne (str. 492);
Zaraz po stworzeniu nowego obiektu przypisz mu odpowiedni materiał. Do drobnych części używaj prostszych materiałów, których tekstury nie wymagają rozwinięcia siatki w przestrzeni UV. Zazwyczaj taka „stal”, „guma”, czy „cięgna”, będą się później powtarzać w innych zespołach samolotu (str. 488, 489);
Drobne sprężyny można modelować za pomocą zwykłych walców, pokrytych specjalnym, półprzeźroczystym materiałem (str. 495, 498);
Jako elementy, które się powtarzają (śruby, bolce, płaskowniki, ...) warto wykorzystywać klony pojedynczej siatki (np. wzorcowa śruba — str. 496);
Czasami trzeba w jakimś konkretnym klonie zmienić materiał (chodzi o sytuacje, gdy ma być inny niż ten, przypisany do wzorcowej siatki). Wystarczy wówczas przełączyć taki element z wykorzystania materiału siatki (Data) na materiał obiektu (Object) — str. 497;
Przy wzajemnym dopasowywaniu pokryw luków i mechanizmu podwozia, warto pozostawić oryginalne pokrywy w pozycji „zamkniętej” (tak, jak je wcześniej zamodelowaliśmy). Stwórz za to dodatkowy, roboczy klon pokrywy i jej osi, i ustaw je w pozycji „otwarte” (str. 496);
Jak już zdążyłeś się przekonać w poprzedniej sekcji, każde podwozie to mniej lub bardziej złożony zespół kół, goleni, amortyzatorów i różnorodnych popychaczy. Większość samolotów z okresu II Wojny Światowej miała w dodatku podwozie chowane. Wyobraź sobie, że robisz dwie sceny ze swoim modelem: jedną na lotnisku, a drugą w locie. W pierwszej podwozie musi być wysunięte, a w drugiej — schowane. Oczywiście, można je chować i wysuwać element po elemencie. Zapewniam Cię jednak, że za drugim razem podobna zabawa staje się już bardzo nużąca. Po co zresztą się tak męczyć, skoro Blender udostępnia nam różnorodne środki animacji? Wystarczy z nich skorzystać, by związać te wszystkie części w jeden mechanizm, uruchamiany przesunięciem pojedynczego uchwytu.
Pierwszym rozwiązaniem, które się w takiej sytuacji nasuwa, jest wykorzystanie takich samych szkieletów, jakich używa się w Blenderze do animacji postaci ludzi czy zwierząt. Te szkielety nazywane są w grafice komputerowej armaturami (armatures). Składają się (a jakże by inaczej!) — z kości (bones). Wstawiający do rysunku nieskomplikowaną armaturę, złożoną z dwóch połączonych kości, można szybko uzyskać podstawowy efekt chowania i wysuwania kółka ogonowego (Rysunek 8.3.1):
Rysunek 8.3.1 Chowanie kółka ogonowego za pomocą armatury
(Wszystko na temat budowy takiej armatury znajdziesz na str. 841 i następnych). Niestety, tak prosto można okiełznać tylko płaski zespół elementów. W przypadku ruchu w przestrzeni kości zaczynają się skręcać wokół osi podłużnej, co prowadzi do zaskakujących efektów.
Zobacz, na przykład, układ dwóch kości, modelujący mechanizm zamykania luku podwozia (Rysunek 8.3.2a):
Rysunek 8.3.2 Przykład problemów z odwrotną kinematyką kości (armatura luku podwozia)
Wydaje się równie prosty jak ten poprzedni, prawda? A jednak, gdy koniec ramienia zaczyna wędrować, wraz z wahaczem, do góry, cała pokrywa także się składa, ale jednocześnie — skręca (Rysunek 8.3.2b). Co prawda, można zapanować nad takim efektem ubocznym za pomocą różnych ograniczeń (Constrains), ale cała praca zamienia się w dość męczące zajęcie.
Sądzę, że taką „niesforną” armaturę można okiełznać, ale, mówiąc szczerze, nie chciało mi się poświęcać na to czasu. Przy okazji prób radzenia sobie z jej obrotami poznałem system ograniczeń (constrains) Blendera. Szybko doszedłem do wniosku, że do osiągnięcia zamierzonego efektu — otwierania i zamykania całego podwozia za pomocą jednego przesunięcia. — kości właściwie nie są potrzebne. Wystarczy tylko zamienić miejscami przyczynę ze skutkiem. To nie wahacz będzie się chował, bo jest ciągnięty w górę przez amortyzator, tylko amortyzator podniesie się do góry, bo jest popychany przez obrót wahacza. Gdy to dobrze rozegramy, zewnętrzny obserwator nawet nie zwróci uwagi, jakie są prawdziwe zależności pomiędzy poszczególnymi częściami zespołu. A gdy odwrócisz przyczynę i skutek, możesz cały mechanizm zamodelować za pomocą kilku ograniczeń. Nie trzeba do tego żadnej armatury, ani Pose Mode!
Zacznijmy od wstawienia obiektu — uchwytu, którego przemieszczenie będzie sterować wysuwaniem i chowaniem podwozia (Rysunek 8.3.3):
Rysunek 8.3.3 Uchwyt, który będzie poruszał całym zespołem kółka ogonowego
Osobiście używam na takie uchwyty zwykłych, ośmiobocznych cylindrów. Przypisałem mu materiał Artifical i umieściłem na warstwie 10 (tej samej, na której znajduje się „cel” kamery — por. str. 277). Uchwyt położony jest nieco z boku kadłuba (Rysunek 8.3.3a,b) by w razie potrzeby łatwo go było dostrzec. Postaraj się dobrać jego położenie tak, by jego współrzędne były liczbami całkowitymi. Nie jest to niezbędne, ale bardzo ułatwia dalszą pracę. Nadajmy mu nazwę z innym przedrostkiem, by odróżniał się od „zwykłych części”. Niech to będzie X.500.Handle. Włącz uchwyt do hierarchii modelu, przypisując go (relacją Parent) do okucia wahacza (B.545.ArmBase — por. Rysunek 8.3.3c, a także str. 496).
Aby wahacz (B.530.SwingArm) podążał za ruchem uchwytu, przypisz mu ograniczenie Locked Track (Rysunek 8.3.4, więcej na temat tego ograniczenia — str. 849):
Rysunek 8.3.4 Przypisanie do wahacza ograniczenia Locked Track.
W parametrach ograniczenia wskaż jako cel obiekt X.500.Handle (Rysunek 8.3.4a). Ustal X jako oś obrotu, a Y niech celuje w środek uchwytu (Rysunek 8.3.4b). Gdy przesuniesz uchwyt do góry (do pozycji Z = 8.0), koło podwozia znajdzie się w pozycji „schowane” (Rysunek 8.3.4b).
Dolne i górne położenia uchwytu musisz dopasować tak, by odpowiadały właściwemu położeniu kółka ogonowego. (Położenie dolne powinno odpowiadać podwoziu całkowicie wysuniętemu, a górne — schowanemu). W razie czego możesz lepiej dobrać to położenie, zmieniając odległość uchwytu od środka obrotu wahacza (zmieniając współrzędną Y). Gdy zakres ruchu uchwytu jest już ustalony, „utrwal” go za pomocą odpowiedniego ograniczenia Limit Location (Rysunek 8.3.5). (Więcej na temat tego rodzaju ograniczenia i jego parametrów znajdziesz na str. 853).
Zajmijmy się teraz górną częścią podwozia: popychaczem i amortyzatorem. Bardzo ważne jest odpowiednia pozycja środków i hierarchii tych elementów (Rysunek 8.3.6):
Rysunek 8.3.6 Położenie środków poszczególnych części zespołu amortyzatora
Środek popychacza (B.565.Rail) umieść (jak — zob. str. 835) w osi obrotu tłoka amortyzatora (Rysunek 8.3.6b). Jeżeli chodzi o hierarchię, to przypisz (relacją Parent) tłok (B.550.Piston) do popychacza B.565.Rail. Cylinder amortyzatora (B.540.Damper) przypisz (relacją Parent) do niepozornego łącznika (B.535.Connector — Rysunek 8.3.6c), a sam łącznik — do wahacza (B.530.SwingArm).
Teraz przypisz łącznikowi B.535.Connector ograniczenie Locked Track tak, by jego oś Y „celowała” w środek popychacza (Rysunek 8.3.7a):
Rysunek 8.3.7 Ograniczenia Locked Track, przypisane do elementów amortyzatora
Jednocześnie ogranicz cylinder B.550.Piston tak, by jego oś Z śledziła środek cylindra B.540.Damper (Rysunek 8.3.7b). Na wszelki wypadek możesz także dodatkowo ograniczyć cylinder, by „celował” w tłok.
Na razie nasze ograniczenia powodują, że w trakcie obrotu wahacza amortyzator jest niemiłosiernie ściskany (Rysunek 8.3.8):
Rysunek 8.3.8 Rezultat działania ograniczeń: ugięcie amortyzatora
To dlatego, że nie uruchomiliśmy jeszcze popychacza. Gdy będziesz przesuwał uchwyt X.500.Handle do góry, popychacz powinien się przesuwać w lewo (Rysunek 8.3.9a), o 3.5 jednostki Blendera. Najprościej ten efekt uzyskać za pomocą „uniwersalnej przekładni” — ograniczenia Transformation (Rysunek 8.3.9b):
Rysunek 8.3.9 Przełożenie ruchu uchwytu na przesunięcie popychacza (ograniczenie Transformation)
Jak widzisz, panel tego ograniczenia ma wyjątkowe duże rozmiary. Ustala się w niej obiekt sterujący (określany jako Target lub Source), oraz przełożenie jego współrzędnych na obiekt do którego przypisano ograniczenie. Jak widać z opisu na ilustracji, to w zasadzie proste zagadnienie wiąże się z paroma uwagami. Szczegółowy opis parametrów i działania ograniczenia Transformation znajdziesz na str. 855.
Dystans przesunięcia popychacza — 3.5 jedn. Blendera — dopasowałem po kilku „przymiarkach”.
Uzyskaliśmy w ten sposób całkiem poprawny ruch mechanizmu podwozia (Rysunek 8.3.10):
Rysunek 8.3.10 Chowanie podwozia za pomocą uchwytu X.500.Handle.
Do tej pory ustawialiśmy koło w pozycji wysuniętej tak, jak wyglądało tuż przed lądowaniem — gdy amortyzator był zupełnie bez obciążenia. Jednak wtedy, gdy samolot stoi na ziemi, amortyzator „zsuwa” się trochę. Powoduje to odchylenie wahacza.
Aby odwzorować takie ugięcie podwozia, „nałóż” na uchwyt X.500.Handle drugi, mniejszy uchwyt (ale za to szerszy! — Rysunek 8.3.11b). Nadajmy mu nazwę X.501.Handle (Rysunek 8.3.11a):
Rysunek 8.3.11 Dodatkowy uchwyt, sterujący ugięciem amortyzatora (X.501.Handle).
Przypisz (relacją Parent) uchwyt X.501.Handle do podstawowego uchwytu (X.500.Handle) (Rysunek 8.3.11c). Dzięki temu uchwyt pomocniczy będzie „przyczepiony” do X.500.Handle, gdy zaczniesz nim poruszać, by schować podwozie. Aby ugięcie amortyzatora nie było „przegięciem”, dodaj do uchwytu X.501.Handle ograniczenie Limit Location (Rysunek 8.3.11d). Pozwól przesuwać mu się wyłącznie w pionie (wzdłuż lokalnej osi Z), na dystans 2 jednostek (od -3.0 do -1.0). (Po kilku przymiarkach zdecydowałem, że taki zakres będzie odpowiedni — powoduje „zsunięcie” amortyzatora o około 1 jednostkę Blendera. Odpowiada to 10 cm na rzeczywistym samolocie).
Teraz zmodyfikuj „cel” ograniczenia Locked Track wahacza (B.530.SwingArm). Wpisz tam, w miejsce nazwy uchwytu podstawowego, nazwę uchwytu pomocniczego (X.501.Handle) (Rysunek 8.3.12a):
Rysunek 8.3.12 Sterowanie ugięciem amortyzatora.
Początkowo nie zmieni to niczego, gdyż środki obydwu uchwytów się pokrywają (por. Rysunek 8.3.11a). Gdy jednak zaczniesz przesuwać X.501.Handle do góry, zauważysz że ten ruch wsuwa cylinder amortyzatora — tak, jak gdyby był obciążony (Rysunek 8.3.12b). Popychacz zacznie się wysuwać dopiero wtedy, gdy przesuniesz do góry uchwyt podstawowy (X.500.Handle) (Rysunek 8.3.12c). X.501.Handle będzie się poruszać wraz z nim (bo są związane relacją Parent). Musisz tylko pamiętać, by przed zamknięciem podwozia przesunąć uchwyt pomocniczy zupełnie do dołu (tj. ustawić koło w pozycji „swobodnej”).
Kolejnym elementem „do ograniczania” są cięgna. Zacznij od wstawienia w każde z okuć — lewe i prawe — pomocniczych obiektów typu Empty (por. str. 816). Nadaj im nazwę B.519.Target.L i .R (Rysunek 8.3.13):
Rysunek 8.3.13 Pusty obiekt (Empty) — cel dla cięgna | Rysunek 8.3.14 Położenie środka cięgna |
Jeżeli chodzi o strukturę modelu — przypisz (relacją Parent) każdy z tych „celów” do odpowiedniego okucia. (B.519.Target.L do B.519.Nest.L.001, a B.519.Target.R do B.519.Nest.R.001)
Środki cięgien powinny się znajdować w miejscu ich zaczepienia (Rysunek 8.3.14). Gdy już tam są, możesz do każdego cięgna dodać ograniczenie Track To (por. str. 847). Jako „cel” (Traget) tych ograniczeń wpisz odpowiedni z obiektów B.519.Target (.L lub .R) (Rysunek 8.3.15a).
Rysunek 8.3.15 „Układanie się” cięgien podczas ruchu podwozia
W przypadku cięgien należy stosować ograniczenie Track To, a nie Locked Track, gdyż mogą się obracać względem dwóch osi. (Locked Track imituje obrót wokół jednej osi)
Za pomocą ograniczeń Track To sprawiłeś, że w każdej pozycji podwozia cięgna będą „przechodzić” przez własne okucia. W przyszłości, aby podnieść realizm modelu, możesz przełożyć ruch steru kierunku na skręcenie goleni kółka ogonowego. (Oryginalnie cięgna B.517.Wire służyły właśnie do tego). W naszym modelu nie będzie to przyczyną, a skutkiem ruchu: w wyniku obrotu goleni obróci się przypisany do niej orczyk. To z kolei spowoduje niesymetryczne przesunięcie środków cięgien (jedno się cofnie, drugie przesunie do przodu). Obydwa zbliżą się nieznacznie do osi kadłuba (poruszają się po okręgu). Dzięki ograniczeniu Track To, nawet przy takim przemieszczeniu ich końce będą przechodzić przez okucia, przymocowane do wręgi kadłuba.
Na koniec warto skrócić końcówki tych drutów, aby przy całkowicie schowanym podwoziu nie „sterczały” z poszycia (Rysunek 8.3.15b). Na szczęście można dobrać ich długość tak, by jednocześnie przy zupełnie wysuniętym kole „dotykały” powierzchni wręgi. Kłopot może się zacząć, gdy obrócisz orczyk — wtedy końcówka jednego z nich stanie się widoczna! Może trzeba tu będzie potem „dosztukować” jakiś pomocniczy „drut”? Udawałby dalszą część cięgna, ale poruszałby się tylko poziomo. Byłby wysuwany tylko przy obrocie orczyka.
Ruch wahacza powodował w P-40 otwieranie lub zamykanie pokryw podwozia. Włączmy je więc w wirtualny mechanizm, który tu budujemy. W poprzedniej sekcji zamodelowaliśmy okucie i popychacz tylko dla lewej pokrywy. Umieściliśmy je na jej „roboczej” kopii — B.305.L.Door.Test (por. str. 496). Włącz teraz widoczność warstwy, na której znajduje się ten obiekt (Rysunek 8.3.16a):
Rysunek 8.3.16 Powielenie okuć i popychaczy pokryw podwozia
Obróć pokrywę wokół lokalnej osi Z jej zawiasów, tak, by przyjęła pozycję „zamknięte”. W ten sposób okucie znalazło się w położeniu dopasowanym do „właściwych” pokryw: B.305.L.Door i B.305.R.Door. Tych pokryw nigdy dotąd nie ruszaliśmy z pozycji „zamknięte”. Odłącz okucie od roboczej kopii (Alt-P — Clear Parent) i przypisz do pokrywy B.305.L.Door. Jego lustrzane odbicie przypisz do B.305.R.Door. (Opis tej operacji — jak stworzyć lustrzane odbicie okucia, jak przypisywać je do pokryw — znajdziesz na str. 869). Potem możesz już usunąć cały zespół roboczej pokrywy B.305.L.Door.Test — nie będziemy go więcej potrzebować.
Ograniczenie Transformation w poprzednich wersjach Blendera (2.67 i wcześniejszych) miało pewien błąd pojawiający się przy obrocie. Aby nie wystąpił, musiałem tę oś poprzedzić obiektem Empty (Rysunek 8.3.17):
Rysunek 8.3.17 Pusty (Empty) rodzic zawiasu — obejście problemu, występującego w Blenderze 2.67 i wcześniejszych
W Blenderze 2.67 i wcześniejszych obrót za pomocą ograniczenia Transformation wymagał wyzerowania kątów obrotu transformowanego obiektu. Tylko w ten sposób mogłem uzyskać poprawny obrót wokół jednej osi. Dlatego do prawego i lewego zawiasu dodałem nowego rodzica — obiekt Empty (por. Rysunek 8.3.17b). Aby to ułatwić stworzyłem polecenie Add Empty Parent (por. str. 859). Szczegółowe wyjaśnienie tej operacji znajdziesz na str. 857. Ustawienia ograniczenia wymuszającego obrót zawiasu przedstawia Rysunek 8.3.18:
Rysunek 8.3.18 Ograniczenie Transformation, przypisane do zawiasów pokrywy osłony kółka ogonowego
Zwróć uwagę na obiekt, wpisany w polu Target na panelu tego ograniczenia. Początkowo próbowałem uzależnić kąty obrotu zawiasów (B.307.DoorAxis) od przesunięcia uchwytu X.501.Handle. Okazuje się jednak, że przesunięcie opisane w sekcji Transformation:Source jest związane z przesunięciem obiektu względem jego bezpośredniego „rodzica”. W efekcie pokrywy przymykały się poprawnie wtedy, gdy uginałem amortyzator. Gdy poruszałem jego „rodzicem” — podstawowym uchwytem X.500.Handle — drzwi komory pozostawały nieruchome.
Aby obejść ten problem, musiałem stworzyć dodatkowy obiekt (typu Empty) który podążą za jakimkolwiek ruchem każdego z dwóch uchwytów (Rysunek 8.3.19a):
Rysunek 8.3.19 X.501.Target —pomocniczy obiekt sterującego obrotem pokryw podwozia
Nadałem mu nazwę X.501.Target. W hierarchii modelu zajmuje inne miejsce (por. Rysunek 8.3.19b). Aby jednak „przymocować” go do obydwu uchwytów, powiązałem go z uchwytem X.501.Handle ograniczeniem Copy Location (por. Rysunek 8.3.19c). Dzięki Copy Location obiekt X.501.Target podąża za każdym przesunięciem uchwytów. I dlatego to ten obiekt steruje obrotem zawiasów.
Tak przygotowane pokrywy zamykają się, gdy przesuniesz główny uchwyt do góry (Rysunek 8.3.20):
Rysunek 8.3.20 Chowanie kółka ogonowego
Pokrywy reagują także na ugięcie amortyzatora, wywołane przesunięciem pomocniczego uchwytu X.501.Handle.
Ostatnim elementem, który pozostał nam do mechanizacji, są popychacze pokryw podwozia. Zacznijmy od beczułek okucia, do których są przymocowane (Rysunek 8.3.21a):
Rysunek 8.3.21 Skierowanie beczułki okucia na oś popychacza (Locked Track)
Przypisz beczułkom ograniczenia Locked Track. Skieruj ich osie X na środki (origin) popychaczy (Rysunek 8.3.21c). (Te punkty znajdują się na wewnętrznych krańcach popychaczy — por. Rysunek 8.3.21b).
Jednocześnie skieruj osie Y popychaczy na beczułki okuć (B.550.Dolly.L lub .R). Tutaj jednak nie posłużymy się ograniczeniem Locked Track. Gdybyśmy to zrobili, to pomiędzy końcami popychaczy i beczułkami pojawiałyby się wyraźne odstępy (por. str. 861). (Jest to rezultat przybliżenia rzeczywistego ruchu pokryw podwozia za pomocą zwykłego obrotu). Zamiast tego wykorzystamy inny rodzaj ograniczenia: Stretch To (Rysunek 8.3.22):
Rysunek 8.3.22 Dopasowanie popychacza do okucia (Stretch To)
Szczegółowe informację o działaniu i parametrach tego ograniczenia znajdziesz na str. 861. Dzięki Stretch To końce popychaczy będą się trzymać beczułek „jak przyklejone”. Co prawda, ograniczenie Stretch To nie obsłuży nam wszystkich niuansów ruchu prawdziwego popychacza. Rysunek 8.3.23 pokazuje, jak skręca się jego końcówka podczas chowania podwozia:
Rysunek 8.3.23 Skręcona końcówka popychacza podczas chowania podwozia
W dodatku w niektórych stadiach składania kółka ogonowego popychacze rozciągają się jak gdyby były z gumy. To kompromis, z którym musiałem się pogodzić1. Najważniejsze jest, by podwozie wyglądało poprawnie w pozycji „otwarte”. W pozycji „zamknięte” nie powinno razić, choć może odbiegać od oryginału w niewielkich szczegółach (nikt pod poszycie nie będzie zaglądał).
Rysunek 8.3.24 przedstawia ostateczne działanie mechanizmu, który stworzyliśmy w tej sekcji:
Rysunek 8.3.24 Składanie kółka ogonowego — jednym przesunięciem uchwytu!
„Mechanizacja” opisana w tej sekcji polega na połączeniu poszczególnych części modelu w jedną całość (mechanizm). Chodzi o to, by można było łatwo uruchomić model jakiegoś zespołu — np. podwozia — za pomocą jednego przesunięcia jakiegoś pomocniczego uchwytu (str. 500);
Ruch i wzajemne zależności części mechanizmu można najwierniej odwzorować za pomocą tzw. armatury (Armature), zawierającej zespół tzw. „kości” (bones). Niestety, w przypadku takich elementów jak podwozie, próba zastosowania kości może się wiązać z poważnymi trudnościami (str. 500);
W tej sekcji przedstawiam metodę alternatywną: zamiast używać armatury i jej kości, można zbudować cały „wirtualny” mechanizm przypisując elementom zespołu różnego typu ograniczenia ruchu (constraints);
Pracę zaczynamy od stworzenia na warstwie 10 łatwo dostępnego „uchwytu”. Ruch tej części będzie poruszał całym mechanizmem (str. 501);
Podstawowym ograniczeniem, imitującym zawiasy i inne połączenia osiowe, jest Locked Track (str. 501). Przed zastosowaniem tego ograniczenia warto jest zgrubnie ustawić osie obiektu w odpowiednim kierunku — by zastosowanie ograniczenia zmieniło je tylko trochę (str. 508);
Ograniczenie Limit Location pozwala ustalić zakres ruchu uchwytu — a w rezultacie całego mechanizmu — do zakresu położeń odpowiadającego rzeczywistości (str. 502);
Ograniczenie Transform można traktować jako „uniwersalną przekładnię” ruchu jednego przedmiotu na inny. Można jej użyć, by powiązać obrót, czy nawet zmianę skali, z przesunięcia jakiegoś wzorcowego obiektu (str. 503). Obroty obiektu docelowego najlepiej jest ograniczyć do jednej osi — tak jak to zrobiliśmy dla zawiasów pokryw podwozia (str. 506);
„Zsuwający” się amortyzator należy zamodelować z dwóch części: cylindra i tłoka. Każda z nich powinna mieć środek (origin) na przeciwległym krańcu, i innego „rodzica” (parent). Tłok powinien być „celem” (Target) ograniczenia Locked Track cylindra, a cylinder — tłoka (str. 502);
Ugięcie amortyzatora pod obciążeniem jest osobnym ruchem mechanizmu. Dlatego można je uzależnić od dodatkowego uchwytu (str. 505);
Ograniczenia Track To należy użyć do obiektów, które mogą się obracać w dwóch kierunkach — na przykład cięgien (str. 505);
Ograniczenie Stretch To można użyć do „przyłączenia” do mechanizmu popychaczy. Unikniemy w ten sposób „odrywania” ich końcówek od okuć, występującego w niektórych pośrednich pozycjach mechanizmu podwozia (str. 508);
Jak przekonałeś się w poprzednich sekcjach, podwozie składa się z dziesiątek drobnych elementów. Zazwyczaj są one zbyt małe, by zostać prawidłowo nakreślone na planach modelarskich. O ile autor nie załączył jakiegoś szczegółowego rysunku, podczas wykonywania podwozia jesteś skazany na analizę dostępnych zdjęć. W przypadku P-40 jesteśmy w tej szczęśliwej sytuacji, że oprócz udostępnionej w Internecie dużej liczby fotografii, można znaleźć także oryginalny rysunek złożeniowy podwozia głównego (widok z przodu i z boku). Pozostaje wkomponować go w rzuty samolotu (Rysunek 8.4.1):
Rysunek 8.4.1 Fabryczne rysunki zespołu koła głównego
Oryginalny rysunek fabryczny podzieliłem na rzut z przodu i rzut z boku. Dopasowywanie zacząłem od rzutu z przodu, gdyż zawiera zarys dolnej krawędzi przedniego dźwigara. (Było do niej przymocowane okucie osi obrotu goleni). Na siatce skrzydła modelu zidentyfikowałem podłużnicę, która odpowiada tej krawędzi, i przeniosłem jej zarys na plany (Rysunek 8.4.1a). W oparciu o tę linię, można było poprawnie „zawiesić” podwozie pod skrzydłem. Potem dla tej samej współrzędnej Z i skali ustawiłem rzut z boku (Rysunek 8.4.1b). Aby nie wierzyć ślepo planom, położenie goleni wzdłuż osi samolotu (ich współrzędną Y) ustaliłem na podstawie zdjęć.
Modelowanie podwozia zaczynam od opony. Wykonałem ją tą samą techniką, co kółko ogonowe — jako „ćwiartkę” torusa, odbitą modyfikatorem Mirror względem dwóch osi (Rysunek 8.4.2).
Rysunek 8.4.2 Siatka opony | Rysunek 8.4.3 Siatka piasty koła |
Ze zdjęć wynika, że opony wczesnych wersji P-40 zupełnie nie miały bieżnika. W razie czego — bieżnik można zamodelować lub odwzorować za pomocą tekstury nierówności. Podczas wykonywania piasty koła nie skorzystałem z modyfikatora Mirror (Rysunek 8.4.3). Tarcze piast były często na P-40 malowane w fantazyjne wzory, więc jako jedyny element podwozia jej siatka zostanie rozwinięta w płaszczyźnie UV.
W bardzo podobny sposób wykonałem tarczę hamulca (Rysunek 8.4.4). W odróżnieniu od piasty była „na sztywno” przymocowana do osi koła, więc musi być odrębnym obiektem.
Rysunek 8.4.4 Siatka tarczy hamulcowej | Rysunek 8.4.5 Koło główne — obiekty i ich materiały |
Nadałem tej oponie nazwę B.620.R.Tyre, piaście — B.615.R.Gear, a tarczy hamulca — B.616.R.Brake. Zbudowałem z nich prostą hierarchię, przypisując oponę do piasty, a piastę do hamulca. Zaraz po skończeniu modelowania warto także przypisać poszczególnym siatkom odpowiednie materiały, by już do nich nie wracać. Przy okazji pracy nad kółkiem ogonowym „dorobiliśmy” się już odpowiedniego zestawu wykończeń. Przydzieliłem oponie koła głównego ten sam materiał, jaki wykorzystaliśmy na oponę kółka ogonowego: B.Rubber.Tyre. Pozostałym elementom przypisałem typową powłokę metalu, czyli B.Steel.Rough (Rysunek 8.4.5).
Teraz wykonamy dolną część goleni, pełniącą jednocześnie rolę tłoka amortyzatora (Rysunek 8.4.6):
Rysunek 8.4.6 Dolna część goleni — tłok amortyzatora
Podstawowy kształt tej siatki powstał ze złożenia pod kątem 90º dwóch rur (Rysunek 8.4.6c). Następnie wyznaczyłem na tylnej ściance okrągłą krawędź otworu na zaczep (hak) holowniczy. (Zrobiłem to za pomocą dodatku Intersection — por. str. 829). W oparciu o tę krawędź wkomponowałem w siatkę goleni odpowiedni otwór. Z przeciwnej strony dodałem do siatki okrągłą tarczę, do której w prawdziwym samolocie był przykręcony zespół hamulca. Przy odpowiednim przesunięciu i zagęszczeniu wierzchołków, udało mi się przekształcić ten ośmiokąt w kształt przypominający klepsydrę (Rysunek 8.4.6a). Oczywiście, uzyskanie takich ostrych krawędzi było tylko możliwe poprzez zwiększenie ich wartości Cearese do 1.0. Zamodelowałem tylko jedną stronę siatki — reszta jest wygenerowana przez modyfikator Mirror. Nadałem tej części goleni nazwę B.610.R.Piston i ustaliłem materiał na B.Steel.Rough. W hierarchii modelu ta goleń jest „rodzicem” tarczy hamulca.
Kolejnym fragmentem podwozia jest zaczep (hak) holowniczy (Rysunek 8.4.7):
Rysunek 8.4.7 Hak do holowania
Według rysunków fabrycznych, hak powinien być ustawiony pionowo (Rysunek 8.4.7a), choć na zdjęciach odrestaurowanych samolotów najczęściej jest obrócony o 90º. (W tym położeniu najprawdopodobniej łatwiej jest przymocować do każdego z kół końcówkę jakiegoś pomocniczego „zaprzęgu” holowniczego). Siatka tej części to dwunastoboczny cylinder, któremu „zgniotłem” końcówkę, wkomponowując w nią otwór, oparty na ośmioboku (Rysunek 8.4.7b). Aby się nie przemęczać, modelowałem tylko „ćwiartkę” tej powierzchni — reszta to rezultat użycia modyfikatora Mirror, generującego odbicie względem dwóch osi. Nadałem tej części nazwę B.612.Hook, i umieściłem w hierarchii obiektów jako „potomka” goleni (B.610.R.Piston). Tak jak pozostałym elementom podwozia, przypisałem do siatki B.612.Hook materiał B.Steel.Rough.
Jak się powiedziało „A”, trzeba powiedzieć i „B”, więc skoro mamy dolną część goleni (tłok amortyzatora), dodajmy zaraz część górną, zawierającą jego cylinder (Rysunek 8.4.8):
Rysunek 8.4.8 Druga część goleni — cylinder amortyzatora
Cylinder amortyzatora stanowił integralny fragment górnej części goleni podwozia. Siatka tego elementu powstała z ośmioboku (Rysunek 8.4.8c). To stosunkowo prosty kształt, jak z tokarki. Nie redukowałem tu liczby oryginalnych ścian za pomocą modyfikatora Mirror — bo z jednej strony ta siatka będzie miała „wypustkę” (por. str. 519). Goleń podwozia P-40 ma lekko pochyloną oś. Podczas pracy będziesz wielokrotnie ustawiał ją na chwilę do pionu, więc warto ustalić jej pochylenie na jakiś określony kąt, by łatwo było w to położenie wrócić. Po sprawdzeniu planów i zdjęć, zdecydowałem się na pochylenie osi goleni dokładnie o 3º (Rysunek 8.4.8a).
Podczas składnia podwozia goleń obraca się wokół swojej osi o ponad 90º. Jest utrzymywana przez specjalny kołnierz. Stąd na powierzchni B.630.R.Leg przygotowałem małe wytłoczenia dla tego elementu.
Aby zapobiec przypadkowemu obrotowi, cylinder i tłok amortyzatora są powiązane za pomocą dwóch przegubowych łączników (Rysunek 8.4.10). Modelowanie tego zespołu zaczniemy od ich okuć (Rysunek 8.4.9):
Rysunek 8.4.9 Okucia łączników
Okucia łączników w P-40 wyglądają jak dwa paski, wygięte wokół goleni (Rysunek 8.4.9a). Wydaje mi się, że takie rozwiązanie znajdziesz na większości samolotów z okresu II Wojny Światowej. (Technologicznie nie opłacało się wykonać „w jednym kawałku” goleni razem z okuciami). Rysunek 8.4.9b) pokazuje szczegóły siatki okuć — to w zasadzie cylinder z dołączonymi „uszami” na oś obrotu łącznika. Świadomie zrezygnowałem tu z modelowania otworu osi (por. np. 493, Rysunek 8.2.18) — bo i tak jedna z jego ścian zostanie zupełnie zasłonięta przez łeb śruby a druga — przez nakrętkę. Zwróć uwagę, że „uszy” okuć są odsunięte w bok od koła (Rysunek 8.4.9c). Tak wynika ze zdjęć (gdyby płaszczyzna symetrii łączników leżała na osi goleni, wówczas nakrętka śruby zawadzałaby o oponę). Środki okuć umieściłem w osiach obrotu łączników (są równoległe, ale odsunięte od goleni — por. Rysunek 8.4.9a). Takie położenie będzie w przyszłości bardzo przydatne do zbudowania poprawnego „mechanizmu” dla tego zespołu. Górnemu okuciu nadałem nazwę B.621.R.Attachement, a dolnemu — B.611.Attachement.
Gdy mamy już w czym „osadzić” łączniki, można je teraz wykonać (Rysunek 8.4.10):
Rysunek 8.4.10 Łączniki tłoka i cylindra amortyzatora
Środki łączników znajdują się w tym samym punkcie, co środki ich okuć (por. Rysunek 8.4.10a i Rysunek 8.4.9a). Łączniki nie są identyczne — dolny jest zakończony „widelcem”, który zachodzi na końcówkę górnego (Rysunek 8.4.10b).
Sam łącznik wygląda na solidną, krótką sztangę. Jest na tyle drobny, że tworząc jego siatkę zrezygnowałem z pracochłonnego łączenia poszczególnych zespołów (Rysunek 8.4.11):
Rysunek 8.4.11 Szczegóły siatki łącznika amortyzatora
Siatka łącznika powstała ze złożenia trzech oddzielnych powłok: cylindra wokół osi okucia (1), właściwego ramienia (2), oraz widelca (3) (w górnym łączniku ten fragment ma inny kształt). Mimo ostrych krawędzi przenikających się powierzchni, element w Object Mode i na renderze wygląda to całkiem normalnie. Trzeba tylko dokładnie dosunąć do siebie wszystkie trzy powłoki, by nigdzie nie było widać jakichś szczelin.
Wreszcie doszliśmy do śrub (Rysunek 8.4.12a). Tak, tak, zdecydowałem się zamodelować co większe egzemplarze, choć sam wcześniej ostrzegałem przed popadaniem w przesadę. (I zamiast modelować np. śruby mocujące owiewki połączeń skrzydła i kadłuba, odwzorowałem je za pomocą tekstury nierówności — por. str. 335). Tym razem jednak robię to z całą premedytacją. Po pierwsze — śruby, wykorzystane do połączenia elementów goleni miały większy rozmiar od śrub używanych do mocowania blach płatowca. Po drugie — do modelowania podwozia stosujemy tylko tekstury proceduralne, więc nie ma gdzie narysować odpowiednich łbów i nakrętek. Po trzecie — aby poprawnie „zmechanizować” ruch łączników towarzyszący ugięciu amortyzatora, potrzebujemy oddzielnego obiektu w każdej z trzech osi obrotu tego zespołu. Po co wstawiać w to miejsce jakieś „puste” (Empty) twory, skoro możemy w naturalny sposób skorzystać ze śrub, umieszczonych tam przez konstruktora?
Siatkę śruby wygenerowałem z połówki cylindra, z włączonym modyfikatorem Mirror (Rysunek 8.4.12b):
Rysunek 8.4.12 Śruba i nakrętka
Kulisty łeb śruby wytłoczyłem z końcówki walca. Po włączeniu umiarkowanego wygładzenia (modyfikator Subsurf z Subdivisions = 1) utrwaliłem je (Apply). Zrobiłem to po to, by wygodnie naciąć we łbie szczelinę. Śruby wykorzystamy w wielu miejscach podwozia, więc przygotowałem kilka alternatywnych siatek, różniących się długością gwintu (B.Screw.Flat.008, B.Screw.Flat.010, B.Screw.Flat.011 — końcówki oznaczają długość, w 1/10 jednostki Blendera). Zastosujemy je w wielu klonach. Nakrętka zaciskowa („bezpieczna” — B.Nut.Safe) ma siatkę na bazie dwunastoboku, bez żadnych wygładzeń (Rysunek 8.4.12c).
Nie wiem, czy w oryginalnym P-40 stosowano takie zaciskowe nakrętki, jakie pokazuje Rysunek 8.4.12c). Zamodelowałem ją na podstawie zdjęć jednego z odrestaurowanych P-40E.
Śruby umieściłem w osiach ramion łącznika. Same ramiona można na chwilę ukryć (H — Hide). Przypisałem im takie ograniczenia, jakie pokazuje Rysunek 8.4.13:
Rysunek 8.4.13 Budowa mechanizmu przegubowego połączenia goleni.
Śrubie umieszczonej w osi przegubu nadałem nazwę B.620.R.Screw (Rysunek 8.4.13a). Przypisałem jej dwa ograniczenia Limit Distance (Rysunek 8.4.13b). Każde z nich wymusza utrzymanie przez ten obiekt stałej odległości (Clamp Region = Surface) od środków okuć (leżą w tym samym miejscu, co osie obrotu ramion). Śruby umieszczone w tych osiach — B.625.R.Screw i B.615.R.Screw — przypisałem (relacją Parent) do okuć. Nadałem im ograniczenia Stretch To, by ich osie Y były zawsze skierowane na oś przegubu. Potem możesz z powrotem „odsłonić” (Alt-H) schowane przed chwilą ramiona. Przypisz każdą z nich relacją Parent do odpowiedniej śruby (B.625.R.Screw dla górnego ramienia, B.615.R.Screw dla dolnego). Powinieneś uzyskać rezultat jaki pokazuje Rysunek 8.4.14a).
Szczegółowy opis budowy tego mechanizmu znajdziesz w sekcji dotyczącej ograniczenia Limit Distance, na str. 866. Wykorzystałem tam go jako przykład.
Aby wymusić ruch dolnej części amortyzatora tylko w założonych granicach (max. skok tłoka — +/- 9 cm), przypiszemy mu ograniczenie Limit Location (Rysunek 8.4.14):
Rysunek 8.4.14 Ograniczenie ruchu amortyzatora.
Uważaj: przed przypisaniem tłokowi ograniczenia Limit Location, ustaw na chwilę całą goleń zupełnie pionowo (Rysunek 8.4.14a). (To dlatego poprzednio podkreślałem, że powinna być pochylona o jakąś „okrągłą” wartość kąta, by łatwo było ją na chwilę przywrócić do pionu — por. str. 513). Tylko w takim położeniu Blender poprawnie „zrozumie”, co masz na myśli pozostawiając obiektowi swobodę ruchu tylko wzdłuż osi Z (Rysunek 8.4.14b). Potem możesz z powrotem pochylić całą goleń — dzięki przełączeniu Convert na Local Space, kierunki działania ograniczeń obrócą się wraz z nią.
Rysunek 8.4.15 przedstawia działanie mechanizmu, który zbudowaliśmy. Wraz z ruchem tłoka ramiona łączników poprawnie się składają i rozkładają:
Rysunek 8.4.15 Działanie mechanizmu przegubowego połączenia goleni.
Zapewne, ten sam efekt można było uzyskać za pomocą armatury, złożonej z dwóch kości (por. str. 841). Jednak w poprzedniej sekcji zdecydowałem się wyrugować armatury z mechanizmu kółka ogonowego. Aby zachować jednorodność rozwiązań w modelu, muszę teraz konsekwentnie wykonać każdy mechanizm wyłącznie za pomocą ograniczeń. Zresztą — to nie jest aż takie trudne, jak mogłoby się wydawać.
Czas pomyśleć o dalszej „mechanizacji” naszego podwozia. Zacznijmy od przygotowania dwóch uchwytów, działających w sposób podobny do uchwytów kółka ogonowego (Rysunek 8.4.16a):
Rysunek 8.4.16 Podstawowe elementy animacji goleni
Podstawowym uchwytem, odpowiedzialnym za złożenie podwozia, jest pomocniczy obiekt X.600.Handle. Jego ruch ograniczyłem do osi Y, od -10 (podwozie schowane) do -20 (zupełnie wysunięte). X.600.Handle jest „rodzicem” pomocniczego uchwytu X.601.Handle (Rysunek 8.4.16c). To uchwyt sterujący ugięciem amortyzatorów. Ograniczyłem jego ruch do 1.5 jednostki Blendera (15 cm), by dokładnie odpowiadał zakresowi ugięcia podwozia głównego. (Z rysunków fabrycznych wynika, że dla normalnej masy startowej ugięcie wynosiło 6cm. Gdy zakresy ruchu amortyzatora i sterującego uchwytu są takie same, ustawienie go w odpowiedniej pozycji nie nastręcza problemów).
Goleń podwozia P-40 nie tylko obracała się do tyłu, ale także wokół swojej osi. Aby dobrze odwzorować ten ruch, odtworzyłem elementy oryginalnego podwozia (Rysunek 8.4.16b). Dodałem oś — B.640.R.Axis — obracaną za pomocą uchwytu X.600.Handle (poprzez ograniczenie Transform). Bezpośrednio do osi przypisane są trzy elementy: opaska (B.635.R.Ring) i „czepiec” (B.650.R.Cap), oraz sama goleń (B.630.R.Leg). Podczas składania podwozia goleń dodatkowo obraca się wokół swojej osi (w wyniku ograniczenia Transform) o 90º.
A jak to wygląda w działaniu? Składanie podwozia zacznij od rozciągnięcia amortyzatora (za pomocą uchwytu X.610.Handle) do pozycji swobodnej (Rysunek 8.4.17a):
Rysunek 8.4.17 Składanie podwozia głównego
(Inaczej koło nie trafi w swój otwór!). Następnie złap za główny uchwyt (X.600.Handle) i zacznij go przesuwać do góry. Spowoduje to złożenie goleni, połączone z jednoczesnym obrotem (Rysunek 8.4.17b) — tak jak w prawdziwym P-40. Zakres obrotu B.640.R.Axis wokół lokalnej osi X — od -3º do +88º. Zakres obrotu goleni B.630.R.Leg wokół lokalnej osi Z — od 0º do +96º (trochę więcej niż 90º, by płaszczyzny kół leżały na powierzchni płata o wzniosie +6º). Rysunek 8.4.17c, d) pokazuje podwozie główne w pozycji złożonej.
Dopasowanie odpowiednich kątów złożenia wymaga paru iteracji, podczas których należy uważnie sprawdzać położenie koła względem poszycia płata i ścian komory. Te, które podałem, dobrałem na podstawie rysunków fabrycznych. Pozwalają złożyć podwozie tak, jak to pokazuje Rysunek 8.4.18a):
Rysunek 8.4.18 Dopasowanie kół do komory podwozia
Wydaje się być całkiem poprawne — tak samo złożone podwozie wygląda na dostępnych zdjęciach P-40, wykonanych podczas lotu. Przy okazji dopasowywania wyszły na jaw ciekawe szczegóły:
Tylna krawędź opony wystaje z dolnej powierzchni skrzydła (Rysunek 8.4.18b)! Sprawdzałem trzy razy rozmiar opony, kąt pochylenia złożonej goleni, i doszedłem do wniosku, że tak było naprawdę1. Jak pokazuje Rysunek 8.4.18a), w większości ujęć zupełnie tego nie widać, gdyż otwór komory jest nieco większy od koła. Dzięki temu czarna, matowa, wystająca opona nie rzuca się w oczy;
Wewnętrzna powierzchnia koła zagłębia się w dwóch tylnych podłużnicach górnego pokrycia płata (Rysunek 8.4.18c)! Dzięki temu zrozumiałem, dlaczego te dwie podłużnice na zdjęciach mają wyraźne wgłębienia wzdłuż komory podwozia. Nie zamodelowałem ich, bo mało kto w to miejsce modelu będzie zaglądał. Oczywiście, jeżeli chcesz wykonać dokładniejszy model, nie zapomnij o tym szczególe;
Uruchomiliśmy już podwozie, ale czas je wzbogacić o resztę „żelastwa”, które widać na zdjęciach. Zacznij od przygotowania okuć, które mocowały oś do skrzydła (Rysunek 8.4.19a):
Rysunek 8.4.19 Okucia osi podwozia
Na zdjęciach i rysunkach konstrukcyjnych P-40 widać blachy (lub odkuwki) o profilu w kształcie „T”, przynitowane do dźwigara i wręg. Zamodelowałem je jako jeden obiekt (B.660.R.Frame), starannie dopasowując do powierzchni skrzydła. Gdybyś chciał robić jakiś bardzo dokładny model, należałoby odwzorować — np. za pomocą mapy nierówności — wypukłe nity, którymi przymocowano półki tych elementów do płata. Ja jednak przypisałem tym wzmocnieniom standardowy materiał B.Skin.Inner, bez nitów. I tak nie będzie ich prawie widać.
Do blach okuć były przykręcone (za pomocą wielu śrub) kolejne elementy, mocujące oś podwozia (Rysunek 8.4.19b). Mówiąc szczerze, mimo rysunków i paru zdjęć, jakie miałem do dyspozycji, trudno było zdeterminować ostateczny kształt tych części. Kilka razy musiałem je szkicować na kartce papieru, by uświadomić sobie ich wszystkie zakamarki. I w tym przypadku pominąłem kilkanaście śrub, którymi były przykręcone do blach okuć — ich także prawie nie widać.
Następnie dodałem dwie zębatki, które wymuszały obrót goleni podczas składania podwozia (Rysunek 8.4.20a):
Rysunek 8.4.20 Dalsze szczegóły podwozia
Zębatka B.645.R.Cog jest przypisana do obracającej się goleni B.630.R.Leg.(W tym momencie przydało się zamodelowanie goleni jako pełnej siatki: można było z niej łatwo wytłoczyć niesymetryczną wypustkę do umocowania zębatki). Zębatkę B.665.R.Cog przypisałem do nieruchomych okuć osi. Potem dodałem pozostałe elementy: popychacze (B.692.R.Stick) i wzmocnienie poprzeczne (B.686.R.Stick) (Rysunek 8.4.20b). Każde z nich jest przypisane (relacją Parent) do opaski B.635.R.Ring, by składały się wraz z resztą podwozia.
Aby popychacze wykonywały ruch przypominający rzeczywisty, dodałem na ich krańcach końcówki (R.693.R.Stick). Są one przypisane do zupełnie niewidocznej ramki, która je obraca (X.602.R.Transform) (Rysunek 8.4.21):
Rysunek 8.4.21 Mechanizm popychaczy
Ramka X.602.R.Transform ma przypisane ograniczenie Transformation. Dzięki temu podczas składania podwozia wykonuje obrót o taki sam kąt, jak ramka popychaczy. Do ramki są przypisane (relacją Parent) końcówki R.693.R.Stick, więc obracają się wraz z nią. Popychacze B.692.R.Stick mają ustawione ograniczenia Locked Track na swoje końcówki, więc podczas chowania podwozia poruszają się po trajektorii bardzo zbliżonej do rzeczywistej. Mechanizmu, ukrytego wewnątrz skrzydła, nie modelowałem. I tak jest zupełnie niewidoczny.
Wzdłuż goleni P-40 (i większości samolotów) biegnie elastyczny przewód z płynem hamulcowym. Ten detal zamodelowałem za pomocą krzywej (Curve: szczegóły — str. 872), wokół której „owinąłem” rurkę (cylinder) przewodu (za pomocą polecenia Parent→Curve Deform, opisanego na str. 955). Gdyby chodziło o statyczny model, to by wystarczyło. Nasza goleń potrafi się jednak obrócić, i może się w niej ugiąć amortyzator. To zmusiło mnie do zamodelowania przewodu za pomocą trzech oddzielnych krzywych (Rysunek 8.4.22a):
Rysunek 8.4.22 Odwzorowanie przewodu hamulcowego
Krzywe — X.612.R.Curve.001 .. 003 — są łączone wewnątrz dwóch opasek, mocujących przewód do goleni. Na przykład pierwszy segment — X.612.R.Curve.001 (Rysunek 8.4.22b) — ma swój początek (i punkt odniesienia) we wtyczce do tarczy hamulca. Drugi koniec dotyka opaski B.631.R.Nest.001. Aby przewód uginał się elastycznie przy ruchu amortyzatora, krzywa jest powiązana z opaską ograniczeniem Stretch To. Wzdłuż krzywej wygiąłem długi i cienki cylinder przewodu B.612.R.HLine.001 (Rysunek 8.4.22c)
Sprawdźmy, jak „pracuje” przygotowany w ten sposób zespół podczas ruchu amortyzatora (Rysunek 8.4.23):
Rysunek 8.4.23 Ugięcie dolnej części przewodu hamulcowego
Gdy amortyzator jest zupełnie rozciągnięty (bez obciążenia — Rysunek 8.4.23a), ograniczenie Stretch To wydłuża krzywą X.612.R.Curve.001, wraz z powiązany z nią przewodem. Przekrój poprzeczny przewodu staje się wtedy w niektórych miejscach eliptyczny. Przy ugięciu statycznym amortyzatora (Rysunek 8.4.23b) wszystko wygląda normalnie (bo jest to pozycja „neutralna” modyfikatora Stretch To). Przy maksymalnym ugięciu (Rysunek 8.4.23c) na przewodzie pojawiają się nierealistyczne zgrubienie. Zdecydowałem się jednak tak to pozostawić, gdyż w tej pozycji amortyzator będzie się znajdował bardzo rzadko, i tylko przez chwilę. Zresztą w ujęciach z większych odległości ten defekt w ogóle nie będzie widoczny.
Podobnie zamodelowałem środkową część przewodu (X.612.R.Curve.002). Jej górny kraniec był przymocowany do nieruchomej „opaski”, a dolny — obracał się razem z golenią (Rysunek 8.4.24):
Rysunek 8.4.24 Skręcenie środkowej części przewodu
Końcówki przewodu powinny zawsze przechodzić „gładko” w odcinki sąsiednie. Punkt odniesienia krzywej X.612.R.Curve.002 leży na jej dolnym krańcu. Krzywa jest „przymocowana” (relacją Parent) do obracanej części goleni. Podobnie jak poprzedni fragment, jest „rozciągana” ograniczeniem Stretch To, wzdłuż osi Y, do nieruchomej opaski B.631.R.Nest.002 (Rysunek 8.4.24a). Takie rozwiązanie powoduje załamanie przewodu na opaskach w końcowych fazach składania podwozia (porównaj Rysunek 8.4.24b i c). Jednak goleń jest wówczas już zasłonięta pokrywą i ten defekt nie jest widoczny.
Kolejnym elementem zespołu podwozia jest pokrywa goleni (Rysunek 8.4.25):
Rysunek 8.4.25 Pokrywa goleni wraz z popychaczem
Przy otwartym podwoziu jej otwory są dość widoczne, więc zdecydowałem się je wykonać nie teksturą przejrzystości, a „w siatce” (Rysunek 8.4.25a). Najważniejszą częścią pokrywy jest oś (B.165.R.Axis). Przypisałem jej ograniczenie Transformation, by zamykała się w odpowiedni sposób (szczegóły ustawień tego ograniczenia znajdziesz na str. 528). Popychacz i jego okucie (Rysunek 8.4.25b) to kopie elementów z pokryw kółka ogonowego. Popychacz ma przypisane ograniczenie Locked Track.
Oś pokrywy bocznej obraca się w trakcie wysuwania goleni dzięki ograniczeniu Locked Track, kierującemu oś -X na jedną ze śrub2 (Rysunek 8.4.26a):
Rysunek 8.4.26 Pokrywa boczna i jej popychacz
Wraz z osią obraca się połączona z nią „na sztywno” (relacją Parent) pokrywa. Pomiędzy pokrywą a golenią podwozia znajdował się mały popychacz (Rysunek 8.4.26b). Powstał ze złożenia trzech śrub i tyluż elementów „podłużnych”. (To znacznie przerobiony fragment popychacza pokryw kółka ogonowego — por. str. 508, Rysunek 8.3.21). Śruby w tym elemencie nie są tylko „upiększeniem”. Pełnią także rolę „celów” dla poszczególnych ograniczeń Locked Track i Stretch To. W ten sposób unikamy komunikatów w konsoli Blendera o wykryciu zapętlenia w zależnościach pomiędzy obiektami. (Z tego samego powodu dodałem podobne śruby do mechanizmu kółka ogonowego).
Rysunek 8.4.27 prezentuje ostateczny efekt — podwozie główne w kolejnych fazach składania:
Rysunek 8.4.27 Podwozie główne podczas wciągania
Podsumowanie
Dokładne rysunki podwozia samolotu często nie są dostępne. Należy wówczas posłużyć się zdjęciami. Zazwyczaj najlepszej jakości, kolorowe ujęcia pochodzą ze współcześnie odrestaurowanych egzemplarzy. Takie „maszyn z odzysku” powinieneś traktować z pełną rezerwą: w wielu szczegółach mogą się różnić od oryginału! (Zazwyczaj dlatego, że nie zachowały się odpowiednie detale, a ich wierne odtworzenie było zbyt drogie);
Opony koła głównego i kółka ogonowego można pokryć tym samym materiałem (w tym modelu jest to B.Rubber.Tyre str. 511). Gdyby koło główne miało bieżnik (a tak jest w późniejszych wersjach P-40) — trzeba byłoby stworzyć nowy materiał, z odpowiednią teksturą nierówności. Można byłoby jednak w nim powtórnie wykorzystać przynajmniej większość tekstur proceduralnych, które opracowaliśmy w poprzedniej sekcji;
Podwozie główne jest modelowane w ten sam sposób, co kółko ogonowe (str. 512 - 513).Czasami, by uniknąć kłopotliwego łączenia siatek, „łączyłem” dwie powłoki poprzez zwykłe złożenie (str. 515);
Do uzyskania realistycznego ruchu ramion łącznika amortyzatora można użyć ograniczenia Limit Distance (str. 516);
Do „uruchomienia” podwozia używamy zespołu dwóch uchwytów — pomocniczego do ugięcia amortyzatora i głównego do chowania i otwierania (str. 517). Takie samo rozwiązanie zastosowaliśmy w poprzedniej sekcji, do wymuszenia ruchu kółka ogonowego;
Koło podwozia musi być prawidłowo dopasowane do swojej komory (str. 518). Ten proces wymaga zazwyczaj kilku przybliżeń. Czasami można odkryć, że opona jest zbyt szeroka, lub amortyzator miał w pozycji „swobodnej” trochę inną długość;
Okucia, mocujące podwozie, i inne detale mogą przysporzyć dużo pracy, jeżeli chcesz je wykonać dokładnie. Lepiej uważaj, i naucz się w odpowiednim momencie rezygnować z części drobnych, mało widocznych szczegółów!
Do odtworzenia przewodu, doprowadzającego płynem hamulcowym do tarczy koła, najlepiej jest skorzystać z krzywej (Path) i modyfikatora Curve (str. 520);
W poprzednich sekcjach uformowaliśmy i uruchomiliśmy kółko ogonowe i jedno z kół głównych. W tej sekcji pouzupełniamy wszystko, czego jeszcze w podwoziu brakuje, by definitywnie zakończyć ten zespół.
Zacznijmy od wnętrza komory podwozia. W przypadku kółka ogonowego wypełniliśmy ją wręgami już na etapie modelowania (por. str. 275). Uważam, że ten fragment jest niemal na każdym ujęciu niewidoczny, więc nie trzeba go o nic dodatkowego wzbogacać. Co innego z wnętrzem gondoli koła głównego (Rysunek 8.5.1a):
Rysunek 8.5.1 Zamalowane fragmenty płata wewnątrz owiewek goleni podwozia
W P-40 była to wzmocniona powierzchnia płata, pokryta taką samą farbą jak inne powierzchnie wewnętrzne: Curtiss Green. Uznałem, że nie trzeba w tym miejscu zagęszczać siatki skrzydła tylko po to, by przypisać odpowiednim ścianom materiał B.Skin.Inner. Tak więc ten fragment jest pokryty materiałem B.Skin.Camouflage, tak jak cała reszta płata. Po prostu zamalowałem odpowiednie miejsca tekstury barwy (color.png) odpowiednim kolorem (Rysunek 8.5.1b). Zrobiłem to na nowej warstwie — Color-Inner — w źródłowym pliku skin.xcf.
Poza barwą, warto wzbogacić ten fragment poszycia o zarys blach, naniesionych w charakterze wzmocnienia, nity, oraz małe otwory (Rysunek 8.5.2):
Rysunek 8.5.2 Odwzorowanie szczegółów powierzchni płata wewnątrz owiewki podwozia
Nity na wszystkich powierzchniach wewnętrznych były wypukłe (bo naniesienie takiego szwu było mniej pracochłonne i tańsze, a sam szew — bardziej wytrzymały). Naniosłem więc zespół białych „kółek” na odpowiednią warstwę rysunku skin.svg. Na tym rysunku wektorowym znalazło się także wzmocnienie wokół otworów w skrzydle (Rysunek 8.5.2a), oraz same otwory. Z pliku skin.svg powtórnie wygenerowałem ponownie wszystkie pliki rastrowe, by uzyskać nowe obrazy tekstur (zgodnie ze schematem ze str. 468). Rezultat zastosowania tych poprawionych tekstur pokazuje Rysunek 8.5.2b).
Teraz można skopiować zespół prawego koła w koło lewe. Takich całości lepiej nie powielać poleceniem Mirror, bo potem poprawianie rezultatu może zająć dużo czasu. Lewe koło stworzymy jako „klon” prawego (w ten sposób obiekty wchodzące w skład lewego koła będą wykorzystywać te same siatki, co koło prawe). Przed zaznaczeniem elementów do skopiowania pamiętaj, aby oprócz warstwy 5 (podwozie) włączyć także warstwę nr 9, z pomocniczymi obiektami (zawiera pomocnicze krzywe, „wyginające” przewód hydrauliczny) (Rysunek 8.5.3):
Rysunek 8.5.3 Przygotowanie do skopiowania podwozia
Obiektem nadrzędnym prawie całego zespołu podwozia jest ramka B.660.R.Frame (por. Rysunek 8.5.3). Zaznacz wszystkie obiekty potomne tej ramki (Najlepiej poleceniem Select→Grouped→Children). Tylko pamiętaj, że po wywołaniu tego polecenia należy włączyć do zbioru selekcji także samego „rodzica” (Rysunek 8.5.4a)! Potem sklonuj podwozie (Alt-D):
Rysunek 8.5.4 Skopiowanie (sklonowanie) podwozia
Po wywołaniu polecenia nie przesuwaj klona podwozia w nowe miejsce. Zamiast tego przypisz na czas pracy wszystkie zaznaczone obiekty do dodatkowej warstwy (Rysunek 8.5.4b). Powinna to być jakaś pusta warstwa, której w tej chwili nie używamy. Proponuję użyć do tego celu warstwę 17.
Pozostaw teraz włączoną tylko warstwę 17 (Rysunek 8.5.5a). Zaznacz ponownie ramkę i przenieś ją na lewą stronę modelu, zmieniając znak jej współrzędnej X na ujemny (Rysunek 8.5.5b):
Rysunek 8.5.5 Zmiana położenia lewego podwozia
Teraz możesz już z powrotem włączyć widoczność warstwy 5 (podwozia) Gdy przyjrzysz się rezultatowi, zauważysz w lewym kole potwornie rozciągnięty popychacz (Rysunek 8.5.6a):
Rysunek 8.5.6 Efekty uboczne zmiany położenia
To rezultat przypisanego ograniczenia, które pozostało skierowane na obiekt przypisany do pokrywy prawego podwozia. Dopóki go nie skopiujemy, zmniejsz wpływ tego efektu do zera (Influence = 0 — Rysunek 8.5.6b).
Następnie zmień nazwę ramki lewego koła na B.660.L.Frame (Rysunek 8.5.7) i przerzuć cały zespół w poziomie, zmieniając skalę tego obiektu wzdłuż osi X na ujemną (Rysunek 8.5.8):
Rysunek 8.5.7 Zmiana nazwy ramki | Rysunek 8.5.8 Zmiana skali ramki wzdłuż osi X na ujemną |
Na koniec przypisz ramkę lewego koła (obiekt B.660.L.Frame) do lewego skrzydła (poleceniem Set Parent To→Object (Keep Transform)). W podobny sposób sklonuj i przerzuć na lewą stronę popychacz X.606.R.Transform (por. Rysunek 8.5.3). To element jest symetryczny, więc nie trzeba mu zmieniać skali na ujemną. Pamiętaj tylko, że ma przypisane ograniczenie Transformation (powiązane z uchwytem sterującym podwoziem — por. str. 520, Rysunek 8.4.21). Przed przypisaniem popychacza do lewego skrzydła poleceniem Set Parent zmniejsz wpływ tego ograniczenia (Influence) do zera. Potem z powrotem możesz przestawić je na 1. Jeżeli o tym zapomnisz, Blender w wyniku jakiegoś błędu ustawi go w przestrzeni pod dziwnym kątem.
Teraz czeka nas trochę żmudnej pracy „porządkowej”: zmiana nazw wszystkich obiektów, wchodzących w skład skopiowanego zespołu. Blender domyślnie dodał do nich końcówki „.001”, „.002” (albo niektórym z nich takie końcówki usunął). By mieć porządek w modelu, musimy poprawić wszystkie nazwy, zmieniając w nich symbol strony z „R” na „L”. Aby niczego nie przeoczyć, rób to metodycznie, zaczynając np. od góry (Rysunek 8.5.9):
Rysunek 8.5.9 Porządkowanie nazw
Przesuwaj się sukcesywnie do dołu, aż nie poprawisz nazw całego zespołu. Na koniec sprawdź, czy o czymś nie zapomniałeś, przeglądając ten fragment w oknie Outliner (por. str. 63).
Zmiana nazw wszystkich części lewego koła jest okazją do starannego przejrzenia wszystkich jego zakamarków. Zwróć szczególną uwagę na niesymetryczne obiekty z przypisanymi ograniczeniami Stretch To. W naszym przypadku były to dwie krzywe, odpowiedzialne za wygięcie przewodów hydraulicznych. Gdy się im przyjrzysz, zauważysz że na lewym kole mają inny, nieprawidłowy kształt (Rysunek 8.5.10):
Rysunek 8.5.10 Wpływ ograniczenia Stretch To na kopie krzywych
Wynika to z faktu, że wszystkie obiekty lewego koła mają przestawiony zwrot osi X (to skutek ujemnej skali ramki — por. Rysunek 8.5.8). Ograniczenie Stretch To przestawia ten kierunek z powrotem na pozytywny…
Takie problem może się pojawić dla obiektów, które używają ograniczenia Stretch To i są niesymetryczne względem lokalnej osi Y.
Aby sobie z nim poradzić, trzeba na chwilę wyłączyć taki obiekt z hierarchii zespołu, „utrwalić” (Apply→Scale) jego krzywej taką ujemną skalę, a potem skorygować orientację obiektu i krzywej (lub siatki). Szczegółowy opis jak to zrobić znajdziesz na str. 863. Podczas tej operacji koniecznie jest m. in. utworzenie indywidualnych instancji krzywych dla lewego i prawego podwozia. Skorygowane krzywe przewodów z płynem hamulcowym przedstawia Rysunek 8.5.11:
Gdy podstawowy zespół lewego koła jest gotowy, zajmiemy się jego pokrywami. W przypadku pokrywy głównej wystarczy przypisać jej osi (B.165.L.Axis) takie same ograniczenie Transformation jakie przypisaliśmy osi z prawej gondoli (Rysunek 8.5.12a):
Rysunek 8.5.12 Mechanizacja głównej pokrywy podwozia
To ograniczenie przekłada przesunięcie głównego uchwytu (X.600.Handle) na obrót osi pokrywy, Zwróć uwagę na „śledzony” zakres współrzędnych Z (Source:Z). Choć pełen zakres ruchu uchwytu w tym kierunku to od Z=-20 do Z=-10, to obrót pokrywy rozpoczyna się dopiero w ostatniej fazie składania goleni. (W ten sposób unikam kolizji pokrywy z golenią). Gdy pokrywa jest w pozycji otwartej, można klonować (Alt-D) z prawego podwozia popychacz pokrywy i jego okucie. Przed skopiowanie warto zmniejszyć wpływ ograniczenia Locked Track, przypisanego popychaczowi B.158.R.Stick.001, do zera. „Rodzicem” kopiowanego zespołu jest obiekt B.157.L.Nest.001 (to nazwa po już zmianie). Przekształć go tak samo jak zrobiliśmy to z ramką lewego koła (por. str. 526). Przypisz ten zespół do lewej pokrywy gdy jest w pozycji otwartej (Rysunek 8.5.12c).
Analogicznie jak pokrywę goleni, „uruchom” pokrywę boczną. Zacznij od dopasowania „spoczynkowego” kąta osi obrotu (gdy podwozie jest zamknięte) (Rysunek 8.5.13a), a potem przypisz jej odpowiednie ograniczenie Locked Track (Rysunek 8.5.13b):
Rysunek 8.5.13 Dopasowanie zakresu kątów pokrywy bocznej
Gdy przypiszesz już jej wszystkie ograniczenia i popychacz, można sprawdzić działanie pełnego zespołu podwozia głównego (Rysunek 8.5.14):
Rysunek 8.5.14 Test składania całego podwozia głównego
Składa się całkiem realistycznie, nieprawdaż? Skoro tak, to po co nam dwie pary uchwytów — jeden do kół głównych, a drugi do kółka ogonowego ? Przypisz im odpowiednie ograniczenia Transformation, wiążące ich ruch z ruchem uchwytów X.600.Handle i X.601.Handle (ich szczegóły podaje Rysunek 8.5.15):
Rysunek 8.5.15 Parametry ograniczeń Transformation przypisanych do uchwytów kółka ogonowego
W ten sposób chowaniem i wysuwaniem podwozia naszego modelu steruje jeden uchwyt — X.600.Handle, a ugięcie wszystkich amortyzatorów można ustawić za pomocą uchwytu pomocniczego — X.601.Handle.
Nim ukończymy ten model, takich uchwytów jak podwozia będzie potrzeba więcej: do sterów, lotek, klap... Przydałaby się do nich jakaś „panel sterowania”, aby nie trzeba było ich szukać po przestrzeni modelu.
Przygotowując sobie warsztat pracy w Blenderze, parę lat temu stworzyłem właśnie taką uniwersalną panel sterowania modelem. Jest to dodatekHandle Panel (dołączony do innych dodatków Blendera, towarzyszących tej książce). Szczegółowy opis, jak się nim posługiwać, znajdziesz na str. 877. Skrypt jest uniwersalny, bo samoczynnie wykrywa w pliku modelu wszystkie uchwyty. Muszą to być po prostu obiekty o nazwie zakończonej przyrostkiem *.Handle, z przypisanym ograniczeniem Limit Location (por. str. 878). Muszą być także przypisane (relacją Parent) do jakiegoś obiektu nadrzędnego („rodzica”). Środek takiego obiektu jest traktowany przez skrypt jako „położenie domyślne” uchwytu. Załóżmy, że domyślnie podwozie ma być schowane. Stwórz w górnym położeniu uchwytu X.600.Handle nowy, pusty (Empty) obiekt (Rysunek 8.5.16a), i nadaj mu nazwę X.600.Base. Przypisz X.600.Handle do X.600.Base 1, a X.600.Base — do kadłuba (B.300.Fuselage). Hierarchia tego fragmentu powinna wyglądać tak, jak to pokazuje Rysunek 8.5.16b):
Rysunek 8.5.16 Przypisanie do uchwytu „punktu odniesienia”
Z kolei „rodzicem” pomocniczego obiektu, sterującego ugięciem amortyzatora (B.601.Handle) jest główny uchwyt podwozia (B.600.Handle). W efekcie domyślnym położeniem amortyzatora jest pełne rozciągnięcie (w tej pozycji były rzeczywiście chowane).
Położenie obiektów X.500.Handle i X.501.Handle, sterujących położeniem kółka ogonowego, uzależniliśmy od uchwytów podwozia głównego. Aby te obiekty nie zostały zidentyfikowane przez skrypt jako uchwyty (ich położenie jest związane z X.60*.Handle), musisz zmienić im nazwę — np. na X.500.Control i X.501.Control. Na razie Handle Panel tworzy tylko dwa panele (Rysunek 8.5.17):
Rysunek 8.5.17 Panel sterowania modelem (na razie tylko dwa uchwyty podwozia)
Dzięki panelowi sterowania nie musisz się zastanawiać, do czego służy konkretny uchwyt. (Parę miesięcy po zakończeniu modelu możesz już mieć taki dylemat). W Handle Panel udostępnia wszystko czytelnie poopisywane. Z czasem okno tego skryptu zapełni się panelami różnorodnych uchwytów.
Podsumowanie
Aby nie komplikować niepotrzebnie siatki, część powierzchni wewnętrznych można namalować wprost na teksturze kamuflażu (str. 524);
Zespół drugiego koła (prawego, lewego — w zależności od tego, które wykonałeś jako pierwsze) najlepiej jest stworzyć poprzez sklonowanie (str. 526). Potem rezultat tej operacji wymaga jeszcze trochę pracy, m.in. poprawienia nazw skopiowanych obiektów (str. 527);
„Lustrzane odbicie” zespołu podwozia najprościej uzyskać, zmieniając skalę na ujemną dla kilku wybranych obiektów (str. 526). (Chodzi zazwyczaj o jeden lub dwa elementy, znajdujące się „na szczycie” hierarchii całego zespołu);
Pokrywy podwozia powstają zazwyczaj wcześniej niż koła i golenie — już podczas modelowania powierzchni samolotu (por. str. 246 i dalsze). Najlepiej dopasować je do reszty zespołu podwozia w pozycji „złożonej” (str. 528 - 529);
Całe podwozia — główne i ogonowe — można „sprząc” ze sobą tak, by było sterowane pojedynczym zespołem uchwytów (str. 529);
Na koniec warto uporządkować nazwy wszystkich pomocniczych obiektów. Tylko nazwy „prawdziwych” uchwytów mogą mieć przyrostek „*.Handle”. Dobrze jest także przypisać je (relacją Parent) do elementów, których środki wyznaczają „położenie neutralne” (str. 530). To wszystko pozwoli później na prawidłową identyfikację zakresu ruchu całego zespołu przez specjalną „paneli sterowania” (Handle Panel — str. 530);
Budując wnętrze kabiny, trzeba polegać głównie na zdjęciach - jakiekolwiek rysunki na planach modelarskich są niemal zawsze za mało dokładne. Podczas budowy modelu stosowaliśmy zasadę „jeżeli czegoś nie odwzorowujesz, to przynajmniej przygotuj tak, aby łatwo można było zrobić to później”. Dzięki niej podczas formowania kadłuba przygotowaliśmy wewnętrzną powłokę kokpitu, wraz z wręgami i podłużnicami (por. str. 238).
Pracę nad kabiną najlepiej jest zacząć od przełączenia wewnętrznej powłoki z domyślnego trybu wyświetlania Textured w tryb Wire (zestaw Object, panel Display). Ułatwia to znacznie dalsze prace, bo możesz teraz widzieć na wskroś poprzez powierzchnię kadłuba (Rysunek 8.6.1):
Rysunek 8.6.1 Przygotowanie szkieletu kadłuba i poszycia kabiny
Kolejnym krokiem jest powtórne zweryfikowanie kształtu i rozłożenia elementów szkieletu wewnątrz kabiny (Rysunek 8.6.1a) . Porównaj je starannie z dostępnymi zdjęciami. To bardzo ważne, bo potem krzyżujące się wręgi i podłużnice będą służyły Ci za coś w rodzaju „siatki odniesienia”. Analizując fotografie, będziesz mógł na ich podstawie szacować wielkość pozostałych elementów wyposażenia. Przy okazji możesz zdecydować się na jakieś uszczegółowienia ich kształtu — na przykład zdecydowałem się zmienić przekrój głównej podłużnicy z „C” ma „H”, bo taki widać na zdjęciach (Rysunek 8.6.1b).
Zdjęcia kabiny przytłaczają liczbą szczegółów. Nie przejmuj się tym tak bardzo! Przyjrzyj się fotografiom i wyodrębnij na nich elementy podstawowe (te, do których są przymocowane pozostałe) (Rysunek 8.6.2):
Rysunek 8.6.2 Podstawowe „bryły” wyposażenia kabiny
Zazwyczaj zidentyfikujesz i stworzysz tablicę przyrządów (wraz ze stelażem), oraz parę „pudełek” i „płytek”, ciągnących się wzdłuż lewej (Rysunek 8.6.2a) i prawej (Rysunek 8.6.2b) strony kabiny. Krawędzie „pudełek” warto fazować (poleceniem Bevel — por. str. 961). Przygotuj także dwa nowe materiały (możesz je skopiować z B.Inner.Details). Pierwszym: B.Skin.Cockpit, pokryj „wszystko, co nie jest czarne”. Drugim — B.Black.Instruments — pokryjesz „wszystko, co czarne” (tablicę przyrządów, pokrętła, itp.).
Materiał B.Black.Instruments będzie miał przypisane oddzielne tekstury, na których odwzorujemy wszystkie drobne szczegóły: tabliczki z napisami, tarcze przyrządów pokładowych. Trochę „na doczepkę” zaliczyłem do nich także wystające w kabinie zamki „półcalówek” Browninga. (Na zdjęciach także są czarne i mają taki sam połysk, co tablica przyrządów). Przygotuj rozwinięcia siatek należących do tego materiału. Aby uzgodnić ich położenie w UV, przypisz wszystkie do pomocniczego obrazu o nazwie Test-Instruments (Rysunek 8.6.3):
Rozwinięcia ułóż tak, by zostawić na teksturze dużo wolnego miejsca — umieścimy tam powiększone obrazy tarcz instrumentów pokładowych, i różnych innych „opisanych” elementów. (Na przykład: bloku sterowania przepustnicą, mieszanką i skokiem śmigła, pokręteł trymerów, itp.).
Należy oczekiwać, że ciekawscy obserwatorzy będą częściej zaglądać do kabiny niż do luków podwozia. Warto więc zastosować w materiale B.Skin.Cockpit odpowiednią mapę nierówności, odwzorowującą łączenia blach i nity, a także mapę barw, odwzorowującą różnorodne przetarcia, zadrapania i zabrudzenia. Aby to było możliwe, rozwiń w UV odpowiednie powierzchnie (Rysunek 8.6.4). By nie było ich zbyt dużo, możesz pominąć drobniejsze elementy, przypisując je do materiału B.Inner.Details. Dla uproszczenia rozwinąłem tylko symetryczną połówkę kadłuba (zabrudzenia będą lustrzanym odbiciem, ale to nie powinno razić).
Zdecydowałem się odwzorować już na tym etapie fotel pilota (Rysunek 8.6.5b). (Jest najbardziej „wyeksponowany”, i na pewno będzie miejscami zabrudzony, więc trzeba go także wkomponować w rozwinięcie UV).
Rysunek 8.6.5 Stelaż i fotel pilota
W P-40 stosowano dwa rodzaje foteli pilota i stelaży, w zależności od odbiorcy: „brytyjski” i „amerykański” . Samoloty AVG miały, wg Hume Batesa ([7] ), kanciasty model „brytyjski”, na prostym stelażu (Rysunek 8.6.5a).
Tekstury dla materiału B.Skin.Cockpit uzyskamy w ten sam sposób, jak tekstury powierzchni zewnętrznych samolotu (por. str. 405 - 425). Przygotujemy je w oddzielnych plikach, w podkatalogu o nazwie cockpit. (Uważam, że oddzielny folder jest wygodniejszym do rozróżniania plików z obrazami tekstur, niż dodawania jakichś przedrostków do ich nazw).
Najpierw wyeksportuj z Blendera rozwinięcia siatek (tych, które pokazywał Rysunek 8.6.4) w formacie SVG, i złóż je w Inkscape (por. str. 1130), w pliku cockpit\cockpit.svg. Obraz cockpit\cockpit.svg będzie mniejszy od obrazu powierzchni zewnętrznych — nadaj mu rozmiar, powiedzmy, 1024x1024px. Potem przygotuj podobne warstwy, jak w pliku skin.svg (por. str. 401). (Niektóre możesz pominąć, bo ten rysunek nie będzie miał takich elementów, jak cienie pod nitami lub zagłębienia pod śrubami). Narysuj na nich obraz nierówności wnętrza kabiny (Rysunek 8.6.6):
Rysunek 8.6.6 Przygotowywanie w Inkscape tekstury nierówności (plik cockpit\cockpit.svg)
Sprawdź w Blenderze, jak ta mapa nierówności „leży” na siatkach, i nanieś odpowiednie poprawki. Gdy będzie gotowa — połącz w Inkscape poszczególne warstwy w grupy (por. str. 405). Skomponuj z klonów tych grup na oddzielnej warstwie obraz map nierówności (Result:Nor). Używając odpowiednich filtrów (por. str. 742) przygotuj z klonów tych samych warstw mapę odbić (ref.png — por. str. 413-417). Podobnie jak w pliku skin.svg, będzie złożenie trzech warstw: Result:Ref-Blur, Result:Ref-Grunge, Result:Ref-Other (Rysunek 8.6.7):
Rysunek 8.6.7 Tekstura odbić (cockpit\ref.png) | Rysunek 8.6.8 Tekstura barwy (cockpit\color.png) |
Obraz rozwinięć UV wyeksportuj z Inkscape do pliku rastrowego, i wczytaj do Gimpa (jako plik cockpit\cockpit.xcf). Posługując się tymi samymi technikami, co w sekcji „Tekstura barwy” (str. 425) stwórz obraz tekstury barwy. Rezultat wyeksportuj do pliku cockpit\color.png.
Przygotowaliśmy w ten sposób trzy obrazy dla odpowiednich tekstur materiału B.Skin.Cockpit:
plik cockpit\nor.png zawiera obraz dla tekstury nierówności (cockpit-nor);
plik cockpit\ref.png zawiera obraz dla tekstury odbić (cockpit-ref);
plik cockpit\color.png zawiera obraz dla tekstury barwy (cockpit-color);
Na razie użyłem tych tekstur tak samo jak w materiale B.Skin.Camouflage, podłączając je do komponentu X.Textured Skin. Powstała w ten sposób jego uproszczona wersja — B.Skin.Cockpit (Rysunek 8.6.9):
Rysunek 8.6.9 Schemat materiału B.Skin.Cockpit (uproszczona wersja B.Skin.Camouflage)
Rysunek 8.6.10 przedstawia render, stworzony z zastosowaniem tego materiału. (Aby rozproszyć nieco cienie, oświetlam kabinę pomocniczym światłem typu Sun o Strength = 5, Size = 1, Cast Shadows = Off):
Rysunek 8.6.10 Rezultat zastosowania materiału B.Skin.Cockpit
Podłogą kabiny jest górna powierzchnia płata (Rysunek 8.6.10a). Obszary zakryte, tak jak ten, były nitowane za pomocą zwykłych nitów z łbami wypukłymi (a nie wpuszczanymi, jak na powłokach zewnętrznych). Jak przystało na podłogę, musi być zabrudzona, szczególnie tam, gdzie najczęściej stawiano stopy: w okolicach pedałów orczyka. Dodatkowo wzbogaciłem ją serią innych niewielkich zabrudzeń i zadrapań.
Fotel pilota (Rysunek 8.6.10b) należy zawsze do najbardziej „wytartych” elementów kabiny. Ten sam typ siedzenia był wykorzystywany w innym samolocie, produkowanym dla Wielkiej Brytanii: North American „Mustang”. Dokumentacja tego detalu to kilka zdjęć z restauracji P-51A, które znalazłem w Internecie. Wygląda na to, że o ile siedzenia pilota P-40 w USAAF pozostawiano w kolorze naturalnego duralu, to te fotele były malowane. W przypadku „Mustanga” były szaroniebieskie (farba Dull Grey)? Mogę tylko spekulować, w jakim kolorze były w samolotach AVG, więc pozostawiłem je w Curtiss Green, tak jak resztę kabiny.
Materiał B.Black.Instruments odpowiada niemal czarnej, połyskliwej powierzchni tablicy przyrządów. Dla tak ciemnej barwy nie można zastosować naszego uniwersalnego shadera Glossy Paint (jest w tym przypadku za mało połyskliwy). Musiałem poszukać innego rozwiązania. Ostatecznie zdecydowałem się wykorzystać połączenie 70% szorstkiej lecz połyskliwej powierzchni (shader Glossy) i 30% jeszcze bardziej szorstkiej lecz jaśniejszej anizotropowej1 powierzchni metalu (shader Anisotropic — Rysunek 8.6.13):
Rysunek 8.6.11 Wstępny schemat materiału B.Black.Instruments
Ten schemat B.Black.Instruments to moja propozycja rozwiązania dla takiego materiału. Nie traktuj go jako czegoś ostatecznego, być może uda Ci się uzyskać lepszy efekt w odmienny sposób.
Tablica przyrządów jest najbardziej wyeksponowanym fragmentem kabiny pilota, więc warto jej poświęcić nieco więcej uwagi. Zaczniemy od naniesienia w Inkscape miejsc na tarcze przyrządów (Rysunek 8.6.12):
Rysunek 8.6.12 Przygotowanie tekstury otworów (głównie z myślą o tablicy przyrządów)
Pod rozwinięcia UV podstawiłem zdjęcie prawdziwej tablicy, i naniosłem w odpowiednich miejscach czarne koła. Stworzony w Inkscape rysunek wyeksportuj do pliku rastrowego instruments\holes.png.
W trybie wyświetlania Textured podstaw go w Blenderze pod rozwinięcia siatek (jako plik przypisany do obrazu Test-Instruments — Rysunek 8.6.13). Sprawdź, czy nie są zdeformowane:
Rysunek 8.6.13 Dopasowanie obrazu otworów do rozwinięcia siatek (3D View, tryb Textured) | Rysunek 8.6.14 Test zastosowania tekstury otworów |
Tarcze każdego wskaźnika, umieszczonego na tablicy, znajduje się w odpowiednim otworze. Przy krawędziach tych otworów widać okrągłe łby śrub, mocujących przyrządy. Śruby odwzorujemy za pomocą mapy nierówności. Otwory na tarcze przyrządów można byłoby zamodelować w siatce (wielu modelarzy tak robi). Ja jednak zaproponuję tu alternatywne rozwiązanie: zamiast wycinać dziury w siatce — uzyskajmy je za pomocą tekstury przejrzystości (Rysunek 8.6.14). Efekt jest równie dobry jak przy modelowaniu, nawet przy użyciu obrazu o umiarkowanej rozdzielczości. (Użyłem tu pliku instruments\holes.png, który ma rozdzielczość 1024x1024 pikseli. Odpowiada takiemu rozwinięciu UV siatek, jakie pokazuje Rysunek 8.6.3 ze str. 533).
Blacha na krawędziach otworów w tablicy była wygięta do środka (typowy efekt technologii tzw. cięcia gumą). Aby odtworzyć ten szczegół, przygotowałem odpowiednią mapę nierówności (Rysunek 8.6.15a):
Rysunek 8.6.15 Szczegóły tekstury nierówności
Otwory na obrazie (instruments\nor.png) tekstury nierówności są otoczone obrysem, wypełnionym odpowiednim gradientem kołowym (Rysunek 8.6.15c). Daje to całkiem poprawny rezultat (Rysunek 8.6.15b).
W tak przygotowane otwory wstawimy przyrządy. Większość z nich miała niemal identyczne oprawy (na tablicy występują w zasadzie tylko dwie średnice tarcz — wyjątkiem jest sztuczny horyzont). W tej sytuacji proponuję stworzyć większość opraw jako klony jednej siatki B.711.Dial (Rysunek 8.6.16):
Rysunek 8.6.16 „Oprawa” wskaźnika
Oprawa składa się z cylindra, pokrytego czarnym, połyskliwym materiałem (B.Black.Details). W środek cylindra wstawiłem płytkę imitującą szkło (Rysunek 8.6.16a). Ta część jest pokryta materiałem B.Glass.Dials — prostym szkłem o przejrzystych cieniach (por. str. 1009). Testowy render tej części przedstawia Rysunek 8.6.16b).
W środku oprawy umieściłem oddzielny obiekt. W tym przypadku to B.712.Tacho — płaska płytka, na której znajduje się rysunek tarczy przyrządu (pokryta materiałem B.Black.Instruments) (Rysunek 8.6.17):
Rysunek 8.6.17 Tarcza wskaźnika
Potem pozostaje tylko umieścić oprawę w tablicy (najlepiej w trybie Textured, by trafić dobrze w otwór — Rysunek 8.6.18a). Rezultat na renderze pokazuje Rysunek 8.6.18b):
Rysunek 8.6.18 Osadzenie wskaźnika w tablicy
Zwróć uwagę na szczelinę pomiędzy krawędzią otworu w tablicy przyrządów a oprawą tarczy wskaźnika (Rysunek 8.6.18b). Takie same szczeliny widać na zdjęciach z prawdziwych kabin P-40. W tej chwili nieco rażą, bo prześwituje przez nie obraz otoczenia. Przestaną być widoczne gdy włączysz warstwy z nosem kadłuba.
Wykonaj wszystkie wskaźniki tablicy przyrządów w ten sam sposób co B.712.Tacho: jako zespół klon siatki oprawy (B.712.Dial) i „indywidualnej” tarczy. Muszę przyznać, że najbardziej pracochłonną czynnością było ich narysowanie. (Wskazówki dot. szybkiego rysowania skali na tarczy przyrządu znajdziesz na str. 720). Stworzyłem je w Inkscape, na podstawie dostępnych zdjęć (Rysunek 8.6.19):
Rysunek 8.6.19 Tekstura barwy materiału B.Black.Instruments z narysowanymi tarczami wskaźników
Tarcze są dość duże — ich rozmiar dobrałem tak, by po eksporcie do obrazu rastrowego instruments\color.png, o wymiarach 1024x1024, nadal wyglądały w miarę dokładnie. Stworzenie takiego rysunku wymagało kilku godzin pracy. Rozdzielczość większości zdjęć kabiny, którymi dysponowałem, nie pozwalała na dokładne odczytanie cyfr i opisów na tarczach wskaźników. Czasami musiałem szukać podobnych przyrządów w konstrukcjach pokrewnych, np. w P-51. Rezultat wyszedł jednak dość zadowalająco (Rysunek 8.6.20):
Rysunek 8.6.20 Render tablicy przyrządów, po wstawieniu wszystkich wskaźników
Teraz pozostaje uzupełnić tablicę przyrządów o kilka ostatnich detali (Rysunek 8.6.21):
Rysunek 8.6.21 Tablica przyrządów, uzupełniona o pozostałe szczegóły
Umieszczono na niej kilka plakietek z napisami (4, 5, 6, 7), wskaźnik ostrzegawczy przegrzania silnika (3), oraz parę przełączników (1, 2, 7). Siatki elementów, na których znajdował się tekst lub inny znak graficzny warto nanieść na teksturę barwy instruments\color.png (Rysunek 8.6.22a):
Rysunek 8.6.22 Napisy na detalach tablicy przyrządów — kolejny fragment obrazu instruments\color.png
(Nie będę tu opisywał tworzenia i rozwijania siatek, bo są trywialne — sądzę, że sam już dobrze wiesz, jak je wykonać). Rozwinięcia dodałem do warstwy UV w pliku instruments\instruments.svg. Posługując się Inkscape, naniosłem na nie odpowiednie napisy i inne elementy (np. białe krawędzie). Na warstwie Screws dodałem także do grupy #Screws śruby, umieszczone w narożnikach plakietek. Po wygenerowaniu kolejnej wersji mapy kolorów (instruments\color.png) i nierówności (instruments\nor.png) uzyskałem efekt jak na renderze, który pokazuje Rysunek 8.6.21.
Zwróć może uwagę (por. Rysunek 8.6.21), że w niektórych elementach tablicy przyrządów wykorzystałem inne materiały, niż B.Cockpit.Instruments. Uchwyt przełącznika iskrowników (1) był czerwony, więc cały jest w materiale B.Red.Details. (To kopia materiału B.Skin.Inner ze zmienionym kolorem — dla drobnych detali bez rozwinięć UV). Podobnie przełączniki na plakietkach 2 i 7 to klony tej samej siatki, przypisane do materiału B.Steel.Smooth (bo ten materiał zapewnia im najbardziej odpowiedni „odblask”).
Tablica przyrządów jest już gotowa. To jednak dopiero „przygrywka” do dalszej pracy nad wnętrzem kabiny. Czeka nas jeszcze wykonanie mnóstwa drobiazgów. Rysunek 8.6.23a) przedstawia wykończone wnętrze wiatrochronu:
Rysunek 8.6.23 Szczegóły wnętrza wiatrochronu
Pomiędzy prętami owiewki umieściłem ramkę z szybą pancerną. Szyba miała grubość 1.5 cala (38 mm). Nie byłem pewien, czy miała taki sam zielonkawy odcień, jak na P-40E. Przypisałem jej więc ten sam materiał „szkła”, jaki został użyty w pozostałych szybach owiewki (B.Glass.Canopy).
Ramka i szkło szyby pancernej to jedna siatka (użyłem w niej dwóch różnych materiałów). Część nieprzeźroczysta jest pokryta materiałem B.Skin.Inner. (To zbyt drobny element, by przypisywać mu materiał wymagający rozwinięcia siatki w UV). Zwróć uwagę na zaokrąglony bok kanału wentylacyjnego (Rysunek 8.6.23a). To także część tej samej siatki. Nie użyłem tu nawet wygładzania powierzchnią podziałową (Subsurf), by nie komplikować niepotrzebnie modelu. Te zaokrąglenie są stworzone w istocie przez cztery ściany. Cały trick polega na doborze w modyfikatorze Edge Split tego obiektu odpowiedniej wartości granicznego kąta pomiędzy ścianami Split Angle — na nieco większą niż 45º (Rysunek 8.6.24).
W maszynach produkowanych dla USAAC przed szybą pancerną był umieszczony reflektor celownika (Rysunek 8.6.23a). Projektor celownika była montowany nietypowo, na podłodze kabiny (Rysunek 8.6.23b). To rozwiązanie odziedziczone po P-36. Samoloty produkowane dla Wielkiej Brytanii miały klasyczny, jednoczęściowy celownik refleksyjny za szybą pancerną.
Kłopoty mieli za to zbrojmistrze AVG, otrzymawszy brytyjskie samoloty bez celowników. Po wielu „podchodach” udało im się uzyskać amerykańskie projektory podłogowe (takie, jakie pokazuje Rysunek 8.6.23b). Musieli jednak sami do nich dorobić prowizoryczne reflektory (Rysunek 8.6.25).
Aby się w tych wszystkich szczegółach nie pogubić, w dalszej pracy nad kabiną proponuję przyjąć zasadę „wykańczania strefy”. Dzielisz w niej kabinę na kilka stref: wnętrze wiatrochronu, otoczenie tablicy przyrządów, lewą burtę, podłogę, prawą burtę. Każdą z nich wypełniasz wszystkimi detalami, i nie przechodzisz do następnej dopóty, dopóki aktualna nie będzie zupełnie wykończona. (Chodzi tu o pozostawienie wszystkiego — modelu, materiałów, tekstur — w takim stanie, byś nie musiał do nich nigdy wracać, by cokolwiek zmienić).
Pierwszą strefę — wnętrze wiatrochronu — już wykończyliśmy (por. Rysunek 8.6.23, str. 541), pora teraz uzupełnić detale wokół tablicy przyrządów (Rysunek 8.6.26):
Rysunek 8.6.26 Detale wokół tablicy przyrządów
Najbardziej okazałym elementem tej strefy są pedały orczyka. Wnętrze kabiny wykonuję w sposób uproszczony, stąd zdecydowałem się użyć w obydwu tej samej siatki. W konsekwencji w przestrzeni UV materiału B.Skin.Cockpit istnieje tylko jedno rozwinięcie tego elementu. Wadą takiego podejścia jest identyczny układ rys i zabrudzeń na każdym z pedałów, ale nie rzuca się to specjalnie w oczy. Zaletą jest możliwość użycia przez siatkę większej powierzchni tekstury. Przyniosło to szczególnie dobry efekt w przypadku tekstury nierówności.
Oprócz orczyka odtworzyłem wiele innych detali — np. uchwyty służące do przeładowywania karabinów skrzydłowych, regulator ciśnienia tlenu, czy przełącznik sterujący odladzaniem gaźnika (Rysunek 8.6.26).
W trakcie kolejnych prób spróbowałem się wykorzystać w innych materiałach efekt „metalicznego połysku”, uzyskany w materiale B.Black.Instruments. W tym celu połączyłem jego shadery (por. str. 536, Rysunek 8.6.11) w bardziej poręczną grupę, którą nazwałem Metallic Paint (Rysunek 8.6.27):
Rysunek 8.6.27 Nowy shader — Metallic Paint
Tak przygotowany shader użyłem w materiale B.Skin.Cokpit. Wcześniej wykorzystywaliśmy tu grupę X.Textured.Skin (por str. 535, Rysunek 8.6.9), która wewnętrznie była oparta na shaderze Gloss Paint. Uzyskany w ten sposób efekt był zbyt matowy. Na przykład, mimo zastosowania pomocniczego źródła oświetlenia, nie było widać wyraźnie napisu wytłoczonego na powierzchni pedałów orczyka (w takim ujęciu jak to, pokazane na str. 542, Rysunek 8.6.26). Dlatego, aby podkreślić podobne detale, spróbowałem wstawić w miejsce grupy X.Textured.Skin nowy zespół węzłów, oparty o shader Metallic Paint (Rysunek 8.6.27):
Rysunek 8.6.28 Alternatywna wersja B.Skin.Cockpit, wykorzystująca shader Metallic Paint
Uważam, że ta wersja materiału wygląda lepiej. W każdym razie odbija światło w inny sposób. Wykorzystałem ją do uzyskania widoku pokazywanego przez Rysunek 8.6.26, i będę wykorzystywał w dalszej części tej sekcji.
W tym momencie mamy gotowy cały przód kabiny, do wysokości tablicy przyrządów. Czas zabrać się za kolejny obszar — lewą burtę (Rysunek 8.6.29a).
Rysunek 8.6.29 Detale lewej burty.
Na lewej burcie znajduje się większość różnorodnych dźwigni i pokręteł. W szczególności zespół manetek silnika (przepustnicy i mieszanki) oraz skoku śmigła (Rysunek 8.6.29b,c). Modelarze zazwyczaj odwzorowują obudowę tego zespołu jako trójkątne „pudełko”. Ze zdjęć wynika jednak, że była to raczej grupa blaszanych prowadnic (Rysunek 8.6.29b), bez jakichkolwiek ścianek bocznych. Z przodu była do niej tylko przykręcona „maskownica”, z napisami eksploatacyjnymi (Rysunek 8.6.29c). Innym szczegółem lewej burty jest tablica rozdzielcza instalacji elektrycznej (Rysunek 8.6.29a). Wykorzystałem na niej wiele klonów przełącznika, użytego po raz pierwszy na tablicy przyrządów (por. str. 540).
Kolejnym detalem jest rozrząd instalacji hydraulicznej, z dźwigniami: klap i podwozia (Rysunek 8.6.30):
Rysunek 8.6.30 Zawór, sterujący klapami i podwoziem (P-40E) | Rysunek 8.6.31 Odwzorowanie zaworu w naszym modelu |
Tylko na dwóch zdjęciach pewnego P-40C w jednym z muzeów w USA dostrzegłem wystającą zza fotela dźwignię sterującą klapami skrzydłowymi. W dodatku ten egzemplarz nie ma całkiem oryginalnego wyposażenia: wygląda na to, że zespół sterowania silnikiem zaadaptowano z P-40E. Nie widać tam też śladu po przewodach, zasilających ten rozrząd. (Tak w ogóle, to w jego kabinie brak jeszcze wielu innych szczegółów).
Korpus rozrządu był na pewno odlewany — świadczą o tym obecne wszędzie zaokrąglenia i wyoblenia. Dokładne odtworzenie takiego kształtu byłoby bardzo pracochłonne. Ten szczegół jest tak mało widoczny, że zdecydowałem się odwzorować go w sposób uproszczony, bez zaokrągleń (Rysunek 8.6.31). Przebieg jednego z przewodów i sposób zamocowania pomocniczego zaworu są oparte wyłącznie na domysłach, które mogą okazać się fałszywe. Pominąłem za to wiele innych przewodów, kryjących się za fotelem.
Kolejnym uproszczeniem jest także pominięcie napisów eksploatacyjnych, biegnących wzdłuż burt samolotu. Wprawdzie wykonanie napisów „DOWN” lub „OFF”, widocznych na fotografii (Rysunek 8.6.30) nie stanowiłoby większego problemu, ale co jest napisane na tej czarnej tabliczce obok?
Kolejnym obszarem do wypełnienia jest podłoga kabiny (Rysunek 8.6.32). W P-40 tę funkcję pełniła górna powierzchnia płata. Na szczęście nie ma tu dużo detali do wykonania. Najważniejszymi elementami na tym obszarze są: zespół drążka sterowego i projektor celownika (Rysunek 8.6.32b):
Rysunek 8.6.32 Szczegóły podłogi kabiny pilota
Drążek był najbardziej narażony na rysy i zadrapania farby, więc rozwinąłem ten fragment siatki w przestrzeni UV materiału B.Skin.Cockpit. Zwróć uwagę na przewód, wychodzący z drążka. To szczegół dość często pomijany przez modelarzy. Rysunek 8.6.32c) przedstawia szczegóły górnej części drążka sterowego. Wytłoczenie na uchwycie uzyskałem za pomocą mapy nierówności (materiału B.Black.Instruments). Specyficzne dla tej konstrukcji są przymocowane do na podłogi paliwomierze zbiorników skrzydłowych (Rysunek 8.6.32a).
Wreszcie prawa burta kabiny (Rysunek 8.6.33). Konstruktorzy umieścili z tej strony „korbkę” służącą do odsuwania i zasuwania osłony, kontrolki radiostacji, oraz dźwignię sterowania chłodnicy (Rysunek 8.6.33a):
Rysunek 8.6.33 Szczegóły prawej burty kabiny pilota
Tarcza korby osłony kabiny miała fragment powierzchni zachowany w naturalnej barwie duralu, wypolerowanego niemal jak lustro (Rysunek 8.6.33b). Powinienem właściwie go pokryć materiałem B.Skin.Duraluminum, takim jak poszycie samolotu (por. str. 421). Przygotowanie dla tego tak małego fragmentu odpowiedniej tekstury nierówności byłoby jednak zbyt pracochłonne. Zrobiłem więc to „na skróty”: pokryłem tę powierzchnię zmodyfikowaną wersją materiału B.Steel.Rough: B.Alumin.Smooth. Łby ośmiu śrub, które są na niej widoczne, to siatki, a nie tekstura (Rysunek 8.6.33b). (Wykorzystałem klony standardowych śrub, często używanych w innych miejscach kabiny i podwozia). Tak po prostu było najszybciej, a wpływ na komplikację modelu tych kilkudziesięciu dodatkowych ścian jest minimalny.
Na prawej burcie występują dwa spiralne przewody (Rysunek 8.6.34). Pierwszy to elastyczny kabel lampy (spotyka się takie nadal w niektórych lampkach biurowych). Drugi — to zawijany kabel od wtyczki (mikrofonu?) radiostacji, przypominający kable słuchawek starych, przewodowych telefonów. Są to na tyle drobne elementy, że zostały odwzorowane za pomocą tekstury. Już raz taką sztuczkę wykonaliśmy, przy sprężynach kółka ogonowego (por. str. 498). Wykorzystałem do tego celu, podobnie jak wtedy, odpowiednio spłaszczoną teksturę proceduralną typu Wave Texture:Bands. Każdy z kabli to po prostu wygięty wzdłuż krzywej cylinder. Pewną niedogodnością jest tu konieczność indywidualnego dopasowania mapowania zwojów tekstury. Zwróć uwagę np. na zakończenie przewodu od radiostacji (Rysunek 8.6.34) — „kabel”, imitowany przez teksturę dyskretnie przekształca się w nieprzejrzystą końcówkę. Wymagało to „trafienia” końcem zwoju w początek nieprzejrzystego kabla. W rezultacie dla każdego z tych przewodów trzeba było stworzyć indywidualny materiał. Dla dwóch elementów, jak w tej kabinie, to jeszcze nie był problem. Pamiętaj jednak o tym ograniczeniu, gdybyś chciał wykorzystywać to rozwiązanie częściej. Zbyt dużo materiałów może bardzo utrudnić wprowadzanie zmian w modelu.
Ostatnim obszarem kabiny, który „uszczegółowiłem”, była tylna ściana, wraz z fotelem pilota (Rysunek 8.6.35):
Rysunek 8.6.35 Szczegóły tylnej ściany kabiny pilota
Wykonanie tego fragmentu wydaje się prostsze od pozostałych — bo zawiera mniej detali. Ot, zagłówek, pasy, i jakieś inne drobiazgi (Rysunek 8.6.35a). A jednak modelowanie „luźno rzuconej” uprzęży pilota (Rysunek 8.6.35b) wymagało istotnego wysiłku. I to wcale nie z powodu zróżnicowanych materiałów!
Tworzenie tego zespołu zacząłem od wykonania kompletu sprzączek. Są to stosunkowo małe detale, więc nie trzeba było tu wygładzać siatki modyfikatorem Subsurf. Do uzyskania odpowiedniego efektu wystarczyło użyć uproszczeń — np. okręgu ośmiokątem (Rysunek 8.6.36). Wrażenie zaokrągleń uzyskałem wyłącznie przez oznaczanie cieniowania odpowiednich ścian jako „gładkie” (Smooth Shading). Ewentualne ostre krawędzie powstawały samoistnie na granicy ścian, różniących się tym ustawieniem. Zastosowałem także inne uproszczenia, jak lustrzane odbicie siatki. Rezultaty na renderze wyglądają całkiem realistycznie, nawet w zbliżeniach (Rysunek 8.6.35b).
Same pasy to bardzo płaskie prostopadłościany (Rysunek 8.6.37a). Ich grubość odpowiada 1 mm w rzeczywistym samolocie. Te siatki są wygięte wzdłuż odpowiedniej krzywej (modyfikatorem Curve, tak jak wyginaliśmy kable i rurki). To te krzywe nadają im indywidualny kształt (Rysunek 8.6.37b):
Rysunek 8.6.37 Pasy — płaskie siatki, wygięte wzdłuż krzywej
Do stworzenia lewego i prawego pasa użyłem dwóch klonów tej samej siatki (por. Rysunek 8.6.37a).
W zasadzie uprząż pilota składa się z czterech pasów: dwóch biodrowych i dwóch grzbietowych (choć te ostatnie są właściwie połączone w jeden długi odcinek — por. Rysunek 8.6.35a). W środku każdego pasa jest sprzączka, dzieląca go na dwie części. Początek każdej z tych części jest obszyty wokół jednej ze sprzączek, a koniec — zawinięty wokół poprzeczki drugiej (Rysunek 8.6.38a):
Rysunek 8.6.38 Trzy elementy każdego pasa: wygięty środek i dwie nie zdeformowane końcówki
Zamodelowanie takich końcówek poprzez wygięcie wokół krzywej jest możliwe, ale wymagałoby powtórzenia wiele razy tej samej, żmudnej roboty. (Mamy tu siedem fragmentów uprzęży, z których każdy ma swój indywidualny kształt — i swoją własną krzywą). Można jednak to zdecydowanie uprościć, gdy w charakterze obszycia użyjemy klonu jednej, uniwersalnej siatki. Dosztukujemy ją, jako oddzielny obiekt, do początku każdego pasa (Rysunek 8.6.38c). Podobnie każde owinięcie tkaniny wokół sprzączki to klon innej, uniwersalnej siatki, nakładany na koniec wygiętego odcinka pasa. Wystarczy tak skomponować krzywe, modelujące fragmenty uprzęży, by płaskie końcówki wydawały się być ich naturalnym przedłużeniem. (Obszycia, przez to, że łączą „na zakładkę” dwie warstwy tkaniny, rzeczywiście układają się płasko. Nie można tego powiedzieć o zawiniętych końcach pasów. Te jednak wystarczy pochylić pod różnymi kątami, by także nie raziły swoją „sztywnością”). Dzięki temu, że ani obszycie, ani zawinięcie nie są wyginane wzdłuż krzywej, można je jeszcze bardziej uprościć, modelując tylko połowę ich siatek — a drugą uzupełnić modyfikatorem Mirror (Rysunek 8.6.38b,c).
Przy bardziej „pokręconych” fragmentach pasów możesz mieć problemy z ich dopasowaniem do „sztywnych” końcówek (Rysunek 8.6.39a):
Rysunek 8.6.39 Korygowanie niewłaściwego skręcenia pasa wokół osi
W takich sytuacjach musisz zmienić kąty poprzecznego skręcenia (Tilt) w poszczególnych wierzchołkach krzywej (W przyborniku Property — por. Rysunek 8.6.39b, więcej na ten temat znajdziesz na str. 957).
Gdy masz zamodelować jakiś specjalnie skręcony środkowy fragment pasa, nie zapomnij przygotować dla tego obiektu indywidualnej siatki! Na pewno będziesz musiał ją lokalnie zagęścić, wstawiając więcej poprzecznych sekcji (poleceniem Loop Cut). Takie modyfikacji nie powinny być powielane w pozostałych częściach (np. w pasie lewym i pasie prawym).
Mówiąc szczerze, układanie pasów uprzęży tak, by wyglądały jak swobodnie rzucone na siedzenie, uważam za jeden z trudniejszych elementów modelowania samolotu. Gdy się z tym uporamy, nadchodzi pora, by przypisać poszczególnym obiektom odpowiednie materiały. Skórzanemu zagłówkowi przypisałem materiał B.Black.Leather, a podkładce pod „spinką” pasów (por. Rysunek 8.6.35b, str. 546) B.Brown.Leather (szczegóły konfiguracji — str. 1096). Pasom uprzęży przypisałem materiał B.White.Belt (szczegóły konfiguracji — str. 1103), gdyż na zdjęciach i w filmach te pasy wyglądają na białe. Liny gumowe, zaczepione za fotelem, także wydawały się białe, więc przypisałem im ten sam materiał, co pasom (to uproszczenie, ale nie razi).
Przy okazji wprowadziłem pewną modyfikację do podstawowego materiału wnętrza kabiny (B.Skin.Cockpit). Podstawiłem we wnętrzu przetarć metaliczną powierzchnię (w charakterze maski użyłem intensywności tekstury barw — por. str. 669). Otrzymałem w ten sposób ostre krawędzie przetarć, które lepiej wyglądają w zbliżeniach (np. str. 546, Rysunek 8.6.35). Rezultaty były na tyle ciekawe, że dodałem podobne rozwiązanie także do materiału powierzchni zewnętrznych (B.Skin.Camouflage — por. str. 670).
Wnętrze naszej kabiny jest ukończone. Nadal nie dorównuje najlepszym symulatorom tego samolotu. Pominąłem wiele przewodów i napisów eksploatacyjnych, których nie byłem w stanie odcyfrować. (Zawsze można je dodać później, gdy natkniesz się na nowe, dokładniejsze materiały). Tym niemniej osiągnęliśmy całkiem przyzwoite przybliżenie oryginału. Rysunek 8.6.40 przedstawia dwa ujęcia gotowej kabiny pilota:
Rysunek 8.6.40 Gotowa kabina (na razie bez pilota)
Rysunek 8.6.40a) to ujęcie z wnętrza kadłuba2. Rysunek 8.6.40b) przedstawia kabinę widzianą z zewnątrz. Mam wrażenie że w takim zbliżeniu pasy na oparciu fotela pilota wydają się trochę sztuczne. (W przyszłości możesz spróbować ulepszyć ich materiał). Zazwyczaj będziemy jednak oglądać ten szczegół z większej odległości, więc pozostawiłem je w takim stanie.
Wnętrze kabiny samolotu odtwarza się głównie na podstawie zdjęć (str. 532, 544). Jest to zazwyczaj bardzo skomplikowany zespół. Dlatego dobrze jest zawsze przed rozpoczęciem tej pracy założyć odpowiedni poziom uproszczeń — na przykład rezygnację z pomniejszych przewodów czy części napisów eksploatacyjnych;
Rysunki w trzech rzutach przydają się głównie do dokładnego ustalenia położenia wręg i podłużnic wewnątrz kabiny. Te elementy szkieletu pełnią później rolę czegoś w rodzaju „układu współrzędnych”. Pomagają lepiej oszacować rozmiary i położenie poszczególnych elementów wyposażenia (str. 532);
Pracę zaczynamy od identyfikacji i wymodelowania podstaw, do których są przymocowane pozostałe elementy wyposażenia (str. 532). Sprowadza się to zazwyczaj do umieszczenia z przodu tablicy przyrządów, a jakiegoś zespołu „pudełek” po lewej i prawej burcie. Do „podstaw” zaliczam także fotel pilota (str. 533);
W kabinie użyłem dwóch podstawowych materiałów (str. 532):
- B.Cockpit.Skin: do „pomalowanych” powłok, czyli wewnętrznej strony poszycia samolotu, szkieletu, a także fotela pilota i innych większych elementów;
- B.Black.Instruments: do wszystkich „czarnych” części: tablicy przyrządów, tabliczek z napisami eksploatacyjnymi;
Dla każdego z tych materiałów trzeba przygotować rozwinięcia w UV odpowiednich siatek (str. 533). Posłużyłem się nim do mapowania tekstur nierówności (str. 534), odbić i barwy;
Otwory w tablicy przyrządów najlepiej jest uzyskać za pomocą odpowiedniej tekstury przejrzystości (str. 536 - 537), oraz tekstury nierówności (str. 537);
Każdy wskaźnik można wykonać jako zespół dwóch części:
- szkła i oprawy, wspólnego dla wszystkich przyrządów. (Każdy ze wskaźników wykorzystuje klon tej siatki, w razie potrzeby — w zmienionej skali);
- prostej tarczy zegara, która jest tworzona indywidualnie dla każdego wskaźnika (nanoszony jest na nią odpowiedni obraz wskazówek i skali);
Tak przygotowany wskaźnik umieszczam w odpowiednim otworze tablicy przyrządów (str. 538 - 539);
Tabliczki znamionowe i inne napisy eksploatacyjne to proste siatki, pokryte materiałem B.Black.Instruments. W ich rozwinięciach UV są umieszczone odpowiednie fragmenty tekstury barwy (str. 540);
Szczegóły wyposażenia kabin mogą się różnić nawet w obrębie tej samej wersji samolotu. Widać to na przykładzie odmiennych reflektorów celowników w samolotach należących do USAAC i AVG (str. 541);
Aby nie pogubić się w detalach, proponuję podzielić pracę nad kabiną na 5 stref:
- przód, z tablicą przyrządów i wiatrochronem;
-lewa burta;
-podłoga;
-prawa burta;
-ściana tylna, wraz z fotelem pilota;
Każdą z nich konsekwentnie wypełniamy wszystkimi szczegółami. Pracę nad następną strefą zaczynamy dopiero wtedy, gdy poprzednia została zupełnie skończona (str. 542);
Drobne elementy, których siatek nie opłacało się rozwijać w przestrzeni UV pokrywam materiałem B.Skin.Inner (str. 540, 541). Stosowaliśmy już go na wewnętrznych powierzchniach wnęk podwozia i klap skrzydła. Powinien mieć ma taką sama barwę, co wnętrze kabiny (B.Skin.Cockpit). Dla pokrycia detali w innych kolorach powstały z niego (zmieniłem tylko barwę podstawową) inne materiały: B.Red.Details, B.Black.Details;
Wiele szczegółów trzeba wykonać w sposób uproszczony, o ile nie chcesz spędzić roku nad samą kabiną. Przykładem takiej części jest odlewany korpus sterowania hydrauliką klap i podwozia (str. 544). To niewielki, mało widoczny element, wciśnięty w kąt kabiny. Próba dokładnego odwzorowania jego kształtu pochłonęłaby tyle samo pracy, co całe skrzydło!
Elastyczne, spiralne przewody można łatwo uzyskać za pomocą odpowiedniej tekstury przejrzystości (str. 545). Mankamentem tego rozwiązania jest to, że trzeba stworzyć odrębny materiał dla każdego rodzaju przewodu. Dobrze się za to nadaje się do wykonania kilku takich elementów w kabinie;
Pasy fotela pilota najlepiej zbudować z odcinków, połączonych sprzączkami. Każdy odcinek pasa składa się z trzech elementów:
- obszycia początkowej sprzączki (jedna, uniwersalna siatka, której klony są użyte w każdym odcinku);
-środka (prostokątna siatka, wygięta wzdłuż krzywej w indywidualny kształt);
-zawinięcia wokół sprzączki końcowej (uniwersalna siatka, której klony są użyte w każdym odcinku);
Taka metoda pozwala uniknąć pracochłonnego „obszywania” każdej sprzączki (str. 546, 547);
Pasy wygięte wzdłuż bardzo skomplikowanej krzywej mogą wymagać ręcznych korekt kąta skręcenia poprzecznego (Tilt). Wprowadzasz je w panelu właściwości (N) pojedynczego punktu (lub punktów) sterującego krzywej (str. 547);
Kabina jest już gotowa, ale w scenach w locie dziwnie by wyglądała bez pilota. Tak się miło składa, że tę samą figurkę (byleby tylko była ubrana odpowiednio dla właściwych sił powietrznych) można wstawić do wielu modeli. Przygotowałem więc „uniwersalnego” pilota USAAC, w hełmofonie, goglach, kombinezonie i kurtce używanych w latach 1941-42. Założyłem mu także spadochron siedzeniowy, razem z uprzężą (Rysunek 8.7.1):
Rysunek 8.7.1 Figurka pilota USAAC/AVG (render)
Najbardziej szczegółowo przygotowałem górne partie tego modelu (Rysunek 8.7.1b) — gdyż te, po wsadzeniu pilota w kabinę, będą najbardziej widoczne. Elementy mało widoczne, jak buty i spodnie, wykonałem bardzo pobieżnie (np. pominąłem na spodniach kieszenie, znajdujące się pod kolanami) (Rysunek 8.7.1a).
Plik z pilotem znajdziesz w folderze model/p40/, pod nazwą pilot.blend. (Zdjęcia pokazują, że lotnicy AVG ubierali się podobnie jak piloci USAAC). W pliku jest także „zapakowany” obraz tekstury, wykorzystywanej w modelu (Rysunek 8.7.2a). W prawym dolnym rogu umieściłem obraz twarzy (Rysunek 8.7.2b), zapożyczony z Blender Art Magazine (sam nie potrafiłbym tak namalować). Dla porządku zachowałem na nim podpis autora:
Rysunek 8.7.2 Tekstura i jej rozłożenie na modelu
Źródłowy plik obrazu (wykonany w Inkscape) tekstury znajdziesz w p40/textures/8.07/pilot.src/000.svg.
Jeżeli sprawdzisz wcześniej sam plik pilot.blend w Blenderze, przekonasz się, że pilot znajduje się w nim na warstwie 8, niewidoczne elementy pomocnicze (krzywe) na 9, a armatura („kości” — por. str. 841) — na warstwie 10. Na tych samych warstwach pojawią się po wczytaniu do modelu P-40. Warto więc włączyć elementom, do których pilot musi się „dopasować” — dodatkową obecność na warstwie 8 (Rysunek 8.7.3a). Potem wystarczy wczytać z pliku pilot.blend figurkę (poleceniem File→Append, szczegóły str. 773) :
Rysunek 8.7.3 Import pilota do naszego modelu
Rysunek 8.7.3b) pokazuje sytuację zaraz po wczytaniu: zazwyczaj, trzeba dokonać kilku dopasowań. Nie inaczej jest w tym przypadku: spadochron wystaje za dno fotela, a stopy nie sięgają orczyka. Dodatkowo włączyłem widoczność ramek kabiny (warstwa 4) (Rysunek 8.7.4a). Wygląda na to, że głowa pilota znajduje się na prawidłowym poziomie, więc trzeba obniżyć fotel, by dopasować go do spadochronu.
Gdybyś miał chciał przesunąć pilota, „łap” go za pakunek spadochronu (000.Parachute). To do niego są przypisane wszystkie pozostałe elementy (także te na innych warstwach: krzywe i armatura) .
Rysunek 8.7.4a) przedstawia dopasowywanie do „poziomu siedzenia” pilota. Tak się dobrze składa, że lokalna oś Y fotela biegnie wzdłuż prowadnic — więc wszystko, co trzeba zrobić, to przesunąć go do dołu wzdłuż tej osi. Wystarczy obserwować (w trybie Wireframe), kiedy spód siedzenia pilota obejmie cały spadochron:
Rysunek 8.7.4 Dopasowanie elementów kabiny do pilota
Teraz przyjrzyj się uważnie rękom pilota. Lewa pewnie spoczywa na manetkach gazu i obrotów — nie wymaga żadnych poprawek. Za to z prawą jest kłopot: drążek sterowy jest za krótki o jakieś 10 cm (licząc w jednostkach rzeczywistych) (Rysunek 8.7.4b). To raczej wygląda na mój błąd podczas modelowania — nieprawidłowo oceniłem długość tego elementu na podstawie zdjęć. Na szczęście nie jest to jakiś duży problem: wydłużyłem siatkę w dolnej części drążka (tam, gdzie była prostą rurą) (Rysunek 8.7.4c). Zrobiłem to tak, by zachować proporcje pomiędzy częścią prostą i wygiętą. Potem pozostało jeszcze przesunąć do góry parę elementów związanych z rączką, i całość znalazła się na właściwym miejscu (Rysunek 8.7.4d).
Teraz trzeba wyprostować nogi pilota, by spoczęły na pedałach orczyka. Model, który wczytałeś, ma siatkę przypisaną do armatury („kości”). Wystarczy włączyć dodatkowo widoczność warstwy 10, na której je umieściłem. W związku z tym, że armatura znajduje się wewnątrz „ciała” lotnika, najwygodniej ją zaznaczyć po przełączeniu trybu wyświetlania na wireframe (Rysunek 8.7.5a):
Rysunek 8.7.5 Dosuwanie stóp pilota do pedałów orczyka
Następnie przełącz się w Pose Mode (por. str. 843), i zaznacz koniec kości goleni nogi (Rysunek 8.7.5b). Przesuń ją tak, by obcas oparł się o pedał. Następnie zaznacz kość stopy (Rysunek 8.7.5c), i obróć ją, by cała podeszwa buta spoczęła na orczyku. Tak samo zmień położenie drugiej nogi.
Czasami po zmianie pozycji modelu trzeba poprawić pasy uprzęży (Rysunek 8.7.6). (Choć też są przypisane do armatury, to nie deformują się w ten sam sposób).
Rysunek 8.7.6 Poprawianie uprzęży spadochronu
W takim przypadku trzeba przejść do edycji ich siatki i obrócić lub przesunąć odpowiednie grupy wierzchołków. Na koniec można dopasować sprzączki do zmienionego położenia końcówek pasów.
Ostatnim elementem, który na pewno będzie wymagał poprawienia, jest kabel radiowy, biegnący z hełmofonu pilota (Rysunek 8.7.7). Trzeba go inaczej wygiąć, by nie przechodził przez oparcie fotela, i wydłużyć:
Rysunek 8.7.7 Poprawianie przebiegu kabla hełmofonu
Pozostaje „przypiąć” pilota do fotela. Umieść w tym celu na warstwie 8 wszystkie sprzączki i końcówki pasów uprzęży, którą przygotowaliśmy w poprzedniej sekcji (por. str. 546). Rozmieść je w nowych położeniach — tam, gdzie powinny się znaleźć na ciele pilota (Rysunek 8.7.8a). To drugi zestaw pasów, do scen w locie:
Rysunek 8.7.8 Ponowne rozłożenie uprzęży fotela pilota
Przy okazji „zapnij” wszystkie elementy sprzączki (Rysunek 8.7.8b), i ustaw odpowiadające sobie węzły tak, by mimo skręcenia miały szansę zostać poprawnie połączone. Tym razem pasy nie są tak bardzo „pokręcone”, więc najlepiej jest je wyciągnąć z jednej z końcówek (Rysunek 8.7.9a). Krzywej użyłem tylko dla najdłuższego odcinka na plecach (Rysunek 8.7.9b):
Rysunek 8.7.9 Szczegóły wykonania pasów
Wczytany model pilota ma swoje własne materiały. Możesz je łatwo odróżnić od innych materiałów modelu po przedrostku nazwy: wszystkie zaczynają się od „000.”. Na przykład materiał kombinezonu nosi nazwę 000.Uniform.Fabric, a skórzanej kurtki — 000.Uniform.Leather. Wykorzystałem w nich kopie różnych grup pomocniczych stworzonych na potrzeby tego modelu: Moderate, Negate, Gloss Paint. Aby jednak po imporcie nie mylić ich ze sobą, te dodatkowe grupy mają przedrostek „Z.000.”. Dzięki temu pojawią się na samym końcu menu Add→Group.
Model pilota będzie można wykorzystać w wielu scenach o różnej intensywności oświetleniu. Dlatego każda barwa w schematach jego materiałów jest wprowadzona za pomocą specjalnej grupy o nazwie Z.000.ColorControl. Jej instancje znajdziesz w wielu miejscach (Rysunek 8.7.10):
Wystarczy że przejdziesz do edycji jakiejkolwiek z tych instancji grupy Z.000.ColorControl i zmienisz wartość parametru Value w węźle Hue Saturation Value (Rysunek 8.7.11a). Definicja grupy jest tylko jedna, więc spowoduje to natychmiastową rozjaśnienie lub przyciemnienie wszystkich materiałów wykorzystanych w modelu pilota (Rysunek 8.7.11b):
Rysunek 8.7.11 Dostosowanie barwy modelu pilota do oświetlenia sceny
Aby nie pokazać na tym samym renderze dwóch wersji pasów fotela pilota, umieściłem na warstwie 18 ich opracowane w poprzedniej sekcji „luźne” wersje. Tak więc pamiętaj — gdy chcesz pokazać pustą kabinę (np. w scenie na lotnisku), włącz warstwy 15 (wnętrze kabiny) i 18, a gdy potrzebujesz sceny w locie — warstwy 15 i 8. Dla ujęć w których widać tylko głowę pilota wystarczy włączyć samą warstwę 8.
Rysunek 8.7.12a) przedstawia naszego pilota w kabinie w ujęciu z przodu, a Rysunek 8.7.12b) — z tyłu:
Rysunek 8.7.12 Ukończona kabina, wraz z pilotem
Uważam, że efekt uzyskany na tych testowych renderach jest całkiem zadowalający. Być może dla takiego ujęcia warto zastosować na zewnętrznych powierzchniach samolotu teksturę barw o większej rozdzielczości. Taką decyzję trzeba było jednak podjąć wcześniej — teraz obraz poszycia jest już namalowany w GIMP, i trzeba byłoby go tworzyć od nowa. Tak więc pamiętaj o tym na przyszłość, jeżeli planujesz zbliżenia!
Figurę pilota masz przygotowaną w odrębnym pliku Blendera (by można ją było wykorzystać w wielu modelach). Jest przypisana do warstwy 8. Zaimportuj ją do modelu p-40 (str. 551);
Model pilota trzeba dopasować do kabiny. Czasami oznacza to poprawki w szczegółach jej wyposażenia (str. 552). Czasami jednak trzeba zmienić „pozę” pilota (str. 553). Do zmiany pozycji figurki służy umieszczona wewnątrz armatura („kości”);
Po dopasowaniu pilota do kabiny, trzeba poprawić parę szczegółów, takich jak uprząż spadochronu (str. 554), czy kabel radiowy hełmofonu;
Ostatnim elementem, jakim pozostał, jest druga wersja pasów fotela pilota (do scen „w locie”). Skopiuj w tym celu na warstwę 8 wszystkie sprzączki i końcówki pasów, stworzone w poprzedniej sekcji (str. 546). Należy je rozmieścić w nowych miejscach na figurce pilota (str. 554). Potem wystarczy połączyć je ze sobą nowymi segmentami pasa. Te fragmenty są zazwyczaj dość proste, i wtedy nie trzeba wykorzystywać do ich formowania krzywych.
Do wykończenia pozostało jeszcze trochę drobiazgów. Aby o żadnym nie zapomnieć, proponuję zacząć je uzupełniać od nosa samolotu. Zasada jest podobna do tej, którą stosowaliśmy w kabinie (por. str. 542): sukcesywnie posuwamy się w kierunku ogona, tworząc po drodze wszystkie brakujące detale. Każdy z nich należy wykończyć nie pomijając materiałów i tekstur, by już nie trzeba było do niego więcej wracać. To także dobra okazja, by po kolei sprawdzić wygląd wszystkich zakamarków naszego modelu.
Zacznijmy od śmigła: na łopaty należy nałożyć teksturę z metryczką części i znakiem firmowym Curtiss. Jak pozostałe elementy tego typu, wkomponujmy ją w teksturę decals.png (Rysunek 8.8.1a,b, por. str. 443):
Rysunek 8.8.1 Drobne oznaczenia na śmigle (tekstura declas.png)
Okrągły emblemat „Curtiss Electric Propellers” możesz zeskanować z jakiegoś schematu malowania, pomniejszyć i wstawić do rysunku decals.svg. Ten symbol jest tak mały, że dla domyślnego mapowania UV łopaty śmigła (UVTex) wygląda przekonująco tylko z większej odległości. Stworzyłem więc dla tej siatki alternatywną mapę UV Decals, na której łopata i emblemat są dużo większe (Rysunek 8.8.1a). Dzięki temu mapowaniu napisy i symbole wyglądają dobrze nawet na zbliżeniach (Rysunek 8.8.1c) . Dla łopat w kolorze naturalnego duralu symbol Curtiss miał niebieskie tło, a dla łopat pomalowanych na czarno (np. samolotów z AVG) — czarne tło. Aby łatwo zmieniać te tła, zdecydowałem się go „zwektoryzować” (jak — patrz str. 751).
Materiał łopaty nosi nazwę B.Duralumin. Aby uzyskać te napisy na śmigle, dołączyłem do niego teksturę decals.png (Rysunek 8.8.2):
Rysunek 8.8.2 Materiał duraluminiowej powierzchni łopaty
W związku z użyciem tekstury mapowanej we współrzędnych UV, materiału B.Duralumin nie można wykorzystywać do mniejszych szczegółów. Użyłem go jeszcze we wnętrzu wlotu powietrza do sprężarki (ta siatka także posiada rozwinięcie UV).
Teraz można przejść do kolejnego obszaru: okapotowania silnika. Do tej pory brakowało na nim kolektora spalin, teraz wreszcie nadszedł czas, by go wykonać.
Kolektor zaczynam od uformowania pojedynczej rury wydechowej. Takie rury miały dość „pogięty” kształt. Aby nie namęczyć się nad nim bez potrzeby, przygotowałem najpierw „wyprostowaną” wersję tego elementu (Rysunek 8.8.3a):
Rysunek 8.8.3 Formowanie pojedynczej rury wydechowej
Na takiej siatce zdecydowanie łatwiej jest kształtować odpowiednie przejścia pomiędzy kolejnymi sekcjami. Aby sprawę jeszcze bardziej uprościć, wykonuję tylko górną połowę siatki — dolną generuje mi modyfikator Mirror (Rysunek 8.8.3a). Potem wystarczy dodać modyfikator Curve, związany z odpowiednią krzywą (Path) , by wygiąć rurę w kształt, który widać na zdjęciach i rzutach z góry (Rysunek 8.8.3b).
Na tym jednak formowanie się nie kończy, bo rura była wygięta także w płaszczyźnie prostopadłej (Rysunek 8.8.4a). To lokalne zagięcie, na przestrzeni dwóch segmentów wieloboku sterującego krzywą. Aby modyfikator Curve nie skręcił nam siatki wokół tak „pogiętej” osi, w rzucie z góry ustawiłem te dwa odcinki w jednej linii (por. Rysunek 8.8.3b).
Rysunek 8.8.4 Kolektor spalin — ustalenie położenia w kadłubie
Gdy siatka jest już powyginana na wszystkie strony, pozostaje ją ustawić we właściwym miejscu. Zacząłem od odpowiedniego pochylenia rury (tym razem jako obiektu, a nie siatki) (Rysunek 8.8.4b). Obróciłem ją o 30º, bo przypuszczałem że pod takim kątem była pochylona boczna ścianka cylindrów silnika, do której był przymocowany kolektor. Potem pozostało odpowiednio go ustawić wewnątrz kadłuba, by wystawał z niego na właściwą odległość. (Jaką? Co tu dużo gadać, na planach była za duża, dobrałem ją na podstawie zdjęć).
Mamy już pierwszą rurę, teraz należy ją powielić. Użyłem tu innego modyfikatora: Array (Rysunek 8.8.5a,b):
Rysunek 8.8.5 Powielenie rury wydechowej (modyfikator Array)
Wystarczyło go dodać i wpisać odpowiedni odstęp (Offset — por. Rysunek 8.8.5c), by pojawiły się kolejne rury!
Drugi rząd rur (z prawej strony kadłuba) można wygenerować za pomocą kolejnego modyfikatora Mirror (Rysunek 8.8.6). Wystarczy podać jako punkt odniesienia środek innego obiektu (np. okapotowanie silnika):
Rysunek 8.8.6 Formowanie całości kolektora (wyłącznie za pomocą modyfikatorów!)
Dlaczego w poprzednim kroku wygenerowałem tylko trzy, a nie sześć rur? Bo pozostało coś dla koneserów: odstęp pomiędzy trzecim i czwartym cylindrem silnika Allison był nieco większy! Załatwi to kolejny modyfikator Array (Rysunek 8.8.6, a szczegóły o modyfikatorze Array — str. 965 i następna).
Pozostało już tylko „owinąć” wokół kolektora połowę rury ogrzewającej powietrze gaźnika (Rysunek 8.8.7a):
Rysunek 8.8.7 „Obudowa” kolektora spalin — ogrzewanie powietrza dla gaźnika
Na koniec dodałem z tyłu czarny „ekran”, by nie straszyć prześwitami w modelu (Rysunek 8.8.7b).
Kolektor pokryłem nowym materiałem B.Steel.Exhaust. To przerobiony B.Steel.Rough, w którym nałożyłem, za pomocą kolejnej tekstury proceduralnej „brudno-rdzawe” naleciałości (Rysunek 8.8.8):
Rysunek 8.8.8 Gotowy kolektor spalin — testowy render
Rura z powietrzem dla gaźnika biegnie wewnątrz kadłuba, tuż przy krawędzi otworu. Nie jest na tej ilustracji specjalnie widoczna. Musisz mi uwierzyć na słowo, że pokryłem ją zwykłą stalą — materiałem B.Steel.Rough.
Kolejnym elementem, który wykończymy, jest zespół chłodnic. To ta sama siatka, powielona trzy razy. Ściankę czołową wgłębiłem nieco do wewnątrz, uzyskując wyraźne obramowanie (Rysunek 8.8.9a):
Rysunek 8.8.9 Siatka i materiał chłodnic
Przypisałem temu obszarowi perforowany materiał B.Radiator.Cooper (Rysunek 8.8.9b). Jest to „zażółcona” odmiana B.Steel.Smooth (zmieniłem barwę połysku — Specular). Perforację uzyskałem za pomocą odpowiedniej tekstury przejrzystości (wystarczy mały fragment jej wzoru — por. Rysunek 8.8.10a):
Rysunek 8.8.10 Schemat materiału B.Radiator.Cooper
Jako barwę podstawową (Diffuse) wykorzystałem teksturę ogólnych zabrudzeń” X.Random.Dirt.
Materiał wlotu i wylotu chłodnic otrzymał „miedziany” połysk (por. Rysunek 8.8.9b), gdyż chłodnice Prestone, stosowane w P-40 aż do wersji „M”, były miedziane lub mosiężne1. Miały ścianki ułożone w sześciokątny wzór „plastra miodu”, który odtworzyliśmy za pomocą prostego obrazka honeycomb.png 2. Mapowałem ten obraz we współrzędnych Object. Co prawda spowodowało to mniejszy rozmiar „oczek” na chłodnicy oleju (to ta w środku, o nazwie B.415.OilRadiator), bo ten element ma inną skalę niż chłodnice cieczy. Pozostawiłem jednak to w tym stanie, bo w normalnych warunkach oświetlenia ta różnica nie jest widoczna (Rysunek 8.8.10b).
Skoro chłodnice są już gotowe, czas popracować nad ich tunelem wylotowym. Na jego obwodzie umieszczono cztery klapy. „Zmechanizowałem” je za pomocą ograniczenia Locked Track, śledzącego pojedynczy obiekt - cel X.360.Target (Rysunek 8.8.11):
Rysunek 8.8.11 „Mechanizacja” klap chłodnic | Rysunek 8.8.12 Dopasowanie „uszczelnień” pomiędzy klapami |
Aby pojawiające się w szczelinach trójkątne „zasłonki” nie rozjeżdżały się podczas ruchu klap, musiałem także dodać im ich własne ograniczenia Locked Track (Rysunek 8.8.12a). Ich osie X śledzą indywidualne „cele”, umieszczone na krawędzi sąsiedniej klapy (Rysunek 8.8.12b).
Podobnie jak w przypadku podwozia, ruch obiektu-celu (X.360.Target) wymusza, za pomocą kolejnych ograniczeń Locked Track, ruch popychaczy. Zamodelowałem dwie pary takich elementów, by udawały, że to one poruszają klapami (Rysunek 8.8.13):
Rysunek 8.8.13 Odwzorowanie mechanizmu sterującego klapami
Jeżeli chodzi o dobór materiałów, to ostatecznie wnętrze kanału wylotowego pokryłem standardowym B.Skin.Inner (Rysunek 8.8.14)3. Można tak zrobić, gdyż te powierzchnie są mało widoczne. Tym samym materiałem są pokryte części mechanizmu poruszającego całym zespołem. Otwory w kadłubie były zakryte gumowymi uszczelkami (B.Rubber.Details) z metalowym obramowaniem (B.Steel.Rough) — przynajmniej na rekonstrukcji z Duxford! W kolorze stali pozostawiłem także trójkąty zamykające szczeliny pomiędzy klapami. Za to same klapy, jako elementy najlepiej widoczne, pokryte zostały materiałem B.Skin.Camouflage, z odpowiednimi teksturami nierówności, odblasku i barwy. Pobrudziłem je na brązowawo, zakładając jakieś drobne wycieki instalacji chłodnicy oleju. Ostateczny rezultat przedstawia Rysunek 8.8.15:
Rysunek 8.8.14 Wylot z chłodnicy — dobór materiałów | Rysunek 8.8.15 Ukończony wylot z chłodnicy |
Zwróć uwagę na otwory na łuski, umieszczone za chłodnicą (Rysunek 8.8.15) . Dodałem ten szczegół po zebraniu i przeanalizowaniu większej liczby zdjęć. Wymagało to kilku modyfikacji, m.in. przesunięcia do przodu dolnych krawędzi owiewek skrzydeł, razem z ich śrubami na teksturze nierówności!
Do paneli sterowania modelem (Handle Panel — por. str. 877) dodałem dwa zestawy kontrolek, związane z nosem samolotu: jedną dla otwierania i zamykania klap, a drugą — dla obrotu śmigła (Rysunek 8.8.16b) :
Rysunek 8.8.16 Nowe kontrolki, sterujące obrotem śmigła i klapami chłodnicy
Kontrolki tworzę tak samo, jak to robiliśmy dla podwozia (por str. 501 i dalsze). Najpierw wstawiam na warstwę 9 „punkt odniesienia”, przymocowany na trwałe (relacją Parent) do kadłuba. Dla obrotu śmigła to pusty obiekt (Empty) X.005.Base, a dla klap — X.360.Base (Rysunek 8.8.16a). Na warstwę 10 dodałem uchwyty X.005.Handle i X.350.Handle. Są powiązane z *.Base relacjami Parent i ograniczeniami Limit Location. Z tymi uchwytami, za pomocą ograniczeń Transfrom, jest skojarzony ruch elementów modelu. Dla śmigła to po prostu obrót kołpaka (B.005.Hub), a dla klap — przesunięcie wzdłuż lokalnej osi X obiektu B.360.Target (por. str. 561).
Przygotowując się do odwzorowania luf karabinów, zamontowanych w skrzydłach, ściągnąłem ze strony poświeconej karabinom Browning rysunek wersji lotniczej, kalibru 0.303 cala (Rysunek 8.8.17a) :
Rysunek 8.8.17 Odwzorowanie kształtu lufy karabinu Browning 0.303 cala
Z zaskoczeniem stwierdziłem, że zewnętrzna osłona lufy była lekko stożkowa! Oczywiście zaraz to odwzorowałem (Rysunek 8.8.17b). Lufy wykorzystują ten sam materiał co zamki w kabinie pilota: B.Black.Instruments, bo jest „odpowiednio czarny”.
Rysunek 8.8.18 Przygotowanie otworów w osłonie lufy
Pokazywane przez Rysunek 8.8.18 otwory w osłonie wykonałem za pomocą dwóch tekstur: otworów (instruments-holes.png , Rysunek 8.8.18a) i nierówności (instruments-nor.png, Rysunek 8.8.18b)
Rysunek 8.8.19 pokazuje uzyskany rezultat — myślę, że dorównuje otworom modelowanym w siatce.
Przy modelowaniu konkretnej maszyny zwróć uwagę, czy końce luf karabinów nie były zaklejone jakąś jaskrawą taśmą klejącą. Tak często zabezpieczano je przed kurzem, wzbijanym przez samolot podczas startu i lądowania.
To już indywidualny szczegół samolotu, który w razie czego musisz uzupełnić. Właśnie z tego powodu nie cyzelowałem specjalnie końcówek luf karabinów — i tak były zazwyczaj zasłonięte...
Kolejną „rurką” sterczącą z krawędzi natarcia samolotu jest czujnik prędkościomierza, nazywany od nazwiska wynalazcy „rurką Pitota” . Egzemplarze P-40 produkowane dla Wielkiej Brytanii miały inną końcówkę tego przyrządu (Rysunek 8.8.20a), niż samoloty wytwarzane na zamówienie USAAC (Rysunek 8.8.20b):
Rysunek 8.8.20 Dwie wersje rurki Pitota
Podobnie jak w przypadku reflektora celownika (por. str. 541), przygotowałem obydwie wersje, i umieściłem je na razie na różnych warstwach (7 i 17). W następnym rozdziale podzielimy ten plik Blendera na różne sceny: jedną z Pearl Harbor, inną z AVG. Umieścimy wtedy odpowiednią wersję w odpowiedniej scenie.
Innym szczegółem jest wysuwany reflektor do lądowania w nocy. Wbudowano go w lewe skrzydło. Uformowanie samego reflektora nie było jakąś specjalną filozofią: ot, stożek z jakimś cylindrem (pełniącym rolę „żarówki”) i szybką (Rysunek 8.8.21a,b):
Rysunek 8.8.21 Składany reflektor do lądowania (w lewym płacie)
Zdecydowałem się wykonać w siatce tego płata rzeczywisty otwór, w oparciu o sześciokąt (Rysunek 8.8.21c). Niestety, okazało się że w pobliżu tego otworu brzydko wygina się tekstura nierówności (Rysunek 8.8.21d). Próbowałem różnych metod, ale w końcu stwierdziłem że pozostaje ten otwór wyciąć modyfikatorem Boolean (Rysunek 8.8.22a,b). Wstaw ten modyfikator do obiektu lewego skrzydła po Subdivison Surface, a uzyskasz poprawny efekt (Rysunek 8.8.22c,d):
Rysunek 8.8.22 Inna metoda wykonania otworu na reflektor
Kolejnym elementem płata jest mechanizm klap. W P-40 zastosowano klapy „krokodylowe”. Po otwarciu takich klap wnętrze skrzydła staje się widoczne, a w nim — mechanizm, który nimi porusza, oraz jakieś elementy szkieletu płata. Na szczęście już na etapie modelowania odwaliliśmy połowę roboty, umieszczając gdzie trzeba wszystkie żebra i podłużnice (por. str. 273). Teraz pozostał do dorobienia sam mechanizm.
Mechanizm klap krokodylowych działał w każdej konstrukcji w ten sam sposób: wzdłuż skrzydła biegła rura, w której były przypięte popychacze (Rysunek 8.8.23a). Drugi koniec każdego popychacza były przymocowany przegubowo do szkieletu klapy:
Rysunek 8.8.23 Mechanizm otwierania klapy
Aby złożyć klapę, wystarczyło by siłownik hydrauliczny przesunął tę rurę wzdłuż jej osi podłużnej. Przesuwająca się rura „ciągnęła” za sobą popychacze, a te — klapę. Przy otwieraniu wszystko poruszało się w przeciwną stronę. Mechanizując nasz model jak zwykle zamieniłem przyczynę na skutek: tu klapę poruszają obrót jej zawiasów, przeniesiony z ruchu odpowiedniego uchwytu (Rysunek 8.8.23b). Początkowo zamierzałem powiązać oś z uchwytem ograniczeniem Locked Track. Wymaga to jednak precyzyjnego ustalenia położenia uchwytu (por. str. 850). Dlatego ostatecznie zdecydowałem się użyć tu ograniczenia Transformation (przypisując każdą z osi klapy do „pustego” obiektu-rodzica poleceniem Add Empty Parent (por. str. 859). W ten sam sposób steruję przesunięciem rury z popychaczami.
Rysunek 8.8.24) przedstawia zespół pojedynczego popychacza (aby go dobrze pokazać, ukryłem wnętrze klapy). Na rurę nałożona jest mufa. W środku mufy umieściłem niewidzialny obiekt (Empty) — cel dla ograniczeń Locked Track popychacza i mocującej go śruby. Śledzi go, obracając się wokół osi Z, oś X śruby. Śledzi go także oś Y popychacza, obracając się wokół jego osi X. Cała rura tylko się przesuwa, ale sama mufa również obraca, śledząc osią Y śrubę na drugim końcu popychacza.
Rysunek 8.8.24 Zespół popychacza | Rysunek 8.8.25 Ograniczenia prawej klapy |
Gdy mechanizm lewej klapy zaczął działać, skopiowałem go do klapy prawej (Rysunek 8.8.25).
Rysunek 8.8.26 przedstawia kolejne fazy chowania klapy P-40. Zwróć uwagę na charakterystyczne „składanie” popychaczy na boki:
Rysunek 8.8.26 Kolejne fazy chowania klapy
Lotki także mają swoje osi obrotu. Dodałem do lewej uchwyt X.105.Handle, by nimi sterować (Rysunek 8.8.27):
Rysunek 8.8.27 Sterowanie lewą lotką
Podobne jak oś klapy, oś lotki poprzedziłem pomocniczym obiektem „rodzica” (za pomocą dodatku Add Empty Parent). Pozwala to przypisać do osi lotki odpowiednie ograniczenie Transformation, wiążące jej obrót z położeniem uchwytu (w granicach pokazanych przez Rysunek 8.8.28):
Rysunek 8.8.28 Sterowanie lewą lotką za pomocą ograniczenia Transformation
Położenie uchwytu X.105.Handle jest mierzone względem jego „rodzica” — X.105.Base. (Z kolei rodzicem X.105.Base jest lewe skrzydło).
Lotki wychylają się różnicowo: gdy jedna porusza się w górę, to druga — w dół. (Gdy prawa jest podniesiona do góry o 26º, to lewa jest obrócona w dół o 12º, i na odwrót)4. Najprościej byłoby przypisać osi prawej lotki takie ograniczenie Transformation jak dla lewej lotki. Jednak gdy w takim rozwiązaniu ustawisz uchwyt w pozycji „neutralnej”, to lewa lotka będzie także w pozycji neutralnej, a prawa — obrócona o 14º. To byłby błąd. Przypisz do tego obiektu dwa uzupełniające się ograniczenia Transformation (jedno na obrót w górę, drugie na obrót w dół). To działa w Blenderze 2.7. W wyniku jakiegoś błędu Blender 2.6 uwzględniał tylko ostatnie z tych ograniczeń. Musiałem więc dodać kolejny obiekt pomiędzy rodzica i oś prawej lotki (Rysunek 8.8.29a), i przypisać temu nowemu obiektowi obrót w górę, a osi — obrót w dół (Rysunek 8.8.29b):
Rysunek 8.8.29 Różnicowe wychylenia lotek, uzyskane za pomocą dwóch ograniczeń Transformation.
Dzięki tak przypisanym ograniczeniom różnicowym wychyleniem obydwu lotek steruje pojedynczy uchwyt (Rysunek 8.8.29c).
Na koniec pozostaje nadać uchwytom lotek i klap odpowiednie oznaczenia na naszym panelu sterowania modelem (HandlePanel) (Rysunek 8.8.30):
Rysunek 8.8.30 Nowe kontrolki, sterujące klapami i lotkami
Przedrostki etykiet kontrolek („20.”, „50.” — por. Rysunek 8.8.30b) ustalam, starając się je ułożyć w logicznej kolejności. (Pomiędzy lotkami i klapami zostawiłem miejsce w numeracji na stery kierunku i wysokości).
Ostatnim szczegółem, który pozostał do ukończenia obszaru płatów, są światła pozycyjne. Element niewielki, ale wyeksponowany na końcówkach skrzydeł. Uformowałem najpierw ich podstawę (Rysunek 8.8.31a):
Rysunek 8.8.31 Światło pozycyjne — szczegóły
Potem zakryłem tę lampę „kloszem”, pokrytym materiałem B.Red.Plastic (Rysunek 8.8.31b). (Opis tego materiału znajdziesz na str. 1106). Żadnej z tych siatek nie rozwijałem w UV, tylko przypisałem im „uproszczone” wersje barw powierzchni zewnętrznych samolotu: B.Skin.Details.L (Neutral Gray) i oliwkowozieloną B.Skin.Details.U (Olive Drab). (Obydwa materiały używają grupy X.Dirty.Color, której użyliśmy już we wnętrzu kabiny). Wykorzystamy je także do pokrycia innych detali zewnętrznych.
P-40 miał sześć świateł pozycyjnych — po dwa z każdej strony skrzydeł i statecznika. Materiały plastiku i ramki pochodzą z przypisanego obiektu, a nie z siatki (Rysunek 8.8.31c,d) — by jej nie powielać.
Osłony świateł pozycyjnych były z jednej strony nieprzejrzyste, by nie oślepiać pilota. Aby ten efekt uzyskać, przygotowałem odpowiednią mapę nieprzejrzystości (Rysunek 8.8.32):
Rysunek 8.8.32 Mapa nieprzejrzystości
Potem podłączyłem ją do parametru Opacity shadera Plastic (Rysunek 8.8.34):
Rysunek 8.8.33 Mapa nieprzejrzystości
Zwróć uwagę, że materiał od strony pilota zachował resztkę przejrzystości (myślę że tak wygląda lepiej).
Inna sprawa, że cyzelowanie takiego szczegółu, jak lampka pozycyjna, wynika wyłącznie z czystej modelarskiej pasji. Na wszystkich renderach nie będzie tego widać — bo ten detal jest po prostu za mały (Rysunek 8.8.34):
Rysunek 8.8.34 Materiały, przypisane do poszczególnych obiektów (klonów) lampek pozycyjnych
Rysunek 8.8.34a) pokazuje, jak wyglądają lampki na prawej końcówce płata, a Rysunek 8.8.34b) — na lewej. Prawda, że nie są duże? Zwróć za to uwagę, że mają różne barwy — mimo tego, że wszystkie cztery wykorzystują tę samą siatkę! To dzięki przypisaniu materiału do obiektu. (Dopóki jest to możliwe, staram się nie powielać siatek. To bardzo się przydaje, gdy za jakiś czas okaże się, że ich kształt trzeba poprawić).
Wlew paliwa do zbiornika kadłubowego znajdował się w P-40 za kabiną pilota. W wersjach B/C były to dwa „korki”, umieszczone w ciągnących się za nią wyżłobieniach (Rysunek 8.8.35):
Rysunek 8.8.35 „Korki” tylnego zbiornika paliwa
Było to dość dziwne rozwiązanie: w lewej szybie ponad „korkami” były wycięte dwa otwory (Rysunek 8.8.36):
Rysunek 8.8.36 Modyfikacja lewej tylnej szyby kabiny
Okrągłe wzmocnienia wokół „korków”, oraz umieszczone na nich śruby to wymodelowane siatki. Właściwie to można było je uzyskać także za pomocą tekstury nierówności. Zamodelowałem je trochę „z rozpędu”, a pozostawiłem jako przykład zastosowania ciekawej techniki modelowania. Każdy z tych kołnierzy to zwykły płaski pierścień. Ułożyłem je „jak naleśniki” na powierzchni kadłuba za pomocą modyfikatora Shrinkwrap (por. str. 970). Uzyskanie takiego nie zdeformowanego kształtu na teksturze rozwiniętej w UV mogło być trudne.
Proponuję dodać do naszego zestawu kontrolek sterujących modelem kolejną, odsuwającą owiewkę kabiny pilota (Rysunek 8.8.37) . W domyślnym położeniu (0%) jest zamknięta (Rysunek 8.8.37b):
Rysunek 8.8.37 Nowa kontrolka, sterująca przesunięciem osłony kabiny
Szyny owiewki P-40 były nieznacznie wygięte do dołu (Rysunek 8.8.37a), stąd ruch owiewki jest powiązany z przesunięciem uchwytu (X.335.Handle) za pomocą dwóch ograniczeń Transformation. Jedno z nich wywołuje przesunięcie w poziomie, a drugie — to niewielki obrót (o 1º).
Obok celownika odblaskowego, P-40 miały także drugi, tradycyjny. Umieszczono go z boku (Rysunek 8.8.38):
Rysunek 8.8.38 Dodatkowy celownik | Rysunek 8.8.39 Odnawiane napisy eksploatacyjne |
Nawet w AVG, mimo „polowych” warunków eksploatacji, mechanicy odnawiali co ważniejsze napisy eksploatacyjne. Naniosłem na tekstury teksty z osłon wlewów paliwa do zbiorników skrzydłowych (Rysunek 8.8.39). Inne napisy, które potwierdzają zdjęcia, umieściłem na usterzeniu (Rysunek 8.8.40a):
Rysunek 8.8.40 Usterzenie, wraz z anteną
Na tym etapie prac wiele części masz już gotowych: na przykład światło na usterzeniu (Rysunek 8.8.40b).
Innym elementem „z odzysku” jest sprężyna, naciągającą druty anteny5 (Rysunek 8.8.40b). Odwzorowałem ją za pomocą odpowiedniej tekstury przejrzystości. (Wykorzystałem materiał B.Steel.Spring, który stworzyliśmy w zespole kółka ogonowego — por. str. 495 i 498).
Jeżeli chodzi o światła sygnalizacyjne, to rysunek fabryczny statecznika pionowego P-40 pozwolił mi wyśledzić pewien szczegół: były umieszczone niesymetrycznie (Rysunek 8.8.41a). Kolejnym przydatnym drobiazgiem okazały się popychacze, wykorzystane w klapach. Mogłem ich użyć powtórnie, wraz ze śrubką i nakrętką, do zamodelowania napędu trymera (Rysunek 8.8.41b). W porównaniu z tym szczegółem krawędź trymera w dużych zbliżeniach wygląda trochę nieładnie — bo jest „wcięta” za pomocą tekstury. Jednak z nieco większych odległości (por. np. Rysunek 8.8.40a) wygląda zupełnie naturalnie.
Rysunek 8.8.41 Szczegóły usterzenia ogonowego
W przedniej części steru kierunku P-40 znajdowały się dwa otwory. W dolnym umieściłem orczyk na osi steru. Do końców orczyka przymocowane są linki. Do ich zamodelowania wykorzystałem tę samą siatkę, co w kabinie pilota (w istocie to końce tych samych linek). W górnym odwzorowałem okucia, mocujące osie sterów do stateczników (Rysunek 8.8.41c). Na koniec przygotowałem odpowiednie mechanizmy poruszania powierzchniami sterowymi (Rysunek 8.8.42) :
Rysunek 8.8.42 Nowe kontrolki, sterujące sterem kierunku i wysokości
W tej sekcji przebyliśmy drogę „od nosa do ogona” samolotu, uzupełniając po drodze wszystkie szczegóły zewnętrzne. Rysunek 8.8.43 przedstawia testowy render sceny w locie (o tym, jak „puścić w jego ruch” śmigło napiszę w następnym rozdziale):
Rysunek 8.8.43 Gotowy model — w powietrzu
Rysunek 8.8.44 przedstawia ten sam model stojący na abstrakcyjnej, białej płaszczyźnie6. W następnym rozdziale pokażę, jak go dopasować do jakiegoś przekonującego otoczenia.
Rysunek 8.8.44 Ten sam model postawiony na białej płaszczyźnie
Aby uzyskać w zbliżeniach modelu bardzo wyraźne napisy i oznaczenia, możesz powiększyć rozwinięcia UV wybranych siatek (str. 557);
Praca nad detalami oznacza także konieczność poprawiania fragmentów tekstur. Może to być, na przykład, tekstura barwy (str. 570), czy nierówności (str. 569);
Kolektor spalin najprościej jest wykonać z pojedynczej, prostej „rury wydechowej”, stosując kilka modyfikatorów. Modyfikatorów Curve użyłem do wygięcia siatki w odpowiedni kształt (str. 558). Potem powieliłem siatkę pojedynczej rury za pomocą modyfikatorów Array (str. 559);
Ściany chłodnic cieczy można odwzorować za pomocą odpowiedniej tekstury przejrzystości (str. 560);
W czasie prac nad ostatnimi szczegółami może się zawsze pojawić konieczność poprawy jakiegoś dawno uformowanego fragmentu poszycia. Tak się stało z otworami wyrzutników łusek karabinowych, które umieściłem na spodzie kadłuba (str. 562). Takie poprawki są często wymagają zmian w rozwinięciach UV, a te z kolei pociągają za sobą konieczność modyfikacji podstawowych tekstur;
Do paneli sterujących modelem (dodatek HandlePanel) warto dodać także uchwyt odpowiedzialny za obrót śmigła (str. 562). To ułatwi „pozowanie” modelu na ziemi i uzyskanie efektu rozmycia łopat w locie;
Otwory w osłonach luf karabinów maszynowych najłatwiej jest uzyskać za pomocą tekstury przejrzystości (str. 563);
Do zestawu paneli sterowania modelem warto dodać, oprócz sterów kierunku, lotek i klap, także owiewkę kabiny (str. 570);
W tej sekcji zakończyliśmy pracę nad samym modelem. Rysunek 8.9.1 przedstawia jak wygląda uzyskany efekt (to inne ujęcie modelu „na białym tle”, pokazanego na koniec poprzedniej sekcji):
Rysunek 8.9.1 Obecny stan naszego modelu
W takim momencie jak ten warto jest przejrzeć plik Blendera, zawierającym naszą pracę. Zazwyczaj zauważysz w nim wiele zapomnianych zakamarków, wymagających uporządkowania. Na przykład — przejrzyj listę obrazów (w oknie UV/Image Editor). Często znajdziesz w niej wiele niepotrzebnych obiektów (Rysunek 8.9.2):
Rysunek 8.9.2 Usuwanie z pliku referencji do niepotrzebnych obrazów
Nie używane obrazy dość opornie znikają podczas kolejnych zapisów pliku *.blend na dysk. Dzieje się tak dlatego, że ich „licznik użycia” (reference count — por. str. 1215) jest zwiększany przez każde wyświetlanie w jakimkolwiek oknie UV/Image Editor. Takie okna z załadowanym i zapomnianym obrazem mogą się kryć pod każdym z widoków 3D View. (Wystarczy że kiedyś przełączyłeś je na Image Editor, otworzyłeś w nim obraz, a potem przełączyłeś z powrotem na 3D View). Tych przypisań nie znajdziesz posługując się Outlinerem. W oknie Outliner nie znajdziesz także powiązań obrazu ze ścianami siatki (co prawda wykorzystywaliśmy do tego obraz Test — por. str. 366 — ale mogły się gdzieś zapodziać i inne) .
Najszybszym sposobem na pozbycie się niepotrzebnych obrazków jest odłączyć je w UV/Image Editor z wciśniętym klawiszem Shift (Rysunek 8.9.2).
Taka operacja „zrywa” wszelkie połączenia bloku danych z resztą sceny. W efekcie ściany jakiejś siatki mogą stracić przypisania do tego obrazu (w trybie Blender Renderer) ale to nie przeszkadza w renderowaniu.
W trakcie prac nad szczegółami modelu stworzyliśmy wiele nowych materiałów: dla wnętrza kabiny (str. 532) i dla różnorodnych detali (gumy, skóry, tkaniny pasów, plastiku). Rozbudowaliśmy także podstawowy materiał powierzchni zewnętrznych (B.Skin.Camouflage) o dodatkowe efekty (Rysunek 8.9.3):
Rysunek 8.9.3 Nowe węzły w materiale B.Skin.Camouflage
W stosunku do schematu omówionego na str. 468, B.Skin.Camouflage zawiera teraz kilka nowych elementów poprawiających jego wygląd w zbliżeniach. Są to:
efekt przetarć „do gołego metalu” (grupa Bare Metal i sterująca nią tekstura chips.png);
efekt przetarć „do farby podkładowej” (grupa Primer, także sterowana przez tę samą teksturę chips.png);
podkreślenie śrub za pomocą odrębnego shadera (grupa Bolts i sterująca nią tekstura screws.png) ;
zróżnicowanie odbić światła od powierzchni modelu (zespół Random Dirt, wykorzystujący teksturę proceduralną General Noise) ;
Szczegółowy opis efektów przetarć (zespoły Bare Metal, Primer i Bolts) znajdziesz na str. 669-671. Opis odwzorowania drobnych nieregularności w połyskliwości powierzchni (zespół Random Dirt) za pomocą tekstury proceduralnej General Noise znajdziesz na str. 1082-1083.
W materiale B.Skin.Camouflage zostały wykorzystane dwa dodatkowe obrazy:
screws.png: wyeksportowana z GIMP (skin.xcf) warstwa Color-Screws.png (na czarnym tle);
chips.png: wyeksportowana z GIMP (skin.xcf) warstwa Color-Chips (na czarnym tle);
Jednocześnie użyte w materiale obrazy zostały podzielone na grupy:
niezależne od kamuflażu: przechowywane w folderze głównym (np. model\p40\textures\8.08);
zależne od kamuflażu: przechowywane w podfolderach odpowiednich dla wersji (\USAAC lub \AVG);
Zarówno obraz przetarć (chips.png) jak i śrub (screws.png) umieściłem w podfolderach zależnych od kamuflażu (bo każda maszyna nosi nieco inne ślady zużycia eksploatacyjnego).
Na koniec przypomniałem sobie o pewnym drobnym szczególe: obsługa naziemna przed każdym startem zalepiała lufy karabinów taśmą klejącą. Ta osłona chroniła przed kurzem, który mógł spowodować późniejsze zacięcie broni. Przypuszczam że kolory tych „zaklejek” bywały różne — czerwone, zielone, białe, żółte… Aby ten detal odwzorować, umieściłem na każdej z luf mały cylinder (Rysunek 8.9.4a) w kolorze żółtym (użyłem materiału B.Yellow.Details — Rysunek 8.9.4b):
Rysunek 8.9.4 Osłona luf karabinów przed kurzem (żółta taśma klejąca)
To oczywiście element opcjonalny — po strzelaniu z broni pokładowej resztki tych taśm mogły być zerwane przez strumień powietrza.
W tym rozdziale ostateczne kończę pracę nad naszym modelem, wkomponowując go w jakiś przekonujący obrazek.
Ten rozdział zawiera tylko dwie sekcje. Pierwsza sekcja opisuje zagadnienia związane z przygotowaniem sceny w locie. Pokażę jak uzyskać poprawny obrazu rozmytych ruchem łopat śmigła, lepiej dopasować model do zdjęcia podstawionego jako tło, czy nadać scenie dynamikę poprzez rozmycie otoczenia.
Druga sekcja pokazuje, jak „postawić samolot na ziemi”, którą widać na podstawionej za modelem fotografii. W tym przypadku kluczową sprawą jest właściwe ustawienie samolotu i uzyskanie jego cienia na podłożu. Model postawimy na lotnisku polowym, więc pokażę jak stworzyć trawę i inne dodające realizmu szczegóły otoczenia.
Podstawowe modele opisane w tym rozdziale znajdziesz w plikach *.blend z pakietu p40.zip, a foldery z obrazami ich tekstur — w pakiecie textures2.zip. (Adres miejsca, z którego można pobrać te pliki, znajdziesz na. str. 22). Pliki *.blend z dodatkowymi scenami pokazanymi w tym rozdziale znajdziesz w pakiecie p40w.zip.
Renderując przykłady z tego rozdziału w Cycles na CPU natknąłem się na pewne ograniczenie: 32-bitowa wersja Blendera potrafi obsłużyć sceny zawierające do 400 – 420 tys. ścian (800-900 tys. trójkątów). Nasz model w różnych konfiguracjach ma ich zazwyczaj więcej — około 600 tys. ścian. Stąd podczas przygotowania danych do renderowania 32-bitowa wersja Blendera zgłosi błąd. (Program nie jest w stanie otrzymać od systemu operacyjnego Windows żądanej ilości pamięci RAM).
Zalecam renderowanie przedstawionych w tym rozdziale przykładów w 64-bitowej wersji Blendera.
W tej sekcji pokażę, jak przygotować scenę w locie. Omówię poszczególne zagadnienia, posługując się przykładami z różnych scen1. Zaczynam od wyszukania w Internecie jakiegoś darmowego zdjęcia o odpowiedniej rozdzielczości. Potem podstawiam je za modelem, komponując prostą scenę. Jest to dla mnie swoisty „ostateczny test” realizmu: jeżeli mój samolot będzie dobrze wyglądał na tle fotografii, oznacza to że udało mi się go dobrze odwzorować. Specjalnie zresztą wyszukuję zdjęcia okolic, nad którymi naprawdę latała konkretna maszyna, której barwy nosi mój model. Chcę w ten sposób odtworzyć jej „naturalne otoczenie”.
Pracę nad sceną zaczynam od podstawienia za widok z kamery obrazu tła. Rysunek 9.1.1 pokazuje takie ustawienie (jest to Background Image, przypisany do osi Camera — por. str. 787). Potem w widokach z przodu i z góry przesuwam odpowiednio kamerę, „pozując” model w tym tle:
Rysunek 9.1.1 „Pozowanie” — dopasowanie pozycji kamery (a w efekcie – modelu) do tła
Następnie włączam podgląd renderu i ustalam pozycje i energię (Strength) słońca Sun i otoczenia World. Robię to tak, by światło padało na model z tej samej strony, co na fotografii (Rysunek 9.1.2):
Rysunek 9.1.2 Dopasowanie położenia świateł słońca i energii otoczenia
Dla tego zdjęcia ustawiłem Sun:Strength = 25 i Background:Strength = 2;
Na razie na renderze nie są także widoczne łopaty śmigła, a sam kołpak jest nieruchomy. Czas już, by zaczęły się kręcić! Przypisałem sekwencję ruchu (tzw. „krzywą F” — F-Curve) do uchwytu, poruszającego kołpakiem (Rysunek 9.1.3). (Szczegóły tworzenia tej animacji są opisane na str. 1153). Naciśnij Alt-A w którymś z okien 3D View, by zobaczyć jak to działa — Rysunek 9.1.3b,c,d):
Rysunek 9.1.3 Przypisanie krzywej ruchu do uchwytu sterującego obrotem śmigła
Gdy animacja śmigła jest już gotowa, możemy uzyskać w naszej scenie efekt rozmycia ruchu. Wystarczy w zestawie Render włączyć opcję Motion Blur. Aby obraz wirujących łopat śmigła miał odpowiedni kształt, zastosuj jakąś dużą wartość parametru Shutter (Rysunek 9.1.4a) i odpowiednio spowolnij obrót śmigła (Rysunek 9.1.4b). (Więcej na temat tych ustawień znajdziesz na str. 1157).
Rysunek 9.1.4 Dobór wartości przesłony i prędkości obrotu śmigła
Potem wystarczy wcisnąć przycisk Render (lub klawisz F12) by otrzymać rezultat (Rysunek 9.1.5):
Rysunek 9.1.5 Efekt „rozmycia” wirujących łopat śmigła (tło: © Tomo Yun, www.yunphoto.net)
Efekt jest całkiem zadowalający, w dodatku nie wydłużył znacznie czasu renderowania.
Co prawda model, tło i oświetlenie przedstawione przez Rysunek 9.1.5 dopasowywaliśmy już w poprzednich rozdziałach (por. str. 307 i następne). W istocie te góry tworzą uniwersalne tło, pasujące do wielu maszyn. Jednak ta „biała 160” to maszyna stacjonująca w 1941r w Pearl Harbor, i na pewno nikt nie miał okazji zrobić jej zdjęcia ponad szczytami pokrytymi śniegiem (w dodatku te konkretne góry znajdują się w Japonii). Stąd spróbowałem poszukać obrazu na jakieś bardziej adekwatne tło. W Internecie znalazłem ciekawe ujęcie wyspy Oahu wykonane „spod skrzydła” awionetki (Rysunek 9.1.6):
Rysunek 9.1.6 Fragment wybrzeża Hawajów (wyspa Oahu, zdjęcie: www.archerbravo.com)
Spróbujmy wykorzystać to tło do stworzenia nowej sceny (Rysunek 9.1.7):
Rysunek 9.1.7 Wkomponowanie modelu w nowe tło
Wykorzystałem tu dotychczasowy obraz otoczenia (por. str. 306) — to metoda mniej poprawna, ale szybsza. Zwiększyłem tylko jego energię (do 4) i zmieniłem odcień nieba na bardziej błękitny (por. str. 1043).
(Taka adaptacja światła rozproszonego jest niezbędna, by je zbliżyć do warunków oświetlenia widocznych na zdjęciu). Dla tak silnego światła otoczenia musiałem zmniejszyć wartość Reflectivity szkła owiewki do 0.1.
Aby lecieć w pobliżu awionetki, P-40 musiał bardzo zwolnić (być może wysunął kalpy, zasłonięte w tym ujęciu przez skrzydła). W takich warunkach piloci często odsuwają owiewki kabiny Dlatego zdecydowałem się odsunąć osłonę kabiny pilota (Rysunek 9.1.8a). Można to zrobić używając dodatku Handle Panel (por. str. 877), lub uchwytu z warstwy 10. Jeżeli chodzi o samego pilota — pomyślałem, że powinien patrzeć na samolot, do którego się zbliża. Przełączyłem się więc w Pose Mode i obróciłem odpowiednio „kość” Head z armatury umieszczonej wewnątrz tej figurki (Rysunek 9.1.8b):
Rysunek 9.1.8 „Pozowanie” pilota
Rysunek 9.1.9 przedstawia uzyskany rezultat:
Rysunek 9.1.9 Rezultat — model wstawiony w fotografię
Zwróć uwagę ze stery nie są w położeniu neutralnym, a klapy chłodnicy są szeroko otwarte.
W podobnej morsko – zielonej tonacji jest kolejne zdjęcie (Rysunek 9.1.10). To półwysep Kaena, na północy wyspy Ohau. Nieco dalej wzdłuż tego wybrzeża znajdowało się polowe lotnisko, które 7 grudnia 1941r uniknęło ataku japońskich myśliwców. Nasza „biała 160” jest jedną z maszyn, której udało się stamtąd wystartować.
Rysunek 9.1.10 Kolejne tło — półwysep Kaena (www.hawaii.gov)
Wybrałem to zdjęcie, gdyż przekątna linia brzegu dobrze się komponuje z modelem, podkreślając przestrzeń i tor lotu maszyny (Rysunek 9.1.11):
Rysunek 9.1.11 Pierwszy rezultat
Tak jak poprzednio, dobrałem odpowiednie położenie słońca (sugerowałem się cieniami na zboczach wzgórz). Energia słońca jest nieco większa niż poprzednio (Strength = 30). Światło rozproszone ma umiarkowaną intensywność (2.5) i kolor biały. Jednak obraz, który otrzymaliśmy jest lekko rozmyty. Czy można to jakoś poprawić?
Tak, do końcowych poprawek obrazu lub filmu służy w Blenderze tzw. kompozytor. Budujesz w nim z węzłów odpowiedni schemat końcowego przetwarzania wyrenderowanego obrazu (to tzw. postprocessing). Wprowadzenie do budowania schematów kompozytora znajdziesz na str. 1160.
W tym konkretnym przypadku wykorzystałem węzeł Filter→Sharpen, o natężeniu 10% (Rysunek 9.1.12):
Rysunek 9.1.12 Wyostrzenie renderowanego obrazu (podgląd z Node Editor)
Potem dodałem węzeł Color Balance (por. str. 1166). Przesunąłem w nim barwy obrazu w kierunku błękitu, zmniejszając odrobinę intensywność odbłysków i zwiększając intensywność średnich odcieni (Rysunek 9.1.13):
Rysunek 9.1.13 Zmiana tonacji obrazu za pomocą węzła Color Balance
Rysunek 9.1.14 przedstawia uzyskany rezultat:
Rysunek 9.1.14 Rezultat zastosowania obydwu węzłów
Nic tak nie ożywia cieni jak odrobina światła. Cycles nie ma jeszcze (Blender 2.67) prawdziwego światła sferycznego (Hemi). Dlatego przybliżyłem wpływ światła odbitego od powierzchni morza za pomocą słabego światła kierunkowego Sun.Helper (Rysunek 9.1.15):
Rysunek 9.1.15 Dodatkowe źródło światła
To światło ma włączoną opcję Cast Shadow, aby nie rozjaśniało zbytnio głębokich cieni w zakamarkach tuneli chłodnicy czy wlotu powietrza. Jednak jednocześnie jego duży rozmiar (Size = 1) i niewielkie natężenie sprawia, że cienie rzucane przez Sun.Helper są tak rozmyte, że praktycznie niedostrzegalne. Tworzy za to delikatne podświetlenie na zacienionej powierzchni kadłuba (Rysunek 9.1.16):
Rysunek 9.1.16 Wpływ dodatkowego źródło światła
Choć początkowo sądziłem, że światło odbite od powierzchni morza powinno być zielonkawe lub błękitne, to po kilku próbach na podglądzie renderu zdecydowałem się ostatecznie na białe. Dzięki zastosowaniu Sun.Helper wyraźniej widać podziały blach, zadrapania i zabrudzenia na zacienionych powierzchniach kadłuba.
Na tym etapie zmieniliśmy za pomocą węzła Color Balance odcień całego obrazu — zarówno tła jak i samolotu. Niestety, nie mogłem rozjaśnić całości tak bardzo jak bym chciał, ze względu na „przepalenia” bieli obrazu (por. str. 1170). Czy można wydzielić z obrazu sam samolot, aby chociaż go nieco rozjaśnić?
Na szczęście można stworzyć na podstawie współrzędnych Z maskę samolotu (Rysunek 9.1.17):
Rysunek 9.1.17 Maska, zbudowana na podstawie współrzędnych Z pikseli
Wykorzystuję tu do tego celu gotową grupę o nazwie Object Mask. Zasadę działania i szczegóły budowy tego elementu znajdziesz na str. 1171. Tę maskę podłączyłem do wejścia Fac dodatkowego węzła Color Balance. Zmieniam za jego pomocą odcieni i jasność samego samolotu (Rysunek 9.1.18):
Rysunek 9.1.18 Zmodyfikowany schemat
W ten sposób udało się nam znacząco poprawić oryginalny render (Rysunek 9.1.19):
Rysunek 9.1.19 Ostateczny rezultat
Zwróć uwagę, że na obrazie przedstawionym przez Rysunek 9.1.19 samolot ma nieco inny odcień niż na poprzednim renderze. To wynik drobnego przesunięcia ku żółci w kontrolce Gamma jego dodatkowego węzła Color Balance (por. Rysunek 9.1.18). Ten model znajdziesz w pliku history\p40\P40B-9.01w3.blend. Możesz sam poeksperymentować z jego odcieniem, tworząc własną wariację na temat „jak w tym oświetleniu wyglądałby średnio zużyty kolor Olive Drab”.
Możliwość wyodrębnienia samego modelu za pomocą grupy Object Mask umożliwia łatwiejszą integrację z tłem: możesz swobodnie zmieniać odcień samego modelu, aby lepiej pasował do otoczenia
Wydaje mi się, że na tej scenie brakuje drugiego samolotu. 7 grudnia 1941 roku wystartowały z lotniska Haleiwa dwie maszyny, o numerach bocznych „160” (to nasz model) i „316”. Zmieniłem więc nazwę podstawowej sceny na 160 i dodałem nową (wybierając opcję Link Objects) , o nazwie 316. Potem przekształciłem jej referencje (links) w kopie obiektów (Object→ Make Single User→Object). Wreszcie przypisałem scenę 160 jako „tło” sceny 316 (Rysunek 9.1.20a):
Rysunek 9.1.20 Dodanie drugiego samolotu (jako drugiej sceny)
Szczegóły budowy takiej złożonej sceny znajdziesz na str. 802. Rysunek 9.1.21 przedstawia rezultat:
Rysunek 9.1.21 Scena z dwoma samolotami
Co prawda Rysunek 9.1.21 tego dobrze nie pokazuje, ale każdy z samolotów ma naprawdę inny numer boczny. Aby ten efekt uzyskać, stworzyłem drugą wersję obrazu oznaczeń taktycznych (decals-316.png). Następnie przypisałem kilku kluczowym obiektom maszyny „316” Pass Index = 1 i uzależniłem od niego wybór tekstury w materiale B.Skin.Camouflage. (Szczegóły — patrz str. 804).
Dalszy samolot „316” wyszedł na „surowym” renderze zbyt ciemno (obiekty bardziej odległe wydają się zawsze jaśniejsze). Dodałem więc do schematu kompozytora dodatkową sekcję, która rozjaśnia tylko ten myśliwiec (Rysunek 9.1.22):
Rysunek 9.1.22 Zmodyfikowany schemat kompozytora
Wykorzystałem w tym celu drugi raz grupę Object Mask. Dzięki ustawieniu minimalnego dystansu na 300 jednostek Blendera (por. str. 1171), ten węzeł zaznacza tylko dalszy samolot. Kolory obszaru wybranego za pomocą takiej maski rozjaśniłem i zmniejszyłem nasycenie za pomocą węzła Hue Saturation Value. Plik z tą sceną towarzyszy tej książce pod nazwą history\p40\P40B-9.01w4.blend.
Rysunek 9.1.23 przedstawia inne ujęcie (z innym obrazem tła) sceny z dwoma samolotami. W tym widoku z boku dobrze widać ich różne numery taktyczne, uzyskane dzięki zróżnicowaniu wartości Pass Index:
Rysunek 9.1.23 Inna scena z dwoma samolotami
Obraz który przedstawia Rysunek 9.1.23 wydaje się zbyt statyczny: te dwa samoloty są zawieszone nad wodą jak balony. Aby dodać do takiej sceny dynamikę, możesz użyć węzłów Directional Blur i Object Mask do kierunkowego rozmycia tła, imitującego rozmycie ruchu (Rysunek 9.1.24):
Rysunek 9.1.24 Scena z kierunkowym rozmyciem tła
Aby uzyskać taki efekt, użyłem w schemacie kompozycji drugiej warstwy renderowania (czyli obrazu sceny), na której znajduje samo tło (Rysunek 9.1.25):
Rysunek 9.1.25 Schemat kompozycji sceny z liniowym rozmyciem tła
Obraz z tego drugiego węzła RenderLayer podłączyłem do efektu Directional Blur, poddając go rozmyciu w kierunku poziomym. Następnie w węźle Mix nałożyłem na to rozmyte tło oryginalny (tzn. ostry) obraz samolotów. (Aby „wyciąć” ich sylwetki ze statycznej sceny, wykorzystałem grupę Object Mask, która steruje udziałem obrazów łączonych w węźle Mix). Potem dokonuję korekty barw (w węźle Color Balance). Na koniec wzdłuż lewej krawędzi obrazu pozostał czarny pasek, który eliminuję „przycinając” obraz węzłem Crop. Więcej informacji na temat kierunkowego rozmycia ruchu i tego schematu znajdziesz na str. 1174.
W ujęciach z przodu należy używać koncentrycznego rozmycia ruchu. Rysunek 9.1.26 przedstawia scenę, w której wykorzystuję taki sam schemat kompozycji jak ten pokazywany przez Rysunek 9.1.25. Zmieniłem tylko obraz tła, ustawienie modelu, i parametry węzła Directional Blur:
Rysunek 9.1.26 Ujęcie z przodu: zastosowanie rozmycia koncentrycznego
W takich scenach należy zwrócić uwagę, by oś samolotu biegła równolegle do kierunku rozmycia. Rysunek 9.1.26 ujawnia mankament zastosowanego schematu kompozycji: nieprawidłowy obraz wirujących łopat śmigła. Można temu zaradzić wykonując taką scenę w dwóch, a nie jednym kroku. Najpierw wykonaj rozmycie samego tła i zapisz rezultat (jest dostępny jako obraz Viewer Node, w UV/Image Editor) do pliku (Rysunek 9.1.27):
Rysunek 9.1.27 Zapisanie rozmytego obrazu tła do pliku
Potem powróć do prostego schematu bez rozmycia tła, i użyj pliku z rozmytym obrazem jako zwykłej tekstury otoczenia (por. str. 1042). Rezultat przedstawia Rysunek 9.1.28:
Rysunek 9.1.28 Obraz wyrenderowany na uprzednio rozmytym tle (wykorzystuje plik coast-blur.png)
Rysunek 9.1.29 przedstawia obraz startu pary myśliwców z lotniska Haleiwa, stworzony w ten sam sposób:
Rysunek 9.1.29 Inna scena, wykorzystująca to samo tło
W tej scenie nie musiałem sztucznie rozjaśniać dalszej maszyny (być może w wyniku innego położenia słońca). Zwróć uwagę że osie samolotów w kierunku pionowym są tu odchylone od kierunku rozmycia. Jednak każde odchylenie w kierunku poziomym wyglądałoby na błąd! Niesymetryczne składanie kół podwozia (najpierw jedno, potem drugie) było charakterystyczne dla wszystkich P-40.
Plik z tą sceną znajdziesz w materiałach towarzyszących książce (history\p40\P40B-9.01w6.blend).
W tej sekcji pokazałem, jak stworzyć scenę w locie poprzez wkomponowanie modelu w fotografię. Zdjęcia, których do tego używam, znajduję w Internecie. Korzystam z wyszukiwarek, by znaleźć dostępne fotografie o odpowiedniej rozdzielczości. Na przykład w Google możesz ustawić min. rozmiar obrazu w kryteriach wyszukiwania. Oczywiście, ta metoda jest dopuszczalna, dopóki tworzysz swoje prace hobbystycznie, tylko dla własnej satysfakcji;
„Pozowanie” samolotu odbywa się poprzez przesunięcia kamery, albo przesunięcie lub obrót jej „celu” (obiektu Target). Dużą pomocą jest ustawienie fotografii tła w oknie widoku z kamery (jako Background Image — str. 578);
Po ustaleniu pozycji i orientacji kamery, trzeba ustalić pozycję i energię świateł. Chodzi o odtworzenie warunków oświetlenia widocznych na fotografii (str. 578). Oprócz podstawowego źródła światła — Sun — możesz wykorzystać jakieś słabe oświetlenie pomocnicze (str. 584). Za pomocą takiego światła można uzyskać na powierzchni modelu dodatkowe odblaski i rozjaśnienia. Często przydaje się także zmienić trochę barwę otoczenia (str. 580) (Można ją także określić jako „kolor cieni”);
Efekt „rozmycia ruchu” łopat śmigła jest kanonem, który powstał i utrwalił się dzięki fotografii. Nie sposób się od niego uwolnić. Aby go uzyskać, musisz najpierw animować obrót zespołu śmigła (str. 579). Typowa „prędkość” tego ruchu (odpowiednia dla przesłony Motion Blur:Shutter = 100) to 1000-1200 klatek na pełen obrót (str. 579).
Dla lepszego dopasowania modelu do zdjęcia tła przydatny jest zaprojektowanie dodatkowych modyfikacji obrazu po wyrenderowaniu. Ten ostatni etap określa się w CG jako postprocessing. W Blenderze możesz go zrealizować za pomocą schematu kompozycji, który tworzysz w Node Editor, używając Composite Nodes (str. 583). To bardzo elastyczne narzędzie o dużych możliwościach. Pozwala na łączenie ze sobą wielu różnych obrazów i poddawaniu ich różnorodnym transformacjom;
Schemat kompozycji opisuje transformację, której zostanie poddany każdy piksel wyrenderowanego obrazu. Oczywiście, każdy węzeł tego schematu może zmienić tylko niektóre fragmenty z tej całości;
Typowym węzłem, dostarczającym schematom kompozycji Blendera danych wejściowych jest RenderLayer. Reprezentuje na schemacie pojedynczą „warstwę renderowania” (render layer). Możesz zdefiniować wiele alternatywnych warstw rednerowania dla pojedynczej sceny. Każda z nich to indywidualny zestaw parametrów dla renderera. Opisuje, co ma być przetworzone, oraz określa rodzaje danych udostępnianych na wyjściu węzła (str. 583, 585, 588). Domyślnie każda scena Blendera ma jedną taką warstwę, o nazwie 1 Render Layer;
Typową metodą na lepszą integrację modelu ze zdjęciem tła jest zmiana ich odcieni po wyrenderowaniu. Możesz to zrobić za pomocą węzła Color Balance (str. 583);
Podobnie jak w schematach materiałów, często używane kombinacje węzłów kompozycji można łączyć w grupy. Upraszcza to budowę schematów i poprawia ich czytelność. W tej sekcji wykorzystuję grupę o nazwie Object Mask. Na podstawie informacji z kanału Z tworzy obraz, w którym białe kontury modelu są umieszczone na tle czarnego tła (str. 585). To przydatna maska do różnych efektów (np. dostosowania odcienia samolotu do tła — str. 585, albo rozmycia tła za samolotem — str. 588);
Istnieje wiele metod stworzenia sceny z kilkoma samolotami. Na str. 586 pokazuję, jak uzyskać obraz pary P-40. Używam do tego scen Blendera (po jednej na każdy samolot);
Aby zróżnicować oznaczenia (np. numery taktyczne) na każdym z modeli użytych w scenie grupowej, trzeba przygotować dwie wersje tekstury oznaczeń (decals.png). Potem zmodyfikuj materiał poszycia (B.Skin.Camouflage), uzależniając wybór piksela z tych tekstur od wartości Pass Index renderowanego obiektu (por. str. 804);
Efekt kierunkowego rozmycia ruchu nadaje dynamiki scenie — szczególnie ujęciom robionym na bardzo małej wysokości. Uzyskuje się go za pomocą węzła Directional Blur (str. 588). Czasami można stosować ten efekt w dwóch krokach: stworzenia rozmytego tła i wyrenderowania na nim samolotu (str. 589);
Choć może wydawać się to dziwne, trudno jest znaleźć duże, dobre zdjęcie lotniska polowego, które nadaje się na tło sceny. Szczególnie, jeżeli szukamy fotografii z określonej okolicy, z której operował nasz model. W tej sekcji „postawimy” na lotnisku polowym P-40 („białą 75”) z AVG. Szukałem przez parę dni dużych obrazów z prowincji Yunnan (Chiny), ale niczego odpowiedniego nie znalazłem. No cóż, gdy czegoś brakuje, zawsze możesz spróbować to stworzyć sam. Przeglądając posiadane zdjęcia, zdecydowałem się połączyć kawał równego jak stół stepu w Mongolii z brzegiem rzeki Jangcy (Rysunek 9.2.1):
Rysunek 9.2.1 Fotomontaż obrazu fragmentu lotniska w Kweilin
Step ze zdjęcia a) przypomina powierzchnię lotniska Kweilin widoczną na archiwalnych zdjęciach: jest płaski, porośnięty kępkami rzadkiej trawy. Wzgórza i brzeg rzeki ze zdjęcia b) wyglądają podobnie do otoczenia tego lotniska (z lat 40-tych XX w.). Obydwa zdjęcia wydają się mieć zbliżony odcień. Użyłem GIMP aby je ze sobą złożyć. Zasłoniłem obrazem stepu powierzchnię wody ze zdjęcia b). Potem, używając narzędzia Color Balance zmieniłem nieco odcień stepu, by go lepiej dopasować do odcienia chińskiego lessu widocznego na brzegu rzeki. Rezultat (Rysunek 9.2.1c) znajdziesz w pliku model\p40\background\kweilin.png. To, że uzyskany obraz jest dość ciemny, nie stanowi dużej przeszkody. Te barwy są gdzieś w połowie skali pomiędzy czernią i bielą, więc można je zawsze stosunkowo łatwo rozjaśnić.
Podstaw to zdjęcie jako tło sceny (Rysunek 9.2.2a). Kamerę ustaw tak, by koła modelu „stanęły” na gruncie tam, gdzie pasują do rozmiaru trawy widocznej na tle (Rysunek 9.2.2b). To wymaga pochylenia „celu” kamery — obiektu Target. (Upewnij się, że w jej ograniczeniu Track To jest włączony przełącznik TargetZ).
Rysunek 9.2.2 Ustawienie kamery i modelu
Do tej pory ustawialiśmy oświetlenie dla sceny w locie (por. str. 306, 287). W scenie na ziemie trzeba je zaaranżować nieco inaczej. Rysunek 9.2.3 przedstawia pierwsze przybliżenie:
Rysunek 9.2.3 Pierwsze przybliżenie oświetlenia sceny
Na zdjęciu tła trudno jednoznacznie ocenić kierunek promieni słonecznych, gdyż cienie na wzgórzach są odległe i zamglone. Wydaje się padać od strony obserwatora (Rysunek 9.2.4b). Ostatecznie zdecydowałem że znajduje się po lewej (Rysunek 9.2.3, Rysunek 9.2.4a):
Rysunek 9.2.4 Szczegóły ustawień słońca
Otoczenie na zdjęciu sprawia wrażenie lekko zamglonego — stąd zdecydowałem się zmienić rozmiar słońca (Sun) z 0.01 do 0.1 (Rysunek 9.2.4c), by uzyskać „miękkie” krawędzie cieni. Z tego samego powodu nadałem słońcu taki kolor, jaki ma niebo (na rozjaśnionej wersji zdjęcia).
Zdecydowałem się także rozjaśnić odcień powierzchni samolotu. Zrobiłem to, zmieniając w materiale B.Skin.Camouflage bazową wartość parametru X.Textured Skin: Diffuse Intensity do 0.3 (Rysunek 9.2.5):
Rysunek 9.2.5 Rozjaśnienie powierzchni samolotu (B.Skin.Camouflage)
Scena przedstawiana przez Rysunek 9.2.3 wykorzystuje to samo otoczenie World, jakie stworzyliśmy w poprzednich rozdziałach (takie, jakie jest opisane na str. 1036 i następnych). Podstawiłem tylko jako zawartość obrazu background nasz fotomontaż. Dodatkowo rozjaśniłem go za pomocą korekty Color→Gamma (aby nie „przepalić” tego jasnego nieba w zupełną biel — Rysunek 9.2.6):
Rysunek 9.2.6 Rozjaśnienie obrazu tła (środowisko World)
Oprócz tego zdecydowałem się rozjaśnić i zmienić zabarwienie światła rozproszonego. (Tym bardziej, że większość powierzchni samolotu w tym ujęciu widzimy od strony nie oświetlonej przez słońce). Stąd zwiększyłem jego intensywność z 2.0 do 3.0, i zwiększyłem w nim udział koloru żółtego (Rysunek 9.2.7):
Rysunek 9.2.7 Rozjaśnienie światła rozproszonego (środowisko World)
Bez tych zmiany render przedstawiony przez Rysunek 9.2.3 byłby zbyt ciemny.
„Wierzch” samolotu już całkiem dobrze pasuje do tła. Teraz musimy zająć się jego spodem, a dokładniej: stworzyć na zdjęciu cień naszego modelu. Umieść kursor 3D w środku samolotu, ale na poziomie kół (Rysunek 9.2.8a). Wstaw w tym miejscu duży kwadrat (Plane) — to będzie nasz „grunt”:
Rysunek 9.2.8 Płaszczyzna podłoża
Nadaj temu obiektowi nazwę Ground, i umieść na warstwie 19. Podstaw go, w rzucie z góry, pod koła główne. Potem przełącz się na rzut z boku, i obróć tę płaszczyznę tak, by dotknęła kółka ogonowego (Rysunek 9.2.8b). Upewnij się, że wszystkie koła minimalnie przenikają przez jej powierzchnię (Rysunek 9.2.8c).
Przy okazji możesz naszemu „gruntowi” przypisać ograniczenie Locked Track, kierujące na kamerę oś –Y tej płaszczyzny (Rysunek 9.2.9a):
Rysunek 9.2.9 Skierowanie podłoża na kamerę (za pomocą ograniczenia Locked Track)
Osią obrotu tego ograniczenia jest lokalna oś Z podłoża. Takie ustawienie pozwala na obracanie modelu w kamerze (a właściwe — kamery wokół modelu) bez zmiany tła (por. str. 599, Rysunek 9.2.21). To bardzo ułatwia późniejsze poprawki sceny.
Powierzchnię Ground można jeszcze bardziej powiększyć, by w polu widzenia kamery było widać tylko jej jedną, przeciwległą krawędź (Rysunek 9.2.10a). Przypiszmy do tej siatki materiał — także o nazwie Ground. Używając tekstury gradientu „rozmyj” tylną krawędź powierzchni podłoża (Rysunek 9.2.10b) :
Rysunek 9.2.10 Dopasowanie tylnej krawędzi podłoża do tła
Rysunek 9.2.11 przedstawia początkowy schemat materiału Ground, na którym widać szczegóły mapowania tekstury gradientu. Zwróć uwagę, że jest mapowania we współrzędnych okna (Window):
Rysunek 9.2.11 Materiał podłoża (Ground) — schemat początkowy
Aby lepiej ocenić efekt rozmycia, początkowo pozostawiłem powierzchnię podłoża w kolorze białym.
Teraz zmodyfikujmy kolor płaszczyzny: przypisz do shadera Diffuse BSDF obraz tła, w takim samym mapowaniu jak w otoczeniu World: Window (Rysunek 9.2.12):
Rysunek 9.2.12 Materiał Ground: dodanie obrazu podłoża
Na wszelki wypadek za węzłem Image Texture z obrazem background dodałem węzeł HSV do sterowania intensywnością barw. Będziemy go potrzebować (Rysunek 9.2.13):
Rysunek 9.2.13 Mapowanie tekstury tła na podłoże
Gdy zastosujesz materiał Ground z ustawieniami pokazanymi przez Rysunek 9.2.12, uzyskasz zbyt jasną powierzchnię (Rysunek 9.2.13a). Dopiero zmniejszenie intensywności barw tekstury do 0.4 sprawia, że powierzchnia podłoża poprawnie łączy się z tłem (Rysunek 9.2.13b). W ten sposób uzyskaliśmy rzecz kluczową do integracji ze zdjęciem: cień (Rysunek 9.2.14):
Rysunek 9.2.14 Cień, rzucany przez model na zdjęcie tła
Co prawda cień na poprzedniej ilustracji wydaje się zbyt głęboki. Na szczęście to można bardzo łatwo zmienić. Wystarczy dodać do schematu materiału Ground za teksturą gradientu dodatkowy węzeł Multiply (Rysunek 9.2.15b). Ten węzeł zmniejsza jasność gradientu, a w efekcie — zwiększa przejrzystość powierzchni podłoża. Jak pamiętasz pod podłożem znajduje się nadal półsfera która emituje światło rozproszone (por. Rysunek 9.2.3). Stąd cień samolotu i jego dolne powierzchnie stają się jaśniejsze (Rysunek 9.2.15a):
Rysunek 9.2.15 Sterowanie intensywnością cieni
Uzyskaliśmy więc teraz jasny (może nawet nieco zbyt jasny?) cień. Jednak widzę inny problem: jest zbyt płaski (Rysunek 9.2.15a)! Na zdjęciu tła widać kępki trawy — ich obecność powinna deformować granice cienia. Aby uzyskać ten efekt ustawiłem tuż pod siatką podłoża drugą, z której wyemitowałem trawę (Rysunek 9.2.16a,b):
Rysunek 9.2.16 Podłoże z dodaną w okolicach cienia trawą
Taki efekt uzyskuję za pomocą systemu cząstek (Particles) typu Hair (Rysunek 9.2.16c). Wykorzystuję tu możliwość generowania włosów/trawy przez Cycles. Szczegółowy opis tego systemu cząstek jest na str. 1180 1.
Rysunek 9.2.17 przedstawia materiały przypisane do emitera (obiektu Grass):
Rysunek 9.2.17 Materiały przypisane do obiektu Grass
Do powierzchni tej siatki przypisałem zupełnie przejrzysty materiał Empty (aby nie miał wpływu na jasność cieni — por. Rysunek 9.2.15) . Źdźbła trawy pokryte takimi samymi teksturami co podłoże Ground, ale z nałożonymi z inną intensywnością. Nazwałem ten materiał Grass. Aby obraz tła był nałożony na trawę i podłoże dokładnie w ten sam sposób, połączyłem wszystkie węzły oryginalnego materiału Ground w pomocniczą grupę X.Ground (Rysunek 9.2.18a). Wykorzystałem ją następnie w obydwu materiałach (Rysunek 9.2.18b):
Rysunek 9.2.18 Pomocnicza grupa X.Ground i jej użycie w materiale Grass
Gęstością trawy można sterować za pomocą wag. Namaluj je na wierzchołkach siatki emitera w trybie Weight Paint (Rysunek 9.2.19, por. także str. 958):
Rysunek 9.2.19 „Malowanie” trawy
Kontury kępek trawy odrysowałem wcześniej ze zdjęcia tła wykorzystując Grease Pencil (por. str. 1149).
Rysunek 9.2.20 przedstawia nasz model stojący na powierzchni wzbogaconej o efekt trawy. Zmodyfikowałem tu także materiał opon (por. str. 1095), aby wyglądały na bardziej zużyte i pobrudzone:
Rysunek 9.2.20 Cień samolotu dopasowany do trawiastej powierzchni lotniska ze zdjęcia
Na pewno niejeden z grafików komputerowych wszystkie takie poprawki cienia woli po prostu domalować na ostatecznym renderze. Można to zrobić w dowolnym programie do grafiki rastrowej (Photoshop, GIMP...). Ja jednak uważam, że lepiej przygotować podłoże w przestrzeni 3D, w oryginalnej scenie Blendera. Później możesz w prosty sposób poprawić pozycję kamery, czy też wykonać inne zmiany w układzie sceny.
Zobacz chociażby, jak łatwo jest teraz zmienić kompozycję obrazu. Załóżmy, że chcesz ustawić samolot pod innym kątem, a tło i podłoże mają pozostać nieruchome. Pamiętasz, jak przypisaliśmy „gruntowi” ograniczenie Locked Track, śledzące położenie kamery (por. str. 595)? To właśnie dla szybkiego wykonania takich zmian!
Przypisz jeszcze tylko do „gruntu” wszystkie światła (relacją Parent). W ten sposób zapewnimy sobie ich niezmienną pozycję2. Teraz ustaw płaszczyznę widoku równolegle do podłoża (View→Align View→Align View to Selected). Umieść w jej środku kursor 3D (Object→Snap→Cursorto Selection). Ustaw oś obrotu (Pivot) na 3D Cursor. Następnie zaznacz kamerę i jej cel (obiekt Target). Zacznij je obracać (Rysunek 9.2.21a):
Rysunek 9.2.21 Obracanie kamery wraz z podłożem
Jednocześnie obserwuj w drugim oknie, co się dzieje w obiektywie kamery. Choć obracasz tylko kamerę, to tam wygląda to wszystko tak, jak gdybyś obracał sam model! Reszta „sceny” — podłoże, oświetlenie i tło — jest w kamerze nieruchoma. I właśnie o taki efekt chodziło! W ten sposób możesz zmienić ujęcie modelu, nie tracąc czasu na dopasowania trawy i podłoża do nieruchomej fotografii tła. Zobacz sam: jednym ruchem ustawiłeś nasz samolot bokiem do kamery (Rysunek 9.2.22):
Rysunek 9.2.22 Ujęcie z boku
Grafik, który poprawia render w Photoshopie, musiałby w takim przypadku usiąść, i ponownie poprawiać „surowy” cień samolotu. A my mamy to gotowe! Teraz można byłoby po lewej wstawić drugi samolot, a wokół niego — figurki mechaników…
W tym nowym ujęciu (Rysunek 9.2.22) zmieniłem nieco odcień tekstury podłoża i trawy (w grupie X.Ground) — tak, aby lepiej pasował do odcienia samolotu. W GIMP na obrazu kamuflażu (color.png — por. str. 425, 458) nałożyłem w trybie Multiply dwie dodatkowe warstwy Ref-shadows.png (to kopia ref_details.png) i Ref-Smoke. Zwiększyłem w ten sposób wrażenie kurzu i zużycia. Choć na tak „szorstkim” modelu to niewiele zmienia, wstawiłem w środowisku World panoramę otoczenia odpowiadającą zdjęciu tła. Rysunek 9.2.23 pokazuje zawartość nowego pliku (kweilin.jpg), który podstawiłem w Blenderze jako obraz dolnej półsfery otoczenia (Earth):
Rysunek 9.2.23 Panorama otoczenia dla środowiska World (kweilin.svg)
Panoramę przedstawioną przez Rysunek 9.2.23 stworzyłem ustawiając obok siebie oryginalny obraz tła (model/p40/background/kweilin.png) i jego lustrzane odbicie — tak jak to opisałem na str. 1037. Tym razem jednak zrobiłem to w Inkscape, a nie w GIMP (w Inkscape łatwiej się operuje obszarami wypełnionymi gradientem). Prawa część panoramy to klon lewego obrazu, przerzucony w poziome. Linię horyzontu umieściłem tu w połowie wysokości (bo obserwator stoi na ziemi). Głębsze obszary dolnej półsfery wypełniłem białym gradientem, aby zapewnić otoczeniu odpowiednią energię do rozjaśniania cieni (por. 597, Rysunek 9.2.15).
Zmiana obrazu panoramy otoczenia ma minimalny wpływ na matowe powierzchnie modelu w tej scenie3. Co innego, gdyby były gładkie! W aktualnej projekcji oszkleniu kabiny także nie widać odbić otoczenia. Zdecydowaną różnicę widać za to na lustrzanej powierzchni sondy (Rysunek 9.2.24):
Rysunek 9.2.24 Odbicia starej i nowej panoramy otoczenia na powierzchni sondy
Zwróć uwagę, że linia horyzontu panoramy jest pochylona — to dlatego, że mamy obróconą kamerę (por. str. 592, Rysunek 9.2.2). Należy to skompensować za pomocą dodatkowego węzła transformacji (Rysunek 9.2.25):
Rysunek 9.2.25 Dostosowanie linii horyzontu panoramy
Czas dokończyć naszą scenę. Ustaw oś widoku 3D wzdłuż osi słońca (Align View to Selected→Top) i upewnij się czy cały cień samolotu w nowym położeniu mieści się na powierzchni trawy. Jeżeli nie — przesuń obiekt Grass wzdłuż lokalnych osi X, Y (Rysunek 9.2.26):
Rysunek 9.2.26 Dopasowanie obszaru trawy do zmienionego cienia samolotu
Na ostatecznym obrazie zdecydowałem się dodać drugą, lądującą maszynę, by podkreślić, że samolot stoi na lotnisku polowym (Rysunek 9.2.27):
Rysunek 9.2.27 Nowa wersja ujęcia z boku
Lądujący samolot to kopia modelu umieszczona w drugiej scenie, stworzonej metodą opisaną w poprzedniej sekcji (por. także str. 802). Aby uzyskać jej efekt rozmycia śmigła, włączyłem z powrotem w zestawie Render opcję Motion Blur. Umieściłem także pod tym lądującym samolotem podłoże — głównie po to, aby jego dolne powierzchnie nie były zbyt jasne. Plik z tą sceną znajdziesz w danych towarzyszących książce (to model\p40\history\P40B-9.02w1.blend).
Uzyskany obraz warto dodać drobnym korektom (postprocessing). Stworzyłem w tym celu prosty schemat, wykonujący dwie operacje: niewielkiego zwiększenia nasycenia barw (w węźle Hue Saturation Value) oraz drobnego wyostrzenia obrazu (w węźle Filter:Sharpen — Rysunek 9.2.28):
Rysunek 9.2.28 Dodatkowy postprocessing obrazu
Rysunek 9.2.29 przedstawia rezultat uzyskany w wyniku tych dwóch operacji:
Rysunek 9.2.29 Poprawiona wersja sceny na ziemi
Oprócz zwiększenia nasycenia barw zastosowałem tu także niewielkie rozjaśnienie (zwiększając wartość HSV:Value o 3%). Myślę, że po tych końcowych poprawkach obraz wygląda lepiej. Aby poprawić kompozycję całości, możesz jeszcze odciąć jego dolną część. (Tak aby samolot znalazł się dokładnie w połowie wysokości obrazu).
Gdy brakuje nam odpowiedniej fotografii tła miejsca, w którym chcielibyśmy umieścić nasz model, można spróbować skomponować odpowiedni obraz. W tej sekcji stworzyłem obraz lotniska z dwóch innych zdjęć (str. 592);
Aby poprawnie ustawić model na tle fotografii, musisz uwzględnić położenie horyzontu i właściwe proporcje obiektów na zdjęciu i modelu (np. wysokość trawy na powierzchni lotniska polowego). Zazwyczaj nie wystarczy przesuwać kamery, trzeba także ją trochę obrócić (str. 592). W naszym przypadku kamera jest skierowana na obiekt Target za pomocą ograniczenia Track To, i jej obrotem steruje obrót tego obiektu.
Oświetlenie sceny na ziemi składa się z tych samych elementów co sceny w powietrzu. Źródłem światła kierunkowego jest słońce (Sun — str. 593) o podobnej energii co w scenach w locie. Gdy na tle widać zamglenie, można zwiększyć rozmiar źródła Sun, by uzyskać „miękkie” granice cieni. Źródłem światła rozproszonego jest panorama, zbudowana z części górnej i dolnej. Górną częścią jest taki sam obraz nieba jak w scenach w locie, dolną — obraz skomponowany z fotografii tła (str. 600-601);
Cień samolotu uzyskujemy na powierzchni, podstawionej pod koła modelu (str. 594). To nasz model „gruntu”. Najprostszą metodą integracji cienia z tłem jest pokrycie powierzchni gruntu tym samym obrazem co tło sceny, w takim samym mapowaniu (Texture Coordinate:Window). Ze względu na oświetlenie słońcem taką teksturę trzeba w tym przypadku przyciemnić (str. 596). Jasnością cienia sterujemy zmieniając przejrzystość materiału podłoża (str. 597);
Cień samolotu można dodatkowo „urealnić”, umieszczając na podłożu widoczne na obrazie tła nierówności. (Chodzi o te, które zniekształcają cień). Zazwyczaj jest to trawa, którą można stworzyć za pomocą tzw. systemu cząsteczek (Particles), typu Hair (str. 597);
Nieregularne kępki trawy tworzy się za pomocą „malowania” wag (tryb Weight Paint — por. str. 598). Do przeniesienia ich zarysu ze zdjęcia może się przydać narzędzie do nanoszenia „linii koncepcyjnych” — Grease Pencil (por. str. 1149);
Światła sceny warto przypisać (relacją Parent) do płaszczyzny podłoża. Podłoże można skierować (ograniczeniem Locked Track) na kamerę (str. 595). Takie ustawienia umożliwiają wygodne obracanie kamery wokół modelu (str. 599, 600);
Zawartość tej części bardzo przypomina zawartość plików podpowiedzi do trzech programów: GIMP, Inkscape i Blendera. Są tu zestawione opisy tych poleceń, które zostały wykorzystane w poprzednich częściach książki. Z założenia będziesz z nich korzystał wyrywkowo (por. „Jak czytać tę książkę?”, str. 16). Nie doszukuj się więc w kolejności rozdziałów i sekcji tej części jakiejś przemyślanej metody wprowadzania w obsługę programu. Do tego służy część pierwsza — „Budowa modelu”. To tam specjalnie dobrałem kolejność prezentowanego materiału w ten sposób, byś mógł stopniowo poznawać wszystkie potrzebne zagadnienia.
Gdy zdecydujesz się wydrukować tę książkę dla własnych potrzeb, proponuję pozostawić tą część w postaci elektronicznej. W przeglądarce PDF szybciej znajdziesz podaną w części pierwszej stronę, niż kartkując gruby wydruk. (No i zużyjesz mniej drzew z lasów...).
Nazwa GIMP pochodzi, jak sądzę, od pierwszych liter angielskiego G raphic Im age P rocessor. Jest to jeden z pierwszych, dużych i ukończonych projektów Open Source.
Pobierz ze strony http://www.gimp.org/downloads/ plik instalacyjny i uruchom go (do przeprowadzenia tej operacji musisz mieć uprawnienia Administratora). Program instalacyjny wyświetla najpierw się okno dialogowe pozwalające ustalić język w jakim będą wyświetlane poszczególne ekrany (Rysunek 10.1.1a), a następnie ekran startowy (Rysunek 10.1.1b):
Rysunek 10.1.1 Instalacja GIMP — pierwsze dwa ekrany
Jeżeli chcesz np. zmienić folder programu — przejdź do Customize. Na jednym z ekranów, które się wówczas pojawią, możesz na przykład zmienić folder w którym zostaną umieszczone pliki programu. Potem wrócisz na ekran startowy.
Ja jednak proponuję zainstalować GIMP bez jakiejkolwiek zmiany domyślnych parametrów: naciśnij od razu przycisk Install. Spowoduje to rozpoczęcie całej operacji (Rysunek 10.1.2a):
Rysunek 10.1.2 Dalsze ekrany programu instalacyjnego
Po zakończeniu kopiowania plików i rejestracji komponentów program instalacyjny wyświetli ekran końcowy (Rysunek 10.1.2b).
Potem możesz uruchomić GIMP. Na początku pojawi się okno startowe (Rysunek 10.1.3):
Rysunek 10.1.3 GIMP — okno startowe
Pierwsze uruchomienie GIMP trwa zazwyczaj najdłużej — przez minutę lub dwie program rozpoznaje swoje komponenty. Gdy otworzą się główne okna, proponuję od razu zmienić język interfejsu z polskiego na angielski.
Dlaczego? Większość „samouczków” do GIMP, które możesz znaleźć w Internecie, opisuje ten program w języku angielskim. W tym języku jest prowadzona jest także większość forów dyskusyjnych. Będziesz mógł o wiele łatwiej i szybciej przyswajać sobie wszelkie wskazówki na temat tego programu gdy będziesz oswojony z jego „międzynarodową” nomenklaturą.
Język przełącza się bardzo łatwo (Rysunek 10.1.4):
Rysunek 10.1.4 Ustalanie języka programu
otwórz okno Edycja→Preferencje (Rysunek 10.1.4a);
w oknie Preferencji przejdź do sekcji Interfejs (Rysunek 10.1.4b);
zmień Język z Język systemowy na angielski (w wersji amerykańskiej: Rysunek 10.1.4c);
naciśnij OK aby zamknąć okno Preferencje, po czym zamknij GIMP i otwórz go ponownie.
Domyślnie GIMP otwiera trzy okna: jedno na obraz i dwa „narzędziowe” (Rysunek 10.1.5):
Rysunek 10.1.5 Trzy domyślne okna GIMP
Myślę, że do środowiska Windows bardziej pasuje program zawarty w pojedynczym oknie. Przełączmy GIMP w taki tryb opcją Windows→Single-Window Mode (Rysunek 10.1.6):
Rysunek 10.1.6 Przełączenie GIMP w tryb pojedynczego okna
Gdy ta opcja jest włączona, GIMP wyświetla wszystkie swoje panele w pojedynczym oknie (Rysunek 10.1.7):
Rysunek 10.1.7 GIMP w trybie pojedynczego okna
Po zainstalowaniu GIMP, możesz także pobrać z tej samej stron ( http://www.gimp.org/downloads/ ) pakiet instalacyjny rozbudowanego systemu podpowiedzi (Help). Rysunek 10.1.8a) pokazuje pierwszy ekran, jaki pojawia się po uruchomieniu tego instalatora:
Rysunek 10.1.8 Pierwsze dwa ekrany instalacji podpowiedzi
Na kolejnym ekranie (Rysunek 10.1.8b) można ustalić folder w którym zostaną umieszczone pliki systemu pomocy.
Na kolejnym ekranie (Ready to Install — Rysunek 10.1.9a) naciśnij przycisk Install aby rozpocząć kopiowanie plików:
Rysunek 10.1.9 Instalacja GIMP — ekrany: rozpoczęcia operacji i finalny
Instalacja systemu podpowiedzi kończy się ekranem finalnym (Rysunek 10.1.9b).
Ładowanie wszystkich komponentów zajmuje Gimpowi parę sekund podczas uruchamiania. W tym czasie pokazywane jest “okno startowe” (Rysunek 10.2.1):
Rysunek 10.2.1 Okno startowe GIMP — pokazuje postęp ładowania komponentów
Po zakończeniu ładowania, ujrzysz główne okno programu (Rysunek 10.2.2):
Rysunek 10.2.2 Domyślny ekran GIMP (2.8, tryb pojedynczego okna)
Obszar pośrodku okna to miejsce na obrazy. Po jego obu stronach są umieszczone panele dialogowe z przyborami rysunkowymi lub innymi pomocami. Paneli dialogowych jest w programie dużo, i mogą być łączone w zakładki (jak te z prawej strony przykładowego okna).
Obszar paneli możesz zawęzić (nawet do zera), jeżeli będzie Ci brakować miejsca na ekranie.
Rysunek 10.2.3a) przedstawia ważniejsze elementy okna przybornika (Toolbox) i panelu z opcjami narzędzi (domyślnie umieszczonego z lewej strony okna):
Rysunek 10.2.3 Przybornik i panel dialogowa
Przyjrzyj się nagłówkowi obszaru zakładek w oknie Toolbox. Jest tam, po prawej stronie, taki niepozorny przycisk „strzałki”. Gdy w niego klikniesz — otworzysz menu rozwijalne sterowania panelami (Rysunek 10.2.3b). Pierwszą jego pozycją jest submenu, odpowiadające aktywnej zakładce tego zestawu. (Na tej ilustracji zestaw zawiera pozycję o nazwie Tool Options).
Jeżeli w obszarze masz więcej niż jedną panel, możesz każdą z nich „wyciągnąć” w oddzielne okno „pływające” ponad ekranem. Służy do tego polecenie Detach Tab z menu panelu.
Polecenie Close Tab zamyka aktualną zakładkę (jeżeli była to ostatnia zakładka — zniknie cały obszar).
Zajmijmy się jednak innym poleceniem z tego menu: Add Tab. Jest to zagnieżdżone menu, prezentujące do wyboru wszystkie dostępne zakładki (Rysunek 10.2.4a). Gdy wybierzesz z tego menu jedną z zakładek (np. Layers — kształty narzędzi), GIMP doda ją do przybornika (Rysunek 10.2.4b):
Rysunek 10.2.4 Dodawanie do przybornika dodatkowej zakładki
Na ekranie możesz mieć otwartych kilka obszarów z panelami. Panele można przenosić pomiędzy obszarami metodą „przeciągnij i upuść”, „łapiąc” myszką (LPM) za zakładkę (Rysunek 10.2.5):
Rysunek 10.2.5 Przenoszenie pojedynczego panelu pomiędzy obszarami dialogowymi
Jeżeli nie chcesz przez nieuwagę przeciągnąć myszką jakiegoś panelu — możesz wyłączyć możliwość takiego przeciągania, włączając w jego menu (por. Rysunek 10.2.3b) opcję Lock Tab to Dock.
Posługując się tymi poleceniami możesz w skompletować zakładki, które są Ci potrzebne do pracy. Wydaje mi się, że do naszych celów na razie wystarczą trzy: Tool Options, Brushes i Layers (por. Rysunek 10.2.6):
Rysunek 10.2.6 Sugerowany układ ekranu
Jeżeli brakuje Ci miejsca na ekranie, można przenieść wszystkie potrzebne panele na jedną stronę ekranu, a potem szerokość przeciwległego obszaru zmniejszyć do zera.
W centrum okna programu wyświetlany jest edytowany obraz. Rysunek 10.2.7 przedstawia kilka istotnych elementów tego obszaru, które pojawiają się gdy wczytałeś istniejący plik lub stworzyłeś nowy:
Rysunek 10.2.7 Elementy obszaru obrazu
W GIMP możesz naraz otworzyć wiele obrazów. Każdy z nich zostanie umieszczony w odrębnej zakładce (Rysunek 10.2.8). Można także ten sam obraz otworzyć w kilku zakładkach (View→New View).
Rysunek 10.2.8 Praca z wieloma obrazami naraz
Jeżeli chcesz widzieć różne obrazy lub fragmenty obrazu w oknach ustawionych obok siebie — wyłącz opcję Windows→Single-Window Mode.
Jednym z typowych elementów interfejsu użytkownika są kontrolki umożliwiające określenie jakiejś ograniczonej wartości (np. intensywność jakiegoś efektu). Podstawowym problemem w przypadku takich elementów jest pogodzenie możliwości szybkiej i łatwej zmiany za pomocą myszki z możliwością wpisania dokładnej wartości. We wcześniejszych wersjach programu starano się to umożliwić za pomocą zespołu dwóch kontrolek: suwaka i pola tekstowego (Rysunek 10.2.9a). W wersji 2.8 GIMPa połączono te dwa elementy w całość (Rysunek 10.2.9b):
Rysunek 10.2.9 Nowy rodzaj kontrolki — połączenie suwaka i pola tekstowego
W taką kontrolkę można wpisać za pomocą klawiatury dokładną wartość — podczas pisania zachowuje się tak, jak klasyczne pole liczbowe (Rysunek 10.2.10a). Alternatywnie możesz także przesunąć pasek wartości klikając myszką w górną krawędź kontrolki (Rysunek 10.2.10b). Przeciągnięcie granicy paska wzdłuż dolnej krawędzi pozwala uzyskać drobniejsze zmiany (Rysunek 10.2.10c):
Rysunek 10.2.10 Szczegóły obsługi nowej kontrolki zakresu
W GIMP polecenia z palety narzędzi (przybornika) są dostępne także poprzez menu Tools (Rysunek 10.2.11). Twórcy programu pogrupowali je tam w kilka submenu: Selection Tools, Paint Tools, Transform Tools. W tekście książki łatwiej i bardziej jednoznacznie jest mi podawać polecenia z menu, niż umieszczać obrazki ikon do naciśnięcia. Będę więc powoływał się na nazwy poleceń. Jeżeli wolisz korzystać z przybornika — otwórz tylko raz podane przez mnie menu, aby upewnić się o którą ikonę chodzi. (Są zawsze widoczne obok napisów) Gdy już rozpoznasz ten symbol — używaj przybornika.
Wszystkie programy w tej książce pokazuję w wersji anglojęzycznej. GIMP ma także dobre tłumaczenie na język polski. Program instalacyjny domyślnie wgrywa odp. wersję narodową (patrz str. 607 i dalsze).
Aby otworzyć obraz, wybierz z menu polecenie File→Open (Rysunek 10.3.1).
Spowoduje to pojawienie się okna dialogowego wyboru pliku (Rysunek 10.3.2). Okno to nie przypomina standardowego okna Windows. Dzieje się tak dlatego, że GIMP używa do obsługi okienek zestawu komponentów o nazwie GTK+1. Tak właśnie wygląda w GTK+ komponent do wyboru plików.
Rysunek 10.3.2 GIMP — okno wyboru plików
GIMP rozpoznaje wiele różnych formatów zapisu obrazu. Po naciśnięciu Open załaduje wskazany w oknie dialogowym plik.
Istnieje także prostsza metoda na załadowanie obrazu. Gdy GIMP nie zawiera żadnego obrazu, możesz „przeciągnąć” myszką jakiś plik z obrazem do okna GIMP, i tam go „upuścić”.
Pliki *.tif, *.jpg lub *.png nie przechowują informacji o warstwach. Dlatego gdy GIMP importuje ich zawartość używając polecenia File→Open, tworzy pojedynczą warstwę nazwaną tak samo jak importowany plik.
W obecnej wersji GIMP polecenie File→Save As pozwala zapisać obraz tylko we własnym formacie programu (*.xcf). Używaj go wtedy, gdy chcesz zapisać obraz w tej postaci, i/albo jako plik o zmienionej nazwie. Jeżeli chcesz zachować obraz w innym formacie (np. *.jpg, *.png, *.tif,…) należy użyć polecenia File→Export As (Rysunek 10.4.1):
Rysunek 10.4.1 Różne metody zapisywania pliku
Każde z nich spowoduje to pojawienie się okna (Rysunek 10.4.2), podobnego do tego, w którym wybieraliśmy plik do załadowania (por. Rysunek 10.3.2, str. 616):
Rysunek 10.4.2 Okno zapisywania do pliku
W oknie Export Image (Rysunek 10.4.2) wybieramy folder, do którego zapiszemy rysunek. Wpisujemy także nazwę pliku. Bardzo ważne jest także wpisanie właściwego rozszerzenia pliku — np. .png, .tif, albo .jpg. (GIMP określa sposób zapisu obrazu na podstawie rozszerzenia pliku, które podasz). Na koniec naciśnij na w oknie Export Image przycisk Export.
W zależności od formatu zapisu, który wybrałeś, GIMP może jeszcze pokazać pomocnicze okno, z dodatkowymi opcjami. Rysunek 10.4.3 pokazuje takie okno dla formatu TIFF. Można tu ustalić sposób kompresji obrazu. Wybieraj zawsze opcję LZW. (Nie sprawdzałem innych, ale LZW jest bardzo popularną metodą, i poprawnie wczytuje się do Blendera).
Po naciśnięciu kolejnego przycisku Export, nasz rysunek zostanie ostatecznie zapisany na dysku.
Gdyby GIMP wyświetlił komunikat o braku możliwości zapisania informacji o przejrzystości w pliku TIFF, wywołaj polecenie Image→Flatten Image i spróbuj jeszcze raz.
Inne okno dialogowe wyświetla się dla zapisu w postaci pliku *.jpg (Rysunek 10.4.4). Format JPEG pozwala uzyskać pliki o najmniejszym rozmiarze, ale za pewną cenę: pogorszenia jakości obrazu. W modelowaniu stosuj go tylko wtedy, gdy pliki których używasz — tekstury, rysunki referencyjne — nie mogą być zbyt duże. Podczas zapisu do JPEG powinieneś znaleźć kompromis pomiędzy rozmiarem pliku a jakością obrazu. Służą do tego kontrolki w oknie Export Image as JPEG. Gdy je stosujesz, włączaj opcję Show preview in image window. Spróbuj zmniejszyć wartość Quality poniżej 90. W oknie dialogowym będziesz widział jak zmniejsza to rozmiar pliku, a w oknie głównym GIMP — jaki ma to wpływ na obraz. W ten sposób szybko dobierzesz odpowiednią wartość.
W przypadku zapisu do pliku PNG (Rysunek 10.4.5) pozostawiaj poziom Compression level na najwyższej wartości (9). W odróżnieniu od JPEG, PNG (podobnie jak TIFF) jest tzw. „formatem bezstratnym”: przechowuje oryginalne wartości każdego piksela obrazu. W takim przypadku najwyższy poziom kompresji nie wpływa na jakość, a pozwala uzyskać najmniejsze pliki.
Wybierz z menu polecenie Tools→Selection Tools→Rectangle Select, (lub naciśnij na klawiaturze R). Przesuwając myszkę z wciśniętym LPM, zaznacz obszar dookoła rzutu z boku (Rysunek 10.5.1).
Rysunek 10.5.1 Zaznaczenie rzutu z boku
Następnie poleceniem Image→Crop to Selection ogranicz cały obraz do zaznaczonego obszaru (Rysunek 10.5.2):
Rysunek 10.5.2 Odcięcie reszty obrazu
Linie pomocnicze (guides) służą do oznaczenia jakiegoś istotnego miejsca, a także porównań.
Aby dodać do rysunku linię pomocniczą, “złap” myszką (LPM) za linijkę, umieszczoną ponad obrazem. Trzymając przez cały czas wciśnięty LPM przesuń ją do dołu. Zobaczysz wówczas, że przesuwasz poziomą linię pomocniczą (Rysunek 10.6.1):
Rysunek 10.6.1 “Pobranie” linii pomocniczej
Gdzie zwolnisz LPM (“upuścisz” linię pomocniczą), tam zostanie. Nie jest częścią obrazu. Możesz ją powtórnie złapać myszką i przesunąć w inne miejsce. (Jeżeli nie reaguje na myszkę — naciśnij na klawiaturze M, aby przejść w tryb przesuwania).
W podobny sposób pobierz także kolejne linie pomocnicze, tym razem pionowe, z linijki po lewej stronie obrazu. Umieść je na kluczowych liniach konstrukcyjnych, o których wiesz, że powinny być pionowe lub poziome (Rysunek 10.6.2):
Rysunek 10.6.2 Przykładowe rozmieszczenie linii pomocniczych
Aby usunąć linię pomocniczą, przesuń ją z powrotem tam, skąd ją „wyciągnąłeś”: do linijki ponad obrazem (linie poziome) lub z lewej strony (linie pionowe)
W GIMP powiększenie można zmienić na dwa sposoby (Rysunek 10.7.1):
szybko i mniej dokładnie: trzymając wciśnięty Ctrl i obracając kółkiem myszki (KM);
dokładnie, ale nie tak szybko: wybierając z listy u dołu ekranu jedno z predefiniowanych powiększeń, lub wpisując bezpośrednio nową wartość w jej pole tekstowe;
Rysunek 10.7.1 Trzy metody zmiany powiększenia (Zoom)
Przesunięcie widoku to ruch myszki z wciśniętym SPM (Rysunek 10.7.2):
Rysunek 10.7.2 Przesuwanie widoku (Pan)
Oczywiście, można się także posługiwać paskami przewijania, ale w większości przypadków to najmniej wygodna metoda.
Alternatywną metodą przesunięcia obrazu jest wykorzystanie kontrolki w prawym dolnym rogu obszaru obrazu (Rysunek 10.7.2). Gdy naciśniesz ją myszką (LPM), otworzy się miniaturka obrazu z zaznaczonym widocznym obszarem (Rysunek 10.7.3):
Rysunek 10.7.3 Alternatywna metoda przesuwania widoku (Pan)
Wystarczy ruch myszki, by przesunąć obraz. Ta metoda jest szczególnie przydatna w przypadku pracy w dużym powiększeniu.
Aby zmienić rozmiar obrazu (np. powiększyć), użyj polecenia Image→Canvas size... W oknie dialogowym, które się pojawi (Rysunek 10.8.1), rozłącz powiązanie pomiędzy wysokością i szerokością (przycisk z “ogniwami”). Potem np. zwiększ wysokość (Height).
Rysunek 10.8.1 Okno zmiany rozmiaru obrazu
Następnie przesuń (LPM) miniaturę aktualnego obrazu, aby przestrzeń, którą dodajemy, znalazła się w odpowiednim miejscu. Gdy skończysz, naciśnij przycisk Resize.
Na koniec nie zaszkodzi wywołać polecenie Layer→Layer to Image Size.
Warstwy w GIMP możesz sobie wyobrazić, jako oddzielne powierzchnie przejrzystej folii. Każda z nich może zawierać oddzielny obraz. Obrazy te nakładają się na siebie (Rysunek 10.9.1). Do zarządzania warstwami służy zakładka Layers, dostępna w przyborniku.
Rysunek 10.9.1 Warstwy — na obrazie i w zakładce Layers
Zakładka Layers zawiera listę warstw, oraz kilka pomocniczych kontrolek. Rysunek 10.9.2 wyjaśnia, jak się nią posługiwać:
Rysunek 10.9.2 Funkcje zakładki Layers
Warstwy mogą zasłaniać się wzajemnie. Jak w świecie rzeczywistym, obowiązuje zasada, że warstwa leżąca wyżej zasłania warstwę leżącą niżej. Stąd, w przykładzie na ilustracji (Rysunek 10.9.1), warstwa P40B-JJ-Left.tif zasłoniła obraz na warstwie P40B-JJ-Right.tif. Tę nieprzejrzystość można jednak zmniejszyć. Służy do tego suwak Opacity, umieszczony powyżej listy warstw (Rysunek 10.9.2).
Kolejność warstw także można zmienić — wystarczy “złapać” pojedynczy wiersz LPM i przesunąć w nowe położenie na liście (Rysunek 10.9.2).
Na liście Layers zawsze jedna warstwa jest podświetlona na niebiesko. To warstwa aktywna.
Prawie wszystkie polecenia, które wywołujesz w GIMP (rysowanie, usuwanie, transformacje, filtry, itp.) dotyczą wyłącznie zawartości warstwy aktywnej! Pozostałe warstwy nie ulegają zmianie.
Warstwa może być powiązana (z warstwą aktywną). Takie powiązanie powoduje, że można przesuwać (poleceniem Move — M, por. str. 644) zawartość kilku warstw naraz. Do włączenia/wyłączenia blokady służy ikona “łańcucha”, po lewej stronie nazwy warstwy (Rysunek 10.9.2). To powiązanie nie działa jednak podczas innych transformacji — np. obrotu, ani malowania. Osobiście nigdy go nie używałem1.
Warstwę można ukryć. Służy do tego ikona “oka”, umieszczona z lewej strony nazwy każdej warstwy. Piksele warstwy można także zablokować przed zmianami. Służą do tego opcje Lock (w nagłówku listy warstw — por. Rysunek 10.9.2).
Aby zmienić nazwę warstwy — kliknij w nią dwukrotnie. W wierszu pojawi się chwilowe pole edycji, w którym będziesz mógł ją poprawić.
Na koniec może wyjaśnię, pochodzenie nazw warstw w przykładzie pokazywanym przez Rysunek 10.9.2:
P40B-JJ-Right.tif — gdy wczytujesz plik obrazu w typowym formacie rastrowym: JPEG, PNG, TIFF, GIMP umieszcza jego zawartość na pojedynczej warstwie. Nadaje jej taką nazwę, jak nazwa wczytanego pliku.
P40B-JJ-Left.tif — warstwa powstała poprzez wczytanie dodatkowego obrazu (File→Open As Layer, por. str. 627). GIMP nadaje w takim przypadku nazwę wczytanego pliku.
Inną ciekawą funkcją jest możliwość grupowania warstw, którą wprowadzono w wersji 2.8 GIMP. Aby dodać nową grupę wywołaj polecenie Layer→New Layer Group., lub kliknij ikonkę foldera u dołu okna warstw (Rysunek 10.9.3a):
Rysunek 10.9.3 Grupowanie warstw
Spowoduje to wstawienie nowej grupy ponad warstwą aktywną. Taka pusta grupa jest reprezentowana przez ikonę folderu. Podobnie jak warstwy, możesz ją przesuwaćw górę i w dół, a także zmieniać nazwę. W przykładzie pokazywanym przez Rysunek 10.9.3b) przesunąłem ją do dołu i zmieniłem nazwę na Reflectivity. Następnie przesunąłem (metodą „przeciągnij i upuść”) do jej wnętrza odpowiednie warstwy (Rysunek 10.9.3c).
Grupy warstw można np. wykorzystać do uporządkowania pliku skin.xcf, w którym przechowuję trzy zestawy warstw: jeden dla tekstury odbić, drugi dla tekstury barwy, i trzecią — z plikami referencyjnymi (schemat barw, rozwinięcia UV). Trzymam te warstwy razem, gdyż tekstury barwy i odbicia światła zależą od siebie nawzajem (np. namalowane zabrudzenia muszą być bardziej matowe). Plik powstał we wcześniejszych wersjach GIMP, w którym grupowania jeszcze nie było. Do tej pory musiałem pamiętać, jakie warstwy ukryć, aby wygenerować teksturę barwy, a jakie — aby uzyskać teksturę odbić. Pomagałem w tym sobie nadając nazwom poszczególnych warstw przedrostki — Ref-* dla składników tekstury odbić, i Color-* dla składników tekstury barwy. Teraz mogłem stworzyć dla wszystkich składników tekstury odbić grupę Reflectivity, do której poprzenosiłem odpowiednie tekstury Ref-* (Rysunek 10.9.4a):
Rysunek 10.9.4 Przykład połączenia warstw w grupy
Zawartość pliku GIMP podzieliłem na trzy grupy (Rysunek 10.9.4b):
| Reference | Grupa zawiera warstwy z rysunkami referencyjnymi. Takie obraz powinny być zawsze widoczne, stąd jest umieszczona u góry, i ma włączony tryb (Mode) na Multiply. Jednocześnie, aby żaden z rysunków referencyjnych nie był za bardzo kontrastowy, zmniejszyłem przejrzystość (Opacity) tej grupy. Grupa jest zawsze widoczna, bo włączam w jej środku widoczność tej warstwy, która jest mi w danym momencie potrzebna; |
| Reflectivity | Grupa zawiera warstwy z obrazem tekstury odbić. |
| Color | Grupa zawiera warstwy z obrazem tekstury barwy; |
Od tej chwili, gdy chcę wyeksportować z pliku teksturę odbić, wystarczy że wyłączę widoczność grupy Color i Reference. Podobnie w przypadku eksportu tekstury barwy. Nazwy grup pozwolą mi szybko zorientować się w strukturze, choćbym do tego pliku zajrzał po wielu latach.
Zwróć uwagę, że nazwy grup składowych nadal mają przedrostki — Ref-* i Color-*. Przyczyna jest prosta:
Grupy warstw to nie foldery plików: nadal każda warstwa GIMP musi mieć unikalną nazwę w obrębie całego pliku, niezależnie od tego do jakiej grupy należy.
Wczytamy zawartość drugiego pliku jako dodatkowy obraz, do nowej warstwy. Zazwyczaj chodzi o to, aby nałożyć na siebie dwa rysunki, i je porównać. Dlatego pokażę od razu, jak ustawić częściowa przejrzystość warstwy z wczytanym obrazem.
Aby efekt przejrzystości był możliwy, aktualny rysunek nie może zapisywać barw jako tzw. indeksowanych kolorów. Jeżeli w menu Image→Mode zobaczysz, że twój rysunek ma włączony tryb Indexed, musisz to zmienić. Najlepiej będzie, jeżeli wywołasz polecenie Image→Mode→Grayscale, To zmieni odwzorowanie barw na 256 odcieni szarości. Możesz także przełączyć się w tryb barwny — Image→Mode→RGB,.
Załaduj drugi plik jako nową warstwę: File→Open as Layers. W oknie dialogowym wyboru pliku znajdź i wskaż obraz — powiedzmy, że nazywa się P40B-JJ-Left.tif.
W efekcie zobaczysz w oknie obrazu obydwa rysunki. Wczytany obraz przykrył dotychczasowy (Rysunek 10.10.1):
Rysunek 10.10.1 Dodana do rysunku warstwa z nowym obrazem
Otwórz w przyborniku zakładkę sterującą warstwami (Layers — Rysunek 10.10.1). Widać tu listę z dwoma wierszami. Każdy z nich to jedna z warstw. Dotychczasowa zawartość rysunku znajduje się na warstwie P40B-JJ-Right.tif. Druga warstwa nosi nazwę obecnie wczytanego pliku. Efekt „nałożenia” obydwu rysunków na siebie wziął się stąd, że warstwa P40B-JJ-Left.tif znajduje się powyżej warstwy P-40B-JJ-Right.tif, i po prostu ją zasłania.
Domyślna nazwa warstwy to nazwa oryginalnego pliku *.tif, *.jpg lub *.png, który otworzyliśmy w GIMP — nie tylko poleceniem File→Open as Layers, ale także zwykłym poleceniem File→Open. GIMP traktuje obraz z takiego pliku jak obraz importowany z obcego formatu, który zawiera jedną, domyślną warstwę. Aby ta warstwa nie była „bezimienna”, nadaje jej taką samą nazwę jak nazwa importowanego pliku
Teraz zmienimy przejrzystość warstwy P40B-JJ-Left.tif. Upewnij się, że jest podświetlona na liście Layers (oznacza to, że jest aktywna). Następnie zmień wartość, ustawioną na suwaku Opacity, np. z 100 na 40 (Rysunek 10.10.1).
Zobaczysz, że spod spodu zaczną “prześwitywać” linie warstwy P40B-JJ_Right.tif(Rysunek 10.10.2).
Rysunek 10.10.2 Efekt zwiększenia przejrzystości górnej warstwy obrazu
W wyniku polecenia Layer→New Layer pojawi się okno dialogowe New Layer (Rysunek 10.11.1).
W polu Layer name wpisz nową nazwę warstwy. Spośród grupy opcji Layer Fill Type wybierz sposób wypełnienia tła warstwy. Zazwyczaj wybieram tło w pełni przejrzyste (Transparency).
Po naciśnięciu OK nowa warstwa zostanie stworzona.
Warstwę możesz usunąć na dwa sposoby:
Poleceniem Layer→Delete Layer. Usuwa aktualną warstwę (zawsze się upewnij, która jest aktualna...)
W zakładce Layers: Podświetl wiersz, odpowiadający warstwie, którą chcesz usunąć. Następnie naciśnij przycisk z ikoną kosza (Rysunek 10.12.1).
Rysowanie pokażę na przykładzie “z życia wziętym”: na półprzeźroczystej warstwie narysujemy kształt kadłuba. Linie rysunku wzorcowego, do którego mamy się dopasować, są widoczne na warstwie leżącej pod spodem (Rysunek 10.13.5 pokazuje, co ma być narysowane).
Nim zaczniesz rysować, upewnij się, że tryb koloru twojego rysunku jest ustawiony na RGB. W razie czego — przestaw go w ten tryb (Image→Mode→RGB). Inaczej zamiast czerwonego będzie szary!
Zacznijmy od momentu, gdy warstwy są odpowiednio ustawione. Przed rozpoczęciem rysowania często zmienia się aktualny kolor. W tym przypadku wybierz czerwony (Rysunek 10.13.1):
Rysunek 10.13.1 Ustalenie aktualnego koloru
Z palety narzędzi wybierz “pędzelek” (Tools→Paint Tools→Paintbrush z menu, albo P na klawiaturze). Następnie ustal formę narzędzia (Rysunek 10.13.2), oraz jego rozmiar (Rysunek 10.13.3):
Rysunek 10.13.2 Wybór kształtu “pędzelka” | Rysunek 10.13.3 Ustalenie rozmiaru rysowania |
W trybie rysowania, gdzie tylko naciśniesz LPM, na rysunku pojawi się okrągła “plama”. Obrysowanie kadłuba najwygodniej jest wykonać za pomocą krótkich odcinków linii prostych. Aby zacząć taką sekwencję, kliknij LPM w narożnik obszaru, który chcesz zaznaczyć. Następnie przesuń myszkę trzymając wciśnięty Shift (Rysunek 10.13.4). Widzisz, że ciągniesz koniec prostej linii? Gdy trzymasz wciśnięty Shift, GIMP zawsze łączy aktualne położenie kursora z końcem ostatnio narysowanej linii. W ten sposób możesz szybko i dokładnie narysować kształt przyszłej selekcji.
Rysunek 10.13.4 Rysowanie prostymi odcinkami
“Ciągnięta” w ten sposób linia zakończy się tam, gdzie klikniesz LPM. Po obrysowaniu kształtu należy zamalować wnętrze obszaru (Rysunek 10.13.5):
Rysunek 10.13.5 Do wypełniania wnętrza wygodniej jest zmienić rozmiar narzędzia na większy
Jeżeli pomylisz się i narysujesz coś, czego nie powinieneś — użyj polecenia Edit→Undo (Ctrl-Z).
Jeżeli na rysunku masz już zaznaczony obszar selekcji — GIMP pozwoli Ci rysować tylko wewnątrz tego obszaru. Możesz go więc wykorzystywać do celowego nakładania ograniczeń (np. aby na pewno żadna linia nie wystawała poza założony obrys).
Do usunięcia czegoś z obrazu służy “gumka”: Tools→Paint Tools→Eraser . Znajdziesz ją także w oknie przybornika, pod odpowiednią ikoną (Rysunek 10.14.1). Możesz także skorzystać ze skrótu na klawiaturze: Shift-E. Po wybraniu narzędzia, wybierz jego kształt z zakładki Brushes. (Rysunek 10.14.1). W zakładce opcji narzędzia ustal rozmiar (Size — Rysunek 10.14.2):
Rysunek 10.14.1 Wybór narzędzia (“gumki”) i jej kształtu | Rysunek 10.14.2 Wybór rozmiaru gumki |
Teraz już możesz wymazać z rysunku to, czego nie ma na nim być (Rysunek 10.14.3):
Rysunek 10.14.3 Wymazywanie z rysunku niepotrzebnych elementów
Gumka ściera, gdy trzymasz wciśnięty LPM. (Ta zasada obowiązuje w Gimpie dla każdego narzędzia: pędzla, aerografu, itd.). Jeżeli pomylisz się i zetrzesz coś, czego nie powinieneś - użyj polecenia Edit→Undo (Ctrl-Z).
Jeżeli na rysunku masz już zaznaczony obszar selekcji — GIMP pozwoli Ci usuwać obraz tylko wewnątrz tego obszaru. Możesz go więc wykorzystywać do celowego nakładania ograniczeń (np. aby na pewno nie usunąć niczego więcej).
Zaznaczanie obszaru wyboru za pomocą prostokąta jest w GIMP najprostszą formą selekcji. Naciśnij na klawiaturze klawisz R, lub wybierz z menu polecenie Tools→Selection Tools→Rectangle Select:
Rysunek 10.15.1 Zaznaczenie obszaru selekcji
Rysunek 10.15.2 pokazuje wybrany obszar. Nadal można go jeszcze zmienić (powiększyć, pomniejszyć). Służą do tego uchwyty w narożnikach obszaru. (Są tak duże, że trudno ich nie zauważyć):
Rysunek 10.15.2 Prostokątny obszar wyboru
Aby wyłączyć obszar selekcji — wystarczy wywołać polecenie Select→None.
Narzędzie dla ludzi o pewnej ręce! Wybierz polecenie Tools→Selection Tools→Free Select (lub F z klawiatury). Zacznij rysować zamknięty obszar (Rysunek 10.16.1):
Rysunek 10.16.1 Rysowanie granic obszaru selekcji
Obszar po zamknięciu jest obrysowany linią przerywaną (Rysunek 10.16.2):
Rysunek 10.16.2 Przykład nieregularnego obszaru selekcji
Aby wyłączyć obszar selekcji — wystarczy wywołać polecenie Select→None.
Wywołaj polecenie z menu: Select→By Color (Shift-O), albo naciśnij przycisk z przybornika (Rysunek 10.17.1a):
Rysunek 10.17.1 Zaznaczenie poprzez wskazanie koloru
Następnie kliknij (LPM) w obszar o odpowiednim kolorze (Rysunek 10.17.1b). W efekcie na rysunku zostanie zaznaczony każdy piksel o wskazanej barwie. W przykładzie na ilustracji wskazałem kolor biały, więc czarne krawędzie siatek nie zostały zaznaczone (Rysunek 10.17.1c).
Aby poszerzyć obszar selekcji, wywołaj polecenie Select→Grow... (Rysunek 10.18.1):
Rysunek 10.18.1 Poszerzanie zaznaczonego obszaru (polecenie Select→Grow...)
W oknie dialogowym Grow Selection (Rysunek 10.18.1a) ustal rozmiar powiększenia (w pikselach) i naciśnij OK. W ten sposób możesz usuwać mniejsze przerwy w obszarze selekcji. Większe wcięcia — takie, jakie pokazuje Rysunek 10.18.1b) — tylko się zmniejszą. Takie miejsca pozostaje zaznaczać ręcznie (np. maską — por. str. 640).
W GIMP obszar selekcji może być dowolną plamą/plamami. Może także mieć rozmyte krawędzie. Takie efekty możesz uzyskać tylko w jeden sposób: malując obszar selekcji, tak jak maluje się jakiś kształt.
Narysowanie obszaru selekcji nie zadziała, jeżeli rysunek jest zapisany w trybie tzw. indeksowanych barw. Aby mieć pewność, że wszystko będzie poprawnie, przełącz go w tryb RGB (Image→Mode→RGB).
Pokażę, jak to zrobić na przykładzie opisanym w pierwszej części tej książki (str. 50). Chodzi o objęcie ściśle “przylegającą” selekcją rysunku tylnej części kadłuba samolotu. Linie rysunku znajdują się w tym przykładzie na warstwie o nazwie P40B-JJ-Top.tif.
Obszary selekcji będziemy malować na oddzielnej warstwie, którą stworzymy wyłącznie dla tego celu. Wywołaj polecenie Layer→New Layer. Dodaj do rysunku na nową warstwę, o nazwie Mask (szczegóły — str. 629). Warstwa musi być zupełnie przejrzysta. (Podczas tworzenia, w oknie dialogowym New Layer, określ kolor tła jako Transparency).
Rysunek 10.19.1 pokazuje, jak należy przygotować układ warstw (szczegóły - str. 624):
Ukryj wszystkie inne warstwy poza Mask i P40B-JJ-Top.tif;
Przesuń warstwę ze wzorcem kształtu do narysowania — P40B-JJ-Top.tif — ponad Mask;
Ustaw nieprzejrzystość P40B-JJ-Top.tif na 50%, by wygodniej dopasować rysowany kształt do linii kadłuba;
Podświetl Mask, aby stała się warstwą aktywną.
Po ustaleniu stanu warstw należy na warstwie Mask obrysować i wypełnić (szczegóły — str. 631) kształt kadłuba (Rysunek 10.19.2):
Rysunek 10.19.2 Rysowanie kształtu selekcji
Na koniec zmień narzędzie na “gumkę” (Tools→Paint Tools→Eraser, z klawiatury Shift-E). Kształt narzędzia pozostaw bez zmian, za to rozmiar przestaw na 1.0. Użyjemy go do drobnych wygładzeń i korekt narysowanego kształtu, np. wymazania naddatku linii (Rysunek 10.19.3).
Rysunek 10.19.3 Końcowe przygotowania - wymazanie “naddatków”
Pozostaje zmienić narysowany kształt w selekcję. Wywołaj polecenie: Layer→Transparency→Alpha to Selection.
I to wszystko. Na koniec porządkujemy warstwy (Rysunek 10.19.4):
ukryj Mask (można by ją było usunąć, ale może się przydać przy następnym takim przypadku);
odkryj inne warstwy (te, które są potrzebne do dalszej pracy);
podświetl warstwę, na której chcesz coś zmienić, za pomocą aktualnie wybranego obszaru (np. P40B-JJ-Top.tif). (Stanie się w ten sposób warstwą aktywną)
W GIMP kształt selekcji “przenika” przez wszystkie warstwy. Nie jest związany w szczególny sposób z żadną z nich. Dzięki temu warstwa, na której go rysowałeś, może być zaraz usunięta
W sekcji 10.19 (str. 638) przedstawiłem tworzenie zaznaczenia z kanału Alfa (nieprzejrzystości) aktualnej warstwy. Podobny efekt można także osiągnąć w inny sposób — wykorzystując tzw. „chwilową maskę” (Quick Mask). Jest to metoda bardzo przydatna do obsługi obszarów selekcji o bardzo złożonych kształtach.
Rysunek 10.20.1a) przedstawia przykład skomplikowanego obszaru selekcji. Przełączymy się w tryb Quick Mask, aby go zmienić. Możesz to zrobić na kilka sposobów: wywołując polecenie z menu (Select→Toggle Quick Mask), skrótem Shift-Q, lub klikając LPM w lewy dolny narożnik rysunku (Rysunek 10.20.1a):
Rysunek 10.20.1 Przełączenie w tryb rysowania zaznaczenia (Quick Mask)
Możesz traktować Quick Mask jak specjalną, chwilową warstwę, nałożoną na rysunek. Zaznaczony obszar jest na niej zupełnie przeźroczysty. Reszta jest pokryta półprzejrzystym kolorem czerwonym (Rysunek 10.20.1b).
Do przełączenia się z powrotem w tryb normalny służą te same polecenia (Select→Toggle Quick Mask, skrót Shift-Q).
Po powierzchni chwilowej maski możesz rysować, używając dowolnego narzędzia z przybornika. Rysunek 10.20.2a przedstawia przykład użycia pędzelka (Paintbrush). Rysując, zmniejszasz obszar zaznaczenia:
Rysunek 10.20.2 Zmiana obszaru zaznaczenia — poprzez malowanie
Aby zwiększyć obszar zaznaczenia, użyj w trybie Quick Mask „gumki” (Eraser). Wystarczy usunąć z maski kolor czerwony.
Podczas pracy z maską należy uważać na wybieranie narzędzi. Jeżeli wybrałeś w trybie normalnym wybrane narzędzie Paintbrush, i przełączyłeś się na Quick Mask, to dalej będziesz malować po powierzchni normalnej warstwy, a nie po masce.
Wszystkie narzędzia, których chcesz użyć do zmiany Quick Mask, wybierz po przełączeniu się w ten tryb. Nawet jeżeli jest to ten sam Paintbrush, aktualnie używany w trybie normalnym — wybierz go raz jeszcze.
Może to efekt jakiegoś błędu w programie i zniknie w kolejnych wersjach — ale przezorność nie zawadzi.
Czasami najbardziej pracochłonną częścią malowania w Gimpie jest przygotowanie odpowiedniego obszaru selekcji (na przykład w trybie Quick Mask). Czy można taki obszar zaznaczenia zachować do późniejszego użycia ? Na szczęście — tak. Służy do tego polecenie Select→Save to Channel (Rysunek 10.21.1):
Rysunek 10.21.1 Zapamiętanie obszaru zaznaczenia — do powtórnego użycia
Obszary zaznaczenia, zapamiętane w zakładce Channels, są przechowywane w pliku rysunku i mogą być użyte także po ponownym uruchomieniu programu. Użyj przycisku, umieszczonego u dołu zakładki Channels (Rysunek 10.21.1), aby przekształcić je z powrotem w aktualną selekcję.
Gdy w zakładce Channels klikniesz PPM na jednym z zapamiętanych zaznaczeń, otworzysz menu kontekstowe (Rysunek 10.21.2). Znajdziesz tam kilka przydatnych poleceń, służących do łączenia zapamiętanego obszaru zaznaczenia z aktualnym obszarem selekcji:
Channel to Selection oznacza zwykłe zastąpienie aktualnego obszaru przez obszar zaznaczenia;
Add to Selection pozwala dodać do aktualnie zaznaczonego na ekranie obszaru obszar zaznaczenia;
Substract from Selection zmniejsza aktualną selekcję o obszar zaznaczenia;
Intersect with Selection zmniejsza obszar aktualnej selekcji do części wspólnej z obszarem zaznaczenia
Jeżeli w GIMP jakiś obszar jest wybrany (selekcją) — obrót będzie dotyczył tylko tego obszaru. Jeżeli jednak nic nie jest wybrane, obracana jest cała zawartość warstwy aktywnej. Operację pokażę na przykładzie właśnie takiej sytuacji.
Jeżeli wykonujesz obrót po raz pierwszy, warto odpowiednio ustawić opcje tego narzędzia.
Zaznacz je w przyborniku (Rysunek 10.22.1), aby w panelu Tool Options GIMP wyświetlił aktualne ustawienia operacji Rotate (Rysunek 10.22.2). Proponuję wyłączyć wyświetlanie siatki linii pomocniczych dla tej operacji, bo jest na tyle gęsta, że wydaje się zasłaniać obracany obraz. Wyłącza się je wybierając z listy rozwijalnej Guides pozycję No guides (Rysunek 10.22.2):
Rysunek 10.22.2 Przygotowanie do obrotu (Rotate)
Przed każdym obrotem upewnij się, że Twój obraz jest dostatecznie duży (Rysunek 10.22.2). Chodzi o to, że GIMP obraca zawartość obrazu, ale jego granice („ramka”) pozostaje nieruchoma. Jeżeli obrócisz zbyt niski obraz, górna część po obrocie może zostać obcięta, tak jak to pokazuje Rysunek 10.22.3:
Rysunek 10.22.3 Obcięcie części obróconego obrazu
Jeżeli chcesz obrócić tylko zaznaczony obszar rysunku (aktualną selekcje) — zacznij od wywołania polecenia Select→Float. W przeciwnym razie będziesz obracać całą zawartość warstwy aktywnej.
Wywołaj polecenie Tools→Transform Tools→Rotate (Shift-R). Pojawi się dodatkowe okno Rotate (Rysunek 10.22.4). Zauważysz także pewne pogorszenie jakości wyświetlanego obrazu. Linie stały się mniej gładkie, gdyż GIMP przełączył się na wyświetlanie “roboczej kopii” rysunku. Pokazuje teraz, jak będzie wyglądał obraz, gdy zatwierdzisz ten obrót. (Czyli taki, jaki byłby, gdybyś w tym momencie nacisnął przycisk Rotate. Jeżeli naciśniesz Cancel — zrezygnujesz z całej operacji).
Rysunek 10.22.4 Obrót obrazu (Rotate)
Zwróć uwagę, że okno Rotate nie przeszkadza w zmianie powiększania widoku, ani w przesuwaniu poziomym i pionowym suwakiem. To bardzo wygodne, gdyż z większą dokładnością możesz obserwować zgodność linii pomocniczej i linii na kadłubie samolotu. Podczas obrotu pokazywana jest także oś obrotu — kółko z krzyżykiem, wyglądające jak celownik (Rysunek 10.22.4). Możesz w każdym momencie ją złapać (LPM) i przesunąć w nowe miejsce.
Obraz można obracać przesuwając myszkę z wciśniętym LPM (dobre na pierwsze przybliżenie). Można także zmienić numeryczną wartość kąta obrotu w oknie Rotate, polu Angle (tak najwygodniej wprowadzać ostatnie, drobne poprawki). Wartość kąta w polu Angle zmienia się także wtedy, gdy obracasz obraz myszką.
Obrót zatwierdzamy naciskając przycisk Rotate.
Jeżeli obracałeś tylko zaznaczony fragment obrazu (selekcję), po zakończeniu obrotu wywołaj jeszcze polecenie Layer→Anchor Layer (Ctrl-H).
(To scali “pływający” ponad rysunkiem, obrócony obszar z resztą obrazu, i zakończy całą operację).
Jeżeli chcesz przesunąć tylko zaznaczony obszar rysunku (aktualną selekcje) — zacznij od wywołania polecenia Select→Float. W przeciwnym razie będziesz przesuwać całą zawartość warstwy aktywnej.
Transformację zademonstruję na przykładzie, gdzie przesuwam obraz na jednej warstwie tak, by pokrył się ze wzorcem (umieszczonym na innej warstwie — Rysunek 10.23.1). Naciśnij na klawiaturze M (jest to skrót polecenia Tool→Transform Tools→Move). “Złap” zmieniamy obszar (LPM) i przenieś we właściwe miejsce:
Rysunek 10.23.1 Przesuwanie zawartości warstwy
Przesunięcie kończysz, zwalniając LPM (Rysunek 10.23.2):
Rysunek 10.23.2 Obraz po przesunięciu
Jeżeli przesuwałeś tylko zaznaczony fragment obrazu (selekcję), po zakończeniu przesuwania wywołaj jeszcze polecenie Layer→Anchor Layer (Ctrl-H).
(To scali “pływający” ponad rysunkiem, deformowany obszar, z resztą obrazu, i zakończy całą operację).
Jeżeli chcesz zdeformować tylko zaznaczony obszar rysunku (aktualną selekcje) — zacznij od wywołania polecenia Select→Float. W przeciwnym razie deformacji ulegnie cała zawartość warstwy aktywnej.
Jeżeli wykonujesz przekoszenie po raz pierwszy, warto odpowiednio ustawić opcje tego narzędzia. Zaznacz je w przyborniku (Rysunek 10.24.1), aby w panelu Tool Options GIMP wyświetlił aktualne ustawienia operacji Shear (Rysunek 10.24.2). Proponuję wyłączyć wyświetlanie siatki linii pomocniczych dla tej operacji, bo jest na tyle gęsta, że wydaje się zasłaniać deformowany obraz. Wyłącza się je wybierając z listy rozwijalnej Guides pozycję No guides (Rysunek 10.24.2).
Często takie operacje jak przekoszenie wywołujemy, aby dopasować obraz na jednej warstwie do wzorca na drugiej warstwie. Aby podczas transformacji nie stracić ani przez chwilę wzorcowego obrazu z oczu, włącz w panelu Tool Options opcję Show preview image, oraz zmniejsz jego nieprzejrzystość (Opacity) do 50% lub mniej (Rysunek 10.24.2). Aby nie zmieniać tych ustawień za każdym razem, możesz potem je zapisać jako domyślne (służy do tego ikona dyskietki u dołu tego panelu — por. Rysunek 10.24.2).
Przekoszenie pokażę na przykładzie transformacji prostokątnego fragmentu obrazu. Ponieważ deformujemy selekcję, wywołaj najpierw polecenie Image→Float. Potem użyj Tools→Transform Tools→Shear (lub Shift-S). Pojawi się dodatkowe okno Shear (Rysunek 10.24.3). Zauważysz także pewne pogorszenie jakości obrazu w zaznaczonym obszarze. Linie stały się mniej gładkie, gdyż GIMP przełączył się na wyświetlanie “roboczej kopii” tego fragmentu. Pokazuje teraz, jak będzie wyglądał obraz, gdy zatwierdzisz tę transformację. (Czyli gdy naciśniesz przycisk Shear. Jeżeli naciśniesz Cancel — zrezygnujesz z całej operacji).
Rysunek 10.24.3 Przekoszenie (poziome)
Polecenie Shear działa podobnie do obrotu. (Zresztą wszystkie transformacje w GIMP działają w taki sposób). Obecność okna Shear nie przeszkadza w zmianie powiększenia widoku, ani w przesuwaniu pionowym i poziomym suwakiem. Przekoszenie nie ma, niestety, widocznego środka, który można by było przesunąć. Punkt ten jest stały i znajduje się w środku obszaru selekcji.
Podświetlony na rysunku fragment można deformować przesuwając myszkę z wciśniętym LPM (dobre na pierwsze przybliżenie). Można także zmienić numeryczną wartość transformacji w oknie Shear, polu Shear magnitude X (Rysunek 10.24.3) (tak najwygodniej wprowadzać ostatnie, drobne poprawki). Wartość w polu Shear magnitude X zmienia się także wtedy, gdy dokonujesz deformacji myszką. Przekoszenie zatwierdzasz naciskając przycisk Shear.
W GIMP nie można wskazać środka tej transformacji. Po jej zakończeniu zmieniony fragment może leżeć niezupełnie tam, gdzie trzeba. Potem trzeba go wtedy przesunąć (M, por. str. 644) we właściwe miejsce.
Jeżeli deformujesz tylko fragment obrazu, wywołaj na koniec polecenie Layer→Anchor Layer (Ctrl-H). To scali “pływający” ponad rysunkiem deformowany obszar z resztą obrazu, i zakończy całą operację.
Jeżeli chcesz zdeformować tylko zaznaczony obszar rysunku (aktualną selekcje) — zacznij od wywołania polecenia Select→Float. W przeciwnym razie deformacji ulegnie cała zawartość warstwy aktywnej.
Jeżeli przeskalowujesz po raz pierwszy, warto odpowiednio ustawić opcje tego narzędzia.
Zaznacz je w przyborniku (Rysunek 10.25.1), aby w panelu Tool Options GIMP wyświetlił aktualne ustawienia operacji Scale (Rysunek 10.25.2). Proponuję wyłączyć wyświetlanie siatki linii pomocniczych dla tej operacji, bo jest na tyle gęsta, że wydaje się zasłaniać deformowany obraz. Wyłącza się je wybierając z listy rozwijalnej Guides pozycję No guides (Rysunek 10.25.2).
Często takie operacje jak skalowanie wywołujemy, aby dopasować obraz na jednej warstwie do wzorca na drugiej warstwie. Aby podczas transformacji nie stracić ani przez chwilę wzorcowego obrazu z oczu, włącz w panelu Tool Options opcję Show preview image, oraz zmniejsz jego nieprzejrzystość (Opacity) do 50% lub mniej (Rysunek 10.25.2). Aby nie zmieniać tych ustawień za każdym razem, możesz potem je zapisać jako domyślne (służy do tego ikona dyskietki u dołu tego panelu — por. Rysunek 10.25.2).
Wywołaj polecenie Tools→Transform Tools→Scale (lub Shift-T). Pojawi się okno dialogowe Scale (Rysunek 10.25.3). Zauważysz także pewne pogorszenie jakości wyświetlanego obrazu. Linie stały się mniej gładkie, gdyż GIMP przełączył się na wyświetlanie „roboczej kopii” rysunku. Pokazuje teraz, jak będzie wyglądał obraz, gdy zatwierdzisz tę zmianę skali. (Czyli gdy naciśniesz przycisk Scale. Jeżeli naciśniesz Cancel — zrezygnujesz z całej operacji).
Rysunek 10.25.3 Zmiana rozmiaru obrazu w kierunku pionowym
Zwróć uwagę, że okno Scale nie przeszkadza w zmianie powiększania widoku, ani w przesuwaniu poziomym i pionowym suwakiem. To bardzo wygodne, gdyż z większą dokładnością możesz obserwować zgodność linii pomocniczej i linii na rysunku samolotu.
Jeżeli nie zamierzasz zmieniać skali tak samo w obydwu kierunkach: upewnij się, że wysokość i szerokość są „rozprzęgnięte”. (Ogniwa łańcucha w oknie dialogowym Scale powinny być przerwane). Następnie w polu Height lub Width wpisz nowy rozmiar obiektu.
Transformację zatwierdzamy naciskając przycisk Scale.
Czasami może zajść potrzeba identyfikacji wartości komponentów R, G, B (więcej na temat tych komponentów — str. 1246) jakiejś barwy, widocznej na ekranie. Na przykład — jeden z serwerów wzorów barw, http://colorserver.net, pokazuje tylko obrazy próbek koloru. Liczbowe wartości RGB nie są tam nigdzie podane (Rysunek 10.26.1):
Rysunek 10.26.1 Próbka koloru, wyświetlanego przez colorserver.net.
Aby skopiować zawartość jakiegoś innego okna, uruchom GIMP i z menu File wywołaj polecenie FIle→Create→Screen Shot (Rysunek 10.26.2):
Rysunek 10.26.2 GIMP — uruchomienie kopiowania z zawartości wybranego okna.
W oknie WinSnap naciśnij przycisk Grab. Potem wskaż za pomocą „krzyżyka” z Select Window okno do skopiowania. Po chwili kopia wskazanego fragmentu ekranu zostanie umieszczona w oknie Gimpa.
W GIMP wybierz narzędzie Color Picker (O, albo Tools→Color Picker). Kliknij nim (LPM) w obszar, którego barwę chcesz poznać (Rysunek 10.26.3):
Rysunek 10.26.3 GIMP — pobieranie barwy z obrazu
Color Picker zmienia kolor pierwszoplanowy (Foreground Color) na kolor piksela, wskazanego na obrazie. Teraz wystarczy otworzyć okno edycji tej barwy, by odczytać jego właściwości (Rysunek 10.26.4):
Rysunek 10.26.4 GIMP — odczytanie wartości R,G,B pobranego z próbek koloru
W oknie Change Foreground Color można odczytać wartości komponentów barwy z pól R, G, B. Są podane jako liczby całkowite z zakresu 0..255. W polu HTML notation te same liczby, ale w postaci heksadecymalnej (szesnastkowej), są „sklejone” w jeden symbol.
Czasami możesz stwierdzić, że potrzebujesz pędzla o innym kształcie, niż te, które są dostępne w przyborniku Brushes (Rysunek 10.27.1).
Nic prostszego — w istocie tworzenie nowego wzoru pędzla w Gimpie nie różni się specjalnie od stworzenia nowego rysunku.
W tej sekcji utworzymy nowy pędzel o kształcie podłużnej plamy. Taki pędzel bardzo się przydaje do malowania przetarć farby na poszyciu samolotu.
Zacznij od stworzenia nowego rysunku (File→New). Nadaj mu jakiś niewielki rozmiar, a w ustawieniach zaawansowanych zmień typ przestrzeni barw (Color space) z RGBColor na Grayscale (Rysunek 10.27.2):
Rysunek 10.27.2 Tworzenie nowego obrazu — wzoru pędzla
Powinieneś zacząć od obrazu zupełnie wypełnionego bielą.
Jeżeli obraz jest trybie Grayscale, GIMP traktuje kolor biały w pędzlu jako przeźroczysty, a czarny — jako zupełnie nieprzeźroczysty.
Gdy już znasz zasadę, nic prostszego jak namalować odpowiedni kształt. Powiększ obraz do jakiegoś znaczącego rozmiaru (300-400%). W tym przypadku za pomocą innych pędzli (Bristles, Grass, Oils, Acrylic) stworzyłem nowy obraz plamy, biegnącej wzdłuż przekątnej obrazu (Rysunek 10.27.3). Na przemian to domalowywałem jej fragment, a potem usuwałem granice gumką o podobnie nieregularnym kształcie.
Gdy już narysujesz pędzel, sprawdź, do którego folderu należy go zapisać. GIMP podczas uruchamiania przeszukuje kilka folderów w poszukiwaniu plików z definicjami pędzli. Otwórz okno preferencji (Edit→Preferences) , aby sprawdzić (w Folders:Brushes) , jakie to są katalogi (Rysunek 10.27.4):
Rysunek 10.27.4 Foldery, w których są wyszukiwane pędzle
Gdy wiesz już, do jakiego folderu trzeba zapisać plik, nie pozostaje nic innego, jak to zrobić. Wywołaj polecenie File→Export As (Rysunek 10.27.5):
Rysunek 10.27.5 Zapisywanie obrazu jako definicji pędzla GIMP (plik *.gbr)
Wskaż odpowiedni folder i nadaj plikowi nazwę — koniecznie z rozszerzeniem *.gbr („gimp brush”). Gdy naciśniesz przycisk Save, pojawi się dodatkowe okno Save a Brush (Rysunek 10.27.5). W polu Description wpisz nazwę pędzla — taką, pod jaką ma figurować w zakładce Brushes.
Potem wystarczy odświeżyć zakładkę Brushes poleceniem Refresh Brushes (z jej menu kontekstowego — por. Rysunek 10.27.6):
Rysunek 10.27.6 Odświeżenie zawartości palety pędzli
W trakcie prac nad teksturami samolotu trzeba namalować dużo zabrudzeń, zadrapań, i innych tego rodzaju efektów. Do uzyskania takich plam GIMP oferuje cały zestaw „pędzli” o nieregularnych kształtach. Jednak sam kształt narzędzia to nie wszystko: oko ludzkie szybko rozróżnia wystąpienia podobnych kształtów. Dlatego wielką pomocą podczas rysowania takich zabrudzeń jak to które pokazuje Rysunek 10.28.1a) jest możliwość obracania i zmiany rozmiaru pędzla (Rysunek 10.28.1b):
Rysunek 10.28.1 Przykładowe pasmo „zabrudzeń” i parametry pędzla, zmieniane podczas malowania tego efektu
Najczęściej trzeba zmieniać kąt pędzla — tak, aby dwa podobne kształty nie wystąpiły obok siebie. Nieco rzadziej zmieniamy rozmiar, a w ostatniej kolejności — kształt narzędzia.
Dużą pomocą w rysowaniu takich tekstur byłaby możliwość obrotu oraz powiększania i pomniejszania pędzla bez konieczności ciągłego klikania w kontrolki w panelu jego opcji. Domyślnie GIMP nie ma takich skrótów, ale na szczęście możemy je dopisać sami. Zaczynamy od otwarcia okna preferencji programu (Edit→Preferences). Przejdź tam do sekcji Input Devices:Input Controllers i kliknij w Active Controllers:Main Mouse Wheel (Rysunek 10.28.2):
Rysunek 10.28.2 Przejście do akcji przypisanych do kółka myszki
Spowoduje to otwarcie okna Configure Input Controller w którym widzisz na liście wszystkie czynności (w slangu programistów to „zdarzenia” — ang. event) związane z kółkie myszki. Możesz do nich przypisać jakieś polecenie GIMP (Rysunek 10.28.3):
Rysunek 10.28.3 Przypisanie akcji do obrotu kółka mszyki
Obrót narzędzia (polecenia Increase Brush Angle / Decrease Brush Angle) proponuję przypisać do obrotu kółka myszki (zdarzenia Scroll Up / Scroll Down). Aby za dużo nie kręcić tym kółkiem, zdecydowałem się przypisać do tego zdarzenia bardziej „zgrubną” wersję poleceń GIMP (tą z końcówką *More).
Podobnie zgrubną zmianę rozmiaru narzędzia (polecenia Increase Brush Size More / Decrease Brush Size More) przypisałem do obrotu myszki przy wciśniętym klawiszu Shift (zdarzenia Scroll Up (Shift) / Scroll Down (Shift)). Po tych modyfikacjach lista zdarzeń kółka myszki powinna wyglądać tak, jak to pokazuje Rysunek 10.28.4.
Potem pozamykaj wszystkie otwarte okna preferencji, naciskając odpowiednie przyciski Close i OK. (GIMP automatycznie zapisuje zmiany dokonane w konfiguracji programu gdy zamkniesz jego okno). Od tego momentu nowe skróty są już dostępne podczas malowania.
Dzięki nowym skrótom malowanie stało się bardziej dynamiczne, bo nie musisz co chwila wracać do panelu Tool Options. Z palety z prawej strony możesz wybrać różne kształty pędzli. Rozmiar narzędzia zmieniasz trzymając obracając KM z klawiszem Shift wciśniętym na klawiaturze (Rysunek 10.28.5):
Rysunek 10.28.5 Szybkie zmniejszenie lub powiększenie pędzla
Gdy wciśniesz Shift, GIMP łączy linią pomocniczą obecne położenie kursora z ostatnio narysowanym miejscem (Rysunek 10.28.5 — gdybyś teraz nacisnął LPM, narysowałby linię prostą). Jednak nie ma co się tym przejmować: obrót KM w tej kombinacji poprawnie zmienia rozmiar narzędzia.
Obrót samego KM, bez żadnych dodatkowych klawiszy, powoduje obrót pędzla (Rysunek 10.28.6):
Rysunek 10.28.6 Szybki obrót pędzla
Jeżeli w GIMP jakiś obszar jest wybrany (selekcją) — transformacja będzie dotyczyć tylko tego obszaru. Jeżeli jednak nic nie jest wybrane, zmianie ulega cała zawartość aktualnej warstwy.
Rozmycie zademonstruję na przykładzie ostrego, biało-czarnego rysunku. Wywołaj polecenie Filters→Blur→Gaussian Blur... (Rysunek 10.29.1):
Rysunek 10.29.1 Menu efektów rozmycia (Blur)
W oknie dialogowym, które się pojawi, ustaw odpowiedni Blur Radius (Rysunek 10.29.2). Im większy promień ustawisz, tym intensywniejsze będzie rozmycie. Ma to także wpływ na czas przeliczania całego obrazu (większe promienie zabierają procesorowi więcej czasu).
Rysunek 10.29.2 Okno polecenia Gaussian Blur i jego efekt
Za pomocą Inkscape można wygenerować mapę „podstawowych zabrudzeń”, biegnących wzdłuż krawędzi paneli poszycia samolotu (por. str. 416). W tej sekcji pokażę, jak szybko wzbogacić ten obraz o inne, mniej regularne efekty — losowe zabrudzenia i ślady spalin.
Aby wygodnie nanosić te elementy w GIMP, wczytaj na oddzielną warstwę (File→Open as Layers) obraz uzyskany z Inkscape (w tym przykładzie nazywa się Shadows.png) (Rysunek 10.30.1):
Rysunek 10.30.1 Układ warstw w GIMP
Ponad warstwą Shadows.png umieść nową, przejrzystą (Transparent) warstwę o nazwie Smoke. To na niej będziemy rysować. Wybierz z palety odpowiednie narzędzie: — aerator (A).
Dobierz odpowiedni pędzel (z zakładki Brushes) — ten o nazwie Harndess 0.25 (Rysunek 10.30.2a).
Potem przejdź do zakładki narzędzia i ustaw jego parametry mniej więcej tak, jak to pokazuje Rysunek 10.30.2b):
Jeżeli chcesz nakładać efekt stopniowo i powoli, możesz dodatkowo zmniejszyć wartość Opacity ze 100 do, powiedzmy, 50 (Rysunek 10.30.2b).
Aby w trakcie rysowania płynnie zmieniać rozmiar pędzla, przypisz mu skrót Shift-KM (por. str. 655).
Ślady brudu i spalin możesz mieć już naniesione w Blenderze (w trybie Texture Paint — por. str. 1134)1. W Gimpie możesz je poddać drobnym poprawkom. Jeżeli jednak narzędzia malarskie Blendera wydają Ci się zbyt toporne, możesz namalować dym od podstaw w Gimpie (Rysunek 10.30.3):
Rysunek 10.30.3 Korygowanie śladu spalin za rurami wydechowymi silnika
Aby uzyskać inny efekt: zacieków — zmień narzędzie na zwykły pędzel (Paintbrush — P). Wybierz „twardszą końcówkę” (Hardness 075) i zmniejsz je rozmiar do kropki (Size = 4.0). Użyj jej by nanieść ciemne punkty tam, skąd mają się zaczynać zacieki (Rysunek 10.30.4):
Rysunek 10.30.4 Zacieki: naniesienie punktów początkowych
Potem przełącz się na „rozmazywanie” (Smudge — S) : . Zwiększ rozmiar narzędzia (do Size = 10) i zacznij rozmazywać narysowane przed chwilą kropki zgodnie z kierunkiem opływu powietrza (Rysunek 10.30.5):
Rysunek 10.30.5 Zacieki: rozmazywanie (Smudge)
„Ogólne” plamy, o kształcie nie związanym z kierunkiem opływu, uzyskasz w ten sam sposób, tylko rozmazując je we równomiernie we wszystkie strony (Rysunek 10.30.6):
Rysunek 10.30.6 Zwykłe plamy: kropki rozmazywane (Smudge) w różne strony
Ciekawy efekt w plamieniu można uzyskać, przełączając narzędzie na gumkę (Eraser — Shift-E) i zmieniając kształt pędzla na jakąś złożoną, bezkształtną plamę — np. Galaxy (Rysunek 10.30.7):
Rysunek 10.30.7 Nanoszenie kontrastów na plamach poprzez usuwanie (Erase) ich części
Jeżeli używasz warstwy Smoke scalonej z obrazem spalin uzyskanym z Blendera (ref_dirt.png, por. str. 419), zamiast narzędzia Erase użyj tego samego pędzla, ale malującego w kolorze białym. (Obraz uzyskany z Blendera ma białe, nieprzejrzyste tło i Erase tworzy w nim „dziury”).
Czasami dobry efekt daje także wykonanie „drugiego przebiegu” narzędziem o zmodyfikowanych parametrach. W przypadku gumki można np. zmniejszyć jej intensywność (Opacity) , albo włączyć ostre granice efektu (Hard edge) (Rysunek 10.30.8).
Aby płynnie obracać podczas malowania tak nieregularnym kształtem jak Galaxy, zdefiniuj dodatkowy skrót. Przypisz obrót narzędzia obrotowi KM (por. str. 655).
Każda maszyna od chwili rozpoczęcia eksploatacji, zaczyna „obrastać” w ślady zużycia. W przypadku samolotu są to, między innymi, odpryski i przetarcia farby. Właściwie naniesione, znacznie poprawiają realizm modelu. Każdy typ samolotu ma charakterystyczny układ takich śladów. Nim zaczniesz te skazy malować, warto najpierw przejrzeć zdjęcia, aby określić ich położenie, rozmiar i rodzaj. W czasie malowania uważaj, by nie ulec pokusie i nie pokrywać rysami całej powierzchni maszyny. W normalnej sytuacji obsługa naziemna nie próżnowała, i na bieżąco zamalowywała spostrzeżone uszkodzenia. Obszarem, z którym nie była w stanie sobie na dłuższą metę poradzić, jest w dolnopłatach górne poszycie skrzydła, przy kabinie. Mimo odpowiednich „dywaników”, widocznych na wielu zdjęciach, to miejsce zawsze było porysowane butami pilotów i mechaników. Każde zamalowanie w tym obszarze szybko znikało. W tej sekcji pokażę, jak można uzyskać efekt zużycia powłok samolotu właśnie na przykładzie tego fragmentu.
Do pracy bardzo się nam przyda obraz linii nitów i krawędzi paneli poszycia (np. wyeksportowany z wektorowego pliku Inkscape). Wczytaj go na odpowiednią warstwę referencyjną: UV-Lines.png (Rysunek 10.31.1):
Rysunek 10.31.1 Wstawienie warstw: podstawowej i referencyjnej
Wstaw do rysunku także nową warstwę Color-Chips, na którą naniesiemy obraz rys na powierzchni. Następnie zmień aktualny kolor na biały, i za pomocą „ołówka” (N, Tools→Paint Tools→Pencil) oraz pędzelka o nazwie Bristles 02, zacznij rysować na warstwie Color-Chips obszar złuszczonej farby (Rysunek 10.31.2):
Rysunek 10.31.2 Wybór narzędzia i rysowanie
Podczas rysowania za pomocą tak nieregularnego kształtu warto co chwila obracać pędzel. Można także nieznacznie zmieniać jego rozmiar. Aby te operacjie nie przerywały malowania, przypisz obrot narzędzia do obrotu KM, a zmianę rozmiaru — do kombinacji Shift-KM (por. str. 655).
Możeż też przygotować do takich operacji swoje własne pędzle. Ja np. stworzyłem pędzel o nazwie Jitter specjalnie do rysowania tego rodzaju efektów. Plik z jego definicją znajdziesz w folderze source\gimp\brushes (por. str. 22) pod nazwą jitter.gbr. Aby stał się widoczny w zakładce Brushes, wgraj go do jednego z folderów ustalonych w konfiguracji Gimpa (zob. str. 653, Rysunek 10.27.4)1.
Nadal używając pędzla Bristles, przełącz się na usuwanie barwy za pomocą „gumki” (Eraser). Włącz w zakładce właściwości tego narzędzia opcję Hard edge (Rysunek 10.31.3a), i pousuwaj część obszarów odprysków, redukując je do właściwego kształtu. Postaraj się, aby „plamy” białego koloru miały jak najbardziej realistyczny (a jednocześnie — chaotyczny) kształt. To dobra okazja, by uwolnić w sobie uśpionego impresjonistę ☺. Postaraj się uwzględnić mniej przetartą powierzchnię w drobnych zagłębieniach — na przykład wokół śrub (Rysunek 10.31.3b):
Rysunek 10.31.3 Ustawienie „gumki” i usuwanie naddatków
Rysunek 10.31.4 pokazuje narysowaną na warstwie Color-Chips białą plamę, która na modelu wygląda jak złuszczenie farby:
Rysunek 10.31.4 Przykład efektu łuszczącej się farby
Zwróć uwagę, że każda ze stron tego fragmentu na obrazie tekstury jest malowana osobno: część na rozwinięciu kadłuba (Rysunek 10.31.4a), a część — na rozwinięciu płata (Rysunek 10.31.4b). Mimo pozorów, niespecjalnie starałem się te dwie plamy „zsynchronizować”. Złożenie wyszło „samo” (Rysunek 10.31.4c) — wydaje mi się, że całkiem dobrze.
Odchodząca całym płatami farba świadczy o kiepskich składnikach, użytych do jej produkcji, i/lub problemach z obsługą naziemną2. Powłoki nanoszone bezpośrednio w zakładach Curtissa były dobrej jakości. Przejrzałem wiele zdjęć, ale nawet na szkolnych P-40, używanych intensywnie przez kilka ładnych lat, nie znalazłem śladu łuszczącej się farby. Co najwyżej — przetarte „do gołej blachy” pokrycie tam, gdzie wszyscy chodzili: na krawędzi kadłuba i skrzydeł.
Malowanie przetarcia zacznij od przygotowania odpowiedniej maski, poprzez którą będziemy nanosić barwę. Najłatwiej jest ją narysować w trybie Quick Mask (Shift—Q, szczegóły — str. 640) (Rysunek 10.31.5b):
Rysunek 10.31.5 Efekt przetarcia — przygotowanie maski (tryb Quick Mask)
Z maski usuń za pomocą „gumki” (Eraser) kolor z tych obszarów, które mają być poprzecierane. Stosuj tu w dużym stopniu obszary półprzeźroczyste — aby przetarcia płynnie zanikały w otoczeniu. Aby to osiągnąć, zmniejsz nieprzejrzystość (Opacity) „gumki” do 50%. Do usuwania stosuj pędzelek o rozmytych brzegach (Hardness 050— Rysunek 10.31.5a).
Teraz wyłącz Quick Mask i zacznij malować białe linie zarysowań powłoki. Użyj do tego zwykłego narzędzia Paintbrush i jednego z dołączonych do tej książki pędzli (source\gimp\brushes\lines.gbr) (Rysunek 10.31.6):
Rysunek 10.31.6 Efekt przetarcia — nanoszenie linii „zadrapań”
Aby znaleźć pokazywane przez Rysunek 10.31.6a) pędzle Lines-00, musisz przenieść pliki source\gimp\brushes\*.gbr do jednego z folderów, figurujących w konfiguracji GIMP (zob. str. 653). Alternatywnie — możesz dopisać w ustawieniach GIMP ten folder jako jeden z katalogów z definicjami pędzli.
Podczas malowania za pomocą końcówki Lines-00 unikaj nakładania równoległych linii blisko siebie. Umieść kolejne „przyłożenia” narzędzia w takiej odległości, by widać było pojedyncze kreski (Rysunek 10.31.6b).
Aby uczynić układ rys na powierzchni bardziej chaotycznym, zmień teraz kształt końcówki na pędzel Scratches (Rysunek 10.31.7a):
Rysunek 10.31.7 Efekt przetarcia — nanoszenie innych skaz powierzchni
Wzór tego pędzla — plik scratches.gbr — jest w tym samym folderze, co pozostałe wzory dołączone do tej książki (source\gimp\brushes). To relatywnie duża końcówka (Rysunek 10.31.7b). Nie przejmuj się jednak tak bardzo jej rozmiarem. Zaznaczony obszar rysowania skutecznie ograniczy jej zasięg. Tak samo jak linie, nanieś jej obrazy kolejnymi „kliknięciami” tak, by nie nakładały się na siebie.
Na koniec można trochę ograniczyć różne naddatki plam, które w nieunikniony sposób pojawiły się podczas malowania. To ten sam finalny krok, co w przypadku odprysków farby. Zmień z powrotem narzędzie na „gumkę” (Eraser). Tym razem wymazywanie ma działać z pełną ostrością, więc zwiększ Opacity narzędzia Eraser do 100%, i włącz opcję Hard edge (Rysunek 10.31.8a):
Rysunek 10.31.8 Efekt przetarcia — usuwanie naddatków
Wyłącz ograniczenie do zaznaczonego obszaru (Select→None). Wybierz pędzel Jitter. Używając „gumki” tego kształtu, postaraj się zmienić granice wytartych obszarów na mniej regularne (Rysunek 10.31.8b).
Wyeksportuj tak zmodyfikowany obraz barw do pliku color.png. Ten plik wykorzystujemy w Blenderze, w materiale poszycia samolotu (B.Skin.Camouflage — Rysunek 10.31.9, por. także str. 425 i następne):
Rysunek 10.31.9 Użycie obrazu color.png w Blenderze (fragment schematu materiału B.Skin.Camouflage)
Rysunek 10.31.10 pokazuje, jak nasze przetarcia prezentują się w różnych ujęciach modelu:
Rysunek 10.31.10 Przetarcia na modelu (pełna intensywność)
Mówiąc szczerze, efekt jest na tyle intensywny, że reszta powierzchni wydaje się wręcz wołać o podobne „przetarcie”! To oznaczałoby dużo pracy. Na szczęście, obsługa naziemna zazwyczaj stawała na wysokości zadania a samoloty podczas wojny rzadko kiedy mają się okazję aż tak zestarzeć.
Zmniejsz w GIMP nieprzejrzystość warstwy Color-Chips do ok. 50% (Rysunek 10.31.11a). Rysunek 10.31.11b) pokazuje, jak „zbladły” w wyniku tej zmiany rysy na górnej powierzchni płata. Gdy wyeksportujesz ten obraz do pliku dla Blendera, uzyskamy na modelu właściwe, „umiarkowane” przetarcia (Rysunek 10.31.11c):
Rysunek 10.31.11 Efekt przetarcia — zmniejszenie intensywności
Choć powierzchnie P-40 były traktowane „z należytym szacunkiem”, pokażę jeszcze, jak uzyskać drobne rysy wzdłuż krawędzi paneli silnika. Rysuje się je prościej niż „szerokie” przetarcia, takie jak u nasady skrzydła.
Zmień aktualny kolor na biały, narzędzie — na Paintbrush, i zmniejsz rozmiar pędzla do niewielkiej kropki. Użyj jej do pociągnięcia cienkiej białej linii wzdłuż krawędzi, które mają być porysowane (Rysunek 10.31.12):
Rysunek 10.31.12 Zużyte krawędzie — naniesienie linii bazowej
Następnie zmień pędzel na Jitter, i dodaj po „pacnięciu” w okolicach każdej śruby (Rysunek 10.31.13a). Potem ogranicz te „pacnięcia” i poprzerywaj białą linię za pomocą „gumki” (pędzel bez zmian: Jitter), z włączoną opcją Hard Edge (Rysunek 10.31.13b):
Rysunek 10.31.13 Zużyte krawędzie — malowanie i wycieranie
Na koniec jeszcze namaluj najdrobniejszym pędzlem, gdzieś na środku każdego panelu, parę chaotycznych kropek — aby nie było tam „za czysto” (Rysunek 10.31.14a):
Rysunek 10.31.14 Zużyte krawędzie — ostatnie dodatki i efekt finalny
Rysunek 10.31.14b) przedstawia ostateczny efekt na modelu (po zmniejszeniu nieprzejrzystości warstwy Color-Chips do 50%). Uzyskaliśmy dyskretne rysy, podkreślające nieco krawędzie okapotowania silnika (na modelu wyszły nam zbyt dokładnie dopasowane, więc staram się je w ten sposób dodatkowo wyróżnić).
Rysy na poszyciu warto malować jako bardzo wyraźne — tak, jak na jakimś „starym gracie”. Potem zawsze możesz je stonować, adekwatnie do stopnia zużycia odwzorowywanego egzemplarza samolotu. Wystarczy zmniejszyć nieprzejrzystość (Opacity) warstwy Color-Chips.
Wnętrze kabiny P-40 było pomalowane wyłącznie farbą podkładową (Curtiss Green). Zakładam, że łatwiej się przecierała niż powłoka powierzchni zewnętrznych. Dlatego na teksturze barwy materiału wnętrza kabiny (B.Skin.Cockpit — por. str. 534) namalowałem duże, białe przetarcia. Detale kabiny oglądamy z bliska, więc podczas wypełniania szczegółami tego obszaru szybko zacząłem dostrzegać że takie białe plamy w zbliżeniach nie wyglądają dobrze. Weźmy za przykład taki fotel pilota (Rysunek 10.31.15):
Rysunek 10.31.15 Duże przetarcia w zbliżeniach
Rysunek 10.31.15a) przedstawia widok ogólny. Siedzenie fotelu powinno być przetarte „do gołego metalu”, stąd umieściłem w tym miejscu biały obszar (Rysunek 10.31.15c). Niestety, to nie wygląda jak przetarcie, a jak zwykła, biała plama. Szczególnie to przeszkadza w zbliżeniach (Rysunek 10.31.15b).
Trzeba było coś z tym zrobić. Przetarcia są najjaśniejszym elementem tekstury barwy, stąd spróbowałem użyć jej jak maski sterującej połączeniem z prostym shaderem metalu (odpowiednio ustawiony Gloss Paint). Wykorzystałem tu funkcję Greater Than, aby uzyskać ostre granice materiałów (Rysunek 10.31.16):
Rysunek 10.31.16 Zmodyfikowany materiał fotela (B.Skin.Cockpit)
Rezultat takiej modyfikacji wygląda bardzo ciekawie. Biała plama na siedzeniu zmieniła się w metaliczną powierzchnię (Rysunek 10.31.17a). Gdy obejrzysz z bliska granice tego obszaru, zauważysz że dotychczasowe białe plamy teraz mają ostre krawędzie i wyglądają jak odpryski farby (Rysunek 10.31.17b). Widać to nawet w zbliżeniach (Rysunek 10.31.17c).
Rysunek 10.31.17 Fotel po modyfikacji materiału
Ten rezultat był na tyle zachęcający, że spróbowałem wprowadzić taką samą zmianę do materiału poszycia samolotu (B.Skin.Camouflage — Rysunek 10.31.18):
Rysunek 10.31.18 Dodanie do materiału poszycia (B.Skin.Camouflage) efektu „przetarć metalu”
Po tej modyfikacji wyraźniejsze stały się śruby na okapotowaniu silnika (Rysunek 10.31.19a). W zbliżeniach ciekawe efekty daje większa połyskliwość obszarów przetarć (Rysunek 10.31.19b):
Rysunek 10.31.19 Materiał B.Skin.Camouflage po modyfikacji
Jeżeli producent samolotu używał jakiejś kontrastowej farby podkładowej (w wielu samolotach z USA była to jasna, żółtozielona Zinc Chromate), możesz spróbować ją odwzorować, tworząc wokół przetarć „otoczkę” w barwie podkładu. To może podnieść realizm rys na powierzchni. W przypadku modelu P-40 kolorem farby podkładowej był Curtiss Green, ten sam który wykorzystywaliśmy w materiale powierzchni wewnętrznych (B.Skin.Inner). Stworzyliśmy nawet specjalną grupę — shader X.Curtiss Green, ułatwiający powtórzenie tej barwy w wielu schematach (por. str. 454). Teraz zastosujemy ją do ulepszenia efektu przetarcia. Wstaw do materiału B.Skin.Camouflage kolejny zespół z tym shaderem i węzłami Greater Than i Mix Shader (Rysunek 10.31.20). Węzeł Mix Shader efektu farby podkładowej podłącz przed węzłem Mix Shader efektu „przetarć do metalu”:
Rysunek 10.31.20 Dodanie do materiału poszycia efektu „farb podkładowej”
W efekcie wokół przetarć „do gołego metalu” pojawiły się zielonkawe obwódki. Widać je już z większych odległości (Rysunek 10.31.21a). Poprawiły także efekt przetarć w zbliżeniach (Rysunek 10.31.19b):
Rysunek 10.31.21 Materiał B.Skin.Camouflage po kolejnej modyfikacji
Opisane powyżej rozwiązanie wykorzystujące intensywność tekstury barw do łączenia shaderów opracowałem dość późno, podczas modelowania kabiny. Dlatego materiały, które je wykorzystują, znajdziesz dopiero w pliku model\p40\history\P40B-8.06.blend (por. str. 22).
Rysowanie przetarć, zadrapań i zabrudzeń to zajęcie, w pewnym sensie, artystyczne. Często dwa zupełnie różne (i wykonane różnymi technikami) obrazy tekstur znajdują jednakowo wysokie uznanie wśród widzów. Pod żadnym pozorem nie należy traktować metod, które przedstawiłem w tej sekcji, jako ostatecznych. Pokazałem tu kilka rzemieślniczych „sposobów”, jak osiągnąć efekt na — bądźmy szczerzy — średnim poziomie. (To znaczy na poziomie, który przynajmniej nie razi widza). Na pewno można to zrobić lepiej lub inaczej. Jestem pewien, że z czasem dopracujesz się swojego własnego stylu.
Na Inkscape natknąłem się przypadkiem. GIMP miał tylko marginalne możliwości rysowania linii wektorowych. A ja szukałem więc czegoś, w czym można by było wygodnie rysować (i poprawiać) linie nitów i łączenia blach. Gdy jednak wertowałem jego plik podpowiedzi, szukając szczegółów tej funkcji, natknąłem się na zdanie:
„Rysowanie linii w GIMP nie jest tak wygodne, jak w wyspecjalizowanych programach, np. Inkscape”.
Co to jest to „Inkscape”? Wystarczyło wpisać to hasło w Google, by znaleźć stronę tego projektu. Jest to najmłodszy z programów, używanych w tej książce. Nie osiągnął jeszcze “pełnoletniości” (aktualne wersje mają nadal numer poniżej 1.00). W związku z tym potrafi czasami się zawiesić, lub zakończyć się nagle z jakimś krytycznym błędem. Na szczęście nie dzieje się to zbyt często. W każdym razie nie zapominaj o częstym zapisywaniu swojej pracy do pliku!
Pobierz (z http://inkscape.org/en/download/ ) i uruchom program instalacyjny. Na początku pojawia się ekran “powitalny”, a następnie ekran z umową licencyjną (Rysunek 11.1.1):
Rysunek 11.1.1 Instalacja GIMP — pierwsze dwa ekrany
Po naciśnięciu przycisku Next > na ekranie License Agreement, przejdziemy do ekranu Choose Components (Rysunek 11.1.2):
Rysunek 11.1.2 Wybór opcji instalacji
Warto dopilnować, aby na ekranie Choose Components. wyłączyć z komponentów wszelkie tłumaczenia poza angielskim (obowiązkowe) i polskim. Na ekranie Choose Install Location można zmienić domyślny folder programu.
Po naciśnięciu przycisku Install wykonuje się instalacja (Rysunek 11.1.3):
Rysunek 11.1.3 Instalacja Inkscape - ekrany: postępu i finalny
Kiedy otworzysz po raz pierwszy Inkscape, program może być w języku polskim (choć nie zawsze — wydaje mi się że to zależy od wersji Windows, której używasz). Proponuję przełączyć się na język angielski (z tych samych przyczyn, dla których sugeruję używać języka angielskiego w GIMP — por. str. 608). Zacznij od otwarcia okna ustawień programu (Plik→Ustawienia Inkscape’a — Rysunek 11.1.4):
Rysunek 11.1.4 Inkscape: przejście do ustawień programu
W oknie ustawień wybierz sekcję Interfejs. W niektórych Windows język angielski może figurować jako język Domyślny systemu (Rysunek 11.1.5) w innych znajdziesz go jako angielski (w kilku odmianach: amerykańskiej, kanadyjskiej, brytyjskiej):
Rysunek 11.1.5 Inkscape — zmiana języka programu
Przełącz język na angielski (lub, jeżeli nie możesz znaleźć takiej pozycji na liście — na Domyślny systemu). W oknie Ustawienia Inkscape’a nie ma żadnego przycisku „OK”. Wystarczy że zamkniesz Inkscape i uruchomisz go powtórnie.
Po powtórnym uruchomieniu program wyświetla wszelkie opisy w języku angielskim (Rysunek 11.1.6):
Rysunek 11.1.6 Okno Inkscape (wygląd zaraz po instalacji)
Nie wiem dlaczego, ale domyślny układ ekranu Inkscape po instalacji wcale nie jest „domyślny”! Pasek z poleceniami systemowymi jest umieszczony po prawej (Rysunek 11.1.6), zamiast — w sposób typowy dla Windows — u góry okna, pod menu rozwijalnym. Tych pasków narzędzi nie można przesuwać myszką. Zmień ich układ wybierając opcję View→Default (Rysunek 11.1.7):
Rysunek 11.1.7 Przeniesienie przybornika z poleceniami systemowymi pod nagłówek okna
Wreszcie ostatni szczegół: wersja 64-bitowa z partha.com (por. str. 28) ma interfejs utrzymany w ciemniejszych barwach niż w standardowym oknie Inkscape (Rysunek 11.1.8):
Rysunek 11.1.8 Okno 64-bitowego Inkscape (z partha.com )
W wersji 0.48 nie można jeszcze zmieniać barw programu w oknie preferencji. Aby sobie z tym problemem poradzić, musimy użyć metody nieco hakerskiej. Zacznij od pobrania z http://inkscape.org/en/download/ plików oficjalnej wersji 32-bitowej, spakowanej w formacie 7z (Rysunek 11.1.9):
Rysunek 11.1.9 Pobranie oficjalnej (32-bitowej) wersji Inkscape w postaci spakowanego folderu
Format *.7z to alternatywa popularnego formatu *.zip. Jeżeli do tej pory nigdy jeszcze takich plików nie rozpakowywałeś, pobierz ze strony http://7-zip.org/ i zainstaluj program Open Source o tej samej nazwie.
Gdy zajrzysz do wnętrza pliku pobranego ze strony Inkscape, przekonasz się że zawiera pojedynczy folder o nazwie inkscape (Rysunek 11.1.10):
Rysunek 11.1.10 Zawartość pliku *.7z, pobranego z portalu Inkscape (okno programu 7-zip)
Gdybyś chciał używać wersji 32-bitowej, mógłbyś po prostu rozpakować ten folder gdziekolwiek na swój dysk twardy i uruchomić umieszczony w środku plik inkscape.exe.
My jednak chcemy używać zainstalowanej wersji 64-bitowej, dlatego wykorzystamy tylko niektóre podkatalogi folderu inkscape z pliku 7z.
Na ilustracji poniżej pliki 64-bitowego Inkscape znajdują się w folderze C:\Program Files\Inkscape-0.48\. Zacznij od zmiany nazwy podkatalogu etc\ na etc.org\ 1 (Rysunek 11.1.11):
Rysunek 11.1.11 Podmiana podkatalogu etc\ na nowy, pobrany z pliku *.7z.
Następnie skopiuj do folderu Inkscape katalog etc\ z pliku 7z (Rysunek 11.1.11). Najprościej to zrobić przeciągając ten folder z okna 7-zip do folderu Inkscape w oknie Eksploratora Windows.
Następnie przejdź w obydwu oknach do podkatalogów o nazwie share\ (w oknie Inkscape to Inkscape-0.48\share, w pliku 7z to inkscape\share — por. Rysunek 11.1.12):
Rysunek 11.1.12 Skopiowanie folderu themes z pliku 7z do katalogu share\
Skopiuj z pliku 7z do katalogu share folder o nazwie themes (Rysunek 11.1.12). Po tych zmianach, gdy powtórnie wywołasz 64-bitowy Inkscape, okno będzie maiło jaśniejszy odcień, i nie będzie problemu z widocznością jakichkolwiek ikon (Rysunek 11.1.13):
Rysunek 11.1.13 Poprawione barwy okna 64-bitowej wersji Inkscape
Rysunek 11.2.1 pokazuje, jak wygląda ekran Inkscape zaraz po pierwszym otwarciu:
Rysunek 11.2.1 Okno Inkscape
Okno programu jest tu jednocześnie oknem obrazu. Wokół krawędzi są rozmieszczone różnorodne przyborniki z ikonami (Rysunek 11.2.1). Pionowo, po lewej — przybornik z narzędziami edycji. U góry — m.in. pola umożliwiające zmianę położenia i rozmiarów wybranego obiektu.
W zależności od kompilacji Inkscape wykorzystuje różne odmiany okna wyboru plików (otwieranych poleceniem polecenia File→Open. Oficjalne, 32-bitowe wersje programu, wykorzystują standardowe okno wyboru plików Windows. Wersja 64-bitowa, pochodząca spoza oficjalnego portalu (por. str. 28) ma takie same okna wyboru plików, jak w Gimpie (Rysunek 11.3.1 — por. str. 616):
Rysunek 11.3.1 Inkscape (64-bitowe) — okno wyboru plików
Inkscape umożliwia podgląd zawartości pliku, podświetlonego na liście — ale tylko do pewnego rozmiaru. Po naciśnięciu przycisku Open, w Inkscape pojawi się załadowany plik.
Podobnie w przypadku zapisu pliku (polecenie File→Save As): 32-bitowa wersja Inkscape używa standardowego okna Windows, a 64-bitowa — okna z tej samej biblioteki (komponentu) co GIMP (Rysunek 11.3.2):
Rysunek 11.3.2 Inkscape (64-bitowe) — okno zapisu plików
Wywołaj polecenia File→Document Properties. (Rysunek 11.4.1):
Rysunek 11.4.1 Ustalenie rozmiaru dokumentu
W oknie dialogowym Document Properties, w pola Width, Height sekcji Custom size, wpisz wymiary dokumentu. Sugerowałbym, aby — dla wygody — założyć, że 1 jednostka Inkscape = 1 piksel weryfikowanego obrazu.
Okno Document Properties nie ma przycisku “OK.” — zmiany zostają wprowadzone, gdy tylko opuścisz to okno.
Wywołaj polecenie File→Import. W oknie dialogowym wyboru plików, które się pojawi, wskaż jakiś plik rastrowy (Rysunek 11.5.1a):
Rysunek 11.5.1 Wybór pliku rastrowego (wersja 32-bitowa)
Gdy naciśniesz przycisk Otwórz, Inkscape wyświetli jeszcze dodatkowe okno dialogowe (Rysunek 11.5.1b). Wybierz na nim opcję link. Wówczas wybrany obraz zostanie wstawiony do aktualnego rysunku (Rysunek 11.5.2):
Rysunek 11.5.2 Kolejny obraz rastrowy, dodany do dokumentu Inkscape
64-bitowa wersja Inkscape używa okien dialogowych wyboru plików w stylu GTK+ — takich jak te używane w GIMP (por. str. 616).
Inkscape potrafi wyświetlać zawartość plików rastrowych. Traktuje je jako niepodzielną całość, której wnętrze nie podlega żadnej edycji. Program może nawet nie przechowywać kopii takich obrazów w swoich rysunkach (*.svg). Zapamiętuje tylko ścieżki do plików, które ma wyświetlić1. Ma to dwie konsekwencje:
jeżeli usuniesz z dysku plik, którego referencja jest w rysunku Inkscape — program już go nie wyświetli;
jeżeli zmienisz za pomocą GIMP coś w pliku wstawionym do rysunku Inkscape, zmiany wprowadzone w ten sposób staną także widoczne w Inkscape.
Rysunek 11.6.1 Rysunek rastrowy wczytany do Inkscape
W razie potrzeby sam możesz zmieniać w Inkscape referencje do pliku. Zaznacz obraz, który chcesz zmienić. Naciśnij teraz PPM, aby otworzyć jego menu kontekstowe, i wybierz z niego polecenie Image Properties (Rysunek 11.6.2):
Rysunek 11.6.2 Okno właściwości obrazu rastrowego
W oknie Image Properties możesz wpisać nazwę zupełnie innego pliku, z innym obrazem. Inkscape go wyświetli, w aktualnie zaznaczonym miejscu.
Wywołaj File→Export Bitmap l. Inkscape otworzy odpowiednie okno dialogowe (Rysunek 11.7.1):
W sekcji Export area naciśnij przycisk (przełącznik) Page. W tym trybie eksportowany jest zadeklarowany obszar rysunku (por. str. 681). W sekcji Bitmap size ustal rozmiary obrazu rastrowego. Jeżeli eksportowany plik ma być użyty jako tekstura, postaraj się, by miał taką samą wysokość i szerokość. Jeszcze lepiej, gdy rozmiar obrazu w pikselach jest jakąś potęgą liczby 2. Zazwyczaj stosuje się rozmiary 512, 1024, 2048. Jak widać na ilustracji, ja wybrałem 2048 (aby było widać jak najwięcej szczegółów) .
W polu Filename ustalamy nazwę pliku. Inkscape zapisuje (na razie?) bitmapy tylko w jednym formacie: *.png. Nie jest to jednak duży problem, możemy ją później przekształcić na inny format za pomocą Gimpa. Zresztą Blender akceptuje obrazy także w formacie *.png.
Po naciśnięciu przycisku Export zostanie utworzony obraz, gotowy do użycia w Blenderze.
Eksportowana jest tylko zawartość tych warstw Inkscape, które są aktualnie widoczne!
Obsługa zmiany powiększenia (zoom) i przesuwania obrazu (pan) jest w Inkscape prawie taka sama jak w GIMP.
Zmiany powiększenia można dokonać na dwa sposoby:
szybko i mniej dokładnie: trzymając wciśnięty Ctrl i obracając kółkiem myszki (KM);
dokładnie: wpisując %powiększenia w pole Zoom, u dołu ekranu (Rysunek 11.8.1);
Rysunek 11.8.1 Widok: dwie metody zmiany powiększenia (Zoom)
Przesunięcie widoku to ruch myszki z wciśniętym SPM (identycznie jak w GIMP — str. 621). Możesz także użyć w tym celu pasków przewijania (scrollbars), umieszczonych z boku ekranu.
Dodatkowo, zgodnie ze standardem Windows, obrót KM powoduje przewijanie obrazu w górę i w dół. Już poza tym standardem, kombinacja Shift - KM przesuwa widok w poziomie.
W Inkscape, podobnie jak w GIMP, istnieją warstwy, za pomocą których możesz grupować elementy rysunku. Gdy wywołasz polecenie Layer→Layers (Shift-Ctrl-L), na ekranie pojawi się dodatkowy panel (Rysunek 11.9.1) :
Rysunek 11.9.1 Panel zarządzania warstwami
Panel sterowania warstwami zapewnia pełną kontrolę ich stanu. Zwróć szczególną uwagę na kontrolkę Opacity — zmienia przejrzystość podświetlonej na liście warstwy. Będziesz jej często używał. Panel Layers (i wszystkie inne) możesz “schować” lub przywołać z powrotem naciskając F12 (View→Show/Hide Dialogs)
Oprócz paneli zarządzania, Inkscape ma dodatkową kontrolkę u dołu ekranu (Rysunek 11.9.2). Za pomocą tej listy rozwijalnej i dwóch przełączników można:
zmienić aktualną warstwę;
włączyć lub wyłączyć widoczność warstwy;
włączyć lub wyłączyć blokadę zmian dla obiektów umieszczonych na warstwie.
Rysunek 11.9.2 Elementy szybkiego zarządzania warstwami
Z kontrolki umieszczonej u dołu ekranu korzysta się najczęściej, gdyż nie zajmuje tyle cennej przestrzeni ekranu, co panel Layers.
Warto zwrócić uwagę na pewne konwencję prezentowania nazwy warstw na liście rozwijalnej:
nazwa zablokowanej warstwy jest ujęta w nawiasy kwadratowe.
nazwa warstwy ukrytej jest szare, a nie czarna.
W ten sposób, zaraz po rozwinięciu listy, możesz się szybko zorientować co do stanu każdej z warstw.
Otwórz panel Layers (Layer→Layers). Na panelu naciśnij przycisk . Możesz także (alternatywnie) użyć polecenia z menu: Layer→Add Layer.... Pojawi się okno dialogowe nowej warstwy (Rysunek 11.10.1):
Rysunek 11.10.1 Dodawanie nowej warstwy
W oknie Add Layer wpisz w pole Layer name nazwę nowej warstwy. W polu Position możesz ustalić, w którym miejscu na liście ma być umieszczona (powyżej lub poniżej warstwy aktualnej).
Otwórz panel Layers (Layer→Layers). Na panelu podświetl warstwę do usunięcia i naciśnij przycisk (Rysunek 11.11.1). (Możesz także — alternatywnie — użyć polecenia z menu: Layer→Delete Current Layer..).
Rysunek 11.11.1 Usunięcie warstwy
Wybór (selekcja) obiektów odbywa się w Inkscape w sposób typowy dla aplikacji Windows. Zaznaczony obiekt/obiekty są obramowane prostokątną ramką z uchwytami (Rysunek 11.12.1). Naciśnięcie klawisz Esc powoduje rezygnację z wykonanego wyboru (w menu jest to polecenie Edit→Deselect) .
Wybór pojedynczego obiektu to kliknięcie w jego obszar LPM. Powoduje jednocześnie wyłączenie z selekcji ewentualnych obiektów wybranych wcześniej (Rysunek 11.12.1):
Rysunek 11.12.1 Zaznaczony, pojedynczy obiekt
Gdy chcesz zaznaczyć obiekt, który nie ma wypełnienia, musisz kliknąć LPM dokładnie w jedną z jego linii. Jeżeli np. wybierasz kwadrat, który nie ma wypełnionego środka, kliknięcie w jego wnętrze wcale go nie zaznaczy!
Aby wybrać wiele obiektów, jeden po drugim: trzymaj wciśnięty Shift i klikaj w nie po kolei LPM (Rysunek 11.12.2):
Rysunek 11.12.2 Zaznaczanie wielu obiektów — metoda bezpośrednia
Jeżeli powtórnie klikniesz Shift - LPM w zaznaczony obiekt - zostanie wykluczony z selekcji.
Aby wybrać wiele obiektów za pomocą prostokątnego obszaru: wciśnij LPM w miejscu, gdzie nie ma żadnego obiektu. To wyznacza jeden z narożników prostokąta; Następnie, trzymając wciśnięty LPM, przesuwaj kursor. Będziesz “ciągnął” w ten sposób przeciwległy narożnik obszaru selekcji. Miejsce, w którym zwolnisz LPM, wyznaczy rozmiar prostokąta. Wybrane zostaną wyłącznie obiekty, które mieszczą się w nim w całości (Rysunek 11.12.3):
Rysunek 11.12.3 Zaznaczanie obiektów obszarem prostokątnym
W Inkscape każdy obiekt jest umieszczony “ponad” albo “poniżej” innych. Przyjrzyjmy kwadratowi i elipsie, umieszczonym na tej samej warstwie (Rysunek 11.13.1). Elipsa zasłania kwadrat — jest obiektem pierwszoplanowym:
Rysunek 11.13.1 Oryginalna kolejność obrazów
Zaznacz elipsę. Następnie wywołaj polecenie Object→Lower to Bottom. Sytuacja ulegnie zmianie (Rysunek 11.13.2):
Rysunek 11.13.2 Kolejność obrazów po przesunięciu pierwszoplanowego “na dno”.
Spośród czterech poleceń, za pomocą których można w Inkscape zmieniać kolejność obiektów, w praktyce używałem tylko dwóch:
Object→Lower to Bottom (skrót klawiatury: End, ikona: ): umieszcza zaznaczony obiekt poniżej wszystkich innych;
Object→Raise to Top (skrót klawiatury: Home, ikona: ): umieszcza zaznaczony obiekt powyżej wszystkich dotychczas narysowanych;
Każdy nowy obiekt, który tworzysz, jest umieszczany ponad wszystkimi narysowanymi do tej pory.
W Inkscape istnieją także warstwy, pełniące podobną rolę jak w GIMP: podzielenia rysunku na fragmenty, łatwiejsze do zarządzania (patrz str. 686). W ogólnej hierarchii Inkscape najważniejsza jest kolejność warstw. To ona określa “zgrubnie”, co jest widoczne, co nie widoczne, a także co jest na wierzchu a co pod spodem. Omawiane w tej sekcji operacje — “przesuń na spód”, “przesuń na wierzch” — zmieniają kolejność obiektów tylko w obrębie pojedynczej warstwy.
W Inkscape możesz użyć linii pomocniczych (guides). Służą do zaznaczania jakiegoś istotnego miejsca, a także porównań. Tworzy się je tak samo jak w GIMP: poprzez “wyciągnięcie” z linijki z boku lub z góry ekranu (Rysunek 11.14.1):
Rysunek 11.14.1 “Pobranie” linii pomocniczej
Linia pomocnicza nie jest częścią obrazu — nie jest drukowana, ani nie pojawia się w obrazach wyeksportowanych do pliku rastrowego.
Istniejące linie pomocnicze można przesuwać. Gdy zbliżasz do nich wskaźnik myszki na odległość kilkunastu pikseli, linie zmieniają kolor na czerwony. W ten sposób Inkscape sygnalizuje, że wciśnięcie w tym obszarze LPM i przesunięcie myszki przeniesie linię pomocniczą w nowe miejsce. Zostanie umieszczona tam, gdzie zwolnisz LPM.
Aby usunąć linię pomocniczą — trzymając wciśnięty Ctrl, kliknij w nią LPM.
Jeżeli w oknie Document Properties (Shift-Ctrl-D) jest włączone “przyciąganie” do punktów charakterystycznych (Rysunek 11.14.2) — tworzone lub edytowane obiekty będą się dopasowywać do linii pomocniczych.
Przesunięcie za pomocą myszki zawsze jest obarczone jakimś błędem. Inkscape umożliwia — jako alternatywę — wpisanie dokładnych wartości numerycznych dla położenia i rozmiaru obiektu. Można to zrobić w trybie wyboru obiektów. Służą do tego pola X, Y, W, H, umieszczone w przyborniku ponad rysunkiem (Rysunek 11.15.1):
Rysunek 11.15.1 Obraz: ustalenie dokładnego położenia
Najczęstsze zastosowanie tej funkcji, to dokładne pozycjonowanie obrazów na rysunku. Aby ustalić ostateczną pozycję, wpisz w pola X i Y współrzędne lewego górnego narożnika obrazu (Rysunek 11.15.1).
Inkscape dolicza do rozmiaru obiektu także grubość jego obrysu (jeżeli kształt obiektu jest obrysowany — tzn. ma włączoną opcję Stroke — por. str. 695).
Rysowanie linii zaczynamy od przełączenia się w odpowiedni tryb pracy — rysowania linii (Rysunek 11.16.1):
Rysunek 11.16.1 Rysowanie linii w Inkscape
Linię zaczynasz od kliknięcia LPM w punkt, który będzie początkiem pierwszego odcinka. Od tej chwili za kursorem myszki zaczyna się “ciągnąć” czerwona kreska (mimo, że nie naciskasz żadnego klawisza). Gdy po raz drugi klikniesz LPM — wskażesz koniec odcinka. Linia może się składać z jednego lub więcej takich segmentów. Zwróć uwagę, że po wskazaniu drugiego punktu Inkscape “z własnej inicjatywy” rozpoczął “ciągnąć” kolejny odcinek linii. Musisz na koniec nacisnąć Enter, aby zasygnalizować programowi, że “na tym kończymy”.
Aby usunąć ostatnio narysowany odcinek linii — naciśnij Backspace.
Jeżeli rysowany odcinek ma być poziomy lub pionowy — podczas rysowania trzymaj wciśnięty Ctrl.
Inkscape stara się ułatwić rysowanie linii jako figury zamkniętej. Stąd, gdy podczas rysowania linii zbliżysz koniec ostatniego odcinka do początku pierwszego — punkt początkowy ulegnie podświetleniu (Rysunek 11.16.2). Gdy umieścisz w nim punkt końcowy odcinka, który rysujesz (kliknięcie LPM) — linia stanie się zamknięta.
Każdy obiekt w dokumencie Inkscape — poza obrazem rastrowym — jest figurą geometryczną, złożoną z dwóch elementów:
Dla obydwu można ustalić kolor, a w bardziej złożonych przypadkach — gradient czy deseń, jakim są rysowane. Linia konturu dodatkowo posiada takie właściwości jak grubość i wzór (ciągła, kreskowana, kropkowa,...)
Kontury otwarte także mogą posiadać wypełnienie — choć w takim przypadku wygląda nieco dziwnie.
Do zmiany wypełnienia i linii konturu obiektu służy panel Fill and Stroke (Rysunek 11.17.1):
Rysunek 11.17.1 Okno właściwości kształtu (Fill and Stroke)
W zakładce Stroke style ustalasz grubość i deseń linii obrysu. W zakładce Stroke paint ustalasz barwę (lub gradient, lub deseń) linii (Rysunek 11.17.2):
Rysunek 11.17.2 Zmiana barwy linii — zakładka Stroke paint
Zakładka sterująca wypełnieniem obiektu to Fill. Zawiera identyczne kontrolki jak Stroke paint.
Spośród możliwych trybów wypełnienia wyróżnia się pierwsza opcja od lewej — (Rysunek 11.17.3). Gdy ją wybierzesz w zakładce Fill, obiekt w ogóle nie będzie miał wypełnienia. (Analogicznie, wybór tej opcji w Stroke paint spowoduje, że obiekt w ogóle nie będzie miał obrysu).
Na zakończenie warto wspomnieć o jeszcze jednej właściwości obiektu w Inkscape. Możesz tu sterować nieprzejrzystością pojedynczego obiektu dokładnie tak samo, jak w GIMP steruje się nieprzejrzystością całych warstw. Służy do tego niewielka kontrolka O, umieszczona u dołu ekranu (Rysunek 11.17.4):
Rysunek 11.17.4 Zmiana nieprzejrzystości obiektu (O pacity)
Linie (a właściwie — “ścieżki”, bo Inkscape określa je jako paths), które narysowałeś, możesz później modyfikować. Służy do tego oddzielny tryb — edycji węzłów (Rysunek 11.18.1). (Węzłem linii jest każdy z jej wierzchołków):
Rysunek 11.18.1 Edycja wierzchołków wybranej linii
W tym trybie każdy punkt linii (węzeł) jest oznaczony małym rombem. Możesz za nie „łapać” (LPM) i przesuwać w nowe miejsca. Obowiązują tu dokładnie te same reguły, co przy edycji całych obiektów. Pojedyncze kliknięcie w węzeł oznacza go jako wybrany (Węzeł wybrany zmienia swój kolor na niebieski). Jeżeli podczas wskazywania węzłów będziesz trzymać wciśnięty klawisz Shift - możesz zaznaczyć wiele punktów naraz. Możesz je także zaznaczać obszarem prostokątnym.
Aby dodać do linii nowy wierzchołek — kliknij dwukrotnie LPM w segment, w miejscu w którym ma być wstawiony.
Aby usunąć wybrany węzeł/węzły — naciśnij klawisz Del. To zazwyczaj powoduje zmianę kształtu linii.
Inkscape pozwala od razu rysować linie krzywe — wystarczy w trakcie rysowania kolejnego segmentu trzymać przez cały czas wciśnięty LPM. Muszę jednak przyznać, że dla dokładnego odwzorowania kształtu ta metoda jest trochę nieodpowiednia. (A może — nie przećwiczyłem jej dostatecznie.) W każdym razie pokażę tu sposób, którego używam “na co dzień”.
pierwszym przybliżeniu obrysu za pomocą linii łamanej (patrz str. 694, 702);
przekształceniu kolejnych segmentów łamanej w odcinki krzywej.
Aby zmienić kształt linii łamanej w krzywą, musisz się przełączyć w tryb edycji. Potem wystarczy “złapać” za segment linii LPM i wygiąć w odpowiedni kształt (Rysunek 11.19.1):
Rysunek 11.19.1 Linia krzywa uzyskana poprzez “wyciągnięcie”
Alternatywną metodą jest zamiana poszczególnych węzłów (wierzchołków) z “ostrych” na “gładkie”, poprzez naciśnięcie ikony . Rysunek 11.19.2 przedstawia, na czym to polega:
Rysunek 11.19.2 Linia krzywa uzyskana poprzez zmianę typu węzła na “gładki, symetryczny”
W węźle pojawiły się dwie styczne do krzywej. Możesz sterować kształtem linii zmieniając ich pochylenie i długość. Przedstawiony na rysunku węzeł jest “symetryczny”, co oznacza że zmiana jednej stycznej powoduje identyczną zmianę drugiej. (Dzięki temu wygięcie będzie bardziej “płynne”, gdyż krzywe z obydwu stron węzła mają w tym miejscu taki sam promień krzywizny).
Jeżeli nie zależy Ci na aż tak “dokładnych” zaokrągleniach — możesz węzeł przełączyć w tryb (Rysunek 11.19.3). Wtedy styczne z każdej strony węzła będą utrzymywały współliniowość. Mogą się jednak różnić długością.
Rysunek 11.19.3 Węzeł gładki, niesymetryczny
Krzywe, uzyskane w ten sposób, “na oko” wyglądają na gładkie. Gdy jednak styczne w węźle różnią się długością, występuje w nich skokowa zmiana promienia krzywizny.
Gdy chcesz uzyskać w węźle „narożnik” — przełącz się w tryb . Wtedy możesz manipulować każdą ze stycznych oddzielnie (Rysunek 11.19.4):
Rysunek 11.19.4 Węzeł ostry
Ostateczny kształt krzywej uzyskujesz, przekształcając kolejne węzły na “gładkie” i — zazwyczaj — symetryczne (Rysunek 11.19.5). Zaczynasz ten proces od jednego krańca linii łamanej. Sukcesywnie przekształcasz w krzywą i nadajesz właściwy kształt kolejnym segmentom, dopóki nie dotrzesz do końca linii.
Rysunek 11.19.5 Krzywa z wieloma wierzchołkami
Łuk to specjalny przypadek krzywej. Operację pokażę na przykładzie formowania obrysu krawędzi natarcia statecznika pionowego. Jest to odcinek prostej i fragment łuku. Zacząłem jednak od narysowania dwóch prostych odcinków (Rysunek 11.20.1a):
Rysunek 11.20.1 Obrys — wygładzanie
Aby zmienić drugi segment w łuk:
przełącz się w tryb edycji węzłów;
kliknij w środek segmentu, który ma być zakrzywiony. (Jego obydwa wierzchołki powinny zabarwić się na niebiesko);
naciśnij przycisk w pasku narzędzi, zmieniający odcinek w segment krzywej (Rysunek 11.20.1a);
ustaw odpowiednio uchwyty stycznych na końcu linii, aby nadać krzywiźnie właściwy kształt (Rysunek 11.20.1b);
W Inkscape każda krzywa to tzw. krzywa Beziera. Pojedynczy segment takiej linii potrafi całkiem dokładnie odwzorować łuk o kącie do 60º. W tym przypadku kąt nie przekracza 45º, więc nie dodawałem żadnego dodatkowego węzła pośrodku.
Gdy za pomocą krzywej Beziera masz zamodelować łuk, trzymaj się następujących zasad:
kierunki stycznych na końcach krzywej powinny być takie same, jak styczne łuku;
długości obydwu odcinków stycznych powinny być równe.
W tej sekcji pokażę, jak za pomocą krzywych odwzorować zadany kontur - na przykładzie obrysu steru kierunku P-40. (Odwzorowanie przedniej części — konturu krawędzi natarcia statecznika pionowego — jest opisane na str. 701). Jeżeli do tej pory w Inkscape rysowałeś tylko linie łamane — zerknij na str. 698. Znajdziesz tam wprowadzenie do tworzenia linii krzywych.
Najpierw obrysuj kontur linią łamaną (Rysunek 11.21.1a). Wierzchołki linii wstawiaj w takich miejscach, by największe wybrzuszenie krzywej leżało w równej odległości od początku i końca odcinka (Rysunek 11.21.1b).
Rysunek 11.21.1 Wstępny obrys steru kierunku — odcinkami prostych
Po narysowaniu linii, włącz tryb edycji węzłów. Zamień łamaną na krzywą, wygładzając kolejne wierzchołki (p. str. 699).. Dla kolejnych węzłów (poza krańcowymi):
zaznacz węzeł jako “symetrycznie gładki” (Rysunek 11.21.2);
dostosuj krzywiznę za pomocą stycznych. Czasami trzeba także przesunąć węzeł.
Podczas wygładzania może się także zdarzyć, że zdecydujesz się jakiś węzeł dodać lub usunąć.
Przełącz się w tryb rysowania prostokątów (Rysunek 11.22.1):
Rysunek 11.22.1 Rysowanie kwadratu
Wciśnij LPM w miejscu, gdzie ma się znajdować jeden z narożników prostokąta. Następnie, trzymając wciśnięty LPM, przesuwaj kursor. Będziesz “ciągnął” w ten sposób przeciwległy narożnik prostokąta. Aby uzyskać kształt kwadratu, trzymaj jednocześnie wciśnięty Ctrl. Miejsce, w którym zwolnisz LPM, wyznaczy przeciwległy narożnik obiektu.
Zaznacz prostokąt i przełącz się w tryb “prostokąta” (Rysunek 11.23.1):
Rysunek 11.23.1 Punkty sterujące rozmiarem prostokąta
Możesz przeciągnąć LPM kwadratowe uchwyty, umieszczone w narożnikach prostokąta, w nowe miejsce. W ten sposób zmienić rozmiar tego obiektu. Alternatywnie — możesz ustalić rozmiar w sposób dokładny — wpisując wartości numeryczne w pola W, H, umieszczone w przyborniku ponad obszarem rysunku (Rysunek 11.23.1).
Dodatkowo, prostokąt ma w pobliżu prawego górnego narożnika widoczne jeden lub dwa okrągłe węzły. Gdy widzisz jeden, oznacza to, że są na siebie nałożone (por. Rysunek 11.23.1). Węzły okrągłe służą do ustalenia promienia zaokrąglenia narożników prostokąta (Rysunek 11.23.2):
Rysunek 11.23.2 Prostokąt - zaokrąglanie
Jeżeli przeciągniesz jeden okrągły węzeł do dołu, a drugi - w lewo (Rysunek 11.23.2) — narożniki prostokąta staną się zaokrąglone. Jeżeli zsuniesz je w to samo miejsce — narożniki staną się ostre. Możesz ustalić dokładne wartości promieni zaokrąglenia, wpisując je w pola Rx i Ry, umieszczone ponad obszarem rysunku. Zwróć uwagę, że zaokrąglenia mogą być eliptyczne (gdy Rx i Ry nie są równe).
W Inkscape okręgi rysuje się tak samo jak kwadraty (por. str. 703). Wybierasz tylko inny tryb rysowania: okręgów (oznaczony ikoną: ). Następnie naciskasz LPM w miejscu, gdzie mają sięgać lewe, górne granice elipsy. Przeciągasz kursor z wciśniętym LPM, i zwalniasz ten przycisk w miejscu, do którego mają sięgać prawe, dolne granice elipsy (Rysunek 11.24.1):
Rysunek 11.24.1 Rysowanie okręgu
Podobnie jak w przypadku kwadratów, ważne jest wciśnięcie klawisza Ctrl podczas “przeciągania” drugiego punktu, bo inaczej narysujesz elipsę.
Jeżeli podczas tworzenia okręgu będziesz trzymał wciśnięty klawisz Shift — początkowe położenie myszki stanie się środkiem okręgu, a nie narożnikiem jego „ramki”
Zaznacz okrąg/elipsę i przełącz się w tryb “okręgu” (Rysunek 11.25.1):
Rysunek 11.25.1 Węzły sterujące elipsy/łuku
Kwadratowe węzły sterujące, umieszczone z lewej strony i u góry, służą do zmiany długości promieni elipsy/ promienia okręgu.
Okrągłe uchwyty służą do zmiany elipsy w łuk (eliptyczny) (Rysunek 11.25.2):
Rysunek 11.25.2 Przekształcenie w łuk
Dokładną wartość kąta początkowego można wpisać w pole Start, a końcowego — w pole End, umieszczone w przyborniku ponad obszarem rysunku (Rysunek 11.25.2).
Ikona , umieszczona z lewej strony, służy do ponownego zamknięcia elipsy (zmiany kąta łuku na 360º).
Jeżeli nie chcesz widzieć linii skierowanych od krańców łuku do środka elipsy — przełącz się na alternatywny tryb rysowania (Rysunek 11.25.3).
“Złap” LPM obiekt (tylko nie ramkę zaznaczenia!) i przesuwaj. Punkt, gdzie zwolnisz LPM, określi nowe położenie obiektu. Na przykład, złap LPM za obraz rzutu z góry i przesuń, aby wyrównać z rzutem z lewej (Rysunek 11.26.1).
Rysunek 11.26.1 Przesunięcie — dopasowywanie rzutu z góry do rzutu z boku
Aby dobrze dopasować do siebie obydwa obrazy, często warto użyć linii pomocniczych (Rysunek 11.26.2):
Rysunek 11.26.2 Linie pomocnicze — ułatwiają dopasowanie dwóch obrazów
Zamiast przesuwać obiekt myszką, możesz także wpisać dokładne współrzędne jego nowego położenia. Możesz to zrobić w polach X, Y, w przyborniku ponad obszarem rysunku (Rysunek 11.26.1).
W Inkscape, wokół każdego zaznaczonego obiektu rysowana jest ramka. Nazwijmy ją ramką selekcji.
Początkowo ramka selekcji pojawia się zawsze w trybie “zmiany rozmiaru” (Rysunek 11.27.1). Jeżeli jednak jeszcze raz klikniesz w zaznaczony obiekt LPM, przełączysz się w tryb “obrotu/przekoszenia” (Rysunek 11.27.2):
Rysunek 11.27.1 Ramka zmiany rozmiaru | Rysunek 11.27.2 Ramka obrotu/przekoszenia |
Ramka obrotu zawiera bardzo ważny punkt — środek transformacji. Jest oznaczony niewielkim krzyżykiem (Rysunek 11.27.2). (Gdy nie możesz go od razu dostrzec, zmniejsz powiększenie — wtedy łatwiej go znaleźć).
Środek transformacji można “złapać” LPM i przesunąć w inne miejsce (Rysunek 11.27.3).
Środek jest zawsze wykorzystywany przez Inkscape podczas obrotu, oraz — gdy trzymasz wciśnięty klawisz Shift — podczas zmiany skali i przekoszenia.
Zaznacz obiekt, który ma być zmieniony. Następnie złap LPM za uchwyt ramki selekcji i przeciągnij. Nowe rozmiary obiektu będą ustalone dla miejsca, w którym zwolniłeś LPM (Rysunek 11.28.1):
Rysunek 11.28.1 Zmiana rozmiaru (skali) obiektu
Domyślnym środkiem skalowania jest przeciwległy narożnik ramki.
Aby zmieniać skalę względem środka obiektu (patrz str. 708) — podczas przesuwania myszki dodatkowo trzymaj wciśnięty klawisz Shift.
Aby zmienić skalę równomiernie we wszystkich kierunkach — podczas przesuwania myszki dodatkowo trzymaj wciśnięty klawisz Ctrl.
Jeżeli chcesz dokonać zmiany skali o dokładnie ustaloną wartość — otwórz panel Transform za pomocą polecenia Object→Transform (Shift-Ctrl-M) . Wybierz w niej zakładkę Scale (Rysunek 11.28.2). W pola Width, Height możesz wpisać dokładne wartości nowej skali.
Zaznacz obiekt, który ma być obrócony. Kliknij w niego jeszcze raz, aby przełączyć ramkę selekcji w tryb obrotu (szczegóły - str. 708). Następnie złap LPM za jeden z narożników ramki i zacznij przesuwać. Obrót obiektu będzie zatwierdzony dla miejsca, w którym zwolnisz LPM (Rysunek 11.29.1):
Rysunek 11.29.1 Obrót obiektu
Przed obrotem możesz przesunąć środek transformacji w inne miejsce. Wystarczy go “złapać” LPM i przesunąć (szczegóły - str. 708).
Aby obrót następował skokowo, dokładnie co 15º — podczas przesuwania myszki dodatkowo trzymaj wciśnięty klawisz Ctrl.
Jeżeli chcesz dokonać obrotu o dokładnie ustaloną wartość — otwórz panel Transform za pomocą polecenia Object→Transform (Shift-Ctrl-M). Wybierz w niej zakładkę Rotate (Rysunek 11.29.2). W polu Angle możesz wpisać dokładną wartość kąta obrotu.
Zaznacz obiekt, który ma być przekoszony. Kliknij w niego jeszcze raz, aby przełączyć ramkę selekcji w tryb przekoszenia (szczegóły - str. 708). Następnie złap LPM za jeden z uchwytów na boku ramki, i przesuń. Przekoszenie obiektu będzie ustalone dla miejsca, w którym zwolnisz LPM (Rysunek 11.30.1):
Rysunek 11.30.1 Obrót obiektu
Przed przekoszeniem możesz przesunąć środek transformacji w inne miejsce. Wystarczy go “złapać” LPM i przesunąć (szczegóły — str. 708).
Aby przekoszenie następowało skokowo, dokładnie co 15º — podczas przesuwania myszki dodatkowo trzymaj wciśnięty klawisz Ctrl.
Jeżeli chcesz dokonać przekoszenia o dokładnie ustaloną wartość — otwórz panel Transform za pomocą polecenia Object→Transform (Shift-Ctrl-M) . Wybierz w niej zakładkę Skew (Rysunek 11.30.2). W pola Horizontal, Vertical możesz wpisać dokładne wartości przekoszenia.
Gdy włączysz tryb tekstowy (oznaczony ikoną: ), Inkscape zamienia się w typowy edytor tekstu. W pasku narzędzi pojawią się typowe kontrolki formatowania: wybór czcionki, jej rozmiar, wyrównanie tekstu, pogrubienie, pochylenie, kierunek (Rysunek 11.31.1):
Rysunek 11.31.1 Włączenie trybu wpisywania tekstu
Kursor myszki zmienia w tym trybie postać — staje się małym krzyżykiem. Tam, gdzie klikniesz LPM, Inkscape wstawia kursor tekstowy (pionowa, mrugająca kreska). Tekst, który zaczniesz wpisywać, będzie się pojawiał w tym miejscu (Rysunek 11.31.2):
Rysunek 11.31.2 Wpisywanie/edycja tekstu
Podobnie, gdy klikniesz LPM w jakiś istniejący tekst, Inkscape wstawi w to miejsce kursor tekstowy, umożliwiając edycję tego fragmentu. Uważaj tylko na „podpowiedzi” programu: w trybie tekstowym kursor myszki może zmieniać swoją postać, w zależności od tego, co znajduje się pod nim na ekranie. Kursor w kształcie krzyża z małą literą „A” oznacza, że kliknięcie LPM w tym miejscu rozpocznie nowy tekst (Rysunek 11.31.3a):
Rysunek 11.31.3 Oznaczanie „gotowości do edycji tekstu”.
Gdy przesuwasz kursor myszki ponad jakimś tekstem, zmienia swój kształt w pionową kreskę (ang. „I-beam” — Rysunek 11.31.3b). Jeżeli w tym miejscu naciśniesz LPM, przejdziesz do edycji tekstu. Abyś nie miał wątpliwości, o który tekst chodzi, Inkscape otacza go niebieską obwódką (Rysunek 11.31.3b).
Tekst w Inkscape może być ułożony wzdłuż dowolnej linii — łamanej lub krzywej. Aby uzyskać ten efekt, zaznacz tekst, zaznacz krzywą, i wywołaj polecenie Text→Put on Path (Rysunek 11.32.1):
Rysunek 11.32.1 Ustawienie tekstu wzdłuż krzywej
Mimo powiązania, obydwa elementy można nadal modyfikować: edytować tekst w trybie tekstowym (por. str. 713), lub zmieniać kształt krzywej (Rysunek 11.32.2):
Rysunek 11.32.2 Tekst podążą za zmianą kształtu linii
Operacją odwrotną do Put on Path jest — jak łatwo się domyśleć — Text→Remove from Path.
W Inkscape istnieją dwie metody powielenia obiektu: w „duplikat” i w „klon” . Duplikat to niezależna kopia (taka, która „ma wszystko własne”: wierzchołki, ustawienia barwy wypełnienia i linii, itp.) Tworzymy go, zaznaczając pierwowzór i wywołując polecenia Edit→Duplicate (Ctrl-D) (Rysunek 11.33.1) .
Klon — to kolejna instancja pierwowzoru. Inkscape zamienia zaznaczony obiekt we wzorzec, którego referencje zostają umieszczone na rysunku. W przypadku jakiejkolwiek zmiany kształtu czy barwy wzorca, tej samej zmianie ulegają wszystkie jego referencje (klony). Zaznaczony obiekt „klonujemy” jednym z poleceń z menu Edit→Clone(Rysunek 11.33.1). Najbardziej popularne, tworzące pojedynczy klon — Edit→Clone→Create Clone — ma skrót na klawiaturze: Alt-D.
Rysunek 11.33.1 Powielanie obiektów — polecenia.
„Klon” możesz zmienić w „duplikat” poleceniem Edit→Clone→Unlink Clone (Shift-Alt-D). Pamiętaj tylko, że jest to w zasadzie operacja nieodwracalna — chyba, że wycofasz ją ogólnym poleceniem Edit→Undo.
W Inkscape możesz wybrać wiele różnych wzorów linii kropkowych i przerywanych (por. str. 695). Do odwzorowania linii nitów potrzebujemy takiej, która jest złożona z samych kropek (kółek). W tej sekcji pokażę, jak uzyskać taki efekt.
Narysuj linię, reprezentującą szew nitów. Początkowo będzie to linia ciągła, o grubości odpowiadającej średnicy nitu (Rysunek 11.34.1a):
Rysunek 11.34.1 Zmiana typu linii na kropkową
Następnie zmień jej wzór, wybierając z listy Fill and Stroke:Dahses linię kropkową o odpowiednim dystansie pomiędzy punktami (Rysunek 11.34.1b). W zwykłym powiększeniu rezultat wydaje się być poprawny (Rysunek 11.34.1c). Jeżeli jednak przyjrzysz się mu z bliska — zobaczysz, że każdy punkt („nit”) to mały kwadrat, a nie kółko!
Spróbujmy to skorygować. Zmieńmy typ zakończenia linii (Fill and Stroke:Cap) z płaskiego na zaokrąglony (Rysunek 11.34.2b — por. z Rysunek 11.34.1b):
Rysunek 11.34.2 Zmiana kształtu zakończeń linii na okrągłe
Niestety, zaokrąglenia zwiększają szerokość linii, i kwadraty zamieniają się nie w koła, a w bardziej podłużne kształty (Rysunek 11.34.2c)!
Możesz sprawdzić każdą z linii kropkowych, zdefiniowanych w Inkscape. Nie znajdziesz takiej, która pozwala uzyskać okrągłe kropki. Skoro żaden ze wzorców linii dostępnych w menu Dahses nam nie odpowiada, możemy zdefiniować własny. Aby to zrobić, wywołaj polecenie Edit→XML Editor… (Rysunek 11.34.3):
Rysunek 11.34.3 Wywołanie edytora XML
(Pliki Inkscape są zapisane w standardzie SVG, a SVG wykorzystuje jako format zapisu język XML, stąd nazwa tego okna). Po lewej stronie widać w nim listę elementów rysunku. Inkscape podświetla na niej zaznaczony obiekt. Po prawej stronie, u góry, widać listę atrybutów zaznaczonego elementu. Zaznacz na niej (kliknięciem LPM) atrybut o nazwie style. U dołu okna, po prawej stronie, zobaczysz wtedy jego wartość — tekst opisujący, jak obiekt ma być rysowany (Rysunek 11.34.3). W tym polu możesz także modyfikować ten tekst. Zmień wartość wyrażenia stroke-dasharray (to właśnie jest definicja wzoru linii) (Rysunek 11.34.4):
Rysunek 11.34.4 Wpisanie niestandardowego wzoru kreskowania
Zmniejsz pierwszą liczbę (szerokość kreski) do 0.05 (Rysunek 11.34.4b), a potem naciśnij przycisk Set. Uzyskamy w ten sposób linię okrągłych kropek (Rysunek 11.34.4c).
Ten niestandardowy wzór Inkscape będzie błędnie pokazywał w panelu Fill and Stroke jako linię ciągłą (Rysunek 11.34.4d). Wiąże się z tym także druga wada: gdy teraz zmienisz jakąkolwiek właściwość w tym panelu, linia naprawdę zmieni się w linię ciągłą, i będziesz musiał jej jeszcze raz ustawiać to specjalne kreskowanie. Dlatego linie nitów z użyciem linii kropkowej najprościej jest rysować kopiując jakąś istniejącą linię w nową (Rysunek 11.34.5):
Rysunek 11.34.5 Wstawienie do rysunku nowej linii kropkowanej (poprzez kopiowanie)
Zaznacz jakąś istniejącą linię kropkową, i naciśnij Ctrl-D (Edit→Duplicate) (Rysunek 11.34.5a). Następnie przesuń tę nową linię w położenie docelowe (Rysunek 11.34.5a). Jeżeli trzeba potem zmienić jej kształt — kliknij w nią dwa razy LPM, by przejść w tryb edycji wierzchołków (Rysunek 11.34.5c). Potem ustaw je tak, by biegły wzdłuż krawędzi łączonych paneli poszycia (Rysunek 11.34.5d).
Czasami na poszyciu samolotu występują jakieś otwory, które przerywają linie szwów. Możesz, rzecz jasna, odwzorować to rysując dwie oddzielne linie (tzn. dwa oddzielne obiekty). Możesz także narysować to jako jeden obiekt, wykorzystując fakt, że linie w Inkscape mogą mieć przerwy pomiędzy wierzchołkami (Rysunek 11.34.6):
Rysunek 11.34.6 Wstawienie przerwy w linii
Przejdź w tryb edycji wierzchołków linii i wstaw (dwukrotne kliknięcie LPM) dwa wierzchołki na przeciwległych krańcach otworu (Rysunek 11.34.6b). Potem zaznacz obydwa (Shift-LPM) (Rysunek 11.34.6c). Następnie wywołaj z przybornika (u góry ekranu) polecenie usunięcia fragmentu linii (Rysunek 11.34.6d).
Zwróć uwagę, że po wystąpieniu takiej przerwy Inkscape zaczyna od nowa wzór linii — tak, że pierwszy nit wypada zawsze na początku nowego segmentu (Rysunek 11.34.7):
Rysunek 11.34.7 Efekt małej przerwy pozwala dokładnie sterować położeniem nitów
Ten efekt może się przydać, jeżeli chcesz staranniej narysować przecięcia szwów nitów. Początkowo, gdy rysujesz nity za pomocą pojedynczych segmentów linii ciągłych, rezultat wydaje się być poprawny — przynajmniej z daleka (Rysunek 11.34.8a):
Rysunek 11.34.8 Szwy nitów, narysowane za pomocą pojedynczych odcinków linii
Jednak w powiększeniu widać, że na przecięciu poprzecznych linii podłużnic i żeber nity nie układają się tak, jak powinny (Rysunek 11.34.8b). Można to skorygować za pomocą drobnych przerw w liniach (Rysunek 11.34.9):
Rysunek 11.34.9 Nanoszenie poprawek na przecięciu dwóch szwów
Przerwy w liniach nitów należy nanosić zaczynając od początku odcinka i sukcesywnie przesuwając się do jego końca. W ten sposób na pewno wszelkie przerwy będą miały wpływ jedynie na jeszcze nie przejrzaną część szwu.
Choć o wiele łatwiej jest dokonywać wszelkich przesunięć, obrotów i zmian skali „łapiąc” myszką za uchwyty obiektu, czasami trzeba wykonać transformację o dokładnie określone, ułamkowe wartości liczbowe. Taka sytuacja ma na przykład miejsce, gdy rysujesz tarcze przyrządów pokładowych. Na wielu z nich skala jest podzielona np. na 32 „kreski”. Oznacza to, że kąt pomiędzy kreskami skali musi wynosić dokładnie 11.25º. Takiego obrotu nie uzyskamy za pomocą skoku Snap (klawisz Ctrl). Najprościej to zrobić, używając panelu Transform.
Rysunek 11.35.1 pokazuje przygotowanie do takiej operacji. Narysowałem pustą tarczę przyrządu, a w jej środku umieściłem przecięcie linii pomocniczych — by jego środek sam przyciągał przesuwane obiekty. Następnie narysowałem „wzorcową”, pojedynczą kreskę skali. Przesunąłem jej środek do środka tarczy (bo wokół tego punktu będzie obracana). Następnie wywołałem polecenie Object→Transform (Rysunek 11.35.2):
Rysunek 11.35.1 Przygotowanie obiektu do transformacji | Rysunek 11.35.2 Wywołanie polecenia |
W panelu Transform, który w ten sposób otworzyłem, wpisałem w zakładce Rotate, polu Angle, dokładny kąt pomiędzy kreskami skali (Rysunek 11.35.3):
Rysunek 11.35.3 Wykonanie dokładnego obrotu
Teraz wystarczy ostatnią kreskę zaznaczyć, skopiować, i nacisnąć przycisk Transform:Apply. I tak po kolei, dopóki nie wypełnisz całego zakresu skali klonami „wzorca”.
W Inkacape masz do dyspozycji dwa polecenia przenoszące zaznaczony obiekt na inną warstwę:
przeniesienie na wyższą warstwę (Shift-PgUp, albo Layer→Move Selection to Layer Above);
przeniesienie na niższą warstwę (Shift-PgDn, albo Layer→Move Selection to Layer Below);
Obydwa są dostępne w menu Layer (Rysunek 11.36.1):
Rysunek 11.36.1 Polecenia zmiany warstwy obiektu.
Z poleceń tych będziesz korzystać dość często, więc warto zapamiętać ich skróty na klawiaturze. O ile warstwa docelowa nie ma jakichś specjalnych ustawień przejrzystości czy rozmycia, jedynym widocznym na ekranie efektem jest zmiana nazwy w liście rozwijalnej u dołu ekranu. Rysunek 11.36.2 pokazuje przykład takiej operacji — przesunięcie prostokąta z warstwy Bkg-White na Bkg-Grey:
Rysunek 11.36.2 Efekt zmiany warstwy jest widoczny tylko na pasku stanu.
Inkscape pozwala przenosić obiekty tylko „po kolei”, poprzez poszczególne warstwy. Jeżeli podczas tej „podróży” zostanie napotkana warstwa o zmniejszonej nieprzejrzystości (Opacity), zmniejszy się także nieprzejrzystość obiektów, które się na niej znajdują. Nawet gdy już ją opuszczą, przemieszczone na kolejną warstwę, pozostaną częściowo przeźroczyste!
Zaznacz elementy, z których chcesz stworzyć grupę, i wywołaj polecenie Object→Group (Ctrl-G) (Rysunek 11.37.1):
Rysunek 11.37.1 Grupowanie obiektów
Inkscape traktuje grupę obiektów jak pojedynczy element. Klonowanie (por str. 715) grup obiektów jest efektywną techniką, pozwalającą zmniejszyć rozmiar rysunku, i ułatwiającą jego późniejsze zmiany. (Wystarczy tylko raz zdefiniować grupę „śruba”, a później wstawić w całym rysunku setki klonów tej grupy.)
Operacją odwrotną do grupowania jest Object→Ungroup Shift-Ctrl-D. „Rozkłada” grupę na elementy, z których powstała. Transformacje (obrót, przesunięcie, skala), jakim została poddana grupa, zostają zachowane.
Inkscape pozwala na edycję elementów wchodzących w skład grupy. Służy do tego polecenie Enter group, z menu kontekstowego (Rysunek 11.37.2):
Rysunek 11.37.2 Przejście do edycji grupy
W istocie, warstwy w Inkscape to z punktu widzenia standardu SVG takie duże grupy, zawierające wiele elementów.
Jeżeli grupowane elementy znajdują się na wielu warstwach — to po połączeniu zostaną przeniesione na jedną, wspólną warstwę.
Zaznacz obiekt, który ma być wypełniony. Następnie w panelu Fill and Stroke, zakładce Fill, wybierz opcję wypełnienia gradientem (Rysunek 11.38.1):
Rysunek 11.38.1 Włączenie wypełnienia gradientem (liniowym)
Domyślny gradient jest płynnym przejściem pomiędzy dwoma kolorami: początkowym i końcowym. Gdy go włączysz, zmieni się zawartość zakładki Fill. Pojawią się w niej kontrolki, służące do zmiany gradientu (zob. Rysunek 11.38.1).
Układ geometryczny gradientu możesz zmieniać, po przełączeniu w tryb edycji linii (Rysunek 11.38.2a):
Rysunek 11.38.2 Odcinek, sterujący położeniem, rozmiarem i orientacją gradientu
W trybie edycji linii pojawi się, obok punktów sterujących kształtem obiektu, dodatkowy odcinek: to sterowanie geometrią gradientu (Rysunek 11.38.2a). Zmieniasz ją, przesuwając końce odcinka sterującego w nowe miejsce. Możesz w ten sposób zmienić rozmiar gradientu (zwężać lub poszerzać), a także zmienić jego orientację, oraz położenie (Rysunek 11.38.2b).
Gdy zawężasz gradient tak, aby był mniejszy od obiektu (np. tak jak to pokazuje Rysunek 11.38.2b), możesz włączyć inny efekt: powtórzenie. Służy do tego lista Repeat (Rysunek 11.38.3):
Rysunek 11.38.3 Powtarzanie gradientu, w trybie direct
W Inkscape masz dostępne dwa sposoby powtarzania gradientu: bezpośredni (direct) i odbity (reflected). Przykład zastosowania trybu direct przedstawia Rysunek 11.38.3. Zasada jest prosta: koniec jednego segmentu gradientu jest jednocześnie początkiem następnego.
Rysunek 11.38.4 przedstawia inny tryb powtórzenia: reflected. W tym trybie koniec jednego segmentu gradientu spotyka się z końcem „sąsiada”, a początek — z początkiem:
Rysunek 11.38.4 Powtarzanie gradientu, w trybie reflected
Zwróć uwagę na efekt trybu reflected dla prostego, dwukolorowego gradientu: to trochę wygląda jak fragment rzędu walców, widzianych z przodu (Rysunek 11.38.5). Ten efekt możesz jeszcze poprawić, zmieniając rozkład barwy wzdłuż gradientu z liniowego na bardziej „kołowy”. (Poprzez wstawienie dodatkowego węzła — patrz na następnych stronach).
Rozkład barwy wzdłuż gradientu, zastosowany do wypełnienia, możesz zmieniać na kilka sposobów. Pierwszym, najbardziej oczywistym, jest wybór z listy jednego z gradientów, które już są zdefiniowane w rysunku (Rysunek 11.38.6). Za każdym razem, gdy włączysz w jakimś kształcie wypełnienie gradientem, na tej liście pojawi się nowa pozycja. Jeżeli z niej nie skorzystasz — zniknie, gdy zaznaczysz na rysunku inny obiekt. Możesz także stworzyć nowy gradient, za pomocą przycisku Duplicate. Naturalną konsekwencją takiego powielenia jest jakaś zmiana tak uzyskanego gradientu. Służy do tego przycisk Edit... , który otwiera okno Gradient editor (Rysunek 11.38.7):
Rysunek 11.38.6 Wybór wzoru (rozkładu) gradientu | Rysunek 11.38.7 Okno edycji wzoru gradientu |
W Inkscape nie ma możliwości zmiany nazwy gradientu i jego węzłów. Musisz korzystać z nazw wygenerowanych przez program. Może w przyszłości ta niedogodność zostanie usunięta.
W oknie Gradient editor możesz zmienić barwy węzła (stop) gradientu. Z listy u góry wybierasz punkt, który chcesz zmienić, a następnie ustalasz jego barwę za pomocą kontrolek z sekcji Stop Color (Rysunek 11.38.8):
Rysunek 11.38.8 Zmiana barwy końca wzoru gradientu
Gradient musi mieć co najmniej dwa węzły: początek i koniec. Może być ich więcej — wystarczy, że dodasz kolejny za pomocą przycisku Add stop. Położenie takiego węzła możesz zmieniać w oknie Gradient editor za pomocą kontrolki Offset. Nowy punkt jest także widoczny na rysunku, i tam także możesz go przesuwać — za pomocą myszki (Rysunek 11.38.9):
Rysunek 11.38.9 Dwie metody zmiany węzła gradientu
Ten „dualizm” metod edycji dotyczy także zmiany barwy — po zaznaczeniu węzła możesz użyć kontrolek z zakładki Fill (Rysunek 11.38.9). W sumie — okna Gradient editor można tylko używać do dodania lub usunięcia węzła.
W Inkscape, oprócz gradientu liniowego, istnieje także gradient kołowy. Wystarczy włączyć inną opcję wypełnienia (Rysunek 11.38.10):
Rysunek 11.38.10 Gradient kołowy
Linie połączeń na poszyciu samolotu odwzorowujemy za pomocą tekstury nierówności1. Proponuję, aby podstawową mapę, odwzorowującą także nity i inne szczegóły konstrukcyjne, wykonać jako rysunek wektorowy w Inkscape (więcej na ten temat — zobacz str. 325 i następne).
Odwzorowanie połączeń blach poszycia samolotów odrzutowych jest, paradoksalnie, najłatwiejsze. Począwszy od lat 50-tych XX w. blachy na ich powierzchni są łączone zazwyczaj „na styk” , by powodować jak najmniejsze zaburzenia warstwy przyściennej. Na rysunkach samolotu takie połączenia poznasz po tym, że mają linię nitów z obydwu stron. Zresztą, łby nitów są „na gładko” zeszlifowane z kadłubem, i często ich obecność można poznać tylko po innej barwie poszycia, utrzymanym w kolorze naturalnego duralu. Takie „wklęsłe” szwy znajdziesz już na MiG-15 czy F-86. Ich odwzorowanie na teksturze nierówności jest banalne — po prostu ciemniejsza linia (Rysunek 11.39.1):
Rysunek 11.39.1 Łączenie poszycia „na styk” i jego odwzorowanie na mapie nierówności | Rysunek 11.39.2 Łączenie poszycia „na zakładkę” i jego odwzorowanie na mapie nierówności |
W wolniej latających konstrukcjach stosowano (i nadal się stosuje) mniej pracochłonne łączenie „na zakładkę” (Rysunek 11.39.2). Takie szwy wymagają dwa raz mniej nitów, umieszczonych tylko po jednej stronie. Szwy „na zakładkę”, czasami jeszcze z nitami o wypukłych łbach, spotkasz w większości konstrukcji z okresu II Wojny Światowej. Jeżeli miały nawet nity z łbem wpuszczanym — to często nie były szlifowane do poziomu poszycia (wiadomo, produkcja wojenna...). Cały problem z narysowaniem takich połączeń to uzyskanie powoli narastającej barwy, która — w miejscu krawędzi — gwałtownie ciemnieje. Można ten efekt uzyskać przy użyciu powierzchni wypełnionych gradientami. Oczywiście, nie jest to tak proste, jak rysowanie pojedynczych linii.
Zacznij od przygotowania poziomu odniesienia — to szare tło. Uzyskałem je poprzez wstawienie na warstwę Background prostokąta, zasłaniającego cały obraz. Prostokąt jest wypełniony kolorem szarym, o odcieniu na poziomie 50% czerni (czyli, w wartościach podawanych w Inkscape — 128).
W kolejnej warstwie — Rivets — umieściłem linie nitów. Nie obawiaj się — nie rysowałem każdego osobno! Stworzyłem je, używając specjalnego wzoru linii kropkowej2. To wzór niestandardowy — aby go uzyskać, musiałem użyć okna XML Editor (szczegóły — str. 716). Rysunek 11.39.3 przedstawia rezultat:
Rysunek 11.39.3 Faza pierwsza — neutralne tło i linie nitów.
Jeżeli nity mają być wypukłe, nadaj im barwę białą (255), a jeżeli wklęsłe - czarną (0). W razie czego — zawsze przyglądaj się zdjęciom. Nawet tam, gdzie poszycie było „z zasady” pokryte nitami z łbem wpuszczanym, mogą się trafić jakieś szczególnie obciążone szwy, w których konstruktorzy zdecydowali się użyć nitów z łbem wypukłym (mają większą wytrzymałość)3.
Głębokość / wysokość nitów ustalasz, zmieniając nieprzejrzystość warstwy Rivets (Rysunek 11.39.3a). Pamiętaj, że nity wpuszczane są niemal niewidoczne. Tylko dlatego, aby coś było widać na ilustracjach w tej sekcji, ustawiłem nieprzejrzystość tej warstwy na 50%. Zazwyczaj odpowiednią wartością jest 5%, może czasami 10%. (Przy takich wartościach nity na obrazie są niemal niewidoczne, ale mimo to „wyjdą” po zastosowaniu tekstury na modelu!).
Utwórz teraz kolejną warstwę poniżej warstwy Rivets. Nadaj jej nazwę PanelH i ustal nieprzejrzystość na 50% (Rysunek 11.39.4a). Narysuj na niej zamknięte obrysy paneli. Nie rysuj wszystkich — tylko te, które odpowiadają za jakieś połączenie w poziomie (Rysunek 11.39.4b):
Rysunek 11.39.4 Faza druga — poziome połączenia blach.
Do wypełnienia paneli użyj najprostszego gradientu (jak — str. 723), w którym obydwa krańce maja kolor biały. Różnią się tylko przejrzystością — jeden z nich jest zupełnie przejrzysty (A = 0), a drugi — wcale (A = 255). Użyj tego samego gradientu na wszystkich narysowanych panelach (wspominam o tym tylko „na wszelki wypadek”, gdybyś w przyszłości chciał go zmienić). Zorientuj rozmiar i pochylenie gradientu tak, by biała, nieprzejrzysta krawędź biegła wzdłuż linii szwu, a przejrzysta mieściła się mniej więcej w zarysie panelu (Rysunek 11.39.4b) .
Utwórz jeszcze jedną warstwę ponad warstwą PanelH. Nadaj jej nazwę PanelV, i także ustal jej przejrzystość na 50% (Rysunek 11.39.5a). Na tej warstwie umieść z kolei panele odpowiedzialne za krawędzie pionowe (Rysunek 11.39.5b):
Rysunek 11.39.5 Faza trzecia — pionowe połączenia blach.
Do wypełnienia narysowanych paneli użyj tego samego gradientu, jaki stosowałeś do obiektów na warstwie PanelH. Dopasuj go według tych samych reguł — jasna krawędź wzdłuż linii szwu, przeciwległa — na przeciwnym krańcu panelu (tam, gdzie biegnie linia kolejnego pionowego połączenia). Panele należy rozciągnąć do granic obrysu kadłuba — nawet tam, gdzie do tej pory nie było paneli poziomych (Rysunek 11.39.5b).
Zwróć uwagę, że dzięki zastosowaniu „krzyżowania” obrysów z dwóch warstw, odwzorowaliśmy oryginalne 7 „kawałków blachy” poszycia tylko za pomocą 4 elementów! Oszczędziło to nam sporo pracy przy wzajemnym dopasowaniu kształtów (ta rośnie geometrycznie w stosunku do liczby dopasowywanych obiektów).
Czy już widzisz, co udało się nam uzyskać? W wyniku zastosowania gradientów panele stają się coraz jaśniejsze, by doprowadzić do dużego kontrastu wzdłuż linii szwu. To na mapie nierówności wywoła właściwe wrażenie zachodzących na siebie blach. Nawet narożniki nie są tu przeszkodą — są dwa razy jaśniejsze od środka szwu. Dokładne intensywności szarości (w skali 0..255) przedstawia Rysunek 11.39.6. Z jednej — „wyższej„ — strony szwu są piksele o jasności 192, z drugiej — „niższej” — 128 (kolor tła). Daje to różnicę poziomów (kontrast) rzędu 64. W narożnikach, gdzie nakładają się na siebie dwa gradienty, „najwyższy” narożnik ma jasność 224. Graniczy z liniami o jasności 192 (kontrast - 32). Największy kontrast — 96 — występuje na połączeniach w kształcie litery „T”. Tam narożnik o jasności 224 graniczy z jednej strony z tłem (Rysunek 11.39.6):
Rysunek 11.39.6 Rezultat złożenia paneli „pionowych” (PanelV) i „poziomych” (PanelH).
Na powierzchni samolotu mogą wystąpić jeszcze elementy nałożone na wszystkie inne blachy — jakieś pokrywy, czy temu podobne. Stwórzmy dla nich specjalną warstwę Overlay, umieszczoną ponad PanelV i PanelH (Rysunek 11.39.7a):
Rysunek 11.39.7 Faza czwarta — blachy, które są nałożone na pozostałe.
Elementy, umieszczone na warstwie Overlay muszą być jaśniejsze od jakiejkolwiek krawędzi powstałej z nałożenia paneli z warstw PanelH i PanelV. W przykładzie, jaki pokazuje Rysunek 11.39.7b, jest to jakiś prostokątny fragment blachy, przymocowany do poszycia. Nadałem mu odpowiednio „wysoką” jasność (232). Warstwa Overlay jest całkowicie nieprzejrzysta (oczywiście tam, gdzie jest cokolwiek na niej narysowane).
Aby wypukłe (białe) nity lepiej „wyszły” na renderingu, możesz przyciemnić tło — z 50% np. do 25% szarości (ze 128 do 64). Taka ściemni wszystkie barwy na panelach, ale zachowa kontrasty wzdłuż linii szwów.
Na koniec warto wspomnieć o pewnym typowym problemie. Pokażę go na przykładzie z realnej konstrukcji — fragmentu kadłuba P-40.
W miejscu, które pokazuje Rysunek 11.39.8, z jednolitą krawędzią panelu A graniczą początki dwóch innych paneli (B i C). W takiej sytuacji mamy problem z kontrastem w lewym dolnym narożniku panelu B. Odcień szarości jest tam taki sam, jak w sąsiedniej panelu A.( Rysunek 11.39.8). Oznacza to, że na modelu krawędź podziału blach w tym miejscu zaniknie.
Jak poradzić sobie z takim problemem? Należy „obniżyć” odcień obszaru za panelem A — zarówno wypukłości, jak też barwę „bazy” (tło). Narysuj najpierw obszar tego obniżenia. Musisz nadać mu taki kształt, by krawędzie poprzeczne były ukryte (Rysunek 11.39.9a):
Rysunek 11.39.9 Uzyskanie kontrastu wzdłuż krawędzi panelu za pomocą gradientu „przyciemniającego”.
Potem wypełnij ten obszar gradientem, którego przejrzystość zmienia się od 0 do 25% (64) (Rysunek 11.39.9b).
Ostatnim elementem poszycia, który odwzorujemy, są śruby (przymocowujące do poszycia np. prostokątny panel z warstwy Overlay). Umieść je ponad nitami, na oddzielnej warstwie Screws (Rysunek 11.39.10):
Rysunek 11.39.10 Faza piąta — inne elementy poszycia (śruby, zamki, itp.)
Blacha poszycia tworzy często drobne zagłębienia wokół dokręconych śrub (Rysunek 11.39.10b) . Możesz je odwzorować za pomocą kolistych gradientów, umieszczonymi na specjalnej warstwie Bumps. Umieść ją pod innymi warstwami (por. Rysunek 11.39.10a). Aby cienie pod śrubami były widoczne, zwiększ nieco (np. o 30%) przejrzystość warstwy Overaly.
Aby ułatwić ewentualne przyszłe modyfikacje, proponuję nanieść na rysunek „klony” (Object→Clone→Create Clone, p. str. 715) wzorców śrub i ich cieni, które narysujesz raz, gdzieś z boku (Rysunek 11.39.11a):
Rysunek 11.39.11 Wzorce śrub i cieni
Wzorce mogą być o wiele większe od swoich klonów — gdyż rozmiar (oraz ewentualną deformację — zobacz cienie na narożnikach przyśrubowanej na rysunku płyty) można ustalić dla każdego klonu indywidualnie. Wzór zaciemnienia uzyskasz, wypełniając koło odpowiednim gradientem (Rysunek 11.39.11b).
Do przygotowania obrazów drugorzędnej tekstury nierówności (B.Skin.Nor-Bump), a także tekstury odbić i odbłysków (B.Skin.Ref) należy ostre i dokładne linie obrazu wektorowego poddać „rozmyciu”. Najbardziej oczywistą metodą jest wyeksportowanie ostrego obrazu z Inkscape do pliku rastrowego, by potem „rozmyć” go w Gimpie. Taką właśnie to zrobiłem w początkowych sekcjach o teksturowaniu (por. str. 329-330). Do obrazu tekstury potrzebne było złożenie trzech kolejnych „rozmyć”, różniących się promieniami: 5, 10, 25 px. Każde z nich było tworzone w GIMP na oddzielnej warstwie.
Okazuje się, że ten sam efekt można osiągnąć wprost w Inkscape, za pomocą tzw. filtrów (Filters) . Nie będę się tutaj szczegółowo rozwodził, jakie filtry są dostępne w Inkscape i co umożliwiają, bo to baardzo rozległy temat. (W razie czego spróbuj sam poszukać w Internecie materiałów z ich opisem — to tzw. „SVG filters”). Zamiast tego skoncentruję się na przykładzie konkretnego filtra, wykonującego „w locie” kaskadowe rozmycie metodą Gaussa. Zastosowanie tego filtra pozwoli nam uzyskać obraz drugorzędnej tekstury nierówności — nor_bumps.png (por. str. 328) — wprost z Inkscape.
Przygotowanie filtra zacznij od zaznaczenia na rysunku obiektu/obiektów, wobec których ten filtr ma być zastosowany. Ze względu na wydajność nie przypisuj tego samego filtru do zbyt wielu obiektów na rysunku. Lepiej jest je połączyć w grupę (str. 722), wobec której zastosujesz odpowiedni filtr.
Polecenia związane z filtrami znajdziesz w menu Filters. Twórcy Inkscape umieścili tu mnóstwo gotowych kompozycji filtrów — możesz z nimi poeksperymentować. Aby stworzyć nowy filtr „od zera”, wybierz polecenie Filters→Filter Editor... .Spowoduje to pojawienie się po prawej stronie okna edytora filtrów (Rysunek 11.40.1):
Rysunek 11.40.1 Tworzenie nowego filtra — wywołanie i ekran edytora
Rysunek 11.40.1b) pokazuje, z jakich elementów składa się edytor filtrów. Aby dodać do rysunku nowy filtr, naciśnij przycisk New. Rysunek 11.40.2 pokazuje rezultat:
Rysunek 11.40.2 Tworzenie nowego filtra — ustalenie nazwy i wykorzystanie pól wyboru efektu
Najpierw zacznijmy od „czynności porządkowych”: kliknij w nazwę filtru i zmień ją na coś reprezentatywnego (Rysunek 11.40.2a). Temu filtrowi nadałem nazwę Blur. Potem możesz zacząć dodawać do definicji filtra kolejne komponenty (tzw. „efekty” — effects). Robi się to w dwóch krokach (por. Rysunek 11.40.2b):
Wybierz efekt rozmycia metodą Gaussa (Gaussian Blur) . W rezultacie na liście definicji filtra pojawił się pierwszy komponent, a element przypisany do filtru Blur uległ rozmyciu (Rysunek 11.40.3):
Rysunek 11.40.3 Efekt zastosowania pojedynczego komponentu typu Gaussian Blur
Popatrz uważnie na obszar definicji filtra. To w istocie schemat, pokazujący co jest wejściowym obrazem do rozmycia (Source Graphic). Rezultatem działania filtru jest rezultat zwracany przez ostatni (najniższy) efekt.
Spośród pięciu potencjalnych źródeł obrazu wejściowego (Source Graphic, Source Alpha, Background Image, Fill Paint, Stroke Paint — por. Rysunek 11.40.3) najczęściej wykorzystuje się dwa:
Source Graphic oznacza zawartość elementu (wszystkie linie, wypełnienia, itp.), do którego filtr jest przypisany (Source = element przypisany) ;
Background Image oznacza cały widoczny rysunek, znajdujący się pod elementem przypisanym do filtru;
Podczas komponowania filtrów zazwyczaj wykorzystujemy Source Graphic, choć czasami spotkałem się także z użyciem Background Image. Pozostałe są mniej użyteczne, np. Fill Paint to barwa, gradient, lub wzór wypełnienia, a Stroke Paint — barwa, gradient, lub wzór linii przypisanego obiektu.
Pozostaw w parametrach pierwszego komponentu wartość Standard Deviation = 1.0. Dla takiej wartości rozmycie obrazu jest mniej więcej takie, jak w GIMP dla promienia Blur Radius = 5. (Promień rozmycia w GIMP i standardowe odchylenie w Inkscape to zupełnie inne parametry! W dodatku zależność pomiędzy nimi wcale nie jest liniowa).
Teraz dodaj do filtra kolejne rozmycie Gaussa (Rysunek 11.40.4):
Rysunek 11.40.4 Dodanie do filtra drugiego komponentu typu Gaussian Blur
Domyślnie Inkscape podstawia, jako informację wejściową dla nowo dodanego efektu, rezultat wszystkich dotychczasowych komponentów (Rysunek 11.40.4a). Wyszło by z tego jednak zbyt duże rozmycie, a chcemy tu uzyskać złożenie trzech rozmyć oryginalnego, ostrego obrazu, o promieniach 5, 10 i 25 px (por. str. 329-330). Przestaw więc „wejście” do drugiego komponentu: złap LPM za końcówkę jego „wejścia” i przesuń ją z wyjścia pierwszego rozmycia ponad obszar Source Graphic (Rysunek 11.40.4b) . Zwiększ także odchylenie standardowe drugiego rozmycia z 1.0 do 1.7 (odpowiada to w przybliżeniu Blur Radius = 10 w Gimpie).
Zwróć uwagę, że po tym zabiegu obraz na ekranie wygląda jakby był rozmyty wyłącznie przez drugi komponent (nie widać żadnego wpływu pierwszego rozmycia). Tak jest w istocie: w obecnym układzie wyjść i wejść z komponentów rezultat pierwszego rozmycia (tego o Standard Deviation = 1.0) nie jest podłączony do niczego. Podczas przerysowania ekranu jest „po cichu” pomijany przez Inkscape.
Jak „złożyć” rezultaty tych dwóch rozmyć ze sobą? Można to zrobić np. za pomocą kolejnego komponentu: Blend (Rysunek 11.40.5):
Rysunek 11.40.5 Złożenie rezultatu dwóch komponentów za pomocą efektu Blend
Komponent Blend dokonuje złożenia dwóch wejściowych obrazów, stąd ma dwa wejścia. Dokonuje tego zgodnie z regułami „arytmetyki barw” (patrz str. 1246). W zależności od tego, jaką operację ustawisz w jego parametrach, będzie wykonywał „zwykłe” sumowanie (Normal), mnożenie (Multiply), rozjaśnianie (Lighten) lub zaciemnianie (Darken). Zaraz po dodaniu, obydwa wejścia komponentu Blend są podłączone do rezultatu poprzedniego efektu, a tryb jest ustawiony na Normal (Rysunek 11.40.5a). (Przy takich ustawieniach tego komponentu na rysunku nic nie ulegnie zmianie). Przełącz jedno z jego wejść na rezultat pierwszego rozmycia, a operację Blend — na Multiply (Rysunek 11.40.5b). Uzyskasz w ten sposób na rysunku złożenie dwóch rozmyć — zupełnie tak samo, jak wcześniej w Gimpie.
Pozostaje teraz dodać kolejny efekt: trzeci, najbardziej rozmyty obraz. Wstaw do filtra kolejny komponent Gaussian Blur, tym razem ze Standard Deviation = 3.4 (odpowiada to w przybliżeniu Blur Radius = 25px w GIMP). Zsumuj rezultat tego efektu z pozostałymi za pomocą kolejnego komponentu Blend (Rysunek 11.40.6) :
Rysunek 11.40.6 Gotowy filtr: złożenie trzech rozmyć Gaussian Blur (Std Dev. = 1, 1.7, 3.4)
Na zakończenie warto wspomnieć o kilku typowych operacjach w edytorze filtru:
aby przesunąć jeden z komponent w górę lub w dół, wystarczy go „złapać” LPM i „upuścić” w docelowym miejscu;
aby usunąć komponent z filtra, zaznacz go, i z menu kontekstowego (PPM) wybierz polecenie Remove (Rysunek 11.40.7);
aby usunąć cały filtr, zaznacz go, i z menu kontekstowego (PPM) wybierz polecenie Remove (Rysunek 11.40.8);
Rysunek 11.40.7 Usuwanie pojedynczego efektu | Rysunek 11.40.8 Usuwanie całego filtru |
Pewne powierzchnie samolotów mogą być pokryte płótnem. Jest to stosunkowo gruba tkanina, naprężona jak bęben za pomocą impregnatów. Myśliwce z pierwszej połowy lat 40-tych zazwyczaj miały pokryte w ten sposób powierzchnie sterów i lotek.
Specyfiką takich powierzchni są wypukłości wzdłuż krawędzi żeber (Rysunek 11.41.1a). Płótno na szkielecie jest napięte, więc w dalszej odległości od żeber wygląda na zupełnie płaskie. (O ile krawędzie żeber są linią prostą. Jeżeli jest to wyraźna krzywa — pomiędzy żebrami pojawią się zagłębienia). Rysunek 11.41.1b) pokazuje typową mapę nierówności, imitującą pokrycie z płótna:
Rysunek 11.41.1 Odwzorowanie płóciennego pokrycia steru na mapie nierówności
Obraz mapy nierówności został narysowana w Inkscape (Rysunek 11.41.2):
Rysunek 11.41.2 Szczegóły obrazu nierówności pokrycia steru (warstwa Fabric)
W miejscu każdego żebra narysuj prostokąt, wypełniony liniowym gradientem odbitym (reflected) wzdłuż osi żebra,. Z obydwu stron prostokąta umieść zamykające półkola, wypełnione tym samym gradientem, ale w układzie kołowym (Rysunek 11.41.2). Wzmacniające paski tkaniny, naszyte na płótno w miejscach narażonych na przetarcia można łatwo odwzorować za pomocą jednolitych, białych obszarów o niewielkiej nieprzejrzystości (komponent A barwy wypełnienia rzędu 25%, czyli 64). Tam, gdzie takie fragmenty się nałożą, uzyskasz w naturalny sposób dodatkowe „pogrubienie”.
Czasami na płótnie widoczne były nierówności od leżących pod spodem nitów (w tym miejscu były to zawsze nity z łbem wypukłym). Właściwie należałoby każdy z nich zamodelować kołowym gradientem. Nity są jednak małe, a podczas eksportu do obrazu rastrowego i tak się rozmyją, więc zdecydowałem się odwzorować je tak samo, jak pozostałe tego rodzaju szwy.
Do uzyskania właściwej wypukłości wzdłuż żebra należy użyć białego gradientu (R, G, B = 100%, czyli 255), w którym kolejne węzły będą się różnić tylko nieprzejrzystością (A) . Nieprzejrzystość powinna się zmniejszać nie liniowo, a parabolicznie (Rysunek 11.41.3):
Rysunek 11.41.3 Gradient paraboliczny, wykorzystany do odwzorowania wypukłości żeber
Gradient paraboliczny dobrze odwzorowuje wypukłość wokół żebra nawet na dużo szerszych obszarach, niż te, pokazywane na poprzedniej stronie. Takie szersze obszary możesz stosować w konstrukcjach, gdzie zagłębienia płótna pomiędzy żebrami były głębsze.
Wykonanie obrazu nierówności całego steru zaczynasz od narysowania zespołu pojedynczego żebra — prostokąta i dwóch okrągłych końcówek, wypełnionych gradientem. Nanieś na nie także pasek, imitujący naszyte wzmocnienia — prostokąt o 25% nieprzejrzystości (patrz Rysunek 11.41.2). Dla ułatwienia dalszych kroków nadaj tym wszystkim elementom jakieś całkowite współrzędne położenia i wymiary. (Jeżeli zadeklarowane w Inkscape rozmiary Twojego obrazu to 2048x204 px, nie powinno być z tym problemu).
Potem po prostu kopiuj tę grupę w miejsce kolejnego żebra. Zazwyczaj po skopiowaniu będziesz musiał zmienić długość prostokątów i odpowiednio przesunąć półokrągłą końcówkę. Aby położenie (współrzędne X, Y) końcówki i szerokość (W) prostokąta były dobrze do siebie dopasowane — ustalaj nowe wartości numerycznie, w polu powyżej ekranu. (Dlatego przydatne jest posługiwanie się wymiarami bez części ułamkowych — bo można je szybko przeliczyć w pamięci).
Uzyskany obraz nierówności dla powierzchni krytych płótnem umieść na jakiejś wydzielonej warstwie (nazwijmy ją Fabric). Ustaw nieprzejrzystość takiej warstwy na np. na 50%. Umożliwi Ci to w wygodne sterowanie głębokością nierówności na lotkach i sterach modelu.
Mapa nierówności, którą na razie stworzyliśmy, pozwala uzyskać wrażenie lokalnych wypukłości na żebrach (por. Rysunek 11.41.1). Tak rzeczywiście wygląda naprężone płócienne pokrycie w sytuacji „statycznej”, gdy samolot stoi na lotnisku. Ale w locie to już inna sprawa: pod wpływem gwałtownych różnic ciśnienia płótno potrafi się deformować jak balon1!
Przygotujmy obraz takich dynamicznych wgłębień w powierzchniach sterów (Rysunek 11.41.4):
Rysunek 11.41.4 Rysowanie zagłębień w płótnie lotki w Inkscape (warstwa Fabric Bump)
Na ilustracji pokazuję to na przykładzie lotki. Obrysuj na oddzielnej warstwie (nazwijmy ją Fabric Bump) cały obszar powierzchni sterowej czarnym wielobokiem (Rysunek 11.41.4a). Potem ponad każdym żebrem umieść prostokąt (Rysunek 11.41.4b). Te prostokąty połącz w jedną siatkę i odejmij (Difference) od czarnego wieloboku (Rysunek 11.41.4c). Na koniec „rozmyj” uzyskany obrys zmodyfikowanym filtrem Rounded (Rysunek 11.41.4d). Ten filtr uzyskasz poprzez rozmycie standardowego filtra: Filters→Morphology→Smooth Edges dodaną na końcu operacją Gaussian Blur w której Standrad Deviation = 6 (Rysunek 11.41.5):
Rysunek 11.41.5 Filtr Rounded, wykorzystywany do rozmycia wgłębień w płótnie
Rysunek 11.41.6 przedstawia rezultat zastosowania samej warstwy Fabric (Rysunek 11.41.6a), z wypukłościami wzdłuż żeber i innymi szczegółami konstrukcyjnymi. Tak wygląda ster gdy samolot stoi na lotnisku (Rysunek 11.41.6b):
Rysunek 11.41.6 Efekt użycia samej warstwy z wypukłościami żeber (Fabric)
Rysunek 11.41.7 przedstawia rezultat uzyskany po nałożeniu na poprzednio użytą warstwę Fabric warstwy z obrazem zagłębień w płótnie (Fabric Bump: Rysunek 11.41.7a). Tak może się odkształcać poszycie steru podczas lotu (Rysunek 11.41.7b):
Rysunek 11.41.7 Efekt użycia dodatkowej warstwy z zagłębieniami płótna (Fabric Bump)
Przy tworzeniu tekstur dla modelu samolotu dużo czasu może zająć stworzenie efektu zabrudzeń, biegnących wzdłuż linii połączeń poszycia. W tej sekcji pokażę, jak można ten efekt uzyskać w Inkscape za pomocą filtra (Rysunek 11.42.1):
Rysunek 11.42.1 Cel: stworzenie filtra przekształcającego prosty rysunek połączeń w obraz „zabrudzeń”
Zawartość tej sekcji może także posłużyć także jako ilustracja praktycznego zastosowania różnorodnych efektów, dostępnych w Inkscape.
Stwórz nowy filtr i przypisz go do rysunku linii. Wstaw do edytora pierwszy komponent: Morphology. Ustaw go w tryb „zanikania” linii: Erode (Rysunek 11.42.2):
Rysunek 11.42.2 Użycie efektu Morphology:Erode do zmniejszenia grubości linii
Ustaw promień efektu (Radius) 1.5 - 2.0. Przy takich wartościach z oryginalnych linii prawie nic nie zostanie, ale nie przejmuj się tym. Im promień jest mniejszy, tym bardziej kontrastowe będą ciemne „odpryski” wokół linii na ostatecznym obrazie. Gdybyś ustawił go np. na wartość = 1.4, rezultat byłby zbyt wyrazisty.
Aby „zmiękczyć” trochę efekt „zanikania” linii, dodaj kolejny komponent Composite, „mieszający” zanikające linie z oryginalnym obrazem (Rysunek 11.42.3):
Rysunek 11.42.3 Użycie efektu Composite do stonowania efektu Morphology:Erode.
Dodajmy teraz zaburzenia: efekt Turbulence. Po jego dodaniu uważaj: dopóki nie zmienisz parametru Base Frequency, Inkscape może niczego nie pokazywać na ekranie (to chyba jakiś błąd programisty). Ustaw typ zaburzeń (Type) na Fractal Noise, o największej częstotliwości Base Frequency = 0.4 (Rysunek 11.42.4):
Rysunek 11.42.4 Ustawienia efektu Turbulence.
Choć nie ma to wielkiego znaczenia, ustaw także Octaves i Seed na wartość 5. Na razie wygląda na to, że zepsuliśmy sobie tą turbulencją cały efekt, ale wstrzymaj się z oceną do następnego kroku.
Teraz dodaj kolejny komponent: Displacement Map. Zasadę działania tego efektu najlepiej chyba ilustruje obrazek, załączony przez twórców Inkscape (Rysunek 11.42.5). Ustaw jedno z jego wejść na obraz przed zastosowaniem Turbulence, a drugie — po Turbulence. Wartość Scale ustaw na = 20. Ten parametr określa szerokość „rozrzutu” śladu linii (im mniejsza, tym rozrzut mniejszy).
Rysunek 11.42.5 Użycie efektu Displacement Map i Turbulence do „rozproszenia” linii obrazu.
Aby „wzmocnić” nieco centrum śladu linii, wstawmy tam bardzo słaby ślad ich oryginałów. Użyjemy do tego kolejnego komponentu Composite (Rysunek 11.42.6). Aby to scalenie wyglądało lepiej, rozjaśnimy całość o 20% (parametr K4).
Rysunek 11.42.6 Dodanie „centralnych” śladów linii i rozjaśnienie efektu za pomocą kolejnego efektu Composite.
Komponent Composite ma wiele trybów, ale zazwyczaj używam go do arytmetycznego sumowania obrazów (Operator = Arithmetic). Gdy pozostawiasz współczynnik K1 = 0, wówczas K2 określa udział obrazu podłączonego do wejścia i1, a K3 — do wejścia i2 (Rysunek 11.42.6). Oprócz tego istnieje jeszcze współczynnik K4, który jest wartością stałą, dodawaną do reszty. Wartości R,G,B,A każdego piksela obrazów i1 i i2 są podstawiane do wzoru: I = i1*K2 + i2*K3 + K4. Potem rezultat I jest „obcinany” do zakresu 0.0 .. 1.0.
Pod te „kropkowe” zabrudzenia pasowało mi podstawić jakieś rozmycie Gaussa o dość dużym Std Deviation — powiedzmy, równym 5.0 (Rysunek 11.42.7):
Rysunek 11.42.7 Obraz linii, rozmyty metodą Gaussa — dodatkowy komponent obrazu.
Teraz pozostaje złożyć „cienie” linii (Rysunek 11.42.7) z dotychczasowym rezultatem. Użyjmy do tego komponentu Blend. Ten efekt imituje operacje, użyte w trybach nakładania warstw: Multiply, Darken, Lighter, itp. Więcej na ich temat znajdziesz na str. 1246 i dalszych. Rysunek 11.42.8 przedstawia rezultat złożenia efektów „rozproszenia” i „rozmycia” linii:
Rysunek 11.42.8 Złożenie za pomocą komponentu Blend „rozproszonych” i „rozmytych” linii.
Do połączenia tych dwóch obrazów wybrałem tryb „zwykły” — Normal (Rysunek 11.42.8). Daje to taki efekt, jak gdyby każdy ze składników znajdował się na oddzielnej warstwie. Wygląda to już całkiem nieźle, ale przydałoby się jakoś zaburzyć te gaussowskie rozmycia — biegną zbyt regularnie wzdłuż linii podziału blach.
Zaburzenie linii uzyskamy w ten sam sposób co poprzednio: wstaw przed rozmycie Gaussa efekt Turbulence. Tym razem ustaw w nim dwukrotnie mniejszą częstotliwością niż poprzednio (Rysunek 11.42.9):
Rysunek 11.42.9 Przygotowanie do zaburzenia rozmycia Gaussa — dodanie kolejnego efektu Turbulence.
Nieodłącznym następcą turbulencji jest Displacement Map (te efekty zawsze chyba trzeba używać w parze). Wstaw go pomiędzy Turbulence i Gaussian Blur. Rysunek 11.42.10 przedstawia, jak wyglądają „surowe” linie (Source Graphic), przetworzone przez zespół Turbulence + Displacement Map:
Rysunek 11.42.10 Efekt przetworzenia prostych linii przez złożenie Turbulence i Displacement Map.
Porównaj Rysunek 11.42.10 z efektem działania pokazanym przez Rysunek 11.42.5 (str. 744). Czy widzisz jak różne efekty można osiągnąć zmieniając częstotliwość komponentu Turbulence? Linie, które przedstawia Rysunek 11.42.5 zostały „rozbite w proch” za pomocą najwyższej częstotliwości: 0.4. Gdy użyliśmy częstotliwości dwa razy mniejszej (0.2 — por. Rysunek 11.42.10), to linie jeszcze się nie rozerwały. Zamiast tego wiją się po obrazie jak dym z papierosa.
Z połączenia komponentów Turbulence i Displacement Map można uzyskać dużo różnorodnych deformacji prostych linii — od „zacieków” po „rozproszenie”.
Włącz teraz ten zespół (Turbulence i Displacement Map) przed Gaussian Blur (Rysunek 11.42.11):
Rysunek 11.42.11 Złożenie obrazów: rozproszonego i rozmytego („turbulentnie”).
Pozostają teraz jeszcze drobne poprawki końcowe. Pierwszą z nich jest przyciemnienie za pomocą odpowiedniej Color Matrix (Rysunek 11.42.12):
Rysunek 11.42.12 O kontrastów obrazu poprzez przyciemnienie i zmniejszenie przejrzystości rozmyć.
W sumie macierz, którą przedstawia Rysunek 11.42.12, wykonuje dwie operacje równocześnie:
zwiększa przejrzystość obiektu, przypisanego do filtra, o 50%;
ściemnia całość — a przede wszystkim chodzi tu o rozproszone linie — o 60%;
Wizualnie spowodowało to przyciemnienie linii i ich tła o jakieś 10% (bo linie, choć ciemniejsze, stały się jednocześnie bardziej przejrzyste). Obszary pomiędzy liniami także stały się ciemniejsze, gdyż nie były zupełnie przeźroczyste — wcześniej rozjaśnialiśmy je o 20% (por. str. 744, Rysunek 11.42.6). W sumie „spłaszczyło” to kontrast pomiędzy filtrowanym obiektem, a jego tłem.
Na koniec dodajmy jeszcze jeden komponent Composite, by rozjaśnić efekt ostateczny (Rysunek 11.42.13):
Rysunek 11.42.13 Ostateczny obraz, rozjaśniony za pomocą komponentu Composite.
Element ten łączy obraz sprzed i po przetworzeniu przez Color Matrix. Robi to w trybie Default, który nie wymaga podania żadnych dodatkowych parametrów.
Na samolocie można wyróżnić wiele większych i mniejszych napisów. Do większych należą numery seryjne, oznaczenia kodowe, a do mniejszych — napisy eksploatacyjne. Małe napisy można wykonać, używając czcionki o kształcie liter zbliżonym do oryginału — w Windows będzie to zazwyczaj Arial. Gorzej jednak z większymi elementami — tu każdy dostrzeże różnice! Czasami trzeba zakasać rękawy i po prostu je narysować.
Na szczęście ktoś specjalnie przygotował czcionkę True Type, o kształcie takim, jak szablony używane w USAAC/USAAF w latach 40-tych. Jest do pobrania z serwisu http://www.simmerspaintshop.com 1. Możesz ją swobodnie używać do celów niekomercyjnych. Kopie tych plików znajdziesz wśród materiałów towarzyszących książce — umieściłem je w folderze source\stencil\ (por. str. 22).
Czcionki True Type można stosować tylko w środowisku Microsoft Windows. Możesz sprawdzić, czy istnieją gdzieś wersje tych czcionek dla Apple Mcintosh. Niestety, nie można ich używać pod Linuxem.
W source\stencil\ znajdują się dwa pliki *.ttf. Podstawowym jest USAAF_Stencil.ttf. Zawiera definicję „ogólnego” kroju pisma, o nazwie USAAF Stencil, stosowanego w Siłach Powietrznych USA podczas drugiej wojny światowej (Rysunek 11.43.1):
Rysunek 11.43.1 Czcionka USAAF Stencil.
Aby USAAF Stencil stał się dostępny we wszystkich aplikacjach Windows, skopiuj plik USAAF_Stencil.ttf do systemowego folderu Windows: C:\Windows\fonts\.
Czcionka zawiera, oprócz liter pokazywanych przez Rysunek 11.43.1, także dodatkowe wersje poszczególnych znaków, różniące się układem „prześwitów”. (Autor naniósł wszystkie przypadki, jakie mógł zidentyfikować na podstawie zdjęć). W odróżnieniu od podstawowego zestawu, te dodatkowe litery są przypisane w sposób trochę przypadkowy, do różnych innych znaków (np. apostrof, cudzysłów, itp.) Najwygodniejszą metodą wyboru takich liter jest skorzystanie ze standardowej aplikacji Windows „Tabela znaków”. Ten program znajdziesz w menu Windows: Start →Akcesoria→Narzędzia systemowe→Tablica znaków (Rysunek 11.43.2)
Używając w Inkscape tekstów napisanych czcionką USAAF_Stencil, możesz błyskawicznie stworzyć takie elementy oznakowania samolotu, jak napis na dolnej powierzchni płata (Rysunek 11.43.3) :
Rysunek 11.43.3 Zastosowanie czcionki USAAF_Stencil — odtworzenie napisów na samolocie.
Gdybyś nie miał do dyspozycji tego zestawu znaków — trzeba byłoby podstawić „pod spód”, jako tło, jakiś wzorzec. Zapewne byłaby to zeskanowana kopia schemat malowania. Potem musiałbyś obrysować każdą literę napisu „U.S. ARMY”. Zajęłoby to dłuższą chwilę. A tu — do narysowania pozostały mi dwa małe kwadraty, udające „kropki” w napisie „U.S.” (kropek nie ma w zestawie USAAF_Stencil).
W folderze source\stencils znajdziesz jeszcze drugi plik: USAAF_Serial_Stencil.ttf. Ta czcionka jest uzupełnieniem USAAF_Stencil. Zawiera wyłącznie pomniejszone definicje cyfr, z podkreślonymi (poszerzonymi) „prześwitami”. Według twórcy czcionki, „takie litery będą lepiej wyglądać na małych napisach, takich jak numery seryjne” (Rysunek 11.43.4):
Rysunek 11.43.4 Czcionka USAAF Serial Stencil — do małych numerów seryjnych.
Czasami trzeba odwzorować na modelu jakieś skomplikowane godła lub inne oznaczenia. Na przykład — na każdej z łopat śmigła P-40 był naniesiony znak firmowy „Curtiss Electric”. Rysunek 11.44.1a) przedstawia „surowy” obraz, wycięty z zeskanowanej strony monografii:
Rysunek 11.44.1 „Surowy” obraz naklejki z łopaty śmigła Curtiss Electric, zeskanowany z planszy barwnej
W takiej postaci obraz pokryty jest rastrem o nieco innym odcieniu (Rysunek 11.44.1b). Może to jest efekt druku w technologii offsetu?. Aby te kropki wyeliminować, poddaj go „wstępnej obróbce” w GIMP:
Image→Scale, (zmniejsz obraz do 50%, z filtrem Linear) — to eliminuje część „kropek”;
Wybrać (Select By Color) na napisie Curtiss Electric Propellers „kropki” innych kolorów niż pomarańczowy, i zamalować je na pomarańczowo (barwą pobraną z napisu);
Powtórnie wywołaj Color→Posterize (zmniejszyć liczbę barw do 3);
Wybrać (Select By Color) na napisie Curtiss Electric Propellers „kropki” innych kolorów niż pomarańczowy. Zamalować je barwą pomarańczową pobraną z napisu;
Powinieneś uzyskać w ten sposób uproszczony obraz, o liczbie barw zredukowanej do minimum (Rysunek 11.44.2):
Rysunek 11.44.2 Ten sam obraz, po ujednoliceniu barw (do trzech)
Tak przygotowany obraz załaduj do Inkscape (Rysunek 11.44.3):
Rysunek 11.44.3 Rastrowy wzorzec, załadowany do Inkscape
Przyjrzyj się uważnie temu wzorcowi i zastanów, które szczegóły szybciej i dokładniej można narysować od podstaw w Inkscape, a które lepiej będzie uzyskać poprzez automatyczne odwzorowanie kształtu. (To polecenie nie działa idealnie — czasami pozostawia jakieś niewielkie przekłamania). Osobiście, patrząc na Rysunek 11.44.3, zdecydowałem się automatycznie przenieść tylko główny napis: „Curtiss Electric Propellers”. Szczególnie sam „Curtiss” jest bardzo fantazyjny i trudno byłoby go narysować od podstaw.
Aby stworzyć wektorową kopię obrazu rastrowego, zaznacz go na rysunku i wywołaj polecenie Path→Trace Bitmap. Spowoduje to pojawienie się okna dialogowego z opcjami wykrywania kształtu (Rysunek 11.44.4):
Rysunek 11.44.4 Okno dialogowe polecenia Trace Bitmap.
Możesz poeksperymentować chwilę z różnymi opcjami wykrywania kształtu i rezultatami ich działania, pokazywanymi obok, w obszarze podglądu (Preview). Przekonasz się, że każda z nich tworzy efekt znacznie różniący się od pozostałych. W tym konkretnym przypadku zdecydowałem się użyć metody Color quantization, z Colors = 3, gdyż z takim ustawieniem „wydobywa” z obrazu rastrowego sam napis „Curtiss Electric Propellers”. Niczego więcej nie potrzebuję, więc oszczędzę sobie w ten sposób usuwania zbędnych rezultatów wektoryzacji.
Po naciśnięciu w oknie Trace Bitmap przycisku OK., Inkscape stworzy nową ścieżkę, o konturach odpowiadających kształtom, które wykrył w obrazie rastrowym (Rysunek 11.44.5):
Rysunek 11.44.5 Rezultat polecenia Trace Bitmap.
Domyślnie nowy kontur powstał na tej samej warstwie, na której umieszczony jest rastrowy pierwowzór. Aby ułatwić sobie dalszą pracę, przenieś go na jakąś warstwę powyżej. Będziesz mógł wtedy łatwo manipulować przejrzystością wzorca.
Ogólny kształt, uzyskany w wyniku polecenia Trace Bitmap, wygląda poprawnie. Gdy jednak wyłączysz na chwilę widoczność leżącego pod spodem wzorca, zaczniesz dostrzegać pewne różnice. Podczas śledzenia kształtu Inkscape ma tendencję do zaokrąglania wszelkich ostrych narożników i uskoków. Takie drobne zaokrąglenia składają się jednak na ogólny efekt. Warto więc skorygować nieco uzyskany kształt, nadając odpowiednim narożnikom z powrotem kąty ostre (Rysunek 11.44.6):
Rysunek 11.44.6 „Wyostrzanie kątów” na ścieżce stworzonej poleceniem Trace Bitmap.
Tak jak wspomniałem wcześniej, pozostałe elementy obrazu prościej jest narysować od podstaw. Używając obrazu rastrowego jako „podkładki”, narysuj jedną łopatę śmigła, a następnie skopiuj ją i obrócić o 120º, by uzyskać dwie pozostałe. Tło, wraz z wewnętrznymi kręgami, narysuj jako zespół kół, z których niektóre mają białe obwódki. Napis „T.M. REG. U.S. PAT. OFF.” bardzo ładnie można odwzorować za pomocą jakiejś prostej czcionki bezszeryfowej — nawet standardowej Arial.
Gorzej z białymi napisami: „CONSTANT SPEED”, „SELECTIVE PITCH”, „FEATHERING”. Użyto do nich bardzo podobnej czcionki, co w napisie „Electric Propellers”. Nie udało mi się znaleźć podobnej, a wektoryzacja tego kształtu nie wyszłaby zbyt dobrze — za dużo byłoby „babrania” się z poprawianiem kątów ostrych. Ostatecznie zdecydowałem się użyć innego kroju pisma. Choć nie jest takie samo, to na pierwszy (a może i drugi) rzut oka nie razi, szczególnie gdy nigdzie obok nie widać oryginału1 (Rysunek 11.44.7):
Rysunek 11.44.7 Efekt finalny — całkowicie wektorowy obraz rastrowego pierwowzoru
W tym rozdziale przedstawione są zagadnienia, które dotyczą więcej niż jednego okna (edytora) Blendera lub więcej niż jednego trybu pracy.
Pomijam tu zagadnienia, które przedstawiłem wcześniej (Rozdział 3). Były to:
Ta sekcja opisuje instalację Blendera ze spakowanego pliku *.zip. Uważam, że ta metoda jest równie dobra co użycie programu instalacyjnego. Za to wiesz dokładnie, co i gdzie zostało zmienione na Twoim komputerze.
Zacznij od głównej strony tego programu: http://www.blender.org . Jest na niej umieszczony skrót do plików instalacyjnych (Rysunek 12.1.1):
Rysunek 12.1.1 Strona główna Blendera
Pobierz z jednego z dostępnych serwerów odpowiedni plik *.zip (Rysunek 12.1.2):
Rysunek 12.1.2 Pobieranie pakietu instalacyjnego
Pobrany w ten sposób plik rozpakuj do folderu C:\Program Files (może to być także inny folder) (Rysunek 12.1.3):
Rysunek 12.1.3 Rozpakowanie plików Blendera
Potem zmień nazwę rozpakowanego folderu ze specyficznej na jakąś „ogólną”: np. Blender (Rysunek 12.1.4):
Rysunek 12.1.4 Zmiana nazwy folderu Blendera
Aby uruchomić Blender, należy dwukrotnie kliknąć na pliku blender.exe, umieszczonym w tym katalogu (Rysunek 12.1.5):
Rysunek 12.1.5 Uruchomienie Blendera
Oczywiście, wygodniej będzie jeżeli skopiujesz skrót do tego pliku na pulpit i/lub do menu Start.
Warto także przypisać Blender jako domyślny edytor plików o rozszerzeniu *.blend 1.
Chwilę po uruchomieniu zobaczysz okno Blendera wraz z ekranem powitalnym (Rysunek 12.1.6):
Rysunek 12.1.6 Ekran po uruchomieniu Blendera
Wybierz z menu Blendera (nagłówek okna Info) polecenie File→Open (lub naciśnij Ctrl-O) (Rysunek 12.2.1):
Rysunek 12.2.1 Wybór polecenia z menu
Spowoduje to chwilowe wyświetlenie na całym ekranie Blendera w okno wyboru plików (File Browser) – Rysunek 12.2.2:
Rysunek 12.2.2 Okno wyboru pliku
Jak widać, Blender ma własne okno do wskazywania pliku – jest to konsekwencja decyzji o zastosowaniu własnego interfejsu użytkownika. Omówmy pokrótce jego obsługę. Z panelu System, po lewej stronie, można wybrać dysk. Z niżej położonego panelu Bookmarks można wybrać jeden z typowych folderów, a z panelu Recent — ostatnio otwierany folder (Rysunek 12.2.3):
Rysunek 12.2.3 Okno wyboru pliku — elementy interfejsu użytkownika
Pobierz towarzyszący tej książce plik la5.zip (por. str. 22). Jego zawartość rozpakowuje się do folderu o nazwie model\la5. Załóżmy że umieściłeś te pliki na jakimś dysku E:, więc teraz otworzymy w Blenderze plik E:\model\la5\la5.blend.
Otwórz w oknie wyboru plików dysk E:\ (Rysunek 12.2.4):
Rysunek 12.2.4 Nawigacja w oknie wyboru plików
Wystarczy kliknąć (LPM) w nazwę folderu model, aby go otworzyć. W podobny sposób przejdź do folderu la5 (Rysunek 12.2.5):
Rysunek 12.2.5 Zawartość folderu model
Kliknij w plik, który chcesz otworzyć – jego nazwa pojawi się w polu na nazwę pliku do otwarcia (Rysunek 12.2.6). (Można było, oczywiście, wpisać ją z klawiatury, ale komu by się chciało...):
Rysunek 12.2.6 Wybór i otworzenie pliku Blendera
Po naciśnięciu przycisku Open Blender File plik zostanie załadowany. W zależności od mocy obliczeniowej Twojego komputera, może to zająć Blenderowi od jednej do paru sekund.
Warto jeszcze wspomnieć o kilku innych poleceniach z menu File (okna Info), związanych z otwieraniem plików:
File→Open Recent: pozwala otworzyć jeden z dziesięciu ostatnio zapisywanych plików;
File→Recover Last Session: pozwala odzyskać plik, który był załadowany gdy ostatni raz zamykałeś Blender (np. poleceniem File→Quit). Podczas zamykania Blender nie ostrzega, że aktualny plik zawiera niezapisane zmiany. Zamiast tego po prostu zawsze go zapisuje w folderze tymczasowym, pod nazwą quit.blend. To polecenie otwiera właśnie ten plik. Pozwala to odzyskać niezapisane zmiany, o ile zorientowałeś się w porę i nie zamknąłeś Blendera po raz kolejny…
File→Recover Auto Save… Jeżeli masz w konfiguracji programu włączone okresowe zapisywanie kopii pliku, tym poleceniem możesz go otworzyć po np. zawieszeniu programu. Więcej o odtwarzaniu danych — p. str. 775.
Aby zapisać aktualnie otwarty plik, wybieramy polecenie File→Save (Rysunek 12.3.1). Alternatywnie możesz nacisnąć na klawiaturze Ctrl-S — to skrót do tego polecenia:
Rysunek 12.3.1 Polecenie - zapisanie pliku
Jeżeli chcesz zapisać plik pod inną nazwą, wybierz polecenie File→Save As. Analogicznie jak przy otwarciu pliku (por. str. 759), na ekranie pojawi się na chwilę okno wyboru pliku (Rysunek 12.3.2):.
Rysunek 12.3.2 Okno zapisu pliku
Zwróć uwagę, że w polu z nazwą do zapisania domyślnie pozostaje oryginalna nazwa pliku. Aby zapisać go pod nową nazwą, musisz ją zmienić — wpisując z klawiatury lub klikając w inny plik (który chcesz nadpisać). Zapis pod nową nazwą nastąpi po naciśnięciu przycisku Save As Blender File.
Osobiście używałem tego polecenia co najmniej raz dziennie – do zapamiętania kolejnej wersji pliku. Nazywałem to „wersją dzienną”. Takie wersje bywają przydatne. Na początku pracy z Blenderem, zdarzało mi się poprzestawiać dziesiątki parametrów i nie uzyskać oczekiwanego efektu. Czułem, że szukając rozwiązania zabrnąłem w „ślepą uliczkę”. Wycofanie dokonanych zmian do stanu początkowego wyglądało często na bardzo pracochłonne, a czasami na praktycznie niemożliwe. O wiele prościej było zacząć jeszcze raz od „czystej” wersji z poprzedniego dnia. Twórcy Blendera z myślą o takich jak ja, dodali do okna zapisu pliku (Rysunek 12.3.2) dodatkowy „gadżet”. Przyciski [+], [-] lub klawisze + i - z klawiatury numerycznej zwiększają lub zmniejszają cyfrę (numer wersji) na końcu nazwy pliku.
Z innych poleceń które mogą okazać się przydatne, warto wspomnieć:
SaveScreenshot: zapisuje obraz aktualnego ekranu Blendera. Polecenie dostępne tylko za pomocą skrótu: Ctrl-F3. Format obrazu (JPG, PNG, ...) — ustalamy w oknie właściwości (Properties), zestaw Render, panel Output (patrz str. 100);
Image→Save As Image (F3): Polecenie z nagłówka okna UV/Image Editor. Zapisuje wyrenderowany finalny obraz sceny do pliku o wskazanej nazwie. Domyślnie proponuje taki sam format pliku rastrowego, jak Save Screenshot, ale można go zmienić w panelu Save As Image okna File Browser.
Szczegóły wyglądu i działania środowiska Blendera są wynikiem złożenia dwóch grup ustawień. Są to:
ustawienia „ogólne” z okna User Preferences. Są one zapisywane do pliku o nazwie userpref.blend gdy naciśniesz w tym oknie przycisk Save User Settings. Oznacza to, że te ustawienia nie są związane z jakimkolwiek aktualnym rysunkiem. Traktuj je jako konfigurację Twojej instalacji Blendera;
ustawienia „lokalne”, przechowywane w każdym pliku Blendera. Dotyczą one przede wszystkim interfejsu użytkownika: układ okien, alternatywnych układów ekranu (screen layouts). Gdy nie załadowałeś jeszcze żadnego pliku lub gdy tworzysz nowy plik poleceniem File→New, Blender wykorzystuje tzw. plik startowy, o nazwie startup.blend. (Stąd zawartość tego pliku decyduje, jak wygląda ekranu programu zaraz po uruchomieniu. Możesz ją nadpisać poleceniem File→ Save Startup File) ;
W pliku source.zip (por. str. 22) umieściłem foldery z konfiguracją Blendera, której używałem pisząc tę książkę. Możesz je wgrać tak, jak jest to pokazane na str. 772.
Jeżeli jednak nie czujesz się w takich operacjach na folderach zbyt pewnie, istnieje inna metoda. Otwórz w Blenderze (File→Open, por. str. 759) wzorcowy plik source\config\startup.blend. A potem w oknie User Preferences naciśnij przycisk Save User Settings i wywołaj polecenie File→Save Startup File, aby zachować także układ ekranu (Rysunek 12.4.1):
Rysunek 12.4.1 Przeniesienie ustawień z pliku startup.blend, dostarczonego z tą książką
I to wszystko! Kopia tego pliku, wraz z plikiem userpref.blend zostanie zapisana w Twoim profilu użytkownika jako aktualna konfiguracja Blendera. Dodatkowo możesz jeszcze zainstalować dodatki (add-ons), z których będziemy korzystać. (por. str. 790). Pliki tych dodatków umieściłem w katalogu source\scripts\addons.
Blender jest już skonfigurowany do dalszej pracy. Pierwszą różnicą, którą zapewne zauważyłeś, są jaśniejsze okna 3D View (Rysunek 12.4.1). Domyślne, ciemne tło z Blendera 2.5/2.6 źle wyglądało na ilustracjach dla tej książki. Dlatego zdecydowałem się używać schematu barw, do którego przywykłem, używając Blendera 2.4.
Abyś jednak wiedział, co i dlaczego jeszcze zmieniłem, przejdę przez kolejne sekcje okna User Preferences. Pokażę na nich, jakie ustawienia standardowe zostały zmienione.
W sekcji Interface — włączyłem View Manipulation: Rotate Around Selection (Rysunek 12.4.2). To ułatwi obracanie widoku wokół detali. Oprócz tego wyłączyłem Manipulator (to taki pomocniczy „gadżet” w oknie 3D View). Niektórzy uważają, że ułatwia manipulację obiektami w przestrzeni trójwymiarowej. Ja jednak należę do „starej szkoły” Blendera, która takiego udogodnienia nie znała:
Rysunek 12.4.2 Ustawienia Blendera — sekcja Interface
Jak pokazuje to Rysunek 12.4.2, w sekcji Interface możesz opcjonalnie przełączyć jeszcze parę innych opcji.
W sekcji Editing — włączyłem New Objects:Align to:View (Rysunek 12.4.3). Dzięki temu każdy obiekt, który stworzysz, powstanie w płaszczyźnie równoległej do aktualnego widoku. (Inaczej, aby odpowiednio zorientować nowo powstały element, musiałbyś go dodatkowo obracać).
Rysunek 12.4.3 Ustawienia Blendera — sekcja Editing
W sekcji Input — włączyłem opcję Emulate Numpad (Rysunek 12.4.4). Choć jest to praktyczne przede wszystkim dla notebooków, może okazać się przydatne także na tradycyjnych komputerach. (Pozwoli utrzymywać lewą rękę ponad centrum klawiatury, a nie przesuwać ponad całą jej szerokością).
Rysunek 12.4.4 Ustawienia Blendera — sekcja Input
Zwróć uwagę, że w tej sekcji możesz zmienić konfigurację skrótów poleceń Blendera (Rysunek 12.4.5):
Rysunek 12.4.5 sekcja Input — rozwinięta grupa poleceń Window
Dwa dodatkowe klawisze w nagłówku okna tej sekcji pozwalają także zapisywać i odczytywać skróty do poleceń z pliku (Rysunek 12.4.6):
Rysunek 12.4.6 Przyciski w nagłówku okna w sekcji Input
W sekcji Add-Ons (programowe rozszerzenia Blendera) włączyłem Dynamic Spacebar Menu (Rysunek 12.4.7):
Rysunek 12.4.7 Ustawienia Blendera — sekcja Add-Ons
W sekcji Themes, jak już o tym wspominałem, pozmieniałem kolory widoku 3D View (Rysunek 12.4.8):
Rysunek 12.4.8 Ustawienia Blendera — sekcja Themes
Sekcja File zawiera domyślne ścieżki, na których Blender ma poszukiwać różnych rodzajów plików. Niczego w niej nie musiałem zmieniać. (Rysunek 12.4.9):
Rysunek 12.4.9 Ustawienia Blendera — sekcja File
Wreszcie sekcja System (Rysunek 12.4.10). Tu także niczego nie zmieniałem:
Rysunek 12.4.10 Ustawienia Blendera — sekcja System
Przy okazji omawiania sekcji System wspomnę o pewnym udogodnieniu. W domyślnej konfiguracji Blendera wysunięcie przybornika z boku okna 3D View powoduje zmniejszenie wyświetlanego obrazu (Rysunek 12.4.11):
Rysunek 12.4.11 Pomniejszanie obrazu przy otwarciu przybornika
Mówiąc szczerze, niezbyt lubię ten efekt. Na szczęście w Blenderze 2.66 pojawiła się alternatywa: zaznacz w zakładce System opcję Region Overlap i przełącz Window Draw Method na Triple Buffer (Rysunek 12.4.12):
Rysunek 12.4.12 Zmiana parametrów w sekcji User Preferences:System
W rezultacie tło przyborników stało się półprzejrzyste, i teraz „wysuwają się” ponad obrazem (Rysunek 12.4.13):
Rysunek 12.4.13 Półprzeźroczyste tło przybornika, zachowujące oryginalny rozmiar obrazu
W stosunku do oryginalnej wersji Blendera, wprowadziłem także parę zmian w domyślnym układzie ekranu. Nie było to niezbędne, ale często łapałem na tym, że ciągle w ten sam sposób poprawiam zawartość nowo utworzonego rysunku. Po co? Zapisałem raz poprawiony plik jako domyślny, i w ten sposób oszczędziłem sobie ciągłej roboty (Rysunek 12.4.14):
Rysunek 12.4.14 Trzy widoki robocze
Zwróć uwagę, że usunąłem ze sceny “pudełko”, które Blender domyślnie umieszcza pośrodku sceny. (Zawsze pierwszą rzeczą, którą robiłem, było pozbycie się tego obiektu). Przesunąłem także obiekty związane wyłącznie z renderingiem — kamerę i lampę — na warstwę 20 (Rysunek 12.4.15):
Rysunek 12.4.15 Warstwa obiektów związanych z renderingiem: kamery i lampy
To taka moja konwencja — oczywiście, możesz to sobie zorganizować inaczej.
Gdy choć raz wywołasz w Blenderze polecenie File→Save Startup File, lub naciśniesz w oknie User Preferences przycisk Save User Settings, Blender zapisze w Twoim profilu użytkownika zmienioną konfigurację. Stosunkowo trudno znaleźć folder, zawierający te dane. Jest tworzony (przynajmniej w Windows) w ukrytym katalogu Application Data. W różnych wersjach Windows Application Data znajduje się w różnych miejscach profilu użytkownika. W dodatku Eksplorator Windows w każdej wersji językowej systemu wyświetla nazwę tego folderu w lokalnym języku (podobnie jak My Documents) co pogłębia zamieszanie. (Nawet gdybym podał ścieżkę do tego folderu dla każdej wersji Windows, część użytkowników i tak by go nie znalazła).
Zamiast tego przygotowałem w pliku source.zip (por. str. 22) skrót Blender configuration. Wykorzystuje zmienną środowiskową Windows (APPDATA) by otworzyć w Eksploratorze Windows Twój folder z konfiguracją Blendera (Rysunek 12.5.1):
Rysunek 12.5.1 Otwarcie folderu na konfiguracje Blendera
Każda z wersji Blendera przechowuje tu swoje pliki w oddzielnym katalogu (Rysunek 12.5.1). Dzięki temu możesz z nich korzystać jednocześnie (np. aby sprawdzić, jak coś działało poprzednio). Gdy instalujesz nową wersję programu, przy pierwszym uruchomieniu Blender proponuje skopiowanie konfiguracji z wersji poprzedniej (por. str. 24).
Wewnątrz katalogu każdej wersji znajdują się dwa podfoldery:
config\: zawiera dwa ważne pliki (Rysunek 12.5.2) Pierwszy z nich nazywa się userpref.blend. Są w nim przechowywane wszelkie ustawienia z okna User Preferences, zapisane przyciskiem Save User Settings. Drugim plikiem jest startup.blend. Zawartość tego pliku Blender wyświetla bezpośrednio po uruchomieniu, lub gdy wybierzesz polecenie File→New. Plik startup.blend determinuje m.in. domyślny układ ekranu Blendera Możesz go zastąpić jakimś bieżącym rysunkiem, wywołując polecenie File→Save Startup File.
scripts\addons\: w podfolderze addons Blender przechowuje dodatki (add-ons) zainstalowane przez użytkownika (Rysunek 12.5.3, por. także str. 790). Dzięki temu są przenoszone z całą konfiguracją przy aktualizacji do nowej wersji programu.
W operowaniu konfiguracją Blendera nie ma żadnej „ukrytej magii” . Wystarczy zmieniać odpowiednie pliki. Na przykład, instalację grupy dodatków (add-on), możesz wykonać na dwa sposoby:
łatwy: używając GUI Blendera (tak jak to jest opisane na str. 790) — ale wtedy musisz wgrywać po kolei każdą wtyczkę;
zaawansowany: jednym ruchem skopiować wszystkie pliki wtyczek do podkatalogu scripts\addons\ folderu z konfiguracją Blendera. Wymaga to tylko wiedzy, gdzie ten folder się znajduje, i za pierwszym razem należy po prostu tam założyć takie podkatalogi;
Podobnie możesz się przełączać pomiędzy się różnymi konfiguracjami Blendera — wystarczy przechowywać pod inną nazwą lub w innym miejscu alternatywne pliki userpref.blend i startup.blend. Gdy skopiujesz do folderu config\ ich nowe wersje — Blender posłuży się nimi przy najbliższym uruchomieniu .
Abyś mógł podążać za przykładami, umieszczonymi w tej książce, w pliku source.zip dostarczyłem podkatalogi config i scripts z odpowiednią konfiguracją Blendera. Na wszelki wypadek najpierw skopiuj wszystkie pliki z Twoją oryginalną konfiguracją w jakieś inny miejsce. Potem po prostu przenieś odpowiednie te dwa podkatalogi z source.zip do folderu z konfiguracją Twojej aktualnej wersji Blendera (Rysunek 12.5.4):
Rysunek 12.5.4 Przeniesienie konfiguracji Blendera, wymaganej dla tej książki
Aby wstawić do aktualnej sceny obiekty z innego pliku, wybierz polecenie File→Append (Rysunek 12.6.1a). Alternatywnie możesz nacisnąć na klawiaturze Shift-F1 — to skrót do tego polecenia:
Rysunek 12.6.1 Polecenie - import elementów innego pliku
Na ekranie pojawi się okno wyboru plików (Rysunek 12.6.1b). Przejdź w nim do folderu z plikiem, z którego coś chcesz wczytać. W naszym przypadku to pilot.blend (Rysunek 12.6.2)
W trybach Append lub Link możesz w oknie wyboru pliku wejść „do środka” rysunku Blendera, jak gdyby był podkatalogiem(klikając LPM). W środku zobaczysz „foldery” (Rysunek 12.6.3a):
Rysunek 12.6.3 Wybór elementów do importu
Te „foldery” to klas obiektów, przechowywanych w rysunku Blendera. To taka konwencja - zawartość każdego pliku *.blend jest wyświetlana, jak gdyby jej struktura była przedłużeniem struktury katalogów i plików na dysku.
Przejdź do folderu Object (zazwyczaj importujemy obiekty — Blender sam zadba o to, by przeniosły się za nimi wszystkie siatki, materiały i tekstury). W środku zobaczysz wszystkie obiekty, znajdujące się w pliku pilot.blend (Rysunek 12.6.3b). Aby ułatwić wybór, elementom składającym się na model pilota nadałem przedrostek „000.”. Pozaznaczaj je, klikając w każdy LPM. Potem naciśnij przycisk Link/Append from Library.
W efekcie pilot znajdzie się w aktualnej scenie Blendera (Rysunek 12.6.4):
Rysunek 12.6.4 Model pilota, wczytany do aktualnej sceny
Użyliśmy tu polecenia Append, które wstawia do aktualnego pliku kopie wybranych elementów. Gdybyś wybrał alternatywne polecenie Link — do aktualnej sceny wstawione zostałyby tylko „odsyłacze” (referencje) do obiektów umieszczonych we wskazanym pliku Blendera (w tym przykładzie byłby to pilot.blend). Możesz w ten sposób wykorzystywać pewne pliki *.blend jako biblioteki. Przechowywałbyś w nich wzorce elementów wykorzystywanych w wielu różnych projektach. Gdybyś zmienił definicję takiego „odsyłacza” — uległby zmianie wszędzie tam, gdzie jest użyty. Podłączać w ten sposób możesz nie tylko całe obiekty, ale — na przykład — same siatki. Wymaga to jednak przemyślanej struktury projektu. Poza tym — nie można modyfikować takich „podłączonych” elementów tam, gdzie są użyte. W praktyce często kończy się to i tak stworzeniem ich lokalnej kopii.
W tej sekcji opiszę sposób „awaryjnego” odzyskiwaniu pliku. Uczciwie mogę powiedzieć, że przez długi czas (pierwszych 7-8 miesięcy pracy) Blender zachowywał mi się bardzo stabilnie. Na palcach jednej ręki mógłbym policzyć sytuacje, gdy straciłem choć trochę pracy z powodu niespodziewanego zakończenia przez błąd w programie. Potem, gdy model przekroczył ok. 500 tys. ścian, a ja zacząłem używać różnych zaawansowanych funkcji, bywało, że czasami Blender mi się nagle „wysypał”. W każdym razie – istnieje pewien sposób, pozwalający odzyskać choć część pracy od ostatniego zapisu.
W oknie User Preferences przejdź do sekcji File (Rysunek 12.7.1):
Rysunek 12.7.1 Włączenie automatycznego zapisu
Ważne są tu dwie kontrolki:
Opcja Auto Save Temporary Files: moja rada: pozostaw ją zawsze włączoną, jak na ilustracji;
Pole numeryczne Timer: tu wpisz, co ile minut ma być zachowywany stan pliku;
Gdy Blender nagle zgłosił „fatalny” błąd i został zamknięty przez system operacyjny, nie popadaj w rozpacz. Jeżeli miałeś włączony Auto Save, możesz jeszcze odzyskać swoją pracę. Uruchom ponowie Blender, a następnie wywołaj polecenie File→Recover Auto Save (Rysunek 12.7.2):
Rysunek 12.7.2 Przejście do odzyskiwania pliku
Blender otworzy wówczas w oknie wyboru plików Twój folder tymczasowy (Rysunek 12.7.3):
Rysunek 12.7.3 Wybór pliku do odzyskania
Dużo tutaj plików Blendera, prawda? I w dodatku nazwy wszystkich to jakieś niezrozumiałe, numeryczne nazwy! To właśnie efekty automatycznego zachowywania. Blender zapisuje plik pod nazwą, która jest tzw. „identyfikatorem procesu” (ang. process ID — skrót: PID). Co prawda — nie wiesz, jaki numer procesu miała sesja Blendera, która zakończyła się tym fatalnym błędem. Nie przejmuj się jednak tym: znajdziemy potrzebny plik, posługując się czasem jego modyfikacji. Włącz w nagłówku okna wyświetlanie szczegółów opisu plików (Rysunek 12.7.3). Następnie uporządkuj je malejąco według daty. Przypuszczalnie pierwszy od góry plik pochodzi z ostatnich kilkunastu minut — i to jest ten, którego szukamy! Zaznacz go (kliknięciem) i otwórz w Blenderze. Gdy się przekonasz, że to jest właściwy rysunek, zapisz go pod inną nazwą w tym samym folderze, w którym trzymasz poprzednie wersje swoich prac. Potem po prostu pracuj dalej. Robiłem tak niejeden raz. Pliki, odzyskane w ten sposób, są zupełnie normalne — bez żadnych luk w danych, czy skaz w zapisie.
Kursor 3D (3D Cursor) jest w Blenderze specjalnym punktem w przestrzeni. Wyznacza “aktualną pozycję”, która jest używana podczas dodawania do sceny nowych obiektów. Może być także wykorzystany jako punkt odniesienia podczas obrotu, zmiany skali, lub odbicia lustrzanego (Mirror).
Położenie kursora 3D jest oznaczane niewielkim krzyżem, otoczonym czerwono-białą obwódką (Rysunek 12.8.1):
Rysunek 12.8.1 Kursor 3D na scenie
Kliknięcie LPM można traktować jako pierwszą, przybliżoną metodę wskazania położenia kursora. Z oczywistych przyczyn nie jest specjalnie dokładnie. Potem możesz zawsze dosunąć kursor do najbliższego węzła “kratki pomocniczej” (grid), która jest naniesiona na płaszczyznę widoku. Naciśnij w tym celu Shift-S (Object→Snap), i wybierz z menu Snap polecenie Cursor to Grid (Rysunek 12.8.2):
Rysunek 12.8.2 Dosunięcie kursora do węzła siatki pomocniczej (grid)
W podobny sposób możesz także wybrać polecenie Cursor to Selected. W trybie obiektu (Object Mode) kursor zostanie umieszczony w środku (tzn. punkcie odniesienia) aktualnie zaznaczonego obiektu. W trybie edycji siatki (Edit Mode) kursor przesunie się do aktualnie zaznaczonego wierzchołka
Podczas modelowania prawie przez cały czas używam kursora 3D.
Polecenie Snap→Cursor to Selected, w połączeniu ze zmianą skali do zera (często tylko wzdłuż jednej osi) pozwala szybko ustawić obiekty lub wierzchołki dokładnie w takim położeniu, jakie jest potrzebne.
Przykład wykorzystania kursora 3D do dokładnego pozycjonowania obiektów znajdziesz na str. 881, a wierzchołków — na str. 897.
Dokładne położenie kursora 3D można także po prostu wpisać. Wywołaj przybornik Properties (N, albo View→Properties). W przyborniku, w panelu 3D Cursor znajduje się sekcja Location (Rysunek 12.8.3):
Rysunek 12.8.3 Ustalanie położenia kursora w przyborniku Properties:View
Możesz z niej bezpośrednio odczytać lub wpisać liczbowe wartości współrzędnych X, Y, Z kursora.
Warto wspomnieć o jeszcze jednej możliwości. Pokażę ją na przykładzie modelu walca (Rysunek 12.8.4):
Rysunek 12.8.4 Przykładowy model walca
Gdy klikniesz gdzieś w oknie 3D View LPM, Blender umieści tam kursor 3D, nie zmieniając jednak jego położenia wzdłuż osi prostopadłej do ekranu (Rysunek 12.8.5):
Rysunek 12.8.5 Zwykłe przenoszenie kursora 3D za pomocą myszki
Włącz jednak oknie User Preferences włączysz opcję Cursor Depth (Rysunek 12.8.6, por. także str. 765, Rysunek 12.4.2):
Rysunek 12.8.6 Włączenie opcji Auto Depth
Wówczas, gdy klikniesz LPM w jakieś miejsce na powierzchni modelu, kursor zostanie umieszczony tuż ponad jego powierzchnią (Rysunek 12.8.7):
Rysunek 12.8.7 Przenoszenie kursora 3D z włączoną opcją Cursor Depth
Niestety, w tym trybie kursor nigdy nie jest umieszczany dokładnie na powłoce klikniętej siatki. W dodatku jego odległość od ściany wydaje się zależeć od kąta pochylenia do płaszczyzny widoku. Wydaje mi się, że ten brak dokładności praktycznie uniemożliwia wykorzystanie tego trybu do modelowania konstrukcji, takich jak samolot.
Podczas budowy modelu prezentowanego w tej książce, tryb Cursor Depth był wyłączony.
Zdecydowałem się jednak wspomnieć o tej opcji. Nie mogę bowiem wykluczyć, że przy innym stylu pracy może okazać się bardzo przydatna.
Aby podstawić plany samolotu jako tło, scal najpierw wszystkie okna 3D View w jedno (Rysunek 12.9.1). Następnie otwórz przybornik Properties (N). Włącz w niej panel Background Images:
Rysunek 12.9.1 Przygotowanie do ustawiania tła okna 3D View
Następnie naciśnij przycisk Add Image (Rysunek 12.9.1). W panelu pojawi się nowa sekcja, początkowo bez obrazu (Not Set — Rysunek 12.9.2):
Rysunek 12.9.2 Wczytanie obrazu z rzutem samolotu
Przypisz tej sekcji obraz (przyciskiem Open). Ustaw też oś widoku (Axis) , odpowiednio do wczytanego obrazu.
W środku układu współrzędnych widoku 3D powinieneś zobaczyć załadowany obraz (Rysunek 12.9.3). (Jeżeli miałeś włączone duże powiększenie, obraz może być mały):
Rysunek 12.9.3 Wczytany obraz
Jeżeli na swoim ekranie nie widzisz obrazu w tle okna 3D View, sprawdź:
czy masz włączony widok z tej samej strony, jaki wybrałeś z listy Axis (por. Rysunek 12.9.2)? Jeżeli nie — ustaw go;
czy widzisz na ekranie środek układu współrzędnych (przecięcie dwóch kolorowych osi)? Jeżeli nie — naciśnij Home, aby go zobaczyć;
czy masz ustawione odpowiednie powiększenie? (Obraz może być obecnie zbyt mały, abyś go zobaczył). Spróbuj zmienić powiększenie;
Blender domyślnie ustawia rozmiar wczytanego rysunku (Size) na 5.0 jednostek, a jego środek umieszcza w centrum układu współrzędnych (Rysunek 12.9.3). Wartość, wpisywana w pole Size, określa rozmiar połowy szerokości obrazu. Zakładając, że 1 jednostka Blendera to 10 cm rzeczywistego samolotu, powinniśmy zwiększyć Size do 50.0. (Długość kadłuba P-40C wynosiła 967cm, a nasz cały obraz będzie się w tej skali rozciągał na niewiele więcej — 100 jednostek, czyli 1000cm). Jednocześnie przesuń obraz (wartości X, Y) tak, by oś kadłuba pokryła się z osią Y, a czubek kołpaka śmigła dotykał osi Z (Rysunek 12.9.4).
Rysunek 12.9.4 Obraz tła — wyrównanie do dokładnego ustalenia rozmiaru
Najłatwiej jest posługiwać się tu polami X i Y jak suwakami — przesuwając myszkę (z LPM) ponad taką kontrolką (por. str. 100). Możesz wtedy obserwować, jak dynamicznie przesuwa się obraz tła.
Zwróć uwagę, że kontrolki X i Y z panelu Background Images to lokalne współrzędne obrazu, a przestrzeni widoku. Warto także uczynić obraz tła częściowo przejrzystym, by było widać umieszczoną pod spodem siatkę. Służy do tego suwak Opacity (Rysunek 12.9.4).
Aby wyznaczyć punkt, do którego ma sięgać koniec kadłuba samolotu, w panelu View ustaw 3D Cursor Location na współrzędne: X = 0.0, Y = 96.7 (odpowiada 967 cm rzeczywistej długości kadłuba), Z = 0.0. Spowoduje to pojawienie się kursora 3D w odpowiednim miejscu na osi Y (Rysunek 12.9.5). (Potem możesz zmienić współrzędną Z na nieco większą, by kursor znalazł się dokładnie tam, gdzie leży koniec kadłuba — trochę ponad osią Y).
Rysunek 12.9.5 Przymiarki do ustalenia końca kadłuba
Teraz ustaw w panelu Background Images trochę mniejszą wartość Size — aby krawędź steru kierunku przybliżyć na mniej więcej połowę początkowego dystansu, wyznaczonego przez kursor 3D (Rysunek 12.9.6a):
Rysunek 12.9.6 Dopasowywanie rysunku tła do zadanych wymiarów
Pamiętaj, że zmiana rozmiaru zachodzi względem środka obrazu — w obydwu kierunkach! Po każdej zmianie skali przesuń się w pobliże środka układu współrzędnych. Zobaczysz tam, że nos samolotu z obrazu uległ odsunięciu w prawo (Rysunek 12.9.6b). Musisz to skorygować przesunięciem obrazu w lewo (zmianą współrzędnej X). Następnie znów zajrzyj na koniec kadłuba, i powtórnie zmień skalę tak, by znów zmniejszyć dystans pomiędzy krawędzią steru i kursorem 3D o połowę. Potem znów to skoryguj przesunięciem (kontrolką X) nosa w lewo. Po kilku takich przybliżeniach powinieneś osiągnąć założone położenie rzutu z lewej (Rysunek 12.9.7):
Rysunek 12.9.7 Rysunek dopasowany
Po wyskalowaniu obrazu pozostaje przesunąć go w docelowe położenie. W praktyce końcówka nosa samolotu nie jest najlepszą powierzchnią odniesienia. Proponuję ustawiać obrazy tak, by przez środek układu współrzędnych przechodziła jakaś inna, “ważniejsza” dla konstrukcji powierzchnia. Użyjmy do tego celu podstawowej wręgi kadłuba, do której były zamocowane: silnik i przedni dźwigar płata1. Przesuń obraz (zmieniając wartość X obrazu) tak, by środek układu współrzędnych znalazł się w tym miejscu (Rysunek 12.9.8):
Rysunek 12.9.8 Ostateczne położenie obrazu tła — ściana ogniowa będzie powierzchnią bazową
Po widoku z boku załaduj widok z góry i dopasuj go do rozpiętości skrzydeł. Potem dostosuj współrzędną Y tego obrazu tak by dopasować początek i koniec kadłuba. Przypisz odpowiednią oś (Axis) do każdego widoku.
Uwaga: wartość Size dotyczy dłuższego boku każdego obrazu, więc będzie inna dla rzutów z boku, i inna dla rzutów z góry/dołu!
W tym przykładzie posługiwałem się rysunkami P-40, których przygotowanie opisałem w pierwszej części tej książki (Rozdział 2 i Rozdział 18). Jeżeli jednak chcesz już skorzystać ze zweryfikowanych rysunków, użyj planów z pliku source.zip (por. str. 22). W jego podkatalogu source\plans znajdziesz dwa pełne zestawy rzutów P-40B. Rysunek 12.9.9 przedstawia okno z przypisanymi wszystkimi widokami z zestawu p40b-lowres\:
Rysunek 12.9.9 Okno z zestawem obrazów przypisanym do każdego widoku (zestawu planów do tej książki)
Nadałem tym planom odcień pomarańczowy, by odróżniały się od domyślnej szarości modelowanych siatek.
Gdy wszystkie widoki samolotu są już przypisane do okna, podziel je na kilka rzutów, których będziemy używać podczas modelowania (Rysunek 12.9.10):
Rysunek 12.9.10 Układ ekranu po ostatecznym podziale
Zwróć uwagę, że Blender będzie podstawiał pod ekran obraz tła tylko wtedy, gdy wybierzesz jeden z widoków ortogonalnych: z lewej, z prawej, z góry, z dołu… (Decyduje o tym przypisana obrazowi oś Axis).
Na słabszych komputerach lepiej jest stosować wersje obrazów o mniejszej rozdzielczości, bo wtedy wszystkie polecenia Pan i Zoom działają szybciej. Zestaw takich obrazów znajdziesz w folderze plans\p40b-lowres\. Mała rozdzielczość wiąże się jednak z pewnym mankamentem: zanikaniem lekko ukośnych linii (Rysunek 12.9.11):
Rysunek 12.9.11 Problem z lekko ukośnymi liniami na obrazach o małej rozdzielczości
Możesz to jednak na chwilę skorygować — wystarczy że w panelu obrazu wskażesz plik z wersją o wyższej rozdzielczości (Rysunek 12.9.12). Potem w ten sam sposób z powrotem przestaw go na wersję lowres\.
Rysunek 12.9.12 Przełączenie na obraz o większej rozdzielczości
Na zakończenie chciałbym wspomnieć o innej metodzie „podstawienia” rysunków samolotu. Zamiast obrazów tła można w tym celu wykorzystać obiekty typu Empty (por. str. 816), którym przypiszesz odpowiednie obrazy (Rysunek 12.9.13):
Rysunek 12.9.13 Alternatywne rozwiązanie — podstawienie obrazów samolotu za pomocą trzech obiektów typu Empty
Tak wyświetlane obrazy lepiej wyglądają w mniejszych powiększeniach (Rysunek 12.9.14):
Rysunek 12.9.14 Obrazy wyświetlane w obiektach Empty lepiej wyglądają w mniejszych powiększeniach
Jednak gdy powiększysz obraz tła (Rysunek 12.9.14b) do projekcji w której zazwyczaj formujesz elementy modelu, stanie się tak samo ostry i wyraźny jak obraz wyświetlany przez obiekt Empty.
Obrazy wyświetlane przez obiekty Empty mają jednak inną wadę: nie są przejrzyste! Popatrz na model kołpaka śmigła, przedstawiony przez Rysunek 12.9.15a):
Rysunek 12.9.15 Obrazy Empty zasłaniają modelowany obiekt
Stworzyłem go w oparciu o rzut z boku (Rysunek 12.9.15a). Potem obróciłem trochę widok, aby sprawdzić, jak wygląda w przestrzeni (Rysunek 12.9.15b). Jednak gdy chciałem go zobaczyć z przodu — płaszczyzna z obrazem skutecznie go zasłoniła (Rysunek 12.9.15c). Można to jednak częściowo skompensować, zmieniając wartość parametru Transparency we właściwościach obiektu Empty (por. Rysunek 12.9.13).
Innym problemem może także być wydajność — szczególnie gdy zdecydujesz się przez cały czas używać obrazów o wyższej rozdzielczości. O ile obrazy wyświetlane jako Background Image pojawiają się tylko wtedy, gdy włączysz „ich” rzut, to obrazy związane z obiektami Empty są rysowane przez cały czas — także w widoku przestrzennym, kiedy są raczej bezużyteczne.
Oczywiście, można ten problem rozwiązać umieszczając obiekty Empty na oddzielnej warstwie, którą będziesz w razie potrzeby wyłączał. Po co jednak to robić, skoro Background Image oferuje tę funkcjonalność „w standardzie”?
Uważam, że w praktyce modelowania lepiej się sprawdza podstawiania rysunków referencyjnych za pomocą funkcji Background Image. Opisałem je jednak tutaj, gdyż możesz mieć inny styl pracy, lub po prostu preferować taką formę prezentacji, jaką oferują obrazy wyświetlane za pomocą obiektów Empty.
Background Image pomaga także w kompozycji sceny: zdjęcie tła można zamapować w trybie Camera (Rysunek 12.9.16):
Rysunek 12.9.16 Nałożenie zdjęcia tła w trybie Background Image:Camera
Blender domyślnie proponuje kilka różnych układów ekranu, przygotowanych do różnych faz pracy nad projektem. Możesz się pomiędzy nimi przełączać za pomocą listy Screen lay-out (Rysunek 12.10.1a):
Rysunek 12.10.1 Lista Screen lay-out: Zespół kontrolek do zarządzania układem ekranu
Lista układów ekranów (Rysunek 12.10.1b) to jednocześnie dobry przykład typowej kontrolki Blendera do zarządzania referencjami tzw. bloków danych (np. materiałami, teksturami, itp.)1. Po wybraniu z listy Screen lay-out np. układu do pracy nad teksturami (UV Editing) , zobaczysz zupełnie inne okna (Rysunek 12.10.2):
Rysunek 12.10.2 Inny układ ekranu — (UV Editing)
Jeżeli nie jesteś zadowolony z domyślnych ustawień Blendera — możesz tu wszystko pozmieniać. Oprócz zmiany istniejącego układu, istnieje możliwość dodania nowego. Wystarczy nacisnąć przycisk , umieszczony z lewej strony okna (Rysunek 12.10.3a):
Rysunek 12.10.3 Dodanie własnego układu ekranu
Potem możesz już go pozmieniać, jak chcesz (Rysunek 12.10.4):
Rysunek 12.10.4 Nowy układ ekranu: Modeling
Nowy układ już figuruje na liście (Rysunek 12.10.5). Oczywiście, jeżeli nie będziesz zadowolony ze swojego układu — zawsze możesz go usunąć, naciskając przycisk , umieszczony po prawej stronie listy Screen lay-out. Gdy to zrobisz, znajdziesz się w poprzednim układzie (w tym przykładzie byłby to „Default”).
Blender przed usunięciem układu ekranów nie zadaje żadnego pytania typu „jesteś pewien?”. Usuwa i już!
Układy ekranów są zapamiętywane oddzielnie w każdym pliku Blendera. Dlatego np. w pliku pochodzącym z Blendera 2.4 będą miały inne nazwy, niż pokazane na ilustracjach w tym przykładzie. Aby stworzyć układ, którego będziesz używać we wszystkich swoich rysunkach, musisz zapisać go do pliku startowego, poleceniem File→Save User Settings (por. str. 764).
Benderowi towarzyszy dużo dodatków1, rozszerzających jego funkcjonalność. Są to skrypty napisane w języku programowania Python, zazwyczaj przez samych użytkowników. Dodatki to zazwyczaj niewielkie pliki z rozszerzeniem *.py. Oprócz tych, które są dostarczane wraz z Benderem, możesz znaleźć inne np. na forach Blendera w Internecie. Także do tej książki dodałem kilka narzędzi, które wykorzystuję od lat i uważam za bardzo przydatne i godne polecenia (znajdziesz je w pliku source.zip, w scripts\addons — por. str. 22). Instalacja dodatku Blendera może polegać po prostu na wgraniu pliku wtyczki do odp. podkatalogu w folderze z konfiguracją programu (por. str. 771). Jeżeli jednak nie czujesz się w tej materii zbyt pewnie, pokażę tutaj inną, mniej „hakerską” metodę. W oknie User Preferences, sekcji Add-Ons, naciśnij przycisk Install Add-On… (Rysunek 12.11.1):
Rysunek 12.11.1 Wywołanie instalacji dodatku (okno User Preferences)
Blender wyświetli wówczas okno File Browser. Przejdź w nim do katalogu, w którym umieściłeś dodatki do zainstalowania, wskaż jeden z nich, i naciśnij przycisk Install Add-On (Rysunek 12.11.2):
Rysunek 12.11.2 Wybór pliku skryptu do zainstalowania
W oknie File Browser wskazuj zawsze tylko jeden skrypt! Choć Blender w tym oknie pozwala zaznaczyć wiele plików dodatków, to zainstaluje tylko jeden – ten, który zaznaczyłeś jako ostatni.
Dodatek jest już zainstalowany. Abyś ją dostrzegł wśród innych, Blender przełączył wyświetlane kategorie na All i w polu filtra wpisał jego nazwę (Rysunek 12.11.3):
Rysunek 12.11.3 Wygląd okna User Preferences po zainstalowaniu dodatku (Handle Panel)
W razie czego nie bądź przerażony, że z Blendera znikły wszystkie pozostałe dodatki. Wystarczy usunąć filtr (Rysunek 12.11.4):
Rysunek 12.11.4 Wygląd okna User Preferences po usunięciu filtra
Aby usunąć dodatek z Blendera, po prostu naciśnij jej przycisk Remove (Rysunek 12.11.5):
Rysunek 12.11.5 Usuwanie dodatku
Plik Blendera może zawierać wiele scen. Każda z nich to odrębna “przestrzeń”, w której można umieszczać obiekty (więcej na ten temat — str. 1219). Domyślnie w nowym rysunku istnieje tylko jedna, o nazwie Scene. Do zarządzania scenami służy zespół kontrolek umieszczony w nagłówku okna Info (Rysunek 12.12.1). Składa się z pola, pokazującego nazwę aktualnej sceny, przycisku rozwijającego listę scen, oraz przycisku usuwającego aktualną scenę.
Aby zmienić nazwę aktualnej sceny, kliknij LPM w jej nazwę, i wpisz nową (Rysunek 12.12.1):
Rysunek 12.12.1 Zmiana nazwy aktualnej sceny
Aby stworzyć nową scenę, naciśnij przycisk , umieszczony z prawej strony nazwy (Rysunek 12.12.2):
Rysunek 12.12.2 Dodanie nowej sceny
Spowoduje to pojawienie się menu New scene, z którego możesz wybrać jedną z opcji:
New: tworzy nową, pustą scenę (z globalnymi ustawieniami jak w pliku startowym);
Copy Settings: tworzy nową, pustą scenę, kopiując globalne ustawienia ze sceny aktualnej;
Link Objects: wypełnia nową scenę referencjami do obiektów z aktualnej sceny. (Ten sam obiekty będzie “użyty” przez obydwie sceny. Więcej na ten temat — str. 1219);
Link Object Data: tworzy w nowej scenie kopie obiektów z aktualnej sceny, które współdzielą z obiektami aktualnej siatki, materiały, itp. (To tak, jak gdybyś wszystkie powielił poleceniem Alt-D — Duplicate Linked — str. 823);
Full Copy: cała zawartość nowej sceny będzie niezależną kopią aktualnej;
W praktyce stosuję zazwyczaj opcję Copy Settings (pojedyncze obiekty można później dodać do innej sceny poleceniem Object→Make Links→To Scene). Nowa scena otrzyma taką nazwę, jak scena oryginalna, z dodanym na końcu “.001”. Zmień ją na właściwą.
Aby usunąć aktualną scenę, naciśnij przycisk [x] z prawej strony nazwy (Rysunek 12.12.3):
Blender nie zadaje już żadnego pytania „czy jesteś pewien”: po naciśnięciu przycisku [x] scena znika. Jeżeli usunąłeś ją przez pomyłkę — możesz się z tej operacji wycofać, wywołując polecenie Undo (Ctrl-Z)
Kontrolka służąca do ustalania koloru jest w Blenderze niewielkim prostokątnym polem. Aby zmienić kolor, który wyświetla, kliknij w nią LPM (Rysunek 12.13.1):
Rysunek 12.13.1 Kontrolka w trybie RGB | Rysunek 12.13.2 Kontrolka w trybie HSV |
Spowoduje to rozwinięcie chwilowego okna (menu?) z zestawem kontrolek służących do zmiany barwy. W górnej części okna znajduje się koło braw i pasek intensywności. Wykorzystaj je do ustalenia koloru za pomocą myszki. Jeżeli jednak chcesz wpisać dokładną wartość numeryczną — możesz skorzystać z zestawu pól umieszczonych poniżej. Blender oferuje trzy tryby wpisywania wartości koloru: RGB, HSV, i Hex. W trybie RGB (Rysunek 12.13.1) możesz zmieniać wprost intensywności składników R, G, B barwy. Są one tu wyrażone jako liczby z zakresu od 0.0 do 1.0. Niezależnie od tego, którego zestawu kontrolek użyjesz, Blender na bieżąco aktualizuje pole z którego rozwinęliśmy to okno, wyświetlając tam bieżący kolor.
Parametry z zestawu HSV są alternatywną metodą opisu koloru (Rysunek 12.13.2):
H (Odcień — ang. Hue): determinuje barwę. Ta wartość odpowiada poruszaniu się „wzdłuż spektrum barw”, czyli w naszym przypadku po obwodzie koła pokazywanego przez Rysunek 12.13.2;
S (Nasycenie — ang. Saturation): Wartość 0.0 to zupełny brak barwy (wszystko jest w odcieniach szarości), a 1.0 — czyste barwy. Ta wartość odpowiada przesuwaniu punktu wzdłuż promienia koła barw (Rysunek 12.13.2);
V (Intensywność — ang. Value): determinuje „jasność” barwy (widać ją na suwaku po prawej);
Czasami wygodniej jest po prostu wskazać jakąś istniejącą barwę. Służy do tego przycisk z „pipetką”. Gdy klikniesz w niego myszką, okno zniknie, a kursor zmieni postać (Rysunek 12.13.3):
Rysunek 12.13.3 Podstawienie barwy wskazanego piksela ekranu
Końcówką tej „pipetki” kliknij w dowolne miejsce ekranu, a w polu kontrolki pojawi się jego kolor.
Wreszcie ostatni tryb określania barwy: Hex (heksadecymalny — por. str. 1253). Przydaje się, gdy chcesz np. przenieść kolor z innego programu, np. z GIMP (tam to się nazywa HTML notation — por. str. 651, Rysunek 10.26.4). Kopiujesz w nim do schowka 6-znakowy kod barwy, a następnie wklejasz w tym trybie do okna Blendera (Rysunek 12.13.4):
Zwróć uwagę, że np. kolor materiału, przypisany do obiektu, jest w oknie View 3D ciemniejszy niż na kontrolce. To przede wszystkim wpływ domyślnego oświetlenia OpenGL, używanego przez Blender w trybie Viewport Shading:Solid (por. str. 768, Rysunek 12.4.10).
Inną przyczyną może być także brak tzw. „korekty gamma” . Pod tą tajemniczą nazwą kryje się proces lepszego dopasowania zakresu wyświetlanych barw do czułości ludzkiego oka. Blender od wersji 2.64 wyświetla barwy stosując taką korektę.
Jest to ustawione w panelu Color Management zestawu Scene (Rysunek 12.13.5a). Gdy opcja Display Device jest ustawiona na wartość sRGB, wówczas wyświetlane kolory ulegną rozjaśnieniu. Ten tryb to nieliniowa konwersja intensywności wejściowej barwy (Rysunek 12.13.5b) poprzez krzywą gamma (Rysunek 12.13.5c) na barwę wyświetlaną (Rysunek 12.13.5d):
Rysunek 12.13.5 Efekt korekty gamma (sRGB): nieliniowe rozjaśnianie barw
Należy pamiętać, że ta konwersja działa także w drugą stronę. Gdy wkleisz do okna koloru w trybie Hex tekst „808080”, odpowiadający mieszance 50% czerni i bieli, to w trybie sRGB Blender wcale nie przyjmie dla niego wartości R=G=B=0.5, jak można by się było spodziewać (por. str. 1246). Zamiast tego zobaczysz R=G=B=0.216 (por. Rysunek 12.13.5b). I mimo to wyświetlany w kontrolce kolor dokładnie odpowiada temu, który uzyskasz dla kodu hex. „808080” w GIMP! Dlaczego? Bo korekta gamma jest wbudowana w system operacyjny. I Windows, i Linux używają takiej samej krzywej sRGB. Dla większej części jej zakresu (gdzieś tak od 0.25 do 1.0) jej współczynnik gamma = 2.2. Mac OS używa krzywej o nieco innym współczynniku: 1.8, więc dla tych samych wartości heksadecymalnego kodu odcień koloru na ekranie komputera od Apple może wyglądać nieco inaczej. (Przypuszczam jednak, że Color Management Blendera uwzględnia i takie przypadki, dokonując odpowiedniej konwersji).
W pracy nad modelem opisanym w tej książce przez cały czas używałem korekty sRGB. (Dokładniej — od rozdziału o materiałach: por. str. 289, Rysunek 5.1.7).
W węzłach Cycles (np. Image Texture) włączasz korektę gamma (sRGB) wybierając tryb Color. Dla tekstur nie odwzorowujących barwy (np. nierówności) używa się trybu bez żadnej korekty: Non-Color Data.
Węzły, podobnie jak znane Ci do tej pory kontrolki w panelach czy oknach dialogowych, służą do zmiany jakichś parametrów. To po prostu inna forma prezentacji. Tradycyjny interfejs użytkownika udostępnia w oknie/oknach wszystkie możliwe opcje naraz. Zazwyczaj podczas pracy zmieniasz tylko niektóre z nich. Można nazwać tę formę “statyczną”. Węzły stosuje się tam, gdzie wielka liczba dostępnych opcji czyni „statyczną” prezentację w oknie lub oknach niemożliwą. Każdy węzeł to jakiś pojedynczy zespół parametrów. Budując z węzłów schemat, “dynamicznie” dobierasz tylko te kontrolki, których wartości chcesz zmienić. W związku z tym musisz się trochę orientować, jakie komponenty (węzły) masz do dyspozycji i co każdy z nich robi. To pewna wada. Z drugiej strony, węzły można łączyć na najróżniejsze sposoby, których uzyskanie nie byłoby praktycznie możliwe w tradycyjnym, “statycznym” GUI.
Gdy przełączysz jedno z okien Blendera w tryb Node Editor, zobaczysz widok przypominający Rysunek 12.14.1:
Rysunek 12.14.1 Okno Node Editor (aktualny kontekst: materiał Cycles)
Edytor węzłów może służyć do pracy z definicjami materiałów, tekstur lub kompozycji ostatecznego obrazu. Rysunek 12.14.1 przedstawia definicję materiału o nazwie B.Skin.Camouflage. To prosty schemat, składający się z dwóch węzłów: shadera (Glossy BSDF) połączonego z rezultatem (Material Output). Z lewej strony każdego węzła znajdują się punkty wejścia, z prawej — punkty wyjścia. W Node Editor budujesz definicję, łącząc wyjścia jednych węzłów z wejściami innych. Rysunek 12.14.2 przedstawia typowe kontrolki węzłów i sposób ich łączenia:
Rysunek 12.14.2 Podstawowe elementy i łączenie węzłów
Aby połączyć węzły ze sobą, „łapiesz” odpowiedni punkt wyjścia i przeciągasz ponad wejście innego węzła. Blender łączy je eleganckim „kablem” (por. Rysunek 12.14.2). Usunięcie takiego połączenia polega na złapaniu myszką końcówki takiego „kabla” i „upuszczeniu” jej gdziekolwiek poza węzłem. Możesz także „przeciąć” te linie (Ctrl-LPM).
Węzły możesz zaznaczać tak samo jak obiekty w oknie 3D View: Kliknięcie PPM (a także LPM) zaznacza pojedynczy węzeł. Skrót A (View→Select or Deselect All) zaznacza/wyłącza zaznaczenie wszystkich węzłów schematu. Dostępne jest także zaznaczenia obszarem prostokątnym (B — View→Border Select).
Aby przesunąć pojedynczy węzeł, wystarczy go „złapać” LPM i przeciągnąć w nowe miejsce. Tak jak w oknie 3D View dostępne są także skróty G (przesunięcie), S (skalowanie) i R (obrót). Szczególnie te dwie ostatnie operacje mają sens jedynie dla dwóch lub więcej węzłów. (Skalowanie zbliża lub oddala zaznaczone węzły, a obrót obraca ich środki).
Aby wstawić do schematu nowe węzły, wybierasz je z menu Add (z nagłówka okna Node Editor). W każdym trybie pracy zawartość tego menu jest inna. (W każdym z tych trybów używane są inne węzły). Tak jak obiekty, węzły mogą być kopiowane (Shift-D — Node→Duplicate).
Aby usunąć jakiś węzeł, zaznacz go i naciśnij Delete lub X (Node→Delete).
Aby przesunąć ekran (Pan) na inny fragment schematu, przesuń myszkę z wciśniętym SPM.
Powiększenie można zmienić tak samo jak w oknie 3D View: obracając KM lub przesuwając myszkę z wciśniętym Ctrl i SPM. Działa tu także skrót Home (View→View All).
Schemat materiału lub kompozycji, który budujesz w Node Editor, będzie wykorzystany do przetworzenia każdego piksela renderowanego obiektu lub obrazu.
Specyfiką Cycles jest dodatkowe wyświetlanie kontrolek węzłów w panelach okna Properties (zestawu Material — Rysunek 12.14.1). Każda z tych paneli wyświetla kontrolki wszystkich węzłów podłączonych do odpowiednich wejść (Surface, Displacement) węzła Material Output (Rysunek 12.14.3):
Rysunek 12.14.3 Powtórzone kontrolki węzłów materiału w panelach Surface i Displacement (Cycles)
To powiązanie powoduje, że dla nieco bardziej złożonych schematów panele gwałtowanie się rozrastają — i liczba wyświetlanych w niej kontrolek czyni je praktycznie bezużytecznymi. Możesz je zwinąć, aby nie przeszkadzały. Sądzę, że ta właściwość przydaje się w dwóch przypadkach:
dla bardzo prostych materiałów — niedoświadczeni użytkownicy mogą się czuć pewniej, używając panelu, a nie edytora węzłów;
do obsługi parametrów materiału, który jest oparty na grupie węzłów (por. str. 997);
Kolor punktów wyjścia i wejścia węzła zależy od jego typu danych (Rysunek 12.14.4):
Rysunek 12.14.4 Oznaczenia barwne typów wejść i wyjść węzłów
Żółty punkt oznacza barwę (R, G, B, A), szary — pojedynczą liczbę (rzeczywistą), zielony — informacje dla shadera, a niebieski — wektor (X, Y, Z), determinujący położenie lub kierunek. Wektory są zazwyczaj potrzebne na wejściu węzłów tekstur: określają, jak dwuwymiarowy obraz tekstury ma być rozłożony na trójwymiarowej powierzchni.
Istnieją specjalne typy węzłów, które służą do konwersji z jednego rodzaju danych na drugi. Przykładem takiego węzła jest chociażby RGB to BW, (RGB to Black/White). Można go użyć do przekształcenia koloru na pojedynczą liczbę (od 0.0 do 1.0) (Rysunek 12.14.5):
Rysunek 12.14.5 Przykład jawnej konwersji typu połączenia (tutaj: z barwy na liczbę)
Node Editor pozwala także łączyć ze sobą węzły różnych typów (Rysunek 12.14.6):
Rysunek 12.14.6 Przykłady automatycznej konwersji typów
Wzdłuż takiego połączenia Blender dokonuje automatycznej konwersji z jednego typu wartości na drugi. Reguły tej automatycznej konwersji przedstawia Tabela 12.14.1 (pola na przekątnej nie są konwertowane):
| Na końcu Na początku | Value | Color | Vector | Shader |
| Value | v | v→ R, v→ G, v→ B | v→ X, v→ Y, v→ Z | brak |
| Color | Odcień szarości | RGBA | R → X, G → Y, B → Z | brak |
| Vector | (X+Y+Z)/3 | X → R, Y → G, Z → B | XYZ | brak |
| Shader | brak | brak | brak | — |
Tabela 12.14.1 Automatyczna konwersja danych na połączeniu pomiędzy różnymi rodzajami wejść i wyjść węzłów
Zwróć uwagę, że nie istnieje żadna automatyczna konwersja na / z danych shadera.
Edytor węzłów można uruchamiać w trzech różnych kontekstach (trybach pracy): materiału, tekstury, i końcowej kompozycji obrazu (postprocessing). Przełącznik tych trybów znajduje się w nagłówku okna (Rysunek 12.14.7):
Rysunek 12.14.7 Nagłówek okna Node Editor (aktualny kontekst: materiał Cycles)
Każdy z tych trybów oferuje inny zestaw węzłów i służy do czego innego. Rysunek 12.14.7 przedstawia nagłówek w trybie edycji materiału. W tej książce będziemy także wykorzystywać tryb kompozycji (postprocessing). Trybu tekstur nie będziemy używać, gdyż jest przeznaczony wyłącznie dla renderera BI (W Cycles tekstury można komponować w trybie materiału).
Zwróć także uwagę, że w trybie materiału w nagłówku okna Node Editor pojawia się z prawej strony opcji wyboru trybu jeszcze dodatkowy przełącznik (Rysunek 12.14.7). Umożliwia przełączanie pomiędzy definicją aktualnego materiału (materiału przypisanego do aktywnego łącza siatki1 — por. Rysunek 12.14.3) i definicją otoczenia sceny.
Sporą pomocą przy pracy nad złożonymi schematami są przyciski Copy/Paste, umieszczone z prawej strony nagłówka (Rysunek 12.14.7). Pozwalają na kopiowanie i wklejanie całych zespołów węzłów.
Inną pomocą w pracy nad węzłami jest możliwość łączenia węzłów w ramki (Rysunek 12.14.8)
Rysunek 12.14.8 Łączenie węzłów w ramki
Zaznacz węzły, które chcesz połączyć w ramkę i naciśnij Ctrl-J (Node→Join in new Frame). Blender otoczy wówczas zaznaczone elementy ramką. To prostokąt z zaokrąglonymi narożnikami i umieszczoną etykietą pod górną krawędzią (domyślnie jest tam wpisane „Frame”). Ramki traktuj jak pomocnicze „skrzynki”. Możesz je „złapać”, naciskając LPM w jej wnętrzu, i trzymając wciśnięty ten klawisz myszy przeciągnąć w nowe położenie. Ramka zawsze przesuwa się wraz z całą zawartością. To często wygodniejsze niż zaznaczanie wielu węzłów.
Gdy zaznaczysz ramkę i naciśniesz przycisk N (View→Properties) , Node Editor wyświetli po prawej stronie ekranu odpowiedni przybornik. W panelu Active Node możesz zmienić właściwości ramki (Rysunek 12.14.9):
Rysunek 12.14.9 Właściwości ramki
Uważam że jedną z najważniejszych elementów ramki jest jej etykieta. Zawsze ją zmieniaj, nadając ramce jakąś nazwę odpowiednią do roli węzłów, które zawiera. To bardzo pomaga w późniejszej analizie schematów!
Aby włączyć jakiś węzeł do istniejącej ramki, po prostu przeciągnij go do jej wnętrza (Rysunek 12.14.10):
Rysunek 12.14.10 Dodawanie węzłów do ramki
Operacja odwrotna nie jest tak intuicyjna: aby „wyjąć” węzły z ramki musisz je zaznaczyć i wywołać polecenie Node→Remove from Frame. Czasami prościej jest po prostu usunąć całą ramkę (zaznacz ją i naciśnij X lub Del). To usuwa tylko obramowanie — zawartość ramki (węzły, połączenia) pozostaje na schemacie.
Czasami krzywa linia łącząca dwa punkty bywa przesłonięta przez inne węzły (Rysunek 12.14.10):
Rysunek 12.14.11 Połączenie, zasłonięte przez inny węzeł
To zmniejsza czytelność schematu. Czy można wymusić inny przebieg tej linii połączenia?
Do sterowania kształtem linii połączeń używamy w Blenderze punktów pomocniczych. Aby je wstawić, musisz „przeciąć” linię myszką, trzymając na klawiaturze wciśnięty klawisz Shift (Rysunek 12.14.12):
Rysunek 12.14.12 Wstawianie pomocniczego punktu w linię połączenia
Blender wstawia w miejscu przecięcia nowy punkt pomocniczy. Ten punkt od razu jest zaznaczony (ma białą obwódkę). Wystarczy nacisnąć G i przesunąć go w nowe miejsce (Rysunek 12.14.13):
Rysunek 12.14.13 Przesuwanie pomocniczego punktu
Aby skończyć przesuwanie punktu, kliknij LPM (to działa tak samo jak przesuwanie zwykłego węzła). Aby usunąć jakiś punkt pomocniczy musisz go zaznaczyć (PPM) i nacisnąć X lub Delete (Rysunek 12.14.14):
Rysunek 12.14.14 Usuwanie pomocniczego punktu
Usunięcie punktu pomocniczego usuwa także jego linię połączenia.
W tej sekcji pokażę, jak wykorzystać drugą scenę w charakterze „tła”. (To coś innego niż podstawianie zdjęcia za modelem). Zrobię to na przykładzie tworzenia wizualizacji z udziałem dwóch samolotów. W tym przypadku będą to dwie maszyny tego samego typu (samoloty myśliwskie często latały parami) .
Na razie w pliku jest jeden odpowiednio „upozowany” samolot, który ma teksturę z numerem bocznym „160”, więc zmieniłem nazwę jego sceny na 160. Skopiowałem tę scenę, wykorzystując opcję Link Objects, a potem zmieniłem jej nazwę na numer drugiej maszyny: 316 (Rysunek 12.15.1):
Rysunek 12.15.1 Dodanie nowej sceny (316)
W tej chwili scena 316 zawiera referencje (Link) do wszystkich obiektów z oryginalnej warstwy 160. Na pierwszy rzut oka niczym się nie różnią poza nazwą. Ustalmy, że sceną główną (tą, na której będziemy przesuwać model samolotu) będzie 316. Dla porządku proponuję usunąć ze 160 wszystkie obiekty z warstwy 20 (kamera, źródła światła) oraz obiekt Target z warstwy 10. (Potrzebujemy ich tylko na scenie 316).
Potem możemy stworzyć w 316 lokalne kopie wszystkich obiektów i krzywych animacji (ale nie siatek czy innych skojarzonych z nimi danych!). W tym celu wywołaj w 316 z menu Object→Make Single User polecenia:
Object→All (Rysunek 12.15.2a) — to utworzy lokalne kopie wszystkich obiektów sceny 316. Blender zmieni odwołania we wszystkich ograniczeniach i innych referencjach do innych obiektów. Oznacza to że uchwyty poruszające poszczególnymi częściami samolotu na każdej ze scen można ustawiać niezależnie. Obiekty z obydwu scen współdzielą jednak wszystkie bloki danych, takie jak siatki, materiały czy krzywe ruchu z obiektami;
Object Animation→All (Rysunek 12.15.2b) — to stworzy lokalne kopie linii ruchu śmigła, przypisane do każdej ze scen ;
Rysunek 12.15.2 Stworzenie lokalnych kopii obiektów i ich linii ruchu (F-Curve)
Musieliśmy powielić tory ruchu obiektów (F-Curves), aby śmigła renderowanych samolotów nie były ustawione w tej samej pozycji. Teraz przesuń tę drugą krzywą ruchu w górę, aby to osiągnąć (Rysunek 12.15.3):
Rysunek 12.15.3 Zmiana położenia łopat śmigła w scenie 316
Teraz wpisz scenę 160 jako tło sceny 316 (w polu Scene:Background — Rysunek 12.15.4a):
Rysunek 12.15.4 Przypisanie scenie 316 sceny 160
W efekcie w scenie 316 pojawił się samolot ze sceny 160. Jest tylko wyświetlany (nie można go zaznaczyć), więc spokojnie przesuń do tyłu, formując szyk (Rysunek 12.15.5):
Rysunek 12.15.5 Pozowanie samolotu ze sceny 316
W takim momencie przydało się, że początkiem hierarchii wszystkich elementów naszego modelu jest jeden obiekt — kadłub (B.300.Fuselage). Jego odpowiednik w scenie 316 nosi nazwę B.300.Fuselage.001 (Blender nadał wszystkim kopiom końcówki „.001”). Dzięki temu nie musisz zaznaczać wszystkich elementów, wystarczy że odpowiednio ustawisz ten jeden obiekt.
Jeżeli przesuwany obiekt miał jakieś obiekty potomne na warstwach ukrytych podczas tej transformacji, to po ich odkryciu możesz zobaczyć ich zawartość w starym miejscu. Wystarczy jednak wykonać wtedy jakiś drobny ruch obiektem nadrzędnym, by wszystkie „wskoczyły” na swoje miejsce. To jakiś błąd w Blenderze.
Odsuń samolot 316 trochę w bok od toru lotu 160, i pochyl nieco jego skrzydła (Rysunek 12.15.6). (To dodaje do sceny jakiś drobny element dramatyzmu — samoloty lecące w równym szyku kojarzą się z siłą i spokojem):
Rysunek 12.15.6 Pozowanie samolotu ze sceny 316, c.d.
Jak umieścić na drugiej maszynie inne numery taktyczne? Przygotuj alternatywną teksturę (decals-316.png) i sprawdź jak wygląda na modelu (Rysunek 12.15.7b). Następnie zmień obiektom na których namalowano numery taktyczne wartość Relations:Pass Index z domyślnego 0 na 1 (Rysunek 12.15.7a):
Rysunek 12.15.7 Nowe numery taktyczne na drugim samolocie
Pass Index pozwala wyróżnić obiekty podczas renderowania. Teraz w materiale B.Skin.Camouflage (por. str. 470, 575) wprowadźmy zmiany, które dla obiektów z Pass Index = 0 podstawią piksele z tekstury decals.png, a dla tych z Pass Index = 1 — alternatywną decals-316.png. W miejsce dotychczasowej pojedynczej tekstury umieść dwie, których wejścia są połączone przełącznikami Color:Mix (Rysunek 12.15.8):
Rysunek 12.15.8 Modyfikacja materiału poszycia, różnicująca oznaczenia taktyczne na samolotach
Współczynnik „mieszania” w węzłach Mix jest podłączony do wyjścia Object Index z węzła Object Info. (Object Index to samo co Pass Index — drobna niezgodność terminologii). Dla porządku „przepuszczam” tę wartość przez węzeł Greater Then, aby współczynnik w węzłach Mix na pewno miał zawsze wartość 0 lub 1. Dzięki temu ten układ działa jak przełącznik — dla obiektów z Pass Index > 0 podstawia teksturę z numerem bocznym „316” (decals-316.png).
Rysunek 12.15.9 przedstawia rezultat. (Ustawiłem tu samoloty bokiem, by było widać wyraźnie ich numery taktyczne):
Rysunek 12.15.9 Różne numery taktyczne na dwóch modelach pokrytych tym samym materiałem
W niektórych panelach okna Properties znajdują się listy. Służą do zarządzania materiałami, grupami wierzchołków, alternatywnymi rozwinięciami UV i dziesiątką innych rzeczy. Obsługę listy Blendera pokażę na przykładzie panelu zarządzającego grupami wierzchołków siatki. Inne listy mogą nie mieć niektórych z opisanych tu kontrolek.
Rysunek 12.16.1 opisuje funcje kontrolek widocznych na i wokół listy:
Rysunek 12.16.1 Elementy typowej listy (zawartość panelu Vertex Groups z okna Properties)
Aby zmienić nazwę elementu listy, należy kliknąć ten element myszką (LPM), z wciśniętym na klawiaturze klawiszem Ctrl (Rysunek 12.16.2):
Rysunek 12.16.2 Zmiana nazwy pozycji listy
W etykiecie pozycji pojawia się karetka, i możesz wtedy zmienić wpisany tam tekst. Ta funkcja nie jest związana z żadnym widocznym przez cały czas elementem, ani z żadnym elementem menu kontekstowego1. W podpowiedzi można przeczytać że w celu zmiany nazwy należy kliknąć dwukrotnie na pozycję listy. W praktyce nie zawsze to działa, bo np. pozycje na liście wierzchołków należy kliknąć czterokrotnie (2 x podwójne kliknięcie) aby przełączyła się w ten tryb.
Aby wyszukać na długiej liście element zawierający w nazwie jakiś charakterystyczne słowo, rozwiń sekcję wyszukiwania i wpisz to słowo w polu Search, a następnie naciśnij Enter (Rysunek 12.16.3):
Rysunek 12.16.3 Wyszukiwanie pozycji na liście
Listy Blendera można uporządkować „ręcznie” lub alfabetycznie. Uporządkowanie „ręczne” polega na ustaleniu pozycji kolejnych elementów za pomocą przycisków z prawej strony listy (Rysunek 12.16.4a):
Rysunek 12.16.4 Zmiana uporządkowania listy
Za pomocą przycisku w obszarze wyszukiwania możesz się przełączyć na uporządkowanie w kolejności alabetycznej (Rysunek 12.16.4b). Dodatkowy przycisk z prawej strony pozwala przełączyć się pomiędzy kolejnością rosnącą i malejącą.
Niektóre listy mają dodatkowy przycisk, rowzwijający menu kontekstowe jej elementów (Rysunek 12.16.5). Jego zawartość zależy od rodzaju elementów listy — inne menu zobaczysz dla grup wierzchołków, a inne dla alternatywnych współrzędnych UV. Polecenia z menu kontekstowego mogą dotyczyć całej zawartości listy (np. Lock All) albo aktywnego (podświetlonego) elementu (np. Mirror Vertex Group).
Z edytorem obiektów miałeś już okazję się zetknąć (Rozdział 3, “Blender – pierwsze kroki”). W tym rozdziale omówimy podstawowe pojęcia, które się z nim wiążą.
Pominę tu zagadnienia, które przedstawiał już Rozdział 3. Chodzi tu o:
Tryb edycji obiektów włączasz naciskając przycisk Tab. Alternatywnie możesz także zrobić to za pomocą listy rozwijalnej z nagłówka okna widoku (Rysunek 13.1.1):
Rysunek 13.1.1 Okno widoku: przełączenie w trybu obiektu (Object Mode)
Powtórne naciśnięcie Tab przełączy Cię z powrotem do poprzedniego trybu (np. edycji — Edit Mode). Możesz także wybrać inny tryb z listy rozwijalnej Mode.
Nagłówek okna 3DView w trybie Object Mode ma wiele przydatnych kontrolek (Rysunek 14.2.2) :
Rysunek 13.1.2 Okno widoku: kontrolki dostępne w trybie obiektów
Najpierw umieść kursor 3D w miejscu, gdzie ma być środek okręgu (Rysunek 13.2.1a). (Każdy nowa siatka jest umieszczana tam, gdzie aktualnie jest kursor 3D). Następnie wywołaj polecenie Add→Mesh→Circle (Rysunek 13.2.1b):
Rysunek 13.2.1 Stworzenie okręgu (wieloboku)
Po wywołaniu tego polecenia Blender zawsze wstawia do rysunku okrąg o promieniu = 1 jednostki. Jego siatka składa się z 32 wierzchołków, połączonych w pojedynczą krawędź (Rysunek 13.2.2a).
Możesz także stworzyć okrąg wykorzystując Tool shelf (T): w jego zakładce Create, panelu Add Primitive, naciśnij przycisk Circle (jest w sekcji Mesh).
Aby zmienić te domyślne wartości, zaraz po stworzeniu okręgu naciśnij F6. W oknie dialogowym, które się pojawi (Rysunek 13.2.2b), zmień liczbę wierzchołków i promień okręgu. Nie staraj się wybierać zbyt wielu wierzchołków (pole Vertices). Za chwilę zobaczysz, że 8 zupełnie wystarczy. Zwróć uwagę, że Blender przy każdej zmianie wartości w oknie parametrów polecenia na bieżąco zmienia nowo utworzony obiekt (Rysunek 13.2.2c):
Rysunek 13.2.2 Ustalanie parametrów okręgu
Nasz obiekt to już właściwie ośmiokąt, a nie okrąg. Teraz jednak wygładzimy go w sposób „odwracalny”. Przełącz okno Properties na zestaw Modifiers. Z listy rozwijalnej Add Modifier wybierz modyfikator Subdivision Surface (Rysunek 13.2.3):
Rysunek 13.2.3 Dodanie do obiektu modyfikatora Subdivision Surface
Dodałeś w ten sposób do siatki modyfikator, który w sposób dynamiczny zmienia jej właściwości. Modyfikator Subsurf posiada parametry, które możesz zmienić w jego panelu (Rysunek 13.2.4). Ustaw wartości Subdivisions: View i Render na 2. Zobacz rezultat wygładzenia:
Rysunek 13.2.4 Okrąg wygładzony za pomocą modyfikatora Subdivision Surface
Do wygładzania okręgu i elips najlepiej jest używać schematu obliczeniowego o nazwie Catmull-Clark. Nie zmieniaj tego ustawienia w modyfikatorze Subsurf (Rysunek 13.2.4). Schemat Catmulla-Clarka całkiem dokładnie odwzorowuje takie krzywizny już dla oryginalnej siatki złożonej z 6-8 wierzchołków, i dla niewielkiego poziomu podziału (Subdivisions:View = 2).
Rysunek 13.2.5 Linia podziałowa, uzyskana z 8 wierzchołków linii bazowej i poziomu podziału (Subdivisions) = 3
W przypadku, gdy stworzone koło ma być podstawą do utworzenia jakiegoś niewielkiego, mało istotnego elementu (np. rurek, kabli) — możesz zmniejszyć poziom podziału do 1. Zmniejszy to ogólną liczbę ścian modelu. Gdy chodzi o duży obiekt, jak kołpak śmigła — możesz zwiększyć poziom podziału do renderowania do 3 (aby na pewno wyeliminować nawet małe “nierówności” na obwodzie okręgu).
Jeżeli chcesz dowiedzieć się więcej o krzywych i powierzchniach podziałowych — p. “Powierzchnie podziałowe”, str. 1221.
Najpierw umieść kursor 3D w miejscu, gdzie ma być środek kwadratu (Rysunek 13.3.1a). (Każdy nowa siatka jest umieszczana tam, gdzie aktualnie jest kursor 3D). Następnie wywołaj polecenie Add→Mesh→Plane (Rysunek 13.3.1b):
Rysunek 13.3.1 Stworzenie kwadratu
Po wywołaniu tego polecenia Blender wstawia do rysunku kwadrat o boku = 2 jednostki (Rysunek 13.3.2a). Aby zmienić ten domyślny rozmiar, naciśnij F6. W oknie parametrów zmień pole Radius na nową wartość (Rysunek 13.3.2b). (To długość połowy boku kwadratu):
Rysunek 13.3.2 Rezultat i parametry polecenia Plane
Gdy następnym razem wywołasz polecenie Add→Mesh→Plane, Blender stworzy kwadrat o takim rozmiarze jak stworzony ostatnio (program „pamięta” ostatnią wartość Radius i stosuj ją jako domyślną).
Rozmiar każdego obiektu można także zmieniać w inny sposób: zaraz po utworzeniu naciśnij S (Scale) i powiększ go do odpowiedniej skali .
Możesz także stworzyć kwadrat wykorzystując Tool shelf (T): w jego zakładce Create, panelu Add Primitive, naciśnij przycisk Plane (jest w sekcji Mesh).
Umieść kursor 3D w miejscu, gdzie ma być umieszczony nowy walec (Rysunek 13.4.1a). (Każdy nowy obiekt jest umieszczany tam, gdzie aktualnie jest kursor). Następnie wywołaj polecenie Add→Mesh→Cylinder (Rysunek 13.4.1b):
Rysunek 13.4.1 Stworzenie walca
Na scenie pojawi się domyślny walec, o promieniu = 1, wysokości 2 i 32 ścianach bocznych (Rysunek 13.4.2a). (W Twoim przypadku może być inny, bo Blender „pamięta” ostatnio użyte parametry). Stworzony cylinder możesz teraz interaktywnie pozmieniać, otwierając zaraz po stworzeniu Tool Shelf (T). W jego dolnej części znajdziesz panel Add Cylinder, z parametrami tego polecenia:
Rysunek 13.4.2 Vertices: zmiana liczby boków
Rysunek 13.4.2b) pokazuje walec o liczbie boków (Vertices) zredukowanej do 8 (to właściwie graniastosłup). Z kolei przełącznik Cap Ends steruje obecnością ścian podstaw walca (Rysunek 13.4.3):
Rysunek 13.4.3 Cap Ends:włączanie i wyłączanie ścian podstaw walca
Czasami, w małym oknie 3D View, dolna część Tool Shelf z parametrami ostatnio wywołanego polecenia może być „zwinięta”. Możesz ją „wyciągnąć” za pomocą małego uchwytu z ikonką „+”, wystającego z nagłówka okna 3D View. Możesz także nacisnąć F6, by otworzyć na ekranie okno z tym samym panelem Add Cylinder, który jest wyświetlane w Tool Shelf (tylko na innym tle — Rysunek 13.4.4):
Rysunek 13.4.4 Alternatywne okno, pozwalające na interaktywną modyfikację parametrów ostatniego polecenia
Podobnie jak okrąg, walec można jeszcze wygładzić. Wystarczy, że w panelu Modifiers wybierzesz z listy Add Modifier modyfikator Subdivision Surface (Rysunek 13.4.5):
Rysunek 13.4.5 “Wygładzenie” walca
Ustaw parametry Subdivisions: View i Subdivisions: Render na 2. To wartość wystarczająca do uzyskania całkiem porządnego przybliżenia okręgu.
Do wygładzania okręgu i elips najlepiej jest używać schematu obliczeniowego o nazwie Catmull-Clark. Nie zmieniaj tego ustawienia w modyfikatorze Subsurf. Schemat Catmulla-Clarka całkiem dokładnie odwzorowuje takie krzywizny już dla oryginalnej siatki złożonej z 6-8 wierzchołków, i dla niewielkiego poziomu podziału (Subdivisions = 2).
Jeżeli chcesz dowiedzieć się więcej o krzywych i powierzchniach podziałowych — patrz “Powierzchnie podziałowe”, dodatek „Powierzchnie podziałowe”str. 1221.
Możesz także stworzyć walec wykorzystując Tool shelf (T): w jego zakładce Create, panelu Add Primitive, naciśnij przycisk Cylinder (jest w sekcji Mesh).
Czasami, podczas pracy z ogranicznikami (constrains) przydają się pomocnicze elementy, służące wyłącznie jako „punkty odniesienia” w przestrzeni. Takie obiekty określane są w Blenderze jako „puste” (Empty), gdyż nie zawierają żadnej siatki. To samo „opakowanie”: środek (położenie), obrót, a także skala. (Skala nie ma wpływu na sam obiekt Empty, ale może mieć na inne, zwykłe elementy „siatkowe”, dla których jest „rodzicem”).
Aby dodać do rysunku nowy obiekt Empty, umieść kursor 3D w miejscu, gdzie ma być jego środek. Następnie wywołaj polecenie Add→Empty (Rysunek 13.5.1):
Rysunek 13.5.1 Stworzenie pustego obiektu
Spowoduje to stworzenie nowego obiektu. Aby w ogóle był widoczny, każdy obiekt typu Empty w trybie Arrows ma włączoną opcję rysowania osi lokalnego układu współrzędnych.
Umieść kursor 3D w miejscu, gdzie ma być umieszczone nowa źródło światła (Rysunek 13.6.1a). (Każdy nowy obiekt jest umieszczany tam, gdzie aktualnie jest kursor). Wywołaj polecenie Add→Add Lamp→Sun (Rysunek 13.6.1b):
Rysunek 13.6.1 Wstawienie źródła światła (lampy)
Z submenu wybierz jeden z dostępnych typów źródeł światła. W tej książce będziemy używać tylko światła kierunkowego (słonecznego — Sun) bo żadna ze scen które stworzymy nie rozgrywa się w pomieszczeniu zamkniętym.
Jeżeli nawet wybierzesz nieprawidłowy — nic złego się nie stanie. Typ źródła światła można zmienić także po jego stworzeniu, w jego właściwościach (okno Properties, zakładka Object Data).
Możesz także stworzyć źródło światła wykorzystując Tool shelf (T): w jego zakładce Create, panelu Add Primitive, naciśnij przycisk Sun (jest w sekcji Lamp).
Umieść kursor 3D w miejscu, gdzie ma być umieszczona nowa kamera. (Każdy nowy obiekt jest umieszczany tam, gdzie aktualnie jest kursor). Następnie wywołaj polecenie Add→Camera (Rysunek 13.7.1):
Rysunek 13.7.1 Wstawienie nowej kamery
Jeżeli dodajesz do sceny drugą kamerę, tylko jedna z nich może być kamerą aktywną — czyli taką, z której widok będzie renderowany. Aby uczynić zaznaczoną kamerę aktywną, użyj polecenia View→Cameras→Set Active Object as Camera (Rysunek 13.7.2):
Rysunek 13.7.2 Przełączanie aktywnej kamery
Kamera aktywna jest oznaczana na rysunku wypełnioną „strzałką”.
Możesz także stworzyć kamerę wykorzystując Tool shelf (T): w jego zakładce Create, panelu Add Primitive, naciśnij przycisk Camera (jest w sekcji Other).
Widok z kamery (0, albo View→Cameras→Active Camera) jest w oknie 3D View pokazywany w następujący sposób (Rysunek 13.8.1):
Rysunek 13.8.1 Widok z kamery (w oknie 3D View)
Największa ramka, narysowana linią ciągłą, to sama kamera. (Możesz np. w nią kliknąć PPM, aby została zaznaczona). Wokół niej Blender rysuje przerywaną linią drugi prostokąt. Oznacza w ten sposób obszar, który pojawi się na renderowanym obrazie. Najmniejszy obszar — prostokąt o zaokrąglonych narożnikach — to pomocnicza informacja, gdzie się zaczynają brzegi renderowanego obrazu.
Aby dostać się do właściwości kamery, zaznacz jej obiekt, i przełącz się na zestaw przycisków Object Data 1 (Rysunek 13.8.2):
Rysunek 13.8.2 Właściwości kamery (zestaw Object Data)
Rysunek 13.8.2 pokazuje istotne pola panelu Lens. (Pozostałych w tym modelu nie używałem). Najbardziej oczywistym parametrem kamery jest ogniskowa (Focal Length). Domyślna ogniskowa kamery w Blenderze to 35mm. Odpowiada to kątowi rozwarcia 50º. To nieco za duży kąt jak dla odległości oczu od ekranu. Często powoduje, że zniekształcenie perspektywiczne kamery wywołuje wrażenie “rybiego oka”. Lepiej jest ją przestawić na większą wartość, np. 70mm (Rysunek 13.8.3):
Rysunek 13.8.3 Kamera — efekt zmiany ogniskowej z 35mm do 70mm
Aby kamera nie “obcięła” zbyt odległej części modelu, wydłuż także jej zasięg. Chodzi o pola Clipping Start/End. Zmień pole End z domyślne 100 na 1000 jedn. Blendera, gdyż inaczej kamera może “obciąć” model (Rysunek 13.8.4):
Rysunek 13.8.4 “Obcięcie” modelu przez zbyt małą wartość Clipping:End
Warto także wydłużyć wartość Clipping:Start z domyślnego 0.1 do 1 jednostki, aby w widoku 3D View blisko położone powłoki modelu nie generowały artefaktów “przebić” jednej powierzchni przez drugą (Rysunek 13.8.5):
Rysunek 13.8.5 Artefakty na powierzchni modelu, powstałe przez zbyt małą wartość Clipping:Start
Co prawda, “przebicia”, które pokazuje Rysunek 13.8.5 nie pojawią się na ostatecznym renderze. Po co jednak mają nas drażnić podczas edycji obiektu!? Lepiej zmienić pole Clipping:Start i po kłopocie!
Zaznacz obiekt, które chcesz powiększyć/pomniejszyć, oraz ustal środek transformacji (lista Pivot). Praktycznie stosuję jeden z dwóch rodzajów środka: Bounding Box Center albo Cursor 3D. Bounding Box Center to środek najmniejszego “pudełka”, które zawiera środki wszystkich zaznaczonych obiektów. Zacznijmy od przypadku, gdy środkiem skalowania jest właśnie Bounding Box Center (możesz go ustawić z klawiatury — ,), a zaznaczony jest pojedynczy obiekt (Rysunek 13.9.1a):
Rysunek 13.9.1 Skalowanie obiektu
Naciśnij S (Object→Transfrom→Scale). Przełączysz się w ten sposób w tryb skalowania. Na rysunku pojawi się kreskowana linia od kursora myszy do środka transformacji. Każde przesunięcie myszy będzie powodować zmianę skali zaznaczonego obiektu — proporcjonalnie do zmiany długości kreskowanej linii. Dokonywane zmiany są pokazywane na bieżąco we wszystkich oknach Blendera.
W nagłówku aktywnego okna jest wyświetlana aktualna zmiana skali wzdłuż każdej osi. Aby zatwierdzić nowe wymiary obiektu (zakończyć transformację), należy kliknąć LPM. Aby zrezygnować z operacji, możesz w każdej chwili nacisnąć Esc .
Jeżeli w trakcie przesuwania naciśniesz X, Y, lub Z — ograniczysz zmianę skali do jednej z tych osi. W pozostałych kierunkach żaden rozmiar nie ulegnie zmianie. Po pierwszym naciśnięciu klawisza wybrana jest oś globalna. Jeżeli jednak jeszcze raz naciśniesz ten sam klawisz — przełączysz się na lokalną oś obiektu. To rozróżnienie pomiędzy osią globalną i lokalną ma swój sens wtedy, gdy obiekt jest w jakiś sposób obrócony.
Podobne reguły obowiązują przy wyłączaniu ze skalowania jednej z osi: Shift-X, Shift-Y, lub Shift-Z zablokują transformację wzdłuż jednej z globalnych osi (odpowiednio: X, Y lub Z). Aby ograniczyć skalowanie wzdłuż lokalnej osi obiektu, naciśnij taki skrót jeszcze raz.
Podczas zmiany skali możesz dodatkowo trzymać wciśnięty klawisz Ctrl. Spowoduje to skokową zmianę proporcji (np. co 0.1). Jeżeli będziesz trzymał wciśnięty klawisz Shift — zmiana skali na ekranie “wyhamuje”, pozwalając na dokładniejsze ustalenie. Wreszcie kombinacja obydwu — Shift-Ctrl — umożliwia skokową zmianę skali o niewielkie odległości (np. co 0.01).
Zwróć uwagę, że gdy zaznaczysz pojedynczy obiekt, całe to Bounding Box Center wypada po prostu w środku obiektu (Rysunek 13.9.1b). To dlatego, że dla jednego punktu Bounding Box ma zerowy rozmiar.
A jak działa Bounding Box Center dla grupy obiektów? Spróbuj zmienić w tym trybie skalę dwóm obiektom naraz (Rysunek 13.9.2):
Obydwa obiekty jednocześnie oddalają się od siebie i zmieniają rozmiar. Dzieje się tak dlatego, że środkiem transformacji jest punkt w połowie odległości pomiędzy środkami tych obiektów.
Bounding Box Center dla obiektów leży w środku ich punktów odniesienia, a nie siatek (tzn. kształtu)
W Blenderze istnieją dwa polecenia do tworzenia duplikatów obiektu:
Duplikat jest stworzony jako kopia “powiązana” (Object→Duplicate Linked, Alt-D). Kopia może mieć oddzielną skalę, położenie, obrót, ale korzysta nadal z tej samej siatki, co wzorzec. (W efekcie ma zawsze ten sam kształt, co oryginał);
Duplikat jest stworzony jako zwykła kopię (Object→Duplicate, Shift-D). Kopia jest obiektem, który w żaden sposób nie zależy od oryginału.
Wywołanie i obsługa obydwu poleceń jest identyczna, więc opiszę je na przykładzie tworzenia kopii “powiązanej”. Rysunek 13.10.1 pokazuje sytuację początkową. Zaznaczyliśmy obiekt — wzorzec: łopatę śmigła. Utworzymy jej dwie powiązane kopie, tworząc trójłopatowe śmigło.
Rysunek 13.10.1 Łopata śmigła, do której dodamy dwie dalsze — jako powiązane kopie
Naciśnij teraz Alt-D (Object→Duplicate Linked). To stworzyło nowy obiekt. Blender nadaje mu unikalną nazwę poprzez doklejenie do nazwy oryginału końcówki w rodzaju “.001”. Od razu także proponuje dokonać jego przesunięcia (Rysunek 13.10.2a):
Rysunek 13.10.2 Powielenie (poprzez obrót)
Jeżeli nie chcesz przesunąć nowego obiektu, a np. obrócić, wystarczy nacisnąć Esc. To przerwie przesuwanie kopii, ale pozostawi ją jako zaznaczoną. Teraz wystarczy wybrać polecenie dowolnej innej transformacji, którą chcesz zastosować — na przykład R, by nowy obiekt obrócić1 (Rysunek 13.10.2b).
Zwykłą kopię obiektu tworzysz identycznie, tyle tylko że zaczynasz poleceniem Shift-D (Object→Duplicate)
Jaka jest w takim razie praktyczna różnica pomiędzy kopią zwykłą, a kopią powiązaną? Pokażę to na przykładzie śmigła (w którym dodałem już także trzecią łopatę). Wszystkie trzy łopaty wykorzystują tą samą siatkę. Gdy zmodyfikujesz jedną z nich, i powrócisz do trybu obiektu (Object Mode) — zmiana stanie się widoczna we wszystkich trzech instancjach (Rysunek 13.10.3):
Rysunek 13.10.3 Obiekty powiązane — siatka jest zmieniana we wszystkich równocześnie
Więcej na ten temat — patrz “Struktura danych modelu i sceny w Blenderze”, str. 1215.
Każdy element rysunku Blendera musi mieć unikalną nazwę. Blender nadaje pewne nazwy domyślne, ale w bardziej złożonym modelu konieczne jest wprowadzenie nazewnictwa w sposób bardziej kontrolowany. Stąd, po utworzeniu każdego nowego obiektu powinieneś nazwać go na nowo.
Aby zmienić nazwę obiektu zaznacz go, i w zestawie Object okna Properties wpisz odpowiedni tekst (Rysunek 13.11.1a). W podobny sposób w zestawie Object Data możesz ustalić nazwę siatki (Rysunek 13.11.1b). Zazwyczaj obydwie nazwy są identyczne, ale czasami może być inaczej (por. nazwa siatki i obiektu pokazywanej przez Rysunek 13.11.1b).
Rysunek 13.11.1 Przykłady nazw obiektów i siatki
Zacznijmy od zasad: jaki system nazewnictwa przyjąć dla elementów naszego modelu? Nazwa nie powinna być długa, zazwyczaj nie powinna przekraczać 20 znaków. Proponuję w związku z tym stosować tekst składający się z następujących segmentów:
segment pełniący rolę unikalnego identyfikatora: składa się z 2 lub 3 części, oddzielonych kropkami:
1 znak: znak, który będzie pełnił rolę wyróżnika wersji samolotu. Wszystkie części w pojedynczym pliku Blendera będą używać takiej samej litery. Na przykład w modelu P-40B nazwy będą zaczynać się od “B”. Okaże się to przydatne później1. Wyjątkiem są elementy specjalne: uchwyty i inne artefakty, używane wyłącznie do animacji modelu. Te mają przedrostek „X”
3 znaki: unikalny numer części. Wydaje mi się, że dobrze jest wydzielić główne podzespoły za pomocą pierwszego znaku. Pozostałe dwa — może to być cyfra, określająca numer części w obrębie zespołu. Oczywiście, także można starać się, aby elementy podzespołów miały zbliżone numery. W takim przypadku radziłbym zwiększać numerację nie co 1, a co 5 (np. “A05”, “A10”, “A15”, “A20”,...). W ten sposób pozostawiamy sobie miejsce w numeracji na ewentualne dodatkowe elementy. (Podczas pracy często się okazuje, że trzeba przekonstruować gotowy zespół. Takie luki w numeracji są wtedy jak znalazł!);
1 znak: opcjonalny znacznik “powielenia”. Może to być “L” lub “R” dla części lewej lub prawej, które są symetryczne. Może także być “nr kolejny”, np. dla 3 łopat śmigła jest to “A”, “B”, “C”;
segment z dodatkową, “ludzką” nazwą. Rola tego fragmentu jest pomocnicza — ma ułatwić identyfikację przez użytkownika. Sądzę, że w związku z tym, że nigdy nie wiesz, do kogo trafi Twoja praca, najlepiej jest stosować nazwy angielskie.
Zgodnie z powyższymi regułami, siatka łopaty śmigła (Rysunek 13.11.1b) nosi nazwę “B.010.Blade”:
“B” — przedrostek, którego będę używał do wszystkich części P-40B;
“010” — numer tej części: “0” będę używać dla podzespołu śmigła, a “10” — to numer kolejny, nadany z zachowaniem zasady “odstępu w numerach co 5”;
segment nazwy: “Blade”.
Zwróć uwagę, że obiekty poszczególnych łopat śmigła, pokazywanych przez Rysunek 13.11.1, różnią się znacznikiem „powielenia”. Dodatkowo, nazwa siatki (B.010.Blade) i nazwa obiektu (B.010.B.Blade) różnią się od siebie. Stało się tak dlatego, że wszystkie trzy łopaty śmigła (B.010.A.Blade, B010.B.Blade, B.010.C.Blade) używają jednej i tej samej siatki, o nazwie B.010.Blade. Są one tzw. kopiami powiązanymi, które, w wyniku użycia tej samej siatki, będą miały zawsze ten sam kształt. (Więcej szczegółów na temat kopii powiązanych — str. 823).
Dlaczego trzeba nadawać oddzielne nazwy obiektowi i siatce? Skąd w ogóle taki podział, i czym w Blenderze jest w takim razie “obiekt”? Jeżeli nurtują Cię takie pytania, zajrzyj na str. 1215, do sekcji “Struktura danych modelu i sceny w Blenderze”.
Najpierw zaznacz obiekty, które chcesz uczynić podrzędnymi. Gdy wszystkie już zaznaczysz, włącz do selekcji obiekt, który ma być ich obiektem nadrzędnym. Koniecznie upewnij się, że jego nazwa pojawiła się w lewym, dolnym narożniku ekranu, (tzn. że stał się obiektem aktywnym). Następnie naciśnij Ctrl-P (Object→Parent→Set→Object). Rysunek 13.12.1 pokazuje ten moment w przypisywaniu trzech łopat śmigła (B.010.*.Blade) do kołpaka (B.005.Hub):
Rysunek 13.12.1 Tworzenie powiązań hierarchicznych
Gdy wybierzesz z menu Set Parent To, które pojawi się na ekranie, polecenie Object (Rysunek 13.12.1), nic właściwie widocznego na scenie się nie zmieni. Dopiero w podglądzie struktury sceny zobaczysz różnice (Rysunek 13.12.2):
Rysunek 13.12.2 Utworzone powiązanie hierarchiczne
Bezpośrednim efektem przypisania łopat do kołpaka jest ułatwienie w manipulacji obiektami na scenie. Wcześniej, aby obrócić czy przesunąć ten zespół, musiałbyś dokonać odpowiedniej transformacji oddzielnie na każdym obiekcie. Przypisując łopaty do kołpaka, “skleiłeś” je ze sobą. Od tej chwili, gdy tylko obrócisz lub przesuniesz kołpak, łopaty będą także się obracać i przesuwać — jak w prawdziwym śmigle.
Nic nie stoi na przeszkodzie, aby później uczynić kołpak śmigła obiektem podrzędnym kadłuba. W ten sposób tworzysz bardzo istotną hierarchię części modelu.
Do wyznaczenia przecięcia dwóch powłok proponuję użyć dołączonego do tej książki dodatku o nazwie Intersection 1. Powinieneś go znaleźć w oknie User Preferences, sekcji Addons:Object (Rysunek 13.13.1):
Rysunek 13.13.1 Aktywacja dodatku do wyznaczenia krawędzi przecięcia siatek dwóch obiektów
Zaznacz najpierw dwa obiekty, dla których chcesz znaleźć krawędź przecięcia (Rysunek 13.13.2):
Rysunek 13.13.2 Zaznaczenie obiektów i wywołanie polecenia
Kolejność zaznaczania jest ważna: najpierw wskaż obiekt który pełni rolę „narzędzia tnącego”, a potem obiekt do którego siatki skrypt doda krawędź przecięcia. Następnie naciśnij klawisz W, by otworzyć menu Specials, i wybierz z niego polecenie Intersection (Rysunek 13.13.2).
Po uruchomieniu na ekranie pojawi się okno dialogowe z opcjami polecenia (Rysunek 13.13.3a):
Rysunek 13.13.3 Wyznaczenie krawędzi przecięcia
Na razie niczego w nim nie zmieniaj, tylko naciśnij przycisk OK. W zależności od liczby ścian przecinanych siatek operacja może potrwać sekundę lub dwie. Intersection dodaje wyznaczoną krawędź przecięcia do siatki aktywnego obiektu, zaznacza jej wierzchołki, i przełącza Blender w tryb Edit Mode, abyś mógł je od razu zobaczyć (Rysunek 13.13.3b). Jeżeli nie jesteś zadowolony z rezultatów — wystarczy nacisnąć X, aby je usunąć, po czym powrócić (Tab) do Object Mode i spróbować wywołać polecenie jeszcze raz, z innymi ustawieniami.
Pierwsza z opcji operacji — Use selected faces — ma znaczenie tylko wtedy, gdy wcześniej w Edit Mode zaznaczyłeś jakieś ściany przecinanych siatek. Dodatek Intersection ograniczy wówczas zakres operacji tylko do tego zaznaczonego obszaru. Jeżeli nic nie jest na siatkach zaznaczone — sprawdzane są ich wszystkie ściany.
Gdy druga opcja — Use both meshes — jest włączona, skrypt buduje rezultat z punktów przecięcia krawędzi obydwu siatek (Rysunek 13.13.4a):
Rysunek 13.13.4 Wpływ opcji Use both meshes na krawędź przecięcia
Gdy ją wyłączysz, rezultat będzie zawierać wyłącznie punkty przecięcia aktywnego obiektu ze ścianami obiektu „tnącego” (Rysunek 13.13.4b). Taki efekt może być przydatny przy odpowiednio gęstych siatkach.
Skrypt Intersection wyszukuje punkty przecięcia krawędzi jednej z siatek ze ścianami drugiej i łączy je we wspólną linię. Podczas obliczeń każda czworokątna ściana jest dzielona przekątną (diagonal), aby zamienić ją na dwie ściany trójkątne. Zazwyczaj punkty przecięcia tych tymczasowych przekątnych ze ścianami drugiej siatki są pomijane.
Jeżeli jednak włączysz opcję Use diagonals, zobaczysz je wszystkie (Rysunek 13.13.5a):
Rysunek 13.13.5 Wpływ opcji Use diagonals na krawędź przecięcia
Rysunek 13.13.5b) przedstawia przekątną wybranej ściany i jej punkty przecięcia ze ścianami drugiej siatki. Opcję Use diagonals pozostawiłem tylko na wszelki wypadek — zazwyczaj jej nie używam.
Ta sama operacja dostępna jest także w Edit Mode, pod nazwą Intersect. W tym trybie służy do przecinania zaznaczonych ścian z pozostałymi ścianami siatki (Rysunek 13.13.6):
Rysunek 13.13.6 Wywołanie polecenia Intersect w trybie edycji siatki
W tej wersji polecenia jego opcje są dostępne w panelu przybornika (Toolshelf, T). Możesz je tu przestawiać, interaktywnie zmieniając rezultat. Jeżeli chcesz wykluczyć jakieś ściany z przecinania — ukryj je (H) przed tą operacją, a po jej zakończeniu „odkryj” powtórnie (Alt-H).
Dodatek Intersection jest od 2009r. udostępniany na zasadach Open Source (jak wszystkie dodatki do Blendera, które napisałem). Sądząc z liczby pobrań, wielu użytkowników uznało go za przydatny. Przypuszczam, że jest „przodkiem” polecenia Intersect, dodanego do Blendera w 2014 roku prez jedego z jego głównych programistów (Campbella Bartona). W odróżnieniu od mojego Intersection, który tworzy pojedynczą krawędź niepowiązaną z resztą siatki, ten Intersect dzieli jej ściany.
Zasada działania jest bardzo podobna: zaznacz w Edit Mode siatkę, którą chcesz przeciąć (Rysunek 13.13.7), a następnie wywołaj Mesh→Faces→Intersect:
Rysunek 13.13.7 Wywołanie standardowego polecenia Intersect (Blender 2.72)
W rezultacie uzyskujesz taką krawędź przecięcia, jak w dodatku Intersection dla włączonej opcji Use both faces (por. Rysunek 13.13.4). Zwróć uwagę opcję Separate. Gdy jest wyłączona — Faces→Intersect scala siatkę wzdłuż znalezionej krawędzi przenikania. Gdy opcja Separate jest włączona — ściany siatki są dzielone przez krawędź przecięcia na dwie rozłączne części (Rysunek 13.13.8):
Rysunek 13.13.8 Efekt działania opcji Separate
W takim przypadku każda z początkowych powłok (zaznaczona i nie zaznaczona) jest podzielona na dwie części (Rysunek 13.13.8b). Pod każdym z widocznych wierzchołków krawędzi przenikania znajdują się trzy inne. Aby szybko zaznaczyć każdą z wynikowych powłok, zanacz jeden z jej zewnętrznych wierzchołków, a następnie wywołaj polecenie Select→Linked (Ctrl-L, Rysunek 13.13.8a). Potem możesz łatwo odsunąć taką powłokę, „oczyszczając” w ten sposób uszyskaną krawędź z niepotrzebnych ścian.
Używaj dodatku Intersection gdy chcesz uzyskać tylko krawędź przenikania, a polecenia Faces→Intersect — gdy potrzebujesz odciętych ścian.
Scalenie dwóch obiektów oznacza scalenie ich siatek. Jednocześnie wszystkie wskazane obiekty, poza obiektem aktywnym, przestają istnieć.
Operację tę wykonuję często by przenieść uzyskaną krawędź przecięcia (p. str. 829) do drugiej siatki. Rysunek 13.14.1 przedstawia jedną z takich sytuacji. Pomocniczy obiekt (B.115.T.Main Wheel) to obrys (nie wygładzony) otworu na koło główne. Jego siatka zawiera także krawędź przecięcia z powierzchnią płata:
Rysunek 13.14.1 Pomocniczy obiekt — zawiera krawędź przecięcia ze skrzydłem
Tylko ta krawędź jest potrzebna do dalszej pracy. Powinna się jednak znaleźć w siatce skrzydła, aby można z niej było stworzyć otwór na podwozie główne. W tym celu należy scalić obydwa obiekty.
Zaznacz najpierw obiekt, który zniknie, a na koniec — obiekt, który ma pozostać po tej operacji. (Podczas scalania obiekt aktywny “wchłania” pozostałe). Następnie naciśnij Ctrl-J (Object→Join — Rysunek 13.14.2):
Rysunek 13.14.2 Połączenie siatek dwóch obiektów
Jedyną widoczną zmianą wywołania tego polecenia jest wygładzenie krawędzi pomocniczego obiektu.
Jeżeli jednak przełączysz się w tryb edycji (naciśnij Tab), zobaczysz że siatki tych dwóch obiektów uległy scaleniu (Rysunek 13.14.3):
Rysunek 13.14.3 Rezultat — połączone siatki
Pomocniczy obiekt (B.115.T.Main Wheel) przestał istnieć. Możesz teraz usunąć niepotrzebne wierzchołki z tej pomocniczej siatki, pozostawiając w płacie krawędź do wykonania otworu.
Operacją odwrotną do scalenia siatek obiektów jest wydzielenia siatki (Separate, str. 925).
Punkt odniesienia obiektu, używany dla określenia położenia, obrotu, i skali, nazywany jest w Blenderze środkiem obiektu. To polskie tłumaczenie angielskiego terminu origin wywołuje czasem niewłaściwe skojarzenia, bo środek obiektu często wcale nie leży w jego środku geometrycznym.
Stosunkowo często pojawia się konieczność zmiany położenia środka obiektu względem jego siatki. Najszybciej możesz to zmienić w następujący sposób (Rysunek 13.15.1):
zaznacz obiekt;
umieść kursor 3D w miejscu, w którym chcesz umieścić nowy środek obiektu;
Wywołaj polecenie Origin to 3D Cursor. Możesz to zrobić listy rozwijalnej Set Origin zakładki Tools przybornika Toolshelf (T — jak pokazuje to Rysunek 13.15.1) albo z menu Object→Transform;
Rysunek 13.15.1 Zmiana położenia środka obiektu
W efekcie środek obiektu znajdzie się w miejscu wskazanym przez kursor 3D. Zmiana położenia środka obiektu jest “jego wewnętrzną sprawą”. Nie powinna wpłynąć na jego rozmiar ani położenie w przestrzeni (chyba, że obiekt jest obrócony w jakiś specyficzny sposób!).
Czasami, podczas pracy, przydatna jest możliwość ukrycia na jakiś czas niektórych obiektów. Jest to szczególnie ważne wtedy, gdy jedna część zasłania drugą.
Aby ukryć zaznaczony obiekt (lub obiekty), po prostu naciśnij H (Object→Show/Hide→Hide Selected). To sprawi, że zaznaczenie zniknie (Rysunek 13.16.1):
Rysunek 13.16.1 Ukrycie wybranego obiektu
Aby ukryte obiekty stały się z powrotem widoczne — naciśnij Alt-H (Object→Show/Hide→Show Hidden).
Podczas pracy nad modelem potrzeba czasami ustawić płaszczyznę widoku (czyli płaszczyznę, po której możemy przesuwać obiekty) prostopadle do wybranego obiektu. Aby to zrobić, zaznacz obiekt, do którego chcesz się “wyrównać” (Rysunek 13.17.1a). Następnie rozwiń menu View→Align View→Align View to Selected (Rysunek 13.17.1b):
Rysunek 13.17.1 Wyrównanie aktualnego widoku do wybranego obiektu
Z menu Align View to Selected możesz wybrać jedną z sześciu “kardynalnych” płaszczyzn obiektu (Rysunek 13.17.1b). Efekt zobaczysz natychmiast (Rysunek 13.17.1c). W razie czego, jeżeli za pierwszym razem wybrałeś złą płaszczyznę kardynalną - wywołaj to polecenie jeszcze raz, i wybierz właściwą. Zwróć uwagę, że poszczególnym poleceniom z menu Align View to Selected przypisano skróty klawiatury. Są łatwe do zapamiętania: wystarczy poprzedzić skrót, którym zmieniasz projekcję względem globalnego układu współrzędnych klawiszem Shift. I tak, jeżeli normalnie wybierałeś widok z góry klawiszem 7, to na widok z góry w lokalnej płaszczyźnie aktywnego obiektu przełączy Cię Shift-7. Podobnie na lokalny rzut z boku przełączysz się skrótem Shift-3, a z powrotem na „globalny” rzut z boku — klawiszem 3.
Aby sprawdzić, na jakiej warstwie jest pojedynczy obiekt: zaznacz go, i przejdź do zestawu przycisków Object. Tam, w panelu Relations zobaczysz warstwę, do której należy wybrany element (Rysunek 13.18.1):
Rysunek 13.18.1 Warstwy, do których jest przypisany aktywny obiekt.
Klikając w kontrolki Layers (Rysunek 13.18.1) zmienisz przypisania obiektu do warstwy. Zwróć uwagę, że w Blenderze obiekt może być równocześnie na wielu warstwach (gdy będziesz klikał w warstwy z wciśniętym klawiszem Shift). Jeżeli włączysz widoczność którejkolwiek z nich — obiekt także stanie się widoczny.
Aby zmienić warstwę dla wielu obiektów jednocześnie: zaznacz je i naciśnij M (Object→Move to Layer…). Rysunek 13.18.2 pokazuje, jak to masz zrobić:
Rysunek 13.18.2 Zmiana warstwy dla grupy obiektów
Na kontrolce, pokazanej w oknie dialogowym (Rysunek 13.18.2) także możesz wskazać naraz wiele warstw. Pamiętaj, że jeżeli przypiszesz wybrane obiekty do warstwy, która jest aktualnie niewidoczna, znikną z ekranu!
Domyślnie Blender przypisuje materiał do siatki (por. str. 765, Rysunek 12.4.3, i str. 940). Czasami jednak potrzebujemy czegoś odwrotnego. Dotyczy to, na przykład, różnych drobnych części o identycznym kształcie — śrub, bolców, jakichś standardowych okuć. Zobacz ten trójkątny element okucia z otworem na oś, który pokazują: Rysunek 13.19.1a) i Rysunek 13.19.2a). Każde okucie składa się z dwóch takich blaszek. Wszystkie blaszki używają tej same siatki, o nazwie B.519.Nest. (Są to jej „klony”). Siatce jest przypisany materiał wyglądający jak „gładka stal” — B.Steel.Smooth. To barwa, w której te płaskowniki występowały najczęściej. Dopóki obiekt ma w kontekście Material włączoną opcję Data (Rysunek 13.19.1b), dopóty „dziedziczy” materiał swojej siatki:
Rysunek 13.19.1 Materiał przypisany do siatki
W innym miejscu — prowadnicy cięgna, przymocowanej do wręgi kadłuba (Rysunek 13.19.2a) — te same blaszki powinny być „pomalowane” na kolor reszty szkieletu: B.Skin.Inner. Czy można ten efekt osiągnąć bez powielania siatki? Tak, wystarczy przełączyć tryb kontekstu Material z Data na Object, i wybrać odpowiedni materiał (Rysunek 13.19.2b):
Rysunek 13.19.2 Materiał przypisany do obiektu
Co właściwie ten przełącznik Object robi? Informuje Blender, że dla tej konkretnej części należy użyć materiału przypisanego do obiektu, a nie do siatki (Data).
W panelu Display zestawu Object znajdziesz opcje wyświetlania obiektu. Pamiętaj, że dotyczą zawsze obiektu aktywnego (Rysunek 13.20.1):
Rysunek 13.20.1 Panel Display — opcje rysowania obiektu w oknie widoku.
Pola Type zazwyczaj nic nie musisz zmieniać — pozostaw sposób wyświetlania na Textured. No, może czasami, można przełączyć wyświetlanie powierzchni szyb kabiny na Wire. (Dzięki temu także podczas modelowania będziesz „przez nie widzieć” wnętrze kabiny).
Z kolei najczęściej wyświetlanym przeze mnie elementem dodatkowym są osie lokalnego układu współrzędnych. Ich widocznością steruje opcja Axis (Rysunek 13.20.2):
Rysunek 13.20.2 Włączenie rysowania osi lokalnego układu współrzędnych (Axis).
Czasami, podczas pracy z ograniczeniami, przydaje się włączyć także wyświetlanie nazw obiektów. Służy do tego opcja Name (Rysunek 13.20.3):
Rysunek 13.20.3 Włączenie rysowania nazwy obiektu (Name).
Aby „puścić w ruch” wykonany model, w grafice komputerowej używa się specjalnych szkieletów, nazywanych także armaturami (Armature). Skoro szkielet, to muszą być i kości. I tak się już utarło, że szkielety używane do animacji są złożone z „kości” (Bones). W tej sekcji pokażę ich zastosowanie na przykładzie animacji mechanizmu chowania kółka ogonowego (zasada działania — zob. str. 487, Rysunek 8.2.1)
W Blenderze armaturę można dodać jak każdy inny obiekt: najpierw ustaw kursor 3D w miejscu, gdzie ma się znaleźć początek pierwszej kości. Potem wywołaj Add→Armature→SingleBone (Rysunek 13.21.1a):
Rysunek 13.21.1 Dodanie armatury (pierwszej „kości”)
W pierwszym momencie po stworzeniu armatury, jeżeli pracujesz w mniejszym powiększeniu, możesz jej nie dostrzec (Rysunek 13.21.1b). To dlatego, że początkowo to jest jedna kość (skierowana do góry), o rozmiarze 1 jednostki (Rysunek 13.21.1c,d). Zdecydowanie odradzam zmianę skali armatury jako obiektu1.
Zamiast tego, przełącz się w tryb edycji, i zacznij dopasowywać położenie i rozmiar kości do obiektu (Rysunek 13.21.2):
Rysunek 13.21.2 Powiększenie kości do odpowiednich rozmiarów
W trybie edycji armatury kość możesz zaznaczyć na dwa sposoby. Gdy klikniesz PPM w jej trzon — podświetli się cała, i możesz ją cała przesunąć w inne miejsce. Gdy klikniesz PPM w jej końcówkę — podświetli się tylko umieszczona na niej kula. W tym trybie przesuwasz sam koniec kości (początek pozostaje tam, gdzie jest).
Zwróć uwagę że w oknie Properties zestaw Object Data ma teraz inną ikonę (Rysunek 13.21.3a). Teraz znajdziesz w nim ogólne ustawienia aktualnej armatury. Pojawił się także drugi zestaw — Bone — z ustawieniami aktualnie wybranej kości (Rysunek 13.21.3b):
Rysunek 13.21.3 Zawartość (Object Data) obiektu armatury i jego kości (Bone)
Domyślnie pierwsza kość nosi nazwę Bone, a następne — Bone.001, Bone.002, itd. Oczywiście, można je nazwać inaczej, adekwatnie do konkretnej roli, którą pełnią (np. ramie, przedramie czy coś w tym stylu). Nazwy kości muszą być unikalne tylko w obrębie pojedynczej armatury. (W innej armaturze możesz użyć takich samych nazw). W zestawach Object Data (Rysunek 13.21.3) możesz nadać nową nazwę całej armaturze, a w zestawie Object — obiektowi, do którego jest przypisana. (Najlepiej żeby były takie same).
Aby dodać do armatury nową kość, która łączy się z poprzednią, należy użyć lokalnej odmiany operacji wytłaczania (Extrude). Kliknij najpierw PPM w koniec kości — punkt, w którym ma się zaczynać następna kość (Rysunek 13.21.4a):
Rysunek 13.21.4 Wytłoczenie (Extrude) kolejnej kości
W odpowiedzi Blender powinien podświetlić samą końcówkę kości (Rysunek 13.21.4b). (Jeżeli zaznaczył całą — kliknij w PPM w to samo miejsce jeszcze raz. Cała kość i końcówka są wybierane naprzemiennie). Następnie naciśnij przycisk E (lub wybierz z menu Armature→Extrude). W tym momencie do armatury zostanie dodana nowa kość, której koniec możesz przesunąć myszką w odpowiednie miejsce (Rysunek 13.21.4c). Gdy klikniesz LPM — kość zostanie ostatecznie dodana. Gdybyś chciał z niej jednak zrezygnować — w trakcie przesuwania wystarczy nacisnąć Esc.
Nowa kość otrzymuje automatycznie taką samą nazwę, jak kość z której powstała, z dodaną numeryczną końcówką (np. z Bone wytłoczysz Bone.001, a z Bone.001 — Bone.002). Blender przypisuje ją także do poprzedniej kości jako „rodzica” (zobacz pole Parent na panelu Relations zestawu Bone — Rysunek 13.21.4d).
„Rozpięliśmy” już dwie kości, odpowiadające wahaczowi i amortyzatorowi kółka ogonowego. Inna sprawa, że są rysowane przez Blender jako dość duże ośmioboki (Display:Octahedral). Na szczęście w panelu Armature:Display masz do wyboru kilka innych sposobów reprezentacji kości. Przełącz się na przykład na „pręty” (Stick — Rysunek 13.21.5):
Rysunek 13.21.5 Włączenie Pose Mode i dostosowanie wyświetlania kości
Zobaczmy, jak to wygląda w działaniu. Przełącz się w specjalny tryb „pozowania” — Pose Mode. Wystarczy wybrać Pose Mode z listy trybów pracy w nagłówku okna widoku 3D
Zawartość listy trybów pracy zależy od rodzaju aktywnego obiektu. Tryb Pose Mode pojawia się na niej tylko wtedy, gdy aktywnym obiektem jest jakaś armatura.
W Pose Mode włącz w przyborniku opcję Auto IK 2 (Rysunek 13.21.6a). To spowoduje, że cały układ kości zacznie się zachowywać jak prawdziwy zespół powiązanych przegubami prętów (Rysunek 13.21.6b):
Rysunek 13.21.6 Poruszanie armaturą w trybie Auto IK
Spróbujmy teraz poruszać naszą armaturą. Kliknij PPM w kość Bone.001, aby ją zaznaczyć (powinna się podświetlić na niebiesko). Następnie naciśnij G (Pose→Transform→Grab) i przesuń koniec zaznaczonej kości w nowe miejsce (Rysunek 13.21.6b). Czy widzisz? Obydwie kości poruszają się całkiem realistycznie, jak dwa połączone przegubowo segmenty.
W trybie pozowania można eksperymentować, ustawiając armaturę na najróżniejsze sposoby. Gdy przełączysz się z powrotem w tryb edycji, wszystko powróci do pozycji początkowej (Rest position).
Teraz wystarczy przyłączyć do tych kości odpowiednie obiekty. Upewnij się, że jesteś w Pose Mode.
Aby zaznaczyć obiekt i kość tak, jak to jest pokazane poniżej, musisz zacząć zaznaczanie w trybie Pose Mode. Inaczej nie uda Ci się wskazać konkretnej kości.
Jeżeli chodzi o amortyzator, to w hierarchii obiektów jego „rodzicem” powinien być niewielki B.355.Connector. Zaznacz go (PPM). Do złączki B.535.Connector powinny być hierarchicznie przypisane (relacją „parent — child”): cylinder (B.540.Damper) i tłok (B.550.Piston). W przypadku obiektów przyłączonych do kości, bardzo ważny jest środek. Najlepiej, aby się znajdował w tym samym miejscu, co początek kości. Zacznij od odłączenia obiektu B.535.Connector od obiektu nadrzędnego (Alt-P, Clear Parent: Clear and Keep Transform).
Jeżeli w Pose Mode, mimo klikania PPM, Blender nie chce obiektu podświetlić, to oznacza to, że masz zaznaczoną jakaś kość. Wyłącz ją (klawisz A — Select/Deselct All) i spróbuj jeszcze raz.
Zwróć uwagę, że to zaznaczenie przełączyło tryb pracy w Object Mode (Rysunek 13.21.7a):
Rysunek 13.21.7 Zaznaczenie początku amortyzatora i kości (Bone.001)
Teraz dodaj do wybranych elementów odpowiednią kość — w tym przypadku to Bone.001. Kliknij w nią PPM, trzymając wciśnięty klawisz Shift. Spowoduje to przełączenie Blendera w Pose Mode. Powinieneś w tym momencie widzieć: obiekt, który chcesz przypisać do kości w kolorze bladoróżowym („pozostałe zaznaczenie”) i kość w kolorze niebieskim (Rysunek 13.21.7b).
Gdy dla tak wskazanych obiektów naciśniesz Ctrl-P, pojawi się menu Set Parent To, z którego należy wybrać opcję Bone (Rysunek 13.21.8a):
Rysunek 13.21.8 Przypisanie amortyzatora do kości (Bone.001)
To wszystko — złączka amortyzatora jest przypisana do kości (a wraz z nią — wszystkie jej obiekty „potomne”: cylinder i tłok, czyli cały amortyzator). To przypisanie widać właściwościach obiektu B.535.Connector (Rysunek 13.21.8b) — jego rodzicem jest kość Bone.001 z armatury Armature.
W ten sam sposób przypisz do Bone.001 tłok amortyzatora, a rodzicem wahacza (B.530.SwingArm) zrób pierwszą kość armatury — Bone (Rysunek 13.21.9):
Rysunek 13.21.9 Przypisanie wahacza do kości Bone | Rysunek 13.21.10 Rezultat — składające się kółko ogonowe |
Zwróć uwagę, że środek wahacza znajduje się tam, gdzie początek kości Bone — w osi, do której wahacz jest przyczepiony. Teraz wystarczy w Pose Mode powtórnie przesunąć poziomo (G,Y) koniec kości amortyzatora (Bone.001) — i cały zespół kółka ogonowego składa się i rozkłada jak pierwowzór (Rysunek 13.21.10)!
Skoro nam tak dobrze idzie, włączmy w ten mechanizm popychacz (B.565.Rail). W prawdziwym samolocie ten element przesuwał koniec amortyzatora do tyłu i do przodu, wymuszając otwieranie i zamykanie podwozia. Wytłocz z końca Bone.001 kolejną, poziomą kość (Bone.002) (Rysunek 13.21.11a):
Rysunek 13.21.11 Wytłoczenie trzeciej kości (Bone.002) i przypisanie jej do popychacza
Przypisz do kości Bone.002 popychacz B.565.Rail (Rysunek 13.21.11b). Teraz wystarczy zaznaczyć tę ostatnią kość (Rysunek 13.21.12a) i przesunąć:
Rysunek 13.21.12 Niespodziewany rezultat poziomego przesunięcia kości Bone.002
Ale zaraz, dlaczego w miarę, jak przesuwasz koniec Bone.002 w lewo, cały popychacz coraz bardziej odchyla się do góry (Rysunek 13.21.12b)!?
Jeżeli podczas przesuwania przyjrzysz się dokładniej zachowaniu kości Bone.002, zauważysz że w miarę oddalania się od „pozycji spoczynku” coraz bardziej odchyla się do dołu. A skoro kość się odchyla, to robi to także jej obiekt potomny — popychacz.
W takim razie, może jeżeli przesuwać będziemy koniec poprzedniej kości — amortyzatora (Bone.001) — to następna (Bone.002) podczas ruchu zachowa poziome położenie? Spróbujmy (Rysunek 13.21.13):
Rysunek 13.21.13 Podobny efekt dla kości Bone.001 | Rysunek 13.21.14 Rozwiązanie problemu — dodanie do popychacza ograniczenia Locked Track. |
Niestety, nic z tego. Pozostawiona „samej sobie” swobodna kość Bone.003 odchyla się jeszcze bardziej niż poprzednio. Takie są, niestety, efekty działania kinematyki odwrotnej (Auto IK).
Ten problem można rozwiązać za pomocą ograniczenia:
wstaw na linii ruchu środka popychacza (osi obrotu tłoka amortyzatora) pomocniczy, pusty obiekt (Add→Empty — szczegóły na str. 814). Ten obiekt będzie pełnić rolę „celu”;
dodaj do popychacza ograniczenie Locked Track (szczegóły — zob. str. 849). W parametrach ograniczenia lokalna oś Z obiektu na śledzić umieszczony z przodu „cel”, a obrót może następować wyłącznie wokół lokalnej osi X;
Rysunek 13.21.14 przedstawia rezultat tego rozwiązania. Popychacz ignoruje, dzięki dodanemu ograniczeniu, poprzeczne obroty kości Bone.002. Gdy przesuwasz poziomo koniec kości Bone.001, cały zespół prawidłowo składa się i rozkłada.
Obiekt z ograniczeniem Track To jest zawsze zorientowany w przestrzeni tak, by jego oś była skierowana na środek wskazanego celu (innego obiektu). Domyślnie w cel kierowana jest lokalna oś Z, ale oczywiście we właściwościach ograniczenia można wskazać inną (X lub Y).
Najszybsza metoda utworzenia ograniczenia Track To to:
zaznaczenie obiektu/obiektów podlegających ograniczeniu;
zaznaczenie obiektu - celu (to musi być ostatni zaznaczony — tzn. to musi być obiekt aktywny!);
naciśnięcie skrótu Ctrl-T i wybranie z podręcznego menu polecenia Track To Constraint:
Rysunek 13.22.1 pokazuje, jak to zazwyczaj wygląda:
Rysunek 13.22.1 Dodanie ograniczenia Track To za pomocą skrótu Make Track
Bardziej ogólna metoda, pozwalająca dodać każde ograniczenie, polega na zaznaczeniu najpierw „celu” a potem obiektu “ograniczanego”, i wywołaniu polecenia Object→Constraints→Add Constraint (with Targets). Lista rozwijalna, która się wówczas pojawi, zawiera wszystkie typy ograniczeń.
Właściwości ograniczenia Track To wybranego obiektu można zmienić w zestawie Object Constraints (), i panelu o tej samej nazwie (Rysunek 13.22.2):
Rysunek 13.22.2 Właściwości ograniczenia Track To
W przypadku tworzenia powiązania kamery z celem, nie zapomnij włączyć przełącznika Target Z.
Najprostszą drogą do usunięcia ograniczenia Track To jest użycie skrótu Alt-T. W menu, które wówczas się pojawi, warto wybrać opcję Clear Track and Keep Transform. Po jej wybraniu obiekt/obiekty zostaną “uwolnione”, ale nie zmienią swojego położenia ani orientacji w przestrzeni.
Innymi drogami do usunięcia ograniczenia są:
usunięcie pojedynczego ograniczenia ze stosu ograniczeń aktualnego obiektu (Rysunek 13.22.2).
Te metody nie gwarantują jednak zachowania aktualnej transformacji obiektu, jak to ma miejsce przy użyciu skrótu Alt-T.
Ograniczenie Locked Track działa podobnie do Track To (por. str. 840). Także tutaj obiekt obraca się zawsze tak, by wskazana w parametrach ograniczenia oś lokalnego układu współrzędnych była skierowana na środek wskazanego celu. Jednak w tym przypadku obiekt może się obracać tylko wokół jednej osi (Rysunek 13.23.1):
Rysunek 13.23.1 Zasada działania ograniczenia Locked Track.
Oznacza to, że wybrana oś może nie być dokładnie skierowana na cel, (bo np. cel jest przesunięty w bok, poza płaszczyzną obrotu). Tym niemniej obiekt z ograniczeniem Locked Track zawsze będzie się „starał wycelować” ją jak najlepiej — na tyle, na ile pozwala mu podana w parametrach oś obrotu.
Ograniczenia typu Locked Track doskonale nadają się do modelowania mechanizmów. Prawie każdy element takich zespołów ma „jeden stopień swobody” — może się obracać wokół jednej osi.
Aby dodać ograniczenie Locked Track, zaznacz odpowiedni obiekt, i w zestawie Constraints, naciśnij przycisk Add Constraint (Rysunek 13.23.2a):
Rysunek 13.23.2 Dodanie do obiektu ograniczenia Locked Track.
Z listy rozwijalnej, która się pojawi ponad przyciskiem, wybierz opcję Locked Track. Blender wstawi to ograniczenie na koniec listy („stosu”) ograniczeń przypisanych do obiektu. W pierwszej chwili pole Locked Track w panelu ograniczenia, (to z nazwą), jest czerwone (Rysunek 13.23.2b). To oznacza, że coś z parametrami tego ograniczenia jest nie tak. W tym przypadku w polu Target nie wpisaliśmy jeszcze nazwy obiektu — „celu”. Gdy to uzupełnimy, czerwony kolor zniknie z panelu.
Zróbmy to: wpisz w pole Target nazwę obiektu Target.001 (którego używam wyłącznie w celach szkoleniowych). Oprócz tego na liście To zaznacz oś Z, a na Lock — X (Rysunek 13.23.3a):
Rysunek 13.23.3 Przykład przypisania parametrów Locked Track.
Gdy teraz spróbujesz przesunąć ograniczony obiekt do góry — zobaczysz że zacznie się obracać tak, by jego oś Z nadal „celowała” w środek obiektu Target.001 (Rysunek 13.23.3b). Gdybyś zaczął przesuwać ten obiekt B.565.Rail wzdłuż lokalnej osi X, nie spowodowałoby to żadnego dodatkowego obrotu (tym właśnie się różni to ograniczenie od ograniczenia Track To).
Ograniczenie Locked Track doskonale się nadaje do sterowania ruchem sterów, lotek lub klap samolotu. Zazwyczaj przypisuje się je do ich osi obrotu (zamodelowanych jako oddzielny obiekt — por. str. 149). Często jednak te osie nie są ustawione równolegle do globalnego układu współrzędnych. (Tak bywa, gdyż w czasie formowania samolotu nie zawsze byłeś w stanie o to odpowiednio zadbać). Pojawia się wówczas problem: jak umieścić obiekt — „cel” ograniczenia Locked Track we właściwym położeniu?
Przykładem takiego problemu jest klapa skrzydła, którą pokazuje Rysunek 13.23.4:
Rysunek 13.23.4 Problem: określenie dokładnego położenia „celu” ograniczenia Locked Track
Klapa to z grubsza prostokątny fragment powierzchni. Jest przymocowana (relacją Parent) do długiego walca, imitującego jej zawiasy (por. str. 275). Klapę należy „zmechanizować”: przypiszemy osi X zawiasów ograniczenie Locked Track, śledzące specjalnie w tym celu przygotowany obiekt — „cel” (Rysunek 13.23.4a). Obrót będzie się odbywał wokół lokalnej osi Z. Dzięki temu użytkownik będzie mógł sterować klapą za pomocą łatwo dostępnego uchwytu („celu”), a nie ukrytej głęboko osi, którą trudno jest wskazać myszką.
Niestety, lokalna oś X zawiasów klapy jest pochylona w stosunku do globalnego układu współrzędnych, w którym umieściliśmy obiekt — „cel”. Jak ustawić ten „uchwyt” dokładnie w punkcie 1 (Rysunek 13.23.4a), aby po włączeniu ograniczenia zamknięta klapa się nie „poruszyła”? Jak wyznaczyć drugie położenie „uchwytu”, odpowiadające całkowicie wychylonej (w tym przypadku — o kąt 45º) klapie (punkt 2, Rysunek 13.23.4b)?
Aby wyznaczyć górne położenie „celu”, przejdź do edycji siatki zawiasów (Rysunek 13.23.5a):
Rysunek 13.23.5 Umieszczenie kursora 3D w górnym położeniu „celu”
W tym przypadku tak się szczęśliwie składa, że siatka ma wierzchołek w tym samym punkcie, co środek (punkt odniesienia) tego obiektu (Rysunek 13.23.5c). Zaznacz go, i wytłocz z niego nową krawędź wzdłuż lokalnej osi X (E, X, X). Odsuń jej koniec na jakąś większą odległość (Rysunek 13.23.5b). Powinna być na tyle duża, by końcowy wierzchołek znalazł się znacznie poza powierzchnią płata. Potem wystarczy wywołać polecenie, które umieści w tym punkcie kursor 3D: Shift-S (Snap), Cursor to Selected (Rysunek 13.23.5d).
Umieściliśmy już w odpowiednim miejscu „punkt zaczepienia” — kursor 3D. Mógłbyś teraz odczytać jego współrzędne i wpisać je jako nowe położenie uchwytu. Znam jednak prostszą metodę, nie wymagającą przepisywania, które zajmuje czas i podczas którego można się pomylić. To przesuwanie obiektów za pomocą zmiany skali (Rysunek 13.23.6):
Rysunek 13.23.6 Umieszczenie środka obiektu — „celu” w punkcie wyznaczonym przez kursor 3D
Zaznacz obiekt, który ma być umieszczony tam, gdzie znajduje się kursor 3D. Następnie przełącz Pivot w tryb 3D Cursor i włącz przełącznik Manipulate center points, umieszczony obok (Rysunek 13.23.6a). (Jego włączenie powoduje, że zmiana skali i obrót stosuje się nie do całego obiektu, a tylko do jego środka). Potem naciśnij S (Scale), i trzymając wciśnięty klawisz Ctrl przesuń kursor myszki tak, by znalazł się ponad kursorem 3D. Nasz obiekt („uchwyt”) podąży w tym samym kierunku, a gdy skala transformacji osiągnie (0,0,0) — jego środek znajdzie się w docelowym miejscu (Rysunek 13.23.6a,b). Zatwierdź tę transformację.
Po skalowaniu z użyciem przełącznika Manipulate center points nie zapomnij go wyłączyć, bo inaczej nie będziesz mógł obrócić żadnego obiektu!
W analogiczny sposób możesz także określić drugie położenie „uchwytu”, odpowiadające klapie całkowicie otwartej (Rysunek 13.23.7):
Rysunek 13.23.7 Wyznaczenie dolnego położenia obiektu — „celu”
Wystarczy:
obrócić oś (zawiasy) o odpowiedni kąt (tutaj: 45º);
przejść do edycji siatki zawiasów;
ponownie zaznaczyć nasz „roboczy” wierzchołek i umieścić na nim kursor 3D;
zakończyć edycję siatki zawiasów;
przesunąć „uchwyt” do kursora 3D;
Na koniec usuń, oczywiście, z siatki zawiasów wytłoczony podczas tej operacji wierzchołek!
Aby części naszego modelu nie mogły się poruszać po całej scenie, tylko same „pilnowały” swoich właściwych położeń, można zastosować ograniczenie Limit Location. Oczywiście, opłaca się go użyć tylko dla kluczowych elementów. Na przykład — dla uchwytu odpowiedzialnego za chowanie i wysuwanie podwozia (Rysunek 13.24.1):
Rysunek 13.24.1 Położenie i dopuszczalny zakres ruchu „uchwytu”, sterującego pozycją kółka ogonowego.
O pozycji podwozia decyduje uchwyt X.500.Handle, którego środek jest śledzony przez lokalną oś Y wahacza (Rysunek 13.24.1a). (Ten efekt jest uzyskany pomocą ograniczenia Locked Track — por. str. 849). Gdy podwozie jest całkowicie otwarte, uchwyt znajduje się w punkcie X=3,Y=-55, Z=-3 (Rysunek 13.24.1a,b). Na razie uchwyt można omyłkowo przesunąć w każdą stronę, bez żadnych ograniczeń. Użytkownik może się więc pomylić, i ustawić podwozie w nienaturalnej pozycji. Ograniczymy to, pozwalając uchwytowi X.500.Handle przesuwać się wzdłuż osi Z, w zakresie od -3 (podwozie wysunięte) do +8 (podwozie schowane) (Rysunek 13.24.1c).
Aby dodać ograniczenie Limit Location, zaznacz obiekt (uchwyt), i w zestawie Constraints z listy Add Constraint wybierz opcję Limit Location (Rysunek 13.24.2a):
Rysunek 13.24.2 Dodanie do obiektu ograniczenia Limit Location.
Blender wstawi to ograniczenie na koniec listy („stosu”) ograniczeń przypisanych do obiektu. W pierwszej chwili wszystkie pola Minimum* i Maximum* są wyłączone (Rysunek 13.24.2b). Oznacza to, że nie obowiązuje jeszcze żadne z nich (tzn. ograniczenie nie jest aktywne).
Zacznij od przepisania w pola Minimum* i Maximum* współrzędnych krańcowych położeń uchwytu. Możesz je np. odczytać z panelu Transform z przybornika Properties (N) (Rysunek 13.24.3):
Rysunek 13.24.3 Przykład ustawienia parametrów ograniczenia Limit Location.
Gdy je przepiszesz, włącz poszczególne ograniczenia (Rysunek 13.24.3b). W pole Maximum Z wpisz wartość dopuszczalnego, górnego położenia uchwytu. Warto jeszcze włączyć opcję For Transform. (Jeżeli tego nie zrobisz, po ewentualnym zdjęciu ograniczeń pozycja obiektu może Cię zaskoczyć). Przełącz także układ współrzędnych (Convert), w którym obliczane są ograniczenia na Local Space. Dlaczego właśnie ten? Także po to, by uniknąć niespodzianek. W przyszłości, podczas kompozycji sceny, możesz chcieć przechylić lub przesunąć model. Uchwyty powinny być wkomponowane w hierarchię jego zespołów, i podążać za ruchem całego samolotu. Przełączenie ich ograniczeń na lokalny układ współrzędnych to właśnie zapewnia.
Na przykład X.500.Handle jest przypisany do nieruchomego okucia wahacza: B.545.ArmBase (Rysunek 13.24.4a):
Rysunek 13.24.4 Rezultat wyboru dla Limit Location lokalnego układu współrzędnych (Local).
Gdy pochylisz to okucie (tak jak mógłbyś pochylić cały samolot, np. aby wyglądał jak podczas nurkowania), pochyli się odpowiednio także „sztywno” powiązany z nim uchwyt (Rysunek 13.24.4a). Gdybyś w ograniczeniu Limit Location pozostawił jako Convert domyślny układ współrzędnych World Space, to ograniczenie działałoby dalej pionowo, i podwozie „samo” zaczęłoby Ci się podczas obrotu okucia przesuwać. (Taki problem miałem we wcześniejszych wersjach Blendera — do 2.44 — w których Limit Location było zawsze obliczane w World Space). Na szczęście wybór Local Space powoduje, że osie ograniczenia są „przymocowane” do lokalnego układu współrzędnych uchwytu. Dzięki temu ich położenie względem reszty modelu nie ulega zmianie (Rysunek 13.24.4b) i w czasie animacji samolotu nie jesteś narażony na takie zaskoczenia, jak samoczynne otwieranie się podwozia.
Ograniczenie Transformation można traktować jako rodzaj „uniwersalnej przekładni”. Pokażę je na przykładzie przełożenia ruchu pionowego uchwytu (X.500.Handle) na poziome przesunięcie popychacza (B.565.Rail) (Rysunek 13.25.1):
Rysunek 13.25.1 Przykład typowego zagadnienia dla ograniczenia Transformation.
Gdy użytkownik przesuwa uchwyt do góry, popychacz powinien przesuwać się w lewo, przy czym każdy z nich ma inną prędkość ruchu. W czasie gdy uchwyt X.500.Handle przesunie się o 11 jednostek, popychacz B.565.Rail ma przebyć tylko 3.5 (Rysunek 13.25.1). Aby uzyskać ten efekt, przypiszemy do popychacza ograniczenie Transformation.
Aby dodać to ograniczenie zaznacz obiekt (popychacz), i w zestawie Constraints z listy Add Constraint wybierz opcję Transformation (Rysunek 13.25.2a):
Rysunek 13.25.2 Dodanie do obiektu ograniczenia Transformation.
Blender wstawi to ograniczenie na koniec listy („stosu”) ograniczeń przypisanych do obiektu. W pierwszej chwili pole Transformation w panelu ograniczenia, (to z nazwą), jest czerwone (Rysunek 13.23.2b). To oznacza, że coś z parametrami tego ograniczenia jest nie tak. W tym przypadku w polu Target nie wpisaliśmy jeszcze nazwy obiektu — „celu”. Gdy to uzupełnimy, czerwony kolor zniknie z panelu.
Zwróć uwagę, że domyślnie włączone jest przełożenie położenia (Loc) obiektu — „celu” (Source) na położenie (Loc) obiektu Destination (obiektu, do którego jest przypisane ograniczenie). Możliwe są jednak i inne przełożenia — np. obrotu (Rot) na położenie (Loc), skali (Scale) na obrót (Rot), itp. Wszystko zależy wyłącznie od tego, jaką kombinację tych opcji zaznaczysz.
Ustawienia transformacji dla popychacza B.565.Rail przedstawia Rysunek 13.25.3:
Rysunek 13.25.3 Przykład ustawienia parametrów ograniczenia Transformation.
W pole Target wpisałem nazwę uchwytu — X.500.Handle. W zespole Source pozostawiłem śledzenie położenia (Loc), i wpisałem pełen zakres dopuszczalnych ruchów uchwytu (Z: Min = -3.00, Max = 8.00). Ten ruch przekładam na zmianę współrzędnej Y popychacza. Dlatego w zespole Source to Destination Mapping wybrałem dla współrzędnej Y z listy rozwijalnej kombinację Z→Y (Rysunek 13.25.3). W zespole Destination podajemy wartości zmiany odpowiednich współrzędnych. Dlatego w polu Y:Min pozostawiłem wartość 0.00. W polu Y:Max wpisałem wartość mniejszą: - 3.50 (w ten sposób zapewniłem popychaczowi ruch z prawej na lewo). Oczywiście, zmieniłem także typ (Space) układów współrzędnych celu i obiektu transformowanego na Local Space, by to ograniczenie było niezależne od orientacji modelu w przestrzeni (por. str. 854).
Ustawienia, które pokazuje Rysunek 13.25.3, przekazują Blenderowi prostą zależność:
dla położeń uchwytu pomiędzy Z = -3.00 ... +8.00 współrzędna Y punktu odniesienia (origin) popychacza ma się proporcjonalnie zmniejszać, o wartości od 0.00 do -3.50;
Wartości przesunięcia dla pośrednich położeń obiektu transformowanego są wyliczane w sposób proporcjonalny. Taka zależność nazywana jest także liniową: np. gdy uchwyt jest „w połowie drogi” — Z = +2.50 — to popychacz także jest już przesunięty o połowę dystansu: Y = - 1.75.
Rysunek 13.25.4 przedstawia rezultat działania ograniczenia Transformation — ruch popychacza B.565.Rail wymuszony przez przesunięcie uchwytu X.500.Handle:
Rysunek 13.25.4 Działanie ograniczenia Transformation
Liniowy sposób działania ograniczenia Transformation powoduje, że zazwyczaj nie można go użyć do „przełożenia” bardziej złożonych ruchów, np. równoczesnego obrotu względem wszystkich trzech osi. (W przypadku tak złożonego obrotu pośrednie położenia obiektu mogą być czasami zaskakujące). Należy sobie zdawać sprawę że nawet zwykłe pokrywy (np. podwozia) zamykane za pomocą popychaczy nie obracają się w sposób liniowy. Obrót uzyskany za pomocą Transformation będzie tylko przybliżeniem ich prawdziwego ruchu.
Dla przykładu, spróbujmy przełożyć za pomocą ograniczenia Transformation przesunięcie uchwytu na obrót pokrywy podwozia. Zacznijmy od sprawdzenia jak zmieniają się jego kąty obrotu (Rysunek 13.25.5):
Rysunek 13.25.5 Kąty obrotu, wyświetlane dla dwóch krańcowych położeń pokrywy podwozia
Zawiasy pokrywy, które należy obrócić, to zwykłe cylindry, wyciągnięte do odpowiedniego rozmiaru wzdłuż lokalnych osi Z (Rysunek 13.25.5a). Ich „rodzicem” jest kadłub. Są względem niego obrócone — wokół wszystkich trzech osi (por. panel Transform z przybornika Properties — Rysunek 13.25.5b). Do zawiasów jest „przymocowana” (relacją Parent) sama pokrywa. Aby ją otworzyć, należy obrócić zawias wokół lokalnej osi Z o 145º (Rysunek 13.25.5c). Porównaj jednak w panelu Transform(przybornik Properties) obroty wokół osi X, Y, Z przed i po tej transformacji (por. Rysunek 13.25.5b z Rysunek 13.25.5d). Zauważ, że każdy z nich uległ zmianie: wokół osi X (z 85.487º na 95.479º), wokół osi Y (z 0.367º na 145.491º), wokół osi Z (z 6.166º na 9.305º).
W panelu Transform przybornika Properties Blender wyświetla obroty względem osi obiektu „rodzica”. Jednak ich stan początkowy jest taki, jaki istniał w chwili przypisania poleceniem Set Parent.
Wygląda na to, że Blender „zapamiętuje” kąty obrotu obiektu w chwili gdy przypisujesz go do obiektu nadrzędnego poleceniem Set Parent. (Dokładniej rzecz biorąc — zapamiętuje w tym momencie tzw. „przekształcenie odwrotne”) . Stąd kąty obrotu większości obiektów, które widzisz w oknie Properties, nie są ani kątami wyrażonymi w globalnym układzie współrzędnych, ani kątami mierzonymi względem osi „rodzica”. Stwarza to problem przy zastosowaniu ograniczenia Transformation, bo często obrót wokół jednej osi jest wyrażony za pomocą złożenia trzech obrotów względem globalnego układu współrzędnych!
Zmianę kąta obrotu dla ograniczenia Transformation na pewno poprawnie odczytasz sprawdzając najpierw poleceniem Rotate (R), o jaki kąt musisz obrócić obiekt wokół jego lokalnej osi (np. w przypadku który pokazuje Rysunek 13.25.5b to 145º). Kąty wyświetlane w Properties:Transform mogą być mylące!
No dobrze, skoro znamy już kąt obrotu, to przypiszmy do zawiasów ograniczenie Transformation. Powiążmy je ze zmianą położenia (Loc) uchwytu (Target: X.500.Handle) wzdłuż osi Z (od Z = -3 do Z = 8) (Rysunek 13.25.6):
Rysunek 13.25.6 Ograniczenie, przypisane do zawiasów pokrywy podwozia
Ustalmy w obszarze Destination, że zmieniać się ma obrót (Rot). W sekcji Source to Destination Mapping nie musimy niczego zmieniać, bo przełożenie Z→Z jest tam ustawione domyślnie. W pole Z:Min wpiszmy zmianę kąt obrotu wokół osi Z dla położenia „otwarte”. W pola Z:Max pozostawiamy (w tym przypadku) wartość 0.
Po przypisaniu ograniczenia spróbuj przesunąć uchwyt (Rysunek 13.25.7). Zawiasy obracają się automatycznie w ten sam sposób, jak to sprawdziliśmy obracając je „ręcznie” wokół osi Z:
Rysunek 13.25.7 „Liniowa” droga od jednego do drugiego położenia krańcowego
W Blenderze wersji 2.67 i wcześniejszych ograniczenie Transformation z takimi ustawieniami działało tylko wtedy, gdy kąty obrotu zawiasu (wyświetlane w panelu Properties:Transform) były zerowe. Aby to uzyskać musiałem wstawić jako rodzica tego elementu (Rysunek 13.25.8b) pomocniczy obiekt typu Empty (por. str. 816). Ten nowy „rodzic” jest ustawiony równolegle do zawiasu (w jego Properties:Transform zobaczysz takie same kąty — por. Rysunek 13.25.8a), dzięki czemu zawias może mieć wszystkie kąty zerowe:
Rysunek 13.25.8 Pomocniczy obiekt — nowy „rodzic” zawiasu
Wstawienie takiego obiektu pomocniczego, jaki pokazuje Rysunek 13.25.8, wymagało nieco pracy. Trzeba było najpierw odłączyć obiekt zawiasów od dotychczasowego rodzica (Clear Parent), a potem wstawić w to samo miejsce pomocniczy obiekt Empty. Następnie zapamiętać kąty obrotu zawiasu, wyzerować je, i przypisać zawias do obiektu Empty (Set Parent). Wreszcie przypisać obiektowi Empty zapamiętane kąty obrotu i przypisać go do oryginalnego rodzica zawiasów.
Aby ułatwić sobie taką operację, przygotowałem mały dodatek o nazwie Add Empty Parent. Myślę, że to polecenie może się nadal przydać do wielu inych zastosowań, dlatego krótko je tutaj opiszę.
Plik dodatku znajdziesz w pakiecie source.zip, nazywa się tam source\scripts\addons\object_add_parent.py (por. str. 22). Po zainstalowaniu powinieneś go znaleźć w sekcji Addons:Object (por. str. 767) i aktywować (Rysunek 13.25.9):
Rysunek 13.25.9 Aktywacja dodatku Add Empty Parent
Użycie dodatku jest proste: zaznacz obiekt, do którego chcesz uzyskać zerowe kąty obrotu. Następnie naciśnij W, by otworzyć menu Specials. Wywołaj stamtąd polecenie Add Empty Parent, a w tym samym miejscu co zaznaczony obiekt pojawi się odpowiedni obiekt Empty (Rysunek 13.25.10):
Rysunek 13.25.10 Użycie dodatku Add Empty Parent
Skrypt umieszcza obiekt Empty na tej samej warstwie (warstwach) co zaznaczony obiekt potomny. Nadaje mu taką samą nazwę, z końcówką “.Parent”.
Pamiętaj, aby przed przypisaniem, zmianą lub usunięciem rodzica zmniejszyć współczynniki Influence wszystkich ograniczeń obiektu potomnego do zera! Gdy o tym zapomnisz, Blender przypisze temu obiektowi jakieś dziwne współrzędne. Gdy nowy rodzic jest już przypisany, możesz z powrotem przestawić współczynniki Influence ograniczeń na ich oryginalne wartości (zazwyczaj to 1.0);
Takie szybkie wstawienie dodatkowego obiektu nadrzędnego przydaje się także do innych zastosowań (np. do obejścia problemu z ujemną skalą transformowanego obiektu)
Ograniczenie Stretch To łączy w sobie dwie operacje: skierowania na “cel” określonej osi obiektu (przypomina w tym działanie Locked Track), i zmianę skali wzdłuż tej osi. Nadaje się doskonale do drobnych “naciągnięć”, maskujących pewne niedokładności w torach ruchu poszczególnych części mechanizmów. Popatrz, na przykład, na popychacze pokrywy kółka ogonowego (Rysunek 13.26.1):
Rysunek 13.26.1 Przykład typowego zagadnienia dla ograniczenia Stretch To.
Rysunek 13.26.1a) pokazuje mechanizm podwozia w pozycji “otwarte”. Popychacz (B.575.Stick.L) jest tu skierowany na okucie pokrywy ograniczeniem Locked Track. W tym położeniu wszystko wygląda poprawnie — w koniec popychacza wpasowana jest oś beczułki okucia. Gdy jednak zaczniesz składać podwozie, zauważysz że w szerokim zakresie położeń pośrednich popychacz “odrywa” się od okucia (Rysunek 13.26.1b). Na zmianę dystansu pomiędzy obiektem i jego celem ograniczenie Track To nic poradzić nie może1. Pomoże za to inne — Stretch To.
Aby dodać ograniczenie Stretch To, zaznacz obiekt (popychacz), a potem w zestawie Constraints z listy Add Constraint wybierz Stretch To (Rysunek 13.26.2a):
Rysunek 13.26.2 Dodanie do obiektu ograniczenia Stretch To.
W pierwszej chwili pole Stretch To w panelu ograniczenia, (to z nazwą), jest czerwone (Rysunek 13.23.2b). To oznacza, że coś z parametrami tego ograniczenia jest nie tak. W tym przypadku w polu Target nie wpisaliśmy jeszcze nazwy obiektu — „celu”. Gdy to uzupełnimy, czerwony kolor zniknie z panelu.
Wpisz w pole Target nazwę beczułki okucia (B.550.Dolly.L). Oprócz tego na liście Plane zaznacz oś X, a na Volume — None (Rysunek 13.26.3a):
Rysunek 13.26.3 Przykład przypisania parametrów Stretch To.
Ograniczenie Stretch To zawsze „celuje” we wskazany w polu Target obiekt lokalną osią Y (Rysunek 13.26.3b). (Nie można tego zmienić, tak jak w Locked Track). Jeżeli masz inaczej zorientowane osie — musisz wcześniej obrócić siatkę względem środka obiektu. Możesz nadal, podobnie jak w Locked Track, określić oś, która ma pozostać nieruchoma — X lub Z. (Traktuj ją jako „oś obrotu” — por. Rysunek 13.26.3b). Po przypisaniu obiektu Blender odnotowuje w polu Rest Length odległość do środka „celu”. Od tej chwili zaczyna zmieniać skalę obiektu wzdłuż osi Y o tyle, o ile różni się aktualny dystans od dystansu wpisanego w Rest Length.
Rezultat działania ograniczenia pokazują ujęcia popychacza w dwóch kolejnych położeniach mechanizmu (Rysunek 13.26.4a i b są wykonane dokładnie w tej samej projekcji):
Rysunek 13.26.4 Rezultat ograniczenia Stretch To.
Koniec popychacza trzyma się “jak przyklejony” beczułki okucia. Przy okazji rozciąga się jak guma — zwróć uwagę, że dystanse D1 i D2 na ilustracjach bardzo się różnią!
Ograniczenia Stretch To wymagają uwagi, gdy stosujesz je dla obiektów o ujemnej skali (także takiej „odziedziczonej” po obiekcie nadrzędnym) . Pokażę to na przykładzie podwozia głównego (Rysunek 13.26.5):
Rysunek 13.26.5 Podwozie główne
W zespołach kół głównych ograniczenia Stretch To są użyte do „wyciągnięcia” obiektów o niesymetrycznym kształcie: krzywych, wzdłuż których są wygięte przewody hydrauliczne (Rysunek 13.26.6a):
Rysunek 13.26.6 Wpływ ograniczenia Stretch To na „negatywne” kopie obiektów
Aby poprawnie wyglądać, wszystkie elementy lewego koła powinny mieć oś X przestawioną w przeciwną stronę niż te same elementy koła prawego. Wygląda jednak na to, że ograniczenie Stretch To przestawia z powrotem skale obiektu na pozytywne (Rysunek 13.26.6b). Staje się to problemem dla obiektów których oś Y nie jest osią symetrii. W przypadku lewego koła takim przypadkiem są właśnie krzywe kabli z płynem hamulcowym. W wyniku tej zmiany przestały do siebie pasować w miejscach połączeń.
Cóż, w takim przypadku pozostaje się po prostu do tego stanu rzeczy dopasować, poprzez odpowiednią reorientację obiektu i jego krzywej. Pokażę to na przykładzie linii wygięcia dolnej części przewodu — korekty kształtu X.612.L.Curve.001. Zacznijmy od wyłączenia jej ograniczenia Stretch To (zmień jego wartość Influence od 0 — Rysunek 13.26.7):
Rysunek 13.26.7 Wyłączenie ograniczenia Stretch To | Rysunek 13.26.8 Odłączenie obiektu od zespołu lewego koła |
Potem odłącz krzywą od zespołu koła (Alt-P, Clear and Keep Transformation — Rysunek 13.26.8). W rezultacie skala obiektu „urealni się”, i stanie się ujemna (Rysunek 13.26.9). Teraz powinniśmy ją „utrwalić” poleceniem Apply→Scale. To polecenie nie działa jednak na klony. Chodzi o to, że wszystkie elementy koła lewego używają tych samych siatek i krzywych, co koło prawe.
W naszym przypadku obiekt X.612.L.Curve.001 używa krzywej X.612.Curve.001. Ta sama krzywa jest używana w prawym kole przez obiekt X.612.R.Curve.001. Musimy więc je powielić, tworząc lokalną wersję dla każdego obiektu (Rysunek 13.26.10):
Rysunek 13.26.10 Powielenie krzywych przypisanych do dwóch obiektów
Teraz możesz już wywołać polecenie Object→Apply→Scale. Spowoduje to zmianę kierunku lokalnych osi obiektu (Rysunek 13.26.11a):
Rysunek 13.26.11 Obrót obiektu krzywej
Ograniczenie Stretch To działa zawsze wzdłuż osi Y, stąd aby z powrotem skierować ją do góry, musimy obrócić obiekt wokół lokalnej osi X o 180º (Rysunek 13.26.11b). Aby taki obrót skompensować, przejdź do Edit Mode i obróć z kolei krzywą przypisaną do obiektu o kolejne 180º (Rysunek 13.26.12):
Rysunek 13.26.12 Obrót punktów krzywej
Pamiętaj tylko, aby wcześniej ustawić we właściwym miejscu kursor 3D (por. Rysunek 13.26.12a). (Najszybciej to zrobić otwierając menu Snap Shift-S i wybierając z niego polecenie Cursor to Selected).
Po tej modyfikacji możesz z powrotem przypisać obiekt krzywej w odpowiednie miejsce hierarchii lewego koła (Rysunek 13.26.13):
Rysunek 13.26.13 Przyłączenie obiektu od zespołu lewego koła | Rysunek 13.26.14 Włączenie ograniczenia Stretch To |
Na koniec włącz z powrotem działanie modyfikatora Stretch To (Rysunek 13.26.14). Uzyskaliśmy w ten sposób to, o co chodziło: przewód płynu hamulcowego ma taki sam kształt (i tak samo się wygina) na obydwu kołach podwozia samolotu (Rysunek 13.26.15a):
Rysunek 13.26.15 Skorygowana krzywa X.612.L.Curve.001
Pozostaje teraz powtórzyć te operacje dla kolejnego segmentu tej krzywej (por. Rysunek 13.26.15b)
Ograniczenie Limit Distance wymusza na obiekcie zachowanie odpowiedniej odległości od środka obiektu — celu. Ta właściwość przyda się do zamodelowania działania połączenia przegubowego, takiego jak u tych dwóch łączników na amortyzatorze goleni podwozia (Rysunek 13.27.1). To typowe rozwiązanie, stosowane w konstrukcji samolotów od początku lat czterdziestych: dwa składające się „jak nożyce” pręty, zapobiegające przypadkowemu obrotowi koła wokół goleni.
Wydaje się, że najłatwiej odwzorować ten mechanizm za pomocą wewnętrznego szkieletu (armatury — por. str. 841). Można to także zrobić w inny sposób. Wystarczy użyć ograniczeń Limit Distance i Stretch To.
Zaczniemy od dodania ograniczenia Limit Distance, do osi przegubu. W naszym przykładzie to śruba B.620.R.Screw (por. Rysunek 13.27.1). Zaznacz ją, a potem w zestawie Constraints z listy Add Constraint wybierz Limit Distance (Rysunek 13.27.2a):
Rysunek 13.27.2 Dodanie do obiektu ograniczenia Limit Distance.
W pierwszej chwili pole Limit Distance w panelu ograniczenia, (to z nazwą), jest czerwone (Rysunek 13.27.2b). To oznacza, że coś z parametrami tego ograniczenia jest nie tak. Po prostu w Target nie wskazaliśmy jeszcze obiektu — „celu”. Wpisz tam nazwę okucia (B.611.Attachement), a czerwony kolor zniknie z panelu (Rysunek 13.27.3a):
Rysunek 13.27.3 Przykład przypisania parametrów Limit Distance.
Jednocześnie przestaw Clamp Region na On Surface. To wymusza na śrubie zachowanie stałej odległości od środka okucia (Rysunek 13.27.3b). (Zauważ, że środek okucia nie musi być jego środkiem geometrycznym).
Z jednego ograniczenia Limit Distance nie ma jeszcze efektu, o który chodzi. Dodaj jednak do tej samej śruby (B.620.R.Screw) drugie ograniczenie tego samego typu — tyle że tym razem względem górnego okucia (B.621.Attachement) (Rysunek 13.27.4a):
Rysunek 13.27.4 Przykład zastosowania dwóch ograniczeń Limit Distance.
Rysunek 13.27.4b) pokazuje, że środek ograniczonej w ten sposób śruby może leżeć tylko w jednym, jedynym miejscu: tam, gdzie odległości od obydwu okuć są takie same. Ten punkt zmieni się, gdy okucia zbliżą się do siebie lub oddalą, w wyniku ruchu amortyzatora. W ten sposób ograniczenia Limit Distance zastępują ramiona łączników.
Teraz pozostaje tylko przypisać śrubom w osiach obrotu ramion ograniczenia Stretch To (por. str. 861) — tak, by ich lokalne osie Y „celowały” w oś przegubu (Rysunek 13.27.5a):
Rysunek 13.27.5 Przypisanie osiom łączników ograniczeń Stretch To.
(Rysunek 13.27.5b pokazuje parametry jednego z tych ograniczeń — jako Target jest wpisana śruba B.620.R.Screw, a osią obrotu jest lokalna oś Z). Potem pozostaje tylko przypisać do osi same ramiona (relacją Parent), by same się kierowały na oś przegubu (Rysunek 13.27.6a):
Rysunek 13.27.6 Przypisanie łączników do osi obrotu.
Zwróć uwagę, że ramiona są lekko odchylone od osi Y ich „rodziców” — śrub (Rysunek 13.27.6b).
Rysunek 13.27.7 przedstawia mechanizm, który stworzyliśmy, w działaniu:
Rysunek 13.27.7 Działanie mechanizmu połączenia przegubowego.
Wygląda to na poprawnie zginające się połączenie przegubowe. Na pierwszy rzut oka efektu nie można odróżnić od klasycznego zastosowania armatury (por. str. 841 i następne). Na koniec tej sekcji warto odnotować, że:
Jako cel ograniczeń Limit Distance można wskazać wprost śruby w osiach obrotu ramion łącznika (chodzi o obiekty B.625.R.Screw, B.615.R.Screw — por str. 867, Rysunek 13.27.5). W ten sposób mechanizm byłby złożony z mniejszej liczby obiektów, czyli — prostszy. Nie zrobiłem tego jednak ze względów „porządkowych”. (Blender wtedy wyświetla od czasu do czasu w konsoli ostrzeżenia o wzajemnej referencji — circular reference — tych dwóch śrub). Zamiast tego użyłem ich „rodziców” — okuć, którym specjalnie ustawiłem środki w osiach obrotu ramion.
Gdyby otwory na oś przegubu (obiekt B.620.R.Screw) leżały na osi ramiona łączników (B.625.R.Stick, B.615.R.Stick) — ograniczenia Stretch To zostałyby przypisane bezpośrednio do nich. Wtedy ramiona mogły by być bezpośrednimi „potomkami” okuć, a śruby, leżące w ich osiach obrotu, nie byłyby w mechanizmie potrzebne. Zastosowałem je wyłącznie dlatego, że oś przegubu nie leży na osi podłużnej ramienia łącznika, więc nie można jej wycelować prosto w jego środek (por. str. 867, Rysunek 13.27.6b).
Teoretycznie, do skierowania ramion na oś przegubu, zamiast ograniczeń Stretch To można by było zastosować ograniczenia Locked Track (por. str. 849). Jednak wtedy końcówki ramion mogą w pewnych położeniach „odstawać” od przegubu. Wygląda na to, że Blender wyznacza położenie wynikające z ograniczeń Limit Distance w sposób przybliżony (iteracja?), co prowadzi do powstania takich odstępów. Jedynym lekarstwem na to są ograniczenia Stretch To, które same dbają o to, by końcówki ramion były „dociągnięte” do zadanego punktu. (Niewielkie zmiany skali wzdłuż lokalnych osi Y śrub są przenoszone na obiekty potomne — ramiona. I to wystarcza).
Transformacja Mirror jest właściwie skrótem — specyficzną formą zmiany skali obiektu poprzez pomnożenie jej wartości względem jednej z lokalnych osi przez -1. Można ją wywołać skrótem Ctrl-M lub poleceniem Object→Mirror. (Ten sam rezultat można uzyskać poprzez odpowiednią zmianę skali w jednym kierunku). W tej sekcji pokażę praktyczny przypadek zastosowania lustrzanego odbicia (Mirror).
Naszym zadaniem jest skopiowanie i przypisanie do prawej pokrywy luku podwozia okucia, do którego ma być potem przyczepiony popychacz (Rysunek 13.28.1a):
Rysunek 13.28.1 Okucie pokrywy podwozia i jego struktura
Okucie składa się z dwóch trójkątnych blach, połączonych bolcami (nazwy poszczególnych części podaje Rysunek 13.28.1b). W hierarchii modelu (Rysunek 13.28.1c) jedna z tych blach (B.303.Nest.L.001) jest „rodzicem” (parent) pozostałych elementów okucia. Jednocześnie jej „rodzicem” jest lewa pokrywa podwozia (B.306.L.Door).
Zaznacz wszystkie elementy okucia i zduplikuj je (Alt-D, str. 823). Zaraz po stworzeniu przesuń te duplikaty w bok, na jakiś „równy” i łatwy do zapamiętania dystans — np. o 1 jednostkę Blendera (Rysunek 13.28.2a). (Robimy to wyłącznie po to, by łatwo było je zaznaczać). Przy okazji zmień w nazwach nowo utworzonych obiektów końcówki L na R (choć jeszcze na to nie wygląda, będzie to okucie prawej pokrywy):
Rysunek 13.28.2 Powiązanie duplikatu okucia z pomocniczym obiektem Empty
Aby w wyniku operacji Mirror okucie nie odwróciło się „do góry nogami”, musimy zastosować pewne obejście. Wstaw na chwilę w osi samolotu pomocniczy obiekt Empty (jak — str. 814) i uczyń go rodzicem blaszki B.303.Nest.R.001 (Rysunek 13.28.2c).
Teraz można wywołać transformację Mirror (Ctrl-M) dla obiektu Empty. To w istocie zmiana skali wzdłuż osi X z 1.0 na -1.0. „Rodzic” okucia — blaszka B.303.Nest.R.001 — jest jednocześnie „dzieckiem” Empty(Rysunek 13.28.2c). Zmiana skali „rodzica” przekłada się na wszystkie obiekty do niego przypisane, stąd okucie znalazło się już po przeciwległej stronie osi samolotu (Rysunek 13.28.3a):
Rysunek 13.28.3 Przeniesienie duplikatu okucia ponad drugą pokrywę (Mirror)
Przesuń jeszcze okucie wzdłuż osi X o 1 jedn. (por. str. 869, Rysunek 13.28.2a) — tak, jak to pokazuje Rysunek 13.28.3b). W rezultacie mamy je już w miejscu docelowym (Rysunek 13.28.3c).
Na koniec zamieniamy „rodzica” okucia (a konkretnie: jego blaszki B.303.Nest.R.001) z tymczasowego obiektu Empty na pokrywę podwozia (B.306.R.Door) (Rysunek 13.28.4). Pamiętaj: zawsze w takich sytuacjach używaj polecenia Set Parent To→Object (Keep Transform), aby pozostał na swoim miejscu!
Potem możesz już usunąć niepotrzebny obiekt Empty.
Gdy wykonasz wszystkie te operacji warto jeszcze przełączyć się na tryb wyświetlania Wireframe (Z), i sprawdzić, czy w rzucie z boku linie obydwu okuć dokładnie się pokrywają (Rysunek 13.28.5a):
Rysunek 13.28.5 Weryfikacja poprawności — w rzucie z boku i z przodu
Nie zaszkodzi zerknąć także na rzut z przodu (Rysunek 13.28.5b), czy są w równych odległościach od osi samolotu.
Rysunek 13.28.6 przedstawia ostateczny rezultat — prawidłowo ustawione okucia, przypisane do odpowiednich pokryw luku podwozia:
Rysunek 13.28.6 Ostateczny rezultat
Zastosowanie dla krzywych znajduję w Blenderze stosunkowo rzadko: gdy trzeba zamodelować jakiś wygięty kabel czy rurkę. Przykładem takiego elementu jest przewód z płynem hamulcowym, doprowadzanym do piasty koła głównego (Rysunek 13.29.1):
Rysunek 13.29.1 Przykład siatki, wygiętej wzdłuż krzywej | Rysunek 13.29.2 Krzywa, determinująca kształt siatki |
Przewód, który pokazuje Rysunek 13.29.1, został uformowany jako prosta „rurka”. Następnie wygiąłem go, za pomocą odpowiedniego modyfikatora Curve (por. str. 955) wzdłuż odpowiedniej krzywej przestrzennej (Rysunek 13.29.2). To jeden z typów linii dostępnych w Blenderze. Można byłoby tę siatkę „powyginać” bez pomoc krzywej, ale tak jest wygodniej modyfikować jej kształt. W dodatku mamy gwarancję, że przekrój poprzeczny tak wygiętej „rury” nie będzie w żadnym miejscu zdeformowany.
Aby dodać do rysunku krzywą, umieść kursor 3D w miejscu, gdzie ma być jej środek (tzn. punkt odniesienia obiektu, który będzie ją zawierać). Następnie wywołaj polecenie Add→Curve→Path (Rysunek 13.29.3):
Rysunek 13.29.3 Tworzenie krzywej typu Path.
Zwróć uwagę, że masz do wyboru w Blenderze aż pięć rodzajów krzywych. Ja zwyczaj stosuję krzywą typu Path. To przestrzenna krzywa NURBS która zachowuje ciągłość promienia krzywizny.
Możesz także stworzyć krzywą wykorzystując przybornik Tool shelf (T): w jego zakładce Create, panelu Add Primitive, naciśnij przycisk Path (jest w sekcji Curve).
Blender zawsze wstawia obiekt typu Path jako zupełnie prosty, poziomy odcinek. Jego geometryczny środek znajduje się tam, gdzie kursor 3D (Rysunek 13.29.4a):
Rysunek 13.29.4 Nowo utworzona ścieżka (krzywa) Path — jako obiekt i w trybie edycji
Rysunek 13.29.4 pokazuje obiekty w trybie wyświetlania Wireframe, gdyż część odcinka przenika do wnętrza innych powłok. Krzywą można zmieniać tak samo, jak zmienia się siatki. Wystarczy przełączyć się w tryb edycji (Tab). Zaraz po utworzeniu ścieżka składa się z czterech równych segmentów, łączących pięć wierzchołków (Rysunek 13.29.4b). Aby usunąć niepotrzebne wierzchołki, wystarczy je zaznaczyć i nacisnąć X (Curve→Delete) (Rysunek 13.29.5):
Rysunek 13.29.5 Usuwanie wierzchołków ze ścieżki
W menu, które się pojawi (Rysunek 13.29.5a), wystarczy wybrać opcję Select. Wierzchołki ścieżki możesz obracać (R) , przesuwać (G) , czy wytłaczać (E) tak samo, jak wierzchołki siatki (Rysunek 13.29.6):
Rysunek 13.29.6 Dalsza edycja ścieżki
Po wytłoczeniu piątego wierzchołka ścieżka staje się linią krzywą (Rysunek 13.29.7):
Rysunek 13.29.7 Wytłoczenie kolejnego wierzchołka | Rysunek 13.29.8 Uformowana krzywa przestrzenna |
Na krzywej ścieżki Blender rysuje pomocnicze „strzałki”. Pokazuje w ten sposób kierunek poprzeczny w każdym punkcie tej linii. (Ta informacja jest używana np. do orientacji kamery, przesuwanej wzdłuż ścieżki, czy podczas deformacji siatki wzdłuż krzywej). Wierzchołki, którymi manipulujemy, to punkty sterujące kształtem krzywej. Tworzą tzw. wielobok sterujący. Odpowiednio dobierając jego kształt, można uzyskać krzywą przestrzenną, wyglądającą jak wygięty kawałek elastycznego przewodu (Rysunek 13.29.8).
Końce krzywej Path znajdują się zawsze w krańcowych wierzchołkach wieloboku sterującego. Kierunki krańcowych segmentów wieloboku wyznaczają kierunki styczne na końcach krzywej (Rysunek 13.29.8) .
Minimalna liczba wierzchołków, przy której Path zaczyna być krzywą, wskazuje na to, że jest to tzw. krzywa czwartego stopnia (lub — używając innej terminologii — piątego rzędu). Jest to najmniejszy stopień krzywej przestrzennej, zapewniający ciągłość i „gładkie” zmiany promienia krzywizny wzdłuż jej całej długości.
Współrzędne zaznaczonego wierzchołka krzywej możesz znaleźć w panelu Transform z przybornika Properties. Gdy zaznaczysz więcej niż jeden wierzchołek Blender wyświetla w tym panelu wartości średnie. Zwróć uwagę że oprócz współrzędnych X, Y, Z jest tam podana także waga wierzchołka W (Rysunek 13.29.9):
Rysunek 13.29.9 Sterowanie skręceniem ścieżki (Tilt)
Innym parametrem każdego wierzchołka sterującego jest kąt skręcenia Tilt. „Strzałki”, biegnące wzdłuż krzywej pokazują aktualną orientację w każdym jej punkcie. Porównaj Rysunek 13.29.9a) i Rysunek 13.29.9b). Na ilustracji b) środkowy segment tej krzywej uległ skręceniu o 150º.
Gdy użyjesz polecenia Add→Add Curve→Bezier, stworzysz pojedynczy segment krzywej Beziera (4 rzędu). Mamy tu nieco inne punkty „uchwyty” punktów sterujących (Rysunek 13.29.10a):
Rysunek 13.29.10 Krzywa Beziera (4 rzędu)
Główne punkty sterujące leżą zawsze na krańcach segmentu krzywej Beziera. Tylko w tych punktach można zmieniać skręcenie (Tilt) krzywej. Każdemu punktowi głównemu towarzyszą dwa punkty pomocnicze. Ich kierunek determinuje kąt pochylenia krzywej na krańcach segmentu, a długość ich odcinków — lokalny promień krzywizny. Nowy segment krzywej Beziera możesz dodać tak samo jak w krzywej Path — poleceniem Extrude (E — Rysunek 13.29.10b). Pamiętaj że aby uniknąć skokowej zmiany promienia krzywizny na połączeniu segmentów krzywej Beziera, musisz zapewnić równą długość odcinków |AB| i |BC| (Rysunek 13.29.10b).
Innym rodzajem linii jest NURBS (Add→Add Curve→Nurbs). W odróżnieniu od Path jest to „klasyczna” krzywa, ze „swobodnymi” końcami (Rysunek 13.29.11a):
Rysunek 13.29.11 Krzywa NURBS (4 rzędu)
Możesz próbować „dociągnąć” koniec krzywej do ostatniego wierzchołka zwiększając jego wagę W (Rysunek 13.29.11a), ale lepszą metodą jest wstawienie w środek ostatniego segmentu dodatkowego punktu sterującego (Rysunek 13.29.11b).
Dla każdego typu krzywej istnieje polecenie tworzące krzywą zamkniętą (Circle) :
Rysunek 13.29.12 Okrąg Beziera (Bezier Circle) | Rysunek 13.29.13 Okrąg NURBS (Nurbs Circle) |
Bezier Circle (Rysunek 13.29.12) jest pewnym przybliżeniem okręgu, o dokładności zbliżonej do krzywej podziałowej uzyskanej z ośmioboku (por. str. 1226). Gdy potrzebujesz bardzo wysokiej dokładności — użyj Nurbs Circle, którego wierzchołki leżą dokładnie wzdłuż matematycznego okręgu (dzięki zmniejszonym wagom W narożników wieloboku sterującego — por. Rysunek 13.29.13). Inna sprawa, że wierzchołki Nurbs Circle nie są rozłożone równomiernie. (Zwróć uwagę na większą liczbę „strzałek” w pobliżu środków boków wielokąta sterującego).
Szczegółowe właściwości całej krzywej znajdziesz w zestawie Object Data okna Properties (Rysunek 13.29.15):
Rysunek 13.29.14 Panele właściwości krzywej | Rysunek 13.29.15 Krzywa zamknięta i otwarta (Cyclic) |
W przypadku krzywej NURBS możesz tu zmienić m.in. rząd krzywej (Active Spline:Order) i liczbę wierzchołków na segment (Resolution). Innym ważnym przełącznikiem jest Cyclic. Ta flaga pozwala przełączać się pomiędzy krzywą zamkniętą i otwartą (Rysunek 13.29.15).
Pamiętaj, aby po stworzeniu krzywej zawsze wyłączać jej opcję Path Animation (Rysunek 13.29.16). Ta panel jest domyślnie włączona. Jeżeli o tym zapomnisz, w kolejnych klatkach animacji krzywa może zacząć się poruszać (a wraz z nią i siatki, których kształt modyfikuje).
Lepiej więc nie narażać się na taki stres i skorygować to od razu.
Opis, jak zastosować krzywą do deformacji siatek (np. uzyskania wygiętego przewodu) znajdziesz w sekcji o modyfikatorze Curve (na str. 955 i następnych).
W ukończonym modelu znajdzie się około dziesięciu uchwytów (pomocniczych obiektów, służących do poruszania w określony sposób jakiejś części). Jeden służy do wysuwania i chowania podwozia, inny steruje obrotem steru kierunku, jeszcze inny — lotkami, kolejny — klapami, itd. Za jakiś czas, gdy zajrzysz do pliku z ukończonym modelem, możesz mieć problemy z szybkim zidentyfikowaniem, do czego służy konkretny element jego „chmurki” uchwytów. Odkrywanie na nowo ich funkcji „metodą prób i błędów” nie jest specjalnie zachęcającą perspektywą.
Dlatego opracowałem specjalny dodatek do Blendera. Jest to dodatek Handle Panel. Po uruchomieniu przeszukuje cały model i znajduje w nim wszystkie uchwyty. Dla każdego znalezionego uchwytu wyświetla panel z opisową nazwą i „suwakiem”, umożliwiającym wygodne określenie aktualnego położenia każdego z podzespołów samolotu (Rysunek 13.30.1):
Rysunek 13.30.1 Panel sterowania zespołami samolotu
Nazwy, które widzisz na ilustracji (np. „06. Canopy Hood”), zostały przypisane poszczególnym uchwytom za pomocą przycisku , umieszczonego na każdej z paneli. Te teksty są przechowywane i zapisywane razem z całym modelem (jako dodatkowe dane poszczególnych obiektów).
Skąd dodatek Handle Panel „wie”, co jest uchwytem, a co nim nie jest? To proste: ten program wyświetla panel dla każdego obiektu spełniającego następujące kryteria:
-nazwa obiektu ma przyrostek *.Handle, np. X.600.Handle (uważaj więc na takie nazwy);
-obiekt ma ograniczenie Limit Location, w lokalnym układzie współrzędnych (Convert: Local);
-obiekt jest przyporządkowany (relacją Parent) do jakiegoś innego obiekty („rodzica”);
Program zakłada, że środek (tzn. punkt odniesienia — origin) „rodzica” uchwytu wyznacza jego położenie neutralne. Odpowiada ono jakiejś szczególnej pozycji mechanizmu. (Na przykład: steru kierunku jest w nim ustawiony dokładnie wzdłuż osi kadłuba, podwozie jest zupełnie wciągnięte, a klapy — schowane).
Przygotowałem dwa uchwyty, sterujące ruchem podwozia — X.600.Handle i X.601.Handle — tak, by skrypt mógł je odnaleźć (Rysunek 13.30.2):
Rysunek 13.30.2 Przypisanie uchwytowi „rodzica”
Uchwyt X.600.Handle steruje wysuwaniem i chowaniem podwozia. Ma przypisane ograniczenie Limit Location, wymuszające jego położenie do pionowego odcinka o długości 10 jednostki Blendera (Rysunek 13.30.2a). Gdy jest w położeniu górnym, podwozie jest schowane. W tym właśnie, górnym punkcie znajduje się jego „rodzic” (Rysunek 13.30.2b) — pusty (Empty) obiekt X.600.Base. Wyznacza w ten sposób domyślne położenie podwozia — w pozycji „złożone”.
Drugi uchwyt — X.601.Handle — służy do „ściskania” i „rozciągania” amortyzatorów kół głównych i pochylania wahacza kółka ogonowego. Ma przypisane ograniczenie Limit Location, wymuszające ruchu tego uchwytu wzdłuż pionowego odcinka o długości 1.5 jednostki Blendera. (Ta długość odpowiada skokowi amortyzatorów podwozia głównego). Rodzicem X.601.Handle jest uchwyt X.600.Handle. W dolnym położeniu, środek X.601.Handle pokrywa się z X.600.Handle. Położenie neutralne amortyzatora odpowiada więc całkowitemu rozciągnięciu (brakowi obciążenia).
Po takich przygotowaniach można już włączyć dodatek Handle Panel. Powinieneś go znaleźć w oknie User Preferences, sekcji Addons:Scene (Rysunek 13.30.3):
Rysunek 13.30.3 Włączenie dodatku Handle Panel
U dołu zestawu Scene znajdziesz panel tego dodatku (Handle Panel — Rysunek 13.30.4a). Naciśnij na niej przycisk Show/Refresh, by dodatek wyszukał i wyświetlił panel dla każdego znalezionego w scenie uchwytu (Rysunek 13.30.4b):
Rysunek 13.30.4 Aktywacja paneli sterujących
W naszym przypadku pojawiły się dwie panele, dla dwóch obiektów sterujących.
Rysunek 13.30.5 Panele sterowania modelem
Przypuszczam, że wystarczył Ci rzut oka, by wiedzieć jak posługiwać się tym programem: należy przesuwać suwak Pos, umieszczony na każdym panelu (Rysunek 13.30.5). (W tę kontrolkę możesz także wpisać dokładną wartość numeryczną). Gdy podwozie jest wysunięte (por. Rysunek 13.30.2), uchwyt X.600.Handle jest w najniższym położeniu (0%). Także uchwyt amortyzatora X.601.Handle jest w położeniu 0% (najniższym) — gdy amortyzator jest całkowicie rozciągnięty. Wystarczy którykolwiek z tych suwaków przesunąć, by wywołać ruch odpowiedniego mechanizmu (Rysunek 13.30.6):
Rysunek 13.30.6 Chowanie podwozia za pomocą panelu sterowania
Dodatkowo, aby ułatwić ustawienie zespołu w jakiejś wyróżnionej pozycji neutralnej, dodałem do każdego panelu przycisk . Gdy go naciśniesz, środek uchwytu zostanie przesunięty w miejsce, w którym znajduje się środek jego obiektu — „rodzica” (Parent). W przypadku uchwytu z tego przykładu, „rodzic” to pomocniczy obiekt X.600.Base.
Domyślna nazwa paneli uchwytu jest zapożyczona z nazwy obiektu. Warto ją zmienić na coś bardziej „reprezentatywnego”. Jak wspomniałem wcześniej (por. str. 877), służy do tego przycisk (Rysunek 13.30.7):
Rysunek 13.30.7 Zmiana nazwy panelu
Wpisz w oknie dialogowym nową nazwę. Po naciśnięciu przycisku OK etykieta, wyświetlana u góry panelu, ulegnie zmianie.
Skrypt ustawia zawsze panele wg ich nazw, w kolejności alfabetycznej. Warto więc poprzedzić je jakimś numerycznym przedrostkiem, by amortyzator został umieszczony przy podwoziu, a ster wysokości (Elevator) przy sterze kierunku (Rudder).
Podczas pracy nad modelem często powstaje sytuacja, gdy jakiś obiekt należy umieścić w dokładnie określonym miejscu. Jego aktualne położenie może być przypadkowe, a w każdym razie nieistotne. Robimy to dość często gdy modelujemy zespół złożony z wielu części — np. podwozie lub wnętrze kabiny. Ta sekcja pokazuje szybką i dokładną metodę wykonania takiej operacji.
Rysunek 13.31.1 przedstawia typowy przypadek opisanego powyżej problemu. Właśnie sklonowaliśmy dwie śruby (2 i 3). Śruba 3 ma się znaleźć w osi korbki 1, a śruba 2 — w centrum jej rączki. Jak to zrobić najszybciej i najłatwiej?
Rysunek 13.31.1 Typowy problem: jak najszybciej/najłatwiej osadzić śruby w osiach korbki?
Środek (punkt odniesienia — origin) korbki leży w jej osi obrotu. W tym samym miejscu ma się znaleźć śruba 3. Skorzystajmy z tego faktu i umieśćmy w tym punkcie kursor 3D. Aby to zrobić: zaznacz korbkę (Rysunek 13.31.2a) i naciśnij Shift-S, by rozwinąć podręczne menu Snap (Rysunek 13.31.2b). Wybierz z niego polecenie Cursor to Selected:
Rysunek 13.31.2 Przeniesienia kursora 3D do punktu odniesienia obiektu (origin)
W rezultacie, kursor 3D znajdzie się w środku (punkcie odniesienia) korbki (Rysunek 13.31.2c).
Teraz trzeba jeszcze odpowiednio ustawić tryb transformacji:
przełącz tryb Pivot na 3D Cursor (Rysunek 13.31.3a),
włącz Manipulate center points (Rysunek 13.31.3b):
Rysunek 13.31.3 Ustawienie odpowiednich trybów dla punktu odniesienia i transformacji
Zaznacz śrubę 3, i naciśnij S, rozpoczynając operację zmiany skali. Gdy jest włączony tryb Manipulate center points, rozmiar śruby nie ulegnie zmianie. Gdy podczas zmiany skali tylko jej środek zacznie zmierzać w kierunku środka transformacji — kursora 3D. I o to chodzi! (Rysunek 13.31.4a):
Rysunek 13.31.4 Umieszczenie śruby w zadanym punkcie (poprzez zmianę skali)
Aby szybko zmniejszyć skalę do zera, po prostu naciśnij klawisz 0 (por. str. 92). Dla tej wartości środek śruby 3 znajdzie się dokładnie w tym samym miejscu, co kursor 3D — czyli w osi korbki (Rysunek 13.31.4b). Tyle tylko, że został „zagłębiony” w materiale (Rysunek 13.31.4c).
To na szczęście można szybko skorygować: wystarczy przesunąć śrubę wzdłuż jej lokalnej osi Z (G,Z,Z) dopóty, dopóki jej łeb nie „wynurzy” się z korbki (Rysunek 13.31.5):
Rysunek 13.31.5 Finalne dopasowanie (przesunięcie wzdłuż osi śruby)
Śrubę 2 umieścimy w korbie w ten sam sposób. Musimy tylko umieścić w innym miejscu kursor 3D. W tym celu przełączymy się na chwilę w tryb edycji siatki (Tab), i zaznaczymy wierzchołek leżący w centrum uchwytu (Rysunek 13.31.6a):
Nie zapomnij wyłączyć opcji Manipulate center points po zakończeniu tej operacji. W przeciwnym razie nie będziesz mógł obrócić żadnego obiektu w tej scenie!
Rysunek 13.31.6 Przeniesienia kursora 3D do środka uchwytu
Potem postępujemy tak samo, jak poprzednio: Shift-S, by przywołać menu Snap, i wybrać z niego polecenie Cursor to Selected. W efekcie kursor 3D zostanie umieszczony w podświetlonym wierzchołku.
Wierzchołki siatki bardzo się przydają do ustawienia kursora 3D w różnych kluczowych miejscach. Na przykład, jeżeli nawet nie masz wierzchołka w środku otworu, wystarczy zaznaczyć dwa przeciwległe wierzchołki na jego obwodzie. Polecenie Cursor to Selected umieści kursor 3D dokładnie pomiędzy nimi.
Gdy mamy już kursor 3D w odpowiednim miejscu, można się znowu przełączyć w Object Mode (Tab). Potem ze śrubą 2 postępujemy tak samo, jak ze śrubą 3: zmiana skali do zera (Rysunek 13.31.7a, b):
Rysunek 13.31.7 Umieszczenie śruby w centrum uchwytu
Na koniec dosuwamy łeb śruby do powierzchni korbki, przesuwając ją wzdłuż lokalnej osi Z. Rysunek 13.31.7c) przedstawia gotową korbkę, z dwoma śrubami osadzonymi we właściwych miejscach.
We wprowadzeniu do Blendera omówiliśmy podstawowe metody wyboru obiektów — kliknięcie PPM i zaznaczanie obszarem prostokątnym (B — por. str. 84). W tej sekcji przedstawię kilka innych metod selekcji, które mogą przydać się w trakcie dalszej pracy.
Często wygodniejszą od „prostokąta” metodą zaznaczenia grupy obiektów jest użycie okręgu (C, albo Select→Circle Select — Rysunek 13.32.1):
Rysunek 13.32.1 Zaznaczanie obiektów za pomocą okręgu
Rozmiar okręgu wyboru możesz zmieniać obracając KM. Obiekty wewnątrz okręgu wybierasz pojedynczym kliknięciem LPM. Zwróć uwagę, że podczas wybierania kształt obiektu nie ma żadnego znaczenia — liczy się tylko to, czy jego środek (punkt odniesienia, niekoniecznie środek geometryczny) znajduje się wewnątrz czy na zewnątrz okręgu. Jeżeli chcesz wykluczyć zaznaczone obiekty — zamiast LPM kliknij SPM. Kolejne kliknięcia okręgiem zaznaczają/wykluczają z zaznaczenia grupy obiektów. Wybór kończysz naciśnięciem Esc.
W Blenderze wybierasz środki obiektów (origin), a nie ich kształty!
Powyższa reguła dotyczy każdej metody selekcji — także zwykłego kliknięcia PPM w pojedynczy obiekt. Gdy klikniesz w ten sposób gdzieś pomiędzy środkami dwóch obiektów, Blender zaznaczy ten, którego środek jest bliżej kursora myszki.
A co w sytuacji, gdy pod kursorem klikniętej myszki znajduje się wiele różnych obiektów? Domyślnie Blender wybierze jeden z nich. Abyś mógł świadomie zdecydować, który z takich obiektów ma być wybrany, trzymaj podczas kliknięcia PPM wciśnięty klawisz Alt (Rysunek 13.32.2):
Rysunek 13.32.2 Wybór jednego spośród wielu możliwych obiektów
Gdy klikniesz w ten sposób w grupę obiektów, Blender wyświetla listę ich nazw. Możesz z niej wybrać właściwy element.
Skoro już wybieramy obiekty według nazw: możesz także użyć w tym celu okna Outliner (Rysunek 13.32.3):
Rysunek 13.32.3 Wybór obiektów w oknie Outliner
Kliknięcie LPM w nazwę obiektu w tym oknie działa tak samo, jak kliknięcie obiektu w 3D View: zaznacza obiekt i czyni go obiektem aktywnym. Dodatkowo wciśnięty Shift pozwala dodawać do zbioru selekcji kolejne elementy. Z menu kontekstowego obiektu (kóre otwierasz w oknie Outliner kliknięciem PPM) możesz także wybrać polecenia Select/Deselect (Rysunek 13.32.3). Ciekawym narzędziem w tym menu jest polecenie Select Hierarchy: zaznacza kliknięty obiekt i wszystkie obiekty potomne.
W oknie Outliner można także wyszukiwać obiekty według nazw (Rysunek 13.32.4):
Rysunek 13.32.4 Wybór obiektów według nazwy
W Blenderze każdy kształt odwzorowany jest za pomocą ścian, połączonych w tzw. „siatkę” (mesh). Tryb Edit Mode służy do zmiany siatki pojedynczego obiektu.
Siatka (Mesh) w Blenderze to zbiór elementarnych ścian (face), ich krawędzi (edge) i wierzchołków (vertex). Rysunek 14.1.1 pokazuje przykład takiej siatki:
Rysunek 14.1.1 Elementy siatki (mesh)
Począwszy od wersji 2.63 ściany w Blenderze mogą mieć więcej niż cztery boki. Staraj się jednak używać w modelu ścian czworobocznych, a w miejscach gdzie jest to niemożliwe — trójkątnych. W ten sposób unikniesz wielu problemów podczas eksportu swoich modeli do innych programów lub silników gier. W szczególnych przypadkach mogą w siatce mogą także istnieć krawędzie bez ścian, czy wręcz “osamotnione” wierzchołki bez krawędzi.
W Blenderze występuje także pojęcie “linii wierzchołków” (edgeloop — Rysunek 14.1.1). Najłatwiej wskazać je na siatkach o ścianach prostokątnych. Blender potrafi jednak także znaleźć takie linie także na siatkach o ścianach trójkątnych.
Tryb edycji siatki włączasz naciskając przycisk Tab. Alternatywnie możesz także zrobić to za pomocą menu z nagłówka okna widoku (Rysunek 14.2.1):
Rysunek 14.2.1 Okno widoku: włączenie trybu edycji
Powtórne naciśnięcie Tab przełączy Cię z powrotem do poprzedniego trybu (np. obiektu — Object Mode). Możesz także wybrać inny tryb z nagłówka widoku, listy rozwijalnej Mode.
Nagłówek okna View 3D ma w trybie edycji wiele przydatnych kontrolek:
Rysunek 14.2.2 Okno widoku: kontrolki dostępne w trybie edycji
Mankamentem tego nagłówka jest brak możliwości włączania i ukrywania warstw. (Aby to zrobić, musisz się przełączyć w Object Mode)
W zasadzie, wierzchołki można zaznaczać tak samo, jak całe obiekty (por. str. 84). Gdy klikniesz w jeden z nich PPM — stanie się zaznaczony, i zmieni swój kolor na żółty (Rysunek 14.3.1):
Rysunek 14.3.1 Zaznaczenie pojedynczego wierzchołka
Zwróć uwagę, że kolor krawędzi, wychodzących z zaznaczonego wierzchołka także ulega stopniowej zmianie. Im bliżej zaznaczenia, tym bardziej są żółte. Taka konwencja ułatwia szybkie odnalezienie zaznaczonego na siatce obszaru.
Aby wybrać wiele wierzchołków, jeden po drugim: trzymaj wciśnięty klawisz Shift i klikaj w nie po kolei PPM (Rysunek 14.3.2):
Rysunek 14.3.2 Wybór wielu wierzchołków
Kombinacja Shift - PPM działa jak przełącznik stanu zaznaczenia: pierwsze kliknięcie w wierzchołek włącza go do wybranych wierzchołków. Następne kliknięcie — wyklucza z tego zbioru.
Jeżeli chcesz szybko zrezygnować z aktualnego zaznaczenia — naciśnij klawisz A (Select→Select/Deselect All). Jeżeli chcesz zaznaczyć wszystko — naciśnij ten klawisz powtórnie. (Polecenie to działa jak przełącznik: “wszystko - nic”).
Na siatce złożonej z czworoboków można także szybko wskazać cały rząd wierzchołków, tworzących topologicznie linię (edgeloop) . Trzymając wciśnięty Alt, kliknij PPM w jedną z krawędzi siatki (Rysunek 14.3.3):
Rysunek 14.3.3 Zaznaczanie linii wierzchołków
Analogicznie, jak w przypadku pojedynczych wierzchołków, możesz wyłączać/wykluczać z selekcji całe linie. Trzymaj na klawiaturze wciśnięte Alt-Shift, i klikaj PPM w krawędzie odpowiednich linii (Rysunek 14.3.4):
Rysunek 14.3.4 Wykluczanie z wyboru linii wierzchołków
Możesz także odwrócić aktualną selekcję (tzn. wybrać to, co nie jest zaznaczone): wystarczy nacisnąć na klawiaturze I (to skrót od Select→Inverse).
W Blenderze jest także dostępne wybieranie obszarem prostokątnym. Naciśnij B (Select→Border Select) (Rysunek 14.3.5).
Rysunek 14.3.5 Zaznaczanie obszarem prostokątnym
Zaznaczone w ten sposób wierzchołki są dodawane do wybranych poprzednio. Pozwala to zaznaczać jakieś złożone kształty „kawałek po kawałku”.
Osobiście wolę jednak posługiwać się inną odmianą wyboru obszarem: wyborem okręgiem. Aby włączyć ten tryb, naciśnij klawisz C (Select→Circle Select) . Wokół kursora na ekranie pojawi się okrąg (Rysunek 14.3.6):
Rysunek 14.3.6 Zaznaczanie okręgiem
W tym trybie, gdy klikniesz LPM, zaznaczysz wierzchołki, które są wewnątrz okręgu. Rozmiar okręgu możesz zwiększać lub zmniejszać, obracając KM. Klikając w różne miejsca, możesz włączać kolejne wierzchołki do zbioru selekcji.
Każdy z tych trybów wyboru możesz przerwać (zrezygnować), naciskając Esc.
Na koniec chciałbym przypomnieć, jak ważne podczas zaznaczania jest właściwe dobranie widoku. Rysunek 14.3.7 pokazuje, co się może stać, gdy zaznaczamy obszarem wierzchołki, za którymi są jeszcze dalsze punkty siatki:
Rysunek 14.3.7 Zaznaczanie obszarem — projekcja dobrana niewłaściwie
Rysunek 14.3.8 pokazuje, jak wygląda projekcja lepiej dobrana do tej sytuacji. Gdy nic nie leży poza zaznaczanymi wierzchołkami, nie ma możliwości przypadkowego zaznaczenia czegokolwiek dodatkowego:
Rysunek 14.3.8 Zaznaczanie obszarem — projekcja dobrana właściwie
Do tej pory omówiłem szczegółowo tryb wybierania wierzchołków. Ale na tym możliwości programu się nie kończą. W nagłówku okna widoku mamy do dyspozycji jeszcze dwa dalsze tryby (Rysunek 14.3.9):
Rysunek 14.3.9 Włączony tryb selekcji wierzchołków w nagłówku okna View 3D
W każdym z trzech dostępnych trybów selekcji (wierzchołków, krawędzi, ścian) możesz stosować wszystkie metody zaznaczania, które opisałem na poprzednich stronach.
Gdy włączysz tryb zaznaczania krawędzi, zmieni się sposób wyświetlania siatki (Rysunek 14.3.10):
Rysunek 14.3.10 Tryb zaznaczania krawędzi
Tryb zaznaczania krawędzi jest przydatny np. wtedy, gdy chcesz usunąć ich grupę bez usunięcia wierzchołków. W trybie zaznaczania wierzchołków masz dwa razy więcej do “klikania”!
Ostatnim trybem zaznaczania jest zaznaczanie całych ścian (Rysunek 14.3.11):
Rysunek 14.3.11 Tryb zaznaczania ścian
W przypadku wybierania ścian obszarem prostokątnym (B) lub okręgiem (C) — wybrane zostaną te, których środki będą się znajdować wewnątrz zaznaczonych obszarów.
Zaznacz wierzchołki, które chcesz przesunąć, a następnie naciśnij G (Mesh→Transfrom→Grab/Move) (Rysunek 14.4.1a):
Rysunek 14.4.1 Zaznaczenie wierzchołków
Przełączysz się w ten sposób w tryb przesuwania. Każdy ruch myszy będzie powodować przemieszczenie zaznaczonych wierzchołków. Dokonywane zmiany w kształcie siatki są pokazywane na bieżąco we wszystkich oknach Blendera. W nagłówku aktywnego okna jest wyświetlane bieżące przesunięcie (Rysunek 14.4.1b). Aby zatwierdzić nowe położenie (zakończyć operację), należy kliknąć LPM. Aby zrezygnować, możesz w każdej chwili nacisnąć Esc .
Jeżeli w trakcie przesuwania naciśniesz X, Y, lub Z — ograniczysz swój ruch tylko do translacji wzdłuż jednej z tych osi. Po pierwszym naciśnięciu klawisza jest to oś globalna. Jeżeli jednak naciśniesz ten sam klawisz po raz drugi — przełączysz się na lokalną oś obiektu. Takie rozróżnienie pomiędzy osią globalną i lokalną ma znaczenie wtedy, gdy obiekt jest w jakiś sposób obrócony. Rysunek 14.4.2 pokazuje przykład takiej sytuacji. Łopata śmigła została najpierw (jako obiekt) obrócona o 120º w prawo. Następnie przełączyłem się w tryb edycji, zaznaczyłem kilka wierzchołków siatki, i nacisnąłem G, X. W efekcie mogę przesuwać wierzchołki wzdłuż globalnej osi X — na bok (Rysunek 14.4.2b). Jeżeli nacisnę jeszcze raz X — przełączę się na przesunięcie wzdłuż lokalnej osi X obiektu (Rysunek 14.4.2c):
Rysunek 14.4.2 Przesuwanie wzdłuż globalnej osi X (X) i lokalnej osi X (X, X)
W związku z tym, że obiekt został wcześniej obrócony, jego lokalna oś X jest pochylona. Przesunięcie “na bok” zaznaczonych wierzchołków oznacza w tym przypadku przemieszczenie pod kątem!
Podczas przesuwania możesz dodatkowo trzymać wciśnięty klawisz Ctrl. Spowoduje to skokową zmianę odległości (np. co 0.1 jednostki). Jeżeli będziesz trzymał wciśnięty klawisz Shift — przesunięcia na ekranie “wyhamują”, pozwalając na dokładniejsze ustalenie pozycji. Wreszcie kombinacja obydwu — Shift-Ctrl — umożliwia skokową zmianę położenia o niewielkie wartości (np. co 0.01 jednostki).
Zaznacz grupę wierzchołków, które chcesz powiększyć/pomniejszyć, oraz ustal środek transformacji (na liście Pivot — Rysunek 14.5.1). Praktycznie stosuję dwa — trzy rodzaje środków: Bounding Box Center, Median Point oraz Cursor 3D. Bounding Box Center to środek „pudełka” nadpisanego na zaznaczonych wierzchołkach. Median Point to wypadkowy środek wszystkich zaznaczonych wierzchołków. (W przypadku trójkąta leży w “środku ciężkości” tej figury). W ostatnim z wymienionych trybów środkiem transformacji jest 3D Cursor. Zacznijmy od trybu w którym środkiem skalowania jest Median Point (możesz go także ustawić używając skrótu Shift-,).
Naciśnij S (Mesh→Transfrom→Scale). Przełączysz się w ten sposób w tryb skalowania. Na rysunku pojawi się kreskowana linia od kursora myszy do środka transformacji. Każde przesunięcie myszy będzie powodować zmianę skali zaznaczonych wierzchołków — proporcjonalnie do zmiany długości kreskowanej linii. Dokonywane zmiany w kształcie siatki są pokazywane na bieżąco we wszystkich oknach Blendera (Rysunek 14.5.1):
Rysunek 14.5.1 Skalowanie względem środka zaznaczonych wierzchołków
W nagłówku aktywnego okna jest wyświetlana aktualna zmiana skali wzdłuż każdej osi. Aby zatwierdzić nowe położenie wierzchołków (zakończyć transformację), należy kliknąć LPM. Aby zrezygnować z operacji, możesz w każdej chwili nacisnąć Esc .
Podczas zmiany skali możesz dodatkowo trzymać wciśnięty klawisz Ctrl. Spowoduje to skokową zmianę proporcji (np. co 0.1). Jeżeli będziesz trzymał wciśnięty klawisz Shift — zmiana skali na ekranie “wyhamuje”, pozwalając na dokładniejsze ustalenie. Wreszcie kombinacja obydwu — Shift-Ctrl — umożliwia skokową zmianę skali o niewielkie wartości (np. co 0.01).
Jeżeli w trakcie przesuwania naciśniesz X, Y, lub Z — ograniczysz zmianę skali do jednej z tych osi. W pozostałych kierunkach żaden rozmiar nie ulegnie zmianie. Po pierwszym naciśnięciu klawisza jest wybrana oś globalna. Jeżeli jednak jeszcze raz naciśniesz ten sam klawisz — przełączysz się na lokalną oś obiektu. To rozróżnienie pomiędzy osią globalną i lokalną ma swój sens wtedy, gdy obiekt jest w jakiś sposób obrócony.
Aby ograniczyć skalowanie do jednej płaszczyzny, użyj skrótu Shift-[blokowana oś]. Np. Shift-Z blokuje zmiany wzdłuż globalnej osi Z. Gdy naciśniesz taki skrót jeszcze raz, zablokujesz skalowanie wzdłuż lokalnej osi obiektu. (Dlatego aby zablokować zmiany wzdłuż lokalnej osi Z, naciśnij powtórnie Shift-Z).
Pokażę to na przykładzie modyfikacji krawędzi spływu końcówki skrzydła (Rysunek 14.5.2):
Rysunek 14.5.2 Wykluczenie jednej osi ze zmiany skali
Za pomocą zmiany skali chcę przesunąć zaznaczone wierzchołki bliżej konturu końcówki, narysowanego na płaszczyźnie X,Y na czerwono (Rysunek 14.5.2a). Zależy mi jednak na tym, aby współrzędne Z krawędzi spływu i pozostałych zaznaczonych wierzchołków (Rysunek 14.5.2d) nie uległy podczas tej operacji zmianie.
Po naciśnięciu S naciskam skrót Shift-Z aby zablokować oś Z (Rysunek 14.5.2b). W ten sposób współrzędne Z skalowanych wierzchołków nie ulegają zmianie (porównaj Rysunek 14.5.2d i Rysunek 14.5.2e). Gdy skończysz transformację, w opcjach wykonanego polecenia Resize możesz się upewnić, że przełącznik Constraint Axis: Z jest wyłączony (Rysunek 14.5.2c).
Rysunek 14.5.3a) pokazuje inny przykład — krawędź, którą „spłaszczymy” skalując wzdłuż jednej osi. Punktem odniesienia będzie tu 3D Cursor. Umieszczam go na płaszczyźnie, gdzie chcę mają się znaleźć wszystkie wybrane wierzchołki. Na tym przykładzie część krawędzi leży we właściwym miejscu. Zaznaczyłem więc jeden z poprawnych wierzchołków i przeniosłem w to miejsce kursor 3D (Shift-S, 3 — Rysunek 14.5.3b,c):
Rysunek 14.5.3 Spłaszczenie krawędzi — ustawienie kursora 3D w odpowiednim miejscu
Przełączyłem typ punktu odniesienia na 3D Cursor (na klawiaturze: .) i zaznaczyłem wszystkie wierzchołki krawędzi. Nacisnąłem S, Y. Następnie naciśnij klawisz 0 (por. str. 92) by zmniejszyć odległość wierzchołków od środka skalowania do zera (Rysunek 14.5.4):
Rysunek 14.5.4 Spłaszczenie krawędzi — poprzez zmianę skali do zera
Zmianę skali do zera wzdłuż jednej lub wszystkich osi można także stosować do dokładnego “spłaszczania” lub ustalania pozycji wierzchołków.
W czasie modelowania bardzo często używam skalowania do realizacji tych dwóch zadań.
Zaznacz grupę wierzchołków, które chcesz obrócić, oraz ustal środek transformacji (Pivot) (Rysunek 14.6.1). Praktycznie stosuję jeden z dwóch rodzajów środka: Bounding Box Center albo 3D Cursor . W tym przypadku, środkiem obrotu będzie 3D Cursor. Możesz go ustawić za pomocą klawiatury — naciśnij klawisz . (kropka):
Rysunek 14.6.1 Przygotowanie operacji
Naciśnij R (Mesh→Transfrom→Rotate). Przełączysz się w ten sposób w tryb obrotu. Na rysunku pojawi się kreskowana linia od kursora myszy do środka transformacji. Każde przesunięcie myszy będzie powodować obrót zaznaczonych wierzchołków — proporcjonalnie do zmiany kąta kreskowanej linii. Dokonywane zmiany w kształcie siatki są wyświetlane na bieżąco we wszystkich oknach Blendera (Rysunek 14.6.2):
Rysunek 14.6.2 Obrót grupy wierzchołków
Domyślnie obrót następuje w płaszczyźnie aktywnego widoku. W nagłówku aktywnego okna jest wyświetlany aktualny kąt obrotu.. Aby zatwierdzić nowe położenie wierzchołków (zakończyć transformację), należy kliknąć LPM. Aby zrezygnować z operacji, możesz w każdej chwili nacisnąć Esc .
Jeżeli w trakcie obrotu naciśniesz X, Y, lub Z — przełączysz się na obrót wokół jednej z tych osi. Po pierwszym naciśnięciu klawisza jest wybrana oś globalna. Jeżeli jednak jeszcze raz naciśniesz ten sam klawisz — przełączysz się na lokalną oś obiektu. To rozróżnienie pomiędzy osią globalną i lokalną ma swój sens wtedy, gdy obiekt jest w jakiś sposób obrócony.
Podczas obrotu możesz dodatkowo trzymać wciśnięty klawisz Ctrl. Spowoduje to skokową zmianę proporcji (co 5º). Jeżeli będziesz trzymał wciśnięty klawisz Shift — zmiana obrót na ekranie “wyhamuje”, pozwalając na dokładniejsze ustalenie. Wreszcie kombinacja obydwu — Shift-Ctrl — umożliwia skokową zmianę obrotu o niewielkie kąty (np. co 0.5º).
Aby wytłoczyć wybraną krawędź, zaznacz ją. Następnie naciśnij E (Mesh→Extrude Region). W tym momencie została utworzona kopia zaznaczonej krawędzi. Kopia ta będzie podążać za ruchem myszki “ciągnąc” za sobą będzie krawędzie poprzeczne, łączące jej wierzchołki z wierzchołkami oryginału. Kliknij LPM w miejscu, gdzie nowa krawędź ma zostać ostatecznie umieszczona (Rysunek 14.7.1):
Rysunek 14.7.1 Wytłaczanie krawędzi
Podczas przesuwania wytłoczonych elementów możesz ograniczyć ich ruch do osi X, Y, lub Z — te skróty działają tak samo, jak w standardowym poleceniu przesunięcia (por. str. 894).
Aby wytłoczyć wybrany obszar, zaznacz go. Następnie naciśnij E (Mesh→Extrude Region). W tym momencie wzdłuż krawędzi zaznaczonego obszaru zostały dodane dodatkowa ściany. Sam obszar będzie podążać za ruchem myszki, zupełnie jak podczas przesuwania. Kliknij LPM w miejscu, gdzie ma zostać ostatecznie umieszczony (Rysunek 14.7.2):
Rysunek 14.7.2 Wytłaczanie obszaru
Domyślnie kierunek przesunięcia jest ograniczony do linii prostopadłej do płaszczyzny przesuwanego obszaru.
Jeżeli zaraz po wywołaniu polecenia Extrude naciśniesz Esc — przerwana zostanie (tylko!) druga część operacji. Mimo, że tego zazwyczaj nie widać, odpowiednie krawędzie/ ściany/ wierzchołki uległy już powieleniu, i są zaznaczone. W razie czego musisz je usunąć dodatkowym poleceniem (Delete).
Gdy zaraz po wywołaniu Extrude naciśniesz S — wytłaczane elementy będą skalowane, a nie przesuwane. (Podobnie gdy naciśniesz R, będą obracane). W taki przypadku uważaj na punkt odniesienia! Lepiej jest używać w tym charakterze kursora (tryb 3D Cursor) — bo to punkt, nad którym w pełni panujesz. Zdanie się na wypadkową środków (Median Point, Bounding Box Center) może prowadzić do niespodziewanych deformacji! (Chyba że zaznaczonych wierzchołki są rozłożone symetrycznie).
Czasami zachodzi także konieczność wytłoczenia wybranych wierzchołków (np. po to, by utworzyć “ręcznie” nową ścianę). Operację zaczynasz tak, jak zazwyczaj — zaznacz wierzchołki do powielenia. Następnie naciśnij Alt-E (to wersja polecenia Extrude pozwalająca wybrać ręcznie tryb pracy). Z menu rozwijalnego, które się pojawi, wybierz Vertices Only. W tym momencie została utworzone kopie zaznaczonych wierzchołków. Kopie te będzie podążać za ruchem myszki. “Ciągnąć” za sobą będą krawędzie, łączące je z oryginałami. Tym razem jednak te krawędzie nie są połączone ścianami. Kliknij LPM w miejscu, gdzie nowe wierzchołki mają zostać ostatecznie umieszczone (Rysunek 14.7.3):
Rysunek 14.7.3 Wytłaczanie pojedynczych wierzchołków w krawędzie
W oknie Properties przejdź do zestawu Modifiers i rozwiń tam listę Add Modifier. Spośród dostępnych “modyfikatorów” siatki wybierz Subdivison Surface (Rysunek 14.8.1):
Rysunek 14.8.1 Dodanie modyfikatora wygładzenia siatki (Subdivision Surface)
Dodanie modyfikatora spowodowało wygładzenie powierzchni - wszystkie narożniki uległy zaokrągleniu “do środka”. Faktura powierzchni zdradza, że teraz zamiast 8 ścian siatka składa się z 32 ścian. Jest to tak zwana “powierzchnia podziałowa”. Wierzchołki oryginalnej siatki pełnią rolę tzw. punktów sterujących (control points). Możesz zmienić kształt powłoki, zmieniając ich położenie. Jednocześnie w zestawie Modifiers pojawiła się panel z parametrami modyfikatora (Rysunek 14.8.2):
Rysunek 14.8.2 Modyfikator Subdivision Surface
Proponuję ustalać liczbę podziałów powierzchni (Subdivisions) na 1-2, w wyjątkowych przypadkach 3. To zapewni odpowiednio małą liczbę ścian przy wystarczającej “gładkości”. Poziom podziału do renderowania (Render) można ustawić o 1 większy. (Choć na pewno w jakimś stopniu wydłuży to czas obliczania finalnego obrazu). Jeżeli chcesz dowiedzieć się więcej o powierzchniach podziałowych — por. “Powierzchnie podziałowe”, str. 1221.
Zwróć uwagę, że możesz w każdej chwili zmienić liczbę podziałów powierzchni. To może mieć znaczenie, gdy dla potrzeb gry chcesz mieć model o jak najmniejszej liczbie ścian. Dzięki Subdivision Surfaces możesz używać tego samego modelu raz w roli “dokładnego” (większa liczba ścian). Innym razem — możesz go użyć w roli modelu “uproszczonego” (zmniejszając liczbę ścian poprzez zmniejszenie liczby podziałów).
Subsurf jest modyfikatorem siatki — oznacza to, że zmiany, jakie wprowadził, są odwracalne. Wystarczy że usuniesz ten modyfikator, klikając w mały przycisk w jego lewym, górnym narożniku (Rysunek 14.8.2) . Wygładzona siatka zniknie, i pozostaniesz z powrotem z podstawowym zestawem ścian.
Możesz także “utrwalić” podział siatki — naciskając przycisk Apply (Rysunek 14.8.2). Spowoduje to zniknięcie modyfikatora i trwałe przyjęcie przez siatkę kształtu powierzchni podziałowej.
Początkowo cienie na wygładzonej siatce zdradzają przebieg krawędzi elementarnych ścian (Rysunek 14.8.1). Aby temu zaradzić, zmienimy model cieniowania. Zaznacz wszystkie wierzchołki siatki (naciskając A — Select→Select All). Następnie z menu Specials (W) wybierz Shade Smooth (Rysunek 14.8.3):
Rysunek 14.8.3 Zmiana modelu cieniowania na “gładki”
Efekt nie całkiem odpowiada naszym oczekiwaniom: co to za ciemne cienie, biegnące wzdłuż oryginalnych krawędzi? To rezultat niewłaściwego skierowania wektorów normalnych w niektórych wierzchołkach! Na szczęście poprawienie tego nie jest kłopotliwe. Naciśnij Ctrl-N (Mesh→Normals→Recalulate Outside). Rysunek 14.8.4 przedstawia rezultat:
Rysunek 14.8.4 Uporządkowanie kierunku normalnych
I tym razem rezultat (Rysunek 14.8.4) jest już tym, o co nam chodziło — gładką powierzchnią, bez załamań i cieni w miejscu podziału ścian.
Aby uzyskać z powrotem powierzchnię z pocieniowanymi ścianami — zaznacz całość i wywołaj Specials→Shade Flat.
Zmianę metody cieniowania możesz ustalać oddzielnie dla różnych fragmentów siatki. W zależności od tego, jakie wierzchołki zaznaczysz, część powierzchni może być “smooth”, a część — “flat”.
Zaznacz wierzchołki, które powinny zostać scalone w jeden. Muszą być położone blisko siebie, lub dokładnie w tym samym miejscu. Czasami, aby ten warunek zapewnić, zmniejszałem ich skalę do zera (z włączonym środkiem typu Median Point - p. str. 896).
Następnie naciśnij W, by przywołać menu Specials. Wybierz z niego polecenie Remove Doubles (Rysunek 14.9.1a).
Rysunek 14.9.1 Scalanie wierzchołków
Alternatywnie wybrać to polecenie głównego menu (Mesh→Vertices→Remove Doubles), ale to znacznie dłuższa droga. W efekcie operacji zaznaczone wierzchołki są zamienione w jeden wierzchołek. W oknie 3D View nic się nie zmieniło (bo te punkty i tak były w tym samym miejscu). Jedyną różnicę zauważysz podczas selekcji wierzchołków i krawędzi.
W razie potrzeby aby zmienić parametry tolerancji tego scalania, otwórz przybornik Tool Shelf. Znajdziesz tam pole Merge Distance (Rysunek 14.9.1b). (Ten sam parametr możesz także zmienić naciskając po wywołaniu operacji klawisz F6, by otworzyć jej okno dialogowe).
U góry ekranu, w nagłówku okna Info, po wywołaniu polecenia Remove Doubles program przez kilka sekund wyświetla informację o liczbie usuniętych wierzchołków (Rysunek 14.9.2):
Rysunek 14.9.2 Informacja o rezultacie operacji w oknie Info
Jeżeli nie zdążyłeś go dostrzec — możesz ją zawsze znaleźć we wnętrzu okna Info, gdzie są odnotowywane wszystkie wywoływane polecenia i ew. komunikaty programu. (Wystarczy je powiększyć w pionie, by oprócz nagłówka była widoczna także reszta okna).
Narzędzie Knife pozwala stworzyć w siatce nowe krawędzie. Powstają one poprzez przecięcie zaznaczonych ścian, w kierunku prostopadłym do aktualnego widoku (tzn. płaszczyzny ekranu). Rolę “krawędzi tnącej” pełni narysowana w oknie 3D View pomocnicza linia łamana. Funkcji Knife można używać na wiele różnych sposobów. Do modelowania samolotów używam jej zazwyczaj w trybie cut through, i taki tryb opisuję poniżej.
Zaznacz na siatce krawędzie, które mają zostać przecięte (Rysunek 14.10.1a). W tym przykładzie zaznaczyłem obszarem (B) ściany po obydwu stronach skrzydła (Rysunek 14.10.1b):
Rysunek 14.10.1 Zaznaczenie ścian do przecięcia
Naciśnij Shift-K (Knife) Zwróć uwagę, że kursor myszy zmienił się teraz na mały “skalpel”. Narysuj teraz krawędź tnącą. Kliknij LPM w miejsce ekranu, gdzie ma się znaleźć pierwszy punkt tej krawędzi (Rysunek 14.10.2a). Za kursorem myszy zaczęła teraz podążać linia, pokazująca przebieg pierwszego segmentu cięcia.
Rysunek 14.10.2 Cięcie siatki za pomocą narzędzia Knife
Kliknij LPM w drugi punkt — w ten sposób zakończysz rysowanie pierwszego segmentu (Rysunek 14.10.2b). Blender automatycznie ciągnie od ostatnio narysowanego punktu do kursora myszy kolejną linię (Rysunek 14.10.2c). Jeżeli nie chcesz niczego więcej przecinać — naciśnij Enter lub Spację. To zakończy rysowanie linii i spowoduje dodanie proponowanych krawędzi do siatki. (Jeżeli chcesz zrezygnować z polecenia, w każdym momencie możesz nacisnąć Esc lub PPM).
Rezultat operacji przedstawia Rysunek 14.10.3. Gdy przyjrzysz się temu rezultatowi w przestrzeni, dostrzeżesz że powstała linia biegnąca na górnej i dolnej powierzchni skrzydła (Rysunek 14.10.3b):
Rysunek 14.10.3 Rezultat dwustronnego cięcia — w rzucie z góry i w przestrzeni
Za pomocą Knife można przypadkowo stworzyć ściany o liczbie boków większej niż 4. W grafice komputerowej określa się je jako n-gony. Takie ściany są bardzo przydatne w trakcie formowania siatki. Potem jednak staraj się je zastąpić zespołami kwadratów i trójkątów (por. str. 933).
Zwróć uwagę na informację, wyświetlaną w nagłówku okna w trakcie polecenia Knife. Program wyświetla tam bieżące wartości wewnętrznych flag i klawisze, którymi możesz je przełączyć (Rysunek 14.10.4):
Rysunek 14.10.4 Skróty klawiatury i bieżący stan narzędzia Knife, wyświetlane w pasku stanu
Flagi te odpowiadają następującym trybom działania noża:
ignore snap: wyłączenie wszelkich skoków do punktów charakterystycznych (trochę pokrętnie, bo stan Off oznacza że skok jest aktywny);
angle constrain: prowadź linię cięcia pod „równymi” kątami: 0º, 30º, 45º, 60º, 90º…;
cut through: przecinanie wszystkich zaznaczonych ścian — także gdy są zasłonięte przez inne;
Gdy podczas pracy z modelem zależy Ci na cięciu dokładnie wzdłuż linii poziomej lub pionowej, wówczas przydaje się możliwość włączenia trybu angle constrain (C).
Możesz wywołać Knife za pomocą dwóch skrótów: K (cut through nieaktywne) i Shift-K (cut through aktywne). Gdy tryb cut through jest aktywny, Knife przecina wszystkie zaznaczone ściany, nawet gdy są zasłonięte przez inne. Kiedy cut through jest nieaktywny, cięte są tylko widoczne ściany (niezależnie od tego, czy będą zaznaczone, czy nie).
Tryb cut through miał w Blendere 2.6 kilka błędów, które powodowały że czasami krawędź przecięcia zawierała częściwo odłączone wierzchołki i krawędzie1. Na szczęście w Blenderze 2.70 zostało to poprawione i teraz działa poprawnie.
Zaznacz wierzchołki, które chcesz skopiować (Rysunek 14.11.1):
Rysunek 14.11.1 Zaznaczenie wierzchołków do powielenia
Następnie naciśnij Shift → D (Mesh→Duplicate). W rezultacie w siatce pojawią się nowe wierzchołki. Są one od razu zaznaczone (Rysunek 14.11.2):
Rysunek 14.11.2 Odsunięcie powielonych wierzchołków
Powielony fragment siatki możesz od razu odsunąć od oryginału — zupełnie jak podczas polecenia Grab/Move (por. str. 894). (Na przykład, naciśnij klawisz Z, aby przesunąć je wzdłuż osi Z, i trzymaj wciśnięty klawisz Ctrl, jeżeli mają zostać przesunięte na jakąś równą odległość).
Zaznacz krawędź, które chcesz podzielić. Naciśnij następnie W, by otworzyć menu Specials. Wybierz stamtąd polecenie Subdivide (Rysunek 14.12.1):
Rysunek 14.12.1 Wywołanie z menu Specials polecenia Subdivide
W środku zaznaczonej krawędzi pojawi się nowy wierzchołek. (To samo polecenie znajduje się także w “zwykłym” menu: Mesh→Edge→Subdivide).
Gdy otworzysz przybornik Toolshelf (T) lub naciśniesz F6, zobaczysz parametry tego polecenia (Rysunek 14.12.2):
Rysunek 14.12.2 Paramery polecenia Subdivide
Paramter Number of Cuts steruje liczbą podziałów. To opcja szczególnie użyteczna dla liczb parzystych, których nie możesz uzyskać w wyniku kolejnych wywołań polecenia. Subdivide zazwyczaj zmienia przyległe ściany w n-gony, chyba że włączysz Quad/Tri Mode. Ta opcja zmusza Blendera do podziału przyległych ścian siatki na kwadraty i czworokąty (Rysunek 14.12.2).
Możesz także użyć Subdivide do podziału ścian siatki. Polecenie dzieli ściany czworokątne na cztery lub więcej czworokątów, a trójkątne — na cztery lub więcej trójkątów.
Operacja polega na przesunięciu po ścianach siatki jednej z jej linii wierzchołków (egdeloop) w nowe położenie.
Zaznacz rząd wierzchołków, który ma być przesunięty. (Musi to być konkretny rząd, a nie dowolny zbiór wierzchołków — zaznaczaj więc używając Alt - PPM). Następnie naciśnij Ctrl - E, i z menu Edge Specials wybierz polecenie Edge Slide (Rysunek 14.13.1). (Możesz je także wywołać jako Mesh→Edges→Edge Slide):
Rysunek 14.13.1 Rozpoczęcie przesuwania linii wierzchołków
Od tej chwili każde przesunięcie myszy powoduje wybranej linii wierzchołków. U nagłówku okna Blender wyświetla względne położenie krawędzi w stosunku do linii sąsiednich. Gdy Edge Slide = 0.0, przesuwana krawędź znajduje się w oryginalnym położeniu. Gdy zbliżymy ją do linii z prawej (Rysunek 14.13.1), kształt będzie zmieniał, aż w końcu stanie się identyczny z lewym rzędem (Edge Slide = -1.0). Gdy zbliżymy zaznaczoną linię do linii z lewej, kształt będzie proporcjonalnie się zmniejszał, aż stanie się taki sam jak lewa krawędź (Edge Slide = +1.0) . Kończymy całą operację, naciskając LPM. W każdej chwili możesz z niej zrezygnować, naciskając Esc.
Aby przesunąć pojedynczy wierzchołek wzdłuż jednej z krawędzi które łączy, zaznacz go (Rysunek 14.14.1a) i naciśnij Shift-V (Mesh→Vertices→Vertex Slide):
Rysunek 14.14.1 Przesuwanie wierzchołka po krawędzi
Po wywołaniu tego polecenia Blender zaczyna przesuwać wierzchołek podążając za ruchem kursora myszki. Ten ruch odbywa się po krawędzi, do której jest zbliżony kursor. (Podczas operacji jest zaznaczona grubszą linią — Rysunek 14.14.1b). W nagłówku okna jest wyświetlane jego względne położenie od pozycji początkowej (Vert Slide = 0.0) do końcowej (przy przeciwległym wierzchołku Vert Slide = 1.0). Gdy przesuniesz wierzchołek w nowe miejsce, zakończ operację kliknięciem LPM. (Możesz także w każdej w chwili z niej zrezygnować, naciskając Esc).
Możesz także przesuwać kilka wierzchołków naraz – każdy po „swojej” krawędzi (Rysunek 14.14.2):
Rysunek 14.14.2 Przesuwanie kilku wierzchołków jednocześnie
Zgodnie z podpowiedzią wyświetlaną w nagłówku okna: gdy naciśniesz C przełączając flagę Clamp na OFF, możesz przesunąć wierzchołek poza koniec wybranej krawędzi.
Operacja polega na wstawieniu nowej linii wierzchołków (egdeloop) pomiędzy istniejące linie siatki.
Naciśnij T aby otworzyć przybornik Toolshelf, i z sekcji Add panelu Tools:Mesh Tools wybierz polecenie Loop Cut and Slide (Rysunek 14.15.1):
Rysunek 14.15.1 Wywołanie polecenia Loop Cut
Aby to polecenie wywołać, możesz także użyć skrótu Ctrl-R. Teraz masz wybrać, w jakim kierunku, i pomiędzy którymi liniami chcesz wstawić nowy rząd wierzchołków. W zależności od tego, gdzie ustawisz mysz, Blender pokazuje aktualną możliwość za pomocą fioletowej linii.
Dla uproszczenia tłumaczenia, nazwijmy okręgi na siatce stożka „równoleżnikami”, a krawędzie do nich poprzeczne — „południkami”. Rysunek 14.15.2a) pokazuje, że gdy zbliżysz kursor do jakiegoś „południka” siatki, Blender zaproponuje utworzenie nowego „równoleżnika”. Ta nowa linia zostanie utworzona pomiędzy dwoma sąsiednimi „równoleżnikami”, które są najbliższe kursora. Jeżeli z kolei zbliżysz kursor w pobliże „równoleżnika” — Blender zaproponuje nowy „południk” (Rysunek 14.15.2b):
Rysunek 14.15.2 Wybór kierunku i pary sąsiednich linii
Wybór kierunku i sąsiednich linii siatki zatwierdzasz kliknięciem LPM.
Powiedzmy, że wybraliśmy opcję stworzenia nowego “równoleżnika” (Rysunek 14.15.2a). Po kliknięciu LPM Blender wstawił w zaznaczony obszar nową linię wierzchołków (Rysunek 14.15.3). Od tej chwili każde przesunięcie myszy powoduje przesuwanie wybranej linii wierzchołków po powierzchni siatki — tak jak w poleceniu Edge Slide (por. str. 911). W nagłówku okna 3D View program wyświetla % dystansu pomiędzy sąsiednimi krawędziami. (0% odpowiada krawędzi leżącej dokładnie pośrodku). Kończymy całą operację, naciskając powtórnie LPM. W każdej chwili możesz z niej zrezygnować, naciskając Esc.
Ostateczny efekt pokazuje Rysunek 14.15.4 — możesz porównać ze stanem początkowym (Rysunek 14.15.1):
Rysunek 14.15.4 Wstawiony nowy rząd wierzchołków
Blender pozwala na zmianę ostrości wybranych krawędzi “wygładzonej” siatki. Możesz ten efekt płynnie stopniować. Sprowadza się to do tego, że każda krawędź ma dodatkowy parametr — Crease — który może przyjmować wartości od 0.0 (zupełnie gładka) do 1.0 (zupełnie ostra). Zmianę ostrości pokażę na przykładzie zwiększenia ostrości krawędzi podstawy stożka. (Analogicznie możesz wygładzić ostrą krawędź).
Zaznacz krawędzie, które chcesz wyostrzyć. Następnie naciśnij Shift-E (Mesh→Edges→Edge Crease) (Rysunek 14.16.1):
Rysunek 14.16.1 Stan początkowy: krawędź “naturalnie zaokrąglona”
Spowoduje to pojawienie się pomocniczej, przerywanej linii, biegnącej od środka zaznaczonych wierzchołków do aktualnej pozycji kursora myszy (Rysunek 14.16.2):
Rysunek 14.16.2 Wyostrzanie krawędzi
Od tej chwili położenie kursora określa poziom wyostrzenia (Crease) . Jego wartość jest pokazywana na bieżąco w nagłówku aktywnego okna (Rysunek 14.16.2). Do dyspozycji masz zakres wartości od Crease = 0 (naturalna, gładka powierzchnia), do Crease = 1.0 (ostra krawędź). Rysunek 14.16.2 pokazuje, na ile wyostrzyła się krawędź przy Crease = 0.4.
Podczas zmiany ostrości krawędzi możesz także wykorzystywać klawisz Ctrl — powoduje skokową zmianę parametru Crease o 0.1.
Gdy zwiększysz ostrość (crease) do poziomu = 1.0, uzyskasz absolutnie ostrą krawędź (Rysunek 14.16.3):
Rysunek 14.16.3 Krawędź ostra (crease = 1.0)
Zwróć uwagę, że krawędź jest ostra tylko w jednym kierunku. W kierunku poprzecznym nadal jest gładka, dzięki czemu zachowała kształt okręgu. (Gdybyś chciał uzyskać kształt ośmiokąta — powinieneś wyostrzyć także krawędzie “południków” tego stożka) .
Zmianę ostrości krawędzi zatwierdzamy kliknięciem LPM. Jeżeli chcesz zrezygnować z operacji — naciśnij Esc.
Na koniec czynność kosmetyczna — krawędź będzie lepiej wyglądać, gdy zmienimy sposób cieniowania ścian podstawy z “gładkiego” na “płaski”. Zaznacz ściany podstawy i naciśnij klawisz W, by otworzyć podręczne menu siatki (Specials) . Wywołaj stamtąd polecenie ShadeFlat (Rysunek 14.16.4):
Rysunek 14.16.4 Zmiana sposobu cieniowania ścian podstawy na “płaski” (Flat)
Usuwanie linii wierzchołków różni się od wszystkich innych “usunięć” w trybie edycji. Różnica polega na tym, że zachowuje ciągłość ścian siatki. Jest to operacja odwrotna do wstawienia nowej linii wierzchołków poleceniem Loop Cut (str. 913).
Zaznacz linię wierzchołków, którą zamierzasz usunąć (najlepiej — użyj PPM i klawisza Alt, aby na pewno zaznaczyć całą linię). Następnie naciśnij X (lub Mesh→Delete...) i z menu Delete, które się pojawi, wybierz opcję Edge Loops (Rysunek 14.17.1):
Rysunek 14.17.1 Usuwanie linii wierzchołków
W efekcie rząd wierzchołków, który chcieliśmy usunąć, znikł z siatki. Ciągłość powierzchni została jednak zachowana — sąsiadujące wzdłuż usuwanej krawędzi ściany uległy scaleniu.
Gdy chcesz usunąć tylko część jakiegoś ciągu krawędzi, możesz także zastosować opcję Limited Dissolve (Rysunek 14.17.2):
Rysunek 14.17.2 Usuwanie części linii wierzchołków
Zauważ że dwa ostatnie zaznaczone wierzchołki (oznaczone jako A i B – por. Rysunek 14.17.2) nie zostały usunięte.
Rezultat Limited Dissolved zależy od wartości parametru Max Angle (dostępnego w oknie otwieranym przez klawisz F6, patrz Rysunek 14.17.3). Kiedy zmniejszysz go do 0º, nic nie zostanie usunięte!
Zaznacz wierzchołki, które chcesz usunąć, a następnie naciśnij Delete (lub X). Z menu Delete wybierz Vertices (Rysunek 14.18.1):
Rysunek 14.18.1 Usuwanie wierzchołków z siatki
W rezultacie usunięcia wierzchołka znikną także wszystkie krawędzie i ściany, do których należał. Stąd zazwyczaj rezultatem takiej operacji jest “dziura” w siatce. (Oczywiście, to “twórcza destrukcja”. Zazwyczaj w ten sposób przygotowuje się miejsce na nowe ściany, otaczające np. otwór).
Aby usunąć wierzchołek bez usuwania ścian, użyj polecenia Dissolve Vertices (Rysunek 14.18.2):
Rysunek 14.18.2 Usuwanie wierzchołków z siatki (bez usuwania ścian)
Usuwając wierzchołek poleceniem Dissolve tworzysz ścianę o liczbie boków większej niż 4. Pamiętaj, aby po zakończeniu modelowania wyeliminować wszystkie takie ściany (więcej na ten temat — patrz str. 933).
Zaznacz krawędź/krawędzie, które chcesz usunąć (wygodniej to zrobić w trybie wyboru krawędzi, a nie wierzchołków — p. str. 893). Następnie naciśnij Delete (lub X). Z menu Delete wybierz opcję Edges (Rysunek 14.19.1):
Rysunek 14.19.1 Usuwanie wierzchołków z siatki (wraz ze ścianami)
W rezultacie usunięcia krawędzi znikną także wszystkie ściany, które dzieliła.
Aby usunąć krawędź bez usuwania ścian, użyj polecenia Dissolve Edges (Rysunek 14.19.2):
Rysunek 14.19.2 Usuwanie krawędzi z siatki (bez usuwania ścian)
Usuwając krawędź poleceniem Dissolve często możesz stworzyć ścianę o liczbie boków większej niż 4. Pamiętaj, aby po zakończeniu modelowania wyeliminować wszystkie takie ściany (więcej na ten temat — patrz str. 933).
Zaznacz ścianę/ściany, które chcesz usunąć (wygodniej to zrobić w trybie wyboru ścian, a nie wierzchołków — p. str. 893). Następnie naciśnij Delete (lub X). Z menu Delete wybierz Only Faces (Rysunek 14.20.1):
Rysunek 14.20.1 Usuwanie ścian z siatki
Zaznacz wierzchołki (lub krawędzie), na których chcesz “rozpiąć” nową ścianę. Następnie naciśnij F — Mesh→Make Edge/Face (Rysunek 14.21.1):
Rysunek 14.21.1 Dodanie trójkątnej ściany do siatki
Gdy zaznaczysz trzy wierzchołki i naciśniesz F, powstanie ściana trójkątna. Gdy zaznaczysz cztery wierzchołki i naciśniesz F — powstanie ściana czworokątna (Rysunek 14.21.2):
Rysunek 14.21.2 Dodanie czworokątnej ściany do siatki
Wraz z nową ścianą utworzone są nowe krawędzie (tam, gdzie ich brakowało).
Gdy użyjesz więcej niż 4 wierzchołków, Blender także stworzy z nich pojedynczą ścianę (tzw. n-gon) — tak jak to pokazuje Rysunek 14.21.3:
Rysunek 14.21.3 Stworzenie ściany liczącej więcej niż 4 boki
Ściany liczące więcej niż 4 boki mogą być bardzo przydatne podczas formowania siatki. Jeżeli jednak istnieje szansa, że Twój model będzie wykorzystywany np. w jakiejś grze — lepiej na koniec pracy pozamieniaj takie ściany w czworokąty lub trójkąty (por. str. 933).
By stworzyć cały ciąg ścian pomiędzy dwoma zaznaczonymi rzedami wierzchołków, użyj polecenia Mesh→Edges→Bridge Edge Loops. Znajdziesz je także w menu Specials (W) (Rysunek 14.21.4):
Rysunek 14.21.4 Łączenie dwóch krawędzi poleceniem Bridge Edge Loops
Można także wskazać więcej rzędów wierzchołkow — polecenie połączy je wszystkie. Jeżeli będą miały taką samą liczbę elementarnych krawędzi, Blender stworzy pomiędzy nimi regularne, czworoboczne ściany (Rysunek 14.21.4). W przeciwnym razie ściany będą trójkątne.
Bridge Edge Loops ma wiele dodatkowych opcji. Znajdziesz je po wywołaniu tego polecenia w jego panelu Option Tools (lub naciskając F6). Nie używałem ich podczas budowy tego modelu, bo w tym czasie jeszcze nie istniały. Myślę, że czasami mogą być przydatne. Na przykład: gdy zwiększysz wartość parametru Number of Cuts, Blender stworzy wygładzone przejście pomiędzy łączonymi sekcjami siatki (Rysunek 14.21.5):
Rysunek 14.21.5 Przykład dodatkowych opcji polecenia Bridge Edge Loops: efekt zwiększenia wartości Number of Cuts
Aby stworzyć nową krawędź na pomiędzy wierzchołkami nie należącymi do tej samej ściany: zaznacz dwa wierzchołki, a następnie naciśnij F (Mesh→Make Edge/Face — Rysunek 14.22.1):
Rysunek 14.22.1 Dodanie do siatki nowej krawędzi (bez ściany)
Aby stworzyć nową krawędź na pomiędzy wierzchołkami ścian: zaznacz dwa wierzchołki, a następnie naciśnij J (Mesh→Vertices→Vertex Connect — Rysunek 14.22.2):
Rysunek 14.22.2 Dodanie do siatki nowej krawędzi poprzez podział istniejącej ściany
To samo polecenie może być użyte do stworzenia krawędzi łączącej dwa wierzchołki należące do różnych ścian (Rysunek 14.22.3):
Rysunek 14.22.3 Dodanie do siatki nowej krawędzi łączącej dwa odległe wierzchołki
Zaznacz dwie trójkątne ściany, które chcesz złączyć ze sobą (muszą mieć wspólną krawędź). Następnie naciśnij Alt-J — Mesh→Faces→Tris to Quads (Rysunek 14.23.1):
Rysunek 14.23.1 Scalenie dwóch ścian trójkątnych w jedną ścianę czworokątną
Polecenie Tris to Quads nie działa, gdy trójkąty nie tworzą wypukłego czworokąta (Gdy kąt rozwarcia krawędzi w jakimkolwiek z wierzchołków byłby > 180º). To może się również zdarzyć gdy scalane ściany zawierają powielone wierzchołki (częsty przypadek w modelach importowanych z innych systemów).
Aby scalić dwie ściany o dowolnym kształcie, usuń ich wspólną krawędź poleceniem Delete→Dissolve (por. str. 919).
Zaznacz fragment siatki, który chcesz przekształcić w nowy obiekt. Następnie naciśnij P — Mesh→Vertices→Separate. Z menu opcji, które się pojawiło, wybierz Selection (Rysunek 14.24.1):
Rysunek 14.24.1 Wydzielenie zaznaczenia (lotki) w nową siatkę
W rezultacie zaznaczone ściany znikają z oryginalnej siatki. Nie są usuwane jednak tak samo, jak gdybyśmy wybrali polecenie Delete (str. 918). W tym przypadku krawędzie zaznaczonego obszaru pozostaną na swoim miejscu (Rysunek 14.24.2):
Rysunek 14.24.2 Siatka po wydzieleniu lotki
Gdzie się podział zaznaczony fragment siatki? Stał się siatką nowego obiektu (Rysunek 14.24.3):
Rysunek 14.24.3 Lotka, wydzielona z siatki
Nowy obiekt otrzymał taką samą nazwę jak ten, z którego powstał, zakończoną jednak dodatkową końcówką typu “.001”. Na przykład lotka, wydzielona w ten sposób z płata B.100.Wing, otrzymuje początkową nazwę B.100.Wing.001. Oczywiście, zmień ją zaraz na prawidłową (str. 825).
Operacją odwrotną do wydzielenia siatki jest scalenie siatek obiektów (Join Objects, str. 833).
Siatki obiektów symetrycznych można tworzyć w uproszczony sposób — modelując tylko jedną połowę. Kształt drugiej strony można uzyskać, stosując modyfikator Mirror.
Aby stworzyć lustrzane odbicie siatki, w zestawie Modifiers naciśnij przycisk Add Modifier. Spowoduje to rozwinięcie listy dostępnych “modyfikatorów” siatki. Wybierz spośród nich Mirror.
Rysunek 14.25.1 Zastosowanie modyfikatora Mirror
Środkiem lustrzanego odbicia, wykonywanego przez modyfikator Mirror, jest domyślnie środek obiektu (tzn. jego punkt odniesienia — nie mylić ze środkiem geometrycznym). Stąd też zawczasu należy zadbać, aby znajdował się we właściwym miejscu (por. str. 835). Odbicie dokonuje się wzdłuż lokalnych osi X, Y, Z obiektu. Oś odbicia ustalasz przełącznikami w panelu modyfikatora (X, Y, Z — Rysunek 14.25.1). Możliwe jest jednoczesne włączenie odbicia wzdłuż dwóch, a nawet wszystkich trzech osi.
Naciśnięcie przycisku Apply spowoduje “utrwalenie” siatki tworzonej przez modyfikator, tzn. stworzenie nowych wierzchołków i usunięcie modyfikatora Mirror (Rysunek 14.25.2):
Rysunek 14.25.2 „Utrwalenie” modyfikatora Mirror
Gdy stosujesz ten modyfikator dla powierzchni podziałowych — razem z modyfikatorem Subsurf — pamiętaj, aby Mirror był zawsze powyżej Subsurf. Szczególnie ważne w przypadku powierzchni podziałowych jest także ustawienie wartości Merge Limit (Rysunek 14.25.1). Dwa wierzchołki — oryginał i jego odbity obraz — leżące w odległości mniejszej niż Merge Limit, są traktowane jakby były jednym wierzchołkiem. Dzięki tej właściwości wygładzone modyfikatorem Subsurf powierzchnie nie mają w płaszczyźnie symetrii ostrej krawędzi, ani przerwy. Zazwyczaj nie musisz zmieniać wartości Mege Limit.
Transformacja polega na odsunięciu1 wybranych wierzchołków od aktualnej powierzchni. Każdy wierzchołek jest przemieszczony w kierunku prostopadłym (normalnym) do powierzchni, na odległość określoną przez użytkownika. Za pomocą odsunięcia można łatwo uzyskać takie efekty, jak nadanie powłoce grubości, czy wytłoczenie regularnych wgłębień (np. żeber lub podłużnic).
Operację zaczynamy od zaznaczenia wierzchołków, które mają być odsunięte. Często zaznaczone wierzchołki tworzę za pomocą wcześniejszego wytłoczenia (E — Extrude), podczas którego rezygnuję z proponowanego domyślnie przesunięcia (naciskając Esc). Rysunek 14.26.1a), b) pokazuje przykład zaznaczonych ścian po takiej właśnie operacji wytłoczenia “bez przesunięcia”:
Rysunek 14.26.1 Przygotowanie do operacji — zaznaczenie ścian, które mają być odsunięte
Następnie naciskamy Alt-S (Mesh→Transform→Shrink/Fatten) (Rysunek 14.26.3):
Rysunek 14.26.2 Przebieg operacji — wierzchołki przesuwają się wzdłuż normalnych do oryginalnej powłoki
Sterujesz dystansem odsunięcia przesuwając myszkę w górę i w dół. W trakcie ustalania tej odległości możesz się także posłużyć standardowymi klawiszami “modyfikującymi” Blendera. Trzymanie wciśniętego Ctrl powoduje, że dystans zmienia się skokowo, a Shift — zwiększa dokładność ruchu.
Rysunek 14.26.3 pokazuje efekt, który może wystąpić w przypadku odsuwania wierzchołków od płaskich ścian z ostrymi narożnikami:
Rysunek 14.26.3 Deformacja płaskich ścian w wyniku odsunięcia
Wierzchołki, które leżały w środku płaskich ścian, zostały odsunięte “głębiej” od oryginalnej powierzchni niż wierzchołki narożne. Mimo pozorów, wszystkie wierzchołki zostały przemieszczone na tę samą odległość (0.2 jedn. Blendera). Dysproporcja wynika wyłącznie z różnych kierunków normalnych. Wektory normalne w narożnikach są pochylone pod katem 45º, więc wierzchołki narożne przesunęły się o 0.2 jedn. pod kątem 45º. Punkty środkowe miały normalne skierowane prostopadle do przesuwanych ścian, więc odsunęły się na pełen dystans. W efekcie powstała deformacja, którą trzeba skorygować, “spłaszczając” z powrotem ściany. (Poprzez zmianę skali wzdłuż jednej z osi: X lub Y).
Transformacja Shrink/Fatten o wiele lepiej sprawdza się na mniej kanciastych kształtach. Rysunek 14.26.4a) przedstawia typowy przypadek takiej powierzchni — symetryczną połowę jakiejś powłoki:
Rysunek 14.26.4 Odsunięcie ścian na typowej, obłej powierzchni
W środku powłoki znajdują się dwa żebra. Zaznaczyłem ściany pomiędzy nimi i wytłoczyłem je (poleceniem Extrude). Zrezygnowałem z przesuwania (Esc) i wywołałem odsunięcie (Alt-S).
Rysunek 14.26.4b) pokazuje, jak należy przygotować krawędzie siatki, by odsunięcie przebiegło zgodnie z naszymi intencjami. Wykorzystałem tu fakt, że na krańcach powierzchni kierunek odsunięcia jest zawsze prostopadły do ostatniej ściany. Aby przebiegał wzdłuż płaszczyzny lustrzanego odbicia siatki, umieściłem na tym krańcu powierzchni niewielką, poziomą ściankę (Rysunek 14.26.4c). Jej istnienie wymusza odsunięcie krańcowego wierzchołka pionowo do dołu. Dla porównania przyjrzyj się drugiemu, “wolnemu” końcowi powierzchni (Rysunek 14.26.4d). Tu niczego specjalnego nie przygotowywałem, więc zaznaczony wierzchołek jest odsunięty pod pewnym katem.
Aby zobaczyć, jak skierowane są wektory normalne wierzchołków, przełącz w przyborniku Properties (N), w panelu Mesh Display, przełącznik Normals ze „ścian” na „wierzchołki”.
Operacja odsunięcia jest jednorazową. Po odsunięciu fragmentu powłoki zmienia się układ normalnych. Jeżeli chcesz wrócić do poprzedniego stanu — użyj polecenia Undo (Ctrl-Z).
Alternatywną metodą odsunięcia powierzchni jest użycie polecenia Solidify — p. str. 939.
Zaznacz ścianę, do której chcesz dopasować bieżący widok okna 3D View (Rysunek 14.27.1a). Potem naciśnij Shift-7 (View→Align View→Align View to Selected→Top) :
Rysunek 14.27.1 Ustawienie widoku na wprost zaznaczonej ściany
W rezultacie Blender ustawi płaszczyznę ekranu równolegle do zaznaczonej ściany (Rysunek 14.27.1b).
Warto pamiętać skróty, wywołujące te polecenia. Znajdziesz je w menu Align View to Selected. Są takie same jak skróty zmiany widoku globalnego, tyle że z dodatkowym klawiszem Shift (Rysunek 14.27.2):
Rysunek 14.27.2 Dostępne polecenia z submenu Align View to Selected
Widok można dopasowywać także do pojedynczej krawędzi siatki (Rysunek 14.27.3):
Rysunek 14.27.3 Rezultaty poleceń Align View dla pojedynczej krawędzi
Podczas różnych modyfikacji siatki można przypadkowo stworzyć ściany o liczbie boków większej niż 4. W grafice komputerowej określa się je jako n-gony. Takie ściany są bardzo przydatne w trakcie formowania. Potem jednak staraj się je zastąpić zespołami kwadratów i trójkątów, aby nie utrudnić ewentualnego eksport Twojego modelu do innych programów (np. silników gier). Pokażę tutaj, jak to zrobić.
Wyłącz wszelkie dotychczas zaznaczone ściany siatki. Następnie wywołaj polecenie Select→By Number of Verts. Zaraz potem naciśnij F6 i ustaw parametry tego polecenia jak jest to pokazuje Rysunek 14.28.1:
Rysunek 14.28.1 Odnajdowanie w siatce n-gonów
Potem obejrzyj ze wszystkich stron siatkę — program podświetli na niej n-gony. Eliminuj je po kolei, tak jak pokazuje to Rysunek 14.28.2:
Rysunek 14.28.2 Podział pięcioboku na trójkąt i kwadrat
Zaznacz dwa wierzchołki, które chcesz połączyć krawędzią i naciśnij J (Mesh→Vertices→Vertex Connect). Wstawiony w ten sposób odcinek podzielił pięciobok na trójkąt i czworokąt.
Dodając nowe krawędzie za pomocą skrótu J (Vertex Connect) możesz szybko wyeliminować n-gony z siatki. Operacją odwrotną jest Dissolve (por. str. 919)
Kadłub proponuję formować metodą “ewolucyjną”. Polega to na:
wytłoczeniu na całą długość jakiegoś dużego, jednorodnego elementu;
stopniowej modyfikacji takiej “rury” poprzez wstawianie w środek kolejnych wręg. Nadaję za ich pomocą niezbędną wypukłość, tam, gdzie powinna wystąpić.
W tej sekcji chcę pokazać typowe postępowanie podczas dodawania kolejnej wręgi. Przedstawię to na przykładzie formowania górnej części ogona P-40. Kształtujemy ją niezależnie od części środkowej i dolnej. Zacznij od wytłoczenia całej długości, do statecznika pionowego (Rysunek 14.29.1):
Rysunek 14.29.1 Wytłoczony zarys ogona P-40
Uzyskany obrys “odstaje” od rzutu z boku w środku długości (mam na myśli czerwoną, poprawioną linię — p. Rysunek 14.29.1). Wstaw więc w tym miejscu nową wręgę (Rysunek 14.29.2a):
Rysunek 14.29.2 Dodanie i dosunięcie do obrysu nowej wręgi
Po wstawieniu przesuń ją do góry (wzdłuż osi Z) tak, by obrys kadłuba z boku pokrył się z obrysem na planach (Rysunek 14.29.2b).
Teraz umieść kursor 3D w najwyższym wierzchołku wręgi. Najszybciej i najdokładniej jest to zrobić zaznaczając ten wierzchołek, i wywołując polecenie Shift-S (Snap), Cursor to Selected (Rysunek 14.29.3):
Rysunek 14.29.3 Umieszczenie kursora 3D w najwyższym wierzchołku wręgi
(Zakładam, że najwyższy punkt wręgi leży jednocześnie w osi kadłuba samolotu. Zazwyczaj tak jest). Teraz możesz wygodnie zmienić, poprzez zmianę skali względem kursora 3D, wysokość i szerokość wręgi (Rysunek 14.29.4a,b):
Rysunek 14.29.4 Dopasowanie wysokości szerokości wręgi do reszty kadłuba
Środek transformacji leży na górnej krawędzi kadłuba. Dzięki temu zmiana skali wzdłuż osi Z nie zagraża zgodności z obrysem z boku.
Poprawność uformowania wręgi warto jest także ocenić w rzucie z przodu (Rysunek 14.29.5). Podłużnice, które na nim widzimy, powinny wykazywać stopniowe przekształcanie, bez żadnych nagłych załamań.
Na koniec wstaw brakujące ściany, łączące górną i dolną część kadłuba.
Czasami podczas formowania otworu trzeba wstawić w narożnik pomocniczą linię łamaną, której wszystkie wierzchołki będą leżeć dokładnie na powierzchni oryginalnej ściany. Przykładem takiej sytuacji jest przygotowywanie otworu na kółko ogonowe w kadłubie. Otwór ten miał duży promień zaokrąglenia narożników (Rysunek 14.30.1). Musimy ten efekt odtworzyć:
Rysunek 14.30.1 Zaokrąglenie narożnika otworu w kadłubie
Wykorzystamy do tego kilka poleceń z tego rozdziału, które poznałeś już wcześniej.
Zacznijmy od podziału lewej krawędzi (zaokrąglenie ma się zacząć gdzieś w połowie — Rysunek 14.30.2):
Rysunek 14.30.2 Podział przedniej krawędzi
Wykorzystując nowy wierzchołek, podziel sąsiednie ściany (Rysunek 14.30.3):
Rysunek 14.30.3 Dodanie nowych krawędzi
Podziel wewnętrzną krawędź ściany narożnika na dwie (ewentualnie trzy) części (Rysunek 14.30.4):
Rysunek 14.30.4 Podział wewnętrznej krawędzi na trzy części
Następnie ustaw widok w bieżącym oknie 3D View prostopadle do ściany narożnej (Top — Rysunek 14.30.5):
Rysunek 14.30.5 Ustawienie płaszczyzny widoku równolegle do ściany
W płaszczyźnie ściany można łatwo przesunąć wewnętrzne wierzchołki krawędzi w kierunku narożnika, nadając krawędzi wygięcie (Rysunek 14.30.6):
Rysunek 14.30.6 Formowanie kształtu narożnika
Następnie zamień ten pięciobok na trzy trójkąty. (Robimy to wyłącznie po to, by ta ściana nie sprawiła nikomu kłopotu podczas ewentualnego importu do innego programu lub silnika gier).
Rysunek 14.30.7 przedstawia gotowe zaokrąglenie narożnika:
Rysunek 14.30.7 Gotowe zaokrąglenie
Polecenie Solidify różni się od Shrink/Fatten (str. 929) tym, że odsuwa od zaznaczonych ścian ich kopie, i łączy je ze sobą dodatkowymi poprzecznymi ścianami (nadając rezultatowi „grubość”).
Zaznacz najpierw obszar, dla którego chcesz uzyskać ten efekt (to nie musi być cała powłoka). Następnie wywołaj polecenie Mesh→Faces→Solidify (Rysunek 14.31.1):
Rysunek 14.31.1 Nadanie siatce grubości za pomocą polecenia Solidify
Blender odsunie od zaznaczonych ścian ich kopie wzdłuż wektorów normalnych siatki. Parametrem polecenia jest szerokość pogrubienia (thickness — Rysunek 14.31.2):
Rysunek 14.31.2 Sterowanie szerokością pogrubienia
Szerokości ujemne oznaczają odsunięcie “na zewnątrz” powłoki.
Aby przypisać pojedynczą siatkę do jakiegoś istniejącego materiału, należy zaznaczyć obiekt, który ją zawiera (tak, aby się stał obiektem aktywnym — Rysunek 14.32.1a). Następnie w oknie Properties, zestawie Material rozwiń listę z lewej strony przycisku New, i wybierz z niej jeden z widocznych tam materiałów (Rysunek 14.32.1b). Blender przypisuje domyślnie materiał do siatki1, a nie obiektu, stąd zmianie ulegnie nie tylko aktywny obiekt, ale także wszystkie inne obiekty, które używają tą samą siatkę (Rysunek 14.32.1c):
Rysunek 14.32.1 Przypisanie materiału do pojedynczej siatki
Aby szybko przypisać materiał do wielu obiektów (siatek) naraz, zaznacz je i wykorzystaj polecenie Copy Material to Others (Rysunek 14.32.2):
Rysunek 14.32.2 Skopiowanie przypisania materiału do wielu siatek naraz
Zwróć uwagę że w menu, które przedstawia Rysunek 14.32.2b), są także polecenia Copy Material i Paste Material. Możesz ich także użyć do przypisania pojedynczego materiału, jeżeli nie chcesz wybierać go co chwila z listy. Polecenie Copy Material to Others znajduje się także pod inną nazwą — Material — w menu Object→Make Links… (dostępnym pod skrótem Ctrl-L).
A jak przypisać do różnych fragmentów pojedynczej siatki różne materiały ?
W Blenderze materiały są przypisane do ścian siatki za pośrednictwem tzw. łączy materiałów (material slots — Rysunek 14.32.3).
W każdej siatce możesz stworzyć wiele łączy materiałów. Każda ściana jest przypisana tylko do jednego z nich. Niektóre z takich łączy mogą nie mieć przypisanych ścian. Mogą także nie mieć przypisanych materiałów. (Takie “puste” łącza nie mają wpływu na rendering).
Przypisanie fragmentu siatki do innego materiału pokażę na przykładzie gondoli podwozia głównego (obiektu B.150.R.Cover). Rysunek 14.32.4 przedstawia „sytuację wyjściową”:
Rysunek 14.32.4 Siatka, której fragmentowi chcemy przypisać inny materiał
Wszystkie ściany siatki owiewki ma już przypisany materiał odpowiedni dla powierzchni zewnętrznych: B.Skin.Camouflage. Teraz chcemy ścianom wewnętrznym przypisać materiał B.Skin.Inner.
Zaczynamy od utworzenia nowego, pustego łącza materiału. To „miejsce” na nowy materiał (Rysunek 14.32.5):
Rysunek 14.32.5 Dodanie do siatki nowego, pustego łącza materiału.
Naciśnij przycisk z prawej strony listy łączy materiałów. Blender doda na koniec listy nowe, puste łącze. Przesunie także na nie podświetlenie, czyniąc je łączem aktywnym.
Tak jak można się spodziewać, przycisk usuwa aktywne (tzn. podświetlone na liście) łącze materiału. Można jednak to robić tylko w Object Mode!
Teraz przypisujemy do naszego łącza materiał — w tym przypadku B.Skin.Inner (Rysunek 14.32.6):
Rysunek 14.32.6 Przypisanie materiału do łącza.
Na koniec przypisz do łącza ściany. Zaznacz je w oknie View 3D, a następnie naciśnij w panelu Material przycisk Assign (Rysunek 14.32.7):
Rysunek 14.32.7 Przypisanie ścian do nowego indeksu materiału.
Nie musisz zaznaczać od razu wszystkich ścian. Możesz tę operację przypisania powtórzyć kilka razy (w przypadku bardzo złożonych kształtów tak jest prościej).
Zwróć uwagę, by obszar siatki przypisany do łącza materiału nie zawierał żadnej nie powiązanej ze ścianą krawędzi lub wierzchołka. Takie miejsca mogą powodować różne artefakty na ostatecznym renderze.
Możesz używać ścian przypisanych do łączy do selekcji wierzchołków siatki w trakcie jej edycji. (Służą do tego umieszczone poniżej listy łączy przyciski Select i Deselect)
Zaznacz ściany siatki, które chcesz rozwinąć (to może być nawet mały fragment, niekoniecznie cała siatka). Następnie naciśnij U (Mesh→UV Unwrap). Na ekranie pojawi się menu UV Mapping, z alternatywnymi metodami rozwijania siatek. Wybierz z niego polecenie Unwrap (Rysunek 14.33.1):
Rysunek 14.33.1 Zwykłe rozwinięcie (Unwrap) siatki w przestrzeni UV
Rezultat rozwinięcia zobaczysz w oknie UV/Image Editor (por. str. 1111). Jeżeli wyszło zdeformowane, np. tak jak pokazuje Rysunek 14.33.1b, możesz spróbować użyć alterntywną metodę rozwijania. W parametrach operatora (T lub F6) Unwrap wybierz z listy rozwijalnej inny tryb (Rysunek 14.33.2):
Rysunek 14.33.2 Sterowanie metodą rozwinięcia
Jak do tej pory, metoda Unwrap używa jednej z dwóch metod rozwijania: Conformal i Angle Based. Jeżeli nie jesteś zadowolony z aktualnej, przestaw ją na alternatywną (Rysunek 14.33.2). Rezultat operacji może wówczas ulec poprawie (porównaj Rysunek 14.33.2 i Rysunek 14.33.1b). Jeżeli nadal nie jesteś z niego zadowolony — pozostaje poprawić rozwinięcie „ręcznie”, tzn. poprzez zmianę położenia ścian w edytorze UV.
Zaznacz ściany siatki, które chcesz rozwinąć w przestrzeni UV. Następnie naciśnij U (Mesh→UV Unwrap). Na ekranie pojawi się menu UV Mapping, z alternatywnymi metodami rozwijania siatek. Wybierz z niego opcję Project From View (Rysunek 14.34.1):
Rysunek 14.34.1 Rozwinięcie UV poprzez rzutowanie na płaszczyznę widoku (Project From View)
Rezultat rozwinięcia zobaczysz w oknie UV/Image Editor (opis — str. 1111). Siatka wygląda dokładnie tak samo, jak w oknie 3D View, ale jest płaskim obrazem, umieszczonym na płaszczyźnie UV.
Za pomocą polecenia Project From View można rozwijać nie tylko całe siatki, ale także ich pojedyncze fragmenty. Przykład takiej operacji pokazuje Rysunek 14.34.2:
Rysunek 14.34.2 Rzutowanie na płaszczyznę UV fragmentu siatki
Gdy zaznaczysz na siatce w oknie 3D View tylko jej fragment (jak np. krawędź owiewki, którą pokazuje Rysunek 14.34.2), i wywołasz polecenie UV Unwrap→Project From View, w oknie UV/Image Editor zobaczysz rzut tego fragmentu. Możesz go np. zaraz po rzutowaniu „przyszpilić” (UVs→Pin — patrz str. 1122).
W Blenderze istnieje możliwość przypisania wierzchołków siatki do grupy. Została stworzona z myślą o powiązaniu powierzchni modelu z animowanym szkieletem. Może się jednak przydać do „zapamiętania” jakiegoś skomplikowanego obszaru siatki, który będziesz często zaznaczał.
Nową grupę wierzchołków tworzysz w zestawie Object Data, panelu Vertex Groups (Rysunek 14.35.1):
Rysunek 14.35.1 Stworzenie i zmiana nazwy nowej grupy wierzchołków
Po naciśnięciu przycisku (Rysunek 14.35.1a) Blender utworzy nową grupę. Na liście Vertex Groups pojawi pierwsza pozycja (Rysunek 14.35.1b). Zobaczysz w niej napis Group (taka nazwa jest domyślnie nadawana każdej nowo utworzonej grupie). Zmień ją na jakąś inną — na przykład Top (por. str. 806).
Do usunięcia aktualnej grupy, której nie potrzebujesz, służy przycisk . Usunięciu ulegają tylko przypisania wierzchołków do grupy i pozycja z listy. Same wierzchołki siatki nie są, rzecz jasna, usuwane.
Na razie z grupą nie jest związany żaden wierzchołek. Zaznacz odpowiedni obszar siatki w oknie 3D View, a następnie naciśnij w panelu Vertex Groups przycisk Assign. To przypisze wybrane wierzchołki do aktualnej grupy (Rysunek 14.35.2):
Rysunek 14.35.2 Przypisanie do grupy wierzchołków
Samo przypisanie wierzchołków do grupy nie powoduje żadnej widocznej zmiany w oknie 3D View. Aby się przekonać, czy są naprawdę w aktualnej grupie, wyłącz aktualne zaznaczenie (A). Następnie naciśnij przycisk Select (Rysunek 14.35.2b). Sprawdź, czy wszystkie wierzchołki, które powinny należeć do grupy, są zaznaczone. Jeżeli nie — zaznacz brakujące, i jeszcze raz naciśnij przycisk Assign.
Przycisk Select dodaje do aktualnego zaznaczenia wszystkie wierzchołki aktywnej (tzn. podświetlonej na liście Vertex Groups) grupy, a Deselect — wyłącza ich zaznaczenie.
Całą powierzchnię możesz podzielić na kilka grup. Skoro zdefiniowaliśmy już górną powierzchnię płata jako grupę, dodajmy w ten sam sposób drugą, zawierającą „całą resztę”. Stwórz ją w ten sam sposób, co poprzednią. Nadaj jej nazwę Bottom (Rysunek 14.35.3b):
Rysunek 14.35.3 Przypisanie reszty siatki do drugiej grupy wierzchołków (Bottom)
Najprościej wybrać „całą resztę” siatki zaznaczając (przycisk Select) grupę Top. Potem należy przełączyć tryb wyświetlania z wierzchołków na ściany (por. str. 893), i z menu okna 3D View wywołać polecenie Selection→Inverse (Ctrl - I). Powinieneś uzyskać takie zaznaczenie, jakie pokazuje Rysunek 14.35.3a). Na koniec pozostaje nacisnąć przycisk Assign, aby przypisać ten fragment siatki do grupy Bottom. Uważaj, aby nie zaznaczyć za dużo, gdyż Blender nie stawia tu przeszkód, i ten sam wierzchołek może należeć do wielu grup.
Na koniec kilka dodatkowych wskazówek:
Pojedynczy wierzchołek siatki może należeć równocześnie do wielu różnych grup wierzchołków.
Nazwy grup muszą być unikalne tylko w obrębie tej same siatki. Oznacza to, że wiele różnych siatek w Twoim modelu może mieć grupy o takich samych nazwach — Top,Bottom, czy podobnych.
(To pewne ułatwienie, gdyż nie trzeba tworzyć jakiegoś kolejnego systemu nazw).
Podczas rozwinięcia UV, Blender automatycznie dzieli siatkę wzdłuż krawędzi, które oznaczysz jako „szwy” (seams).
Nanoszenie „szwów” jest bardzo proste: zaznacz krawędzie, wzdłuż których ma być podzielone rozwinięcie UV. Następnie naciśnij Ctrl-E, i z menu Edges wybierz polecenie Mark Seam (Rysunek 14.36.1):
Rysunek 14.36.1 Oznaczanie krawędzi siatki jako linii szwów (Mark Seam)
Rysunek 14.36.2 Sterowanie wyświetlaniem szwów siatki
(To polecenie znajdziesz także w menu: Mesh→Edges→Mark Seam).
Szwy są na siatce oznaczane pomarańczowym pogrubieniem. Jeżeli nie widzisz żadnego dodatkowego oznaczenia linii szwów, które stworzyłeś — zajrzyj do przybornika Properties (N), panelu Mesh Display (Rysunek 14.35.2). Sprawdź, czy masz tam włączoną opcję Seams. Jeżeli nie — możesz ją tu włączyć.
Do zaznaczania szwów możesz także wykorzystać odpowiedni tryb z panelu Mesh Options (z przybornika narzędzi — Rysunek 14.36.3):
Po włączeniu Options:Mesh Options: Edge Select Mode na tryb Tag Seam, przełącz jeszcze w nagłówku okna 3D View tryb selekcji siatki na krawędzie (Edges). Od tej chwili kliknięcie Ctrl-PPM w krawędź siatki oznacza ją jako szew. Powtórne takie kliknięcie wyłącza to oznaczenie.
Czasami łatwiej jest znaleźć i zaznaczać linie szwów bezpośrednio na rozwinięciach w oknie UV/Image Editor. Dlatego tam także jest dostępne polecenie UVs→Mark Seams (Rysunek 14.36.4a):
Rysunek 14.36.4 Oznaczanie linii szwów w UV/Image Editor
Po zaznaczeniu krawędzi i wywołaniu polecenia w samym oknie UV/Image Editor nic nie ulegnie zmianie1. Efekt polecenia zobaczysz za to w oknie 3D View (Rysunek 14.36.4b).
Czasami możesz natknąć się na sytuację, gdy dla dwóch różnych tekstur przydałyby się dwa różne rozwinięcia siatki w UV. Pokażę to na przykładzie ramki oszklenia za kabiną pilota P-40 (Rysunek 14.37.1):
Rysunek 14.37.1 Alternatywne rozwinięcia w UV siatki ramek oszklenia za głową pilota
Przy nakładaniu barw — plam kamuflażu, znaków rozpoznawczych, itp. — najlepiej, by siatka ramki znajdowała się tam, gdzie była przymocowana: na powierzchni kadłuba (Rysunek 14.37.1a). Przy takim ustawieniu jednym pociągnięciem w Gimpie namalujesz idealnie dopasowany kamuflaż na obydwu elementach. Z kolei dla tekstury nierówności (czy też odbić) lepiej byłoby, gdyby rozwinięcia kadłuba i ramki były odseparowane (Rysunek 14.37.1a). Każdy z tych elementów ma swój własny układ linii nitów i innych detali konstrukcyjnych. Gdy jedna siatka leży na drugiej — nie jesteś w stanie ich prawidłowo odwzorować (bo na każdej z powierzchni zobaczysz naraz wszystkie linie).
Na szczęście w Blenderze każda siatka może mieć kilka alternatywnych rozwinięć UV (określanych także jako „mapowania UV” — UV Maps). Do zarządzania tymi rozwinięciami służy panel UV Maps z zestawu Object Data (Rysunek 14.37.2):
Rysunek 14.37.2 Panel zarządzania mapowaniami UV (UV Maps)
Gdy dokonałeś w edytorze UV rozwinięcia siatki, Blender automatycznie utworzył pierwszą mapę, o nazwie UVMap (Rysunek 14.37.2). Możesz zmienić jej nazwę na inną (por. str. 806). Nazwy map UV muszą być unikalne tylko w obrębie pojedynczej siatki. Mogą (a w przypadku naszego modelu — muszą) się powtarzać w różnych siatkach. Gdy naciśniesz przycisk , Blender stworzy duplikat podświetlonego na liście mapowania. Podobnie przycisk
umożliwia usunięcie rozwinięcia UV.
Gdy naciśniesz przycisk , poniżej mapy UVTex pojawi się jej duplikat, o nazwie UVMap (Rysunek 14.37.3):
Rysunek 14.37.3 Nowa mapa UV
Aby o tym potem nie zapomnieć, zmień od razu nazwę nowego mapowania na docelową — np. na Color (Rysunek 14.37.4a). Zwróć także uwagę na ikonę aparatu fotograficznego (), umieszczoną z prawej strony nazwy każdego z rozwinięć. Tylko jedna spośród wszystkich pozycji na liście może mieć tę ikonę w stanie nie wyszarzanym (por. Rysunek 14.37.3a i Rysunek 14.37.4a). Taka „żywa” ikona oznacza mapowanie używane domyślnie podczas renderowania — czyli to, które Cycles zwróci na wyjściu Texture Coordinate:UV (por. str. 348). To nie jest tylko informacja, ale także kontrolka! Gdy klikniesz w jedną z tych wyszarzonych (
) ikon LPM — zmieni swój stan na „żywy” (
). W ten sposób mapowanie UV, które ją zawiera, stanie się mapowaniem domyślnym.
W oknie UV/Image Editor, a także w oknie 3D View, w trybie Textured, Blender używa zawsze mapowania aktywnego — czyli tego, które jest podświetlone na liście UV Maps. Zwróć uwagę (Rysunek 14.37.3a) że to wcale nie musi być domyślne mapowanie renderu.
Po skopiowaniu rozwinięcia UV możesz je zaznaczyć i dowolnie zmieniać w UV/Image Editor (Rysunek 14.37.4):
Rysunek 14.37.4 Zmiana jednej z map UV
W nagłówku okna UV/Image Editor znajdziesz pomocniczą listę rozwijalną do wyboru aktywnej mapy UV (Rysunek 14.37.5):
Rysunek 14.37.5 Lista wyboru aktywnej mapy UV w oknie UV/Image Editor
Podczas wykonywania detali, możesz się natknąć na takie drobiazgi, jak nacięcie (karb) na goleni kółka ogonowego (Rysunek 14.38.1a):
Rysunek 14.38.1 „Karb” na goleni kółka ogonowego
Jak szybko uzyskać taki szczegół? Gdybyśmy chcieli wykonać taki karb w ten sam sposób, co otwory w kadłubie — byłoby to bardzo pracochłonne. Trzeba by było zawczasu odpowiednio przygotować poprzeczny kontur goleni, z „ostrymi” (crease=1) krawędziami w pobliżu granicy zagłębienia (por. formowanie kadłuba, str. 185). W efekcie otrzymalibyśmy coś, co i tak nie miałoby takiej ładnej, ostrej krawędzi jak zagłębienie, które pokazuje Rysunek 14.38.1b). W takim przypadku bardziej opłaca się zastosować modyfikator Boolean.
Karb wygląda jak wycięty fragmentem walca, więc wstawmy do rysunku cylinder o dość dużym promieniu (Rysunek 14.38.2a):
Rysunek 14.38.2 „Narzędzie tnące” — walec (Cylinder)
Rysunek 14.38.2b) pokazuje, że boczna ściana walca jest nieznacznie zagłębiona w goleni — na tyle, ile ma wynosić głębokość karbu. Na razie pozostawiłem temu obiektowi nazwę Cylinder. To nasze „narzędzie tnące”.
Teraz przełącz się w tryb edycji goleni (B.410.Leg), a potem w zestawie Modifiers naciśnij przycisk Add Modifier i wybierz z listy Boolean. Rysunek 14.38.3a) pokazuje dodany modyfikator:
Rysunek 14.38.3 Dodanie do siatki goleni modyfikatora typu Boolean
W panelu modyfikatora zmień rodzaj operacji na Difference, i wpisz nazwę “narzędzia tnącego” — cylindra, który przed chwilą przygotowaliśmy (Rysunek 14.38.3b).
Rysunek 14.38.4 przedstawia rezultat operacji po ukryciu (H) walca:
Rysunek 14.38.4 Rezultat operacji Boolean | Rysunek 14.38.5 Przesunięcie walca na niewidoczną podczas rednerowania warstwę pomocniczą |
Uzyskany karb ma ładną, ostrą krawędź. Na ostatecznym renderze nie będzie widać lekkich załamań ścianek wewnątrz zagłębienia.
Operacje typu Boolean w Blenderze nie są jeszcze dopracowane . Czasami w wyniku użycia tego modyfikatora możesz uzyskać dodatkowe ściany, których nie powinno być. Zmień wtedy układ siatki, poprzez dodanie jednej — dwóch nowych krawędzi, i spróbuj ponownie.
Oczywiście, nie chcemy widzieć walca na ostatecznym renderingu. Przesuń go na warstwę 10 (M, Rysunek 14.38.5). (Warstwę 10 przeznaczyliśmy na różne pomocnicze obiekty — por. str. 277).
Zaletą operacji Boolean, implementowanych jako modyfikator, jest dynamiczne połączenie obydwu brył — „narzędzia” i „obiektu”. Dzięki temu nie komplikujesz oryginalnych siatek i nadal możesz łatwo zmieniać ich kształt podczas edycji. W przypadku wygładzonych powierzchni, krawędź przecięcia jest wyznaczana na ścianach powierzchni podziałowych. Dzięki temu nie zaburzają kształtu reszty powłoki.
Na razie poprawmy trochę krawędzie karbu: powinny tworzyć elipsę równoległą do osi goleni, więc obróćmy odpowiednio nasz cylinder (Rysunek 14.38.6a):
Rysunek 14.38.6 Modyfikacja kształtu nacięcia
W rezultacie uzyskaliśmy pożądany kształt (Rysunek 14.38.6b). Zwróć jednak uwagę, że teraz walec obracał się dość „opornie”. Wadą zastosowania modyfikatora Boolean jest wolniejsze odświeżanie ekranu podczas przesuwania, obrotu lub innych zmian każdego „składnika” tej operacji. Przy każdym Twoim ruchu wykonywane są ponownie obliczenia przenikania obydwu brył. Na szczęści na finalny czas renderingu to nie ma wpływu. Być może zdecydujesz się wyłączać podczas co intensywniejszych edycji działanie tego modyfikatora. (Wystarczy usunąć z jego parametrów nazwę obiektu „tnącego”, a po zakończeniu zmian — wpisać powtórnie).
Do uzyskania poprawnego „wycięcia” nie jest właściwie potrzebny cały walec — wystarczy fragment jego ściany (Rysunek 14.38.7):
Rysunek 14.38.7 Walec „tnący”, zredukowany do niezbędnych ścian | Rysunek 14.38.8 Uaktualnione parametry modyfikatora |
Nadaj temu, co zostało z oryginalnego cylindra jakąś nazwę porządkową (w tym przykładzie — B.411.Leg). Zwróć uwagę, że odpowiedniej zmianie uległ także wpis w panelu modyfikatora (Rysunek 14.38.8). Aby karb nie „uciekał” podczas ruchu goleni (będziemy ją animować), przypisz ten obiekt do goleni (Make Parent — Ctrl-P).
W wyniku dołączenia obiektu B.411.Leg do goleni (B.410.Leg), w konsoli Blendera zacznie się pojawiać komunikat ostrzegawczy (Rysunek 14.38.9):
Rysunek 14.38.9 Komunikaty o wzajemnym powiązaniu goleni (B.410.Leg) i ściany „tnącej” (B.411.Leg)
To trochę „alergiczna” reakcja: B.411.Leg wpływa tylko na kształt siatki goleni, w żaden sposób nie zmienia położenia i orientacji obiektu B.410.Leg, który jest jego „rodzicem”. Nie ma się czym przejmować!
Oczywiście, gdy będziesz pewien że tego elementu nie będziesz już zmieniał, możesz „utrwalić” obydwa modyfikatory (Subsurf i Boolean), przypisane do siatki goleni (B.410.Leg), i wyrzucić z rysunku niepotrzebny już pomocniczy B.411.Leg. Zrób to jednak na sam koniec pracy, bo to jest w sumie krok nieodwracalny. Po „utrwaleniu” tych modyfikatorów, w przypadku konieczności poważniejszej zmiany kształtu, najprościej będzie stworzyć taką goleń od nowa.
Zazwyczaj wzdłuż krzywej są trzeba wygiąć jakieś cylindry — aby w ten sposób stworzyć imitację jakiegoś przewodu, kabla, lub rury. W najprostszej wersji polega to na wskazaniu cylindra, krzywej (Path — por. str. 872), i naciśnięciu Ctrl-P (Rysunek 14.39.1a):
Rysunek 14.39.1 Wygięcie rury (Cylinder) wzdłuż krzywej (Path)
W odpowiedzi Blender otworzy menu Set Parent To. Wybierz z niego opcję Curve Deform (Rysunek 14.39.1b). To polecenie przypisało obiekt zawierający krzywą jako „rodzica” (Parent) rury (Rysunek 14.39.2a):
Rysunek 14.39.2 Efekt działania polecenia Set Parent To→Curve Deform
Jednocześnie rura otrzymała modyfikator Curve, przypisany do osi X (trzeba to zmienić — Rysunek 14.39.2b).
Przed operacją warto dopilnować, by środki obydwu obiektów — cylindra i krzywej — leżały w tym samym miejscu. Najlepiej aby osie X ich lokalnych układów współrzędnych pokrywały się ze sobą.
Powłoce, którą pokazuje Rysunek 14.39.1b), wyraźnie przydałby się dodatkowy segment. Gdy przejdziesz w tryb edycji wygiętej siatki — ta natychmiast się wyprostuje (Rysunek 14.39.3a):
Rysunek 14.39.3 Edycja siatki wygiętej rury
To może utrudnić dostosowanie gęstości siatki do promienia krzywizny. Tym niemniej gdy przełączysz się z powrotem w Object Mode — rura znów stanie się wygięta (Rysunek 14.39.3b).
W panelu Modifiers możesz skorzystać z przełącznika Apply during Edit, umieszczonego w „nagłówku” każdego modyfikatora (Rysunek 14.39.4). Gdy go włączysz, obraz wygiętej siatki pojawi się także podczas edycji:
Rysunek 14.39.4 Włączenie deformacji podczas edycji siatki
Po odpowiednim zagęszczeniu siatki „na zakrętach”, można dodać kolejny modyfikator — Subdivision Surface — by ją dodatkowo wygładzić (Rysunek 14.39.5):
Rysunek 14.39.5 Dodanie kolejnego modyfikatora — wygładzania
Modyfikator Curve można traktować jako specyficzną formę relacji hierarchicznej (Parent — Child). Jakkolwiek nie obrócimy lub przesuniemy krzywą, wygięta wzdłuż jej linii rura podąży za nią. Co więcej, zmiana kształtu krzywej zmienia odpowiednio kształt wygiętej powłoki (Rysunek 14.39.6):
Rysunek 14.39.6 Kształt krzywej steruje kształtem rury
Kształt krzywej zmieniamy, przesuwając (w trybie edycji) jej punkty sterujące (por. str. 873). Gdy zaczniesz to robić, zauważysz że wygięty cylinder „podąża” za deformowaną linią. Takie dynamiczne zmiany, zachodzące w trakcie edycji, bardzo ułatwiają dopasowania zespołu do reszty modelu.
Gdy wyginamy taką „deskę” jaką pokazuje Rysunek 14.39.7, ważny staje się kierunek skręcenia poprzecznego:
Rysunek 14.39.7 Inny przypadek: płaska „deska” i jej krzywa
Aby wygiąć tę deskę jak „wstążkę”, musimy zmienić orientację krzywej (parametr Tilt — Rysunek 14.39.8a):
Rysunek 14.39.8 Zmiana skręcenia krzywej (Tilt)
Zaznacz krzywą i przełącz się w tryb Edit Mode. Zaznacz wszystkie punkty sterujące krzywej(Rysunek 14.39.8a), a następnie zwiększ ich wartość Tilt o 90º (Rysunek 14.39.8b).
Inny parametr punktów sterujących — Radius — można użyć do zmiany szerokości siatki. Na przykład — w wyniku wygięcia krzywej w przestrzeni (Rysunek 14.39.9a) można odnieść wrażenie, że jej środkowa część jest szersza niż brzegi (Rysunek 14.39.9b):
Rysunek 14.39.9 Zawężanie lokalne paska za pomocą parametru Radius
Aby zrównoważyć ten efekt, wystarczy zmniejszyć Radius środkowego punktu sterującego (Rysunek 14.39.9c).
W poprzedniej sekcji (str. 955) pokazałem, jak wygiąć siatkę cylindra wzdłuż linii krzywej. Przekształcaliśmy prostą „rurę” (Rysunek 14.40.1a) w zakrzywioną powłokę, jaką pokazuje Rysunek 14.40.1b):
Rysunek 14.40.1 Cylinder wygięty wzdłuż krzywej: całkowicie (b) i częściowo (c)
Czasami potrzebna jest jednak taka deformacja, gdzie tylko część siatki ma się „ułożyć” wzdłuż krzywej, a reszta ma płynnie przechodzić we fragment bez zniekształceń (Rysunek 14.40.1c) . Jak taki efekt uzyskać?
W Blenderze służą do tego wagi (weight). Waga to przypisana do każdego wierzchołka siatki liczba z zakresu od 1.0 do 0.0. Określa wpływ modyfikatorów (takich, jak Curve) na jego położenie. Na przykład wszystkie wierzchołki powłoki, którą pokazuje Rysunek 14.40.1b), mają Weight = 1.0 (100% — pełna deformacja). Za to wierzchołki końcówki cylindra, który pokazuje Rysunek 14.40.1c), mają Weight = 0.0 (0% — brak deformacji). Punkty leżące na „odchodzącym” od krzywej odcinku cylindra mają odpowiednie wartości pośrednie.
Jak nanosi się wagi na siatkę? Najpierw musisz zaznaczyć obszar, którego w ogóle ma dotyczyć deformacja (Rysunek 14.40.2a):
Rysunek 14.40.2 Zdefiniowanie grupy wierzchołków o początkowej wadze = 0
Następnie stwórz nową grupę wierzchołków (w panelu Vertex Groups zestawu Object Data — por. str. 945). W polu Weight wpisz początkową wartość wagi (Rysunek 14.40.2b). Na koniec naciśnij przycisk Assign, by przypisać zaznaczone na siatce wierzchołki do tej grupy. Na potrzeby tego przykładu nie będę jej zmieniał nazwy — będzie się nazywać Group. (W modelu zmieniaj je raczej na coś znaczącego. Nazwy grup wierzchołków muszą być unikalne tylko w obrębie tej samej siatki. Mogą się powtarzać w różnych powłokach, więc zazwyczaj nie ma problemu z ich doborem).
W Blenderze wagi wierzchołków się „maluje”. Zmień tryb pracy z Edit Mode na Weight Paint (Rysunek 14.40.3):
Rysunek 14.40.3 Przełączenie w tryb Weight Paint
Spowoduje to, rzecz jasna, zmianę menu w nagłówku (a właściwe stopce) okna — ze starych pozostanie na nim tylko menu View, i pojawi się nowe: Paint. Jednocześnie wokół kursora myszy pojawi się okrąg „pędzla”, a wierzchołki siatki staną się niebieskie (jest to kolor odpowiadający Weight = 0.0, który przypisaliśmy grupie).
Nim zaczniemy malować wagi, należy odpowiednio przygotować „środowisko pracy” (Rysunek 14.40.4):
Rysunek 14.40.4 Przygotowanie „środowiska pracy” przed malowaniem wag na siatce cylindra
W zestawie Modifiers dodaj do siatki (o ile nie zrobiłeś tego wcześniej) modyfikator Curve. W polu Vertex Group wpisz nazwę odpowiedniej grupy wierzchołków (w naszym przypadku to Group).
W zestawie Object Data: upewnij się (w panelu Vertex Groups), że aktualnie wybrana grupa jest grupą, której wagi chcesz zmieniać.
Każda siatka może mieć wiele alternatywnych grup wierzchołków (a każdy wierzchołek może należeć jednocześnie do wielu różnych grup).
Każda grupa wierzchołków ma swoje własne wagi (więc ten sam wierzchołek siatki może mieć różne wagi — w zależności od grupy, na którą się powołasz).
W trybie Weight Paint w przyborniku (Tool Shelf — T) pojawiają się panele związane z malowaniem (m.in. Brush — Rysunek 14.40.4). To „paleta” do malowania wag. Brush zawiera zestaw kontrolek, za pomocą których ustalisz aktualną wartość, którą będziesz nanosił na wierzchołki (Weight) , rozmiar „pędzla” (Radius) , oraz jego siłę (Strength). Ten ostatni parametr jest uwzględniany podczas „mieszania” wartości, którą malujesz, z wartością wagi, którą już posiada „malowany” wierzchołek. U dołu tego panelu możesz wybrać jeden z trybów tego mieszania (najczęściej używany jest domyślny Mix).
Waga 1.0 (100%) jest oznaczana kolorem czerwonym, a waga 0.0 — kolorem niebieskim. Wartościom pośrednim odpowiada spektrum pomiędzy tymi barwami. Powierzchnie z naniesionymi wagami mienią się więc w Blenderze wszystkimi kolorami tęczy.
Ustaw najpierw w panelu Brush aktualną wagę (Weight) na 1.0 i umiarkowany rozmiar pędzla (Radius) — 30. Malujesz, naciskając LPM ponad siatką. Zacznij nanosić wagę 100% od końca cylindra (Rysunek 14.40.5):
Rysunek 14.40.5 „Namalowanie” obszaru całkowicie wygiętego
Pomalowane wagą „100%” fragmenty siatki natychmiast „doklejają” się do krzywej, przypisanej przez modyfikator. Podczas malowania staraj się nie robić zbyt gwałtownych ruchów, by „trafić” z odpowiednią wagą na wszystkie ściany.
Po pomalowaniu „na czerwono” mniej więcej 60% długości cylindra, zacznij zmniejszać aktualną wagę co 0.1 (10%). Zbliżając się do drugiego końca powłoki, nanoś coraz mniejsze wartości (Rysunek 14.40.6):
Rysunek 14.40.6 Namalowanie obszaru przejściowego
Spowoduje to pojawienie się na powłoce odcieni żółci, zieleni (waga = 50%), a potem błękitu. Pośrednie wagi nanoś w ten sposób, by na końcu siatki pozostawić wagę = 0 (kolor niebieski). W ten sposób uzyskasz efekt, który pokazywał Rysunek 14.40.1c) (str. 958).
Najpierw zaznacz na siatce krawędzie, które chcesz sfazować. Najwygodniej jest na ten moment przełączyć się z domyślnego trybu selekcji wierzchołków w tryb selekcji krawędzi (Rysunek 14.41.1a):
Rysunek 14.41.1 Fazowanie wybranych krawędzi (Bevel)
Następnie naciśnij klawisz W, i z menu Specials wybierz polecenie Bevel (Rysunek 14.41.1b). (To samo polecenie znajdziesz w menu: Mesh→Edges→Bevel). Wzdłuż zaznaczonych krawędzi pojawią się fazki, których szerokość możesz zmieniać dynamicznie, przesuwając myszkę (Rysunek 14.41.1c). Gdy ustawisz właściwą szerokość, potwierdzasz ją naciskając LPM. (Możesz też w każdej chwili z niej zrezygnować, naciskając Esc).
Klawisz Ctrl tu nie działa. Aby uzyskać jakąś zaokragloną szerokość fazy, musisz zajrzeć do parametrów tego polecenia w przyborniku (T) i wpisać tam odpowiednią wartość (Rysunek 14.41.2a):
Rysunek 14.41.2 Parametry polecenia Bevel
Gdy włączysz tryb Vertex only, uzyskasz zaokrąglenie samych narożników (Rysunek 14.41.2b). Gdy zwiększysz parametr Segments, uzyskasz zaokraglenie zamiast fazki (Rysunek 14.41.3):
Rysunek 14.41.3 Użycie fazowania do zaokrąglania krawędzi siatki
Zaokrąglanie za pomocą parametru Segements opłaca się stosować tylko w przypadku jakichś specjalnie dużych promieni. W Cycles wązka fazka także wygląda jak zaokraglenie. Przekonaj się zresztą sam: Rysunek 14.41.4a) przedstawia „pudełko”, którego krawędzie sfazowałem na szerokość 0.05 jednostki. Widać na nim wyraźnie każde załamanie krawędzi:
Rysunek 14.41.4 Efekt różnej szerokości fazek na renderze
„Pudełko” przedstawione przez Rysunek 14.41.4b) także ma pojedynczą fazę, ale o szerokości 0.01 jednostki. Prawda że wygląda tak, jak gdyby miało zaokrąglone krawędzie?
Istnieje kilka różnych metod określania szerokości fazki. Możesz wybrać jedną z nich z listy Amount Type (Rysunek 14.41.5a):
Rysunek 14.41.5 Różne metody określania szerokości fazki
Pierwsze trzy pozycje listy (Depth, Width, Offset) reprezentują alternatywne metody określania szerokości fazki „wyciętej” pod kątem 45º. Rysunek 14.41.5b) wyjaśnia ich znaczenie. W ostatniej metodzie — Percent — szerokość fazki zależy od rozmiarów przyległych ścian (Rysunek 14.41.5c). Dla metody Percent wpisuj w pole Amount wartości od 0 do 100 (%). Dla pozostałych metod Amount to długość, wyrażona w jedn. Blendera.
Kiedy formujesz nie fazkę a zaokrąglenie (tzn. liczba Segements > 1), możesz sterować jej kształtem przekroju poprzecznego poprzez współczynnik Profile (Rysunek 14.41.6):
Rysunek 14.41.6 Sterowanie kształtem zaokrąglenia za pomocą współczynnika Profile
Polecenie Bevel zmienia siatkę „na trwałe”, dodając nowe wierzchołki, ściany i krawędzie. Aby uzyskać efekt fazownia bez komplikacji siatki możesz użyć modyfikatora Bevel (Rysunek 14.41.7):
Rysunek 14.41.7 Modyfikator Bevel
Modyfikator Bevel ma takie same parametry jak polecenie Bevel, choć w ich nazwach można dostrzec pewną niekonsekwencję (tutaj używa się słowa „Width”, podczas gdy w panelu polecenia — „Amount”). W panelu modyfikatora jest dodatkową opcję Clamp Overlap. Gdy jest włączona, Blender sprawdza czy gdzieś na siatce fazaowane krawędzie się nie nakładają. Gdy znajdzie takie miejsce, zmniejsza szerokość fazek.
W porównaniu z poleceniem, modyfikator Bevel ma jeszcze dodatkową opcję Limit Method (Rysunek 14.41.7). Służy do określenia, które krawędzie siatki mają być fazowane. Dostępne są następujące metody:
| None | |
| Angle | fazuje tylko te krawędzie, w których dwie ściany siatki łączą się pod kątem większym niż określony kąt graniczny. (Gdy wybierzesz tę metodę, Blender wyświetli poniżej dodatkowy suwak Angle); |
| Vertex Group | fazuje krawędzie pomiędzy wierzchołkami należącymi do wskazanej grupy. (Gdy wybierzesz tę metodę, Blender wyświetli poniżej dodatkową listę Vertex Group); |
| Weight | fazuje „ręcznie” oznaczone krawędze (por. Rysunek 14.41.8); |
Aby oznaczyć krawędzie do fazowania, najpierw przełącz Limit Method na Weight (Rysunek 14.41.8a):
Rysunek 14.41.8 Ręczny wybór krawędzi do sfazowania przez modyfikator Bevel
Nastepnie przełącz w nagłówku okna 3D View tryb selekcji siatki na krawędzie (Edges — Rysunek 14.41.8b). Potem otwórz przybornik (T) i w panelu Options:Mesh Options wybierz z listy Edge Select Mode tryb Tag Bevel. Od tej chwili kliknięcie Ctrl-PPM w krawędź siatki oznacza ją jako fazkę. Powtórne takie kliknięcie wyłącza to oznaczenie.
Do uzyskania innych kształtów zaokragleń niż te dostępne za pomocą współczynnika Profile (pokazywanych przez Rysunek 14.41.6) możesz użyć kombinacji modyfikatorów Bevel i Subdivision Surface. Na przykład — użyłem tej metody do skomponowania eliptycznych zaokrągleń na wręgach kadłuba (Rysunek 14.41.9):
Rysunek 14.41.9 Uzyskanie zaokrąglenia eliptycznego za pomocą modyfikatorów Subsurf i Bevel
Oryginalna siatka została wstępnie wygładzona pierwszym modyfikatorem Subdivision Surface (Subsurf 1 — Rysunek 14.41.9d). Wręgi mają tu nadal prostokątny przekrój (Rysunek 14.41.9a) — ponieważ współczynnik Crease ich krawędzi = 1. Te ostre narożniki są następnie zaokrąglone przez modyfikator Bevel. Tworzy on zaokraglenia (Segments = 2) wzdłuż krawędzi które łączą ściany siatki pod kątem > 30º (opcja Limit Method: Angle, patrz Rysunek 14.41.9d). Modyfikator Bevel tworzy pierwsze przybliżenie docelowego przekroju wręgi (Rysunek 14.41.9b). Zwróć uwagę, że do ustalenia szerokości fazek użyto tu metody względnej (Percent). To była jedyna możliwa opcja, ponieważ niektóre z wręg mają minimalną szerokość. Rezultat jest wygładzony następną powierzchnią podziałową (Subsurf 2 — patrz Rysunek 14.41.9d). Rysunek 14.41.9c) przedstawia gotową siatkę.
Zastosowanie modyfikatora Bevel pozwala także zachować prostą topologię siatki, co np. ułatwia późniejsze rozwinięcia UV (Rysunek 14.41.10):
Rysunek 14.41.10 Wpływ modyfikatora Bevel na mapowanie UV
Siatkę można powielić poprzez sklonowanie obiektu, który ją zawiera (Alt-D, por. str. 823). Jeżeli jednak zależy Ci na szybkim rezultacie i równych odstępach pomiędzy poszczególnymi kopiami, użyj zamiast tego modyfikatora Array. Dla przykładu przekształcę za pomocą modyfikatorów pojedynczą rurę wydechową w pełen kolektor spalin. W oryginalnym samolocie cały ten zespół składał się z 12 takich rur, po sześć z każdej strony.
Na początek wygenerujmy za pomocą modyfikatora pierwsze trzy rury wydechowe(Rysunek 14.42.1):
Rysunek 14.42.1 Użycie modyfikatora Array
Zaznacz odpowiedni obiekt, i z listy Add Modifier wybierz Array (Rysunek 14.42.1a). W panelu modyfikatora Array, który się pojawi, ustaw licznik instancji (Count) na 3, i dystans pomiędzy instancjami obiektu (Relative Offset) na 0.87 (Rysunek 14.42.1b). Jak sam widzisz na ilustracji, modyfikator Array ma jeszcze wiele innych przełączników (a więc i możliwości). Nie były mi jednak potrzebne do stworzenia modelu kolektora spalin, więc nie będę ich tutaj omawiał. (Mówiąc szczerze: jeszcze ich nie sprawdziłem).
Dlaczego stworzyłem 3 rury, a nie od razu 6? Wyjaśnię za chwilę. Na razie stwórzmy lustrzane odbicie kolektora z drugiej strony kadłuba (Rysunek 14.42.2):
Rysunek 14.42.2 Powielenie kolektora spalin za pomocą modyfikatora Mirror
Wykorzystałem w tym celu modyfikator Mirror, wskazując mu jako punkt odniesienia środek pokrywy silnika. (Pokrywa ma środek w osi kadłuba, więc druga część kolektora pojawi się we właściwym miejscu).
Wróćmy do pytania: dlaczego nie stworzyłem od razu rzędu sześciu rur wydechowych? Ponieważ w odwzorowywanym silniku były podzielone na dwie sekcje, po 3 rury każda. Odstęp pomiędzy rurą trzecią i czwarta (na granicy „sekcji”) był nieco większy niż pomiędzy pozostałymi. Aby ten efekt uzyskać, wystarczy jeszcze raz użyć modyfikatora Array (Rysunek 14.42.3):
Rysunek 14.42.3 Dodanie kolejnych rur wydechowych — powtórne użycie modyfikatora Array
Każdy następny modyfikator Array powiela cały rezultat działania poprzednich modyfikatorów (Rysunek 14.42.3a), więc tym razem należy w licznik (Count) wpisać 2 (Rysunek 14.42.3b). Także odstęp (Relative Offset) pomiędzy segmentami należy zrobić nieznacznie większy — 1, a nie 0.87. (Jest o całe 13 mm szerszy — to coś dla koneserów silników Allison ☺).
Czasami potrzebna jest deformacja siatki, która wprowadzi w jej kształt jakiś „nieład”. Na przykład — hełmofon pilota, który pokazuje Rysunek 14.43.1a), wydaje się gładki. Właściwie taki kształt wyglądałby w miarę poprawnie, gdyby to nakrycie z głowy było ze skóry. Niestety, w tym przypadku jest to płócienna „pilotka” USAAC, która powinna się marszczyć na szwach (Rysunek 14.43.1b):
Rysunek 14.43.1 Hełmofon pilota: gładki i z fałdami
Kolory hełmofonu i linie szwów, które pokazuje Rysunek 14.43.1, uzyskałem za pomocą tekstury (Rysunek 14.43.2a). To fragment większego obrazu, naniesiony na rozwinięcie UV siatki hełmofonu (Rysunek 14.43.2b):
Rysunek 14.43.2 Obraz 000.Color, nałożony na rozwinięciu UV hełmofonu | Rysunek 14.43.3 Definicja grupy Folds |
Obraz 000.Color, przedstawiony przez Rysunek 14.43.2 jest użyty w dwóch rolach: tekstury koloru i nierówności. Jak pokazuje render (Rysunek 14.43.1a), wychodzi to zbyt słabo.
Skoro zwykła tekstura nierówności jest zbyt „słaba”, musimy nanieść na siatkę hełmofonu prawdziwe fałdy. Aby to było możliwe, najpierw należy ją odpowiednio zagęścić (modyfikatorem Subsurf, z Level = 2) . Warto także wydzielić nową grupę wierzchołków (por. str. 945), które będą podlegały tej deformacji. Zaznacz odpowiednie wierzchołki i nadaj tej Vertex Group nazwę Folds (Rysunek 14.43.3).
Teraz dodaj do stosu modyfikatorów siatki kolejny, o nazwie Displace (Rysunek 14.43.4a):
Rysunek 14.43.4 Dodanie modyfikatora Displace
Trzeba przyznać że zaraz po dodaniu do hełmofonu tego modyfikatora, jego domyślne ustawienia (Rysunek 14.43.4b) „rozdmuchały” nasz hełmofon w coś, co przypomina balon (Rysunek 14.43.4c). Zaraz je zmienimy, I wszystko wróci na swoje miejsce!
Zacznijmy od zdefiniowania mapy deformacji. Modyfikator Displace wykorzystuje tekstury używane przez Blender Renderer, a nie Cycles Renderer. Stąd trzeba teraz stworzyć nową teksturę (Rysunek 14.43.5):
Rysunek 14.43.5 Przejście do tworzenia mapy deformacji
W panelu modyfikatora naciśnij przycisk pokazywany przez Rysunek 14.43.5a). (Uwaga: występuje tylko wtedy, gdy masz ustawiony jako aktywny renderer Cycles). Możesz także po prostu przejść do kontekstu Textures i wybrać tam zestaw związany z modyfikatorem Displace Rysunek 14.43.5b). Naciśnij tam przycisk New. Następnie nadaj nowej teksturze nazwę (w tym przypadku 000.Displace), zmień jej typ na Image or Movie i przypisz do obrazu 000.Color (Rysunek 14.43.6):
Rysunek 14.43.6 Zdefiniowanie tekstury deformacji (000.Displace)
Teraz możemy wrócić do ustawień naszego modyfikatora. Jest dopasowany do rozwinięcia UV siatki, więc uzyskanie pofałdowania jest bardzo proste (Rysunek 14.43.7a):
Rysunek 14.43.7 Dodanie modyfikatora Displace i jego wpływ na siatkę
W poszczególnych polach modyfikatora wpisujemy:
Direction : kierunek deformacji. Ograniczyłem do lokalnej osi pionowej obiektu (w przypadku hełmofonu jest to jego oś Y);
Texture Coords : mapowanie tekstury. Ustawiłem na UV, bo nasz obraz pasuje do rozwinięcia obiektu;
Vertex Group: ogranicza deformację do grupy wierzchołków (w tym przypadku — Folds);
Midlevel: poziom odniesienia (0.0..1.0). Barwy ciemniejsze będą tworzyć wgłębienia, jaśniejsze — wypukłości. Ustawiłem na 0.4, aby nie przebijały się włosy pilota;
Strength: skala (wysokość) deformacji — dobrałem tak, by „fałdki” nie były zbyt wysokie (0.4).
Rysunek 14.43.7b) przedstawia działanie tak ustawionego modyfikatora Displace. Drobne ściany, stworzone przez Subsurf, zostały przesunięte wzdłuż osi Y.
Rysunek 14.43.8 przedstawia render tak zmodyfikowanego hełmofonu:
Rysunek 14.43.8 Rezultat (render hełmofonu)
Zwróć uwagę, że dzięki Displace mogliśmy zachować do modyfikacji oryginalną, niezdeformowaną siatkę.
Modyfikator Shrinkwrap pozwala położyć siatkę na wskazanej powierzchni („jak naleśnik”) (Rysunek 14.44.1):
Rysunek 14.44.1 Rzutowanie siatki na inną powierzchnię
Dla przykładu „położymy” na powierzchni kadłuba (obiekt B.300.Fuselage) siatkę w kształcie pierścienia (Rysunek 14.44.1a). W sekcji Modifiers naciśnij przycisk Add Modifier. Spowoduje to rozwinięcie listy dostępnych modyfikatorów siatki. Wybierz spośród nich Shrinkwrap. W panelu modyfikatora (Rysunek 14.44.1b) wpisz w pole Target nazwę obiektu — powierzchni, na którą rzutujemy siatkę. Dodatkowo możesz zaznaczyć jeszcze opcję Keep Above Surface. W rezultacie nasz pierścień „opadł” na kadłub, zupełnie tak jak naleśnik (Rysunek 14.44.1c)
Na razie ten rezultat jest daleki od satysfakcjonującego: chcielibyśmy, aby nasz pierścień po deformacji wyglądał jak wygięte koło, a nie jak jakiś kawałek gumy!
Na szczęście nie jest to takie trudne do osiągnięcia (Rysunek 14.44.2):
Rysunek 14.44.2 Korygowanie kształtu rzutu
Obróć pierścień wokół lokalnej osi X, by jego powierzchnia była w przybliżeniu równoległa do powierzchni kadłuba. Nie zaszkodzi umieścić jego środka na rzutowanej powierzchni (Rysunek 14.44.2b). Widzisz, co się stało (Rysunek 14.44.2c)? Uzyskaliśmy to, o co chodziło — okrąg, położony na kadłubie.
Stosujemy tu tryb Nearest Surface Point, w którym modyfikator Shrinkwrap przesuwa wierzchołki deformowanej siatki do najbliższego punktu na powierzchni obiektu odniesienia (Target). Możesz także stosować inny tryb — Project. W tym trybie wszystkie wierzchołki są rzutowane w jednym kierunku, wzdłuż jednej z trzech osi lokalnego układu współrzędnych modyfikowanego obiektu.
Na razie nasza siatka leży dokładnie na powierzchni kadłuba (Rysunek 14.44.3a):
Rysunek 14.44.3 Odsunięcie od powierzchni
Przy modelowaniu konstrukcji zazwyczaj jednak chcemy, by miała pewną grubość. Do ustalania tego odstępu służy pole Offset, umieszczone na panelu modyfikatora (Rysunek 14.44.3b). Gdy wpiszesz tam jakąś niezerową wartość, wygięta siatka ulegnie odsunięciu (Rysunek 14.44.3c).
To jednak dopiero połowa sukcesu. W tej chwili nasz wygięty pierścień „lewituje” nad kadłubem. Aby uzyskał solidne boczne ścianki, zaznacz zewnętrzne krawędzie siatki, i przypisz je do jakiejś nowej grupy wierzchołków (por. str. 945). Nadajmy jej nazwę, np. Bottom (Rysunek 14.44.4a):
Rysunek 14.44.4 Nadanie rzutowanej siatce „grubości”
Następnie dodaj kolejny modyfikator Shrinkwrap (Rysunek 14.44.4b). Tym razem jednak wpisz w pole Vertex Group nazwę Bottom, by działał tylko na krawędzie należące do tej grupy. Potem zmniejsz w tym modyfikatorze Offset do zera. W efekcie mamy oczekiwany rezultat: wygięty pierścień z bocznymi ściankami, nadające siatce „grubości”.
W Blenderze każda ściana ma stronę „wewnętrzną” i „zewnętrzną”. O tym, która jest zewnętrzna, decyduje zwrot1 wektora normalnego (tzn. prostopadłego), który jest przypisany do każdej ściany.
Aby włączyć wyświetlanie normalnych do ścian siatki, otwórz Properties Shelf (N) i przejdź do panelu Mesh Display (Rysunek 14.45.1):
Rysunek 14.45.1 Włączenie wyświetlania kierunków normalnych do ścian siatki
Włącz w nim opcję Normals:Face, w środkach każdej ściany pojawią się błękitne kreski (Rysunek 14.45.1). Zazwyczaj będziesz musiał je nieco wydłużyć, korzystając z kontrolki Normal Size.
Gdy zwrot normalnych na sąsiadujących ścianach jest różny, w trybie cieniowania Shade Smooth zobaczysz na siatce brzydkie, czarne cienie. Ale gdy wszystkie normalne siatki wskazują w niewłaściwą stronę, podczas modelowania w oknie 3D View możesz nie zauważyć niczego podejrzanego. Będzie to jednak przyczyną dziwnego „lustrzanego” efektu na renderze, gdy użyjesz w materiale połyskliwego shadera Glosssy BSDF.
Zaradzenie temu efektowi jest bardzo proste: w trybie edycji siatki zaznacz wszystkie ściany (Select All — A) i naciśnij Ctrl-N (Mesh→Normals→Recalculate Outside — Rysunek 14.45.2):
Rysunek 14.45.2 Przeliczenie kierunku normalnych
Zazwyczaj Blender poprawnie zrozumie twoje intencje, i przerzuci wszystkie normalne na jedną stronę ścian siatki.
A co jeżeli jednak nie zrozumie? Rysunek 14.45.3a) przedstawia taki złożony przypadek. To siatka modelująca wewnętrzną powierzchnię kabiny pilota. Jak widzisz, część jej ścian jest skierowana poprawnie, a część nie. Polecenia Recalculate Outside nie można tu użyć, bo te ściany trzeba skierować „do wewnątrz”. W Blenderze istnieje także polecenie Recalculate Inside (Shift–Ctrl-N). Nie możemy go jednak tutaj użyć, bo część tylnych ścian kabiny ma pozostać skierowana „ na zewnątrz”. Jedynym rozwiązaniem jest zaznaczyć wszystkie nieprawidłowe ściany i wywołać polecenie Mesh→Normals→Flip Normals (Rysunek 14.45.3b)
Rysunek 14.45.3 Przełączenie kierunków normalnych dla wybranych ścian siatki
(Polecenie Flip Normals masz dostępne także w menu Specials — wywoływanym skrótem W).
Na zakończenie warto wspomnieć, że Blender potrafi także wyświetlać drugi rodzaj normalnych: w wierzchołkach (Rysunek 14.45.4) . Są one wypadkową normalnych do ścian, które łączy każdy wierzchołek. To, czy wolisz operować na normalnych ścian czy wierzchołków jest kwestią gustu. W istocie są to dwie alternatywne metody reprezentacji tych samych wartości.
Kierunek normalnych do powierzchni wpływa na to, w jaki sposób wyświetlane są na ekranie krawędzie siatki. Program może wyznaczyć wektor normalny dla każdej płaskiej, elementarnej ściany. Każdy komputerowy model oświetlenia wymaga określenia kierunku normalnego dla dowolnego miejsca powierzchni. Jeżeli przyjmiemy najprostsze założenie, że na kierunek normalny na całym obszarze ściany jest stały (Rysunek 14.46.1a), uzyskamy efekt jak dla trybu Shade Flat (Rysunek 14.46.1b):
Rysunek 14.46.1 Wektory normalne w trybie Shade Flat
Cieniowanie Shade Flat jest nieodpowiednie dla obłych powierzchni, takich jak opływowe kształty współczesnych samolotów. Musiałbyś bardzo zagęścić ich siatki, by wyglądały na gładkie!
Na szczęście nie musimy tak komplikować modelu, bo mamy do dyspozycji drugi tryb cieniowania: Shade Smooth (Rysunek 14.46.2):
Rysunek 14.46.2 Wektory normalne w trybie Shade Smooth
W tym trybie kierunek normalny w dowolnym punkcie powierzchni jest interpolacją (uśrednieniem) kierunków normalnych najbliższych ścian (Rysunek 14.46.2a). Do interpolacji wykorzystuje się tzw. metodę Phonga, bardzo popularną w grafice komputerowej. Używając jej, za pomocą niewielu ścian można uzyskać wrażenie gładkiej powierzchni (Rysunek 14.46.2b).
Element, który przedstawia Rysunek 14.46.2b), to oszklenie owiewki kabiny pilota. Na powiększeniu ilustracji pokazuję, że ma ona niewielką grubość. Jej siatka oryginalnie wygładzona powierzchnią podziałową. Krawędź, biegnącą wzdłuż jej brzegu oznaczyłem jako “ostrą” (Crease), by owiewka wyglądała jak wygięty arkusz szkła organicznego. Spowodowało to pojawienie się na ścianach sąsiadujących z tą ostrą krawędzią dziwnych cieni (Rysunek 14.46.2b).
Jeżeli zignorujesz te cienie, staną się przyczyną dziwnych efektów na renderze (Rysunek 14.46.3):
Rysunek 14.46.3 Efekt ostrej krawędzi oszklenia powierzchni i cieniowania Shade Smooth na renderze
To rezultat zastosowania interpolacji normalnych metodą Phonga dla ostrej krawędzi. Na szczęście remedium jest bardzo proste: włącz dla tej siatki opcję Auto Smooth i ustaw kąt graniczny na 30º- 90º (Rysunek 14.46.4):
Rysunek 14.46.4 Opcja Auto Smooth — automatyczne korygowanie ostrych krawędzi
Gdy opcja Auto Smooth z paneluNormals jest włączoną, Blender poprawia kierunki normalne wzdłuż wszystkich krawędzi siatki, które łączą ściany pod kątem większym niż określony graniczny kąt Angle. (Kierunki normalnych wzdłuż takiej krawędzi są rozdzielone, jak pokazywał to Rysunek 14.46.1a).
Dla powierzchni nieprzejrzystych interpolacja normalnych wzdłuż krawędzi nie powoduje tak drastycznych skutków, jak dla szkła. Przyjrzyj się na przykład tej owiewce skrzydła (Rysunek 14.46.5):
Rysunek 14.46.5 Odblask wzdłuż nieskorygowanej krawędzi
Tutaj taka krawędź wygląda jak zaokrąglona i nadaje elementowi wrażenie grubości (Rysunek 14.46.5b).
Co jednak robić w takim przypadku, jaki pokazuje Rysunek 14.46.6? Powiedzmy, że chcielibyśmy zachować wrażenie zaokrąglonych krawędzi przy szkle kabiny. Jednocześnie warto usunąć brzydkie cienie na zewnętrznych krawędziach tej ramki:
Rysunek 14.46.6 Nieskorygowane krawędzie ramki | Rysunek 14.46.7 Ramka po automatycznej korekcie |
Zastosowanie Auto Smooth z wartością Angle do 90º „spłaszcza” wszystkie ostre krawędzie. A nam chodzi, aby tak poprawić tylko zewnętrzną krawędź ramki — tak, jak pokazuje Rysunek 14.46.7.
Taki wybiórczy efekt jest do osiągnięcia. Trzeba tylko najpierw oznaczyć krawędzie, które mają być skorygowane, specjalną flagą Sharp. Upewnij się, że przyborniku właściwości tej siatki masz włączoną opcję Mesh Display:Overlays:Sharp — Rysunek 14.46.8a). Potem zaznacz korygowane krawędzie:
Rysunek 14.46.8 Oznaczanie wybranych krawędzi jako Sharp
Z menu Mesh→Edges (Ctrl-E) wywołaj polecenie Mark Sharp. W efekcie Blender podświetli zaznaczone krawędzie na czerwono (Rysunek 14.46.8b). (Taki kolor jest przypisany fladze Sharp). Potem wystarczy przestawić kąt graniczny Normals:Angle na 180º (Rysunek 14.46.9a):
Rysunek 14.46.9 Rezultat — selektywna korekta krawędzi
Tak duży kąt graniczny powoduje, że „ostre” są tylko krawędzie oznaczone flagą Sharp (Rysunek 14.46.9b).
Oznaczanie krawędzi flagą Sharp można także wykonać w inny sposób (Rysunek 14.46.10):
Rysunek 14.46.10 Alternatywna metoda oznaczanie krawędzi flagą Sharp
Niestety, flaga Sharp nie może mieć wartości pośrednich, tak jakie ma dla powierzchni podziałowych flaga Crease. Czasami więc możesz natknąć się na taki przypadek, jak dla kołpaka śmigła, który przedstawia (Rysunek 14.46.11). Bez korekty kierunku normalnych krawędź kołpaka wygląda na zbyt zaokrągloną:
Rysunek 14.46.11 Krawędź nieskorygowana | Rysunek 14.46.12 Krawędź skorygowana |
Działanie Auto Smooth jest w tym przypadku nieco za mocne: część krawędzi kołpaka zlewa się zupełnie z osłoną silnika (Rysunek 14.46.12).
W takim przypadku pozostaje tylko jedno: wstawienie w pobliżu „ostrej” krawędzi dodatkowego rzędu wierzchołków (np. poleceniem Loop Cut and Slide — Rysunek 14.46.13a):
Rysunek 14.46.13 Zmniejszenie cienia na powłoce poprzez wstawienie dodatkowej krawędzi
Nowa krawędź przy brzegu kołpaka zdecydowanie zmniejsza efekt zaokrąglenia (Rysunek 14.46.13b).
Jak widzisz, Blender nie pozwala na bezpośrednią manipulację kierunkami normalnych siatki. Możesz to robić pośrednio, aby uzyskać na renderze poprawny efekt ostrej krawędzi. Służą do tego opcje z panelu Normals.
Dopóki można, staraj się eliminować zaburzenia kierunku normalnych wzdłuż ostrych krawędzi opcją Auto Smooth i — ewentualnie — modyfikatorem Bevel. Dodanie nowej krawędzi do siatki nie eliminuje, a tylko zmniejsza te zaburzenia.
Aby uniknąć poważnych kłopotów na renderze (por. str. 975, Rysunek 14.46.3b), do elementów „szklanych” zawsze stosuj opcje Auto Smooth z kątem granicznym = 30º. Można go także używać do większości innych siatek z ostrymi krawędziami (np. siatki płata). Tylko w szczególnych przypadkach warto używać zaznaczania pojedynczych krawędzi flagą Sharp, tak jak to pokazałem na str. 976.
Czasami decydowałem się — ale jeszcze na etapie modelowania — wstawiać dodatkowe krawędzie aby usunąć duże zaburzenia kierunku normalnych (por. str. 284). Zrobiłem to „na wszelki wypadek”. Sądzę, że w ten sposób te siatki sprawią mniejszy kłopot przy imporcie do jakiegoś programu, za pomocą formatu danych który nie uwzględnia informacji o kierunkach normalnych. Dodanie nowej krawędzi na późniejszych etapach prac nad modelem może być dość kłopotliwe. Gdy siatki modelu są już rozwinięte w przestrzeni UV (por. str. 360 - 393) każda nowa krawędź wymaga dodatkowej korekty tego rozwinięcia.
Na koniec warto wspomnieć o pewnym zaskakującym efekcie ubocznym opcji Auto Smooth. Gdy stworzyłem pierwszy render samolotu, obiekty, zobaczyłem że prawe skrzydło jest zupełnie czarne (Rysunek 14.46.14a). Taki efekt dotknął wszystkich obiektów, które powstały w wyniku „lustrzanego odbicia” (operacji Mirror — tzn. takich, które mają co najmniej jeden ze współczynników skali ujemny):
Rysunek 14.46.14 Niespodziewany efekt opcji Auto Smooth (dla „starszych” siatek)
Wystarczyło jednak wyłączyć opcję Auto Smooth, aby wszystko wróciło do normy (Rysunek 14.46.14b).
Takie samo działanie jak opcja Normals:Auto Smooth ma modyfikator Edge Split (Rysunek 14.46.15). Należy tylko pamiętać, że modyfikatory są związane z obiektem, a nie z siatką. W modelu przedstawionym powyżej ta sama siatka połowy skrzydła jest użyta dwa razy (i to dlatego prawe skrzydło ma ujemną skalę). Aby uniknąć na płatach sztucznych „przebarwień”, po wyłączeniu opcji Auto Smooth dodałem modyfikator Edge Split do obiektów prawego i lewego skrzydła.
Modyfikator Mesh Deform pozwala sterować kształtem skomplikowanej siatki o dużej liczbie ścian za pomocą otaczającej ją siatki o małej liczbie ścian.
Przygotuj najpierw siatkę deformującą. Może to być np. taki prostopadłościan, jaki pokazuje Rysunek 14.47.1. Powinien otaczać deformowaną siatkę. Aby ściany obiektu deformującego nie zasłaniały tego, co w środku, zmieniłem jego tryb wyświetlania (Properties:Object:Display:Type) na Wire (por. str. 840).
Siatka deformująca musi otaczać (zawierać w środku) wszystkie deformowane obiekty.
Następnie zaznacz obiekt deformowany (w naszym przykładzie to Cylinder), i w zestawie Modifiers, panelu Modifiers, naciśnij przycisk Add Modifier. Spowoduje to rozwinięcie listy dostępnych “modyfikatorów” tej siatki. Wybierz spośród nich Mesh Deform (Rysunek 14.47.1):
Rysunek 14.47.1 Przygotowanie modyfikatora Mesh Deform
We właściwościach tego modyfikatora wpisz w pole Object odpowiedni obiekt deformujący (w naszym przykładzie to Cube). Początkowo modyfikator jest nieaktywny. Aby zaczął działać, naciśnij przycisk Bind (Rysunek 14.47.1). Powoduje to obliczenie wpływów wierzchołków obiektu deformującego na deformowaną siatkę. W zależności od liczby wierzchołków może to potrwać dłuższą chwilę.
Aktywny modyfikator możesz poznać po tym, że zamiast przycisku Bind zawiera przycisk Unbind i ma wyszarzane pole Object (Rysunek 14.47.2a):
Rysunek 14.47.2 Działanie modyfikatora Mesh Deform
Aby zdeformować siatkę, w Object Mode wybierz obiekt deformujący i przełącz go w tryb edycji (Rysunek 14.47.2b). Każda zmiana jego kształtu powoduje płynną deformację modyfikowanego obiektu.
Jeżeli jesteś zadowolony z uzyskanego efektu, możesz go tak pozostawić, lub nacisnąć w panelu modyfikatora przycisk Apply, by go „utrwalić” w deformowanej siatce.
Pamiętaj, aby podczas takich operacji nie zmieniać w żaden sposób topologii siatki deformatora, bo to powoduje natychmiastowe wyłączenie przypisanych do niego modyfikatorów Mesh Deform (Rysunek 14.47.3):
Rysunek 14.47.3 Wpływ zmiany liczby wierzchołków siatki na modyfikator Mesh Deform
Jeżeli chcesz wprowadzić jakieś zmiany do siatki deformatora — lepiej najpierw odłącz modyfikator (naciskając klawisz Unbind — por. Rysunek 14.47.2a i Rysunek 14.47.3). Wówczas obiekt deformowany powróci do pierwotnego kształtu, natomiast obiekt deformujący pozostanie w zmienionej postaci (Rysunek 14.47.4b):
Rysunek 14.47.4 Rezultat wyłączenia modyfikatora Mesh Deform
Teraz możesz wprowadzić dowolne zmiany do siatki deformującej. Osobiście, bardzo mi przeszkadza że po odłączeniu od Mesh Deform deformator nie wraca do oryginalnego kształtu. Teraz, gdy naciśniesz ponownie przycisk Bind, dla uzyskania podobnego do poprzedniego wygięcia obiektu Cylinder należy jeszcze bardziej zniekształcić siatkę Cube.
Na koniec mała rada: nie używaj zbyt szczegółowej siatki deformującej (Rysunek 14.47.5):
Rysunek 14.47.5 Problemy ze zbyt dokładną siatką deformującą
O wiele lepiej sprawdza się zwykłe „pudełko” lub kształt do niego zbliżony, o niewielkiej liczbie odpowiednio odległych ścian (Rysunek 14.47.6):
Rysunek 14.47.6 Działanie prostszej siatki deformującej
Dodatek MDeform służy do obsługi grupy obiektów, przypisanych za pomocą modyfikatorów Mesh Deform do pojedynczej siatki („deformatora”). Towarzyszy tej książce jako plik source\scripts\addons\object_mdeform.py (por. str. 22). Znajdziesz go w sekcji Addons okna User Preferences 1, wśród innych dodatków (Rysunek 14.48.1):
Rysunek 14.48.1 Uaktywnienie dodatku MDeform (okno User Preferences)
Pracę z dodatkiem rozpoczynasz w Object Mode, od przypisania do deformatora. Zaznacz najpierw obiekty deformowane, potem obiekt deformujący (aby stał się obiektem aktywnym) i z menu Specials (W) wywołaj polecenie Set Deformer (Rysunek 14.48.2):
Rysunek 14.48.2 Przypisanie obiektów do siatki deformującej
Polecenie Set Deformer dodaje na początek stosu modyfikatorów każdego z wybranych obiektów odpowiedni modyfikator Mesh Deform (Rysunek 14.48.3):
Rysunek 14.48.3 Rezultat polecenia Set Deformer
Poleceniem odwrotnym do Set Deformer jest Clear Deformer. Znajdziesz je w menu Specials dla obiektów, które są już przypisane do jakiegoś deformatora (Rysunek 14.48.3). Wywołanie Clear Deformer powoduje usunięcie ich modyfikatorów MDeformer.
Gdy obiekty są już przypisane, przełącz siatkę deformującą w tryb Edit Mode (Tab). W tym trybie otwórz przybornik Properties (N) i znajdź w nim panel Deformer (Rysunek 14.48.4):
Rysunek 14.48.4 Panel sterowania efektem deformacji (siatka nieaktywna)
To panel wyświetlana przez dodatek MDeform. Gdy naciśniesz na niej przycisk Bind objects, uaktywnisz efekt deformacji. (To może zająć dłuższą chwilę, gdyż podczas tej aktywacji Blender przelicza wpływ wierzchołków siatki deformatora na poszczególne obiekty).
Po aktywacji panel Deformer ulega zmianie (Rysunek 14.48.5):
Rysunek 14.48.5 Panel sterowania efektem deformacji (siatka aktywna)
Dodatek MDeform używam zazwyczaj do poprawek kształtu takich złożonych obiektów jak kadłub. W tej sekcji pokażę jedną z takich sytuacji. Rysunek 14.48.6 przedstawia (naniesiony czerwoną linią) nowy obrys kadłuba w rzucie z góry. Musimy się do niego dopasować:
Rysunek 14.48.6 Rysunek referencyjny, do zmiany konturu kadłuba
Zmianę kształtu wprowadzamy, zmieniając położenie wierzchołków siatki sterującej (Rysunek 14.48.7):
Rysunek 14.48.7 Zmiana kształtu kadłuba
Aby przysunąć ściany kadłuba do nowego konturu, stopniowo zbliżam wybrane wierzchołki siatki do osi kadłuba (używając np. polecenia Scale). Mógłbym je także przesuwać lub obracać, gdyby to było potrzebne.
Pamiętaj, aby na tym etapie nie wprowadzać żadnych zmian w topologii siatki deformatora (tzn. nie zmieniać liczby wierzchołków)! Gdy spróbujesz to zrobić, modyfikatory w przypisanych obiektach natychmiast przestaną działać.
Jeżeli po skorygowaniu kształtu kadłuba naciśniesz przycisk Deformer: Apply — zmiany zostaną „utrwalone” we wszystkich obiektach przypisanych do deformatora, a sama panel Deformer zniknie.
Jeżeli jednak chcesz jeszcze coś zmienić — na przykład przypisać kolejne obiekty, lub zmienić topologię siatki deformującej poprzez dodanie nowego segmentu — naciśnij przycisk Unbind objects (Rysunek 14.48.8):
Rysunek 14.48.8 Deaktywacja siatki deformującej
Spowoduje to odtworzenie stanu sprzed deformacji (tzn. sprzed ostatniego wywołania polecenia Bind objects). Kształty przypisanych obiektów powrócą do swoich oryginalnych postaci, podobnie jak deformator.
Zazwyczaj trzeba przeprowadzić kilka prób, aby dobrze dopasować układu siatki deformującej do tak złożonej modyfikacji całego kadłuba. Do tego właśnie służą przełączniki Bind/Unbind objects.
Gdy już będziesz zadowolony z rezultatu — „utrwal” go przyciskiem Apply. Możesz także zrezygnować z całej operacji naciskając przycisk Remove.
Czasami po naciśnięciu przycisku Apply możesz zobaczyć taki komunikat (Rysunek 14.48.9):
Rysunek 14.48.9 Informacja o problemach w „utrwalaniu” efektu deformacji
Sprawdź wtedy na końcu listy w oknie Info, z jakimi obiektami mamy kłopoty (Rysunek 14.48.10):
Rysunek 14.48.10 Identyfikacja „problemowego” obiektu na liście komunikatów programu
Zazwyczaj chodzi o próbę „utrwalenia” modyfikatora dla siatki współdzielonej przez dwa lub więcej obiektów. Należy stworzyć wówczas w odpowiednim obiekcie jej duplikat i powtórnie wywołać polecenie Deformer:Apply.
Ten rozdział opisuje szczegóły definiowania materiałów I otoczenia dla silnika renderującego Cycles. (Jest to renderer który wybrałem do użycia w tej książce — por. str. 290). Jego materiały komponuje się głównie za pomocą węzłów (nodes), więc w tym rozdziale będziemy prawie przez cały czas korzystać z okna Node Editor. (Wprowadzenie do Node Editor znajdziesz na str. 796).
Pokażę tu stworzenie najprostszego materiału dla silnika renderera Cycles. Nazwiemy go B.Skin.Camouflage.
Zacznijmy od sytuacji wyjściowej: wybraliśmy obiekt do którego ma być przypisany nowy materiał (to B.100.R.Wing — Rysunek 15.1.1a). W oknie Properties wybierz zestaw Material, i naciśnij przycisk New (Rysunek 15.1.1b):
Rysunek 15.1.1 Obiekt (a właściwie — siatka) bez przypisanego materiału
W rezultacie Blender stworzył nowy materiał (o domyślnej nazwie Material) i przypisał go do siatki aktywnego obiektu. W zestawie Material pojawiły się panele (Rysunek 15.1.2a):
Rysunek 15.1.2 Zmiana nazwy nowego materiału
Najlepiej od razu zmienić temu materiałowi nazwę — w tym przypadku na B.Skin.Camouflage (Rysunek 15.1.2b).
W konfiguracji, jaką wybraliśmy (por. Rysunek 12.4.3, str. 765 — okno User Preferences, przełącznik Link Materials To:) materiał jest przypisany do siatki, a nie do obiektu. Stąd obok nazwy materiału widzisz wybrany tryb Data (por. Rysunek 17.1.2b). To skrót od Object Data. Blender umożliwia przypisanie różnym fragmentom pojedynczej siatki różnych materiałów, które wybiera się z listy umieszczonej ponad nazwą. (Szczegółowy opis wykorzystania wielu materiałów w jednej siatce znajdziesz na str. 940). Informacje o przypisywaniu materiału do obiektu, a nie siatki (tryb Object), znajdziesz na str. 839. Czasami ten alternatywny tryb także się przydaje!
Wróćmy jednak do naszego materiału. Jego kolor na renderze ustawiasz w polu Color panelu Surface (Rysunek 15.1.3):
Rysunek 15.1.3 Zmiana barwy materiału
(Szczegóły posługiwania się tą kontrolką znajdziesz na str. 793). Jednak ten kolor nie ma żadnego wpływu na barwę wyświetlaną w oknie 3D View. (Mam na myśli kolor w domyślnym trybie Solid, który wykorzystujemy podczas edycji). Do ustalenia tej barwy służy pole Viewport Color w panelu Settings (Rysunek 15.1.4):
Rysunek 15.1.4 Zmiana barwy materiału w oknie 3D View (tryb Viewport Shading=Solid)
Raz utworzony materiał można przypisać wielu obiektom/siatkom. W Blenderze możesz także przypisać materiał wielu obiektom naraz. O tym, jak to zrobić, możesz przeczytać na str. 940.
Ta sekcja przedstawi Ci typową metodę pracy z materiałami w Cycles: definiowanie efektu za pomocą tzw. węzłów (nodes). Pokażę to na przykładzie modyfikacji materiału powierzchni samolotu. Zacznijmy od opisu problemu (Rysunek 15.2.1):
Rysunek 15.2.1 Jak uzyskać połysk na powierzchni samolotu?
Rysunek 15.2.1a) przedstawia samolot pokryty najprostszym materiałem w kolorze szarym — takim, jakiego stworzenie zostało opisane w sekcji 15.1 (str. 987). Materiał ten wykorzystuje zupełnie matowy typ powierzchni (określany tutaj jako shader, albo BSDF) o nazwie Diffuse (jest wybrany w panelu Material:Surface — por. Rysunek 15.2.2a)
Rysunek 15.2.2 Parametry shadera Diffuse
Wygląda na to, że shader Diffuse ma raptem dwa parametry. Jeden z nich — Color — jest intuicyjny, zresztą ustawiałeś już go zaraz po utworzeniu materiału (por. str. 988).
Drugi — Roughness („szorstkość”) — jest domyślnie ustawiony na 0.0 (tak, jak pokazuje Rysunek 15.2.2a). A co by się stało, gdyby go zwiększyć?
Rysunek 15.2.3 przedstawia, jak zmienia się powierzchnia modelu dla różnych wartości tego parametru. Wygląda to tak, jak gdyby materiał stał się nieco mniej „czuły” na oświetlenie (dla większych wartości Roughness kadłub staje się ciemniejszy).
Efekt może i ciekawy, ale zupełnie nie jest to, o co nam chodzi. Ustawmy „szorstkość” naszego materiału na jakąś niewielką, niezerową wartość — np. 0.2 — i szukajmy połysków gdzie indziej.
Spróbuj wybrać z listy rozwijalnej Surface inny rodzaj shadera — na przykład ten o obiecującej nazwie Glossy
Rysunek 15.2.4 Przełączenie na shader Glossy
To z kolei dało efekt zbyt mocny — z przodu samolotu pojawiły się odbicia jak na zamazanym lustrze. Dla małych wartości Roughness (0.0..0.4) ten materiał wygląda metalicznie i jest zbyt połyskliwy (Rysunek 15.2.4b i Rysunek 15.2.5c). Zwróć uwagę, że im mniejsza „szorstkość” tym białe odbicia światła stają się mniejsze i mają coraz ostrzejsze granice. Ostatecznie dla Roughness = 0.0 powierzchnia samolotu zmienia się w idealne lustro i wszelkie odbicia światła znikają1 (Rysunek 15.2.5d):
Rysunek 15.2.5 Shader Glossy — dla różnych wartości Roughness
Dla większych wartości „szorstkości” (0.5..0.8) odbicia wypełniają większą część powierzchni (Rysunek 15.2.5a i b). Są jednak na tyle rozproszone, że nie tworzą już połysków o kształcie i intensywności, której potrzebujemy.
Możesz spróbować wybrać jeszcze inne shadery z listy Surface. (Zwróć jednak uwagę, że wiele z nich — np. Background, Emission, Holdout, Mix Shader, Add Shader służy do czegoś zupełnie innego). W sumie ta lista dostępnych shaderów jest w Cycles dość krótka. Są to wszystkie te z końcówką „BSDF”. Mamy tu szkło (Glass), lustro (Glossy), „glina” (Diffuse), „aksamit” (Velvet)… Każdy z nich ma niewiele parametrów i bardzo się różni od pozostałych. I jak tu tworzyć w oparciu o takie shadery realistyczne materiały?
Otóż są to zaledwie podstawowe składniki! Kluczowym założeniem Cycles jest komponowanie przez użytkownika materiałów o najróżniejszych właściwościach poprzez łączenie ze sobą tych elementarnych typów powierzchni. Materiał, który pokazuje Rysunek 15.2.1b), uzyskamy z odpowiedniego połączenia shaderów Glossy i Diffuse. Aby to zrobić, przełącz jedno z okien Blendera w tryb Node Editor.
Node Editor pozwala tworzyć schematy złożone z tzw. węzłów (nodes). Węzły, podobnie jak znane Ci do tej pory kontrolki w panelach czy oknach dialogowych, służą do zmiany parametrów materiału. Takie schematy to po prostu inna forma prezentacji. Jeżeli nie pracowałeś do tej pory w edytorze węzłów — przeczytaj jego opis na str. 796. Obsługa nie jest specjalnie skomplikowana, skróty większości operacji (zmiana projekcji, zaznaczanie, przesuwanie, usuwanie, kopiowanie węzłów) są takie same jak w oknie 3D View.
W chwili otwarcia w edytorze, definicja naszego materiału składała się z dwóch węzłów: shadera (Glossy BSDF) i rezultatu (Material Output). Dodajmy do niej drugi shader: Diffuse (Add→Shader→Diffuse BSDF) (Rysunek 15.2.6):
Rysunek 15.2.6 Dodanie do definicji materiału shadera Diffuse
W podobny sposób dodaj do schematu trzeci węzeł: Mix Shader (Add→Shader→Mix Shader) i połącz je tak, jak pokazuje (Rysunek 15.2.7a):
Rysunek 15.2.7 Złożenie dwóch shaderów za pomocą Mix Shader
Mix Shader „miesza” shadery połączone do jego dwóch wejść w proporcji określonej przez wartość Factor. Gdy Factor = 0.0, wykorzystywany jest wyłącznie pierwszy shader (w tym przypadku Diffuse BSDF). Rezultat wygląda wtedy bardzo podobnie do tego, co przedstawia Rysunek 15.2.2b). Gdy z kolei Factor = 1.0, Blender bierze pod uwagę wyłącznie drugi shader (w tym przypadku — Glossy BSDF) i rezultat wygląda tak, jak Rysunek 15.2.4b). Efekt połysku, o który nam chodzi, pojawia się dla wartości Factor leżących w pobliżu wartości 0.5 (Rysunek 15.2.7b).
Do tej pory ocenialiśmy odblaski, oglądając model z dużej odległości. Teraz przyjrzyjmy się uzyskanemu efektowi nieco bliżej, z innego punktu widzenia (Rysunek 15.2.8):
Rysunek 15.2.8 Powierzchnia samolotu dla różnych wartości Mix Shader:Factor
Wydaje mi się, że cień na wlocie do chłodnicy nawet dla Mix Shader:Factor = 0.2 jest zbyt głęboki (Rysunek 15.2.8a). Z drugiej strony — dla jeszcze mniejszych wartości (< 0.2) połysk zupełnie zanika. W dodatku powierzchnia samolotu szybko ciemnieje w miarę wzrostu udziału shadera Glossy (por. Rysunek 15.2.8a i c). To może utrudnić późniejsze nałożenie tekstur, które najlepiej wychodzą na możliwie jasnych powłokach.
Te shadery trzeba połączyć w inny sposób — tak, by udział połyskliwego Glossy BSDF nie był wszędzie równy. Powinien być uzależniony od kąta, pod którym obserwator widzi poszczególne fragmenty powierzchni. Do uzyskania takiego efektu służy węzeł Layer Weight (por. str. 1001). Dodaj go do schematu (poleceniem Add→Input→Layer Weight) i podłącz tak, jak to pokazuje Rysunek 15.2.9.
Ustaw współczynnik Layer Weight:Blend na jakąś umiarkowaną wartość (np. 0.6).
Przy takich ustawieniach model wygląda dużo lepiej. Stał się jaśniejszy, a cienie na wlocie chłodnicy stały się bardziej „miękkie” (Rysunek 15.2.10):
Rysunek 15.2.10 Eliminacja cieni na niektórych krawędziach — poprzez zmianę metody obliczeń odbić na CGX
Wypróbuj ten efekt dla różnych wartości Layer Weight:Blend. Przekonasz się, że masz teraz do dyspozycji o wiele większy zakres wartości, przy których odbłyski wyglądają realistycznie. Jedyne, co jeszcze mi się nie podoba to cienie wzdłuż górnych krawędzi skrzydła i usterzenia (Rysunek 15.2.10a). Okazuje się, że za ten efekt odpowiada domyślny algorytm węzła Glossy BSDF:Beckmann. Gdy zmienisz go na alternatywny — CGX — cienie znikają i całość wygląda tak, jak powinna (Rysunek 15.2.10b). Ostateczny schemat materiału przedstawia Rysunek 15.2.11:
Rysunek 15.2.11 Schemat opracowanego materiału i rezultat na podglądzie renderu
W sekcji 15.2 skomponowaliśmy materiał B.Skin.Camouflage, który ma odwzorować zewnętrzne powierzchnie samolotu (Rysunek 15.3.1):
Rysunek 15.3.1 Zespół węzłów, który zgrupujemy
To samo rozwiązanie powinniśmy wykorzystać także w drugim materiale, którym pokryte są powierzchnie wewnętrzne — B.Skin.Inner. Tyle, że tam materiał ma mieć inną barwę. Zamiast tworzyć od nowa ponownie ten sam schemat, możemy przekształcić zaznaczony na ilustracji zespół węzłów w tzw. grupę (group). Stworzymy w ten sposób nasz własny, wyspecjalizowany węzeł, który będzie można użyć w obydwu materiałach (Użycie grupy węzłów w materiale B.Skin.Inner — p. str. 999). Łączenie węzłów ma jeszcze tą zaletę, że gdy zdecydujemy się coś zmienić w tym zespole (np. zmienić typ odblasków w shaderze Glossy BSDF z CGX na Beckmann) to ta zmiana będzie dotyczyć każdego materiału, w którym jest użyta ta grupa.
Aby stworzyć nową grupę, zaznacz obiekty które wchodzą w jej skład, np. obszarem prostokątnym (B — Rysunek 15.3.2a). Potem wywołaj polecenie Node→Group→New Group (Ctrl-G). Zaznaczone węzły zostaną połączone w nową grupę (Rysunek 15.3.2b):
Rysunek 15.3.2 Stworzenie nowej grupy węzłów
Blender od razu otwiera nową grupę w trybie edycji. Świadczy o tym inny kolor tła oraz obecność dwóch nowych węzłów: Group Input i Group Output (Rysunek 15.3.2b).
W każdej chwili możesz powrócić z definicji grupy do definicji materiału: wystarczy nacisnąć Tab lub przycisk Go to parent tree (Rysunek 15.3.3a):
Rysunek 15.3.3 Przełączanie się pomiędzy definicją grupy i definicją wykorzystującego ją materiału
Aby z powrotem przejść do definicji grupy należy zaznaczyć jej węzeł (Rysunek 15.3.3b) i nacisnąć Tab (lub wywołać polecenie Node→Edit Group).
Od razu zmień w węźle grupy jej nazwę na jakąś bardziej odpowiednią (Rysunek 15.3.4):
Rysunek 15.3.4 Zmiana nazwy grupy
Grupa z tego przykładu będzie nam służyć jako shader powłok pomalowanych półmatową lub błyszczącą farbą. Dlatego proponuję ją nazwać Glossy Paint.
Powróćmy do definicji grupy. Przyjrzyj się dwóm węzłom o żółtych nagłówkach (por. Rysunek 15.3.3a): Group Input zawiera wejścia grupy, a Group Output — jej punkty wyjściowe. Na razie nasza grupa ma jedno wyjście (o nazwie Shader) i żadnych wejść. Umieśćmy więc w Group Input kolor obydwu shaderów. Aby to uzyskać, podłącz wejście jednego z shaderów do „pustego” gniazda węzła Group Input (Rysunek 15.3.5):
Rysunek 15.3.5 Definiowanie wejścia węzła grupy Gloss Paint
Zauważ, że Blender przesunął teraz puste wyjście węzła Group Input do dołu — ale nadal jest dostępne!
Załóżmy (tylko dla przykładu!) że obydwa shadery (Glossy BSDF i Diffuse BSDF) powinny mieć ten sam kolor. Możemy to teraz wymusić podłączając obydwa węzły do tego samego gniazda wejściowego (Rysunek 15.3.6).
W podobny sposób „wyciągnij” z obydwu shaderów parametr Roughness (jego wartości powinny być jednakowe). Na koniec przenieś także do parametrów wejściowych współczynnik Layer Weight:Blend (Rysunek 15.3.7a):
Rysunek 15.3.7 Ulepszony węzeł Gloss Paint
Gdy spróbujesz „zwinąć” definicję grupy przekonasz się, że „wyciągnięte” w ten sposób wejścia stały się parametrami jej węzła (Rysunek 15.3.7b).
Podczas edycji grupy z prawej strony ekranu możesz otworzyć przybornik Properties (N). Tam, w panelu Interface, znajdziesz się kontrolki służące do zarządzania jej wyjściami i wejściami (Rysunek 15.3.8a). Gdy na liście Inputs lub Outputs wybierzesz (podświetlisz) jakiś punkt we/wy, u dołu panelu zobaczysz jego właściwości. Możesz tam zmienić jego nazwę lub go usunąć. W polu Default Value można ustawić domyślną wartość tego parametru (w przypadku pokazanym przez Rysunek 15.3.8a jest to barwa):
Rysunek 15.3.8 Panel Interface — zarządzanie wejściami i wyjściami grupy
Dla parametrów które są pojedynczą liczbą, Blender wyświetla w panelu Interface inny zestaw kontrolek (Rysunek 15.3.8b). Możesz tu ustalić dopuszczalny zakres wartości takiego współczynnika (pola Min i Max).
Patrząc na grupę przedstawioną przez Rysunek 15.3.7, wydaje mi się że jej użytkownik (czyli — ja sam, za parę miesięcy) może mieć problem ze zrozumieniem co właściwie zmienia parametr Blend. Na szczęście bez problemu możemy zmienić tę nazwę na inną. Wystarczy wpisać nową w polu Interface:Name (Rysunek 15.3.9a). W ten sam sposób możesz zmieniać także nazwy punktów wyjścia, z listy Outputs (Rysunek 15.3.9b). (W naszym przykładzie jest to jeden punkt, o domyślnej nazwie Shader. Myślę że nie pozostawia wątpliwości co do sposobu użycia, więc pozostawiamy ją bez zmian).
Rysunek 15.3.9 Zmiana nazwy parametru grupy
Dzięki stworzeniu grupy schemat naszego materiału został zredukowany do dwóch węzłów i trzech parametrów, które są w nim istotne (Rysunek 15.3.10):
Rysunek 15.3.10 Węzeł Glossy Paint w oknie Properties (zestaw Material)
Zwróć uwagę, że w oknie Properties nawet zazwyczaj „zaśmiecona kontrolkami” panel Material:Surface wyświetla dla tego schematu wyłącznie parametry grupy Glossy Paint. Dzięki temu stała się prosta i czytelna.
W każdym schemacie materiału są jakieś parametry, które można zmieniać, oraz inne, których nie należy ruszać bo się zepsuje cały efekt. Łączenie węzłów w grupy pozwala także wyróżnić i nadać bardziej odpowiednie nazwy tym wybranym parametrom. W ten sposób schemat staje się bardziej czytelny — bo użytkownik może traktować każdą grupę jak „czarną skrzynkę”, nie zagłębiając się w to, jak działa.
W schemacie grupy możesz stosować nie jeden, a kilka instancji Group Input. Przydaje się to gdy chcesz uniknąć efektu „spaghetti”: wielu krzyżujących się linii połączeń, które są trudne do śledzenia (Rysunek 15.3.11):
Rysunek 15.3.11 Uproszczenie układu połączeń wewnątrz grupy za pomocą drugiej instancji Group Input
Uważaj jednak by w takim upraszczaniu nie posunąć się zbyt daleko! Na przykład: unikaj wykorzystywania tego samego wyjścia w dwóch różnych instancjach Group Input (Rysunek 15.3.12). Choć z technicznego punktu widzenia jest to poprawne, wydaje mi się, że schemat jest mniej czytelny.
Przedstawiony w tej sekcji sposób prezentacji schematu grupy został wprowadzony dopiero w Blenderze 2.67. Poniżej opiszę pokrótce jak wyglądała definicja grupy we wcześniejszych wersjach (może się to przydać przy analizie różnych tutoriali stworzonych przed 2013r). W Blenderze 2.66 i wcześniejszych zawartość edytowanej grupy była otaczana ramką (Rysunek 15.3.13b). Na lewym boku ramki były umieszczone gniazda wejściowe, a na prawym — wyjściowe. Umieszczone wewnątrz węzły były podłączane do tych gniazd. Rysunek 15.3.13 pokazuje porównanie obydwu sposobów wyświetlania zawartości grupy:
Rysunek 15.3.13 Porównanie „starej” i „nowej” metody prezentacji definicji grupy węzłów
Uważam że dla mniej złożonych grup węzłów „stary” sposób prezentacji (Rysunek 15.3.13b) był bardziej czytelny, przynajmniej dla takich prostych grup jak przedstawione w tej książce. Widać było na nim nazwę grupy (w nagłówku ramki) i wartość domyślną każdego parametru. Otoczenie węzłów charakterystyczną ramką pozwala się natychmiast zorientować, że to jest definicja grupy.
W sekcji 15.3 (str. 994) przekształciliśmy grupę węzłów w nowy element — shader o nazwie Gloss Paint. Początkowo jest używany tylko w materiale powierzchni zewnętrznych samolotu (B.Skin.Camouflage). W tej sekcji pokażemy, jak użyć tego shadera w materiale powierzchni wewnętrznych (B.Skin.Inner).
Zaznacz jakiś obiekt, który wykorzystuje materiał B.Skin.Inner. Gdy jest to jakiś prosty materiał, złożony z jednego shadera, najwygodniej jest go zmienić w zestawie Material okna Properties (Rysunek 15.4.1):
Rysunek 15.4.1 Zmiana typu węzła shadera na Gloss Paint
Zacznij od skopiowania koloru ze starego węzła1 do schowka (Rysunek 15.4.1a) — chyba, że nie chcesz go zachować. Następnie rozwiń listę rozwijalną z typami shaderów (Rysunek 15.4.1b) i wybierz z niej grupę Gloss Paint. I to wszystko. No, może nie do końca: zawróć uwagę, że podstawił się nam domyślny kolor i inne ustawienia grupy (Rysunek 15.4.1c). Możesz teraz zmienić kolor Glossy Paint:Diffuse 2 na ten skopiowany do schowka.
Jeżeli schemat materiału jest bardziej złożony, i w oknie Properties nie możesz odnaleźć węzła, który chcesz zmienić, otwórz okno Node Editor. Poleceniem Add→Group→Gloss Paint dodaj do schematu tego materiału nowy węzeł (Rysunek 15.4.2):
Rysunek 15.4.2 Dodanie do schematu materiału węzła grupy Gloss Paint
(Tak! Nie dziw się — Blender umieści w menu Group polecenie tworzące każdą grupę węzłów, którą masz zdefiniowaną w tym pliku *.blend).
Spowoduje to dodanie do schematu nowego, początkowo nie podłączonego węzła (Rysunek 15.4.3a):
Rysunek 15.4.3 Włączenie shadera Gloss Paint do schematu (na miejsce Diffuse BSDF)
Następnie zmień barwę Diffuse węzła Gloss Paint na kolor dotychczasowego węzła3 (Rysunek 15.4.3a). Potem przenieś połączenia ze starego węzła na nowy, i ostatecznie usuń niepotrzebny element (Rysunek 15.4.3b).
Pamiętaj, że wszystkie materiały w których używasz grupy Glossy Paint, odwołują się do tego samego bloku danych z jej definicją (zwróć uwagę na licznik użycia tej grupy — Rysunek 15.4.3b).
Grupy są współdzielone pomiędzy materiałami. Oznacza to, że jakakolwiek zmiana w definicji grupy ma wpływ na wszystkie materiały, które jej używają.
Węzeł Layer Weight możesz dodać w Node Editor poleceniem Add→Input→Layer Weight. Ten element ma dwa wyjścia: Fresnel i Facing (Rysunek 15.5.2). Każde z nich zwraca liczbę z zakresu 0..1.0. Wartości tych współczynników zależą od kąta pod którym kamera „widzi” odpowiednią ścianę modelu. Parametr Blend steruje intensywnością efektu. Może przyjmować wartości z zakresu od 0 do 1 (traktuj je jako 0%..100%).
Rysunek 15.5.1 Węzeł Layer Weight | Rysunek 15.5.2 Materiał do testowania wartości współczynników Layer Weight |
Wartości z węzła Layer Weight można na przykład użyć do sterowania udziałem shaderów łączonych węźle Mix Shader (Rysunek 15.5.2). Uzależnia to cechy otrzymanego materiału od kąta pochylenia powierzchni modelu, co pozwala uzyskać różne ciekawe efekty.
Abyś mógł lepiej ocenić, jakie właściwie wartości zwraca Layer Weight dla poszczególnych pikseli obrazu, proponuję je sprawdzić używając prostego materiału „testowego”, którego schemat przedstawia Rysunek 15.5.2. To połączenie dwóch matowych powierzchni: czerwonej i jasnoszarej. Wartości z węzła Layer Weight określają tutaj udział powierzchni jasnoszarej (udział powierzchni czerwonej to dopełnienie do 100%). Dla takiego materiału czerwone miejsca na powierzchni samolotu odpowiadają wartości = 0.0 (Rysunek 15.5.3a):
Rysunek 15.5.3 Wartości zwracane przez Layer Weight dla krańcowych wartości współczynnika Blend
Jasnoszare obszary odpowiadają miejscom, gdzie Layer Weight zwraca wartość = 1.0 (Rysunek 15.5.3b).
Dla Blend = 0.0 obydwa wyjścia węzła (Fresnel, Facing) zwracają wartość = 0.0 (Rysunek 15.5.3a) niezależnie od kąta pochylenia powierzchni. Podobnie dla Blend = 1.0 obydwa wyjścia na całej powierzchni modelu zwracają wartości = 1.0 (Rysunek 15.5.3b).
Ciekawe efekty uzyskasz ustawiając parametr Blend gdzieś pomiędzy tymi granicami. Przyjrzyjmy się najpierw wartościom uzyskiwanymi z wyjścia Layer Weight:Facing (Rysunek 15.5.4):
Rysunek 15.5.4 Wartości Layer Weight:Facing w zależności od parametru Blend
Wyjście Facing zwraca tym większą wartość, im powierzchnia materiału jest bardziej odchylona od obserwatora (Nie znalazłem w żadnym opisie bardziej szczegółowych informacji. Domyślam się, że jest to rezultat jakiejś funkcji, na przykład cosinusa tego kąta). Początkowo (dla Blend = 0.0.. 0.1) czerwień naszego samolotu robi się coraz jaśniejsza (Rysunek 15.5.4a). To oznacza, że współczynnik Facing dla prawie całej powierzchni jest w granicach 0.8-0.9, czyli na razie rezultat nie różni się znacznie od zwykłego mieszania ze stałym współczynnikiem udziału. Jedynie grzbiet skrzydeł i usterzenia poziomego mają bielsze krawędzie — zapewne tam Facing przyjmuje wartości rzędu 0.5.
Gdy zwiększysz wagę Blend do około 50%, tylko fragmenty powierzchni modelu które są bardziej równoległe płaszczyzny widoku (krawędzie natarcia, część kołpaka śmigła) pozostaną czerwone (Facing < 0.2) (Rysunek 15.5.4b). Reszta powierzchni stanie się bladoróżowa (oznacza to wartość Facing > 0.5), a górne powierzchnie płatów i usterzenia — wręcz jasnoszare (Facing = 1.0). Wreszcie dla Blend = 80% tylko powierzchnie równoległe do płaszczyzny widoku pozostaną czerwone (Rysunek 15.5.4c) — dla reszty wartość Facing jest bardzo bliska 1.0.
Rysunek 15.5.5 przedstawia podobne zestawienie dla wartości z drugiego wyjścia (Layer Weight:Fresnel):
Rysunek 15.5.5 Wartości Layer Weight:Fresnel w zależności od parametru Blend
Wartości Fresnel także rosną w miarę odchylania powierzchni od obserwatora, ale wolniej, mają inny układ niż w przypadku wyjścia Facing.
Te same wartości, co na wyjściu Layer Weight:Fresnel, możesz uzyskać używając bardziej wyspecjalizowanego węzła Fresnel (Rysunek 15.5.6). Rysunek 15.5.7 przedstawia materiał do testowania jego rezultatu:
Rysunek 15.5.6 Węzeł Fresnel | Rysunek 15.5.7 Materiał do testowania wartości współczynników Fresnel |
Dla niewielkich wartości IOR = (1.0..1.2) węzeł Fresnel zwraca dla prawie całej powierzchni wartości zbliżone do 0.0 (Rysunek 15.5.8a). Rezultat jest taki sam jak z wyjścia Fresnel węzła Layer Weight (por. Rysunek 15.5.5a) i Rysunek 15.5.8b):
Rysunek 15.5.8 Wartości zwracane przez węzeł Fresnel dla małych wartości współczynnika IOR
Na tych ilustracjach widać, że wartości zwracane przez węzeł Fresnel i Layer Weight:Fresnel są takie same (por. Rysunek 15.5.4 i Rysunek 15.5.9). Tylko zależność pomiędzy współczynnikami IOR i Blend jest nieliniowa:
Rysunek 15.5.9 Wartości Fresnel dla większych wartości współczynnika IOR
Autor Cycles sugeruje użycie współczynnika Fresnel do uzyskania materiału „z połyskiem” (por. str. 993, Rysunek 15.2.11). Nic dziwnego, bo jest to funkcja używana w fizyce do obliczenia ilości światła odbitego od gładkiej powierzchni. Jej wartości należy użyć do sterowania udziałem dwóch powierzchni, łączonych w węźle Mix Shader: podstawowej (shadery Difusse lub Glass) i „lustrzanej” (shader Glossy). Pierwotnie jedynym węzłem dostarczającym współczynników Fresnel był w Cycles Layer Weight. Powstał głównie z myślą o wykorzystaniu w charakterze „wagi” dla węzła Mix Shader. Potem dodano oddzielny węzeł Fresnel dla tych użytkowników, którzy chcieliby sterować układem połysków podając fizyczną wartość współczynnika załamania światła (ang. index of refraction — IOR), a nie wagę Layer Weight:Blend. W każdym razie obydwa węzły zwracają te same wartości.
W Blenderze 2.7 węzły Fresnel i Layer Weight posiadają dodatkowe wejście: Normal (Rysunek 15.5.10):
Rysunek 15.5.10 Dodatkowe wejście w węzłach Fresnel i Layer Weight | Rysunek 15.5.11 Prosty przykład modyfikacji kierunku normalnych |
Domyślnie (gdy nic do nich nie jest przyłączone) te węzły wykorzystują informacje o kierunku normalnych ścian modelu — taki sam efekt, jak gdybyś podłączył do nich wyjście Normal węzła Geometry (por. str. 1010). Jednak czasami możesz się pokusić o modyfikację tego „naturalnego” kierunku — na przykład o odchylenie wszystkich wektorów normalnych o pewien stały kąt — tak jak to pokazuje Rysunek 15.5.11. Choć takie zmiany raczej nie prowadzą do poprawienia realizmu modelu, to być może w jakimś szczególnym przypadku mogą się przydać.
Na koniec chciałbym uczulić Czytelnika na problem doboru parametru IOR. Wartości tego współczynnika można znaleźć w wielu miejscach w Internecie. W fizyce IOR określa, ile razy mniejsza jest w danym ośrodku prędkość światła (a bardziej ogólnie — fali elektromagnetycznej) od prędkości w próżni. Zazwyczaj jest wiązany ze zjawiskiem załamania światła na granicy ośrodków przejrzystych (jak szkło czy woda). Można go także wyprowadzić dla materiałów nieprzejrzystych (na podstawie ich właściwości elektrycznych). Wygląda na to, że takie same wartości parametru o nazwie IOR ustawia się w kontrolkach efektu Fresnela w różnych programach do tworzenia grafiki 3D (np. Cinema4D, a także 3DSMax — tylko tam ustaw korektę gamma na wartość = 2.2). W praktyce wszystkich programów 3D przyjmuje się następujące wartości Fresnel:IOR 1:
Powietrze: w przybliżeniu 1.0;
Woda: 1.33;
Plexiglas, przejrzysty plastik: 1.5;
Szkło: zazwyczaj 1.5, ale niektóre specjalne odmiany mogą dochodzić do 1.7 (por. Rysunek 15.5.9a — czerwony kolor odpowiadałby przejrzystemu szkłu);
Wszystkie materiały złożone, jak drewno, kamień, beton, itp. (czyli w miarę jednorodne, ale chropowate) są przybliżane za pomocą IOR = 3 … 4 (por. Rysunek 15.5.9b);
Plastik (nieprzejrzysty, o niezbyt gładkiej powierzchni) jest przybliżany za pomocą IOR = 5…8;
Metale: fizycznie rzecz biorąc, te i inne przewodniki mają IOR < 1, ale w Cycles nie można używać tak małych wartości tego współczynnika (to inna funkcja matematyczna). Zadowalające przybliżenie metalu można uzyskać dla bardzo dużych wartości IOR — gdzieś pomiędzy 15 a 100 (por. Rysunek 15.5.9c — widoczny na nim biały kolor odpowiadałby lustrzanej powierzchni metalu).
W Blenderze, tak jak w większości programów do grafiki 3D, dostępne są tylko wartości funkcji Fresnela dla gładkich powierzchni dielektryków. (Szkła, plastiku, i innych materiałów nie przewodzących prądu elektrycznego). Tych funkcji można także użyć do uzyskania przybliżonego efektu połyskliwości metali. Więcej szczegółów o odbiciu światła i współczynniku Fresnela oraz IOR znajdziesz na str. 1255.
Cycles, podobnie jak większość współczesnych programów do renderowania, wykorzystuje algorytm „śledzenia promieni” (ang. raytracing) . Teoretycznie program powinien śledzić promienie wychodzące ze źródła światła. Jednak większość z nich nigdy nie dotrze do kamery. Aby nie marnować czasu na ich obliczenia, program śledzi je w kierunku przeciwnym. Z każdego piksela renderowanego obrazu wyprowadza promień (określany także jako light path) w odwrotnym kierunku niż płynie światło z renderowanej sceny (Rysunek 15.6.1):
Rysunek 15.6.1 Podstawowa zasada działania renderera ( wikipedia.org )
Czasami promień nie napotka niczego po drodze, innym razem zostanie kilka razy odbity (ang. bounced) od obiektów wchodzących w skład sceny. Gdy natknie się na jakąś powierzchnię, renderer prowadzi pomocniczy promień wprost do źródła światła. Jeżeli napotka po drodze jakiś obiekt — piksel jest identyfikowany jako cień (Rysunek 15.6.1). W przypadku powierzchni połyskliwych lub przejrzystych śledzenie na tym się nie kończy, bo „podstawowy” promień ulega odbiciu i/lub załamaniu i trzeba go śledzić dalej. (W Cycles określasz max. liczbę śledzonych odbić w zestawie Render, panelu Light Paths).
Węzeł Light Path umożliwia uzyskiwanie w Cycles różnych „sztuczek”. Każdy z jego punktów wyjściowych (Rysunek 15.6.2a) zwraca wartość = 1.0 dla piksela obrazu, którego promień spełnia odpowiedni warunek. Dla pozostałych pikseli węzeł zwraca wartość = 0.0. Te wartości można wykorzystać jako współczynniki dla jakichś innych operacji. Rysunek 15.6.2b) przedstawia używane w Cycles nazwy poszczególnych typów promieni:
Rysunek 15.6.2 Typy promieni, rozróżniane w Cycles (wg wiki.blender.org )
Punkty wyjściowe węzła Light Path zwracają wartość 1.0 dla następujących pikseli obrazu:
Is Camera Ray: piksel tła. Jego promień nie napotkał „po drodze” żadnego elementu sceny;
Is Transmission Ray: piksel z jakiejś powierzchni przejrzystej;
Pozostałe trzy wyjścia węzła (por. Rysunek 15.6.2a) pozwalają wyróżnić spośród pikseli spełniających warunek Is Reflection Ray lub Is Transmission Ray następując przypadki:
Is Diffuse Ray: piksel pochodzący z odbicia światła rozproszonego;
Is Singular Ray: piksel należy do bezpośredniego odbicia promienia światła;
Z opisu na wiki.blender.org można się domyślać, że wyjście Is Singular Ray powinno zwracać wartość 1.0 dla ostrych, punktowych odbić promieni słonecznych. Nie jestem jednak tego pewien, bo nie udało mi się uzyskać takiego efektu. (Może nie była w chwili pisania tego fragmentu książki implementowana? W każdym razie sprawdzałem w Blenderze 2.61).
Najprostszym przykładem „sztuczki” z udziałem węzła Light Path może być efekt „podstawienia odbicia”. W połyskliwej powłoce płata czerwona osłona kabiny odbija się na czerwono, a biała — na biało (Rysunek 15.6.3):
Rysunek 15.6.3 Kolor odbicia owiewki kabiny na powierzchni skrzydła
Gdy jednak zmieszasz tą czerwień i biel ze sobą wykorzystując wagę Light Path:Is Reflection Ray (Rysunek 15.6.4a), uzyskasz czerwony cień białego obiektu (Rysunek 15.6.4b):
Rysunek 15.6.4 Złożenie białego materiału z czerwonym odbiciem
W podobny sposób jak odbicie można zamienić cień. W kolejnym przypadku mamy dwa shadery: szkło (Glass BSDF), które przy wyłączonej kaustyce rzuca lity cień (Rysunek 15.6.5a), oraz „zupełną przejrzystość” (Transparent), która rzuca przejrzyste cienie (Rysunek 15.6.5b):
Rysunek 15.6.5 Materiały do złożenia
Złącz te dwie powierzchnie ze sobą w Mix Shader, wykorzystując jako współczynnik udziału wyjście Light Path: Is Shadow Ray (Rysunek 15.6.6):
Rysunek 15.6.6 Schemat materiału
W efekcie owiewka kabiny, mimo wyłączonej kaustyki (por. zestaw Render, opcja Light Paths:Reflective Caustics i Refractive Caustics) rzuca przejrzyste cienie (Rysunek 15.6.7). Pozwala to także zobaczyć zasłonięte przez nią wnętrze kabiny, które wcześniej było zupełnie czarne. (Domyślna barwa szkła, które pokazuje Rysunek 15.6.7, jest szara. Wnętrze kabiny będzie jeszcze jaśniejsze, gdy zmienisz ją na białą).
Uważam, że nawet gdy przyszłe wersje Cycles będą już poprawnie obsługiwać kaustykę dla światła równoległego, warto pamiętać o tej „sztuczce”. Wyłączenie kaustyki eliminuje większość „białego szumu” z nieprzejrzystych powierzchni i przyśpiesza renderowanie połyskliwych powłok — takich jak wypolerowane duraluminium. W scenach lotniczych nie potrzebujemy dokładnych i skomplikowanych cieni za szklanymi powierzchniami, jaki daje wyłączenie opcji No Caustics. Efektu „zamiany cienia” można użyć dla optymalizacji czasu renderowania.
Do uzyskania różnych specyficznych efektów (np. mgły) potrzebne są informacje geometryczne, dotyczące renderowanego piksela. W Cycles ich źródłem jest węzeł Geometry, dodawany do schematu poleceniem Add→Input→Geometry (Rysunek 15.7.1):
Rysunek 15.7.1 Węzeł Geometry
Geometry jest, podobnie jak Texture Coordinate czy Light Path, węzłem wejściowym. Oferuje do wykorzystania wiele różnorodnych informacji (wyjść). Jednym z nich jest flaga Backfacing, zwracająca wartość = 0 dla piksela z przedniej strony ściany, i wartość = 1 dla strony przeciwnej. Tę informację można wykorzystać do obejścia problemu barwy dla dwustronnych ścian, takich jak we wnęce klapy skrzydła (Rysunek 15.7.2)
Rysunek 15.7.2 Problem: „srebrne” powierzchnie po wewnętrznej strony ścian siatki
Flaga Geometry:Backfacing pozwala podstawić na tylnych ściankach matowy shader Diffuse (Rysunek 15.7.3):
Rysunek 15.7.3 Pokrycie wewnętrznych stron ścian siatki materiałem rozpraszającym światło (Diffuse BSDF)
Zauważ że kolor, który uzyskaliśmy na tylnych ścianach żeber, różni się nieznacznie od reszty powierzchni.
Fragmenty powierzchni wewnętrznych, takich jak wnęka klapy skrzydła, nie są w typowych scenach tak mocno oświetlone. W normalnym otoczeniu żebra toną w cieniu, przez co drobna różnica w barwie staje się zupełnie niewidoczna (Rysunek 15.7.4):
Rysunek 15.7.4 Skorygowany materiał w typowym oświetleniu
Zaadoptowałem rozwiązanie z flagą Geometry:Backfacing we wnętrzu grupy Gloss Paint, aby było dostępne „w standardzie” (por. str. 1054). Dzięki temu można stosować w modelu pojedyncze ściany, oczywiście z umiarem i w miejscach mało wyeksponowanych. Te kilka dodatkowych węzłów praktycznie nie wydłuża czasu renderu. (Z moich doświadczeń wynika, że ew. różnica mieści się w granicy błędu pomiarowego – poniżej 1%).
Materiały. Zazwyczaj w skład modelu wchodzi o wiele mniej materiałów niż obiektów. Stąd przy nazewnictwie tych elementów nie ma potrzeby stosowania członu z unikalnym numerem. Wystarczą same nazwy.
W przypadku materiałów proponuję stosować tekst składający się z następujących segmentów (rozdzielonych kropkami):
1 znak: segment, który będzie pełnił rolę wyróżnika wersji samolotu. Wszystkie części w pojedynczym pliku Blendera będą używać takiej samej litery. Na przykład w modelu P-40B nazwy będą zaczynać się od “B”;
segment z podstawową, “ludzką” nazwą materiału. Dwóm podstawowym materiałom, używanym do pokrycia samolotu, nadałem nazwę Skin. (To dlatego, że imitują różnorodne pokrycia, i nie można im przypisać jakiejś jednej “fizycznej materii”.) W pozostałych przypadkach stosujemy nazwy “fizyczne” — “Glass” (np. osłony kabiny), “Rubber” (np. na oponach), “Leather” (np. zagłówka pilota), “Chrome” (dla gładzi cylindrów amortyzatorów). W przypadku imitacji pokrycia farbą w jednolitym kolorze, można stosować nazwę koloru tej farby — np. “Black”.
opcjonalny segment z członem “uszczegóławiającym”. W przypadku podstawowych materiałów poszycia (nazwa w pierwszym segmencie — “Skin”) ten segment zawiera niezbędne określenia: Inner lub Camouflage. W pozostałych przypadkach to potoczna nazwa zespołu, do którego należy stosować materiał (np. Canopy dla oszklenia kabiny).
Zgodnie z powyższymi regułami, materiał pokrywający zewnętrzne powierzchnie samolotu będzie nosił nazwę B.Skin.Camouflage, a materiał osłony kabiny — B.Glass.Canopy.
W przypadku materiałów związanych z konkretną sceną, a nie z modelem (np. trawy lotniska) nie stosuję żadnych 1-znakowych przedrostków.
Tekstury. W „starym” silniku renderującym Blendera (Internal) teksturą był nazywany zespół złożony z obrazu i różnych dodatkowych parametrów, związanych z próbkowaniem pikseli, mapowaniem na powierzchnię modelu, itp. W Cycles za te operacje są odpowiedzialne oddzielne węzły, które można dodać do schematu. Ekwiwalentem tekstury z silnika BI może być w Cycles grupa węzłów, zawierająca jakiś węzeł typu Image Texture. W tej książce stosuję jednak inny styl i nie łączę ich w ten sposób.
Do tekstur odwołuję się, używając nazwy pliku z ich obrazem (np. „color.png”, albo „decals.png”).
Stąd nazwy własne mają tylko tekstury związane z węzłami Image Texture lub Environment Texture (czyli te, które zawierają referencje do obrazów). Tekstury proceduralne (np. Noise Texture) nie mają nazw.
Grupy. Na przedstawionych w tej publikacji schematach można wyróżnić dwa rodzaje grup:
Nowe węzły do ogólnych zastosowań (takie jak na te przedstawione na str. 1062). Te grupy traktuję jakby były takimi samymi podstawowymi elementami schematu jak standardowe węzły Cycles. Dlatego noszą nazwy opisujące ich funkcję, bez żadnych przedrostków: Moderate, Negate, … Jak widzisz, nawet zapisuję je w tym samym stylu, co nazwy standardowych węzłów Cycles;
Wyspecjalizowane zespoły efektów, stworzone, aby nie powielać tego samego fragmentu schematu w podobnych materiałach (por. str. 454). Takie grupom nadaję przedrostek „X”, aby w menu Add→Group znalazły się na końcu listy (gdyż są rzadziej używane). Pisząc ich nazwy używam stylu właściwego dla innych „nazw własnych” w tym modelu (np. X.Curtiss Green);
Efekt Sky Texture to w Cycles programowo generowana panorama bezchmurnego nieba. Wstawia się ją do schematu w Node Editor, poleceniem Add→Texture→Sky Texture. Należy ją dołączyć do wejścia Color shadera Background. Rysunek 15.9.1 przedstawia ją w trybie Preetham (to nazwa algorytmu):
Rysunek 15.9.1 Użycie węzła Sky Tekture w schemacie otoczenia (World)
Rysunek 15.9.2 przedstawia obraz tekstury, uzyskany na powierzchni kulistej sondy (por. str. 1016). Górna część otoczenia ma błękitny kolor nieba. Nieco powyżej „linii horyzontu” ta barwa płynnie przechodzi w pastelowy, jednolity kolor. Większość scen rozgrywa się na ziemi, i w takich zastosowaniach większej części tej dolnej półsfery po prostu nie widać. Dla ujęć w locie horyzont tej panoramy znajduje się zbyt wysoko (Rysunek 15.9.3):
Rysunek 15.9.2 Podgląd z użyciem sondy | Rysunek 15.9.3 Model w otoczeniu wykreowanym przez Sky Texture |
Na błękitnym „niebie” Sky Texture znajduje się (domyślnie w zenicie) rozjaśnienie, odpowiadające słońcu (Rysunek 15.9.4a). Położeniem tego rozjaśnienia możesz sterować za pomocą „kulki”, umieszczonej w węźle. Wystarczy ją „złapać” LPM i przeciągnąć, aby przesunąć to rozjaśnienie ponad odbity przez powierzchnię sondy obraz słońca (obiektu typu Sun — Rysunek 15.9.4b):
Rysunek 15.9.4 Dopasowanie najjaśniejszego miejsca nieba do aktualnej pozycji słońca
Lepiej zawsze mieć te dwa źródła światła odpowiednio zsynchronizowane.
Drugi parametr tekstury — Turbidity — służy do sterowania efektem, określanym jako „zamglenie”. Domyślna wartość wynosi 2.2 (por. Rysunek 15.9.1). Gdy ją zwiększysz, górna półsfera ulegnie rozjaśnieniu a dolna — pociemnieje. Obszar odpowiadający położeniu słońca stanie się większy i bielszy (Rysunek 15.9.5).
Wpływ zmiany tego parametru na połyskliwą („aluminiową”) powierzchnię modelu pokazuje Rysunek 15.9.6. Domyślne Turbidity = 2.2 odpowiada warunkom „czystego nieba” (Rysunek 15.9.6a). Jednocześnie zbyt wysokie położenie horyzontu podstawia za modelem i w odbiciach na powierzchniach bocznych za dużo pastelowej barwy dolnej półsfery. Takie zabarwienie może mieć samolot oświetlony promieniami wschodzącego/zachodzącego słońca. (Oczywiście, trzeba by tu jeszcze zmienić barwę źródła światła Sun z białej na pomarańczową).
Przy zwiększonym zamgleniu (Turbidity = 5.0) powierzchnia modelu staje się jaśniejsza, a barwy — mniej zróżnicowane. Dolna półsfera stała się nieco ciemniejsza, ale nie zmieniło to specjalnie odcienia odbijanego przez dół i boki naszego testowego samolotu (Rysunek 15.9.6b).
Aby obniżyć linię horyzontu Sky Texture, wykorzystaj węzeł Vector→Mapping (por. str. 1018). Tylko wtedy można uzyskać ujecie z boku na tle błękitnego nieba (Rysunek 15.9.7):
Rysunek 15.9.7 Przykładowe ujęcie modelu z boku, po obniżeniu linii horyzontu (tryb Preetham)
Gdy przełączysz się na alternatywny obraz nieba (Hosek/Wilkie) — w węźle Sky Texture pojawi się dodatkowy parametr (Ground Albedo — Rysunek 15.9.8):
Rysunek 15.9.8 Użycie węzła Sky Tekture w trybie Hosek/Wilkie
To współczynnik odbicia światła prez „ziemię” — czyli dolną półsferę panoramy. Zwiększenie tej wartości rozjaśnia nieco panoramę (por Rysunek 15.9.9), choć i tak algorytm Hosek/Wilkie tworzy ciemniejszy obraz od algorytmu Preetham (por Rysunek 15.9.9a) i Rysunek 15.9.2):
Rysunek 15.9.9 Wpływ parametru Ground Albedo na panoramę Sky Tekture
Rysunek 15.9.10 przedstawia test naszego modelu w tej drugiej odmianie panoramy Sky Texture:
Rysunek 15.9.10 Przykładowe ujęcie modelu z boku, po obniżeniu linii horyzontu (tryb Hosek/Wilkie)
Wydaje się, że niebo stworzone za pomocą algorytmu Hosek/Wilkie jest bardziej niebieskie od nieba wygenerowanego za pomocą metody Preethama. W dokumentacji Blendera podano także, że Hosek/Wilkie lepiej się nadaje do scen zachodu lub wschodu słońca.
Renderowaną scenę obserwujemy przez „okienko” kamery. Dla typowych ustawień (ogniskowa rzędu 70-90 mm) oznacza to że widać przez nie około 0.3% ogólnej powierzchni obrazu, który umieściliśmy w charakterze panoramy otoczenia (np. Environment Texture — por. str. 1022). Obserwacja tak ograniczonego obszaru bardzo utrudnia modyfikację jego ustawień, np. geometrii (zmianę skali i przesunięcie w celu obniżenia linii horyzontu, lub podobne). Czasami po prostu trudno się zorientować, co właściwie aktualnie widać w tle okna.
W takich sytuacjach warto użyć w podglądzie renderu bardzo prostego narzędzia: sondy w postaci lustrzanej kuli. Nie musi mieć idealnie kulistego kształtu, więc łatwo ją stworzyć dosłownie w parę sekund. Wystarczy umieścić w środku sceny (zazwyczaj jest to środek globalnego układu współrzędnych — punkt 0,0,0) sześcian. Następnie wygładzić go porządnie modyfikatorem Subdivision Surface — ustawiając parametr Subdivisions na 4 lub 5 — aby uzyskał kształt zbliżony do sfery (Rysunek 15.10.1):
Rysunek 15.10.1 Siatka sondy
Nadałem temu pomocniczemu obiektowi nazwę E.001.Light Probe. Aby nie przeszkadzał w głównej scenie, dodałem go w pomocniczej scenie Spares (por. str. 792, 1215). (Przypisz jej to samo otoczenie: World).
Powierzchnia sondy jest pokryta materiałem Artifical. W Cycles nadałem mu właściwości lustra, bo nie chciałem mnożyć niepotrzebnie materiałów pomocniczych (Rysunek 15.10.2):
Rysunek 15.10.2 Materiał sondy — powierzchnia lustrzana (Artifical)
Włącz teraz w oknie 3D View podgląd renderu, a przekonasz się, jak działa nasza sonda (Rysunek 15.10.3):
Rysunek 15.10.3 Użycie sondy do orientacji w obrazie otoczenia
Odbija się w niej otoczenie. Obracając się wokół tego obiektu, możesz w niej obejrzeć cały obraz panoramy — tak, jak jest rozłożony wokół sceny.
Zwróć uwagę, że na powierzchni kuli widać zarówno zenit jak i nadir sfery otoczenia. Zobaczysz to wyraźniej, gdy jako panoramę otoczenia podstawisz obraz testowej „szachownicy” ( Rysunek 15.10.4a):
Rysunek 15.10.4 Szczegóły geometrii odbijanego w sondzie obrazu
Ten efekt to naturalne zniekształcenie obrazu w kuli. Obraz otoczenia jest w Cycles rozpostarty na powierzchni olbrzymiej sfery, w środku której znajduje się scena. W jej biegunach — zenicie i nadirze — wyświetlana panorama ulega największej deformacji. Rysunek 15.10.4b pokazuje drogę promieni światła, w wyniku której na powierzchni kuli widać obszary położone po przeciwnej stronie biegunów otoczenia.
Węzeł Mapping dodaje się w Node Editor poleceniem Add→Vector→Mapping. Służy do modyfikacji danych typu Vector. Dane tego typu są zazwyczaj używane do ustalenia sposobu wyświetlania rozkładanych na powierzchniach obiektów obrazów (tekstur), oraz panoram otoczenia. Ten węzeł to typowy „konwerter”, wstawiany pomiędzy źródło i odbiorcę danych. Rysunek 15.11.1 przedstawia przykład użycia:
Rysunek 15.11.1 Typowe połączenie węzła Mapping
Źródłem danych geometrycznych jest tu węzeł Geometry, odbiorcą — panorama Sky Texture. Kontrolki węzła Mapping służą do transformacji współrzędnych dostarczanych na wejściu. Ustawienia węzła przedstawionego przez Rysunek 15.11.1 nie zmieniają jeszcze niczego — przesunięcie (Location) i obrót (Rotation) są zerowe. W tym stanie linia horyzontu Sky Texture jest w okolicy równika — tak jak pokazuje sonda (Rysunek 15.11.2a):
Rysunek 15.11.2 Zastosowanie węzła Mapping do obniżenia linii horyzontu panoramy otoczenia
Aby przesunąć horyzont w dół, zwiększ Location:Z do 0.5 (Rysunek 15.11.2b). Horyzont się przesunął, ale pojawił się niespodziewany efekt uboczny: czarna dziura w zenicie (Rysunek 15.11.2c)! (Obraz panoramy jest „za krótki” i po przesunięciu już nie sięga do końca sfery). Aby ją zlikwidować, zmniejsz Scale:Z z 1.0 do 0.5 (Rysunek 15.11.3b). Panorama „rozciągnie” się w obydwu kierunkach, z jednej strony docierając z powrotem do zenitu, a z drugiej — jeszcze bardziej obniżając linię horyzontu (Rysunek 15.11.3c):
Rysunek 15.11.3 Korygowanie efektu „czarnej dziury”
Węzeł Mapping ma wiele trybów działania: Texture, Point, Vector, Normal. To rozróżnienie wprowadzono stosunkowo niedawno, w Blenderze 2.69. Wcześniej węzeł działał tak, jakby był zawsze ustawiony w trybie Point (czyli traktował podane współrzędne jakby opisywały położenie punktu w przestrzeni).
Wszystkie przykłady w tej książce powstawały we wcześniejszych wersjach Blendera 2.6. Dlatego węzły Mapping, które wykorzystuję w schematach materiałów, działają w trybie Point.
Tryb Texture jest odwrotnością trybu Point (w zamyśle twórców ma służyć do transformacji obrazu tekstury, a nie jej współrzędnych). Jeżeli np. zastosujesz go do transformacji którą pokazuje Rysunek 15.11.2a) (por. Rysunek 15.11.4b) uzyskasz „czarną dziurę” u dołu, a nie u góry panoramy (Rysunek 15.11.4c):
Rysunek 15.11.4 Efektu „czarnej dziury” na panoramie (tryb Texture)
Aby uzyskać ją u góry, musisz przesunąć teksturę do dołu (wprowadzając ujemną Location:Z = -0.5), oraz zwiększyć, a nie zmniejszyć jej skalę (Scale: Z = 1.5). Ilustruje to Rysunek 15.11.5:
Rysunek 15.11.5 Korygowanie efektu „czarnej dziury” (tryb Texture)
Tryb Vector ma służyć do transformacji wektorów — stąd w tym trybie ignorowane są wszelkie zmiany położenia (Location). (Wektory można tylko obracać i skalować).
Tryb Normal ma służyć do transformacji wektorów o jednostkowej długości, stąd w tym trybie ignorowane są wszelkie zmiany położenia (Location) i skali (Scale). (Wektory jednostkowe można tylko obracać)
Aby dodać obraz rastrowy jako nową teksturę1, wywołaj w Node Editor polecenie Add→Texture→Image Texture. Spowoduje to dodanie do schematu nowego węzła (Rysunek 15.12.1):
Rysunek 15.12.1 Węzeł Image Texture
Na wejściu należy zawsze podłączyć jakieś współrzędne tekstury (Vector). (Zazwyczaj wykorzystuje się w tym celu jedno z wyjść węzła Texture Coordinate). Jeżeli nic tu nie podłączysz, Cycles wykorzystuje niejawnie współrzędne UV siatki. Na wyjściu węzeł zwraca piksele tekstury (Color). Można je podłączyć np. do wejścia Color jakiegoś shadera, nakładając w ten sposób obraz tekstury na jego powierzchnię.
Poniżej przypisania do obrazu węzeł Image Texture zawiera pomocniczą kontrolkę, za pomocą której wybiera się typ korekty barw pikseli. Na razie dostępne są dwie możliwości:
Non-Color Data: bez korekty (używane są odczytane z pliku obrazu wartości RGBA);
Color: odczytane z pliku wartości RGBA pikseli podlegają tzw. korekcie gamma (por. str. 794), a dopiero potem są użyte w renderze;
Początkowo nowy węzeł nie jest przypisany do żadnego obrazu. Nowy plik obrazu można odczytać z dysku używając przycisku Open (Rysunek 15.12.2):
Rysunek 15.12.2 Przypisanie teksturze nowego obrazu (z pliku)
Załadowany obraz to oddzielny blok danych (wyjaśnienie tego pojęcia — por. str. 1215). Tekstura zawiera tylko jego przypisanie (referencję). Dlatego po załadowaniu obrazu na miejscu przycisku Open pojawił się typowy zestaw kontrolek do obsługi referencji. Przyciskiem można załadować z dysku inny obraz na miejsce aktualnego, a przycisk
służy do usunięcia powiązania węzła z obrazem.
Po załadowaniu ten sam obraz można przypisać do wielu różnych węzłów Image Texture. Służy do tego lista rozwijalna, umieszczona z lewej strony przycisku Open (Rysunek 15.12.3).
Być może kiedyś do węzła Image Texture zostanie dodane jakieś okno podglądu obrazu. Póki co, każdy załadowany (w ten czy inny sposób) do Blendera obraz można obejrzeć w oknie Image Editor (Rysunek 15.12.4):
Rysunek 15.12.4 Podgląd pliku obrazu (Image Editor).
Domyślnie Blender nie kopiuje do pliku ze sceną zawartości obrazu2. Zapamiętuje tylko ścieżkę, skąd ma pobrać plik. Wynika stąd praktyczna wskazówka:
Możesz zmieniać zawartość obrazu tekstury za pomocą zewnętrznego narzędzia (np. GIMP), bez konieczności zamykania Blendera. Po prostu otwórz, zmodyfikuj i zapisz odpowiedni plik obrazu na dysku. Potem wystarczy w Image Editor wywołać polecenie Image→Reload Image (Alt-R)— i zobaczysz w Blenderze jego aktualną wersję.
Ten węzeł służy do otoczenia sceny jakimś panoramicznym obrazem, Dodaje się go w Node Editor poleceniem Add→Texture→Environment Texture (Rysunek 15.13.1):
Rysunek 15.13.1 Węzeł Environment Texture
Węzeł Environment Texture ma podobne kontrolki oraz takie same punkty wejścia i wyjścia jak węzeł Image Texture (por. str. 1020, Rysunek 15.12.1). To dlatego, że używa się ich w podobny sposób. Czym się różnią? Kształtem obrazu! Węzeł Image Texture reprezentuje płaski kwadrat. A Environment Texture to panorama — a dokładniej, sfera. W domyślnym trybie mapowania (Equirectangular) Cycles oczekuje przypisania do tego węzła obrazu o proporcjach wysokości i szerokości jaki 1:2 (Rysunek 15.13.2a):
Rysunek 15.13.2 Odwzorowanie obrazu na otoczeniu sceny w mapowaniu Equirectangular
Efekt uzyskany z Environment Texture jest taki sam, jak gdybyś umieścił scenę w ogromnej sferze, na którą jest nałożony obraz (w znanej z geografii projekcji Merkatora: Rysunek 15.13.2b). Skąd wziąć takie panoramy? Spróbuj poszukać ich w Internecie. Wiele z nich jest zapisana w specjalnym formacie HDR (Rysunek 15.13.3):
Rysunek 15.13.3 Przykładowa panorama (obraz HDR z www.openfootage.net )
Pliki *.hdr możesz podejrzeć tylko w Blenderze, bo kolory są w nich zapisane jako liczby zmiennoprzecinkowe.
(GIMP nie obsługuje jeszcze tego formatu). Gdy wyświetlisz taki obraz w UV/Image Editor Blendera, zapewne zauważysz że jest przyciemniony (por. Rysunek 15.13.3). To efekt uboczny innej skali intensywności, stosowanej w takich plikach. Najprostszy przykład użycia węzła Environment Texture przedstawia Rysunek 15.13.4a):
Rysunek 15.13.4 Przykład zastosowania węzła Environment Tetxure
Podłączasz jego wyjście (Environment Texture:Color) do wejścia Color shadera Background. Nie musisz niczego podłączać do wejścia Environment Texture:Vector (chociaż możesz — o tym za chwilę). Jeżeli obraz panoramy jest w jednym z typowych formatów obrazów rastrowych — *.jpg, *.png, *.tiff — pozostaw domyślny tryb Color (z konwersją gamma, por. str. 1020). Dla obrazów HDR użyj trybu Non-Color Data (to tryb bez żadnej korekty — por. Rysunek 15.13.4a). Obrazy HDR mogą także wymagać ustawienia większej intensywności (Background:Strength). Rezultat przedstawia Rysunek 15.13.4b). To sonda, wstawiona do tak ustawionego otoczenia. Zwróć uwagę, jak bardzo rozmyty jest obraz tła na tym próbnym renderze. To efekt zbyt małej rozdzielczości obrazu (choć ta panorama ma rozmiar 1000x2000px). Po prostu kamera „widzi” tylko jej mały wycinek (Rysunek 15.13.5):
Rysunek 15.13.5 Położenie fragmentu obrazu pokazywanego w kamerze (obraz jest rozjaśniony)
Ten rozmyty obraz wyklucza użycie panoram o rozdzielczości rzędu 2000 – 3000 px jako podstawowego tła sceny. Widać to na naszym testowym modelu — brak ostrości psuje efekt1 (Rysunek 15.13.6):
Rysunek 15.13.6 Model w otoczeniu panoramy
Zwróć jednak uwagę, że odbicia otoczenia na powierzchni modelu są już przy tym rozmiarze panoramy całkiem zadowalające. Można to wykorzystać przy budowaniu złożonych schematów środowiska wokół sceny (str. 1036).
Sferą otoczenia można poruszać. Wystarczy dołączyć do wejścia Environment Texture:Vector dwa dodatkowe węzły: Texture Coordinate i Mapping (Rysunek 15.13.7):
Rysunek 15.13.7 Dodatkowe węzły, umożliwiające sterowanie sferą otoczenia
Gdy zaczniesz zmieniać wartość Mapping:Rotation:Z, zobaczysz że otoczenie się obraca (Rysunek 15.13.8):
Rysunek 15.13.8 Obracanie otoczenia wokół sceny
Podobnie możesz obniżyć linię horyzontu, przesuwając otoczenie w dół. Wystarczy zwiększyć wartość parametru Mapping:Location:Z (Rysunek 15.13.9):
Rysunek 15.13.9 Przesuwanie linii horyzontu w dół sceny
Zwróć uwagę, że mimo znacznego przesunięcia do dołu, w zenicie nie pojawiły się tu żadne artefakty, jak to miało miejsce dla Sky Texture (por. str. 1018, Rysunek 15.11.2).
Na koniec warto wspomnieć, że w wielu filmach instruktażowych (video tutorials) o Blenderze autorzy wykorzystują siatkę do zbudowania sfery wokół sceny. Następnie nakładają na nią obraz otoczenia. Podczas pracy nad tą sekcją porównałem uzyskiwany w ten sposób efekt z rezultatem uzyskiwanym za pomocą węzła Environment Texture. I wiecie co? Nie było żadnej specjalnej różnicy!
Wykorzystując otoczenie generowane przez węzeł Environment Texture można uzyskać ten sam efekt co za pomocą zamodelowanej siatki sfery, otaczającej scenę.
Wykorzystanie tego węzła jest rozwiązaniem prostszym, bardziej czytelnym i eleganckim niż dodawania do sceny ogromnej sfery. Pamiętaj o tym, gdy zobaczysz taką siatkę w kolejnym tutorialu o tworzeniu sceny w Blenderze!
Tekstury proceduralne są oparte na jakimś wyrażeniu matematycznym, lub algorytmie, pozwalającym uzyskać dwuwymiarowy obraz. Są to zazwyczaj jakieś abstrakcyjne (co nie znaczy, że bezużyteczne!) wzory, nieregularne „chmury”. Zdarzają się jednak także wzory regularne — np. procedura generująca rzędy cegieł w ścianie. Tekstury proceduralne stosuje się zazwyczaj razem, a czasami nawet zamiast tekstur rastrowych.
Jedną z tekstur proceduralnych dostępnych w Cycles jest prosty, czarno-biały gradient. Jego węzeł dodaje się do schematu poleceniem Add→Texture→Gradient Texture. Węzeł Gradient Texture przydaje się często jako „źródło współczynników”, dlatego ma dwa wyjścia: Color (barwa) i Fac (odpowiadająca jej wartość odcienia szarości) (Rysunek 15.14.1a):
Rysunek 15.14.1 Węzeł Gradient Texture i obraz, który generuje
Podobnie jak inne węzły tekstur (por. str. 1013, 1020, 1022) gradient ma jedno wejście typu Vector. Służy do transformacji wyświetlanego obrazu (pokażę to na następnych stronach tej sekcji). Gradient Texture ma jeden parametr — listę rozwijalną, z której można wybrać jeden z kilku dostępnych kształtów gradientu (Rysunek 15.14.1b). Rysunek 15.14.1c pokazuje, jak wygląda gradient liniowy (Linear). To „obraz jednowymiarowy”. Gdy na wejściu Vector współrzędna X jest równa 0.0, Gradient Texture:Linear zwraca wartość 0 (kolor czarny). Dla współrzędnej X = 1.0 zwraca wartość 1 (biały). W istocie to prosta zależność liniowa: V = X.
Rysunek 15.14.2a,b) przedstawia pozostałe kształty gradientów liniowych, które mamy do dyspozycji w tym węźle (Quadratic, Easing). Obydwa dla X = 0 zwracają 0, a dla X = 1 — 1. Różnią się tylko „tym, co pośrodku” — sposobem przejścia z czerni do bieli.
Rysunek 15.14.2 Pozostałe rodzaje gradientów jednowymiarowych
Trochę nadmiarowo jest tu także dostępny typ Diagonal. To właściwie gradient dwuwymiarowy. Jednak dokładnie taki sam efekt można uzyskać, pochylając pod kątem 45º (za pomocą węzła Mapping) gradient liniowy.
Pozostałe gradienty są oparte na okręgu o promieniu = 1.0, więc aby zobaczyć ich pełen kształt, trzeba poddać teksturę transformacji (por. str. 1018). Wykorzystuję tu typowe rozwiązanie, oparte o węzły Texture Coordinate i Mapping. Transformacja współrzędnych polega na dwukrotnym powiększeniu obrazu wyświetlanego dla oryginalnego zakresu współrzędnych X,Y = [0.0 .. 1.0] i przesunięciu środka o połowę rozmiaru (-1, -1) (Rysunek 15.14.3):
Rysunek 15.14.3 Modyfikacja położenia i rozmiaru obrazu tekstury
Gradient Texture dla współrzędnych wejściowych (X. Y) z zakresu -1.0 do 1.0 wyświetla następujące kształty (Rysunek 15.14.4):
Rysunek 15.14.4 Dostępne rodzaje gradientów sferycznych
Do tej pory przedstawiałem obraz generowany przez Gradient Texture na płaskiej, kwadratowej płytce. Rezultat działania tego węzła można jednak także stosować dla obiektów sferycznych, takich jak otoczenie sceny (Rysunek 15.14.5). Takie wartości przydają się np. do łączenia dwóch różnych panoram:
Rysunek 15.14.5 Użycie Gradient Texture w otoczeniu sceny
Za pomocą Gradient Texture można uzyskać płynne przejście pomiędzy górną półsferą z obrazem nieba i chmur, i dolną, z obrazem ziemi. Trzeba tylko obrócić kierunek gradientu (Mapping:Rotation:Y) o 90º (Rysunek 15.14.6):
Rysunek 15.14.6 Zmiana kierunku gradientu na pionowy
Potem można także sterować także wysokością tak uzyskanej „linii horyzontu” (Rysunek 15.14.7):
Rysunek 15.14.7 Przesunięcie granicy gradientu do dołu sfery otoczenia
Cycles, oprócz tekstury gradientu (omówionej w poprzedniej sekcji — por. str. 1026) udostępnia węzły z kilkoma innymi teksturami proceduralnymi. Znajduje się tam m.in. kilka rodzajów nieregularnych „szumów”.
Zacznijmy od „zwykłej” tekstury szumu, czy też „chmur”. Jej węzeł dodaje się do schematu poleceniem Add→Texture→Noise Texture. Węzeł Noise Texture przydaje się wszędzie tam, gdzie chcemy wprowadzić na powierzchni jakąś nieregularność. Często jest wykorzystywany jako „źródło współczynników”, dlatego ma dwa wyjścia: Color (barwa) i Fac (intensywność, czyli odcień szarości) (Rysunek 15.15.1):
Rysunek 15.15.1 Węzeł Noise Texture i obraz, który generuje
Noise Texture ma jedno wejście (Vector) na współrzędne mapowania, oraz po jednym z wejść dla każdej z wartości jego parametrów. (Możesz tworzyć różne ciekawe efekty, podłączając do nich inne tekstury proceduralne). Jeżeli do wejścia Vector nie podłączysz żadnych współrzędnych, Cycles użyje w sposób niejawny współrzędnych Texture Coordinate:Generated 1.
Aby dać Ci pojęcie, jak wygląda obraz generowany przez Noise Texture, przygotowałem po kilka przykładów ilustrujących wpływ każdego z trzech parametrów węzła (Scale, Detail, Distortion). Poza podaną na ilustracji wartością, pozostałe dwa parametry tekstury mają zawsze ustawione takie wartości, jakie pokazuje Rysunek 15.15.1.
Zacznijmy od parametru Scale. Zwiększenie skali powoduje zmniejszenie rozmiaru szumu, generowanego przez teksturę (Rysunek 15.15.2):
Rysunek 15.15.2 Wpływ parametru Scale
Zauważ, że obraz uzyskany dla Scale = 100 doskonale nadaje się dla jakichś chropowatych powierzchni!
Kolejnym parametrem jest Detail. To poziom “szczegółowości” szumu (Rysunek 15.15.3):
Rysunek 15.15.3 Wpływ parametru Detail
Gdy ustawisz Detail = 0, uzyskasz bardzo rozmyty obraz. Wraz ze zwiększaniem wartości Detail, “chmury” generowane przez Noise Image, mają coraz więcej drobnych szczegółów. Jednocześnie wydłuża się czas renderowania powierzchni, wykorzystującej tę teksturę. (Dla porównania 100 próbek renderowało mi się: gdy Detail = 0 →13s, gdy Detail = 1 → 14s, Detail = 2 → 15s, Detail = 5 → 18s a gdy Detail = 20 → 30s). Nie widziałem już specjalnej różnicy pomiędzy obrazem uzyskanym dla Detail = 5 i Detail = 20. Stąd wniosek:
Zazwyczaj nie opłaca się używać wartości Detail > 5. Gdy używasz dużej skali, zmniejszaj wartość Detail.
Na przykład gdy Scale = 100 (Rysunek 15.15.2c), warto zastosować Detail = 0, bo i tak nie ma sensu bardziej rozdrabniać na tych mikroskopijnych „ziarenek”.
Ostatnim parametrem tekstury szumu jest Distortion. Ta wartość opisuje intensywność „rozmazywania” obrazu szumu w różnych losowych kierunkach (Rysunek 15.15.4):
Rysunek 15.15.4 Wpływ parametru Distortion
W odróżnieniu od Detail, zmiana wartości Distortion nie ma znaczącego wpływu na czas liczenia każdej próbki.
Kolejnym rodzajem węzła, który mamy do dyspozycji, jest Vornoi Texture (Rysunek 15.15.5):
Rysunek 15.15.5 Tekstura Vornoi (w trybie Intensity)
Przy odpowiednio małej skali (Scale) możesz użyć tej tekstury do uzyskania chropowatej powierzchni.
Po przełączenie w drugi tryb — Cells — Voronoi Texture zwraca wzór przypominający nieregularne kryształy jakiegoś minerału. Czasami taki rozkład odcieni szarości można zaobserwować na powierzchni blachy (Rysunek 15.15.6):
Rysunek 15.15.6 Tekstura Vornoi (w trybie Cells)
Trzecim rodzajem węzła, który można wykorzystać do tworzenia różnego rodzaju nieregularnych wzorów, jest Musgrave Texture. Ten węzeł ma najwięcej parametrów (Rysunek 15.15.7):
Rysunek 15.15.7 Tekstura Musgrave
Opis parametrów węzła Musgrave Texture w podstawowej dokumentacji Cycles jest bardzo lakoniczny2. Pierwsze dwa parametry — Scale i Detail — działają podobnie jak te z Noise Texture (por. str. 1029 i 1030). Nieco inna wersja tekstury Musgrave jest używana od kilku lat w Blender Internal. W porównaniu z węzłem używanym w Cycles ma jeszcze większą liczbę parametrów — m.in. wybór funkcji bazowej (Noise Basis). Tym niemniej gdy nie ma nic lepszego, możesz posłużyć się jej opisem jako wskazówką co do działania parametrów tego węzła (por: http://wiki.blender.org/index.php/Doc:2.6/Manual/Textures/Types/Procedural/Musgrave ).
W każdym razie Musgrave Texture oferuje pięć różnych typów obrazów. Domyślny (fBM) przedstawia Rysunek 15.15.7, a pozostałe — Rysunek 15.15.8:
Rysunek 15.15.8 Inne typy tekstury Musgrave
W zasadzie wydaje się, że obraz typu Hetero Terrain (Rysunek 15.15.8a) różni się od Hibrid Multifractal (Rysunek 15.15.8b) tylko jasnością. Przypuszczam jednak, że dla innych wartości parametrów tej tekstury te różnice mogą być większe.
Pamiętaj, że najciekawsze efekty można osiągnąć łącząc ze sobą różne tekstury proceduralne. Na przykład — Rysunek 15.15.9 przedstawia jeden z możliwych rezultatów połączenia węzłów Vornoi i Musgrave:
Rysunek 15.15.9 Przykład efektu uzyskanego w wyniku złożenia dwóch tekstur proceduralnych
Taki wzór przypomina np. ogniska rdzy na płaskiej powierzchni blachy.
Tło, wypełnione prostymi barwami lub panoramą o niedostatecznej rozdzielczości (por. str. 1023, Rysunek 15.13.4) pozostawia wiele do życzenia ze względu na brak realizmu. Rysunek 15.16.1 pokazuje jeden z takich przypadków. Czy można “podstawić” za model realistyczne zdjęcie, które pokazuje Rysunek 15.16.2?
Rysunek 15.16.1 Model z kiepskim tłem | Rysunek 15.16.2 Obraz — lepsze tło dla modelu |
Jest to całkiem proste. Do schematu otoczenia dodaj węzeł Image Texture z obrazem tła (por. str. 1020). Dodaj także węzeł Texture Coordinate i podłącz współrzędne tekstury do jego wyjścia Window. Wyjście z węzła tekstury (Image Texture:Color) podłącz jako barwę shadera Background (Rysunek 15.16.3):
Rysunek 15.16.3 Schemat otoczenia sceny
Rysunek 15.16.4 przedstawia rezultat renderu — nasz model na tle zdjęcia:
Rysunek 15.16.4 Rezultat: model z lepszym tłem
Efekt wygląda zadowalająco poza pewnym szczegółem: odbitym obrazem otoczenia. Jeżeli nawet samolot ma półmatową powierzchnię, na których tych odbić nie widać, to można je zobaczyć na oszkleniu kabiny (Rysunek 15.16.5):
Rysunek 15.16.5 Problem z kształtem odbić otoczenia
Aby uzyskać inny układ odbić, trzeba inaczej rozłożyć obraz za modelem. W takim razie proponuję użyć Texture Coordinate:Camera, wraz z konieczną korektą węzłem Mapping (Rysunek 15.16.6):
Rysunek 15.16.6 Zastosowanie innego mapowania obrazu
(Więcej na temat węzła Mapping znajdziesz na str. 1018). Tak zastosowane współrzędne Camera pozwalają uzyskać za modelem niemal nie zdeformowany obraz (Rysunek 15.16.7):
Rysunek 15.16.7 Nowe ułożenie obrazu tła na renderze
W zbliżeniu odbicie otoczenia w oszkleniu kabiny wygląda inaczej. Zamiast wielu drobnych pasków jest jeden, ale większy (Rysunek 15.16.8):
Rysunek 15.16.8 Układ odblasków uzyskany dla mapowania Texture Coordinate:Camera
Spróbuj zmienić trochę punkt widzenia, a przekonasz się, że dla wielu ujęć uzyskany układ odblasków wygląda zupełnie nieźle (Rysunek 15.16.9a):
Rysunek 15.16.9 Porównanie odblasków dla różnych mapowań obrazu
Możesz także sprawdzić, że odbłyski uzyskane z użyciem Texture Coordinate:Window także wyglądają „znośnie” dla innych położeń kamery (Rysunek 15.16.9b).
Na koniec warto zauważyć, że cały ten problem „szklanych odbić” dotyczy tylko zbliżeń. W scenach, w których widać cały samolot, kabina jest zazwyczaj niewielka. Widoczne na niej półprzejrzyste odbicia otoczenia są w takim przypadku zbyt małe, by mogły popsuć efekt. Co innego, gdy połyskliwa jest cała powierzchnia samolotu (a tak jest w przypadku maszyn utrzymanych w barwie naturalnego duralu). Wówczas trzeba się uciec do bardziej złożonych kompozycji shaderów otoczenia (por. str. 1036).
W scenach “na wolnym powietrzu”, jakimi zazwyczaj są sceny lotnicze, trzeba umieścić wokół modelu imitację otoczenia. Najprościej jest “wstawić” za model jakąś fotografię — tak jak jest to opisane na str. 1033. To nie wystarcza, gdy samolot na naszej scenie ma mieć powierzchnię w naturalnym kolorze duralu. Aby na takiej powierzchni pojawiły się przekonujące odbicia otoczenia, potrzebujemy obrazu, który zostanie rozpostarty wokół sceny. Chodzi o kulistą “panoramę”, obejmującą 360º równika, i 180º południków (od zenitu do nadiru — por. str. 1022) . Obrazy tego rodzaju można znaleźć w Internecie, ale nie są tak liczne, jak zwykłe zdjęcia. Zazwyczaj, panoramy dostępne za darmo mają za małą rozdzielczość, by można je było zastosować do pełnego odwzorowania tła (do tego celu potrzebne są obrazy rzędu 10000x5000 pikseli lub większe — por. str. 1023). Dlatego musimy tu użyć złożenia “płaskiego zdjęcia za modelem”, stanowiącego podstawowe tło obrazu, z panoramą otoczenia, zapewniającą odpowiednie odblaski (Rysunek 15.17.1):
Rysunek 15.17.1 Przykład otoczenia złożonego z płaskiego obrazu i panoramy (Tło: © Tomo Yun, www.yunphpto.net )
Na szczęście takie pomocnicze panoramy nie muszą mieć bardzo dużych rozdzielczości, i darmowe pliki, udostępniane w Internecie, zupełnie do tego celu wystarczą. W tej sekcji pokażę szczegóły tego rozwiązania.
Podczas poszukiwań w Internecie możesz się natknąć na panoramy zapisywane w specjalnych formatach: HDR lub EXR 1. Taka forma zapisu wymaga nieco innych ustawień parametrów (por. str. 1022)
Podstawowym obrazem, od którego zaczynamy kompozycję sceny, jest zwykłe, płaskie zdjęcie które podstawimy jako tło renderowanego obrazu. Czasami bywa tak, że masz pomysł na scenę i szukasz w Internecie odpowiedniego otoczenia. Czasami — na odwrót, znajdziesz zdjęcie, w którym dostrzeżesz jakąś nową, ciekawą możliwość. W każdym razie w podczas takich poszukiwań zawsze warto zajrzeć na www.yunphoto.net . Autor oferuje tam za darmo różne zdjęcia w dużej rozdzielczości, m.in. nieba widzianego z samolotu.
W tej sekcji jako podstawowy obraz tła wykorzystamy plik, który nazwałem 4046.jpg (Rysunek 15.17.2a). (To właśnie jedna jedno ze zdjęć z samolotu wykonane przez Tomo Yuna, udostępnione pod nr 4046):
Rysunek 15.17.2 Źródła obrazów, wykorzystywanych w tej sekcji
Teraz trzeba dobrać do tego zdjęcia panoramę nieba. Dla Cycles szukaj zawsze panoram w tzw. rozwinięciu cylindrycznym (por. str. 1022). To takie dobrze znane rozwinięcie Merkatora, stosowane od wieków w geografii. Rysunek 15.17.2b) przedstawia panoramę, która wydaje mi się dość dobrze pasować do 4046.jpg. To darmowa próbka panoramy nr 163, udostępniona wyspecjalizowanym serwisie cgskies.com . Nazwałem ją cgsky.jpg.
Wykorzystywany w tej sekcji obraz: 4046.jpg nie jest niezbędny do wykonania modelu. Dlatego umieściłem go w dodatkowym pliku optional.zip (por. str. 22). Pozostałe pliki, które tutaj używam, pochodzą z pliku p40.zip, i znajdziesz w folderze model/p40/background.
Zwróć uwagę, że w panoramie cgsky.jpg brakuje dolnej połowy. Autorzy po prostu założyli, że dolna półsfera będzie się zawsze poza polem widzenia kamery. Na potrzeby naszej sceny w locie sami musimy wypełnić ten obszar obrazem „ziemi” . Najlepiej, aby odbicie tej półsfery na powierzchni samolotu pasowało do podstawowego tła (obrazu 4046.jpg). Proponuję więc uzyskać ją z przekształcenia tego właśnie obrazu (Rysunek 15.17.3):
Rysunek 15.17.3 Tworzenie panoramy dolnej półsfery (earth.jpg)
Załaduj obraz 4046.jpg do GIMP. Na początek możesz nieco zmniejszyć jego rozmiar (Image→Scale Image), na przykład dwukrotnie. (Oryginalne zdjęcie ma szerokość niemal 5000px, a w tej pomocniczej panoramie nie potrzeba aż takich rozdzielczości).
Następnie zduplikuj domyślną warstwę GIMP z obrazem i przerzuć tę kopię w poziomie, aby stworzyć „lustrzane odbicie” oryginalnego zdjęcia (Rysunek 15.17.3a). Zwiększ szerokość obrazu (Image→Canvas Size) dwukrotnie, a następnie starannie przysuń do siebie te dwie połówki. W ten sposób uzyskaliśmy podstawowy obraz, na którym nie będzie widać linii łączenia. To nic, że składa się z dwóch identycznych części. W odbiciach na powierzchni samolotu nie będzie tego widać.
Na koniec zwiększy wysokość obrazu (Image→Canvas Size) tak, by stała się równa połowie szerokości (Rysunek 15.17.3b). (To typowe proporcje obrazu panoramy). Ta część obrazu i tak będzie „zasłonięta” przez górną półsferę (cgsky.jpg). Oryginalne zdjęcie 4046.jpg miało proporcje 2:3, stąd zajmuje 2/3 wysokości panoramy. Taka „zakładka” może się jednak przydać, gdy będziesz chciał opuścić trochę ten obraz ziemi do dołu. Uzyskanemu w ten sposób plikowi z panoramą dolnej półsfery nadałem nazwę earth.jpg.
Rysunek 15.17.4 przedstawia złożenie obrazów górnej i dolnej półsfery (Environment Texture — por. str. 1022):
Rysunek 15.17.4 Złożenie panoramy z dwóch obrazów (earth.jpg i cgsky.jpg)
Mogłem dla każdy z użytych obrazów podłączyć do odrębnego shadera Background, połączonych później za pomocą węzła Mix Shader. Zamiast łączenia shaderów wolałem połączyć w jeden obraz przygotowane panoramy. Stąd wykorzystuję do tego węzeł Color→Mix, którego wyjście jest połączone z pojedynczym shaderem otoczenia (Rysunek 15.17.4).
Na początek warto sprawdzić za pomocą sondy (por. str. 1016), czy każda z panoram „układa” się tak jak tego byśmy chcieli (Rysunek 15.17.5):
Rysunek 15.17.5 Sprawdzanie obydwu panoram za pomocą sondy
Dla Mix:Fac = 0 scena jest otoczona wyłącznie przez panoramę earth.jpg (Rysunek 15.17.5b), a dla Mix:Fac = 1.0 — przez cgsky.jpg (Rysunek 15.17.5a).
Do właściwego złożenia tych dwóch obrazów potrzebujemy zmiennego współczynnika podziału. Użyjemy w tym charakterze obróconego o 90º gradientu typu Easing (Gradient Texture — str. 1026) (Rysunek 15.17.6):
Rysunek 15.17.6 Współczynnik podziału: gradient liniowy
Rysunek 15.17.7 przedstawia rezultat podłączenia wyjścia Gradient Texture:Fac (Rysunek 15.17.6) do wejścia Mix:Fac zespołu pokazywanego przez Rysunek 15.17.4.
Po pierwsze — coś jest nie tak z tym naszym gradientem, bo w górnej części sfery widać nadal górną granicę obrazu tła (por. Rysunek 15.17.5).
Jednocześnie warto przesunąć trochę źródło światła kierunkowego (Sun), aby jego odbicie pokrywało się z obrazem słońca na panoramie otoczenia (Rysunek 15.17.7). (W tym przykładzie te dwa punkty były bardzo blisko siebie, więc takie drobne poprawki położenia obiektu Sun nie stanowiły problemu. W przypadku większych różnic konieczny może się okazać obrót panoramy nieba — por. str. 1041, Rysunek 15.17.12).
Dlaczego na górnej półsferze poprzez panoramę nieba (cgsky.jpg) prześwituje ziemia (earth.jpg — Rysunek 15.17.7)? Popatrz jeszcze raz na Rysunek 15.17.6b). Zwróć uwagę, że dopiero w połowie górnej półsfery gradient uzyskuje wartość 50%. A taka wartość oznacza, że w tym miejscu zobaczysz złożenie obydwu łączonych obrazów! 100% nieba występuje na razie w jednym punkcie: w zenicie. Aby zwiększyć ten obszar, powiększ obraz gradientu wzdłuż osi Z (Mapping:Scale:Z) — na przykład 2 razy (Rysunek 15.17.8):
Rysunek 15.17.8 Zastosowanie gradientu jako współczynnika łączenia dwóch sfer
Rysunek 15.17.9 przedstawia nowy rozkład gradientu (a) oraz uzyskaną panoramę (b):
Rysunek 15.17.9 Poprawiony gradient do łączenia dwóch sfer
Po tej poprawce panorama wydaje się całkiem poprawna — sprawdźmy, jak wygląda w tym otoczeniu nasz model (Rysunek 15.17.10):
Rysunek 15.17.10 Model w otoczeniu panoramy (earth.jpg + cgsky.jpg)
O ile ujęcia z góry i z dołu (Rysunek 15.17.10a,b) wyglądają poprawnie, to w widoku poziomym (Rysunek 15.17.10c) horyzont położony jest zbyt wysoko. Trzeba go obniżyć (Rysunek 15.17.11):
Rysunek 15.17.11 Przesunięcie linii horyzontu do dołu
Aby zmieścić na poprzedniej stronie Rysunek 15.17.11, zmniejszyłem na nim węzeł transformacji dolnej półsfery (earth.jpg). Zrobiłem tak gdyż ta panorama nie ulega żadnej zmianie przy obniżaniu horyzontu. Warto jednak podłączyć do jej wejścia taki sam węzeł transformacji (Mapping) jak do półsfery nieba, aby móc swobodnie nią obracać (Rysunek 15.17.12a):
Rysunek 15.17.12 Panorama otoczenia (po dodatkowym obrocie panoramy earth.jpg)
(Za pomocą obrotu dolnej półsfery możesz zmieniać układ odbić otoczenia, widocznych na dolnych powierzchniach modelu). Uzyskane w wyniku tej i poprzedniej zmiany otoczenie sceny przedstawia Rysunek 15.17.12b). Jak widać, horyzont uległ tu znacznemu obniżeniu.
Sprawdźmy, jak to wpłynęło na ujęcia naszego modelu. Dla widoku z góry (Rysunek 15.17.13a) właściwie nic się nie zmieniło (por. Rysunek 15.17.10a). Na tle ujęcia z dołu (Rysunek 15.17.13b) majaczące w oddali odległe, błękitne góry (por. Rysunek 15.17.10b) zostały zastąpione przez czyste niebo. Tę zmianę widać jeszcze bardziej dobitnie w widoku z boku (Rysunek 15.17.13c). Poprzednio nasz samolot wyglądał jakby leciał między górami (Rysunek 15.17.10c), a teraz występuje na tle błękitnego nieba:
Rysunek 15.17.13 Model w otoczeniu poprawionej panoramy (earth.jpg + cgsky.jpg)
Dodajmy teraz do naszego schematu drugi element: konwencjonalny obraz (Texture Image) tła, podstawiony za modelem (Rysunek 15.17.14):
Rysunek 15.17.14 Złożenie panoramy z „płaskim” obrazem tła
Zastosowałem tu rozwiązanie opisane na str. 1033: konwencjonalny obraz (Texture Image) podstawiony we współrzędnych okna (Texture Coordinate:Window.) . Do rozróżnienia promieni (pikseli renderowanego obrazu) odbitych od modelu i od tła użyłem flagi Light Path:Is Camera Ray (str. 1007). Dla pierwszych (Is Camera Ray = 0) wykorzystywana jest przygotowana wcześniej panorama otoczenia. Dla drugich (Is Camera Ray = 1) podstawiany jest obraz nebraska.png 2. Mogłem połączyć te obraz kolejnym węzłem Color→Mix z flagą Is Camera Ray w charakterze współczynnika udziału (Fac). Zdecydowałem się jednak podłączyć każdy z tych obrazów do oddzielnego shadera typu Background, które są łączone węzłem Mix Shader (Rysunek 15.17.14). Taki układ pozwala na niezależną regulację intensywności oświetlenia powierzchni modelu i tła (Rysunek 15.17.15):
Rysunek 15.17.15 Regulacja jasności panoramy otoczenia
Czasami przydaje się dodać niebu jakiś odrobinę inny odcień. Aby to zrobić, wstaw nowy element typu Color→Mix w środek linii łączącej wyjście z Environment Texture (z cgsky.jpg) z węzłem Color→Mix scalającym górną i dolną panoramę (Rysunek 15.17.16):
Rysunek 15.17.16 Dodatkowy efekt — odcień nieba
Ustaw wejście Mix:Color2 nowego węzła na barwę, która „pasuje” do obrazu tła sceny. Dla takiego otoczenia jak nebraska.png zastosowałem kolor pomarańczowy. Trybem łączenia jest Mix, a do wejścia Mix:Color1 podłączyłem obraz z Environment Texture. Intensywnością zabarwienia nieba steruje współczynnik Mix:Fac. Ustaw go na jakąś niewielką wartość — np. 0.1 (10%). Rysunek 15.17.17 przedstawia efekt takiej niewielkiej zmiany:
Rysunek 15.17.17 Regulacja „odcienia nieba”
Rysunek 15.17.17a) to wersja obrazu stworzona z użyciem obrazu nieba bez żadnej korekty. Rysunek 15.17.17b) przedstawia obraz, w którym niebo stało się lekko pomarańczowe (gdyż zmieniłem Mix:Fac na 0.1). Trzeba przyznać, że efekt jest „kosmetyczny”. Pomaga lepiej „dopasować” model do obrazu tła. Coś podobnego można także uzyskać w inny sposób — np. operując odpowiednimi obrazami w kompozytorze Blendera (por. str. 1166). Ja jednak takie proste poprawki wolę wstawiać bezpośrednio do schematu otoczenia sceny. Uważam, że w ten sposób łatwiej z nich skorzystać, niż z Render Layers kompozytora.
Pewien szczegół naszego modelu nadal nie pasuje do tła: za szybami kabiny wciąż widać błękitny fragment panoramy otoczenia, a nie obraz tła (Rysunek 15.17.18a):
Rysunek 15.17.18 Wpływ opcji Caustics na render
W pierwszej chwili sądziłem, że to efekt zaciemnienia szyb, wywołany włączonymi w panelu Light Paths zestawu Render opcjami Caustics (Rysunek 15.17.18b). Po włączeniu tych opcji (Rysunek 15.17.18d) błękit widoczny za kabiną pozostał, wnętrze kokpitu tylko nieznacznie się rozjaśniło, za to na kadłubie pojawiło się mnóstwo białych punktów („świetlików” — Rysunek 15.17.18c), które zaczęły znikać dopiero po kilku tysiącach próbek. Czym prędzej więc z powrotem wyłączyłem opcje Caustics. Nie one są tutaj przyczyną.
Węzeł Light Path zalicza promienie przechodzące przez szybę do grupy Is Transmission Ray. A promień (piksel renderu) może należeć tylko do jednej kategorii — więc za szybą kabiny widać fragment błękitu naszej panoramy otoczenia, a nie obraz tła. W takie sytuacji można tak zmienić schemat, by podstawiał obraz tła i dla Is Camera Ray, i dla Is Transmission Ray ( Rysunek 15.17.19a):
Rysunek 15.17.19 Uzyskanie obrazu tła za oszkleniem kabiny
Chodzi tu o sumę „logiczną”, która zwróci 1 gdy którakolwiek z tych flag będzie równa 1. Ten efekt można uzyskać za pomocą węzła Math, ustawionego na funkcję Maximum (Rysunek 15.17.19a). W efekcie na renderze za kabiną pojawi się odpowiednie tło obrazu (Rysunek 15.17.19b). Jedyną wadą tego rozwiązania są nietypowe odblaski otoczenia na szybach (szersze omówienie tego problemu znajdziesz na str. 1034).
Należy zauważyć, że te odblaski są w wyniku „zmieszania” z panoramą otoczenia słabsze. W razie czego pamiętaj, że rozwiązanie oparte na sumowaniu Is Camera Ray z Is Transmission Ray warto stosować tylko wtedy, gdy przez oszklenie widać jakiś fragment tła sceny. Czasami możesz tak ustawić kamerę, by „za szkłem” były widoczne wyłącznie powierzchnie modelu. Wtedy możesz zastosować tylko flagę Light Path:Is Camera Ray (jak na str. 1042, Rysunek 15.17.14) dla której nie ma problemu ze środowiskiem odbitym w szybach. Innym sposobem na uniknięcie stosowania flagi Is Transmission Ray jest podstawienie „za szybą” modelu takiego fragmentu panoramy otoczenia, który kolorystycznie pasuje do obrazu tła. (W przypadku Rysunek 15.17.18a i c mógłby to być jakiś fragment białej chmury).
Zresztą — najczęściej te nieprawidłowe odblaski, jakie uzyskamy stosując złożenie Is Camera Ray z Is Transmission Ray (Rysunek 15.17.19), nie są czymś specjalnie rażącym. Popatrz chociażby na model poniżej (Rysunek 15.17.20):
Rysunek 15.17.20 Rezultat — srebrzysty samolot na tle zimowego krajobrazu
Wydaje mi się, że nie zwróciłeś na nie uwagi także na renderze z początku tej sekcji (str. 1036, Rysunek 15.17.1).
Rysunek 15.17.21 przedstawia uzyskany schemat otoczenia sceny. Aby zmieścić go na jednej ilustracji, pozostawiłem węzły transformacji (Mapping) gradientu i panoram w stanie „zminimalizowanym”:
Rysunek 15.17.21 Pełen schemat otoczenia sceny (World)
Zastanawiałem się, jak można przekształcić te węzły w jakąś elegancką grupę. Jednak zrezygnowałem, gdyż obecnie w Cycles nie ma możliwości wygodnego „wyciągnięcia” wybranych parametrów z węzłów Mapping.
Stwórz nowy materiał i przypisz go do elementów oszklenia kabiny. Nazwijmy go B.Glass.Canopy (por. str. 1012). Uzyskanie materiału odpowiadającemu szkłu (a dokładniej: szkłu organicznemu) wydaje się w Cycles trywialne. Przecież mamy tu do dyspozycji gotowy shader Glass BSDF! Wykorzystajmy więc go w naszym materiale. Rysunek 15.18.1 pokazuje pierwszą wersję jego definicji, przygotowaną w Node Editor:
Rysunek 15.18.1 Domyślne ustawienia nowego materiału
Ustaliłem dla tej powierzchni kolor biały i idealną gładkość (Roughness = 0). Współczynnik refrakcji IOR jest odpowiedni dla plexiglasu (por. str. 1005). Jednak rezultat tych ustawień na podglądzie renderu jest daleki od oczekiwanego (Rysunek 15.18.2):
Rysunek 15.18.2 Rezultat pierwszego zastosowania shadera Glass BSDF
Dlaczego w środku kabiny wszystko jest niemal zupełnie czarne!? Składa się na to kilka przyczyn. Po pierwsze, miałem wyłączoną obsługę tzw. kaustykę (ang. caustic) czyli przenikania światła przez szkło. (Wyłączenie kaustyki daje mniej przypadkowych białych punktów na renderze nieprzejrzystych, połyskliwych powierzchni. W przypadku naszego modelu to znacznie poprawia wynik i skraca cza renderowania). Włączenie kaustyki (Rysunek 15.18.3a) tylko trochę rozjaśnia wnętrze kabiny (Rysunek 15.18.3b):
Rysunek 15.18.3 Shader Glass BSDF: problemy z cieniem!
Właściwą przyczyną naszych problemów jest cień: ta szyba rzuca cień jak lity przedmiot! (Rysunek 15.18.3b).
W wersji Blendera, w której to wykonuję (2.71) Cycles nie obsługuje prawidłowo kaustyki dla źródła światła typu „słońce”, które stosujemy w tej scenie. Musimy to obejść pewną sztuczką. Otóż mamy do dyspozycji shader o nazwie Transparent. Kolor tego węzła pozwala płynnie regulować cień (Rysunek 15.18.4):
Rysunek 15.18.4 Shader Transparent: problemy z brakiem oszklenia
Powierzchnie Transparent nie zastąpią nam jednak szkła — jest to taki efekt „techniczny”, przeznaczony do łączenia z innymi shaderami. My podstawimy jego cień zamiast cienia szkła — używając znacznika Light Path:Is Shadow Ray (Rysunek 15.18.5). (Więcej na temat Light Path znajdziesz na str. 1007).
Rysunek 15.18.5 Uzyskanie uproszczonych cieni za oszkleniem
Rysunek 15.18.6a) przedstawia rezultat, jaki otrzymaliśmy dla tak zmodyfikowanego materiału na renderze. Zwróć uwagę, że działa mimo włączonych opcji Caustics (Rysunek 15.18.6b):
Rysunek 15.18.6 Efekt: przejrzysty cień, mimo wyłączonej kaustyki
Uzyskaliśmy przejrzyste cienie, co zdecydowanie rozjaśniło wnętrze kabiny. Nasze szkło jest jednak nadal prawie niewidoczne (Rysunek 15.18.7):
Rysunek 15.18.7 Materiał szkła (złożenie shaderów Glass BSDF i Transparent BSDF) na owiewce kabiny
Trzeba wzbogacić jego powierzchnię o efekt lustrzanego odbicia, który zapewnia shader Glossy BSDF. Udział doskonale przejrzystej powierzchni szkła powinien się zmniejszać przy większych kątach widzenia. (Powierzchnia szkła pochylona pod kątem odbija obraz otoczenia). Dlatego jako współczynnika użyjemy wartości dostarczanych przez węzeł Fresnel (por. str. 1003, 301). Rysunek 15.18.8 przedstawia zmodyfikowany schemat:
Rysunek 15.18.8 Połączenie shaderów Glass i Glossy
Rysunek 15.18.8 przedstawia tak zmodyfikowany materiał na podglądzie renderu. Teraz już wygląda jak szkło:
Rysunek 15.18.9 Szkło z połyskiem
Do uzyskania zadowalającego rezultatu takie przejrzyste powierzchnie wymagają wykonania kilkuset próbek renderu. Co gorsza, w pierwszej wersji Cycles, której używam, gdzieś w okolicach próbki nr 100 mogą się na nich pojawić białe punkty (Rysunek 15.18.8), które zostaną rozmyte dopiero po kilku tysiącach dalszych próbek!
Im gładsza powierzchnia kadłuba (Roughness → 0.0), tym większa szansa wystąpienia na renderze owiewki kabiny niepożądanych białych punktów („świetlików”).
Najwięcej takich punktów tworzy się na szybach z tyłu kabiny, gdzie powierzchnia kadłuba znajduje się zaraz za powierzchnią szkła. Zobacz na koniec tej sekcji (str. 1051), gdzie umieściłem opis jak sobie poradzić z tym problemem.
Na szczęście P-40B i C były zawsze pomalowane jakąś półmatową farbą, co zmniejsza ryzyko pojawienia się na renderze „świetlików”. Zdecydowałem umożliwić użytkownikowi materiału sterowanie przejrzystością szkła, czyli parametrem IOR z węzła Fresnel. (Zwróć uwagę, że chodzi tu wyłącznie o możliwość zmiany udziału shadera Glossy BSDF. Nie zmienia to w żadne sposób współczynnika Glass BSDF:IOR, który decyduje o załamaniu promieni słonecznych w szkle). Przekształciłem opracowany do tej pory zespół węzłów w grupę Plexiglas (Rysunek 15.18.10a), wprowadzając jednocześnie kilka drobnych udogodnień:
zastąpiłem węzeł Fresnel węzłem Layer Weight, którego parametr Blend w zakresie 0.0 .. 0.4 przekłada się bardziej liniowo na zmianę współczynnika Fresnela niż Fresnel:IOR. Z obserwacji kilku testowych renderów wywnioskowałem, że Fresnel:IOR = 1.5 odpowiada Layer Weight:Blend = 0.32;
Dodałem na wejściu do Layer Weight dodatkowy węzeł Multiply (Convertor→Math), który przelicza wprowadzaną przez użytkownika wartości parametru Reflectivity (intuicyjne 0.0 .. 1.0) na wartość odpowiednią dla Layer Weight:Blend;
Parametry nowego shadera przedstawia Rysunek 15.18.10b):
Rysunek 15.18.10 Definicja shadera Plexiglas
Zdecydowałem się „wyciągnąć” z tych węzłów następujące wejścia (por. Rysunek 15.18.10b):
Glass: barwa szkła (i — jednocześnie — barwa przejrzystego cienia);
Reflectivity: domyślna wartość 1.0 oznacza „zmatowienie” szkła (wynikające z udziału shadera Glossy) odpowiednie dla IOR = 1.5, a mniejsze wartości — szkło bardziej przejrzyste. Zmniejszenie tego parametru może się przydać w zbliżeniach i przy wzmocnionym świetle otoczenia;
Softness: „miękkość” odbłysków. To parametr Glossy BSDF:Roughness, pod zmienioną nazwą;
Aby dodatkowo nie komplikować schematu pokazywanego przez Rysunek 15.18.10, pokazuję oddzielnie wewnętrzne ulepszenie tej grupy. Przed wejściem do shadera Transparent dodałem węzeł typu Color→Mix. To operacja mieszania dwóch barw zgodnie z proporcją ustaloną przez współczynnik Fac (Rysunek 15.18.11):
Rysunek 15.18.11 Dodatkowy wewnętrzny element, przyciemniający cień rzucany przez oszklenie
W tym przypadku węzeł Mix służy do nieznacznego przyciemnienia barwy przeźroczystych cieni. Miesza podaną na wejściu grupy barwę szkła (Plexiglas:Glass) z 10% czerni, i tak zmieniony kolor dostarcza do wejścia shadera Transparent BSDF. Oczywiście, równie dobrze możesz ustawić tu jaśniejsze cienie — np. 5%.
Rysunek 15.18.12 przedstawia rezultat uzyskany za pomocą shadera Plexiglas. Tym razem zamiast jednolitego tła użyłem panoramicznej tekstury otoczenia, z chmurami i niebem, które w naturalny sposób odbija się w owiewce:
Rysunek 15.18.12 Rezultat użycia shadera Plexiglas (Reflectivity = 100%)
Zwróć uwagę, jak ważne jest uzyskanie jakiegoś zróżnicowanego odbicia otoczenia w szybach owiewki. Uważam, że dodają jej realizmu. Jednak bardzo trudno jest znaleźć odpowiednią panoramę, a jeszcze trudniej — panoramę o odpowiedniej rozdzielczości. Jeżeli w tle sceny podstawisz zamiast niej jakieś płaskie zdjęcie, zetkniesz się z pewnymi zniekształceniami odbić w oszkleniu owiewki (por. str. 1034).
Na koniec chciałbym wrócić do problemu „świetlików” . W wersji 2.7 Blendera wprowadzono w Cycles pewne poprawki. Po pierwsze — zoptymalizowano nieco algorytm działania, co spowodowało, że białe punkty są jakby mniejsze. Po drugie — w panelu Render:Sampling pojawiły się dodatkowe parametry o nazwie Clamp (Rysunek 15.18.13a). To max. dopuszczalna jasność pikseli podczas obliczania kolejnych próbek renderu (wartość 1.0 oznacza biały). Domyślnie Sampling:Clamp Direct (odbicia bezpośrednie) i Clamp Indirect (odbicia wtórne) są ustawione na wartość = 0, co oznacza że są wyłączone. W takim przypadku białe punkty pojawiają się na renderze tak jak we wcześniejszych wersjach (Rysunek 15.18.13b):
Rysunek 15.18.13 Render bez ograniczeń na zakres jasności pikseli
Ustaw parametry Clamp na taką wartość, by nie „obcinały” białych pikseli, ale eliminowały tylko takie, które są ewidentnie zbyt jasne (tzn. nieprawidłowe). Wypraktykowałem, że dla naszych scen wystarczy przyjąć Clamp = 2.0 (Rysunek 15.18.14a). Dla tej wartości świetliki są wyeliminowane już po około 50 próbkach. Po 200 próbkach mamy już zupełnie porządny efekt (Rysunek 15.18.14b):
Rysunek 15.18.14 Render z ograniczeniem na zakres jasności pikseli (Clamp)
Jednocześnie scena nie ulega żadnemu widocznemu zaciemnieniu (tak się dzieje dla wartości Clamp < 1.0). Nie widać także innych negatywnych efektów ubocznych. Czyli — ustawienie godne polecenia!
Podczas modelowania wnętrza kabiny natknąłem się na problem odbicia otoczenia przez szkło. Każdy z przyrządów pokładowych zamontowanych w tablicy przyrządów był zabezpieczony płaską szklaną płytką. Początkowo przypisałem im materiał użyty w osłonie kabiny (oparty o shader Plexiglass). Okazało się, że w ujęciach z boku tarcze wskaźników zmieniały się w małe lusterka (Rysunek 15.18.15):
Rysunek 15.18.15 „Lustrzane” odbicia otoczenia w osłonach przyrządów pokładowych
Taki efekt nie wygląda realistycznie. Przyczyną jest shader Glossy BSDF, którego udział rośnie wraz z kątem pochylenia szklanej powierzchni do obserwatora. Aby to skorygować, trzeba uczynić ten shader częściowo przejrzystym. „Zmieszałem” go więc z shaderem Transparent BSDF (Rysunek 15.18.16):
Rysunek 15.18.16 Schemat zmodyfikowanego materiału dla osłon przyrządów (B.Glass.Dials)
Rysunek 15.18.17 przedstawia to samo ujęcie, uzyskane z wykorzystaniem materiału o schemacie przedstawionym powyżej (nadałem mu nazwę B.Glass.Dials):
Rysunek 15.18.17 Odbicia otoczenia w materiale B.Glass.Dials
Doszedłem do wniosku, że przesadziłem z połyskliwością szkła owiewki. Zdecydowałem się więc wprowadzić podobną modyfikację do shadera Plexiglass (Rysunek 15.18.18):
Rysunek 15.18.18 Grupa Plexiglass: wprowadzenie przejrzystych odbić
W wnętrzu grupy dodałem węzeł łączący shadery Transparent BSDF i Glossy BSDF 1. Zdecydowałem się podłączyć parametr Reflectivity do nieprzejrzystości odbić. Współczynnik Fresnela „mieszania” shaderów szkła i odbić stał się teraz stały (= 1.45), stąd mogłem zastąpić węzeł Layer Weight węzłem Fresnel (por. str. 1049, Rysunek 15.18.10). Sądzę, że poprawiło to czytelność schematu.
Rysunek 15.18.19 przedstawia porównanie rezultatu dla dwóch różnych przejrzystości odbić (Reflectivity):
Rysunek 15.18.19 Porównanie efektu dla dwóch różnych przejrzystości odbić
Sądzę, że lepsze efekty uzyskamy dla bardziej przejrzystego szkła (Reflectivity = 0.2 — Rysunek 15.18.19b). Przy okazji: zwróć uwagę, że w Cycles nic nie wymaga tylu próbek, co uzyskanie właściwych odbić w szybie! (Każdy z przedstawionych powyżej przykładów wymagał od renderera wykonania od 300 do 500 takich iteracji).
Jako podstawowy shader powierzchni samolotu stosuję grupę, której nadałem nazwę Gloss Paint. To klasyczne połączenie shaderów Diffuse BSDF i Glossy BSDF za pomocą współczynnika Fresnela. Stworzyliśmy je na początku tego rozdziału (por. str. 993 i 996). Na początku tej sekcji wspomnę tylko o pewnym drobnym usprawnieniu, o które warto wzbogacić tę grupę. Rzecz polega na tym, że gdy tylko udział Glossy BSDF jest niezerowy (czyli gdy parametr Reflectivity jest > 0), shader o schemacie jak na str. 996 tworzył na wewnętrznych ścianach siatki odbicie otoczenia (por. str. 302, 303). Dla powierzchni matowych lub półmatowych ten efekt można zminimalizować, podstawiając na ścianach wewnętrznych sam rezultat samego shadera Diffuse BSDF. Na str. 1010 pokazałem to na schemacie, „mieszając” wynik z Glossy Paint z zewnętrznym shaderem, przy użyciu flagi Geometry:Backfacing. Ten sam rezultat można uzyskać wewnątrz samej grupy Gloss Paint, mnożąc współczynnik wagi (Layer Weigth:Fresnel) przez 1 dla ścian zewnętrznych i 0 dla wewnętrznych (Rysunek 15.19.1):
Rysunek 15.19.1 Modyfikacja shadera Gloss Paint — wyłączenie połyskliwości dla wewnętrznej strony ścian siatki
Ściany wewnętrzne są renderowane rzadko — w tym modelu tylko w żebrach skrzydła (Rysunek 15.19.2):
Rysunek 15.19.2 Shader Gloss Paint: działanie przed i po modyfikacji
Ten sam shader pozwala na odwzorowanie najróżniejszych rodzajów poszycia samolotu. Mimo nazwy, za pomocą Glossy Paint możesz uzyskać także efekt powierzchni utrzymanej w naturalnym kolorze metalu (Rysunek 15.19.3):
Rysunek 15.19.3 Powierzchnia jak dla wypolerowanej blachy Alcald
(Dla takich połyskliwych powierzchni istotny jest także obraz otoczenia. Na tej i następnych ilustracjach wykorzystuję panoramę otoczenie World jak na schemacie ze str. 1045, Rysunek 15.17.21). Tak lustrzaną powierzchnię mogły mieć samoloty z produkowanej w USA blachy Alcald, odpowiednio wypolerowane przez obsługę naziemną. (Arkusze Alcald były pokryte cienką warstwą czystego aluminium). Dla mniej zadbanego samolotu użyj nieco większej wartości parametru Roughness — od 0.02 do 0.05 (por. str. 1059).
O ile dla bardzo połyskliwych (Reflectivity = 0.98) powierzchni o barwie decyduje niemal wyłącznie kolor Specular, to po zmniejszeniu połyskliwości do 0.5 — 0.6 możesz uzyskać efekt wyglądający jak błyszczący lakier lub jak połyskliwy plastik. Teraz ważny staje się także kolor Diffuse (Rysunek 15.19.4):
Rysunek 15.19.4 Powierzchnia jak dla połyskliwego lakieru
Samoloty bojowe były zazwyczaj malowane farbami półmatowymi lub matowymi, by zmniejszyć szansę na dostrzeżenie przez przeciwnika. Aby uzyskać taki efekt, zwiększ wartość Roughness do wartości rzędu 0.15 — 0.25. Jednocześnie zastosuj ciemniejszą barwę Diffuse (utrzymuj jej intensywność V pomiędzy 0.05 — 0.01). Zmniejsz także intensywność barwy Specular do poziomu 0.15 — 0.25 (Rysunek 15.19.5):
Rysunek 15.19.5 Półmatowy kamuflaż samolotu bojowego
Wszystkie te zmiany spowodowały pogłębienie cieni na powierzchni samolotu. Stały się już na tyle ciemne, że ujęcie, które pokazuje Rysunek 15.19.5, nie wygląda najlepiej. W tej scenie światło słońca pada na lewą stronę kadłuba. Dlatego po prawej stronie, w cieniu, szczegóły jego powierzchni są mniej wyraźne. (Już nie rozjaśnia ich tak bardzo odbite światło otoczenia — bo zmniejszyliśmy intensywność Specular). Oczywiście, ten sam materiał wygląda inaczej po stronie oświetlonej (Rysunek 15.19.6):
Rysunek 15.19.6 Ten sam materiał od strony oświetlonej światłem słońca
Dla takich półmatowych powierzchni modelu można przywrócić obliczenia kaustyki (wyłączyć opcję Caustics w panelu Light Paths zestawu Render). To rozjaśni nieco wnętrze kabiny pilota, a dla tak „chropowatych” powierzchni Cycles nie będzie już tworzył masy „świetlików”, jak robił na str. 1044, dla połyskliwej powierzchni (Rysunek 15.17.18). W zasadzie kamuflaż po oświetlonej stronie modelu wydaje się nawet trochę zbyt jasny. Tylko wloty do kanałów chłodnicy cieczy są bardzo ciemne. Później przypiszemy im właściwy kolor (były jasnoszare), w wyniku czego przestaną być tak czarne.
Często kamuflaż samolotów był znacznie ciemniejszy, niż ten na poprzednich ilustracjach — chociażby taki „fabrycznie świeży” kolor Olive Drab (Rysunek 15.19.7):
Rysunek 15.19.7 Samolot w kolorze zbliżonym do „fabrycznie nowego” Olive Drab
Barwa Diffuse określa podstawowy kolor powierzchni, a Specular — udział barwy odbitego otoczenia (w scenach w locie — głównie nieba). Dlatego zazwyczaj Specular to jakiś odcień neutralnej szarości.
Sądzę, że po przedstawieniu tych kilku typowych sytuacji będziesz już umiał dobierać właściwe barwy Diffuse i Specular. Wydaje mi się za to, że warto jeszcze pokazać na nieco innym przykładzie, jak „działają” dwa pozostałe parametry: Reflectivity i Roughness. Myślę, że chyba nikt z nas nie oglądał zbyt często odbić otoczenia na powierzchni samolotu w locie. Abyś mógł lepiej ocenić efekt testu, zdecydowałem się umieścić nasz model „na ziemi”, w środowisku, którego odbicia znane są nam na co dzień (Rysunek 15.19.8):
Rysunek 15.19.8 Obraz otoczenia, który wykorzystamy dalej jako środowisko testowe ( www.openfootage.net )
Do dalszych testów, aby wykluczyć wpływ cieni i odblasków słońca, zastosujemy uproszczony model oświetlenia: wyłącznie panorama otoczenia (Rysunek 15.19.9). Zmieniłem także kolor Diffuse powierzchni naszego modelu na jasnoszary (V=0.8), a Specular — na biały (V = 1.0).
Rysunek 15.19.9 Schemat otoczenia, które wykorzystamy do testów
Wpływ zmian współczynnika Reflectivity przedstawiają: Rysunek 15.19.10 (dla powierzchni o wysokim połysku — „srebrnych”) i Rysunek 15.19.11 (dla pozostałych rodzajów powierzchni):
Rysunek 15.19.10 Efekt dla wysokich wartości Reflectivity
Rysunek 15.19.11 Efekt dla niższych wartości Reflectivity
Nawet niewielkie modyfikacje wartości Roughness (w tym przykładzie — o 0.05) powodują znaczące zmiany dla powierzchni o wysokim połysku (Rysunek 15.19.12). Dla pozostałych są nieznaczne (Rysunek 15.19.13):
Rysunek 15.19.12 Efekt dla wysokich wartości Reflectivity
Rysunek 15.19.13 Efekt dla niższych wartości Reflectivity
W miarę zwiększania wartości Roughness powierzchnie “połyskliwe” (Reflectivity = 1) i matowe (Reflectivity = 0) stają się do siebie coraz bardziej podobne. Rysunek 15.19.14 przedstawia sytuację, gdy dla Roughness = 1.0 każda powierzchnia stała się zupełnie matowa:
Rysunek 15.19.14 Wpływ wysokich wartości parametru Rougness na powierzchnię połyskliwą (a) i matową (b)
Gdyby na takiej powierzchni umieścić jakiś czarny obszar, wyglądałby jak plama sadzy. Ten silny wpływ chropowatości na materiał “z połyskiem” wykorzystamy w następnym rozdziale do uzyskania efektów brudu i zakurzenia.
Wartości Reflectivity i Roughness powierzchni modelu można lokalnie modulować za pomocą tekstur, np. w celu uzyskania efektu zużycia lub zabrudzeń
Nie staraj się uzyskać zbyt połyskliwego kamuflażu. W Internecie możesz znaleźć dużo zdjęć różnych rekonstrukcji P-40. Choć przy ich malowaniu zazwyczaj starano się dobrać właściwy odcień farby (o doborze kolorów bazowych — por. str. 1251), to użyty lakier jest z reguły połyskliwy. Ciekawe, czy to efekt zamierzony? (Taka maszyna wygląda ładniej na pokazach…). W każdym razie przy doborze kolorystyki lepiej korzystaj ze zdjęć archiwalnych. W sieci można znaleźć trochę kolorowych zdjęć z tego okresu. Pamiętaj tylko, że wraz z upływem lat te fotografie zrobiły się bardziej niebieskie. Trzeba na to wziąć poprawkę!
Rysunek 15.19.15 Wejście Normal shadera
W Blenderze 2.65 w węzłach shaderów BSDF pojawiło się nowe wejście: Normal. Jest ono przeznaczone do podłączenia alternatywnej mapy nierówności. Do tej pory nierówności powierzchni samolotu można było odwzorować podłączając do „globalnego” wejścia Displacement węzła Material Outpt mapę odcieni szarości. Tworzy to złudzenie drobnych zmian „wysokości” powierzchni (por. str. 325). Wejście Normal pozwala uzyskać jeszcze silniejszy efekt, gdyż możesz podać na wejściu współrzędne wektorów prostopadłych do powierzchni. (Zazwyczaj jest to specjalnie przygotowana tekstura, której wartość R, G, B barwy piksela są interpretowane jako współrzędne X, Y, Z wektora normalnego. Często tworzy się ją operacją Bake z odpowiednio przygotowanego, bardzo szczegółowego modelu). W ten sposób można dobrze odwzorować, nawet w zbliżeniach, np. nierówności odlewanych pancerzy czołgów czy spawy na krawędziach ich płyt.
Abyś mógł użyć wejścia Normal, stworzyłem kopię Gloss Paint wzbogaconą o ten element (Rysunek 15.19.16):
Rysunek 15.19.16 Zmodyfikowana wersja shadera (Opaque Surface)
Nazwałem tę grupę Opaque Surface. Stosuj ją wszędzie tam, gdzie masz jakąś mapę normalnych do podłączenia. Pamiętaj tylko, aby zawsze do wejścia Normal było coś podłączone — odpowiednikiem informacji domyślnej jest Geometry:Normal (Rysunek 15.19.17):
Rysunek 15.19.17 Zmodyfikowany shader Gloss Paint
Taka konieczność podłączania kolejnego węzła to zawsze dodatkowy element komplikujący schemat. Dlatego shader Gloss Paint pozostał, abyś mógł go używać wszędzie tam, gdzie nie potrzebujemy map normalnych (a tak jest w większości materiałów). We wnętrzu tej grupy umieściłem teraz shader Opaque Surface z podłączonymi domyślnymi kierunkami normalnych (Rysunek 15.19.17).
Wartości, którymi operujemy na schematach Cycles, są zazwyczaj w przedziale od 0.0 do 1.0. Na przykład: liczbami z tego przedziału są intensywności poszczególnych komponentów barwy (RGBA — por. str. 1246). Także współrzędne tekstur (dane typu Vector) to wartości od 0 do 1 (współrzędne UV — por. str. 1109). W zasadzie autorzy Cycles starali się zbudować podstawowe węzły tak, by każdy z ich parametrów miał zakres od 0.0 do 1.0. Nawet funkcja Fresnela, normalnie zależąca od IOR materiału, została w ten sposób sparametryzowana w węźle Layer Weight (por. str. 1001).
W tej sekcji przedstawię trochę pomocniczych grup węzłów, obsługujących różne powtarzające się na schematach operacje arytmetyczne na liczbach rzeczywistych od 0.0 do 1.0. Ich działanie zademonstruję, przekształcając monochromatyczne obrazy testowe1.
Węzła Moderate używam do „łagodzenia” działania tekstur nierówności (Rysunek 15.20.1):
Rysunek 15.20.1 Działanie węzła Moderate
Gdy Moderate:Range = 1.0, węzeł zwraca bez zmian obraz wejściowy. Zmniejszenie wartości Range powoduje rozjaśnienie ciemniejszych miejsc obrazu. Wewnętrznie grupa Moderate wykorzystuje węzeł Color:Mix (Rysunek 15.20.2). Ten węzeł „miesza” otrzymane wartości tak, jak gdyby były kolorami (por. str. 1246).
Rysunek 15.20.2 Budowa węzła Moderate
Pole Value, do którego podłączamy obraz tekstury, jest traktowane jako współczynnik udziału (Mix:Fac) barw Color2 i Color1 2. Dla czarnych pikseli tekstury (Value = 0) węzeł zwraca piksel o odcieniu szarości podstawionym jako Color1, a dla białych (Value = 1.0) — biały Color2. Jeżeli podstawimy pod Mix:Color1 czerń — otrzymamy na wyjściu obraz wejściowy, bez żadnych zmian. Jeżeli jednak rozjaśnimy tę barwę — otrzymamy na wyjściu obraz w której oryginalnej czerni będzie odpowiadał szary z Mix:Color1. W rezultacie zakres intensywności występujących w obrazie ulegnie „spłaszczeniu”, zachowując bez zmian białe piksele. Aby lepiej uświadomić użytkownikowi, czym operuje, obliczam odcień szarości dla Mix:Color1 jako „1 – Range” (za pomocą węzła Invert). Dzięki temu wartość parametru Range określa zakres intensywności w obrazie wyjściowym (Range = 1.0 podstawia pod Mix:Color1 czerń, a Range = 0.4 — szary, o V = 0.6).
O ile Moderate pozwalał tylko na rozjaśnienie obrazu, to jego rozbudowana wersja — węzeł Range To Max — pozwala także na zmniejszenie jasności obrazu. Rysunek 15.20.3 przedstawia trzy różne ustawienia tego węzła na tle uzyskiwanych rezultatów:
Rysunek 15.20.3 Działanie węzła Range To Max
Rysunek 15.20.3a) to ustawienie neutralne — dla wartości Range = 1 i Max = 1 węzeł Range To Max zwraca bez żadnych zmian obraz wejściowy. Parametr Max określa jasność odpowiadającą białym pikselom obrazu wejściowego. Jeżeli ulegnie zmniejszeniu — rezultat będzie odpowiednio przyciemniony (Rysunek 15.20.3b).
Do rozjaśniania najciemniejszych pikseli służy, tak jak w węźle Moderate, parametr Range. Jednak tutaj jego wartość określa względny % spektrum od 0 do Max. Odcień szarości Mix:Color1 jest tu określany ze wzoru: Max*(1-Range). Dlatego najciemniejszy odcień na obrazie przedstawionym przez Rysunek 15.20.3c) ma intensywność V = 0.7 * (1 – 0.3) = 0.49. Może to nie jest zupełnie intuicyjne, ale bezpieczne3.
Rysunek 15.20.4 przedstawia wewnętrzną strukturę węzła Range To Max:
Rysunek 15.20.4 Budowa węzła Range To Max
Węzeł Range To Max najwygodniej używa się z obrazami o białym tle, które służą do lokalnego zmniejszania jakiejś wartości bazowej. (Ustawiasz wówczas tę wartość bazową jako Max, a parametrem Range regulujesz intensywność lokalnych zmniejszeń).
Aby obsłużyć sytuację odwrotną: obrazu o czarnym tle, który służy do lokalnego zwiększenia jakiejś wartości, przygotowałem węzeł Range From Min (Rysunek 15.20.5):
Rysunek 15.20.5 Działanie węzła Range From Min
Rysunek 15.20.5a) przedstawia sytuację neutralną — dla wartości Min = 0.0 i Range = 1.0 węzeł Range From Min zwraca bez żadnych zmian obraz wejściowy. Parametr Min określa jasność odpowiadającą czarnym pikselom obrazu wejściowego. Jeżeli ulegnie zwiększeniu — rezultat będzie odpowiednio rozjaśniony (Rysunek 15.20.5b). Parametr Range tu także określa % względnego spektrum od Min do 1.0 (Mix:Color2 = Min + (1-Min)*Range). Dlatego dla parametrów jakie pokazuje Rysunek 15.20.5c) białym polom obrazu wejściowego odpowiada kolor szary o V = 0.3 + (1-0.3)*0.4 = 0.58.
Rysunek 15.20.6 przedstawia wewnętrzną strukturę grupy Range From Min:
Rysunek 15.20.6 Budowa węzła Range From Min
Węzeł Stack Image służy do nałożenia jednej tekstury na drugą, tak jak się nakładają na siebie warstwy w Inkscape lub GIMP (Rysunek 15.20.7):
Rysunek 15.20.7 Działanie węzła Stack Image
Podobnie jak w tych programach rysunkowych, do łączenia obydwu barw wykorzystywana jest nieprzejrzystość (komponent Alpha) pikseli nakładanego obrazu (por. str. 1246). Stąd zazwyczaj nakładana tekstura ma przejrzyste tło — tak jak decals.png na ilustracji powyżej. Należy ją podłączyć do wejść Color i Alpha węzła Stack Image. Obraz tła powinien być nieprzejrzysty — przynajmniej w obszarach, które będą nałożone na powierzchnię modelu. Podłączasz go do wejścia Stack Image:Background (w naszym przykładzie jest to tekstura color.png). Stack Image ma dodatkową kontrolkę Opacity. Używaj jej do sterowania nieprzejrzystością nakładanej warstwy (tak samo jak sterujesz nieprzejrzystością warstw w GIMP lub Inkscape). Wyjściem z węzła Stack Image jest obraz tekstury, który możesz normalnie podłączyć do innego wejścia — na przykład barwy shadera. Wykorzystując węzły Stack Image możesz także zbudować „stos” obrazów tekstur — wystarczy podłączać rezultat z węzła leżącego „poniżej” do wejścia Background następnego („wyższego”) węzła Stack Image. W porównaniu ze „stosem” warstw w GIMP czy Inkscape scalonych w jedną teksturę, to rozwiązanie pozwala łączyć w Blenderze obrazy tekstur nakładanych z różnymi alternatywnymi rozwinięciami UV.
Rysunek 15.20.8 przedstawia wewnętrzną strukturę grupy Stack Image:
Rysunek 15.20.8 Budowa węzła Stack Image
Właściwe “mieszanie” barw łączonych tekstur odbywa się tu w węźle Color→Mix (z ustawioną domyślną operacją Mix). Wagą tego łączenia jest przejrzystość (Alpha) “górnego obrazu”. Dodałem tu jeszcze pomocniczy węzeł Multiply, który służy do ewentualnego osłabienia przejrzystości nakładanej tekstury.
Jak właściwie używać alternatywnych map UV? W tym celu należy w Cycles użyć węzła Attribute. Abyś dobrze zrozumiał, jak to działa, przygotowałem przykładową scenę złożoną z trzech sześcianów (Rysunek 15.21.1a):
Rysunek 15.21.1 Rozwinięcia sześcianów na przykładowej scenie
Każdy z sześcianów posiada identyczne rozwinięcie ścian o nazwie UVMap (Rysunek 15.21.1b). Jest to domyślna mapa UV ich siatek. (O tym, co to znaczy „domyślna” i w jaki sposób włączać to oznaczenie — por. str. 950). Oprócz tego sześcian lewy i prawy mają alternatywne rozwinięcia UV, o nazwach Left (Rysunek 15.21.1d) i Right (Rysunek 15.21.1c).
Rysunek 15.21.2a) przedstawia materiał sześcianów, a Rysunek 15.21.2b) — ich testowy render:
Rysunek 15.21.2 Render sceny z użyciem domyślnego mapowania UV
Aby odwołać się do alternatywnego rozwinięcia UV, należy w Cycles użyć węzła Attribute. Wstaw go na miejsce węzła Texture Coordinate. W pole Attribute:Name wpisz nazwę mapy UV, którą chcesz wykorzystać (Rysunek 15.21.3a):
Rysunek 15.21.3 Wykorzystanie węzła Attribute w celu użycia innego rozwinięcia UV
Rezultat przedstawia Rysunek 15.21.3b). Tekstura pojawiła się tylko na siatce, która posiada rozwinięcie UV o podanej nazwie (w tym przypadku — Left). Siatki bez tego rozwinięcia są jednolicie szare.
Starszy renderer Blendera (BI) wykorzystałby do pokrycia sześcianów bez mapy Left domyślne współrzędne UV (w tym przypadku — UVMap). BI pokryłby te siatki teksturą w taki sam sposób, w jaki pokazuje je Rysunek 15.21.2b). Ten efekt (po angielsku określany jako fallback) pozwolił mi w pierwszej edycji książki przygotować alternatywne rozwinięcia UV tylko w tych siatkach, w których było to potrzebne. (Używałem wtedy BI, bo Cycles jeszcze nie istniał). Taki efekt wykorzystania domyślnych mapowań UV oszczędził mi sporo pracy. Cycles jednak tak nie działa. Czy można na to coś poradzić?
W takiej sytuacji zawsze próbuję szukać jakiegoś rozwiązania, sprawdzając rezultaty innych wyjść z badanego węzła. W tym przypadku sprawdziłem, co zwraca współczynnik Attribute: Fac (Rysunek 15.21.4):
Rysunek 15.21.4 Sprawdzanie wartości Attribute:Fac
Zwracane przez węzły wartości skalarne można szybko sprawdzić, podłączając je bezpośrednio do koloru shadera materiału. W tym przypadku podłączyłem wyjście Attribute:Fac do wejścia Color shadera Diffuse (Rysunek 15.21.4a,b). Gdy w węźle Attribute jest wpisana nazwa (Name) Left, cała powierzchnia lewego sześcianu (tj. siatki zawierającej rozwinięcie Left) jest szara, a pozostałe sześciany — czarne (Rysunek 15.21.4c). Gdy zmienisz w węźle Attribute nazwę na Right, szary stanie się prawy sześcian (bo posiada rozwinięcie UV o tej samej nazwie). Pozostałe sześciany znów będą czarne (Rysunek 15.21.4d). Na tej podstawie można wnioskować, że:
Attribute: Fac dla siatki zawierającej żądane rozwinięcie UV zwraca wartość 0.5, a dla pozostałych — 0.0
Taka reguła pozwala nam zbudować odpowiedni zespół węzłów, który podstawi domyślne współrzędne UV dla każdej siatki bez mapy UV o żądanej nazwie1. Aby przekształcić wartości uzyskiwane z Attribute:Fac dla siatki posiadającej mapę UV z 0.5 na 1.0, używam węzła Math:Greater Then (Rysunek 15.21.5a):
Rysunek 15.21.5 Dodatkowe węzły, uzupełniające brakujące współrzędne tekstury wartościami domyślnymi
(Nie mnożę ich np. przez 2, bo nie jestem pewien, czy zwracana wartość to dokładnie 0.5. Używając porównania „> 0” mniej ryzykuję). Jako „przełącznika” współrzędnych tekstur użyłem węzła Color:Mix 2 (Cycles nie zawiera wyspecjalizowanego węzła do łączenia danych typu Vector). Współrzędne z wejścia Color1 będą użyte, gdy Attribute:Fac zwróci wartość = 0 (brak żądanej mapy UV). Powinny być wówczas użyte wartości domyślne, więc podłączyłem w to miejsce węzeł Texture Coordinate, który je dostarcza. Współrzędne z wejścia Color2 będą użyte, gdy siatka zawiera żądaną mapę (Mix:Fac = 1.0), stąd podłączyłem w to miejsce wyjście w węzła Attribute. Udało mi się w ten sposób uzyskać pożądany rezultat — sześciany, które poprzednio były czarne, teraz są pokryte teksturą (Rysunek 15.21.5b).
Tak pożyteczny zespół węzłów warto jest połączyć w grupę, by zwiększyć przejrzystość schematów materiałów. Przygotowałem taki węzeł, i nadałem mu nazwę UV Fallback (Rysunek 15.21.6):
Rysunek 15.21.6 Wykorzystanie grupy UV Fallback do uzupełniania brakujących współrzędnych tekstur
Użycie jest proste: obydwa wejścia należy podłączyć do węzła atrybutu, a wyjście — do współrzędnych tekstur. Grupy UV Fallback będę używał wszędzie tam, gdzie wykorzystuję alternatywne mapowania UV.
W Blenderze 2.7 dodano wyspecjalizownay węzeł wejściowy UV Map. Pozwala wygodniej wybierać jedną z dostępnych map UV. Zwraca to samo co węzeł Attribute, ale ma tylko jedno wyjście: Vector.
Teksturę Wave możesz wykorzystać gdy potrzebujesz jakiegoś wzoru pasków lub pierścieni. Podobnie jak inne węzły tekstur dodajesz ją do schematu poleceniem Add→Texture→Wave Texture. Bezpośrednio po wstawieniu węzeł jest ustawiony na generowanie pasków (Bands) pochylonych pod kątem 45º (Rysunek 15.24.1):
Rysunek 15.22.1 Węzeł Wave Texture i jego domyślmy rezultat (paski — Bands)
Aby zmienić kierunek pasków, podłącz do wejścia Vector połączone węzły Texture Coordiante i Mapping. Następnie w węźle Mapping ustaw odpowiedni obrót (jak na str. 1028).
Gdy przełączysz węzeł w tryb Rings, uzyskasz wzór koncentrycznych okręgów (Rysunek 15.22.2):
Rysunek 15.22.2 Okręgi, wygenerowane w trybie Rings
Aby zobaczyć ich więcej, możesz zwiększyć skalę (Scale) tekstury — to zagęszcza paski (Rysunek 15.22.3):
Rysunek 15.22.3 Zagęszczenie wzoru poprzez zwiększenie skali obrazu
Aby wprowadzić do uzyskanych pasków losowe zaburzenia, zwiększ parametr Distortion (Rysunek 15.22.4):
Rysunek 15.22.4 Wprowadzanie do wzoru pasków losowych zaburzeń
Postać tych zaburzeń można regulować zmieniając parametr Detail (Rysunek 15.22.5):
Rysunek 15.22.5 Uproszczenie kształtu zaburzeń pasków
Znacznie większy wpływ na kształt zaburzeń ma parametr Detail Scale. Gdy go zmniejszysz, deformacje ulegną wydłużeniu (Rysunek 15.22.6):
Rysunek 15.22.6 Wydłużenie deformacji pasków tekstury
Dla każdego piksela renderowanej powierzchni można podać wiele alternatywnych współrzędnych tekstur. Każda z nich jest liczona inną metodą. W Cycles ich źródłem jest węzeł Texture Corrdinate, dodawany do schematu poleceniem Add→Input→Texture Coordinate (Rysunek 15.23.1):
Rysunek 15.23.1 Węzeł Texture Coordinate
Texture Coordinate jest węzłem wejściowym, podobnie jak węzły Geometry czy Light Path. Każde z jego wyjść udostępnia inny rodzaj współrzędnych tekstury. Niektóre z nich są używane dość rzadko: na przykład współrzędne aktualnego okna — Window — możesz wykorzystać do podstawienia za modelem jakiegoś zdjęcia (por. str. 1033). Dopilnuj tylko, by obszar tego obrazu tła i okna renderu miał takie same proporcje wysokości i szerokości. Inaczej będzie na renderze zdeformowany! W podobnym celu możesz wykorzystać współrzędne aktualnego piksela wyrażone w lokalnym układzie współrzędnych kamery (Camera — por. str. 1034). W praktyce nigdy nie potrzebowałem wykorzystywać mapowania Reflection — musisz z nim sam poeksperymentować. Te wszystkie trzy rodzaje współrzędnych wiążą obraz z globalnym układem współrzędnych sceny. Tekstura zamapowana za pomocą wyjść Window, Camera lub Reflection zmienia swoje położenia na obiekcie „podążając” za obserwatorem.
Pozostałe rodzaje mapowań wiążą obraz tekstury z układem współrzędnych obiektu.
Wyjście UV zwraca współrzędne domyślnej mapy UV, przypisanej do siatki (czyli tej, która jest oznaczona jako „dla renderowania” — por. str. 1066). Pamiętaj jednak, że najpierw sam je musisz stworzyć. W Blenderze siatki nie posiadają żadnego „domyślnego” rozwinięcia.
Aby pokazać działanie pozostałych mapowań: Generated, Object i Normal, posłużę się prostą teksturą pasków pochylonych pod kątem 45º. (Jest to domyślny efekt działania tekstury proceduralnej Wave). Rysunek 15.23.2 przedstawia schemat testowego materiału i obraz, który tworzy na płaskiej powierzchni:
Rysunek 15.23.2 Tekstura, której użyjemy w przykładach: Wave
Ja widać, tekstura Wave jest wstawiona z domyślnymi parametrami: wzorem Bands i skalą (Scale) = 2.
Aby wyznaczyć współrzędne Generated, Blender tworzy robocze „pudełko” obejmujące całą siatkę i zorientowane tak jak lokalny układ współrzędnych obiektu. Niezależnie od proporcji uzyskanego w ten sposób prostopadłościanu, współrzędne w każdym z kierunków zmieniają się w zakresie od 0.0 do 1.0 (Rysunek 15.23.3):
Rysunek 15.23.3 Mapowanie Generated
W efekcie gdy obiekt ma podłużny kształt, obraz tekstury nałożony w trybie Generated ulega rozciągnięciu.
Aby zachować proporcje obrazu, użyj lokalnych współrzędnych obiektu — czyli danych z wyjścia Object (Rysunek 15.23.4):
Rysunek 15.23.4 Mapowanie Object
W tym trybie cały obraz tekstury ma domyślny rozmiar 1x1 jednostki Blendera. Oczywiście, możesz zmienić jego wielkość za pomocą dodatkowego węzła Mapping (por. str. 1018). Jeżeli powierzchnia obiektu jest większa od obrazu — Blender powieli go (tak jak pola na szachownicy).
Wreszcie mapowanie wykorzystujące aktualny kierunek prostopadły do powierzchni: Normal (Rysunek 15.23.5):
Rysunek 15.23.5 Mapowanie Normal
Wykorzystanie tych współrzędnych do nałożenia tekstury pasków na domyślny sześcian nie tworzy żadnego szczególnego efektu — każda ze ścian ma jednolitą barwę. Dlaczego? Bo każdy piksel tych ścian ma taki sam kierunek wektora normalnego (to tryb Shade Flat — por. str. 974). Stąd na każdą z nich jest nałożony pojedynczy piksel obrazu tekstury!
Rysunek 15.23.6 pokazuje, co się stanie gdy siatkę cieniowaną w trybie Shade Flat zaczniesz zwiększać liczbę ścian tak, by każda była pochylona pod innym kątem (np. za pomocą modyfikatora Subdivision Surface):
Rysunek 15.23.6 Mapowanie pasków w trybie Normal (dla Shade Flat)
Po lewej widzimy zwykły sześcian przed podziałem — każda z jego ścian ma jednolity kolor (Rysunek 15.23.6a). Gdy zwiększymy liczbę podziałów do 2 (Rysunek 15.23.6b), każdy z podstawowych trójkątów na jaki Blender dzieli tę siatkę ma nadal stały kolor. Barwy sąsiednich ścian różnią się między sobą. Po kolejnych podziałach zaczniesz dostrzegać na wygładzonej powierzchni siatki wzór pasków (Rysunek 15.23.6c).
Ten wzór jest od razu widoczny, nawet dla sześcianu, gdy kierunki normalne do siatki są interpolowane pomiędzy wierzchołkami w trybie Shade Smooth (Rysunek 15.23.7a)1:
Rysunek 15.23.7 Mapowanie obrazu pasków w trybie Normal (dla Shade Smooth)
Dla większej liczby ścian dla obydwu trybów wygładzania — Shade Flat i Shade Smooth uzyskujemy bardzo podobny obraz (por. Rysunek 15.23.7b i Rysunek 15.23.6c).
Węzeł Color Ramp zwraca dla podanych wartości współczynnika Fac (0.0...1.0) odpowiedni kolor ze swojego paska spektrum barw. Możesz go dodać do schematu poleceniem Add→Convertor→Color Ramp (Rysunek 15.24.1):
Rysunek 15.24.1 Węzeł Color Ramp
Ten efekt możesz wykorzystać do modyfikacji tekstur proceduralnych — na przykład zmiany domyślnej barwy tekstury pasków (Wave: Rysunek 15.24.2):
Rysunek 15.24.2 Zmiana barwy tekstury pasków za pomocą węzła Color Ramp
Aby zwiększyć szerokość pasków na obiekcie, złap (LPM) za czerwony węzeł paska barw i przesuń go w prawo (Rysunek 15.24.3):
Rysunek 15.24.3 Zmiana szerokości pasków poprzez zmianę położenia węzła barwy
Aby uzyskać ostrą granicę pasków, możesz zmienić funkcję interpolującą na Constant (Rysunek 15.24.4):
Rysunek 15.24.4 Uzyskanie ostrej granicy pasków poprzez zmianę interpolacji braw (na Constant)
Przyciskiem Add („+”) możesz dodać do paska kolejny punk węzłowy. Automatycznie po dodaniu węzeł staje się aktywny. Możesz np. zmienić jego barwę na niebieską, aby dodać do wzoru kolejny pasek (Rysunek 15.24.5):
Rysunek 15.24.5 Dodanie do paska kolejnego węzła
Węzeł aktywny, dla którego barwę wyświetla kontrolka powyżej, możesz wybrać kliknięciem LPM. Aby usunąć węzeł aktywny, użyj przycisku Delete („-”).
Color Ramp zawiera także drobne udogodnienie: przycisk inwersji barw, odwracający kolejność kolorów na pasku (Rysunek 15.24.6):
Rysunek 15.24.6 Inwersja paska barw
Węzły z krzywymi służą do przekształcenia wartości wejściowych według jakiejś określonej reguły (matematycy nazwaliby ją funkcją). Działanie takiej krzywej ilustruje Rysunek 15.25.1.
Wartości wejściowe są zaznaczane na osi poziomej (X). W tym przykładzie jest to wartość 0.7. Takiej wartości X odpowiada na przedstawionej krzywej wartość Y = 0.55. To rezultat, który zwraca węzeł. Krzywe mapują wartości od 0 do 1, i ich rezultat leży w tym samym zakresie.
W Blenderze węzły krzywych można spotkać w każdym kontekście: tekstur (RGB Curves) , kompozycji (RGB Curves), a w materiałach Cycles są nawet dwa (RGB Curves i Vector Curves). Co ciekawe, każdy z nich służy do modyfikacji wartości „wektorowej”: współrzędnych wektorów normalnych (Vector Curves) czy barwy (RGB Curves). Rysunek 15.25.2 przedstawia węzeł RGB Curves z edytora materiałów Cycles (dodany poleceniem Add→Color→RGB Curves):
Rysunek 15.25.2 Węzeł RGB Curve
Krzywa w środku węzła to krzywa Beziera. Domyślnie to linia prosta, rozciągnięta pomiędzy punktem początkowym i końcowym. Kliknij w jej środek, aby dodać kolejny punkt, i przesuń go, aby uzyskać wygięcie. Menu, które można rozwinąć po kliknięciu w ikonę , zawiera kilka dalszych opcji dla punktów krzywej (Rysunek 15.25.3):
Rysunek 15.25.3 Menu węzła RGB Curve
Każdy nowy węzeł Curve dodany do schematu jest neutralny: ma krzywą ustawioną na proste kopiowanie obrazu wejściowego w wyjściowy. To linia prosta, od punktu (0,0) do punktu (1,1) (Rysunek 15.25.4).
Gdy przesuniesz początek tej linii nieco wyżej — rozjaśnisz najciemniejsze miejsca obrazu (tak jak standardowa funkcja Lighten — por. Rysunek 15.25.5a). Gdy skierujesz taką linie z punktu (0,1) do (1,0) — uzyskasz rewers barw (Invert, Rysunek 15.25.5b). Innym efektem jest zmniejszenie kontrastu obrazu. Można to robić na wiele sposobów — Rysunek 15.25.5c) przedstawia jeden z nich (to nieliniowe zmniejszenie kontrastu).
Wreszcie czasami możesz potrzebować wyostrzenia krawędzi rozmytych barw. Możesz wtedy przestawić wewnętrzne wierzchołki w tryb Vector Handle (wybierz to polecenie z menu — por. Rysunek 15.25.3), a potem ustaw je tak, jak pokazuje to Rysunek 15.25.5d).
Rysunek 15.25.5 Przykłady typowych przekształceń obrazu wejściowego
Przedstawione powyżej przykłady wykorzystywały krzywą Composite, przekształcając obrazy monochromatyczne. Oczywiście, możesz wykorzystać węzeł RGB Curves do koloryzacji. W tym celu należy zmienić krzywe poszczególnych kanałów R, G, B.
Rysunek 15.25.6 przedstawia przykład modyfikacji kanału barwy czerwonej (Red). Im bardziej krzywa oddala się od przekątnej obszaru, tym silniejszy jest uzyskany efekt. Zwiekszenie intensywności komponentu R zabarwia obraz wynikowy na czerwono. Zmniejszenie intensywności tego składnika tworzy obszar błękitu.
Podobne efekty można uzyskiwać także za pomocą węzła spektrum barw (Color Ramp — por. str. 1074). Jednak węzeł Curve, choć czasem trudniejszy w obsłudze, pozwala uzyskać bardziej złożone transformacje.
Zazwyczaj każdy element ma zróżnicowaną powierzchnię na której są losowo rozłożone ciemniejsze i jaśniejsze obszary. Na niektórych materiałach te różnice odcieni, połyskliwości i szorstkości są ledwo widoczne. Na innych — widać je wyraźnie. Zazwyczaj jest to efekt pokrycia samolotu cienką warstwą kurzu i innych zanieczyszczeń. Odtworzymy go w tej sekcji za pomocą paru tekstur proceduralnych.
Teksturę najwygodniej jest sprawdzać na najprostszym, białym materiale testowym. Na początek nałóżmy tu zwykły obraz typu Noise Texture, zamapowany w trybie Texture Coordinate:Object (Rysunek 15.26.1a):
Rysunek 15.26.1 Pierwsza wersja materiału testowego
Rysunek 15.26.1b) przedstawia rezultat. Jak widać, cętki tekstury znikają na mocno naświetlonych powierzchniach. Aby je podkreślić, dodaj do schematu węzeł Color Ramp (Rysunek 15.26.2):
Rysunek 15.26.2 Wzmocnienie obrazu za pomocą węzła Color Ramp
Teraz dodaj drugi obraz — „ziarnistej” tekstury Voronoi, i połącz ją z pierwszym (Multiply — Rysunek 15.26.3):
Rysunek 15.26.3 Dodanie tekstury „ziarnistości”
Oprócz bezkierunkowego wzoru, który poka zuje Rysunek 15.26.3b), czasami przydaje się dodać do szumu jakieś elementy o jednolitym kierunku. W tym celu używam kolejnej tekstury — Musgrave, zamapowanej we współrzędnych Normal (tzn. w kierunku prostopadłym do powierzchni). Ten rodzaj współrzędnych zamienia każdą teksturę proceduralną w paski. (Odstępny pomiędzy paskami i ich barwa zależą wyłącznie od rozmieszczenia i proporcji ciemnych i jasnych plam na oryginalnym obrazie. Dlatego wybrałem teksturę Musgrave: Multifractal, bo tworzy duże, jasne odstępy).
Rysunek 15.26.4a) przedstawia schemat testowego obrazu. Zwróć uwagę na użycie w tym miejscu węzła Color Ramp. Służy tu do rozjaśnienia obrazu na obiekcie (aby te paski dobrze się komponowały z szumem bezkierunkowym w węźle Multiple). Rysunek 15.26.4b) pokazuje uzyskany obraz, zamapowany na obiekcie:
Rysunek 15.26.4 Drugi obraz — szum skierowany
Teraz połącz ze sobą (w kolejnym węźle Multiply) przygotowany wcześniej szum bezkierunkowy (Rysunek 15.26.3b) z przygotowanym w ten sposób szumem skierowanym (Rysunek 15.26.5b):
Rysunek 15.26.5 Złożenie dwóch szumów
(Specjalnie wybrałem najjaśniejszą wersję tekstury Musgrave na obraz kierunkowy, aby nie powodować dalszego zaciemnienia otrzymanego obrazu).
Taki zespół węzłów będziemy używać w charakterze „szumu bazowego” w wielu materiałach. Stąd proponuję „spakować” je w bardziej poręczną grupę (Rysunek 15.26.6):
Rysunek 15.26.6 Gotowy komponent — zawartość (a) i wygląd zewnętrzny (b)
Rysunek 15.26.6a) przedstawia schemat tej tekstury, a Rysunek 15.26.6b) — jej postać zewnętrzną. Nazwałem ją X.Random.Dirt i jest wykorzystywana w wielu materiałach. Oprócz właściwego obrazu, udostępnionego na wyjściu Fac, dodałem do tego węzła drugi punkt wyjściowy: Displacement. Ten współczynnik to sama tekstura Voronoi — jeżeli chcesz, możesz ten punkt podłączyć do wejścia Material Output:Displacement. Uzyskasz w ten sposób efekt drobnych chropowatości powierzchni.
Pierwszy parametr grupy X.Random Dirt — Scale — pozwala regulować rozmiar uzyskanego „szumu” . Drugi — Directed Noise — zmienia obraz użytego szumu kierunkowego. Wartość = 0 oznacza wyłączenie tego komponentu. Wyższe wartości tego parametru zwiększają liczbę „pasków” (Rysunek 15.26.7):
Rysunek 15.26.7 Wpływ parametru Directed Noise
Komponent X.Random.Dirt wykorzystuję w różnych materiałach powierzchni wewnętrznych (B.Skin.Inner) oraz detalach modelu (np. B.Steel.Rough). Rysunek 15.26.8 przedstawia fragment ogona, w którym wykorzystujemy obydwa materiały:
Rysunek 15.26.8 Wykorzystanie tekstury X.Random.Dirt w materiałach
Użycie komponentu X.Random.Dirt w schemacie materiału B.Skin.Inner przedstawia Rysunek 15.26.9a):
Rysunek 15.26.9 Przykład wykorzystania tekstury — schemat B.Skin.Inner
Jak widać, pojedyncze wyjście Fac z tekstury X.Random Dirt jest rozdzielone na rożne węzły regulujące, których rezultaty zmieniają połyskliwość i chropowatość shadera Glossy Paint. Aby nie tworzyć za każdym razem kolumny takich kontrolek, scaliłem te wszystkie parametry w jedną grupę. Nadałem jej nazwę X.Pattern.Adaptor. Grupuje pary wartości (Min lub Max i Range) dla poszczególnych wyjść: Diffuse, Specular, Roughness, Reflectivity. Te wyjścia podłącz do odpowiednich wejść Gloss Paint.
Grupy X.Pattern.Adaptor opłaca się używać do rozdzielenia sygnał z pojedynczej tekstury na trzy lub więcej kanały o różnej intensywności.
Materiał powierzchni zewnętrznych (B.Skin.Camouflage) przygotowany tak jak to zrobiliśmy w poprzednim rozdziale (por. str. 468), tworzy duże, jednorodne odbicia światła (Rysunek 15.26.10):
Rysunek 15.26.10 Odbicie światła na okapotowaniu silnia (materiał B.Skin.Camouflage jak do tej pory)
W zbliżeniu to wygląda trochę sztucznie: trzeba ten efekt “złamać” za pomocą drobnych niejednorodności w połyskliwości powierzchni (Rysunek 15.26.11):
Rysunek 15.26.11 Odbicie światła „złamane” za pomocą tekstury
Taki efekt można uzyskać podstawiając do schematu materiału B.Skin.Camofulage dodatkową teksturę losowych zabrudzeń. To tekstura proceduralna, modulująca obraz połyskliwości (Specular Image) i intensywność odbijania światła (Reflectivity — por. Rysunek 15.26.12):
Rysunek 15.26.12 Modyfikacja schematu materiału B.Skin.Camouflage
Choć nazwałem ramkę widoczną na schemacie Random Dirt, to kształt plam generowanych przez komponent X.Random.Dirt niezbyt w tym miejscu pasuje. W dodatku jest bardzo kosztowny podczas renderowania. Dlatego przygotowałem do takich zastosowań inną grupę, o nazwie General Noise (Rysunek 15.26.12).
Grupa General Noise to złożenie rezultatów generowanych przez dwa węzły Noise Texture. Każdy z nich ma inne ustawienia (skalę, poziom detalu — Rysunek 15.26.13):
Rysunek 15.26.13 Alternatywny „szum” — grupa General Noise
Rysunek 15.26.14 przedstawia rezultat generowany przez tę grupę (włączoną na pełną intensywność):
Rysunek 15.26.14 Rezultat generowany przez General Noise
Efekt wygląda na bardzo silny, ale to dobrze — dużą moc zawsze można zmniejszyć, gorzej jest gdy jej brakuje. Aby stworzyć wrażenie drobnych nieregularności, General Noise użyte w materiale B.Skin.Camouflage jest ustawione na 30% swojej intensywności. Dodatkowo ta wartość ulega dalszemu osłabieniu w grupach sterujących obrazem odbić (Specular Image) i skalą połyskliwości (Reflectivity). Pokazuje to Rysunek 15.26.15:
Rysunek 15.26.15 Szczegóły użycia tekstury General Noise w materiale B.Skin.Camouflage
Efekt tych ustawień na modelu pokazuje Rysunek 15.26.11. Czas renderowania wydłużył się o 20%.
Materiału, który wygląda jak stal, będziemy potrzebować do wykonania różnych drobnych detali samolotu. W zasadzie może to być prosty materiał oparty o dobrze nam znany shader Gloss Paint (Rysunek 15.27.1):
Rysunek 15.27.1 Najprostsza wersja: szary materiał o umiarkowanej połyskliwości
Nazwijmy ten materiał B.Steel.Smooth.
Co prawda istnieje fragment modelu, który wymaga specjalnego traktowania: jest to powierzchnia robocza tłoka amortyzatora. Podobne element możesz napotkać w różnego rodzaju siłownikach. Można je zobaczyć na co dzień w wielu miejscach — na przykład różnych dźwigach czy podnośnikach. Zauważ, że część tłoka która wsuwa się w cylinder jest w nich bardzo gładka. Jej powierzchnia przypomina lekko zamglone lustro.
Aby odtworzyć ten efekt stworzymy oddzielny materiał – B.Steel.Mirror (Rysunek 15.27.2):
Rysunek 15.27.2 Specjalny materiał dla powierzchni pracującej tłoka amortyzatora
W tym materiale zmniejszyłem szorstkość powierzchni (Roughness) do 0.005 i zwiększyłem jej połyskliwość (Reflectivity) do 0.9.
Innym specyficznym fragmentem wykonanym ze stali są plecione linki, wykorzystywane m.in. w cięgnach kółka ogonowego. Odwzorujemy je za pomocą tekstury nierówności. Wykorzystamy w tym celu teksturę Wave:Bands (por. str. 1076). Wystarczy tylko ją trochę rozciągnąć i zwiększyć liczbę pasków (Rysunek 15.27.3):
Rysunek 15.27.3 Dopasowanie tekstury pasków do cięgna
Zaczynamy więc od materiału testowego: składa się ze zwykłego shadera Diffuse, do którego podłączamy naszą teksturę (Rysunek 15.27.3a). Aby zwiększyć liczbę pasków zwiększ parametr Wave Texture:Scale. Długością przeplotu możesz sterować zmieniając skalę tekstury wzdłuż osi cięgna (Z). Wreszcie mapowanie we współrzędnych Texture Coordinate:Objec t zapewnia, że ten sam materiał użyty np. dla bardzo długich linek anteny będzie miał taką samą długość przeplotu jaką pokazuje Rysunek 15.27.3b).
Teraz wystarczy tylko podstawić do tego schematu shader Glossy Paint, ustawiony jak dla ciemniejszego i bardziej szorstkiego metalu, i podłączyć tę teksturę jako mapę nierówności (Rysunek 15.27.4a):
Rysunek 15.27.4 Podłączenie obrazu pasków jako tekstury nierówności
Nazwijmy ten materiał B.Steel.Wire. Zastosujemy go do innych metalowych linek stosowanych w samolocie, m.in. anteny radiowej. Każdy z nich jest modelowany jako podłużny cylinder. Należy tylko zwrócić uwagę, by w każdym takim elemencie oś siatki cylindra pokrywała się z lokalną osią Z obiektu!
Podobne rozwiązanie wykorzystamy do stworzenia sprężyny na zakończeniu cięgna (Rysunek 15.27.5):
Rysunek 15.27.5 Wykorzystanie zmodyfikowanej tekstury pasków do odwzorowania sprężyny
Nazwiemy ten materiał B.Steel.Spring. Początkowo skopiowałem tu węzły z B.Steel.Wire, po czym zmniejszyłem liczbę i skok zwoju oraz zwiększyłem jasność i połyskliwość (Rysunek 15.27.5a). Rysunek 15.27.5b) pokazuje uzyskany rezultat.
Ten efekt można jeszcze poprawić: wyprowadź z tekstury Wave drugą wersję obrazu, przetworzoną przez węzeł Color Ramp (uzyskując tą drogą ostre krawędzie pasków — por. str. 1074). Aby użyć jej jako mapy przejrzystości, zastęp domyślny węzeł wyjściowy węzłem grupy Surface Output (por. str. 451) (Rysunek 15.27.5):
Rysunek 15.27.6 Wykorzystanie obrazu pasków jako tekstury nieprzejrzystości
Potem pozostaje tylko obejrzeć nasz element z większej odległości, by lepiej dobrać: skok zwojów sprężyny i szerokość odstępów pomiędzy zwojami (Rysunek 15.27.7a):
Rysunek 15.27.7 Dostosowanie efektu do widoku z większej odległości
Rysunek 15.27.7b) przedstawia uzyskany efekt. Sądzę że te sprężyny wyglądają na nim wystarczająco dobrze.
Przedstawiona w materiale B.Steel.Spring metoda jest dobrym rozwiązaniem przy tworzeniu różnych drobnych detali. Możesz w ten sposób szybko stworzyć elementy, które nie mają być specjalnie widoczne lub będą zazwyczaj bardzo małe.
Do tej pory stworzyliśmy efekt powierzchni metalu za pomocą shadera Glossy Paint, w prostym schemacie jaki pokazuje Rysunek 15.27.1 (str. 1084). Uzyskana powierzchnia sprawia wrażenie bardzo gładkiej (Rysunek 15.27.8a) — jak gdyby była pokryta niklem lub innym drogim wykończeniem. Większe elementy podwozia były odlewane lub kute, i powinny mieć bardziej zróżnicowaną powierzchnię — na przykład taką, jaką przedstawia Rysunek 15.27.8b):
Rysunek 15.27.8 Zróżnicowanie powierzchni metalu
Do odwzorowania takich powierzchni stwórzmy nowy materiał: B.Steel.Rough. Jego schemat przedstawia Rysunek 15.27.9a). Do modulacji barw Diffuse i Specular używam w tu złożonej tekstury szumu — komponentu X.Random Dirt (opis budowy tej tekstury znajdziesz na str. 1078). Drugiego wyjścia z tej grupy — obrazu Displacement — używam jako tekstury tworzącej wrażenie drobnych chropowatości powierzchni.
Rysunek 15.27.9 Materiał B.Steel.Rough
Zastosowanie tekstur proceduralnych pozwala uzyskać ciekawe efekty bez konieczności wykonywania pracochłonnych rozwinięć UV. Ceną za to jest dłuższy czas renderowania: obraz pokazywany przez Rysunek 15.27.8a) został stworzony w 3min 12s, podczas gdy Rysunek 15.27.8b) — w 6min 40s.
Silniejszy efekt można uzyskać podłączając do tej samej tekstury „szumu” pozostałe współczynniki shadera Gloss Paint: Roughness i Reflectivity (Rysunek 15.27.10a):
Rysunek 15.27.10 Bardziej szorstki materiał
W tym przypadku zastosowanie grupy X.Pattern Adaptor pozwala przedstawić wszystkie parametry w bardziej zwartej formie, upraszczając w sposób znaczący cały schemat. Aby uzyskać efekt pokazywany przez Rysunek 15.27.10b) ustaw wartości wejściowe tej grupy tak, jak pokazuje ilustracja. Potem możesz trochę poeksperymentować z ustawieniami. Zwróć uwagę, że nawet drobne zmiany parametrów sterujących wyjściem Roughness (Roughness Min, Roughness Range) wywołują znaczne różnice w wyglądzie uzyskanej powierzchni.
Oczywiście, ten materiał można poddać kolejnym zmianom. Na przykład — w celu zabezpieczenia przed korozją powierzchnie stalowe są często pokrywane cienką warstwą cynku. Pojawia się na nich charakterystyczny wzór obszarów o różnym odcieniu, przypominający teksturę Voronoi:Cells (por. str. 1031). Jednocześnie powierzchnię którą pokazuje Rysunek 15.27.10b) można wzbogacić o trochę połysku.
Stąd proponuję dodać do schematu materiału B.Steel.Rough drugą gałąź, w której monochromatyczny obraz „komórek” uzyskany z wyjścia Voronoi:Fac jest podłączony do barwy i szorstkości shadera typu Glossy. Każdy z tych obrazów jest modulowany w inny sposób — np. barwa jest wzmacniana za pomocą węzła Bright/Contrast. Całość połączona z dotychczasowym wyjściem z Gloss Paint za pomocą nowego węzła Mix Shader (Rysunek 15.27.11):
Rysunek 15.27.11 Dodatkowa tekstura — „ocynk”
Rysunek 15.27.12a) przedstawia rezultat. Dodanie kolejnej tekstury proceduralnej wydłużyło czas renderu do 7min 57s. Z niewielkiej odległości efekt wydaje się być nieco przesadzony (możesz to skorygować, zmniejszając wartość MixShader:Fac do 0.1). Po zwiększeniu odległości kamery od obiektu te komórki tekstury Voronoi zlewają się w drobne kropki (Rysunek 15.27.12b):
Rysunek 15.27.12 Efekt na podglądzie renderu
Z większej odległości może to wyglądać na kurz lub brud — w każdym razie efekt jest ciekawy. Zdecydowałem pozostawić go w tym materiale. Gdy obiekt pokryty teksturami proceduralnymi zajmuje niewielką część obrazu, ich wpływ na ogólny czas renderowania jest niewielki. Takie tekstury wpływają zazwyczaj na zbliżenia: Rysunek 15.27.12b) generował się trzy razy szybciej (2min 36s) niż Rysunek 15.27.12a).
Złożonych tekstur proceduralnych warto używać dla detali, które nie zajmują dużej powierzchni na ostatecznym renderze.
W tej sekcji pokażę krok po kroku, jak uzyskać materiał sprawiający wrażenie „zakurzonego kawałka gumy” — taki, jak opona tego kółka ogonowego (Rysunek 15.28.1):
Opony we wczesnych wersjach P-40 albo nie miały w ogóle bieżnika, albo bieżnik miał prosty kształt podłużnych rowków. Jeżeli zastosujemy dla wszystkich tekstur materiału mapowanie Texture Coordinate:Generated (por. str. 1072), będzie można ten sam materiał wykorzystać i dla opony kółka ogonowego, i dla opon kół głównych. Dlatego proponuję nazwać ten materiał B.Rubber.Tyre. W tej sekcji pokażę krok po kroku jak go stworzyć za pomocą tekstur proceduralnych. Sprowadza się to do skomponowania z nich kilku obrazów, które posłużą nam do dodania takich efektów jak bieżnik, przetarcia, kurz.
Najbardziej zużytą częścią opony jest bieżnik. Zacznijmy od stworzenia białego pasa, który wyznacza jego granice. Ten obraz posłuży nam do tonowania pozostałych efektów zużycia po bokach opony (Rysunek 15.28.2):
Rysunek 15.28.2 Pojedynczy, szeroki pasek — maska bieżnika
Posłużyłem się tu odpowiednio zmapowaną teksturą Wave (por. str. 1076). Pozostawiłem wzdłuż osi opony biały pas, podczas gdy obszar poza bieżnikiem jest ciemniejszy (ale nie czarny!). Do sterowania intensywnością tych odcieni szarości użyłem dodatkowego węzła Color Ramp (por. str. 1074). Aby lepiej pokazać użycie na schemacie materiału tych i następnych obrazów, przekształcę je w tymczasowe grupy. Zespół węzłów tej maski bieżnika połączyłem w grupę Z.Tyre.Tread Width (Rysunek 15.28.3):
Kolejną teksturą będzie wzór bieżnika opony. Zakładam, że we wczesnych wersjach P-40 był to prosty wzór podłużnych pasków. Uzyskamy go w bardzo podobny sposób, co maskę bieżnika: za pomocą tekstury Wave. Wystarczy nadać jej nieco inną skalę i zmodyfikować spektrum węzła Color Ramp (Rysunek 15.28.4):
Rysunek 15.28.4 Tekstura bieżnika
Zwróć uwagę, że w węźle Color Ramp zastosowałem tu inną funkcję: Constant. W ten sposób uzyskujemy ostre granice barw pasków. Podobny węzeł użyjemy, aby za pomocą maski bieżnika (Z.Tyre.Tread Width) zamaskować boki opony (Rysunek 15.28.5):
Rysunek 15.28.5 Tekstura bieżnika (po zamaskowaniu boków)
Węzły wzoru bieżnika łączymy w nową grupę o nazwie Z.Tyre.Tread Pattern. Rysunek 15.28.6 przedstawia użycie obydwu grup w pierwszej wersji materiału (pełnią rolę mapy nierówności):
Rysunek 15.28.6 Tekstura bieżnika (mapa nierówności) w pierwszej wersji materiału opony
Teraz należy nadać naszej oponie jakąś bardziej widoczną szorstkość. Wykorzystam w tym celu teksturę Voronoi w trybie Intensity (por. str. 1030). Powiększ wartość jej skali (Scale) do 400 — 500, aby uzyskać coś co przypomina ziarna piasku (Rysunek 15.28.7):
Rysunek 15.28.7 Tekstura chropowatości
Ten wzór wykorzystamy jako teksturę nierówności oraz do modulacji szorstkości materiału opony. W każdym z tych miejsc musi mieć inną intensywność. Do podkreślenia ziaren na obrazie szorstkości wykorzystuję węzeł Bright/Contrast (znajdziesz go w submenu Add→Color). Do złagodzenia intensywności mapy nierówności użyłem grupy Moderate (Rysunek 15.28.7). Węzły połączyłem w grupę Z.Tyre.Roughness, która ma dwa wyjścia: Fac (współczynnik szorstkości) i Height (dla mapy nierówności). Użycie tej grupy w materiale opony przedstawia Rysunek 15.28.8:
Rysunek 15.28.8 Wykorzystanie tekstury chropowatości
Zwróć uwagę, że wyjście Height podłączyłem do wejścia Normal shadera Diffuse. Zrobiłem to na zasadzie eksperymentu (Wejście Normal służy do alternatywnego odwzorowania nierówności za pomocą tzw. mapy normalnych). Węzeł Bump dokonuje tu automatycznej konwersji mapy szarości na wektory normalne.
Aby odwzorować rozkład kurzu i brud na oponie, połączymy trzy różne tekstury (Rysunek 15.28.9):
Rysunek 15.28.9 Składniki tekstury zabrudzeń
Rysunek 15.28.10 przedstawia szczegóły tych trzech tekstur oraz sposób i rezultat ich złożenia:
Rysunek 15.28.10 Złożenie tekstury zabrudzeń
Tekstura a) to obraz Noise, „spłaszczony” wzdłuż osi opony (Mapping:Scale = 3) w celu uzyskania efekt rozciągniętych plam (wzdłuż kierunku obrotu koła). Tekstura b) to klasyczny monochromatyczny wzór Voronoi:Cells (por. str. 1031), z odpowiednio zwiększonym kontrastem. Tekstury a) i b) są połączone węzłem Mix, którego współczynnik Fac steruje udziałem „komórek” tekstury b) w ostatecznym obrazie. Uzyskujemy w ten sposób pewien losowy wzór, który będzie w miarę dobrze pasować na zabrudzenia opony. Aby całość nie wyglądała zbyt regularnie, łączę ją jeszcze z teksturą c). To typowa „drobnoziarnista” Voronoi:Intensity (por. str. 1030). Jest łączona z sumą tekstur a) i b) operacją Multiply, przez co ostateczny obraz złożenia jest dość ciemny (Rysunek 15.28.10). Ten zespół węzłów połączyłem w pomocniczą grupę o nazwie Z.Tyre.Color Pattern.
Aby przekształcić odcienie szarości zwracane przez grupę Z.Tyre.Color Pattern w coś, co będzie przypominać kurz i pył, potrzebujemy jeszcze jednej grupy. Nazwałem ją Z.Tyre.Diffuse Color. Po połączeniu do przygotowanych wcześniej grup obrazów stworzy wrażenie zabrudzeń o odpowiednich kolorach (Rysunek 15.28.11):
Rysunek 15.28.11 Grupa dostarczająca barwy Diffuse
Grupa Z.Tyre.Diffuse Color to złożenie trzech węzłów „mieszających” barwę podstawową Base (ustaw ją na ciemnoszary, tzn. V = 0.01) z jaśniejszymi kolorami pozostałych zabrudzeń (Rysunek 15.28.11a). Kolory tych zabrudzeń nazwałem Color1 i Color2 (Rysunek 15.28.11b). Dobierz je odpowiednio do tworzonej sceny!
Rysunek 15.28.12a) przedstawia zmodyfikowany materiał opony. Najpierw wymieniłem używany do tej pory shader na Opaque Surface (to to samo co Gloss Paint, ale z wejściem dla mapy normalnych — por. str. 1061). Następnie włączyłem do tego schematu przygotowane grupy odpowiedzialne za efekt kurzu — Z.Tyre.Color Pattern i Z.Tyre.Diffuse Pattern. Ich rezultat jest podłączany do barwy Diffuse shadera:
Rysunek 15.28.12 Połączenie wszystkich komponentów materiału
Zwróć uwagę na sposób połączenia tekstury zabrudzeń (Z.Tyre.Color Pattern) z grupą barw Z.Tyre.Diffuse Color. Tekstura steruje udziałem barw kurzu (Color1 i Color2) w poszczególnych miejscach opony. Jedno z jej wyjść jest podłączone bezpośrednio do udziału ciemniejszej barwy (Color1). Drugie — najpierw jest ograniczane (węzeł Multiply) do obszaru bieżnika, a dopiero potem uaktywnia jaśniejszą barwę zabrudzeń (Color2). (W ten sposób zabrudzenia na bieżniku są jaśniejsze).
Dla dodatkowego wzmocnienia efektu tak zmodyfikowany obraz jest podłączony do wejścia Bump:Strenght, różnicując w ten sposób drobne nierówności powierzchni. Zmniejszyłem także głębokość bieżnika (do 0.05 — por. ze str. 1091, Rysunek 15.28.6), aby wyglądał na bardzo zużyty. Rysunek 15.28.12b) przedstawia uzyskany rezultat.
Aby uzyskać jeszcze ciekawszy efekt zużycia, możesz połączyć obrazy Z.Tyre.Roughness i Z.Tyre.Tread Width w dodatkowym węźle Multiply (czyli skupić efekt na obszarze bieżnika). Rezultat podłącz do wejść Roughness i Reflectivity shadera (Rysunek 15.28.13a):
Rysunek 15.28.13 Dodatkowa modulacja szorstkości bieżnika
W rezultacie guma bieżnika stała się tak zużyta, że jest miejscami lekko połyskliwa (Rysunek 15.28.13b).
Do wyjaśnienia działania komponentów materiału B.Rubber.Tyre używałem grup węzłów, gdyż inaczej całość nie zmieściłaby się na ilustracjach w tej książce. (Przynajmniej nie na tyle, by etykiety węzłów pozostały czytelne). Z drugiej jednak strony — tak duża liczba grup wydłuża menu Add→Group, a przecież każda z nich zostanie użyta tylko raz. Dlatego na koniec zastąpiłem zawartość tych grup ramkami — uważam je za coś w rodzaju komentarzy, ułatwiających zrozumienie schematu (Rysunek 15.28.14):
Rysunek 15.28.14 Ostateczna postać materiału B.Rubber.Tyre (grupy zastąpione ramkami)
Rysunek 15.28.15 przedstawia co trzeba w tym schemacie zmienić, aby stworzyć wrażenie większego zużycia i zabrudzenia opony. Pokazuję to na przykładzie koła na lotnisku polowym:
Rysunek 15.28.15 Modyfikacje w celu zwiększenia wrażenia zużycia opony
W kabinie występują dwa elementy pokryte skórą: zagłówek i podkładka pod „spinką” pasów (Rysunek 15.29.1):
Rysunek 15.29.1 Skórzane elementy modelu
Skórzane materiały mają charakterystyczny wzór powierzchni. W „starym” rendererze Blendera (Blender Render) można go szybko uzyskać za pomocą proceduralnej tekstury Clouds:Voronoi Crackle. Niestety, w Cycles nie ma takiego węzła, więc musimy sami zbudować coś podobnego z innych tekstur. Rozwiązanie prezentowany w tej sekcji jest oparte na materiale opublikowany w serwisie Blend Swap1.
Tworzenie materiału pokażę to na przykładzie podkładki pod sprzączkę pasa biodrowego (Rysunek 15.29.1). (Na czarnej skórze zagłówka nie widać pewnych drobiazgów). Podstawową teksturę zbudujemy poprzez złożenie wielu tekstur Wave Texture:Bands. Rysunek 15.29.2 przedstawia pierwszą przymiarkę, służącą do doboru podstawowych parametrów, takich ja rozmiar:
Rysunek 15.29.2 Wstępna wersja tekstury
Jako współrzędne tekstury zdecydowałem się zastosować lokalne współrzędne obiektu (Texture Coordinate:Object). Pozwoli to zachować taką sam rozmiar wzoru dla wszystkich obiektów o skali = 1. Za pomocą dwóch dodatkowych węzłów: Math (Power) i Color Ramp uzyskałem wzór cienkich pasków.
Oczywiście, takim paskom jeszcze daleko do złożonego wzoru skóry. Na początek połączmy ze sobą dwa takie same obrazy, obrócone o 90º (Rysunek 15.29.3):
Rysunek 15.29.3 Złożenie dwóch obróconych obrazów pasków
W ten sam sposób można uzyskać obraz dla mapy nierówności. Wystarczy w miejsce pasków Color Ramp o ostrej granicy barw (por. Rysunek 15.29.2) wstawić dwa ciemniejsze i nieco rozmyte (Rysunek 15.29.4):
Rysunek 15.29.4 Druga tekstura: nierówności
Dodatkowe węzły (Invert i Gamma) służą w tym schemacie do dalszego zmniejszenia kontrastu obrazu.
Obydwie tekstury mają wiele podobnych węzłów, stąd zdecydowałem się je połączyć w jeden pomocniczy komponent, o nazwie X.Leather.Band (Rysunek 15.29.5):
Rysunek 15.29.5 Pomocniczy komponent materiału X.Leather.Band
Teraz złóżmy trzy takie obrazy, różnicując ich kąty obrotu (współczynniki w węzłach Mapping), zaburzenia kształtu (w X.Leather.Band:Distortion), skale (w węzłach Multiply) i odcienie szarości (w węzłach Darken). Taką pomocniczą teksturę nazwijmy X.Leather.Pattern. Jej schemat przedstawia Rysunek 15.29.6:
Rysunek 15.29.6 Schemat tekstury X.Leather.Pattern: złożenie trzech różnych obrazów X.Leather.Band
Rysunek 15.29.7 przedstawia obrazy generowane przez teksturę X.Leather.Pattern:
Rysunek 15.29.7 Przykładowy obraz, uzyskany za pomocą tekstury X.Leather.Pattern
Gdy wykorzystamy wyjście X.Leather.Pattern:Color do modulacji szorstkości i połyskliwości standardowego materiału Opaque Surface (por. str. 1061), a wyjście Bump do stworzenia mapy nierówności — uzyskamy coś przypominającego powierzchnię skóry (Rysunek 15.29.8):
Rysunek 15.29.8 Pierwsza wersja materiału skóry
Aby osiągnąć jeszcze lepszy efekt, trzeba nanieść na tę powierzchnię jakieś ślady zużycia. W tym celu połączyłem „miękkie” plamy z tekstury Noise z X.Leather.Pattern, tworząc kolejny obraz (Rysunek 15.29.9):
Rysunek 15.29.9 Dodatkowy obraz, który wykorzystamy do efektu „zużycia”
Ten obraz zmieszamy za pomocą węzła Color:Mix (Multiply) z podstawową barwą Opaque Surface:Diffuse (Rysunek 15.29.10):
Rysunek 15.29.10 Nałożenie obrazu „zużycia” na materiał skóry (B.Brown.Leather)
Jak widać na schemacie materiału B.Brown.Leather, aby wykonać takie połączenie, musiałem „wyciągnąć” barwę Diffuse do osobnego węzła. Efekt „wiekowania” polega na przyciemnieniu wypukłych miejsc na powierzchni skóry. Najlepiej wychodzi na jasnych powierzchniach, dlatego użyłem tu jaśniejszej barwy podstawowej (por. Rysunek 15.29.10 i Rysunek 15.29.8).
Zagłówek za siedzeniem pilota był pokryty czarną skórą (Rysunek 15.29.11). Nadałem temu materiałowi nazwę B.Black.Leather. Ma taki sam schemat jak ten pokazywany przez Rysunek 15.29.10, różni się tylko barwą. Zwróć uwagę że na tak ciemnej powierzchni efekt „zużycia” jest mało widoczny.
Jak na razie zajmowaliśmy się skórą bez fałd i „zmarszczek” . Tak wyglądała na zagłówku fotelu pilota. Jednak czasami taka gładka skóra nie jest odpowiednia. Porównaj, proszę, dwa materiały kurtki pilota, które przedstawia Rysunek 15.29.12:
Rysunek 15.29.12 Dwa różne materiały skórzanej kurtki
Rysunek 15.29.12a) to materiał opisany na wcześniejszych stronach. Niestety, nie wygląda tu realistycznie. W żaden sposób tu nie pomaga opracowana z takim mozołem drobna tekstura powierzchni! Za to wersja, którą pokazuje Rysunek 15.29.12b) wygląda zdecydowanie lepiej. Wszystko to dzięki temu, że jest w różnych miejscach pomarszczona. Takie zmarszczki można uzyskać na kilka sposobów, m.in.:
poprzez wymodelowanie w siatce (najbardziej pracochłonne, wymaga gęstej siatki);
za pomocą tekstury użytej w modyfikatorze Displace (ale to wymaga gęstej siatki);
za pomocą zwykłej tekstury nierówności (efekt trochę mniej od realistyczny, ale nie dodaje ścian);
Rysunek 15.29.12b) pokazuje rezultat wykorzystania tej trzeciej metody — zastosowania zwykłej tekstury nierówności. Nadałem temu materiałowi nazwę 000.Leather.Jacket (otrzymał prefiks „000.” a nie „B”, bo należy do uniwersalnego modelu pilota, i nie jest specyficzny dla samolotu P-40B). Poniżej pokażę jak taki efekt uzyskać:
W zasadzie zarys fałd można byłoby namalować w GIMP lub Inkscape (wykorzystując filtry — por. str. 733). My pójdziemy tu jednak na zupełne uproszczenie, i wykorzystamy odpowiednią teksturę proceduralną (Rysunek 15.29.13):
Rysunek 15.29.13 Tekstura ze wzorem „fałd”
To tekstura Wave:Bands. Po dodaniu tego węzła do schematu materiału zwiększyłem jego wartości Scale i Distortion do 10.
Aby odpowiednio nałożyć tę teksturę na kurtkę, najlepiej jest przygotować dodatkowe rozwinięcie siatki. Nadałem mu nazwę Folds. Powiększ na nim wszystkie obszary które mają być gęsto pofałdowane, a zmniejsz obszary które mają być bardziej płaskie. Rysunek 15.29.14a) zastosowane rozwinięcie siatki kurtki:
Rysunek 15.29.14 Mapowanie fałd na kurtkę pilota
Przypisz mapowanie Folds za pomocą węzła Attribute do tekstury. W tym rozwiązaniu sterujesz kształtem fałd zmieniając rozmiar i położenie poszczególnych ścian siatki w przestrzeni UV. Pamiętaj, aby wzajemnie dopasować wzór fałd na poszczególnych elementach — rękawach, torsie. Najlepiej na śledzić na bieżąco wynik na podglądzie renderu.
Aby Cycles uwzględnił ostatnie zmiany siatki (w tym także zmiany w rozwinięciu UV) musisz się na chwilę przełączyć z Edit Mode na Object Mode. Potem z powrotem możesz wrócić do Edit Mode.
Tak przygotowany obraz wykorzystaj jako teksturę nierówności. Rysunek 15.29.15a) przedstawia schemat materiału 000.Leather.Jacket, a Rysunek 15.29.15b) — podgląd efektu na renderze:
Rysunek 15.29.15 Materiał 000.Leather.Jacket
Zwróć uwagę na węzeł Moderate, sterujący głębokością nierówności. Jest ustawiony na stosunkowo dużą wartość (0.8), co tworzy na renderze efekt fałd (Rysunek 15.29.15b).
Właściwie to poza teksturą fałd jest to bardzo prosty materiał, wykorzystujący nasz standardowy shader Gloss Paint i teksturę barwy (Rysunek 15.29.15a). Barwa połysków (Specular) jest jasnobrązowa, a powierzchnia dość połyskliwa (Reflectivity = 0.4). Ten model pilota będzie używany do ujęć z większych odległości, i dla takich zastosowań nie ma potrzeby stosowania bardziej skomplikowanych rozwiązań.
Okazuje się, że takie odblaski na fałdach zależą nie tylko od połyskliwości materiału, ale i od oświetlenia! Render, który pokazuje Rysunek 15.29.15b) był wykonany z lampą typu Sun. To było źródło o dużej mocy (Strength = 25), ale także o dużym rozmiarze (Size = 1). Można to poznać po bardzo miękkich i delikatnych cieniach, jakie powstały na modelu. Gdy zmniejszymy rozmiar słońca do takiego, jaki używamy w scenie z modelem samolotu (Size = 0.01), efekt będzie o wiele mniej ciekawy (Rysunek 15.29.16)
Na renderze pojawiły się ciemne cienie o ostrych granicach. Odbłyski na kurtce stały się zbyt ostre, wręcz metaliczne. Ogólny efekt jest zdecydowanie gorszy. Aby to skorygować, trzeba nieco zmodulować połyskliwość (Reflectivity) shadera materiału (Rysunek 15.29.17a):
Rysunek 15.29.17 Dostosowanie materiału kurtki do ostrego oświetlenia
Po tych modyfikacjach kurtka wygląda całkiem znośnie (Rysunek 15.29.17b). Przypuszczam, że można tu wprowadzić jakieś inne modyfikacje, które nadały by jej powierzchni bardziej „skórzany” wygląd. Na razie jednak nie znalazłem niczego lepszego i pozastawiam ten efekt w postaci jak na ilustracji.
Pasy fotela pilota były wykonane z grubej tkaniny. Aby uzyskać jednolity kierunek ich wątków, rozwiń je w przestrzeni UV (Rysunek 15.30.1):
Rysunek 15.30.1 Rozwinięcie siatek pasów na powierzchni UV
Najszybciej jest to zrobić używając polecenia Smart UV Project z menu Mesh→UV Unvrap (U — Rysunek 15.30.1a). To rozwinięcie nie musi być staranne ani dokładne: poszczególne siatki mogą się na siebie nakładać. Ważne jest jedynie, aby miały takie same szerokości pasa, oraz kierunek (pionowy — Rysunek 15.30.1b).
Teraz nałóżmy na te siatki teksturę pasków. Należy je obrócić o 45º, aby biegły wzdłuż siatek, tak jak włókna tkaniny (Rysunek 15.30.2):
Rysunek 15.30.2 Pierwsza „przymiarka” tekstury pasów
Teraz połącz je z drugą teksturą pasków — tym razem pochylonych (o 45º — Rysunek 15.30.3)
Rysunek 15.30.3 Dodanie pasów poprzecznych
Gdy pasy mają właściwy odcień i orientację, zwiększ skalę obydwu tekstur, by rozmiar pasków stał się podobny do rozmiaru włókien (Rysunek 15.30.4):
Rysunek 15.30.4 Zmniejszenie skali pasów
Przygotujmy jeszcze obraz barwy pasów. Oryginalnie te pasy były białe, ale w warunkach polowych taki kolor nie miał szans się długo utrzymać. Dlatego nadałem im kolor „kawy z mlekiem” (Rysunek 15.30.5b):
Rysunek 15.30.5 Dobór ogólnej barwy materiału
Jako podstawowego shadera użyłem grupy Gloss Paint. Na podstawowy kolor nałożyłem ciemniejsze plamy, którym kształt nadała znacznie rozciągnięta w pionie (Mapping:Scale:Y = 0.05) tekstura Musgrave (Rysunek 15.30.5a). Teraz podłącz do shadera odwrotność tekstury włókien — aby modulowała wartości jego szorstkości (Roughness) i odbić (Reflectivity). Tego samego obrazu użyj jako tekstury nierówności (Rysunek 15.30.6):
Rysunek 15.30.6 Materiał pasów
Rysunek 15.30.7 przedstawia uzyskany rezultat:
Rysunek 15.30.7 Materiał pasów — rezultat
Te pasy wyglądają na bardzo brudne. W razie czego możesz je nieco „wyczyścić”, zmniejszając kontrast ich barw. (Wystarczy dodać na schemacie przedstawionym przez Rysunek 15.30.6 węzeł Bright/Contrast za węzłem Hue Saturation Value, a potem zmniejszyć wartość Contrast do -0.1).
W konstrukcjach z lat 40-tych występuje kilka rodzajów tworzyw sztucznych (bakelit, kauczuk syntetyczny, szkło organiczne). Połyskliwy materiał, który dziś nazywamy potocznie „plastikiem”, był wówczas zabarwionym szkłem organicznym. W P-40 wykorzystano go m.in. w osłonach świateł pozycyjnych. (Czerwonych na lewym skrzydle, zielonych na prawym, i białych na ogonie).
Shader szkła organicznego — grupę Plexiglas — stworzyliśmy w jednej z poprzednich sekcji (por. str. 1046). Wykorzystajmy więc go w tym materiale — wystarczy tylko zmienić kolor na czerwony (Rysunek 15.31.1):
Rysunek 15.31.1 Przejrzysta osłona lewego światła pozycyjnego
Zwróć uwagę, że barwie odbłysków (Specular) także nadałem odcień czerwony. (Choć jest to kolor jaśniejszy i o mniejszym nasyceniu niż podstawowa barwa Glass).
A jak uzyskać nieprzejrzystą wersję takiego materiału ? Wystarczy zmieszać shader Plexiglas z shaderem Glossy Paint (Rysunek 15.31.2):
Rysunek 15.31.2 Nieprzejrzysta wersja „plastiku”
Już dla 70% udziału shadera Glossy Paint powoduje, że materiał wygląda zupełnie nieprzejrzyście. Jednocześnie zachowuje połysk szkła organicznego. Zwróć uwagę na dobór kolorów Diffuse i Specular w shaderze Glossy Paint: mają jeszcze inny odcień niż shaderze Plexiglas. Dobór tych odcieni wymagał trochę pracy!
Aby za każdym razem nie ustawiać tych czterech barw, stworzyłem pomocniczy shader Plastic (Rysunek 15.31.3a):
Rysunek 15.31.3 Shader Plastic
Używając tej grupy ustalasz tylko jedną barwę. W środku zmieniam jej odcienie za pomocą odpowiednich węzłów Hue Saturation Value, dostosowując dla poszczególnych wejść shaderów Plexiglas i Glossy Paint. Parametr Opacity (Rysunek 15.31.3b) pozwala uzyskać także plastik półprzeźroczysty.
Edytor UV jest specjalnym narzędziem, przeznaczonym do przypisywania przestrzennym wierzchołkom siatki położenia na płaskiej powierzchni tekstury. Nazwa pochodzi od nazw parametrycznych współrzędnych teksturowania (UV). Edytor UV przydaje się wyłącznie dla tych siatek, na które tekstury są nakładane z wykorzystaniem tzw. “mapowania UV” (np. wykorzystują w Cycles wyjście UV z węzła Texture Coordinate).
Drugim trybem pracy edytora jest modyfikacja rastrowego obrazu tekstury (Image Painting). Zestaw narzędzi, dostępnych do tego celu w Blenderze, nie dorównuje wyspecjalizowanym edytorom obrazów, jak GIMP. Tym niemniej jest wystarczający do wykonania jakichś mniejszych czy większych poprawek (por. str. 1134).
Obrazy rastrowe w grafice komputerowej są zazwyczaj prostokątne (preferowane są kwadratowe). Gdy taki kwadrat (Rysunek 16.1.1b) chcesz nałożyć na, powiedzmy, kulę (Rysunek 16.1.1a), deformacja obrazu jest nieunikniona (Rysunek 16.1.1c):
Rysunek 16.1.1 Nakładanie prostokątnej tekstury na kulę
A czy można zobaczyć, gdzie na obrazie tekstury znajdują się ściany siatki kuli, zamapowane tak, jak pokazuje to Rysunek 16.1.1c)? Oczywiście! Przedstawia je Rysunek 16.1.2:
Rysunek 16.1.2 Przypisanie ścian do powierzchni tekstury — rozwinięcie w przestrzeni UV.
Do powierzchni tekstury zostały przypisany układ współrzędnych. Jego osie, dla odróżnienia od współrzędnych wierzchołków w przestrzeni, otrzymały nazwy U (pozioma) i V (pionowa) . Zazwyczaj przyjmuje się, że każda z tych współrzędnych ma wartość 0 w lewym, dolnym narożniku obrazu. Na krańcu tekstury U lub V przyjmują wartość = 1.0 (por. Rysunek 16.1.2). (Czasami podaje się je także w innych jednostkach — pikselach obrazu). Dwuwymiarowa przestrzeń, w której jest rozciągnięta tekstura, nosi nazwę przestrzeni UV. Rozwinięcie ścian powierzchni siatki w tej przestrzeni nazywa się rozwinięciem UV. W naszym przykładzie topologia rozwiniętych ścian siatki nie ulega zmianie, za wyjątkiem krawędzi „szwów” (por. Rysunek 16.1.2).
Typowym zagadnieniem, z którym się będziesz musiał zmierzyć, jest takie ułożenie ścian siatki w przestrzeni UV, by nałożony na model obraz tekstury był jak najmniej zdeformowany. W Blenderze służy do tego specjalne okno edytora UV (UV Editor) . Pozwala rozwinąć, a następnie zmieniać położenia ścian siatki w przestrzeni tekstury. Rysunek 16.1.3 przedstawia rezultat użycia: poprawione rozwinięcie siatki, którą pokazywał Rysunek 16.1.2. Większość jej obszaru została przekształcona w prostokąt. Pozwoliło to zachować regularny układ prostokątów obrazu i ich kątów na większości powierzchni kuli, oraz ciągłość wzoru na „szwie”:
Rysunek 16.1.3 Przykład innego rozłożenia ścian na teksturze
Rozwinięcia UV w Blenderze mogą nie zachowywać topologii oryginalnej siatki. Świadczy o tym już sam fakt istnienia „szwu”, wzdłuż którego siatka z przykładu została „rozcięta” i rozwinięta. W istocie w Blenderze każda ściana przechowuje „swoje” współrzędne wierzchołków UV, które mogą być zupełnie różne od ścian z którymi sąsiaduje w przestrzeni okna 3D View (Rysunek 16.1.4, por. także str. 1114):
Rysunek 16.1.4 Rozwinięcie UV w Blenderze traktuje każdą ścianę jako osobną całość
Blender domyślnie utrzymuje topologiczną ciągłość siatki, automatycznie włączając do selekcji wszystkie wierzchołki UV o tych samych współrzędnych. Rysunek 16.1.4 pokazuje jednak, że ten tryb można wyłączyć. Czasami takie efekty się przydają.
Siatka kuli w układzie „południki — równoleżniki” (jak w naszym przykładzie), jest powierzchnią, na którą nie można nałożyć kwadratowej tekstury bez jakiejś deformacji. Można się tylko starać, by odkształcenia obrazu były niewielkie (w końcu nad podobnym zagadnieniem biedziły się pokolenia kartografów). Większość powierzchni, z którymi będziesz miał do czynienia, nie jest aż tak wymagająca. Edytor UV i trochę dobrych pomysłów na rozwinięcie pozwala Ci uniknąć wyraźnych deformacji obrazu.
Edytor to odrębny rodzaj okna — UV/Image Editor — które można wybrać z listy z lewej strony nagłówka (Rysunek 16.2.1):
Rysunek 16.2.1 Przejście do edytora UV/obrazu (UV/Image Editor) — edycji siatki w przestrzeni UV
Aby efektywnie pracować z rozwinięciem UV, Blender musi być w trybie Edit Mode (por. str. 888). Okno Edytora UV jest ściśle powiązane z edycją siatki w oknie widoku 3D. (Obydwa modyfikują różne właściwości wierzchołków i ścian tej samej siatki.) Dlatego warto zawczasu ustawić obydwa okna obok siebie (jak to pokazuje Rysunek 16.2.1).
Okno UV/Image Editor ma dwa tryby pracy: edycji rozwinięcia UV (View) i malowania po obrazie (Paint). Do zmiany trybu służy lista rozwijalna w nagłówku okna. Rysunek 16.2.2 przedstawia nagłówek trybu Paint:
Rysunek 16.2.2 Nagłówek UV/Image Editor (aktywny tryb malowania — Paint)
Gdy przełączysz się w tryb View — w nagłówku pojawi się mnóstwo kontrolek związanych z edycją UV (Rysunek 16.2.3):
Rysunek 16.2.3 Kontrolki nagłówka UV/Image Editor (tryb edycji UV — View)
Zwróć szczególną uwagę na kontrolkę , pokazaną na obrazie nagłówka. Za jej pomocą możesz przełączyć się na tryb pracy z pojedynczymi ścianami rozwinięcia. (Więcej na ten temat znajdziesz na str. 1114). Niezależnie od trybu pracy, w tle okna zawsze jest widoczny wybrany w nagłówku obraz rastrowy.
Konwencje i klawisze skrótu, obowiązujące w edytorze UV, są bardzo zbliżone do tych, którymi posługujesz się w oknie 3D View. Tak jak w tamtej przestrzeni istnieje kursor 3D (3D Cursor — por. 777), tak tu znajdziesz jego dwuwymiarowy odpowiednik. Te same kombinacje klawiszy powodują selekcję, zmianę widoku, czy podstawowe operacje edycji (przesunięcie, obrót, zmianę skali).
Z kolei w trybie malowania (Paint) praca w UV/Image Editor przypomina trochę pracę w GIMP (Rysunek 16.2.4):
Rysunek 16.2.4 Praca w UV/Image Editor w trybie „malowania”
Różnorodne przybory malarskie znajdziesz tu w przyborniku (T), w zakładce Tools. Niestety, obraz nie ma tu warstw, jak w Gimpie. Jeżeli jednak włączysz w oknie 3D View tryb Texture Paint i w zakładce Slots przybornika (T) wskażesz ten sam obraz co w oknie UV/Image Editor, zobaczysz go na modelu (Rysunek 16.2.4). Co więcej w trybie Texture Paint możesz także malować bezpośrednio po powierzchni trójwymiarowego modelu (Rysunek 16.2.5):
Rysunek 16.2.5 Malowanie bezpośrednio na powierzchni modelu (tryb Texture Paint)
W edytorze UV możesz używać do selekcji tych samych metod i skrótów klawiatury, co w oknie 3D View, w trybie edycji (zob. str. 889-891) . Dokładnie takie samo działanie uzyskasz, gdy włączysz w nagłówku okna UV/Image Editor tryb „synchronicznej selekcji” (Rysunek 16.3.1):
Rysunek 16.3.1 Selekcja w trybie “synchronizacji” (z widokiem 3D View)
W tym trybie obowiązuje zasada dokładnej równoważności — gdy coś zaznaczysz w edytorze UV, staje się także zaznaczone w oknie 3D View, i odwrotnie. Nagłówek UV/Image Editor zawiera takie same opcje wyboru wierzchołków lub ścian, jakie są dostępne w oknie 3D View w Edit Mode (Rysunek 16.3.1). Także wszystkie skróty służące do selekcji — np. Alt - PPM — działają w UV/Image Editor tak samo, jak w oknie 3D View.
Gdy wyłączysz tryb synchronizacji — w edytorze UV widzisz (i możesz manipulować) wyłącznie ścianami, które są zaznaczone na siatce w oknie 3D View (Rysunek 16.3.2):
Rysunek 16.3.2 Selekcja w trybie bez “synchronizacji”
Jeżeli chcesz przez cały czas widzieć rozwinięcie wszystkich ścian siatki, niezależnie od aktualnej selekcji — włącz tryb synchronizacji z 3D View.
Wewnętrznie Blender przechowuje oddzielnie współrzędne UV każdej ściany. Oznacza to, że jednemu wierzchołkowi siatki XYZ może odpowiadać tyle punktów w przestrzeniu UV, ile ścian się w nim łączy (najczęściej dwie, trzy, lub cztery — Rysunek 16.3.3):
Rysunek 16.3.3 Koncepcyjny schemat ścian siatki w rozwinięciu UV — każda ma własne współrzędne
Zazwyczaj, gdy wskażesz jeden z wierzchołków UV, metoda wybrana na liście Sticky Selection Mode (Rysunek 16.3.2) powoduje automatyczne zaznaczenie („zlepienie”) pozostałych wierzchołków, leżących w tym samym miejscu. Możesz także wyłączyć ten tryb (Sticky Selection Mode:Disabled) . Blender umożliwia wtedy dowolną zmianę topologii (wygodniej się wówczas przełączyć na zaznaczenie ścian) (Rysunek 16.3.4):
Rysunek 16.3.4 „Zlepianie” rozwinięcia UV wyłączone (Disabled) — można manipulować oddzielnymi ścianami
Rysunek 16.3.5 i Rysunek 16.3.6 pokazują dwa dostępne tryb „zlepiania” wierzchołków UV — Shared Location i Shared Vertex. Zazwyczaj w czasie pracy będziesz używał trybu Shared Location:
Gdy synchronizacja selekcji jest wyłączona, obok ikon zaznaczania ścian lub wierzchołków, w nagłówku okna pojawia się trzecia możliwość: UV Island (Rysunek 16.3.7):
Rysunek 16.3.7 Szybkie zaznaczanie całych fragmentów siatki w trybie wyboru UV Island.
Przy włączonym UV Island jedno kliknięcie PPM zaznacza wszystkie ściany, które w sposób bezpośredni lub pośredni są połączone z miejscem wskazanym przez kursor. Ten tryb jest przydatny np. do szybkiego zaznaczania i przesuwania drobnych fragmentów siatki.
Kursor 2D (2D Cursor) pełni w edytorze UV analogiczną rolę do kursora 3D w oknie 3D View (por. str. 777). I tam, i tu, wyznacza „aktualną pozycję”, która jest używana jako punkt odniesienia podczas transformacji siatki (obrotu, zmiany skali).
Położenie kursora 2D jest oznaczane niewielkim krzyżem, otoczonym czerwono-białym rombem (Rysunek 16.4.1):
Rysunek 16.4.1 Kursor 2D w oknie UV
Kliknięcie LPM można traktować jako pierwszą, przybliżoną metodę wskazania położenia kursora. Z oczywistych przyczyn nie jest specjalnie dokładnie. W edytorze UV nie ma możliwości „dosunięcia” kursora do najbliższego węzła siatki pomocniczej (chociaż sama siatka jest widoczna). Gdy naciśniesz Shift-S (ten skrót nie ma w oknie UV/Image Editor odpowiednika w menu), przekonasz się że lista możliwości jest tu uboższa (Rysunek 16.4.2a):
Rysunek 16.4.2 Dosunięcie kursora do zaznaczonego wierzchołka
W edytorze UV kursor 2D można dosuwać (Snap) tylko do wybranych wierzchołków (Cursor to Selected) lub najbliższego piksela tekstury (Cursorto Pixels). Rysunek 16.4.2 przedstawia przykład użycia polecenia Snap:Cursor to Selected. Kursor został dosunięty do zaznaczonego wierzchołka. Mówiąc szczerze, tej funkcji używam częściej od pozostałych.
W UV/Image Editor istnieje także możliwość dokładnego wpisania współrzędnych kursora. Służy do tego panel Display z przybornika Properties. Gdy otworzysz przybornik (np. klawiszem N), przewiń jego zawartość, aby zobaczyć zawartość panelu Display (Rysunek 16.4.3):
Rysunek 16.4.3 Ustalanie położenia kursora 2D w panelu Display
Współrzędne kursora 2D można tu odczytać lub zmienić w polu Cursor Location. Trochę niekonsekwentnie, autorzy tego panelu podają nazwę współrzędnej poziomej jako X (to U), a pionowej — Y (to V). Obydwie wartości, jakie pokazuje Rysunek 16.4.3, są wyrażone w pikselach. Aby się przełączyć na klasyczny zakres współrzędnych UV — 0.0...1.0 (por. str. 1109) — wystarczy włączyć opcję Coordinates:Normalized.
Zaznacz wierzchołki, krawędzie lub ściany, które chcesz przesunąć (Rysunek 16.5.1):
Rysunek 16.5.1 Zaznaczenie przesuwanych ścian
Następnie naciśnij G (UVs→Transfrom→Translate). Przełączysz się w ten sposób w tryb przesuwania. Każde przesunięcie myszy będzie powodować przemieszczenie zaznaczonych wierzchołków. Dokonywane zmiany w kształcie siatki są pokazywane na bieżąco we wszystkich oknach Blendera (Rysunek 16.5.2):
Rysunek 16.5.2 Przesuwanie grupy wierzchołków
W nagłówku aktywnego okna jest wyświetlane aktualne przesunięcie. Aby zatwierdzić nowe położenie (zakończyć przesunięcie), należy kliknąć LPM. Aby zrezygnować z operacji, możesz w każdej chwili nacisnąć Esc .
Podczas przesuwania możesz dodatkowo trzymać wciśnięty klawisz Ctrl. Spowoduje to skokową zmianę odległości (np. co 0.1 jednostki). Jeżeli będziesz trzymał wciśnięty klawisz Shift — przesunięcia na ekranie “wyhamują”, pozwalając na dokładniejsze ustalenie pozycji. Wreszcie kombinacja obydwu — Shift-Ctrl — umożliwia skokowe przesuwanie położenia o niewielkie odległości (np. co 0.01 jednostki). Jeżeli w trakcie przesuwania naciśniesz X lub Y — ograniczysz swój ruch tylko do translacji wzdłuż jednej z tych osi.
Zaznacz grupę wierzchołków, które chcesz obrócić, oraz ustal środek transformacji (Pivot) (Rysunek 16.6.1). Praktycznie stosuję jeden z dwóch rodzajów środka: Bounding Box Center albo Cursor 2D. W tym przypadku, środkiem obrotu będzie Cursor 2D. Możesz go ustawić z klawiatury — naciśnij . (kropka):
Rysunek 16.6.1 Zaznaczenie wierzchołków
Naciśnij R (UVs→Transfrom→Rotate). Przełączysz się w ten sposób w tryb obrotu. Na rysunku pojawi się kreskowana linia od kursora myszy do środka transformacji. Każde przesunięcie myszy będzie powodować obrót zaznaczonych wierzchołków — proporcjonalnie do zmiany kąta kreskowanej linii. Dokonywane zmiany w kształcie siatki są pokazywane na bieżąco (Rysunek 16.6.2):
Rysunek 16.6.2 Obrót grupy wierzchołków
W nagłówku okna UV/Image Editor jest wyświetlany aktualny kąt obrotu. Aby zatwierdzić nowe położenie wierzchołków (zakończyć transformację), należy kliknąć LPM. Aby zrezygnować z operacji, możesz w każdej chwili nacisnąć Esc .
Podczas obrotu możesz trzymać wciśnięty klawisz Ctrl. Spowoduje to skokową zmianę proporcji (co 5º). Jeżeli będziesz trzymał wciśnięty klawisz Shift — zmiana obrót na ekranie “wyhamuje”, pozwalając na dokładniejsze ustalenie. Wreszcie kombinacja obydwu — Shift-Ctrl — umożliwia skokową zmianę obrotu o niewielkie kąty (np. co 0.5º).
Zaznacz grupę wierzchołków, które chcesz powiększyć/pomniejszyć, oraz ustal środek transformacji (z listy Pivot — Rysunek 16.7.1). Lista pozwala wskazać trzy rodzaje „środków”: Bounding Box Center, Median Point oraz 2D Cursor. Median Point to wypadkowy środek wszystkich zaznaczonych wierzchołków. (Leży w ich “środku ciężkości”). Zacznijmy od przypadku, gdy środkiem skalowania jest właśnie Median Point. (Możesz go ustawić z klawiatury — Shift-,):
Rysunek 16.7.1 Zaznaczenie wierzchołków
Naciśnij S (UVs→Transfrom→Scale). Przełączysz się w ten sposób w tryb skalowania. Na rysunku pojawi się kreskowana linia od kursora myszy do środka transformacji. Każde przesunięcie myszy będzie powodować zmianę skali zaznaczonych wierzchołków — proporcjonalnie do zmiany długości kreskowanej linii. Dokonywane zmiany w kształcie siatki są pokazywane na bieżąco (Rysunek 16.7.2):
Rysunek 16.7.2 Powiększanie grupy wierzchołków
W nagłówku okna UV/Image Editor jest wyświetlana aktualna zmiana skali wzdłuż każdej osi. Aby zatwierdzić nowe położenie wierzchołków (zakończyć transformację), należy kliknąć LPM. Aby zrezygnować z operacji, możesz w każdej chwili nacisnąć Esc .
Podczas zmiany skali możesz dodatkowo trzymać wciśnięty klawisz Ctrl. Spowoduje to skokową zmianę proporcji (np. co 0.1). Jeżeli będziesz trzymał wciśnięty klawisz Shift — zmiana skali na ekranie “wyhamuje”, pozwalając na dokładniejsze ustalenie. Wreszcie kombinacja obydwu — Shift-Ctrl — umożliwia skokową zmianę skali o niewielkie wartości (np. co 0.01).
Środkiem skalowania może być także kursor 2D. Przełącz typ punktu odniesienia (Pivot) na 2D Cursor (skrót tej opcji na klawiaturze to .) (Rysunek 16.7.3):
Rysunek 16.7.3 Zmiana skali względem kursora 2D
Jeżeli w trakcie przesuwania naciśniesz X lub Y — ograniczysz zmianę skali do jednej z tych osi. W takim przypadku żaden rozmiar w kierunku poprzecznym nie ulegnie zmianie. Zobacz sam: naciśnij klawisz S, aby rozpocząć nową operację zmiany skali, a następnie naciśnij klawisz Y. Trzymając przez cały czas wciśnięty klawisz Ctrl (aby uzyskać dokładną zmianę skali) możesz np. uzyskać efekt odbicia w poziomie (Rysunek 16.7.4):
Rysunek 16.7.4 Zmiana skali względem kursora 2D (i wzdłuż jednej osi — Y)
Pokazaną powyżej zmianę skali wzdłuż jednej osi można także stosować jako sposób na dokładne i szybkie “spłaszczenie” grupy wierzchołków.
Do efektywnego przekształcania siatek UV będziesz używał dwóch poleceń, które wydają mi się nierozłączne jak... chyba jak młotek i gwoździe. Dlatego zdecydowałem się opisać je w tej samej sekcji. Pierwszym z nich jest przypinanie (Pin) wierzchołków siatki do określonych punktów UV. Sprawa jest bardzo prosta — zaznaczasz wybrane wierzchołki i naciskasz P (UVs→Pin, Rysunek 16.8.1):
Rysunek 16.8.1 Przypinanie punktów (Pin)
Po co przypinamy wierzchołki? Aby sterować rozwinięciem siatki. Punkty „przypięte” nie będą nigdy zmieniane przez jakikolwiek „automat”. W przypadku punktów nie przypiętych — może być różnie. Sprawdź to sam: obróć górną część zaznaczonych wierzchołków tak, jak to pokazuje Rysunek 16.8.2a:
Rysunek 16.8.2 Wywoływanie powtórnego rozwinięcia siatki (Unwrap)
Następnie zaznacz całą siatkę i naciśnij E (UVs→Unwrap). Rezultat pokazuje Rysunek 16.8.2b. Widzisz? Przemieszczenie „przyszpilonych” wierzchołków pociągnęło za sobą resztę siatki! Na drugim, dolnym obszarze, gdzie pozostawiliśmy je „w spokoju”, nie nastąpiły żadne zmiany. Przed wywołaniem polecenia Unwrap trzeba było zaznaczyć na siatce (w oknie 3D View!) obszar, który ma ulec zmianie. W przykładzie, który pokazuje Rysunek 16.8.2, zaznaczyliśmy po prostu całą siatkę. Oczywiście, może to być mniejszy fragment1.
Pomyśl, ile pracy wymagałoby takie uzyskanie takiego płynnego wygięcia siatki, jakie pokazuje Rysunek 16.8.2b, gdybyś spróbował tradycyjnie przesuwać lub obracać grupy wierzchołków! Najwięcej czasu poświęciłbyś właśnie na uzyskanie płynnego przejścia, pomiędzy tymi punktami, które przemieściłeś bardziej, a tymi, które przemieściłeś mniej. A tutaj — wystarczy wybrać jakiś rząd kluczowych wierzchołków, a reszta dopasowuje się sama!
Aby było jeszcze łatwiej, twórcy Blendera umieścili w menu UVs przełącznik Live Unwrap (Rysunek 16.8.3). Gdy jest włączony, program dokonuje dynamicznego rozwinięcia siatki, gdy tylko przemieścisz jakikolwiek „przyszpilony” wierzchołek.
Aby zobaczyć, jak to działa: włącz ten tryb w menu. Na potrzeby tego przykładu zaznacz w oknie 3D View całą siatkę, i wyłącz w oknie edytora UV tryb synchronizacji selekcji (por. Rysunek 16.8.3).
Zaznacz teraz dolną część „przyszpilonej” krawędzi, i zacznij ją obracać (Rysunek 16.8.4):
Rysunek 16.8.4 Dynamiczne rozwijanie siatki w trakcie przemieszczania punktów (Live Unwrap)
Dzięki Live Unwrap możesz lepiej „wyczuć”, jak zachowuje się rozwinięcie siatki. Oczywiście, zetkniesz się na pewno z bardzo złożonymi transformacjami, w których tryb „dynamiczny” tylko by przeszkadzał. Wtedy zawsze możesz go wyłączyć, i korzystać z prostego polecenia Unwrap (E).
Polecenie UVs→Unwrap (E) i opcja UVs→Live Unwrap nie działają, gdy włączyłeś synchronizację selekcji z widokiem 3D View.
Oprócz rozwinięcia siatki, UV/Image Editor umożliwia edycję obrazu rastrowego. Zresztą — nie trzeba go od razu edytować. Częstym zastosowaniem jest po prostu podstawienie zawartości jakiegoś pliku pod rozwinięcie siatki w UV, wyłącznie w celach referencyjnych. (UV/Image Editor wyświetla jednocześnie i rozwinięcie siatki, i obraz, więc można jedno z drugim porównać).
Najpierw zaznacz całą siatkę w oknie 3D View. (Obraz jest przypisywany do zaznaczonych ścian siatki — gdy ich nie zaznaczysz, nic się nie stanie). Najprostszą drogą podstawienia obrazu jest wybranie jednego z tych, które są już używane w tym pliku Blendera. Służy do tego lista w nagłówku okna (Rysunek 16.9.1):
Rysunek 16.9.1 Wybór obrazu rastrowego z listy
Jeżeli wybierzesz jakiś obraz, którego boki nie są równe (nie jest kwadratem), przygotuj się na małe zaskoczenie (Rysunek 16.9.2):
Rysunek 16.9.2 Rezultat podstawienia obrazu, który nie jest kwadratowy
Rozwinięcie UV siatki ulega zawsze rozciągnięciu, odpowiedniemu do proporcji boków obrazu. Dzieje się tak dlatego, że współrzędne UV wierzchołków są zawsze wartościami względnymi (0..1), jak to pokazuje Rysunek 16.9.1 i Rysunek 16.9.2. Ich pozycja na ekranie jest wyznaczana na podstawie rozmiarów obrazu tła!
Gdy usuniesz (odłączysz) taki prostokątny obraz z tła (, por. Rysunek 16.9.2), rozwinięcie siatki natychmiast wraca do właściwych proporcji (jak to pokazuje Rysunek 16.9.3a). Czy teraz już rozumiesz, dlaczego obrazy wszystkich tekstury są kwadratami?
Do UV/Image Editor możesz załadować jakikolwiek plik z obrazem rastrowym. Służy do tego polecenie Image→Open Image. Można tu także utworzyć nowy, pusty obraz — na przykład po to, by za chwilę coś na nim namalować (por. str. 1112, Rysunek 16.2.4). Służy do tego polecenie Image→New Image. (Alt-N) albo przycisk New w nagłówku (Rysunek 16.9.3a):
Rysunek 16.9.3 Utworzenie nowego obrazu i przypisanie go do ścian siatki
W oknie dialogowym New Image ustal, jaką nazwę będzie nosił obraz (Rysunek 16.9.3b). Możesz tu także zmienić jego rozmiar (w pikselach) — w polach Width i Height. Z listy Generated Type możesz wybrać jedną z kilku opcji. Dla opcji Blank nowy obraz będzie wypełniony jednolitą barwą, Color (por. Rysunek 16.9.3b). Jeżeli jednak włączysz opcję UV Grid, ta informacja jest ignorowana. Wybór UV Grid powoduje wygenerowanie wzoru z kwadratów i krzyżyków, przypominającego szachownicę (Rysunek 16.9.3c). To narzędzie pomocnicze, przeznaczone do wyszukiwania deformacji obrazu nałożonego na siatkę.Opcja Color działa podobnie (to inny wzór).
Blender przypisuje ładowany/tworzony obraz rastrowy do tych ścian siatki, które są w tym momencie zaznaczone w do UV/Image Editor.
O co chodzi z tym „przypisaniem”? Otwórz obok okno 3D View, przełącz na chwilę renderer na BlenderRenderer i tryb wyświetlania na Textured, a zobaczysz o co chodzi (Rysunek 16.9.4):
Rysunek 16.9.4 Podgląd w oknie 3D View obrazu nałożonego na siatkę w edytorze UV
Tryb wyświetlania Textured, gdy aktualnym silnikiem renderującym jest Blender Render, zawsze pokazuje obraz przypisany do ścian siatki (tzn. przypisanych w UV/Image Editor).
Czasami specyfika trybu wyświetlania Textured może przeszkadzać w pracy z zawartością okna 3D View. Popatrz na Rysunek 16.9.5a):
Rysunek 16.9.5 Porównanie dwóch metod wyświetlania obrazu nałożonego na siatkę
Siatki, które nie zostały przypisane w UV/Image Editor do żadnego obrazu, są w trybie Textured rysowane bez żadnych cieni, jednolitym kolorem białym. To utrudnia pełną ocenę ich kształtu w przestrzeni. Z kolei na siatkach które są pokryte przypisanym obrazem potrafią się pojawić głębokie cienie (Rysunek 16.9.5a). Takie cienie utrudniają np. wyszukiwanie deformacji testowej „szachownicy” na siatce.
Na szczęście w Blenderze jest dostępna alternatywna metoda wyświetlania obrazów tekstur na siatkach. Ustaw tryb wyświetlania zawartości 3D View na Solid. Następnie w przyborniku Properties (N) znajdź panel Display i włącz na niej opcję Textured Solid (Rysunek 16.9.5b). W tym trybie siatki bez obrazu są normalnie cieniowane. Nie występuje także problem z głębokimi cieniami na powierzchniach z obrazem.
Jeżeli przeszkadza Ci sposób wyświetlania w trybie Textured, zawsze możesz spróbować użyć zamiast niego opcji Display:Textured Solid.
Wszystko, co podano powyżej, dotyczy pracy z Blender Renderer. Gdy aktywnym rendererem jest Cycles, na model jest nakładany obraz z aktualnie zaznaczonego na schemacie materiału węzła tekstury (Rysunek 16.9.6):
Rysunek 16.9.6 Cycles: wybór obrazu, wyświetlanego na modelu
Wyrównanie oznacza w edytorze UV ustawienie wskazanych wierzchołków pionowo (Align Y) lub poziomo (Align X). Ten sam efekt możesz osiągnąć zmieniając skalę zaznaczonych wierzchołków wzdłuż jednej z osi do 0. Align X/Y jest właściwie „skrótem” takiej operacji.
Zaznacz jakąś linię wierzchołków, które chcesz wyrównać (Rysunek 16.10.1a). Następnie naciśnij W (lub UVs→Weld/Align), aby otworzyć menu Weld/Align. Z menu wybierz Align X (bo wierzchołki mają leżeć na linii pionowej). Rezultat przedstawia Rysunek 16.10.1b:
Rysunek 16.10.1 Wyrównywanie linii wierzchołków.
Każde z poleceń Align X/Y zmienia tylko jedną ze współrzędnych wierzchołków — tę, którą ma w nazwie. Współrzędne Y (V) punktów, które pokazuje Rysunek 16.10.1, nie uległy żadnej zmianie.
Obraz rozwinięcia UV można zapisać do pliku (rastrowego: *.png, lub wektorowego: *.svg lub *.eps). Na początek proponuję wykorzystywać domyślną opcję — zapis do pliku rastrowego. Wywołaj polecenie UVs→Export UV Layout — jak pokazuje to Rysunek 16.11.1a):
Rysunek 16.11.1 Zapisanie rozwinięcia UV do pliku (rastrowego).
Spowoduje to przełączenie okna Blendera w okno wyboru pliku. W tym oknie odszukaj po lewej stronie u dołu panel parametrów tego polecenia (Export UVLayout — Rysunek 16.11.1b). Można tu ustalić rozmiar obrazu (pola size — wyrażone w pikselach). (Najlepiej jest zawsze eksportować obraz kwadratowy). Można tu także określić nieprzejrzystość ścian rozwinięcia (Fill Opacity). Po wpisaniu nazwy i naciśnięciu przycisku Export UV Layout na dysku pojawi się zapisany plik z obrazem. Możesz go otworzyć w dowolnym programie — choćby w Gimpie (Rysunek 16.11.1c). Wszystkie ściany na tym obrazie będą wypełnione barwą materiału, do którego są przypisane. Wszystkie linie będą czarne, o szerokości 1 px.
W polu Format panelu Export UV Layout można także wybrać zapis do postaci wektorowej (pliku SVG — czyli formatu który wykorzystuje Inkscape). To cenna możliwość, pozwalająca przygotować obrazy rozwinięć wielu siatek w sposób bardzo dokładny, w stosunkowo niewielkich plikach.
Jednak w standardowym poleceniu brakowało mi pewnych opcji. Dlatego na potrzeby naszego projektu przygotowałem specjalny komponent, służący wyłącznie do eksportu rozwinięć siatki do pliku SVG. Znajduje się w pliku source\scripts\addons\io_mesh_uv_svg.py (aby zainstalować — por. str. 790). Możesz go włączyć w oknie User Preferences:Addons (Rysunek 16.11.2).
Jedną z funkcji, której brakowało mi w standardowym poleceniu Export UV Layout, była możliwość eksportu siatek wielu obiektów jednocześnie. Jest to o tyle dziwne, że edytorze UV/Image, po włączeniu opcji View→Draw Other Objects, Blender wyświetla ich rozwinięcia (Rysunek 16.11.3):
Rysunek 16.11.3 Podgląd rozwinięcia wielu siatek naraz.
Zaimplementowałem więc tę funkcję w moim dodatku. Po włączeniu możesz go wywołać poleceniem UVs→Export to SVG (Rysunek 16.11.4a):
Rysunek 16.11.4 Polecenie Export to SVG.
Podobnie jak w przypadku standardowego polecenia eksportu, ekran Blendera przełączy się w standardowe okno wyboru plików. W tym samym miejscu, co poprzednio, znajdziesz panel Export to SVG, z parametrami polecenia. Zwróć uwagę, że tym razem jest tych opcji więcej. Abyś nie musiał ich za każdym razem ustawiać, program zawsze domyślnie zaproponuje parametry użyte podczas poprzedniego wywołania tego polecenia.
Przy zapisie rozwinięć siatki do pliku SVG proponuję używać takich ustawień, jakie pokazuje Rysunek 16.11.4b). Jeżeli włączysz opcję From All Objects, do pliku SVG zapisane zostaną rozwinięcia aktywnych map UV ze wszystkich zaznaczonych w oknie 3D View obiektów. (Gdy ta opcja jest wyłączona, zapisywane są tylko ściany edytowanej siatki).
W czasie pracy nad siatką będziemy w ten sposób tworzyć wiele różnych plików, które następnie złożymy w jeden rysunek. Aby nie pogubić się w ich nazwach, możesz włączyć opcję Use Object Name. Sprawa barwy ścian i linii to oczywiście kwestia gustu. Natomiast koniecznie zaznacz opcję Broder Around Image ( Rysunek 16.11.4b). Dlaczego? Ponieważ tylko dzięki tej ramce będziesz mógł w Inkscape szybko i dokładnie złożyć obrazy rozwinięć siatki wyeksportowane z Blendera! Zaraz to zresztą pokażę.
Dla takich ustawień, jakie pokazuje Rysunek 16.11.4b), we wskazanym katalogu na dysku powstanie plik o nazwie B_300_Fuselage_UVTex.svg. Włączona opcja Export to SVG:Use Object Name spowodowała, że nazwą pliku stała się nazwa kadłuba (B.300.Fuselage) z podkreśleniami w miejscu kropek. Czasami siatki mogą mieć kilka alternatywnych rozwinięć (map) UV. Aby je odróżnić, drugą częścią nazwy jest nazwa aktywnego rozwinięcia UV (w tym przypadku — UVTex). Rysunek 16.11.5 przedstawia ten plik otwarty za pomocą Inkscape:
Rysunek 16.11.5 Rezultat eksportu (podgląd w Inkscape).
Wyeksportowane obrazy rozwinięcia UV są niezbędne do przygotowania tekstur modelu. Podstawą do tworzenia tekstur jest rysunek „technicznych” nierówności — krawędzi paneli, nitów, śrub — przygotowany w Inkscape. Jako „podkładkę” pod ten rysunek użyjemy rozwinięć UV, które gromadzimy w pomocniczym pliku uv.svg. Stworzony przez Blender plik wczytaj do rysunku zbiorczego uv.svg (File→Import — str. 682) (Rysunek 16.11.6):
Rysunek 16.11.6 Obraz po wczytaniu do Inkscape.
Zawartość importowanego pliku jest w Inkscape jedną grupą, składającą się z kwadratowej ramki i grup z rozwinięciami siatek. Długość boku ramki jest taka, jak zadeklarowany rozmiar obrazu (2048). Stąd, aby umieścić dodawane rozwinięcia dokładnie we właściwym miejscu rysunku zbiorczego, wpisz we współrzędne X i Y obiektu wartości (0, 0) (por. Rysunek 16.11.6). Potem rozdziel tę grupę (Object→Ungroup, albo Shift-Ctrl-G), abyś w razie czego mógł kopiować i przełączać pomiędzy warstwami rozwinięcia pojedynczych siatek. Jej ramka jest już niepotrzebna, możesz ją usunąć.
Rozwinięcia SVG zawierają bardzo dużo ścian, i Inkscape dość wolno odświeża kompletny rysunek uv.svg. Właśnie z powodu wydajności programu jako „podkładkę” do rysowania tekstur w pliku skin.svg proponuję wykorzystać rastrowy obraz (uv.png) o dużej rozdzielczości (4096x4096 px), wyeksportowany z uv.svg.
Aby stworzyć nowy obraz rastrowy w UV/Image Editor, wywołaj polecenie Image→New Image (Alt-N, Rysunek 16.12.1a):
Rysunek 16.12.1 Wywołanie polecenia
To polecenie otwiera okno dialogowe, w którym możesz wpisać podstawowe właściwości nowego obrazu: nazwę (Name) , rozmiar w pikselach (Width, Height) , kolor wypełnienia (Color — Rysunek 16.12.1b). Jako Generated Type wybierz opcję Blank. Gdy naciśniesz przycisk OK, zobaczysz w edytorze nowy obraz (Rysunek 16.12.2):
Rysunek 16.12.2 Nowy obraz
Zwróć uwagę na gwiazdkę w nazwie menu: Image* (Rysunek 16.12.2). W ten sposób Blender sygnalizuje, że obraz trzeba zapiać na dysk. (Bezpośrednio po stworzeniu, obraz istnieje tylko w pliku Blendera. Zawsze pamiętaj o jego zapisaniu!)
Dwie pozostałe opcje Generated Type — UV Grid i Color — tworzą specjalny obraz testowej siatki, przydatnej do sprawdzania rozwinięć UV lub testowych renderów.
Jeżeli chcesz po raz pierwszy zapisać nowo stworzony obraz, lub stworzyć kopię istniejącego pliku, wybierz polecenie Image→Save As Image (F3, Rysunek 16.13.1a):
Rysunek 16.13.1 Wywołanie polecenia Save As Image i jego opcje
Na ekranie Blendera pojawi się okno wyboru pliku. Zwróć uwagę na jego najniższą panel: to parametry polecenia Save As Image (Rysunek 16.13.1b). Możesz tam wybrać format zapisu pliku, tryb barwy, a także poziom kompresji. Dla plików PNG nie zapomnij ustawić kompresji (Save As Image:Compression) na poziomie 100%, bo tylko wtedy Blender zapisze na dysku odpowiednio mały plik!
Dla plików w formacie JPG stosuje się zazwyczaj kompresję na poziomie 80 – 95% (patrz str. 618).
Po naciśnięciu przycisku Save As Image, obraz zostanie zapisany na dysku do pliku o wskazanej nazwie (Rysunek 16.13.2a):
Rysunek 16.13.2 Rezultat wywołania polecenia Save As Image
Jednocześnie w menu Image okna UV/Image Editor dostępne stanie się polecenie Save Image (Alt-S, Rysunek 16.13.2b). Od tej pory możesz go używać, gdy będziesz chciał zapisać dokonane w edytorze zmiany do pliku obrazu na dysku.
Gdy plik obrazu został zmieniony, Blender sygnalizuje to małą gwiazdką (*) w nazwie menu Image. Taki plik warto zapisać na dysku poleceniem Save Image.
Malowanie po powierzchni modelu pokażę na przykładzie obrazu zabrudzeń (dla tekstur odbić i koloru).
Zaznacz w oknie 3D View obiekt, który chcesz „pomalować”, a potem ustaw odpowiednią projekcję i przełącz je w tryb Texture Paint. Jeżeli siatka aktywnego obiektu ma już rozwinięcie UV oraz przypisany materiał Cycles, zobaczysz na powierzchni obiektu obraz z węzła tekstury wybranej w Node Editor (Rysunek 16.14.1).
Rysunek 16.14.1 Przestawienie okna 3D View w tryb malowania
W trybie Texture Paint kursor staje się okrągłym kółkiem „pędzla” (Brush). Model najwygodniej jest malować w dwóch oknach (Rysunek 16.14.2). W 3D View widzisz obraz na modelu, a w UV/Image — ten sam obraz na płaszczyźnie. Aby przełączyć UV/Image Editor w tryb malowania wybierz z listy w nagłówku okna opcję Paint:
Rysunek 16.14.2 Przestawienie okna UV/Image Editor w tryb malowania
Aby ułatwić malowanie w UV/Image Editor, Blender wyświetla na powierzchni obrazu rozwinięcie UV siatki aktywnego obiektu (Rysunek 16.14.2). W trybie Paint nie możesz go zmieniać. W tym trybie okna przybornika (Toolshelf — T) w widoku 3D View oraz w edytorze UV/Image są niemal identyczne. Przybornik 3D View odróżnia się dodatkową zakładką Slots, w której możesz szybko przełączać się pomiędzy teksturami materiału.
Jeżeli chcesz namalować coś na obrazie nie związanym z żadnym materiałem — po uruchomieniu trybu Texture Paint w zakładce Slots przełącz Painting Mode z Material na Image, i wybierz odpowiedni obraz (por. str. 1112, 1137).
W Blenderze możesz zdefiniować wiele różnych „pędzli”. Ich właściwości (rozmiar, barwę, tryb pracy, itp.) ustawiasz w oknie przybornika. Znajduje się tam także lista, z której można wybierać pędzle (Rysunek 16.14.3):
Rysunek 16.14.3 Malowanie po powierzchni samolotu
W obydwu edytorach kursor zaczyna malować, gdy trzymasz wciśnięty LPM. W działaniu to przypomina trochę aerograf. Parametr Radius określa rozmiar pędzla, Strength: intensywność, a Blend — tryb „mieszania” barwy pędzla z obrazem (na tej liście znajdziesz takie same funkcje co w GIMP).
Aby wymazać jakiś fragment rysunku, należy zamalować go kolorem tła. W poprzednich wersjach Blendera potrzebne były do tego dwa pędzle (brushes): w „kolorze pierwszoplanowym” i „kolorze tła”. Od wersji 2.7 mamy dwie barwy w jednym pędzlu, przełączane prostym naciśnięciem klawisza X (Rysunek 16.14.4a):
Rysunek 16.14.4 Szczegóły kontrolki pędzli
U góry panelu Brush znajduje się kontrolka wyboru pędzla. Kliknij w nią, by rozwinąć listę z dostępnymi pędzlami (Rysunek 16.14.4b). Kontrolka pędzla posiada wszystkie typowe przyciski bloku danych Blendera, służące do zmiany nazwy, tworzenia nowego obiektu (poprzez skopiowanie bieżącego), lub jego usunięcie (odłączenie). W oknie Blendera tylko jeden pędzel jest aktywny. Aby uniknąć usunięcia tego bloku danych podczas zapisu pliku Blendera, warto włączyć jego flagę F (Fake user — por. str. 1217).
Zamiana kolorów tła i pierwszoplanowego przydaje się do drobnych poprawek. Ciągłe przestawianie innych parametrów narzędzia byłoby zbyt uciążliwe, stąd nadal warto definiować odrębne pędzle.
Szczegóły dotyczące „pociągnięcia” pędzla można ustawiać w panelu Paint Stroke. Sposób nakładania nowej barwy na obraz wybierasz z listy Stroke Method. Oprócz metod intuicyjnych, takich jak „aerograf” (Airbrush) czy linia (Line), znajdziesz tu kilka innych, takich jak Dot (maluje kolejną kropkę w stałych odstępach czasu) czy Space (maluje kolejne kropki w stałej odległości, określanej przez parametr Spacing — por. Rysunek 16.14.5a):
Rysunek 16.14.5 Panel Stroke — rysowanie w trybie Space
Opcja Smooth Stroke pozwala “ciagnąć” linię „jak psa na smyczy” (Rysunek 16.14.5b). W ten sposób powstają gładsze odcinki. Linie proste można rysować tak, jak to pokazuje Rysunek 16.14.6:
Rysunek 16.14.6 Panel Stroke — rysowanie w trybie Line
Oprócz zwykłego trybu „rysowania” (Draw) pędzel Blendera można także zmienić w innego rodzaju narzędzia. Służą do tego opcje Brush→Image Paint Tool. Rysunek 16.14.7 przedstawia definicję i działanie narzędzia do rozmazywania (Smear):
Rysunek 16.14.7 Zmiana typu „narzędzia malarskiego” — na przykładzie rozmazywania (Smear)
Domyślnie w trybie Texture Paint Blender wyświetla edytowany obraz tylko na powierzchni aktywnego obiektu. Gdy obraz do zamalowania pokrywa wiele obiektów, najlepiej jest widzieć go w całości. W tym celu przełącz na czas malowania silnik renderujący na Blender Renderer, i włącz w panelu Shading właściwości widoku (Property Shelf — N) opcję Textured Solid (Rysunek 16.14.8):
Rysunek 16.14.8 Przygotowanie do malowania obrazu rozpostartego na wielu obiektach
W tym trybie Blender wyświetla obraz przypisany do siatek wszystkich obiektów. W przypadku naszego modelu to obraz Test. Nie jest używany w żadnym materiale, więc aby po nim malować przełącz tryb operacji Texture Paint (lista Painting Mode w zakładce Slots) w tryb Image i jako Canvas Image wskaż Test (Rysunek 16.14.8). Zastąp zawartość tego obrazu (Image→ Replace Image w UV/Image Editor) plikiem, który wykorzystujesz w materiale. Po zakończeniu malowania zapiszesz go na dysku i załadujesz (poleceniem Image→Reload) do dopowiedniego węzła materiału Cycles.
W oknie 3D View możesz malować tylko po powierzchni aktywnego obiektu. W takim modelu jak nasz ta zasada nieco utrudnia pracę. Przyjrzyj się chociażby fragmentowi modelu, poprzez który ma biec smuga sadzy, pokazywana przez Rysunek 16.14.9. W tym miejscu łączą się siatki trzech obiektów: środka i tyłu kadłuba (3) oraz okapotowania silnika (1, 2):
Rysunek 16.14.9 Malowanie po powierzchni kilku obiektów
Aby wybrać inny obiekt w trybie Texture Paint, tryb Paint Mask musi być wyłączony (Rysunek 16.14.9). (To ustawienie jest indywidualnie przypisane do każdego obiektu). W wyniku jakiegoś przeoczenia twórców, gdy po raz pierwszy wybierzesz jakiś obiekt, Blender przełącza się z powrotem w tryb Object Mode. To dość denerwujące, szczególnie gdy masz dużo obiektów do pomalowania.
Aby się tak nie męczyć, napisałem prosty skrypt, który po wyborze obiektu automatycznie przełącza Blendera w tryb Texture Paint. Nosi nazwę Select Paint Target. Znajdziesz go wśród dodatków do tej książki (por. str. 22, plik source\scripts\addons\paint_select_object.py). Zainstaluj go i włącz (Rysunek 16.14.10):
Rysunek 16.14.10 Włączenie wyboru obiektu w trybie Texture Paint
Korzystanie z dodatku Select Paint Target jest bardzo intuicyjne. Wystarczy kliknąć PPM podczas malowania w jakiś inny obiekt, a natychmiast stanie się on obiektem aktywnym (Rysunek 16.14.11):
Rysunek 16.14.11 Zmiana aktywnego obiektu w trybie Texture Paint
Posługując się takim przełącznikiem można szybko namalować odpowiednią smugę (Rysunek 16.14.12):
Rysunek 16.14.12 Rezultat pracy na trzech fragmentach siatek
Zarysu śladu dymu lub spalin warto po narysowaniu „rozmyć”. W tym celu sklonuj obecny pędzel w nowe narzędzie i zmień tryb działania pędzla na Soften (z menu Brush→Image Paint Tool — Rysunek 16.14.13):
Rysunek 16.14.13 Zmiana trybu malowania (na Soften)
W panelu Curve możesz ustawić rozkład intensywności narzędzia wzdłuż promienia. Domyślnie pędzel ma łagodne krawędzie, tak jak pokazuje to Rysunek 16.14.14a). W trybie Soften lepiej się sprawdza jednorodny rozkład intensywności. Ustaw go w panelu Curve tak jak to pokazuje Rysunek 16.14.14b). Dodatkowo możesz także zwiększyć rozmiar pędzla (Brush:Radius — por. str. 1135, Rysunek 16.14.3). W wyniku jakiegoś błędu narzędzie Soften nie działa w oknie 3D View, ale możesz go użyć w w UV/Image Editor. Wystarczy w nim parę razy pociągnąć po naszych plamach, aby je rozmyć (Rysunek 16.14.14b):
Rysunek 16.14.14 Przełączenie krzywej intensywności narzędzia Soften na wartość stałą
By nie zmieniać co chwila tych wszystkich ustawień, warto zachować narzędzie Soften, obok Smear, jako kolejny „pędzel” (por. Rysunek 16.14.7).
W trybie malowania dostępne są także polecenia Undo (Ctrl-Z) i Redo (Shift-Ctrl-Z). Działają tu tak jak w GIMP — Undo usuwa ostatnie pociągnięcia pędzla, a Redo je przywraca.
W tej sekcji nie omówimy dalszych paneli z parametrami malowania, bo po prostu jest ich bardzo dużo. Zresztą pozostałych nie używałem podczas tworzenia tego modelu.
Tryb Texture Paint przydaje się także do korygowania plam kamuflażu. Pokażę to na przykładzie zielonych plam, pokrywających górne i boczne powierzchnie samolotu z AVG (Rysunek 16.14.15):
Rysunek 16.14.15 Przygotowanie w GIMP kopii warstwy z kamuflażem dla Blendera (pomocniczy plik camouflage.png)
Przygotowałem w GIMP obraz kamuflażu samolotu. Poszczególne elementy barwne są umieszczone na różnych warstwach (Rysunek 16.14.15a). Na jednej z nich, o nazwie Color-Green.Camouflage, namalowałem plamy, jakie pokrywały górne i boczne powierzchnie maszyny (Rysunek 16.14.15b). Na pewno granice tych plam będą przesunięte wzdłuż któregoś ze szwów modelu. Aby wykryć i poprawić takie miejsca, kopiuję zawartość tej warstwy do odrębnego pliku (camouflage.png).
Uzyskany z GIMP obraz rastrowy podstawiam w Blenderze (poleceniem Image→Replace) pod nazwę Test (Rysunek 16.14.16). W ten sposób pojawi się natychmiast na całej powierzchni samolotu (bo do tego obrazu są przypisane wszystkie siatki modelu — por. str. 391, a także str. 1125):
Rysunek 16.14.16 Przygotowanie obrazu plam kamuflażu w Blenderze
W widoku 3D View włączyłem tryb Texture Paint i przełączyłem wyświetlanie w tryb Textured Solid (w przyborniku Properties:Display). Blender maluje kolorem białym przejrzyste obaszary na aktywnym obiekcie, a czarnym — przejrzyste obszary na obiektach nieaktywnych. Jak pokazuje to Rysunek 16.14.16, kombinacja czarnego tła i ciemnozielonych plam kamuflażu nie jest zbyt kontrastowa. Na szczęście szybko można temu zaradzić.
Włącz dodatek Select Paint Target (por. str. 1138, Rysunek 16.14.10). Od tej chwili, w każdym obiekcie który klikniesz PPM przeźroczyste tło zmienia się z czarnego na białe (Rysunek 16.14.17). Tak już zostanie — dopóki nie zamkniesz tego pliku Blendera:
Rysunek 16.14.17 Przełączenie tła na białe
Czasami tekstura na wybranym obiekcie może wyglądać dziwnie (Rysunek 16.14.18a). Na szczęście, aby to skorygować wystarczy dwa razy nacisnąć klawisz Tab (Rysunek 16.14.18b,c):
Rysunek 16.14.18 Typowe problemy z mapowaniem obrazu i metoda ich korekty
Barwę podstawowego pędzla odczytaj w GIMP (por. str. 651) i skopiuj do schowka zawartość HTML notation (Rysunek 16.14.19a). Potem wklej ją w okno wyboru barwy Blendera (w trybie Hex — Rysunek 16.14.19b):
Rysunek 16.14.19 Ustalenie barwy pędzla podstawowego (Green)
Aby malować przejrzyste tło, zdefiniuj kolejny pędzel o nazwie Clear. Ustaw jego funkcję (Brush:Blend) na Erase Alpha, a intensywność Strength na 1.0 (Rysunek 16.14.20a). Jako Stroke Method wybierz Airbrush (Rysunek 16.14.20b). Plamy kamuflażu na P-40 były malowane za pomocą szablonów i miały ostre krawędzie. Dlatego w panelu Curve ustaw stałą intensywność wzdłuż promienia narzędzia (Rysunek 16.14.20c):
Rysunek 16.14.20 Ustawienia pędzla do malowania tła (Clear)
Gdy obejrzysz model w widoku 3D View, znajdziesz w nim różne nieprawidłowości (Rysunek 16.14.21):
Rysunek 16.14.21 Przykładowy defekt plam kamuflażu
Rysunek 16.14.21 pokazuje nieciągłość kamuflażu wzdłuż wewnętrznej krawędzi lotki. Ten błąd skorygujemy w oknie 3D View, usuwając nadmiar zielonej plamy za pomocą pędzla Clear (Rysunek 16.14.22):
Rysunek 16.14.22 Usuwanie nadmiaru plamy z obrazu tekstury
Pędzla Green potrzebujemy, by zamalować „ząbki” na skrzydle przy krawędzi lotki (Rysunek 16.14.23):
Rysunek 16.14.23 Poprawianie „ząbków” na krawędzi wnęki lotki
Przejrzyj w ten sposób wszelkie zakamarki modelu. W zależności od sytuacji, pewne plamy ogranicz zamalowując je przejrzystym tłem, inne uzupełnij kolorem zielonym.
Wszystkie zmiany, które naniosłeś w obrazie camouflage.png w Blenderze nie są jeszcze zapisane. Warto je co jakiś czas „utrwalić”. Służy do tego polecenie Image→Save Image (por. str. 1133).
Gdy już uzgodniłeś cały kamuflaż i zapisałeś jego uaktualniony obraz na dysku, pora wczytać rezultaty z powrotem do GIMP. Załaduj plik camouflage.png jako nową warstwę. Najpierw usuńmy z Color-GreenCamouflage nadmiary plam. Wczytaj do rysunku GIMP plik z dysku (poleceniem File→Open As Layers). Zostanie wczytany jako nowa warstwa, o nazwie camouflage.png. Umieść ją powyżej Color-GreenCamouflage(Rysunek 16.14.24):
Rysunek 16.14.24 Wstawienie zmodyfikowanego pliku camouflage.png do obrazu GIMP
Następnie usuń oryginalną warstwę Color-GreenCamouflage, a jej nazwę nadaj nowemu obrazowi plam.
Zwróć uwagę, że dużym ułatwieniem w przygotowaniu kamuflażu jest zastosowanie na warstwie Colors-GreenCamouflage plam o jednolitej barwie.
Tu umieściłem wszystkie polecenia Blendera, które nie pasują do pozostałych rozdziałów. Co prawda połowa jego sekcji jest poświęcona schematom kompozycji i ich węzłom, ale było ich zbyt mało by poświęcić im odrębny rozdział.
W tym przykładzie poznasz stworzenie najprostszego z możliwych materiałów. Nazwiemy go Artifical i będzie miał kolor czerwony. Materiału Artifical będziemy używać do wszystkich obiektów pomocniczych, które nie mają się pojawić na ostatecznym obrazie. (Intensywny kolor czerwony pozwoli nam je łatwiej dostrzec w Object Mode). Tej barwy potrzebujemy już na etapie modelowania, więc wprowadzam go jako materiał domyślnego silnika renderującego Blendera (Blender Renderer, znany także jako Blender Internal). Wszystkie pozostałe materiały tego modelu będę już tworzył dla alternatywnego renderera: Cycles (por. str. 987).
Zacznijmy od sytuacji wyjściowej: wybraliśmy aktywny obiekt (B.310.T.Cowling — Rysunek 17.1.1a). Jest to obiekt pomocniczy, który nie ma się pojawić na jakimkolwiek renderingu. W oknie Properties wybierz zestaw Material, i naciśnij przycisk New (Rysunek 17.1.1b):
Rysunek 17.1.1 Obiekt (a właściwie — siatka) bez przypisanego materiału
W rezultacie Blender stworzył nowy materiał (o domyślnej nazwie Material) i przypisał go do siatki aktywnego obiektu. W zestawie Material zaroiło się od paneli (Rysunek 17.1.2a):
Rysunek 17.1.2 Zmiana nazwy nowego materiału
Najlepiej od razu zmienić temu materiałowi nazwę — w tym przypadku na Artifical (Rysunek 17.1.2b).
W konfiguracji, jaką wybraliśmy (por. Rysunek 12.4.3, str. 765 — okno User Preferences, przełącznik Link Materials To:) materiał jest przypisany do siatki, a nie do obiektu. Stąd obok nazwy materiału widzisz wybrany tryb Data (por. Rysunek 17.1.2b). To skrót od Object Data. Blender umożliwia przypisanie różnym fragmentom pojedynczej siatki różnych materiałów, które wybiera się z listy umieszczonej ponad nazwą. (Szczegółowy opis wykorzystania wielu materiałów w jednej siatce znajdziesz na str. 940). Informacje o przypisywaniu materiału do obiektu, a nie siatki (tryb Object), znajdziesz na str. 839. Czasami ten alternatywny tryb także się przydaje!
Wróćmy jednak do naszego materiału Artifical. Aby zmienić jego kolor na czerwony, rozwiń kontrolkę barw klikając na pole w panelu Diffuse (Rysunek 17.1.3):
Rysunek 17.1.3 Zmiana barwy materiału
(Szczegóły posługiwania się tą kontrolką znajdziesz na str. 793). Aby uzyskać jaskrawą czerwień, zmniejsz w niej wartości G i B do 0.0, a R zwiększ do 1.0 (Rysunek 17.1.3a). Zwróć uwagę, że okienko w panelu Preview (Rysunek 17.1.3b) na bieżąco reaguje na każdą zmianę, jaką wykonasz w kontrolce. W rezultacie nasz obiekt w oknie 3D View będzie wyświetlany właśnie w tym kolorze (Rysunek 17.1.4)
Raz utworzony materiał można przypisać wielu obiektom/siatkom. Służy do tego lista rozwijalna (zestawie Material — Rysunek 17.1.5). W Blenderze możesz także przypisać materiał wielu obiektom naraz. O tym, jak to zrobić, możesz przeczytać na str. 940.
Gdy zmienisz jakikolwiek parametr takiego wspólnego materiału, ta zmiana natychmiast będzie widoczna na wszystkich siatkach/obiektach, które go używają (por. str. 824). Na przykład, popatrz na Rysunek 7.9.7 ze str. 452. Wszystkie żebra skrzydła używają tam tej samej siatki, więc w wyniku dodania do materiału nowej tekstury, na wszystkich pojawiły się otwory.
Podczas renderowania rezultatu, Blender musi przeliczyć uzyskane barwne obszary na konkretne piksele ostatecznego obrazu. Aby model na obrazie wyglądał jak najlepiej, wszystkie jego krawędzie są wygładzane. Steruje tym kontrolka z panelu Render:Film (Rysunek 17.2.1a). Domyślnie linie są wygładzane metodą Gaussa (Gaussian), filtrem o rozmiarze Width = 1.5 piksela (Rysunek 17.2.2a). Aby się przekonać, jak wyglądałby niewygładzony rezultat renderu, możesz maksymalnie zmniejszyć szerokość Film:Width. Co prawda wpisać zera się tam nie da, ale wartość 0.01 jest już wystarczająca. Wszystkie linie ukośne na obrazie są narysowane jako “schodki” poszczególnych pikseli (Rysunek 17.2.1c). To nie wygląda dobrze, nawet przy większej rozdzielczości (Rysunek 17.2.1b):
Rysunek 17.2.1 Próba pierwsza: zupełny brak wygładzania linii obrazu (Width = 0.0)
Porównajmy to z domyślnym filtrem wygładzania: Gaussian, Width = 1.5 (Rysunek 17.2.2):
Rysunek 17.2.2 Domyślne wygładzenie linii Blendera (Width = 1.5)
Ten rezultat wydaje się wyglądać poprawnie. Gdy rozwiniesz listę filtrów w panelu Render:Film, znajdziesz tam oprócz Gaussian jeszcze drugi typ filtru: Box. Nie używam go jednak, gdyż nie można mu regulować szerokości, tak jak filtrowi Gaussian. Efekty, które daj filtr Box są takie same, jakie pokazuje Rysunek 17.2.2.
A co by się stało, gdybyśmy zwiększyli wartość Width filtru Gaussian? Rysunek 17.2.3 pokazuje efekt uzyskany dla szerokości = 3.0:
Rysunek 17.2.3 Wzmocnione wygładzenie linii Blendera (Width = 3.0)
Choć krawędzie stały się jeszcze gładsze, to całość zaczyna wyglądać na nieco rozmytą. To niedobrze, bo takie rozmycie nie jest realistyczne. Raczej należy się wystrzegać „szerokich” filtrów wygładzania, chyba że wiesz dokładnie, co zamierzasz osiągnąć.
W praktyce dla pewnych ujęć i powiększeń będziesz potrzebował czasami nieznacznie zwiększyć szerokość filtra. Chodzi tu jednak o stosunkowo niewielkie poprawki — na tyle duże, by nie było widać granic pikseli, a na tyle małe by uniknąć efektu „rozmycia”. Tak właśnie zrobiłem na przykładzie, który jest przedstawiony przez Rysunek 17.2.4 i Rysunek 17.2.5:
Rysunek 17.2.4 Krawędzie przy Gaussian:Width = 1.5 | Rysunek 17.2.5 Krawędzie przy Gaussian:Width = 2.0 |
Rysunek 17.2.4a) pokazuje (w skali 1:1) fragment niewielkiego obrazu. Jest wygładzony standardowym filtrem (Width = 1.5). Takie wygładzenie okazało się jednak w tym przypadku niewystarczające. Na cienkich liniach krawędzi pokryw silnika granice pikseli są dość wyraźne i kontrastowe (Rysunek 17.2.4b). Ten efekt uległ złagodzeniu, gdy zwiększyłem szerokość filtru do Width = 2.0 (Rysunek 17.2.5).
Czasami pojawia się potrzeba szybkiego naszkicowania na ekranie jakiejś linii pomocniczej. W Blenderze służy do funkcja Grease Pencil. Jej nazwa pochodzi od miękkich ołówków lub kredek świecowych, którymi w latach 90-tych animatorzy 3D rysowali na szklanych ekranach monitorów różne pomocnicze linie. Grease Pencil przydaje się do zaznaczania wielu różnych rzeczy — na przykład do przeniesienia zarysu kolein z fotografii tła na podstawioną pod nim płaszczyznę „gruntu” (Rysunek 17.3.1):
Rysunek 17.3.1 Wykorzystanie linii pomocniczych do stworzenia tekstury kolein
W tym przypadku nie zależy nam specjalnie na dużej dokładności linii — uzyskany obraz kolein wykorzystamy jako teksturę w modyfikatorze Displace (por. str. 967). Kształt kolein i tak ma być rozmyty. Do takich i podobnych zdań Grease Pencil nadaje się najlepiej.
Pokażę to na przykładzie malowania obrazu zabrudzeń. Użyję tu pomocniczych linii do zaznaczenia położenia jednego z jego źródeł: karabinów skrzydłowych. Zacznijmy od ustawiania parametrów narzędzia. Otwórz przybornik (Property Shelf — N) i w panelu Grease Pencil naciśnij przycisk New Layer (Rysunek 17.3.2a):
Rysunek 17.3.2 Grease Pencil — ustawienie parametrów aktualnej warstwy
W efekcie w panelu Grease Pencil pojawi się wiele nowych kontrolek (Rysunek 17.3.2b). Co właściwie się dzieje po naciśnięciu przycisku New Layer? Tak jak w Inkscape czy GIMP, Grease Pencil rysuje swoje linie na warstwach. Ten przycisk stworzył pierwszą z nich, o domyślnej nazwie GP_Layer. W nagłówku panelu możesz także zmienić nazwę warstwy, wyłączyć jej widoczność (ikona „oka”, po lewej), czy, w ostateczności, usunąć (ikona „X” po prawej). Grease Pencil przechowuje w takich warstwach to, co naszkicujesz.
Z każdą warstwą Grease Pencil (GP) jest związany jeden rodzaj linii. W panelu warstwy określasz barwę kreski, jej nieprzejrzystość ( Opacity), oraz szerokość (Thickness). Dla GP_Layer wybierz jakiś kontrastowy kolor linii — na przykład czerwony. Oprócz tego ustaw tryb Drawing Settings:Surface (Rysunek 17.3.2b). W tym trybie linie będą rysowane na powierzchni modelu.
Gdy ustawiłeś już parametry pracy, zamknij okno właściwości 3D View (N), a otwórz jego przybornik (T). U dołu panelu Object Tools znajdziesz zakładkę Grease Pencil. Dostępne są w niej cztery tryby rysowania. Wybierz z nich tryb Draw (Rysunek 17.3.3a, b):
Rysunek 17.3.3 Grease Pencil — przejście w tryb rysowania
Naciśnięcie przycisku Draw przełącza Blendera w tryb rysowania linii pomocniczych. W pasku stanu pojawia się wówczas wskazówka, jak malować i jak wyjść z tego trybu (Rysunek 17.3.3c).
Zgodnie z tą podpowiedzią, przeciągnij po rysunku myszką z wciśniętym LPM, rysując linię pomocniczą (Rysunek 17.3.4a):
Rysunek 17.3.4 Grease Pencil — rysowanie
Grease Pencil traktuje to jako szkicowanie, i odpowiednio „często” zapamiętuje kolejne pozycje kursora jako nowe wierzchołki linii. Gdy tylko zwolnisz przycisk myszki, Blender uzna że rysowanie w trybie Grease Pencil jest zakończone, i wyjdzie z tego trybu pracy. Obejrzyj rezultaty tego rysowania, obracając model. Przy okazji przekonasz się, jak działa opcja Surface: linia „leży” na powierzchni płata (Rysunek 17.3.4b).
Do usuwania narysowanych kresek służy drugi przycisk z przybornika: Grase Pencil: Erase (Rysunek 17.3.5a). Gdy go wciśniesz, kursor zmienia się w „krzyżyk” (Rysunek 17.3.5b). Przesuwając myszkę z wciśniętym LPM wymazujesz narysowane wcześniej linie.
Rysunek 17.3.5 Grease Pencil — usuwanie linii
Jeżeli chciałbyś narysować pojedynczy odcinek linii prostej, użyj polecenia Grease Pencil: Line. Z kolei polecenie Poly pozwala rysować wielolinię, złożoną z linii prostych.
Podobnie jak w przypadku warstw GIMP czy Inkscape, warstwy Grease Pencil można chować i wyświetlać (Rysunek 17.3.6):
Rysunek 17.3.6 Grease Pencil — wyłączanie widoczności warstwy
Do tej pory wykorzystywaliśmy obraz tekstury nierówności, by zaznaczyć na modelu za pomocą Grease Pencil położenie luf karabinów maszynowych. Teraz, gdy już te linie mamy, podstawmy w to miejsce obraz zabrudzeń, na który należy nanieść odpowiednie okopcenia za lufami (Rysunek 17.3.7):
Rysunek 17.3.7 Podmiana obrazu tekstury
Czasami, gdy wybierzesz inny obiekt, linie pomocnicze mogą być początkowo niewidoczne (Rysunek 17.3.8):
Rysunek 17.3.8 Włączenie warstw Grease Pencil dla drugiego skrzydła
W takim przypadku włącz je, wybierając z listy w panelu Grease Pencil odpowiedni blok danych.
Potem możesz się już przełączyć w tryb Texture Paint (por. str. 1134) i namalować odpowiednie plamy (Rysunek 17.3.9). Dzięki odpowiednim liniom pomocniczym możesz widzieć dokładnie, gdzie umieścić źródło śladów sadzy, oraz w jakim kierunku należy rozpraszać te zabrudzenia.
W tej sekcji pokażę, jak przygotować najprostszą animację. Będzie to jednostajny obrót śmigła. Aby zacząć, przełącz się na układ ekranu do animacji (1-Animation — Rysunek 17.4.1):
Rysunek 17.4.1 Układ okien Animation
Ruch na scenie Blendera jest podzielony na pojedyncze klatki (frames). W nagłówku okna Timeline znajduje się kontrolka, w której określasz aktualną klatkę (Rysunek 17.4.1). Animowany obiekt może zajmować w kolejnych klatkach różne położenia. Linia, łącząca współrzędne takich punktów, nosi nazwę F-Curve. W układzie Animation po prawej znajduje się okno Graph Editor, służące do pracy z krzywymi F. Linię ruchu — F-Curve — najprościej jest stworzyć pokazując programowi kolejne położenia obiektu w kilku ważniejszych klatkach. Takie klatki nazywamy klatkami kluczowymi (keyframes).
Zaznacz w widoku 3D obiekt, który ma być animowany. Ustal, wpisując w kontrolkę, numer aktualnej klatki (najlepiej zacznij od 1). Następnie naciśnij (koniecznie w widoku 3D View!) klawisz I (Rysunek 17.4.2):
Rysunek 17.4.2 Wstawienie pierwszej „pozycji kluczowej” (keyframe)
Z menu, które się pojawi, wybierz rodzaj współrzędnej, która ma się zmieniać (w tym przypadku to Location).
Następnie przejdź do kolejnej klatki kluczowej — powiedzmy nr 100 (Rysunek 17.4.3):
Rysunek 17.4.3 Przygotowanie drugiej pozycji kluczowej — sto klatek dalej
(Zwróć uwagę, że spowodowało to przesunięcie w oknie Graph Editor zielonej, pionowej linii — to nasz wskaźnik aktualnej klatki). Przesuń w tej klatce uchwyt sterujący obrotem śmigła (por. str. 562) o 7-8 jednostek Blendera. Następnie znów naciśnij w oknie 3D View klawisz I. Pojawi się menu Insert Keyframe, z którego powtórnie wybierz Location 1 (Rysunek 17.4.4a):
Rysunek 17.4.4 Wstawienie kolejnej pozycji kluczowej (keyframe) — w klatce 100.
Tym razem spowodowało to dodanie do krzywych F drugiego punktu (Rysunek 17.4.4b). Linia z prostej stała się krzywą — dla parametru Z Location. Wartość tego położenia dla klatki 100 wynosi 0 (w to miejsce przesunąłeś uchwyt przed naciśnięciem I). Wygląda na to, że Blender zapamiętuje współrzędne w lokalnym układzie obiektu. Lokalna oś Z uchwytu śmigła biegnie wzdłuż globalnej osi Z, stąd taki efekt.
Dwa punkty wystarczą do poprowadzenia linii prostej, a tylko taka jest nam potrzebna do odwzorowania jednostajnego obrotu śmigła. Teraz proponuję zrobić małe porządki i usunąć z animacji linie F związane z przesunięciem wzdłuż osi X i Y — bo te parametry nie mają ulegać żadnym zmianom.
W edytorze krzywych F obowiązują podobne reguły do innych okien Blendera. Możesz zaznaczyć poszczególne linie zaznaczasz klikając w nie PPM. Na liście po prawej spowoduje to podświetlenie parametru, którego zmianę opisuje krzywa (Rysunek 17.4.5a):
Rysunek 17.4.5 Usuwanie niepotrzebnych współrzędnych krzywych F
Możesz także przejść do edycji punktów zaznaczonej krzywej (klawiszem Tab) — to odpowiednik trybu edycji siatki. Podobnie klawisz X (Channel→Delete Channels) powoduje usunięcie tego, co jest zaznaczone. Wskaż więc linię związaną z parametrem X Location i naciśnij X, by ją usunąć. Zrób to samo dla linii Y Location. Na ekranie krzywych F powinna pozostać tylko linia związana z „naszym” obrotem: Z Location (Rysunek 17.4.5b).
Dla takiego „wygiętego” kształtu krzywej śmigło obracałoby się od klatki 1 do 100, po czym cały ruch by ustał. Aby wymusić jednostajny obrót przez cały czas animacji, zaznacz tę linię, po czym przełącz jej Extrapolation Mode na Linear Extrapolation (Rysunek 17.4.6):
Rysunek 17.4.6 Końcowe dostosowania linii animacji
Teraz linia Z Location stała się pochyloną linią prostą — i o to chodziło. Gdybyś chciał zmienić nazwę zespołu krzywych F (np. z domyślnego X.005.HandleAction na Propeller) — musisz to zrobić w oknie Outliner.
Na koniec sprawdzamy „jak to się kręci”. Naciśnij w oknie 3D View klawisze Alt-A. Możesz także kliknąć odpowiedni przycisk w oknie Timeline (Rysunek 17.4.7a). Nasze śmigło zacznie się obracać (Rysunek 17.4.7b):
Rysunek 17.4.7 Test animacji
Animację możesz przerwać w każdym momencie, naciskając Esc.
Oczywiście, jeżeli obiekt nie porusza się tak, jak powinien, trzeba trochę pozmieniać jego krzywe F. Potem znów sprawdzić, uruchamiając animację. I tak dopóty, dopóki nie uzyskasz zadowalającego efektu.
Ograniczenia przypisane do obiektu obowiązują także dla ruchu wywołanego przez krzywe F.
Dlatego jeżeli chcesz, aby śmigło obracało się w nieskończoność, ustaw wartość Influence ograniczenia Limit Location animowanego w tej sekcji uchwytu X.005.Handle do 0. Jak się przekonasz, do wykonania pojedynczego ujęcia nie jest to potrzebne (wystarczy, aby śmigło obróciło się o 30-60º).
Po naciśnięciu Alt-A Blender zacznie odtwarzanie animacji tylko w aktywnym oknie 3D View. Jeżeli nawet na ekranie masz więcej okien tego typu, nie patrz na inne — tam nic się nie będzie poruszać!
Obrotem śmigła w naszym modelu steruje przesunięcie uchwytu X.005.Handle (por. str. 562), któremu przypisaliśmy odpowiedni tor ruchu wzdłuż osi Z (F-Curve — por. str. 1153). W tej sekcji omówimy jak ustawić ścieżkę ruchu uchwytu. Celem jest uzyskanie na renderze takiego obrazu rozmytych łopata śmigła, jakie widać na zdjęciach samolotu w locie.
Gdy zaczniemy od odwzorowania wartości fizycznych, to będzie wyglądać tak:
obroty silnika w trakcie lotu to około 1800 – 2400 obr/min;
przełożenie reduktora śmigła to około 1:2 (zależne od konstrukcji), stąd prędkość obrotowa śmigła to około 900 – 1200 obr/min, czyli 15-20 obr/s;
prędkość typowej animacji to 20 klatek/s;
pełen obrót śmigła to przesunięcie uchwytu sterującego X.005.Handle o 10 jednostek Blendera (tak to ustawiliśmy w ograniczeniu Transformation kołpaka śmigła);
Oznacza to, że aby odwzorować prędkość 15-20 obr/s, pomiędzy każdą klatką śmigło musi wykonać od 0.75 do 1 obrotu. Taki efekt uzyskamy przesuwając uchwyt X.005.Handle o 7.5 – 10 jednostek Blendera w każdej klatce To oznacza znaczne pochylenie krzywej ruchu (Rysunek 17.5.1):
Rysunek 17.5.1 Ustawienia krzywej ruchu (F-Curve) uchwytu sterującego obrotem kołpaka śmigła | Rysunek 17.5.2 Cycles — włączenie rozmycia ruchu |
Włącz w zestawie Render, panelu Motion Blur efekt rozmycia ruchu dla Cycles (Rysunek 17.5.2). Ta panel zawiera tylko jeden parametr — Shutter. To liczba sąsiednich klatek animacji, na z których obrazów Cycles obliczy średnią (tak się właśnie liczy rozmycie ruchu). Na razie pozostaw tu wartość domyślną (Motion Blur:Shutter= 3). Cycles nie pokazuje rozmycia ruchu na podglądzie renderu. Dlatego tym razem musisz nacisnąć F12 (albo przycisk Render) aby wykonać pełen render naszego modelu.
Rysunek 17.5.3 przedstawia rezultat — śmigło wirowało tu tak szybko, że stworzyło jednolity, prawie zupełnie przejrzysty krąg. W istocie – tak widzimy wirujące śmigło naszymi ludzkimi oczami.
Zawsze powinieneś się zastanowić, czy chcesz zrobić wizualizację tak, jakby była fotografią, czy tak jak widziałyby Twoją scenę ludzkie oczy. Czasami widzimy rzeczy w inny sposób niż nasze aparaty!
Nie wiem czy zastanawiałeś się, jak bardzo zdjęcia przyzwyczaiły nas do pewnych zniekształceń. Na renderze który pokazuje Rysunek 17.5.3 odruchowo szukamy charakterystycznych, rozmytych łopat śmigła. Jesteśmy po prostu do nich od przyzwyczajeni! Aby uzyskać taki efekt, musimy spowolnić ruch śmigła. Im krótszy czas przesłony wykonywanego zdjęcia, tym mniejszy łuk zdążą w tym czasie zatoczyć łopaty. Na zdjęciach z czasów I Wojny Światowej i z lat 20-tych XX w. widać jeszcze całe kręgi śmigieł. To dlatego, że stosowano wtedy stosunkowo długie przesłony. Później pojawił się lepszy sprzęt i wydaje mi się, że samoloty z czasów II Wojny Światowej były fotografowane z przesłoną 1/50 lub nawet 1/100 sekundy. 1/100 z 20 obr/s to 1/5 obrotu (72º). Taki ruch uzyskamy przesuwając uchwyt o 2 jednostki Blendera. Jeżeli nadal chcemy uzyskać rozmycie z uśrednienia 3 sąsiednich klatek, to oznacza że pomiędzy każdą kolejną klatką uchwyt X.005.Handle powinien się przesunąć o 2/3 jednostki Blendera. Musimy więc odpowiednio spłaszczyć naszą linię ruchu (Rysunek 17.5.4a):
Rysunek 17.5.4 Spowolnienie ruchu śmigła
Aby „zagęścić” to rozmycie, trzeba umieścić w tym obszarze więcej uśrednianych obrazów. Dlatego zwiększmy parametr Shutter od 100 (Rysunek 17.5.5a). Odpowiednio spowolnijmy ruch uchwytu, by przesuniecie o 2 jednostki Blendera zajmowało mu 100 lub więcej kolejnych ramek (Rysunek 17.5.5b):
Rysunek 17.5.5 Zwiększenie parametru Shutter i dalsze spowolnienie obrotu śmigła
Wydaje mi się że dla tych ustawień uzyskujemy odpowiedni rezultat. Dla lepszego porównania pokazuję to samo śmigło z dwoma typowymi materiałami. Rysunek 17.5.6a) przedstawia obraz wirujących łopat z wypolerowanego duraluminium, a Rysunek 17.5.6b) — czarne („antyodblaskowe”) łopaty z żółtą końcówką:
Rysunek 17.5.6 Rezultat – rozmycie ruchu dla dwóch różnych materiałów śmigła
Tworząc filmy możesz stosować zamiast łopat wymodelowany w siatce dysk, pokryty materiałem o bardzo dużej przejrzystości. Wystarczy mu nadać powolny obrót (i nie włączać opcji Motion Blur).
(W odróżnieniu od „statycznych” wizualizacji po których widz spodziewa się fotorealizmu, w filmie oczekujemy raczej efektów zbliżonych do postrzegania świata przez nasze własne oczy).
W tej sekcji zademonstruję zastosowanie edytora węzłów do kompozycji ostatecznego obrazu. Węzły, które to umożliwiają, nazywa się w Blenderze „węzłami kompozycji” (Composite Nodes). Jako przykładu użyjemy tu modelu omawianego na str. 582 i dalszych (p40\history\p-40.9.01w3.blend).
Przełącz jedno z okien Blendera na Node Editor (Rysunek 17.6.1):
Rysunek 17.6.1 Edytor kompozycji i jego dwa domyślne węzły
Aby pojawiły się w nim dwa domyślne węzły, opisujące „zwykły” rendering, musisz przełączyć się w tryb Composite Nodes i włączyć Use Nodes (Rysunek 17.6.1). Po lewej widzisz węzeł typu Render Layer. To dane wejściowe. Po prawej znalazł się węzeł typu Composite. To ostateczny obraz. Te węzły przekazują sobie (linia łącząca) piksele obrazu (Image). Dane wejściowe może dostarczać na naszym schemacie węzeł Render Layer (Rysunek 17.6.2a):
Rysunek 17.6.2 Węzeł wejściowy Render Layers i zestaw Render Layers w oknie Properties
Co to właściwie jest, ta „warstwa renderowania” ? To zespół parametrów, opisujących szczegółowo, co ma robić (i czego nie robić) wewnętrzny renderer (w tym przypadku Cycles). Domyślnie w każdej scenie istnieje jedna, domyślna warstwa renderowania, o nazwie 1 Render Layer. Szczegóły jej ustawień możesz obejrzeć w zestawie Render Layers (Rysunek 17.6.2b).
Wydaje mi się, że nazwa Render Layer niezbyt oddaje istotę rzeczy. W istocie jest to opis oddzielnego „przebiegu” renderowania sceny. Wykorzystując kontrolki z zestawu Render Layers możesz przygotować wiele alternatywnych obrazów, które później wykorzystasz jako dane wejściowe kompozytora.
U góry zestawu Render Layers znajduje się lista, z której możesz wybrać jedną z istniejących warstwę renderowania, lub zdefiniować nową (Rysunek 17.6.2b). To typowa lista, jaką spotkałeś przy okazji pracy z innymi rodzajami danych. Gdy ją rozwiniesz, zobaczysz spis istniejących elementów. Przyciski z boku pozwalają stworzyć nowy obiekt lub usunąć bieżący, a pole poniżej — zmienić nazwę. Każdą ze zdefiniowanych w scenie warstw renderowania można użyć w oddzielnym węźle Render Layer kompozytora, tworząc z ich połączeń różne zaawansowane efekty.
Panel Render Layers: Passes (Rysunek 17.6.2b) zawiera zestaw przełączników, pozwalających wybrać wyjścia udostępniane przez węzeł Render Layer (Rysunek 17.6.2a). Przełącznik Combined wyświetla powoduje udostępnienie kompletnego obrazu (wyjście Image) i ewentualnie przejrzystego tła (Alpha). Pozostałe opcje pozwalają użyć informacji cząstkowych, wykorzystywanych przez renderer do stworzenia obrazu. Na przykład Z dostarcza informacji o odległości od obserwatora każdego piksela obrazu (to liczba zmiennoprzecinkowa).
Z kolei panel Render Layers: Layers (Rysunek 17.6.3) pozwala wybierać warstwy sceny, które mają być użyte podczas renderowania obrazu.
Sekcja Scene to widoczność warstw sceny (tę samą kontrolkę masz dostępną w nagłówku okna 3D View). W odróżnieniu od pozostałych sekcji tej paneli, Scene nie jest część definicji warstwy renderowania. Warstw (tych z obiektami), które na niej wyłączysz, nie będziesz widział w widoku 3D.
Sekcja Layer to maska, pozwalająca wyłączyć na renderze widoczność wybranych warstw. Blender renderuje tylko warstwy, które są jednocześnie włączone i w sekcji Scene, i w sekcji Layer. Pamiętaj jednak, że jeżeli obiekt na takiej ukrytej warstwie rzuca cień, to ten cień będzie widoczny! Aby tak nie było — czyli aby zupełnie wykluczyć warstwę z renderowania — zaznacz ją w sekcji Exclude (Rysunek 17.6.4).
Rysunek 17.6.4 Włączenie kompozytora do przebiegu renderowania (automatycznie przetworza rezultat renderu)
Zwróć uwagę że w przykładzie przedstawionym na ilustracji wykluczyłem z renderowania warstwy z uchwytami i obiektami pomocniczymi (9,10). W ten sposób mogę wygodnie pracować nad krzywą ruchu uchwytu śmigła, bez konieczności ciągłego wyłączania warstwy 10 przed renderowanie. (Aby zobaczyć krzywą ruchu uchwytu, muszę zaznaczyć w widoku 3D View ten obiekt).
Domyślnie Blender przedstawia w oknie renderera „surowy” rezultat bieżącej warstwy renderowania. Aby przycisk Render wywoływał cały przebieg ustalony w kompozytorze, musisz w panelu Post Processing zestawu Render zaznaczyć opcję Compositing (Rysunek 17.6.4).
Wróćmy teraz do naszej kompozycji. Rysunek 17.6.5 przedstawia układ trzech okien, który stosuję do pracy z jej węzłami:
Rysunek 17.6.5 Układ ekranu do tworzenia schematu kompozycji
Okno Properties wykorzystuję do zmiany ustawień (zazwyczaj renderowania). W oknie UV/Image Editor mam podgląd obrazów. Zazwyczaj są to specjalne tymczasowe obrazy, które Blender uaktualnia na bieżąco ale nie zachowuje do pliku *.blend. Pierwszym z nich jest Render Result, zawierający rezultat ostatniego renderowania. Aby uzyskać drugi, musisz dodać do schematu co najmniej jeden pomocniczy węzeł wyjściowy typu Viewer (Rysunek 17.6.6):
Rysunek 17.6.6 Pomocniczy węzeł Viewer
Blender dodaje wówczas do listy obrazów dodatkową pozycję: Viewer Node. Możesz ją otworzyć w UV/Image Editor i dokładnie sprawdzić rezultat jakiegoś etapu przetwarzania obrazu.
Czasami węzeł Viewer nie wyświetla od razu podłączonego obrazu. Zazwyczaj dzieje się tak gdy wstawiłeś pierwszy taki element do schematu. Zazwyczaj najłatwiej jest wymusić jego odświeżenie odłączając i przyłączając ponownie wejście jakiegoś węzła który go poprzedza.
Z węzłem Viewer wiąże się dodatkowa ciekawa opcja Backdrop. Włącz ją w nagłówku Node Editor, a Blender wyświetli zawartość aktualnego węzła Viewer w tle okna kompozytora (Rysunek 17.6.7):
Rysunek 17.6.7 Włączenie obrazu Backdrop
Aby przesunąć taki obraz w tle, trzymając na klawiaturze wciśnięty klawisz Alt, „złap” tło SPM i przeciągnij w nowe miejsce. Aby pomniejszyć obraz tła naciśnij V, a aby powiększyć — Alt-V. Trzeba przyznać, że edytor węzłów z włączoną funkcją Backdrop robi wrażenie (możesz to przetestować na znajomych). W praktyce przydawał mi się do porównań przetworzonego obrazu z „surowym” renderem. (Ten drugi wyświetlałem w oknie UV/Image Editor — por. Rysunek 17.6.7).
Aby jednak było co porównywać, dodajmy do naszego schematu jakiś efekt. Obraz stworzony przez render wydaje się być trochę rozmyty, więc wyostrzmy go nieco za pomocą węzła Filter:Sharpen (Rysunek 17.6.8):
Rysunek 17.6.8 Wstawienie węzła Filter
Wybierz w węźle Filter funkcję Sharpen, i zmniejsz jej współczynnik Fac do 0.1 (Rysunek 17.6.9):
Rysunek 17.6.9 Wyostrzenie renderowanego obrazu
Porównaj rezultat „przed” i „po” (Rysunek 17.6.10):
Rysunek 17.6.10 Porównanie rezultatu z oryginalnym renderem
Filtr Sharpen zastosowany „z pełną mocą” (Fac = 1.0) zamienia nasz obraz w dzieło ekspresjonisty. Jednak wydaje mi się, że takie niewielkie wyostrzenie zwiększa realizm sceny. Praca z kompozytorem wygląda właśnie w ten sposób: dodajesz jakiś efekt, podłączasz go do węzła Viewer i sprawdzasz, czy obraz wygląda teraz lepiej. W tekście głównym pokażę kilka typowych narzędzi do poprawiania finalnego efektu. (Ten etap pracy graficy określają jako postprocessing. Osobiście uważam go za okazję do doskonałej zabawy barwami!).
Obrazy Render Result i Viewer Node możesz zapisać na dysk jako zwykłe pliki rastrowe. Wystarczy w UV/Image Editor wybrać polecenie Image→Save As….
Kompozytor to ciekawe narzędzie, które możesz także wykorzystywać do modyfikacji dowolnych obrazów rastrowych, a nie tylko rezultatów renderowania. Wystarczy użyć zamiast Render Layer węzła wejściowego typu Image (Rysunek 17.6.11):
Rysunek 17.6.11 Przykład modyfikacji plików rastrowych w Blenderze
Podłącz do takiego schematu co najmniej jeden węzeł Viewer, bo w tym przypadku Blender tworzy w UV/Image Editor tylko obraz Viewer Node. (Stąd podczas przetwarzania samych obrazów rastrowych nie ma potrzeby stosowania węzła Composite).
Aby nie wykonywać renderowania przed każdym użyciem kompozytora, możesz zapisać „surowe” obrazy renderu (i jakieś inne pomocnicze maski) na dysku jako pliki rastrowe. Potem wystarczy dodać ich węzły wejściowe do kompozytora i poddać dalszej obróbce.
Zmiana odcieni obrazu może poprawić efekt uzyskany z renderu. Pokażę to na przykładzie następującego obrazka (Rysunek 17.7.1):
Rysunek 17.7.1 Obraz początkowy
Aby lepiej pokazać, w czym rzecz, zastąpmy na razie barwy odcieniami szarości (Rysunek 17.7.2):
Rysunek 17.7.2 Wstępne przekształcenie obrazu (w kompozytorze Blendera)
Oto ten sam obraz — teraz wygląda jak czarno-biała fotografia (Rysunek 17.7.3):
Rysunek 17.7.3 Ten sam obraz w wersji monochromatycznej
Wstawmy teraz w schemat naszej kompozycji węzeł Color→Color Balance (Rysunek 17.7.4):
Rysunek 17.7.4 Węzeł Color Balance
Sama nazwa węzła sugeruje jego zastosowanie do osiągnięcia „równowagi barw”. W obróbce zdjęć oznacza to korektę, mającą na celu odtworzenie na fotografii właściwych barw neutralnych — bieli i odcieni szarości. W naszym przypadku wykorzystamy ten węzeł do uzyskania odwrotnego efektu: niewielkich zmian odcieni, poprawiających wygląd obrazu. Technika wizualizacji, którą przedstawiam w tej książce, opiera się na podstawianiu za modelem jakiegoś zdjęcia. Wykonane za pomocą węzła Color Balance subtelne „sprowadzenie do wspólnego odcienia” modelu i tła może zwiększyć wrażenie że stanowią jedność. (W grafice komputerowej używa się często określenia „poprawienie integracji z tłem”).
Color Balance zawiera trzy kontrolki barw, o nazwach Lift, Gamma i Gain. Te nazwy są związane ze stosowanym przez węzeł algorytmem korekcji1. Traktuj wartość każdej z tych barw jako coś, co jest odejmowane lub dodawane do barw obrazu. O „znaku” w tej arytmetyce barw decyduje intensywność koloru kontrolki, którą można zmieniać w zakresie od 0.0 do 2.0. Gdy kontrolka węzła Color Balance ma kolor biały (i intensywność V = 1.0) to nie zmienia obrazu wejściowego. W opisach algorytmu Lift/Gamma/Gain możesz znaleźć że:
zmiana barwy Lift zmienia ciemne barwy obrazu — czyli głównie cienie;
zmiana barwy Gamma zmienia pośrednie barwy obrazu;
zmiana barwy Gain zmienia jasne barwy obrazu (czyli głównie odbłyski);
Z takiego opisu można by wnioskować, że obszary działania tych kontrolek są ściśle podzielone, według intensywności koloru. Sprawdźmy więc to na naszym testowym obrazie. Obecnie zawiera on same odcienie szarości. Umożliwia to nam przetestowanie działania każdej z kontrolek poprzez samą zmianę jej intensywności (zmniejszenie z 1.0 do 0.5). Zacznijmy od Lift (Rysunek 17.7.5):
Rysunek 17.7.5 Wpływ zmniejszenia intensywności Lift (o połowę)
Zmniejszenie intensywności Lift powoduje przyciemnienie i pogłębia różnicę pomiędzy najjaśniejszym a najciemniejszym fragmentem obrazu.
Oczywiście zwiększenie tej wartości spowoduje efekt odwrotny: rozjaśnienie obrazu i zmniejszenie kontrastów — aż do osiągnięcia jednolitej bieli dla wartości Lift:V = 2.0.
A jaki efekt spowoduje podobne zmniejszenie o połowę odcieni pośrednich? (Gamma — Rysunek 17.7.6):
Rysunek 17.7.6 Wpływ zmniejszenia intensywności Gamma (o połowę)
Zmniejszenie intensywności Gamma przyciemnia cały obraz bardziej równomiernie niż Lift. Największej zmianie ulegają barwy o pośredniej intensywności, ale dotyczy także to w mniejszym stopniu tak cieni, jak i odbłysków.
Zwiększenie intensywności Gamma powoduje efekt odwrotny — to takie specjalne rozjaśnienie obrazu, które zachowuje w dużym stopniu kontrast pomiędzy barwami.
I wreszcie zmiana wartości Gain z 1.0 do 0.5 (Rysunek 17.7.7):
Rysunek 17.7.7 Wpływ zmniejszenia intensywności Gain (o połowę)
Zmniejszenie intensywności Gain przyciemnia wszystkie jasne barwy, zmniejszając kontrast obrazu. (Im jaśniejsza barwa, tym większa zmiana).
Zwiększenie intensywności Gain powoduje rozjaśnienie obrazu połączone ze zwiększeniem kontrastów (to taki efekt „słonecznego dnia”).
Opierając się na tych doświadczeniach, można nieco poprawić naszą „biało-czarną” fotografię. Zauważyłem, że lepiej wygląda gdy pogłębiłem nieco cienie (Lift:V = 0.85). Potem skompensowałem zmniejszenie jasności zwiększając intensywność tonów pośrednich (Gamma:V = 1.2). Na koniec zrobiłem ten dzień „bardziej słonecznym”, zwiększając intensywność bieli i odbłysków (Gain:V = 1.1).
Ustawienia Color Balance przedstawia Rysunek 17.7.8, miniaturę oryginalnego obrazu — Rysunek 17.7.9a), a rezultat — Rysunek 17.7.9b):
Rysunek 17.7.9 Korekta intensywności czarno-białego obrazu
Wielu twórców zaczynało swoje wizualizacje od obrazów w odcieniach szarości, bo takie łatwiej jest zintegrować z tłem. Zazwyczaj na koniec nadawali swoim pracom odcień sepii, aby sprawić wrażenie „historycznego zdjęcia”. Rysunek 17.7.10 przedstawia taki efekt uzyskany poprzez zmianę barwy Gamma:
Rysunek 17.7.10 Efekt „sepii”, uzyskany za pomocą zmiany odcienia Gamma
A Rysunek 17.7.11 przedstawia wykorzystanie w tym celu odcieni Gain:
Rysunek 17.7.11 Efekt „sepii”, uzyskany za pomocą zmiany odcienia Gain
Porównując rezultaty przedstawione przez Rysunek 17.7.10 i Rysunek 17.7.11 widać że Blender w każdym z nich podkreślił za pomocą tej samej barwy inne fragmenty obrazu. Wyraźnie rządziły tym efektem te same reguły, które poznaliśmy badając wpływ zmiany intensywności współczynników Lift/Gamma/Gain.
Spróbujmy teraz nadać obrazowi lekko błękitny odcień, nie zmieniając jednak intensywności składników barw Color Balance (bo te dopracowaliśmy już przed chwilą). Rezultat pokazuje Rysunek 17.7.12:
Rysunek 17.7.12 Nieznaczne zabarwienie obrazu na niebiesko
Uzyskałem to zmieniając barwę każdej z kontrolek na niebieską (H = 0.63..0.69), różniącą się tylko nasyceniem (S = 0.04 .. 0.08) (por. str. 793). A co się stanie jak teraz przywrócimy na tym obrazie barwy (Rysunek 17.7.13)?
Rysunek 17.7.13 Ten sam obraz po przywróceniu barw
Wydaje mi się że dodanie odrobiny błękitu poprawiło ostateczny efekt. Obraz wydaje się teraz chłodniejszy, i może przez to bardziej „poważny”. Porównując ten rezultat z oryginałem, znalazłem jednak pewien błąd: pióropusze morskiej piany stały się tak białe, że zniknęły z nich drobne szczegóły. Coś takiego w slangu grafików nazywa się „przepaleniem” bieli. Oznacza bezpowrotną stratę informacji o detalach, co zepsuje ewentualne dalsze efekty przetwarzania. No cóż, pozostaje zmniejszyć intensywność kontrolki Gain (Rysunek 17.7.14):
Rysunek 17.7.14 Eliminacja „przepaleń” bieli
Wydaje mi się że ogólnie obraz na tym stracił, ale można spróbować rozjaśnić sam samolot, używając maski.
Jak „wydobyć” z wyrenderowanego obrazu sam kontur samolotu? Najprostszym rozwiązaniem byłoby renderować go z przeźroczystym tłem, a potem nałożyć na obraz (używając informacji z wyjścia Alpha). Taka metoda ma jednak w Blenderze pewne wady: gubi się efekt rozmycia ruchu łopat, a niemal przejrzyste szkło kabiny zupełnie znika. Dlatego renderuję model od razu z tłem, co powoduje że wartość Alpha całego obrazu jest = 1.0 (i przez to bezużyteczna) .
Zamiast tego możemy użyć informacji o głębokości pikseli (wyjścia Z z węzła Render Layers — Rysunek 17.8.1a). Renderer używa go wewnętrznie aby określić który piksel jest bliżej kamery, a który dalej. Aby był dostępny w węzłach kompozytora, włącz w zestawie Render Layers, paneli Passes, opcję Z (domyślnie zresztą jest włączona). Jest to liczba zmiennoprzecinkowa, podająca odległość (wyrażoną w jednostkach Blendera) od powierzchni kamery do renderowanego piksela.
W scenie, którą wykorzystam jako przykład w tej sekcji, współrzędne położenia kamery to -55,185,31 (Rysunek 17.8.1b). Oznacza to, że odległość od środka modelu (ściany ogniowej kadłuba, leżącej na płaszczyźnie ZX = 0) wynosi 195 jednostek Blendera.
Rysunek 17.8.1 Informacja o odległości od kamery (Z)
Sprawdźmy w kompozytorze, czy się nie pomyliśmy. Dodaję do schematu węzeł Converter→ Math. Wybrałem w nim funkcję Less Than, która dla wartości < 195 zwraca biel, a dla pozostałych — czerń (Rysunek 17.8.2a). Rezultat jest zgodny z oczekiwaniami (Rysunek 17.8.2b):
Rysunek 17.8.2 Próba wykorzystania informacji o głębokości (Z)
Widzimy biały kontur przodu samolotu — aż do płaszczyzny odległej od kamery o 195 jedn. Blendera.
Wygląda na to, że tło ma jakąś nieskończenie dużą wartość Z. W węźle Less Than możesz więc spokojnie wpisać odpowiednio dużą liczbę, która obejmie nie jeden, a całą scenę z kilkoma maszynami (Rysunek 17.8.3a):
Rysunek 17.8.3 Pierwsza wersja maski
Zwróć uwagę, że tak uzyskana maska ma wyraźne granice pikseli (Rysunek 17.8.3b). Dodałem więc węzeł Filter→Blur, aby rozmyć jej kontury (Rysunek 17.8.4). Poprawi to także rozmyte łopaty śmigła!
Rysunek 17.8.4 Druga wersja maski — z rozmyciem
Taką maskę można użyć w kompozycji — np. do dopasowania barw samolotu do otoczenia (Rysunek 17.8.5):
Rysunek 17.8.5 Zastosowanie maski do zmiany odcienia modelu
Sądzę, że taka maska może się często przydawać, więc przekształciłem te węzły w grupę. Nadałem jej nazwę Object Mask (Rysunek 17.8.6):
Rysunek 17.8.6 Grupa Object Mask
Będę ją importował z pliku do pliku — zawsze to łatwiejsze niż tworzenie tego efektu za każdym razem od nowa. Mogę dodać ją także do szablonu nowego pliku Blendera. Do schematu grupy na wszelki wypadek dodałem, oprócz testu na największą odległość, także test na najmniejszą odległość. Może się kiedyś przydać do precyzyjnego wyboru obiektu (np. tylko drugiego samolotu lecącego w szyku).
Efekt rozmycia obrazu w jednym kierunku pozwala stworzyć bardzo silne wrażenie prędkości, dynamiki (Rysunek 17.9.1):
Rysunek 17.9.1 Wykorzystanie poziomego rozmycia tła
Do uzyskania rozmycia kierunkowego w kompozytorze służy węzeł Filter→ Directional Blur (Rysunek 17.9.2):
Rysunek 17.9.2 Schemat kompozycji po dodaniu węzła Directional Blur
Włączyłem węzeł Directional Blur do schematu kompozycji. Umieściłem go przed węzłem Color Balance, bo te dwa efekty zupełnie sobie nie przeszkadzają. Domyślnie Directional Blur ma wszystkie parametry ustawione na wartościach neutralnych, i niczego nie zmienia na obrazie wynikowym. Kontrolki węzła pozwalają uzyskać trzy kształty rozmycia:
Liniowe (tzn. cały obraz przesunięty w jednym kierunku: kontrolki Distance, Angle:);
Koncentryczne (tzn. „w gwiazdę” — kontrolki Zoom i Center);
Spiralne (kontrolki Spin i Center);
Można stosować także złożenia tych efektów. Zacznijmy rozmycia liniowego. Spróbowałem wywołać rozmycie w kierunku poziomym (Directional Blur:Angle = 0) zwiększając Directional Blur:Distance z 0.0 o 1.0. Spowodowało to poważne zmiany w obrazie (Rysunek 17.9.2 pokazuje je w podglądzie pod węzłami). Jednak to w ogóle nie wygląda jak jakiekolwiek rozmycie! Dlaczego?
Po pierwsze, wygląda na to że wartość Distance jest wyrażona w proporcji do rozmiaru obrazu. Spróbuj ją zmniejszyć do 0.5, a rezultat zacznie się „zagęszczać” (Rysunek 17.9.3):
Rysunek 17.9.3 Wpływ zmniejszenia wartości Distance (do 0.5)
Gdy zmniejszysz Distance do wartości rzędu 10% rozmiaru obrazu lub mniej, poszczególne elementy zaczną się na siebie nakładać (Rysunek 17.9.4):
Rysunek 17.9.4 Wpływ zmniejszenia wartości Distance (do 0.1)
Drugim bardzo ważnym parametrem jest liczba iteracji (Iterations). Aby się o tym przekonać, zwiększ teraz jej wartość z 1 (brak iteracji) do 2 (Rysunek 17.9.5):
Rysunek 17.9.5 Wpływ zwiększenia wartości Iterations (do 2)
Gdy zwiększysz liczbę iteracji jeszcze bardziej, zobaczysz wreszcie na obrazie efekt przypominający rozmycie ruchu (Rysunek 17.9.6):
Rysunek 17.9.6 Wpływ zwiększenia wartości Iterations (do 4)
Co prawda w ten sposób rozmyciu uległo wszystko — i tło, i samoloty. Jak wykluczyć z tego pierwszy plan?
Aby rozmyć samo tło, musimy nałożyć na siebie dwa obrazy. Pierwszy z nich zawiera rozmytą fotografię bez samolotów, a drugi — same samoloty. Trzeba to jednak zrobić tak, aby barwy otoczenia widocznego za przejrzystym oszkleniem kabiny pasowały do obrazu tła. Aby uzyskać obraz samego otoczenia bez samolotów, przygotowałem drugą warstwę renderowania, o nazwie 2 Background (Ustawioną tak, jak pokazuje Rysunek 17.9.7).
Dodałem ją do schematu jako dodatkowy węzeł Render Layer (Rysunek 17.9.8). Obraz z tego węzła poddałem umiarkowanemu rozmyciu w poziomie (Distance = 0.02, Iterations = 5). Następnie użyłem maski (Object Mask — por str. 1171) aby rezultat rozmycia „podłożyć” jako tło pod ostre sylwetki samolotów z warstwy 1 RenderLayer. (Maska sylwetek samolotów jest użyta w charakterze współczynnika w węźle Color→Mix — por. Rysunek 17.9.8):
Rysunek 17.9.8 Użycie dwóch warstw renderowania do wykluczenia z rozmycia sylwetek samolotów
Na uzyskanym w ten sposób obrazie samoloty faktycznie wydają się mknąć ponad powierzchnią morza. Razi tylko nieco rozmyty ciemny pasek z prawej strony. To efekt uboczny działania Directional Blur. Podczas komponowania położenia modeli na scenie warto zawczasu przewidzieć pewien naddatek na ten artefakt. W tej scenie pozostawiłem trochę więcej przestrzeni z lewej, więc przeniosę go tam zmieniając kierunek rozmycia na przeciwny. Ustawiłem wartość kąta Angle z 0º na 180º (Rysunek 17.9.9):
Rysunek 17.9.9 Przeniesienie „czarnego paska” na przeciwległą krawędź obrazu
Na koniec pozostaje odciąć naddatek z lewej strony obrazu za pomocą węzła Distort→ Crop (Rysunek 17.9.10):
Rysunek 17.9.10 „Przycięcie” obrazu
Uważaj na węzeł Corp: w odróżnieniu od większości pozostałych nie jest wstawiany do schematu w stanie „neutralnym” (tzn. takim, który nic nie zmienia). Rysunek 17.9.10a) podaje w objaśnieniu, jakie należy wpisać wartości parametrów Left, Right, Up, Down aby obraz pozostał nie naruszony. Te wartości są wyrażone jako proporcje odpowiedniego boku (1.0 = 100%). Stąd, aby odciąć 3% szerokości z lewej, wpisałem Corp:Left = 0.03.
Do stworzenia samego tła potrzeba tylko kilku próbek renderera. Gdy uzyskujemy ten obraz z oddzielnej warstwy renderowania (2 Background), Blender renderuje ten fragment taką samą liczbą próbek jak dla kompletnego modelu. (Liczba próbek jest wspólna dla wszystkich warstw renderowania na scenie).
Jeżeli chcesz uniknąć niepotrzebnego renderowania obrazu tła, stwórz nową scenę (wywołując tę operację z opcją Copy Settings — por. str. 792). Z listy w zestawie World wybierz to samo środowisko (World) co w scenie podstawowej. Na koniec dodaj (Object→Make Links→Object to Scene) do nowej sceny link do obiektu kamery i ustaw w panelu Sampling zestawu Render odpowiednio małą liczbę próbek (np. 10).
Do dynamicznych ujęć z przodu lepiej pasuje1 rozmycie koncentryczne (Rysunek 17.9.11):
Rysunek 17.9.11 Koncentryczne rozmycia obrazu tła
Rozmyciem koncentrycznym obrazu sterują w węźle Directional Blur dwa parametry:
Rysunek 17.9.12 przedstawia geometrię tej deformacji obrazu:
Rysunek 17.9.12 Parametry sterujące koncentrycznym rozmyciem obrazu
Współrzędne X, Y punktu centralnego są wyrażone w sposób względny, jako ułamki odpowiednio: szerokości i wysokości renderowanego obszaru. Stąd wartość 0,0 oznacza lewy dolny narożnik, a 1,1 — prawy górny. Wydaje mi się że skala wartości Zoom jest zbliżona do skali parametru Distance — Zoom = 0.1 oznacza już znaczącą deformację na zewnętrznych granicach obrazu.
Przy stosowaniu koncentrycznego rozmycia tła należy ustawić osie użytych w scenie samolotu/samolotów wzdłuż promieni wychodzących z punktu centralnego (Rysunek 17.9.13):
Rysunek 17.9.13 Uzgadnianie kierunku rozmycia tła i osi modelu
Jeżeli tego nie zrobisz, samolot na obrazku będzie wyglądał jak gdyby lekko trawersował. Uzgodnienie osi możesz uzyskać dopasowując położenie modelu w kamerze do tła, albo zmieniając współrzędne Center w węźle Directional Blur.
Rysunek 17.9.14 przedstawia podstawienie takiego modelu i tła do wypracowanego w tej sekcji schematu:
Rysunek 17.9.14 Rezultat (wersja z użyciem maski)
Aby uniknąć brzydkiego rozmycia łopat śmigła można najpierw wygenerować sam plik tła (Rysunek 17.9.15):
Rysunek 17.9.15 Zapisanie rozmytego obrazu tła do pliku
Potem wystarczy podstawić ten rozmyty obraz jako nową teksturę tła (Rysunek 17.9.16):
Rysunek 17.9.16 Zwykła kompozycja modelu z wcześniej rozmytym tłem
Do modelowania różnych „masowych i stochastycznych” obiektów, jak włosy czy trawa (a także innych, jak dym czy płomień) stosuje się w Blenderze tzw. „cząsteczki” (Particles). Można ich użyć do stworzenia całych pól i trawników. Pokażę tu jedynie dość specyficzne zastosowanie takiego systemu cząstek. W tej książce korzystamy z modelu z podstawionym, w charakterze tła, zdjęciem (por. str. 596, Rysunek 9.2.14). Obraz trawy już na nim jest. Ten sam obraz jest nałożony (w trybie mapowania Window) na płaszczyznę podłoża. Jedyne, co należy zrobić, to „uwiarygodnić” połączenie modelu i tła. Służy do tego m.in. umieszczenie na podłożu stosunkowo rzadkich źdźbeł trawy. Ich podstawowym zadaniem jest „złamanie” gładkich krawędzi i wnętrza cienia, rzucanego przez samolot (Rysunek 17.10.1):
Rysunek 17.10.1 Efekt dodania źdźbeł trawy wokół i wewnątrz cienia samolotu
Rysunek 17.10.1a) przedstawia cień samolotu, rzucany na powierzchnię imitującą grunt. Intensywnością cienia steruje się, zmieniając przejrzystość powierzchni — por. str. 596. Krawędź cienia jest tu idealnie gładka, a przecież biegnie po ziemi, porośniętej drobną trawą. Także wnętrze cienia jest tu jakieś takie …płaskie.
Rysunek 17.10.1b) przedstawia tę samą powierzchnię, ale z odpowiednio przygotowanym „efektem trawy”. Zwróć uwagę, jak pojedyncze, oświetlone słońcem źdźbła zaburzają tu przednią krawędź cienia. Tylna krawędź także jest poprzecinana zacienionymi źdźbłami, a we wnętrzu „coś jest”, dzięki czemu ten obszar nie wygląda zupełnie płasko. W tej sekcji pokażę, jak osiągnąć taki właśnie efekt.
Trawa w Blenderze wyrasta („jest emitowana”) z siatki, więc zaczynamy od przygotowania powierzchni, która ma być pokryta trawą. Stworzyłem mniejszą kopię podłoża (Ground) i nazwałem ją Grass (Rysunek 17.10.2a):
Rysunek 17.10.2 Przygotowanie siatki (emiter)
Ten obiekt przesunąłem na niewielką odległość pod podłoże (Rysunek 17.10.2b). Zmieniłem także nazwę siatki, przypisanej do Grass (na taki sam jak obiektu).
Następnie zmieniłem kształt tej pomocniczej płaszczyzny, aby nie wystawała zbytnio za obszar objęty przez kamerę (Rysunek 17.10.3):
Rysunek 17.10.3 Siatka w kamerze — przymiarka do cienia samolotu
Tę modyfikację wprowadzałem posługując się dwoma oknami 3D View. Przesuwałem wierzchołki w widoku prostopadłym do płaszczyzny, jednocześnie patrząc gdzie się znajdują w widoku z kamery.
Potem sprawdź jeszcze w podglądzie renderu, czy obszar „trawy” obejmuje cały cień samolotu (Rysunek 17.10.4). Nie zawsze trzeba pokrywać wszystko — pewne fragmenty cienia mogą pozostawać poza siatką. To zależy od rozłożenia roślinności na zdjęciu tła.
Na następnych stronach przekonasz się, że każde źdźbło trawy będzie „wyrastać” z pojedynczej ściany siatki. Dlatego musimy ją teraz zagęścić (Rysunek 17.10.5):
Rysunek 17.10.5 Zagęszczenie siatki podłoża trawy
Najpierw „przecinam” powierzchnię krawędziami w jednym kierunku. Robię to za pomocą polecenia przybornika Loop Cut and Slide (skrót: Ctrl-R). Gdy po jego wywołaniu zaczniesz obracać KM, Blender zaproponuje stworzenie nie jednej, a wielu krawędzi. Ustawiłem tą operację na wykonanie 20 nowych sekcji (Rysunek 17.10.5a). W podobny sposób dodałem krawędzie w kierunku poprzecznym (Rysunek 17.10.5b). Dodatkowo można zagęścić tę siatkę w sposób dynamiczny — modyfikatorem Subdivision Surface.
Gdy kształt „trawnika” masz już przygotowany, przejdź do zestawu Particles i stwórz tam nowy system cząsteczek (Rysunek 17.10.6):
Rysunek 17.10.6 Stworzenie nowego systemu cząstek (Particle System)
U góry zestawu znajduje się lista zdefiniowanych systemów cząsteczek. Na razie jest pusta. Naciśnij przycisk , umieszczony z prawej strony. Stworzysz w ten sposób nowy system cząsteczek (o domyślnej nazwie ParticleSystem). Zmień od razu nazwę na inną (np. Grass) i typ systemu na Hair (Rysunek 17.10.7a):
Rysunek 17.10.7 System cząsteczek Grass — ustawienia
Koniecznie zaznacz także opcję Advanced, by wstawić panele Velocity i Phisics. Pole Number z panelu Emission (Rysunek 17.10.7b) steruje gęstością trawy. Po włączeniu opcji Advanced, długością i orientacją źdźbeł trawy steruje panel Velocity (każde źdźbło to jakby „ślad” poruszającej się cząsteczki). W sekcji Emitter Geometry parametr Normal odpowiada za długość trawy, a w sekcji Other parametr Random — za losowe odchylenia tej długości. Długość trawy ustawiam tak, by pasowała do zdjęcia.
Aby nadać źdźbłom losowe pochylenia, w panelu Physics zwiększ wartość parametru Brownian — np. do 0.1 (Rysunek 17.10.8a). (Chodzi tu o chaotyczne odchylenia — w fizyce nazywane „ruchami Browna”):
Rysunek 17.10.8 Efekt na siatce
W trakcie tych ustawień zapewne zauważyłeś zmiany, widoczne w widoku 3D View. Blender rysuje źdźbła trawy Grass jako małe, wygięte kreski (Rysunek 17.10.8b). Nie są specjalnie wyraźne, bo sama trawa jest krótka, taka jak na lotniskach polowych. W dodatku w 3D View mają różny odcień (zapewne w wyniku różnic w orientacji normalnych). Ich kształt, kierunek itp. odpowiadają wartościom wpisanym w panelach Emission, Velocity i Physics. Możesz tu na bieżąco obserwować, jaki wpływ na trawę mają zmiany poszczególnych parametrów (Normal, Random, Brownian, …).
Im więcej źdźbeł trawy — tzn. im większa wartość Emission:Number (por. Rysunek 17.10.7b) — tym większy rozmiar pliku Blendera! Gdy ustawisz tę liczbę na 10 000, to rozmiar pliku zwiększy się o 2 MB.
Istnieje oszczędniejsza metoda zagęszczenia trawy: stworzenie wokół każdego źdźbła tzw. emisji potomnych (Children). Parametry tego efektu ustawia się w panelu Children (Rysunek 17.10.9):
Rysunek 17.10.9 Zagęszczenie trawy za pomocą emisji potomnych (Children)
Najważniejsze są tu parametry z grupy Children:Effects. Na ilustracji oznaczyłem je kolorem żółtym. Zmieniłem także inne parametry, które zaznaczyłem na czerwono. To raczej zmiany opcjonalne, bo ich wpływ nie jest duży.
Na razie nasza trawa to niematerialne „druciki”. Teraz trzeba nadać źdźbłom kształt na renderowanym obrazie (graficy nazywają to „przypisaniem instancji”). Metody dostępne w Blenderze (Rysunek 17.10.10) można podzielić na dwie grupy:
Użycie tych „drucików” wygenerowanych przez system cząsteczek jak krzywych, wzdłuż których można wygiąć pewną wzorcową siatkę. W tym celu należy w panelu Render wybrać tryb Object lub Group. Pojawią się wówczas odpowiednie pola, w których można wpisać nazwę wzorcowej grupy lub obiektu. Ta metoda daje użytkownikowi pełną kontrolę nad kształtem „wyhodowanej” w ten sposób trawy. Jest jednak bardziej pracochłonna (trzeba stworzyć to wzorcowe źdźbło);
Utworzenie przez renderer automatycznego obrazu źdźbła/włosa wzdłuż każdej cząsteczki. Służy do tego opcja Render: Path. To szybsza metoda, choć nie tak dokładna jak pierwsza;
W tej ilustracji potrzebujemy tylko prostej trawy aby „złamać” krawędzie cienia pod samolotem, użyjemy więc tej prostszej metody (Render:Path — jest to zresztą metoda domyślna). To spowoduje pojawienie się na końcu zestawu Particles paneli Cycles Hair Rendering i Cycles Hair Settings. Ustaw ich parametry tak, jak pokazuje to Rysunek 17.10.11).
Siatka trawy ma zazwyczaj przypisane dwa materiały. Pierwszy z nich to materiał podłoża. W naszym przypadku najlepiej, aby był zupełnie przejrzysty: nie będzie przeszkadzał w sterowaniu przejrzystością podstawowej płaszczyzny Ground (por. str. 1180). Drugi materiał to materiał nałożony na źdźbła trawy. Na naszym obrazie powinien mieć takie same barwy jak obraz podłoża. Użyjemy więc na początek materiału Ground. W siatce Grass przypisałem go do slotu 2 (Rysunek 17.10.12a), i wybrałem ten materiał w panelu Particles: Render (Rysunek 17.10.12b):
Rysunek 17.10.12 Wstępne ustawienia materiałów siatki Grass
Slot 1 na razie pozostawiam pusty, aby materiał podłoża był na renderze zupełnie biały. Chcę po prostu za pierwszym razem zobaczyć źdźbła trawy na jakimś kontrastowym tle i przekonać się że w ogóle istnieją i jaką mają gęstość. Uzyskany rezultat przedstawia Rysunek 17.10.13.
Wygląda na to że gęstość trawy na renderze jest o wiele mniejsza niż na podglądzie, który mamy w 3D View. W dodatku źdźbła sprawiają wrażenie ciemnych — ale może to wpływ białego podłoża? Z drugiej strony wygląda na to że światło słońca odbite od tej testowej białej powierzchni rozjaśnia wszystko wokół (zwróć uwagę że spód samolotu jest tu jaśniejszy niż na renderze z str. 1180)…
Pozostaje sprawdzić te wątpliwości dla takiego podłoża, jakie chcemy zastosować na ostatecznym renderze. Przypiszmy więc teraz do siatki Grass docelowe materiały (Rysunek 17.10.15):
Rysunek 17.10.14 Ostateczne przypisanie materiałów do siatki Grass
Ścianom z których jest „emitowana” trawa przypisany jest materiał ze slotu 1, o nazwie Empty (Rysunek 17.10.15b). To zupełnie przejrzysta, biała powierzchnia (Rysunek 17.10.15c). Trawie przypisałem kopię materiału Ground, którą nazwałem Grass (zaraz zobaczysz, dlaczego taki podział jest potrzebny). Aby jednak obydwa materiały — Grass i Ground — korzystały z tych samych tekstur, ustawionych w ten sam sposób, w obydwu wykorzystuję pomocniczą grupę X.Ground. Jej parametrami są nieprzejrzystość (Opacity) i intensywność barw tekstury (Intensity).
Jak więc wygląda nasza trawa na renderze? Pokazuje to Rysunek 17.10.15:
Rysunek 17.10.15 Próbny render trawy (Grass = Ground)
Teraz można powiedzieć na pewno, że jest zdecydowanie za ciemna! Dodatkowo wyraźnie widać że trzeba zmienić jej gęstość, aby rosła tam, gdzie na zdjęciu są kępki trawy.
Aby coś poradzić na zbyt ciemne źdźbła, spróbujmy zwiększyć intensywność kolorów w materiale Grass, zwiększając parametr X.Ground:Intensity z 0.4 do 2.0. Otrzymamy o wiele lepszy wynik (Rysunek 17.10.16):
Rysunek 17.10.16 Próbny render trawy (zwiększona jasność barw w materiale Grass)
Całość wygląda o wiele lepiej! Oświetlone obszary trawy stały się jasne (może nawet odrobinę za bardzo), a te w cieniu pasują teraz do odcienia zdjęcia. Myślę, że odpowiednia intensywność X.Ground dla trawy na tym obrazie jest w zakresie od 1.8 do 2.0.
Do sterowania lokalną gęstością trawy użyjemy wag, malowanych na powierzchni siatki (por. str. 958). Najpierw stwórz nową grupę wierzchołków o nazwie Density, a potem przypisz do niej wszystkie wierzchołki siatki emitera (Grass) (Rysunek 17.10.17):
Rysunek 17.10.17 Stworzenie w siatce emitera trawy grupy Denisity
(Więcej o grupach wierzchołków znajdziesz na str. 945). Potem przejdź do zestawu Particles. W panelu Vertex Groups przypisz parametrowi Density przygotowaną przed chwilą grupę wierzchołków (Density) (Rysunek 17.10.18):
Przy okazji — zwróć uwagę na pozostałe parametry, którymi możesz sterować za pomocą wag. Na przykład — długość trawy (Length). Wystarczy zdefiniować kolejną grupę wierzchołków i przypisać ją tutaj. (Pamiętaj, że ten sam wierzchołek siatki może należeć do wielu grup, więc nie ma tu żadnego konfliktu — możesz stworzyć wiele grup wierzchołków obejmujących całą siatkę, każdą z inną wagą).
Teraz przełącz się w tryb Weight Paint (szczegóły — por. str. 958) i zamaluj wagą = 0 ściany siatki na które na pewno nie będzie padał cień samolotu (Rysunek 17.10.19):
Rysunek 17.10.19 Malowanie gęstości trawy
W trakcie malowania zobaczysz, jak znikają z nich źdźbła. To bardzo wygodna informacja zwrotna: możesz na bieżąco decydować, gdzie zwiększyć wagę (kolor czerwony), a gdzie zmniejszyć (kolor niebieski). Trawę powinniśmy zostawić tam, gdzie pada cień samolotu. Ale gdzie to dokładniej jest? Spróbowałem obrysować te obszary za pomocą narzędzia Grease Pencil (por. str. 1149) — cień na niebiesko, kępki trawy na czerwono (Rysunek 17.10.20):
Rysunek 17.10.20 Zaznaczanie obszaru cienia i trawy (Grease Pencil)
Inną metodą na znalezienie cienia samolotu na podłożu jest ustawienie w 3D View aksonometrycznej projekcji (Ortho) wzdłuż promieni słońca (View→Align View→Align View to Selected→Top). Wtedy wystarczy zamalować na niebiesko (tzn. wagą = 0) obszaru nie zasłoniętego przez samolot (Rysunek 17.10.21a):
Rysunek 17.10.21 Zaznaczanie obszarów z trawą (c.d.)
Gdy trawa pozostała w cieniu samolotu, w widoku z kamery (0) „wytnij” prześwity pomiędzy kępkami odrysowanymi ze zdjęcia (Rysunek 17.10.21b).
Na czas modyfikacji siatki w trybie Weight Paint, trawa znika z podglądu renderu. Pojawi się ponownie, gdy przełączysz aktualny tryb na Object Mode.
Rysunek 17.10.22 przedstawia kolejny próbny render. Widać na nim bardziej naturalną, nieregularną gęstość trawy, z lokalnymi prześwitami:
Rysunek 17.10.22 Rezultat — cień samolotu zaburzony przez kępki trawy
Czytając wcześniejsze rozdziały, zapewne przekonałeś już się, że uwielbiam umieszczać u dołu strony przypisy z dodatkowymi informacjami. Ta część książki to właściwie wybór takich “uwag na marginesie”, które w trakcie pisania urosły do rozmiaru całej sekcji ☺.
Jak w każdym dodatku, są to informacje, z których nie musisz korzystać, aby stworzyć e-model samolotu. Czasami jednak mogą się przydać, by coś wyjaśnić lub ułatwić. Mam jednak nadzieję, że znajdziesz tu rozwinięcie wielu zagadnień, które świadomie skracałem w głównym tekście książki.
Można powiedzieć, że jest to rozdział dla prawdziwych modelarzy — istot, które chcą odtworzyć pierwowzór najdokładniej, jak to jest możliwe. Efektem porównań, które pokażę poniżej, będzie poprawiona sylwetka P-40. Szczerze mówiąc, metody, które tu przedstawiam, pozwoliłyby opracować solidne plany modelarskie. Nie to było to jednak w tym przypadku moim celem.
Znalazłem w Internecie ([1] ) obrazy kilku rysunków fabrycznych P-40. Niestety, nie mają zbyt dużej rozdzielczości, więc większości wymiarów nie można odczytać (Rysunek 18.1.1). Mimo tego się przydadzą. W tej sekcji spróbujemy porównać z nimi odpowiednie fragmenty planów samolotu.
Rysunek 18.1.1 Przykładowy, zeskanowany rysunek fabryczny (z www.p40warhawk.com)
To porównanie wykonamy w Inkscape (wprowadzenie — patrz str. 679), a nie w GIMP. Dlaczego? W Inkscape wygodniej jest skalować i obracać obrazy. GIMP na czas takiej operacji wyłącza wszelkie “przejrzystości” warstw. Inkscape podczas transformacji niczego nie przełącza ani nie wyłącza - warstwy pozostają przejrzyste. Dzięki temu przez cały czas nie tracisz z oczu wzorca, do którego się dopasowujesz. To ogromna różnica. Dopóki nie chcemy ingerować we “wnętrze” porównywanych rysunków, Inkscape jest lepszym narzędziem porównawczym.
Zaczniemy od weryfikacji kształtu usterzenia poziomego. Zmień nazwę pierwszej warstwy (utworzonej domyślnie w nowym rysunku przez Inkscape) z Layer 1 na Image (szczegóły — str. 686). Dodaj także drugą warstwę — nazwijmy ją Drawing.
W warstwę Image wstawimy obraz rzutu z lewej:
wybierz warstwę Image jako aktualną;
wczytaj (File→Import, str. 682) plik P40C-ML-Left.tif (por.str. 55);
dosuń wczytany rysunek do lewego górnego narożnika obrazu (Rysunek 18.1.2):
Rysunek 18.1.2 Przesuwanie obrazu na docelowe miejsce
Na koniec zablokuj warstwę Image przed zmianami (p. str. 686). Dzięki tej blokadzie nie będziesz w stanie omyłkowo zaznaczyć i przesunąć obrazu.
Teraz załadujemy rysunek fabryczny steru kierunku na warstwę Drawing:
wybierz warstwę Drawing jako aktualną;
wczytaj Source\Curtiss\Tail-Rudder framework.gif (z pliku source.zip — por. str. 22)
Rysunek 18.1.3 pokazuje rezultat:
Rysunek 18.1.3 Rysunek steru kierunku, zaraz po wczytania
Jak widać (Rysunek 18.1.3), wczytany obraz musimy nieco przygotować, nim zaczniemy przymierzać do planów:
wywołaj polecenie Object→Rotate 90º CW (lub użyj przycisku z paska skrótów);
ukryj na razie warstwę Image (p. str. 686);
zmniejsz nieprzejrzystość warstwy Drawing do 60% (p. str. 686);
Rysunek 18.1.4 pokazuje rezultat:
Rysunek 18.1.4 Wstępne przygotowanie rysunku
Zbliż się do obrazu steru kierunku (str. 685) i przyjrzyj mu się uważnie. Czy osie są proste? Czy są wzajemnie prostopadłe? (Rysunek 18.1.5):
Dodaj do rysunku kilka linii pomocniczych (p. str. 692). Rozmieść je tak, by można było sprawdzić, czy kluczowe linie rysunku są pionowe lub poziome.
W przykładzie, który pokazuje ilustracja (Rysunek 18.1.5), wygląda na to, że oś steru ma odchylenie. Jednocześnie linie żeber są poprawne, czyli poziome. Taka sytuacja oznacza, że rysunek ma drobne przekoszenie. Będzie to trzeba poprawić przez transformację odwrotną (por. Rysunek 18.1.6c, szczegóły — str. 711).
Musimy jednak wcześniej zadbać o właściwe położenie środka tego przekoszenia (p. str. 708). Przesuń rysunek tak, by dolny zawias steru znalazł się tam, gdzie przecinają się dwie linie pomocnicze. Następnie przesuń w to miejsce także środek obrazu (Rysunek 18.1.5, Rysunek 18.1.6b).
Rysunek 18.1.6 pokazuje szczegóły przekoszenia (Skew), którym skorygujemy odchylenie osi na rysunku fabrycznym (Rysunek 18.1.6a). Środkiem tej transformacji jest punkt, w którym oś rysunku pokrywa się z linią pomocniczą (Rysunek 18.1.6b):
Rysunek 18.1.6 Korygowanie przekoszenia obrazu
Tak niewielkie przesunięcia, jak przedstawiona powyżej, staraj się wykonać w jak największym powiększeniu. (Wystarczy widzieć na ekranie uchwyt, który masz „złapać” myszką, i mieć trochę miejsca na przesunięcie).
Rysunek 18.1.7 pokazuje, w jakim powiększeniu można wygodnie i dokładnie skorygować niewielką deformację osi. Widzimy tu tylko fragment ramki obrotu (Rysunek 18.1.7a). To nic nie szkodzi, bo najważniejszy element — uchwyt przekoszenia — jest nadal dostępny do “złapania”. Na ekranie jest także miejsce na jego przesunięcie.
Rysunek 18.1.7 Przykład powiększenia, w którym koryguję oś steru
Przeciągnij uchwyt w prawo tak, by oś na obrazie pokryła się z linią pomocniczą (Rysunek 18.1.7).
Jeżeli w czasie przeciągania drgnęła Ci ręka - dopóki nie zwolnisz LPM, możesz nacisnąć Esc. To przerwie całą operację.
Jeżeli już skończyłeś - i skrzywiłeś rysunek - zawsze możesz wycofać ostatnie polecenie (Edit→Undo, albo Ctrl-Z).
Włącz z powrotem widoczność warstwy Image, z sylwetką samolotu. Nasuń (por. str. 707) obraz steru na sylwetkę tak, by w tym samym miejscu miały dolny zawias. (Pamiętasz? tam umieściliśmy środek tego obrazu). Zmniejsz rysunek steru, za pomocą narożnego uchwytu ramki (Rysunek 18.1.8). Zrób to, tak, by rozmiar zmienił się proporcjonalnie względem ustalonego środka transformacji. (Trzymaj wciśnięte klawisze Shift i Ctrl — por. str. 709)
Rysunek 18.1.8 Nanoszenie rysunku fabrycznego na sylwetkę samolotu
Podobnie jak rysunek steru kierunku, wczytaj i dopasuj rysunek statecznika pionowego (plik Source\Curtiss\Tail-Fin.gif, z pliku source.zip). Uwaga: rysunek jest nieco obrócony i przekoszony — popraw go nim złożysz ze obrazem steru. Statecznik dopasuj do steru tak, by pokrywały się ich osie oraz punkty zawiasów. Obraz statecznika umieść na tej samej warstwie, co obraz steru (Drawing).
Rysunek 18.1.9 przedstawia ostateczny efekt nałożenia rysunków fabrycznych na rzut z lewej. Widać różnice pomiędzy liniami planów modelarskich i dokumentacji samolotu. To, że są niewielkie, dobrze świadczy o autorach planów.
Rysunek 18.1.9 Efekt nałożenia rysunków fabrycznych na rzut z lewej
Gdy znaleźliśmy takie różnice — warto je uwzględnić przy budowie modelu. Jednak korzystanie wprost z rysunków fabrycznych bywa trochę nieporęczne. Jest ich dużo, i zawierają sporo nieczytelnych wymiarów. (Takie wymiary są zupełnie bezużyteczne). Proponuję nanieść na rzut z lewej poprawiony obrys usterzenia pionowego, odpowiadający rysunkom fabrycznym. Linię tego obrysu narysujemy w Inkscape, na oddzielnej warstwie. Nazwiemy ją — Correction. Aby nasze poprawki odróżniały się od reszty rysunku, wszystko na tej warstwie będzie w kolorze czerwonym. Złożenie warstw Correction i Image wyeksportujemy jako rysunek rastrowy (por. str. 684) P40C-ML-Right.png, który użyjemy w Blenderze.
Zróbmy to. Zablokuj warstwę Drawing przed zmianami. Dodaj do rysunku nową warstwę — Correction (str. 687).
Rysowanie poprawek zaczniemy od naniesienia osi i kilku linii pomocniczych. Narysujemy je w kolorze niebieskim, by zaznaczyć w ten sposób, że nie są żadnym “namacalnym” elementem konstrukcji.
Narysuj linię osi steru (Rysunek 18.1.10). Po narysowaniu pierwszej linii przestaw (por. str. 695):
grubość na 0.5 px;
wzór na linię kreskowaną;
barwę na kolor niebieski.
(Dopóki tych ustawień nie zmienisz, każdy kolejny obiekt, który narysujesz, będzie miał właśnie taką grubość, barwę i wzór).
Na rysunku statecznika pionowego znajduje się także oś i zarys profilu statecznika poziomego. Teraz narysuj samą oś, potem skopiuj także profil. (Na wszystkich planach modelarskich statecznik wydaje się mieć zbyt zaokrągloną krawędź natarcia. Dokumentacja fabryczna i zdjęcia wskazują raczej na zastosowanie profilu z ostrym noskiem — p. str. 1245).
Rysunek 18.1.10 Naniesienie na rysunek osi steru i kilku pomocniczych obrysów
Rysunek 18.1.10 zawiera, oprócz linii, także okrąg. Na planach fabrycznych jest zaznaczone, że obrys zaokrąglonej końcówki statecznika był łukiem. Aby to sprawdzić, umieściłem w podanym przez plany środku okrąg, o odpowiednim promieniu (rysowanie okręgu — p. str. 705). Zgadza się z zarysem statecznika!
Teraz narysuj wszystkie ważne linie wewnętrzne. Są to linie proste, czasami składające się z kilku segmentów. Po narysowaniu pierwszej z nich zmień jej właściwości: barwę linii na kolor czerwony, a wzór linii na linię ciągłą.
Rysunek 18.1.11 Poprawianie narysowanych linii
Podczas rysowania nie zapomnij trzymać wciśnięty klawisz Ctrl, aby linie były dokładnie pionowe lub poziome. Gdy jednak zdarzy Ci się popełnić błąd — możesz to poprawić. Wystarczy przełączyć się w tryb edycji węzłów (p. str. 697) (Rysunek 18.1.11).
Linie krzywe, odwzorowujące kształt samolotu, najlepiej jest tworzyć w dwóch etapach:
najpierw obrysować kontur przybliżoną linią łamaną, o niezbyt dużej liczbie wierzchołków;
potem wygładzić tę przybliżoną linię tak, by dokładnie oddać kształt obrysu.
Na str. 698 znajdziesz ogólne informacje o pracy z krzywymi w Inkscape. Na stronie 701 umieściłem się opis, jak odwzorować krawędź natarcia statecznika pionowego (jest to złożenie linii prostej i łuku). Na str. 702 znajdziesz opis, jak odwzorować kontur steru kierunku (jest to “ogólna” krzywa, a nie żadne złożenie łuków).
Rysunek 18.1.12 przedstawia ostateczny efekt korekt. Wykorzystałem tu wszystko, czym dysponowałem, nawet rysunek fabryczny owiewki wokół usterzenia i kadłuba. (Nie pokazałem, ani nie omawiałem go w tej sekcji.)
Rysunek 18.1.12 Korekty usterzenia pionowego
Szczególnie zaskakujące na tym rysunku jest przesunięcie tylnej krawędzi kadłuba. (Chodzi o krawędź ostatniej wręgi kadłuba, wzdłuż której biegnie oś steru kierunku — Rysunek 18.1.12.) Według wszelkich zdjęć, oś steru leżała z tyłu tej linii, a na rysunkach JJ/MŁ jest z przodu. Także kształt dolnej krawędzi owiewki usterzenia jest inny, niż na planach modelarskich.
Zachowaj to porównanie jako plik P40C-ML-Left.svg (por. str. 680). Wyeksportuj także do bitmapy (File→Export Bitmap) jako plik P40C-ML-Left.png.
Podsumowanie
Jeżeli dysponujemy rysunkami fabrycznymi, choćby fragmentów samolotu — warto je nałożyć na plany modelarskie. Możemy odkryć wiele różnic (str. 1194)!
Do porównania (poprzez nałożenie) wielu obrazów wygodniej jest używać Inkscape, a nie GIMP. W Inkscape podczas każdej transformacji (skalowania lub obracania) nie tracisz z oczu żadnej z warstw. To zdecydowanie ułatwia wzajemne dopasowanie (str. 1193).
Korekty oryginalnych rysunków nanosimy w Inkscape na oddzielną warstwę, w kontrastowym kolorze (np. czerwonym — por. str. 1196)
Porównanie planów modelarskich z rysunkami fabrycznymi zmusiło nas w poprzedniej sekcji do naniesienia poprawek na plany. Mieliśmy do dyspozycji tylko rysunki fragmentów ogona: statecznika pionowego, jego owiewki, i steru kierunku. A co z resztą? Nie mamy już więcej fabrycznej dokumentacji kadłuba wersji P-40 B/C. Czy nie czają się tam kolejne niespodziewane różnice? Pozostaje porównać naszą sylwetkę z jakimś wyraźnym zdjęciem (Rysunek 18.2.1):
Rysunek 18.2.1 Tomahawk IIA (Hawk 81-A2, czyli P-40B) na lotnisku fabrycznym (Curtiss).
Wczytaj to zdjęcie (Source\Photo\P40B-Left-Photo.png z pliku source.zip, por. str. 22) do Inkscape. Warstwę, na której je umieścisz, nazwij Image. Zawsze zaczynaj od sprawdzania, czy fotografia jest zdeformowana — nieproporcjonalnie rozciągnięta w pionie lub w poziomie. Wybierz w tym celu na obrazie coś, co powinno być kołem. W przypadku tego zdjęcia (Rysunek 18.2.1) są to piasty podwozia głównego:
Rysunek 18.2.2 Oryginalne zdjęcie | Rysunek 18.2.3 Zdjęcie po przeskalowaniu (Y: -4%) |
Narysuj ponad piastą okrąg (rysuj z wciśniętym Ctrl, by na pewno nie był elipsą). Jeżeli dostrzeżesz odchylenia w kształcie piasty (Rysunek 18.2.2) — przeskaluj zdjęcie (tj. obraz), aby stała się z powrotem kołem (Rysunek 18.2.3).
Podczas dopasowywania zdjęcia, ułatwisz sobie pracę przesuwając środek transformacji do środka wzorcowego okręgu. Pamiętaj tylko, gdy będziesz zmieniał skalę obrazu, aby trzymać wciśnięty klawisz Shift. (W ten sposób wymusisz przeskalowanie względem środka transformacji obiektu).
Po sprawdzeniu i ewentualnym “wyprostowaniu” zdjęcia, usuń niepotrzebny już okrąg. Zablokuj także przed zmianami warstwę, na której znajduje się ta fotografia.
Używaj zdjęć o jak największej rozdzielczości. Na zdjęciach marnej jakości poprawny okrąg może się wydawać odrobinę spłaszczony, z powodu dużego rozmiaru rastra (pikseli). Kierując się tą fałszywą przesłanką, możesz spłaszczyć zdjęcie. Potem będziesz sądził, że cały rzut z lewej jest do poprawy, gdyż nie pasuje do fotografii.
Utwórz nową warstwę (o nazwie Drawing) i wczytaj na nią rzut z lewej (P40C-ML-Left.png). Następnie zwiększ przejrzystość tej warstwy (Rysunek 18.2.4):
Rysunek 18.2.4 Nałożenie na fotografię rzutu z lewej
Dopasuj rzut z lewej do sylwetki na fotografii. Pochyl go w ten sam sposób, co samolot na zdjęciu. Zmniejsz skalę tak, by wysokość kadłuba w okolicy najmniejszego zniekształcenia była zgodna z wysokością na zdjęciu (Rysunek 18.2.5):
Rysunek 18.2.5 Wstępne dopasowanie sylwetki do zdjęcia
Po wstępnym dopasowaniu sylwetki do zdjęcia widać, że nie będziemy ich w stanie od razu porównać. Zniekształcenie geometryczne fotografii jest zbyt duże. Pomijam zniekształcenie perspektywiczne skrzydła (jego końcówka jest o wiele bliżej obiektywu). Kształtem płata nie będziemy przejmować. Ważny jest tylko jego profil przy kadłubie, w szczególności punkt na krawędzi spływu.
W rzucie z boku najważniejszy jest obrys kadłuba. Linia ta leży na płaszczyźnie symetrii samolotu. Na analizowanym zdjęciu (Rysunek 18.2.2) uległa tzw. “zniekształceniu beczkowatemu”. Rysunek 18.2.6 i Rysunek 18.2.7 pokazują, jak wygląda takie zniekształcenie na przykładzie fotografii regularnej, prostokątnej siatki.
Rysunek 18.2.6 Proste zniekształcenie beczkowate | Rysunek 18.2.7 Złożone zniekształcenie beczkowate |
Gdyby soczewka obiektywu aparatu fotograficznego miała idealną ogniskową — uzyskalibyśmy zniekształcenie proste (Rysunek 18.2.6). Deformacja obrazu ma tu kształt hiperboli.
W realnym świecie nic nie jest jednak proste, a ogniskowe - idealne. Deformacja zdjęcia wykonanego obiektywem o złożonej ogniskowej może mieć skomplikowany kształt — przykład pokazuje Rysunek 18.2.7. W okolicy krawędzi tej fotografii krzywa deformacji obrazu ma końcówki wygięte do góry. (Dokładniejsze wyjaśnienie natury tej transformacji możesz znaleźć w dodatku 19.3, na str. 1238).
Czy można jakoś zdeformować rzut z boku tak, by odpowiadał sylwetce na porównywanym zdjęciu? Ze względu na pracochłonność, bez zastosowania komputera jest to niewykonalne. A to oznacza, że wszelkie rysunki samolotów wykonywane metodą tradycyjną mogą zawierać różnorodne błędy kształtu. Autor takich rysunków na pewno dokładał wszelkich starań, aby zrobić je jak najdokładniej. Zazwyczaj jednak (prawie zawsze) podstawą do opracowania nowych planów modelarskich były:
rysunki samolotu opracowane przez innych autorów;
zdjęcia, które były porównywane z planami w dużej mierze “na oko”. Deformacja perspektywiczna była kompensowana tylko w za pomocą bardzo zgrubnych poprawek.
Z kolei sam fakt opracowania rysunków na komputerze nie świadczy jeszcze o tym, że są bezbłędne. Jeżeli bazowały wyłącznie na wcześniejszych opracowaniach - mogą tylko powtarzać popełnione wcześniej pomyłki innych autorów.
Obecnie istnieją już wyspecjalizowane programy, odwzorowujące deformację perspektywiczną — jednym z nich jest np. Hugin (dostępny w ramach licencji Open Source). Ku mojemu zaskoczeniu, znalazłem jednak tę funkcjonalność także w Gimpie. (W każdym razie oceniam, że jest wystarczająca do naszych celów). Spróbujmy ją zastosować. W tym celu przygotuj w Gimpie odpowiednie zestawienie:
wyeksportuj (File→Export Bitmap) z Inkscape zawartość warstwy z fotografią (por. Rysunek 18.2.5, str. 1198) do pliku P40C-ML-Left-Photo.png;
wyeksportuj z Inkscape zawartość warstwy Drawing (zawiera odp. pochylony rzut z lewej) do pliku P40C-ML-Left-Drawing.png;
otwórz w GIMP utworzony przed chwilą plik P40C-ML-Left-Photo.png. Zmień nazwę jego warstwy domyślnej na Photo;
dodaj do niego, jako dodatkową warstwę, plik P40C-ML-Left-Drawing.png. Zmień nazwę tej warstwy na Drawing;
zapisz złożenie tych dwóch rysunków jako plik GIMP o nazwie P40C-ML-Left.xcf;
ustaw jako aktualną warstwę Drawing (czyli rzut z boku), i zmniejsz jej nieprzejrzystość (Opacity) do 50-60%. (Powinna się pod nią pojawić fotografia samolotu. Jako pierwsza z wczytanych, znajduje się „na dole” stosu warstw, na utworzonej przez GIMP warstwie Photo);
Rysunek 18.2.8 pokazuje efekt tych operacji - przeniesione do GIMP złożenie z Inkscape (por. Rysunek 18.2.5, str. 1198):
Rysunek 18.2.8 Złożenie zdjęcia i rzutu z lewej — przeniesione z Inkscape do GIMP
Może, tak na marginesie, wyjaśnię dlaczego nie zacząłem od razu od Gimpa: w Inkscape jest wygodniej skalować i obracać obrazy. Do GIMP proponuję wczytać tylko obrazy wyeksportowane z Inkscape. W ten sposób zawartość obydwu warstw ma identyczne wymiary. Dzięki temu rzut z lewej znajdzie się w GIMP dokładnie w tym samym położeniu ponad zdjęciem, co w Inkscape.
Teraz wywołaj polecenie Filters→Distorts→Lens Distortion. Spowoduje to pojawienie się okna dialogowego, z parametrami zniekształcenia beczkowatego (Rysunek 18.2.9):
Rysunek 18.2.9 GIMP — okno dialogowe transformacji Lens Distortion.
Okno zawiera suwaki, odpowiadające następującym parametrom transformacji:
X shift, Y shift: położenie na fotografii środka obiektywu. (Chodzi o punkt, na który skierowany był aparat w chwili wykonywania zdjęcia). Położenie jest określane w zakresie od -100% do +100%. Wartość 0% odpowiada środkowi obrazu (patrz Rysunek 18.2.9);
Main: główny współczynnik zniekształcenia. Dodatni oznacza “skurczenie” obrazu wokół krawędzi. Ujemny — to oczywiście efekt odwrotny. Przy dopasowywaniu do zdjęć będziesz używać wartości dodatnich;
Edge: dodatkowa deformacja w okolicy krawędzi. Podobnie jak Main może być dodatnia (dodatkowe “skurczenie” obrazu) lub ujemna.
Zoom: powiększenie (zwykła zmiana skali, bez żadnej “magii”) względem punktu określonego przez X shift, Y shift. Ten parametr warto użyć, gdy nie doceniłeś deformacji zdjęcia i np. nie możesz osiągnąć odpowiedniej wysokości kadłuba w obszarze wokół środka obiektywu
Ustalanie transformacji zacznij zawsze od ustalenia punktu, na który była wycelowana kamera (X shift, Y shift). W przypadku klasycznego zdjęcia samolotu stojącego na lotnisku, współrzędna Y środka obiektywu wypada zazwyczaj na poziomie horyzontu/wzrostu człowieka. Położenia współrzędnej X możesz się domyśleć, szukając obszaru, w którym nie widać żadnego odchylenia płaszczyzn poprzecznych. (Na przykład — końcówki łopat śmigła, albo golenie podwozia, zasłaniające się wzajemnie).
Po ustaleniu celu kamery staraj się dopasować plany do zdjęcia za pomocą zmiany głównej krzywizny: Main. Staraj się ją dobrać w ten sposób, by przynajmniej długość obydwu sylwetek stała się taka sama. Jednocześnie, jak najwięcej “kluczowych” punktów konstrukcji w okolicy “celu” kamery (jak nasada skrzydła, statecznika poziomego, ramki kabiny...) powinno się zgadzać.
W oknie Lens Distortion jest dostępny podgląd efektu transformacji (Rysunek 18.2.9). Niestety, widać w nim tylko aktualną warstwę, więc nie wiemy, czy “trafiliśmy” w zdjęcie, czy nie. Pozostaje tylko taktyka “kolejnych przybliżeń”:
ustaw parametry transformacji (zazwyczaj zmieniasz tylko Main);
naciśnij przycisk OK;
obejrzyj rezultat;
gdy nie jest odpowiedni:
cofnij efekt transformacji (Ctrl-Z lub Edit→Undo Lens Distortion);
wywołaj ponownie okno dialogowe Lens Distortion (Filters→Re-Show “Lens Distortion”). Na szczęście okno “pamięta” ostatnio użyte wartości parametrów;
popraw parametry transformacji i spróbuj jeszcze raz.
Parametru Edge używaj dopiero wówczas, gdy w żaden sposób nie możesz odwzorować zdjęcia za pomocą samego parametru Main. Może to wyglądać tak:
długość zdeformowanej sylwetki dokładnie zgadza się z długością na zdjęciu, podobnie jak część kluczowych wymiarów;
mimo to kształt usterzenia pionowego nie jest zgodny ze zdjęciem.
Rysunek 18.2.10 pokazuje efekt transformacji dla X shift = -40%, Y shift = -10%, Main = 5.8 (pozostałe parametry są pozostawione w pozycji neutralnej):
Rysunek 18.2.10 GIMP — Rzut z lewej, dopasowany do zdjęcia (transformacja Lens Distortion)
Oprócz linii zgodnych, dostrzeżemy szybko na złożeniu wiele niedokładności. Widać nieco zbyt wygięty grzbiet kadłuba za kabiną, zbyt głęboka chłodnicę pod silnikiem... Czy można w jakiś łatwy sposób przenieść te poprawki na niezdeformowany rzut z lewej?
Oczywiście! Wystarczy, że poddamy odwrotnej deformacji nie plany modelarskie, a samo zdjęcie:
wycofaj (Edit→Undo Lens Distortion) ostatnią transformację;
zmień aktywną warstwę na Photo(to ta, zawierająca fotografię);
wywołaj ponownie okno dialogowe Lens Distortion (Filters→Re-Show “Lens Distortion”) i zmień znaki parametrów Main i Edge (Rysunek 18.2.11):
Rysunek 18.2.11 Parametry odwrotnej transformacji — z fotografii do rzutu prostopadłego
Rysunek 18.2.12 pokazuje efekt odwrotnej transformacji - zdjęcie dopasowane do rzutu z lewej!
(Main = -5.4, pozostałe parametry transformacji — bez zmian.)
Rysunek 18.2.12 Fotografia, “rozciągnięta” za pomocą Lens Distortion do rzutu prostopadłego
Teraz wystarczy przenieść zawartość warstwy Photodo Inkscape. W ten sposób będziemy mogli porównać rysunek z prawdziwym samolotem!
(w GIMP:) wyłącz widoczność warstwy Drawing (to ta z rzutem z lewej). Na ekranie powinna pozostać tylko zdeformowana fotografia;
zapisz widoczną warstwę (File→Export As) do pliku o nazwie P40C-Left-Photo.tif;
otwórz (w Inkscape) plik P40C-ML-Left.svg (stworzyliśmy go w poprzedniej sekcji — zobacz str. 1196);
wyłącz w pliku P40C-ML-Left.svg (Inkscape) widoczność wszystkich warstw, oprócz warstwy Image;
dodaj nową warstwę: Photo. Umieść ją pod warstwą Image;
wczytaj na warstwę Photo (File→Import...) plik P40C-Left-Photo.tif. (To ten utworzony przed chwilą w Gimpie);
przesuń i obróć wczytany obraz, tak, by pasował do rzutu z lewej (Rysunek 18.2.13):
Rysunek 18.2.13 Inkscape — złożenie rzutu z lewej z “wyprostowanym” zdjęciem
Teraz pozostaje tylko obrysować różnice kształtu na warstwie Correction, tak jak to robiliśmy w poprzedniej sekcji (por. str. 1195). Na przykład — ze zdjęcia wynika, że górny zawias steru kierunku jest nieco wyżej. Czy pamiętasz, że właśnie do tych zawiasów przykładaliśmy rysunki fabryczne (por. Rysunek 18.1.8, str. 1193)? Założyliśmy wówczas, że są we właściwym miejscu. Teraz będzie trzeba przesunąć trochę cały obrys.
Jeżeli nie porównasz rysunków fabrycznych z odpowiednim zdjęciem, możesz je zastosować w sposób niepoprawny, i nie uzyskać prawdziwego kształtu samolotu
Podczas porównywania planów z fotografią pamiętaj także o tym, że nie wszystkie efekty zniekształcenia perspektywicznego zniknęły z rysunku. Przyjrzyj się końcówkom łopat śmigła (Rysunek 18.2.13): nadal są wygięte względem obserwatora. Ten efekt powoduje, że np. luk akumulatora na planach powinien znajdować się nieco bardziej z przodu, niż na zdjęciu. Jedynie elementy leżące dokładnie w osi symetrii kadłuba nie będą miały takiego przesunięcia. Możesz je oszacować, mierząc np. odchylenie przedniej krawędzi pokrywy kółka ogonowego. Potem proporcjonalnie zmniejszaj tę odległość, jeśli element jest bliżej centrum deformacji. (No cóż, jak widać, nawet tu odwzorowujemy coś “na oko”. Zapewniam jednak, że ogólna niedokładność tego porównania jest o niebo lepsza niż to, z czego mogliśmy korzystać przed “erą komputerów”.1)
Rysunek 18.2.14 pokazuje rezultat — korekty naniesione na rzut z lewej. Rysowałem je w kolorze czerwonym. Dodatkowo na rzut naniosłem wzorce profilu płata - w osi symetrii i u nasady skrzydła. (Zgodnie z dokumentacją, był to NACA 2215. Jeżeli chcesz dowiedzieć się, w jaki sposób na podstawie symbolu profilu narysować jego obrys — patrz „Kształt profili lotniczych (metody odwzorowania)” na str.1240.) Kształt przekroju skrzydła bardzo się przydaje w weryfikacji dolnej krawędzi kadłuba każdego dolnopłata. Większość autorów rysuje ten fragment dość nieuważnie, podobnie jak rzut z boku skrzydła. (Na przykład - na rysunkach Jacka Jackiewicza i Mariusza Łukasika złożone koła podwozia głównego są w rzucie z boku za szerokie. Wygląda to tak, jak gdyby dotykały kadłuba.)
Rysunek 18.2.14 Korekty rzutu z boku, naniesione po porównaniu ze zdjęciem
Ogólnie rzecz biorąc, nasza sylwetka wyszła z porównania ze zdjęciem “obronną ręką”. Poważnych różnic nie ma. Z większych:
Chłodnica cieczy okazała się na fotografii płytsza, niż na rysunku.
Tylna krawędź kadłuba leży bardziej z przodu, niż na planach.
Oś obrotu steru pozostała w tym samym miejscu, więc obecnie jest poza kadłubem. (I tak było w prawdziwym samolocie).
Kołpak śmigła okazał się dłuższy, niż na planach (patrz Rysunek 18.1.10 — weryfikowałem to także z innymi zdjęciami).
Ta ostatnia poprawka wydłużyła całą sylwetkę o ok. 0,3%. Jednocześnie niemal niezauważalnie przesunęła się do przodu tylna krawędź steru kierunku. W sumie sylwetka wydłużyła się o 0,25%, co oznacza różnicę w skali rzeczywistej o ok. 2,5 cm. Może jestem chorobliwie dokładny, ale jest to zbyt drobna różnica, by powtórnie korygować cięciwę płata. (W skali rzeczywistej, w najszerszym miejscu, różnica wynosiłaby ok. 8 mm. To zupełnie niezauważalne. Mimo to, jak pokażę w następnej sekcji, dopasowałem płat do tego rozmiaru.)
Na koniec powiększyłem wysokość tego obrazu z 720 do 1024 jednostek, tak, by obejmował cały obrys dolnej łopaty śmigła. (Nie po to się męczyłem się nad jej obrysem, by teraz go obcinać.) Uzyskany rysunek zapisz, na wszelki wypadek, jako dokument Inkscape (P40C-ML-Left.svg). Stwórz także jego kopię rastrową (File→Export Bitmap). Nadaj jej nazwę P40C-ML-Left.png.
Dzięki porównaniu ze zdjęciami uzyskaliśmy poprawiony rzut z boku. Oszczędzamy sobie w ten sposób późniejszego odkrywania tych wszystkich różnic. (Modelowanie w 3D bezbłędnie wyłapuje wszelkie niekonsekwencje rysunku) Każda z nich objawia się tym, że nagle coś do czegoś nie pasuje. Takie błędy znajdowalibyśmy w trakcie budowy modelu, jeden po drugim. Zapewniam, że wtedy ich poprawianie wymaga większego wysiłku. Oznaczałoby konieczność ciągłego poprawiania ukończonych już elementów, a to hamowałoby cały postęp prac.
Za pomocą narzędzia GIMP — Lens Distortion — możesz “rozwinąć” zdjęcie, dopasowując je do rzutu z boku (str. 1198 - 1203). Otwiera to nowe możliwości weryfikacji planów modelarskich.
Zdjęcie, którego użyjesz do porównania z rzutem z boku, powinno mieć jak największą rozdzielczość. Samolot powinien być na nim jak najmniej zniekształcony (str. 1198 - 1199).
Staraj się zawsze sprawdzić, czy zdjęcie nie jest zdeformowane (zanadto wyciągnięte w pionie lub poziomie). W tym celu wybierz na fotografii kształt, o którym wiesz, że powinien być dokładnym kołem. Porównaj go z okręgiem, narysowanym w Inkscape (str. 1197).
Uzyskane w GIMP “rozwinięte” zdjęcie można wczytać do Inkscape, aby wygodnie nanieść na plany poprawki (str. 1204 - 1205).
Sprawdziliśmy już tak dokładnie, jak się tylko dało, rzut z boku P-40. Pozostał nam jeszcze do sprawdzenia rzut z góry. Z nieocenionego http://www.p40warhawk.com uzyskałem rysunki fabryczne dwóch elementów:
kompletnego płata (znajdziesz go pod nazwą Source\Curtiss\Wing-overall.gif w pliku source.zip);
steru wysokości (znajdziesz go pod nazwą Source\Curtiss\Tail-elevator.gif w pliku source.zip);
Jeżeli chodzi o zdjęcia, to niestety, metoda jaką zastosowaliśmy do “wyprostowania” rzutu z lewej (patrz str. 1197), tu nie zdaje egzaminu. Problem polega na tym, że rzut z góry nie ma jednej płaszczyzny, nad którą można by się było skoncentrować. Jest tu kilka ważnych powierzchni: płata, usterzenia poziomego, kadłuba. Niestety, każda z nich jest w innej odległości od obserwatora. W dodatku płaty mają wznios, co jeszcze bardziej komplikuje sprawę. Zresztą zdjęć z góry samolotu jest o wiele mniej niż zdjęć z boku. Wynika to z prostego faktu, że te z góry trzeba było zazwyczaj wykonać w powietrzu. Na taki “strzał” fotograf ma o wiele mniej okazji — aby go zrobić, musi się znaleźć w innym samolocie.
Szukając w ogóle jakichkolwiek zdjęć z góry, natknąłem się na następujące (Rysunek 18.3.1):
Rysunek 18.3.1 P40N — zdjęcie z góry (USAAF)
To nic, że fotografia przedstawia późną wersję P-40. Wszystkie — od pierwszych do ostatniej serii — miały takie same kształty skrzydeł i usterzenia poziomego.
Rysunek 18.3.1 zawiera unikalne ujęcie. Ten P-40N jest przechylony na lewo — o 7-8º. Dzięki temu lewy płat jest ustawiony niemal prostopadle do obserwatora. Jednocześnie zniekształcenie perspektywiczne jest niewielkie. Koło, w które wpisana jest gwiazda na lewym płacie nie ma żadnych widocznych zniekształceń. Także maszt anteny na ogonie samolotu jest tylko odrobinę odchylony od pionu. Kamera była skierowana na okolicę kabiny pilota. Całej fotografii “rozwinąć” z perspektywy, tak jak to zrobiliśmy z rzutem z lewej, nie jesteśmy w stanie. Ale pojedyncze obszary - to co innego! Użyjemy tego zdjęcia do weryfikacji dwóch elementów. Rysunek 18.3.1 pokazuje je, obrysowane liniami przerywanymi. To:
obrys płata1;
obrys usterzenia poziomego.
Ewentualne różnice naniesiemy jako poprawki na plany samolotu (tak samo, jak to zrobiliśmy z rzutem z lewej).
Zacznijmy od porównania płata z fotografii i płata z planów. Otwórz w Inkscape plik P40C-ML-Top.tif. Utwórz nową warstwę (pod spodem) i wczytaj na nią to zdjęcie (Source\Photo\P40N- Top-Photo.png z pliku source.zip). Dopasuj jak najdokładniej do planów lewe skrzydło samolotu z fotografii. W pierwszym kroku uzgodnij jego rozmiary (szerokość i wysokość). Następnie ustaw fotografię tak, by linia ostrzegawcza była pionowa. Jednocześnie osłony zasobnika z amunicją powinny być poziome (Rysunek 18.3.2). Osiągnięcie tego efektu wymaga drobnego obrotu i minimalnego przekoszenia fotografii. (Przekoszenie niweluje drobny efekt wzniosu płata, widzianego z góry, z tyłu):
Rysunek 18.3.2 Kształt płata — porównanie fotografii z planami M. Łukasika (i J. Jackiewicza)
Efekt jest zaskakujący: krawędź spływu i kocówka płata są na planach źle narysowane! Pociągnęło to za sobą także błędne położenie osi lotki — jest za bardzo przesunięta do przodu.
Na planach modelarskich samolotu, powierzchnie poziome — płat, usterzenie — zawierają częściej błędy, niż lepiej udokumentowane fotografiami powierzchnie pionowe
Upewnijmy się, czy możemy zastosować posiadany fragment dokumentacji fabrycznej. Wczytaj na kolejną warstwę plik z ogólnym zarysem płata (Source\Curtiss\Wing-overall.gif z pliku source.zip). Rysunek 18.3.3 pokazuje złożenie tego rysunku ze zdjęciem:
Rysunek 18.3.3 Porównanie fotografii z fabrycznymi rysunkami płata
Jak można było przypuszczać, tym razem różnic nie ma. Być może autorzy planów (Jacek Jackiewicz, a potem Mariusz Łukasik) nie mieli okazji skorzystać w odpowiednim czasie z tego rysunku.
Rysunek 18.3.4 przedstawia rzut z góry z naniesionymi poprawkami. O dziwo, poza tylnym dźwigarem, wszystkie łączenia blach i linie nitów na planach pasują do rysunków fabrycznych!
Rysunek 18.3.4 Rzut z góry — poprawiony obrys płata
W podobny sposób zweryfikujmy obrys usterzenia poziomego. W tym obszarze rysunki Jacka Jackiewicza i Mariusza Łukasika różnią się od siebie.
Na rysunku Jacka Jackiewicza ster wysokości ma bardziej zaokrągloną krawędź spływu. Jego kompensacja aerodynamiczna znajduje się także w innym miejscu, niż na zdjęciu — i nie jest to mała różnica (Rysunek 18.3.5). Ster na tym rysunku zawiera tyle różnic, że nie ma co się nim posługiwać2.
Rysunek 18.3.5 Obrys usterzenia P-40 wg planów Jacka Jackiewicza | Rysunek 18.3.6 Obrys usterzenia P-40 wg planów Mariusza Łukasika |
Mariusz Łukasik zauważył tę różnicę, i starał się ją poprawić. Jego obrys usterzenia jest bardziej zbliżony do fotografii (Rysunek 18.3.6). Krawędź steru znajduje się w poprawnym miejscu, a wyważenie masowe ma rozmiar zbliżony do rzeczywistego. Wygląda jedynie, że w tym przypadku autor nie zauważył niewłaściwych proporcji statecznika — jego krawędź natarcia jest nadal przesunięta do tyłu. To w efekcie spowodowało zmniejszenie promienia obrysu końcówek usterzenia. (Ster musiał pasować do statecznika). Wygląda na to, że Mariusz Łukasik starał się zachować kształt krawędzi natarcia jak na rysunkach Jacka Jackiewicza. Czyli — jest lepiej, ale też nie za dobrze.
Co z tym fantem robić? Spróbowałem złożyć całą posiadaną dokumentację fabryczną, która dotyczy tego fragmentu (Rysunek 18.3.7).
Na zdjęcie usterzenia nałożyłem rysunki fabryczne:
steru wysokości (Source\Curtiss\Tail-elevator.gif z pliku source.zip);
oprofilowania usterzenia (Source\Curtiss\Tail-fairing.gif z pliku source.zip);
Na pierwszym z nich jest oznaczony środek okręgu konturu końcówki usterzenia. Przedłużyłem go znad steru na statecznik, gdyż taki kształt jest zgodny ze zdjęciem.
Następnie narysowałem prostą linię krawędzi natarcia. Linia ta jest styczną do okręgu końcówki, a z drugiej strony — przechodzi przez punkt wskazany na rysunku oprofilowania usterzenia. Tak “wydedukowany” obrys jest zgodny ze zdjęciem, a więc — poprawny.
Rysunek 18.3.7 Obrys usterzenia P-40 — złożenie dostępnej dokumentacji fabrycznej
Rysunek 18.3.8 przedstawia korekty naniesione na plan usterzenia poziomego (statecznika i steru).
Rysunek 18.3.8 Korekty kształtu usterzenia poziomego
Łączenia blach poszycia statecznika poziomego biegną wzdłuż wzmocnionych podłużnic. Podobne podłużnice biegną przez statecznik pionowy. Obydwa stateczniki były, w miejscu styku tych podłużnic, skręcone śrubami. (Usterzenie pionowe “stało” na niedzielonym stateczniku poziomym, który z kolei był przykręcony do kadłuba). Na rysunkach fabrycznych statecznika pionowego zaznaczone są punkty połączeń z usterzeniem poziomym. Pozwoliło mi to wyznaczyć położenie podłużnic u nasady statecznika poziomego. (Rysunek 18.3.8 zaznacza je liniami przerywanymi.) Jak widać, różnią się tylko nieznacznie od położenia wg planów. Położenie tych podłużnic i szwów blachy przy końcówce statecznika wypada inaczej, gdyż skorygowana końcówka jest dużo szersza. Położenie żeber steru wysokości na rysunkach M. Łukasika jest zgodne z dokumentacją fabryczną.
Rysunek 18.3.9 przedstawia ostateczną postać rzutu z góry, zawierającą poprawiony obrys usterzenia poziomego i skrzydła:
Rysunek 18.3.9 Rzut z góry z naniesionymi poprawkami
Wyeksportuj ten rysunek Inkscape do pliku obrazu o nazwie P40C-ML-Top.png(File→Export Bitmap). Aby zaoszczędzić czas, nie kopiuję tych poprawek na drugą, symetryczną stronę samolotu, ani nie przenoszę ich na inne rzuty. Wystarczy, aby pamiętać, że płat lub usterzenie należy wykonywać z rzutu z góry, wg czerwonych, a nie czarnych (oryginalnych), linii.
Jak widzisz — każdy popełnia błędy, nawet twórcy planów modelarskich. Opierając się jednak na jak najlepszych planach, możemy zidentyfikować i poprawić większość pomyłek, które się na nich znalazły. Jest to możliwe za pomocą odpowiedniego oprogramowania, które pozwala na porównanie wielu obrazów naraz. W poprzednich dekadach taka możliwość jeszcze nie istniała3.
Zdjęcia samolotu z góry nie poddają się tak łatwo rozwinięciu, jak rzut z boku. Zrezygnowałem z tej operacji, bo możliwość błędu w rezultacie takiej pracy byłaby zbyt duża (str. 1207).
Liczba dostępnych, w przybliżeniu prostopadłych, zdjęć samolotu z góry (lub z dołu) jest o wiele mniejsza od zdjęć “horyzontalnych”. Dzieje się tak dlatego, że takie fotografie muszą być robione wyłącznie z powietrza (str. 1207).
Plany modelarskie mogą zawierać więcej błędów kształtu płata i usterzenia poziomego, niż kadłuba i usterzenia pionowego. Wynika to z mniejszej liczby dostępnych fotografii (str. 1209, 1211).
Rysunki fabryczne skrzydła, stateczników i sterów są w tej sytuacji właściwie jedyną metodą weryfikacji. (Chyba, że uda Ci się trafić na jakieś zdjęcie, wykonane z dużej odległości pod kątem niemal 90º).
W tym rozdziale umieściłem informacje “dla dociekliwych”. Znajdują się tu szczegółowe wyjaśnienia wybranych zagadnień, nad którymi nie chciałem się rozwodzić w części głównej. (Aby nie zbaczać z tematu).
Zapewne wiele razy, podczas pracy z Blenderem, mignęło Ci przed oczami tajemnicze słowo “datablock” (“blok danych”). Pojawia się w różnych miejscach i znaczeniach. Gdy zrozumiesz, czym w istocie jest dla Blendera “blok danych”, zrozumiesz także zasady, rządzące elementami rysunku (pliku). Pozwoli Ci to poprawnie przewidywać zachowanie programu, i bardzo ułatwi pracę1.
Każdy model, który stworzyłeś w Blenderze, złożony jest z obiektów (Object) . Obiekt możesz traktować jak doskonale przejrzyste “pudełko”: ma określony rozmiar, środek (punkt odniesienia), położenie, obrót, skalę. Obiekt “sam z siebie” nie ma żadnego kształtu. Kształt określa siatka (Mesh) . Siatka właśnie jest pewnym rodzajem “bloku danych” (datablock). Zawiera złożone informacje o wierzchołkach, krawędziach, ścianach powłoki, która ma być rysowana na ekranie. Zazwyczaj każdy obiekt ma przypisaną “własną” siatkę2 (Rysunek 19.1.1):
Rysunek 19.1.1 Obiekt i jego siatka
Czasami ten sam blok danych — siatka — może być użyta przez kilka różnych obiektów. Przykładem takiej sytuacji jest śmigło modelu P-40 (Rysunek 19.1.2).
To śmigło składa się z trzech identycznych łopat. Rysunek 19.1.2 przy każdym z tych obiektów pokazuje kontekst, wyświetlany w oknie Properties. Dwie nazwy, które są na nim widoczne, to odpowiednio:
poprzedzona ikoną : nazwa obiektu;
poprzedzona ikoną : nazwa siatki;
Poprzedzająca je ikona symbolizuje aktywną scenę, w której znajduje się obiekt. Nazwa aktywnej sceny nie jest tu wyświetlana, bo zazwyczaj widać ją przez cały czas u góry ekranu, w nagłówku okna Info (por. str. 792).
Przyjrzyj się dokładnie opisom, wyświetlanym przez konteksty, które pokazuje Rysunek 19.1.2, a stwierdzisz, że każda z łopat jest obiektem o nazwie wyróżnionej środkową literą. (B.010.A.Blade, B.010.B.Blade, B.010.C.Blade). Zwróć także uwagę, że każdy z tych obiektów używa tej samej siatki — B.010.Blade. Gdy zmodyfikujesz kształt siatki w którymkolwiek z nich — zmienisz kształt wszystkich trzech łopat.
Rysunek 19.1.2 Łopaty śmigła — przykład jednej siatki współdzielonej przez trzy obiekty
Przypisanie bloku danych — w tym przypadku siatki do obiektu — jest na panelach Blendera obsługiwane przez typowy zestaw kontrolek (Rysunek 19.1.3) :
Rysunek 19.1.3 Kontrolki, zarządzające przypisanym blokiem danych
Poniżej opisu kontekstu zestawu Object Data (por. str. 98) wyświetlana jest nazwa siatki, aktualnie przypisanej do obiektu. Aby ją zmienić, należy wybrać inną z listy rozwijalnej, otwieranej przyciskiem po lewej. Jeżeli wybierzesz w tym miejscu siatkę o innym kształcie — zmieni się kształt obiektu.
Po prawej stronie nazwy bloku danych umieszczony jest licznik “użycia” (referencji). Siatka B.010.Blade jest przypisana do trzech obiektów, stąd na ilustracji widoczna jest liczba 3. Kiedy klikniesz w ten przycisk — Blender utworzy duplikat aktualnej siatki. Duplikat nosi taką samą nazwę jak pierwowzór, z dodatkową końcówką “.001”. Duplikat zastępuje oryginalną siatkę, przypisaną do obiektu.
Licznik referencji (“użycia”) bloku danych jest w Blenderze niezwykle ważny. Gdy siatka nie jest “użyta” przez żaden obiekt — jej licznik spada do zera. Wszelkie bloki danych o liczniku równym zero są pomijane przy zapisie pliku na dysk. Kołpak śmigła w naszym przykładzie — B.005.Hub — miał własną siatkę, o identycznej nazwie: B.005.Hub. Gdy usuniemy ten obiekt (Delete), siatka B.005.Hub nadal będzie istnieć, ale jej licznik “użycia” spadnie do zera.
Taki nie używany blok danych Blender oznacza na liście literą “O” (Rysunek 19.1.4) :
Rysunek 19.1.4 Siatka usuniętego kołpaka śmigła
Wszystkie bloki danych, które nie są wykorzystywane (“osierocone”), Blender pomija przy zapisie na dysk. Są w ten sposób, z opóźnieniem, usuwane z pliku.
Mimo wszystko, jeżeli tego chcesz, możesz uchronić siatkę B.005.Hub, przed “czystką” podczas zapisu. Trick polega na włączeniu przełącznik F (Fake user) przed usunięciem obiektu, który zawiera ten blok danych (Rysunek 19.1.5):
Rysunek 19.1.5 Zabezpieczenie bloku danych przed usunięciem — “Fałszywe” (Fake) użycie
Włączenie F powoduje zwiększenie licznika “użycia” o 1. (Oczywiście, zawsze możesz go z powrotem wyłączyć). Dzięki przełącznikowi F, licznik użycia bloku danych zawsze jest > 0.
Blok danych z atrybutem F nigdy nie będzie usunięty z pliku Blendera. (Nawet wtedy, gdy nie jest użyty przez jakikolwiek obiekt, jego licznik użycia jest = 1).
Blokiem danych w Blenderze jest praktycznie wszystko, z czym pracujesz tworząc scenę. W szczególności są to takie typowe elementy, jak:
siatki (meshes — o nich już mówiliśmy): nadają obiektom kształt. Zawierają także inne szczegóły, m.in. współrzędne mapowania tekstury dla każdego wierzchołka;
kamery (cameras): pomocniczy rodzaj obiektu, definiujący projekcję. Używany podczas renderowania;
lampy (lamps): źródła światła, używane podczas renderowania
obiekty ( objects): to „obudowa”, której zawartość (określana jako Object Data — por. str. 98) jest referencją do jednego z bloków danych wyliczonych powyżej;
materiał(y) (materials), przypisane do siatek: nadają powierzchniom podstawową barwę, oraz określają inne ich parametry, takie jak przejrzystość, połyskliwość, itp.;
tekstury (textures), przypisane do materiałów: wzbogacają jednolitą barwę materiału elementy w innych kolorach, zabrudzenia. Pozwalają także uzyskać efekt drobnych nierówności;
obrazy (images), przypisane do tekstur: zawierają obraz, wykorzystywany przez teksturę;
Prezentowany wcześniej model kołpaka śmigła składa się z czterech obiektów: kołpaka śmigła (B.005.Hub) i trzech łopat (B.010.x.Blade) (Rysunek 19.1.6a). Łopaty są przypisane (relacją parent) do kołpaka (Rysunek 19.1.6b):
Rysunek 19.1.6 Śmigło i jego struktura (w oknie Outliner)
Kołpak ma przypisany materiał B.005.Hub (nadający mu żółty kolor). Łopaty wykorzystują materiał B.010.Steel, który ma przypisaną teksturę B.010.Dirt. Tekstura B.010.Dirt korzysta z obrazu B.010.Blade, nakładając na łopatę żółte końcówki i zabrudzenia. Rysunek 19.1.7 przedstawia to na tzw. schemacie Oops:
Rysunek 19.1.7 Inny sposób przedstawienia struktury modelu śmigła (schemat Oops z Blendera 2.49)
Schemat Oops był dostępny w Blenderze 2.4, w wersji 2.5 z niego zrezygnowano. Pozostawiłem go tutaj, gdyż dobrze obrazuje strukturę pliku Blendera. Każdy prostokąt, który na nim widzisz, to jakiś blok danych. Każda z linii oznacza pojedyncze zwiększenie licznika bloku danych, z którego wychodzi. Na przykład: tekstura B.010.Dirt jest używana tylko raz. Jeżeli usuniesz ją z materiału B.010.Steel, zostanie pominięta przy najbliższym zapisaniu pliku. “Osierocony” zostanie wówczas używany przez tę teksturę obraz B.010.Blade. Ten obraz zostanie pominięty przy kolejnym zapisie. (Stąd uwaga praktyczna: czasami trzeba dwa — trzy razy zapisać, zamknąć i otworzyć plik, by wszelkie niepotrzebne “śmieci” zostały z niego usunięte).
W prawym górnym narożniku schematu (Rysunek 19.1.7) widać trzy obrazy, które nie są “powiązane” z niczym. Dlaczego nie zostały usunięte? Ponieważ są to tła poszczególnych widoków 3D: rysunki samolotu w rzucie z góry, lewej i przodu. Każdy z nich ma w istocie licznik użycia = 1, bo jest przypisany do konkretnego okna 3D View (jako Background Image — por. str. 780). Schemat Oops nie pokazywał wszelkich połączeń w pliku Blendera, obrazował tylko strukturę sceny. Np. innym rodzajem bloku danych są teksty, które można przeglądać w oknie Text Editor. To także bloki danych “używane” przez plik, a nie konkretną scenę.
Rysunek 19.1.7 pokazuje, że obiekty — B.005.Hub, B.010.x.Blade, a także Lamp i Camera — są także blokami danych. Ich “użytkownikiem”, dzięki któremu mają przypisane “użycia”, jest scena.
Rysunek 19.1.8 demonstruje strukturę pliku Blendera, w którym utworzyłem drugą scenę (por. str. 788) — nazwałem ją Spares.
Rysunek 19.1.8 Dwie oddzielne sceny w jednym pliku
Scena — to brzmi dumnie. W tym przypadku jednak to tylko nowa, pusta przestrzeń, w której umieściłem drugi raz kołpak śmigła3. Popatrz na schemat Oops (Rysunek 19.1.8) — obiektowi B.005.Hub przybyła jeszcze jedna linia, czyli jeszcze jedno “użycie”. Jeżeli teraz nawet usunę ten obiekt ze sceny Scene, to pozostanie w drugiej scenie — Spares. Zawsze mogę go stamtąd przywołać. W ten sposób można używać drugiej sceny jak “podręcznego składziku”. W przestrzeni Spares można przechowywać różne obiekty, które się jeszcze przydadzą, a których nie chcę widzieć w podstawowej scenie.
Obiekt, który jest użyty na wielu scenach, w każdej z nich ma to samo położenie, obrót, skalę. W końcu nic dziwnego — każda ze scen zawiera tylko odnośnik do jednego bloku danych, opisującego obiekt.
Rysunek 19.1.9 przedstawia strukturę pliku po usunięciu ze sceny Scene kołpaka śmigła (obiektu B.005.Hub). Usunięcie spowodowało zmniejszenie licznika użycia obiektu B.005.Hub o 1. Gdyby występował tylko na jednej scenie — zostałby pominięty przy najbliższym zapisie na dysk4. Tak się jednak nie stanie, gdyż B.005.Hub nadal występuje w drugiej scenie, i jego licznik jest nadal większy od 0.
Rysunek 19.1.9 Struktura pliku po usunięciu obiektu B.005.Hub ze sceny Scene
Plik Blendera może zawierać wiele scen. Te same elementy modelu może występować w każdej z nich. Można ich także użyć tylko w jednej ze scen.
Za pomocą scen można przechowywać w jednym pliku różne wersje samolotu. Części wspólne dla wszystkich wersji są wówczas współdzielone pomiędzy scenami. Części specyficzne — występują tylko w jednej scenie.
Nim opowiem o powierzchniach podziałowych, zacznijmy od przypadku prostszego — linii (krzywej) podziałowej. Linia taka powstaje w Blenderze wówczas, gdy zastosujesz modyfikator Subdivision Surface (określany także skrótem Subsurf) do siatki, składającej się tylko z jednego rzędu wierzchołków. Subsurf w pojedynczym kroku dzieli każdą krawędź oryginalnego wieloboku na dwie, tworząc nową, bardziej “gładką” linię.
Rysunek 19.2.1 pokazuje przykład podziału. Sześciokąt (Rysunek 19.2.1a) jest linią przed wygładzeniem. Będę go określał dalej jako wielobok oryginalny. Każda zmiana położenia któregokolwiek z jego wierzchołków (A1 ..A6 ) zmieni kształt wyznaczanej linii podziałowej. Z tego powodu wielobok oryginalny jest także nazywany wielobokiem sterującym (ang. control polyygon)1 . Punkty A1 ..A6 to punkty sterujące.
Rysunek 19.2.1 Linie podziałowe sześciokąta — wyjściowa i po kolejnych podziałach
Każda kolejna linia podziałowa to wielobok, który ma dwa razy więcej wierzchołków niż ten, z którego powstał. Rysunek 19.2.1b) przedstawia rezultat pierwszego podziału sześciokąta. (W Blenderze, w ustawieniach modyfikatora Subdivison Surface, odpowiada to wartości Level = 1). Jest to regularny wielobok, o dwunastu wierzchołkach. Rysunek 19.2.1c) przedstawia rezultat kolejnego podziału, tym razem dwunastoboku z rysunku b). (W ustawieniach modyfikatora Subdivision Surface, odpowiada to wartości Level = 2). Jest to obrys o 24 wierzchołkach, bardzo zbliżony do okręgu!
Krzywa, którą stałaby się linia podziałowa w wyniku nieskończonej liczby podziałów, nazwijmy krzywą “ostateczną”. Zazwyczaj już po dwóch - trzech podziałach oryginalnego wieloboku, linie podziałowe osiągają kształt niewiele różniący się od ostatecznego. Dzięki tej właściwości, w wyniku niewielkiej liczby obliczeń można uzyskać jego dobre przybliżenie. To duża zaleta tego modelu matematycznego.
Według jakich reguł są wyznaczane wierzchołki krzywych podziałowych? Przedstawię je na przykładzie wyznaczania nowych punktów wokół pojedynczego wierzchołka oryginalnego sześciokąta (Rysunek 19.2.2). (Taki sam proces podziału zachodzi dla każdego wierzchołka wieloboku).
Analizowany wierzchołek oryginalnego wieloboku oznaczmy jako A (Rysunek 19.2.2a). Sąsiednie wierzchołki oznaczyłem jako E1 i E2 . (Każdy z nich odegra identyczną rolę jak wierzchołek A, wobec “swojego” fragmentu linii podziałowej. Dla wierzchołka A są jednak tylko “sąsiadami”).
Co drugi wierzchołek linii podziałowej leży w środku boku oryginalnego wieloboku. W przykładzie (Rysunek 19.2.2b) to sześć wierzchołków (wśród nich punkty e1 , e2 , związane z wierzchołkiem A). Nazwijmy je “krawędziowymi”, bo leżą na krawędziach wieloboku sterującego.
Rysunek 19.2.2 Wyznaczenie wierzchołków e — “krawędziowych” punktów linii podziałowej
Aby znaleźć pozostałe wierzchołki, wyznacz najpierw pomocnicze punkty ok , leżące w połowie odległości pomiędzy odpowiednimi punktami krawędziowymi ek i ek+1 . (Rysunek 19.2.3a pokazuje jeden z nich jako punkt o , umieszczony w połowie odcinka |e1 e2 |).
Pozostałe sześć punktów linii podziałowej — a, “wierzchołkowych” — leży w połowie odpowiednich odcinków |A o| (Rysunek 19.2.3b). Łącząc wierzchołki a i e uzyskamy linię podziałową:
Rysunek 19.2.3 Wyznaczenie wierzchołków a — “wierzchołkowych” punktów linii podziałowej
Rysunek 19.2.3b pokazuje, że z wierzchołka A oryginalnej siatki powstały:
wierzchołki e1 i e2 (współdzielone z rezultatami podziału sąsiednich wierzchołków);
wierzchołek a, który można traktować jako odwzorowanie oryginalnego wierzchołka A na nowym wieloboku.
W każdym kolejnym podziale można wskazać taki punkt wierzchołkowy a, który jest bezpośrednim odwzorowaniem oryginalnego wierzchołka wieloboku sterującego A (Rysunek 19.2.4):
Rysunek 19.2.4 Segmenty linii podziałowej dla różnych poziomów podziału
Te “bezpośrednie odwzorowania” punktów A pozwalają wyróżnić na linii podziałowej tyle segmentów, ile boków ma wielobok sterujący (Rysunek 19.2.4).
Rysunek 19.2.2 i Rysunek 19.2.3 podały “wykreślną” metodę wyznaczenia nowej linii podziałowej. Komputery nie jest jednak maszyną “geometryczną”, tylko “algebraiczną”. Jego procesor oblicza linie i powierzchnie podziałowe w oparciu o współrzędne wierzchołków wieloboku sterującego. W porównaniu z innymi krzywymi stosowanymi w grafice komputerowej (Beziera, B-sklejanymi), wzory te są bardzo proste. Sądzę, że pozwalają dostrzec zależności linii podziałowej od wieloboku sterującego, które nie są oczywiste w metodzie “wykreślnej”:
; (por. Rysunek 19.2.2)
Wyr 19.1 Współrzędne punktów krawędziowych2
(por. Rysunek 19.2.3)
Wyr 19.2 Współrzędne punktów wierzchołkowych
Matematycy dowiedli, że krzywa ostateczna, do której zmierzają linie podziałowe opisane Wyr 19.1 i Wyr 19.2, to tzw. jednorodna linia B-sklejana (uniform B-spline — UB), trzeciego stopnia (cubic) . Oznacza to tyle, że linie podziałowe są dobrym przybliżeniem pewnej odmiany stosowanych od lat w grafice komputerowej krzywych NURBS3.
Linie podziałowe zachowują właściwości NURBS, m.in. :
ciągłość promienia krzywizny wzdłuż całej linii (dzięki temu krzywa wydaje się być bardziej “płynna” od np. połączenia kilku łuków);
sterowanie kształtem linii poprzez zmianę położenia wierzchołków oryginalnego wieloboku (punktów sterujących);
“lokalność” zmian: przesunięcie pojedynczego punktu sterującego wywołuje zmianę kształtu linii podziałowej tylko w pobliżu tego punktu.
Ta ostatnia z wyliczonych właściwości — ograniczony zasięg wpływu punktu sterującego na kształt krzywej — bardzo się przydaje w praktyce. Ale co to właściwie znaczy “w pobliżu punktu sterującego”? Otóż z Wyr 19.1 i Wyr 19.2 wynika, że położenie każdego wierzchołka linii podziałowej zależy od (co najwyżej) trzech sąsiednich punktów sterujących (E1 ,A, E2 ). Ta reguła dotyczy pojedynczego podziału. A gdzie się kończy wpływ punktu A na krzywą podziałową, która powstała w wyniku dwóch lub więcej podziałów? Rysunek 19.2.5a) pokazuje rozszerzanie się obszaru wpływu oryginalnego wierzchołka A na kolejne linie podziałowe. Wygląda na to, że wpływ ten nigdy nie osiągnie granicy drugiego segmentu linii:
Rysunek 19.2.5 Granica wpływu punktu sterującego na kształt krzywej
Rysunek 19.2.5b) pokazuje tę właściwość w praktyce. Zmieniłem położenie wierzchołka A oryginalnego sześciokąta. Krzywa podziałowa zmieniła swój kształt z “prawie idealnego okręgu” (por. Rysunek 19.2.4b) na coś mniej regularnego. Przyjrzyj się temu kształtowi dokładnie. Zauważ że zmianie uległ kształt tylko 4 segmentów najbliższych wierzchołkowi A (po dwa z każdej strony). Segmenty bardziej odległe (mierząc wzdłuż linii) są bez zmian!
Wpływ każdego punktu sterującego na kształt linii podziałowej jest ograniczony tylko do czterech najbliższych segmentów tej linii (po dwa z każdej strony punktu).
* * *
Podczas modelowania różnorodnych konstrukcji mechanicznych trzeba tworzyć różne okrągłe elementy, lub otwory. Im mniej punktów ma ich wielobok sterujący, tym lepiej (szybszy rendering, mniej pracy z modelowaniem). Z drugiej strony rezultat podziału powinien być jak najbardziej zbliżony do okręgu. Warto więc sprawdzić, na ile dokładne “koło” można uzyskać z podziału jakiejś figury o niewielkiej liczbie boków, np. sześciokąta.
Aby sprawdzić odchylenia od regularnego kształtu, porównamy kształt kilku linii podziałowych, wpisanych w okrąg o promieniu 1000 jednostek. Zmierzymy dwa rodzaje różnic:
max. odległość wierzchołka linii podziałowej do okręgu (idealnie — powinna być =0);
max. odległość boku linii podziałowej do okręgu (zależy od liczby wierzchołków linii);
Rysunek 19.2.6 i Rysunek 19.2.7 pokazują wartości odchyleń dla podziału sześciokąta:
Rysunek 19.2.6 Odchylenie od okręgu dwukrotnego podziału sześciokąta
Rysunek 19.2.7 Odchylenie od okręgu trzykrotnego podziału sześciokąta
Linia podziałowa regularnego wielokąta jest nieco spłaszczona w środku każdego segmentu. Stąd w tym miejscu występują największe odchylenia (p. Rysunek 19.2.6 i Rysunek 19.2.7). Należy zdawać sobie sprawę, że odsunięcie wierzchołka linii podziałowej od okręgu wynika wyłącznie z różnicy kształtu krzywej ostatecznej. Drugie odchylenie, które mierzyliśmy — odległość środka boku od okręgu — zależy także od liczby wierzchołków linii podziałowej. Będzie zawsze większe od odchylenia wierzchołka. (Im linia ma więcej wierzchołków, tym jest mniej “graniasta”). Błąd położenia wierzchołków przy zwiększeniu poziomu podziału sześciokąta z 2 (Rysunek 19.2.6) do 3 (Rysunek 19.2.7) zmniejszył się tylko o kilkanaście procent (z 0.274% do 0.224%). W związku jednak z dwukrotnym wzrostem liczby boków, trzykrotny podział sześciokąta ma dwukrotnie mniejsze odchylenie ściany (0.66% dla podziału dwukrotnego, 0.315% dla trzykrotnego).
Czy trzykrotny podział sześciokąta jest dobrym kandydatem na siatkę, którą warto stosować do modelowania okręgów? Niestety nie: w praktyce naszego modelowania nie stosujemy trzykrotnych powierzchni podziałowych. Mają zbyt wiele ścian, a kształt, który uzyskamy, nie jest zdecydowanie lepszy od powierzchni dwukrotnych. Podział dwukrotny sześciokąta, z poziomem odchyleń w granicy 0.7%, jest dobry do modelowania małych elementów. (Wyposażenie kabiny, drobne otwory, różnego rodzaju rury). Aby dokładnie zamodelować większe okręgi — o średnicy ok. 80 cm (kołpak śmigła, koła podwozia głównego) — potrzebne jest odchylenie rzędu 0.3%. Powinna je posiadać jakaś dwukrotna linia podziałowa. Cóż, skoro sześciokąt nie spełnił naszych oczekiwać, sprawdźmy dwukrotny podział ośmiokąta (Rysunek 19.2.8):
Rysunek 19.2.8 Odchylenie od okręgu dwukrotnego podziału ośmiokąta
Wygląda na to, że dwukrotny podział ośmiokąta jest zadowalająco dobrym przybliżeniem okręgu. Odchylenia wierzchołków są na poziomie 0.07%, a odchylenie boku też leżą w zakresie tolerancji: 0.27%.
Do zamodelowania mniejszych okręgów wystarczy użyć dwukrotnego podziału sześciokąta (max. odchylenie kształtu rzędu 0.66%). Do większych okręgów lepiej użyć dwukrotnego podziału ośmiokąta (max. odchylenie kształtu rzędu 0.27%).
Do tej pory zajmowaliśmy się wyłącznie krzywymi podziałowymi, które powstały poprzez podział jakiejś linii zamkniętej. Skoncentrowałem się na nich, gdyż większość linii podziałowych, które napotkasz w Blenderze, to krzywe zamknięte. (Linią podziałową jest kraniec każdej powierzchni podziałowej, a granica każdej powierzchni musi być obrysem zamkniętym).
Na koniec jednak, dla porządku, wspomnę o krzywych podziałowych opartych o siatkę, której końce nie są ze sobą połączone (Rysunek 19.2.9):
Rysunek 19.2.9 Linia podziałowa dla obrysu otwartego — wyznaczanie punktów końcowych
Dla końca otwartego wieloboku sterującego A nie można wyznaczyć punktu wierzchołkowego a według Wyr 19.2 (str. 1223). Brak jest kolejnego wierzchołka, który powinien istnieć z lewej strony A — jakiegoś punktu E1 (por. Rysunek 19.2.9a) i Rysunek 19.2.3). Autorzy Blendera przyjęli, że w takim przypadku brakujący punkt E1 leży w tym samym miejscu, co E2 . W tym przypadku krańcowy punkt wierzchołkowy a leży na 1 / 4 boku |A E2 |:
Wyr 19.3 Współrzędne końca linii podziałowej (ostatni punkt wierzchołkowy)
Zwróć uwagę, że z każdym kolejnym podziałem koniec linii podziałowej będzie się zbliżał do środka ostatniego boku oryginalnej linii. Rysunek 19.2.9b) pokazuje wyznaczenie punktu b — ostatniego punktu wierzchołkowego dla drugiego podziału. Punkt b leży na 1 / 4 boku |a e2 |.
Końce otwartej linii podziałowej mają następujące właściwości:
w trakcie kolejnych podziałów oryginalnego wieloboku długość ostatniego boku linii podziałowej szybko się skraca;
leżą zawsze pomiędzy 1 / 4 (pierwszy podział) a 1 / 3 (krzywa ostateczna) ostatniego boku oryginalnego wieloboku;
krzywa ostateczna jest na końcach styczna do krańcowych boków oryginalnego wieloboku.
* * *
Powierzchnie podziałowe powstają w wyniku podziału oryginalnej powłoki (siatki). Wierzchołki oryginalnej powłoki to punkty sterujące powierzchni podziałowej. Podczas podziału każda czworokątna ściana dzieli się na cztery nowe ściany, a trójkątna - na trzy. Rysunek 19.2.10 przedstawia kolejne podziały powłoki, “rozpiętej” na wierzchołkach czterech ośmiokątów. (Z powodu układu ścian, biegnących jak południki i równoleżniki, nazwałem ją “globusem”):
Rysunek 19.2.10 Podział 32-ściennego “globusa”
Rysunek 19.2.10a) przedstawia oryginalną powłokę, złożoną z 32 ścian. Jej 26 wierzchołków (zbyt wiele, aby je na tej ilustracji zaznaczać) to punkty sterujące powierzchni podziałowej. Rysunek 19.2.10b) przedstawia rezultat pierwszego podziału tej siatki. Zwróć uwagę na kształt podziału ścian w okolicach “biegunów” oryginalnej powłoki. Rysunek 19.2.10c) to wynik dwukrotnego podziału. Kształt powłoki stał się już zbliżony do kształtu powierzchni ostatecznej. W przypadku naszego “globusa” wcale nie jest to kula, tylko elipsoida. (Przekrój w płaszczyźnie równoleżnika jest okręgiem, a w płaszczyźnie południka - elipsą)
Istnieje wiele metod (nazywanych także “schematami”) podziału powierzchni. Blender wykorzystuje schemat Catmulla - Clarka. Opublikowany po raz pierwszy w 1978r, przeleżał “na półce” ponad dwadzieścia lat, zanim go “odkurzono” i zastosowano4. Reguły wyznaczania wierzchołków powierzchni podziałowej w tym schemacie podam na przykładzie pojedynczego punktu sterującego A i sąsiednich wierzchołków (Rysunek 19.2.11):
Rysunek 19.2.11 Punkt sterujący A i jego otoczenie
Wierzchołek A łączy kilka krawędzi. Na ilustracji — Rysunek 19.2.11 — są to cztery krawędzie, na których leżą punkty E1 , E2 , E3 , E4 . Otacza go także kilka innych punktów, z którymi nie jest bezpośrednio połączony. Są to pozostałe wierzchołki ścian, do których należy A. Na ilustracji oznaczyłem cztery takie punkty: F1 , F2 , F3 , F4 .
Pierwszą grupa wierzchołków powierzchni podziałowej leży w pośrodku każdej ze ścian powłoki kontrolnej. Oznaczymy je jako punkty “środkowe” (Rysunek 19.2.12):
Rysunek 19.2.12 Wyznaczanie wierzchołków f — “środkowych” punktów powierzchni podziałowej
Punkty środkowe można wyznaczyć wg Wyr 19.4:
dla ścian czworokątnych:
dla ścian trójkątnych:
gdzie5 k = 1,2,..,n; and n — to liczba ścian wokół wierzchołka A.
Wyr 19.4 Współrzędne punktów środkowych ścian wokół wierzchołka A
Kolejne wierzchołki powierzchni podziałowej to punkty krawędziowe — ek . Każdy z nich leży w połowie odległości pomiędzy środkiem odcinka |AEk |, a środkiem odcinka |fk,fk+1 | (Rysunek 19.2.13):
Rysunek 19.2.13 Wyznaczanie wierzchołków e — punktów “krawędziowych” pow. podziałowej
Każdy z punktów krawędziowych — e1 , e2 , e3 , e4 — może być wyznaczony wg Wyr 19.5:
gdzie k = 1,2,..,n; and n — to liczba ścian wokół wierzchołka A.
Wyr 19.5 Współrzędne punktów krawędziowych wokół wierzchołka A
Punkty środkowe fk i krawędziowe ek wyznaczają zewnętrzną krawędź nowych ścian, które powstają wokół wierzchołka A (Rysunek 19.2.14). (Ta krawędź jest “współdzielona” ze ścianami podziałowymi sąsiednich wierzchołków). Do zakończenia wyznaczenia czterech ścian brakuje już tylko ostatniego punktu — a. Punkty a, tak jak w przypadku krzywych, nazywamy punktami wierzchołkowymi:
Rysunek 19.2.14 Punkt a — punkt “wierzchołkowy” pow. podziałowej
Punkt wierzchołkowy a leży zawsze pomiędzy punktem A, końcami krawędzi oryginalnej powłoki Ek , oraz punktami środkowymi fk . Dokładną zależność pomiędzy nimi opisuje Wyr 19.6:
gdzie n — to liczba ścian wokół wierzchołka A
Wyr 19.6 Współrzędne punktu wierzchołkowego a — odwzorowania punktu sterującego A
Powstanie powierzchni podziałowej pokazałem na przykładzie wierzchołka łączącego cztery czworokątne ściany. Dla tak zbudowanych powierzchni sterujących, powłoka ostateczna, do której zmierzają kolejne podziały Catmull-Clarka, jest jednorodną powierzchnią B-sklejaną, trzeciego stopnia6.
Powierzchnie podziałowe potrafią jednak utworzyć gładką powłokę z dowolnej kombinacji ścian, z których każda może mieć inną liczbę boków7. Przykładem takiego “trudnego” wierzchołka są chociażby “bieguny” siatki o układzie “globusa” (Rysunek 19.2.15). Co prawda w okolicach takich punktów nie jest gwarantowana ciągłość promienia krzywizny (w tych miejscach powierzchnia ostateczna nie jest powłoką B-sklejaną). Na pewno jednak powierzchnie podziałowe pozostają “gładkie”. (Wokół wierzchołków “specjalnych” zachowują przynajmniej ciągłość stycznych do powierzchni).
Rysunek 19.2.15 Zwykłe i “specjalne” wierzchołki powłoki sterującej
Wyrażenia opisujące powierzchnie podziałowe (Wyr 19.4,Wyr 19.5, Wyr 19.6) są podane w sposób ogólny, dla dowolnej liczby ścian wokół wierzchołka oryginalnej powłoki. Używając ich, można także wyznaczyć wierzchołki siatki wokół takich “specjalnych” wierzchołków jak punkt B (Rysunek 19.2.15).
Na każdej powłoce podziałowej Catmull-Clarka można wskazać krawędzie, stanowiące bezpośrednie odwzorowanie (“ślad”) krawędzi powłoki sterującej (Rysunek 19.2.16):
Rysunek 19.2.16 Segment powierzchni podziałowej | Rysunek 19.2.17 Blender: przełącznik wyświetlania segmentów powierzchni podziałowych |
Fragment powierzchni podziałowej ograniczony “śladami” krawędzi powłoki sterującej nazwiemy segmentem. Każda powłoka podziałowa ma tyle segmentów, ile ścian ma jej powierzchnia sterująca. (Jest to analogia do segmentów krzywych podziałowych — p. str. 1223).
W Blenderze, podczas edycji siatki, możesz się swobodnie przełączać pomiędzy ścianami powłoki sterującej i jej segmentami. Służy do tego niepozorny przełącznik w panelu modyfikatora Subdivision Surface (Rysunek 19.2.17).
Zakres wpływu pojedynczego punktu sterującego na kształt powierzchni podziałowej jest ograniczony. Zmiany nigdy nie przekroczą obszaru sąsiednich 4 x 4 segmentów. (Po dwa segmenty w każdą stronę, licząc od odwzorowania zmienionego wierzchołka — p. Rysunek 19.2.18).
Rysunek 19.2.18 Granica wpływu punktu sterującego A na kształt powierzchni podziałowej
Wspomniałem wcześniej, że siatki typu “globus”, na których do tej pory eksperymentowaliśmy, pozwalają uzyskać elipsoidę, a nie kulę. Są dwie drogi, aby uzyskać za pomocą powierzchni podziałowych kształt kuli:
zastosować jako powłokę sterującą jakiś wielościan foremny (powierzchnię, której wszystkie ściany są jednakowe);
zwiększyć liczbę, oraz zmienić położenie “równoleżników” na powłoce typu “globus”;
Najprostszym przykładem pierwszej metody — użycia wielościanów foremnych — jest sześcian Rysunek 19.2.19a). Innym, lepszym przybliżeniem jest powłoka o większej liczbie ścian (Rysunek 19.2.19b):
Rysunek 19.2.19 Powłoki, pozwalające uzyskać powierzchnie podziałowe zbliżone do kuli
Rysunek 19.2.19c) przedstawia przykład drugiego rozwiązania — modyfikację siatki typu “globus”. Mimo, że okolice “biegunów” mają w takiej powłoce największe odchylenie od kształtu kuli, w praktyce często stosuję właśnie to rozwiązanie. Dlaczego? Zazwyczaj modelujemy nie pełną kulę, ale jej fragment — jakieś zaokrąglenie. Fragment siatki typu “globus”, zawierający punkt biegunowy, łatwo jest “wyprowadzić” z fragmentów innych siatek. A odchylenie w okolicy bieguna? Cóż, jest to pewien problem, ale zazwyczaj wystarcza dodać jeden - dwa dodatkowe równoleżniki, i kształt staje się wystarczająco “kulisty”.
Do tej pory demonstrowałem wyłącznie powierzchnie zamknięte. Rysunek 19.2.20 pokazuje przykłady powierzchni podziałowych dla powłok, które są otwarte:
Rysunek 19.2.20 Powierzchnie podziałowe dla powłok otwartych
Rysunek 19.2.20a) przedstawia efekt usunięcia połowy “globusa”. Powstała powłoka sterująca w kształcie czaszy. Jej krawędź jest krzywą podziałową — taką jaką analizowaliśmy w pierwszej części tej sekcji. O kształcie tej linii decydują wyłącznie punkty krawędzi powłoki sterującej. (W tym przypadku jest okręgiem, powstałym w wyniku podziału ośmiobocznej krawędzi czaszy) .
Czasza z przypadku a) ma nieco większą średnicę, niż elipsoida, z której powstała. Ten efekt widać dobitniej w drugim przykładzie. Rysunek 19.2.20b) przedstawia powierzchnię, która także powstała z siatki “globusa”. Tym razem nie usunęliśmy żadnego wierzchołka. Usunięta została tylko pojedyncza ściana — i powstał w powłoce otwór. Jego krawędź zależy tylko od wierzchołków tej usuniętej ściany, więc leży w ich płaszczyźnie. W efekcie krawędź otworu znalazła się powyżej oryginalnej powłoki, i “pociągnęła” za sobą inne ściany z otoczenia. Wygląda to trochę jak brzeg formującego się wulkanu. Dla powłok o niewielkim zaokrągleniu ten efekt jest praktycznie niewidoczny. Może stanowić problem, gdy będziesz próbował wykonać większy otwór w bardziej zaokrąglonej powierzchni — np. kadłuba (por. Rysunek 19.2.28, str. 1237).
Abyś nie odniósł mylnego wrażenia, że krawędź powierzchni podziałowej zawsze jest jakimś płaskim obrysem, przygotowałem ostatni, trzeci przykład. Rysunek 19.2.20c) pokazuje nieregularną powierzchnię, w której jedne ściany są trójkątne, a inne — czworokątne. Krawędź takiej powłoki jest także krzywą podziałową — tyle, że tym razem przestrzenną8.
Krawędzią powierzchni podziałowej jest zawsze krzywa podziałowa. Wielobokiem sterującym tą krzywą jest krawędź powłoki sterującej.
Krawędzie otwartych powłok podziałowych przyjmują opisany powyżej kształt, bo zastosowano do ich podziału inne wyrażenia, niż dla pozostałych wierzchołków powierzchni. Ich punkty krawędziowe są wyznaczane według Wyr 19.1 (str. 1223) a nie Wyr 19.5 (str. 1229). Podobnie punkty wierzchołkowe — ich współrzędne opisuje Wyr 19.2, a nie Wyr 19.6. W sumie to program obliczający wierzchołki podejmuje decyzję, według jakiego wyrażenia podzieli daną krawędź. W związku z tym programiści stworzyli dodatkową możliwość: użytkownik może sam oznaczyć niektóre krawędzie oryginalnej powłoki jako “ostre” (creases). Zostaną wówczas potraktowane jak gdyby były krawędziami zewnętrznymi, mimo że leżą pośrodku powierzchni. Ich odwzorowaniem na powłoce podziałowej jest ostra krawędź, o kształcie krzywej podziałowej (Rysunek 19.2.21):
Rysunek 19.2.21 Ostre krawędzie wewnątrz powierzchni podziałowych
Rysunek 19.2.21 a) przedstawia sytuację wyjściową — zwykłą, gładką powłokę. Rysunek 19.2.21 b) pokazuje, jak zmieni się ten kształt, gdy “równik” powłoki sterującej został oznaczony jako “ostry” (crease). Pojawiło się w tym miejscu ostre załamanie kształtu powłoki podziałowej (nie jest zachowana ciągłość stycznych). Kształt końcowych krawędzi powłoki nie uległ zmianie, mimo że mają wspólny punkt przecięcia z “ostrą” krawędzią.
Rysunek 19.2.21c) demonstruje efekt przecięcia się dwóch krawędzi oznaczonych jako “ostre”. Oprócz “równika”, oznaczyłem jako “ostry” jeden z południków. Punkt, w którym przecięły się te dwie krawędzie, znalazł się na powłoce sterującej.
Jeżeli z punktu sterującego wychodzą co najmniej trzy “ostre” krawędzie, to taki wierzchołek także nazywamy “ostrym”, albo “narożnym”. Każda powierzchnia podziałowa (dowolnego poziomu) ma w takim punkcie odpowiedni punkt wierzchołkowy.
Na pierwszy rzut oka powyższa reguła wydaje się nie obowiązywać na przecięciu “ostrej” krawędzi z krawędzią powłoki (Rysunek 19.2.22a) . W punkcie A, gdzie krawędź zewnętrzna styka się z równoleżnikiem, oznaczonym jako “ostry” (krawędź |AE3 |), powinien się pojawić wierzchołek narożny. Nic takiego jednak nie wystąpiło — ostra krawędź płynnie “rozmywa” się w krawędzi powłoki. Punkt wierzchołkowy a leży nadal na nie zdeformowanym okręgu podstawy. Dlaczego?
Rysunek 19.2.22 Uzyskanie narożnika na krawędzi powłoki
Krawędź powłoki jest wyznaczana w taki sam sposób (według tych samych wzorów), co krawędzie “ostre”. Sposób obliczeń nie czyni z niej jednak samoczynnie krawędzi “ostrej”. Dopóki użytkownik nie oznaczy jej w ten sposób, będzie przez program traktowana jak gładka. Dlatego z wierzchołka A wychodzi tylko jedna ostra krawędź — |AE3 |, i nie ma tu narożnika (Rysunek 19.2.22a)9. Aby uzyskać w punkcie A narożnik, należy oznaczyć krawędzie |AE2 | i |AE4 | jako “ostre” (Rysunek 19.2.22b).
Faktycznym wyjątkiem od reguły “punktu narożnego” jest narożnik prostokątnej ściany, leżący na krawędzi powłoki. Rysunek 19.2.23 przedstawia taki punkt A: “gładka” krawędź powłoki omija go szerokim łukiem. Gdy jednak “wyostrzymy” jego obydwie krawędzie — stanie się narożnikiem:
Rysunek 19.2.23 Uzyskanie narożników na zewnętrznej krawędzi powłoki prostokątnej
Wyostrzenie krawędzi umożliwia także uzyskanie prostokątnego otworu wewnątrz powłoki podziałowej. W takim przypadku wystarczy “wyostrzyć” tylko dwie przeciwległe krawędzie otworu (Rysunek 19.2.24). Spowoduje to uzyskanie ostrych narożników, mimo że nie są to punkty narożne, i nie leżą na powierzchni siatki sterującej. Zazwyczaj taki efekt oznacza mniejsze deformacje oryginalnego kształtu siatki, i jest często bardzo pożądany. (Wyostrzenie krawędzi zawsze zmienia kształt powłoki — różnica polega tylko na tym, jak duża jest to deformacja)
Rysunek 19.2.24 Uzyskanie narożników na krawędzi wewnętrznego, prostokątnego otworu
“Ostra” krawędź ogranicza także wpływ punktów sterujących na kształt powierzchni. Punkty sterujące po jednej stronie “ostrej” krawędzi nie mają żadnego wpływu na kształt powierzchni po drugiej stronie.
Rysunek 19.2.25 ilustruje, jaką “barierą dla zmian” jest ostra krawędź. Przedstawiona powłoka zawiera dużą deformację, wywołaną przesunięciem punktu sterującego A. Przypadek a) to kształt gładkiej, zdeformowanej powierzchni. Przypadek b) — powierzchni, w której wpływ punktu A został ograniczony przez “ostrą” krawędź.
Rysunek 19.2.25 Ograniczenie wpływu punktu sterującego A przez “ostrą” krawędź
Krawędzie nie muszą być zawsze “całkiem ostre” lub “całkiem gładkie”. W istocie Blender pozwala na płynną regulację “ostrości” w zakresie od 0 (zwykła, gładka krawędź) do 1 (krawędź ostra) (Rysunek 19.2.26) :
Rysunek 19.2.26 Stopniowa zmiana ostrości krawędzi
Wierzchołek ag leży na zwykłej, gładkiej powierzchni, ao — na zupełnie ostrej (Rysunek 19.2.26). Jak wyznaczany jest a — wierzchołek krawędzi o “częściowej” ostrości (crease = 0.5)? Współrzędne punktów krawędziowych i wierzchołkowych wzdłuż takiej krawędzi są “średnią ważoną” współrzędnych punktów ag i ao . “Wagą” w tej średniej jest wartość “ostrości” — od 0.0 do 1.0:
Wyr 19.7 Współrzędne punktów wierzchołkowych a dla krawędzi “półostrych”
σ — “ostrość”: od 0.0 (całkowicie gładkie) do 1.0 (całkowicie ostre);
e0 — punkt krawędziowy dla krawędzi całkowicie "ostrej", wg Expr. 19.1;
eg — punkt krawędziowy dla krawędzi całkowicie "gładkiej", wg Wyr 19.5;
Wyr 19.8 Współrzędne punktów krawędziowych e dla krawędzi “półostrych”
Pamiętasz, jak podkreślałem, że współrzędna X każdego punktu powłoki podziałowej zależy tylko od współrzędnej X odpowiednich punktów sterujących (str. 1223)? Podobnie współrzędna Y takiego wierzchołka zależy od Y, a Z od współrzędnej Z punktów sterujących.
Kształt rzutu powierzchni podziałowej na płaszczyznę zależy tylko od kształtu rzutu jej punktów sterujących na tej płaszczyźnie.
Ta reguła nie wygląda dość przejrzyście, ale jej znajomość bardzo ułatwia modelowanie. Postaram się ją pokazać na przykładzie. Rysunek 19.2.27 pokazuje lekko wygiętą powłokę, w której wykonałem otwór. Krawędź otworu w płaszczyźnie XY jest okręgiem (Rysunek 19.2.27c):
Rysunek 19.2.27 Okrągły otwór w lekko wygiętej powłoce
Jak się zmieni kształt tej powierzchni w rzucie z góry (płaszczyźnie XY), gdy wygnę tę powierzchnię (Rysunek 19.2.28)? Wygięcie uzyskałem, przesuwając punkty sterujące w kierunku prostopadłym do XY (wzdłuż osi Z). Rysunek 19.2.28c) pokazuje, że jej rzut z góry nie uległ żadnej zmianie! (Porównaj Rysunek 19.2.28c i Rysunek 19.2.27c.)
Ta właściwość jest nieoceniona szczególnie w przypadku konieczności dokonania jakichś niewielkich poprawek kształtu. Możesz je zazwyczaj zaplanować jako przesunięcia wierzchołków wzdłuż pojedynczej osi. W ten sposób masz gwarancję, że kształt obiektu w kierunku prostopadłym nie ulegnie żadnej zmianie.
Na koniec mała dygresja o otworach w powierzchniach o małym i dużym promieniu krzywizny. Każda krawędź otworu w wygiętej powłoce podziałowej wywołuje lokalne zaburzenia kształtu. Wspomniałem to zjawisko na str. 1232 (Rysunek 19.2.20b), używając nieco romantycznego określenia “efekt krawędzi wulkanu”. Efekt ten jest praktycznie do zaniedbania na powierzchniach o małej krzywiźnie, jakiej przykład pokazuje Rysunek 19.2.27. Taką niewielką krzywiznę ma np. skrzydło samolotu (poza krawędzią natarcia). Stąd bardzo łatwo w skrzydle wykonać różnego kształtu otwory i wycięcia.
Problem jednak narasta, gdy rośnie krzywizna powierzchni. Na powłoce wygiętej tak, jak bywa często wygięty przekrój kadłuba, wypukłości wokół otworu stają się widoczne (Rysunek 19.2.28a). Jak napisałem wcześniej, nie wpływają na kształt powierzchni w rzucie prostopadłym, ale na pewno nie można ich tak zostawić. Z tym problemem możesz sobie poradzić, zagęszczając siatkę punktów sterujących w okolicy deformacji. Takie odchylenia powłoki szybko znikają. Już przy dwukrotnym zwiększeniu liczby ścian w takim miejscu deformacja jest o wiele mniejsza.
Rysunek 19.2.28 Okrągły otwór w bardzo wygiętej powłoce
Podsumowanie
Oryginalna siatka, z której powstaje powłoka podziałowa, nazywa się siatką sterującą, a jej wierzchołki — punktami sterującymi (control points — str. 1221).
Krzywe i powłoki podziałowe można podzielić na segmenty. Każdy segment odpowiada krawędzi (dla krzywych) lub ścianie (dla powłok) siatki sterującej (str. 1223).
Wpływ przesunięcia pojedynczego punktu sterującego na kształt krzywej / powłoki podziałowej nie przekracza dwóch segmentów (w każdym kierunku) (str. 1224, str. 1231).
Do dobrego odwzorowania okręgu wystarczy dwukrotny podział sześciokąta. Dla bardzo dokładnego okręgu — dwukrotny podział ośmiokąta (str. 1226)
Krawędzią każdej powierzchni otwartej jest krzywa podziałowa (str. 1232).
Powierzchnie podziałowe mogą zawierać krawędzie oznaczone jako “ostre” (str. 1233). Możliwa jest także ostrość częściowa (str. 1235)
Ostra krawędź jest “barierą” dla propagacji zmiany kształtu powłoki (str. 1235)
Rzut powierzchni podziałowej na płaszczyznę zależy wyłącznie od rzutu jej punktów sterujących na tę płaszczyznę (str. 1236). Dzięki tej właściwości można bez problemu “wycinać” okręgi w powierzchniach, które nie są zbyt wygięte. przy większym wygięciu pojawią się deformacje na brzegu otworu.
Fotografia utrwala rzeczywisty obiekt w ściśle określonym ujęciu perspektywicznym. Podstawowym parametrem tego ujęcia jest długość ogniskowej obiektywu (patrz Rysunek 19.3.1). Powiedzmy, że wynosi 50mm. Wymiary kliszy są zazwyczaj standardowe (wysokość 35mm, szerokość 48mm). Obraz na odbitce 10x15cm wyglądałby “zupełnie jak prawdziwy”, gdybyś oglądał go z odległości 30 cm, zamknąwszy przy tym jedno oko. Oczywiście, nigdy tak zdjęć nie oglądamy. Napotykając je na co dzień, przyzwyczailiśmy się nawet do takich drastycznych deformacji beczkowatych jak “rybie oko”. (Mimo, że nie mamy szans zobaczyć świata w ten sposób — wyklucza to budowa ludzkiego oka).
Rysunek 19.3.1 Zniekształcenie beczkowate na fotografii
Rysunek 19.3.1 pokazuje:
po lewej: geometrię projekcji podczas wykonywania zdjęcia. Linia z punktami A, B, C to np. oś symetrii prawdziwego samolotu. Linia z punktami a, b, c to obraz tej osi na zdjęciu. Zwróć uwagę, że odcinek |Cc| jest o wiele dłuższy od |Aa|;
po prawej: sytuację, gdybyśmy odbitkę tej fotografii obserwowali z nieskończonej odległości (czyli nie byłaby to w ogóle perspektywa, a techniczny rzut z lewej). Dlatego tu wszystkie odcinki |Aa|, |Bb|, |Cc| są równoległe. Różne odległości pomiędzy obiektem a jego obrazem, występujące w perspektywie, zrobiły jednak już swoje. Jeżeli wysokości oryginału (np. kadłuba) w punktach A i C są identycznie, to w punkcie c (na zdjęciu) jest ona mniejsza niż w pkt. a.
Linię, demonstrującą stopień zniekształcenia beczkowatego, można uzyskać ustawiając linie |Cc|, |Bb|, |Aa| pod kątem 90º do płaszczyzny zdjęcia (Rysunek 19.3.1). Długość tych odcinków jest taka sama jak podczas tworzenia zdjęcia. Ich końce wyznaczają teraz krzywą deformacji. Krzywa deformacji ma w tym przypadku kształt hiperboli.
W rzeczywistości soczewki obiektywu nie mają idealnych ogniskowych. Na większości zdjęć krzywa deformacji nie jest idealną hiperbolą — może być dodatkowo wygięta na krańcach. Rysunek 19.3.2 pokazuje, jak powstaje taki efekt:
Rysunek 19.3.2 Przykład złożonego zniekształcenia beczkowatego
Wśród konstruktorów lotniczych funkcjonuje powiedzenie “the wing is the king”. Ma to znaczyć, że geometria płata ma decydujący wpływ na wszelkie charakterystyki samolotu. Na przykład — P-40E “Warhawk” i P-51A “Mustang” miały niemal identyczną powierzchnię płata. Używały takich samych silników Allison, miały bardzo podobną powierzchnię czołową — chłodnic, kadłuba, skrzydeł. Różniły się jednak drastycznie oporem, jaki stawiały podczas lotu. Współczynnik oporu P-40E wynosił 0.02421. Ten sam współczynnik dla P-51A wynosił 0.0176. Co powodowało tę różnicę? Przede wszystkim profil płata! W wyniku zastosowania skrzydła o profilu laminarnym pierwsze “Mustangi” był o 45 km/h szybsze od “Warhawków” 2.
Profil płata jest odwzorowywany w lotnictwie bardzo dokładnie — nawet nieznaczne różnice kształtu mogą w znaczny sposób zmienić np. charakterystyki przeciągnięcia. Rysunek 19.4.1 wyjaśnia podstawowe pojęcia, używane w opisie geometrii profili lotniczych:
Rysunek 19.4.1 Geometria profilu lotniczego
Tradycyjnie profile lotnicze rysuje się w płaszczyźnie XY. Z lewej strony, w punkcie (X=0, Y=0), znajduje się zawsze tzw. nos profilu, określający kształt krawędzi natarcia płata. Nos jest zazwyczaj zaokrąglony. Czasami jest podawany promień tego zaokrąglenia. Profil jest zawsze zakończony w punkcie (X=100, Y=0). Linia profilu jest często dzielona na dwie części: obrys górny i obrys dolny. Obrysy łączą się na krańcach profilu (w X = 0 i X=100).
Prosty odcinek, łączący nos z krawędzią spływu nazywamy cięciwą. Drugą linią charakterystyczną jest szkieletowa. Punkty tej linii leżą w równej odległości od górnej i dolnej krawędzi profilu. Można ją sobie wyobrazić jako linię przechodzącą przez środki okręgów, wpisanych w obrys profilu (Rysunek 19.4.1).
Dla profilu podawana jest często także:
maksymalną grubość (informacyjnie — chodzi tu o wysokość, mierzoną wzdłuż osi Y);
punkt maksymalnego ugięcia linii szkieletowej (Rysunek 19.4.1).
Gdzieś tak do lat dwudziestych XX wieku profile płatów opracowywali sami konstruktorzy. Robili to metodą prób i błędów. Na przykład popularny profil Clark Y powstał właśnie w tym czasie (opracował go w 1922 r. Virginius A. Clark). Użyto go w dziesiątkach samolotów z lat dwudziestych. Aby inżynierowie na całym świecie byli w stanie poprawnie odtworzyć kształt profili, zaczęto publikować współrzędne ich obrysów (Tabela 19.4.1, Rysunek 19.4.2):
| 0 | 1.25 | 2.5 | 5 | 7.5 | 10 | 20 | 30 | 40 | 50 | 60 | 70 | 80 | 90 | 100 | |
| Yg | 3.49 | 5.53 | 6.50 | 7.87 | 8.86 | 9.63 | 11.35 | 11.73 | 11.40 | 10.52 | 9.18 | 7.72 | 5.54 | 3.32 | 0.25 |
| Yd | 3.49 | 1.94 | 1.46 | 0.94 | 0.61 | 0.40 | 0.04 | 0.00 | 0.00 | 0.00 | 0.00 | 0.00 | 0.00 | 0.00 | 0.00 |
Tabela 19.4.1 Współrzędne profilu Clark Y
Rysunek 19.4.2 Profil Clark Y, wykreślony na podstawie współrzędnych z Tabela 19.4.1
Gdzieś w latach dwudziestych coraz szerzej zaczęto używać profili, opracowanych przez placówki naukowe. Na przykład publikował je niemiecki uniwersytet w Getyndze. (Były oznaczane np. “Götingen - 623”, albo “Götingen - 543”.) W 1933 r. finansowana przez rząd USA NACA opublikowała istotny raport, zawierający geometrię i charakterystyki 78 profili lotniczych. Były to tak zwane “profile rodziny 4-cyfrowej”. Od tamtej pory profile te były szeroko wykorzystywane w wielu konstrukcjach lotniczych, nie tylko amerykańskich3. Do rodziny tej należą także profile płata P-36 i P-40: NACA 2215 i NACA 2209.
Czy wiesz, że numer profilu NACA nie jest wcale numerem kolejnym? Tak naprawdę zawiera opis jego kluczowych parametrów geometrycznych:
1 cyfra: największe ugięcie szkieletowej (czyli wartość Y max. ugięcia w %).
2 cyfra: odległość punktu o największym ugięciu szkieletowej od nosa profilu, podzielona przez 10. Na przykład — “2” oznacza, że max. ugięcie szkieletowej znajduje się 20% od krawędzi natarcia.
3 i 4 cyfra: grubość profilu (%).
Tak więc symbol profilu P-40 — “NACA 2215” — oznacza profil o grubości 15% i maksymalnym ugięciu szkieletowej 2%, w X = 20% cięciwy. W istocie kształty NACA 2215 i NACA 2209 różnią się tylko grubością. Gdy przeskalujesz rysunek NACA 2209, rozciągając go w pionie, uzyskasz NACA 2215. (Na odwrót to także działa!)
Co więcej — NACA opublikowało wzory matematyczne, które pozwalają odwzorować kształt profilu z dowolną dokładnością. (Trzydzieści punktów, jakie Tabela 19.4.1 dla profilu Clark Y, pozostawia jeszcze pole do pewnej dowolności).
NACA opublikowała parametry także tzw. “rodziny 5-cyfrowej”, ale nie będziemy się nią tu zajmować. Poza tym istnieją także profile NACA, noszące inne oznaczenia. Na przykład — laminarny profil płata “Mustanga” to NACA 45-100. A profil skrzydła Messerschmitta Bf 109 jest podany jako NACA 2R 1 14.2 (to oznacza podwójne załamanie szkieletowej).
Gdy zaczniesz szukać w Internecie hasła “NACA, airfoil”, znajdziesz szybko kilka stron podających współrzędne wielu różnych profili lotniczych. Uważam, że godny polecenia jest w szczególności serwis dostępny pod adresem http://www.ppart.de/programming/java/profiles/NACA4.html :
Rysunek 19.4.3 Serwis internetowy — generator współrzędnych 4-cyfrowych profili NACA
Rysunek 19.4.4 Wygenerowane współrzędne profilu NACA 2215
Gdy ustawisz na tej stronie odpowiednio parametry:
Maximum Camber: ugięcie szkieletowej (1-sza cyfra);
Max. Camber Pos: pozycja ugięcia szkieletowej (2-ga cyfra);
Thickness: grubość profilu (dwie ostatnie cyfry).
i naciśniesz przycisk Show Points, w polu po prawej stronie ekranu zobaczysz współrzędne. Wygenerowano je dla profilu o długości cięciwy = 1.0. (Po 100 pkt na obrys).
Zaznacz całą zawartość pola tekstowego ze współrzędnymi (Ctrl-A) i skopiuj ją do schowka (Ctrl-C).
Co dalej zrobić z tymi współrzędnymi? Będziemy pracowicie rysować w Inkscape ten profil, “punkcik po punkciku”? Na szczęście nie — istnieje szybsza droga.
Otwórz arkusz kalkulacyjny, który przygotowałem specjalnie tym celu (Source\Tools\airfoil.xls z pliku source.zip, por. str. 22 — Rysunek 19.4.5):
Rysunek 19.4.5 Arkusz kalkulacyjny — przygotowanie wyrażenia SVG
Teraz przełącz się do Inkscape, i: narysuj w nim dowolną linię prostą. Następnie przełącz się na tryb selekcji i otwórz okno edytora XML (Edit→XML Editor...)
Rysunek 19.4.6 Linia na rysunku i jej definicja w edytorze XML (SVG)
Wklej zawartość schowka (kopię obszaru SVG z arkusza airfoil.xls — por. Rysunek 19.4.5) jako nową wartość atrybutu d 4(Rysunek 19.4.7):
Rysunek 19.4.7 Wartość atrybutu d (wierzchołki linii) przeniesiona z arkusza airfoil.xls
Gdy naciśniesz przycisk Set, wprowadzisz nowe wartości do dokumentu Inkscape (Rysunek 19.4.8):
Rysunek 19.4.8 Uzyskany w Inkscape profil NACA 2215
W ten sposób nasza linia nagle zmieniła się w gotowy rysunek profilu NACA 2215! Pozostaje teraz tylko zmienić jego skalę i przesunąć w odpowiednie miejsce rysunku.
Na koniec warto wspomnieć o odmianie profili NACA, z końcówką “T”. Są to wersje o zmniejszonym promieniu noska. Profile “T” mają o 75% zmniejszony promień noska w stosunku do promienia użytego w serii NACA 00xx (bez końcowej litery). Odpowiednio do tego jest także zmodyfikowany cała kształt przedniej sekcji - na “ostrzejszą”. “T” w zamyśle twórców mogło to znaczyć tyle, co angielskie “thinner”, czyli “cieńszy” (albo, równie dobrze, “tapered”). Przykładem profilu “T” jest NACA 0018T (Rysunek 19.4.9):
Rysunek 19.4.9 Profil NACA 0018T (“T” oznacza zmieniony przód — zmniejszony promień noska)
Nigdzie nie znalazłem opisu, jaki przekrój miało usterzenie P-40. Przymierzałem do rysunków fabrycznych (np. owiewki usterzenia) wiele profili. Ostatecznie doszedłem do wniosku, że była to właśnie rodzina NACA 00xxT. W P-40 wykorzystano “cieńsze” wersje profilu, jaki pokazuje Rysunek 19.4.9:
usterzenie pionowe, u nasady: NACA 0008T;
usterzenie poziome, u nasady: NACA 0010T;
usterzenie poziome, u końca: NACA 0009T.
Tabela 19.4.2 określa współrzędne obrysu profilu NACA 0018 T dla piętnastu punktów. Wykorzystałem je do wyznaczenia obrysu profilu. Aby uzyskać z tych współrzędnych cieńszą wersję, wystarczy przeskalować je w kierunku pionowym. Na przykład, po “ściśnięciu” NACA 0018T o 50% uzyskamy NACA 0009T, wykorzystywany w końcówce usterzenia poziomego.
| 0 | 1.25 | 2.5 | 5 | 7.5 | 10 | 20 | 30 | 40 | 50 | 60 | 70 | 80 | 90 | 100 | |
| Yg | 0.00 | 1.87 | 2.83 | 4.28 | 5.41 | 6.32 | 8.46 | 9.00 | 8.62 | 7.67 | 6.44 | 5.09 | 3.65 | 2.05 | 0.00 |
| Yd | 0.00 | -1.87 | -2.83 | -4.28 | -5.41 | -6.32 | -8.46 | -9.00 | -8.62 | -7.67 | -6.44 | -5.09 | -3.65 | -2.05 | 0.00 |
Tabela 19.4.2 Współrzędne profilu NACA 0018T (cieńsze wersje profilu są używane w usterzeniach).
Każdy z programów, wykorzystywanych w tej książce, używa barw wyrażonych poprzez intensywność trzech niezależnych składników (kanałów): czerwonego (R), zielonego (G) i niebieskiego (B). Taki model często określa się jako „RGB”, i jest niezwykle popularny w grafice komputerowej.
Intensywność każdego ze składników barwy jest wyrażona liczbą od 0.0 (brak) do 1.0 („najjaśniejszy”). Rysunek 19.5.1 pokazuje, jak z wartości R, G, B jest tworzona barwa:
Rysunek 19.5.1 Przykład zakodowania barwy za pomocą składników RGB — różne odcienie czerwieni
Czasami wraz z trójką R, G, B występuje czwarty składnik — nieprzejrzystość. Oznaczany jest jako „alfa” (A) i używany jako dodatkowy czynnik przy łączeniu barw. Steruje udziałem każdego ze składników. A = 1.0 oznacza kompletną nieprzejrzystość, A = 0.0 — zupełną przejrzystość.
Aby przyśpieszyć obliczenia i zmniejszyć ilość pamięci, potrzebnej do przechowywania obrazu, składniki R, G, B, A zapisuje się w obrazie jako 8-bitowe liczby całkowite (o wartościach od 0 do 255). W takim przypadku 255 odpowiada oryginalnej wartości 1.0. Z zapisu barw na liczbach całkowitych wziął się, występujący w GIMP i Inkscape, zwyczaj podawania intensywności składnika barwy w skali od 0 do 255.
We wszystkich programach, opisywanych w tej książce, pojawiają się nazwy operacji, przeprowadzanych na barwie (lub intensywności) pikseli: Add, Multiply, Substract, .... W przypadku Blendera może to być tryb łączenia dwóch obrazów w węźle Color:Mix (por. str. 423, Rysunek 7.6.22). W przypadku Gimpa to tryb Mode (str. 624), a w Inkscape — Blend Mode (str. 686, Rysunek 11.9.1). W przypadku programów 2D tryby te sterują nałożeniem obrazu z aktualnej warstwy na warstwy poprzednie (czyli sumę warstw leżących „poniżej”). Postaram się w tej sekcji wyjaśnić efekty każdego z tych trybów, gdyż czasami nie są intuicyjne.
Zacznijmy od zwykłego złożenia dwóch warstw — w Blenderze to nazywa się Mix, a w Gimpie i Inkscape — Normal. Rysunek 19.5.2 pokazuje przykład prostego nałożenia czerwonej, kompletnie nieprzejrzystej warstwy P, na niebieskie tło t. Rysunek 19.5.3 przedstawia tę samą sytuację, ale z częściową przejrzystością warstwy P. Jak programy obliczają kolor złożenia tych dwóch warstw (obszaru rezultatu — c)?
Rysunek 19.5.2 Złożenie podłoża t i warstwy P w trybie Mix/Normal. P zupełnie nieprzejrzysta | Rysunek 19.5.3 Złożenie podłoża t i warstwy P w trybie Mix/Normal. P o nieprzejrzystości = 0.4 |
Przyjrzyjmy się dokładniej przypadkowi, który pokazuje Rysunek 19.5.3. W metodzie Mix/Normal składniki R,G,B barwy wynikowej c są wyznaczane jako tzw. „średnia ważona” składników barw t i P. „Wagą” tej średniej jest nieprzejrzystość A warstwy leżącej „na wierzchu” — P 1:
gdzie:
c — rezultat nałożenia barw (por. Rysunek 19.5.3);
t — barwa tła (por. Rysunek 19.5.3);
P — barwa warstwy nakładanej (por. Rysunek 19.5.3);
A — nieprzejrzystość (składnik Alfa) warstwy P;
Wyr 19.9 Wyznaczanie rezultatu „zwykłego” mieszania barw (operacja nazywana Mix lub Normal)
Jak „działa” Wyr 19.9? Podstawmy do niego takie wartości, jakie podaje Rysunek 19.5.3. Na niebieskie (R = 0, G = 0, B = 1) tło t została nałożona półprzejrzysta (A = 0.4) warstwa P, w kolorze czerwonym (R = 1, G = 0, B = 0). Komponenty R, G, B barwy c wyznaczamy, podstawiając do Wyr 19.9 odpowiednie komponenty barw t i P (Rysunek 19.5.4):
Rysunek 19.5.4 Wyznaczenie nałożenia barw warstwy t i P (A = 0.4 — por. Rysunek 19.5.3) w trybie Mix/Normal.
Rysunek 19.5.4 pokazuje, że każdy z komponentów barwy można traktować jako intensywność — czyli odcień szarości. Komponenty rezultatu c są wyznaczane niezależnie, poprzez podstawienie do odpowiedniego wzoru. Dlatego w dalszej części tej sekcji każdą z operacji na barwach omówię, przedstawiając jej ogólny wzór (taki, jak ten z Wyr 19.9), oraz rezultat — w postaci złożenia dwóch prostopadłych gradientów szarości (Rysunek 19.5.5a):
Rysunek 19.5.5 Sposób prezentacji wyników nałożenia dwóch warstw, z różnymi kierunkami gradientu szarości.
Rezultat nałożenia — z odpowiednim operatorem — warstwy P na t (Rysunek 19.5.5a) będę pokazywać na schematycznym kwadracie (Rysunek 19.5.5b). Możesz na nim zobaczyć wynik połączenia każdego odcienia szarości P z każdym odcieniem szarości tła t. Z góry i z lewej strony kwadratu są pokazane oryginalne kolory pikseli z warstw P i t. To jakby osie układu współrzędnych, z których możesz wybrać interesujący Cię odcień pikseli wejściowych. Na przecięciu prostopadłych do osi P i t widzisz barwę rezultatu operacji (por. Rysunek 19.5.5b).
Domyślną operację — Mix / Normal — już omówiliśmy. Rysunek 19.5.6 przedstawia operację dodawania:
Dodawanie wartości pikseli rozjaśnia obraz. Charakterystyczne dla dodawania jest „obcinanie” rezultatu do 1.0. (Nie ma nic „bielszego od bieli”). Tę operację zapisaliśmy w Wyr 19.10 jako funkcję Clip. Rysunek 19.5.6 pokazuje efekt jej „załączenia” — pół testowego kwadratu jest białe. To obszar, gdzie suma składników barwy t i P była > 1.0.
A teraz odwrotność dodawania: — Substract. Rysunek 19.5.7 przedstawia rezultaty tej operacji:
Odejmowanie wartości pikseli ściemnia obraz. Charakterystyczne dla odejmowania jest „odrzucanie” rezultatów < 0. (Nie ma nic „czarniejszego od czerni”). Tę operację zapisaliśmy w Wyr 19.11 jako funkcję Clip. Rysunek 19.5.7 pokazuje efekt jej „załączenia” — pół testowego kwadratu jest całkowicie czarne. To obszar, gdzie różnica składników barwy t i P była < 0.
Kolejną typową operacją jest mnożenie — Multiply. Rysunek 19.5.8 przedstawia rezultaty tej operacji:
Mnożenie wartości pikseli ściemnia obraz (gdyż mnożysz przez wartości poniżej 1.0). W odróżnieniu od odejmowania, żadna część testowego kwadratu, który przedstawia Rysunek 19.5.7, nie jest czarna. To są obszary zabarwione na bardzo ciemny kolor szary.
Kolejną typową operacją jest dzielenie — Divide. Rysunek 19.5.9 przedstawia rezultaty tej operacji:
Dzielenie wartości pikseli rozjaśnia obraz (gdyż dzielisz przez wartości poniżej 1.0). Charakterystyczne dla dzielenia jest „obcinanie” rezultatu do 1.0. (W tym także nieskończoności, występującej dla A= 0 lub P = 0). Tę operację zapisaliśmy w Wyr 19.13 jako funkcję Clip. Rysunek 19.5.9 pokazuje efekt jej „załączenia” — pół testowego kwadratu jest białe. To obszar, gdzie suma składników barwy t i P była > 1.0. Zwróć uwagę, że rozkład szarości na przeciwległej połowie jest inny, niż w przypadku dodawania (por. Rysunek 19.5.6)
Kolejną typową operacją jest przyciemnienie — Darken. Rysunek 19.5.10 przedstawia rezultaty tej operacji:
Ściemnianie obrazu jest operacją dość intuicyjną. Z każdej pary pikseli (jeden należy do tła, drugi — do nakładanej warstwy) wybiera ten ciemniejszy.
Operacją odwrotną do ściemnienia jest rozjaśnienie — Lighten. Rysunek 19.5.11 przedstawia rezultaty tej operacji:
Rozjaśnianie obrazu jest operacją dość intuicyjną. Z każdej pary pikseli (jeden należy do tła, drugi — do nakładanej warstwy) wybiera ten jaśniejszy.
Na listach rozwijalnych Blendera i Gimpa znajdziesz więcej operacji, niż omówiłem w tym dodatku. Mówiąc szczerze, nie miałem okazji ich do tej pory używać. Jeżeli jednak chciałbyś sprawdzić, jak każda z nich działa — możesz skorzystać z pliku optional\pixel_operations.xcf (por. str. 22). To obraz Gimpa, zawierający dwie warstwy, odpowiadające gradientom t i P. Wykorzystywałem go do wygenerowania ilustracji dla tej sekcji. Możesz go otworzyć i wybrać w Gimpie, z zakładki Layers jakiś inny tryb mieszania barw. Sam się wtedy przekonasz, jak działa.
Jak przełożyć typowy opis barw samolotu — „górne powierzchnie w kolorze Olive Drab, dolne — Neutral Gray, wewnętrzne — Zinc Chromate ” — na konkretne wartości R, G, B, które można wpisać w konkretny program komputerowy?
Omówię to właśnie na przykładzie podanego powyżej, regulaminowego maglownia P-40 w USAAC1. Sprawa wydaje się prosta jak drut: znamy nazwy farb, więc wystarczy gdzieś znaleźć obraz ich próbek, zidentyfikować wartości komponentów R, G, B, i po sprawie. Regulamin to regulamin!
No właśnie — regulamin regulaminem, a w rzeczywistości nic nie jest takie oczywiste. Farby stosowane w latach 40-tch XXw. w lotnictwie to nie współczesne lakiery samochodowe! Z upływem czasu zmieniały barwę — na skutek długotrwałego działania promieni słonecznych, wilgoci, różnic temperatur występujących na różnych pułapach lotu. Zazwyczaj kolory blakły (Rysunek 19.6.1):
Rysunek 19.6.1 Zmiany odcienia Olive Drab w zależności od stopnia zużycia powierzchni.
Farby pochodziły od wielu dostawców (każdy producent samolotów miał ich prawdopodobnie paru). Po rozpoczęciu wojny przez USA wystąpiły braki komponentu stabilizującego barwę, opartego na kadmie. (Ten rzadki metal zawłaszczył przemysł ciężki do uszlachetniania pancerzy czołgów). Substytuty nie pozostały bez wpływu na jakość pokrycia samolotów. W szczególnych przypadkach na ich powierzchni mogły zajść dziwne reakcje chemiczne. Na przykład Olive Drab na wczesnych modelach P-38 „Lightning” z 14 FG, walczącej w Afryce Północnej, osiągnął po jakimś czasie odcień jaskrawej purpury!
Dolne powierzchnie samolotu nie są prawie nigdy poddane działaniu promieni słonecznych, stąd nie ulegają tak intensywnemu wietrzeniu, jak powierzchnie górne. Rysunek 19.6.2 przedstawia kolor, który według modelarzy najlepiej odpowiada „eksploatacyjnemu” Neutral Gray.
Na tej ilustracji (Rysunek 19.6.2) specjalnie umieściłem go na tle „komputerowej” barwy szarej (50% czerni i 50% bieli). Widzisz, że ten kolor ma jakiś błękitnawy odcień? Gdybyś zasugerował się nazwą, na pewno użyłbyś prostej mieszanki bieli i czerni! Świat nazw barw, określonych regulaminami, pełen jest takich pułapek.
Swoją drogą — to była dość ciemna farba, jak na dolne powierzchnie. W pozostałych armiach używano do tego celu o wiele jaśniejszych odcieni (no, może poza Azure Blue RAF z Afryki Północnej).
A jaką właściwie miał barwę miała farba podkładowa Zinc Chromate ? Tu się zaczynają jeszcze większe kłopoty, bo to właściwie nie była farba w pełnym tego słowa znaczeniu, tylko dość rzadki i przejrzysty podkład, o właściwościach antykorozyjnych. Jego barwa zależała od barwy pomalowanego materiału: żółtozielona na białej kartce papieru, stawała się bardziej zielona na powierzchniach aluminiowych2 (Rysunek 19.6.3a,b):
Rysunek 19.6.3 Barwy podkładów Zinc Chromate w zależności od zastosowanych dodatków i powierzchni.
„Surowy” Zinc Chromate nie nadawał się do pomalowania wnętrza kabiny — był zbyt jasny i, w pewnych sytuacjach, kontrastowy. Siły powietrzne zalecały używać do malowania takich miejsc Zinc Chromate zaciemnionego za pomocą czerni Lamp Black. Curtiss uprościł sobie malowanie, zamawiając u dostawcy gotową, zaciemnioną farbę. Używał jej jako podkładu oraz do zabezpieczenia wszelkich powierzchni wewnętrznych, nie tylko kabiny (chyba nakładał tam drugą warstwę?). Barwa ta była często określana jako Curtiss Green (Rysunek 19.6.3c). Różniła się nieco odcieniem od ostatecznie ustalonej regulaminem z 1943r barwy Interior Green (Rysunek 19.6.4), która także była po prostu zaczernionym Zinc Chromate — tyle, że w innej proporcji.
Skąd właściwie wziąłem przedstawione tu próbki kolorów? No cóż, w różnorodnych modelarskich opisach dość często jest podawany ekwiwalent barwy, wyrażony za pomocą symbolu z jednego z powszechnie używanych wzorców. Najczęściej chyba stosowany jest amerykański Federal Standard 595B, określany także skrótem FS. Na przykład na stronie http://www.fed-std-595.com/FS-595-Paint-Spec.html można znaleźć listę stosowanych w modelarstwie nazw farb, wraz z próbką koloru i wartościami RGB (Rysunek 19.6.5):
Rysunek 19.6.5 Fragment listy wybranych barw (tzw. „Fan Deck”) z serwisu www.fed-std-595.com.
Wartości R,G,B są w serwisie www.fed-std-595.com podawane w postaci szesnastkowej (heksadecymalnej). Wartość składnika R to pierwsze dwa znaki, określające liczbę od 0 do 255, wartość składnika G to dwa znaki środkowe, a B — dwa ostatnie. Gdy zmienisz każdą z tych liczb na dziesiętną, i podzielisz przez 255, uzyskasz wartości z zakresu 0..1, takie jak te używane do „arytmetyki barw” (por. str. 1246). Zresztą — nie musisz się nawet tak wysilać, bo i w Inkscape, i w GIMP, i w Blenderze można wpisać wprost te heksadecymalne kody. Nazywa się to tam HTML notation, czy jakoś podobnie.
Serwis www.fed-std-595.com udostępnia za darmo tylko wybór najczęściej spotykanych wzorów barw. Aby uzyskać próbki dowolnego z istniejących symboli FS, skorzystaj z innego serwisu: http://colorserver.net (Rysunek 19.6.6):
Rysunek 19.6.6 Początkowy ekran serwisu colorserver.net.
Na ekranie początkowym możesz wpisać w pole FS Color jeden lub więcej (gdy chcesz zobaczyć próbki obok siebie) symboli FS. Po naciśnięciu przycisku Display color(s) zobaczysz rezultat (Rysunek 19.6.7):
Rysunek 19.6.7 Przykładowa próbka, zwrócona przez serwis colorserver.net.
Mówiąc szczerze, rozmyślnie umieściłem na ilustracji powyżej próbkę FS 34088 (typowy, najczęściej spotykany odcień Olive Drab). Porównaj odcień tę próbkę z próbką tego samego symbolu, przedstawioną przez serwis www.fed-std-595.com (Rysunek 19.6.5). Różnią się zdecydowanie! I która z tych próbek jest prawidłowa? W takich sytuacjach możesz „sprawdzić zeznania trzeciego świadka”, np. serwisu http://www.chassis-plans.com/paint_fed-std-595.html (myślnik występuje w oryginalnym adresie). Wydawałoby się, że powinna się tam znajdować kopia www.fed-std-595.com, bo strona wyraźnie mówi że skorzystała z tych zasobów. Ku mojemu zaskoczeniu, FS 34088 ma tam jasny odcień — taki jak ten pokazywany przez colorserver.net!
Zawsze warto sprawdzić próbkę barwy, odpowiadającą danemu symbolowi FS, w co najmniej dwóch źródłach. W przypadku różnicy — warto sprawdzić jeszcze w trzecim, i wybrać najbardziej prawdopodobny kolor. Dopóki można, kieruj się wiedzą historyczną. Gdy wszystko zawiedzie — zdaj się na wyczucie ☺.
Po wielu próbach odnoszę wrażenie, że na www.fed-std-595.com wiele barw jest ciemniejszych — wzorowali się na odcieniach widocznych w otwartej puszce ze świeżą farbą, czy jak? Serwisu colorserver.net też nie należy traktować jako wyroczni: zdarzają się im błędy. Na przykład barwa Interior Green (FS 34151) , podana przez każdy z tych trzech serwisów wygląda inaczej (Rysunek 19.6.8):
Rysunek 19.6.8 Próbka Interior Green, wg trzech różnych serwerów barw.
Ciekawe, prawda? Każda z próbek ma inny odcień. Wartości R,G,B, podane explicite przez www.fed-std-595.com i www.chassis-plans.com są potwierdzeniem, że to nie jest przypadek. Być może cały problem z odwzorowaniem cyfrowym polega na tym, że Federal Standard 595b jest oparty na zestawie fizycznych wzorników (można je kupić po 158 USD za komplet). Barwy, pokazywane w Internecie, mogły powstać poprzez skanowanie powierzchni tych wzorników. Wygląda na to, że każdy z użytych skanerów był nieco inaczej skalibrowany ☺. Próbka z www.chassis-plans.com jest najbardziej żółta. Znając „pochodzenie” Interior Green (zaczerniony Zinc Chromate) — można przypuszczać, że ta właśnie wersja (Rysunek 19.6.8c) jest najbliższa prawdy.
Jak na razie, w literaturze modelarskiej nikt nie podaje barw posługując się wprost wartościami R,G,B. Odniesienia do takich wzorców, jak barwy FS, traktuj jako pewne przybliżenia. Dla tego samego symbolu FS próbki barw, pokazywana przez różne serwisy internetowe, mogą się różnić!
Jedno z podanych tu źródeł — colorserver.net — pokazuje tylko próbki koloru, bez podawania wartości liczbowych R, G, B. Na szczęście nie jest to duże utrudnienie. Możesz załadować do GIMP „zrzut ekranu” z oknem przeglądarki. Potem w GIMP pobrać próbkę barwy za pomocą narzędzia Color Picker, i sprawdzić w oknie właściwości koloru wartości liczbowe jego komponentów (szczegóły — str. 650).
Kiedy światło pada na przejrzystą powierzchnię (np. warstwy szkła) jego kierunek ulega zmianie. Jednocześnie pewna jego część ulega odbiciu. Schemat tego zjawiska przedstawia Rysunek 19.7.1. Padający na powierzchnię szkła pod kątem θi promień ri ulega rozszczepieniu. Część rt (zazwyczaj większa) przenika przez szkło pod mniejszym kątem (θt ), a część rr ulega odbiciu pod takim samym kątem jak kąt padania (θi = θr ).
Rysunek 19.7.1 Załamanie światła w szkle: schemat | Rysunek 19.7.2 Załamanie światła w szkle: przykład |
Używając w Cycles materiału imitującego szkło (por. str. 1046) możesz taki efekt uzyskać także na renderze. Rysunek 19.7.2 przedstawia rezultat załamania światła przez owiewkę kabiny: podwójny obraz końcówki płata. Jednocześnie w innym miejscu tej osłony pojawia się jasne pasmo światła słońca — to z kolei efekt odbicia części jego promieni od powierzchni obiektu.
Zmiana kierunku światła na granicy dwóch ośrodków nazywana jest refrakcją. Fizycy są w stanie określić dla każdego materiału tzw. współczynnik refrakcji (ang. index of refraction — IOR). Ta bezwymiarowa wartość pozwala określić o ile zmieni się kierunek światła:
Rysunek 19.7.3 Zmiana kierunku światła w zależności od wartości IOR materiału
Wartość IOR określa, ile razy materiał spowalnia światło w stosunku do prędkości światła w próżni (c). Zależy od długości (czyli barwy!) padającego światła, choć nie są to duże zmiany. Za to dla fal o zupełnie innych długościach — promieni Roentgena lub sygnałów radaru — IOR materiału może być zupełnie inny.
Współczynnik IOR powietrza jest praktycznie równy 1.0. Współczynniki IOR dla typowych przejrzystych materiałów, które możesz napotkać w modelach samolotów, wynoszą:
Szkło organiczne (plexiglas): 1.55;
Szkło zwykłe: dla różnej brawy światła widzialnego od 1.45 do 1.52 (to niewielka różnica, którą można zaniedbać w naszych zastosowaniach);
A ile światła odbija się od powierzchni szkła (por. Rysunek 19.7.1, promień rr )? To także zależy od kąta, pod którym pada promień (Rysunek 19.7.4):
Rysunek 19.7.4 Udział ilości światła odbijanego przez gładką powierzchnię szkła w zależności od kąta padania promieni
Z pomiarów wynika, że szkło odbija 4% światła padającego pod kątem prostym (θi = 0º — por. Rysunek 19.7.1). Dla większych kątów padania światła zaczyna mieć wpływ jego polaryzacja. (To kierunek oscylacji fali elektromagnetycznej, jaką jest światło). Np. szkło jest idealnie przejrzyste dla promieni spolaryzowanych w kierunku równoległym (p) do jego powierzchni, padających pod kątem 57º (tzw. kąt Brewstera).
Rysunek 19.7.5 przedstawia, jak ta zależność ilości odbitego światła od kąta pochylenia powierzchni szkła przekłada się na wygląd modelu:
Rysunek 19.7.5 Odbicie światła przez szybę (model)
Żyjący na przełomie XVIII i XIX francuski inżynier Augustine Fresnel opracował wyrażenie matematyczne które pozwala obliczyć udział światła odbijanego przez gładką powierzchnię. Uzyskana krzywa zależy od współczynnika refrakcji (IOR) materiału. Dla IOR = 1 zawsze jest równa 0. Rysunek 19.7.6 przedstawia przebieg krzywych Fresnela dla różnych wartości współczynników refrakcji:
Rysunek 19.7.6 Współczynnik Fresnela dla materiałów nie przewodzących elektryczności (IOR > 1)
To właśnie te wartości zwracają w Blenderze węzły Fresnel i Layer Weight:Fresnel (por. str. 1003). Linia łącząca współczynniki Fresnela dla IOR = 1.5 odpowiada dokładnie rezultatom pomiarów dla szkła oświetlonego światłem niespolaryzowanym (por. Rysunek 19.7.6 i Rysunek 19.7.4). Największy współczynnik IOR spośród występujących w naszym otoczeniu związków chemicznych ma krzem: 4.24. Na wykresie umieściłem jednak także linie odpowiadające dużo wyższym wartościom współczynnika refrakcji. Traktując krzywe Fresnela jak każdą inną funkcję matematyczną, jest to dopuszczalne (por. rezultat użycia przy mieszaniu barw — por. str. 1004, Rysunek 15.5.9c). Na razie zwróć uwagę, że dla każdego IOR > 5 współczynniki Fresnela osiąga minimum dla kątów padania pomiędzy 70º a 90º. Wartość tego minimum zmierza do 0.5 dla coraz większych współczynników refrakcji. Praktycznie osiąga go dla IOR = 20 i to już nie ulega zmianie. Potem można obserwować tylko przesuwanie kąta padania, przy którym to minimum występuje, w kierunku 90º. (Jak pokazuje Rysunek 19.7.6, dla IOR = 100 współczynnik Fresnela osiąga najmniejsza wartość dla światła padającego pod kątem 89.4º).
Czy wiesz, że współczynnik Fresnela opisuje odbijanie światła nie tylko dla materiałów przejrzystych, ale także nieprzejrzystych? Wszystko zależy tylko od tego, jak gładka jest oświetlona powierzchnia (Rysunek 19.7.7):
Rysunek 19.7.7 Odbicie światła przez powierzchnie przejrzyste i nieprzejrzyste o identycznej gładkości
Współczynnik Fresnela opisuje ilość światła odbijanego przez każdą gładką powierzchnię — zarówno przejrzystą, jak i nieprzejrzystą
Dzieje się tak, gdyż współczynnik refrakcji opisuje załamanie na granicy ośrodka nie tylko światła, a wszelkich fal elektromagnetycznych. Dla ciał nieprzejrzystych może zostać obliczony z ich tzw. przenikalności elektrycznej (ang. electric permittivity). Wartości IOR dla różnych materiałów możesz łatwo znaleźć w Internecie.
Udział odbitego światła dla promieni padających prostopadle na gładką powierzchnię dielektryka (szkła, plastiku, i temu podobnych izolatorów), gdy otoczenie wypełnia powietrze, można obliczyć ze wzoru:
|
Wyr 19.16 Odbita ilość prostopadłego światła (θi = 0) | Gdzie: F0 — współczynnik Fresnela (dla θi = 0º); IOR — współczynnik refrakcji materiału; Założenie: IOR otoczenia jest = 1. |
Dla wszystkich powierzchni i niezbyt dużych kątów padania (θi = 0º..45º) możesz traktować tę wartość jako stałą. Ten wzór pozwala oszacować dla danego IOR „połyskliwość” większej części widocznej powierzchni materiału.
Ze związku IOR z przewodnictwem elektrycznym ośrodka wynika fakt, że wszystkie materiały nie przewodzące elektryczności (dielektryki) mają IOR >= 1.0. Z tego samego powodu metale, jako przewodniki, odbijają światło w zupełnie inny sposób. Weźmy na przykład takie aluminium (Rysunek 19.7.8):
Rysunek 19.7.8 Udział ilości światła odbijanego przez gładką powierzchnię aluminium w zależności od kąta padania promieni
Wzory na współczynnik Fresnela dla metali (przewodników) są inne. Współczynnik refrakcji jest w nich tzw. liczbą zespoloną. Wartość IOR metalu pełni w nim rolę tzw. części rzeczywistej. Z częścią urojoną (☺) liczby zespolonej jest tu związany dodatkowy współczynnik absorpcji. Dlatego nie bądź zdziwiony, gdy w podawanych w Internecie tabelach IOR znajdziesz dla srebra wartość = 0.189. To wcale nie znaczy, że światło mknie w srebrze pięć razy szybciej niż w próżni. To po prostu tylko jedna z dwóch części współczynnika refrakcji srebra — w połączeniu ze współczynnikiem absorpcji staje się fizycznie poprawna.
Krzywe współczynnika odbijania światła dla różnych materiałów znajdziesz np. na stronie refractiveindex.info. Aby uzyskać taki „dokładny fizycznie” materiał w Cycles, wystarczy zastosować węzeł RGB Curves (jego opis znajdziesz na str. 1076). (Pomysł na takie zastosowanie węzła krzywej pochodzi z prezentacji Kamila „mookie” Kuklo, zamieszczonej w sierpniu 2014 w popularnym serwisie Blender Nation).
Rysunek 19.7.9 przedstawia schemat testowego materiału powierzchni samolotu. To typowe dla Cycles połączenia shaderów: matowego (Diffuse BSDF) i połyskliwego (Glossy BSDF — odbija światło w 100%). Udział połyskliwego shadera jest uzależniony od kąta nachylenia ścian modelu do kamery (θi ). Wartość tego nachylenia (a dokładniej: odwrotność funkcji cos( θi )) dostarcza wyjście Facing węzła Layer Weight. Ta informacja jest zamieniana przez krzywą węzła RGB Curves w udział shadera Glossy BSDF:
Rysunek 19.7.9 Schemat testowego materiału („dielektryk”) | Rysunek 19.7.10 Szczegóły węzła z krzywą |
Rysunek 19.7.10 przedstawia szczegóły węzła krzywej. W Cycles nie ma węzła wejściowego który by zwracał kąt pochylenia ściany. Dlatego do wejścia RGB Curve musiałem podłączyć współczynnik Facing (gdy Blend =0.5, dla większych katów θi jest niemal liniowy). Tym mniemniej skala pozioma tego wykresu jest nieliniowa. Jako prostą regułę dla tej skali zapamiętaj, że w połowie obszaru przypada wartość dla θi = 60º.
W związku z tym że obydwa shadery materiału są bardzo gładkie (ich Roughness = 0.01), to dla krzywej odbicia szkła (jak ze str. 1257) uzyskamy coś, co wygląda jak połyskliwa porcelana (Rysunek 19.7.11):
Rysunek 19.7.11 Powierzchnia modelu dla materiału „dielektryka”
A teraz spróbujmy zmienić tę „porcelanę” w aluminium. Rysunek 19.7.12 przedstawia ten sam materiał co poprzednio (por. Rysunek 19.7.9). Jedyną różnicą jest zmodyfikowana krzywa odbicia. Teraz wygląda tak jak krzywa odbicia światła przez aluminium, pokazana na str. 1258 (Rysunek 19.7.8).
Rysunek 19.7.12 Testowy materiał „aluminium”
Taka zmiana węzła krzywej powoduje zmianę wyglądu modelu (Rysunek 19.7.13). Teraz zamiast efektu „ceramiki” powierzchnia samolotu wygląda jak wypolerowany dural. Aby takie powłoki wyglądały jak w świecie rzeczywistym, musi się w nich odbijać się zniekształcony obraz otoczenia. (Musisz to otoczenie wcześniej przygotować — chociażby tak, jak jest to opisane na str. 1045):
Rysunek 19.7.13 Powierzchnia modelu dla materiału „aluminium”
Ustawianie za każdym razem krzywej odbić materiału może być kłopotliwie. Czy nie można uzyskać w jakiś przybliżony sposób taką powierzchnię metalu jak na ilustracji powyżej? Spróbujemy użyć w tym celu wyspecjalizowanego węzła Fresnel. Ten węzeł, oraz Layer Weight:Fresnel, zwracają tylko wartości współczynników dla dielektryków (IOR musi być > 1) — czyli takie, jakie pokazuje na str. 1257 Rysunek 19.7.6.
Przybliżmy charakterystykę aluminium za pomocą krzywej Fresnela o nierealnie wysokim IOR: 50 (Rysunek 19.7.14a, b). W efekcie uzyskasz efekt całkiem „metaliczny” (Rysunek 19.7.14c):
Rysunek 19.7.14 Przybliżenie charakterystyki aluminium krzywą Fresnala o wysokiej wartości IOR
A teraz sprawdźmy najprostsze połączenie 92% shadera „lustrzanego” i 8% matowego (Rysunek 19.7.15a, b):
Rysunek 19.7.15 Przybliżenie charakterystyki aluminium linią prostą
Czy widzisz jakąś różnicę pomiędzy renderami pokazywanymi przez Rysunek 19.7.15c) i Rysunek 19.7.14c)? Bo ja nie widzę żadnej! Wydaje się więc, że różnice krzywych odbić dla kątów > 75º są tu bez znaczenia.
Metaliczną powierzchnię można w Cycles uzyskać poprzez złożenie dwóch shaderów: matowego i połyskliwego. Udział tych komponentów uzależnij od węzła Fresnel o wyokim IOR (> 20) lub nawet ustaw na stałą proporcję (wartość pomiędzy 0.85 a 0.95).
Wiedza o tym, jak odbija się światło od powierzchni na pewno przyda Ci się przy komponowaniu materiałów. Jednak nie licz na to, że przygotowanie „poprawnej fizycznie” powierzchni w oparciu o kilka podstawowych współczynników jest gwarancją realistycznego wygląd na renderze. Widać to chociażby po przymiarkach do uzyskania wypolerowanego aluminium, które wykonałem przed chwilą. Bez odpowiedniego otoczenia ten samolot wcale nie wyglądałoby jak z duralu!
Filmy, książki i czasopisma przyzwyczaiły nas do widzenia świata poprzez zdjęcia. Ostateczny wygląd takiego utrwalonego obrazu zależy jednak od wielu rożnych czynników. Jednym z nich jest chociażby polaryzacja światła (Rysunek 19.7.16):
Rysunek 19.7.16 Świat w obiektywnie kamery wygląda inaczej (ilustracja: wikipedia.org)
Oko ludzkie nie rozróżnia czegoś takiego, jak polaryzacji promieni światła. „Widzą” je jednak obiektywy naszych kamer. Renderując nasz model często chcemy osiągnąć coś, co nazywamy „fotorealizmem” — czyli obraz, którego nie da się odróżnić od fotografii1. A światła spolaryzowanego, które może mieć wpływ na wygląd zdjęcia, jest wokół mnóstwo2. Przykładem w skali makro jest choćby nieboskłon. Rozproszone światło nieba jest spolaryzowane, co w znaczący sposób może zmienić jego obraz na zdjęciach (por. Rysunek 19.7.16). Różne obszary nieba mają różną polaryzację, i w dodatku zmienia się ona wraz z ruchem słońca. Orientacja samolotu względem nieba może np. znacząco zmienić na fotografii przejrzystość szyby (por. Rysunek 19.7.4), czy połyskliwość lakieru. Dlatego w doborze barw i wszelkich innych współczynników materiałów nie traktuj wartości fizycznych jak wyroczni. Rzeczywistość jest o wiele bardziej złożona. Aby ją jak najwiarygodniej odtworzyć na obrazie, musisz się czasami zdać na własne wyczucie.
Aby znaleźć w książce jakieś słowo lub wyrażenie możesz użyć narzędzia wyszukiwania wbudowanego w czytnik, którego używasz. Jednak ta metoda może nie być zbyt efektywna w przypadku pojęć koncepcyjnych. (O wiele łatwiej znaleźć takie wyrażenie w skorowidzu drukowanej książki, niż poszukując go poprzez powiązane polecenia lub słowa kluczowe). Co więcej, niektóre aplikacje do czytania publikacji elektronicznych w formacie EPUB na komputerach PC w ogóle nie umożliwiają wyszukiwania w całej książce. Dlatego zdecydowałem się włączyć do tej publikacji skorowidz z wersji "stronicowanej" (PDF). Wystarczy kliknąć na jeden z numerów stron po prawej stronie hasła, by przejść do odpowiedniego fragmentu książki.
Po prawej stronie nagłówka każdego hasła umieściłem skroty do pozostałych nagłówków. Użyj ich, aby nie przewijać zbyt wielu stron przechodząc np. od litery Z do C.
Nazwy poleceń, skróty klawiatury, podane w skorowidzu, dotyczą Blendera, o ile w haśle nie jest zaznaczone inaczej: „(GIMP)”, „(Inkscape)”.
GPL, licencja — General Public Licence, udostępniająca produkt za darmo wszystkim odbiorcom. Licencja ta jest sformułowana w ten sposób, aby uniemożliwić komercyjne rozpowszechnianie produktu.
heksadecymalna, notacja liczb — sposób notacji liczb, oparty na kolejnych potęgach liczby 16, a nie 10 (zapis decymalny). Liczby od 1 do 16 są w nim zapisywane jako: 0,1,..9,A,B,C,D,E,F. W zapisie heksadecymalnym (szesnastkowym) „12” = 1*16 + 2, czyli decymalnie 18. Podobnie liczba 4F to 4*16 + 15 = 79 decymalnie. Zapis szesnastkowy jest szeroko stosowany przy tworzeniu oprogramowania.
materiał — to w Blenderze zestaw cech, używanych przy nanoszeniu obiektu na ostateczny obraz (renderowaniu). Cechy materiału to: barwa, połyskliwość, tekstura, i dziesiątki innych parametrów. Z materiałem może być związanych wiele tekstur (nierówności, barwy), zmieniających “ogólne” właściwości materiału dla pojedynczych pikseli renderowanego obrazu.
nadir — punkt położony na powierzchni nieba po przeciwnej stronie niż zenit. (W normalnych warunkach nadir jest zasłonięty przez Ziemię.)
NURBS (N on- U niform R ational B - s plines) — inny sposób wygładzania powłoki, złożonej z jednorodnych ścian. Powierzchnie NURBS stawiają wygładzanym powłokom wyższe wymagania. Muszą mieć jednorodne ściany (zazwyczaj czworokątne), a zespół ścian powinien także być regularnym czworokątem. NURBS jest starszym o ponad 30 lat modelem obliczeniowym od powierzchni podziałowych. Przez ten czas stał się standardem w systemach CAD/CAM. Osobiście sądzę, że okres jego świetności ma się ku końcowi (choć wielu specjalistów może się ze mną nie zgodzić).
rastrowy, obraz — popularna metoda reprezentacji, polegająca na zapisie obrazu jako zbioru kolorowych lub czarno-białych punktów (pikseli). Tak jest np. wyświetlany obraz na ekran telewizyjnym, monitorze komputera. Wadą reprezentacji rastrowej jest pogorszenie jakości obrazu w dużych powiększeniach — gdy zaczynają być wyraźnie widoczne pojedyncze piksele. Zaletą jest stosunkowo prosty algorytm wyświetlania zawartości. Istnieje wiele różnorodnych sposobów zapisu (formatów) przechowywania obrazów rastrowych w plikach. Najpopularniejsze to *.jpg, *.png, *.bmp, *.tif.
renderowanie (ang. rendering) — w tej książce oznacza tworzenie ostatecznego obrazu (lub sekwencji obrazów — animacji) przygotowanej wcześniej trójwymiarowej sceny. W pierwszych wersjach Autodesk 3D Studio (początek lat 90-tych XX wieku) było przetłumaczone na polski jako powlekanie, ale ta nazwa się nie przyjęła.
shader (ang.) — model matematyczny, stosowany do wyznaczania sposobu odbicia światła przez powierzchnię. W Cycles shadery są reprezentowane przez pojedyncze węzły lub grupy węzłów.
shear (ang.) — przekoszenie (określane także jako “ścinanie”). Transformacja obrazu w GIMP. Przekształca kształt prostokąta w rąb (przeciwległe boki zachowują równoległość).
subdivision surface (pol.: powierzchnia podziałowa) — sposób wygładzania kształtu oryginalnej powłoki, złożonej z dowolnych ścian. W Blenderze występuje jako modyfikator siatki Subsurf (p. str. 903). Szczegółowy opis powierzchni (i linii) podziałowych znajdziesz na str. 1221.
tekstura — obraz (zazwyczaj rastrowy), nakładany na trójwymiarową powierzchnię. Stosowany w grafice komputerowej do “urealniania” obiektów (nieregularności barw, napisy, itp.). Zastosowanie tekstur wykracza poza odwzorowanie barw — są stosowane także do zamodelowania drobnych nierówności powierzchni obiektów (tzw. bump maps).
True Type — sposób zapisu wzorów czcionek, wykorzystywanych w grafice komputerowej. Metoda opracowany w latach osiemdziesiątych przez Adobe. Czcionki True Type opisują kształt znaków w sposób wektorowy — za pomocą wypełnionych obszarów, ograniczonych za pomocą linii łamanych i krzywych Beziera. Dzięki temu wyglądają poprawnie na wydruku i na ekranie — nawet w dużym powiększeniu.
wektorowy, obraz — metoda reprezentacji, polegająca na zapisie obrazu jako zbioru kolorowych linii i obszarów. Każdy element obrazu ma określone współrzędne i kształt (prosta, łuk, koło, krzywa Beziera, ...). W ten sposób są zapisywane stworzone na komputerze rysunki techniczne. Zaletą reprezentacji wektorowej jest zachowanie dokładności przy dowolnym powiększeniu. Wadą jest złożony algorytm wyświetlania (gdyż oznacza przekształcenie na postać rastrową). Jednym ze sposobów zapisu danych wektorowych jest format *.svg, stosowany m.in. przez Inkscape.
wireframe (pol.: siatka?) — oznacza sposób reprezentacji modelu w którym nie rysowane są żadne ściany, tylko krawędzie łączące poszczególne wierzchołki. Jest ich zazwyczaj dużo i są cienkimi liniami. Stąd obrazowo w literaturze anglojęzycznej taka reprezentacja jest nazywana “drucianą siatką” czyli “wireframe”.
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Witold Jaworski pasjonował się lotnictwem i modelarstwem odkąd skończył 10 lat. Zaczynał od plastikowych zestawów do sklejania (1:72), potem wycinanek z „Małego Modelarza” (1:33), by skończyć na budowie modeli od podstaw (1:24). Te zainteresowania zaprowadziły go na Wydział Mechaniczny Energetyki i Lotnictwa Politechniki Warszawskiej, który ukończył w 1994r otrzymując dyplom mgr. inż lotnictwa. W 1987 przerysowywał w tuszu plany samolotów, m.in. do książki „Samoloty bombowe września” (te prace zlecał Andrzej Glass). Potem zaproponowano mu samodzielne opracowanie przekroju i kilku arkuszy planów do nowo powstającego magazynu. Mógł wybrać dowolny samolot. W ten sposób powstały dokładne rysunki myśliwca F-4 Phantom II, opublikowane w 1990r w pierwszym numerze miesięcznika „Aero HOBBY”. Nadal można znaleźć ich kopie w Internecie, na różnych portalach z planami. Podczas studiów na MEiL Witold zainteresował się także grafika komputerową i systemami CAD. W 1991r miał okazję po raz pierwszy wykorzystać tę wiedzę, pomagając w budowie prototypu szybowca PW-5 (zwycięzcy konkursu na tzw. szybowiec światowy w 1992).
Obecnie Autor pracuje jako specjalista IT. Mieszka wraz z żoną i trójką dzieci w Poznaniu. Od czasu do czasu pisze artykuły dla czasopism lotniczych. W tej książce łączy swoje dwie pasje — grafikę komputerową i lotnictwo — w nowy rodzaj modelarstwa: realistyczne, cyfrowye modele historycznych samolotów.